
IBM Tivoli Storage Productivity Center
Version 5.1

User's Guide

SC27-4048-00

���





IBM Tivoli Storage Productivity Center
Version 5.1

User's Guide

SC27-4048-00

���



Note:
Before using this information and the product it supports, read the information in “Notices” on page 1501.

Edition notice

This edition applies to version 5, release 1 of IBM Tivoli Storage Productivity Center (product numbers 5725-F93,
5725-F98, and 5725-G33) and to all subsequent releases and modifications until otherwise indicated in new editions.

© Copyright IBM Corporation 2001, 2012.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.



Contents

Figures . . . . . . . . . . . . . . . ix

Tables . . . . . . . . . . . . . . . xi

Preface . . . . . . . . . . . . . . xiii
Who should read this guide . . . . . . . . xiii
Publications . . . . . . . . . . . . . . xiii

Accessing publications online . . . . . . . xiii
IBM Redbooks . . . . . . . . . . . . xv
Translation . . . . . . . . . . . . . xv
Ordering publications . . . . . . . . . . xv
Providing feedback about publications . . . . xvi

Conventions used in this guide . . . . . . . xvi
Contacting the IBM Support Center . . . . . . xvi

Reporting a problem . . . . . . . . . . xvii

New for Tivoli Storage Productivity
Center Version 5.1 . . . . . . . . . xix

Chapter 1. Getting started . . . . . . . 1

Chapter 2. Product overview . . . . . . 9
Introducing IBM Tivoli Storage Productivity Center . 9

Architecture . . . . . . . . . . . . . 10
IBM Tivoli Storage Productivity Center summary 11
Product licenses for Tivoli Storage Productivity
Center . . . . . . . . . . . . . . . 12
User interfaces to Tivoli Storage Productivity
Center . . . . . . . . . . . . . . . 19
Data Manager . . . . . . . . . . . . 44
Disk Manager . . . . . . . . . . . . 46
Tape Manager . . . . . . . . . . . . 48
Fabric Manager . . . . . . . . . . . . 48

Tivoli Storage Productivity Center for Replication . 49
Architecture . . . . . . . . . . . . . 51
Interfaces for Tivoli Storage Productivity Center
for Replication . . . . . . . . . . . . 51
Tivoli Storage Productivity Center for Replication
integration with Tivoli System Automation
Application Manager . . . . . . . . . . 52

Tivoli Integrated Portal . . . . . . . . . . 53
Key concepts . . . . . . . . . . . . . . 53

Single sign-on . . . . . . . . . . . . 53
Launch and launch in context . . . . . . . 56
User roles . . . . . . . . . . . . . . 68
User tasks . . . . . . . . . . . . . . 70
Data collection . . . . . . . . . . . . 74
Data replication . . . . . . . . . . . . 75
Alerts . . . . . . . . . . . . . . . 108
Provisioning planner . . . . . . . . . . 109
Reporting. . . . . . . . . . . . . . 113
Fabric and zones . . . . . . . . . . . 113
Agents . . . . . . . . . . . . . . 117
Security . . . . . . . . . . . . . . 124

SAN Volume Controller topics. . . . . . . 126

Chapter 3. Scenarios . . . . . . . . 135
Monitoring and reporting on I/O utilization . . . 135
Storage provisioning by using workflows . . . . 138
Archive and delete files . . . . . . . . . . 142
Create a profile with a filter . . . . . . . . 146
Creating a performance threshold within an alert 148
Determine application performance problems . . 151
Identifying performance hot spots . . . . . . 156
Retiring underutilized storage systems . . . . . 158
Tivoli Storage Productivity Center for Replication
scenarios . . . . . . . . . . . . . . . 160

Identifying and investigating a suspended
Metro Mirror session . . . . . . . . . . 161
Performing planned maintenance scenarios . . 164
Recovering from a disaster scenarios . . . . 167
Practicing disaster recovery scenarios . . . . 170

Chapter 4. Administering . . . . . . 175
Starting Tivoli Storage Productivity Center . . . 175

Starting the Tivoli Storage Productivity Center
stand-alone GUI . . . . . . . . . . . 175
Starting the Tivoli Storage Productivity Center
web-based GUI. . . . . . . . . . . . 178

Starting Tivoli Storage Productivity Center for
Replication . . . . . . . . . . . . . . 179
Starting the Tivoli Storage Productivity Center
family of products through Tivoli Integrated Portal. 180
Overview of required user IDs for initial log on to
the Tivoli Storage Productivity Center family of
products . . . . . . . . . . . . . . . 181
Administering DB2 . . . . . . . . . . . 183

Backing up the Tivoli Storage Productivity
Center database . . . . . . . . . . . 183
Starting the Control Center . . . . . . . . 184
Using the command line on UNIX and Linux 184
Manually starting DB2 on Windows . . . . . 185
Manually stopping DB2 on Windows . . . . 185
Monitoring DB2 . . . . . . . . . . . 185

Adding a Tivoli Storage Productivity Center user
group name to Tivoli Storage Productivity Center
for Replication . . . . . . . . . . . . . 186
Backing up and recovering all the Tivoli Storage
Productivity Center for Replication . . . . . . 187
Administering Tivoli Storage Productivity Center 187

Checking the Tivoli Storage Productivity Center
version . . . . . . . . . . . . . . 187
Viewing and managing services . . . . . . 188
Starting and stopping the Tivoli Storage
Productivity Center services . . . . . . . 196
Starting and stopping the Tivoli Integrated
Portal server. . . . . . . . . . . . . 199
Checking Tivoli Storage Productivity Center
status . . . . . . . . . . . . . . . 199

© Copyright IBM Corp. 2001, 2012 iii



Increasing memory allocation . . . . . . . 200
Setting timeouts values for the Device server 202
Changing passwords . . . . . . . . . . 204
Checking for a fully qualified host name . . . 214
Granting local administrative privileges to a
domain account . . . . . . . . . . . 216
Importing SSL certificates for VMware . . . . 217
SQL access to Tivoli Storage Productivity Center
views . . . . . . . . . . . . . . . 218
Repocopy tool . . . . . . . . . . . . 221
Service tool: collecting information . . . . . 224

Administering Tivoli Integrated Portal . . . . . 229
Tivoli Integrated Portal port numbers . . . . 229
Changing the user authentication configuration 231
Changing the LTPA token expiration for single
sign-on . . . . . . . . . . . . . . 248

Administering data sources. . . . . . . . . 249
Checking the health of your data sources . . . 249
Manually changing the Windows service logon
for the agent . . . . . . . . . . . . 249
CIM agents . . . . . . . . . . . . . 249
Storage Resource agents . . . . . . . . . 256
In-band Fabric agents . . . . . . . . . 278
Out-of-band Fabric agents . . . . . . . . 278
Tivoli Storage Productivity Center servers . . . 280
Storage systems . . . . . . . . . . . 286
VMware data source . . . . . . . . . . 294

Managing schedules, jobs, and runs . . . . . . 297
Job Management - Recommendations . . . . 304

Chapter 5. Managing resources in the
stand-alone GUI . . . . . . . . . . 307
Configure Devices wizard . . . . . . . . . 307

Configuring storage subsystems . . . . . . 308
Configure fabrics and switches . . . . . . 318
Configure computers . . . . . . . . . . 320
Configure tape libraries . . . . . . . . . 322

Discovering storage resources . . . . . . . . 324
Discovery overview . . . . . . . . . . 325
Discovering computers in the Windows domain,
NAS, and SAN File System. . . . . . . . 331
Discovering computers . . . . . . . . . 332
Discover storage subsystem, tape library, and
fabric information with CIM agents . . . . . 333
Discovering fabrics with Storage Resource
agents . . . . . . . . . . . . . . . 335
Discovering storage subsystems and switches 336

Collecting data . . . . . . . . . . . . . 337
Collecting storage statistics . . . . . . . . 337
Collecting storage statistics from Tivoli Storage
Productivity Center servers. . . . . . . . 342
Collecting storage usage and trending
information . . . . . . . . . . . . . 346
Determining the availability of storage resources 366
Data collection groups . . . . . . . . . 370
Working with groups of resources . . . . . 373

Collecting performance data . . . . . . . . 377
Monitoring switch performance . . . . . . 377
Monitoring storage-subsystem performance . . 378
Monitoring tape libraries . . . . . . . . 383
Viewing performance data . . . . . . . . 383

Working with alerts . . . . . . . . . . . 385
Creating alerts . . . . . . . . . . . . 385
Configuring alert destinations . . . . . . . 395
Deleting alerts . . . . . . . . . . . . 396
Disabling an alert . . . . . . . . . . . 397
Editing alerts . . . . . . . . . . . . 398
Renaming alerts . . . . . . . . . . . 399
Viewing alerts . . . . . . . . . . . . 399
Viewing alert logs . . . . . . . . . . . 403
Viewing tape library alerts . . . . . . . . 404

Checking storage configurations . . . . . . . 404
Using configuration history. . . . . . . . 404
Using configuration analysis . . . . . . . 409

Planning and modifying storage configurations . . 419
Configuring a provisioning plan by using SAN
Planner . . . . . . . . . . . . . . 419
Working with storage resource group sessions 431

Optimizing storage configurations . . . . . . 432
Storage Optimizer overview . . . . . . . 432
Using the Storage Optimizer . . . . . . . 433
Optimizing tiered storage . . . . . . . . 441

Enforcing storage policies . . . . . . . . . 443
Setting storage usage quotas . . . . . . . 445
Storage usage for Network Appliance quotas 465
Setting file constraints . . . . . . . . . 470
Scheduling script-based actions . . . . . . 479
Archive and backup functions . . . . . . . 484

Working with storage resource groups . . . . . 489
Storage resource group management . . . . 489
Create or Edit a Storage Resource Group . . . 490

Working with scripts . . . . . . . . . . . 493
Running scripts with alerts . . . . . . . . 493
Running scripts using scheduled actions . . . 494
How scripts are run . . . . . . . . . . 496
How the server and agent resolve script names 498

Using the topology viewer . . . . . . . . . 499
The topology viewer . . . . . . . . . . 500
Arranging entities in a group . . . . . . . 512
Checking the status of entities and groups. . . 513
Creating custom groups . . . . . . . . . 522
Defining properties for grouping entities . . . 523
Displaying data paths from one endpoint in the
topology to another . . . . . . . . . . 523
Displaying membership in zones and zone sets 531
Displaying detailed information about entities 532
Displaying storage resource connections . . . 532
Filtering entities based on health status. . . . 533
Labeling entities . . . . . . . . . . . 534
Starting element managers . . . . . . . . 534
Launching SAN Planner. . . . . . . . . 535
Starting Storage Optimizer . . . . . . . . 535
Locating storage resources in the topology . . 536
Managing Storage Subsystems. . . . . . . 536
Managing Zone Control . . . . . . . . . 536
Pinning entities. . . . . . . . . . . . 537
Printing information from the topology viewer 537
Refreshing views . . . . . . . . . . . 537
Removing entities from the database . . . . 538
Removing deleted entities . . . . . . . . 538
Selecting entities in graphical and table views 539
Showing Alerts . . . . . . . . . . . . 539

iv IBM Tivoli Storage Productivity Center: User's Guide



Showing the monitoring status of entities . . . 539
Working with tape libraries in the topology
viewer. . . . . . . . . . . . . . . 539

Managing disk storage . . . . . . . . . . 541
Working with workload profiles . . . . . . 541
Working with provisioning profiles . . . . . 544
Thin provisioning profiles . . . . . . . . 549
Managing storage subsystems . . . . . . . 551
Managing virtual disks . . . . . . . . . 561
Managing volumes . . . . . . . . . . 570

Managing fabrics . . . . . . . . . . . . 576
Working with zones . . . . . . . . . . 576
Working with zone sets . . . . . . . . . 579
Working with zone aliases . . . . . . . . 581

Managing Tape Libraries . . . . . . . . . 584
Discovering tape libraries . . . . . . . . 584
Viewing tape library information . . . . . . 585
Monitoring tape libraries . . . . . . . . 585

Managing DS8000 storage systems using element
managers. . . . . . . . . . . . . . . 585

Configuring the DS8000 element manager . . . 586
Configuring other element managers for DS8000 591

Managing other storage systems using element
managers. . . . . . . . . . . . . . . 592

Adding element managers using CIMOM
discovery. . . . . . . . . . . . . . 593
Modifying other element managers . . . . . 595
Starting other element managers . . . . . . 596
Testing the connection to other element
managers. . . . . . . . . . . . . . 597
Adding user-defined element managers for
other storage systems. . . . . . . . . . 597
Removing user-defined element managers for
other storage systems. . . . . . . . . . 598

Launch and launch in context . . . . . . . . 598
Inbound launch in context feature . . . . . 599
Outbound launch and launch in context
features . . . . . . . . . . . . . . 606

External tools . . . . . . . . . . . . . 610
Adding external tools . . . . . . . . . 610
Modifying external tools. . . . . . . . . 611
Starting external tools . . . . . . . . . 612
Removing external tools . . . . . . . . . 612

Working with invoices . . . . . . . . . . 613
Planning for chargeback . . . . . . . . . 614
Setting up invoices . . . . . . . . . . 615
Generating an invoice . . . . . . . . . 616
Viewing and printing invoices . . . . . . . 616
Sample Invoices . . . . . . . . . . . 617

Chapter 6. Managing resources in the
web-based GUI. . . . . . . . . . . 623
Configuring resources for monitoring . . . . . 624

Resources that you can monitor in the
web-based GUI. . . . . . . . . . . . 625
Display differences in the interfaces . . . . . 628

Viewing information about resources . . . . . 629
How information is organized. . . . . . . 629
Viewing summary information about all
resources . . . . . . . . . . . . . . 631
Viewing information about top-level resources 633

Viewing information about internal and related
resources . . . . . . . . . . . . . . 634

Monitoring the status of resources . . . . . . 635
How status is determined . . . . . . . . 636
Viewing the overall status of resources . . . . 639
Viewing the status of top-level resources . . . 640
Viewing the status of internal resources . . . 641
Acknowledging the status of resources . . . . 641

Viewing jobs . . . . . . . . . . . . . 644
Configuring the display of jobs . . . . . . 645
Viewing all jobs . . . . . . . . . . . 645
Viewing jobs for a type of resource . . . . . 646
Viewing jobs for a specific resource . . . . . 646
Viewing job logs . . . . . . . . . . . 647

Managing alerts . . . . . . . . . . . . 648
Alert severities . . . . . . . . . . . . 649
Viewing all alerts . . . . . . . . . . . 650
Viewing alerts for a type of resource . . . . 651
Viewing alerts for a specific resource . . . . 651
Removing alerts . . . . . . . . . . . 652
Acknowledging alerts . . . . . . . . . 652

Exporting information about resources, jobs, and
alerts . . . . . . . . . . . . . . . . 653
Customizing lists of resources, jobs, and alerts . . 654

Filtering lists . . . . . . . . . . . . 655
Sorting lists . . . . . . . . . . . . . 655
Showing, hiding, and reordering columns in
lists . . . . . . . . . . . . . . . 656

Chapter 7. Managing replication . . . 657
Administering . . . . . . . . . . . . . 657

Starting and stopping Tivoli Storage
Productivity Center for Replication . . . . . 657
Verifying that components are running . . . . 659
Identifying the version of IBM Tivoli Storage
Productivity Center for Replication . . . . . 660
Backing up and restoring IBM Tivoli Storage
Productivity Center for Replication
configuration data . . . . . . . . . . . 660

Managing management servers . . . . . . . 664
Management servers . . . . . . . . . . 664
SNMP alerts . . . . . . . . . . . . . 666
Setting up a standby management server . . . 669
Applying maintenance to an active management
server . . . . . . . . . . . . . . . 670
Reconnecting the active and standby
management servers . . . . . . . . . . 671
Performing a takeover on the standby
management server . . . . . . . . . . 671
Configuring SNMP . . . . . . . . . . 671
Adding SNMP managers . . . . . . . . 672
Changing the standby management server port
number . . . . . . . . . . . . . . 672
Changing the client port number . . . . . . 672

Managing storage systems . . . . . . . . . 673
Storage systems . . . . . . . . . . . 673
Storage connections . . . . . . . . . . 674
Protected volumes. . . . . . . . . . . 678
Site awareness . . . . . . . . . . . . 678
Adding a storage connection . . . . . . . 679
Removing a storage connection . . . . . . 680

Contents v



Removing a storage system. . . . . . . . 681
Modifying the location of storage systems . . . 681
Modifying storage connection properties . . . 682
Refreshing the storage system configuration . . 683
Setting volume protection . . . . . . . . 683
Restoring data from a journal volume . . . . 683

Managing host systems . . . . . . . . . . 684
Adding a host system connection. . . . . . 685
Modifying a host system connection. . . . . 685
Removing a host system connection . . . . . 686
Removing a session from a host system
connection . . . . . . . . . . . . . 686

Managing logical paths . . . . . . . . . . 687
Viewing logical paths. . . . . . . . . . 687
Adding logical paths . . . . . . . . . . 687
Adding logical paths using a CSV file . . . . 688
Removing logical paths . . . . . . . . . 689

Setting up data replication . . . . . . . . . 689
Sessions . . . . . . . . . . . . . . 689
Data replication . . . . . . . . . . . 696
Session commands . . . . . . . . . . 729
Site awareness . . . . . . . . . . . . 743
Preserve Mirror option . . . . . . . . . 744
Creating sessions and adding copy sets. . . . 746
Using the Metro Mirror heartbeat . . . . . 754
Exporting copy set data . . . . . . . . . 756
Importing copy set data . . . . . . . . . 757
Exporting historical data for Global Mirror role
pairs . . . . . . . . . . . . . . . 757
Modifying the location of session sites . . . . 758
Removing sessions . . . . . . . . . . 758
Removing copy sets . . . . . . . . . . 759
Migrating an existing configuration to Tivoli
Storage Productivity Center for Replication . . 760

Practicing disaster recovery. . . . . . . . . 762
Practice volumes . . . . . . . . . . . 763
Practicing disaster recovery for a Metro Mirror
Failover/Failback with Practice session . . . . 763
Practicing disaster recovery for a Global Mirror
either Direction with two-site Practice session . 763
Practicing disaster recovery for a Global Mirror
Failover/Failback with Practice session . . . . 764
Practicing disaster recovery for a Metro Global
Mirror Failover/Failback with Practice session . 765

Monitoring health and status . . . . . . . . 765
Viewing the health summary . . . . . . . 765
Viewing SNMP alerts. . . . . . . . . . 766
Viewing sessions . . . . . . . . . . . 766
Viewing storage system details . . . . . . 786
Viewing storage connection details . . . . . 786
Viewing volume details . . . . . . . . . 786
Viewing logical paths. . . . . . . . . . 787
Viewing console messages . . . . . . . . 787

Security . . . . . . . . . . . . . . . 787
Users and groups . . . . . . . . . . . 788
User roles . . . . . . . . . . . . . 788
Adding the IBM Tivoli Storage Productivity
Center for Replication Administrator role to the
IBM Tivoli Storage Productivity Center
Superuser group . . . . . . . . . . . 791
Granting access privileges for a user. . . . . 791

Viewing access privileges for a user . . . . . 792
Modifying access privileges for a user . . . . 792
Removing access privileges for a user . . . . 792

Chapter 8. Reporting in the
stand-alone GUI . . . . . . . . . . 795
Choosing a reporting type . . . . . . . . . 795
Choosing a report category . . . . . . . . . 797
What can I find out using reports? . . . . . . 803
Report considerations and limitations . . . . . 807
Working with reports . . . . . . . . . . . 811

Generating and viewing reports . . . . . . 811
Sorting report columns . . . . . . . . . 812
Printing reports or charts . . . . . . . . 812
Including charts in reports . . . . . . . . 813
Drilling down a report row. . . . . . . . 816
Navigating tabs . . . . . . . . . . . 816
Trending with historical data . . . . . . . 817

Working with user-defined online reports . . . . 820
Generating reports . . . . . . . . . . 820
Using reporting groups . . . . . . . . . 828
Data Manager reports . . . . . . . . . 831
Data Manager for Databases reports . . . . . 961
Data Manager for Chargeback reports . . . . 990
Disk Manager reports . . . . . . . . . 990
Fabric Manager reports. . . . . . . . . 1003
Tape Manager reports . . . . . . . . . 1010

System reports . . . . . . . . . . . . 1010
Generating and viewing system reports . . . 1010
System reports - Data . . . . . . . . . 1011
System reports - Data Manager for Databases 1025
System Reports - Disk Manager . . . . . . 1037
System reports - Fabric Manager . . . . . 1054

Batch reports . . . . . . . . . . . . . 1061
Creating batch reports . . . . . . . . . 1062
Editing batch reports . . . . . . . . . 1073
Viewing job information for a batch report 1073
Displaying log files for a batch report . . . . 1073
Displaying batch reports from the saved
directory . . . . . . . . . . . . . 1073
Viewing CSV batch reports with spreadsheet
applications . . . . . . . . . . . . 1074
Exporting and importing settings that you
define . . . . . . . . . . . . . . 1074

User ID (saved) reports. . . . . . . . . . 1075
Creating a user-defined report . . . . . . 1075
Displaying user-defined reports . . . . . . 1075
Editing user-defined reports . . . . . . . 1075

Rollup reports . . . . . . . . . . . . . 1075
Generating rollup reports . . . . . . . . 1076
Rollup Reports - Asset . . . . . . . . . 1077
Rollup Reports - Database Asset. . . . . . 1106
Rollup Reports - TPC Server Storage Space 1112
Rollup Reports - Database Capacity . . . . 1129

Data source reports - overview . . . . . . . 1133
Data source reports - CIMOM agents . . . . . 1133

Data source report - By CIMOM Agent . . . 1134
Data source report - By Managed Device . . . 1135

Tivoli Storage Productivity Center Monitoring
Agent reports . . . . . . . . . . . . . 1137

vi IBM Tivoli Storage Productivity Center: User's Guide



Chapter 9. Reporting in the
web-based GUI . . . . . . . . . . 1143
Viewing predefined and custom reports . . . . 1143
Creating and viewing reports from the web-based
GUI . . . . . . . . . . . . . . . . 1144
Accessing report features in Tivoli Common
Reporting . . . . . . . . . . . . . . 1144
Setting options for reports . . . . . . . . . 1145
Predefined reports about resources . . . . . . 1145

Relationship reports . . . . . . . . . . 1146
Server reports . . . . . . . . . . . . 1150
Storage virtualizer reports . . . . . . . . 1154
Storage system reports . . . . . . . . . 1163

Predefined reports about performance . . . . . 1171
Switch reports . . . . . . . . . . . . 1171
Storage virtualizer reports . . . . . . . . 1177
Storage virtualizer performance details reports 1186
Storage system reports . . . . . . . . . 1202
Storage system performance details reports 1212

Predefined reports about historical information 1223
Running the Storage Virtualizers - Historical
Space Report . . . . . . . . . . . . 1224
Storage Virtualizers - Historical Space Report 1224
Running the Storage Virtualizer - Pools
Historical Space Report. . . . . . . . . 1225
Storage Virtualizer - Pools Historical Space
Report . . . . . . . . . . . . . . 1226
Running the Storage Virtualizer - Volumes
Historical Space Report. . . . . . . . . 1228
Storage Virtualizer - Volumes Historical Space
Report . . . . . . . . . . . . . . 1229
Running the Storage Systems - Historical
Space Report . . . . . . . . . . . . 1230
Storage Systems - Historical Space Report 1230
Running the Storage System - Pools Historical
Space Report . . . . . . . . . . . . 1232
Storage System - Pools Historical Space Report 1233
Running the Storage System - Volumes
Historical Space Report. . . . . . . . . 1234
Storage System - Volumes Historical Space
Report . . . . . . . . . . . . . . 1235

Predefined reports about storage tiering . . . . 1236
Running the MDisk Groups - Workload
Activity Report . . . . . . . . . . . 1237
MDisk Groups - Workload Activity Report 1238
Running the MDisk Groups - VDisk Workload
Activity Report . . . . . . . . . . . 1242
MDisk Groups - VDisk Workload Activity
Report . . . . . . . . . . . . . . 1243
Running the MDisk Group - VDisk Workload
Activity Details Report . . . . . . . . . 1247
MDisk Group - VDisk Workload Activity
Details Report . . . . . . . . . . . . 1247
Running the Storage Virtualizer - VDisk
Workload Activity Report . . . . . . . . 1251
Storage Virtualizer - VDisk Workload Activity
Report . . . . . . . . . . . . . . 1252
Running the Storage Resource Group -
VDisk Workload Activity Report . . . . . 1256
Storage Resource Group - VDisk Workload
Activity Report . . . . . . . . . . . 1256

Running the Storage Resource Group - VDisk
Workload Activity Details Report . . . . . 1260
Storage Resource Group - VDisk Workload
Activity Details Report . . . . . . . . . 1261
Running the MDisk Group Details Report . . 1265
MDisk Group Details Report . . . . . . . 1265
Running the VDisk Details Report . . . . . 1268
VDisk Details Report . . . . . . . . . 1268
Running the Volume Migration
Recommendation Report . . . . . . . . 1271
Volume Migration Recommendation Report 1271
Read I/O capability formula . . . . . . . 1272
Changing threshold values in storage tier
reports . . . . . . . . . . . . . . 1274
Threshold values in storage tier reports . . . 1274

Custom reports about performance . . . . . . 1275
Creating custom performance reports in Tivoli
Common Reporting . . . . . . . . . . 1275
Data and properties in performance reports 1277

Custom reports about resources . . . . . . . 1370
Creating custom resource reports in Tivoli
Common Reporting . . . . . . . . . . 1370
Data and properties in resource reports . . . 1376

Troubleshooting reports . . . . . . . . . 1413
Setting up multiple connections to the TPCDB
data source in Tivoli Common Reporting. . . . 1416

Appendix A. Reference . . . . . . . 1419
Alerts and schedules associated with monitoring
groups and templates . . . . . . . . . . 1419
Supported Fabric Agent Types . . . . . . . 1426
Supported storage systems providing full disk
encryption and solid-state drives . . . . . . 1427
Frequently Asked Questions . . . . . . . . 1427

General and Migration Information . . . . 1428
Data Manager . . . . . . . . . . . . 1429
Fabric Manager . . . . . . . . . . . 1429
Disk Manager . . . . . . . . . . . . 1432

Arguments and window locations available with
the inbound launch in context feature . . . . . 1432

Launch in context parameters . . . . . . 1432
Launch in context task parameters . . . . . 1434
Available windows . . . . . . . . . . 1435

Alerts . . . . . . . . . . . . . . . 1438
Triggering conditions for alerts . . . . . . 1439
Alert suppression actions . . . . . . . . 1453
Triggered actions for alerts . . . . . . . 1453
Alert display colors . . . . . . . . . . 1455

Performance data. . . . . . . . . . . . 1457
General performance guidelines . . . . . . 1457
Performance thresholds . . . . . . . . 1457
Performance metrics. . . . . . . . . . 1468

Protocols and standards . . . . . . . . . 1490
Web Based Enterprise Management . . . . 1490
Storage Management Initiative Specification 1491
Service Location Protocol . . . . . . . . 1492
Simple Network Management Protocol . . . 1492
Fibre Channel Methodologies of Interconnects 1493

Contents vii



Appendix B. Accessibility features
for Tivoli Storage Productivity Center 1495

Appendix C. Accessibility features
for Tivoli Storage Productivity Center
for Replication . . . . . . . . . . 1497

Notices . . . . . . . . . . . . . 1501
Trademarks . . . . . . . . . . . . . 1503

Glossary . . . . . . . . . . . . . 1505

Index . . . . . . . . . . . . . . 1511

viii IBM Tivoli Storage Productivity Center: User's Guide



Figures

1. Tivoli Storage Productivity Center components 11
2. Navigation tree . . . . . . . . . . . 23
3. Content pane . . . . . . . . . . . . 24
4. User roles in Tivoli Storage Productivity

Center . . . . . . . . . . . . . . 68
5. A SAN Volume Controller node . . . . . 127
6. Example of a SAN Volume Controller in a

fabric . . . . . . . . . . . . . . 128
7. Physical disks and managed disks (MDisks) 128
8. MDisk group . . . . . . . . . . . 130
9. Managed disk groups and VDisks . . . . 133

10. High-level architecture . . . . . . . . 139
11. Global security page, configure federated

repositories . . . . . . . . . . . . 235
12. Federated repositories page, Manage

repositories . . . . . . . . . . . . 235
13. Manage repositories page, Add a new

repository. . . . . . . . . . . . . 236
14. Manage repositories > New page . . . . . 237
15. Global security > Federated repositories page,

Add base entry to realm . . . . . . . . 237
16. Global security > Federated repositories >

Repository reference page, Add base entry to
realm . . . . . . . . . . . . . . 238

17. Launch the WebSphere administrative console 244
18. Opening the Global security page . . . . . 245
19. Configuring the available realm definitions 245
20. Removing the LDAP repository . . . . . 246
21. Managing the repositories . . . . . . . 246
22. Deleting the LDAP repository . . . . . . 247
23. Master and subordinate server architecture 281
24. Editing the CIMOM discovery job (Options

tab) . . . . . . . . . . . . . . . 334
25. Editing the CIMOM discovery job (When to

Run tab) . . . . . . . . . . . . . 334
26. Checking storage subsystems . . . . . . 335
27. File Filters tab, pop-up menu . . . . . . 357
28. Create Condition window . . . . . . . 358
29. Create Group Window . . . . . . . . 358
30. File Filter window . . . . . . . . . . 359
31. Alert History page . . . . . . . . . . 400
32. Detail for Alert page . . . . . . . . . 400

33. Enabling or disabling the alert overlay 401
34. Using the pop-up menu to view alerts in the

table view . . . . . . . . . . . . 402
35. Viewing alerts by using the Alert tab in the

table view . . . . . . . . . . . . 402
36. Snapshot selection panel . . . . . . . . 406
37. Icons and colors of the change overlay 408
38. The Create Analyzer window . . . . . . 411
39. Topology overview . . . . . . . . . 501
40. Minimap . . . . . . . . . . . . . 502
41. Computer group . . . . . . . . . . 503
42. Data Path Explorer view . . . . . . . . 524
43. Connections . . . . . . . . . . . . 533
44. Highlighted entity . . . . . . . . . . 536
45. Pinned entity . . . . . . . . . . . 537
46. Storage-Subsystem Details page . . . . . 554
47. Virtual Disks page . . . . . . . . . . 566
48. Virtual-Disk Details page . . . . . . . 568
49. Volumes page . . . . . . . . . . . 570
50. Sample Invoice — OS Storage Usage By User 618
51. Sample Invoice — OS Disk Capacity by

Computer. . . . . . . . . . . . . 619
52. Sample Invoice — Storage Usage by Database

User . . . . . . . . . . . . . . 620
53. Sample Invoice — Total Size by

Database-Tablespace . . . . . . . . . 621
54. Chart Generation . . . . . . . . . . 814
55. Tabs . . . . . . . . . . . . . . 817
56. Trending with Historical Data . . . . . . 818
57. History Chart for File System Used Space 820
58. Selection Resources window . . . . . . 824
59. Usage Reporting—Access Load—Access

Time—Chart Network Wide . . . . . . 921
60. Usage Reporting—Access Load—Modification

Time—Chart Network Wide . . . . . . 921
61. Usage Reporting—Files—File Size

Distribution—File Count Chart Tab . . . . 925
62. Managed SAN overview report . . . . . 1138
63. Managed SAN Health report . . . . . . 1139
64. TPC Server overview report . . . . . . 1140
65. TPC Server overview report . . . . . . 1141

© Copyright IBM Corp. 2001, 2012 ix



x IBM Tivoli Storage Productivity Center: User's Guide



Tables

1. Locations of publications for Tivoli Storage
Productivity Center and related products . . xiv

2. Tivoli Storage Productivity Center summary of
functions . . . . . . . . . . . . . 12

3. Functions with each Tivoli Storage
Productivity Center license . . . . . . . 13

4. Available reports with each IBM Tivoli Storage
Productivity Center license . . . . . . . 16

5. Tivoli Storage Productivity Center licenses
when you upgrade from Version 4 to Version 5 18

6. Available configuring and administering tasks
in each GUI . . . . . . . . . . . . 20

7. Available monitoring tasks in each GUI 21
8. Available alerting tasks in each GUI . . . . 21
9. Available reporting tasks in each GUI . . . . 22

10. Available reporting information in each GUI 22
11. Functions that require components to be

licensed and installed . . . . . . . . . 68
12. GUI nodes that require special roles or licenses 69
13. Basic HyperSwap . . . . . . . . . . 76
14. FlashCopy . . . . . . . . . . . . . 76
15. Snapshot . . . . . . . . . . . . . 77
16. Metro Mirror Single Direction . . . . . . 77
17. Metro Mirror Failover/Failback . . . . . . 78
18. Metro Mirror Failover/Failback with Practice 78
19. Global Mirror Single Direction . . . . . . 79
20. Global Mirror Either Direction with Two-Site

Practice . . . . . . . . . . . . . . 79
21. Global Mirror Failover/Failback . . . . . 80
22. Global Mirror Failover/Failback with Practice 80
23. Metro Global Mirror . . . . . . . . . 81
24. Metro Global Mirror with Practice . . . . . 81
25. Roles and authorization levels . . . . . . 125
26. Managed disk group states . . . . . . . 131
27. Capacities of the cluster given extent size 132
28. Role-pair states at the completion of each step

(participating and nonparticipating role pairs) 171
29. Role-pair states at the completion of each step

(participating and nonparticipating role pairs) 172
30. Role-pair states at the completion of each step

(participating and nonparticipating role pairs) 174
31. Required user ID for initial log on after

installation on a single server when the
common user and a separate user for Tivoli
Integrated Portal and Tivoli Common
Reporting are defined . . . . . . . . . 182

32. Required user ID for initial log on after
installation on multiple servers with a remote
database schema . . . . . . . . . . 182

33. Required user ID for initial log on after
installation on multiple servers with remote
Tivoli Integrated Portal and Tivoli Common
Reporting . . . . . . . . . . . . . 183

34. Discovery types, their data sources, and
top-level entities that are discovered . . . . 325

35. Information collected by agent . . . . . . 328

36. Supported SMI agent profiles and subprofiles 330
37. Icons and colors of the change overlay 407
38. Maximum volume name lengths for storage

systems . . . . . . . . . . . . . 423
39. Descriptions of policy types and their

triggering conditions . . . . . . . . . 443
40. Group locations in the topology viewer 504
41. Topology status indicators and their icons 513
42. Internal resources that are used to determine

the status of top-level resources . . . . . 516
43. Propagation of the statuses for internal

resources in the stand-alone GUI . . . . . 518
44. Categories of operational status for storage

entities . . . . . . . . . . . . . . 518
45. Fabric resources that you can monitor in the

web-based GUI . . . . . . . . . . . 625
46. Hypervisor resources that you can monitor in

the web-based GUI . . . . . . . . . 625
47. Server resources that you can monitor in the

web-based GUI . . . . . . . . . . . 626
48. Storage system resources that you can

monitor in the web-based GUI . . . . . . 627
49. Switch resources that you can monitor in the

web-based GUI . . . . . . . . . . . 628
50. Possible statuses of monitored resources 635
51. Internal resources that are used to determine

the status of top-level resources . . . . . 637
52. Propagation of the statuses for internal

resources in the web-based GUI . . . . . 638
53. Possible severities of alerts . . . . . . . 649
54. Session state change traps . . . . . . . 666
55. Configuration change traps . . . . . . . 667
56. Suspending-event notification traps . . . . 667
57. Communication-failure traps . . . . . . 668
58. Management Servers state-change traps 668
59. Basic HyperSwap . . . . . . . . . . 697
60. FlashCopy . . . . . . . . . . . . 697
61. Snapshot . . . . . . . . . . . . . 698
62. Metro Mirror Single Direction . . . . . . 698
63. Metro Mirror Failover/Failback . . . . . 699
64. Metro Mirror Failover/Failback with Practice 699
65. Global Mirror Single Direction . . . . . . 700
66. Global Mirror Either Direction with Two-Site

Practice . . . . . . . . . . . . . 700
67. Global Mirror Failover/Failback . . . . . 701
68. Global Mirror Failover/Failback with Practice 701
69. Metro Global Mirror . . . . . . . . . 702
70. Metro Global Mirror with Practice . . . . 702
71. Basic HyperSwap commands . . . . . . 729
72. FlashCopy commands. . . . . . . . . 730
73. Snapshot session commands . . . . . . 730
74. Snapshot group commands . . . . . . . 731
75. Metro Mirror commands . . . . . . . . 731
76. Metro Mirror with Practice commands 733
77. Global Mirror commands . . . . . . . 734
78. Global Mirror with Practice commands 736

© Copyright IBM Corp. 2001, 2012 xi



79. Metro Global Mirror commands . . . . . 737
80. Metro Global Mirror with Practice commands 740
81. Session status icons . . . . . . . . . 766
82. Volume role symbols . . . . . . . . . 767
83. Data copying symbols . . . . . . . . 767
84. Session states . . . . . . . . . . . 769
85. Detailed status messages for Participating and

Non-Participating role pairs. . . . . . . 784
86. Information about clusters associated with a

Storwize V7000 Unified storage system or an
IBM SONAS system . . . . . . . . . 849

87. Information about nodes associated with a
Storwize V7000 Unified storage system or an
IBM SONAS system . . . . . . . . . 849

88. Information about pools associated with a
Storwize V7000 Unified storage system or an
IBM SONAS system . . . . . . . . . 850

89. Information about a selected NSD associated
with a Storwize V7000 Unified storage system
or an IBM SONAS system . . . . . . . 851

90. Information about a selected NSD associated
with a Storwize V7000 Unified storage system 851

91. Information about the relationship between a
selected NSD and an associated virtual disk
or volume on a Storwize V7000 Unified
storage system . . . . . . . . . . . 852

92. Information about a selected file system
associated with a Storwize V7000 Unified
storage system or an IBM SONAS system . . 854

93. Information about a selected file set
associated with a Storwize V7000 Unified
storage system or an IBM SONAS system . . 854

94. Information about a selected export
associated with a Storwize V7000 Unified
storage system or an IBM SONAS system . . 855

95. NFS protocols for a selected export associated
with a Storwize V7000 Unified storage system
or an IBM SONAS system . . . . . . . 856

96. CIFS protocols for a selected export
associated with a Storwize V7000 Unified
storage system or an IBM SONAS system . . 856

97. Information about a directory associated with
a Storwize V7000 Unified storage system or
an IBM SONAS system . . . . . . . . 857

98. Predefined monitoring groups, templates,
schedules, and alerts for storage subsystems . 1420

99. Predefined monitoring groups, templates,
schedules, and alerts for fabrics . . . . . 1422

100. Predefined monitoring groups, templates,
schedules, and alerts for computers . . . . 1423

101. Predefined monitoring groups, templates,
and schedules for tape libraries1 . . . . . 1425

102. Supported agent types for Switch and Fabric
Functions . . . . . . . . . . . . 1426

103. Interop Namespaces for CIM Agents for
switches and storage systems . . . . . . 1428

104. Supported agent types for Switch and Fabric
Functions . . . . . . . . . . . . 1429

105. Available windows for inbound launch in
context . . . . . . . . . . . . . 1435

106. Triggering conditions and related error
messages for computer alerts . . . . . . 1439

107. Triggering conditions and related error
messages for file system alerts . . . . . 1440

108. Triggering conditions and related error
messages for directory alerts . . . . . . 1442

109. Triggering conditions and related error
messages for instance alerts . . . . . . 1442

110. Triggering conditions and related error
messages for database-tablespace alerts . . 1443

111. Triggering conditions and related error
messages for table alerts . . . . . . . 1444

112. Triggering conditions and related error
messages for storage-system alerts . . . . 1444

113. Triggering conditions and related error
messages for fabric alerts . . . . . . . 1448

114. Triggering conditions and related error
messages for switch alerts . . . . . . . 1449

115. Triggering conditions and related error
messages for endpoint device alerts. . . . 1450

116. Triggering conditions and related error
messages for hypervisor alerts . . . . . 1451

117. Triggering conditions and related error
messages for NAS alerts . . . . . . . 1451

118. Alert colors . . . . . . . . . . . . 1455
119. Array thresholds . . . . . . . . . . 1459
120. Controller thresholds . . . . . . . . 1463
121. Port thresholds . . . . . . . . . . 1464

xii IBM Tivoli Storage Productivity Center: User's Guide



Preface

IBM® Tivoli® Storage Productivity Center is a storage infrastructure management
software product that can centralize, automate, and simplify the management of
complex and heterogeneous storage environments.

Who should read this guide
The audience of this publication is administrators or users who have already
installed the product and are now using IBM Tivoli Storage Productivity Center.
This publication provides an overview of how to use the product and detailed
information about various topics.

Administrators and users must be familiar, or become familiar, with the following
concepts:
v IBM DB2
v IBM Tivoli Common Reporting
v IBM Tivoli Enterprise Console®

v IBM Tivoli Integrated Portal
v Storage Area Network (SAN)
v Simple Network Management Protocol (SNMP)
v Tivoli Storage Productivity Center
v Tivoli Storage Productivity Center for Replication

Publications
This section lists publications in the IBM Tivoli Storage Productivity Center library
and other related publications. It also describes how to access publications online,
how to order publications, and how to submit comments on publications.

The publications are available from the IBM Publications Center at
http://www.ibm.com/e-business/linkweb/publications/servlet/pbi.wss.

Accessing publications online
Publications for this product and other related products are available online.

Information about installing, configuring, upgrading, and uninstalling IBM Tivoli
Storage Productivity Center and related products is available online. Use Table 1 on
page xiv to view and download these publications. Translated documents are
available for some products.

© Copyright IBM Corp. 2001, 2012 xiii

http://www.ibm.com/e-business/linkweb/publications/servlet/pbi.wss


Table 1. Locations of publications for Tivoli Storage Productivity Center and related products

Product Online location (see Note)

IBM Tivoli Storage
Productivity Center
and
IBM Tivoli Storage
Productivity Center for
Replication

http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/
index.jsp. In the left-hand navigation pane, click IBM
Tivoli Storage Productivity Center.

To obtain PDF documents, click IBM Tivoli Storage
Productivity Center > Printable documentation.

To view previous versions of the IBM Tivoli Storage
Productivity Center Information Center, from the main
page click Community and Support > Previous Versions.

IBM Tivoli Storage
Productivity Center for
Replication for System z®

http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/
index.jsp. In the left-hand navigation pane, click IBM
Tivoli Storage Productivity Center for Replication for
System z.

To obtain PDF documents, click IBM Tivoli Storage
Productivity Center for Replication for System z >
Printable documentation.

To view previous versions of the IBM Tivoli Storage
Productivity Center for Replication Information Center,
from the main page, click Community and Support >
Previous Versions.

IBM WebSphere® Application
Server

v http://publib.boulder.ibm.com/infocenter/wasinfo/
v7r0/index.jsp

v http://publib.boulder.ibm.com/infocenter/wasinfo/
v8r0/index.jsp

IBM System Storage®

Productivity Center
http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/
index.jsp. In the left-hand navigation pane, click System
Storage Productivity Center.

To obtain PDF documents, click System Storage
Productivity Center > Printable documentation.

To view previous versions of the IBM System Storage
Productivity Center Information Center, from the main
page click Community and Support > Previous Versions.

IBM System Storage DS3000,
IBM System Storage DS4000®,
or IBM System Storage
DS5000

http://www.ibm.com/support/entry/portal/

IBM System Storage DS6000™ http://publib.boulder.ibm.com/infocenter/dsichelp/
ds6000ic/index.jsp

IBM System Storage DS8000® http://publib.boulder.ibm.com/infocenter/dsichelp/
ds8000ic/index.jsp

IBM System Storage DS®

Open Application
Programming Interface
publications

http://www.ibm.com/support/entry/portal/
Troubleshooting/Hardware/System_Storage/
Storage_software/Other_software_products/
CIM_Agent_for_DS_Open_(API)/

Use these publications for information about how to install,
configure, and use the CIM agent.

IBM System Storage SAN
Volume Controller

http://publib.boulder.ibm.com/infocenter/svc/ic/index.jsp
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Table 1. Locations of publications for Tivoli Storage Productivity Center and related
products (continued)

Product Online location (see Note)

IBM Storwize® V7000 http://publib.boulder.ibm.com/infocenter/storwize/ic/
index.jsp

IBM Storwize V7000 Unified http://publib.boulder.ibm.com/infocenter/storwize/
unified_ic/index.jsp

IBM XIV® Storage System http://publib.boulder.ibm.com/infocenter/ibmxiv/r2/
index.jsp

IBM DB2® Database for
Linux, UNIX, and Windows

http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/
index.jsp

IBM System Storage N series http://www.ibm.com/systems/storage/network/
redbooks.html

For more information about IBM System Storage N series,
see http://www.ibm.com/systems/storage/network/
software/.

IBM Systems Director http://www.ibm.com/systems/software/director/
index.html

Note: If you print PDF documents on other than letter-sized paper, in the Print window
select Fit to Printable Area in the Page Scaling field. This option is available when you
click File > Print. Fit to Printable Area ensures that the full dimensions of a letter-sized
page print on the paper that you are using.

IBM Redbooks
The IBM Redbooks® are books on specialized topics.

You can order publications through your IBM representative or the IBM branch
office serving your locality. You can also search for and order books of interest to
you by visiting the IBM Redbooks home page at http://www.redbooks.ibm.com/
redbooks.

Translation
Translated publications are available from the information center which is available
in certain translated languages. It is displayed in the language that is appropriate
for the browser locale setting.

When a locale does not have a translated version, the information center is
displayed in English, which is the default language. Translations of the PDFs are
available when the information center is translated.

Contact your service representative for more information about the translated
publications and whether translations are available in your language.

Ordering publications
Information is provided for the ordering of IBM publications on the Internet or by
telephone.

You can order many IBM publications online at http://www.ibm.com/e-business/
linkweb/publications/servlet/pbi.wss.
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You can also order by telephone. In the United States and Canada, call
800-879-2755. In other countries, contact your IBM service representative.

Providing feedback about publications
Your feedback is important to help IBM provide the highest quality information.
You can provide comments or suggestions about the documentation from the IBM
Tivoli Storage Productivity Center Information Center.

Go to the information center at http://publib.boulder.ibm.com/infocenter/
tivihelp/v59r1/index.jsp. From any topic page, click the Feedback link.

Conventions used in this guide
This section provides information about the conventions used in this publication.

This publication uses several conventions for special terms and actions, and
operating system-dependent commands and paths.

The following typeface conventions are used in this publication:

Bold

v Flags that appear with text
v Graphical user interface (GUI) elements (except for titles of windows

and dialogs)
v Names of keys

Italic

v Variables
v Values you must provide
v New terms
v Words and phrases that are emphasized
v Titles of documents

monospace

v Commands and command options
v Flags that appear on a separate line
v Code examples and output
v Message text
v Names of files and directories
v Text strings you must type, when they appear within text
v Names of Java methods and classes
v HTML and XML tags also appear like this, in monospace type

For syntax notations, remember the following:
v In UNIX, the prompt for the root user is #.
v In UNIX and Linux, the commands are case sensitive, so you must type

commands exactly as they are shown.

Contacting the IBM Support Center
You can contact IBM Support Center in several ways.
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v Go to the IBM Tivoli Storage Productivity Center technical support website at
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/
Tivoli_Storage_Productivity_Center_Standard_Edition.
To receive future support notifications, sign in under Notifications. You are
required to enter your IBM ID and password. After you are authenticated, you
can configure your subscription for Tivoli Storage Productivity Center technical
support website updates.

v Customers in the United States can call 1-800-IBM-SERV (1-800-426-7378).
v For international customers, go to the Tivoli Storage Productivity Center

technical support website to find support by country. Expand Contact support
and click Directory of worldwide contacts.

You can also review the IBM Software Support Handbook, which is available at
http://www14.software.ibm.com/webapp/set2/sas/f/handbook/home.html.

The support website offers extensive information, including a guide to support
services; frequently asked questions (FAQs); and documentation for all IBM
Software products, including Redbooks and white papers. Translated documents
are also available for some products.

When you contact the IBM Support Center, be prepared to provide identification
information for your company so that support personnel can readily assist you.
Company identification information might also be needed to access various online
services available on the website. See “Reporting a problem.”

Reporting a problem
This topic provides a list of what information you should have ready when you
encounter a problem.

Have the following information ready when you report a problem:
v The IBM Tivoli Storage Productivity Center version, release, modification, and

service level number.
v The communication protocol (for example, TCP/IP), version, and release number

that you are using.
v The activity that you were doing when the problem occurred, listing the steps

that you followed before the problem occurred.
v The exact text of any error messages.
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New for Tivoli Storage Productivity Center Version 5.1

Learn about new features and enhancements in IBM Tivoli Storage Productivity
Center Version 5.1.

New Features

The following features are new in Tivoli Storage Productivity Center 5.1:

Graphical user interfaces
Tivoli Storage Productivity Center provides two graphical user interfaces
for managing the storage infrastructure in an enterprise environment: the
stand-alone GUI and the web-based GUI. Each GUI provides different
functions for working with monitored resources.

To view a comparison of the functions that are available in each GUI, see
“Available functions and report information in the interfaces” on page 19.

Viewing reports from the web-based GUI
From the web-based GUI, you can now run the following types of report
in Tivoli Common Reporting:

Resources reports
Show the relationships between storage resources in your
environment. Resources reports also provide a snapshot of the
capacity, available space, and used space on servers, storage
virtualizers, storage systems, and related storage resources.

Performance reports
Show performance statistics for the most active storage resources in
your environment over a specified period. Performance reports
also provide detailed statistics for specific storage resources.

Historical space reports
Show how space is used over a specified period on storage
virtualizers, storage systems, and related storage resources.

Storage tiering reports
Show volumes that might require migration from a pool in a
storage resource group to a pool in another storage resource group.
You also use the Tivoli Storage Productivity Center web-based GUI
to view the workload activity reports for managed disk groups and
virtual disks.

Creating and designing reports from the web-based GUI
From the web-based GUI, you can create custom reports and design
custom reports. You can create and design the reports in report tools in
Tivoli Common Reporting.

Custom reports can contain detailed information about the relationships
between monitored resources, the properties of monitored resources, and
detailed information about the performance of monitored resources. Unlike
predefined reports, you can select the information that you want to include
in custom reports.

You can create reports with basic formatting, or you can design more
complex reports with advanced formatting features. The advanced
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formatting features include inserting charts that you can customize in
reports, and inserting links that open related reports.

Installing Tivoli Storage Productivity Center
You can install Tivoli Storage Productivity Center in one of the following
ways:

Installation wizard
The installation wizard provides a graphical user interface for
installation.

Command-line interface by using silent mode
In silent mode, you run a command and provide the installation
values in a response file. A silent-mode installation is useful if your
system is running from a terminal that cannot display graphics.

Installation configurations
When you install Tivoli Storage Productivity Center, your system can be
configured in one of the following ways:

Single server
All Tivoli Storage Productivity Center components are installed on
one server.

Multiple servers
In the multiple-servers environment, you can have these
configurations:
v DB2 and the Tivoli Storage Productivity Center database

repository on a remote server and the rest of the Tivoli Storage
Productivity Center components on a local server.

v DB2 and the Tivoli Storage Productivity Center servers,
stand-alone GUI, command-line interface, and Storage Resource
agent on one server, and IBM Tivoli Integrated Portal, Tivoli
Common Reporting, and web-based GUI on a remote server.

Installation components
When you install Tivoli Storage Productivity Center, the following
components are included:
v Database repository
v Data server
v Device server
v Replication server
v Stand-alone graphical user interface
v Web-based graphical user interface
v Command-line interface
v Storage Resource agent
v Tivoli Integrated Portal Version 2.2
v Tivoli Common Reporting Version 2.1.1

Lightweight Directory Access Protocol
You no longer have to configure Lightweight Directory Access Protocol
(LDAP) as an authentication method during the installation. You configure
LDAP as a post-installation task. The Tivoli Storage Productivity Center
installation program establishes a default authentication configuration by
using the federated repositories feature of the WebSphere Application
Server.
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For more information about LDAP and how to add an LDAP repository,
see the Tivoli Storage Productivity Center information center and search
for Administering Tivoli Integrated Portal.

Tivoli Storage Productivity Center licenses
The following licenses are available in Tivoli Storage Productivity Center
5.1:

IBM Tivoli Storage Productivity Center
This license contains the following functions:
v Data management. Data management includes enterprise-wide

reporting and monitoring, and automated capacity provisioning
for direct-attached storage (DAS), network-attached storage
(NAS), and storage area networks (SAN) environments.

v Disk management. Disk management helps you manage SANs
and heterogeneous storage from one console.

v Fabric management. Fabric management helps you manage the
SAN fabric that connects the host systems and applications to
the storage devices. This feature includes automatic resource and
topology discovery, monitoring, alerts, and zone control.

v Tape management. Tape management helps you manage your
tape libraries that must be SMI-S compliant.

Tivoli Storage Productivity Center for Replication
All of the Tivoli Storage Productivity Center for Replication
functions, including the functions that were previously in the Two
Site and Three Site Business Continuity licenses.
v Performance management. Disk and Fabric performance

management functions.
v Device support. For the devices that you can use with Tivoli

Storage Productivity Center, see http://www.ibm.com/support/
docview.wss?rs=40&uid=swg21386446.

IBM Tivoli Storage Productivity Center Select Edition
This license contains all the functions of the IBM Tivoli Storage
Productivity Center license.

IBM Tivoli Storage Productivity Center Advanced
This license contains all the functions in the Tivoli Storage
Productivity Center license plus these additional analytical
functions:
v Configuration Analysis
v Configuration History
v SAN Planner
v Storage Optimizer

Tivoli Storage Productivity Center for data-related functions

v Scans
v Policy management
v Server probes
v Profiles
v Data Manager for Databases
v Data Manager for Chargeback
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IBM Scale Out Network Attached Storage
IBM Scale Out Network Attached Storage (IBM SONAS) manages
repositories of information in enterprise environments that require
large capacities, high levels of performance, and high availability.
IBM SONAS uses up 2 petabytes (PB) of storage in a large file
system.

Policy-based storage tier reports

Use the Tivoli Storage Productivity Center command-line interface
to issue commands that create user-defined storage tiering policies.
Storage tiering policies set the conditions that must be met to
determine whether a volume requires migration to another pool.

New for Tivoli Storage Productivity Center for Replication
Version 5.1

Use this information to learn about new features and enhancements in IBM Tivoli
Storage Productivity Center for Replication Version 5.1. This information highlights
the changes since the last release of Tivoli Storage Productivity Center for
Replication.

Failover operations that are managed by other applications
Applications such as the IBM Series i Toolkit, VMware Site Recovery
Manager, and Veritas Cluster Server manage failover operations for certain
session types and storage systems. If an application completes a failover
operation for a session, the Severe status is displayed for the session. An
error message is also generated for the role pairs for which the failover
occurred.

For more information, see “Failover and failback operations” on page 695.

Additional support for space-efficient volumes in remote copy Tivoli Storage
Productivity Center for Replication sessions

You can use extent space-efficient volumes as copy set volumes for the
following IBM System Storage DS8000 session types:
v FlashCopy® (System Storage DS8000 6.2 or later)
v Metro Mirror (System Storage DS8000 6.3 or later)
v Global Mirror or Metro Global Mirror (System Storage DS8000 6.3 or

later)

For more information, see “Copy sets” on page 690.

New features
The following features are new for Tivoli Storage Productivity Center for
Replication version 5.1.

Reflash After Recover option for Global Mirror Failover/Failback with
Practice sessions

You can use the Reflash After Recover option with System Storage
DS8000 version 4.2 or later. Use this option to create a FlashCopy
replication between the I2 and J2 volumes after the recovery of a
Global Mirror Failover/Failback with Practice session. If you do
not use this option, a FlashCopy replication is created only
between the I2 and H2 volumes.

For more information, see “Session properties” on page 771.
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No Copy option for Global Mirror Failover/Failback with Practice and
Metro Global Mirror with Practice sessions

You can use the No Copy option with System Storage DS8000
version 4.2 or later. Use this option if you do not want the
hardware to write the background copy until the source track is
written to.

For more information, see “Session properties” on page 771.

Recovery Point Objective Alerts option for Global Mirror sessions
You can use the Recovery Point Objective Alerts option with IBM
TotalStorage Enterprise Storage Server® Model 800, System Storage
DS8000, and System Storage DS6000. Use this option to specify the
length of time that you want to set for the recovery point objective
(RPO) thresholds. The values determine whether a Warning or
Severe alert is generated when the RPO threshold is exceeded for a
role pair. The RPO represents the length of time in seconds of data
exposure that is acceptable in the event of a disaster.

For more information, see “Session properties” on page 771.

StartGC H1->H2 command for Global Mirror sessions
You can use the StartGC H1->H2 command with TotalStorage
Enterprise Storage Server Model 800, System Storage DS8000, and
System Storage DS6000. This command establishes Global Copy
relationships between site 1 and site 2, and begins asynchronous
data replication from H1 to H2.

This command is available only for Global Mirror
Failover/Failback and Global Mirror Failover/Failback with
Practice sessions.

For more information about this command, see “Session
commands” on page 729.

Export Global Mirror Data command for Global Mirror role pairs
You can use this option to export data for a Global Mirror role pair
that is in a session to a comma-separated value (CSV) file. You can
then use the data in the CSV file to analyze trends in your storage
environment that affect your recovery point objective (RPO).

For more information, see “Exporting historical data for Global
Mirror role pairs” on page 757.

New chsess command parameters
The command-line interface command chsess has new parameters:
v -reflash

v -dsRPOwarning

v -dsRPOsevere

v -enableHardenedFreeze

For more information, go to the Tivoli Storage Productivity Center
for Replication information center at http://
publib.boulder.ibm.com/infocenter/tivihelp/v59r1/index.jsp and
search for chsess.
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Related tasks:
“Running the Volume Migration Recommendation Report” on page 1271
To see volumes that might require migration to other pools, run the Volume
Migration Recommendation Report.
Related reference:
“Volume Migration Recommendation Report” on page 1271
The Volume Migration Recommendation Report, shows the volumes that comply
with the criteria for migrating volumes to a pool in another storage resource
group. Use the report to identify volumes that might require migration based on
the conditions that are set in tiering policies.
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Chapter 1. Getting started

Use this task list as a getting started guide for installing and using IBM Tivoli
Storage Productivity Center. The tasks are in sequential order to help you learn
how the product works and how to get started administering and managing your
storage environment.

Complete the following tasks as shown and click the included links to learn more
about the capabilities of Tivoli Storage Productivity Center. Follow the tasks as
outlined: planning, installing, configuring, administering, managing storage
devices, and reporting. Troubleshooting contains procedures for debugging any
problems that you might encounter.

Learn more: See the topics about planning and installing the Tivoli Storage
Productivity Center in the IBM Tivoli Storage Productivity Center Information
Center (http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/index.jsp).

Task Description
When and how often must I perform this
task?

Determine
prerequisites and
plan for installation.

The first installation task is planning for
Tivoli Storage Productivity Center. The time
you invest in planning directly affects your
ease of implementation. Planning includes:

v Ensuring that your systems meet hardware
and software requirements

v Determining where to deploy Storage
Resource agents

v Ensuring that ports are open for use by
Tivoli Storage Productivity Center
components

v Granting privileges to the user ID used to
install the Tivoli Storage Productivity
Center components

v Setting up for LDAP Support

Perform this task before you install Tivoli
Storage Productivity Center.

Install Tivoli Storage
Productivity Center.

The second task is installing Tivoli Storage
Productivity Center.

You can install all the Tivoli Storage
Productivity Center components using typical
installation or custom installation. It is
recommended that for a production
environment you use custom installation.

Tivoli Storage Productivity Center has the
following installable components:

v Database schema

v Data server

v Device server

v Graphical user interface (GUI)

v Command-line interface (CLI)

v Storage Resource agent

v IBM Tivoli Integrated Portal

Perform this task after you have completed
planning and ensuring that you meet the
installation prerequisites. You can also install
components separately depending on your
needs, so you might perform a portion of the
installation process a number of times after
the initial installation. For example, you can
install Storage Resource agents at any time
on the computers whose storage you want to
monitor.
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Task Description
When and how often must I perform this
task?

Start and Configure
Tivoli Storage
Productivity Center.

Perform this task after installing Tivoli
Storage Productivity Center to configure it
according to the standards within your
organization, including:

v Starting the Tivoli Storage Productivity
Center GUI.

v Running the Configuration Utility as a
guide to help you through the steps
required to configure and manage Tivoli
Storage Productivity Center for your
environment.

v Using the Help menu to access the online
help system, launch the product
information center, and access information
about the appropriate levels of software,
firmware, and hardware that is needed to
run the product.

v Assigning roles to individuals who use the
product.

v Entering licensing information.

v Setting SNMP and e-mail alerts.

v Entering retention settings for log files,
resource history, and removed resources.

v Defining rules for generating e-mail
addresses of quota violators.

v Scheduling history aggregation and agent
upgrades.

v Setting up NAS filer access.

v Setting up IBM TotalStorage Enterprise
Storage Server or SAN Volume Controller
access.

v Using configuration history to analyze
historical data that identifies possible
problems with a storage area network
(SAN) configuration.

v Using configuration analysis to determine
whether an existing SAN configuration
complies with predefined best practices.

Typically, you perform this step immediately
after installing the product. Once Tivoli
Storage Productivity Center is configured,
you do not have to perform this step again
unless changes within your organization
require it.

2 IBM Tivoli Storage Productivity Center: User's Guide



Task Description
When and how often must I perform this
task?

Administer DB2 and
Tivoli Storage
Productivity Center.

Once Tivoli Storage Productivity Center is
installed and configured, perform the
following administrative tasks as needed:

v Authorizing users.

v Managing Agent Manager.

v Administering data sources (agents):
CIMOM, Data, Storage Resource, Inband
Fabric, Out of Band Fabric, Storage
Subsystems, TPC Servers, VMWare VI.

v Starting and stopping Tivoli Storage
Productivity Center services

v Increasing the memory allocation and
checking the status of Tivoli Storage
Productivity Center components.

v Setting timeout values for the Device
server.

v Changing passwords for Tivoli Storage
Productivity Center components

v Configuring the launch of the IBM Tivoli
Storage Productivity Center for Replication
GUI and other web GUIs or local
executable files.

v Collecting information with the service
tool.

Perform administrative tasks at any time
during the use of Tivoli Storage Productivity
Center. These tasks are meant to provide you
with the tools to maintain a successful
implementation of the product during its
lifecycle.

Configure storage
devices for
monitoring

Before you can use Tivoli Storage
Productivity Center to monitor the storage
devices in your environment, you must
configure them within the user interface.
Configuring devices includes the following
tasks:

v Discovering storage devices.

v Including storage devices in monitoring
groups (optional).

v Defining data collection schedules.

v Determining the conditions that must
occur before you are alerted to a problem
related to the devices you are monitoring.

There are two methods for configuring
storage devices in Tivoli Storage Productivity
Center

v Use the Configure Devices wizard to guide
you through the steps of configuring
devices. The wizard is available under the
IBM Tivoli Storage Productivity Center
node in the navigation tree.

v Manually configure devices using the
corresponding nodes in the navigation tree.

The following rows in the table provide more
information about these tasks.

Perform this task when you want to
configure storage devices for monitoring by
Tivoli Storage Productivity Center. You can
configure devices that are already known to
Tivoli Storage Productivity Center but not
included in a probe schedule, or configure
devices that have not yet been discovered.
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Task Description
When and how often must I perform this
task?

Configure storage
devices: running
discovery schedules

Perform discovery to detect the storage
devices and network topology within your
environment. Discovery schedules collect
basic information about the storage devices,
including computers, CIMOMs, storage
subsystems, fabrics, filers, clusters, and tape
libraries.

To discover storage devices, use either of the
following methods:

v Use the discovery step in the Configure
Devices wizard to automate the detection
of storage devices.

v Go to the Administrative Services >
Discovery node in the navigation tree and
manually define a schedule for the device
type that you want to detect.

You must run discovery schedules before you
can collect more detailed information about
storage resources. Once discovery has run,
use data collection schedules such as probes,
scans, and pings to collect more detailed
information about the discovered storage
devices.

See Discover resources in your system for
more information.

Configure storage
devices: defining
monitoring groups for
the related storage
devices in your
environment

Organize related storage devices into groups
(optional). Use groups when you want to
perform the same action against multiple
devices. For example, if you create a group
that contains all the storage systems for the
Sales division within your organization, you
can include that group in a data collection
schedule. The schedule then collects
information about the all the storage systems
in the Sales group without requiring you to
add them individually to a schedule.

As new devices are introduced into the
environment, you can add them to existing
groups. The same actions that are already
associated with the group are then applied to
the new devices.

To create groups, use either of the following
methods:

v Use the monitoring group step in the
Configure Devices wizard to automate the
grouping of devices.

v Use the Monitoring > Groups facility
within each of Tivoli Storage Productivity
Center managers to define a group that
corresponds to that manager. For example,
use Disk Manager to create storage
subsystem monitoring groups; use Fabric
Manager to create fabric groups; use Data
Manager to create computer, file system,
directory, user, and OS user monitoring
groups.

Create monitoring groups before you do the
following:

v Define data collection schedules (probes,
scans, and pings) to collect information
about storage devices.

v Define Data Manager quotas and
constraints to enforce storage policies.

Creating groups is not required, but they are
meant to help you better organize your
storage devices for monitoring in a large
environment.

See the following topics for more
information:

1. “Data collection groups” on page 370

2. “Working with groups of resources” on
page 373
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Task Description
When and how often must I perform this
task?

Configure storage
devices: determining
the information you
want to gather about
the devices in your
environment and
defining data
collection schedules.

Determining what information you want to
gather about the storage devices within your
enterprise is critical to helping you
implement a storage management strategy.

Once you have determined the types of
information you want to collect about your
storage devices, you can use data collection
schedules to gather that information. Use the
following schedules to collect data about
storage devices:

v Probes: collect detailed statistics about
storage devices.

v Scans: collect data about the usage and
trending of your storage consumption.

v Pings: collect information about the
availability (uptime) of computers.

v Storage Subsystem Performance Monitors:
collect statistics about the performance of
storage subsystems.

v Fabric Performance Monitors: collect
statistics about the performance of fabrics.

v TPC Server probes: gather the information
that has been collected by multiple Tivoli
Storage Productivity Center servers.

To create data collection schedules, use either
of the following methods:

v For creating probes and pings, you can use
the data collection step in the Configure
Devices wizard.

v Go to the Monitoring > schedule_name node
available in each manager, where
schedule_name represents the schedule type
(for example, probe, scan, ping,
performance monitor). For example, to
create a scan, go to the Data Manager >
Monitoring > Scan node in the navigation
tree.

Define data collection schedules after you
determine the type of data you want to
collect. You must collect data about storage
devices before you can perform the other
tasks within Tivoli Storage Productivity
Center, such as viewing reports, enforcing
storage policies, setting alerts, using the
topology viewer, and managing storage
subsystems.

After you define a data collection schedule,
you do not need to redefine that schedule in
the future unless you want to add or remove
devices. The schedule runs at the times you
specified in its definition.

See the following topics for more
information:

v Collect data from system resources

v “Collecting storage statistics” on page 337

v “Collecting storage usage and trending
information” on page 346

v “Determining the availability of storage
resources” on page 366

v “Collecting performance data” on page 377

v “Managing fabrics” on page 576

v “Collecting storage statistics from Tivoli
Storage Productivity Center servers” on
page 342
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Task Description
When and how often must I perform this
task?

Configure storage
devices: determining
the conditions that
must occur before you
are alerted to a
problem within your
storage environment.

Determining when and how you are alerted
to conditions within your storage
environment is important to helping you
maintain and administer storage devices.
Tivoli Storage Productivity Center provides
an extensive list of conditions from which
you can choose. See “Triggering conditions
for alerts” on page 1439 for a list of
triggering conditions for storage devices.

When a condition is met and alert is
triggered, you can choose to be notified
through an SNMP trap, IBM Tivoli Enterprise
Console event, login notification, event log
(Windows), syslog (UNIX), or e-mail.

To associate alert conditions with storage
devices, use either of the following methods:

v Use the Configure Devices wizard to guide
you through the steps for associating alert
conditions with the storage devices that
you want to monitor.

v Go to the Alerting node available in each
manager to manually associate a specific
type of alert condition with storage
devices. For example, to associate alert
conditions with computers, go to the Data
Manager > Alerting > Computer Alerts
node in the navigation tree.

Define alerts:

v After defining data collection schedules

v Based on the information gathered by data
collection schedules

Alerts are checked whenever a probe or scan
schedule is collects data about storage
devices. Computer, fabric, switch, and
endpoint alerts are triggered by probes.
Directory and storage subsystem alerts are
triggered by scans. File system free space
alerts are triggered by both probes and scans.
All other file system alerts are triggered only
by probes.

After you define an alert, you do not need to
redefine it in the future (unless you want to
change it). Defining an alert is a one-time
only task.

See “Working with alerts” on page 385 for
more information.
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Task Description
When and how often must I perform this
task?

Manage storage
resources: determining
the storage policies
that you want to
enforce.

Enforcing storage policies within your
organization can be critical to ensuring the
proper and most cost-effective use of your
storage devices. Use the following policy
management functions to set policies for
devices that are monitored by Tivoli Storage
Productivity Center:

v Use quotas to define limits on the amount
of storage that a user or a group of users
can consume.

v Use Network Appliance Quotas to import,
view, and report on the NetApp Quotas
defined on NAS filers.

v Use constraints to define the acceptable
and unacceptable file types, file sizes, and
file owners for a computer or a set of
computers in your environment.

v Use file system extensions to automatically
extend file systems when utilization
reaches a specified threshold.

v Use scheduled actions to run scripts
against storage devices on a schedule that
you define.

A quota runs according to the schedule that
you specified. Because quotas look at the
information gathered by scans to determine
quota violations, you must schedule quotas
to run after the appropriate scan. For
example, if you want to restrict the amount
of space consumed by users on specific
computers, run a scan on those computers to
collect usage information before running the
quota to enforce that usage restriction.

Constraints are automatically checked
whenever a scan is run against the storage
devices to which the constraint applies.

Schedule file system extensions after running
probes of the related storage devices and file
systems.

Run scheduled actions immediately, once at a
specified time, or repeatedly according to a
schedule you specify.

See the following topics for more
information:

1. Creating and enforcing storage policies

2. “Setting storage usage quotas” on page
445

3. “Setting file constraints” on page 470

4. “Scheduling script-based actions” on page
479

Manage storage
devices: working with
storage systems and
fabrics.

Use the following functions to manage the
storage systems and fabrics that are
monitored by Tivoli Storage Productivity
Center:

v Use the Storage Optimizer identify
performance bottlenecks and recommend
changes to improve performance.

v Use the SAN Planner to assist in the
end-to-end planning of fabrics, hosts,
storage controllers, storage pools, volumes,
paths, ports, zones, and zone sets.

v Define storage resource groups to logically
group related storage entities such as hosts,
storage subsystems, fabrics, and switches.

v Define element managers for storage
subsystems.

v Manage virtual disks: assign host ports,
create virtual disks, delete virtual disks,
add a managed disk to a managed-disk
group, view virtual-disk information.

v Manage volumes: assign host ports, create
volumes, delete volumes, view information
about volumes.

You can manage storage subsystems at any
time after collecting information about them
through discovery and monitoring jobs.

See the following topics for more
information:

v “Optimizing storage configurations” on
page 432

v “Planning and modifying storage
configurations” on page 419

v “Working with workload profiles” on page
541

v

v “Managing storage subsystems” on page
551

v “Managing virtual disks” on page 561

v “Managing volumes” on page 570
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Task Description
When and how often must I perform this
task?

Manage storage
devices: charging for
storage usage

Use the storage usage information gathered
by data collection schedules to generate
invoices that charge back for storage usage.

Generate invoices whenever you want to
charge users or groups of users in your
organization for their storage usage.

See “Working with invoices” on page 613 for
more information.

Manage storage
devices: setting up
and managing
replication

Use Tivoli Storage Productivity Center for
Replication to manage the advanced copy
services for storage systems, including setting
up management servers, adding storage
connections and paths, creating sessions and
copy sets, setting up data replication,
performing planned maintenance, and
recovering from a disaster.

Access the Tivoli Storage Productivity Center
for Replication user interface at any time to
set up management servers and connections
to storage systems.

See Chapter 7, “Managing replication,” on
page 657 for more information.

View information
about storage devices:
using the topology
viewer

Use the topology viewer to see a graphical
representation of the physical and logical
storage resources that have been discovered
in your environment. You can view the health
status, performance, and other details about
storage resources through this function.

The topology viewer consists of two views, a
graphical view and a table view. The table
view shows the same information as the
graphical view, but in a tabular format.

You can use the topology viewer at any time
after running monitoring jobs to collect the
information about your storage environment.

See “Using the topology viewer” on page 499
for more information.

View information
about storage devices:
using any of the
following report types:
predefined,
user-defined, batch,
and rollup reports.

Use reports to view the information that is
gathered by data collection and quota
schedules.

Consider the following steps when
determining how to best use Tivoli Storage
Productivity Center reports:

1. Determine how you want to generate and
view reports by selecting a reporting type
that best meets your needs.

2. Identify which reports contain the most
important information about your storage
environment.

3. Run the appropriate data collection
schedules.

4. Generate the reports you want to view.

Perform this task after the appropriate data
collection schedules have run and you want
to view information about your storage
devices.

See the following topics for more
information:

1. “Choosing a reporting type” on page 795

2. “Choosing a report category” on page 797

3. “What can I find out using reports?” on
page 803

4. “Working with reports” on page 811

Troubleshooting Use troubleshooting tips to resolve any
problems you might have with Tivoli Storage
Productivity Center.

Perform troubleshooting tasks when you
encounter problems while working with the
product. Troubleshooting information is
meant to help you with resolving issues that
might occur during the use of the product.
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Chapter 2. Product overview

IBM Tivoli Storage Productivity Center provides a set of policy-driven automated
tools for managing storage capacity, availability, events, performance and assets in
your enterprise environment, including NAS, SSA, TotalStorage Enterprise Storage
Server, and Microsoft Cluster Server technologies, as well as RDBMSs such as
Oracle, Sybase SQL Server, Microsoft SQL Server, and DB2 UDB. Tivoli Storage
Productivity Center provides storage management from the host and application to
the target storage device. It provides disk and tape subsystem configuration and
management, performance management, SAN fabric management and
configuration, and usage reporting and monitoring.

Tivoli Storage Productivity Center can help you identify, evaluate, control and
predict your enterprise storage management assets. Because it is policy-based, it
can detect potential problems and automatically make adjustments based on the
policies and actions that you define. For example, it can notify you when your
system is running out of disk space or warn you of impending storage hardware
failure. By alerting you to these and other issues related to your stored data, it
enables you to prevent unnecessary system and application downtime.

Tivoli Storage Productivity Center:
v Simplifies the management of storage infrastructures
v Manages, configures, and provisions SAN-attached storage
v Monitors and tracks performance of SAN-attached devices
v Monitors, manages, and controls (through zones) SAN fabric components
v Manages the capacity utilization and availability of file systems and databases

For select IBM hardware orders only, IBM Tivoli Storage Productivity Center
Limited Edition, limited to 2 TB storage managed, is provided at no charge, and
with one year software maintenance. IBM Tivoli Storage Productivity Center
Advanced Edition includes support for TS3500 and limited support for 3494 tape
libraries.

Introducing IBM Tivoli Storage Productivity Center
This section provides an overview of IBM Tivoli Storage Productivity Center.

IBM Tivoli Storage Productivity Center provides a set of policy-driven automated
tools for managing storage capacity, availability, events, performance and assets in
your enterprise environment. Tivoli Storage Productivity Center provides storage
management from the host and application to the target storage device. It provides
disk and tape subsystem configuration and management, performance
management, SAN fabric management and configuration, and usage reporting and
monitoring.

Tivoli Storage Productivity Center can help you identify, evaluate, control and
predict your enterprise storage management assets. Because it is policy-based, it
can detect potential problems and automatically make adjustments based on the
policies and actions that you define. For example, it can notify you when your
system is running out of disk space or warn you of impending storage hardware
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failure. By alerting you to these and other issues related to your stored data, it
enables you to prevent unnecessary system and application downtime.

Tivoli Storage Productivity Center:
v Simplifies the management of storage infrastructures
v Manages, configures, and provisions SAN-attached storage
v Monitors and tracks performance of SAN-attached devices
v Monitors, manages, and controls (through zones) SAN fabric components
v Manages the capacity utilization and availability of file systems and databases

Architecture
The IBM Tivoli Storage Productivity Center consists of several key components.
This topic identifies these components and shows how they are related.

Data server
This component is the control point for product scheduling functions,
configuration, event information, reporting, and graphical user interface
(GUI) support. It coordinates communication with and data collection from
agents that scan file systems and databases to gather storage demographics
and populate the database with results. Automated actions can be defined
to perform file system extension, data deletion, and Tivoli Storage
Productivity Center backup or archiving, or event reporting when defined
thresholds are encountered. The Data server is the primary contact point
for GUI user interface functions. It also includes functions that schedule
data collection and discovery for the Device server.

Device server
This component discovers, gathers information from, analyzes performance
of, and controls storage subsystems and SAN fabrics. It coordinates
communication with and data collection from agents that scan SAN fabrics
and storage devices.

Replication server
This component coordinates communication and processes tasks that are
related to replication and Tivoli Storage Productivity Center for
Replication.

Database
A single database instance serves as the repository for all Tivoli Storage
Productivity Center components.

Agents
Storage Resource agent, CIM agents, and Out of Band fabric agents gather
host, application, storage system, and SAN fabric information and send
that information to the Data Server or Device server.

Tip: Data agents and Fabric agents are supported in V4.2. However, no
new functions were added to those agents for that release. For optimal
results when using Tivoli Storage Productivity Center, migrate the Data
agents and Fabric agents to Storage Resource agents.

GUI Tivoli Storage Productivity Center provides two graphical user interfaces
for managing the storage infrastructure in an enterprise environment. a
stand-alone GUI and the web-based GUI. Each GUI provides different
functions for working with monitored resources. To view a comparison of
the functions that are available in each GUI, see “Available functions and
report information in the interfaces” on page 19.
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CLI Use the command-line interface (CLI) to issue commands for key Tivoli
Storage Productivity Center functions.

Tivoli Integrated Portal
The Tivoli Storage Productivity Center installation program includes IBM
Tivoli Integrated Portal. Tivoli Integrated Portal is a standards-based
architecture for Web administration. Tivoli Integrated Portal enables
developers to build administrative interfaces for IBM and independent
software products as individual plug-ins to a common console network.
The installation of Tivoli Integrated Portal is required to enable single
sign-on for Tivoli Storage Productivity Center. Single sign-on is an
authentication process that you can use to enter one user ID and password
to access multiple applications. Single sign-on integrates with launch in
context features so you can move smoothly from one application to
another application.

IBM Tivoli Storage Productivity Center summary
This topic provides a summary of the functionality provided by Tivoli Storage
Productivity Center.

The Tivoli Storage Productivity Center functions are shown in Table 2 on page 12.

Figure 1. Tivoli Storage Productivity Center components
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Table 2. Tivoli Storage Productivity Center summary of functions

Data management Disk management Fabric management Tape management

Host-centric:
v Discovery of

storage resources
v Monitoring of

storage resources
v Filesystem

extension
v Enterprise- wide

reporting

Application-centric:
v Monitoring of

relational
databases DB2,
Oracle, SQL Server,
Sybase

v Chargeback

For storage
subsystems:
v Discovery of

storage resources
v Monitoring of

storage resources
v Configuration (for

example, creating
volumes)

v Performance
management

For fabrics:
v Discovery of

storage resources
v Monitoring of

storage resources
v Configuration (for

example, zoning)
v Performance

management

For tape libraries:
v Discovery of

storage resources
v Monitoring of

storage resources

Product licenses for Tivoli Storage Productivity Center
Product licenses are available for IBM Tivoli Storage Productivity Center. Each
license determines the functions that are accessible in the stand-alone GUI,
command-line interface, and the API. You can review the functions that are
included with each license and determine which license meets your storage
management needs.

IBM Tivoli Storage Productivity Center
This license contains the following functions:

Data management
A file and capacity management solution for heterogeneous storage
environments. Data management includes enterprise-wide
reporting and monitoring, and automated capacity provisioning for
Direct Attached Storage (DAS), network-attached storage (NAS),
and Storage Area Network (SAN) environments.

Disk management
Disk management helps you manage SANs and heterogeneous
storage from one console.

Fabric management
Fabric management helps you manage the SAN fabric that
connects the host systems and applications to the storage devices.
This feature is a comprehensive management solution for
multi-vendor SANs and includes automatic resource and topology
discovery, monitoring, alerts, and zone control.

Tape management
Tape management helps you manage your SMI-S compliant tape
libraries.

Tivoli Storage Productivity Center for Replication
This license includes all the Tivoli Storage Productivity Center for
Replication functions.

Performance management
Disk and Fabric performance management functions.
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Device support
You can see a complete list of devices that can be used with Tivoli
Storage Productivity Center at https://www.ibm.com/support/
docview.wss?uid=swg21386446. Click the appropriate release under
Storage.

IBM Storage Productivity Center Select Edition
This license contains all the functions of the IBM Tivoli Storage
Productivity Center license. This license is priced by enclosure rather than
by capacity.

IBM Tivoli Storage Productivity Center Advanced
This license contains everything in IBM Tivoli Storage Productivity Center
license and the following functions:

Analytical functions

v Configuration analysis
v Configuration history
v SAN Planner
v Storage Optimizer

Tivoli Storage Productivity Center for data-related functions

v Scans
v Policy management
v Server probes
v Scans
v Profiles
v Data Manager for databases
v Data Manager for Chargeback

Use the following tables to view the specific functions, reports, and elements of the
user interface that are available with each license.

Table 3. Functions with each Tivoli Storage Productivity Center license

Function

Tivoli Storage
Productivity Center or
Storage Productivity
Center Select Edition

Tivoli Storage
Productivity Center
Advanced

Administrative Services

Device discovery Yes Yes

Data Sources11

v CIMOM agents

v Data/Storage Resource Agents

v Inband Fabric Agents

v Out of Band Fabric Agents

v Storage Subsystems

v TPC Servers

v VMWare VI Data Source

v Yes

v Yes

v Yes

v Yes

v Yes

v No

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

Configuration Yes2 Yes

IBM Tivoli Storage Productivity Center

Configuration Utility Yes Yes
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Table 3. Functions with each Tivoli Storage Productivity Center license (continued)

Function

Tivoli Storage
Productivity Center or
Storage Productivity
Center Select Edition

Tivoli Storage
Productivity Center
Advanced

Configure Devices Yes Yes

Job Management Yes Yes

Reporting Yes Yes

v Batch Reports

v User ID reports

v System Reports

v Rollup Reports

v Data Source Reports

See Table 4 on page 16
for a list of available
reports.

See Table 4 on page 16
for a list of available
reports.

Topology Viewer Yes Yes

Monitoring (data collection)

v Probes

v TPC Server Probes

v Yes

v No

v Yes

v Yes

Storage Resource Group Management Yes5 Yes

Analytics

v Configuration History

v Storage Optimizer

v

v Configuration Analysis

v No

v No

v No

v No

v Yes

v Yes

v Yes

v Yes

Alerting:

v Alert Log

v Authentication Configuration
Alerts

v Yes3

v Yes

v Yes

v Yes

Data Manager

Monitoring: (data collection)

v Groups

v Pings

v Scans

v Profiles

v Yes

v Yes

v No

v No

v Yes

v Yes

v Yes

v Yes

Alerting Yes4 Yes

Policy Management No Yes

Reporting Yes

Not all reports are
available with the Tivoli
Storage Productivity
Center or Storage
Productivity Center
Select license. See Table 4
on page 16 for a list of
available reports.

Yes

Data Manager for Databases No Yes

14 IBM Tivoli Storage Productivity Center: User's Guide



Table 3. Functions with each Tivoli Storage Productivity Center license (continued)

Function

Tivoli Storage
Productivity Center or
Storage Productivity
Center Select Edition

Tivoli Storage
Productivity Center
Advanced

Data Manager for Chargeback No Yes

Disk Manager

Storage Subsystems Yes Yes

v Create Volumes

v Create Virtual Disks

v Launch Element Manager

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

Storage Optimizer No Yes

SAN Planner No Yes

Monitoring (data collection)

v Groups

v Jobs

v Storage Subsystem Performance

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

Alerting Yes Yes

Profile Management Yes Yes

Reporting

v Groups

v Storage Subsystems

v Storage Subsystem Performance

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

Fabric Manager

Fabrics Yes Yes

Monitoring (data collection)

v Groups

v Jobs

v Switch Performance Monitors

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

Alerting Yes Yes

Reporting Switch Performance Yes Yes

Tape Manager Yes Yes

Element Manager Yes Yes

Replication Manager Yes Yes
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Table 3. Functions with each Tivoli Storage Productivity Center license (continued)

Function

Tivoli Storage
Productivity Center or
Storage Productivity
Center Select Edition

Tivoli Storage
Productivity Center
Advanced

Note:

1. You cannot associate TPC Servers with Tivoli Storage Productivity Center in the Tivoli
Storage Productivity Center or Storage Productivity Center Select license. VMware Data
Sources are associated with the Tivoli Storage Productivity Center or Storage
Productivity Center Select license. TPC Servers are associated with the Tivoli Storage
Productivity Center Advanced license.

2. The following nodes under Configuration are not available with the Tivoli Storage
Productivity Center or Storage Productivity Center Select license:

v License Keys

v Quota and Constraint e-mail Address Rules

v Resource History Retention for Databases

v Removed Resource Retention for Databases

v Configuration History Settings

3. The following nodes under Alert Log are not available with the Tivoli Storage
Productivity Center or Storage Productivity Center Select license:

v Directory

v User

v OS User Group

v Configuration Analysis

4. The following node under Data Manager > Alerting is not available with the Tivoli
Storage Productivity Center or Storage Productivity Center Select license: Directory
Alerts. Hypervisor Alerts and Other NAS Alerts are available with the Tivoli Storage
Productivity Center or Storage Productivity Center Select license.

5. You cannot create a storage resource group for a type of capacity pool.

Table 4. Available reports with each IBM Tivoli Storage Productivity Center license

Reports

Tivoli Storage
Productivity Center
or Storage
Productivity Center
Select

Tivoli Storage
Productivity Center
Advanced

Batch reports Yes1, 2 Yes1

System Reports:

v Data

v Fabric

v Disk

v Yes4

v Yes

v Yes

v Yes

v Yes

v Yes

Rollup Reports No Yes

Data Source Reports Yes Yes

Asset reports:

16 IBM Tivoli Storage Productivity Center: User's Guide



Table 4. Available reports with each IBM Tivoli Storage Productivity Center
license (continued)

Reports

Tivoli Storage
Productivity Center
or Storage
Productivity Center
Select

Tivoli Storage
Productivity Center
Advanced

v By Cluster

v By Computer

v By Hypervisor

v By IBM Storwize V7000 Unified/IBM
SONAS

v By OS Type

v By Storage Subsystem

v System-wide

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes3

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

Availability reports Yes Yes

TPC-wide Storage Space reports:

v Disk Space

v File System Space

v Consumed File System Space

v Available File System Space

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

Usage reports No Yes (these reports
are a result of a
scan)

Usage Violation reports No Yes (these reports
are a result of a
scan)

Backup reports No Yes (these reports
are a result of a
scan)

Monitored Computer Storage Space reports Yes Yes

Storage Subsystem reports Yes Yes

Storage Subsystem Performance reports Yes Yes

Switch Performance reports Yes Yes

Tape Library report Yes Yes
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Table 4. Available reports with each IBM Tivoli Storage Productivity Center
license (continued)

Reports

Tivoli Storage
Productivity Center
or Storage
Productivity Center
Select

Tivoli Storage
Productivity Center
Advanced

Note:

1. A Storage Resource agent must be deployed on the computer where you want to run
batch reports.

2. The following batch reports are not available with the Tivoli Storage Productivity
Center or Storage Productivity Center Select license:

v Rollup

v Usage

v Usage Violations

v Backup

3. The following Asset > System-wide reports are available with the Tivoli Storage
Productivity Center Advanced license:

v Monitored Directories

v Unmanaged Computers

v Users

v OS User Groups

4. The following Data system reports are available with the Tivoli Storage Productivity
Center or Storage Productivity Center Select license:

v Disk Space Summary

v Disk Defects

v Computer Storage Availability

v Computer Disk Space

v Available File System Space

If you purchased a license for IBM Tivoli Storage Productivity Center Version 4,
when you upgrade to Version 5, you can upgrade to the appropriate license.Table 5
shows the parallel functions in Version 5.

Table 5. Tivoli Storage Productivity Center licenses when you upgrade from Version 4 to
Version 5

If you have this Tivoli Storage
Productivity Center Version 4 license

You are entitled to this Tivoli Storage
Productivity Center Version 5 license

Basic There is no equivalent license in Tivoli
Storage Productivity Center Version 5.1. You
can upgrade by purchasing the Tivoli Storage
Productivity Center Version 5.1 license.

Disk Select IBM Storage Productivity Center Select
Edition

Data IBM Tivoli Storage Productivity Center
Advanced

Disk IBM Tivoli Storage Productivity Center

Standard Select IBM Tivoli Storage Productivity Center
Advanced

Standard IBM Tivoli Storage Productivity Center
Advanced
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User interfaces to Tivoli Storage Productivity Center
Tivoli Storage Productivity Center provides several user interfaces for managing
the storage infrastructure in an enterprise environment.

The following user interfaces are provided:
v A stand-alone GUI for completing all the storage management tasks that are

available in Tivoli Storage Productivity Center. This interface is the same
interface that was used in previous versions, and provides full access to all the
new functions (except for web-based GUI reporting) and existing functions in
the product.

v A web-based GUI for monitoring and troubleshooting the condition of storage
resources in your environment. From the web-based GUI, you can view
predefined reports, create custom reports, and design custom reports about
storage resources. This new, improved interface provides quick access to key
storage asset, status, and performance information that is collected by Tivoli
Storage Productivity Center. You can access this interface from anywhere that
you have a web browser and connectivity to a network.

v A command-line interface for running Tivoli Storage Productivity Center
commands from a command prompt.

Each GUI provides different functions for working with monitored resources.
Determine which GUI to use based on the tasks that you need to complete.
Related concepts:
Chapter 6, “Managing resources in the web-based GUI,” on page 623
You can use the web-based GUI to monitor the condition, capacity, and
relationships of the monitored resources within your storage environment.

Available functions and report information in the interfaces
IBM Tivoli Storage Productivity Center 5.1 provides two graphical user interfaces
(GUI) for managing the resources in a storage environment: a stand-alone GUI and
a web-based GUI. Each interface provides different functions for working with
monitored resources.

GUI overview

Use the following information to determine which interface best helps you
complete your storage-management tasks.

stand-alone GUI
This interface contains the functions that you can use to monitor the
condition of storage resources, and all the tools to manage data, disk,
fabric, tape, and replication. The stand-alone GUI is the same interface that
is available in previous versions of the product, and provides full access to
all the functions that were available in those versions.

web-based GUI
This interface provides quick access to pages that you can use to monitor
the condition, capacity, and relationships of the resources within your
storage environment. Specifically, use the web-based GUI to complete the
following tasks:
v View and acknowledge the status of resources that are monitored by

Tivoli Storage Productivity Center. Resources include storage systems,
servers, hypervisors, fabrics, and switches. Use this information to
quickly determine the state of your storage environment.
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v View summary and detailed information about resources, including
properties, storage usage, storage capacity, and several key performance
metrics. Use this information to monitor the storage on your hardware.
For example, when migrating large amounts of data, you can identify
the target resources that have enough storage capacity to accommodate
the data and require the least amount of reconfiguration.

v View the relationships and storage mapping among resources. For
example, you can view the resources such as servers and hypervisors to
which volumes from a storage system are assigned.

v Identify potential problems and troubleshoot existing problems in a
storage environment. For example, you can locate the internal resources
of a storage system that might be causing a bottleneck in storage
utilization.

v In the reporting, web-based interface, use a drag-and-drop approach to
design custom reports that contain detailed information about the
properties and performance of monitored resources. All the performance
metrics from the stand-alone GUI are available in the reporting interface.
For example, you can drag key metrics into a report to create and
generate a performance chart for a specific volume of a storage system.
The reporting interface also includes a set of predefined reports that
provides quick access to preformatted data about resources.

Configuring and administering

Use the following list to view the specific configuring and administering tasks that
you can complete in each GUI.

Table 6. Available configuring and administering tasks in each GUI

Tasks
Available in web-based
GUI

Available in stand-alone
GUI

Adding and managing data sources,
including agents

No Yes

Discovering resources for monitoring No Yes

Configuring resources for monitoring No Yes

Configuring Tivoli Storage
Productivity Center

No Yes

Starting element managers in context

v Storage systems

v Switches

v No

v Yes

v Yes

v Yes

Administering Tivoli Storage
Productivity Center services

No Yes

Managing Tivoli Storage Productivity
Center jobs:

v Viewing information about jobs

v Administering jobs

v Yes

v No

v Yes

v Yes

Monitoring

Use the following list to view the specific monitoring tasks that you can complete
in each GUI.
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Table 7. Available monitoring tasks in each GUI

Tasks
Available in web-based
GUI

Available in stand-alone
GUI

Creating data collection schedules
and groups

No Yes

Creating storage resource groups No Yes

Managing replication No Yes

Viewing information about the
following resources:

v Storage systems

v Servers

v Hypervisors

v Switches

v Fabrics

v Tape libraries

v Databases

v Yes

v Yes

v Yes

v Yes

v Yes

v No

v No

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

v Yes

Viewing the following information
about resources:

v Status

v Capacity (including used and
available space)

v Relationships between resources

v Data paths

v Yes

v Yes

v Yes

v No

v Yes

v Yes

v Yes

v Yes

Exporting information about
resources to a file

Yes Yes

Running analytics:

v Configuration history

v Storage optimizer

v SAN Planner

v Configuration analysis

v No

v No

v No

v No

v Yes

v Yes

v Yes

v Yes

Managing zones and zone sets No Yes

Viewing a visual topology of
resources

No Yes

Creating storage policies No Yes

Charging back for storage usage No Yes

Alerting

Use the following list to view the specific alerting tasks that you can complete in
each GUI.

Table 8. Available alerting tasks in each GUI

Tasks
Available in web-based
GUI

Available in stand-alone
GUI

Creating alerts No Yes

Viewing alert conditions that are
detected on monitored resources

Yes Yes
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Table 8. Available alerting tasks in each GUI (continued)

Tasks
Available in web-based
GUI

Available in stand-alone
GUI

Acknowledging the status of alerts Yes Yes

Removing alerts Yes Yes

Reporting

Use the following lists to view the specific reporting tasks and information that
you can complete in each GUI.

Reporting tasks

Table 9. Available reporting tasks in each GUI

Tasks
Available in web-based
GUI

Available in stand-alone
GUI

Accessing the web-based reporting
interface

Yes No

Saving reports Yes Yes

Scheduling reports Yes Yes

Reporting information

Table 10. Available reporting information in each GUI

Information
Available in web-based
GUI

Available in stand-alone
GUI

Resource properties Yes* Yes

Performance Yes Yes

Capacity (including used and
available space)

Yes Yes

Historical capacity Yes Yes

Storage tiering Yes No

Policy violations No Yes

Rollup servers No Yes

File statistics No Yes

Tape libraries No Yes

Data sources No Yes

Databases No Yes

Note: * Information about the properties of fabrics is not available.

The stand-alone GUI
Use the stand-alone GUI to complete all your storage management tasks. The main
window for this interface is organized into two main sections: the navigation tree
and the content pane.

Navigation tree
The navigation tree is displayed on the left side of the main window. You
can expand, select, and collapse the nodes in the tree to navigate through
the interface. Each node represents a function or task for managing storage.
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Figure 2. Navigation tree
When you start Tivoli Storage Productivity
Center, the navigation tree is expanded to
show all the high-level functions in the
product. To view the nodes within each
high-level function, click the expand icon
next to the node or double click the name of
the node.

Expanding and collapsing the navigation
tree: If the navigation tree gets too large, or
if you want to return it to its original state,
right-click on the major nodes of the tree
and select Collapse Branch or Expand
Branch. For example, right-click the IBM
Tivoli Storage Productivity Center node
and select Collapse Branch to collapse all
the nodes in that branch of tree. To expand
all the nodes in the IBM Tivoli Storage
Productivity Center branch, right click the
node and select Expand Branch.
Printing the navigation tree: Right-click on
a node and choose Print Branch to print all
the subnodes within that node.

Content pane
The content pane is displayed on the right side of the main window. When
you select a node in the navigation tree, a corresponding panel is
displayed in the content pane. Use the panels in the content pane to
complete tasks such as configuring Tivoli Storage Productivity Center,
creating data collection schedules, defining alerts, and viewing reports.
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Navigation tree:

The navigation tree shows all of the available resource management tasks,
organized by major topic nodes for Administrative Services, IBM Tivoli Storage
Productivity Center, Data Manager, Disk Manager, Fabric Manager, and Tape
Manager.

Administrative Services
Provides product configuration functions for Tivoli Storage Productivity
Center.

This node is always present.

Tivoli Storage Productivity Center
Provides operational functions for Tivoli Storage Productivity Center.

This node is always present.

Data Manager
Provides operational functions for the Data Manager.

This node is present when Data Manager is installed and licensed.

For Data Manager functions, you must use Data agents or Storage
Resource agents to collect data about your storage resources. For example,
use scans, pings, and probes to collect data about the computers on which
the agents are installed.

Data Manager for Databases
Provides operational functions for Data Manager for Databases.

Figure 3. Content pane
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This node is present when Data Manager is installed and licensed.

Data Manager for Chargeback
Provides operational functions for Data Manager for Chargeback.

This node is present when Data Manager is installed and licensed.

Disk Manager
Provides operational functions for the Disk Manager.

This node is present when Disk Manager is installed and licensed. A subset
of the functions is provided when you install the Data Server.

For Disk Manager functions, the subsystem CIMOMs and data collection
are required (for example, through probes), except for devices that use
Native API connection, for example: System Storage DS8000, SAN Volume
Controller, and the XIV system.

Fabric Manager
Provides operational functions for the Fabric Manager.

This node is present when Fabric Manager is installed.

For Fabric Manager functions, the available agent types are CIM agents,
in-band fabric agents, out-of-band fabric agents, and Storage Resource
Agents. You must run a data collection job (for example, through probe
jobs). If you want to perform zone control actions, the in-band fabric
agents for QLogic and Cisco fabrics must be deployed. For Fabric Manager
features such as zone control and performance monitoring, you must
perform data collection from performance monitors. For a list of current
agent types supported for the Switch Performance Management
functionality and the Fabric Zone Configuration functionality, see “Fabric
Manager” on page 1429.

Tape Manager
Provides operational functions for the tape library.

This node is present when the Device server is installed.

For Tape Manager functions, the library CIMOMs and data collection are
required (for example, probes).

Element Manager
Allows you to access the Element Manager tab of the Configuration Utility
where you can configure and administer IBM System Storage DS8000 and
other storage subsystems.

Replication Manager
Allows you to access the Replication Manager tab of the Configuration
Utility where you can manage IBM Tivoli Storage Productivity Center for
Replication and to set the triggering condition and actions for alerts
associated with Tivoli Storage Productivity Center for Replication.

Dashboard:

The dashboard provides a concise, yet detailed overview of the health of your
storage environment. It quickly points out potential problem areas that need
further investigation.

When you first log in to IBM Tivoli Storage Productivity Center you are asked if
you want to collect statistics. You must answer yes in order for the dashboard
information to be displayed. The dashboard then appears whenever you start the
product or close all the active windows in a running session.
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The dashboard contains four display areas and seven panels that you can cycle
through to view your environment's storage information.

Using the dashboard:

Use the dashboard to monitor the overall status of your storage resources.

Purpose

When you first log on to Tivoli Storage Productivity Center or close all the active
panels, the topic pane shows the "dashboard". The dashboard provides a concise,
yet detailed overview of the status of your storage environment. Use it to quickly
point out potential problem areas that need further investigation. The dashboard
contains four displayable areas and eight panels that you can cycle through to
view the storage information that has been collected about your environment.

Keep in mind the following considerations when viewing the information about
the dashboard:
v The information in the dashboard is collected by data collection schedules and

aggregated by the History Aggregator. To ensure that the latest information is
displayed in the dashboard, run the history aggregator regularly . See the
information center for instructions about how to create and schedule history
aggregator jobs.

v The value in the All field on the Alerts Pending panel might be higher than the
sum of the alerts shown in the other fields on that panel. This situation occurs
because some alerts are not associated with a specific category, and are reflected
in the value that is shown in the All field only.
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v The names of some fields have been updated. For your reference, the original
names of those fields are shown within parentheses ( ) next to their new names
in this topic.

v Click Refresh to update the displayed panels. You must click Refresh to ensure
that the latest information from the history aggregator is displayed in the
dashboard.

v Click Cycle Panels to cycle through the panels in the dashboard and view
information about your storage assets.

TPC-wide Summary panel

Use this panel to view an enterprise-wide summary of your storage through the
following values:

File System Space (Capacity)
Total amount of unique file system storage space on computers where a
Data agent or Storage Resource agent is installed. Tivoli Storage
Productivity Center does not include the following file systems in its
calculation of the value for this field:
v File systems that become missing after a probe.
v File systems discovered on virtual machines where an agent is installed.
v File systems that are mounted remotely and are not identified to a

network-attached storage server.
v File systems that are not mounted.

Consumed File System Space (Filesystem Used Space)
Total amount of unique file system storage space that is used or consumed
by the computers where a Data agent or Storage Resource agent is
installed. Tivoli Storage Productivity Center does not include the following
file systems in its calculation of the value for this field:
v File systems that become missing after a probe.
v File systems on discovered hypervisors that are assigned to virtual

machines where an agent is installed.
v File systems on virtual machines where an agent is installed, but the

hypervisors for the virtual machines have not been discovered and the
total used space exceeds the capacity of the total file system capacity.

v File systems that are mounted remotely and are not identified to a
network-attached storage server.

v File systems that are not mounted.

Available File System Space (Filesystem Free Space)
Total amount of unique file system storage space that is not used or
available to the computers where a Data agent or Storage Resource agent is
installed. Tivoli Storage Productivity Center does not include the following
file systems in its calculation of the value for this field:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network-attached storage server.
v File systems that are not mounted.

Fibre Attached Computer Disk Space (Computer Fibre Attached Disk Space)
Total amount of unique disk space on computers where a Data agent or
Storage Resource agent is installed and the disks are attached through a
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fibre channel port. Tivoli Storage Productivity Center does not include the
following disks in its calculation of the value for this field:
v Computer disks that are behind a fibre channel port that has not been

identified by an agent.
v Computer disks that are not behind a fibre channel port.
v Computer disks discovered on virtual machines where an agent is

installed.
v Computer disks that become missing after a probe.

Non-Fibre Attached Computer Disk Space (Computer Non-fibre Attached Disk
Space) Total amount of unique disk space on computers where a Data agent or

Storage Resource agent is installed and the disks are not attached through
a fibre channel port. Tivoli Storage Productivity Center does not include
the following disks in its calculation of the value for this field:
v Computer disks that are behind a fibre channel port.
v Computer disks discovered on virtual machine where an agent is

installed.
v Computer disks that become missing after a probe.

Physical Storage Subsystem Disk Space (Storage Subsystem Physical Disk
Space) Total amount of unique internal physical disk space on the storage

subsystem arrays that are monitored by subordinate servers and the master
server. Tivoli Storage Productivity Center does not include the following
storage space in its calculation of the value for this field:
v Storage subsystem disks that become missing after a storage subsystem

probe.
v Back-end storage volumes on monitored storage subsystem virtualizers

(for example, SAN Volume Controller) that are attached from a storage
subsystem.

v Storage subsystem disks that are on storage subsystems that have not
been probed by the subordinate servers or the master server.

Storage Subsystem Volume Space (LUN Capacity)
Total amount of unique storage subsystem volume space and virtual
storage volume space on the storage subsystem arrays that are monitored
by subordinate servers and the master server. Tivoli Storage Productivity
Center does not include the following volumes in its calculation of the
value for this field:
v Storage subsystem volumes or virtual storage volumes that become

missing after a storage subsystem probe.
v Storage subsystem volumes or virtual storage volumes that Tivoli

Storage Productivity Center identifies as back-end storage volumes on
monitored storage subsystem virtualizers (for example, SAN Volume
Controller).

v Storage subsystem disks that are on storage subsystems that have not
been probed by the subordinate servers or the master server.

Consumable Storage Subsystem Volume Space (Usable LUN Capacity)
Amount of file system storage space for a file system. Total amount of
unique storage subsystem volume space and virtual storage volume space
on monitored storage subsystem arrays that can be assigned or are
assigned to systems within the network. Tivoli Storage Productivity Center
does not include the following columns in its calculation of the value for
this field:
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v Storage subsystem volumes or virtual storage volumes that become
missing after a storage subsystem probe.

v Storage subsystem volumes or virtual storage volumes that are used as
FlashCopy targets.

v Storage subsystem volumes or virtual storage volumes that are identified
as Business Continuance Volume extended (BCVx).

v Storage subsystem volumes or virtual storage volumes used as a Volume
Configuration Management (VCM) database.

v Storage subsystem volumes or virtual storage volumes that Tivoli
Storage Productivity Center identifies as back-end storage volumes on
monitored storage subsystem virtualizers (for example, SAN Volume
Controller).

FlashCopy Target Storage Subsystem Volume Space (FlashCopy Target Capacity)
Total amount of unique storage subsystem volume space and virtual
storage volume space on monitored storage subsystem arrays that is
identified as FlashCopy target space. Tivoli Storage Productivity Center
does not include the following volumes in its calculation of the value for
this field:
v Storage subsystem volumes or virtual storage volumes that become

missing after a storage subsystem probe.
v Storage subsystem volumes or virtual storage volumes that are not used

as FlashCopy targets.

Monitored Computers (Servers)
Total number of computers where a Data agent or Storage Resource agent
is installed and are detected by the Data server. Tivoli Storage Productivity
Center does not include the following systems in its calculation of the
value for this field:
v Systems where an agent is installed but was not started or was unable to

communicate with the Data server.
v Systems where an agent is not installed.
v Systems where an agent is installed but that agent communicates with a

different Tivoli Storage Productivity Center server.
v Systems that have been removed from the Administrative Services >

Data Sources > Data/ or Storage Resource agents panel.
v Hypervisors

Unmonitored Computers (Servers)
Total number of computers found in a Windows domain that do not have
a Data agent or Storage Resource agent communicating with the Data
server. Tivoli Storage Productivity Center does not include the following
systems in its calculation of the value for this field:
v Systems that are not running a Windows operating system.
v Systems that are not in a Windows domain.
v Systems where an agent is installed and is communicating with a Data

server.

Storage subsystems
Total number of storage subsystems that have been discovered and probed.
Tivoli Storage Productivity Center does not include the following storage
subsystems in its calculation of the value for this field:
v Storage Subsystems that have been discovered but not probed.
v Storage Subsystem that have not been discovered.
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v Storage Subsystems that have been removed from the Disk Manager >
Storage Subsystems panel.

Users Total number of user accounts discovered by Data agents or Storage
Resource agents.

Disks Total number of unique disks discovered by Data agent or Storage
Resource agent probes, hypervisor probes, network storage filer probes,
and storage subsystem probes. This value does not include disks that have
become missing after a successful probe.

Storage Subsystem Volumes (LUNS)
Total number of unique storage volumes and virtual storage volumes
discovered by storage subsystem probes. This value does not include
storage volumes or virtual storage volumes that have become missing after
a successful storage subsystem probe.

Filesystems
Total number of unique file systems discovered by probes. This value
excludes file systems that have become missing after a successful probe.

Directories
Total number of directories discovered by scans. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this field:
v Directories within file systems that were discovered by a probe but were

not scanned.
v Directories that have become missing after a successful probe.

Files Total number of files discovered by scans. Tivoli Storage Productivity
Center does not include the following files in its calculation of the value
for this field:
v Files within file systems that were discovered by a probe but were not

scanned.
v Files that have become missing after a successful probe.

Rollup Summary panel

Use this panel to view a summary of information collected by the master server
and by Tivoli Storage Productivity Center servers that are subordinate servers.

File System Space (Capacity)
Total amount of unique file system storage space on the computers that are
monitored by subordinate servers and the master server. Tivoli Storage
Productivity Center does not include the following file systems in its
calculation of the value for this field:
v File systems that become missing after a probe.
v File systems discovered on virtual machines where the Data agent or

Storage Resource agent is installed.
v File systems that are mounted remotely and are not identified to a

network-attached storage server.
v File systems that are not mounted.
v File systems that have not been probed by subordinate servers or the

master server.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the computers that are monitored by subordinate servers and the
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master server. Tivoli Storage Productivity Center does not include the
following file systems in its calculation of the value for this field:
v File systems that become missing after a probe.
v File systems on discovered hypervisors that are assigned to virtual

machines where the Data agent or Storage Resource agent is installed.
v File systems on virtual machines where the Data agent or Storage

Resource agent is installed, but the hypervisors for the virtual machines
have not been discovered and the total used space exceeds the capacity
of the total file system capacity.

v File systems that are mounted remotely and are not identified to a
network-attached storage server.

v File systems that are not mounted.
v File systems that have not been probed by subordinate servers or the

master server.

Available File System Space (Filesystem Free Space)
Total amount of unique file system storage space that is not used or
available to the systems that are monitored by subordinate servers and the
master server. Tivoli Storage Productivity Center does not include the
following file systems in its calculation of the value for this field:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network-attached storage server.
v File systems that are not mounted.
v File systems that have not been probed by subordinate servers or the

master server.

Physical Storage Subsystem Disk Space (Storage Subsystem Physical Disk
Space) Total amount of unique internal physical disk space on monitored storage

subsystem arrays. Tivoli Storage Productivity Center does not include the
following storage space in its calculation of the value for this field:
v Storage subsystem disks that become missing after a storage subsystem

probe.
v Back-end storage volumes on monitored storage subsystem virtualizers

(for example, SAN Volume Controller) that are attached from a storage
subsystem.

Storage Subsystem Volume Space (LUN Capacity)
Total amount of unique storage subsystem volume space and virtual
storage volume space on monitored storage subsystem arrays. Tivoli
Storage Productivity Center does not include the following volumes in its
calculation of the value for this field:
v Storage subsystem volumes or virtual storage volumes that become

missing storage subsystem probe.
v Storage subsystem volumes or virtual storage volumes that Tivoli

Storage Productivity Center identifies as back-end storage volumes on
monitored storage subsystem virtualizers (for example, SAN Volume
Controller).

Consumable Storage Subsystem Volume Space (Usable LUN Capacity)
Total amount of unique storage subsystem volume space and virtual
storage volume space on storage subsystem arrays that are monitored by
subordinate servers and the master server and can be assigned or are
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assigned to systems within the network. Tivoli Storage Productivity Center
does not include the following storage space in its calculation of the value
for this field:
v Storage subsystem volumes or virtual storage volumes that become

missing after a storage subsystem probe.
v Storage subsystem volumes or virtual storage volumes that are used as

FlashCopy targets.
v Storage subsystem volumes or virtual storage volumes that are identified

as Business Continuance Volume extended (BCVx).
v Storage subsystem volumes or virtual storage volumes used as a Volume

Configuration Management (VCM) database.
v Storage subsystem volumes or virtual storage volumes that Tivoli

Storage Productivity Center identifies as back-end storage volumes on
monitored storage subsystem virtualizers (for example, SAN Volume
Controller).

v Storage subsystem disks that are on storage subsystems that have not
been probed by the subordinate servers or the master server.

Monitored TPC Servers
Total number of subordinate servers that are monitored by the master
server.

Monitored Computers (Servers)
Total number of computers that are monitored by Tivoli Storage
Productivity Center and are detected by the subordinate and the master
server. Tivoli Storage Productivity Center does not include the following
systems in its calculation of the value for this field:
v Systems where an agent is installed but was not started or was unable to

communicate with the Data server.
v Systems where an agent is not installed.
v Systems where an agent is installed but that agent communicates with a

Tivoli Storage Productivity Center server that is not a subordinate server
or the master server.

v Systems that have been removed from the Administrative Services >
Data Sources > Data/ or Storage Resource agents panel.

Storage subsystems
Total number of storage subsystems that have been discovered and probed
by subordinate servers and the master server. Tivoli Storage Productivity
Center does not include the following storage subsystems in its calculation
of the value for this field:
v Storage Subsystems that have been discovered but not probed.
v Storage Subsystem that have not been discovered.
v Storage Subsystems that have been removed because of the storage

subsystem settings on the Removed Resource Retention panel.

Consumed File System Space (Filesystem Used Space panel)

Use the chart on this panel to view the total amount of used file system storage
space across the entire network.
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Users Consuming the Most Space (chart) panel

Use this panel to view the following information:
v A list of the users consuming the most space within your environment
v A graphical view of the amount of space they are consuming

The chart on this panel shows information about users across the network. If
multiple hosts contain the same user name, the value displayed for that user
represents the space consumed on all the hosts. For example, if the user "root"
exists on three hosts that are monitored by Tivoli Storage Productivity Center, then
the value displayed on this chart represents the space consumed by "root" on those
three hosts.

Note: The space usage of administrative users within your environment is not
included as part of this dashboard report.

Monitored Computer Summary panel

Use this panel to view the following information:
v The number of monitored computers running each Operating System type
v Total amount of file system and disk capacity per Operating System type

Filesystems with Least Free Space Percentage panel

Use this panel to view the monitored computers with the least percentage of free
space, including the following values:
v Percent of free space on each computer
v Total file system capacity on each computer
v Name of the computers, file systems, and mount points

Users Consuming the Most Space Report panel

Use this panel to view the following information:
v A list of the users consuming the most space within your environment
v The total amount of storage each user is consuming

Alerts Pending panel

Use this panel to view the active alerts that are still pending.

Note: The number of alerts on this panel might be less than the number of alerts
shown in the IBM Tivoli Storage Productivity Center > Alerting > Alert Log. Alerts
for failed jobs (pings, probes, and scans) are not listed in separate rows on this
panel, but are included in the total displayed in the All row.

These alerts are organized into the following categories:
v All
v Computer
v Disk
v Filesystem
v Directory
v User Quota
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v OS User Group Quota
v Directed to user

v Storage Subsystem
v Switch
v Fabric
v Endpoint Device
v External
v Tape Library
v Hypervisor
v Authentication Configuration
v Replication
v Configuration Analysis
v NAS Node
v NAS File Set
v Export

Working with the navigation tree and content pane:

This section describes some methods for working with the nodes and windows in
the navigation tree and content pane.

Right-clicking and pop-up menus:

Right-click nodes in the navigation tree to access menus that contain actions you
can perform.

As you navigate through the IBM Tivoli Storage Productivity Center user interface,
notice that you can right-click nodes in the navigation tree to access menus that
contain actions related to that node. Use these actions to quickly access many
product functions.

The following actions are available for the nodes in the navigation tree:

Option Description

Create <object> Create an object, including a group, data collection schedule, policy,
batch report, or alert.

Delete Delete the selected object definition, such as a data collection
schedule, policy, batch report, group, or alert. This action is not
available for definitions owned by TPCUser.

Rename Rename the object definition. This action is not available for
definitions owned by TPCUser.

Refresh Refresh the list of objects in the navigation tree. The navigation tree is
not updated automatically. You must click Refresh for a node to view
the latest objects related to that node. For example, right-click the
Tivoli Storage Productivity Center > Monitoring > Probes node and
select Refresh to update the probe schedules that are listed in the
navigation tree.

Job History View the list of jobs related to a data collection or batch report
schedule on the Job Management panel.

Run Now Run a data collection or batch report schedule immediately.

Collapse Branch Minimize the navigation tree under the selected node.

34 IBM Tivoli Storage Productivity Center: User's Guide



Option Description

Expand Branch Open the navigation tree under the selected node.

Print Branch Print the contents of the navigation tree under the selected node.

Selecting panels in the content pane:

The content pane is displayed on the right side of the stand-alone GUI. When you
click a node in the navigation tree, a corresponding panel is displayed in the
content pane. Use the panels in the content pane to complete storage management
tasks.

Each time you select a node in the navigation tree, the panel for the previously
selected node is not deleted. Instead, it moves into the background and is

accessible by clicking and on the toolbar. You can also select
currently active panels from the Window > Show Window List in the menu bar.

In the Window menu, a > is shown next to the name of the active panel. Objects
that you are editing (such as data collection schedules) are marked with a black
arrow if they have no pending changes; a solid red arrow indicates objects that
have pending changes.

Menu bar:

Use the menu bar of the main window to access some of the main functions within
IBM Tivoli Storage Productivity Center.

The following sections describe the options available from the menu bar.

File menu:

Use the options in the File menu to save objects and jobs, export report data, print,
refresh alerts, close the current window, and exit the product session.

Menu Option Description

Save Save the changes for the current object (for example, groups,
profiles, etc.) or job (for example, probes, scans, pings, etc.) that
you are editing.

Save As Save the changes for the current object or job that you are editing
under a different name.

Export Data Export the report data to other formats:
v Formatted Report file (.txt)
v Comma delimited file (.csv)
v Comma delimited file with headers
v HTML file

This allows you to import the data to another application, such as
Excel, if needed.

Print Print the current data in the content pane. You can print tabular
reports or report charts. You can also save the output to a PDF file
or HTML file, and print those files at a later time.
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Menu Option Description

Print Tree Print the expanded contents of the navigation tree. You can also
save output to a PDF or HTML file, and print those files at a later
time.

Refresh Alerts Refresh all the alerts from the database repository and update the
GUI by highlighting the appropriate objects and showing all the
new alerts in the alert logs.

Close Close the current window that occupies the content pane.

Exit End the current session.

View menu:

Use the options in the View menu to hide or show the navigation tree and
highlight the node in the navigation tree for the currently open window.

Menu Option Description

Tree Hide and show the navigation tree. If you want to increase the
size of the content pane to occupy the entire window, clear the
check box for the Tree option. To redisplay the navigation tree
next to the content pane in the main window, select the Tree
option.

Current Page in Tree Display the highlighted node on the navigation tree that was
responsible for displaying the data on the content pane. Use this
option to reorient the navigation tree with the window that is
currently displayed in the content pane.

Connection menu:

Use the option in the Connection menu to end the current session and establish a
new connection to the same IBM Tivoli Storage Productivity Center server or to a
different server.

Menu Option Description

New Connection Initiate a new connection to a server from the current GUI
session. For example, use this option to connect to the same
server using a different user ID, or to a completely different
server.

All the current changes that are unsaved in the open windows
will be lost when you establish a new connection.

Preferences menu:

Use the options in the Preferences menu to change the appearance of the user
interface, edit the way the product manages open panels, determine what alerts are
shown upon login, select what tab appears first when generating reports, and
specify what unit of measurement to use when displaying storage sizes in reports.
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Menu Option Description

Look and Feel Windows Set the look and feel of the GUI to appear like
Microsoft Windows GUI.

CDE/Motif Set the look and feel of the GUI to appear like
the UNIX Motif interface.

Metal Set the look and feel of the GUI to appear like
Metal, the cross-platform Java look and feel.

Edit General Panel Retention The Panel recall depth value specifies the
number of windows that are linked in the
content pane for access via the

and

buttons on the toolbar. The default is 20.

The Panels kept in memory field specifies the
number of windows to store in memory,
which helps to optimize the system
performance. The default is 2.
Note: Any open views in the topology viewer
(for example, an L2:Storage Subsystem view,
an L0:Computers view) are considered part of
the topology viewer panel and are listed as
tabs on the topology viewer panel. If the
value in this field is a low number, such as
the default of 2, then opening additional
non-topology panels can exceed the number
of panels that are kept in memory. This can
result in the topology viewer panel refreshing
and any tabbed views being closed. To avoid
this situation, change the value in this field to
a higher number, such as 10.

On login, show Control which alerts you will view upon
logging in to a user interface session.

You can select:

v No Alerts

v Alerts Directed to <Userid>

v All Active Alerts

Initial Reporting
Tab to Display

Control what tab will be displayed when you
first generate and view a report. You can
select:

v Selection tab

v Report tab

v Chart tab (if Available)
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Menu Option Description

Advanced Options Select the unit of measurement that should be
used to reflect the storage sizes included in
IBM Tivoli Storage Productivity Center
reports. This setting affects the results in
online, exported, and Batch reports. You can
choose from the following options:

v As Appropriate: Choose this option to
automatically determine the unit
measurement (KB, MB, GB, TB) to display
for storage sizes in a report.

v Kilobytes (KB): Choose this option to
display storage sizes in reports using the
kilobyte unit of measurement. For example,
if the storage capacity for a computer is 100
megabytes, it is shown as 102400.00 KB in a
capacity report.

v Megabytes (MB): Choose this option to
display storage sizes in reports using the
megabyte unit of measurement. For
example, if the storage capacity for a
computer is 1 gigabyte, it is shown as 1024
MB in a capacity report.

v Gigabytes (GB): Choose this option to
display storage sizes in reports using the
gigabyte unit of measurement. For example,
if the free space on a computer is 500
megabytes, it is shown as 0.49 GB in a free
space report.

v Terabytes (TB): Choose this option to
display storage sizes in reports using the
terabyte unit of measurement. For example,
if the free space on a computer is 350
gigabytes, it would be shown as 0.34 TB in
a free space report.

Window menu:

Use the options in the Windows menu to close all the open windows that do not
have any changes, display the dashboard, and list all the open windows.

Menu Option Description

Close all Windows Without
Changes

Close all of the open windows that do not contain any modifications. Any
windows that contain active changes to editable objects will not be closed.

Show Dashboard Display the IBM Tivoli Storage Productivity Center dashboard.

Show Window List Lists names of all open windows active in the content pane. Select one of these
options to view the corresponding window.

Beside each window name is an icon that indicates the status of the window:

v no icon - No changes were made to the window

v solid red circle - Changes were made, but have not been saved

v black arrow (>) - Current window displayed. No changes were made

v solid red arrow (>) - Current window displayed. Changes were made, but have
not been saved
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Help menu:

Use the options in the Help menu to access online help for the product, launch the
information center Web page, launch the Supported Products Web pages, launch
the demonstrations Web page, and display product information (such as the
version number).

Menu Option Description

Help Topics Select this menu item to launch IBM Tivoli Storage Productivity
Center's online Help system. The Help system will appear in its
own window and display a table of contents from which you
can access information about how to use the product.

Help for Displayed Panel Select this menu item to launch the online Help system and
display help information for the product window that is
currently displayed. You can also press F1 to launch the help
topic for the product window that you are viewing.

Launch Information
Center

Select this menu item to launch the information center for IBM
Tivoli Storage Productivity Center Information Center in a Web
browser. The IBM Tivoli Storage Productivity Center
Information Center contains detailed instructions that explain
how to install, upgrade, configure, maintain, and use the Tivoli
Storage Productivity Center product.

See “Web browser support” on page 40 for information about
Web browser support for launching the IBM Tivoli Storage
Productivity Center Information Center.

Supported Products Data Select the links under this menu item to launch Web pages that
contain additional documentation for Disk Manager, Fabric
Manager, and Data Manager. This documentation includes
matrixes that show the devices supported by each of the
managers.

v IBM Tivoli Storage Productivity Center for Disk Supported
Products. Click this item to view the Support for Tivoli
Storage Productivity Center for Disk Web page. To view the
devices supported by Disk Manager, scroll to the
Integration/Operation section and click the link that matches
your version of Tivoli Storage Productivity Center.

v IBM Tivoli Storage Productivity Center for Fabric
Supported Products. Click this item to view the Support for
Tivoli Storage Productivity Center for Fabric Web page. To
view the devices supported by Fabric Manager, scroll to the
Integration/Operation section and click the link that matches
your version of Tivoli Storage Productivity Center.

v IBM Tivoli Storage Productivity Center for Data Supported
Products. Click this item to view the Support for Tivoli
Storage Productivity Center for Data Web page. To view the
devices supported by Disk Manager, scroll to the
Integration/Operation section and click the link that matches
your version of Tivoli Storage Productivity Center.

See “Web browser support” on page 40 for information about
Web browser support for launching the supported products data
Web pages.
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Menu Option Description

Tivoli Storage
Productivity Center
Demos

Select this menu item to launch a Web page that contains Flash
demos of Tivoli Storage Productivity Center. These demos
provide an introduction to the product, the business and storage
administrator challenges that are met by the product, and
detailed information about the features and functions that the
product provides.

See “Web browser support” for information about Web browser
support for launching the product demos Web page.

Launch IBM Tivoli
Storage Productivity
Center Information
Center

Select this menu item to display product information including:

v version information

v copyright information

v trademark information

Web browser support:

IBM Tivoli Storage Productivity Center starts a web browser when you access web
pages from items in the Help menu, start another application using its
launch-in-context feature, or start IBM Tivoli Storage Productivity Center for
Replication from its user interface.

Note: The Tivoli Storage Productivity Center software is bundled with its own
IBM Java™ JRE. When you use the Java Web Start method of remotely accessing
the stand-alone GUI, you must use the IBM Java.

Before you start Tivoli Storage Productivity Center, ensure that you are using a
supported web browser. For a list of web browsers that you can use with Tivoli
Storage Productivity Center, see the support matrix at http://www.ibm.com/
support/docview.wss?uid=swg21386446. In the Agents, Servers and GUI column,
click the version of Tivoli Storage Productivity Center that you are installing. On
the next page, click Web Browsers to find the web browsers that you can use.

If you do not have a web browser configured for use with Tivoli Storage
Productivity Center when you access a web page from its user interface, the
Configure Element Launcher window is displayed. Use this window to configure a
web browser for use with the product.

Tip: For information about the web browsers that you can use with the DS8000,
see the DS8000 Information Center at http://publib.boulder.ibm.com/infocenter/
dsichelp/ds8000ic/index.jsp. Search for Internet browser support.

Browser-specific information: To download Firefox 3 for Linux or Windows, go
to ftp://ftp.mozilla.org/pub/mozilla.org/firefox/releases/.

The software to block pop-up windows must be turned off in Windows Internet
Explorer for any application to start the graphical user interface (GUI) for the
following storage systems:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified
v IBM SONAS
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For example, if you are in Tivoli Storage Productivity Center and you want to start
the Element Manager of the SAN Volume Controller GUI, you must configure
Internet Explorer with the following settings.
1. Open Internet Explorer.
2. From the Internet Explorer toolbar, click Tools > Pop-up Blocker > Turn Off

Pop-up Blocker.

If the Internet Explorer Information Bar displays a message that content is blocked
because it was not signed by a valid security certificate, click the Information Bar
and select Show blocked content.

Web browser support for Tivoli Storage Productivity Center for Replication

When you start Tivoli Storage Productivity Center for Replication from within the
Tivoli Storage Productivity Center, its user interface is displayed in a web browser.
Depending on the configuration settings for the web browser on your computer,
Tivoli Storage Productivity Center for Replication is displayed within a tab of an
existing browser session or it is displayed within a new browser session.

In Firefox, you can configure how Tivoli Storage Productivity Center for
Replication is displayed when started from Tivoli Storage Productivity Center. To
configure Firefox, complete the following steps:
1. Start Firefox.
2. Select Tools > Options from the menu bar.
3. Select Tabs.
4. Select a new window to indicate that you want start Tivoli Storage Productivity

Center for Replication in a new web browser session. Select a new tab to
indicate that you want to start Tivoli Storage Productivity Center for
Replication in a new tab of an existing web browser session.

Note: For Internet Explorer, Tivoli Storage Productivity Center for Replication
is always started in a new web browser session.

Note: If you start Tivoli Storage Productivity Center for Replication from within
Tivoli Storage Productivity Center, you might be logged out of the Tivoli Storage
Productivity Center for Replication user interface unexpectedly. This action occurs
when you use Tivoli Storage Productivity Center to start a session of Tivoli Storage
Productivity Center for Replication in an Internet Explorer web browser and then
open and close a wizard or secondary window in that Tivoli Storage Productivity
Center for Replication session.

To work around this problem, use one of these solutions:
v Start Tivoli Storage Productivity Center for Replication from Tivoli Storage

Productivity Center using Firefox
v Start Tivoli Storage Productivity Center for Replication from Tivoli Integrated

Portal
v Start Tivoli Storage Productivity Center for Replication by entering its web

address directly in a Firefox or Internet Explorer web browser.

Web browser support for Help menu items

Tivoli Storage Productivity Center provides a number of items in its Help menu
that you can click to learn more about how to use the product. When you click one
of these items, Tivoli Storage Productivity Center starts a web browser and
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displays the appropriate web page. You must have an internet connection on the
system where you are running the Tivoli Storage Productivity Center user
interface. You must also have a default browser configured to successfully access
these web pages.

Toolbar:

The toolbar on the Tivoli Storage Productivity Center main window provides
one-click access to key commands.

Click the following buttons on the toolbar to access key commands in the product:

Button Description

Element Management Click this button to open the Element Manager page in the
Configuration Utility. Use the Element Manager page to configure
and start the element managers that are visible to Tivoli Storage
Productivity Center. Element managers are programs that enable
you to configure and maintain your storage devices. An example
of an element manager is DS8000 Storage Manager, which is the
default element manager that is provided with IBM System
Storage DS8000.

Back Click this button to move backward through the active panels in
the content pane.

Forward Click this button to move forward through the active panels in
the content pane.

Save Click this button to save the current object that you are editing.
The object changes are saved to the database repository.

Print Click this button to print the current data or report chart that is
displayed in the content pane.

Cancel edit session Click this button to discard the contents of the content pane. If
content pane is in an edit session and changes have been made, a
prompt notifying you that a change has been made is displayed.

Configure devices Access the Configure Devices wizard. Use the wizard to configure
the following storage devices for monitoring by Tivoli Storage
Productivity Center.

v Storage systems

v Fabrics and switches

v Computers

v Tape libraries

The wizard guides you through the process of adding a storage
device as a data source, running a discovery, applying alert
conditions, and including the device in data collection schedules.
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Button Description

Manage jobs, schedules,
and runs

Access the Job Management panel. Use this panel to view and
manage the schedules, runs, and jobs related to the storage
devices that are monitored by Tivoli Storage Productivity Center.

Stop current server
request

Click this button to stop the current server request. This button
becomes active when a request is made to the server and the user
interface is waiting for a response.

During the server request wait time, the cursor arrow is
displayed as an hourglass. If you decide the current request is
taking too long or you do not want to wait any longer, click this
button to cancel that request and regain control of the GUI.
Note: If you click this button, the current request continues to
run, and the resources that are used by it on the server are not
released until it completes. Frequent use of this button during a
session might exhaust the resources on the server and cause the
user interface to stop responding.

Schedules, runs, and jobs:

Use schedules, run, and jobs to manage and monitor the storage entities in your
environment. These objects form the framework of job management within Tivoli
Storage Productivity Center. Use the Job Management panel to view and manage
the schedules, runs, and jobs related to the storage entities that are monitored by
the product.

In previous versions of Tivoli Storage Productivity Center, a schedule and its
related runs and jobs were displayed as nodes in different parts of the navigation
tree. In v4.2 and later, all schedules, runs, and jobs are displayed in the Job
Management panel. Use this panel to perform the following tasks:
v View information about all schedules, runs, and jobs in one central location.
v Identify all the schedules, runs, and jobs that are encountering problems when

executing.
v Ensure that a storage entity is fully monitored by Tivoli Storage Productivity

Center.
v Edit, rename, delete, and run schedules.

Schedules
A schedule is a definition of a monitoring task that collects data about
storage devices. Monitoring tasks include scans, probes, pings, quotas,
discovery, and performance monitors. For example, define a probe
schedule to collect data about storage subsystems; define a scan schedule
to collect file-level information about hosts.

Schedule definitions are displayed in the navigation tree under their
corresponding type. For example, probe schedules are displayed under the
IBM Tivoli Storage Productivity Center > Monitoring > Probes node;
scans are displayed under the Data Manager > Monitoring > Scans node.
You can click a schedule in the navigation tree to view or edit its definition
at any time.

Runs A run is a single invocation of a schedule. For example, if a probe schedule
is set to collect data once per day, there is one run of that schedule per day.
Runs for a schedule are displayed on the Job Management panel.

Jobs A job is a unit of work within a run for a schedule. One run might have
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multiple jobs. For example, a subsystem probe schedule has one job
created for each subsystem for which it collects data. Jobs for a run are
displayed on the Job Management panel.

Data Manager
Data Manager is a comprehensive file and capacity management solution for
heterogeneous storage environments. Data Manager includes enterprise-wide
reporting and monitoring, policy-based management and automated capacity
provisioning for Direct Attached Storage (DAS), network attached storage (NAS),
and SAN environments.

Data Manager helps you improve storage utilization, plan for future capacity, and
ensure availability by providing storage on demand for file systems. Use Data
Manager to perform the following functions:
v Discover and monitor disks, partitions, shared directories, and servers.
v Monitor and report on capacity and utilization across platforms to help you to

identify trends and prevent problems.
v Provides a wide variety of standardized reports about filesystems and storage

infrastructure to track usage and availability.
v Provide file analysis across platforms to help you to identify and reclaim space

used by non-essential files.
v Provide policy-based management and automated capacity provisioning for

filesystems when user-defined thresholds are reached.

Using these functions, Data Manager helps you reduce storage costs by:
v Improving storage utilization
v Enabling intelligent capacity planning
v Helping you manage more storage with the same staff
v Supporting application availability through computer uptime reporting and

application database monitoring.

Information collected by Data Manager helps you understand what is really going
on with data on your servers and in your storage environment. View when files
are created, accessed, and modified, and by what group or user. This type of
information helps system administrators map storage resources to the consumers
of the resource. The ability to map storage consumption to storage hardware has
become increasingly important as the size of open systems environments has
increased.

In addition to understanding the current consumption and usage of data within
the enterprise, Data Manager tracks the information over time. Not only does this
historical view of storage consumption and utilization show usage trends over
time, the system administrator can also see a projected use of storage in the future.
System administrators can prepare for the need to purchase additional capacity in
a planned proactive manner rather than reacting to out-of-space emergencies.

Use Data Manager policy functions to help you evaluate and control the usage and
status of your enterprise storage management assets. Because Data Manager is
policy-based, it has autonomic self-healing capabilities that can detect potential
problems and automatically make adjustments based on the policies and actions
you have established. Use the capability to provision storage based upon storage
policies to expand a file system, and to allocate storage to a volume.
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For example, Data Manager can notify you when your system is running out of
disk space or warn you of impending storage hardware failure. By alerting you to
these and other issues related to your stored data, Data Manager enables you to
prevent unnecessary system and application downtime.

Data Manager for Databases
Data Manager for Databases provides a set of policy-driven automated tools for
managing storage capacity, availability, events, performance and assets in your
relational databases. It can help you identify, evaluate, control and predict the
storage needs of Relational Database Management Systems (RDBMSs), which
include Oracle, Sybase SQL Server, Microsoft SQL Server, and UDB/DB2.

Data Manager for Databases is policy-based and through its autonomic self-healing
capabilities it can detect potential problems and automatically make adjustments
based on the policies and actions you have established. For example, it can notify
you when your database tables are running out of storage space or warn you of a
dropped tablespace. By alerting you to these and other issues related to your
stored data, it enables you to prevent unnecessary system and application
downtime.

The following table lists the RDBMS objects whose storage usage is monitored by
Data Manager for Databases.

Oracle SQL Server Sybase DB2/UDB

Instances Instances Instances Instances
Databases Databases Devices Databases
Tablespaces Datafiles Databases Tablespaces
Datafiles Tables Fragments Containers
Tables Indexes Tables Tables
Indexes Log Files Indexes Indexes
Extents
Segments
Redo Log files
Control Files
Archive Log
Directories

Note: Data Manager for Databases does not currently support the monitoring of
clustered database applications.

Data Manager for Databases collects information about RDBMS storage assets and
performs tasks against the RDBMS storage assets. Methods for managing and
automating capacity utilization of your databases help you:
v Monitor storage assets associated with enterprise-wide databases and

notification of potential problems before they occur
v Make intelligent capacity management decisions based on current and trended

historical data
v See how much storage is being consumed by users, groups of users and OS's

within the database
v Create policy-based management for databases when user-defined threshold is

reached
v View storage utilization management from a database and application

perspective
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Data Manager for Chargeback
Data Manager for Chargeback uses the storage usage information gathered by Data
Manager and Data Manager for Databases to generate invoices that chargeback for
storage usage.

With Data Manager for Chargeback you can collect usage information on a
departmental, group, or user level. You can allocate costs by storage usage by user,
disk capacity by computer, tablespace, or file system/physical device. You can
create cost centers by creating user, computer, or tablespace groups, allowing
organization to chargeback individuals or business units for their storage usage. By
understanding the costs associated with existing and future storage usage, you can
improve the use of that storage and reduce the costs associated with its
maintenances and upgrades.

Using Data Manager, you can run monitoring jobs that gather detailed statistics
about the usage and trending of the storage consumed by the users and user
groups within your organization. Using Data Manager for Databases, you can run
monitoring jobs that gather detailed statistics about the usage and trending of the
storage consumed within RDBMS Instances by the users and user groups within
your organization.

In addition to providing invoicing for storage usage, Data Manager for Chargeback
also integrates with the chargeback systems already implemented in your
environment. It provides you with a higher level, application-specific CIMS output
format which can be imported into CIMS applications. With Data Manager for
Chargeback, you can export chargeback data for direct import into CIMS, giving
you the ability to integrate your storage usage data with other enterprise
chargeback information and processes.

Disk Manager
Disk Manager helps you manage SANs and heterogeneous storage from a single
console.

With Disk Manager you can manage network storage components such as:
v IBM System Storage SAN Volume Controller
v IBM Storwize V7000
v Storwize V7000 Unified
v IBM TotalStorage Enterprise Storage Server (TotalStorage Enterprise Storage

Server)
v Tivoli Storage Productivity Center disk systems (DS4000, DS5000, DS6000, and

DS8000 series)
v IBM XIV Storage System
v IBM SONAS
v Other storage subsystems that support the SMI-S standards

For those devices that use the native interfaces (DS8000, SAN Volume Controller,
Storwize V7000, IBM SONAS, and XIV) device discovery is performed when the
device is added to Tivoli Storage Productivity Center.

For those devices that use the SMI-S standards, device discovery is done using the
Service Location Protocol (SLP), as specified by SMI-S. Configuration of the
discovered devices is possible in conjunction with CIM agents associated with
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those devices, using the standard mechanisms defined in SMI-S. Disk Manager also
gathers events, and can launch an element manager specific to each device.

Disk Manager can:
v Collect and store performance data and provides alerts
v Provide graphical performance reports
v Help optimize storage allocation
v Provide volume contention analysis

Through the use of data collection, setting of thresholds and use of performance
reports, performance can be monitored for the TotalStorage Enterprise Storage
Server, DS4000, DS5000, DS6000, DS8000, SAN Volume Controller, Storwize V7000,
XIV, and any other storage subsystem that supports the SMI-S block server
performance subprofile. The performance function starts with the data collection
task, which captures performance statistics for the devices and stores the data in
the database.

After data collection is done, you can set thresholds to identify exceptions for
certain performance metrics, depending on the type of device. Threshold checking
is performed during data collection, and when performance is outside the specified
bounds, alerts can be generated.

After performance data has been collected, you can configure Disk Manager to
present graphical or text reports on the historical performance behavior of
specified devices, or of specific internal components of those devices. The
performance reports provide information about past period performance metrics or
current performance in graphical form.

Note: Tivoli Storage Productivity Center supports discovery of and reporting on
both FB and CKD volumes (and pools and arrays), but can create only FB volumes.
Tivoli Storage Productivity Center does not support the creation of CKD volumes.

Managing TagmaStore CIM agents
The TagmaStore CIM agents are provided by Hitachi Data Systems for the
TagmaStore storage subsystem. The TagmaStore CIM agent collects information
from the TagmaStore storage system.

IBM Tivoli Storage Productivity Center supports the Hitachi Data Systems
TagmaStore CIM Agent. For information about the CIM agent level supported, see
http://www.ibm.com/support/docview.wss?rs=40&q1=support+matrix
&uid=swg21386446&loc=en_US&cs=utf-8&lang=en. Click the appropriate version
under Storage. Tivoli Storage Productivity Center also supports the TagmaStore as
a Storage Virtualizer. Tivoli Storage Productivity Center can display information for
virtual disks and local disks.

Tivoli Storage Productivity Center cannot provide correlation information between
the virtual storage used by TagmaStore and the volumes created on the storage
due to an existing limitation of the CIM agent 5.8 from Hitachi Data Systems.
However, Tivoli Storage Productivity Center reports correctly display the
correlation between volumes created on the local storage and the local disks. This
limitation has no impact on the topology but it does affect several reports that
show the correlation:
v Data Manager > Reporting > Asset > By Storage Subsystem > <HDS_device>

> Disks > Volumes (does not show the relation between the disk and Volume or
volume in the tree)
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v Disk Manager > Reporting > Storage Subsystem > Volume to Backend
Volume Assignment

v Disk Manager > Reporting > Storage Subsystem > Computer Views (because
Tivoli Storage Productivity Center cannot populate the information for volumes
created on the virtual disks)

All volumes are created from a storage pool that is allocated from a primordial
storage pool and an imported primordial pool. A volume cannot be created over
both local and virtual extents.

For volume correlation, the host computer must have the Storage Resource agent
deployed and the TagmaStore device must be in the same SAN fabric. There must
also be a zone configured in the active zoneset between the ports of the host
computer and the ports of the TagmaStore device. The Storage Resource agent
must be configured for the fabric to which the host is connected.

For back-end correlation, the TagmaStore device ports and back-end subsystem
ports must be in the same zone and the back-end subsystem has assigned storage
volumes to all ports of the TagmaStore device.

Tape Manager
IBM Tivoli Storage Productivity Center Tape Manager helps you manage your
SMI-S compliant tape libraries.

Tape Manager lets you manage those tape libraries which are based on SMI-S 1.1
profile for tape libraries.

You must have at least Tape Operator authority to access the functions in the Tape
Manager node. To view your authority level, open the "Role to Group Mappings"
window in the Administrative Services > Configuration node in the navigation
tree.

With Tape Manager you can:
v Discover SMI-S compliant tape libraries attached to your SAN fabrics
v View tape library information
v Monitor tape libraries by probing for data and viewing alerts
v Create and view asset and capacity reports using data collected from your tape

libraries
v Use the topology viewer to view information about tape libraries

Fabric Manager
Fabric Manager helps you manage the SAN fabric that connects the host systems
and applications to the storage devices. It is a comprehensive management solution
for multi-vendor SANs and includes automatic resource and topology discovery,
monitoring and alerts, and zone control.

Fabric Manager is an enterprise scalable solution architected to ANSI SAN
standards, allowing you to choose the appropriate products for your environment.
It helps you:
v Simplify the task of SAN management and configuration
v Ensure SAN availability
v Improve SAN return on investment

48 IBM Tivoli Storage Productivity Center: User's Guide



Fabric Manager is able to do SAN fabric performance and capacity management
reporting and monitoring. Zoning is one of many SAN security options. Zoning is
the only configuration supported for this release. Along with subsystem based
volume masking, it is almost universally employed to ensure that only systems
that are authorized can access selected data. Zoning is provided by the switch at
the port level, so that, for example, a host on port X can access the subsystem
connected by port Y. When business needs change, often zones must change also.

Zone control is enabled from a centralized location. Existing zones can be
discovered and the members that make up the zone can be viewed and modified
by adding or deleting them. New zones can be created and existing zones can be
deleted. Fabric Manager makes working with zones easy by providing a GUI that
discovers SAN devices and makes them available to add or remove from zones as
individual devices.

The ability to do switch performance and capacity management reporting and
monitoring can help you to determine if more bandwidth is needed. Wide-area and
local-area IP networks, and storage area networks (SANs) move data from one
place to another. The management of the bandwidth is needed to continually
monitor for link utilization and errors. Data needs to be gathered to tune resources,
balance workloads, and do capacity planning.

With Fabric Manager, the comprehensive management of multi-vendor SANs can
help simplify the IT infrastructure by providing automatic resource and topology
discovery, monitoring, and alerts, and zone control. It brings all the sources of
information about SAN topology and configuration into a single place, and creates
topology mapping of the SANs. This topology offers both host-centric and
device-centric views that can be displayed graphically. The SAN topology display
tracks all topology and configuration changes through in-band, out-of-band, and
SMI-S monitoring. Without this type of centralized topology, information from a
number of sources, such as Element Management tools, device logs, and SNMP
traps would have to be continually monitored and manually correlated to
determine the current SAN configuration and topology.

Fabric Manager provides you with the ability to view events happening in your
SAN environment and records state changes. The events are displayed in a
color-coded fashion and can be further customized to reflect organizational
priorities. It will forward events signaling topology changes or updates to the IBM
Tivoli Enterprise Console, another SNMP manager, or both. Source side filtering by
the Fabric Manager enables you to control what events get sent to your centralized
console. Filtering helps ensure that the administrators get the information they
need and are not overwhelmed by extraneous information.

Tivoli Storage Productivity Center for Replication
Tivoli Storage Productivity Center includes Tivoli Storage Productivity Center for
Replication. Tivoli Storage Productivity Center for Replication manages copy
services in storage environments. Copy services are features that are used by storage
systems such as System Storage DS8000 to configure, manage, and monitor
data-copy functions. Copy services include IBM FlashCopy, Metro Mirror, Global
Mirror, and Metro Global Mirror.

Tivoli Storage Productivity Center for Replication provides copy services
management for the storage systems and session types that are listed in the
following table:
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Storage system Session type

System Storage DS8000 v Basic HyperSwap

v FlashCopy

v Metro Mirror Single Direction

v Metro Mirror Failover/Failback

v Metro Mirror Failover/Failback with Practice

v Global Mirror Single Direction

v Global Mirror Either Direction with Two-Site
Practice

v Global Mirror Failover/Failback

v Global Mirror Failover/Failback with Practice

v Metro Global Mirror

v Metro Global Mirror with Practice

System Storage DS6000 v Basic HyperSwap

v FlashCopy

v Metro Mirror Single Direction

v Metro Mirror Failover/Failback

v Metro Mirror Failover/Failback with Practice

v Global Mirror Single Direction

v Global Mirror Either Direction with Two-Site
Practice

v Global Mirror Failover/Failback

v Global Mirror Failover/Failback with Practice

TotalStorage Enterprise Storage
Server Model 800

v Basic HyperSwap

v FlashCopy

v Metro Mirror Single Direction

v Metro Mirror Failover/Failback

v Metro Mirror Failover/Failback with Practice

v Global Mirror Single Direction

v Global Mirror Either Direction with Two-Site
Practice

v Global Mirror Failover/Failback

v Global Mirror Failover/Failback with Practice

v Metro Global Mirror (only H1 site)

v Metro Global Mirror with Practice (only H1 site)

SAN Volume Controller v FlashCopy

v Metro Mirror Single Direction

v Metro Mirror Failover/Failback

v Metro Mirror Failover/Failback with Practice

v Global Mirror Single Direction

v Global Mirror Failover/Failback

v Global Mirror Failover/Failback with Practice
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Storage system Session type

Storwize V7000 v FlashCopy

v Metro Mirror Single Direction

v Metro Mirror Failover/Failback

v Metro Mirror Failover/Failback with Practice

v Global Mirror Single Direction

v Global Mirror Failover/Failback

v Global Mirror Failover/Failback with Practice

Storwize V7000 Unified v FlashCopy

v Metro Mirror Single Direction

v Metro Mirror Failover/Failback

v Metro Mirror Failover/Failback with Practice

v Global Mirror Single Direction

v Global Mirror Failover/Failback

v Global Mirror Failover/Failback with Practice

The XIV system v Snapshot

v Metro Mirror Failover/Failback

v Global Mirror Failover/Failback

Architecture
Tivoli Storage Productivity Center for Replication consists of several key
components.

Tivoli Storage Productivity Center for Replication server
The Tivoli Storage Productivity Center for Replication server is the control
point for the sessions, storage systems, hosts, and other components that
are managed by Tivoli Storage Productivity Center for Replication.

Database
A single database instance serves as the repository for all Tivoli Storage
Productivity Center for Replication data.

An embedded database is provided with Tivoli Storage Productivity Center
for Replication.

GUI The graphical user interface (GUI) is used to manage all Tivoli Storage
Productivity Center for Replication functions.

CLI The command-line interface (CLI) is used to issue commands for key Tivoli
Storage Productivity Center for Replication functions.

Interfaces for Tivoli Storage Productivity Center for
Replication

Tivoli Storage Productivity Center for Replication provides a graphical user
interface (GUI) and a command-line interface (CLI) for managing data replication
and disaster recovery.

Graphical user interface

The Tivoli Storage Productivity Center for Replication GUI contains the following
features:
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Navigation tree
The navigation tree provides categories of tasks that you can complete in
Tivoli Storage Productivity Center for Replication. Clicking a task opens a
main page in the content panel.

Health Overview
The Health Overview area is under the navigation tree and shows a status
summary for all sessions, storage systems, host systems, and management
servers that Tivoli Storage Productivity Center for Replication is managing.

Content area
The content panel displays content based on the item that you selected in
the navigation tree.

You can view help for the currently displayed panel by clicking the ? icon.

You can view the information center by clicking the ←i icon. You must have
Internet access to view the information center.

When you log on to the GUI, the Health Overview panel is displayed in
the content area.

Command-line interface

You can use the Tivoli Storage Productivity Center for Replication CLI by using the
csmcli utilities. You can use the CLI directly or as a script for automating
functions.

For security, the CLI runs only on the Tivoli Storage Productivity Center for
Replication management server. You can run the CLI remotely using a
remote-access utility, such as Secure Shell (SSH) or Telnet.

For Tivoli Storage Productivity Center for Replication on Windows, you can specify
remote access to Linux or AIX® terminals if you enabled Telnet on your Windows
server.

Tivoli Storage Productivity Center for Replication integration
with Tivoli System Automation Application Manager

IBM Tivoli System Automation Application Manager includes a Distributed
Disaster Recovery (DDR) feature that uses IBM Tivoli Storage Productivity Center
for Replication to provide a data replication and disaster recovery solution for
distributed systems. The DDR feature is available in Tivoli System Automation
Application Manager version 3.2 or later and requires Tivoli Storage Productivity
Center for Replication version 3.4.1.8 or version 4.1.1.1 or later.

Tivoli System Automation Application Manager automates the availability of
information technology resources. The DDR feature and Tivoli Storage Productivity
Center for Replication provide a full end-to-end solution for site switching on
distributed systems at the application level.

For more information about the integration of Tivoli Storage Productivity Center
for Replication with Tivoli System Automation Application Manager, including the
steps required to perform the integration, see the Tivoli System Automation
Application Manager Administrator's and User's Guide. The administrator's guide is
provided in theTivoli System Automation Application Manager information centers
by version at http://www.ibm.com/developerworks/wikis/display/
tivolidoccentral/Tivoli+System+Automation+Application+Manager.
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Tivoli Integrated Portal
The IBM Tivoli Storage Productivity Center installation program includes IBM
Tivoli Integrated Portal. Tivoli Integrated Portal is a standards-based architecture
for Web administration. Tivoli Integrated Portal enables developers to build
administrative interfaces for IBM and independent software products as individual
plug-ins to a common console network. The installation of Tivoli Integrated Portal
is required to enable single sign-on for Tivoli Storage Productivity Center and to
access the web-based GUI.

Tivoli Integrated Portal and single sign-on

Single sign-on is an authentication process that you can use to enter one user ID
and password to access multiple applications. For example, you can access Tivoli
Integrated Portal and then access Tivoli Storage Productivity Center and IBM Tivoli
Storage Productivity Center for Replication from Tivoli Integrated Portal using a
single user ID and password. Single sign-on integrates with the launch and launch
in context features to enable you to move smoothly from one application to
another application.
Related concepts:
“Single sign-on”
Single sign-on is an authentication process that enables you to enter one user ID
and password to access multiple applications. For example, you can access IBM
Tivoli Integrated Portal and then access IBM Tivoli Storage Productivity Center and
IBM Tivoli Storage Productivity Center for Replication from Tivoli Integrated
Portal using a single user ID and password. Single sign-on integrates with the
launch and launch in context features to enable you to move smoothly from one
application to another application.
“Launch and launch in context” on page 56
The launch and launch in context features are used to start IBM Tivoli Storage
Productivity Center and to start other applications from Tivoli Storage Productivity
Center. The terms inbound and outbound are used to differentiate starting Tivoli
Storage Productivity Center (inbound) and starting another application from Tivoli
Storage Productivity Center (outbound).
Chapter 6, “Managing resources in the web-based GUI,” on page 623
You can use the web-based GUI to monitor the condition, capacity, and
relationships of the monitored resources within your storage environment.

Key concepts
This section contains a technical overview that will help you understand how IBM
Tivoli Storage Productivity Center works. An understanding of the concepts in this
section will help you use Tivoli Storage Productivity Center effectively.

Single sign-on
Single sign-on is an authentication process that enables you to enter one user ID
and password to access multiple applications. For example, you can access IBM
Tivoli Integrated Portal and then access IBM Tivoli Storage Productivity Center and
IBM Tivoli Storage Productivity Center for Replication from Tivoli Integrated
Portal using a single user ID and password. Single sign-on integrates with the
launch and launch in context features to enable you to move smoothly from one
application to another application.
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For the current version of Tivoli Storage Productivity Center, single sign-on is
available for the following applications:
v Tivoli Storage Productivity Center for Replication
v IBM System Storage DS8000
v IBM System Storage SAN Volume Controller
v IBM Storwize V7000

For Tivoli Storage Productivity Center for Replication Storage Manager, single
sign-on is enabled by default.

For DS8000 Storage Manager, SAN Volume Controller, and Storwize V7000, single
sign-on must be enabled.

To enable single sign-on, see the following topics in the Tivoli Storage Productivity
Center information center:
v Configuring Tivoli Storage Productivity Center for DS8000 LDAP authentication
v Configuring Tivoli Storage Productivity Center for SAN Volume Controller and

Storwize V7000 single sign-on

How single sign-on works

A single sign-on environment requires a centralized authentication repository that
is accessed by all applications within the environment. When you log on to either
Tivoli Integrated Portal or Tivoli Storage Productivity Center, a Lightweight
Third-Party Authentication (LTPA) token is created and used for single sign-on
authentication when you start other applications from within the Tivoli Storage
Productivity Center GUI. LTPA is the security technology that is used in the IBM
WebSphere Application Server for passing the user authentication information
between applications. To use the LTPA tokens, each application must have the
same set of public keys to encrypt the user's information. The authenticating
service uses the corresponding private keys to decrypt the user's information for
authentication. As an additional security mechanism, LTPA tokens expire after a
determined amount of time. By default, the tokens expire after 24 hours. You can
change the LTPA token expiration time using the Tivoli Integrated Portal user
interface.

During the period between when you log on to Tivoli Storage Productivity Center
and when you start other applications, such as element managers, from the Tivoli
Storage Productivity Center GUI, the following conditions might occur:

Condition Explanation

The user password that was used to log on
to Tivoli Integrated Portal or Tivoli Storage
Productivity Center is changed in the user
repository.

Under this condition, the original user
credentials that were used to log into Tivoli
Integrated Portal or Tivoli Storage
Productivity Center are used to access other
applications until the timeout period for the
LTPA token that is used for single sign-on
expires. When the LTPA token expires, you
are prompted to reenter your user ID and
password when you attempt to start another
application using single sign-on.
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Condition Explanation

The user ID that was used to access Tivoli
Integrated Portal is changed in the
repository or removed from the user
repository.

Under this condition, the single sign-on
feature does not work. You are always
prompted to re-enter your user ID and
password when you attempt to start another
application through single sign-on.

The user repository is not accessible. Under this condition, the single sign-on
feature does not work. You are always
prompted to re-enter your user ID and
password when you attempt to start another
application through single sign-on.

Tivoli Storage Productivity Center and IBM Tivoli Storage Productivity Center for
Replication use their respective IBM WebSphere Application Server instances to
authenticate LTPA tokens. However, other applications, such as the IBM System
Storage DS8000 element manager and other element managers that do not run
within an IBM WebSphere Application Server instance use the authentication
service that is provided with Tivoli Integrated Portal. The authentication service
client is typically embedded in these other applications and the client
communicates with the authentication service server in Tivoli Integrated Portal for
all authentication requests.

The single sign-on feature is not supported by the Tivoli Storage Productivity
Center command-line interface (CLI).

Selecting the user authentication method to use with single
sign-on

During the installation of Tivoli Storage Productivity Center, you can specify
whether to use LDAP or the operating system as the authentication and
authorization repository (see the following description of each authentication type).
If you do not specify LDAP, then Tivoli Storage Productivity Center uses the
operating system (OS) users and groups on the server where Tivoli Storage
Productivity Center is installed for authentication and authorization.

OS Authentication
This method authenticates the user against the users defined for the local
operating system (OS).

LDAP/Active Directory
This method authenticates the user against a Lightweight Directory Access
Protocol (LDAP) or Microsoft Active Directory repository.

If OS authentication is selected, the use of the single sign-on feature is limited. OS
authentication does not support single sign-on for element managers, even when
the element manager is installed on the same computer as Tivoli Storage
Productivity Center. LDAP or Microsoft Active Directory authentication supports
single sign-on for element managers regardless of where they are installed.

You can change the user authentication method using the Tivoli Integrated Portal
graphical user interface (GUI).

During installation, you can specify that Tivoli Storage Productivity Center use an
existing Tivoli Integrated Portal instance rather than the instance that is installed
with Tivoli Storage Productivity Center. In this case, Tivoli Storage Productivity
Center uses the authentication repository that is used by Tivoli Integrated Portal
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(LDAP or the operating system). However, if the existing Tivoli Integrated Portal
instance uses a file-based authentication repository, you cannot use the existing
Tivoli Integrated Portal instance. You must install a new Tivoli Integrated Portal
instance when you install Tivoli Storage Productivity Center.
Related concepts:
“Changing the user authentication configuration” on page 231
The Tivoli Storage Productivity Center installation program establishes a default
authentication configuration using the federated repositories feature of the
WebSphere Application Server. If you want to change the user authentication
configuration, follow these procedures.
Related tasks:
“Changing the LTPA token expiration for single sign-on” on page 248
For single sign-on, the user authentication information is passed between
applications using Lightweight Third-Party Authentication (LTPA) tokens. By
default, the tokens expire after eight hours. You can change the LTPA token
expiration time using the Tivoli Integrated Portal user interface.

Launch and launch in context
The launch and launch in context features are used to start IBM Tivoli Storage
Productivity Center and to start other applications from Tivoli Storage Productivity
Center. The terms inbound and outbound are used to differentiate starting Tivoli
Storage Productivity Center (inbound) and starting another application from Tivoli
Storage Productivity Center (outbound).

Inbound launch in context refers to starting Tivoli Storage Productivity Center at a
specific point in the graphical user interface (GUI). You can use inbound launch in
context in either of the following ways:
v Configure an application such as Tivoli Enterprise Portal to start Tivoli Storage

Productivity Center at functionally related locations in the Tivoli Storage
Productivity Center GUI.

v Start Tivoli Storage Productivity Center from Java Web Start, the command line,
or the Windows Start menu using parameters to specify the starting location in
the Tivoli Storage Productivity Center GUI.

Outbound launch in context refers to starting other applications, such as
administrative applications for storage systems and switches, from functionally
related points in the Tivoli Storage Productivity Center GUI.

Launch refers to starting an application at the starting point for that application.
Launch primarily refers to starting applications from the Tivoli Storage
Productivity Center GUI. Starting applications from Tivoli Storage Productivity
Center is referred to as an outbound launch.

56 IBM Tivoli Storage Productivity Center: User's Guide



Related concepts:
“Inbound launch in context feature”
With the inbound launch in context feature you can start IBM Tivoli Storage
Productivity Center at a specified point in the graphical user interface (GUI).
“Outbound launch and launch in context features” on page 64
With the outbound launch and launch in context features, you can start the
administrative applications for devices such as storage systems and switches from
various points in the graphical user interface (GUI).

Inbound launch in context feature
With the inbound launch in context feature you can start IBM Tivoli Storage
Productivity Center at a specified point in the graphical user interface (GUI).

Prerequisite: You must have View and Modify permissions to use the launch in
context feature.

You can use the launch in context feature to perform the following tasks in Tivoli
Storage Productivity Center:
v Create a volume or VDisk
v Open the storage area network SAN Planner
v Create a capacity report
v Create a wasted space report

You can run the launch in context feature in the following ways:
v Use Java Web Start from a Web browser. See “Launch with Java Web Start.”
v Use the command line on Windows, AIX, Linux, or UNIX to enter the

command and arguments on the command line. See “Launch from the command
line” on page 59.

v Use the Windows Start menu. See “Launch from Start menu” on page 60.
v Use the Tivoli Enterprise Portal GUI to define, edit, and launch commands. See

“Launch from Tivoli Enterprise Portal” on page 61.

The launch in context feature has a number of parameters. See “Launch in context
parameters” on page 1432, “Launch in context task parameters” on page 1434, and
“Available windows” on page 1435.

Launch with Java Web Start:

Using Java Web Start, you can use the launch in context feature from a Uniform
Resource Locator (URL).

The launch in context feature requires Java Web Start 6 on the computer that is
running the Web browser. If the correct release of Java Web Start is not present,
you receive an error message when you enter the URL. The message states that
you must download the Java Runtime Environment, which includes Java Web
Start. Follow the link provided in the message to install the required software.

If you are using Internet Protocol Version 6 (IPv6) and are using Java Web Start to
start IBM Tivoli Storage Productivity Center on a Windows system, use a system
host name such as tpc332.storage.newyork.xyz.com:9549 in the Web browser
address field rather than an IPv6 address such as
[2001:DB8:0000:1234:0000:0000:5678:ABCD]:9549.
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To use the launch in context feature to perform a task or display a window on a
remote server from your browser, complete the following steps:
1. Open your browser and type the launch in context command.

URLs cannot include spaces. In the command, a parameter and its value are
separated by an equal sign (=). Parameter=value pairs are separated by an
ampersand (&).
The format of a command to create a volume is:
https://device_server:device_port/ITSRM/jsp/jnlp/
tpcgui.jsp?consoleClass=com.ibm.usmi.console.lic.tpc.LICConsole&-
server=server:port&-function=disk.create_volume&-subsystem_id=ESS-2105-
17844-IBM&-name=myvol&-number=2&-size=10&-unit=MB

The format of a command to view a window on a remote server is:
http://device_server:device_port/ITSRM/jsp/jnlp/
tpcgui.jsp?consoleClass=com.ibm.usmi.console.lic.tpc.LICConsole&-
server=server:port&-function=window_name

Tip: The Data server port value is 9549. The port value for the Device server is
9551 for https and 9550 for http. If the wrong the Device server port value is
used, the return page cannot be interpreted by the browser. If the wrong Data
server port value is used, the following error message is returned.
Unable to connect to the server

2. The first time a window or task is started, you receive a security warning
informing you that the downloaded jar files have been digitally signed using a
certificate from a trusted company. To prevent this message from being
displayed in the future, select Always trust content from this publisher and
click Run. If the Tivoli Storage Productivity Center graphical user interface
(GUI) has not been downloaded on the local computer using Java Web Start, or
the local computer does not have the latest version of the Tivoli Storage
Productivity Center GUI, the GUI is downloaded.

3. If you included the user ID and password in the command, the sign-in dialog
is bypassed, otherwise log on to the Tivoli Storage Productivity Center GUI.
The Tivoli Storage Productivity Center GUI navigates to the tree node
corresponding to the window name that you specified. You are connected using
the user name and password that you entered. Depending on the value you
specified for the -function parameter, the following actions might occur:
v The specified window opens
v For disk.create_volume, depending on the parameters, the Create Volume

wizard or Create VDisk wizard opens.
v For disk.san_planner, the SAN Planner panel opens with the given SAN plan

ID.
v For data.filesystem_capacity_by_computer, the Capacity Report opens.
v For TPC.reports_data_wasted_space, the Wasted Space Report opens.

Restrictions:

v When you open a plan in the SAN Planner using launch in context, you must
enter the exact name of the plan. The value for the -plan_id parameter is
case-sensitive and must match the name of the plan when it was created. For
example, if you created a plan named UserPlan1, you must specify -plan_id
UserPlan1 in the launch in context command.

v There is a known limitation when you launch the Filesystem Capacity > By
Computer report using launch in context, you must specify the ID for the
computer upon which you want to report. For example:
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http://tpcserver14:9550/ITSRM/jsp/jnlp/
tpcgui.jsp?consoleClass=com.ibm.usmi.console.lic.tpc.LICConsole&-
server=tpcserver14.storage.xyz.com:9549&-
function=data.filesystem_capacity_by_computer&-computer_id=tpcserver14

The value you enter for the computer_id parameter might not match the ID for
that computer that is stored in the Tivoli Storage Productivity Center database
repository. You receive a warning message if the ID for the computer that you
enter in the URL does not match the ID that is stored in the data repository. To
ensure that this report is displayed properly when you run from the launch in
context facility, enter an ID for the computer that matches the ID that is
displayed for it through the Topology Viewer or appropriate report in the
product user interface.

Use the information in the following links to enter parameters. If any of the
parameters are spelled incorrectly, an error message indicates the incorrect
parameter.

“Launch in context parameters” on page 1432
You can use the launch in context parameters, definitions, and examples.
“Launch in context task parameters” on page 1434
Use the launch in context feature task parameters to perform tasks.
“Available windows” on page 1435
You can use windows with the inbound launch in context feature to start IBM
Tivoli Storage Productivity Center. These windows are called with the
-function window name argument.

Launch from the command line:

This topic describes how to start windows and tasks from the Windows AIX,
Linux, or UNIX command line.

The bat file tpc.bat is used for Windows operating systems. The .sh file TPCD.sh is
used for AIX, Linux, or UNIX systems. The parameters follow the file name.
Parameters are separated by spaces. Parameters are optional and can appear in any
order. See “Launch in context parameters” on page 1432, “Launch in context task
parameters” on page 1434, and “Available windows” on page 1435 for the
parameters.

Frequently used commands can be saved as unique command files and rerun as
needed.
1. In the Command Prompt window, type the command for the action that you

want to take, and press Enter.
The action occurs on the remote Data server. The graphical user interface (GUI)
window for that action opens on the local computer.

2. Enter parameters if you previously did not enter any parameters. If you do not
provide a user name, password, or server name, the IBM Tivoli Storage
Productivity Center GUI opens the connection dialog box. If you do not
provide these values, the GUI presents an error message box and requests the
values. If you specify incorrect parameters, you receive an error message.

The following example launches a task from the Windows command line:

tpc.bat -user admin -passwd password1 -server
tivolii122.storage.usca.ibm.com:9549 -function
data.filesystem_capacity_by_computer -computer_id <computerID>
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The following example uses the launch in context feature to view a window on the
remote machine:

tpc.bat -user admin -passwd password1 -server
tivolii122.storage.usca.ibm.com:9549 -function disk.storage_subsystem

Restrictions:

v When you open a plan in the SAN Planner using the command line or a Web
browser for launch in context, you must enter the exact name of the plan. The
value for -plan_id in the command line is case-sensitive and must match the
name of the plan when it was created. For example, if you created a plan named
UserPlan1, you might enter the following command on the command line:
./TPCD.sh -user administrator -passwd passw0rd -server
tpcserver14.storage.xyz.com:9549 -function disk.san_Planner -plan_id
UserPlan1

v There is a known limitation when you start the Filesystem Capacity > By
Computer report using launch in context. To start this report, you must specify
the ID for the computer upon which you want to report. For example:
./TPCD.sh -user root -passwd "passw0rd" -server
tpcserver14.storage.xyz.com:9549 -function
data.filesystem_capacity_by_computer -computer_id tpcserver14

The value you enter for "computer_id" might not match the ID for that computer
that is stored in the Tivoli Storage Productivity Center database repository. You
will receive a warning message if the ID for the computer you enter in the
command line does not match the ID stored in the data repository. To ensure
that this report is displayed properly when run from the launch in context
command line or through Java Web Start, make sure to enter an ID for the
computer that matches the ID that is displayed for it through the Topology
Viewer or appropriate report in the product's user interface.

Launch from Start menu:

This topic describes how to start windows and actions from the Windows Start
menu.

The bat file, tpc.bat, is used for Windows operating systems. The parameters
follow the bat file name. Parameters are optional and can appear in any order. To
use the launch in context feature from the Windows Start menu, complete the
following steps:
1. Click Start > Programs > IBM Tivoli Storage Productivity Center, right-click

Productivity Center and select Properties. The Productivity Center Properties
window opens.

2. Enter the command-line arguments in the Target text field and click Enter.
If the Data server is remote, the action occurs on the Data server and the
graphical user interface (GUI) window the action opens is on the local
computer.

3. Enter the parameters if you did not previously enter the necessary parameters.
If you do not provide the user name, password, or server name, the Tivoli
Storage Productivity Center GUI opens the connection dialog box. If you do not
provide these values, the GUI presents an error message box and requests the
values.

The following example starts a task from the Windows Start menu:
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"C:\Program Files\IBM\TPC\gui\tpc.bat" -user admin -passwd password1
-server tivolii122.storage.usca.ibm.com:9549 -function
data.filesystem_capacity_by_computer -computer_id computerID

The following example uses the Windows Start menu to view a window on the
remote server:

"C:\Program Files\IBM\TPC\gui\tpc.bat" -user admin -passwd password1
-server tivolii122.storage.usca.ibm.com:9549 -function
disk.storage_subsystem

For more information see:

“Launch in context parameters” on page 1432
You can use the launch in context parameters, definitions, and examples.
“Launch in context task parameters” on page 1434
Use the launch in context feature task parameters to perform tasks.
“Available windows” on page 1435
You can use windows with the inbound launch in context feature to start IBM
Tivoli Storage Productivity Center. These windows are called with the
-function window name argument.

Launch from Tivoli Enterprise Portal:

This topic shows you how to start an existing launch definition from the Tivoli
Enterprise Portal graphical user interface (GUI).

You must configure Tivoli Enterprise Portal before you can use the launch in
context feature. For information on prerequisites and details on how to configure
the launch in context feature with Tivoli Enterprise Portal, see “Configuring Tivoli
Enterprise Portal” on page 62. After Tivoli Enterprise Portal has been configured,
you can start the application from the configuration window or use Launch from
the Tivoli Enterprise Portal navigation tree.

If you use the Tivoli Enterprise Portal navigation tree, Launch will open the Tivoli
Enterprise Portal graphical user interface with your predefined launch in context
commands. To use one of these commands, complete the following steps:
1. In the Tivoli Enterprise Portal window, expand Enterprise > Windows Systems

your_server_name > Windows OS. Right-click Disk and select Launch. Disk is
one of several values you can select. Values include Disk, Network, Enterprise
Services, Memory, Printer, Process, Processor, and System.

2. The Create or Edit Launch Definitions window opens showing a list of defined
launch definitions in the Existing Launch Definitions area.

3. Select the launch definition you want to use from the list and click Launch. The
window or task that is defined by that launch definition opens.

For information on editing the launch in context command with the Tivoli
Enterprise Portal GUI, see:
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Related tasks:
“Editing launch definitions” on page 63
You can edit an existing launch definition with the Tivoli Enterprise Portal
graphical user interface (GUI).

Configuring Tivoli Enterprise Portal:

You can configure Tivoli Enterprise Portal so that you can use the launch in
context feature.

To configure Tivoli Enterprise Portal complete the following steps:
1. The initial steps depend on whether you are going to open a window or

perform a task.
a. If you are opening a window, in the Tivoli Enterprise Portal navigation

window on the local computer, select where you want the launch
definition to originate from. This opens the corresponding view on the
target computer. Right-click one of the following locations.
v The navigator item
v A row in a table or situation event console view
v A slice of a pie chart
v A bar of a bar chart
If the launch definition originates from a table, chart, or situation event
console view, open the workspace containing the view. If you think you
might edit the argument later, create the launch definition from a table or
chart view.

b. If you are going to perform a task, create a launch definition for one of the
following tasks:
v Create a volume or VDisk
v Open the SAN Planner
v Create a capacity report
v Create a wasted space report

2. In the Tivoli Enterprise Portal window, expand Enterprise > Windows
Systems > your_server_name > Windows OS. Right-click Disk and select
Launch. Disk is one of several values you can select. Values include Disk,
Network, Enterprise Services, Memory, Printer, Process, Processor, and System.

3. The Create or Edit Launch Definitions window opens. Click Create New.
4. In the Name text field, type a descriptive name for this launch definition. This

name is used in the definition list.
5. In the Target text box click Browse to locate the tpc.bat file. The Select files

for directories for Launch Definitions window opens. A typical location for
Windows systems is C:\Program Files\IBM\TPC\gui\tpc.bat. Select the correct
directory and click OK.
When you start a launch definition from the command line, if any part of the
path contains spaces, enclose the entire entry in quotation marks.

6. In the Arguments text field, enter any parameters that will be added when
the application is started. Arguments are entered as -parameter value. In the
Create or Edit Launch Definitions window, click Browse next to Arguments to
locate the parameters that you want to use. The Select Browser Options
window opens. Click Substitutable Items and then click OK. Select
parameters from the Selected Context and Extended Context lists.
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The help argument lists the available function values. You must type the help
parameter by itself into the Arguments text field or into the form tpc.bat
-help functions on the command line for Windows or TPCD.sh -help
functions for UNIX. The -help functions parameter provides a window that
lists the nodes in the navigation tree that are available to start. If you type
-help without the functions parameter, it results in an error message.
When all parameters have been selected, click OK to return to the Create or
Edit Launch Definitions window.

7. If the parameters can be changed at launch time (for example, you want to
change the system ID), check the Edit arguments before execution box.

8. Specify a value for the Start in location. Click Browse to locate the IBM Tivoli
Storage Productivity Center installation and select the folder gui where
tpc.bat is located.

9. Click Evaluate to see how the command resolves when the application starts.
Correct any of the parameters that are incorrect and reevaluate the command.

10. When you are satisfied with the launch definition, click Apply to save your
changes. This keeps the window open so that you can start the current launch
definition or create a new one. Click OK to save the launch definition and
close the window.

11. To start the current definition, select Launch. The Tivoli Storage Productivity
Center graphical user interface (GUI) with the function parameter that you
have provided is opened.

Related reference:
“Launch in context parameters” on page 1432
You can use the launch in context parameters, definitions, and examples.
“Launch in context task parameters” on page 1434
Use the launch in context feature task parameters to perform tasks.
“Available windows” on page 1435
You can use windows with the inbound launch in context feature to start IBM
Tivoli Storage Productivity Center. These windows are called with the -function
window name argument.

Editing launch definitions:

You can edit an existing launch definition with the Tivoli Enterprise Portal
graphical user interface (GUI).

If the Edit arguments before execution box was checked when a launch definition
was configured, you can edit the launch definition by changing the attribute
values. To edit a launch definition, complete the following steps:
1. In the Tivoli Enterprise Portal window, expand Enterprise > Windows Systems

> your_server_name > Windows OS. Right-click Disk and select Launch. Disk
is one of several nodes you can select. Nodes include Disk, Network, Enterprise
Services, Memory, Printer, Process, Processor, and System.

2. The Create or Edit Launch Definitions window opens showing a list of launch
definitions in the Existing Launch Definitions area.

3. Select the launch definition that you want to edit. The values are displayed.
4. Make the necessary changes in the text fields.
5. Click Evaluate to see how the arguments will resolve when the application

starts. Correct any incorrect arguments and re-evaluate the command.
6. Click Apply to save the changes and keep the window open. Click OK to save

the launch definition and close the window.
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If you do not want to overwrite the existing launch definition, save the new
launch definition with a unique name.

Outbound launch and launch in context features
With the outbound launch and launch in context features, you can start the
administrative applications for devices such as storage systems and switches from
various points in the graphical user interface (GUI).

There are two options for starting an application from Tivoli Storage Productivity
Center. The option that is available depends on the device that you want to start.

The launch feature starts an application at the starting point for that application.

The launch in context feature starts an application at a functionally related location
in that application. Launch in context is available for the following applications:
v Tivoli Storage Productivity Center for Replication
v SAN Volume Controller 6.1 or later
v Storwize V7000
v Storwize V7000 Unified
v IBM SONAS

Launch menu

When you right-click one of the following entities in Tivoli Storage Productivity
Center GUI, you see a launch menu for that entity. The content of the launch menu
varies as described in “Launch menu items” on page 65.
v Alert Log Viewer. Each row of the alert log is enabled for a launch in context

menu. The context is determined by the type of the alert. Alert types include:
– Replication
– Storage Subsystem
– Computer
– Fabric
– Switch
– Port
– Tape Library

v Disk Manager Storage Subsystems table
v Fabric Manager Fabrics table
v Tape Manager Tape Libraries table
v Element Manager page (of the Configuration Utility)
v Topology Viewer objects. To see the icons that are associated with each Topology

Viewer object, refer to the following list.

Topology Viewer objects

Topology Object Icon

Fabric
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Topology Object Icon

Switch

Switch port

Tape library

Storage subsystem

Storage subsystem port

File system volume

Storage disk

Storage pool

Launch menu items

The following are the possible menu items that can be displayed in the launch
menu:

Launch in context defined application
This menu item is displayed for each application that is defined by a
launch descriptor file. Tivoli Storage Productivity Center provides launch
descriptor files for the following applications:
v DS8000 Storage Manager
v The management console for the storage systems that are listed under

Management GUI.
v Tivoli Storage Productivity Center for Replication

If the corresponding launch descriptor files are found for the applications,
the following menu items are displayed:

DS8000 Storage Manager
Click this menu item to start DS8000 Storage Manager.

Management GUI
Click this menu item to start the management console for the
following storage systems:
v SAN Volume Controller 6.1 or later
v Storwize V7000
v Storwize V7000 Unified
v IBM SONAS
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Replication Storage Systems Overview
Click this menu item to start Tivoli Storage Productivity Center for
Replication. The window that is opened in the Tivoli Storage
Productivity Center for Replication GUI depends on the context for
the entity that you selected. For example, if you right-click a
storage device on the Element Manager tab of the Configuration
Utility and click Replication Storage Systems Overview, the Tivoli
Storage Productivity Center for Replication Storage Systems
window opens.

If the launch descriptor file cannot be found, the Launch file items error
menu item is displayed. Click this item to view a description of the
problem. The Launch file items error menu item is also displayed in
situations such as the IBM Tivoli Integrated Portal server is not installed or
is not accessible, the Tivoli Storage Productivity Center Data server is not
accessible, or another system error occurred.

External Tools
This menu item shows any external tools that are defined in the
Configuration Utility. Examples of external tools include web-based user
interfaces and local executable files. For example, you might add the
address of a website that you frequently access or an application that you
often use such as a text editor or a spreadsheet.

Element Manager
This menu item shows any element managers that were discovered for the
device by a Storage Management Initiative Specification (SMI-S) query. To
avoid menu item duplication, this item is not displayed when the
associated element manager is defined by a launch descriptor file. In this
situation, the element manager is displayed as a separate menu item.

User Defined Tools
This menu item shows any user-defined element managers that are defined
in the Configuration Utility. These element managers differ from the
element managers in the Element Manager menu because they are
user-defined and are not discovered by an SMI-S query.

Example launch menu

The following figure shows an example launch menu for a storage system in the
L0:Storage topology view. In this example, the menu items Replication Storage
Systems Overview, DS8000 Storage Manager, and External Tools are displayed.
The Element Manager menu item is not displayed because no element managers
other than DS8000 Storage Manager were discovered. The User Defined Tools
menu item is not displayed because there are no user-defined element managers
that are defined in the Configuration Utility.
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Using the single sign-on feature with launch or launch in context

Single sign-on is an authentication process in which you can access more than one
system or application by entering a single user ID and password. Single sign-on
enables you to start applications from Tivoli Storage Productivity Center without
providing logon credentials for the application. Single sign-on is available only for
Tivoli Storage Productivity Center for Replication, DS8000, SAN Volume Controller
6.1 and later, and Storwize V7000.

For Tivoli Storage Productivity Center for Replication Storage Manager, single
sign-on is enabled by default. For DS8000 Storage Manager, SAN Volume
Controller, and Storwize V7000, single sign-on must be enabled.

To enable single sign-on, see the following topics in the Tivoli Storage Productivity
Center information center:
v Configuring Tivoli Storage Productivity Center for DS8000 LDAP authentication
v Configuring Tivoli Storage Productivity Center for SAN Volume Controller and

Storwize V7000 single sign-on
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Related concepts:
“Single sign-on” on page 53
Single sign-on is an authentication process that enables you to enter one user ID
and password to access multiple applications. For example, you can access IBM
Tivoli Integrated Portal and then access IBM Tivoli Storage Productivity Center and
IBM Tivoli Storage Productivity Center for Replication from Tivoli Integrated
Portal using a single user ID and password. Single sign-on integrates with the
launch and launch in context features to enable you to move smoothly from one
application to another application.

User roles
IBM Tivoli Storage Productivity Center provides user roles that can be mapped to
user groups contained in the authentication repository, which is either the local
operating system or an LDAP-compliant directory, depending on the choice of
authentication mechanism made during the Tivoli Storage Productivity Center
installation. The roles determine the user's ability to see and act upon specific
nodes in the navigation tree of the GUI. Other factors that affect the user's
capability are the components that are licensed, installed, and running.

The superuser is the highest level role and can be used to install IBM Tivoli
Storage Productivity Center and to initially set up the product. The superuser has
authority over all the other roles in Tivoli Storage Productivity Center:

The functions that are visible for the user roles require that the following
components be licensed and installed as shown in Table 11.

Table 11. Functions that require components to be licensed and installed

Function Component

Data Manager IBM Tivoli Storage Productivity Center for Data

Disk Manager (requires
Device server installation)

IBM Tivoli Storage Productivity Center for Data or Tivoli
Storage Productivity Center for Disk or IBM Tivoli Storage
Productivity Center for Fabric

Disk performance function
(requires Device server
installation)

Tivoli Storage Productivity Center for Disk

Fabric Manager (requires
Device server installation)

IBM Tivoli Storage Productivity Center for Fabric or IBM
Tivoli Storage Productivity Center for Data or Tivoli
Storage Productivity Center for Disk

Figure 4. User roles in Tivoli Storage Productivity Center
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Table 11. Functions that require components to be licensed and installed (continued)

Function Component

Fabric performance function
(requires Device server
installation)

IBM Tivoli Storage Productivity Center for Fabric

Tape Manager (requires
Device server installation)

IBM Tivoli Storage Productivity Center for Fabric or IBM
Tivoli Storage Productivity Center for Data or Tivoli
Storage Productivity Center for Disk

Element Manager IBM Tivoli Storage Productivity Center or IBM Storage
Productivity Center Select or IBM Tivoli Storage
Productivity Center Advanced Edition

Table 12 shows the GUI nodes that require special roles to view, edit, and act upon
the services. The Productivity Center administrator or superuser is required for
viewing configurations.

Table 12. GUI nodes that require special roles or licenses

GUI node Special roles

Administrative Services All roles can see this node but the user must
be a Productivity Center administrator or
superuser to edit and act upon the services
(for example enable or disable tracing, shut
down services, delete services, and so forth).

Administrative Services
- Configuration

- Role-to-Group Mappings

Only the Productivity Center administrator
or superuser can see this node.

Administrative Services
- Configuration

- License Keys

Only the Productivity Center administrator
or superuser can see this node.

Tivoli Storage Productivity Center
- My Reports

- System Reports
- Data

Requires the data administrator role to
create or edit objects, or to run jobs, (for
example, pings and scans). Requires the data
operator role to view reports.

Tivoli Storage Productivity Center
- My Reports

- System Reports
- Disk

Requires that the disk performance function
be installed and the disk operator role.

Tivoli Storage Productivity Center
- My Reports

- System Reports
- Fabric

Requires the fabric administrator role to
create or edit objects, or to run jobs (for
example, pings and scans). Requires the
fabric operator role to view reports. This
includes being able to view the fabric assets,
port connections, SAN switch report, switch
port errors, and switch ports (packet rate
and data rate).

Tivoli Storage Productivity Center
- My Reports

- Batch Reports

Requires any administrator role to create the
batch reports.

Tivoli Storage Productivity Center
- Monitoring

- Probes

Requires any administrator role to create or
edit probes.
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Table 12. GUI nodes that require special roles or licenses (continued)

GUI node Special roles

Tivoli Storage Productivity Center
- Alerting

- Alert log

Requires any administrator role to delete or
clear alerts. The Storage subsystems node
appears if any disk array is installed.

Data Manager Requires the data administrator role to
create or edit objects, or to run jobs (for
example, pings and scans). Requires the data
operator role to view reports.

Data Manager for Databases Requires the data administrator role to
create or edit objects, or to run jobs (for
example, pings and scans). Requires the data
operator role to view reports.

Data Manager for Chargeback Requires the data administrator or data
operator role.

Disk Manager Requires the disk administrator role to create
or edit objects, or to run jobs (for example,
pings and scans). Requires the disk operator
role to view reports. The Storage Subsystem
Performance Monitors node requires that the
Disk performance function is available.

Disk Manager
- Monitoring

- Subsystem Performance Monitors
- Profile Management
- Reporting

- Storage Subsystem Performance

Disk performance function must be
available.

Fabric Manager Requires the fabric administrator role to
create or edit objects, or to run jobs (for
example, pings and scans). Requires the
fabric operator role to view reports.

Fabric Manager
- Monitoring

- Switch Performance Monitors
- Reporting

- Switch Performance
- Constraint Violations

Fabric performance function must be
available.

Tape Manager Requires the tape administrator role to
create or edit objects, or to run jobs (for
example, pings and scans). Requires the tape
operator role to view reports.

Element Manager All roles can view and edit objects and run
jobs.

User tasks
This section provides an overview of the key IBM Tivoli Storage Productivity
Center tasks that you can perform. It includes tasks that are common to all
configurations and tasks that require that specific components be installed and
licensed.
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Common tasks
Perform common tasks on any Tivoli Storage Productivity Center configuration.
These tasks are available under the Administrative Services and IBM Tivoli
Storage Productivity Center nodes in the navigation tree.
v View and manage the services for the Data server, Device server, and Replication

server.
v Configure devices for monitoring by Tivoli Storage Productivity Center.
v Manage agents and data sources, including CIM agents, Storage Resource

agents, Data agents, Fabric agents, storage systems, Tivoli Storage Productivity
Center servers, and VMware VI.

v Discover storage devices that are visible to Tivoli Storage Productivity Center.
v Configure and customize Tivoli Storage Productivity Center for your

environment using the functions available under the Administrative Services >
Configuration node in the navigation tree.

v Authorize users by associating user groups with roles (requires superuser role).
v Deploy Storage Resource agents on hosts that you want to monitor.
v Manage all the schedules, runs, and jobs that are related to the monitoring of

storage devices by Tivoli Storage Productivity Center.
v Define probe schedules to collect information about storage devices and other

Tivoli Storage Productivity Center servers.
v Create batch reports for information that you want to view on a regular basis in

an output file.
v View System Reports that contain key information about the devices that are

monitored by Tivoli Storage Productivity Center. These reports are automatically
generated when data collection schedules are run.

v Generate Rollup Reports to view information that has been collected by Tivoli
Storage Productivity Center servers if you have multiple servers installed in
your environment.

v Create and manage groups of related storage entities. Use storage resource
groups as input into the SAN Planner.

v Analyze storage subsystems, identify performance bottlenecks, and recommend
changes to improve performance (Storage Optimizer).

v Create end-to-end planning for fabrics, hosts, storage controllers, storage pools,
volumes, paths, ports, zones, zone sets, and replication (SAN Planner).

v Determine whether existing SAN configurations violate defined best practices or
policies (Configuration Analysis).

v Check the alert log to see detailed information about alerts.
v Access a topology view of your storage infrastructure.
v Use Tape Manager to view tape libraries, create tape library groups and run

probes against those groups, and view tape library alerts.

Data Manager tasks
Data Manager tasks are tasks that are specific to the Data Manager, Data Manager
for Databases, and Data Manager for Chargeback components.

The following tasks are available under the Data Manager, Data Manager for
Databases, and Data Manager for Chargeback nodes in the navigation tree:
v Create monitoring groups that contain related storage devices. Use groups when

you want to perform the same action against multiple devices, such as collecting
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data with a scan or probe. In Data Manager, you can create groups of
computers, file systems, directories, users, OS user groups, databases,
tablespaces, and tables.

v Define ping schedules to collect availability information about computers and
clusters.

v Define scan schedules to collect detailed information about storage usage and
trending for computers, file systems, directories, and clusters.

v Create profiles to define the files that are scanned during a file systems scan and
the statistics that are gathered.

v Create and manage alerts for computers, file systems, directories, database
instances, tablespaces, and tables. Use alerts to be notified of conditions that are
detected on storage devices.

v Establish quotas and constraints to define storage use limits for users and user
groups.

v Automatically extend local file systems of managed hosts.
v Generate and view data system reports.
v Use Data Manager for Chargeback to generate invoices that charge back for

storage usage.

Disk Manager tasks
The Disk Manager tasks are tasks that are specific to the Disk Manager component.

The following tasks are available under the Disk Manager node in the navigation
tree:
v Configure storage systems for monitoring by Tivoli Storage Productivity Center.
v Create and manage virtual disks and volumes.
v Define and launch element managers for storage systems.
v Use the Storage Optimizer to identify performance bottlenecks and recommend

changes to improve performance for storage systems.
v Use the SAN Planner to perform end-to-end planning for fabrics, hosts, storage

controllers, storage pools, volumes, paths, ports, zones, zone sets, and
replication.

v Create monitoring groups that contain related storage systems. Use these groups
when you want to perform the same action against multiple storage systems,
such as collecting data with a probe.

v Define performance monitors to collect performance data related to storage
systems.

v Create and manage alerts for storage systems. Use alerts to be notified of
conditions that are detected on storage systems.

v Create workload profiles to be used by the SAN Planner to describe
characteristics of the volumes to be created.

v Create provisioning profiles to be used by the SAN Planner to define the actual
capacity (and security - zoning) characteristics of whatever the profile happens
to be associated with.

v Create thin provisioning profiles to specify the parameters for thin provisioned
volumes to be created through SAN Planner.

v Generate and view detailed reports about the storage systems that are monitored
by Tivoli Storage Productivity Center.

Fabric Manager tasks
Fabric Manager tasks are tasks that are specific to the Fabric Manager component.
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The following tasks are available under the Fabric Manager node in the navigation
tree:
v Configure fabrics and switches for monitoring by Tivoli Storage Productivity

Center.
v Create and work with fabric zones, zone aliases, and zone sets
v Create monitoring groups that contain related fabrics. Use these groups when

you want to perform the same action against multiple fabrics, such as collecting
data with a probe.

v Define switch performance monitors to collect performance data related to
switches.

v Create and manage alerts for fabrics, switches, and endpoint devices. Use alerts
to be notified of conditions that are detected on these storage devices.

v Generate and view fabric system reports and switch performance reports.

Tivoli Storage Productivity Center for Replication tasks
You can use Tivoli Storage Productivity Center for Replication to obtain continuous
availability and disaster recovery solutions by using point-in-time replication,
which includes FlashCopy, and Snapshot, and continuous replication, which
includes Metro Mirror and Global Mirror.

You can set up Metro Mirror and Global Mirror sessions to replicate data in both
the forward and reverse directions.

Use Tivoli Storage Productivity Center for Replication for the following tasks:
v Manage Tivoli Storage Productivity Center for Replication servers
v Create and monitor storage system connections
v Create and monitor logical paths
v Create and manage sessions for performing these types of data replication.

– FlashCopy (ESS, DS6000, DS8000, and SAN Volume Controller)
– Snapshot (the XIV system)
– Global Mirror Single Direction (ESS, DS6000, DS8000, and SAN Volume

Controller)
– Global Mirror Either Direction with Two-Site Practice (ESS, DS6000, and

DS8000)
– Global Mirror Failover/Failback (ESS, DS6000, DS8000, SAN Volume

Controller, and the XIV system)
– Global Mirror Failover/Failback with Practice (ESS, DS6000, DS8000, and

SAN Volume Controller)
– Metro Mirror Single Direction (SAN Volume Controller)
– Metro Mirror Failover/Failback (SAN Volume Controller, and the XIV system)
– Metro Mirror Failover/Failback with Practice (SAN Volume Controller)
– Metro Mirror or Global Copy (ESS, DS6000, and DS8000)
– Metro Mirror Failover/Failback or Global Copy (ESS, DS6000, and DS8000)
– Metro Mirror Failover/Failback with HyperSwap® (ESS, DS6000, and DS8000)
– Metro Global Mirror Failover/Failback (DS8000)
– Metro Global Mirror Failover/Failback (ESS and DS8000)
– Metro Global Mirror Failover/Failback with Practice (ESS and DS8000)
– Metro Global Mirror with HyperSwap (ESS and DS8000)
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Note: Metro Global Mirror is available only with the IBM Tivoli Storage
Productivity Center license, and requires a license key.

v Practicing recovery procedures while maintaining disaster recover capability

Data collection
Determining what information you want to gather about the storage resources
within your enterprise is critical to helping you implement a storage management
strategy. Create data collection schedules to gather information about the storage
resources in your environment. There are different data collection schedules within
Tivoli Storage Productivity Center depending on the type of information that you
want to gather and from which types of resources the information is retrieved:
discovery, probes, scans, pings, and performance monitors.

You must run discovery schedules or use the Configure Devices wizard before you
can collect more detailed information about storage resources. After a storage
resource is discovered by Tivoli Storage Productivity Center, use probes, scans,
pings, and performance monitors to collect detailed information about those
resources. You do not need to run discovery schedules for devices that use native
API connection.

The data and statistics gathered by data collection schedules are stored in the
database repository. You must define and run schedules before you can perform
the other tasks within Tivoli Storage Productivity Center, such as viewing reports,
enforcing storage policies, setting alerts, using the topology viewer, and managing
storage subsystems.

The following types of data collection schedules are available in Tivoli Storage
Productivity Center:

Availability Monitoring
Use pings to collect information about the availability of the storage assets
in your enterprise. You can run pings against servers and computers only.
Pings are unavailable for storage subsystems and other devices.

Asset Collection
Use probes to collect statistics about the storage assets in your enterprise,
such as computers, disk controllers, hard disks, file systems, storage
subsystems, fabrics, switches, hypervisors, and RDBMS objects.

Usage Monitoring
Use scans to collect statistics about the usage and trends of your actual
storage consumption. Scans provide all the data for usage reporting, quota
analysis, and constraint analysis. They gather information at the file and
directory level. You can run scans against servers and computers only.
Scans are unavailable for storage subsystems, switches, fabrics, and other
devices.

Switch Performance Monitoring
Use fabric probes and switch performance monitors to collect information
about switches and their performance.

Storage Subsystems Performance Monitoring
Use storage subsystem probes and subsystem performance monitors to
collect information about storage subsystems and their performance.

Tivoli Storage Productivity Center Server Monitoring
Use TPC Server probes to collect the storage asset and capacity information
that has been gathered by other Tivoli Storage Productivity Center servers
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in your environment. Create master and subordinate relationships among
servers to use a single interface to generate reports based on data and
metrics collected by multiple servers.

You can create groups and profiles to use with data collection schedules to more
efficiently monitor storage resources.

Monitoring Groups
Use monitoring groups to ping, probe, or scan multiple storage resources
using the same schedule. You can create named groups of computers,
storage subsystems, file systems, directories, fabrics, databases, table
spaces, tables, users, and OS user groups.

For example, to gather information about all of the computers in a payroll
department, create a computer monitoring group named Payroll and
populate that group with the computers from the payroll department.
Then, to collect information about those computers, select the computer
monitoring group named Payroll when defining a data collection schedule.
As computers are added or removed from the payroll department, update
the Payroll computer monitoring group with those changes. Any data
collection schedule that uses Payroll automatically collects information
about the new computers in the group during its next run.

Profiles
Use profiles to fine-tune and control the files to be scanned during a file
system scan and to specify the statistical information to be gathered.

Default profiles are supplied with Data Manager with Data Manager for
Databases. With the default profiles, you can select a specific statistic that
you want to gather. If you want to scan a computer or file system and
gather all the available statistical information, select all of the default
profiles when you create your scan.

You can also use profiles with Reporting > Usage reports to determine
what information is displayed in those reports.

Data replication
With Tivoli Storage Productivity Center for Replication, you can use several
methods to replicate data. The type of data replication that is associated with a
session is known as the session type.

The following sections describe the session types that are supported by Tivoli
Storage Productivity Center for Replication. Depending on the edition of Tivoli
Storage Productivity Center for Replication that you are using, some of these
session types might not be available.

Basic HyperSwap

Basic HyperSwap sessions are available for the following license types and storage
systems.
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Table 13. Basic HyperSwap

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication
Basic Edition
for System z

v Tivoli Storage
Productivity
Center for
Replication for
System z

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

Basic HyperSwap replication is a
Metro Mirror replication method
that provides high availability if a
disk storage system failure occurs.
Using Basic HyperSwap with
Metro Mirror, you can configure
and manage your synchronous
Peer-to-Peer Remote Copy (PPRC)
pairs.

FlashCopy

FlashCopy sessions are available for the following license types and storage
systems.

Table 14. FlashCopy

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication
Basic Edition
for System z

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

FlashCopy replication creates a
point-in-time copy in which the
target volume contains a copy of
the data that was on the source
volume when the FlashCopy was
established. Using FlashCopy, the
data exists on the second set of
volumes in the same storage
system, and you can restore the
data to the first set of volumes.

SAN Volume Controller or
Storwize V7000 FlashCopy
sessions are managed by using
FlashCopy consistency groups.
Sessions for IBM TotalStorage
Enterprise Storage Server (ESS)
and IBM DS6000 and DS8000 are
not managed by using FlashCopy
consistency groups.
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Snapshot

Snapshot sessions are available for the following license types and storage systems.

Table 15. Snapshot

Supported software Supported storage systems Description

v Tivoli Storage Productivity
Center for Replication
Basic Edition for System z

v Tivoli Storage Productivity
Center for Replication for
System z

v All editions of Tivoli
Storage Productivity
Center

The XIV system Snapshot is a session type
that creates a point-in-time
copy of a volume or set of
volumes without having to
define a specific target
volume. The target volumes
of a Snapshot session are
automatically created when
the snapshot is created.

Metro Mirror Single Direction

Metro Mirror Single Direction sessions are available for the following license types
and storage systems.

Table 16. Metro Mirror Single Direction

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Metro Mirror is a method of
synchronous, remote data
replication that operates between
two sites that are up to 300 KM
apart. The source is located in one
storage system and the target is
located in another storage system.
Using Metro Mirror, the data exists
on the second site that is less than
300 KM away, and you can restore
the data to the first site.

Metro Mirror Failover/Failback

Metro Mirror Failover/Failback sessions are available for the following license
types and storage systems.
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Table 17. Metro Mirror Failover/Failback

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

v The XIV system

Metro Mirror is a method of
synchronous, remote data
replication that operates between
two sites that are up to 300 KM
apart. Using Metro Mirror
Failover/Failback, the data exists
on the second site that is less than
300 KM away. You can use failover
and failback to switch the direction
of the data flow. Using this
method, you can run your
business from the secondary site.

Using Metro Mirror with
HyperSwap, the data exists on the
second site that is less than 300
KM away. You can restore the data
to the first site. You can also use
failover for a backup copy of the
data if your primary volumes
encounter a permanent I/O error.

Metro Mirror Failover/Failback with Practice

Metro Mirror Failover/Failback with Practice sessions are available for the
following license types and storage systems.

Table 18. Metro Mirror Failover/Failback with Practice

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Metro Mirror is a method of
synchronous, remote data
replication that operates between
two sites that are up to 300 KM
apart. The source is located in one
storage system and the target is
located in another storage system.
Metro Mirror Failover/Failback
with Practice combines Metro
Mirror and FlashCopy to provide a
point-in-time copy of the data on
the remote site.

Global Mirror Single Direction

Global Mirror Single Direction sessions are available for the following license types
and storage systems.
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Table 19. Global Mirror Single Direction

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Global Mirror is a method of
asynchronous, remote data
replication between two sites that
are over 300 KM apart. It
maintains identical data in both
the source and target, where the
source is located in one storage
system and the target is located in
another storage system. Using
Global Mirror, the data exists on
the second site that is more than
300 KM away, and you can restore
the data to the first site.

Global Mirror Either Direction with Two-Site Practice

Global Mirror Either Direction with Two-Site Practice sessions are available for the
following license types and storage systems.

Table 20. Global Mirror Either Direction with Two-Site Practice

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

Global Mirror is a method of
asynchronous, remote data
replication between two sites that
are over 300 KM apart. It
maintains identical data in both
the source and target, where the
source is located in one storage
system and the target is located in
another storage system. Global
Mirror Either Direction with
Two-Site Practice combines Global
Mirror and FlashCopy to provide a
point-in-time copy of the data on
either the primary or secondary
sites that are over 300 KM apart.

Global Mirror Failover/Failback

Global Mirror Failover/Failback sessions are available for the following license
types and storage systems.
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Table 21. Global Mirror Failover/Failback

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

v The XIV system

Global Mirror is a method of
asynchronous, remote data
replication between two sites that
are over 300 KM apart. It
maintains identical data in both
the source and target, where the
source is located in one storage
system and the target is located in
another storage system. Using
Global Mirror Failover/Failback,
the data exists on the second site
that is more than 300 KM away,
and you can use failover and
failback to switch the direction of
the data flow. This ability enables
you to run your business from the
secondary site.

Global Mirror Failover/Failback with Practice

Global Mirror Failover/Failback with Practice sessions are available for the
following license types and storage systems.

Table 22. Global Mirror Failover/Failback with Practice

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Global Mirror is a method of
asynchronous, remote data
replication between two sites that
are over 300 KM apart. It
maintains identical data in both
the source and target, where the
source is located in one storage
system and the target is located in
another storage system. Global
Mirror Failover/Failback with
Practice combines Global Mirror
and FlashCopy to provide a
point-in-time copy of the data on a
remote site at a distance over 300
KM away from your first site.

Metro Global Mirror

Metro Global Mirror sessions are available for the following license types and
storage systems.
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Table 23. Metro Global Mirror

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800 (only H1 site)

v System Storage DS8000

Metro Global Mirror is a method
of continuous, remote data
replication that operates between
three sites that varying distances
apart. Metro Global Mirror
combines Metro Mirror
synchronous copy and Global
Mirror asynchronous copy into a
single session, where the Metro
Mirror target is the Global Mirror
source. Using Metro Global Mirror
and Metro Global Mirror with
HyperSwap, the data exists on a
second site that is less than 300
KM away, and a third site that is
more than 300 KM away. Metro
Global Mirror uses both Metro
Mirror and Global Mirror
Failover/Failback to switch the
direction of the data flow. This
ability enables you to run your
business from the secondary or
tertiary sites.

Using Basic HyperSwap with
Metro Global Mirror, you can
configure and manage three-site
continuous replication that is
needed in a disaster recovery
event.

Metro Global Mirror with Practice

Metro Global Mirror with Practice sessions are available for the following license
types and storage systems.

Table 24. Metro Global Mirror with Practice

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800 (only H1 site)

v System Storage DS8000

Using Metro Global Mirror with
Practice, you can practice your
disaster recovery actions while
maintaining disaster recovery
capabilities. The data exists on a
second site that is less than 300
KM away, and a third site that is
more than 300 KM away. Metro
Global Mirror uses both Metro
Mirror and Global Mirror
Failover/Failback to switch the
direction of the data flow. You can
run your business from the
secondary or tertiary sites, and
simulate a disaster.
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Basic HyperSwap (ESS, DS6000, and DS8000)
Basic HyperSwap is a copy services solution for z/OS® version 1.9 and later. It
provides high availability of data if a disk storage system failure occurs. Basic
HyperSwap does not replace a disaster recovery solution. If a session is suspended
but the suspend operation was not caused by a HyperSwap trigger, the session is
not frozen to ensure that it is consistent.

When HyperSwap is combined with Metro Mirror and Metro Global Mirror
replication, you can prepare your system for disaster recovery and ensure high
availability of data. If a session is suspended but the suspend operation was not
caused by a HyperSwap trigger, the session is frozen to ensure that it is consistent.

Restriction: This replication method is only available on ESS, DS6000, and DS8000
storage systems, and on management servers that run IBM Tivoli Storage
Productivity Center for Replication Basic Edition for System z or IBM Tivoli
Storage Productivity Center for Replication for System z.

Basic HyperSwap replication performs the following actions:
v Manages CKD volumes in Metro Mirror to manage synchronous peer-to-peer

remote copy (PPRC) relationships.
v Permits only CKD volumes to be added to the HyperSwap session. The

graphical user interface (GUI) shows only CKD volumes when you add a copy
set. The command-line interface (CLI) does not add a copy set if a fixed block
volume is specified.

v Monitors events that indicate a storage device failed.
v Determines whether the failing storage device is part of a Metro Mirror

synchronous PPRC pair.
v Determines the action to be taken from policy.
v Ensures that data remains consistent.
v Swaps the I/O between the primary logical devices in the consistency group

with the secondary logical devices in the consistency group. A swap can occur
from the preferred logical devices to the alternate logical devices or from the
alternate logical devices to the preferred logical devices.

Metro Mirror Failover/Failback with HyperSwap

Metro Mirror Failover/Failback uses HyperSwap to configure and manage
synchronous PPRC pairs.

Metro Global Mirror with HyperSwap

Metro Global Mirror with HyperSwap is a z/OS replication feature that provides
the three-site continuous replication that you can use if a disaster occurs.

Restriction: If a HyperSwap event occurs when you run a Metro Global Mirror
operation with a HyperSwap session, a full copy operation of the data occurs to
return the system to a full three-site configuration. If you issue a HyperSwap
command when you run a Metro Global Mirror operation with a HyperSwap
session, a full copy operation does not occur. A full copy is required only for an
unplanned HyperSwap session or a HyperSwap-initiated session by using the
z/OS SETHS SWAP command.
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Example

Jane is using multiple DS8000 storage systems. The host applications run on a
z/OS operating system and the z/OS environment is connected to the DS8000
storage systems. She has a site in Manhattan and a secondary DS8000 in Hoboken.
While it is not required that she has a disaster recovery solution in effect, she does
need to have a high-availability solution to keep her applications running all the
time. Jane is worried that if a volume fails on the DS8000 in Manhattan, her
database application might fail. Even a small downtime can be costly to Jane.

Jane uses a Basic HyperSwap session to mirror the data on the DS8000 in
Manhattan to the secondary DS8000 in Hoboken. If a volume at the Manhattan site
fails, Basic HyperSwap automatically directs application I/O to the mirrored
volumes in Hoboken.

FlashCopy
FlashCopy replication creates a point-in-time copy in which the target volume
contains a copy of the data that was on the source volume when the FlashCopy
was established.

The ESS, DS6000, and DS8000 provide multiple logical subsystems (LSSs) within a
single physical subsystem, while the following platforms provide multiple I/O
groups:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

All platforms can use local replication in which the source volume is located in one
LSS or I/O group and the target volume is located in the same or another LSS or
I/O group. Using the FlashCopy feature, you can reference and update the source
volume and target volume independently.

The following figure illustrates how a FlashCopy session works.

Example

Jane works for a bank. Jane uses a FlashCopy session to make a point-in-time copy
of the customer data in existing international accounts. Every night, the bank's
servers start batch processing. Jane uses the FlashCopy session to create checkpoint
restarts for the batch processing if the batch processing fails. In the batch
processing, the first step is to balance all international accounts and to make a
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FlashCopy point-in-time copy of the resulting data. The second step in the batch
processing is to complete the international disbursements.

If the second step in the batch process fails, Jane can use the data from the
FlashCopy session that was taken of the first step to repeat the second step. In this
way, Jane does not have to begin the entire process again. Jane also uses a CLI
script that performs a FlashCopy operation every night at 11:59 PM, and another
script that quiesces the database. She backs up the data to tape on the target
storage system, and then sends the tape to the bank's data facility for storage.

Snapshot
Snapshot is a session type that creates a point-in-time copy of a volume or set of
volumes. You do not have to define a specific target volume. The target volumes of
a Snapshot session are automatically created when the snapshot is created.

The XIV system uses a snapshot session to create a large number of volume copies
without affecting system performance. By using the snapshot function to create a
point-in-time copy, and to manage the copy, you can save storage. With the XIV
system snapshots, no storage capacity is used by the snapshot until the source
volume or the snapshot is changed.

The following figure illustrates how a Snapshot session works.

Example

Jane's host applications are using an XIV system for their back-end storage. With
the XIV system, Jane can create a large number of point-in-time copies of the data.
The snapshot function ensures that if data becomes corrupted, she can restore the
data to any point in time.

Jane sets up a Snapshot session by using Tivoli Storage Productivity Center for
Replication and specifies the volumes on the XIV system that are used by the host
applications. Jane does not have to provision target volumes for all the snapshots
she intends to make. She can quickly configure a single Snapshot session.

When the session is configured, Jane uses a CLI script that runs a Create Snapshot
command to the session every two hours. If a problem occurs, such as data
becoming corrupted, Jane can find a snapshot of the data from a time before the
problem occurred. She can restore the data to that point.

By creating a set of snapshots of the data, Jane can also schedule batch processing
against that data every day. She can use the batch processing to analyze certain
trends in the market without affecting the host applications.

Metro Mirror
Metro Mirror is a method of synchronous, remote data replication that operates
between two sites that are up to 300 KM apart. The source is located in one storage
system and the target is located in another storage system.
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Attention: If you have Tivoli Storage Productivity Center for Replication for
System z sessions that contain Metro Mirror relationships, ensure that the session
does not contain system volumes (such as paging volumes) unless you select the
Manage H1-H2 with HyperSwap or the Enable Hardened Freeze option for the
session. By using these options, z/OS Input/Output Supervisor (IOS) manages
freeze operations for the volumes in the session, which prevents Tivoli Storage
Productivity Center for Replication from freezing the volumes and possibly
freezing itself.

Metro Mirror replication maintains identical data in both the source and target.
When a write operation is issued to the source copy, the changes made to the
source data are propagated to the target before the write operation finishes
processing. If the storage system ends, no data is lost when you use Metro Mirror
if data must be used from the recovery site.

A Metro Mirror session in Global Copy mode creates an asynchronous relationship
to accommodate the high volume of data that is migrated. As a result, the data on
the target system might no longer be consistent with the source system. The Metro
Mirror session switches back to a synchronous relationship when Metro Mirror
reissues a Start command. In addition, you can start a Metro Mirror session in
Global Copy mode and toggle between Metro Mirror and Global Copy modes to
accommodate periods in which you require host I/O response time over data
consistency.

Tip: To determine whether there is any out-of-sync data that must to be copied
before the session is consistent, check the percent that is complete in the session
details page.

Metro Mirror Single Direction

The following figure illustrates how a Metro Mirror Single Direction session works.

Metro Mirror Failover/Failback

Using Metro Mirror Failover/Failback, the data exists on the second site, which is
less than 300 KM away, and you can switch the direction of the data flow. You can
use this session type to run your business from the secondary site, and to copy
changes made at the second site back to the primary site when you want to
resume production at the primary site.

The following figure illustrates how a Metro Mirror with Failover/Failback session
works.
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Metro Mirror Failover/Failback with Practice

A Metro Mirror Failover/Failback with Practice session combines Metro Mirror and
FlashCopy features to provide a point-in-time copy of the data on the remote site.
You can use this session type to practice what you might do if a disaster occurs,
without losing your disaster recovery capability.

This solution consists of two host volumes and an intermediate volume.

The following figure illustrates how a Metro Mirror Failover/Failback with Practice
session works.

Metro Mirror Failover/Failback with HyperSwap

You can enable a Metro Mirror Failover/Failback session to have HyperSwap
capabilities. To enable the HyperSwap feature, the following conditions must
apply:
v The session is running on an Tivoli Storage Productivity Center for Replication

server that runs on IBM z/OS.
v The volumes are only for TotalStorage Enterprise Storage Server, DS6000, and

System Storage DS8000 systems.
v The volumes are count key data (CKD) volumes that are attached to the z/OS

system.

Metro Mirror Failover/Failback with HyperSwap combines the high availability of
Basic HyperSwap with the redundancy of a two-site Metro Mirror
Failover/Failback solution when managing count key data (CKD) volumes on
z/OS. If the primary volumes encounter a permanent I/O error, the I/O is
automatically swapped to the secondary site with minimal effect on the
application.

A swap can be planned or unplanned. A planned swap occurs when you issue a
HyperSwap command from the Select Action list in the graphical user interface
(GUI) or when you issue a cmdsess -action hyperswap command.

The following figure illustrates how a Metro Mirror Failover/Failback session that
is enabled for HyperSwap works.
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For more information about enabling HyperSwap, see “Managing a session with
HyperSwap and Open HyperSwap replication” on page 99.

Metro Mirror Failover/Failback with Open HyperSwap

You can enable a Metro Mirror Failover/Failback session to have Open HyperSwap
capabilities. To enable Open HyperSwap processing, the following conditions must
apply:
v The volumes in the session are System Storage DS8000 5.1 or later volumes.
v The volumes in the session are fixed block and are mounted to IBM AIX 5.3 or

AIX 6.1 hosts with the following modules installed:
– Subsystem Device Driver Path Control Module (SDDPCM) version 3.0.0.0 or

later
– Multi-Path Input/Output (MPIO) module (the version that is provided with

AIX version 5.3 or 6.1)
v The connections between the AIX host systems and the Tivoli Storage

Productivity Center for Replication server are established.

Metro Mirror Failover/Failback with Open HyperSwap combines the high
availability of Basic HyperSwap on z/OS for fixed-block AIX volumes with the
redundancy of a two-site Metro Mirror Failover/Failback solution. If the primary
volumes encounter a permanent I/O error, the I/O is automatically swapped to
the secondary site with minimal effect on the application.

A swap can be planned or unplanned. A planned swap occurs when you issue a
HyperSwap command from the Select Action list in the GUI or when you issue a
cmdsess -action hyperswap command.

The following figure illustrates how a Metro Mirror Failover/Failback session that
is enabled for Open HyperSwap works.

For more information about enabling Open HyperSwap, see “Managing a session
with HyperSwap and Open HyperSwap replication” on page 99.
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Examples

Read the following scenarios for information on using Metro Mirror for
synchronous, remote data replication between two sites.

Metro Mirror Single Direction

At the beginning of a work week, Jane is notified that between 10:00 AM
and 11:00 AM on the next Friday, power in her building is going to be shut
off. Jane does not want to lose any transactions during the power outage,
so she decides to transfer operations to the backup site during the outage.
She wants a synchronous copy method with no data loss for the critical
business functions, so she chooses Metro Mirror, which can be used
between locations that are less than 300 KM apart.

In a synchronous copy method, when a write is issued to change the
source, the change is propagated to the target before the write is posted.
This method of replication maintains identical data in both the source and
target. The advantage of this method is when a disaster occurs, there is no
data loss at the recovery site because both writes must complete before
signaling completion of a write to the source application. Because the data
must be copied to both System Storage DS8000 devices before the write is
completed, Jane can be sure that the data is safe.

The night before the planned outage, Jane quiesces the database and
servers in San Francisco and starts the database and servers in Oakland. To
accomplish this task, Jane issues the Suspend and Recover commands, and
then issues the Start command on the secondary site. She shuts down the
equipment in San Francisco to avoid any power spikes when she restarts
the system after the power is turned on.

Metro Mirror in Global Copy mode

At the beginning of a work week, Jane is notified that between 10:00 AM
and 11:00 AM on the next Friday, power in her building is going to be shut
off. Jane does not want to lose any transactions during the power outage,
so she decides to transfer operations to the backup site during the outage.
She wants a synchronous copy method with no data loss for the critical
business functions, so she chooses Metro Mirror, which can be used
between locations that are less than 300 KM apart.

Jane wants to limit the effect on any applications while completing the
initial Metro Mirror synchronization, so she begins the session in Global
Copy mode. After she sees that approximately 70% of the data is copied,
Jane decides to switch the session to Metro Mirror mode, assuring data
consistency.

Metro Mirror with Practice

Jane wants to run a Metro Mirror with Practice from San Francisco to
Oakland. She wants to verify the recovery procedure for the Oakland site,
but she cannot stop running the Metro Mirror session while she takes time
to practice a recovery. By using a Metro Mirror with Practice session, Jane
can practice the disaster recovery scenario in Oakland while the Metro
Mirror session runs uninterrupted. By practicing running the applications
at the Oakland site, Jane is better prepared to recover data if a disaster
occurs at the San Francisco site.

While her session is running in Prepared state, Jane practices a recovery at
the Oakland site by issuing the Flash command. This command
momentarily pauses the session and starts a FlashCopy to the H2 volumes.
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As soon as the FlashCopy is started, the session is restarted. These
FlashCopy files create a consistent version of the data on the H2 volume
that she can use for recovery testing, while the session continues to
replicate data from San Francisco to Oakland. As a result, she can carry out
the recovery testing without stopping the replication for any extended
duration of time.

If, at some point, the Metro Mirror session is suspended because of a
failure, Jane can use the practice session to restart the data replication
process. She maintains a consistent copy of the data at the Oakland site, in
case of a failure during the resynchronization process. When the session is
suspended, she can issue a Recover command to create a consistent
version of the data on the H2 volumes. After the Recover command
completes, she can issue the Start H1->H2 command to resynchronize the
data from the San Francisco site to the Oakland site.

If a failure occurs before the restarted session is in Prepared state, she has
a consistent version of the data on the H2 volumes. She only has to issue
the Recover command to put the session into Target Available state and
make the H2 volumes accessible from the servers. If the session was not in
Prepared state when it was suspended, the subsequent Recover command
does not issue the FlashCopy files to put the data on the H2 volumes. This
means that the consistent data on the H2 volumes is not overwritten if the
data to be copied to them is not consistent.

Metro Mirror Failover/Failback enabled for Open HyperSwap

Jane wants to run a Metro Mirror with Practice from San Francisco to
Oakland. She wants to verify the recovery procedure for the Oakland site,
but she cannot stop running the Metro Mirror session while she takes time
to practice a recovery. By using a Metro Mirror with Practice session, Jane
can practice the disaster recovery scenario in Oakland while the Metro
Mirror session runs uninterrupted. By practicing running the applications
at the Oakland site, Jane is better prepared to recover data if a disaster
occurs at the San Francisco site.

While the session is running in a Prepared state, Jane practices a recovery
at the Oakland site by issuing the Flash command. This command
momentarily pauses the session and starts a FlashCopy to the H2 volumes.
As soon as the FlashCopy is started, the session is restarted. These
FlashCopy files create a consistent version of the data on the H2 volume
that she can use for recovery testing, while the session continues to
replicate data from San Francisco to Oakland. As a result, she can carry out
the recovery testing without stopping the replication for any extended
duration of time.

If the Metro Mirror session is suspended because of a failure, Jane can use
the practice session to restart the data replication process while she
maintains a consistent copy of the data at the Oakland site, in case of a
failure during the resynchronization process. When the session is
suspended, she can issue a Recover command to create a consistent
version of the data on the H2 volumes. After the Recover command
completes, she can issue the Start H1->H2 command to resynchronize the
data from the San Francisco site to the Oakland site.

If a failure occurs before the restarted session is in Prepared state, she has
a consistent version of the data on the H2 volumes. She only has to issue
the Recover command to put the session into Target Available state and
make the H2 volumes accessible from the servers. If the session was not in
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Prepared state when it was suspended, the subsequent Recover command
does not issue the FlashCopy files to put the data on the H2 volumes. This
means that the consistent data on the H2 volumes is not overwritten if the
data to be copied to the volumes is not consistent.

Selecting a HyperSwap session
A global insurance company decided to use Tivoli Storage Productivity
Center for Replication to manage its disaster recovery environment. Jane
wants minimal data exposure, both for planned outages such as routine
maintenance, and for unplanned disasters. They have CKD volumes on
System Storage DS8000 devices, and use z/OS operating systems. They
have two data centers in New York.

Jane chooses a Metro Mirror recovery solution, because her priority is to
protect the system from regional disasters. Jane decides to use Metro
Mirror solution, because her company has two data centers located near
each other. Jane realizes that because she uses a z/OS operating system,
CKD, and System Storage DS8000 hardware, she can also use a
HyperSwap solution. Using Metro Mirror Failover/Failback with
HyperSwap, Jane can minimize the effects on any applications, while she
maintains the failover process to the secondary site. Jane decides Metro
Mirror Failover/Failback with HyperSwap is the best solution.

After installing and configuring Tivoli Storage Productivity Center for
Replication on z/OS, Jane starts the Tivoli Storage Productivity Center for
Replication GUI. She adds the Tivoli Storage Productivity Center for
Replication storage devices that she intends to use on all sites. From the
Session Overview page, Jane uses the Create Session wizard, and selects
the Metro Mirror Failover/Failback session type. She selects the Manage
H1H2 with HyperSwap option. After finishing the wizard, Jane clicks
Launch Add Copy Sets Wizard. She completes this wizard, and issues a
Start H1->H2 command. After the initial copy is completed, Jane can safely
replicate the data between both sites. She can also issue the HyperSwap
command between sites 1 and 2 to switch sites with minimal effect on the
application during either a disaster or maintenance period.

Performing a planned HyperSwap
Jane's company used Metro Mirror Failover/Failback with HyperSwap
sessions for the past three months. However, Jane needs to perform
maintenance on an H1 volume. During this time, Jane does not want the
applications or replication to be interrupted. To prevent this interruption,
before the maintenance is scheduled to begin, Jane uses the Tivoli Storage
Productivity Center for Replication GUI to perform a HyperSwap
operation to the H2 volumes. This process transitions the applications so
that the data is written to H2. To perform a planned HyperSwap operation,
Jane issues a HyperSwap command.

Understanding what happens when an unplanned HyperSwap occurs
Several weeks after the planned maintenance at Jane's company is
completed, an incident occurs at the H1 site. A disk controller fails, causing
one of the H1 volumes to encounter a permanent I/O error. Jane's data is
safe because she used Metro Mirror Failover/Failback with HyperSwap,
and the H2 volume is an exact duplicate of the H1 volume. When the
permanent I/O error is detected, a HyperSwap is triggered. The
application transitions to write data to the H2 volumes. The applications
are not interrupted.

Jane configured a Simple Network Management Protocol (SNMP) listener
to alert her to any events, so she receives the SNMP event that indicates
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that a HyperSwap occurred. Jane investigates the cause of the HyperSwap
process and uses the z/OS console to identify the volume that triggered
the HyperSwap process. Jane replaces the faulty disk controller. Then, to
recover from the unplanned HyperSwap process, Jane issues the Start
H2->H1 command.

Global Mirror
Global Mirror is a method of asynchronous, remote data replication between two
sites that are over 300 kilometers (km) apart. It maintains identical data in both the
source and target, where the source is located in one storage system and the target
is located in another storage system.

The data on the target is typically written a few seconds after the data is written to
the source volumes. When a write is issued to the source copy, the change is
propagated to the target copy, but subsequent changes are allowed to the source
before the target verifies that it received the change. Because consistent copies of
data are formed on the secondary site at set intervals, data loss is determined by
the amount of time since the last consistency group was formed. If the system fails,
Global Mirror might lose some data that was being transmitted when the failure
occurs. Using Global Mirror, you can ensure that data is recoverable and consistent
if a disaster occurs.

Global Mirror Single Direction

You can use a Global Mirror Single Direction session to run a Global Mirror
replication process from only the primary site.

For ESS, DS6000, and DS8000 storage systems, each copy set in the single direction
session consists of two host volumes and a journal volume. The following figure
illustrates how a Global Mirror Single Direction session works on an ESS, DS6000,
or DS8000 storage system.

For the following storage systems, each copy set in the Global Mirror Single
Direction session consists of two host volumes:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

The following figure illustrates how a Global Mirror Single Direction session works
on these storage systems.
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Global Mirror Either Direction with Two-Site Practice (ESS, DS6000,
and DS8000)

By using a Global Mirror Either Direction with Two-Site Practice session, you can
run Global Mirror replication from either the primary or secondary site. It
combines Global Mirror and FlashCopy to provide a point-in-time copy of the data
on a remote site at a distance over 300 km away from your first site. By using this
practice session, you can create volumes on both the primary and secondary site to
practice what you might do if a disaster occurred, without affecting the disaster
recovery capability.

Restriction: This replication method is available on only ESS, DS6000, and DS8000
storage systems.

The session consists of two host volumes, two intermediate volumes, and two
journal volumes. The following figure illustrates how a Global Mirror Either
Direction with Two-Site Practice session works.

Global Mirror Failover/Failback

Using Global Mirror Failover/Failback, your data exists on the second site that is
more than 300 km away, and you can use failover or failback processing to switch
the direction of the data flow. You can run your business from the secondary site.

For ESS, DS6000, and DS8000 storage systems, each copy set in the Global Mirror
Failover/Failback session consists of two host volumes and a journal volume. The
following figure illustrates how a Global Mirror Failover/Failback session works
on an ESS, DS6000, or DS8000 storage system.
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For the following storage systems, each copy set in the Global Mirror
Failover/Failback session consists of two host volumes:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified
v The XIV system

The following figure illustrates how a Global Mirror Failover/Failback session
works on these storage systems.

Global Mirror Failover/Failback with Practice

A Global Mirror Failover/Failback with Practice session combines Global Mirror
and FlashCopy features to provide a point-in-time copy of the data on a remote
site at a distance over 300 KM away from your primary site. You can use this to
practice what you might do if a disaster occurred, without affecting the disaster
recovery capability.

For ESS, DS6000, and DS8000 storage systems, each copy set in the Global Mirror
Failover/Failback with Practice session consists of two host volumes, an
intermediate volume, and a journal volume. The following figure illustrates how a
Global Mirror Failover/Failback with Practice session works on an ESS, DS6000, or
DS8000 storage system.
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For the following storage systems, each copy set in the Global Mirror
failover/failback with Practice session consists of two host volumes and an
intermediate volume:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

The following figure illustrates how a Global Mirror Failover/Failback with
Practice session works on these storage systems.

Examples

Read the following scenarios for information on using Global Mirror for
asynchronous, remote data replication between two sites.

Global Mirror Single Direction
Although Jane's FlashCopy and Metro Mirror copies were both planned,
Jane realizes that sometimes a failure can occur, and she wants to ensure
that the data is safe. Because Jane works in San Francisco, she wants her
other site to be far away if a disaster occurs locally. Her other site is based
in Houston. A minor earthquake occurs in San Francisco and power and
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communications both fails. Jane arranged for the data on customer
accounts that recently opened or closed to be asynchronously copied in
Houston, using Global Mirror. Jane risks losing the bytes of data that were
being processed when the tremor disrupted the processing in San
Francisco. However, she understands that it is minor inconvenience when
weighed next to the value of backing up her data to an area that is not
prone to earthquakes.

Global Mirror with Practice
Jane wants to run a Global Mirror with practice from San Francisco to
Houston. She plans to verify her recovery procedure for the Houston site,
but she cannot stop running the Global Mirror session while she takes time
to practice a recovery. By using a Global Mirror with Practice session, Jane
can practice her disaster recovery scenario in Houston while the Global
Mirror session runs uninterrupted. When she practices running the
applications at the Houston site, Jane is better prepared to recover the data
if a disaster ever strikes the San Francisco site.

Global Mirror Either Direction with Two-Site Practice
Jane wants to run a Global Mirror with Practice from San Francisco to
Houston. She plans to verify her recovery procedure for the Houston site,
but she cannot stop running the Global Mirror session while she takes time
to practice a recovery. By using a Global Mirror Either Direction with
Two-Site Practice session, Jane can practice her disaster recovery scenario
in Houston while the Global Mirror session runs uninterrupted. When she
practices running the applications at the Houston site, Jane is better
prepared to recover the data if a disaster ever strikes the San Francisco site.

Jane can use the Global Mirror Either Direction with Two-Site Practice
session to run asynchronous consistent data replication from either the San
Francisco site or the Houston site. She can practice the disaster-recovery
tasks at the target site, regardless of the location of the current production
site. Jane's business can run a consistent Global Mirror session from its
Houston site back to San Francisco while it runs a production site at
Houston.

Setting up Global Mirror for Resource Groups on System Storage
DS8000

If resource groups are defined on a System Storage DS8000, Global Mirror session
IDs might be defined for some users. To determine which session IDs are valid,
you must modify the rmserver.properties file and add the following property:
gm.master.sessionid.gm_role,session_name = xx

where gm_role is the role that has the master volume (for example, H1 in a Global
Mirror failover/failback session), session_name is the name of the session that uses
the session ID, and xx is the decimal number for the session ID.

Tip: System Storage DS8000 represents session IDs as a two-digit hexadecimal
number. Use the decimal version of that number. For example, if you want a
Global Mirror Failover/Failback session to use a session ID of 0F, the decimal
number is 15, as shown in the following example:
gm.master.sessionid.H2.11194_wprac=15

Metro Global Mirror (ESS and DS8000)
Metro Global Mirror is a method of continuous, remote data replication that
operates between three sites that are varying distances apart. Metro Global Mirror
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combines Metro Mirror synchronous copy and Global Mirror asynchronous copy
into a single session, where the Metro Mirror target is the Global Mirror source.

This replication method is available on only TotalStorage Enterprise Storage Server
Model 800 and System Storage DS8000 storage systems. You can select ESS storage
systems in only the H1 volume role. All other volume roles must use DS8000
volumes.

You can use both ESS and DS8000 volumes in the H1 volume role. If ESS
andDS8000 storage systems are both used in the H1 role, the DS8000 storage
system performs Incremental Resync processing, and the ESS storage system
performs a full copy operation. Because you cannot use the Incremental Resync
function with ESS, a full copy is required when you change from H1->H2->H3 to
H1>H3 and from H2->H1->H3 to H2->H3.

Attention: If you have Tivoli Storage Productivity Center for Replication for
System z sessions that contain Metro Global Mirror relationships, ensure that the
session does not contain system volumes (such as paging volumes) unless you
select the Manage H1-H2 with HyperSwap or the Enable Hardened Freeze option
for the session. By using these options, z/OS Input/Output Supervisor (IOS)
manages freeze operations for the volumes in the session, which prevents Tivoli
Storage Productivity Center for Replication from freezing the volumes and possibly
freezing itself.

Metro Global Mirror maintains a consistent copy of data at the remote site, with
minimal effect on applications at the local site. This remote mirroring function
works in combination with FlashCopy to provide a disaster-recovery solution that
includes the following features:
v Fast failover and failback
v Rapid reestablishment of three-site mirroring, without production outages
v Data currency at the remote site with minimal time lag at the local site, an

average of only 3 - 5 seconds for many environments
v Quick resynchronization of mirrored sites using only incremental changes

If Tivoli Storage Productivity Center for Replication runs on a z/OS operating
system, you can configure a Metro Global Mirror session to control the Metro
Mirror relationship between the primary and secondary site by using the
HyperSwap feature. With HyperSwap enabled, a failure on the primary storage
system causes an automatic HyperSwap operation, which transparently redirects
application I/O to the auxiliary storage system. The Global Mirror relationship
continues to run uninterrupted throughout this process. With this configuration,
you can achieve almost a zero data loss at larger distances.

Using synchronous mirroring, you can switch from local site H1 to remote site H2
during a planned or unplanned outage. It also provides continuous disaster
recovery protection of the H2 and H3 sites. You do not have to configure H2, if a
switch from site H1 occurs. With this configuration, you can reestablish
H2->H1->H3 recoverability while production continues to run at site H2.
Additionally, this setup can reduce the workload on site H1.

Important:

v If HyperSwap occurs by event when running a Metro Global Mirror with a
HyperSwap session, a full copy of the data occurs to return to a full three-site
configuration. If you issue a HyperSwap command when running a Metro
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Global Mirror with a HyperSwap session, a full copy does not occur. A full copy
is required only for an unplanned HyperSwap or a HyperSwap initiated using
the z/OS SETHS SWAP command.

v In Metro Global Mirror and Metro Global Mirror with Practice sessions, when
the H1 is on an ESS storage system, you might risk filling up the space efficient
journal volumes. Because incremental resynchronization is not available on the
ESS storage system, full copies are performed in many of the transitions.

Metro Global Mirror

A Metro Global Mirror session with Practice combines Metro Mirror, Global Mirror,
and FlashCopy across three sites to provide a point-in-time copy of the data on the
third site.

The following figure illustrates how a Metro Global Mirror session works.

Metro Global Mirror with Practice

A Metro Global Mirror session with Practice combines Metro Mirror, Global Mirror,
and FlashCopy across three sites to provide a point-in-time copy of the data on the
third site. You can use this session to practice what you might do if a disaster
occurred without losing your disaster recovery capability.

The session consists of three host volumes, an intermediate volume, and a journal
volume. The following figure illustrates how a Metro Global Mirror with Practice
session works.
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Note: In Metro Global Mirror and Metro Global Mirror with Practice sessions,
when the H1 is on an ESS storage system, you might risk filling up the space
efficient journal volumes. Because incremental resynchronization is not available on
the ESS storage system, full copies are performed in many of the transitions.

Examples

Read the following scenarios for information on using Metro Global Mirror for
continuous, remote data replication between three sites.

Metro Global Mirror
Although Jane works in San Francisco, she wants to run the business from
either Oakland, the secondary site, or Houston, the tertiary site. Jane can
use Metro Global Mirror with Failover/Failback to switch the direction of
the data flow, so that she can run the business from either Oakland or
Houston. Using Metro Global Mirror, Jane has zero data loss at the
secondary site and minimal data loss at the tertiary site.

Metro Global Mirror with Practice
Jane wants to run a Metro Global Mirror with Practice from San Francisco
to Houston. She plans to verify her recovery procedure for the Houston
site. However, she cannot stop running the Metro Global Mirror session
while she takes time to practice a recovery. By using a Metro Global Mirror
with Practice session, Jane can practice her disaster recovery scenario in
Houston while the Metro Global Mirror session runs uninterrupted. When
she practices running the applications at the Houston site and is prepared
to run the applications at the Oakland site, if necessary, Jane is prepared to
recover data if a disaster occurs at the San Francisco site.

Jane can use Metro Global Mirror with Practice to switch the direction of
the data flow, so that she can run the business from either Oakland or
Houston. Using Metro Global Mirror, Jane has zero data loss at the
secondary site and minimal data loss at the tertiary site.
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Managing a session with HyperSwap and Open HyperSwap
replication
HyperSwap and Open HyperSwap provide high availability of data if a primary
disk storage system failure occurs. When a failure occurs in writing I/O to the
primary storage system, the failure is detected by IOS, and IOS automatically
swaps the I/O to the secondary site with no user interaction and minimal
application effect.

Sessions that can be enabled for HyperSwap or Open HyperSwap:

You can create sessions that enable swapping, which provides a session with a
highly available business continuity solution.

Sessions that can enable HyperSwap

The following session types can enable HyperSwap processing:
v Basic HyperSwap
v Metro Mirror with Failover/Failback
v Metro Global Mirror

To enable HyperSwap processing, the following conditions must apply:
v The session is running on a Tivoli Storage Productivity Center for Replication

server that is running on IBM z/OS.
v The volumes are only for TotalStorage Enterprise Storage Server, System Storage

DS8000, and DS6000 systems.
v The volumes are count key data (CKD) volumes that are attached to the z/OS

system.

Sessions that can enable Open HyperSwap

Only Metro Mirror with Failover/Failback session type can enable Open
HyperSwap processing.

To enable Open HyperSwap processing, the following conditions must apply:
v The volumes in the session are System Storage DS8000 5.1 or later volumes.
v The volumes in the session are fixed block and mounted to IBM AIX 5.3 or AIX

6.1 hosts with the following modules installed:
– Subsystem Device Driver Path Control Module (SDDPCM) version 3.0.0.0 or

later
– Multi-Path Input/Output (MPIO) module (the version that is provided with

AIX version 5.3 or 6.1)
v The connections between the AIX host systems and the Tivoli Storage

Productivity Center for Replication server are established.

Setting up the environment for HyperSwap:

You must set up an environment in which you can run HyperSwap processing
before you can enable HyperSwap for a IBM Tivoli Storage Productivity Center for
Replication session.

Complete the following steps before you enable HyperSwap. For more information
about these steps, see the IBM Tivoli Storage Productivity Center for Replication
for System z Installation and Configuration Guide.
1. Install IBM Tivoli Storage Productivity Center for Replication for System z.
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2. Set up the data store and configure other necessary system settings.
3. Ensure that all RESERVEs are converted to global enqueues (ENQs).
4. Ensure that all volumes in the session that you are enabling for HyperSwap are

attached to the IBM z/OS system that runs Tivoli Storage Productivity Center
for Replication.

5. Set up and start the IOSHSAPI and HSIB tasks.

Setting up the environment for Open HyperSwap:

You must set up an environment in which you can run Open HyperSwap
processing before you can enable Open HyperSwap for a IBM Tivoli Storage
Productivity Center for Replication session.

Complete the following steps before you enable Open HyperSwap.
1. Ensure that the IBM AIX hosts and IBM System Storage DS8000 meet the

following hardware and software requirements:

AIX requirements
You can find the supported AIX version for each Tivoli Storage
Productivity Center for Replication release in the support matrix at
http://www.ibm.com/support/docview.wss?uid=swg21386446. Click
the link for the applicable release under Agents, Servers, and GUI.

You must have the following AIX modules installed:
v Subsystem Device Driver Path Control Module (SDDPCM) version

3.0.0.0 or later
v Multi-Path Input/Output (MPIO) module (the version that is

provided with AIX)

System Storage DS8000 hardware requirements
The Open HyperSwap function requires System Storage DS8000 5.1 or
later.

You cannot use Open HyperSwap with High Availability Cluster
Multi-Processing (HACMP™).

2. Create connections from Tivoli Storage Productivity Center for Replication to
the AIX hosts by following the instructions at “Adding a host system
connection” on page 685.

3. Assign copy set volumes from the storage device to the host by using the
System Storage DS8000 command-line interface (CLI) or the graphical user
interface (GUI).

4. Run the AIX cfgmgr command to discover the volumes that are assigned to the
host.

Considerations for Open HyperSwap and the AIX host:

v A single session that has the Open HyperSwap function enabled can manage
multiple hosts; however, each host can be associated with only one session.
Multiple hosts can share the session.

v For AIX 5.3, a single host can manage a maximum of 1024 devices that are
enabled for Open HyperSwap processing on the host, with eight logical paths
configured for each copy set in the session. For AIX 6.1, a single host can
manage a maximum of 1024 devices that are enabled for Open HyperSwap
processing on the host, with 16 logical paths that are configured for each copy
set in the session.
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v If an application on the host opened a device, a Tivoli Storage Productivity
Center for Replication session for that device cannot be ended. The Terminate
command fails. To end the session, you must either close the application or
remove the copy sets from the session. If you remove copy sets from the session,
you must ensure that the application writes the data to the correct volume when
the copy set relationship is restored.

v Open HyperSwap processing can fail on a subset of hosts for the session and
continue to run on the remaining hosts for the same session. In this situation,
you must determine the best action to take if the application is writing data to
volumes on the source system and to volumes on the target system.

v To enable Open HyperSwap processing on the host, see the IBM System Storage
Multipath Subsystem Device Driver User's Guide.

Configuring timers to support Open HyperSwap:

You can configure timeout values for the storage system, Tivoli Storage
Productivity Center for Replication, and AIX hosts systems. These values can affect
the operation of Open HyperSwap.

The following various timeout values can affect Open HyperSwap:

Storage system quiesce timeout value
This value is the time when the storage system starts a quiesce operation.
When the timer value expires, I/O is resumed on the primary device. The
default timeout value is 2 minutes, but the value can be set from 30 to 600
seconds. To set the quiesce timeout value, use the chdev command in the
IBM System Storage Multipath Subsystem Device Driver User's Guide.

Storage system long busy timeout value
This value is the time in seconds that the logical subsystem (LSS)
consistency group volume stays in the long busy state after a remote
mirror and copy error is reported.

Timeout values for the applications that are on the host
The various applications that are running on the host have timeout values.
The timeout values vary depending on the application.

Considerations for setting timers

Consider the following information for setting timers:
v If the host quiesce timer is set to a shorter value than the Tivoli Storage

Productivity Center for Replication response timer, an I/O swap failure can
occur. If a storage system triggers an unplanned failover and if the storage
system quiesce timer expires before Tivoli Storage Productivity Center for
Replication responds, the host attempts to write I/O to the primary volume
where the loss of access occurred. If the hardware condition that caused the loss
of access continues, the write I/O operation fails again and an unplanned Open
HyperSwap is not performed.

v If the host quiesce timer is set to a longer value than the Tivoli Storage
Productivity Center for Replication response timer, an application timeout might
occur if Open HyperSwap takes too long to complete.

Enabling a session for HyperSwap or Open HyperSwap:

Enabling HyperSwap or Open HyperSwap for a session provides business recovery
and business continuity.
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Ensure that you can use the HyperSwap or Open HyperSwap functions in your
environment. See “Setting up the environment for HyperSwap” on page 99 or
“Setting up the environment for Open HyperSwap” on page 100.

Enable a HyperSwap or Open HyperSwap session by completing the following
steps:
1. In the Tivoli Storage Productivity Center for Replication navigation tree, select

Sessions. Click the button next to the session that you want to enable.
2. From the Select Action menu, select View/Modify Properties and click Go. If

you did not create the session, click Create Session. You can enable the
HyperSwap or Open HyperSwap function on the Properties page

3. In ESS / DS Metro Mirror Options, select the appropriate HyperSwap or Open
HyperSwap options:
v Manage H1-H2 with HyperSwap. This option enables a session to manage

the H1-H2 sequence using HyperSwap. If you select this option, select from
the following additional options.
– Disable HyperSwap. Select this option to prevent a HyperSwap from

occurring by command or event.
– On Configuration Error. Choose one of the following options:

- Partition the system(s) out of the sysplex. Select this option to partition
out of the sysplex when a new system is added to the sysplex and
encounters an error in loading the configuration. A restart of your
system is required if you select this option.

- Disable HyperSwap. Select this option to prevent a HyperSwap from
occurring by command or event.

– On Planned HyperSwap Error. Choose one of the following options:
- Partition out the failing system(s) and continue swap processing on

the remaining system(s). Select this option to partition out the failing
system and continues the swap processing on any remaining systems.

- Disable HyperSwap after attempting backout. Select this option to
stop the HyperSwap action, and disable the HyperSwap commands or
events.

– On Unplanned HyperSwap. Choose one of the following options:
- Partition out the failing system(s) and continue swap processing on

the remaining system(s). Select this option to partition out the failing
systems and continues the HyperSwap processing on the remaining
systems when a new system is added to the sysplex and HyperSwap
does not complete. A restart of your system is required if you select this
option.

- Disable HyperSwap after attempting backout. Select this option to
stop the HyperSwap action, and disable the HyperSwap commands or
events.

v Manage H1-H2 with Open HyperSwap. If volumes are attached to an IBM
AIX host, Tivoli Storage Productivity Center for Replication can manage the
H1-H2 sequence of a Metro Mirror session using Open HyperSwap. If this
option is selected, a failure on the host accessible volumes triggers a swap,
which redirects application I/O to the secondary volumes. Only volumes
that are currently attached to the host systems that are defined on the Tivoli
Storage Productivity Center for Replication Host Systems panel are eligible
for Open HyperSwap.
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– Disable Open HyperSwap. Select this option to prevent a swap from
occurring by a command or event while keeping the configuration on the
host system and all primary and secondary volumes coupled.

4. Click OK to apply the selected options.

Restarting an AIX Host System that is enabled for Open HyperSwap:

When an AIX host system is restarted, the host automatically opens any volumes
for I/O that were open before the system was restarted. If Open HyperSwap was
enabled for a set of volumes on the host system, the host must determine which
storage system is the primary system before the host can allow the volumes to be
opened.

If the Metro Mirror relationship for the set of volumes is in Prepared or Suspended
state and the host has connectivity to both the primary and secondary storage
systems, the host can determine through the hardware which storage system is the
primary system. In this situation, the host automatically opens the volumes.

If the Metro Mirror relationship for the set of volumes is in Prepared state and the
host has connectivity to only the secondary storage system, all I/O to the volumes
might be blocked on the host system. The I/O might be blocked until the host can
verify the primary volume in the relationship. The AIX varyonvg command fails to
open the volumes for I/O to prevent the application from writing to an incorrect
volume. If the host can determine which volume is the primary volume in the
relationship and connectivity to the primary storage system is still lost, a
Hyperswap event is triggered. This event causes all I/O to be automatically
opened and directed to the secondary storage system.

If the Metro Mirror relationship for the set of volumes is in Target Available state
or the host system does not have connectivity and is unable to determine which
site is the primary site, all I/O to the volumes are blocked on the host system. The
Target Available state occurs after a Hyperswap or a Recover command is issued
for the session. The varyonvg command fails to open the volumes for I/O to
prevent the application from writing to an incorrect volume.

Unblocking I/O on the host system after a host system restart

When any of the previous scenarios cause I/O to be blocked, manual actions might
be necessary to remove the block.

If the relationships are in Target Available state on the hardware, issue the Start
command to the session in the required direction of the relationship. This action
defines the primary storage system for the host. The host system can allow the
volumes to be opened for I/O processing.

If the relationships cannot be restarted, or the host cannot determine the primary
storage system, it might be necessary to manually decouple the volumes on the
host system.

To decouple the volumes, complete one of the following tasks:
v Stop the session or remove the copy set. This action requires a full copy when

the relationships are restarted.
v Remove Object Data Manager (ODM) entries by using the following command:

odmdelete -o Volume_Equivalency
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Restriction: This command deletes copy set information; use it only for this
scenario.

Planned and unplanned swaps:

After a session is enabled for HyperSwap or Open HyperSwap processing and
reaches Prepared state, Tivoli Storage Productivity Center for Replication loads the
configuration of volumes that can be swapped to a z/OS or AIX operating system.

When the load is complete, the session can start a planned or unplanned swap.
The H1-H2 role pair of the session shows a type of HS. An "H" is displayed over
the connection in the dynamic image for that role pair, as shown in the following
figure.

Completing a Planned Swap

When the session configuration is loaded on z/OS for HyperSwap or AIX for
Open HyperSwap, the session is considered swap capable. There may be cases
such as a planned maintenance or a migration from the primary storage, in which
a planned swap might be required. When the session is in swap capable state, a
planned swap can be completed by issuing the HyperSwap command for the
session.

After you run a planned swap for z/OS HyperSwap and Open HyperSwap, the
session transitions to Target Available state and all the H1-H2 pairs are in Target
Available state. If the H1-H2 role pair was consistent at the time of the swap, the
session has a status of Normal, which indicates that H1-H2 is consistent. If the
H1-H2 role pair was not consistent at the time of the swap, the session has a status
of SEVERE. The active host on the session is shown as H2.

All I/O is redirected to the H2 volumes. After a successful swap to site 2, you
cannot enable the copy function to site 2. The only way to restart the copy
processing is by issuing the Start H2->H1 command. To have the volumes
protected with high availability and disaster recovery again, correct the error that
caused the swap to occur, and manually restart the session to begin copying data
to the other site.

The following figure illustrates a planned swap operation.
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Unplanned swaps

When the session configuration is loaded on z/OS for HyperSwap processing or
on AIX for Open HyperSwap processing, the session is considered swap capable. If
a primary I/O error occurs, a swap occurs automatically. For HyperSwap, z/OS
completes the swap and then alerts Tivoli Storage Productivity Center for
Replication that a swap occurred. For Open HyperSwap, Tivoli Storage
Productivity Center for Replication and the AIX host work together to complete
the swap.

When an unplanned swap occurs for HyperSwap and Open HyperSwap, the
session transitions to Target Available state and all the H1-H2 pairs are in Target
Available state. If the H1-H2 role pair was consistent at the time of the swap, the
session has a status of Normal and indicates that H1-H2 is consistent. If the H1-H2
role pair was not consistent at the time of the swap, the session might show a
status of SEVERE. The active host on the session is shown as H2.

All I/O is redirected to the H2 volumes. After a successful swap to site 2, you
cannot enable the copy function to site 2. Therefore, it is not possible to issue a
Start H1->H2 command. The only way to restart the copy processing is by issuing
a Start H2->H1 command. To have the volumes protected with high availability
and disaster recovery again, correct the error that caused the swap to occur, and
manually restart the session to begin copying data to the other site.

The following figure illustrates an unplanned swap.
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Scenarios that require a full copy in Metro Global Mirror with HyperSwap
sessions

You must run a full copy to return to the three-site configuration after a swap
when the following conditions occur:
v If you run a Metro Global Mirror session with the HyperSwap function and you

issue the HyperSwap command by using the z/OS HyperSwap API.
v If you run a Metro Global Mirror session with the HyperSwap function and an

unplanned swap occurs.

Verifying a session for a planned or unplanned swap:

You can verify whether a session is capable of a planned or unplanned swap from
the z/OS console on HyperSwap or the AIX host on Open HyperSwap.

Verify the status of HyperSwap from the z/OS console:
1. View the overall status of the HyperSwap session. Issue the ds hs,status

command. For example:
15.03.06 SYSTEM1 d hs,status
15.03.06 SYSTEM1 STC00063 IOSHM0303I HyperSwap Status 531
Replication Session: SR_HS
HyperSwap enabled
New member configuration load failed: Disable
Planned swap recovery: Disable
Unplanned swap recovery: Disable
FreezeAll: No
Stop: No

2. Verify all the volumes in the configuration. Issue the ds hs,config(detail,all)
command. For example:
15.03.51 SYSTEM1 d hs,config(detail,all)
15.03.51 SYSTEM1 STC00063 IOSHM0304I HyperSwap Configuration 534
Replication Session: SR_HS
Prim. SSID UA DEV# VOLSER Sec. SSID UA DEV# Status
06 02 00F42 8K3602 06 04 00FA2
06 01 00F41 8K3601 06 03 00FA1
06 00 00F40 8K3600 06 02 00FA0

Verify the status of Open HyperSwap from the AIX host:
1. View the session association and the path that the I/O is being routed to. The

path is indicated by an asterisk. Issue the pcmpath query device command. For
example:
host1> pcmpath query device 14

DEV#: 14 DEVICE NAME: hdisk14 TYPE: 2107900 ALGORITHM: Load Balance
SESSION NAME: session1
OS Direction: H1<-H2
==========================================================================
PRIMARY SERIAL: 25252520000
-----------------------------
Path# Adapter/Path Name State Mode Select Errors

0 fscsi0/path0 CLOSE NORMAL 6091 0
1 fscsi0/path2 CLOSE NORMAL 6300 0
2 fscsi1/path4 CLOSE NORMAL 6294 0
3 fscsi1/path5 CLOSE NORMAL 6187 0

SECONDARY SERIAL: 34343430000 *
-----------------------------
Path# Adapter/Path Name State Mode Select Errors

4 fscsi0/path1 CLOSE NORMAL 59463 0
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5 fscsi0/path3 CLOSE NORMAL 59250 0
6 fscsi1/path6 CLOSE NORMAL 59258 0
7 fscsi1/path7 CLOSE NORMAL 59364 0

Temporarily disabling HyperSwap or Open HyperSwap:

In some situations, it might be necessary to temporarily disable the HyperSwap or
Open HyperSwap function for a session.

You might want to disable HyperSwap or Open HyperSwap in the following
circumstances:
v If you are performing maintenance on the system
v If one sysplex member cannot communicate with one or more volumes

Complete these steps to disable Open HyperSwap for a specific session:
1. In the Tivoli Storage Productivity Center for Replication navigation tree, select

Sessions.
2. Select the sessions for which you want to disable the HyperSwap or Open

HyperSwap function.
3. Select View/Modify Properties from the Select Actions list, and click Go.
4. Select Disable HyperSwap or Disable Open HyperSwap, and click OK.

Tip: On management servers that run on a z/OS operating system, you can
disable the HyperSwap function from an MVS command prompt window by
entering the SETHS DISABLE command.

Using active and standby Tivoli Storage Productivity Center for Replication
servers with HyperSwap or Open HyperSwap:

You can set up an active and standby management server configuration with
HyperSwap or Open HyperSwap.

Active and standby servers with HyperSwap

When the storage system is set up to connect through the z/OS interface, the
connection information is sent to the standby server and a connection is attempted.
The connection might fail if the standby server does not run on a z/OS operating
system or does not have access to the same volumes. If the connection fails and the
standby server resumes the processing, the standby server cannot manage the
HyperSwap processing.

On the z/OS system, if the session configuration was successfully loaded before
the HyperSwap processing, the z/OS system can manage the HyperSwap
processing. If the z/OS system swaps the volumes but cannot communicate with
the Tivoli Storage Productivity Center for Replication server, the session is set to
Suspended or Severe state. To set the session to Target Available state, clear the
Manage H1-H2 with Hyperswap option, and issue the Recover command for the
session.

Active and standby servers with Open HyperSwap

When there is an active and standby management server configuration and a host
system connection is added to the active server, a connection is attempted between
the host system and the standby server. After AIX loads the session configuration,
Open HyperSwap processing is possible only if there is communication between
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AIX and the Tivoli Storage Productivity Center for Replication server. If a standby
server resumes the processing and is unable to connect to the host system that
manages the swap, the session cannot run Open HyperSwap processing. You must
activate communication to the host system before the session can run Open
HyperSwap processing.
Related tasks:
“Managing management servers” on page 664
This section provides information about how to set up active and standby
management servers, restore a lost connection between the management servers, or
perform a takeover on the standby management server.

Alerts
You can set up Tivoli Storage Productivity Center so that it examines the data that
it collects about your storage infrastructure and writes an alert to a log when an
event occurs. You also can specify that an action is initiated, such as sending an
SMNP trap, sending an e-mail, or running a script when the event occurs.

Alerts that are triggered based on the data collected by monitoring jobs (for
example, pings, scans, and probes) must be defined before the monitoring jobs are
run. Alerts that are triggered based on an external source, such as an SNMP trap,
must be defined after the SNMP server is configured properly.

You can define an alert in the following ways:
v As part of a data collection schedule
v As part of an alert definition

When an event occurs and triggers an alert, the alert is written to a log. You can
also select one or more other ways to be notified of the event. These alert
notifications include SNMP traps, IBM Tivoli Enterprise Console events, Tivoli
Storage Productivity Center login notifications, operating-system event logs, or
email.

Note: Alerts are not generated in a Tivoli Storage Productivity Center instance for
actions that you perform from that instance. For example, if you start Tivoli
Storage Productivity Center and use Disk Manager to assign or unassign volumes
for a subsystem, you do not receive alerts for those volume changes in that
instance. However, if you assign and unassign volumes outside of that Tivoli
Storage Productivity Center instance, an alert is generated.

Triggering conditions for alerts

In general, the following types of conditions can trigger alerts:
v A data collection schedule failed to complete.
v A change occurred in the storage infrastructure.
v A performance threshold was violated.

The specific conditions that can trigger events vary, depending on the type of
storage resource that is being monitored. See “Triggering conditions for alerts” on
page 1439 for more information about triggering conditions.

Alert notifications and triggered actions

Notification methods, or triggered actions, define the method by which you are
notified of an alert: SNMP Trap, Tivoli Enterprise Console Event, Login
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Notification, Windows Event Log, UNIX Syslog, and email. Alerts are always
written to the error log. Additionally, if a Data agent or Storage Resource agent is
deployed on a monitored computer, you can run a script or start an IBM Tivoli
Storage Manager job in response to the alert. See “Triggered actions for alerts” on
page 1453 for more information about triggered actions.

Prerequisites for successfully using alerts

The following conditions must be met in order to successfully use alerts:
v Data collection schedules are configured and scheduled to run on a regular

basis.
v If you want to be notified about an alert in some way other than an entry in the

log file, such as using SNMP traps.Tivoli Enterprise Console events, or email,
alert notification instructions must be configured before using the alert. See
“Configuring alert destinations” on page 395).

v If an alert is triggered based on an SNMP trap from the monitored resource, you
must properly configure the SNMP server of the monitor resource to enable
Tivoli Storage Productivity Center to listen to SNMP traps. The default port
number is 162, and the default community is public.

Default alerts

The following types of alerts are set for your system by default:
v New entity found
v Job failed

You can change the triggered actions and enable or disable these alerts, but you
cannot delete them.

Provisioning planner
Use the IBM Tivoli Storage Productivity Center host planner, the storage planner, and
the security planner to provide guidance when you provision your storage system.
The collective term for all three individual planners working together is the
provisioning planner.

For example, to add more storage to a host, the three planners work together to
create the storage, zone the new storage to the host, and configure the multipath
settings on the host. After using the planners to do these tasks, you can continue to
do typical Tivoli Storage Productivity Center jobs with the storage on the host,
such as creating the file system.

You can call each planner individually. For example, you might modify an existing
multipath or zone setting or create volumes on the subsystem for later use with
the host planner.

Use the planners to plan an integrated set of high-level policies for performance,
availability, and security, based on the current resource utilization. The set of
selected policies determines the best action responses to performance, availability,
and security events and constitutes the output plan, which is the record of the
output of the planners. You can either accept plan advice to trigger an associated
action (like creating a volume or performing zoning), or reject the advice and
change the plan.
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Modes of use

You can use the planners in the following ways:

Planning mode (Host planning advice)
Planning mode uses each of the planners: storage planner, provisioning
planner, and security planner, to configure an end-to-end plan for storage
connectivity. This results in a recommendation for zoning, volume
assignment, and multipath software configuration.

Assist mode
Assist mode provides zoning recommendation that meet the connectivity
requirements, as established in current policies.

Validate mode
Validate mode evaluates the current configuration against the connectivity
requirements, using the configuration checker utility.

Host planner
Use the IBM Tivoli Storage Productivity Center host planner to provide guidance
when you configure host to subsystem connectivity. The host planner accesses
default requirements or requirements that you set, and helps identify
configurations that do not meet those requirements.

You can perform common network and storage provisioning tasks all at once by
using the host planner with the other two planners, which are the security planner
and the storage planner. The collective term for the three individual planners
working together is provisioning planner.

For example, to add more storage to a host, the three planners work together to
create the storage, zone the new storage to the host, and configure the multipath
settings on the host. After using the planners to do these tasks, you can continue to
do typical Tivoli Storage Productivity Center jobs with the storage on the host,
such as creating the file system.

Host planning is the task of determining the connectivity between a host and the
storage subsystems to obtain pathing and performance requirements. Inputs to the
planning process are:
v The host
v Host ports and storage controller ports (and port performance utilization)
v Existing multipathing and zoning information
v The subsystem and identifiers
v The application profile (I/O, performance, and availability requirements)
v Pathing requirements (whether to use multipathing if it is available)

The planning process uses storage planning, configuration checking, and security
planning for portions of the overall process.

Collection of information
The planner retrieves information from the Tivoli Storage Productivity
Center database as its default input. You can provide explicit values to
override default input. If you explicitly specify the number of paths, for
example, the host planner verifies whether the value satisfies performance
requirements. If not, the host planner calculates the number of paths, and
which storage controller and host ports satisfy the requirements. The
fabric, disk, and data discovery and probe operations must run to collect
the information needed for the planner. If the information is not collected,
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the planner output identifies the limitation and presents a recommendation
based on the subset of information that is available.

Required components
The host planner also uses the following components:

Data agent or Storage Resource Agent
The Tivoli Storage Productivity Center data agent is enhanced to
deal with an SD multipathing driver on the host. The enhanced
data agent also collects SDD information, including SDD present,
version, HBAs and ports, HBA info, vdisk and vpath configuration,
and multipathing settings per vpath.

Multipathing control action application programming interfaces (APIs)
Unlike the storage planner or the security planner, control action
APIs for multipathing do not exist.

Overview of the planning process

Host planning requires the following steps:
1. Validating that the host and subsystem are compatible by type and level of the

host, the operating system, the subsystem, and the SDD software, for example
2. Determining the number of paths needed for the pathing policy and the

expected I/O performance
3. Determining the connectivity required between the host and the subsystem
4. Determining the configuration for multipathing software
5. Configuring the zoning and SDD multipathing configuration

Policies related to the host planner
The host planner uses the following policies that you configure with the
configuration checker utility:

Multipath
Specifies the multipath policy requirement (multiple or single path)

Preferred number of paths
Specifies required number of paths between host and subsystems

Multipath driver mode
Specifies multipath driver mode (failover, load balancing, round
robin)

Redundant fabric
Specifies routing through isolated fabrics (must have at least two
routes in separate fabrics, only one route required)

Planning guidance outputs
The host planner provides guidance that is based on the pathing and
performance requirement inputs that it accesses. Outputs from the
planning process are:
v Validation that a plan is possible
v Zoning
v Subsystem assignment
v Multipathing (SDD) configuration information
v Configuration of zoning and SDD
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Indication of violations
The planner notifies you of current policy violations before running a new
plan that compensates for the violations. Violations are logged in the job
log.

Command-line interface
You cannot invoke the planning wizard by using the command-line
interface..

Storage planner
Use the IBM Tivoli Storage Productivity Center storage planner to perform storage
administration tasks, such as creating storage.

You can complete common network and storage provisioning tasks at the same
time by using the storage planner with the other two planners, which are the host
planner and the security planner. The collective term for the three individual
planners working together is provisioning planner.

For example, to add more storage to a host, the three planners work together to
create the storage, zone the new storage to the host, and configure the multipath
settings on the host. After using the planners to do these tasks, you can continue to
do typical Tivoli Storage Productivity Center jobs with the storage on the host,
such as creating the file system.

Collection of information
The storage planner collects and evaluates capacity, storage controller
preferences, storage controller types, the number of volumes and volume
size, performance requirements, the use of unassigned volumes, the RAID
level and performance utilization and capacity utilization input from the
Tivoli Storage Productivity Center database and from explicit values that
you define.

Planning guidance outputs
The storage planner generates a plan that presents optimal storage
controller and storage pool configurations.

Control action application programming interfaces (APIs)
The control action APIs are not implemented by the storage planner but
are implemented by the device manager (DM).

Overview of the planning process
If you explicitly specify the storage pool and controller information, the
storage planner checks to see whether the input performance and capacity
requirements can be satisfied.

Supported devices
The storage planner provides support for IBM System Storage DS8000, IBM
System Storage DS6000, and IBM Enterprise Storage (ES800 controllers).
The storage planner is capable of working with any combination of these
specific controllers.

Security planner
Use the IBM Tivoli Storage Productivity Center security planner to perform security
administration tasks.

You can perform common network and storage provisioning tasks all at once by
using the security planner with the other two planners, which are the host planner
and the storage planner. The collective term for the three individual planners
working together is provisioning planner.
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For example, to add more storage to a host, the three planners work together to
create the storage, zone the new storage to the host, and configure the multipath
settings on the host. After using the planners to do these tasks, you can continue to
do typical Tivoli Storage Productivity Center jobs with the storage on the host,
such as creating the file system.

Collection of information
The security planner collects and evaluates existing host port information,
storage controller ports, zones, zone sets, and switches from the Tivoli
Storage Productivity Center database and from explicit values that you
define as zoning input and volume masking input.

Planning guidance outputs
The security planner generates a plan that presents optimal zoning and
volume masking.

Control action application programming interfaces (APIs)
The security planner control APIs are currently already implemented by
the fabric and DM APIs.

Overview of the planning process
If you specify exact zoning and volume masking information details, the
planner informs you whether your input is different than the existing
configuration, or different than the optimal configuration that the planner
calculates based on policies and the existing security parameters. If the
optimal configuration differs from your selections, the planner proposes
zoning and volume masking settings.

Reporting
This section contains conceptual information about reporting.

Use the Reporting facilities in the different managers of IBM Tivoli Storage
Productivity Center to view both overview and detailed information about your
storage. The over 500 available reports are constructed from the statistical
information accumulated in the repository and enable you to select exactly the
computers, storage systems, switches, clusters, disks, file systems, hypervisors,
users and even other Tivoli Storage Productivity Center servers upon which you
want to report. You can view reports as tables of data or as graphical charts, which
provides you with the flexibility to get a very detailed look at your information or
a very high level overview.

You must collect information about your environment before you can use reports
to view details about the storage resources in it. You can use monitoring jobs in
Tivoli Storage Productivity Center such as probes, scans, pings, and Tivoli Storage
Productivity Center server probes, and discovery jobs to gather comprehensive
information and statistics about your storage resources.

Fabric and zones
Use the IBM Tivoli Storage Productivity Center to learn more about fabrics and
zones.

Zones, zone aliases, and zone sets
Zones, zone aliases, and zone sets allow logical grouping of ports and storage
devices within a storage area network. This section describes zoning concepts and
elements.
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In a storage area network a zone is a logical grouping of ports to form a virtual
private storage network. Zones that belong to a single SAN can be grouped into a
zone set, which can be activated or deactivated as a single entity across all switches
in the fabric. A zone set can contain one or more zones, and a zone can be a
member of more than one zone set. Using zoning, you can automatically or
dynamically arrange fabric-connected devices into logical groups across a physical
fabric.

Ports and devices in a zone are called zone members. A zone can contain one or
more zone members. Ports that are members of a zone can communicate with each
other, but they are isolated from ports in other zones. Devices, however, can belong
to more than one zone. A zone alias is a collection of zone members. A zone alias
can be added to one or more zones.

Note: In some cases, inactive zones might not have any zone members. Activating
an inactive zone set that contains empty zones will fail if a switch does not
support empty zones in active zone definitions.

Zone membership can be specified by:
v The N_Port_Name of the N_Port connected to the switch (also known as WWN

zoning or port name zoning)
v The N_Port address identifier assigned during fabric login (also known as PortId

or FCID zoning)
v The Node_Name associated with the N_Port
v The Domain identification (Domain_ID) and physical port ID of the Switch Port

to which the N_Port is attached (also known as domain port zoning)
v An alias name

Zoning supports the use of aliases, which are meaningful names assigned to
devices. An alias can also be a group of devices that are managed together to make
zoning easier.

There are two types of zoning:

Hardware zoning (port zoning)
In hardware zoning (also called port zoning), the members of a zone are the
physical ports on a fabric switch.

Software zoning (WWN zoning)
Software zoning uses the Simple Name Server (SNS) that runs inside a
fabric switch. It is based on the node WWN or port WWN of the zone
members to be included. Software zoning lets you create symbolic names
for the zones and zone members.

A default zone is a group of devices that are not members of the active zone set.
These can communicate with each other but not with members of any other zone.
Default zoning is enabled by default. You can use a switch element manager to
configure the Default Zone option to enable or disable the default zone
independently of the active zone set.

Note:

1. If the default zone is disabled, devices that are not members of the active zone
set cannot communicate.

2. If the default zone is disabled and no zone set is active, no devices can
communicate.
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3. If default zoning is enabled, deactivating the active zone set makes all devices
members of the default zone. If default zoning is disabled, all communication
stops.

4. If you activate one zone set while another zone set is active, the currently
active zone set is deactivated.

5. If your EFC Manager manages multiple fabrics, ensure that you have the
correct zone set for the fabric you are currently updating.

You can view zones in SANs using the topology viewer console. Fabric Manager
lets you create, update, and delete zones, zone aliases, and zone sets in a SAN. In
addition, you can do the following:
v Assign zones to zone sets
v Activate and deactivate zone sets
v View zone membership
v Add and remove zone members to and from a zone
v Add and remove zone members to and from a zone alias
v Assign zone aliases to zones

Note: Certain types of switches and the types of agents configured can affect the
zoning operations that you can perform.

Zone configuration
When you configure zones, you can use Fabric Manager or the management
application for the devices. The advantages of using Fabric Manager rather than
the management applications of the devices are that Fabric Manager lets you
perform zoning from a single interface, and you can use consistent, familiar
methods to work with devices from multiple vendors.

Consider the following guidelines if you use Fabric Manager with zones:
v For Brocade fabrics, topology information is collected through CIM agents. If no

CIM agents are configured, or if the fabric is a QLogic or Cisco fabric, have at
least one Storage Resource agent attached to each fabric and as a member of an
active zone for the complete topology display. In this way, you can manage your
switches and a string is returned, provided by the vendor, that can be the
worldwide name (WWN) or a vendor, model, and level type designation.

v For zone discovery and zone control for any fabrics with Brocade switches or
vendor Brocade switches, you must have a SMI-S agent configured for the fabric.

v A zone set can be deleted while it contains zones. With QLogic switches, those
zones are put into an orphan zone set. The zones can later be moved from an
orphan set into other zone sets. The Fabric Manager zone configuration panels
cannot display zones in an orphan zone set. However, the zones exist on the
switch, and they can be configured using the tool from the switch vendor.

v You cannot add empty zones to inactive zone sets for switches. Activating an
inactive zone set that contains empty zones can fail if a switch does not support
empty zones in active zone definitions.

Note: Fabric probes through the Storage Resource agents do not detect orphan
zones. These zones are not listed in the Zone Configuration window. However, the
zones exist on the switch, and they can be configured using the tool from the
switch vendor. However, Brocade orphan zones, which are discovered through
Storage Management Initiative (SMI) agents, are listed in the Zone Configuration
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window and can be configured by the Fabric Manager. Brocade orphan zone
aliases are listed in the Zone Configuration window and can be configured by the
Fabric Manager.

Switch zoning capabilities
When you select a fabric in which to perform zoning operations, Fabric Manager
determines the capabilities of the switches in the SAN and limits the zoning
operations based on that information.

To see a list of supported switches and their capabilities, default values, ranges,
and possible effects, go to http://www.ibm.com/support/docview.wss?
&uid=swg21156206.

Zoning for Cisco MDS 9000 devices:

Cisco switches support virtual SANs (VSANs), which is the logical partitioning of
a fabric into multiple fabrics. The overall network is referred to as the physical
infrastructure, and the logical fabrics are the VSANs. Fabric Manager provides
basic zone discovery and zone control for the Cisco MDS 9000 series of devices
using the FC-GS-3 protocol. This allows in-band zone control and defaults to the
Cisco VSANs.

The following tasks are supported:
v Creating, deleting, and updating zones
v Creating, deleting, updating, activating, and deactivating zone sets

Fabric Manager supports these zone member types:
v N_Port WWN
v FC ID (the fibre channel ID of an N_port attached to the switch)

Unsupported zone and zone member types are displayed as non-standard on the
topology display. Fabric Manager does not allow zone management of zones and
zone sets that contain unsupported members.

Brocade switches in zones:

Brocade switches support some non-standard zones such as quick loop zones,
fabric assist zones, and protocol zones. If the switch configurations have these
zones already defined, Fabric Manager preserves them and does not modify them
in any way. They are not displayed on the zone control interface. However, if they
are part of a zone set that is active at some time, the devices that are part of such
zones that are also online are displayed in the topology Zone View.

You can create, change, and delete non-standard zones by using the Brocade switch
management application.

Note:

v A zone set displayed on the zone control interface might have no zones. This
could mean that the zone set contains a non-standard zone on a Brocade switch.

v A zone set might have non-standard zones on a Brocade switch that are not
displayed on the zone control interface.

v When creating a new zone using the same zone name as that of a non-standard
zone that already exists on a Brocade switch, you might get a error that the zone
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already exists. Because the non-standard zone is not displayed on the zone
control interface, you must verify this by using the switch management
application.

v Tivoli Storage Productivity Center allows you to add empty zones to an inactive
zone definition. Activation of a zone set containing empty zones may still fail if
the switch does not support empty zones in active zone definitions.

Agents
The IBM Tivoli Storage Productivity Center uses agents to gather data: Common
Information Model (CIM) agents, Storage Resource agents, Data agents, Fabric
agents, and out-of-band Fabric agents.

Common Information Model agents
Common Information Model (CIM) agents enable communication between the
storage device (storage subsystem, fabric switch, or tape library) and IBM Tivoli
Storage Productivity Center. Each storage device that you want to manage must
have a CIM agent either installed or embedded unless it is a device that uses
Native API connection.

CIM agents are provided by the vendor of the storage subsystem, fabric switch, or
tape library. Each vendor provides unique agent code for their family of storage
devices. This code implements a Common Information Model Object Manager
(CIMOM) that conforms to the Storage Management Initiative Specification (SMI-S)
of the Storage Networking Industry Association (SNIA).

The CIM agent enables communication between the storage device and Tivoli
Storage Productivity Center. Commands and responses are transmitted between
Tivoli Storage Productivity Center and the CIM agent using an XML transport
layer. The CIM agent to storage device layer uses a vendor-specific proprietary
interface.

The CIM agent usually must be installed and configured, so that it can identify the
storage devices with which it communicates. Some storage devices, such as Cisco
fabric switches, contain embedded CIM agents and so do not require that CIM
agents be installed, although Tivoli Storage Productivity Center must be configured
to point directly to the storage devices that contain the embedded CIM agents.

CIM agents can be referred to as SMI-S providers, CIM proxy agents, and CIMOM
agents. CIM agents can be embedded in the device or installed on a separate
computer.

Note:

v Do not install multiple CIM agents on a single computer because of port
conflicts.

v Do not install a CIM agent on the system where a Tivoli Storage Productivity
Center server component is installed.

Storage Resource agents and Data agents
Use Storage Resource agents and Data agents to collect information about the
storage resources (for example, servers, computers, workstations, HBAs, and so on)
in your environment. You must deploy an agent on systems that you want Tivoli
Storage Productivity Center to monitor.

Note: In Tivoli Storage Productivity Center v4.2 and later, you can deploy Storage
Resource agents only. If you want to install a Data agent, you must own a previous

Chapter 2. Product overview 117



version of the product. See the documentation for the previous version of the
product for information about how to install a Data agent.

Agents gather the following information about storage resources:
v Asset information
v File and file system attributes
v Database application information
v Novell Directory Services (NDS) tree information (only supported by Data

agents)
v Network attached storage (NAS) device information
v Topology information
v Zoning information

Agents also discover fabrics and perform zone control for Cisco and Qlogic fabrics.

Deployment guidelines and limitations for Storage Resource agents:

There are a number of guidelines and limitations that you must consider when
managing the Storage Resource agents in your environment.

Use the following information when you deploy Storage Resource agents and
migrate existing Data agents:
v Multiple Storage Resource agents that are probing or scanning the same storage

resources
v Platforms that support Storage Resource agents deployments
v Product functions that are not available for storage devices monitored by Storage

Resource agents
v Required authority for deploying Storage Resource agents
v Orphan zones
v Firewalls and Storage Resource agent deployments
v Multiple computers in a deployment
v Communication between the Tivoli Storage Productivity Center server and a

Storage Resource agent
v Daemon and non-daemon services
v Authentication between the Tivoli Storage Productivity Center server and a

Storage Resource agent
v Storage Resource agents on the same computer
v Time zones for computers monitored by Storage Resource agents
v UNIX systems using RSH protocol
v Deployments on Windows - NetBIOS setting
v Deployments on Windows - User Account Control (UAC) remote restrictions
v Additional information about Storage Resource agents

Multiple Storage Resource agents that are probing or scanning the same storage
resources

If multiple Storage Resource agents are set up to probe or scan the same
storage resources, the Storage Resource agent that was added to Tivoli
Storage Productivity Center first is used for the probe or scan. Therefore,
only data that is gathered by the first Storage Resource agent is shown.

Platforms that support Storage Resource agents for the same
For a list of platforms on which you can deploy Storage Resource agents,

118 IBM Tivoli Storage Productivity Center: User's Guide



go to the Tivoli Storage Productivity Center support site at
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/
Tivoli_Storage_Productivity_Center_Standard_Edition, click the
Documentation link, and enter Platform Support: Agents, Servers and
GUI in the Search box. Click the link to the document for the appropriate
release.

Product functions that are not available for storage devices monitored by Storage
Resource agents

Before you migrate an existing Data agent to a Storage Resource agent or
deploy a new Storage Resource agent, make sure that the product
functions you want to use on the monitored devices are available for those
agents. The following functions are not available for storage devices that
are monitored by Storage Resource agents:
v Certain relational database monitoring. For list of relational databases

that can be monitored by Storage Resource agents, go to the Tivoli
Storage Productivity Center support site at http://www.ibm.com/
support/entry/portal/Overview/Software/Tivoli/
Tivoli_Storage_Productivity_Center_Standard_Edition, click the
Documentation link, and enter Platform Support: Agents, Servers and
GUI in the Search box. Click the link to the document for the
appropriate release.

v The changing of zone configurations and the reporting of HBA, fabric
topology, or zoning information for fabrics connected to hosts running
Linux on IBM System z hardware. These limitations also apply to
Storage Resource agents on all guest operating systems for VMware
configurations.

Required authorities for deploying and running Storage Resource agents
Before you can create deployment schedules and deploy Storage Resource
agents on target computers, you must meet the following requirements:
v To create deployment schedules, you must be logged in to Tivoli Storage

Productivity Center with a user ID that has the Productivity Center
Administrator role. See the IBM Tivoli Storage Productivity Center and
IBM Tivoli Storage Productivity Center for Replication Installation and
Configuration Guide for more information about user roles.

v To deploy Storage Resource agents on target computers, you must
provide a user ID that has administrative rights on those computers. You
enter this ID when creating a deployment schedule. Tivoli Storage
Productivity Center uses this ID to log on to the target computers and
install and configure the necessary runtime files for the agents.

The user under which a Storage Resource agent (daemon or non-daemon)
runs must have the following authorities on the target computers:
v On Linux or UNIX, the user must have root authority. By default, an

agent runs under the user 'root'.
v On Windows, the user must have Administrator authority and be a

member of the Administrators group. By default, a Storage Resource
agent runs under the 'Local System' account.

Orphan zones
Storage Resource agents do not collect information about orphan zones. An
orphan zone is a zone that does not belong to at least one zoneset.

Firewalls and Storage Resource agent deployments
Before you can deploy a Storage Resource agent on a computer, you must
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turn off the firewall on that computer. If you do not turn off the firewall,
the deployment fails. To turn off the firewall on a Windows 2008 computer,
complete the following steps:
1. On the desktop of the Windows 2008 computer, click Start >

Administrative Tools.
2. Click Windows Firewall with Advanced Security.
3. Click Windows Firewall Properties.
4. Change the Firewall state field to Off on the following tabs: Domain

Profile, Private Profile, Public Profile.
5. Click OK to accept the changes and exit.
6. Deploy a Storage Resource agent to the Windows 2008 computer.

Multiple computers in a deployment
You can define a deployment schedule to include multiple computers on
which to install Storage Resource agents. The computers you include in a
deployment schedule must share the same administrative user ID and
password. IBM Tivoli Storage Productivity Center uses these user
credentials to log on to the computers when installing Storage Resource
agents. If the computers in a deployment schedule do not share the same
administrative user credentials, you must create separate deployment jobs
for them.

Note: When you deploy a Storage Resource agent to multiple computers, a
globally unique identifier (GUID) is created for each computer (if one does
not exist).

Communication between the Tivoli Storage Productivity Center server and a
Storage Resource agent

The Tivoli Storage Productivity Center server connects to a monitored
computer when a Storage Resource agent is deployed and whenever a data
collection schedule runs against that agent.

During deployment, the server communicates with the target computer
using one of the following protocols:
v Windows server message block protocol (SMB)
v Secure Shell protocol (SSH)
v Remote execution protocol (REXEC)
v Remote shell protocol (RSH)

After deployment, the type of communication between the server and
agent on that computer depends on whether you deployed the agent as
daemon service or non-daemon service. See the IBM Tivoli Storage
Productivity Center and IBM Tivoli Storage Productivity Center for Replication
Installation and Configuration Guide for more information about these
protocols.

Daemon and non-daemon services
You can deploy a Storage Resource agent agent as a daemon or
non-daemon service:
v A Storage Resource agent that is deployed as a daemon service runs in

the background on the monitored computer and listens for requests from
the Tivoli Storage Productivity Center server. Connectivity between the
server and agent is established using SSL. The server and agent have
their respective certificates and no additional information is required
besides those certificates and the security that is provided by the SSL
protocol.
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v A Storage Resource agent deployed as a service on demand
(non-daemon service) runs as a stand-alone executable file on the
monitored computer. Communication from the server to the agent uses
the same protocol that was used during the deployment of the agent.
Communication from the agent to the server uses SSL.

Authentication between the Tivoli Storage Productivity Center server and a
Storage Resource agent

Tivoli Storage Productivity Center requires the correct authentication
information (user ID, password, port, certificate location, or passphrase) for
monitored computers each time it communicates with Storage Resource
agents on those computers. If the authentication information changes for a
host computer on which a Storage Resource agent is deployed, the
authentication information for that agent must be updated using the
Change Authentication or Update Storage Resource agent List functions
on the Data/Storage Resource agents panel located under the
Administrative Services > Data Sources node in the navigation tree.

Storage Resource agents on the same computer
You cannot deploy a Storage Resource agent on a computer where a
Storage Resource agent is already installed and pointing to the same Data
server. You can deploy a Storage Resource agent on the same computer as
another Storage Resource agent if those agents communicate with different
Data servers and use different ports when listening for requests.

Time zones for computers monitored by Storage Resource agents
The time zones of computers that are monitored by Storage Resource
agents are shown as Greenwich Mean Time (GMT) offsets in Tivoli Storage
Productivity Center reports. For example, a computer in Los Angeles
shows the following time zones in the By Computer report in Asset
reporting:
(GMT-8:00) GMT-8:00

UNIX operating systems using Remote Shell protocol (RSH)
If RSH is configured to use a user ID and password, the connection fails.
To successfully connect to a system using RSH, you must set up the .rhosts
file (in the home directory of the account). RSH must be configured to
accept a login from the system that is running your application.

Deployments on Windows operating systems - NetBIOS setting
If you want to install a Storage Resource agent on Windows targets, the
Enable NetBIOS over TCP/IP option must be selected in the Control Panel
settings for the computer's network connections properties. To set this
option, click Start > Settings > Control Panel > Network and Dial-Up
Connections > <some_connection> > Properties > Internet Protocol
(TCP/IP) > Advanced > WINS > Enable NetBIOS over TCP/IP.

See the documentation for your firewall to determine if these ports are not
blocked for inbound requests.

To determine if security policies are blocking the connection ports, click
Start > Settings > Control Panel > Administrative Tools.

Depending on whether your policies are stored locally or in Active
Directory, follow these directions:

Locally stored policies
For locally stored policies, click Start > Settings > Control Panel >
Administrative Tools > Local Security Policy > IP Security
Policies on Local Computer.
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Policies stored in Active Directory
For policies stored in Active Directory, examine the IP security
policies and edit or remove filters that block the ports:
v Click Administrative Tools > Default Domain Security Settings

> IP Security Policies on Active Directory.
v Click Administrative Tools > Default Domain Controller

Security Settings > IP Security Policies on Active Directory.

For all Windows systems, the Server service must be running to connect to
a Windows system using the Windows protocol.

The following table lists the ports reserved for NetBIOS. Ensure that these
ports are not blocked.

Port Description

135 NetBIOS Remote procedure call. (Not currently used.)

137 NetBIOS name service.

138 NetBIOS datagram. (Not currently used.)

139 NetBIOS session (for file and print sharing).

445 CIFS (on Windows XP).

For Windows Server 2008, shares must be shared for the Guest or
Everyone accounts, and password protected sharing must be disabled. To
disable password protected sharing, follow these steps:
1. Click Control Panel > Networking and Sharing Center.
2. Click the down arrow next to Password protected sharing.
3. Click Turn off password protected sharing.
4. Click Apply. Exit from the Control Panel.

Deployments on Windows 2008 - User Account Control (UAC) remote
restrictions

If you are planning to install Storage Resource agents remotely on a
Windows 2008 operating system, you must disable the User Account
Control (UAC) remote restrictions on the Windows operating system. User
Account Control is a security component on Windows operating systems.

Note: This task contains steps that tell you how to modify the registry.
Serious problems might occur if you modify the registry incorrectly.
Therefore, make sure that you follow these steps carefully. For added
protection, back up the registry before you modify it. Then you can restore
the registry if problems occur. For information about how to back up and
restore the registry, see http://support.microsoft.com/kb/322756/.

To disable UAC remote restrictions, follow these steps:
1. Click Start > Run. Enter regedit and click OK.
2. Locate and click the following registry subkey:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
Policies\System

3. If the LocalAccountTokenFilterPolicy registry entry does not exist,
follow these steps:
a. On the Edit menu, click New > DWORD Value.
b. Enter LocalAccountTokenFilterPolicy as the name for the DWORD

value in the content pane. Click Enter.
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c. Right-click LocalAccountTokenFilterPolicy, then click Modify.
d. In the Edit DWORD Value window, enter 1, then click OK.

This value can be 0 or 1:

0 This value builds a filtered token. This value is the default
value. The administrator credentials are removed.

1 This value builds an elevated token.
e. Exit the registry editor.

Additional information about Storage Resource agents
See Planning for Storage Resource agents in the IBM Tivoli Storage Productivity
Center Installation and Configuration Guide for more information about
Storage Resource agents.

Storage Resource agents
Storage Resource agents collect information about the Storage Attached Network
(SAN) fabrics. You must deploy agents on systems with host bus adapters (HBAs)
that are connected to the SAN fabrics that you want to manage.

Agents communicate through the HBA and collect the following information:
v Attribute and topology information
v Host-level information, such as file system and volume mappings
v HBA information, including make, model, and driver versions
v Port state information
v Zoning information (for QLogic and Cisco fabrics)

You can deploy Storage Resource agents locally or remotely from the Tivoli Storage
Productivity Center server. Deploy a Storage Resource agent on at least one system
that has an HBA that is connected to each switch that you want to manage;
consider installing two Storage Resource agents for each switch to ensure
redundancy.

Out-of-band fabric agents
Out-of-band fabric agents issue SNMP queries to the fabric switches and collect
topology information.

Be sure that your out-of-band fabric agents point to each switch in the Storage
Area Network (SAN) that you want to manage.

Out-of-band fabric agents are necessary for Virtual storage area network (VSAN)
information for Cisco switches. For Brocade fabrics, if no SMI-S agent is
configured, Out-of-band fabric agents are necessary for Zoning information for
Brocade switches.

IBM Tivoli Storage Productivity Center only supports SNMP V1.

See the Planning > Planning for Fabric Manager > Configuring Cisco switches topic
in the Installation and Configuration Guide for more information about using
Out-of-band fabric agents and Cisco switches.

Tivoli Storage Productivity Center Monitoring Agent
The IBM Tivoli Storage Productivity Center Monitoring Agent can be used by the
IBM Tivoli Enterprise Monitoring Server to monitor systems in your enterprise.
This agent is an optional program you can install and use in your enterprise.
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IBM Tivoli Monitoring monitors and manages system and network applications on
a variety of operating systems, tracks the availability and performance of your
enterprise system, and provides reports to track trends and troubleshoot problems.
The Tivoli Storage Productivity Center Monitoring Agent participates in that
environment.

For performance reasons, install the Tivoli Storage Productivity Center server on a
separate system from the IBM Tivoli Monitoring server. You can install the Tivoli
Storage Productivity Center Monitoring agent on any system you want to monitor.

Before using the Tivoli Storage Productivity Center Monitoring Agent, you must
have IBM Tivoli Enterprise Monitoring Server installed. For information about the
IBM Tivoli Enterprise Monitoring Server, see http://publib.boulder.ibm.com/
infocenter/tivihelp/v15r1/index.jsp?topic=/com.ibm.itm.doc_6.2.1/welcome.htm.

For information about installing IBM Tivoli Monitoring, see the Quick Start Guide
at http://publib.boulder.ibm.com/infocenter/tivihelp/v15r1/index.jsp?topic=/
com.ibm.itm.doc/GI11-8058-00.htm.

To use the Tivoli Storage Productivity Center Monitoring Agent, install this agent
on the system you want to monitor.

To see the type of reports displayed by the Tivoli Storage Productivity Center
Monitoring Agent, see “Tivoli Storage Productivity Center Monitoring Agent
reports” on page 1137.

Security
The IBM Tivoli Storage Productivity Center environment supports role-based
security. Tivoli Storage Productivity Center also has several applications that use
certificates to ensure server to server security.

For role-based authorization, user groups contained in the authentication
repository, which is either the local operating system or an LDAP-compliant
directory depending on the choice of authentication mechanism made during the
Tivoli Storage Productivity Center installation, are associated with predefined roles.
When a user ID is authenticated to Tivoli Storage Productivity Center through the
GUI, CLI, or APIs, membership in a user group determines the authorization level.

If you are using a previous version of Tivoli Storage Productivity Center (before
v4.2) or are still using Data agents in v4.2, Agent Manager includes demonstration
certificates that you use for a test environment, but you can also create new
generated certificates during the installation of the Agent Manager. These
generated certificates are used when the Tivoli Storage Productivity Center server
or agent registers with the Agent Manager.

Role-based authorization
Operating system groups or LDAP groups (for example, groups contained in your
LDAP-compliant repository) are associated with predefined roles. When a user ID
is authenticated to Tivoli Storage Productivity Center through the GUI, CLI, or
APIs, membership in an operating system or LDAP group determines the
authorization level of the user.

Table 25 on page 125 shows the association between roles and authorization level.

If you select OS authentication for your Tivoli Storage Productivity Center
installation, then you do not have to create any of the groups before installation.
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The Tivoli Storage Productivity Center superuser role automatically gets mapped
to the Administrators group on the Windows operating system, to the system
group on the AIX operating system, or to the root group on the Linux operating
system.

Table 25. Roles and authorization levels

Role Authorization level

Superuser Has full access to all Tivoli Storage Productivity Center
functions.

Productivity Center administrator Has full access to operations in the Administration
section of the GUI.

Disk administrator Has full access to Tivoli Storage Productivity Center
disk functions.

Disk operator Has access to reports only for Tivoli Storage
Productivity Center disk functions. These reports
include information about tape devices.

Fabric administrator Has full access to Tivoli Storage Productivity Center
Fabric Manager functions.

Fabric operator Has access to reports only for Tivoli Storage
Productivity Center Fabric Manager functions.

Data administrator Has full access to Tivoli Storage Productivity Center
Data Manager functions.

Data operator Has access to reports only Tivoli Storage Productivity
Center Data Manager functions.

Tape administrator Has full access to Tivoli Storage Productivity Center
tape functions.

Tape operator Has access to reports only for tape functions.

Notes:

1. If a user has multiple roles, the authorization level is a combination of the
levels for each of the roles.

2. If a user is not a member of any of the roles listed, no access is granted to that
user.

3. For enterprise-rollup reports, you need superuser or Tivoli Storage Productivity
Center administrator authority to do the following actions:
v Add, remove, or modify the Tivoli Storage Productivity Center subordinate

server that the master server is monitoring.
v Create or run probe jobs that include Tivoli Storage Productivity Center

subordinate servers.

Any Tivoli Storage Productivity Center user can generate enterprise-rollup
reports.

4. You need to assign the appropriate Tivoli Integrated Portal roles to other Tivoli
Storage Productivity Center users and groups who are added later to the
system.

Agent Manager certificates
Agent Manager provides a demonstration certificate to facilitate the rapid
deployment of a test environment or demonstration environment.

The demonstration certificate and its password are publicly available. Anyone who
has a demonstration certificate can participate in your deployment. Using the
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demonstration certificate does not provide the level of security required by a
typical production environment. In a production environment, let the Agent
Manager installation program generate a certificate that is unique to Agent
Manager installation. When you install Agent Manager, you can specify to use the
demonstration certificates or create a new certificate on the Specify Certificates page.

Note: You cannot install Agent Manager in Tivoli Storage Productivity Center v4.2
or later. If you want to install Agent Manager, you must use a previous version of
the product.

SAN Volume Controller topics
This section contains information about the following SAN Volume Controller
topics: managed disks (MDisks), managed-disk states, managed-disk groups, and
virtual disks (VDisks).

IBM Tivoli Storage Productivity Center SAN Volume Controller
The IBM Tivoli Storage Productivity Center SAN Volume Controller is a SAN
appliance that attaches open-systems storage devices to supported open-systems
hosts.

The SAN Volume Controller provides symmetric virtualization by creating a pool
of managed disks from the attached storage subsystems, which are then mapped to
a set of virtual disks for use by attached host computer systems. System
administrators can view and access a common pool of storage on the SAN, which
enables them to use storage resources more efficiently and provides a common
base for advanced functions. The SAN Volume Controller performs the following
functions for the SAN storage that it controls:
v Creates a single pool of storage
v Manages logical volumes
v Provides advanced functions for the SAN, such as large scalable cache, copy

services, and space management

A node is a single storage engine. The storage engines are always installed in pairs
with one or as many as four pairs of nodes constituting a cluster. Each node in a
pair is configured to back up the other.

Each pair of nodes is known as an I/O group. All I/O operations are cached on
both nodes for resilience. To eliminate any single point of failure, each of the two
nodes are protected by different uninterruptible power supplies. A node can be in
only one I/O group.

126 IBM Tivoli Storage Productivity Center: User's Guide



The SAN Volume Controller I/O groups see the storage presented to the SAN by
the back-end controllers as a number of disks, known as managed disks. The
application services do not see these managed disks. Instead, they see a number of
logical disks, known as virtual disks, that are presented to the SAN by the SAN
Volume Controller. Each node must only be in one I/O group and provides access
to the virtual disks in the I/O group.

The fabric contains two distinct zones: a host zone and a disk zone. In the host
zone, the host systems can identify and address the nodes. You can have more
than one host zone. Generally, you create one host zone per operating system type.
In the disk zone, the nodes can identify the disk drives (storage subsystems). Host
systems cannot operate on the disk drives directly; all data transfer occurs through
the nodes. As shown in Figure 6 on page 128, several host systems can be
connected to a SAN fabric. A cluster of SAN Volume Controllers is connected to
the same fabric and presents virtual disks to the host systems. You configure these
virtual disks using the disks located on the RAID controllers.

Figure 5. A SAN Volume Controller node
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Managed disks
A managed disk (MDisk) is a logical disk that a SAN Volume Controller has
exported to the SAN fabric to which the nodes in the cluster are attached.

A managed disk might consist of multiple physical disks that are presented to the
SAN as a single logical disk. A managed disk always provides usable blocks of
physical storage to the cluster, even if it does not have a one-to-one
correspondence with a physical disk.

Figure 7 shows physical disks and managed disks.

Extents

Each MDisk is divided into chunks of equal size called extents. Extents are
numbered sequentially (beginning at 0) from the start to the end of the managed
disk. Extents are a unit of mapping the data between MDisks and virtual disks
(VDisks).

Figure 6. Example of a SAN Volume Controller in a fabric

Figure 7. Physical disks and managed disks (MDisks)
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The extent size is a property of managed-disk groups (MDisk groups). When a
managed disk is added to a managed-disk group, the size of the extents that the
MDisk will be broken into depends on the attribute of the managed-disk group to
which it has been added.

Access modes

The access mode determines how the SAN Volume Controller cluster uses the
MDisk. The possible modes are the following:

Unmanaged
The MDisk is not used by the cluster.

Managed
The MDisk is assigned to an MDisk group and provides extents that
virtual disks (VDisks) can use.

Image The MDisk is assigned directly to a VDisk with a one-to-one mapping of
extents between the MDisk and the VDisk.

Managed disk states
This topic describes the operational states of managed disks (MDisks).

Managed disks can be in the following states:

Online
The MDisk can be accessed by all online nodes. That is, all the nodes that
are currently working members of the cluster can access this MDisk. The
MDisk is online when the following conditions are met:
v All timeout error recovery procedures complete and report the disk as

online.
v Volume inventory of the target ports correctly reported the MDisk.
v Discovery of this volume completed successfully.
v All of the managed disk target ports report this volume as available with

no fault conditions.

Degraded
The MDisk cannot be accessed by all the online nodes. That is, one or more
(but not all) of the nodes that are currently working members of the cluster
cannot access this MDisk. The MDisk might be partially excluded; that is,
some of the paths to the MDisk (but not all) have been excluded.

Excluded
The MDisk has been excluded from use by the cluster after repeated access
errors.

Offline
The MDisk cannot be accessed by any of the online nodes. That is, all of
the nodes that are currently working members of the cluster cannot access
this MDisk. This state can be caused by a failure in the SAN, the storage
subsystem, or one or more physical disks connected to the storage
subsystem. The MDisk will only be reported as offline if all paths to the
disk fail.
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Attention: If your fabric is undergoing transient link breaks or you have been
replacing cables or connections in your fabric, you might see one or more MDisks
change to the degraded status. If an I/O operation was attempted during the link
breaks and the same I/O failed several times, the MDisk will be partially excluded
and change to a status of degraded. You must include the MDisk to resolve the
problem.

Managed disk path Each managed disk will have an online path count, which is
the number of nodes that have access to that managed disk; this represents a
summary of the I/O path status between the cluster nodes and the particular
storage device. The maximum path count is the maximum number of paths that
have been detected by the cluster at any point in the past. Thus if the current path
count is not equal to the maximum path count then the particular managed disk
may be degraded. That is, one or more nodes may not see the managed disk on
the fabric.

Managed disk groups
A SAN Volume Controller MDisk group is a collection of MDisks that jointly
contain all the data for a specified set of virtual disks (VDisks).

All MDisks in a group are split into extents of the same size. VDisks are created
from the extents that are available in the group. You can add MDisks to an MDisk
group at any time in order to increase the number of extents that are available for
new VDisks or to expand existing VDisks. You can add only MDisks that are in
unmanaged mode. When MDisks are added to a group, their mode changes from
unmanaged to managed.

Figure 8 shows an MDisk group containing four MDisks.

You can delete MDisks from a group under the following conditions:
v VDisks are not using any of the extents that are on the MDisk.
v Enough free extents are available elsewhere in the group to move any extents

that are in use from this MDisk.

Attention: If you delete an MDisk group, you destroy all the VDisks that are
made from the extents that are in the group. If the group is deleted, you cannot
recover the mapping that existed between extents that are in the group and the
extents that VDisks use. The MDisks that were in the group are returned to
unmanaged mode and can be added to other groups. Because the deletion of a
group can cause a loss of data, you must force the deletion if VDisks are associated
with it.

Table 26 on page 131 describes the operational states of an MDisk group.

Figure 8. MDisk group
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Table 26. Managed disk group states

Status Description

Online The MDisk group is online and available.
All the MDisks in the group are available.

Degraded The MDisk group is available; however, one
or more nodes cannot access all the MDisks
in the group.

Offline The MDisk group is offline and unavailable.
No nodes in the cluster can access the
MDisks. The most likely cause is that one or
more MDisks are offline or excluded.

Attention: If a single MDisk in an MDisk group is offline and therefore cannot be
seen by any of the online nodes in the cluster, then the MDisk group of which this
MDisk is a member goes offline. This causes all the VDisks that are being
presented by this MDisk group to go offline. Care should be taken when creating
MDisk groups to ensure an optimal configuration.

Consider the following guidelines when you create MDisk groups:
v If you are creating image-mode VDisks, do not put all of these VDisks into one

MDisk group because a single MDisk failure results in all of these VDisks going
offline. Allocate your image-mode VDisks between your MDisk groups.

v Ensure that all MDisks that are allocated to a single MDisk group are the same
RAID type. This ensures that a single failure of a physical disk in the storage
subsystem does not take the entire group offline. For example, if you have three
RAID-5 arrays in one group and add a non-RAID disk to this group, then you
lose access to all the data striped across the group if the non-RAID disk fails.
Similarly, for performance reasons you should not mix RAID types. The
performance of all VDisks will be reduced to the lowest performer in the group.

v If you intend to keep the virtual disk allocation within the storage exported by a
storage subsystem, ensure that the MDisk group that corresponds with a single
subsystem is presented by that subsystem. This also enables nondisruptive
migration of data from one subsystem to another subsystem and simplifies the
decommissioning process if you want to decommission a controller at a later
time.

Extents

To track the space that is available, the SAN Volume Controller divides each
MDisk in an MDisk group into chunks of equal size. These chunks are called
extents, and are indexed internally. Extent sizes can be 16, 32, 64, 128, 256, or 512
MB.

You must specify the extent size when you create a new MDisk group. You cannot
change the extent size later; it must remain constant throughout the lifetime of the
MDisk group. MDisk groups can have different extent sizes. However, different
extent sizes can place restrictions on the use of data migration. The choice of extent
size affects the total amount of storage that can be managed by a cluster. Table 27
on page 132 shows the maximum amount of storage that can be managed by a
cluster for each extent size. Because the SAN Volume Controller allocates a whole
number of extents to each virtual disk that is created, using a larger extent size can
increase the amount of wasted storage at the end of each virtual disk. Larger
extent sizes also reduce the ability of the SAN Volume Controller to distribute
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sequential I/O workloads across many managed disks. Therefore, larger extent
sizes might reduce the performance benefits of virtualization.

Table 27. Capacities of the cluster given extent size

Extent size Maximum storage capacity of cluster

16 MB 64 TB

32 MB 128 TB

64 MB 256 TB

128 MB 512 TB

256 MB 1 PB

512 MB 2 PB

Virtual disks
An SAN Volume Controller VDisk is a logical disk that the cluster presents to the
storage area network (SAN).

Application servers on the SAN access VDisks, not managed disks (MDisks).
VDisks are created from a set of extents in an MDisk group. There are three types
of VDisks: striped, sequential, and image.

Types

You can create the following types of VDisks:

Striped
The striping is at extent level. One extent is allocated, in turn, from each
managed disk that is in the group. For example, a managed disk group
that has 10 MDisks takes one extent from each managed disk. The 11th
extent is taken from the first managed disk, and so on. This procedure,
known as a round-robin, is similar to RAID-0 striping.

You can also supply a list of MDisks to use as the stripe set. This list can
contain two or more MDisks from the managed disk group. The
round-robin procedure is used across the specified stripe set.

Attention: Care should be taken when specifying a stripe set if your
MDisk group contains MDisks of unequal size. By default striped VDisks
are striped across all MDisks in the group. If some of the MDisks are
smaller than others, the extents on the smaller MDisks will be used up
before the larger MDisks run out of extents. Manually specifying the stripe
set in this case might result in the VDisk not being created.

Figure 9 on page 133 shows an example of a managed disk group
containing three MDisks. This figure also shows a striped virtual disk
created from the extents available in the group.
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Sequential
When selected, extents are allocated sequentially on one managed disk to
create the virtual disk if enough consecutive free extents are available on
the chosen managed disk.

Image Image-mode VDisks are special VDisks that have a direct relationship with
one managed disk. If you have a managed disk that contains data that you
want to merge into the cluster, you can create an image-mode virtual disk.
When you create an image-mode virtual disk, a direct mapping is made
between extents that are on the managed disk and extents that are on the
virtual disk. The managed disk is not virtualized. In other words, the
logical block address (LBA) x on the managed disk is the same as LBA x
on the virtual disk.

When you create an image-mode VDisk, you must assign it to a managed
disk group. An image-mode VDisk must be at least one extent in size. In
other words, the minimum size of an image-mode VDisk is the extent size
of the MDisk group to which it is assigned.

The extents are managed in the same way as other VDisks. When the
extents have been created, you can move the data onto other MDisks that
are in the group without losing access to the data. After you move one or
more extents, the virtual disk becomes a real virtualized disk, and the
mode of the managed disk changes from image to managed.

Attention: If you add an MDisk to an MDisk group as a managed disk,
any data on the MDisk will be lost. Ensure that you create image-mode
VDisks from the MDisks that contain data before you start adding any
MDisks to groups.

MDisks that contain existing data have an initial mode of unmanaged, and
the cluster cannot determine whether it contains partitions or data.

A virtual disk can have one of three states. The following list describes the
different states of a virtual disk:

Online
The virtual disk is online and available if both nodes in the I/O group can
access the virtual disk. A single node will only be able to access a VDisk if
it can access all the MDisks in the MDisk group associated with the VDisk.

Offline
The VDisk is offline and unavailable if both nodes in the I/O group are
missing or none of the nodes in the I/O group that are present can access
the VDisk.

Figure 9. Managed disk groups and VDisks
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Degraded
The status of the virtual disk is degraded if one node in the I/O group is
online and the other node is either missing or cannot access the virtual
disk.

If you delete a virtual disk, you destroy access to the data that is on the virtual
disk. The extents that were used in the virtual disk are returned to the pool of free
extents that is in the managed disk group. The deletion might fail if the virtual
disk is still mapped to hosts. The deletion might also fail if the virtual disk is still
part of a FlashCopy or a Metro Mirror mapping. If the deletion fails, you can
specify the force-delete flag to delete both the virtual disk and the associated
mappings to hosts. Forcing the deletion will also delete the copy services
relationship and mappings.
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Chapter 3. Scenarios

This section contains scenarios which illustrate how to perform specific tasks using
IBM Tivoli Storage Productivity Center.

The provided scenarios set out situations that can be solved using Tivoli Storage
Productivity Center. When using these scenarios you should remember the
following:
v The scenarios are intended to be step-by-step instructions that you follow to

complete a specific job. Each scenario contains multiple tasks that must be
followed in the order given.

v Specific values are given in the scenarios, such as user name, IP Address, probe
name, and so forth. These are for illustration purposes only and you must
replace them with values appropriate for your system.

v The scenarios do not provide in-depth conceptual information about the tasks.
See the appropriate topics in the IBM Tivoli Storage Productivity Center
Information Center for more information about the concepts behind the tasks.

v You will complete a scenario successfully if you follow the instructions correctly
and your system performs as expected.

Monitoring and reporting on I/O utilization
This scenario involves monitoring a DS8000 and a DS4000 to determine what data
can be moved to the less expensive storage media. Monitoring over time collects
the necessary information for analysis. Trending reports, produced with IBM Tivoli
Storage Productivity Center Reporter, display utilization information and can be
used by management to make decisions about future storage needs.

You have a DS8000 and a DS4000. The DS8000 is nearly full but the DS4000 is only
half full. You need to move workload onto the DS4000 as the demand for the
DS8000 grows. You will monitor the utilization of volumes on each system to
identify potential migration candidates. You will also gather this information over
time to indicate trends. This trending information, in report format, will be used
for future planning and will be presented to management who will make decisions
based on the report.

To perform this scenario, complete the following steps:

Perform performance monitoring

1. Configure the storage systems for monitoring by Tivoli Storage Productivity
Center This process is in two parts as Tivoli Storage Productivity Center uses
native interfaces to connect to DS8000 storage systems while the DS4000 must
be connected using a CIM object manager (CIMOM) connection. Use the
Configure Devices wizard to configure the DS8000 system. For the DS4000
system, you can configure it manually by running a first discovery to locate the
CIMOMs that are visible to the Device server with SLP. After configuring the
CIMOM login information, run a second discovery to gather information about
the DS4000 system. Run a CIMOM discovery every four hours. See “Discover
storage subsystem, tape library, and fabric information with CIM agents” on
page 333 for more information. Alternatively, you can configure the DS4000
system by using the Configure Devices wizard.
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Configure the DS8000 system

a. Use the Configure Devices wizard to enter connection information for the
native interface of the DS8000 system. See “Configuring storage
subsystems” on page 308for details of how to use the Configure Devices
wizard. You can use the wizard to include the DS8000 system automatically
in a probe. If you want to monitor SAN Volume Controller systems or the
XIV systems, you can also use the Configure Devices wizard to enter
connection information for their native interfaces.

Configure the DS4000 system manually

a. Expand Administrative Services > Data Sources > CIMOM Agents .
b. For each CIMOM you use, click the magnifying glass to open the View and

Edit window. Enter the name and password information. Check the Test
CIMOM connectivity before editing.

c. Click the Save icon. This action saves your information and performs a
connectivity check. You must use this process for each SLP-discovered
CIMOM you choose to use.

d. Expand Administrative Services > Discovery, right-click on CIMOM, and
click Run Now.

e. In the CIMOM Discovery job submitted window, click OK.
f. When the job has finished, you can view the list of discovered storage

systems by expanding Disk Manager > Storage Subsystems.
Configure the DS4000 system using the Configure Devices wizard

a. Use the Configure Devices wizard to enter connection information for the
native interface of the DS8000 system. See “Configuring storage
subsystems” on page 308for details of how to use the Configure Devices
wizard.

2. Create a probe Create the probe to run during off-hours.
a. Expand Tivoli Storage Productivity Center > Monitoring > Probes.

Right-click Probes and select Create Probe.
b. In the What to Probe tab, move the DS6000 and the DS4000 from the

Available list box to the Current Selections box.
c. In the When to run tab you will schedule when you want the probe to run.

We strongly recommend that you run probes when nothing else is running.
1) Choose to run the job repeatedly according to a schedule you specify.
2) Select the current day, month, and year as the date when you want data

collection to begin. Select 1:00 AM as the time the job should begin
running.

3) Select the days the job should run. Select all of them. A check mark will
appear next to each day you have chosen.

d. In the Alerts tab accept the default (error log) as the means of notification if
the job fails.

e. Click Save. The probe will run daily at 1:00 AM.
3. Create a storage-system performance monitor Create a storage-system

performance monitor to gather performance data and view the results in the
log file.
a. Expand Disk Manager > Monitoring, right-click Subsystem Performance

Monitor and select Create Performance Monitor.
b. In the Create Storage Subsystem Performance Monitor window, click the

Storage Subsystems tab. Select the DS8000 and DS4000 you want to report
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on and move them to the Current Selections field. Make sure these storage
systems have been probed. If they have not been, data collection will fail.

c. Click the Sampling and Scheduling tab. In the Sampling area, specify the
length of the sampling window and how frequently the performance data is
to be gathered, using the following values:
v Interval length = 5 minutes
v Duration = Indefinite
v Scheduling = Begin immediately

d. In the Alert tab, Monitor Failed is the only triggering condition. In the
Triggered Actions area accept the default (error log) means of notification.

e. Click Save. When prompted, type a name for the threshold and click OK.
The name of the storage system performance monitor is displayed under
the Subsystem Performance Monitors node. The performance monitor will
take 3 hours to run, as set in step c. The status icon will indicate when the
job has completed successfully.

f. When the job has completed, a table is displayed listing the storage systems.
To view the log file for each storage system, select the magnifying glass.

4. Tivoli Storage Productivity Center Reporter for Disk

This scenario uses Tivoli Storage Productivity Center Reporter for Disk to
prepare a finished report automatically. Tivoli Storage Productivity Center
Reporter is a free Java 2 Platform application that extracts storage system
information and hourly performance statistics. The statistics are transcribed into
a paper-style PDF file containing your storage server utilization, which is saved
on the local machine.
If you do not have Tivoli Storage Productivity Center Reporter for Disk,
complete the following steps. If you have installed Tivoli Storage Productivity
Center Reporter for Disk, go to step 5.
a. Go to the Tivoli Storage Productivity Center Reporter for Disk web page,

http://www-03.ibm.com/support/techdocs/atsmastr.nsf/WebIndex/
PRS2618.

b. Select Download Tivoli Storage Productivity Center Reporter for Disk for
Windows (60MB)

c. Follow steps to download Tivoli Storage Productivity Center Reporter.
d. Run the Installer

5. Create your report with Tivoli Storage Productivity Center Reporter

a. To start the program go to Start > Programs > Tivoli Storage Productivity
Center Reporter for Disk > Tivoli Storage Productivity Center Reporter
for Disk. Select Start. The Confirmation window will open.

b. Enter the Hostname (or IP address), Port, UserID, and Password of the
system that you want the report on. Click Continue. The Select Serial
Number window will open. Tivoli Storage Productivity Center Reporter for
Disk saves a list of the commands and the status of the commands you are
using in the GUI. The commands and status of the commands are displayed
in the Status window.

c. If the probe of the selected systems was successful, the DS8000 and DS4000
storage systems will be listed in the Select Serial Number window. Select
the DS8000 storage system. Click Select. You can only create a report for
one storage system at a time.

d. The Select Date Range window opens. Select the Last 7 days radio button.
Click Select,
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e. The Customer Information window opens. This information will be
included in the title information of the finished report. The first text field,
Company, is required. This is the company name that will appear on the
title page of the report. All other fields are optional. When finished, click
Continue.

f. The IBM/Partner Information window opens. All fields are optional. Click
Continue.

g. Select a file name and directory in which to save the generated report. The
default directory is "My Documents" and the default file name is
TPCReport.pdf. It is strongly recommended that you save the PDF file
under a different name. Click Save.

h. The steps Tivoli Storage Productivity Center Reporter takes to create the
report are shown in the status window. Once the report has been generated,
the Exit button becomes available. Click Exit.

i. Go to "My Documents", find and double-click the PDF report.
The report includes the following information for storage systems, ports,
arrays, and volumes:
v General information
v Performance summary
v Statistics
v Definitions

6. Using the DS8000 report, look at the Volume Performance Summary for
volumes with low levels of I/O and throughput in Megabytes. These might be
candidates for moving to the DS4000.

Printing

The report will have been saved as a PDF file using the latest Acrobat Reader on
your system. If you only have the Reader of that version of Acrobat, you will be
able to view the report, but you will be unable to print it. In this case take the
following steps to print the report:
1. Open your complete version of Adobe Acrobat.
2. Select File > Open and navigate to the report.
3. Select File > Print to print the report.
4. Close the report. You will not be able to save the report as an earlier version of

an Acrobat PDF file.

The following documents were referenced for this scenario:
v IBM Tivoli Storage Productivity Center User's Guide GC32-1775
v Tivoli Storage Productivity Center Reporter for Disk Version 1.01 - Process and Report

Overview

Storage provisioning by using workflows
IBM Tivoli Storage Productivity Center and Tivoli Provisioning Manager Workflow
automation can reduce provisioning time from hours to minutes and significantly
simplify the task of provisioning new storage capacity. This automation is
especially valuable when adding storage provisioning to existing automated server
provisioning tasks, such as deploying operating systems, software, and network
resources. This scenario shows you how to use Tivoli Provisioning Manager and
Tivoli Storage Productivity Center Workflows to automate provisioning of SAN
attached storage capacity to a server in a Microsoft Windows environment.
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Tivoli Storage Productivity Center and Tivoli Provisioning Manager work together
to provide automated storage provisioning for the data center.

Tivoli Provisioning Manager provides the means to automate common tasks in the
data center that surround each of the four major pillars of provisioning:
v OS provisioning (Windows, Linux, AIX, Solaris, HP-UX, and so on)
v Software provisioning (DB2, WebSphere, Oracle, and many more)
v Network provisioning (provisioning VLANs, ACLs, IP addresses, activating, and

deactivating switch ports, and so on)
v Storage provisioning (attaching SAN disks for use by the server)

Tivoli Provisioning Manager Workflows automate tasks, especially the tasks that
are complex, repetitive, and prone to error by applying best practices for zoning,
device configuration, and path selection automatically.

Tivoli Storage Productivity Center provides heterogeneous management functions
for the SAN storage environment. Tivoli Storage Productivity Center Workflows
provide status information about its SAN storage environment to Tivoli
Provisioning Manager. They also allow Tivoli Provisioning Manager to modify the
SAN through Tivoli Storage Productivity Center.

The following illustration shows the movement of workflow information between
Tivoli Provisioning Manager and Tivoli Storage Productivity Center.

Restriction: You must ensure that each Tivoli Provisioning Manager manages only
one Tivoli Storage Productivity Center server. If multiple Tivoli Storage
Productivity Center servers are managed, and you run a probe on the second
server, information on the first server is deleted.

Figure 10. High-level architecture
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End-to-end provisioning of SAN storage is difficult due to the complexity of
modern environments and inputs that must be considered. This scenario creates a
Tivoli Provisioning Manager storage template used for end-to-end storage
provisioning that can automate the process. After the storage template is created, it
can be reused to automate end-to-end provisioning of SAN storage with a few
mouse clicks.

Without workflows, you would need to complete the following individual steps in
Tivoli Storage Productivity Center to provision storage:
v Add a volume (storage subsystem)

– Select storage subsystem
– Select or create new volume
– Select host HBA ports (WWNs)
– Select subsystem controller ports (WWNs)
– Map volume to controller ports
– Map volume to host HBA ports

v Set paths (SAN fabric switches)
– Determine whether multiple paths are required
– Create or update zones
– Get active zone set
– Add zone to zone set
– Activate zone set

v Map the HBA Volumes to the operating system and file system (Host server)
– Rediscover attached volumes
– Configure multipathing drivers
– Map volumes to OS devices

v Create volume and file system (Host server)
– Create Windows volume
– Create or extend NTFS file system

With workflows, after the template is created, these tasks are automated and
condensed to the following tasks:
v Select the host that needs additional storage

– Select the template name from the template list
– Click OK.

To use workflows, the following prerequisites must be met:
v Tivoli Provisioning Manager v5.1 is installed and configured.
v Tivoli Storage Productivity Center v4.1 or later is installed and configured.
v The following two automation packages is downloaded, installed, and

configured from the Open Process Automation Library (OPAL):
– IBMTPC.tcdriver
– WindowsNTFS.tcdriver

For more information about the prerequisites needed to use workflows, see the
IBM white paper,Tivoli Provisioning Manager and IBM Tivoli Storage Productivity
Center-Storage Provisioning Configuration and Exercises.

To create and use a storage template, complete the following steps:
1. To create the Tivoli Provisioning Manager workflow template, complete the

following steps:
a. Select Inventory > Manage Templates > Storage Templates from the Tivoli

Provisioning Manager navigation tree.
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b. Select Edit and click Add Storage Template. The Create Storage Template
window opens.

c. Enter NTFS_SVC as the name for the storage template. Click Next.
d. Define the volume container settings. In the Configure Volume Container

Settings window, enter the following information:
v Type NTFS for the Volume Container Name.
v Select NTFS as the Storage Manager.
v Click Add Volume Container Settings.
v Click Next.

e. Define the physical volume settings
v Scroll down to the SAN Physical Volume Settings and specify a SAN

volume.
v Type SAN in the Name field.
v In the Volume Container Settings field, select NTFS.
v Select mdiskgrp0 as the appropriate storage pool from Storage

Pool/Storage Subsystem.
v Type 5G as the value for Consumable Size.
v Set the Function Type to Generic.
v For the RAID Level, select UNKNOWN.
v Click Add SAN Setting and click Next.

f. Define the data path settings:
v In the Configure Data Path Settings window, select SAN from the SAN

Physical Volume Setting list box.
v Click Add Data Path Settings and click Next.

g. Define the logical volume settings:
v In the Configure Logical Volume Settings window, type TPMVolume in

the Name field.
v Select Simple as the Logical Volume Type.
v Select NTFS for the Volume Container Settings.
v Specify 5G for Consumable Size.
v Set the Function Type to Generic.
v Set the RAID Level to UNKNOWN.
v Click Add Logical Volume Settings and click Next.

h. Define file system settings:
v In the Configure File System Settings window, select TPMVolume from

the Logical Volume Settings list.
v Type H: as the Label.
v For the File System Type, select NTFS from the list.
v Specify 5G for File System Size.
v Click Add File System Settings and click Next.

i. File system mount settings are not used. In the Configure Filesystem Mount
Settings window, click Next.

j. Define disk partition settings:
v In the Configure Disk Partition Settings window, set the Partition Size to

5G.
v From the Physical Volume Settings list, select SAN

v From the Logical Volume Settings list, select TPMVolume.
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v Click Add Disk Partition Settings and click Next.
k. Verify the summary information. When you are done, click Finish.
l. Verify that the NTFS_SVC template is displayed in the Tivoli Provisioning

Manager GUI at Inventory > Manage Templates > Storage Templates.

This template allows any system administrator to complete end to end
provisioning.

2. To provision, complete the following steps
a. From the General tab of a Windows computer in Tivoli Provisioning

Manager, click Edit and select Add Storage to Host.
b. Select NTFS_SVC from the Storage Template list
c. Click OK.
d. Navigate to Automation > Workflow Status and track the status of the

deployment request in the workflow status log until it completes
successfully. It takes approximately 10 - 15 minutes to complete.

A new 5G volume is created on the SAN Volume Controller storage pool
mdiskgrp0. This storage pool is assigned to your windows host and mounted
and formatted as the drive letter H within a few minutes with consistent results
and no user errors.

For more information about workflows, see the following publications:
v IBM Tivoli Storage Productivity Center Workflow User's Guide

v Redpapers:
– Automated Storage Provisioning for Windows by using Tivoli Storage Productivity

Center and Tivoli Provisioning Manager

– An Introduction to Storage Provisioning with Tivoli Provisioning Manager and
Tivoli Storage Productivity Center

v White paper: Tivoli Provisioning Manager and Tivoli Storage Productivity Center -
Storage Provisioning Configuration and Exercises

Archive and delete files
This scenario shows you how to reclaim storage space by archiving and deleting
files that meet criteria you define.

You are running out of available storage capacity and need to find stale data which
can be archived and deleted in order to reclaim space and make it available to
more pertinent data. Specifically, you are TPCUser and you want to find files on
the C:\ file system of computer1 that are larger than 5MB, and have not been
accessed in 365 days.

Steps include the following tasks:
v Running a probe (if needed)
v Defining the constraint
v Running a scan
v Generating a constraint violation report
v Running an archive/backup on selected files in the report

Before you can use the IBM Tivoli Storage Manager archive or backup functionality
you must ensure the prerequisites listed in “Requesting an archive or backup” on
page 476 have been met.
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To create an archive job, complete the following steps:
1. Run a Probe

You may not need to complete this step if a successful probe has been recently
completed. Check the most recent day and time a probe was run successfully at
IBM Tivoli Storage Productivity Center > Monitoring > Probes. To do this,
expand the probe name to see the date the last successful probe was run. In
most cases the default probe is sufficient.
If you do need to run a probe, complete the following steps:
a. Expand IBM Tivoli Storage Productivity Center > Monitoring > Probes,

and select Create Probe. The Create Probe window opens.
b. Enter a description for the probe.
c. In the What to Probe tab, select the resources you want to probe, in this

case Computer Groups > TPCUser.Default Computer Group > computer1.
d. In the When to Run tab, accept the defaults: Run Now and Local time in

each time zone.
e. In the Alerts tab, accept the default. If the probe fails, a notification will be

sent to the error log automatically.
f. Click Save to save the probe. Enter Archive Backup Probe as the probe

name and click OK. An entry for the probe appears under IBM Tivoli
Storage Productivity Center > Monitoring > Probes > TPCUser.Archive
Backup Probe.

g. The probe will begin running immediately. The number of times this job has
been run and the date and time will be listed under the probe name. To see
the status of the job, right-click on the probe name and select Update Job
Status.

2. Define Constraints

Define the criteria you are looking for with a constraint.
a. Expand Data Manager > Policy Management > Constraints, right-click and

select Create Constraint.
b. In the Description field, enter a description of this constraint.
c. In the Filesystems tab Available column, select Filesystems > computer1 >

C:\ and move it to Current Selections.
d. In the File Types tab, check Forbid files matching these patterns. All file

types should be in the Choose a file type column. This will apply the
constraint to all file types.

e. In the Users tab, Check the Forbid files owned by selected users. All users
should be listed in the Available Users column. This will apply the
constraint to all users.

f. In the Options tab, leave the default, 200, in the text box in the Violating
File Limits section. In the Alerts on Files section, select number of days
since last access greater than and type 365. Select bigger than and enter 5
MB. Below the Alerts on Files section, File Filter Text: will list the values
you picked in the File Types, Users, and Options tabs.

g. In the Alert tab under Triggering Conditions, the only triggering condition
is Violating files consume more than. Type 5 in the Value field. Select
Megabytes from the Value Units: pull-down. Accept the default in
Triggered Actions, which will send a message to the error log if the
constraints you have defined are violated.

h. Click the Save icon. Name the constraint Archive File Constraint. The
constraint will be saved as Data Manager > Policy Management >
Constraints > TPCUser.Archive File Constraint.
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3. Run a Scan

Scan with the constraint violation you have created.
a. Expand Data Manager > Monitoring, right-click Scans and select Create

Scan. The Create Scan window opens.
b. In the Filesystems tab, select Filesystems > computer1 > C:/ from the

Available column and move it to the Current Selections column.
c. Do not select anything in the Directory Groups tab.
d. In the Profiles tab, select all the profiles listed in the Available Profiles

column and move them to both Profiles to Apply to Filesystems and
Profiles to Apply to Directories.

e. In the When to Run tab, select Run Now and Local Time in each time
zone.

f. In the Alert tab, Scan Failed is the only Triggering Condition. In the
Triggered Actions area, select nothing to accept the default. If the job fails, a
message will be sent to the log file automatically.

g. Click the Save icon. Save the scan as Archive Scan. The scan is saved under
Data Manager > Monitoring > Scans > TPCUser.Archive Scan. The scan
starts to run immediately. Scans can take some time to complete depending
on the number of storage assets scanned and the profiles used.

4. Generate a Constraint Violation Report

Generate a report listing files that met your constraint violation criteria.
a. Expand Data Manager > Reporting > Usage Violations > Constraint

Violations and click By Constraint. The Constraint Violations: By
Constraint window opens to the Selection tab.

b. In the Report Filter Specifications area, type 100 in the Return maximum
of text field.

c. In the Report Filter Specifications area, click Selection. The Select
Resources pop-up opens listing the available constraints.

d. Select Archive File Constraint. (You may have to de-select the other
constraints.) Click OK.

e. Select the columns you want to appear in the report. By default, all columns
will be listed in Included Columns. If you want to remove columns from
the report, select them and move them to Available Columns.

f. Click Generate Report. The Constraint Violation Report is displayed on the
monitor.

g. The page will stay the same with the addition of a Constraints tab which
shows the Constraint Violations: By Constraint report. Click the
magnifying glass to drill down to the Constraint Violations: By Filesystem
report. Click the magnifying glass again and the Largest Files: By
Filesystem report opens. This report, the Constraint Violation Report, will
be used to create an Archive/Backup job.

5. Run Archive/Backup on selected files in the report

Archive and backup files are automatically sent to the Tivoli Storage Manager
server and are stored on that machine. Files are put into storage groups that are
controlled through a Tivoli Storage Manager policy that the Tivoli Storage
Manager server administrator usually creates.
a. Select the files in the Constraint Violation Report that you want to archive

or backup.
b. Right-click on the selected files and select Create a new archive\backup

job. The Create New Archive/Backup Job window opens.
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c. In the Options tab, choose Archive. In this scenario the purpose is to
archive and delete files that violate the constraints, so select Delete After
Successful Archival. If, for some reason, you did not want to delete the
files after they have been archived, do not select Delete After Successful
Archival. If the archive is not successful, the files will not be deleted.

d. The files you have selected for archive/backup are shown in the Files tab.
e. In the When to Run tab select Run Now. In the How to handle time zones

section, select Local time in each time zone.
f. In the Alert tab, in the Triggering-Condition area, the only triggering

condition is File Archive/Backup Failed. Do not select anything in the
Triggered Actions area to accept the default (a message sent to the error
log).

g. Click the Save icon. Enter the name Archive Log and click OK. The job log
is saved at Data Manager > Monitoring > Policy Management >
Archive/Backup > TPCUser.Archive Log.

h. A notice telling you that the job has been submitted appears. Click OK.
i. Expand the job name to see the status of this particular job. You can judge

the status by the color coding. When the job has finished, click on the date
and time to view the job log file.

Setting an archive/backup from the constraint

You can call archive backup when you set the constraint. However, if you set the
delete option, it will automatically archive and delete all files that match the
constraint criteria, which you probably do not want to do. At the very least you
should not set archive/backup in the constraint the first time you run it.

To call for an archive/backup within a constraint, select Archive/Backup in the
Triggered Actions area of the Alert tab in the Create Constraint window. Click
Define. An Archive/Backup Options pop-up opens. Select Delete After Successful
Archival. Go to the next tab and continue defining your constraint.
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Related concepts:
“Requesting an archive or backup” on page 476
Request anIBM Tivoli Storage Manager archive and backup of the largest violating
files identified by a constraint. Tivoli Storage Manager protects your data from
hardware failures and other errors by storing backup and archive copies of data on
auxiliary storage.
Related tasks:
“Creating probes” on page 338
Create and schedule a probe to job to gather information about your storage
resources. You can define any number of probes to gather information about
different storage resources at different times.
“Creating a file constraint” on page 470
Learn how to create a constraint that defines the acceptable and unacceptable file
types, file sizes, and file owners for a computer or a set of computers in your
environment.
“Defining an archive or backup in a constraint” on page 476
Learn how to request an IBM Tivoli Storage Manager archive and backup of the
largest violating files identified by a constraint. Request a Tivoli Storage Manager
archive and backup on the alert page of a constraint definition.
“Creating scans” on page 346
Create and schedule a scan to gather usage information about your storage
resources. You can specify which file systems, computers, clusters, directories,
databases, and other storage resources that you want to scan. You can define any
number of scans to gather information about different storage resources at different
times.

Create a profile with a filter
This scenario scans storage on a selected drive looking for the 100 largest media
files, and summarizes space used by filesystem or directory and by owner.

There are a number of media files on computer1 that you suspect are taking up
space that could be used for other purposes. You would like to search C:\ drive
file systems and directories for the 100 largest files and create a report you can use
to decide what action to take (contact the owner, archive and delete the files, and
so forth). You will also publish this report to the web, where other people with
permission levels greater to or equal to yours (TPCUser) can access it.

With this scenario, you perform the following tasks:
1. Create a profile to look for the largest media files
2. Create a filter within the profile
3. Create a new scan schedule using the profile
4. Create and run a batch report using the information gathered from the scan

schedule
5. Save this report as an HTML file

For this scenario, complete the following steps:
1. Create a new profile

a. Expand Data Manager > Monitoring, right-click Profiles and select Create
Profile.

b. The Create Profiles window opens. Enter a description for the profile.
c. In the Statistics tab, do the following:
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1) Under Summarize space usage by, select filesystem or directory and
owner.

2) Under Accumulate History, select Per Scan and type 10 as the number
of days to keep.

3) Under Gather statistics by length of time since, select creation.
4) Under Gather the information on the, select largest files and type 100

in the text field.
d. In the File Filters tab, create the filter by doing the following:

1) Highlight (All Files Selected) and click New Condition. The Create
Condition window opens.

2) Select NAME and Matches any of from the pull-down lists.
3) Select In any Directory.
4) In the match field, enter the types of files you are looking for in either a

comma-separated list or by pressing return after each entry. As you
press return, the file type will be listed in the box underneath the text
field. For this scenario the file types are *.avi, *.au, *.mpeg3, and *.gif.
Click OK. The Create Profile window re-opens, reflecting your choices.

e. Click the Save icon. Name the profile Media Files Profile and click OK.
The profile will be saved as Data Manager > Monitoring > Profiles >
TPCUser.Media Files Profile.

2. Create the scan

a. Expand Data Manager > Monitoring, right-click Scans and select Create
Scan.

b. The Create Scans window opens. Type a description of the scan.
c. In the Filesystems tab, select C:/ as the file system to scan.
d. Do not select anything in the Directory Groups tab.
e. In the Profiles tab, select TPCUser.Media Files Profile from Available

Profiles and move it to Profiles to apply to Filesystems.
f. In the When to run tab, choose Run Now and select Local time in each

time zone.
g. In the Alerts tab, the only Triggering Condition is Scan Fails. In the

Triggered Actions area, select nothing to accept the default. If the job fails,
a notification will be sent to the error log automatically.

h. Click the Save icon. Name the scan Media Files Scan and click OK. The
scan will be saved as Data Manager > Monitoring > Scans >
TPCUser.Media Files Scan and the job will begin running immediately.
This scan could take approximately 20 minutes to complete.

3. Create the batch schedule

Once you have run a scan with the new profile, the data is in the database but
you have to go get it with a custom-designed report or batch schedule.
a. Expand IBM Tivoli Storage Productivity Center > My Reports, right-click

Batch Reports and select Create Batch Report.
b. The Create Batch Report window opens. Enter a description for the report.
c. In the Available column in the Report tab, select Usage > Files > Largest

Files > by Computer and move that to Current Selections.
d. In the Selection tab, select TPCUser.Media Files Profile from the available

profiles. By default, all columns are included in Included Columns. If you
do not want a column in your report, select it and move it to Available
Columns.

e. In the Options tab, make the following selections:
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v Under Agent Computer Specification, select computer1. This is the
computer where the report will be run and the data stored. In most cases
this is the Agent running on the Tivoli Storage Productivity Center server.
If computer1 is a Data Agent computer, you must accept the default
report-destination path. If computer1 is a V4.2 Storage Resource Agent or
the Tivoli Storage Productivity Center server, you can accept the default
path or you can specify a different path in the Report destination field.
The default destination path varies depending on whether the computer
is a Storage Resource Agent or the server.

v Under Report Type Specification, select HTML File.
v Select nothing under Script.
v Under Output File Specification, enter the mask that will determine the

output file name. It is recommended that you name the report something
other than the default so that it can be easily identified by you and
others. {Report name}.{Report run date} is recommended.

f. In the When to run tab, choose Run Now and select Local time in each
time zone.

g. In the Alerts tab, the only Triggering Condition is Report Failed. In the
Triggered Actions area, select nothing to accept the default. If the job fails,
a notification will be sent to the error log automatically.

h. Click the Save icon. Name the batch report Largest Media Files and click
OK. The batch report criteria will be saved under IBM Tivoli Storage
Productivity Center > Reports > Batch Reports > TPCUser.Largest Media
Files. The job will begin running immediately. The job number, date, and
time will be listed under TPCUser.Largest Media Files.

4. Batch reports can be saved to any computer running Tivoli Storage Productivity
Center. Reports are saved to a default location for Data Agents. If the computer
is a V4.2 Storage Resource Agent or the Tivoli Storage Productivity Center
server, you can accept the default path or you can specify a different path when
you select batch report options.

Related tasks:
“Creating a profile” on page 356
Create a profile for use within a scan.
“Creating scans” on page 346
Create and schedule a scan to gather usage information about your storage
resources. You can specify which file systems, computers, clusters, directories,
databases, and other storage resources that you want to scan. You can define any
number of scans to gather information about different storage resources at different
times.
“Creating batch reports” on page 1062
Create a batch report.
“Selecting batch report options” on page 1063
Define the agent computer that you want to run the batch report on and specify
the format of the file to be saved.

Creating a performance threshold within an alert
You can monitor the performance of your enterprise by creating alerts with
performance thresholds for storage subsystems and SAN switches. By defining
alerts that are triggered by performance thresholds, you can get timely information
about performance issues in your enterprise.
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To properly monitor the performance of your storage subsystem you will need to
create the appropriate data collection jobs and alert definitions. The performance
monitors collect data from the devices they are monitoring and at each sample
interval the data is compared to the performance thresholds you have set. If the
thresholds are exceeded, a notification is generated and the actions you defined in
an alert are performed.

Note: The term Alert can be used one of three ways. An IBM Tivoli Storage
Productivity Center Alert definition is defined at [Data|Disk|Tape] Manager >
Alerting > [Type of Alert]. Within the Alert definition there is an Alert tab. Within
the Alert tab there is a Triggering Condition area which gives the condition that will
result in an Alert message. Most Triggering Condition areas in the Alert tab have
only one Triggering Condition, such as Probe Failed. However, in Disk Manager
some of the triggering conditions have thresholds, which are condition boundaries
you set. For example, Total I/O Rate Threshold requires two upper-threshold and
two lower-threshold boundaries or values. Only if these boundaries are matched or
exceeded will an Alert message be generated and sent by the method you chose in
Triggered Actions.

In this scenario, you are defining a performance threshold alert to monitor a disk
subsystem (DS8000-21-7-1300271-IBM), for the Total I/O Rate Threshold condition,
and generating, viewing, and printing the results.

To complete this scenario, you need to perform the following tasks:
1. Create a storage subsystem performance monitor
2. Create a storage subsystem alert definition
3. Generate and view a report showing the collected storage subsystem data

Note: You must run probes against storage subsystems prior to successful
performance monitoring of those subsystems.
1. Create a subsystem performance monitor

a. Expand Disk Manager > Monitoring, right-click Subsystem Performance
Monitor and select Create Subsystem Performance Monitor. The Create
Storage Subsystem Monitor page opens to the Storage Subsystem tab.

b. Select the disk you want to monitor from the Available subsystems column
and move it to the Selected subsystems column. Although we do not do it
here, you can select more than one subsystem at a time.

c. Click the Sampling and Scheduling tab. In the Sampling area, set the
interval for gathering data to 1 hour. Select Continuing gathering data for
and select a value of 1 month. In the Scheduling area, select Begin
immediately.

Note: You do not want to sample too frequently as it increases the size of
the database repository significantly. Monitors should be set to run for long
periods, such as weeks or indefinitely.

d. Click the Alert tab. Monitor Failed is the only Triggering Condition
available. In Triggered Actions, select nothing to accept the default. If the
job fails, a message will be sent to the log file automatically.

e. Click the Save icon. Name the monitor SS Monitor. It will be listed at Disk
Manager > Monitoring > Subsystem Performance Monitors > TPCUser.SS
Monitor. The job will begin running immediately.

2. Create a storage subsystem performance alert
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a. Expand Disk Manager > Alerting, right-click Storage Subsystem Alerts
and select Create Storage Subsystem Alert. The Create Storage Subsystem
Alert page opens.

b. Click the Alert tab. Select Total IO Rate Threshold from the Condition
drop down list in the Triggering-Condition area. Text fields will open for
Critical Stress, Warning Stress, Warning Idle, and Critical Idle.

Note: The threshold values given in this scenario are examples and are not
recommended values. They are for the purpose of illustration only. Your
values will undoubtedly be different. Performance behavior varies
tremendously between different devices and even different applications for
different devices. We recommend monitoring your performance for several
weeks and use this historical data to determine reasonable values for each
threshold.
v In the Critical Stress field, type 3000 as the upper-threshold boundary for

critical stress.
v In the Warning Stress field, type 2200 as the upper-threshold boundary

for warning stress.
v Leave the Warning Idle field, the lower-threshold boundary for warning

idle, blank.
v Leave the Critical Idle field, the lower-threshold boundary for critical

idle, blank.
c. In the Triggered-Actions area, select Email to send an e-mail to a mail

address you specify.
1) When you select Email the Email Recipients text box becomes active.
2) Click Add and type an e-mail address in the text box. You can type

multiple e-mail addresses.
3) Click Edit e-mail to customize the e-mail message. Note that errors sent

to the error log are very generic, so you might want to be more
descriptive in the text of the e-mail.

d. In the Storage Subsystems tab, select Storage Subsystems >
DS8000-21-7-1300271-IBM in the Available column and move it to the
Current Selections column.

e. To save the alert, click the Save icon. Name the alert SS Alert. It will be
listed at Disk Manager > Alerting > Storage Subsystem Alerts >
TPCUser.SS Alert. The conditions defined in the alert will be checked when
the next probe runs against the subsystem.

3. Generate and view a report

a. Expand Disk Manager > Reporting > Storage Subsystem Performance,
and click By Storage Subsystem. The Storage Subsystem Performance: By
Storage Subsystem window opens.

b. In the Selection tab, all performance metrics fields are selected by default.
To remove a field from the report, click on the metric name in Included
Columns and move it to Available Columns. In the Report Filter
Specifications area enter the number of storage subsystems upon which
you want a report in the Return maximum of text field.

c. Click the Generate Report button. A Storage Subsystem tab will open
containing the report. There will be one line in the report for each storage
subsystem.
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d. To save the report definition, click the Save icon. The Save As window
opens. Name the report SS Report and click OK. The report will be saved
at IBM Tivoli Storage Productivity Center > My Reports > TPCUser's
Reports > TPCUser.SS Report.

e. Click the Print icon to print the current page on the local machine. You can
only print one screen at a time.

Note: You might want to monitor the Total IO Rate Threshold condition for
the storage subsystem by using constraints instead of thresholds. The
Triggering Condition for a constraint would be Violating Files Consume More
Than. This will alert you if any file goes over the condition value you set. In
the Value field, type 2200, which is the value of Warning Stress. In Value Units,
select Megabytes from the pull-down list. See “Archive and delete files” on
page 142 for more information on creating constraints.

You can use the preceding steps, with some minor changes, to create performance
monitors and alerts for certain types of switches that have been discovered by
Tivoli Storage Productivity Center. Switch performance monitors, for example, are
created in the Fabric Manager node:
v To create a switch performance monitor, expand Fabric Manager > Monitoring

> Switch Performance Monitors

v To create a switch performance alert, expand Fabric Manager > Alerting >
Switch Performance Alerts.

Related tasks:
“Creating storage subsystem performance monitor” on page 379
Create a subsystem performance monitor to gather performance data for storage
systems.
“Creating storage system alerts” on page 392
You can use storage systems alerts to monitor systems for changes in configuration
or status. When the condition is detected during a probe, an alert is generated.
These alerts can be applied to storage subsystem groups and storage subsystems.
Related reference:
“Disk Manager reports” on page 990
Use Disk Manager reports to view the relationships among the components of a
storage subsystem and the storage capacity for a computer, filesystem, storage
subsystem, volume, Array Sites, Ranks, and disk.

Determine application performance problems
This scenario provides a method for finding out why an application has stopped
performing as expected.

A previously normal application has stopped performing well. You must find out
what is impacting the application so that you can take steps to correct the
situation. You suspect a storage system problem.

In this scenario, you perform the following tasks:
v Probe Storage Resource agents and Data agents
v Probe the Storage Systems and start the Performance Monitor running
v Create a Storage Subsystem: By Filesystem/Logical Volume report
v Create a Storage Subsystem Performance: By Volume report
v Create a Storage Subsystem Performance: By Array report
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Tip: Ordinarily, you run probes and performance monitors on both storage
systems and switches, because the problem might be in either place. However, in
this scenario you are only gathering information about storage systems.

Prerequisites:

v The Storage Resource agents and Data agents must be installed on the
monitored computers before you can complete the tasks in this scenario. These
are usually installed as part of the IBM Tivoli Storage Productivity Center
installation process.

v Storage Resource agents, Data agents, and Arrays must have already been
probed.

v Storage systems such as IBM System Storage DS8000 Storage Manager, IBM
System Storage SAN Volume Controller, and theXIV systems must be connected
through native interfaces. For other storage systems, CIM object manager
(CIMOM) connections must be added and discovered.

Substitutable values that are used in this scenario:
v Device path = M:\ (from application owner or server administrator)
v Computer = ODCCL163.odcclass.ibm.com (from Filesystem/Logical Volume

report)
v Volume name = testvol-100 (id.1000)(from Filesystem/Logical Volume report)
v Storage system name = DS6000–1750–13AB44A-IBM (from Filesystem/Logical

Volume report)
v Array = 1750.13AB24A-1 and A-2 (from the By Volume report, drill down to By

Array report)

To track down application performance problems, collect information by running
probes, performance monitors, and reports. Then use that information to determine
actual performance and use values.

To perform this scenario, complete the following steps:
1. When the problem is reported, get computer information, device path

information, and the application name from the application owner or the server
administrator.

2. Probe the Storage Resource agents and Data agents.
a. Expand IBM Tivoli Storage Productivity Center > Monitoring. Right-click

Probes and select Create Probes.
b. In the description field, type Probe for agents.
c. In the What to Probe page, expand 'Computers' in the Available box, select

All Computers, and move that to Current Selections. This includes all
Storage Resource agents and Data agents in the probe.

d. Click the When to Run tab and select Run Repeatedly, and set a regular
time the probe is run. The following settings are up data collection for 2:00
AM every morning.
1) Set the day in Beginning at a day ahead of the current day. If the day is

February 21st, 2008, enter February 22, 2008, at 2:00 AM.
2) Select Repeat Every and set 23 Hour(s) to specify how often the probe is

run. This setting allows time for the probe to shut down and start again.
In the How to handle time zones area, select Use the timezone that the
server runs in, which uses the time zone where the Data server resides.

e. On the Alert page, Probe Failed is the only triggering condition that
triggers an alert. In the Triggered Actions area, select Windows Event Log
and set the Event Type to Warning.
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f. Click the Save icon. Type AgentsProbe_1 as the probe name and click the
Save button. The probe is listed in the navigation tree as IBM Tivoli Storage
Productivity Center > Monitoring > Probes >
Administrator.AgentsProbe_1.

g. To begin collecting data immediately, expand IBM Tivoli Storage
Productivity Center > Monitoring > Probes, right-click
Administrator.AgentsProbe_1 and select Run Now. The status line for the
probe is listed under Administrator.AgentsProbe_1 by date and time.
A probe of the agents typically takes under a minute.

3. Probe the Storage Systems. Creating the Storage System probe is similar to
creating the probe for the Storage Resource agents and Data Agents.
a. Expand IBM Tivoli Storage Productivity Center > Monitoring, right-click

Probes and select Create Probe. In the Description field, type Probe for
Storage Systems.

b. In the What to Probe tab Available area, expand Storage Subsystems. Select
All Storage Subsystems and move it to Current Selections.

c. In the When to Run page, select Run Repeatedly beginning a day later
than the current day at 3:00 AM.

d. Click the Save icon. Type StorageSystemsProbe_1 as the probe name and
click the Save button. The listing for the probe is displayed in the
navigation tree as IBM Tivoli Storage Productivity Center > Monitoring >
Probes > Administrator.StorageSubsystemProbe_1.

e. To collect initial data, right-click Administrator.StorageSubsystemProbe_1
and select Run Now. Depending on the number and size of the storage
systems to be probed, this probe might take up to 15 minutes.

4. Begin running the storage system Performance Manager. If you have a
current Performance Monitor running and you have added another storage
system, you must start a new Performance Monitor.
a. Expand Disk Manager > Monitoring, right-click Subsystem Performance

Monitor and select Create Performance Monitor. In the Description field,
type System performance monitor.

b. Click the Storage Subsystems tab. All storage systems that have had probes
created and completed are listed under Available subsystems. Select all the
available systems and move them to Selected subsystems.

c. Click the Sampling and Scheduling tab. In the Sampling area specify how
frequently data is to be gathered and the length of the sampling window.
1) For the Interval Length, type 5 in the minutes field.
2) For Duration, select Continue indefinitely.
3) Select Begin Immediately in the Scheduling area.

d. Click the Alert tab.
1) In the Condition area, Monitor Failed is the only triggering condition.
2) In the Triggered Actions area, select Windows Event Log with a

Warning event type.
e. Click the Save icon and enter SSPerformanceMonitor_1 as the performance

monitor name. Click OK. The name of the storage system performance
monitor is displayed at Disk Manager > Monitoring > Subsystem
Performance Monitor > Administrator.SSPerformanceMonitor_1.

Tip: Setting performance alerts is not necessary for this scenario, but at this
point you can review the historical performance data for your environment.
Then you can define performance alerts with values that you consider out
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of the ordinary for your environment. You can set performance alerts for
both storage systems and switches. After a performance alert is defined,
future deviations will generate an alert and create an entry in the
Performance Manager Constraint Violation report.

5. Gather information for at least two cycles (in this case, gather the information
for at least 10 minutes). When information has been gathered, run the following
reports to collect the data you can use to check performance.
v Disk Manager > Reporting > Storage Subsystems > Computer Views > By

Filesystem/Logical Volume

v Disk Manager > Reporting > Storage Subsystem Performance > By Volume

v Disk Manager > Reporting > Storage Subsystem Performance > By Array

The data from the reports is saved by date and time, but you might want to
print copies of the reports for easier comparison.
a. The Storage Subsystem: By Filesystem/Logical Volume report identifies the

backend storage volumes associated with the file system. Variable values
that are gathered from this report include values for computer, storage
subsystem, and volume name.
1) Run the report by expanding Disk Manager > Reporting > Storage

Subsystems > Computer Views and click By Filesystem/Logical
Volume.

2) Click the Selection tab, and in the Report Filter Specifications area,
select Volumes to Relate Filesystems/Logical Volumes to in the list.

3) Click the Selection button, clear the listed computers, and select your
Device Path (M:\). Click OK to return to the Selection tab. When you
run the report, the information is limited to your device path.

4) By default all columns are listed as Included Columns. If there are
columns you do not want in the report, select them and move them to
Available Columns. Do not to move the "volume name" columns to
Available Columns.

5) Click Generate Report.
b. The Storage Subsystem Performance: By Volume report shows you the

actual performance metrics that are associated with the volumes the
problem file system resides on.
1) Expand Disk Manager > Reporting > Storage subsystem Performance

and click By Volume. By default all columns are listed as Included
Columns. Do not move any of them to Available Columns.

2) Click the Selection button. Click Deselect All, then find your system
name (DS6000–1750–13AB24A-IBM) and component (the Volume Name -
testvol-1000 (ID.1000)), and select that line. The information in the report
is limited to that system and volume.

3) Click OK. Click Generate Report.
c. The Storage Subsystem Performance: By Array report shows the other

volumes on the same array as the problem volume. It indicates whether the
problem is specific to that one volume or if all of the volumes on the same
array have a similar problem.

Note: Arrays are only supported on IBM TotalStorage Enterprise Storage
Server, DS8000, and IBM System Storage DS6000systems.
1) Expand Disk Manager > Reporting > Storage subsystem Performance

and click By Array.
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2) In the Report Filter Specifications area, select Display latest
performance data (by sample).

3) Click the Selection button. Click Deselect All then find your arrays
(Component) (1750.13AB45A-1 and A-2) and select those lines. The
information in the report is limited to those arrays.

4) By default all columns are listed as Included Columns. Do not move
any of them to Available Columns.

5) Click Generate Report.
6. Parts of the information that you use to determine the problem is in all of the

reports. Look for the following things:
v Look at the I/O rate and the response time together for a complete picture of

the performance. Ideally, you want a high I/O rate and low response time.
v If the I/O rate is high but the response time is slowing over time, look at the

cache hits to see how well cache is performing and, therefore, how often the
I/O must go to disk.

v If the I/O rate is low, look at the data rate. When there is a large number of
I/O requests with high transfer sizes, the data rates become more important
than I/O rates. In this case, look at the data rates and transfer sizes together.

v Look at all the volumes in the same array to determine the I/O rate and
response times. To determine these values, drill up from a selected volume in
the 'By Volume' report to view the arrays that the volume is a part of. Then
drill down from the array to get a filtered 'By Volume' report of just the
volumes on that array. Now compare the performance metrics against all the
volumes in the same array. If all of them show the same performance
problem, the performance bottleneck is the array. If only one volume has a
performance problem, the performance bottleneck is somewhere else.

7. In this scenario, based on the I/O rates and the response times for the array
over a time period, you determine that the array is being saturated with I/O
and I/O should be off-loaded to other storage to improve performance.

Tip: You can also use Tivoli Storage Productivity Center to determine and
project when more storage space is needed by monitoring I/O rates and
response times over a time period.

Related information:
v IBM Tivoli Storage Productivity Center User's Guide or IBM Tivoli Storage

Productivity Center Information Center
– Configuring storage systems, see “Configuring storage subsystems” on page

308.
– Adding CIMOMs manually, see “Adding a CIM agent connection” on page

250.
– Discovering CIMOMs, see “CIMOM discovery” on page 326.
– Setting performance alerts, see “Creating alerts” on page 385.

v IBM Tivoli Storage Productivity Center and IBM Tivoli Storage Productivity Center for
Replication Installation and Configuration Guide or IBM Tivoli Storage Productivity
Center Information Center
– Installing agents, see Installing the agents.
– Planning performance metrics, see Planning for performance metrics.
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Identifying performance hot spots
This scenario uses the Storage Optimizer to analyze storage systems to determine
whether there are performance hot spots. This scenario also illustrates how to use
the Storage Optimizer to get recommendations for improving storage system
performance.

You want to analyze your two IBM System Storage DS8000 Storage Manager
storage systems to determine whether there are performance hot spots. You want
to identify the hot spots and get recommendations on how to improve storage
system performance.

Prerequisites for using Storage Optimizer

v IBM Tivoli Storage Productivity Center Advanced Edition license
v One or more of these systems:

– System Storage DS8000
– System Storage DS6000
– System Storage DS5000
– System Storage DS4000
– TotalStorage Enterprise Storage Server
– SAN Volume Controller
– Storwize V7000

v Performance monitoring data gathered for at least one week in advance of using
Storage Optimizer. Providing a longer time interval for data collection increases
the accuracy of the analysis and recommendations.

Monitoring the performance of your DS8000 systems

At least one week in advance, start performance monitoring for the DS8000 storage
systems.
1. Use the Configure Devices wizard to enter connection information for the

native interfaces of your DS8000 systems. For systems that connect through
CIM object manager (CIMOM) connections, run a discovery for storage system
CIMOMs.

2. Create a probe. See “Creating probes” on page 338.
3. Create a storage system performance monitor and allow it run for at least one

week. See “Creating storage subsystem performance monitor” on page 379.

To identify performance hot spots, complete the following steps:

Part 1: Creating an analysis report that includes both DS8000 storage systems.

1. At least one week in advance, run a storage system performance monitor to
collect performance data for both DS8000 systems.

2. Navigate to IBM Tivoli Storage Productivity Center > Analytics.
3. Right-click Storage Optimizer and select Create Analysis. The Create Analysis

panel allows you to specify the storage systems that you want to analyze.
4. Under Create Analysis, enter "Analyze DS8000 systems" in the Description

field.
5. Click Add in the Select Storage pane. The Optimizer Selection panel opens.

This panel provides a topology view of the current storage network.
6. Select both of your DS8000 storage systems.
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7. Click OK to return to the Storage Optimizer Create Analysis panel with the
DS8000 systems displayed in the Select Storage pane.

8. Set the Performance Time Interval to start one week before the current date.
9. For How often to run, select Run Now.

10. Choose File > Save to save and submit the analysis report job.
11. When prompted to enter a name for the report job, enter "Analyze DS8000

systems" and click OK.
12. View the analysis report job status for "Analyze DS8000 systems" under the

Storage Optimizer node in the navigation tree.

Part 2: Viewing the analysis report and identify hot spots

When the analysis report job "Analyze DS8000 systems" is complete (status is
green), select it to view the analysis report for your DS8000 systems. The heat
maps display color-coded cells that represent the projected utilization of both
DS8000 systems, as measured against the required performance threshold of 80%.
Each cell represents a storage pool.
1. From the list of components for Heat Map based on, choose Hard Disk to

update the heat maps to display the analysis data for that component.
2. Move the performance threshold slider to see its affect on the heat maps.
3. Click the Performance Tables tab to display a tabular view of the data, if

wanted.
4. In the Hard Disk heat map for one of your DS8000 systems, you notice a red

cell, or "hot spot". Move your cursor over that cell to display the details for the
storage pool named Pool 1. The details for Pool 1 indicate that it is exceeding
the required performance threshold of 80%.
A green cell displays for Pool 2. The green color indicates that Pool 2 is
performing at less than or equal to 25% of the established performance
threshold.

You think that you might be able to improve the performance of Pool 1 by moving
some of its volumes to Pool 2. You know that Pool 2 has some amount of available
capacity.

Part 3: Creating an optimization report that includes recommendations on how
to improve the performance of Pool 1.

1. In the analysis report, select the red cell which represents Pool 1.
2. Click >> next to Source Entities to move Pool 1 into the list of source entities.
3. Select the green cell which represents Pool 2.
4. Click >> next to Target Entities to move Pool 2 into the list of target entities.
5. Choose File > Save to save and submit the optimization report job.
6. When prompted to enter a name for the optimization report job, enter

"Optimize DS8000 systems" and click OK.
7. Under View Previously Run Optimization Reports, click Refresh Job Status to

update the report job status.

Part 4: Viewing the optimization report and recommendations.
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When the optimization report job "Optimize DS8000 systems" is complete (job

status is "Success"), click to display the optimization report. The report
includes a recommendation for how to improve the performance of Pool 1.

The heat maps in the optimization report display the performance utilization of
Pool 1 and Pool 2 before and after implementing the recommendation. The heat
maps show you that the red cell representing Pool 1 changes to green after
implementing the recommendation. The heat maps also show you that the green
cell representing Pool 2 changes to yellow after implementing the recommendation.
This means that Pool 2 will be still be performing at less than or equal to 75% of
the performance threshold after you implement the recommendation.

To view the effects on the before and after heat maps of implementing only some
of the recommendations:
v Remove the check mark next to Select all recommendations and select a subset

of the recommendations from the recommendations table.

To print the optimization report:
v Click the Print button in the optimization report.

The printed report includes additional information such as SVC sample scripts to
help you implement the recommendations using the SAN Volume Controller
command-line interface.
Related information:
See “Configuring storage subsystems” on page 308 for details of how to use the
Configure Devices wizard to enter connection information for any of the storage
systems that connect to Tivoli Storage Productivity Center using native interfaces.
For more information, see “Discover storage subsystem, tape library, and fabric
information with CIM agents” on page 333.

Retiring underutilized storage systems
This scenario illustrates how you can use the Storage Optimizer to create
recommendations about retiring underutilized storage systems and migrating their
data to other systems in your data center.

Your data center has seven IBM System Storage DS8000 Storage Manager storage
systems in use. Using various IBM Tivoli Storage Productivity Centercapacity
reports, you determine that two of the systems are underutilized. You want to
create a report that provides recommendations to help guide you in retiring the
underutilized systems and migrating the data into your remaining five systems.

Prerequisites for using Storage Optimizer

v One or more of these supported systems:
– System Storage DS8000
– System Storage DS6000
– System Storage DS5000
– System Storage DS4000
– TotalStorage Enterprise Storage Server
– SAN Volume Controller
– Storwize V7000
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v Performance monitoring data gathered for at least one week in advance of using
Storage Optimizer. Providing a longer time interval for data collection increases
the accuracy of the analysis and recommendations.

Monitoring the performance of your DS8000 systems

At least one week in advance, start performance monitoring for the DS8000 storage
systems.
1. Use the Configure Devices wizard to enter connection information for the

native interfaces of your DS8000 systems. For systems that connect through
CIM object manager (CIMOM) connections, run a discovery for storage system
CIMOMs.

2. Create a probe. See “Creating probes” on page 338.
3. Create a storage system performance monitor and allow it run for at least one

week. See “Creating storage subsystem performance monitor” on page 379.

To perform this scenario, complete the following steps:

Part 1: Creating an analysis report for the seven DS8000 storage systems in your
data center.

1. At least one week in advance, run a storage system performance monitor to
collect performance data for all DS8000 systems.

2. Navigate to IBM Tivoli Storage Productivity Center > Analytics.
3. Right-click Storage Optimizer and select Create Analysis. The Create Analysis

panel allows you to specify the storage systems that you want to analyze.
4. Under Create Analysis, enter “Analyze DS8000 systems” in the Description

field.
5. Click Add in the Select Storage pane. The Optimizer Selection panel opens.

This panel provides a topology view of the current storage network.
6. Select all your DS8000 storage systems.
7. Click OK to return to the Storage Optimizer Create Analysis panel with the

DS8000 systems displayed in the Select Storage pane.
8. Set the Performance Time Interval to start one week before the current date.
9. For How often to run, select Run Now.

10. Choose File > Save to save and submit the analysis report job.
11. When prompted to enter a name for the report job, enter “Analyze DS8000

systems” and click OK.
12. View the analysis report job status for “Analyze DS8000 systems” under the

Storage Optimizer node in the navigation tree.

Part 2: Viewing the analysis report.

When the analysis report job "Analyze DS8000 systems" is complete (status is
green), select it to view the analysis report for your DS8000 systems.
v For Heat Map based on, choose the Space option to view the heat maps in the

analysis report based on disk space utilization. The heat maps confirm that most
pools in systems 6 and 7 are performing at less than 75% of capacity.

Part 3: Creating an optimization report that includes recommendations on how
to retire the underutilized systems 6 and 7 and migrate the data to your
remaining five systems.
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1. In the heat maps, select all pools for storage systems 6 and 7 using the Select
all pools for storage subsystem check box.

2. Click >> next to Source Entities to move systems 6 and 7 into the list of source
entities.

3. Click Make retirement recommendations for the selected entity.
4. In the heat maps, select all pools for storage systems 1 through 5 using the

Select all pools for storage subsystem check box.
5. Click >> next to Target Entities to move systems 1 through 5 into the list of

target entities.
6. Choose File > Save to save and submit the optimization report job.
7. When prompted to enter a name for the report job, enter "Retire DS8K" and

click OK.
8. Under View Previously Run Optimization Reports, click Refresh Job Status to

update the report job status.

Part 4: Viewing the optimization report and recommendations.

When the optimization report job "Retire DS8K" is complete (job status is

"Success"), click to display the optimization report. If it is possible to retire
systems 6 and 7, the report will include recommendations for retiring systems 6
and 7 and migrating the data into systems 1 through 5.
v For Heat Map based on, choose Space to view the before and after optimization

heat maps based on disk space utilization.
v To view the effects on the before and after heat maps of implementing only

some of the recommendations, remove the check mark next to Select all
recommendations and select a subset of the recommendations from the
recommendations table.

The before and after heat maps illustrate the effects of retiring systems 6 and 7 and
migrating the data into systems 1 through 5. The heat maps also confirm that even
after retiring systems 6 and 7, the remaining systems will still perform within the
limits of the required performance threshold.

To print the optimization report:
v Click the Print button in the optimization report.

The printed report includes additional information such as SVC sample scripts to
help you implement the recommendations using the SAN Volume Controller
command-line interface.
Related information:
See “Configuring storage subsystems” on page 308 for details of how to use the
Configure Devices wizard to enter connection information for any of the storage
systems that connect to Tivoli Storage Productivity Center using native interfaces.
For more information, see “Discover storage subsystem, tape library, and fabric
information with CIM agents” on page 333.

Tivoli Storage Productivity Center for Replication scenarios
These scenarios illustrate how to perform specific replication tasks using IBM
Tivoli Storage Productivity Center for Replication.
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The provided scenarios set out situations that can be solved using IBM Tivoli
Storage Productivity Center. When using these scenarios you should remember the
following:
v The scenarios are intended to be step-by-step instructions that you follow to

complete a specific task. Each scenario contains multiple steps that must be
followed in the order given.

v Specific values such as user names, passwords, and IP Address are given in the
scenarios only for illustration purposes. You must replace them with values
appropriate for your environment.

v The scenarios do not provide in-depth conceptual information about the tasks.

Identifying and investigating a suspended Metro Mirror
session

IBM Tivoli Storage Productivity Center and IBM Tivoli Storage Productivity Center
for Replication work together to help meet your storage management needs and
automate your replication management tasks. This scenario shows you how to use
IBM Tivoli Storage Productivity Center to view and investigate a suspended Metro
Mirror between two IBM DS8000 storage systems that was detected by IBM Tivoli
Storage Productivity Center for Replication.

You want to use IBM Tivoli Storage Productivity Center to analyze alerts generated
by events detected by IBM Tivoli Storage Productivity Center for Replication. You
want to open a page in IBM Tivoli Storage Productivity Center for Replication
from the IBM Tivoli Storage Productivity Center user interface.

Prerequisites:

v Two DS8000 storage systems.
v Use IBM Tivoli Storage Productivity Center for Replication to mirror a database

application between the DS8000 storage systems.
v Set up IBM Tivoli Storage Productivity Center to monitor DS8000 storage

systems. The general steps are as follows:
1. Run a CIMOM discovery to identify the storage systems managed by

CIMOMs in your environment. See information about discovering storage
resources in the IBM Tivoli Storage Productivity Center for Replication for
System z User's Guide for more information about how to discover storage
systems.

2. Create and schedule a probe to run against the storage systems. See
information about collecting storage statistics (probes) in the IBM Tivoli
Storage Productivity Center for Replication for System z User's Guide for more
information about how to define probes.

IBM Tivoli Storage Productivity Center includes a predefined set of alerts that
correspond to events detected by IBM Tivoli Storage Productivity Center for
Replication. In this scenario, IBM Tivoli Storage Productivity Center for Replication
detects that a Metro Mirror session just went into a suspended state. That event is
communicated to IBM Tivoli Storage Productivity Center and recorded in the alert
log. Use the alert log to view information about that alert and start the IBM Tivoli
Storage Productivity Center for Replication user interface. Use IBM Tivoli Storage
Productivity Center for Replication to determine that the paths between your
DS8000 devices in a Metro Mirror session were removed and resolve the problem.

The following tasks are described in this scenario:
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1. IBM Tivoli Storage Productivity Center: Set up notification methods for
replication alerts.

2. IBM Tivoli Storage Productivity Center: Use the alert log to view information
about a suspended Metro Mirror session that was detected by IBM Tivoli
Storage Productivity Center for Replication.

3. IBM Tivoli Storage Productivity Center for Replication: Start IBM Tivoli Storage
Productivity Center for Replication from the IBM Tivoli Storage Productivity
Center user interface to access the Session Details panel for the alert and
resolve the problem.

To use IBM Tivoli Storage Productivity Center and IBM Tivoli Storage Productivity
Center for Replication to analyze storage events, complete the following steps:
1. IBM Tivoli Storage Productivity Center: Set up notification methods for

replication alerts.
a. Start IBM Tivoli Storage Productivity Center.
b. In the navigation tree, expand Replication Manager > Alerting and select

Replication Alerts.
c. Click TPCUser.Replication Suspending Event. The Edit Replication Alerts

panel is displayed. Use this panel to determine how you are notified if IBM
Tivoli Storage Productivity Center for Replication detects a suspending
event in your storage environment.

d. In the Triggered Actions section, select the notification methods for the
alert.
By default, all suspending events that are detected by IBM Tivoli Storage
Productivity Center for Replication are recorded as entries in the Alert Log
panel under IBM Tivoli Storage Productivity Center > Alerting . If you
want to be notified using additional methods when the alert log is updated
for a suspending event, select any of the following options:
v Select SNMP Trap to generate an SNMP trap message to any NMS,

console, or terminal to indicate the triggering of a suspending alert.
v Select TEC/OMNIbus Event to send an alert to the Tivoli Event Console

or OMNIBus.
v Select Login Notification to be notified of a suspending event when you

log in to Tivoli Storage Productivity Center.
v Select Windows Event Log or UNIX SYSLOG to write the suspending

alert to the operating system log file.
v Select Run Script to run a script when a suspending alert is triggered.
v Select Email to indicate the email addresses that receive notification when

a suspending alert is triggered.
You are not required to select any of these options. Triggered alerts from
IBM Tivoli Storage Productivity Center for Replication are automatically
recorded in the alert log. These options are meant to provide you with
additional methods for receiving alerts.

e. Click the Save icon to save the alert definition. When IBM Tivoli Storage
Productivity Center for Replication detects that a session has suspended,
this alert is triggered, an entry is added to the IBM Tivoli Storage
Productivity Center alert log, and any additional triggered actions are run.

2. IBM Tivoli Storage Productivity Center: Use the alert log to view information
about a suspended Metro Mirror session.
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This step occurs after IBM Tivoli Storage Productivity Center for Replication
has detected a suspended session and triggered an alert in the IBM Tivoli
Storage Productivity Center user interface.
a. In the navigation tree, expand IBM Tivoli Storage Productivity Center >

Alerting and select Alerting Log. A visual indicator is displayed next to
each alert type under this node. In this scenario, a red, filled-in circle is
displayed next to the Replication node to indicate that IBM Tivoli Storage
Productivity Center has received an alert from IBM Tivoli Storage
Productivity Center for Replication that is unresolved.

b. Click the Replication node. The content pane displays a table that contains
a row for each alert received from IBM Tivoli Storage Productivity Center
for Replication. The Alert Type column in this table indicates the type of
alert that was triggered.

c. Click the magnifying glass icon next to the alert that displays Suspending
Event in the Alert Type column. The Detail for Alert panel displays a
description of the event that triggered the alert:
IWNR1958W [2009/03/04 15:11:49.250 EST] Session session_name has
changed to the SEVERE status due to an unexpected error.

where session_name represents the name of the session in IBM Tivoli Storage
Productivity Center for Replication.

d. Click the back arrow in the tool bar to return to the Alert Log panel.
3. Start IBM Tivoli Storage Productivity Center for Replication from a suspended

event alert in the alert log.
The Session Details page indicates that the session went suspended because the
paths between the devices were dropped.
a. On the IBM Tivoli Storage Productivity Center > Alerting > Alerting Log

page, right-click the row for that represents the Suspending Event alert
type. The menu that is displayed contains the actions that you can perform
against the alert log entry. One of the actions is to start the IBM Tivoli
Storage Productivity Center for Replication user interface.

b. Click Launch Replication Session Details on the menu. The IBM Tivoli
Storage Productivity Center for Replication user interface starts in a Web
browser and displays the Session Details page. Use this page to view
detailed information about the suspended event.
Single sign-on is an authentication process that enables you to enter one
user ID and password to access multiple applications. Single sign-on
integrates with the launch in context feature to enable you to move
smoothly from the IBM Tivoli Storage Productivity Center user interface to
a specific location in the IBM Tivoli Storage Productivity Center for
Replication user interface without re-entering a user ID and password.
For example, this scenario shows how you can use single sign-on and
launch in context to open a page in the IBM Tivoli Storage Productivity
Center for Replication user interface based on a triggered alert in IBM Tivoli
Storage Productivity Center.

c. Use IBM Tivoli Storage Productivity Center for Replication to resolve the
problem that triggered the alert.

You can use steps similar to the preceding ones to use IBM Tivoli Storage
Productivity Center and IBM Tivoli Storage Productivity Center for Replication
together to investigate and resolve different conditions and events that occur
within your storage environment.
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Performing planned maintenance scenarios
Scenarios for a planned outage consist of the removal of a unit from service to
perform scheduled work on specific components for a predetermined duration.

Planned outage of local (H1), moving production to site 2 (H2)
and optional return
In this scenario, your goal is to shut down the H1 box for maintenance, or for a
planned power outage. As a result, you must move production to the H2 site, with
the option of switching back to the H1 site after it is restored.

Follow these steps to carry out this scenario.
1. Start H1->H2->H3

Issue this command to begin Metro Global Mirror on your system when the
production I/O is running on H1. The session will reach a Prepared state so
there is a consistent point on Sites 2 and 3.

Note: Since the outage is a planned outage, stop production I/O to H1.
2. Suspend

This command creates the planned outage by suspending the Metro Mirror
relationship between H1 and H2. When this step is complete, the session state
should be suspended and recoverable.

3. Recover H2

This command makes H2 target-available. When the session state is Target
Available, the production I/O can then be moved to write to the H2 volumes.

4. Start H2->H3

This command starts a Global Mirror session during the outage of H1.
Production I/O can continue on H2. After the session reaches the Prepared
state, a consistent copy of the data resides on Site 3, and can be used in the
event of a disaster.

5. Start H2->H1->H3

Issue this command when H1 is available and ready to be brought back into
the configuration. This command starts a Metro Global Mirror session with H1
and H2 roles reversed from the original configuration. Production I/O can
continue on H2. After the session reaches the Prepared state, both Site 1 and
Site 3 will have a consistent copy of the data.

Note: The following steps are the steps you must follow after you decide to
switch production I/O to write on Site 1 again. Stop production I/O on H2
before continuing to the next step.

6. Suspend

This command suspends the Metro Mirror relationship between H2 and H1.
When this step is complete, the session state should be suspended and
recoverable.

7. Recover H1

This command makes H1 target-available. When the session state is
target-available at H1, run production I/O to H1.

8. Start H1->H2->H3

This command returns the session to its original configuration, copying data
from Site 1, to Site 2, to Site 3.
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Planned outage on site 2 (H2) and return to three-site
configuration
In this scenario, there is a planned outage expected on site 2. Disaster recovery
capability is still needed so the copy will be setup between site 1 and site 3. After
site 2 is brought back up, the session can then be brought back up to its original
configuration.

Follow these steps to carry out this scenario:
1. Start H1->H2->H3

Run this command to begin Metro Global Mirror on your system when the
production I/O is running on H1. After the session is in a Prepared state, both
sites 2 and 3 will have a consistent copy of the data.

Note: Production I/O does not stop running to site 1 to perform the following
steps.

2. Start H1->H3

This command starts a Global Mirror session between site 1 and site 3, during
the outage of H2. Production I/O can continue on H1. After the session has
reached a Prepared state, a consistent copy of the data will reside on Site 3.

Note:

v If running DS8000 devices on H1 with the correct level of microcode, and
enough time has passed since the initial start of the session, the creation of
the H1 to H3 pairs will not require a full copy.

v Data on Site 2 is no longer consistent at this point.
v After Site 2 is brought back up and is ready to hold a consistent copy of the

data, go to the next step to return to the full three-site configuration.
Production I/O never has to stop writing to H1 in this scenario.

3. Start H1->H2->H3

After the session reaches a Prepared state, site 2 and 3 will have a consistent
copy of the data again.

Planned outage of local (H1) with production move to remote
(H3)
In this scenario, there is a planned outage for Site 1 (H1). Site 2, however, does not
have the resources to run production, so production will be moved to Site 3 during
the outage at Site 1. When the outage is complete, production can then be moved
back to Site 1 and resume the full three-site configuration.

Complete the following steps to carry out this scenario.
1. Start H1->H2->H3

Issue this command to begin Metro Global Mirror on your system when the
production I/O is running on H1. Once the session is in a Prepared state, both
sites 2 and 3 will have a consistent copy of the data.

Note: Because this is a planned outage at Site 1, stop production I/O to Site 1
(H1) before continuing to the next step.

2. Suspend

This command creates the planned outage by suspending the Metro Mirror
relationship between H1->H2. When this step is complete, the session state
should be suspended and recoverable.

3. Recover H3
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This command makes H3 Target Available. When the session state is Target
Available at H3, production I/O can be moved to H3.

Note: When Site 1 is ready to resume production, continue with the following
steps. Production I/O can continue to be written to H3 through the following
step.

4. Start H3->H1->H2

Issue this command when H1 and H2 are available and ready to be brought
back into the configuration. Changes from production at the remote site (H3)
flow from the local site (H1) to the intermediate site (H2). The H3-H1 and
H1-H2 pairs are Global Copy. The session will remain in a preparing state.

Note: While the session is Preparing, you can decrease the amount of time that
production I/O has to be stopped by waiting for progress on the H3-H1 role
pair to be at or near 100%. The next step will drive H3-H1 to sync, which
depending on the percentage of the copy that is complete, can take a significant
amount of time. When you are ready to switch back to Site 1, stop production
I/O on H3 before continuing to the next step.

5. Suspend

This command suspends Global Copy relationship between H3->H1 and
H1->H2. When this step is complete, the session state should be suspended and
recoverable.

6. Recover H1

This command makes H1 Target Available. When the session state is Target
Available at H1, production can be switched back to H1.

7. Start H1->H2->H3

This command will resume copy from Site 1 back to sites 2 and 3. Once the
session reaches a Prepared state, there will be a consistent copy on Site 2 and
Site 3.

Planned outage of remote (H3) and returning
In this scenario, the remote site H3 has a planned outage, or consistency groups
from the Global Mirror session need to be temporarily paused.

Complete the following steps to carry out this scenario.
1. Start H1->H2->H3

Issue this command to begin Metro Global Mirror on your system when the
production I/O is running on H1. After the session is in a Prepared state, both
sites 2 and 3 will have a consistent copy of the data.

Note: Production I/O to H1 can continue during the following steps.
2. Suspend H2->H3

Issue this command to suspend only the Global Mirror portion of the session.
The Metro Mirror continues between H1 and H2. This causes the session state
to be put into a SuspendedH2H3 state.

3. Start H1->H2->H3

This command restores the original configuration by restarting the Global
Mirror portion of the session.
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Recovering from a disaster scenarios
Scenarios for disaster recovery (or unplanned outages) describe the steps to recover
from the loss of a complete site and restart operations after a disaster or
disruption.

Unplanned outage of local (H1), production move to intermediate
(H2)
In this scenario, there was an unplanned outage of the local site (H1), and
production must be moved to Site 2 (H2) until Site 1 can be brought back up.

Complete the following steps to carry out this scenario.

Note: To ensure consistency in the event of a rolling disaster where the IBM Tivoli
Storage Productivity Center for Replication server is lost on Site 1 before freezing
all the copies in the session, enable the Metro Mirror heartbeat function.
1. Start H1->H2->H3

Issue this command to begin Metro Global Mirror on your system when the
production I/O is running on H1. Once the session is in a Prepared state, both
sites 2 and 3 will have a consistent copy of the data.

2. Unplanned outage of H1
This event causes an unplanned outage of H1, which causes the session to go
suspended. It is recoverable if the session was in a Prepared state when the
outage occurred. If the state was Preparing when the outage occurred, the
session might be recoverable at Site 2 but will not be recoverable at Site 3.

3. RecoverH2

This command makes H2 Target Available. When the session state is Target
Available at H2, production can be switched to H2.

4. Start H2->H3

This command starts a Global Mirror session from Site 2 to Site 3 during the
outage of H1. Once the session reaches a Prepared state, consistent data should
reside on Site 3.

Note: Do not perform the following step until Site 1 is back up and ready to
receive a copy of the data that has been written to Site 2 during the outage.

5. Start H2->H1->H3

This command starts an MGM session with the H1 and H2 roles reversed from
the original configuration. Production I/O can continue on H2. Wait for the
session to go to the Prepared state, at which point there will be a consistent
copy of the data on Site 1 and Site 3.

Note: The following steps can be used to return to the original configuration so
that production I/O can be switched back to Site 1. Stop production I/O on H2
before continuing to the next step.

6. Suspend

This command suspends the Metro Mirror relationship between H2 and H1.
When this step is complete, the session state should be suspended and
recoverable.

7. RecoverH1

This command makes H1 Target Available. When the session state is Target
Available at H1, production I/O can be switched back to H1.

8. Start H1->H2->H3
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This command restores the original configuration. Once the session reaches a
Prepared state, a consistent copy of the data will reside on Site 2 and Site 3.

Unplanned outage of Site 2 (H2)
In this scenario, an unplanned outage of Site 2 (H2) occurs. Disaster Recovery
capability is still required, so a Global Mirror session must be set up between Site 1
(H1) and Site 3 (H3) while Site 2 is down.

Complete the following steps to carry out this scenario.
1. Start H1->H2->H3

Issue this command to begin Metro Global Mirror on your system when the
production I/O is running on H1. Once the session is in a Prepared state, both
sites 2 and 3 will have a consistent copy of the data

Note: Production I/O to H1 can continue during the following steps.
2. Unplanned outage of H2

This event causes an unplanned outage of H2, which causes the session to go
suspended. It is recoverable if the session was in a Prepared state when the
outage occurred. If the session state was Preparing, the session might be
recoverable at Site 2 but would not be recoverable at Site 3.

3. Start H1->H3

This command starts a Global Mirror session between Site 1 and Site 3 during
the outage of H2. Production I/O can continue on H1.

Note: If you are running DS8000 devices on H1 with the proper level of
microcode, and enough time has passed since the initial start of the session, the
creation of the H1 to H3 pairs will NOT require a full copy.
Once the session has reached a Prepared state, a consistent copy of the data
will reside on Site 3.

Note: Data on Site 2 is no longer consistent at this point.

Note: After Site 2 has been successfully brought back up, perform the next step
to return to the three-site configuration.

4. Start H1->H2->H3

Issue this command when H2 is ready to be brought back into the
configuration. This command restores the original configuration. Production
I/O can continue on H1. Once the session reaches a Prepared state, a consistent
copy will reside on Site 2 and Site 3.

Unplanned outage of remote (H3)
In this scenario, an unplanned outage occurs on Site 3 (H3).

Complete the follow these steps to carry out this scenario.
1. Start H1->H2->H3

Issue this command to begin Metro Global Mirror on your system when the
production I/O is running on H1. Once the session is in a Prepared state, both
sites 2 and 3 will have a consistent copy of the data.
A failure of the remote site (H3) causes the session state to go from Prepared to
SuspendedH2H3, with an error message that the connection to the H3 box has
been lost.
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Note: When the remote site (H3) is repaired and ready to return to the
configuration, the session will remain SuspendedH2H3 and recoverable until
step 2 is completed.

2. Start H1->H2->H3

Issue this command only when the remote site (H3) is repaired and ready to
return to the configuration. With this command, your session returns to the
original configuration by starting the Global Mirror portion back up.

Unplanned outage of local (H1) with production move to remote
(H3)
In this scenario, there is an unplanned outage for Site 1 (H1). Site 2, however, does
not have the resources to run production, so production will be moved to Site 3
during the outage at Site 1. When the outage is complete, production can then be
moved back to Site 1 and resume the full three-site configuration.

Complete the following steps to carry out this scenario.

Note: To ensure consistency in the event of a rolling disaster where the IBM Tivoli
Storage Productivity Center for Replication server might be lost on Site 1 before
freezing all the copies in the session, enable the Metro Mirror heartbeat function.
1. Start H1->H2->H3

Issue this command to begin Metro Global Mirror on your system when the
production I/O is running on H1. When the session is in a Prepared state, both
sites 2 and 3 have a consistent copy of the data.

2. Unplanned outage of H1 and H2

This event causes an unplanned outage of H1 and H2 which causes the session
to go suspended. It is recoverable if the session was in a Prepared state when
the outage occurred. If the state was Preparing, the session might be
recoverable at Site 2, but will not be recoverable at Site 3.

3. Recover H3

This command makes H3 Target Available. The session will be severe/Target
Available. When the session state is Target Available at H3, production I/O can
be moved to H3.

Note: Once Site 1 is brought back up, perform the following step to begin the
process of returning production to Site 1.

4. Start H3->H1->H2

Issue this command when H1 and H2 are available and ready to be brought
back into the configuration. Changes from production at the remote site (H3)
flow from the local site (H1) to the intermediate site (H2). The H3-H1 and
H1-H2 pairs are Global Copy. The session will in the preparing state.

Note: While the session is Preparing, you can decrease the amount of time that
production I/O has to be stopped by waiting for the progress on the H3-H1
role pair to be at or near 100%. The next step will drive H3-H1 to sync, which
depending on the percentage of the copy that is complete, can take a significant
amount of time. When you are ready to switch back to Site 1, stop production
I/O on H3 before continuing to next step.

5. Suspend

This command suspends the Global Copy relationship between H3>H1 and
H1>H2. When this step is complete, the session state should be suspended and
recoverable.

6. Recover H1
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This command makes H1 Target Available. When the session state is Target
Available at H1, run production I/O to H1.

7. Start H1->H2->H3

This command restores the original three-site configuration. Once the session
reaches a Prepared state, a consistent copy of the data will reside on Site 2 and
Site 3.

Practicing disaster recovery scenarios
This section provides scenarios for how to practice disaster recovery using a
regular Metro Global Mirror session. You can follow these scenarios to practice
disaster recovery while continuing to be disaster recovery-capable using only the
Metro Mirror portion of the session. The Metro Global Mirror with Practice session
is also available, which allows for practicing disaster recovery while maintaining
full three-site disaster recovery capability.

Practice a recovery to H2 with production that is continuing on
H1 in a normal configuration
In this scenario, your goal is to practice a recovery to H2 with production that is
continuing on H1 in a normal configuration.

Follow these steps to carry out this scenario.
1. Start H1->H2->H3

Issue this command to begin a Metro Global Mirror session on your system
when the production I/O is running on H1. Wait for the session to go to the
prepared state.
You can continue to run production I/O to H1 during the following steps.

2. Suspend

This command creates the planned outage by suspending the Metro Mirror
relationship between H1 and H2. When this step is complete, the session state
should be suspended and recoverable.

Note: Stop running production I/O to H2 prior to issuing the Suspend
command.

3. Recover H2

This command makes H2 target-available. When the session is target-available
at H2, run practice I/O to H2.

4. Start H1->H3

Issue this command to ensure that any I/O that is written to site 1 is copied to
site 3.
You can also use the Start H1->H3 command to practice for a disaster at the H2
site while still maintaining disaster recovery capability. When the H1->H3 role
pair is in Global Mirror mode, you can recover the session at site 3 if a disaster
occurs.
When you complete testing on H2, you can issue the Start H1->H2->H3
command to return to a three-site configuration without completing a full copy.

5. Start H1->H2->H3

Issue this command to restart the Metro Global Mirror session in the H1-H2-H3
configuration. Any changes from production at the local site (H1) flow from the
remote site (H3) to the intermediate site (H2), which overwrites the test data on
H2.
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Table 28. Role-pair states at the completion of each step (participating and nonparticipating role pairs)

Role-pair states

Steps H1-H2 H2-H3 H2-J3 H3-J3 H1-H3 H1-J3

1 Prepared

Preparing Prepared

Target available

Non-
participating

Non-
participating

2

Suspended
3

4 Non-
participating

Non-
participating

Participating Prepared

5
Prepared

Preparing Prepared Non-
participating

Non-
participating

Practice recovery to H1 with production that is continuing on H2
In this scenario, your goal is to practice a recovery to H1 with production that is
continuing on H2.

Follow these steps to carry out this scenario.
1. Start H1->H2->H3

Issue this command to begin a Metro Global Mirror session on your system
when the production I/O is running on H1. Wait for the session to go to the
prepared state.

2. Suspend

This command creates the planned outage by suspending the Metro Mirror
relationship between H1 and H2. When this step is complete, the session state
should be suspended and recoverable.

Note: Stop running production I/O to H1 prior to issuing the Suspend
command.

3. Recover H2

This command makes H2 target-available.

Note: Start running production I/O to H2.
4. Start H2->H1->H3

This command starts a Metro Global Mirror session with H1 and H2 roles
reversed from the original configuration.
You can continue to run production I/O to H2 for the next two steps.

5. Suspend

This command creates the planned outage by suspending the Metro Mirror
relationship between H1 and H2. When this step is complete, the session
should be suspended and recoverable.

6. Recover H1

This command makes H1 target-available. When the session state is
target-available at H1, run practice I/O to H1.

7. Start H2->H3

Issue this command to ensure that any I/O that is written to site 2 is copied to
site 3.
You can also use the Start H2->H3 command to practice for a disaster at the H1
site while still maintaining disaster recovery capability. When the H2->H3 role
pair is in Global Mirror mode, you can recover the session at site 3 if a disaster
occurs.
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When you complete testing on H1, you can issue the Start H2->H1->H3
command to return to a three-site configuration without completing a full copy.

8. Start H2->H1->H3

Issue this command to restart the Metro Global Mirror session in the H2-H1-H3
configuration. Any changes from production at the local site (H2) flow from the
remote site (H3) to the intermediate site (H1), which overwrites the test data on
H1.

Table 29. Role-pair states at the completion of each step (participating and nonparticipating role pairs)

Role-pair states

Steps H1-H2 H2-H3 H2-J3 H3-J3 H1-H3 H1-J3

1 Prepared

Preparing Prepared

Target available

Non-
participating

Non-
participating

2
Suspended

3

4 Prepared
Non-

participating
Non-

participating
Preparing Prepared5

Suspended
6

7 Preparing Prepared Non-
participating

Non-
participating

8
Prepared

Non-
participating

Non-
participating

Preparing Prepared

Practice at H3 for Metro Global Mirror
This topic describes how to practice at the remote site (H3) while running a Metro
Global Mirror session.

To practice on the remote site, you first need to suspend the back-end. For
example, if running in an H1->H2->H3 configuration, issue a Suspend H2H3
command to pause the Global Mirror portion of the session while leaving the
Metro Mirror portion of the session active. When the session is in a suspended
state (that is, H2H3 is suspended while in an H1->H2->H3 configuration), you
have the option to issue a Recover H3 command.

The Recover H3 command acts differently than other recover commands. In this
case, the command acts only to make the remote site (H3) target-available and
does not switch the application site to H3. The application site remains the original
host site and the session acts as it does in a normal Metro Mirror Failover/Failback
session.

While the session is in this mode, it remains capable of disaster recovery at Site 2
and will freeze all pairs to maintain consistency during an error. You can also
suspend the session by command and recover to Site 2 if necessary. However, if
recovering to Site 2 in this mode, it will not be possible to restart a full three-site
solution. To get three sites back up and running, you need to copy back to H1
using the Start H2->H1 command and then suspend and recover to H1. Once H1
is the application host again, you can issue the Start H1->H2->H3 command to
restart three-site support. If this is done, all data written to H3 during the practice
is overwritten with the data that is on H1.
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Overview of scenarios for practicing at H3 for Metro Global Mirror:

This topic provides an overview of the scenarios for practicing at H3 for Metro
Global Mirror.

Note: For simplicity, the following scenarios are geared toward the configuration
where the session is running H1->H2->H3. The same options apply when in the
configuration is running H2->H1->H3.

There are two methods to set up a practice mode at the remote site, H3.

In the first method, you issue the following commands:
1. Start H1->H2->H3
2. SuspendH2H3
3. RecoverH3

When the session state is Target Available at H3, you can practice you disaster
recovery steps on H3 while continuing to run the real production I/O to H1.

In the second method of setting up a practice mode, issue the following
commands:
1. Start H1->H2->H3
2. Suspend
3. RecoverH3
4. Start H1->H2

When the session state is Target Available at H3, run practice I/O to H3. Continue
running production I/O to H1.

The difference between the second method and the first method is that a Suspend
command is issued instead of a SuspendH2H3 command. When the session is in
suspended mode (as opposed to suspended H2H3 mode), the session does not
automatically go into practice mode. The application site switches to H3 and you
must issue a Start H1->H2 to enable the practice mode.

Practice scenario 1: While practicing, disaster occurs at Site 1, recover to Site 2:

This topic describes what to do in the event that a disaster occurs on Site 1 while
practicing at Site 3.

If a disaster occurs at Site 1, the session immediately suspends itself. You then
must complete the following steps:
1. Issue RecoverH2.
2. Move the production I/O to Site 2.
3. Issue Start H2->H1 to make the session capable of disaster recovery again once

Site 1 has been brought back up.

Practice scenario 2: While practicing, planned outage at Site 1, recover to Site 2:

This topic describes what to do if there is a planned outage on Site 1 while
practicing at Site 3.

While practicing, if you want a planned outage with a switch to Site 2, complete
the following steps:
1. Issue Suspend.
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2. Issue RecoverH2.
3. Move the production I/O to Site 2.
4. Issue Start H2->H1 to make the session capable of disaster recovery again once

Site 1 has been brought back up.

Practice scenario 3: while practicing with production at site 2, move production
back to site 1:

This topic describes an H3 practice scenario, with production running at site 2,
followed by a move of production to site 1.

While practicing, if you moved the production to site 2, you need to move it back
to site 1 before you can start three-site support. To move production back to site 1,
do the following steps (assume the session is running H2->H1):
1. Issue Suspend.
2. Issue Recover H1.
3. Move the production I/O to site 1.
4. Issue Start H1->H2 to make the session capable of disaster recovery again and

move the production I/O to H3.
5. Issue Start H1->H2->H3 when H3 is ready to receive a copy of the data at site

1. When this command completes, all writes that were done to H3 are
overwritten by the data on site 1.

The following table shows the changing states of the role pairs after each step.

Table 30. Role-pair states at the completion of each step (participating and nonparticipating role pairs)

Role-pair states

Steps H1-H2 H2-H3 H2-J3 H3-J3 H1-H3 H1-J3

1 Suspended
Nonparticipating

2 Target Available

4
Prepared

target-available
nonparticipating

5 Preparing Prepared Target Available
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Chapter 4. Administering

Administer DB2 to back up the database and to start and stop the control center.
Administer IBM Tivoli Storage Productivity Center to authorize users, start and
use the console, which is the graphical user interface (GUI), start and stop services,
and many other administrative tasks.

Starting Tivoli Storage Productivity Center
IBM Tivoli Storage Productivity Center provides two graphical user interface (GUI)
applications for managing and monitoring the resources in a storage environment:
a stand-alone GUI and a stand-alone GUI. You can start these GUIs on the Tivoli
Storage Productivity Center server or on a remote system.

The stand-alone GUI and the web-based GUI provide different functions and offer
different advantages. Start the one that is best suited to your current needs.
v The stand-alone GUI contains functions for monitoring the condition of storage

resources, and all the tools for managing data, disk, fabric, tape, and replication.
Start the stand-alone GUI if you must have the full administrative capabilities of
Tivoli Storage Productivity Center. How you start the stand-alone GUI depends
on whether the stand-alone GUI component is installed on your system.

v The web-based GUI provides quick access to pages that you can use to monitor
the condition, capacity, and relationships of the resources within your storage
environment. Start the web-based GUI if you are interested in monitoring your
storage environment but do not require the full set of administrative tools
available in the stand-alone GUI.

Starting the Tivoli Storage Productivity Center stand-alone
GUI

The stand-alone GUI contains functions for monitoring the condition of storage
resources, and all the tools for managing data, disk, fabric, tape, and replication.

How you start the stand-alone GUI depends on whether the stand-alone GUI
component is installed on your system.
v On the Tivoli Storage Productivity Center server, or on a remote system where

the stand-alone GUI component is installed, you start the stand-alone GUI by
running a batch file or a shell script. For Windows operating systems, you run
the batch file tpc.bat, which you can run from the Start menu. For AIX or Linux
operating systems, you run the shell script TPCD.sh.

v If the stand-alone GUI component is not installed on a remote system, you use a
Java Web start application to download and start the stand-alone GUI.

Starting the Tivoli Storage Productivity Center stand-alone GUI
by using Java Web Start
Start the stand-alone Tivoli Storage Productivity Center GUI by using Java Web
Start to interact remotely with Tivoli Storage Productivity Center running on the
server.

Before you start Tivoli Storage Productivity Center, ensure that you are using a
supported web browser. For a list of web browsers that you can use with Tivoli
Storage Productivity Center, see the support matrix at http://www.ibm.com/
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support/docview.wss?uid=swg21386446. In the Agents, Servers and GUI column,
click the version of Tivoli Storage Productivity Center that is installed on your
system. On the next page, click Web Browsers to find the web browsers that you
can use.

On remote systems where the stand-alone GUI component is not installed, you can
start the stand-alone Tivoli Storage Productivity Center GUI using Java Web Start.
To start the stand-alone GUI by using Java Web Start, you click a web link that
downloads a Java Network Launching Protocol (JNLP) file from the server. The
JNLP file specifies all the files needed by the application. The Java Web Start
Launcher on the remote system opens the JNLP file, downloads and caches all the
required files, and starts the stand-alone GUI in a new window.
1. Start a web browser, and type the following address for the Java Web Start

page.
http://hostname:port/ITSRM/app/welcome.html

In the preceding address, specify the following values:

hostname
The Tivoli Storage Productivity Center server. You can specify the hostname
as an IP address or a Domain Name System (DNS) name. To verify your
host name, ask your Tivoli Storage Productivity Center administrator.

port
The port number for the Device server. The default port number for
connecting to the Device server using the HTTP protocol is 9550. However,
this port number might be different for your site. For example, the port
number might be different if the default port range was not accepted
during installation. If the default port number does not work, ask your
Tivoli Storage Productivity Center administrator for the correct port
number.

2. The Tivoli Storage Productivity Center GUI requires an IBM Java Runtime
Environment 1.6.0. Links are provided on the Java Web start page for you to
download the IBM Java Runtime Environment 1.6.0 for Windows, Linux, or
AIX. If an IBM Java Runtime Environment 1.6.0 is not already installed on the
system, click the link to download the IBM Java Runtime Environment 1.6.0 for
your operating system. On Windows, download a self-extracting executable. On
Linux, download an RPM file. On AIX, download an executable JAR file. Install
the JRE from the file that you downloaded before you start the stand-alone
GUI. If you are prompted to install the JRE as the system JRE or to overwrite
the current system JRE, click No.

3. From the Java Web Start page, click TPC GUI (Java Web Start)

The JNLP file is downloaded.

Important: Depending on your browser and operating system and their
default settings for your browser and operating system) you might need to:
v Verify to your browser that the tpcgui.jnlp file is safe to download
v Indicate that JNLP files are to be opened by the Java Web Start Launcher

For more information, go to the Tivoli Storage Productivity Center information
center at http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/index.jsp
and search for Cannot start the Tivoli Storage Productivity Center stand-alone GUI
remotely.

4. The stand-alone Tivoli Storage Productivity Center GUI opens in a separate
window. To log on to Tivoli Storage Productivity Center, enter the following
information and click OK.

176 IBM Tivoli Storage Productivity Center: User's Guide

http://www.ibm.com/support/docview.wss?uid=swg21386446
http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/index.jsp


a. Enter your user ID and password.

Important: If you are logging on immediately after installation and, see
“Overview of required user IDs for initial log on to the Tivoli Storage
Productivity Center family of products” on page 181 for information on the
user ID you must use.

b. If the server field does not contain the address and port number of for the
server, specify the following values for the hostname and port.

hostname
The Tivoli Storage Productivity Center server. You can specify the
hostname as an IP address or a Domain Name System (DNS) name. To
verify your host name, ask your Tivoli Storage Productivity Center
administrator.

port
The port number for the Data server. The default port number for
connecting to the Data server is 9549. However, this port number might
be different for your site. For example, the port number might be
different if the default port range was not accepted during installation.

Starting the Tivoli Storage Productivity Center stand-alone GUI
on a system where the GUI component is installed
On the Tivoli Storage Productivity Center server, or on a remote system where the
stand-alone GUI component is installed, you start the Tivoli Storage Productivity
Center stand-alone GUI using the batch file tpc.bat on a Windows operating
system or the shell script TPCD.sh on an AIX and Linux operating system.

A typical installation of Tivoli Storage Productivity Center on the server includes
the stand-alone GUI component. A remote system can also have the stand-alone
GUI component installed. On a system where the stand-alone GUI component is
installed, use the following instructions for starting the stand-alone GUI. If you are
on a remote system where the stand-alone GUI component is not installed, start
the stand-alone GUI by using Java Web Start instead.
1. Start the Tivoli Storage Productivity Center GUI by using the Start menu or

batch file on a Windows operating system or a shell script on an AIX or Linux
operating system.
v On Windows, click Start > Programs > IBM Tivoli Storage Productivity

Center > TPC Stand-alone GUI. This runs the Windows batch file tpc.bat.
If you are on a remote system, the Start menu item for the stand-alone GUI
might not be available. In this case, run the tpc.bat directly. The default
location for the batch file is C:\Program Files\IBM\TPC\gui\tpc.bat.

v On AIX or Linux, type the following path and command at the command
line.
/opt/IBM/TPC/gui/TPCD.sh

2. From the Tivoli Storage Productivity Center GUI logon window, log on to
Tivoli Storage Productivity Center.
a. Enter your user ID and password.
b. If the server field does not contain the address of the server, enter the

information in the format hostname:port. Specify the following values for
the hostname and port:

hostname
The Tivoli Storage Productivity Center server. You can specify the
hostname as an IP address or a Domain Name System (DNS) name.
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port
The port number for the Data server. The default port number for
connecting to the Data server is 9549. However, this port number might
be different for your site. For example, the port number might be
different if the default port range was not accepted during installation.

c. Click OK.

Starting the Tivoli Storage Productivity Center web-based GUI
You can start the web-based Tivoli Storage Productivity Center GUI by opening a
web browser and entering a web address for the Tivoli Storage Productivity Center
logon page.

Before you start IBM Tivoli Storage Productivity Center, ensure that you are using
a supported web browser. For a list of web browsers that you can use with Tivoli
Storage Productivity Center, see the support matrix at http://www.ibm.com/
support/docview.wss?uid=swg21386446. In the Agents, Servers and GUI column,
click the version of Tivoli Storage Productivity Center that is installed on your
system. On the next page, click Web Browsers to find the web browsers that you
can use.

The web-based GUI provides quick access to pages that you can use to monitor the
condition, capacity, and relationships of the resources within your storage
environment. Start the web-based GUI if you are interested in monitoring your
storage environment, but do not need the full set of administrative tools available
in the stand-alone GUI.
1. On a server running the Windows operating system, click Start > Programs >

IBM Tivoli Storage Productivity Center > TPC Web-based GUI to open a
browser to the correct address. If you are not on a server running the Windows
operating system, start a web browser and enter the following address in the
address field:
http://hostname:port/srm

In the preceding address, specify the following values:

hostname
The Tivoli Storage Productivity Center server. You can specify the host
name as an IP address or a Domain Name System (DNS) name.

port
The port number for Tivoli Storage Productivity Center. The default port
number for connecting to Tivoli Storage Productivity Center by using the
HTTP protocol is 9568. However, this port number might be different for
your site. For example, the port number might be different if the default
port range was not accepted during installation. If the default port number
does not work, ask your Tivoli Storage Productivity Center administrator
for the correct port number.

You might be redirected from the address that you enter to another address
and port that provides secure access using the HTTPS protocol. This page is the
Tivoli Storage Productivity Center logon page.

2. From the Tivoli Storage Productivity Center logon page, type your user name
and password and click Log in. The web-based Tivoli Storage Productivity
Center GUI opens in the browser.
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Starting Tivoli Storage Productivity Center for Replication
You can start the IBM Tivoli Storage Productivity Center for Replication GUI by
opening a web browser and entering a web address for the Tivoli Storage
Productivity Center for Replication logon page.

Before you start Tivoli Storage Productivity Center for Replication, ensure that you
are using a supported web browser. For a list of web browsers that you can use
with Tivoli Storage Productivity Center, see the support matrix at
http://www.ibm.com/support/docview.wss?uid=swg21386446. In the Agents,
Servers and GUI column, click the version of Tivoli Storage Productivity Center
that is installed on your system. On the next page, click Web Browsers to find the
web browsers that you can use.

The Tivoli Storage Productivity Center for Replication GUI provides a single point
of control to configure, manage, and monitor copy services. Whether you start it
on the server or on a remote system, the GUI is web-based and is displayed in a
browser.
1. On a server running the Windows operating system, click Start > Programs >

IBM Tivoli Storage Productivity Center > TPC Replication Manager GUI to
open a browser to the correct address. If you are not on a server running the
Windows operating system, start a web browser and enter the following
address in the address field. The address is case-sensitive.
https://hostname:port/CSM

In the preceding address, specify the following values:

hostname
The Tivoli Storage Productivity Center for Replication server. You can
specify the host name as an IP address or a Domain Name System (DNS)
name.

port
The port number for Tivoli Storage Productivity Center for Replication. The
default port number for connecting to Tivoli Storage Productivity Center
for Replication using the HTTPS protocol is 9559. However, this port
number might be different for your site. For example:
v If you upgraded from Tivoli Storage Productivity Center for Replication

version 3.3 or earlier, the default HTTPS port is 9443.
v If you upgraded from Tivoli Storage Productivity Center for Replication

version 3.4 or later, the default HTTPS port is 3443.
v If you are using IBM WebSphere Application Server for z/OS, the default

HTTPS port is 9443.
v If you are using IBM WebSphere Application Server OEM Edition for

z/OS, the default HTTPS port is 32209.

You can also find the port number in the install_root/eWAS/profiles/
profile_name/properties/portdef.props file. The default port for the HTTP
protocol is defined by the WC_defaulthost_secure property within the file.

2. From the Tivoli Storage Productivity Center for Replication logon page, type
your user name and password and click Login. The web-based Tivoli Storage
Productivity Center for Replication GUI opens in the browser.
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Starting the Tivoli Storage Productivity Center family of products
through Tivoli Integrated Portal

You can start the Tivoli Storage Productivity Center stand-alone GUI, the Tivoli
Storage Productivity Center web-based GUI, and the Tivoli Storage Productivity
Center for Replication web-based GUI within IBM Tivoli Integrated Portal. Tivoli
Integrated Portal provides the advantages of the single sign-on capability and
launch-in-context integration.

Before you start Tivoli Storage Productivity Center, ensure that you are using a
supported web browser. For a list of web browsers that you can use with Tivoli
Storage Productivity Center, see the support matrix at http://www.ibm.com/
support/docview.wss?uid=swg21386446. In the Agents, Servers and GUI column,
click the version of Tivoli Storage Productivity Center that is installed on your
system. On the next page, click Web Browsers to find the web browsers that you
can use.

These instructions assume that you have previously started the Tivoli Storage
Productivity Center stand-alone GUI, Tivoli Storage Productivity Center web-based
GUI, or the Tivoli Storage Productivity Center for Replication web-based GUI
outside of Tivoli Integrated Portal and that you already configured your system.
For example, to start the stand-alone Tivoli Storage Productivity Center GUI by
using Java Web Start, an IBM Java Runtime Environment 1.6.0 is required.

By logging on to Tivoli Integrated Portal, you eliminate the need to log on to Tivoli
Storage Productivity Center or any other Tivoli application that uses the common
portal framework. In addition to the convenience of single sign-on, Tivoli
Integrated Portal provides launch-in-context integration. By using these functions,
you can move between Tivoli Storage Productivity Center and another Tivoli
application at specific points within the other application interface.
1. Start a web browser and enter the following address in the address field:

http://hostname:port/ibm/console

In the preceding address, specify the following values:

hostname
The Tivoli Integrated Portal server. You can specify the host name as an IP
address or a Domain Name System (DNS) name.

port
The port number for Tivoli Integrated Portal. If you did not upgrade your
system from an earlier version of the product, the default port number for
connecting to Tivoli Integrated Portal using the HTTP protocol is 9568.
However, this port number might be different for your site. For example,
the port number might be different if you upgraded your system from an
earlier version of the product or if the default port range was not accepted
during installation. If the default port number does not work, see “Tivoli
Integrated Portal port numbers” on page 229 for alternative default ports.

You might be redirected from the address you enter to another address and
port that provides secure access using the HTTPS protocol. This page is the
Tivoli Integrated Portal logon page.

2. From the Tivoli Integrated Portal logon page, type your Tivoli Storage
Productivity Center ID and password and click Log in.

3. From the Tivoli Integrated Portal navigation tree, click Tivoli Storage
Productivity Center.
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4. From the Tivoli Storage Productivity Center portlets page, you can start the
Tivoli Storage Productivity Center stand-alone GUI, the Tivoli Storage
Productivity Center web-based GUI, or the Tivoli Storage Productivity Center
for Replication web-based GUI. Select one of the following options:
v Start the stand-alone GUI for Tivoli Storage Productivity Center.
v Start the web-based GUI for Tivoli Storage Productivity Center.
v Start the web-based GUI for Tivoli Storage Productivity Center for

Replication.
Related tasks:
“Starting the Tivoli Storage Productivity Center stand-alone GUI by using Java
Web Start” on page 175
Start the stand-alone Tivoli Storage Productivity Center GUI by using Java Web
Start to interact remotely with Tivoli Storage Productivity Center running on the
server.
“Starting the Tivoli Storage Productivity Center web-based GUI” on page 178
You can start the web-based Tivoli Storage Productivity Center GUI by opening a
web browser and entering a web address for the Tivoli Storage Productivity Center
logon page.
“Starting Tivoli Storage Productivity Center for Replication” on page 179
You can start the IBM Tivoli Storage Productivity Center for Replication GUI by
opening a web browser and entering a web address for the Tivoli Storage
Productivity Center for Replication logon page.

Overview of required user IDs for initial log on to the Tivoli Storage
Productivity Center family of products

All the graphical user interfaces (GUIs) in the Tivoli Storage Productivity Center
family require a user ID and password. If you are logging on to a GUI
immediately after you installed the software, the user ID that you must use differs
depending on the type of installation and the GUI interface.

Immediately after you install the software, you must use the user ID as described
in the following tables. After you log on, you can assign roles for users in Tivoli
Storage Productivity Center and Tivoli Storage Productivity Center for Replication.
When users log on, their user roles determine their authorization level and the
components that they can view in each GUI.

For example, if a user is in a group that is assigned to the Tivoli Storage
Productivity Center Superuser role, the user has full access to all Tivoli Storage
Productivity Center functions. However, if a user is in a group that is assigned to
the Tape Administrator role, the user has access to only tape-related functions.

Required user ID for initial log on after installation on a single
server when only the common user is defined

After you install the software on a single server, if you defined only the common
user, and did not define a separate user for Tivoli Integrated Portal and Tivoli
Common Reporting, the required user ID for initial log is the common user name
that was defined for the installation of Tivoli Storage Productivity Center.

You must use this user ID to log on to Tivoli Storage Productivity Center
stand-alone GUI, the Tivoli Storage Productivity Center web-based GUI, the Tivoli
Storage Productivity Center for Replication web-based GUI, or the Tivoli
Integrated Portal.
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Required user ID for initial log on after installation on a single
server when the common user and a separate user for Tivoli
Integrated Portal and Tivoli Common Reporting are defined

After you install the software on a single server if you defined a common user and
a separate user for Tivoli Integrated Portal and Tivoli Common Reporting, you
must use the user ID as described in the following table.

Table 31. Required user ID for initial log on after installation on a single server when the
common user and a separate user for Tivoli Integrated Portal and Tivoli Common Reporting
are defined

To log on to: Use this user ID:

Tivoli Storage Productivity Center
stand-alone GUI

The common user name that was defined for
the installation of Tivoli Storage Productivity
Center

Tivoli Storage Productivity Center
web-based GUI

The common user name that was defined for
the installation of Tivoli Storage Productivity
Center

Tivoli Storage Productivity Center for
Replication web-based GUI

The common user name that was defined for
the installation of Tivoli Storage Productivity
Center

Tivoli Integrated Portal The common user name that was defined for
the installation of Tivoli Integrated Portal
and Tivoli Common Reporting

Required user ID for initial log on after installation on multiple
servers with a remote database schema

After you install the software on multiple servers with a remote database schema,
you must use the user ID as described in the following table.

Table 32. Required user ID for initial log on after installation on multiple servers with a
remote database schema

To log on to: Use this user ID:

Tivoli Storage Productivity Center
stand-alone GUI

The user name that was defined for the
installation of Tivoli Storage Productivity
Center

Tivoli Storage Productivity Center
web-based GUI

The user name that was defined for the
installation of Tivoli Storage Productivity
Center

Tivoli Storage Productivity Center for
Replication web-based GUI

The user name that was defined for the
installation of Tivoli Storage Productivity
Center

Tivoli Integrated Portal The user name that was defined for the
installation Tivoli Integrated Portal and
Tivoli Common Reporting
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Required user ID for initial log on after installation on multiple
servers with remote Tivoli Integrated Portal and Tivoli Common
Reporting

After you install the software on multiple servers with remote Tivoli Integrated
Portal and Tivoli Common Reporting, you must use the user ID as described in the
following table.

Table 33. Required user ID for initial log on after installation on multiple servers with remote
Tivoli Integrated Portal and Tivoli Common Reporting

To log on to: Use this user ID:

Tivoli Storage Productivity Center
stand-alone GUI

The user name that was defined for the
installation of Tivoli Storage Productivity
Center. Because user authentication is
conducted on the server where Tivoli
Integrated Portal is installed, the user name
and user group must exist in the operating
system user and group registry on the Tivoli
Integrated Portal server.

Tivoli Storage Productivity Center
web-based GUI

The user name that was defined for the
installation Tivoli Integrated Portal and
Tivoli Common Reporting

Tivoli Storage Productivity Center for
Replication web-based GUI

The user name that was defined for the
installation of Tivoli Storage Productivity
Center. The Tivoli Storage Productivity
Center for Replication GUI detects only
users and groups that are in the operating
system user and group registry on the server
where Tivoli Integrated Portal is installed. To
provide access to a user or group in the
Tivoli Storage Productivity Center for
Replication GUI, the user or group must be
in the operating system user and group
registry on the Tivoli Integrated Portal
server.

Tivoli Integrated Portal The user name that was defined for the
installation of Tivoli Integrated Portal and
Tivoli Common Reporting

Administering DB2
Administer DB2 by backing up the IBM Tivoli Storage Productivity Center
database, starting the control center, and starting and stopping DB2.

Backing up the Tivoli Storage Productivity Center database
IBM Tivoli Storage Productivity Center uses circular logs for the DB2 database.
Therefore, only an offline database backup is supported. When an offline database
backup is performed, the database connections are terminated. Therefore, the Tivoli
Storage Productivity Center servers need to be stopped and then restarted.
1. Close the Tivoli Storage Productivity Center GUI.
2. Stop the Tivoli Storage Productivity Center servers.
3. Back up your database.

a. Open the DB2 Control Center.
b. The Control Center View panel is displayed. Select Basic and click OK.
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c. In the Control Center navigation tree, click All Databases.
d. Under the All Databases node, you see TPCDB. TPCDB is the IBM Tivoli

Storage Productivity Center database. Highlight TPCDB and right-click it.
Click Backup.

e. The Confirm the details of your database panel is displayed. Click Next.
f. The Specify where to store your backup image panel is displayed. For Media

Type, enter File System. If you want to add a new folder, click Add.
g. On the Path Browser - LOCALHOST panel, click the Create New Folder

icon. Enter the name of your new folder (for example, TPCbackup1). Click
OK.

h. On the Specify where to store your backup image panel, you see your new
folder listed (TPCbackup1). Click Finish. The database backup runs.

i. When the database backup is completed, you see a DB2 Message window
indicating that the database backup completed successfully.

j. Close the DB2 Message window.
4. Restart the Tivoli Storage Productivity Center servers.

If you want to do an online backup of the database, you need to change the use of
circular logs to linear logs. The use of linear logs can fill up the file system quickly
if the database is not maintained properly. For information about how to change
the use of circular logs to linear logs, see the DB2 Information Center. Click
Designing > Backups.

Starting the Control Center
This topic describes how to start the DB2 Control Center.

To start the Control Center, perform the following action:

On Linux operating systems:
From a console window, run the db2cc command.

On UNIX operating systems:
Open the IBM DB2 folder on the desktop and click Control Center.

On Windows operating systems:
Click Start > Programs > IBM DB2 > General Administration Tools >
Control Center

Using the command line on UNIX and Linux
This topic describes how to use a command line to perform actions against a DB2
instance under UNIX or Linux.

If the DB2 control center is unavailable or you do not have access to a graphical
user interface, you can use a command line to execute DB2 commands such as
starting and stopping an instance. To use a command line to perform actions
against an instance of DB2, complete the following steps:
1. Log in with a user ID or name that has ROOT, SYSADM, SYSCTRL, or

SYSMAINT authority on the instance; or log in as the instance owner.
2. Run the startup script:

v For Bourne or Korn shell, type: . HOME/sqllib/db2profile.
v For C shell, type: source HOME/sqllib/db2cshrc.

where HOME is the home directory of the instance you want to use.
3. To start the instance using the command line, type db2start.
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Note: When you run commands to start the database manager instance, the
DB2 database manager applies the command to the current instance.

4. To stop the instance using the command line, type db2stop.

Note: When you run commands to stop the database manager instance, the
DB2 database manager applies the command to the current instance.

Manually starting DB2 on Windows
This topic describes how to manually start DB2 on Windows.

To start DB2 manually, complete the following steps:
1. Start the following Windows services:

v DB2 - DB2-0
v DB2DAS - DB2DAS00
v DB2 JDBC Applet Server
v DB2 License Server
v DB2 Security Server

2. To open a DB2 command window, click Start > Programs > IBM DB2 >
Command Line Tools > Command Window.

3. From the DB2 Command window, run the db2start command.

Manually stopping DB2 on Windows
This topic describes how to manually stop DB2 on Windows.

To stop DB2 manually, complete the following steps:
1. Stop the following Windows services:

v DB2 Security Server
v DB2 License Server
v DB2 JDBC Applet Server
v DB2DAS - DB2DAS00
v DB2 - DB2-0

Note: When you stop the DB2 Security Server service, you are prompted to
stop the Warehouse logger and Warehouse Serve; click Yes.

2. To open a DB2 command window, click Start > Programs > IBM DB2 >
Command Line Tools > Command Window.

3. From the DB2 Command window, run the db2stop command.

To restart DB2, enter the db2start command from the DB2 Command window.
Before you can issue the command, you must first start these services from the
Windows Services panel:
DB2 - DB2-0
DB2DAS - DB2DAS00
DB2 JDBC Applet Server
DB2 License Server
DB2 Security Server

Monitoring DB2
The minimum user authority level needed for monitoring DB2 instances is a user
with DB2 system maintenance authority (SYSMAINT).
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To check and set SYSMAINT authority, follow these steps:
1. Run this command in the DB2 command prompt window to check to see if

there is an operating system user group defined to have SYSMAINT authority:
db2 get dbm cfg

In the output file, look for this information:
SYSADM group name (SYSADM_GROUP) =
SYSCTRL group name (SYSCTRL_GROUP) =
SYSMAINT group name (SYSMAINT_GROUP) =
SYSMON group name (SYSMON_GROUP) =

If the setup for the operating system group has not been done, you do not see
a value set.
If the setup has been done, this example shows what you can expect to see:
SYSADM group name (SYSADM_GROUP) =
SYSCTRL group name (SYSCTRL_GROUP) =
SYSMAINT group name (SYSMAINT_GROUP) = ADMINISTRATORS
SYSMON group name (SYSMON_GROUP) =

In this example, the "ADMINISTRATORS" group has SYSMAINT_GROUP
authority.

2. If the setup has been done, add the user you want to use to the
ADMINISTRATORS group using the operating system utilities or use a user
that already belongs to the ADMINISTRATORS group.
If you want to give a user group "SYSMAINT_GROUP" authority, follow these
steps:
a. If a user (for example userA) belongs to an operating system group called

db2monitor, here is an example of setting the db2monitor group with
SYSMAINT authority. From the DB2 command prompt window, run the
following command:
db2 update dbm cfg using SYSMAINT_GROUP db2monitor

b. After issuing the db2 update command, restart DB2 by running the
following command from the DB2 command prompt window or restarting
the system:
db2 force application all

This command might need to be issued a few times to stop all the database
connections.

c. Run the following commands from the DB2 command prompt window:
db2stop
db2start

d. UserA can now monitor the DB2 database.

Adding a Tivoli Storage Productivity Center user group name to Tivoli
Storage Productivity Center for Replication

To access Tivoli Storage Productivity Center for Replication using a user ID from
the Tivoli Storage Productivity Center user group name, you must add the user
group name to the Tivoli Storage Productivity Center for Replication
administrative role. If you installed Tivoli Storage Productivity Center with LDAP
authentication, you do not have to perform these steps.

Follow these steps:
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1. Log in to Tivoli Storage Productivity Center as the Superuser.
2. Expand Administrative Services > Configuration. Left-click Role-to-Group

Mappings. Locate the user group name that has the user ID you want for
logging in to Tivoli Storage Productivity Center and Tivoli Storage Productivity
Center for Replication.

3. Add the user group name to Tivoli Storage Productivity Center for Replication
Administrator role by using the Add Access wizard. Open Tivoli Storage
Productivity Center for Replication using a Tivoli Storage Productivity Center
for Replication Administrator user ID.

4. Click Add Access on the Administration page.
5. Add the user group name to Tivoli Storage Productivity Center for Replication

and complete the wizard.

Backing up and recovering all the Tivoli Storage Productivity Center
for Replication

There are three backup methods for IBM Tivoli Storage Productivity Center for
Replication. This section provides information about these methods.

The backup methods are:
v The first backup option is to use IBM Tivoli Storage Productivity Center for

Replication's import and export function to save the configuration of each IBM
Tivoli Storage Productivity Center for Replication session. You would export a
IBM Tivoli Storage Productivity Center for Replication session to a CSV file. The
CSV file can then be used to recover a IBM Tivoli Storage Productivity Center
for Replication session.

v The second backup option is to use IBM Tivoli Storage Productivity Center for
Replication's high availability function. This option allows IBM Tivoli Storage
Productivity Center for Replication to have a real time backup server that can
take over in the event of a disaster.

v The third backup option is to use the mkbackup command to create a backup
copy of the embedded database repository. This option does not work for DB2
databases. Any user on DB2 (z/OS or IBM Tivoli Storage Productivity Center for
Replication before version 4.2) will not be able to use the mkbackup command.

For information about the high availability function and configuring sessions and
copy sets, go to the Information Center at http://publib.boulder.ibm.com/
infocenter/tivihelp/v4r1/index.jsp.

Administering Tivoli Storage Productivity Center
Administer Tivoli Storage Productivity Center to authorize users, start the
graphical user interfaces, manage services, change passwords, and many other
administrative tasks.

Checking the Tivoli Storage Productivity Center version
Check the version of Tivoli Storage Productivity Center that is installed on your
system.

To check the version of Tivoli Storage Productivity Center that you have installed,
open the version.txt file that is in the following directory:

For Windows operating systems:
C:\Program Files\IBM\TPC
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For UNIX or Linux operating systems:
usr or opt/IBM/TPC

This is an example of the information in the version.txt file:
TPC V5.1.0.0 Build 20120501-2311

Viewing and managing services
This topic describes viewing and managing services for Data server and Device
server.

Data Server services
Data Server directs all monitoring operations. Data Server services include the
various services that run in the IBM Tivoli Storage Productivity Center for Data
Server component.

The Data Server is the control point for scheduling functions, configuration, event
management, reporting, and GUI support. The Data Server directs all of the
activities related to the monitoring performed on computers with agents installed
and the reporting performed on the client GUI computers.

When you expand the Data Server node, five nodes appear which represent the
running services within the server. Select any of the following nodes to display
information on the server identification, run time statistics, requests processed,
database information, and agent statistics:

Server The component that provides the functionality of the Data Server. The
Server, sometimes called Data Server, provides monitoring functions for
services, data, and facilities to the network.

Scheduler
The Scheduler is the process that receives requests to schedule operations,
such as the running of scheduled pings, probes, and scans. It is a
multithread background server process designed to handle the scheduling
and launching of jobs, based on a simple timing scheme.

GUI The main graphical user interface that enables you to do monitoring
operations, such as generate reports, check the status of agents, create and
run jobs, setup monitoring for the Data Server, and so forth.

Device
Converts general commands for peripheral devices and passes them
between the Server and the device. Defines I/O devices to the operating
system and then controls the operation of these devices.

Agent The process on the server that sends and receives requests from agents for
information gathering or processing. Agents can perform specific
operations, such as scans or probes, on a regular schedule.

With Data Server services you can perform the following tasks:
v View a Data Server service log
v Configure tracing on a service
v Shut down a service
v Restart a service that is inactive

Additionally, through the Server service you can do the following:
v Configure audit logging
v Broadcast name and port information
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To view the status of the server and services, expand Administrative Services >
Services > Data Server. A green box icon next to the name of a service (for
example, Scheduler) means that the service is active and running normally. If the
service is not currently active, a red circle icon is displayed next to the name.

Refresh the Data Server list

To refresh the Data Server list, complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Services.
2. Right-click Data Server, and click Refresh.

Viewing Data Server information with the Server service:

The Server service directs all Data Server information. You can view information
about the Server service, including the name and port, disk space, connections,
requests, and agent information.

To view Data Server information, complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Data Server.
2. Click Server. In the content pane, the Server service page opens displaying the

following information:

Server Displays the name of the server.

Port Displays the port number on which the server is listening to agents.

Start Time
Displays the date and time when the server was started.

Elapsed Time
Displays the elapsed time when the server was last updated.

VM Size
Displays the disk space allocated to the virtual memory size of the
server.

Network Connections
Displays the number of networks to which the server is connected.

Maximum Connections
Displays the maximum number of networks to which the server can
connect.

Pending Requests
Displays the number of outstanding requests waiting for server
response.

Processed Requests
Displays the number of requests processed by the server.

Database
The following fields display information about the Data Manager's
repository database.

JDBC URL
Displays the location of the JDBC file used to connect to the
database.
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JDBC Driver
Displays the name of the JDBC driver used to connect to the
database.

DB Connections
Displays the number of connections to the database.

DB Pool Count
Displays the database pool count.

Agents
The following fields provide information about the status of Data
Manager agents.

Total The number of agents that are installed.

Online
The number of agents that are currently online (communicating
with the server).

Offline
The number of agents that are currently offline (not
communicating with the server, but were shut down normally).

Unreachable
The number of agents that are 1) not communicating with the
server, and 2) provided no information to the server that they
were shutting down.

Upgrading
The number of agents that are currently in the process of
upgrading to the same version as the server.

Upgrade Required
The number of agents that must be upgraded to the same
version as the server.

Viewing information about Data Server services:

Select any of the Data Server services to display information on that services'
identification, run time statistics, requests processed, database information, and
agent statistics.

To display information about a service, complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Data Server.
2. Click one of the following services:

Scheduler
Controls the running of scheduled pings, probes, and scans.

GUI Enables you to generate report requests and to create and run jobs.

Device
Converts commands for peripheral devices.

Agent Sends and receives requests from agents.
3. In the content pane, the following information about the selected Data server

service is displayed:

Service
Whether the service is active or down.
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Pending Requests
Number of requests waiting to be processed by the scheduler for the
current session.

Processed Requests
Number of requests processed by the scheduler for the current session.

Idle Threads
Number of threads waiting for a process request.

Viewing a Data Server service log:

Use the content of a service log file to troubleshoot any errors that might occur
during startup, processing, or shutdown of the Data Server service.

To display a service log, complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Data Server.
2. Right-click the name of the service and click View Log. The service log will

open in the content pane.

Service alerts, if any, are displayed in red.

Logs are searchable by search string. Enter the string in the field provided and
click the up or down arrow to search.

Configuring tracing for Data Server services:

Configure tracing for the Scheduler, GUI, Device, and Agent services by setting the
debug level. Tracing changes can only be made by users with administrator
authority.

To configure tracing for the Scheduler, GUI, Device, and Agent services, complete
the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Data Server.
2. Right-click the name of the service and click Configure Tracing.
3. In the Server Tracing Configuration window, check the Enable Trace box to

enable tracing for the service. If this box is unchecked, tracing will not be
performed.

4. Once tracing has been enabled, select the level of debugging you want to
perform. You can select one of the following:
v DEBUG_MIN - Provides minimal information on errors. This is the default

value.
v DEBUG_MID - Provides more information on errors.
v DEBUG_MAX - Lists all debugging trace information.

5. Click OK.

Tracing can be turned off by de-selecting the Enable Trace option in the Server
Tracing Configuration window.

Configuring audit logging for the Server:

Use audit logging to record a history of user actions. This function is available for
the Server only.
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To configure audit logging, complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Data Server.
2. Right-click the Server node and click Configure Audit Logging. The Server

Audit Logging Configuration window opens.
3. In the Server Audit Logging Configuration window, check the Enable Trace

check box to enable tracing for the server component. If this box is unchecked,
tracing will not be performed.

4. Specify the audit logging options:

Maximum Number of Files
Select the maximum number of trace files that will be created. When
the maximum number of files has been reached, tracing will rollover
and start writing to the first file. (default is 5)

The value in this field also applies to the other services for which
tracing is enabled.

Maximum File Size (kilobytes)
Select the maximum size of each log file. When the current trace file
has reached its maximum capacity, tracing will continue to the next
available trace file as defined in the Maximum Number of Files field.
(default is 20 MB).

The value in this field also applies to the other services for which
tracing is enabled.

5. Click OK.

Broadcasting the Data Server location:

Use broadcasting to inform agents of the Data Server location. Broadcasting is
available with the Server service only.

Broadcasting informs agents of the server location

To broadcast the Data Server location, complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Data Server.
2. Right-click the Server node and click Broadcast.

Shutting down a Data Server service:

Shut down the active process or processes associated with a service (for example,
processes on the server that receive requests from the scheduler). If you shut down
a service, you must restart it before the server will resume receiving requests from
it.

To shut down a running service, complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Data Server.
2. Right-click the name of the service and click Shutdown.
3. Select one of the following shutdown methods:

Normal
Let all running and scheduled processes complete and then shut down
cleanly. During this shutdown process, new jobs are allowed to run if
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they were scheduled during the time that the shutdown is taking place.
Once all jobs have completed and no more jobs are scheduled to start
during the shutdown time, the service will be shut down.

Immediate
Let all running processes complete but not allow scheduled jobs to
start. During this shutdown process, new jobs are not allowed to start if
they were scheduled during the time that the shutdown is taking place.
Once all running jobs have completed, the service will be shut down.

Abort Stops whatever processes are currently running and then shuts down
the service.

Starting a Data Server service:

Reactivate a service after it has been stopped. The start action is available only for
services that are not running.

To start a service, complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Data Server.
2. Right-click the name of the service and click Start.

Configuring tracing
Configure tracing for the Data server, agent, scheduler, Device server, and GUI by
setting the debug level and log file characteristics. The level of information saved
in a log file is determined by the tracing level. Tracing settings can only be
changed by users with administrator authority.

To configure tracing for IBM Tivoli Storage Productivity Center, complete the
following steps:
1. In the navigation tree pane, expand Administrative Services > Services > Data

Server.
2. Right-click on one of the following components:

v Server
v Agent
v Scheduler
v Device
v GUI

Click Configure Tracing.
3. In the Server Tracing Configuration window, check the Enable Trace check box.

Specify additional tracing options:

Level Select the level of debugging you want to perform. Select one of the
following debugging level:

DEBUG_MIN
Provides minimal information about errors. This option is the
default value.

DEBUG_MID
Provides more information about errors.

DEBUG_MAX
Lists all debugging trace information.
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Maximum number of files
Select the maximum number of trace files that is created. When the
maximum number of files has been reached, tracing rolls over and start
writing to the first file. (default is five)

The value in this field also applies to the other services for the Data
server for which tracing is enabled.

Maximum File Size (kilobytes)
Select the maximum size of each log file. When the current trace file
has reached its maximum capacity, tracing continues to the next
available trace file as defined in the Maximum Number of Files field.
(default is 20 MB).

4. Click OK.

Tracing can be turned off by clearing the Enable Trace option in the Server Tracing
Configuration window.

Device server services
A Device server node is present in the Navigation Tree pane only if a device
server is deployed in IBM Tivoli Storage Productivity Center your environment.

In the Navigation Tree pane, expand Administrative Services > Services > Device
server to display a list of the services associated with the Device server. The
following services are displayed:

Device server
Detects all the operations of the Device server.

SAN Planner
Monitors the SAN planning tools.

Event Service that monitors external events.

Log Service for configuring logging and tracing.

Configuration Analysis and History
Monitors the SAN configuration tools.

Control
Service that provides control functions.

Fabric Manager
Service that provides fabric management functions.

Disk Manager
Service that provides storage subsystem management functions.

Inband Agent
Service that maintains the list of in-band Fabric agents.

Disk Monitor
Service that monitors the storage subsystems.

Out of Band Agent
Service that maintains the list of out-of-band Fabric agents.

Element Manager
Service that provides ability to manage element managers.

Performance
Service that monitors device performance.
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Configuration
Service for configuring Device server properties.

Discovery
Service that provides discovery and probe functions.

Tape Manager
Service that provides tape management functions.

Message
Service that provides internal messaging functions.

Data Access functions
Service providing data access and control functions.

Data Server Monitor
Service that provides Data server monitoring functions.

Service Manager
Service that manages the other services.

Server Virtualization Management Service
Service providing server virtualization management functions.

Device server Monitor
Service that provides Device server monitoring functions.

A green box icon next to a service name means that the service is active and
running normally. If the service is not currently active, a red circle icon displays
next to the name.

Changing the Device server password:

This section provides information about changing the Device server password.

To change the password, follow this procedure:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Device server.
2. Right-click the Device server node and select Change Password.
3. In the Change Password window, type the name of the new password twice

and click OK.

Displaying information about a Device server service
You can view service information including start time, version, and status.

To display information about a service, follow this procedure:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Device server.
2. Click the name of the service.

Viewing a Device server log
You can use the content of the log file to troubleshoot any errors that might occur
during startup, processing or shut down. Service alerts, if any, are displayed in red.

To display the log of a service, follow this procedure:
1. In the Navigation Tree pane, expand Administrative Services > Services >

Device server.
2. Right-click the name of the service and select View Log.
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Starting and stopping the Tivoli Storage Productivity Center
services

This section provides information about how to start and stop the IBM Tivoli
Storage Productivity Center services.

Note: The IBM Tivoli Integrated Portal server starts automatically after you reboot
the system or after a temporary power loss on Windows. The IBM Tivoli
Integrated Portal server does not start automatically on AIX or Linux; you must
manually start the server.

Stopping the IBM Tivoli Storage Productivity Center services
This topic describes how to stop the IBM Tivoli Storage Productivity Center
services.

Stopping the services on Windows

To stop the services on Windows, click Start > Control Panel > Administrative
Tools > Services. Stop the following services:

IBM WebSphere Application Server V8.0 - TPCDeviceServer

IBM Tivoli Storage Productivity Center - Data Server

IBM Storage Resource Agent - directory
where directory is where the Storage Resource agent is installed. The
default directory is c:\Program Files\IBM\TPC\agent.

IBM WebSphere Application Server V8.0 - TPCReplicationServer

Tivoli Integrated Portal - V2.2_TIPProfile_Port_xxxx
where xxxxx indicates the port specified during installation.

IBM Cognos Content Database

Stopping the services on Linux

To stop the services on Linux, go to a command prompt window and enter the
following commands:

Data server
/TPC_install_directory/data/server/tpcdsrv1 stop

The default directory is /opt/IBM/TPC.

Device server
/TPC_install_directory/device/bin/linux/stopTPCF.sh

The default directory is /opt/IBM/TPC.

Storage Resource agent
/SRA_install_directory/agent/bin/agent.sh stop

The default directory is /opt/IBM/TPC.

IBM WebSphere Application Server V8.0 - TPCReplicationServer
/opt/IBM/TPC/ewas/profiles/ReplicationServerProfile/bin/stopServer.sh
replicationServer

Tivoli Integrated Portal
/tip_install_directory/profiles/TIPProfile/bin/stopServer.sh server1
-username user name -password password

The tip_install_directory default value is /opt/IBM/tipv2.
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IBM Cognos Content Database service (Tivoli Common Reporting)
/tcr_install_directory/bin/stopTCRserver.sh server1 username
password

The tcr_install_directory default value is /opt/IBM/tipv2Components/
TCRComponent.

Remember: When you start the Tivoli Common Reporting server, the Tivoli
Integrated Portal server also starts.

Stopping the services on AIX

To stop the services on AIX, go to the command prompt window and enter the
following commands:

Data server
/TPC_install_directory/data/server/tpcdsrv1 stop

Device server
/TPC_install_directory/device/bin/aix/stopTPCF.sh

The default directory is /opt/IBM/TPC.

Storage Resource agent
/SRA_install_directory/agent/bin/agent.sh stop

The default directory is /opt/IBM/TPC.

IBM WebSphere Application Server V8.0 - TPCReplicationServer
/usr_or_opt/IBM/TPC/ewas/profiles/ReplicationServerProfile
/bin/stopServer.sh replicationServer

Tivoli Integrated Portal
/tip_install_directory/profiles/TIPProfile/bin/stopServer.sh server1
-username username -password password

IBM Cognos Content Database service (Tivoli Common Reporting)
/tcr_install_directory/bin/stopTCRserver.sh server1 username password

Starting the Tivoli Storage Productivity Center services
This topic describes how to start the Tivoli Storage Productivity Center services.

Starting the services on Windows

To start the services on Windows, click Start > Control Panel > Administrative
Tools > Services. Start the following services:

IBM WebSphere Application Server V8.0 - TPCDeviceServer

IBM Tivoli Storage Productivity Center - Data Server

IBM Storage Resource Agent - directory
where directory is where the Storage Resource agent is installed. The
default directory is c:\Program Files\IBM\TPC\agent.

IBM WebSphere Application Server V8.0 - TPCReplicationServer

Tivoli Integrated Portal - V2.2_TIPProfile_Port_xxxx
where xxxxx indicates the port specified during installation.

IBM Cognos Content Database
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Starting the services on Linux

To start the services on Linux, go to a command prompt window and enter the
following commands:

Data server
/TPC_install_directory/data/server/tpcdsrv1 start

The default directory is /opt/IBM/TPC.

Device server
/TPC_install_directory/device/bin/linux/startTPCF.sh

The default directory is /opt/IBM/TPC.

Storage Resource agent
/SRA_install_directory/agent/bin/agent.sh start

The default directory is /opt/IBM/TPC.

IBM WebSphere Application Server V8.0 - TPCReplicationServer
/opt/IBM/TPC/ewas/profiles/ReplicationServerProfile/bin/startServer.sh
replicationServer

Tivoli Integrated Portal
/tip_install_directory/profiles/TIPProfile/bin/startServer.sh server1

The tip_install_directory default value is /opt/IBM/tipv2.

IBM Cognos Content Database service (Tivoli Common Reporting)
/tcr_install_directory/bin/startTCRserver.sh server1

The tcr_install_directory default value is /opt/IBM/tipv2Components/
TCRComponent.

Remember: When you start the Tivoli Common Reporting server, the Tivoli
Integrated Portal server also starts.

Starting the services on AIX

To start the services on AIX, go to the command prompt window and enter the
following commands:

Data server
/TPC_install_directory/data/server/tpcdsrv1 start

Device server
/TPC_install_directory/device/bin/aix/startTPCF.sh

The default directory is /opt/IBM/TPC.

Storage Resource agent
/SRA_install_directory/agent/bin/agent.sh start

The default directory is /opt/IBM/TPC.

IBM WebSphere Application Server V8.0 - TPCReplicationServer
/opt/IBM/TPC/ewas/profiles/ReplicationServerProfile/bin/startServer.sh
replicationServer

Tivoli Integrated Portal
/tip_install_directory/profiles/TIPProfile/bin/startServer.sh server1

The tip_install_directory default value is /opt/IBM/tipv2.
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IBM Cognos Content Database Service (Tivoli Common Reporting)
/tcr_install_directory/bin/startTCRserver.sh server1

The tcr_install_directory default value is /opt/IBM/tipv2Components/
TCRComponent.

Remember: When you start the Tivoli Common Reporting server, the
Tivoli Integrated Portal server also starts.

Starting and stopping the Tivoli Integrated Portal server
The IBM Tivoli Integrated Portal server starts automatically after you reboot the
system or after a temporary power loss on Windows. The server does not start
automatically on AIX or Linux; you must manually start Tivoli Integrated Portal
and Tivoli Common Reporting. You can manually stop and start Tivoli Integrated
Portal and Tivoli Common Reporting before beginning certain configuration tasks
or as needed.

Perform the following steps at the command prompt:
1. Change to the following directory:

For Windows:
cd c:\program files\IBM\tipv2Components\TCRComponent\bin

For AIX or Linux:
cd /opt/IBM/tipv2Components/TCRComponent/bin

2. To stop Tivoli Integrated Portal and Tivoli Common Reporting, enter the
following command:
For Windows:
stopTCRserver.sh server1 username password

For AIX or Linux:
stopTCRserver.sh server1 username password

Wait for the operation to complete.
3. To start Tivoli Integrated Portal and Tivoli Common Reporting, enter the

following command:
For Windows:
startTCRserver.cmd server1

For AIX or Linux:
startTCRserver.sh server1

Wait for the operation to complete.

Tip: For Windows, you can also stop and start the services by clicking Start >
Control Panel > Administrative Tools > Services. Stop or start the following
services:
v Tivoli Integrated Portal - V2.2_TIPProfile_Port_port_number, where port_number

indicates the port specified during installation
v IBM Cognos Content Database

Checking Tivoli Storage Productivity Center status
This section provides information on checking the status of Tivoli Storage
Productivity Center.
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Checking the status of the Data Server
This topic describes how to check the status of the Data server.

To check the status of the Data Server, complete the following steps:
1. Open the IBM Tivoli Storage Productivity Center graphical user interface (GUI).
2. In the navigation tree, click Administrative Services > Services > Data Server.

A status icon is displayed in the navigation tree for each service.

Checking the status of the Device server
This topic describes how to check the status of the Device server.

To check the status of the Device server, complete the following steps:
1. Open the IBM Tivoli Storage Productivity Center graphical user interface (GUI).
2. In the navigation tree, click Administrative Services > Services > Device

server. A status icon is displayed in the navigation tree for each service.

Checking the status of agents
This topic describes how to check the status of the agents.

In the navigation tree, expand Administrative Services > Data Sources. Click on
one of the following nodes:
v CIMOM Agents
v Data/Storage Resource Agents
v Inband Fabric Agents
v Out of Band Fabric Agents

In the content pane, a list of agents is displayed. If the agents are up and running,
there will be a green health status icon in the State column. For CIMOM Agents,
there will be a green health status icon in the Connection Status column.

If the status icon is red, you can view the log by selecting an agent and click View
Log for Data, Native, and Inband Fabric. This action displays the log in the content
pane. If the reason that an agent is down is a connectivity problem, you might not
be able to get the log files. A given discovered CIMOM appears as a red (critical)
icon status until you enter valid credentials.

Increasing memory allocation
If you run out of memory for the Data server, Device server, or agent, you might
want to increase the memory allocated for these components. This section describes
how to increase the memory allocated for these components on systems running
AIX, Linux, and Windows.

Increasing the memory allocation for the Data server
If you run out of memory for the Data server, you might want to increase the
memory allocated for the Data server. This section describes how to increase the
memory allocated for the Data server on systems running AIX, Linux, and
Windows.

Increasing the memory allocation for the Data server running on AIX:

This section describes how to increase the memory allocation for the Data server
running on AIX.

To increase the memory allocated for the Data server running on AIX, complete the
following steps:
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1. Log in as a user with root authority.
2. To stop the Data Server, from the command prompt, run the following

command:
/opt/IBM/TPC/data/server/tpcdsrv1 stop

3. Using a text editor, open the tpcdsrv1 file.
4. Locate the following line:

exec $JAVAEXE -Dsun.net.inetaddr.ttl=300 -Xrs -Xmx XXXXm
-cp $CLASSPATH com.tivoli.itsrm.server.Server &

where XXXm is the memory allocated for the Data server. By default, this is
1024m (1024 MB).

5. Increase the memory allocated for the Data server. For example, to increase the
memory to 1536 MB, change the line to read as follows:
exec $JAVAEXE -Dsun.net.inetaddr.ttl=300 -Xrs -Xmx1536m
-cp $CLASSPATH com.tivoli.itsrm.server.Server &

6. Save the modified tpcdsrv1 file.
7. To restart the Data server, run the following command:

/opt/IBM/TPC/data/server/tpcdsrv1 start

Increasing the memory allocation for the Data server running on UNIX or
Linux:

This section describes how to increase the memory allocation for the Data server
running on Linux.

To increase the memory allocated for the Data server running on HP-UX, Linux, or
Solaris, complete the following steps:
1. Log in as a user with root authority.
2. To stop the Data Server, from the command prompt, run the following

command:
/opt/IBM/TPC/data/server/tpcdsrv1 stop

3. Using a text editor, open the tpcdsrv1 file.
4. Locate the following line:

exec $JAVAEXE -Dsun.net.inetaddr.ttl=300 -Xrs -Xmx XXXXm
-cp $CLASSPATH com.tivoli.itsrm.server.Server &

where XXXm is the memory allocated for the Data server. By default, this is
1024m (1024 MB).

5. Increase the memory allocated for the Data server. For example, to increase the
memory to 1536 MB, change the line to read as follows:
exec $JAVAEXE -Dsun.net.inetaddr.ttl=300 -Xrs -Xmx1536m
-cp $CLASSPATH com.tivoli.itsrm.server.Server &

6. Save the modified tpcdsrv1 file.
7. To restart the Data server, run the following command:

/opt/IBM/TPC/data/server/tpcdsrv1 start

Increasing memory allocation for Data server running on Windows:

This section describes how to increase the memory allocation for the Data server
running on Windows.
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To increase the amount of memory available to the server, complete the following
steps:
1. Select Start > Run. The Run window is displayed.
2. Type regedit in the Open: field and click OK. The Registry Editor window is

displayed.
3. Expand the HKEY_LOCAL_MACHINE > SOFTWARE > IBM > TSRM folder

on the left-hand side of the Registry Editor window.
4. Right-click the 1 folder and select New > String Value from the pop-up menu.
5. Type SRVJPARMS as the name of the string.
6. Right-click the name of the string and select Modify from the pop-up menu.
7. Enter -Xmx<###>m in the Value data field, where ### represents the number of

megabytes for the server's maximum heap size. The default size is 256. Click
OK. The largest possible value for the maximum heap size is 1536 megabytes.
If the value is set to something larger than 1536, that value will be ignored and
1536 megabytes will be used as the maximum heap size.

8. Stop and restart the server to have the changes take effect. To stop the server,
complete the following steps:
a. Go to Start > Settings > Control Panel > Administrative Tools > Services.

The Services window is displayed.
b. Right-click on IBM Tivoli Storage Productivity Center - Data Server

service and click Stop from the pop-up menu. To restart the server,
complete the following steps:
1) Go to Start > Settings > Control Panel > Administrative Tools >

Services. The Services window is displayed.
2) Right-click on Tivoli Storage Productivity Center - Data Server service

and click Start from the pop-up menu.

Increasing the memory allocation for the Device server
This topic describes how to increase the memory allocated for the Device server.
1. Stop the Device server.
2. Open the server.xml file in a text editor. This file is located at

directory/ewas/profiles/DeviceServerProfile/config/cells/DeviceServerCell/nodes/
DeviceServerNode/servers/deviceServer

where directory is where IBM Tivoli Storage Productivity Center is installed.
3. Search for JVMArguments and change the value of the -Xmx1436m parameter.
4. Save the modified server.xml file.
5. Restart the Device server.

Setting timeouts values for the Device server
If a probe or discovery of a storage subsystem times out before the operation
completes, you can increase the timeout values for the Device server.

If a probe or discovery of a storage subsystem times out before the operation
completes, you receive the following error message:
HWN021650E Encountered timeout while connecting to CIMOM IP:port.
Check the CIMOM or increase timeout value.
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where IP is the IP address, and port is the port number. If you determine that the
Common Information Model Object Manager (CIMOM) is not the cause of the
problem, you can use the command-line interface (CLI) to increase the timeout
values for the Device server.

For those storage systems that use native interfaces to connect to Tivoli Storage
Productivity Center you see this error message:
HWN020103E The external process exceeded the timeout limit and was cancelled.

The following storage systems use native interfaces to connect to Tivoli Storage
Productivity Center:
v System Storage DS8000
v SAN Volume Controller
v The XIV system
v Storwize V7000
v Storwize V7000 Unified
v IBM SONAS
1. Run the getdscfg command to determine the current values of the timeout

properties. From the command prompt, enter the following command:
cli>tpctool getdscfg -user user -pwd password -url host:port
-property timeout_property timeout_value

where:
v user is an IBM Tivoli Storage Productivity Center user ID.
v password is the password for the Tivoli Storage Productivity Center user ID.
v host is the host name or IP address, and port is a valid port number for the

HTTP service of the Device server. The default value for port is typically
9550.

v timeout_property is one of the following strings:
– http.timeout
– CIMClientWrapper.Timeout
– Probe.Timeout.Array
– Probe.Timeout.InBand
– Probe.Timeout.LMM
– Discovery.Timeout
– CIMOMManager.TestConnectionTimeout
For the storage systems that use the native interface, the timeout_property
strings are:
– NAPI.Timeout.TestConnection
– NAPI.Timeout.Probe
– NAPI.Timeout.EventPoll

v timeout_value is the value for the timeout.

.
2. Run the setdscfg command to increase the timeout value. Run the following

command:
cli>tpctool setdscfg -user user -pwd password -url host:port
-property timeout_property timeout_value
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For more information about tpctool, see the Tivoli Storage Productivity Center
Command-Line Interface Reference. You also can view help from the command line by
issuing the command with the -help option.

Changing passwords
This section provides information about changing passwords.

If you installed IBM Tivoli Storage Productivity Center using the typical
installation and used the same DB2 user ID and password for the items IBM Tivoli
Storage Productivity Center requires, then when you change the DB2 password,
you must also change the passwords for the items that the DB2 password applies
to. For example, the DB2 administrative password might also apply to the
following items:
v Database administration user ID and password (for the Data Server or Device

server to connect to the database)
v Database user ID and password to create the database schema
v Host authentication password (for the Storage Resource agents to communicate

with the Device server)
v Storage Resource agent service login user ID and password (for Windows only,

if this user ID does not exist)
v WebSphere administration user ID and password (for the Device server to

communicate with embedded WebSphere if the user ID does not exist). This is
the case only if you select OS authentication during the IBM Tivoli Storage
Productivity Center installation. If you chose LDAP authentication, then the
WebSphere administration user ID and password are set to the LDAP TPC
Administrator username and password.

Changing passwords using the password tool
The password tool changes the passwords for DB2, Tivoli Storage Productivity
Center, and IBM Tivoli Integrated Portal so that they can continue to authenticate
to one another whenever you change a password.

Single server installation where components use the same logon credentials:

Use the password tool to change the password for DB2, Tivoli Storage Productivity
Center, and IBM Tivoli Integrated Portal when they are installed on the same
server, and use the same user name and password.

Before you use the password tool, ensure that you know the existing password or
passwords that you want to change.
1. Complete the following steps:

For Windows operating systems where Tivoli Storage Productivity Center is
configured for OS authentication:

a. From the desktop, click Start > Control Panel.
b. Double-click User Accounts.
c. Click Change your password.
d. Enter the current password, and then enter and confirm the new

password. Click Change password. Close the User Accounts
window.

For AIX or Linux operating systems where Tivoli Storage Productivity Center
is configured for OS authentication:

Log in with the DB2 user ID, and run the passwd command.
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Tip: To change other user credentials, run the passwd username
command.

Tip: To find out how to change the LDAP user password, refer to your LDAP
server documentation.

2. Open a command prompt window and change the directory to the following
default directory:

On Windows operating systems:
C:\Program Files\IBM\TPC\service

On Linux or UNIX operating systems:
/opt/IBM/TPC/service

3. Start the password tool by running the following program:

On Windows operating systems:
changepasswords.bat

On Linux or AIX operating systems:
changepasswords.sh

4. From the "Choose the password to change" window, click Change Tivoli
Integrated Portal password and click OK.

5. Complete the following steps:
a. Enter and confirm the new password, ensuring that it is the same as the

new password that you entered in step 1.
b. Ensure that the Restart servers option is selected. Click OK.
c. In response to the following message, click Yes:

Are you sure you want to change the password?

d. When the process is completed, click Back to Main.
6. To change the password for Tivoli Storage Productivity Center, click Change

Tivoli Storage Productivity Center server and DB2 passwords and click OK.
a. Enter and confirm the new password, ensuring that it is the same as the

new password that you entered in step 1. Click OK.
b. In response to the following message, click Yes:

Are you sure you want to change the password?

Tip: After you click Yes, if the DB2 servers are already started, the
following errors might be displayed in a command prompt window. Ignore
them and continue with the procedure.
Changing DB2 User password for Data Server...
Changing DB2 User password for Device Server...
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5

c. When the process is completed, click Back to Main.

Tip: To verify that the password changes were completed successfully,
review the PWTool.log file that is in the TPC_installation_directory\
service directory, where TPC_installation_directory is the directory where
Tivoli Storage Productivity Center is installed.

7. Exit the password tool.
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Related tasks:
“Single server installation where components use different logon credentials”
Use the password tool to change the passwords for DB2, Tivoli Storage
Productivity Center, and IBM Tivoli Integrated Portal when they are installed on
the same server, but use different user names and passwords.
“Multiple server installation where Tivoli Integrated Portal is remote” on page 208
Change the passwords for DB2, Tivoli Storage Productivity Center, and IBM Tivoli
Integrated Portal when they are installed on two servers, with Tivoli Integrated
Portal on server A, and DB2 and Tivoli Storage Productivity Center on server B.
“Multiple server installation where DB2 is remote” on page 210
Change the passwords for DB2, Tivoli Storage Productivity Center, and IBM Tivoli
Integrated Portal when they are installed on two servers, with Tivoli Integrated
Portal and Tivoli Storage Productivity Center on server A, and DB2 on server B.

Single server installation where components use different logon credentials:

Use the password tool to change the passwords for DB2, Tivoli Storage
Productivity Center, and IBM Tivoli Integrated Portal when they are installed on
the same server, but use different user names and passwords.

Before you use the password tool, ensure that you know the existing password or
passwords that you want to change.
1. Complete the following steps:

On Windows operating systems where Tivoli Storage Productivity Center is
configured for OS authentication:

a. From the desktop, click Start > Control Panel.
b. Double-click User Accounts.
c. Click Change your password.
d. Enter the current password, and then enter and confirm the new

password. Click Change password. Close the User Accounts
window.

On AIX or Linux operating systems where Tivoli Storage Productivity Center
is configured for OS authentication:

When you are logged in with the DB2 user ID, run the passwd
command. To change other user credentials, run the passwd username
command.

Tip: To find out how to change the LDAP user password, refer to your LDAP
server documentation.

2. Open a command prompt window and change the directory to the following
default directory:

On Windows operating systems:
C:\Program Files\IBM\TPC\service

On Linux or UNIX operating systems:
/opt/IBM/TPC/service

3. Start the password tool by running the following program:

On Windows operating systems:
changepasswords.bat

On Linux or AIX operating systems:
changepasswords.sh
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4. From the “Choose the password to change” window, click Change Tivoli
Integrated Portal password and click OK.

5. To change the password, complete the following steps:
a. Enter and confirm the new password and click OK.
b. In response to the following message, click Yes:

Are you sure you want to change the password?

c. When the process is completed, click Back to Main.
6. To change the password for Tivoli Storage Productivity Center, click Change

Tivoli Storage Productivity Center server passwords and click OK.
7. Complete the following steps:

a. Enter and confirm the new password and click OK.
b. In response to the following message, click Yes:

Are you sure you want to change the password?

c. When the process is completed, click Back to Main.
8. To change the password for DB2, click Change DB2 password and click OK.
9. Complete the following steps:

a. Enter and confirm the new password. Ensure that the Restart servers check
box is selected and click OK.

b. In response to the following message, click Yes:
Are you sure you want to change the password?

Tip: After you click Yes, if the DB2 servers are already started, the
following errors might be displayed in a command prompt window. Ignore
them and continue with the procedure.
Changing DB2 User password for Data Server...
Changing DB2 User password for Device Server...
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5

c. When the process is completed, click Back to Main.

Tip: To verify that the password changes were completed successfully,
review the PWTool.log file that is in the TPC_installation_directory\
service directory, where TPC_installation_directory is the directory where
Tivoli Storage Productivity Center is installed.

Important: For Windows operating systems, if Tivoli Integrated Portal fails to
stop and restart, restart your system manually.
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Related tasks:
“Single server installation where components use the same logon credentials” on
page 204
Use the password tool to change the password for DB2, Tivoli Storage Productivity
Center, and IBM Tivoli Integrated Portal when they are installed on the same
server, and use the same user name and password.
“Multiple server installation where Tivoli Integrated Portal is remote”
Change the passwords for DB2, Tivoli Storage Productivity Center, and IBM Tivoli
Integrated Portal when they are installed on two servers, with Tivoli Integrated
Portal on server A, and DB2 and Tivoli Storage Productivity Center on server B.
“Multiple server installation where DB2 is remote” on page 210
Change the passwords for DB2, Tivoli Storage Productivity Center, and IBM Tivoli
Integrated Portal when they are installed on two servers, with Tivoli Integrated
Portal and Tivoli Storage Productivity Center on server A, and DB2 on server B.

Multiple server installation where Tivoli Integrated Portal is remote:

Change the passwords for DB2, Tivoli Storage Productivity Center, and IBM Tivoli
Integrated Portal when they are installed on two servers, with Tivoli Integrated
Portal on server A, and DB2 and Tivoli Storage Productivity Center on server B.

Before you use the password tool, ensure that you know the existing password or
passwords that you want to change.
1. On the server where DB2 and Tivoli Storage Productivity Center are installed,

complete the following steps to change the DB2 and Tivoli Storage
Productivity Center passwords:

On Windows operating systems where Tivoli Storage Productivity Center is
configured for OS authentication:

a. From the desktop, click Start > Control Panel.
b. Double-click User Accounts.
c. Click Change your password.
d. Enter the current password, and then enter and confirm the new

password. Click Change password. Close the User Accounts
window.

For AIX or Linux operating systems where Tivoli Storage Productivity
Center is configured for OS authentication:

When you are logged in with the DB2 user ID, run the passwd
command. To change other user credentials, run the passwd username
command.

Tip: To find out how to change the LDAP user password, refer to your LDAP
server documentation.

2. On the server where Tivoli Integrated Portal is installed, complete the
following tasks:

On Windows operating systems where Tivoli Storage Productivity Center is
configured for OS authentication:

a. From the desktop, click Start > Control Panel.
b. Double-click User Accounts.
c. Click Change your password.

208 IBM Tivoli Storage Productivity Center: User's Guide



d. Enter the current password, and then enter and confirm the new
password. The new password can be different from the password
that you created in step 1. Click Change password. Close the User
Accounts window.

For AIX or Linux operating systems where Tivoli Storage Productivity
Center is configured for OS authentication:

When you are logged in with the DB2 user ID, run the passwd
command. To change other user credentials, run the passwd username
command.

3. On the same server, open a command prompt window and change the
directory to the following default directory:

On Windows operating systems:
C:\Program Files\IBM\TPC\service

On Linux or UNIX operating systems:
/opt/IBM/TPC/service

4. Start the password tool by running the following program:

On Windows operating systems:
changepasswords.bat

On Linux or AIX operating systems:
changepasswords.sh

5. From the “Choose the password to change” window, click Change Tivoli
Integrated Portal password and click OK.

6. Complete the following steps:
a. Enter and confirm the new password and click OK.
b. In response to the following message, click Yes:

Are you sure you want to change the password?

c. When the process is completed, click Back to Main.
7. On the same server, from the “Choose the password to change” window, click

Change DB2 password and click OK.
8. Complete the following steps:

a. Enter and confirm the new password, ensuring that it is the same as the
new password that you entered in step 1. Ensure that the Restart servers
check box is selected and click OK.

b. In response to the following message, click Yes:
Are you sure you want to change the password?

Tip: After you click Yes, if the DB2 servers are already started, the
following errors might be displayed in a command prompt window.
Ignore them and continue with the procedure.
Changing DB2 User password for Data Server...
Changing DB2 User password for Device Server...
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5

c. When the process is completed, click Back to Main.
9. On the server where Tivoli Storage Productivity Center and DB2 are installed,

from the “Choose the password to change” window, click Change Tivoli
Storage Productivity Center server passwords and click OK.

10. Complete the following steps:
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a. Enter and confirm the new password, ensuring that it is the same as the
new password that you entered in step 1. Click OK.

b. In response to the following message, click Yes:
Are you sure you want to change the password?

c. When the process is completed, click Back to Main.
11. On the same server, click Change DB2 password and click OK.
12. Complete the following steps:

a. Enter and confirm the new password, ensuring that it is the same as the
new password that you entered in step 1. Click OK.

b. In response to the following message, click Yes:
Are you sure you want to change the password?

Tip: After you click Yes, if the DB2 servers are already started, the
following errors might be displayed in a command prompt window.
Ignore them and continue with the procedure.
Changing DB2 User password for Data Server...
Changing DB2 User password for Device Server...
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5

c. When the process is completed, click Back to Main.
13. Exit the password tool.

Tip: To verify that the password changes were completed successfully, review
the PWTool.log file that is in the TPC_installation_directory\service
directory, where TPC_installation_directory is the directory where Tivoli Storage
Productivity Center is installed.

Related tasks:
“Single server installation where components use the same logon credentials” on
page 204
Use the password tool to change the password for DB2, Tivoli Storage Productivity
Center, and IBM Tivoli Integrated Portal when they are installed on the same
server, and use the same user name and password.
“Single server installation where components use different logon credentials” on
page 206
Use the password tool to change the passwords for DB2, Tivoli Storage
Productivity Center, and IBM Tivoli Integrated Portal when they are installed on
the same server, but use different user names and passwords.
“Multiple server installation where DB2 is remote”
Change the passwords for DB2, Tivoli Storage Productivity Center, and IBM Tivoli
Integrated Portal when they are installed on two servers, with Tivoli Integrated
Portal and Tivoli Storage Productivity Center on server A, and DB2 on server B.

Multiple server installation where DB2 is remote:

Change the passwords for DB2, Tivoli Storage Productivity Center, and IBM Tivoli
Integrated Portal when they are installed on two servers, with Tivoli Integrated
Portal and Tivoli Storage Productivity Center on server A, and DB2 on server B.

Before you use the password tool, ensure that you know the existing password or
passwords that you want to change.
1. On the server where DB2 is installed, do the following steps:
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For Windows operating systems where Tivoli Storage Productivity Center is
configured for OS authentication:

a. From the desktop, click Start > Control Panel.
b. Double-click User Accounts.
c. Click Change your password.
d. Enter the current password, and then enter and confirm the new

password. Click Change password. Close the User Accounts
window.

For AIX or Linux operating systems where Tivoli Storage Productivity
Center is configured for OS authentication:

When you are logged in with the DB2 user ID, run the passwd
command. To change other user credentials, run the passwd username
command.

Tip: To find out how to change the LDAP user password, refer to your LDAP
server documentation.

2. On the server where Tivoli Integrated Portal and Tivoli Storage Productivity
Center are installed, do the following steps:

For Windows operating systems where Tivoli Storage Productivity Center is
configured for OS authentication:

a. From the desktop, click Start > Control Panel.
b. Double-click User Accounts.
c. Click Change your password.
d. Enter the current password, and then enter and confirm the new

password. The new password can be different from the password
that you created in step 1. Click Change password. Close the User
Accounts window.

For AIX or Linux operating systems where Tivoli Storage Productivity
Center is configured for OS authentication:

When you are logged in with the DB2 user ID, run the passwd
command. To change other user credentials, run the passwd username
command.

3. On the same server, open a command prompt window and change the
directory to the following default directory:

On Windows operating systems:
C:\Program Files\IBM\TPC\service

On Linux or UNIX operating systems:
/opt/IBM/TPC/service

4. Start the password tool by running the following program:

On Windows operating systems:
changepasswords.bat

On Linux or AIX operating systems:
changepasswords.sh

5. From the “Choose the password to change” window, click Change Tivoli
Integrated Portal password and click OK.

6. Complete the following steps:
a. Enter and confirm the new password and click OK.
b. In response to the following message, click Yes:

Are you sure you want to change the password?
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c. When the process is completed, click Back to Main.
7. On the same server, from the “Choose the password to change” window, click

Change Tivoli Storage Productivity Center server passwords and click OK.
8. Complete the following steps:

a. Enter and confirm the new password, ensuring that it is the same as the
new password that you entered in step 2. Click OK.

b. In response to the following message, click Yes:
Are you sure you want to change the password?

c. When the process is completed, click Back to Main.
9. On the server where DB2 is installed, from the “Choose the password to

change” window, click Change DB2 password and click OK.
10. Complete the following steps:

a. Enter and confirm the new password, ensuring that it is the same as the
new password that you entered in step 1. Ensure that the Restart servers
check box is selected, and click OK.

b. In response to the following message, click Yes:
Are you sure you want to change the password?

Tip: After you click Yes, if the DB2 servers are already started, the
following errors might be displayed in a command prompt window.
Ignore them and continue with the procedure.
Changing DB2 User password for Data Server...
Changing DB2 User password for Device Server...
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5

c. When the process is completed, click Back to Main.
11. Click Exit program.
12. On the server where Tivoli Integrated Portal and Tivoli Storage Productivity

Center are installed, from the “Choose the password to change” window, click
Change DB2 password.

13. Complete the following steps:
a. Enter and confirm the new password, ensuring that it is the same as the

new password that you entered in step 1. Ensure that the Restart servers
check box is selected, and click OK.

b. In response to the following message, the following message, click Yes:
Are you sure you want to change the password?

Tip: After you click Yes, if the DB2 servers are already started, the
following errors might be displayed in a command prompt window.
Ignore them and continue with the procedure.
Changing DB2 User password for Data Server...
Changing DB2 User password for Device Server...
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5
OpenServiceW failed, error code = 5

c. When the process is completed, click Back to Main.
14. Exit the password tool.

Important: For the changes to take effect, you might have to manually restart
the Data server, the Device server, or Tivoli Integrated Portal, or all three.
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Tip: To verify that the password changes were completed successfully, review
the PWTool.log file that is in the TPC_installation_directory\service
directory, where TPC_installation_directory is the directory where Tivoli Storage
Productivity Center is installed.

Related tasks:
“Single server installation where components use the same logon credentials” on
page 204
Use the password tool to change the password for DB2, Tivoli Storage Productivity
Center, and IBM Tivoli Integrated Portal when they are installed on the same
server, and use the same user name and password.
“Single server installation where components use different logon credentials” on
page 206
Use the password tool to change the passwords for DB2, Tivoli Storage
Productivity Center, and IBM Tivoli Integrated Portal when they are installed on
the same server, but use different user names and passwords.
“Multiple server installation where Tivoli Integrated Portal is remote” on page 208
Change the passwords for DB2, Tivoli Storage Productivity Center, and IBM Tivoli
Integrated Portal when they are installed on two servers, with Tivoli Integrated
Portal on server A, and DB2 and Tivoli Storage Productivity Center on server B.

Changing passwords by editing configuration files

Changing the DB2 user password for the Device server:

This section provides information about changing the DB2 user password for the
Device server.

If you change the DB2 user password, follow these steps to change it for the
Device server:
1. Go the TPC_installation_dir\cli directory and run the following command:

tpctool encrypt password

This encrypts the password.
2. Copy the encrypted password to the following file: TPC_installation_dir\

device\conf\tsnmdbparms.properties Replace this password:
tivoli.sanmgmt.jdbc.dbPassword=<encrypted_password>

3. Restart the Device server.

Changing the DB2 password for the Data Server:

This section provides information about changing the DB2 password for the Data
Server.

To change the DB2 password, complete the following steps:
1. From a command prompt, change to the directory where the file

repository.config resides in the IBM Tivoli Storage Productivity Center
installation path. For example:
c:\Program Files\IBM\TPC\data\config\ (Windows)
/<usr or opt>/IBM/TPC/data/config/ (AIX or Linux)

2. Run the following command for the Data server. This assumes that the Tivoli
Storage Productivity Center directory is in C:\Program Files\IBM\TPC for
Windows.
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"C:\Program Files\IBM\TPC\data\config>\"program files"\
ibm\tpc\jre\bin\java -classpath "\program files\ibm\tpc\data\server\lib\
TSRMsrv.zip" com.tivoli.itsrm.repository.Transform
-p <new_password> repository.config

3. Stop and then restart the Data Server.
4. Start the Tivoli Storage Productivity Center GUI.

Checking for a fully qualified host name
IBM Tivoli Storage Productivity Center requires fully qualified host names. Some
machines might be configured to return a short host name, such as ddunham
instead of a fully qualified host name, such as ddunham.myorg.mycompany.com.
This topic provides information on how to check for a fully qualified host name.

Checking for a fully qualified host name for Windows systems
This topic provides information on how to verify a fully qualified host name for
Windows systems.

To verify a fully qualified host name, complete the following steps:
1. On the desktop, right-click My Computer.
2. Click Properties.
3. The System Properties panel is displayed.
4. On the Computer Name tab, click Change.
5. The Computer Name Changes panel is displayed. Enter your fully qualified

host name in the Computer name filed. Click More.
6. The DNS Suffix and NetBIOS Computer Name panel is displayed. Verify that

the Primary DNS suffix field displays a domain name. Click OK.
7. Click OK on the Computer Name Changes panel.
8. Click Apply and close the System Properties panel.

Checking for a fully qualified host name for AIX systems
This topic provides information on how to verify a fully qualified host name for
AIX.

The default domain name search order is as follows:
1. Domain Name System (DNS) server
2. Network Information Service (NIS)
3. Local /etc/hosts file.

If the /etc/resolv.conf file does not exist, the /etc/hosts file is used. If only the
/etc/hosts file is used, the fully qualified computer name must be the first one
that is listed after the IP address.

Verify that the /etc/resolv.conf file exists and contains the appropriate
information, such as:
domain mydivision.mycompany.com
nameserver 123.123.123.123

If NIS is installed, the /etc/irs.conf file overrides the system default. It contains
the following information:
hosts = bind,local

The /etc/netsvc.conf file, if it exists, overrides the /etc/irs.conf file and the
system default. It contains the following information:
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hosts = bind,local

If the NSORDER environment variable is set, it overrides all of the preceding files.
It contains the following information:
export NDORDER=bind,local

Checking for a fully qualified host name for Linux systems
This topic provides information on how to verify a fully qualified host name for
Linux.

Linux uses a resolver library to obtain the IP address corresponding to a host
name. The /etc/host.conf file specifies how names are resolved. The entries in the
/etc/host.conf file tell the resolver library what services to use, and in what order,
to resolve names. Edit the host.conf file using the vi editor to add the following
lines:
# Lookup names through DNS first then fall back to /etc/hosts.
order bind,hosts
# Machines with multiple IP addresses.
multi on
# Check for IP address spoofing.
nospoof on

The order option indicates the order of services. The sample entry specifies that the
resolver library should first consult the name server to resolve a name and then
check the /etc/hosts file. It is recommended to set the resolver library to first
check the name server, bind file, and then the hosts file (hosts) for better
performance and security on all your servers. You must have the DNS and BIND
software installed for this configuration to work.

The multi option determines whether a host in the /etc/hosts file can have
multiple IP addresses. Hosts that have more than one IP address are said to be
multihomed, because the presence of multiple IP addresses implies that the host
has several network interfaces.

The nospoof option takes care of not permitting spoofing on this machine.
IP-Spoofing is a security exploit that works by tricking computers into a trust
relationship that you are someone that you really are not. In this type of attack, a
machine is set up to look like a legitimate server and then issue connections and
other types of network activities to legitimize end systems, other servers, or large
data repository systems. This option must be set ON for all types of servers.

Checking for a fully qualified host name for Oracle Solaris
This topic provides information about how to verify a fully qualified host name for
Oracle Solaris systems.

Verify that the /etc/resolv.conf file exists and contains the appropriate
information, such as:
domain mydivision.mycompany.com
nameserver 123.123.123.123

A short name is used if the /etc/nsswitch.conf file contains a line that begins as
follows and if the /etc/hosts file contains the short name for the computer:
hosts: files

To correct this problem, follow these steps:
1. Change the line in the /etc/nsswitch.conf file to the following:
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hosts: dns nis files

2. Enter the following command to stop the inet service:
/etc/init.d/inetsvc stop

3. Enter the following command to restart the inet service:
/etc/init.d/inetsvc start

Granting local administrative privileges to a domain account
For Windows users, the user account which the Storage Resource agent runs under
requires local administrative rights. Because these rights are not necessarily
guaranteed for domain users in a Windows domain environment, this topic
provides information about how to grant local administrative rights for domain
users. Using this procedure, you do not have to manually process each machine in
the domain.

Note: These steps are for a Windows system that is a member of a Windows
domain and not for the Windows Domain Primary Domain Controller.

To use Group Policy to grant local administrative privileges to a domain account,
complete the following steps:
1. On the domain controller, go to Administrative Tools > Active Directory Users

and Computers (you must be running with Domain Administrator privileges).
2. Right-click on the Organizational Unit (OU) upon which you want to apply the

Group Policy. Click Properties.
3. The Group Policy Properties panel is displayed. Select the Group Policy tab and

click New to create a Group Policy.
4. Designate a name for the new Group Policy. Select the new Group Policy and

click Edit.
5. The Group Policy Object Editor panel is displayed. Go to New Group Policy

Object your_policy > Computer Configuration > Windows Settings > Security
Settings > Restricted Groups. Right-click on Restricted Groups. Click Add
Group.

6. For example, name the new group "Administrators." Under "Properties", add
the user "Administrator", and the domain accounts or groups upon which you
want the Group Policy in effect for. For example, you can add
"TPC\tapeadmin", "TPC\tapegroup", and "TPC\TestGroup". Click OK.

7. Add these user rights to the domain account:
v Act as part of the operating system
v Log on as a service

In the Group Policy Object Editor, go to New Group Policy Object your_policy
> Computer Configuration > Windows Settings > Security Settings > Local
Policies > User Rights Assignments. In the content pane, select "Log on as a
service" and double-click. Add the domain user for whom you are granting
user rights and click OK. Repeat this step for "Act as part of the operating
system."

8. The group policy is now enforced for the Organizational Unit to include the
domain accounts and groups specified under the local Administrators group on
each computer in the Organizational Unit. In addition, the domain user has
been granted the necessary rights. To verify the user rights, log in to a domain
computer and open the Computer Management console. Select Groups,
double-click the Administrators group, and verify the membership of the
domain users.
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Importing SSL certificates for VMware
If your VMware uses SSL certificates, you must import the SSL certificates for
VMware Virtual Infrastructrue Data Source.

If your VMware uses SSL certificates, you must follow these steps before you can
get data from the VMware Virtual Infrastructure. Complete the following steps:
1. Open a browser. Point the browser to the following:

https://ESX_server_IP_address/host

2. You will see a list of Configuration files. Right-click on ssl_cert. Save the file as
ESX_machine_name.crt.

Note: Depending on your browser, you would save the file using Save Target
as (for Internet Explorer) or Save Link as (for Firefox).
Use this file to import the certificate.

3. The VirtualCenter Server uses a self-generated SSL certificate located in the
following directory:
C:\Documents and Settings\All Users\Applicatin Data\
VMware\VMware VirtualCenter\SSL\rui.crt

Install these certificates into a certificate store on the client machine. Copy the
certificate file or files from the servers to a directory on the client machine.
Enter the keytool command:
TPC_installation_directory/jre/bin/keytool -import
-file certificate-filename
-alias server-name
-keystore vmware.jks

For example, run this command:
TPC_installation_directory/jre/bin/keytool -import
-file vc-server1.crt -alias vc-server1
-keystore vmware.jks

Enter a password for the keystore. Enter yes to import the certificate.
The truststore will be located in the Device server configuration directory:
TPC_installation_directory/device/conf

If the truststore was generated in another directory, it must be copied to
TPC_installation_directory/device/conf. The truststore is called vmware.jks.
The truststore will automatically be defined at service startup time as this
property in the Device server JVM:
javax.net.ssl.trustStore System

4. Add a VMware data source using the URL, user name, and password for the
service console.

5. Run a discovery job for the VMware data source.
6. Run a probe job for the VMware data source.
7. You will now be able to display VMware Virtual Infrastructure in reports and

the topology viewer.

Important: For Linux: If you install Java when you install the operating system,
the operating system version of the keytool command is installed. The operating
system level of keytool might not be the correct version for Tivoli Storage
Productivity Center to use. To create the vmware.jks file correctly, use the keytool
located in /opt/IBM/TPC/jre/bin.
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SQL access to Tivoli Storage Productivity Center views
IBM Tivoli Storage Productivity Center stores the information collected by data
collection jobs in its DB2 database repository. This information is organized into a
set of accessible views. You can use Structured Query Language (SQL) to retrieve
the information from these views to create custom reports or for use within other
applications.

Prerequisite: See the Planning section in the Tivoli Storage Productivity Center
Information Center for information about the requirements when retrieving data
from views in the database repository.

A view is a logical table that consists of data that is generated by a query. A view
is based on an underlying set of base tables in the database repository, and the
data in a view is determined by a SELECT statement that is run on those base
tables. The data collected Tivoli Storage Productivity Center is organized into the
following sets of views that you can access in the database repository:

Storage entity views
These views include detailed information about the properties of storage
entities. For example, the name, disk space, and available disk space for a
storage subsystem. Information about the following storage entities are
available in views in the database repository:
v Storage entity views: Hosts, volume groups, disks, virtual disks, external

storage volumes, disk paths, virtual disk paths, controllers, logical
volumes, file systems, clusters, cluster resource groups, hypervisors,
virtual machines, virtual machine disks, hypervisor volumes, host virtual
files, hypervisor partitions, MAC addresses, files, file types, directories,
exports, OS users, OS user groups, IP addresses, Windows domains, and
Storage Resource agents.

v Host relationship views:
– Logical volume to host disk
– Logical volume to logical volume (Parent and child logical volume

relationships)
– Computer to storage entity (disk or logical volume)
– Filesystem to logical volume

(for example, the relationship between a logical volume and a host disk)
v Database views: Database instances, database containers, database

archive logs, database control files, database datafiles, database devices,
database log files, database log groups, database segments, database
tables, database tablespaces

v Storage subsystem views: Storage subsystems, storage virtualizers,
storage pools, extents, volumes, disk drives, disk groups, element
managers, nodes, backend disks, storage virtualizer I/O groups, volume
paths, array sites, ranks

v Storage subsystem relationship views:
– Disk drive to storage extent
– Storage volume to storage extent
– Volume to disk drive
– Storage volume to backend disk

v NAS Filers
v Tape library views: Tape libraries, tape cartridges, tape drives, tape

frames, tape I/O ports, tape media changers, tape media locations
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v Fabric views: Fabrics, nodes, peripheral entities, port to port connections,
switches, switch blades, zones, zone members, zone sets, zone aliases,
FC ports, host bus adapters

v Fabric relationship views:
– Blade to FC port
– Node to HBA, Node to port
– Peripheral entity to node
– Switch to port
– Zone to alias, Zone to zone member, Zone to node, Zone to member
– Zone set to zone
– Zone alias to node
– Alias to member
– Fabric to switch, Fabric to zoneset, Fabric to zone, Fabric to zone alias

v Performance management views (for example, metrics and threshold
violations)

Entities defined by Tivoli Storage Productivity Center
These views include information about entities that are defined by Tivoli
Storage Productivity Center. These entities include Data agents, Fabric
agents, the alert log, the Tivoli Storage Productivity Center servers, scan
profiles, external tools, monitoring groups, reporting groups, and storage
resource groups.

Data sources
These views include information about the data sources that are associated
with Tivoli Storage Productivity Center. These data sources include Data
agents, Storage Resource agents, Fabric agents, Tivoli Storage Productivity
Center servers, CIMOM agents, Out of Band agents, and VMWare Virtual
Infrastructure.

Aggregated views
These views provide summary information for the database history, data in
a database instance, and the Data agent file system.

Reporting views
These views combine several different entities into one view, such as
aggregate database and file system summary views, file size, time, and age
distribution views, enterprise-wide statistics views, directory size views,
and historical views of statistics for database summaries, ping jobs, user
space usage, and files in user groups.

Rollup views
These views include rollup report information from the master and
subordinate Tivoli Storage Productivity Center servers, Data agents, Fabric
agents, Storage Resource agents, host cluster data, computer group, host,
database computer groups, fabric SAN assets, switch assets, storage
subsystem group, storage subsystems, and Data Manager for Databases.

See the Tivoli Storage Productivity Center's support Web site for detailed
descriptions of the views provided with Tivoli Storage Productivity Center:
http://www.ibm.com/systems/support/storage/software/tpc

This Web page contains the following additional documentation:
v Information about the TPCREPORT schema, including:
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– A list of the views that exist in the schema and descriptions of the columns
with the views.

– A list of the views that contain performance data and descriptions of the
performance metrics within those views.

– Diagrams that show the relationships between views.
v A diagram that traces the relationship between a computer and a storage

subsystem disk and shows the views that contain information about the storage
entities within that relationship.

Accessing views in the database repository
Use SQL to access the views in Tivoli Storage Productivity Center database
repository. You can do this using an SQL command line or an application capable
of using SQL to retrieve information from views. This topic provides an example of
how to create and view a report based on those views.

To retrieve information from the database repository you must have the proper
authority to access the views. You must also collect information about your storage
assets to populate those views with information. See the Planning section in the
Tivoli Storage Productivity Center Information Center for more information.

To perform the steps described in this topic, you must install the correct version
BIRT. You can download BIRT v2.2.1 from the following Web page:
http://www-01.ibm.com/software/brandcatalog/portal/opal/
details?catalog.label=1TW10OT02. You must use this version of BIRT when
working with Tivoli Storage Productivity Center and Tivoli Common Reporting.

You can use a number of SQL and reporting tools for accessing and viewing the
content of IBM Tivoli Storage Productivity Center's exposed views. For example,
you can use the DB2 Command Line Processor to run SQL commands against the
views.

This topic describes how to use BIRT to create a report package based on the views
and how to import that package into Tivoli Common Reporting for viewing. Tivoli
Common Reporting is installed with Tivoli Storage Productivity Center.

See the following web sites for more information about BIRT and Tivoli Common
Reporting:
v BIRT overview information: http://www.eclipse.org/birt/phoenix/intro/
v Tivoli Common Reporting overview information: http://www.ibm.com/

developerworks/spaces/tcr

Complete these steps to use BIRT and Tivoli Common Reporting to work with
Tivoli Storage Productivity Center's views:
1. Install BIRT on a computer that has access to Tivoli Storage Productivity

Center's database repository. The database repository is located on the
computer where the Tivoli Storage Productivity Center server is installed.

2. Start the BIRT Designer tool.
3. Set the connection information for the Tivoli Storage Productivity Center

database repository in Data Source section of the user interface.
4. Use the Data Sets section of the user interface to create a report based on SQL

queries to the exposed views that are in the TPCREPORT schema. See
http://www.eclipse.org/birt/phoenix/intro/ for information on how to use
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BIRT to create a report. When writing queries against the views make sure to
qualify the view names with the TPCREPORT schema (for example,
TPCREPORT.STORAGESUBSYSTEM).

Note: BIRT limits the amount of views that are displayed to 100 by default. To
change this, access the Preferences window for the Data Set Editor and enter a
value greater than 275 in the Maximum number of tables in each schema to
display field.

5. Define the layout of the report. Use BIRT to customize the appearance of a
report, including customizing column names and creating charts, graphics, and
aggregated totals for the data in the report. Use the preview function to view a
snapshot of the report that you defined.

6. Create a report package (archive file) for the reports to import into Tivoli
Common Reporting.

7. Import the report package into Tivoli Common Reporting.
a. Start Tivoli Integrated Portal. For information about starting Tivoli

Integrated Portal, go to the Tivoli Storage Productivity Center information
center. Search for Starting the Tivoli Storage Productivity Center GUI from
Tivoli Integrated Portal.

b. Expand Reporting in the navigation tree and click Common Reporting.
c. Right-click Report Sets and select Import Report Package.
d. Select the report package you want to import and click Import. Click

Overwrite in the Advanced Options section if the report package was
previously imported. The name of the report package appears in the
Reports section of the panel.

e. Right-click the report package and select Views As > output_type, where
output_type represents the format of the generated report.

f. View the report.

Repocopy tool
You can use the Repocopy tool to export all the tables in the IBM Tivoli Storage
Productivity Center repository (Data Manager data) for purposes of debugging
problems.

You can send the exported data to the IBM Support Center to help debug
problems.

Note:

v You must stop the Device server and Data server before running repocopy.
v You cannot import repocopy data into the IBM Tivoli Storage Productivity

Center database if the migration tool has not been run against the database.
When you upgrade the Device server, you must run the migration tool before
importing repocopy data.

Exporting repository data
Use the repocopy tool to export data from an existing repository into a comma
delimited file.

To export repository data, follow these steps:
1. Go to the following default directory:

On Windows operating systems:
c:\Program Files\IBM\TPC\data\server\tools
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On Linux or UNIX operating systems:
/opt/IBM/TPC/data/server/tools

2. Run the repocopy.bat or repocopy.sh command. A window opens prompting
you for what you would like to do.

3. Select Export data from repository tables and click Next. The Options for
Import/Export window is displayed.

4. In the Options for Import/Export window, enter information in the following
fields:

Directory for Export
Enter the directory where the comma delimited file is saved.

Delimiter
Enter a delimiter for the delimited file format (comma is the default).

Quote Enter the symbol that contains string data (double quotation marks is
the default).

IBM Tivoli Storage Productivity Center exports the data into the comma
delimited file you specify, and place it in a file named tablename.txt. Click
Next.

5. The Choices for DB2 Export window are displayed. You have the following
choices:
v Export Using DB2 native format
v Export Using text files

Make a choice and click Next.
6. The Table Export Choices window opens. You have the following choices:

v Export base tables (always)
v Export Performance Manager tables
v Export history tables used for IBM Tivoli Storage Productivity Center for

Data history reports

Make a choice and click Next. The Connection Properties window opens.
Tivoli Storage Productivity Center reads the server.config file and determines
your current repository and the information for accessing the database. The
information detected in the server.config file is displayed in the Connection
Properties window within the following fields:
v Database Types
v User name
v Password
v Driver Class
v Driver URL
v Database
v DB Creator
v Classpath

Note: If you want to export data from a different database from the one listed
in the server.config file, you can select the database from the Database Types
list box. Manually enter the database information.

7. Click Finish.
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8. Tivoli Storage Productivity Center then connects to the database and displays
the database and connection information. To begin the export process, click
Run.

A window opens containing the export progress log. As you progress through the
export process, messages are written to this progress log. You can keep track of the
steps through the progress log.

Note: When you run the repocopy tool on a server that has a remote database, the
repocopy tool displays a message. When the repocopy tool is used with a remote
database, the DB2 shared library is unavailable for loading libTSRMinsudb.so. You
can ignore this message. Click OK and continue.

Importing repository data
Use the Repository Copy tool to import data from a comma delimited file. You
must have previously exported data from an existing repository.

To import data into repository tables, follow these steps:
1. Stop the Device server and Data server.
2. Go to the following directory:

On Windows operating systems:
c:\Program Files\IBM\TPC\data\server\tools

On Linux or UNIX operating systems:
/opt/IBM/TPC/data/server/tools

3. Run the repocopy.bat or repocopy.sh command. A window is displayed
prompting you for what you would like to do

4. Select Import data into repository tables, and then click Next. The Options for
Import/Export window opens.

5. In the Options for Import/Export window, enter information in the following
fields:

Directory for Import
Enter the directory where the comma delimited files are stored.

Delimiter
Enter a delimiter used for the delimited file format (comma is the
default). You must use the same delimiter that was used in the
exported file.

Quote Enter the symbol used to contain string data (double quotation marks
is the default). You must use the same double quotation marks that
were used in the exported file.

Delete before inserting
Check this option if you want to delete any existing data in the
repository tables before importing new data.

IBM Tivoli Storage Productivity Center imports the data from the comma
delimited file that you specify. Click Next.

6. The Connection Properties window opens.
7. Enter the database and the access information of the database to which you

want to import data. The Connection Properties window contains the following
fields:
v Database Types
v User name
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v Password
v Driver Class
v Driver URL
v Database
v DB Creator
v Classpath

Click Finish. Tivoli Storage Productivity Center then connects to the database
and displays the database and connection information.

8. To begin the import process, click Run.

A window containing the import progress log opens. As you progress through the
import, messages are written to this progress log. You can use the progress log to
track the steps as they happen.

Note: When you run the repocopy tool on a server that has a remote database, the
repocopy tool displays a message. When the repocopy tool is used with a remote
database, the DB2 shared library is unavailable for loading libTSRMinsudb.so. You
can ignore this message. Click OK and continue.

Service tool: collecting information
The Service tool collects information from all installed IBM Tivoli Storage
Productivity Center components. The tool detects system configuration, collects the
applicable information, and creates a compressed file that can be sent to the IBM
support center.

The Service tool collects the following information:
v Host name
v IP address and configuration information
v Operating system and version
v Java home, version, and class path
v Java Virtual Machine (JVM) implementation name and version
v Protocol statistics and current IBM Tivoli Storage Productivity Center / Internet

Protocol network connections, including listening ports
v Diagnostic information regarding the system and its services
v Listing of all library files, for example, server and library, agent and library, and

GUI library

When the Service tool is run on the system where the Data server or the Device
server is installed, it also collects the following information:
v For the Data server, information about all of the graphical user interfaces

(remote and local) that are associated with this Data server
v All applied e-fixes
v Installation logs
v Everything in the log directory, including subdirectories
v Everything in the conf directory
v Directory listing of the lib directory
v Everything in the log and conf directories underneath the ewas directory
v The version of DB2 (information from the db2level command)
v Information from the ipconfig /all command (Windows operating systems)
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v Information from the ipconfig -a command (Linux and UNIX operating systems)
v Information from the netstat -an command

When the Service tool is run on the system where the database repository is
installed, it also collects the following information:
v The DB2 support information (information from the db2support command)

When the Service tool is run on the system where Tivoli Integrated Portal and the
TCR component is installed, it also collects the following information:
v Everything in the log and confdirectories
v Logs for the deployment engine
v Listing of COI components installed
v InstallAnywhere logs for Tivoli Integrated Portal and TCR
v TCR COI related logs
v Tivoli Integrated Portal ewas configuration files

When the Service tool runs on the Storage Resource Agent computer, it collects the
following information:
v All applied e-fixes
v Everything in the log directory (including subdirectories).
v Everything in the conf directory
v Directory listing of the lib directory
v Information from the ipconfig /all command (for Windows operating systems).
v Information from the ifconfig -a command (for UNIX and Linux operating

systems).
v Information from the netstat -an command

By default, the service data is collected in the following directory:

On Windows operating systems:
TPC_installation_directory\service\data

On UNIX and Linux operating systems:
TPC_installation_directory/service/data

You can change the default directory. To do this, refer to the following topic:
“Customizing the service tool from the command line” on page 227

Tip: You can run the Service tool on IBM Tivoli Storage Productivity Center
regardless of whether you configured it on a single server or on a split server. The
Service tool automatically recognizes the installed components and collects service
data about them. To learn how to run the Service tool for servers, see the following
topic: “Creating a compressed file about servers for the IBM Support Center” on
page 226.

Restriction: The Service tool does not collect service logs or other service
information for Tivoli Storage Productivity Center for Replication. If you must
collect the log and trace files for the Replication server, go to the information
center. Go to IBM Tivoli Storage Productivity Center > Troubleshooting > IBM
Tivoli Storage Productivity Center for Replication > Logs.
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Creating a compressed file about servers for the IBM Support
Center
Run the Service tool for the Data server and the Device server to create a
compressed file that can be sent to the IBM Support Center.

You must have administrator authority on Windows operating systems or root
authority on UNIX and Linux operating systems.

To run the tool for the servers, follow these steps:
1. Log on to the system.
2. If you used the default directory, go to the following directory:

v On Windows operating systems: C:\Program Files\IBM\TPC\service\.
v On Linux or UNIX operating systems: /usr_or_opt/IBM/TPC/service/.

3. Run the following program:

On Windows operating systems:
service.bat

On Linux or UNIX operating systems:
service.sh

A compressed file, TPCServiceFiles.zip, is created in the following directory:

On Windows operating systems
TPC_installation_directory\service\data

On Linux or UNIX operating systems
TPC_installation_directory/service/data

Tip: You can customize the data that is collected by the Service tool. For more
information, see “Customizing the service tool from the command line” on page
227
Related tasks:
“Creating a compressed file about Storage Resource Agents for the IBM Support
Center”
Run the Service tool on Storage Resource Agents that were deployed by using the
stand-alone GUI to create a compressed file that can be sent to the IBM Support
Center.

Creating a compressed file about Storage Resource Agents for
the IBM Support Center
Run the Service tool on Storage Resource Agents that were deployed by using the
stand-alone GUI to create a compressed file that can be sent to the IBM Support
Center.

You must have administrator authority on Windows operating systems or root
authority on UNIX and Linux operating systems.

To run the Service tool on the Storage Resource agents, do the following steps:
1. Log on to the stand-alone GUI.
2. In the navigation tree, expand Administrative Services > Data Sources >

Data/Storage Resource Agents.
3. In the content pane, select the agent. From the Select Action menu, click

Collect Service Data.
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The following compressed files are created:

On Windows operating systems:
C:\Program Files\IBM\TPC\data\log\SRATraces\SRA_computer_name\
TPCServiceInfo.zip

On UNIX and Linux operating systems:
/opt/IBM/TPC/data/log/SRATraces/SRA_computer_name/TPCServiceInfo.zip

where SRA_computer_name represents the name of the computer on which the
Storage Resource agent is located.

If the compressed file cannot be created, a message indicates that the job was
unsuccessful.

For more information about the error, see the server log file or the services script
information file. The files are in the following default locations:

Server log file
This file is on the system where IBM Tivoli Storage Productivity Center is
installed:

For Windows operating systems:
c:\Program Files\IBM\TPC\data\log

For UNIX or Linux operating systems
/opt/IBM/TPC/data/log

Services script information file
This file is on the system where the Storage Resource agent is installed:

For Windows operating systems:
c:\Program Files\IBM\TPC\SRA_computer_name\services\
TPCServiceInfo.log

For UNIX or Linux operating systems:
/opt/IBM/TPC/SRA_computer_name/services/TPCServiceInfo.log

Tip: You can customize the data that is collected by the Service tool. For more
information, see “Customizing the service tool from the command line”
Related tasks:
“Creating a compressed file about servers for the IBM Support Center” on page
226
Run the Service tool for the Data server and the Device server to create a
compressed file that can be sent to the IBM Support Center.

Customizing the service tool from the command line
Using various parameters, you can use the service tool to collect data about
specific IBM Tivoli Storage Productivity Center components, which you can then
send to the IBM Support Center. You can also use the command line parameters to
specify a location to place the data that is collected, specify whether the data
should be compressed, or both.

Help and output command-line parameters

To customize the data that is collected by the service tool, use the following
command-line parameters:

-output directory_path
Places the files that contain the data that was collected in a directory that you
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specify. If you specify a directory that does not exist on your system, that
directory is created. If you do not use the -output directory_path parameter,
the files are placed in the default directory:

On Windows operating systems:
TPC_installation_directory\service\data

On Linux or UNIX operating systems:
TPC_installation_directory/service/data

Restriction: If you specify a directory, the directory path cannot contain
spaces.

-nozip
When you use this parameter, separate directories are created for each Tivoli
Storage Productivity Center component for which data was collected. You can
then create compressed files for the files. In this way, you can control the size
and content of each compressed file. To specify a directory other than the
default directory, use the -output directory_path parameter.

Tip: You can specify more than one parameter, for example, C:\Program
Files\IBM\TPC\service>service -install -nozip.

Collecting data for specific Tivoli Storage Productivity Center
components

You can use the service tool to collect data about specific Tivoli Storage
Productivity Center components.

The following list shows the parameters that are used to collect data for each
component:

-all
Collects data about all Tivoli Storage Productivity Center components.

-install
Collects data about the installation component files.

-data
Collects data about the data server component files.

-device
Collects data about the device server component files.

-repl
Collects data about the replication server component files.

-sra
Collects data about the Storage Resource Agent component files.

-db
Collects data about DB2 files.

-cli
Collects data about command-line interface files.

-gui
Collects data about Tivoli Integrated Portal and other IBM Tivoli Storage
Productivity Center web-based GUI files.

-tcr
Collects data about IBM Tivoli Common Reporting.
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Tip: You can specify more than one parameter, for example, C:\Program
Files\IBM\TPC\service>service -tcr -install -gui.

If you collect information about a particular component and you do not specify the
-nozip parameter, you can identify the contents of a compressed service file from
its name. For example, if you specify the -tcr -install -gui parameters but did
not specify the -nozip parameter, a file named
TPCServiceFiles_tcr_install_gui.zip is created.

Attention: An existing compressed file is overwritten when another file of the
same name is created. For example, if you run C:\Program Files\IBM\TPC\
service>service -db -gui, a file named TPCServiceFiles_device_db.zip is
created. If you rerun the tool with the same component options, a new file named
TPCServiceFiles_device_db.zip is created. This new file overwrites the previously
created file unless you specify the -nozip parameter, or use the -output parameter
to specify a different path.

If you specify the -nozip parameter, a subdirectory is created for the components
that you specified in the parameter. If you did not specify a specific component,
data is collected for all installed components, and the data is placed in files in the
following directory:

Windows operating systems:
TPC_installation_directory\service\data

UNIX or Linux operating systems:
TPC_installation_directory/service/data

Files for particular components are then placed in a subdirectory that corresponds
to that component. Common files, such as license.txt, are placed in the following
directory:

Windows operating systems:
TPC_installation_directory\service\data

UNIX or Linux operating systems:
TPC_installation_directory/service/data

Administering Tivoli Integrated Portal
This topic provides information on how to perform administrative tasks in Tivoli
Integrated Portal that are reflected in Tivoli Storage Productivity Center.

Tivoli Integrated Portal port numbers
Depending on how you installed Tivoli Storage Productivity Center, the default
port numbers for Tivoli Integrated Portal can vary.

To find the default port numbers that are used in Tivoli Integrated Portal URLs, do
the following steps:

For a new installation of Tivoli Storage Productivity Center Version 5.1:

1. Go to the following directory:

On Windows operating systems:
C:\Program Files\IBM\tipv2\properties\

On Linux or UNIX operating systems:
/opt/IBM/tipv2/properties/
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2. Open the TIPPortDef.properties file.
3. Review the following entry:

For http:// protocols:
WC_defaulthost_xxxx

For https:// protocols:
WC_defaulthost_secure_xxxx

For an installation of Tivoli Storage Productivity Center Version 5.1 that was
upgraded from an earlier version:

1. Go to the following directory:

On Windows operating systems:
C:\Program Files\IBM\Tivoli\tipv2\properties\

On Linux or UNIX operating systems:
/opt/IBM/Tivoli/tipv2/properties/

2. Open the TIPPortDef.properties file.
3. Review the following entry:

For http:// protocols:
WC_defaulthost_xxxx

For https:// protocols:
WC_defaulthost_secure_xxxx

Port numbers for a new installation of Tivoli Storage Productivity
Center Version 5.1
v If you installed Tivoli Storage Productivity Center Version 5.1 and used default

Tivoli Integrated Portal port numbers, the port numbers are as follows:

For http:// protocols:
9568

For example:
http://hostname:9568/ibm/console/logon.jsp

For https:// protocols:
9569

For example:
https://hostname:9569/ibm/console/logon.jsp

v If you installed Tivoli Storage Productivity Center version 5.1 and used
customized port numbers for Tivoli Integrated Portal, the URLs for a Tivoli
Integrated Portal logon might appear as follows:

For http:// protocols:

For example:
http://hostname:WC_defaulthost/ibm/console/logon.jsp

For https:// protocols:

For example:
https://hostname:WC_defaulthost_secure/ibm/console/
logon.jsp

Port numbers for an upgraded installation of Tivoli Storage
Productivity Center Version 4.2.2
v If you upgraded from Tivoli Storage Productivity Center Version 4.2.2 to Version

5.1, the default Tivoli Integrated Portal port numbers are as follows:
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For http:// protocols:
16310

For example:
http://hostname:16310/ibm/console/logon.jsp

For https:// protocols:
16311

For example:
https://hostname:16311/ibm/console/logon.jsp

v If you used customized port numbers when you installed Tivoli Storage
Productivity Center Version 4.2.2, upgraded to Version 5.1, and then used
customized port numbers for Tivoli Integrated Portal, the URLs for a Tivoli
Integrated Portal logon might appear as follows:

For http:// protocols:
http://hostname:12345/ibm/console/logon.jsp

For https:// protocols:
https://hostname:12346/ibm/console/logon.jsp

Changing the user authentication configuration
The Tivoli Storage Productivity Center installation program establishes a default
authentication configuration using the federated repositories feature of the
WebSphere Application Server. If you want to change the user authentication
configuration, follow these procedures.

Within the federated repositories framework, the Tivoli Storage Productivity Center
installation program creates two repositories:

File-based user repository
This repository contains the user "tpcFileRegistryUser" (This user password
is the same as the common user password entered during the Tivoli
Storage Productivity Center installation.)

Operating system repository
In the federated repositories framework, the Tivoli Storage Productivity
Center installation program creates two repositories on all the following
Tivoli Storage Productivity Center IBM® WebSphere® Application Servers:
v Tivoli Integrated Portal server
v Device server
v Replication server

The Tivoli Integrated Portal server is used as the primary WebSphere
Application Server for user authentication in Tivoli Storage Productivity
Center. If the Tivoli Integrated Portal server is down, the Device Server
and Replication Server are used as the back up WebSphere Application
Servers to perform the user authentication and allow the authorized local
OS users to log in to the Tivoli Storage Productivity Center stand-alone
GUI and Tivoli Storage Productivity Center for Replication web-based GUI.
You can add an LDAP repository as a post-install task. This configuration
is completed on the Tivoli Integrated Portal server. The LDAP repository
configuration settings are not propagated to the Device and Replication
servers. So, if the Tivoli Integrated Portal server is down, then the
authorized LDAP users cannot log in to Tivoli Storage Productivity Center
stand-alone GUI and Tivoli Storage Productivity Center for Replication
web-based GUI. The back up user authentication mechanism based on

Chapter 4. Administering 231



Device and Replication servers allows the authorized local OS users to log
in to the Tivoli Storage Productivity Center stand-alone GUI and the Tivoli
Storage Productivity Center for Replication web-based GUI.

This repository is referred to as the localOS repository and contains the
users and groups that are managed by the local operating system.
On computers that are members of a Windows domain, this local OS
repository also contains the domain users and groups that are managed by
the Windows domain, provided that the computer is correctly configured
with the Windows domain.
Use of the Tivoli Storage Productivity Center single sign-on feature,
especially with storage system element managers, is limited with this
default authentication configuration. Storage system element managers do
not support using the localOS repository or the file-based repository for
single sign-on, even when the element manager is installed on the same
system as Tivoli Storage Productivity Center.

The LDAP repositories supported by Tivoli Storage Productivity Center depend on
the Tivoli Integrated Portal support. For more information about the LDAP
repositories supported, see one of the following topics:
v For the Windows operating system: http://www.ibm.com/support/

docview.wss?rs=180&uid=swg27012421 .
v For the AIX operating system: http://www.ibm.com/support/

docview.wss?rs=180&uid=swg27012389.
v For the Linux operating system: http://www.ibm.com/support/

docview.wss?rs=180&uid=swg27012415.

Search for LDAP Servers using Federated Repository Configuration.

Whenever you change the user authentication configuration (by adding or
removing an LDAP repository within the federated repositories framework), you
must first back up the existing Tivoli Integrated Portal WebSphere configuration
files. The WebSphere backup files provide a restoration point in the event of a
failure when performing these procedures. You must also back up the WebSphere
configuration files after you add an LDAP repository to the user authentication
configuration and want to later change the LDAP authentication settings.

The WebSphere Application Server cannot resolve duplicated users or groups if
these users or groups are present in more than one repository in the federated
repositories framework. For example, an Administrator user exists in both the local
OS and LDAP repository. You must ensure that the duplicated users (or groups)
are not used during the configuration or to manage Tivoli Storage Productivity
Center.

The following topics describe how to select and configure each user authentication
method.

Adding an LDAP repository to the federated repositories
You can configure Tivoli Storage Productivity Center to communicate with an
external Lightweight Directory Access Protocol (LDAP) repository such as IBM
Tivoli Directory Server or Microsoft Active Directory. To add an LDAP repository
to the federated repositories in Tivoli Storage Productivity Center, you must use
Tivoli Integrated Portal.

If you installed Tivoli Storage Productivity Center on a correctly configured
computer that is a member of a Windows domain, Active Directory users and

232 IBM Tivoli Storage Productivity Center: User's Guide

http://www.ibm.com/support/docview.wss?rs=180&uid=swg27012421
http://www.ibm.com/support/docview.wss?rs=180&uid=swg27012421
http://www.ibm.com/support/docview.wss?rs=180&uid=swg27012389
http://www.ibm.com/support/docview.wss?rs=180&uid=swg27012389
http://www.ibm.com/support/docview.wss?rs=180&uid=swg27012415
http://www.ibm.com/support/docview.wss?rs=180&uid=swg27012415


groups also exist in the localOS repository. To determine whether the Active
Directory users exist in the localOS repository, log on to Tivoli Integrated Portal
and click Users and Groups > Manage users. You should not add the Active
Directory repository if the Active Directory users exist. If you plan to add the
Active Directory repository for performance reasons, you must remove the localOS
repository from the federated repositories.

The WebSphere Application Server cannot resolve duplicated users or groups if
these users or groups are present in more than one repository in the federated
repositories framework. For example, an Administrator user exists in both the
localOS and LDAP repository. You must ensure that the duplicated users (or
groups) are not used during the configuration or to manage Tivoli Storage
Productivity Center.

To add an LDAP repository to the federated repositories in Tivoli Storage
Productivity Center, complete the following steps. Contact your LDAP server
administrator for assistance.
1. Back up the Tivoli Integrated Portal WebSphere Application Server

configuration files. The WebSphere Application Server configuration backup
files provide a restoration point in the event of a failure when you complete
this procedure. This procedure uses the variable name
TIP_installation_directory to indicate where Tivoli Integrated Portal is
located.
a. Back up the WebSphere Application Server configuration files.

For the AIX or Linux operating systems, run the following command:
TIP_installation_directory/profiles/TIPProfile/bin/
backupConfig.sh

For the Windows operating systems, run the following command:
TIP_installation_directory\profiles\TIPProfile\bin\
backupConfig.bat

b. Back up the soap.client.props file for Tivoli Integrated Portal.
For the Windows operating systems, use the copy command to back up
this file:
TIP_installation_directory\profiles\TIPProfile\properties\
soap.client.props

For the AIX or Linux operating systems, use the cp command to back up
this file:
TIP_installation_directory/profiles/TIPProfile/properties/
soap.client.props

c. Back up the IBM Cognos 8.ear directory.
For Windows operating systems, enter the xcopy command to back up this
directory:
TIP_installation_directory\profiles\TIPProfile\installedApps\
TIPCell\IBM Cognos 8.ear

For the AIX or Linux operating systems, enter the cp command to back up
this directory:
TIP_installation_directory/profiles/TIPProfile/installedApps/
TIPCell/IBM Cognos 8.ear

d. The WebSphere Application Server backupConfig command generates a
compressed file: WebSphereConfig_YYYY-DD-MM.zip. When you run the
backupConfig command, the Tivoli Integrated Portal server will shut
down. The Tivoli Integrated Portal server must be restarted after the
backupConfig command is finished.
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To start the Tivoli Integrated Portal server, follow these steps:
1) For Windows operating systems, click Start > Administrative Tools >

Services. On the Windows Services page, right-click Tivoli Integrated
Portal - V2.2_TIPProfile_Port_xxxx where xxxx indicates the port
specified during installation and select Start.

2) For AIX or Linux operating systems, open a command prompt window
and enter the following command:
TIP_installation_directory/profiles/TIPProfile/bin/
startServer.sh

2. To restore the WebSphere Application Server and IBM Cognos configuration,
complete the following steps:
a. Restore the WebSphere configuration by running the restoreConfig.sh or

restoreConfig.bat command. The restoreConfig command is located here:
v For Windows operating systems:

TIP_installation_directory\profiles\TIPProfile\bin\
restoreConfig.bat

v For AIX or Linux operating systems:
TIP_installation_directory/profiles/TIPProfile/bin/
restoreConfig.sh

b. Restore the IBM Cognos 8.ear directory that you backed up in step 1c. For
the Windows operating systems, enter the xcopy command to replace the
contents of this directory:
TIP_installation_directory\profiles\TIPProfile\installedApps\TIPCell\IBM Cognos 8.ear

For the AIX or Linux operating systems, use the cp command to replace
the contents of this directory:
TIP_installation_directory/profiles/TIPProfile/installedApps/
TIPCell/IBM Cognos 8.ear

3. Open an Internet Explorer or Mozilla Firefox web browser and enter the
following information in the address bar:
http://hostname:port/ibm/console/logon.jsp

or
https://hostname:port/ibm/console/logon.jsp

Where hostname is the server that is running Tivoli Integrated Portal such as
the server name or IP address and port is the port number for Tivoli
Integrated Portal.
The port number differs depending on the protocol that you use (http or
https) and the options that you selected during the installation of Tivoli
Storage Productivity Center. For more information about port numbers, see
“Tivoli Integrated Portal port numbers” on page 229.
You can also contact your Tivoli Storage Productivity Center administrator to
verify the host name and port number.

4. On the Tivoli Integrated Portal logon page, log on using the appropriate user
ID and password. Your user ID must have Tivoli Integrated Portal
administrator authorization.

5. In the Tivoli Integrated Portal navigation tree, click Settings > WebSphere
Administrative Console.

6. In the Tivoli Integrated Portal window, click Launch WebSphere
administrative console.

7. In the WebSphere Application Server Administrative Console navigation tree,
click Security > Global security.
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8. On the Global security page, in the User account repository section, click the
Configure button next to the Available realm definitions list.

9. On the Global security > Federated repositories page, under "Related Items,"
click Manage repositories.

In this window, you must ensure that the Primary administrative user name
exists only in one repository. The WebSphere Application Server will not start
if this user name exists in multiple repositories.

10. On the Global security > Federated repositories > Manage repositories page,
add the LDAP repository that you want to use for authentication. Follow
these steps:

Figure 11. Global security page, configure federated repositories

Figure 12. Federated repositories page, Manage repositories
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a. Click Add to add a new repository.

b. Enter the values for the following fields:

Repository identifier
A unique identifier for the LDAP repository. This identifier
uniquely identifies the repository within the realm, for example,
LDAP1.

Directory type
The type of LDAP server that you want to connect to.

Primary host name
The host name of the primary LDAP server. This host name is
either an IP address or a domain name service (DNS) name.

Port The LDAP server port. The default value is 389. You can specify a
different port depending on your LDAP server configuration. If
you do not know what port to use, contact your LDAP server
administrator.

Bind distinguished name
The distinguished name (DN) for WebSphere Application Server to
use when binding to the LDAP repository. If no name is specified,
WebSphere Application Server binds anonymously. In most cases,
bind DN and bind password are required. However, when an
anonymous bind can satisfy all the required functions, bind DN
and bind password are not required.

Bind password
The password for WebSphere Application Server to use when
binding to the LDAP repository.

Login properties
The authentication properties that are used to log on to WebSphere
Application Server. Type uid;cn in this field. This value enables
WebSphere Application Server to use the property that is required
for the directory type.

Figure 13. Manage repositories page, Add a new repository
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c. Click OK.
d. In the messages dialog box that is displayed on the Manage repositories

page, click the Save link in Save directly to the master configuration.

Important: On the Global security > Federated repositories > Manage
repositories page, do not delete the "localOS" repository.

11. From the Manage repositories page, return to the Global security > Federated
repositories page.

12. Under "Repositories in the realm," click Add Base entry to Realm.

Figure 14. Manage repositories > New page

Figure 15. Global security > Federated repositories page, Add base entry to realm
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13. If the Messages dialog box is displayed on the Repository reference page, click
the Save link in Save directly to the master configuration.

14. On the Repository reference page, configure the following items:
a. In the Repository list, select the repository that you created in step 10 on

page 235.
b. In the Distinguished name of a base entry that uniquely identifies this

set of entries in the realm field, enter the distinguished name of a base
entry that uniquely identifies the repository in the realm.

c. In the Distinguished name of a base entry in this repository field, enter
the distinguished name of the base entry in the repository. In most
instances, this value is the same value that you entered in the
Distinguished name of a base entry that uniquely identifies this set of
entries in the realm field. Click OK.

d. In the messages dialog box that is displayed, click the Save link in Save
directly to the master configuration.

Important: In the Repositories in the realm table, do not remove the
InternalFileRepository entry. Do not remove the localOS entry, unless
you are planning to add an Active Directory repository to Tivoli Storage
Productivity Center that is installed on a computer that is a member of a
Windows domain and have verified that the Active Directory users exist in
the localOS repository.

15. Log out from the WebSphere Application Server Administrative Console.
16. Log out from the Tivoli Integrated Portal Administrative Console.
17. Stop and restart the Tivoli Integrated Portal server. For information about

stopping and starting the Tivoli Integrated Portal server, see the Tivoli Storage
Productivity Center information center. Search for Starting and stopping the
Tivoli Integrated Portal server.

Figure 16. Global security > Federated repositories > Repository reference page, Add base
entry to realm
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To verify that the LDAP federated repository is configured correctly, complete the
following steps:
1. Log on to Tivoli Integrated Portal by using the same user ID and password

from step 4 on page 234.
2. In the Tivoli Integrated Portal navigation tree, click Users and Groups >

Manage Users.
3. In the Search by list, select User ID.
4. Click Search to search for users in the federated repositories. The list of users

includes users from the local file repository, the operating system repository,
and the LDAP repository.

5. In the Tivoli Integrated Portal navigation tree, click Users and Groups >
Manage Groups.

6. In the Search by list, select Group name.
7. Click Search to search for groups in the federated repositories. The list of

groups includes groups from the operating system repository and the LDAP
repository.

Important: Before you establish the desired authorization configuration for
Tivoli Integrated Portal, Tivoli Storage Productivity Center, and Tivoli Storage
Productivity Center for Replication, you must ensure that there are no
duplicated user names or group names within the local file repository, the
operating system repository, and the LDAP repository.

After you have completed and verified the addition of an LDAP repository to the
Tivoli Storage Productivity Center federated repositories authentication
configuration, you must establish the desired authorization configuration for Tivoli
Integrated Portal. Tivoli Integrated Portal administrators require the iscadmins and
administrator roles. Operators viewing Tivoli Storage Productivity Center reports
require the tcrPortalOperator role. For Tivoli Storage Productivity Center Version
5.1 single sign-on and launch in context features to work correctly, the LDAP user
or group requires the following Tivoli Integrated Portal roles:
v administrator
v iscadmins
v tcrPortalOperator
v chartAdministrator
v monitor

For information about user roles and groups, go to the Tivoli Integrated Portal
administrative console online help. On the Welcome page, open the online help by
clicking ?. On the Help welcome page, click Using the Tivoli Integrated Portal >
Users and Groups in the navigation pane.

You should also assign Tivoli Storage Productivity Center roles to groups using the
Role-to-Group Mapping node in the Tivoli Storage Productivity Center
stand-alone GUI. You can map Tivoli Storage Productivity Center roles, such as
Tape Operator or Fabric Administrator, to user groups that you create in your
operating system repository and your LDAP repository. For information about the
Role-to-Group Mapping node, go to the Tivoli Storage Productivity Center
information center. Search for Role-to-Group Mappings.
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For information about assigning roles to users and roles to groups for Tivoli
Storage Productivity Center for Replication, go to the Tivoli Storage Productivity
Center information center. Search for Managing replication. On the Managing
replication page, click Security.

Enabling secure communication between Tivoli Storage Productivity Center and
the LDAP repository:

You can use the Secure Socket Layer (SSL) protocol to secure the communication
between Tivoli Storage Productivity Center and the LDAP repository that you are
using for user authentication. The SSL protocol provides security and data integrity
for communications over Transmission Control Protocol/Internet Protocol (TCP/IP)
networks.

To enable SSL for LDAP communications, you must complete the following steps
in Tivoli Integrated Portal:
1. Open an Internet Explorer or Firefox web browser. Enter the following

information in the address bar: https://hostname:port/ibm/console/logon.jsp
where hostname defines the server that is running Tivoli Integrated Portal such
as the server name or IP address and port defines the port number for Tivoli
Integrated Portal. To view information about Tivoli Integrated Portal port
numbers, see “Tivoli Integrated Portal port numbers” on page 229. Contact
your Tivoli Storage Productivity Center administrator if you must verify the
host name and port number.

2. On the Tivoli Integrated Portal logon page, log on using the appropriate user
ID and password. Your user ID must have Tivoli Integrated Portal
administrator authorization.

3. In the Tivoli Integrated Portal navigation tree, click Settings > WebSphere
Administrative Console.

4. In the Tivoli Integrated Portal content pane, click Launch WebSphere
administrative console.

5. In the WebSphere Administrative Console navigation tree, click Security >
SSL certificate and key management.

6. On the SSL certificate and key management page, in the "Related Items"
section, click Key stores and certificates.

7. On the Key stores and certificates page, in the table, click
NodeDefaultTrustStore.

8. On the NodeDefaultTrustStore page, in the "Additional Properties" section,
click Signer Certificates.

9. On the Signer Certificates page, click Retrieve from port.
10. On the Retrieve from port page, enter the values for the following fields:

Host The fully qualified host name and domain name of your
LDAP-compliant repository.

Port The port where the LDAP repository is listening for secure
communications; this port is usually 636.

SSL configuration for outbound connection
Accept the default value.

Alias An alias name for the retrieved certificate.
11. Click Retrieve signer information.
12. When the signer information is displayed, click OK.
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13. In the messages dialog box displayed on the Signer certificates page, click the
Save link in Save directly to the master configuration.

14. In the WebSphere Administrative Console navigation tree, click Security >
Global security.

15. On the Global security page, in the "User account repository" section, click the
Configure button next to the "Available realm definitions" drop-down list.

16. On the Global security > Federated repositories page, under "Related Items,"
click Manage repositories.

17. On the Global security > Federated repositories > Manage repositories page,
click the identifier for the LDAP repository for which you want to enable the
SSL protocol.

18. On the configuration page for the LDAP repository, configure the following
items:
a. In the Port field, enter the port where your LDAP repository is listening

for secure communications; this port is usually 636.
b. Select Require SSL communications.

Click OK.
19. In the messages dialog box displayed on the Manage repositories page, click

the Save link in Save directly to the master configuration.
20. Log out from the WebSphere Administrative Console.
21. Log out from the Tivoli Integrated Portal Administrative Console.
22. Stop and restart the Tivoli Integrated Portal server. For information about

stopping and starting the Tivoli Integrated Portal server, see the Tivoli Storage
Productivity Center information center. Search for Starting and stopping the
Tivoli Integrated Portal server.

Disabling secure communication between Tivoli Storage Productivity Center and
the LDAP repository:

You can disable the Secure Socket Layer (SSL) protocol between the LDAP
repository and the Tivoli Storage Productivity Center system at any time.

To disable the use of SSL, you must complete the following steps in Tivoli
Integrated Portal:
1. Open an Internet Explorer or Firefox web browser. Enter the following

information in the address bar: https://hostname:port/ibm/console/
logon.jsp where hostname defines the server that is running Tivoli Integrated
Portal such as the server name or IP address and port defines the port number
for Tivoli Integrated Portal. To view information about Tivoli Integrated Portal
port numbers, see “Tivoli Integrated Portal port numbers” on page 229.
Contact your Tivoli Storage Productivity Center administrator if you must
verify the host name and port number.

2. On the Tivoli Integrated Portal logon page, log on using the appropriate user
ID and password. Your user ID must have Tivoli Integrated Portal
administrator authorization.

3. In the Tivoli Integrated Portal navigation tree, click Settings > WebSphere
Administrative Console.

4. In the Tivoli Integrated Portal content pane, click Launch WebSphere
administrative console.

5. In the WebSphere Administrative Console navigation tree, click Security >
Global security.
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6. On the Global security page, in the "User account repository" section, click the
Configure button next to the "Available realm definitions" drop-down list.

7. On the Global security > Federated repositories page, under "Related Items,"
click Manage repositories.

8. On the Global security > Federated repositories > Manage repositories page,
click the identifier for the LDAP repository for which you want to disable the
SSL protocol.

9. On the configuration page for the LDAP repository, configure the following
items:
a. In the Port field, enter the port where your LDAP repository is listening

for nonsecure communications; this port is usually 389.
b. Clear the Require SSL communications check box.

Click OK.
10. In the messages dialog box displayed on the Manage repositories page, click

the Save link in Save directly to the master configuration.
11. Log out from the WebSphere Administrative Console.
12. Log out from the Tivoli Integrated Portal Administrative Console.
13. Stop and restart the Tivoli Integrated Portal server. For information about

stopping and starting the Tivoli Integrated Portal server, see the Tivoli Storage
Productivity Center information center. Search for Starting and stopping the
Tivoli Integrated Portal server.

Removing an LDAP repository from the federated repositories
To remove an LDAP repository from the federated repositories, you must use
Tivoli Integrated Portal.

If removing an LDAP repository from the federated repositories in Tivoli Storage
Productivity Center leaves only the localOS repository and the file-based
repository, then the use of the Tivoli Storage Productivity Center single sign-on
feature is limited. Storage system element managers do not support using the
localOS repository for single sign-on, even if the element manager is installed on
the same system as Tivoli Storage Productivity Center. This procedure uses the
variable name TIP_installation_directory to indicate where Tivoli Integrated
Portal is located.

To remove an LDAP repository from the federated repositories, complete the
following steps:
1. Back up the Tivoli Integrated Portal WebSphere configuration files. The

WebSphere configuration backup files provide a restoration point in the event
of a failure when performing this procedure. This procedure uses the variable
name TIP_installation_directory to indicate where Tivoli Integrated Portal
is located.
a. Back up the WebSphere configuration files.

For the AIX or Linux operating systems, run the following command:
TIP_installation_directory/profiles/TIPProfile/bin/
backupConfig.sh

For the Windows operating systems, run the following command:
TIP_installation_directory\profiles\TIPProfile\bin\
backupConfig.bat

b. Back up the soap.client.props file for Tivoli Integrated Portal .
For the Windows operating systems, use the copy command to back up
this file:
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TIP_installation_directory\profiles\TIPProfile\properties\
soap.client.props

For the AIX or Linux operating systems, use the cp command to back up
this file:
TIP_installation_directory/profiles/TIPProfile/properties/
soap.client.props

c. Back up the IBM Cognos 8.ear directory.
v For Windows operating systems:

TIP_installation_directory\profiles\TIPProfile\installedApps\
TIPCell\IBM Cognos 8.ear

v For AIX or Linux operating systems:
TIP_installation_directory/profiles/TIPProfile/installedApps/
TIPCell/IBM Cognos 8.ear

d. The WebSphere backupConfig command generates a compressed file:
WebSphereConfig_YYYY-DD-MM.zip. When you run the backupConfig
command, the Tivoli Integrated Portal server will shut down. The Tivoli
Integrated Portal server must be restarted after the backupConfig
command is finished.
To start the Tivoli Integrated Portal server, follow these steps:
1) For Windows operating systems, click Start > Administrative Tools >

Services. On the Windows Services page, right-click Tivoli Integrated
Portal - V2.2_TIPProfile_Port_xxxx where xxxx indicates the port
specified during installation. Select Start.

2) For AIX or Linux operating systems, open a command prompt window
and enter the following command:
TIP_installation_directory/profiles/TIPProfile/bin/
startServer.sh

2. To restore the WebSphere Application Server and IBM Cognos configuration,
complete the following steps:
a. Restore the WebSphere configuration by running the restoreConfig.sh or

restoreConfig.bat command. The restoreConfig command is located here:
v For Windows operating systems:

TIP_installation_directory\profiles\TIPProfile\bin\
restoreConfig.bat

v For AIX or Linux operating systems:
TIP_installation_directory/profiles/TIPProfile/bin/
restoreConfig.sh

b. Restore the IBM Cognos 8.ear directory that you backed up in step 1c.
v For the Windows operating systems, use the xcopy command to replace

the contents of this directory:
TIP_installation_directory\profiles\TIPProfile

v For the AIX or Linux operating systems, use the cp command to replace
the contents of this directory:
TIP_installation_directory/profiles/TIPProfile/installedApps/
TIPCell/IBM Cognos 8.ear

3. Open an Internet Explorer or Mozilla Firefox web browser, and type the
following information in the address bar:
https://hostname:port/ibm/console/logon.jsp

Where hostname defines the server that is running Tivoli Integrated Portal
such as the server name or IP address and port defines the port number for
Tivoli Integrated Portal. If the default port range was accepted during the

Chapter 4. Administering 243



installation of Tivoli Integrated Portal, the port number is 9569. Contact your
Tivoli Storage Productivity Center administrator if you must verify the host
name and port number.

4. On the Tivoli Integrated Portal logon page, log on using the appropriate user
ID and password. Your user ID must have administrator authorization.

5. In the Tivoli Integrated Portal navigation tree, click Settings > WebSphere
Administrative Console.

6. In the Tivoli Integrated Portal content pane, click Launch WebSphere
administrative console.

7. In the WebSphere Administrative Console navigation tree, click Security >
Global Security.

Figure 17. Launch the WebSphere administrative console
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8. On the Global security page, in the "User account repository" section, click
Configure next to the "Available realm definitions" drop-down list.

9. On the Global security > Federated repositories page, in the "Repositories in
the realm" table, select the entry for the LDAP repository you previously
added. Click Remove.

Figure 18. Opening the Global security page

Figure 19. Configuring the available realm definitions
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10. In the message dialog box displayed on the Federated repositories page, click
the Save link in Save directly to the master configuration.

11. On the Global security > Federated repositories page, under "Related items,"
click Manage repositories.

12. On the Global security > Federated repositories > Manage repositories page,
select the entry for the LDAP repository that you previously added and click
Delete.

Figure 20. Removing the LDAP repository

Figure 21. Managing the repositories
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13. In the message dialog box displayed on the Manage repositories page, click
the Save link in Save directly to the master configuration.

14. Log out from the WebSphere Administrative Console.
15. Log out from the Tivoli Integrated Portal Administrative Console.
16. Stop and restart the Tivoli Integrated Portal server. For information about

stopping and starting the server, go to the Tivoli Storage Productivity Center
information center. Search for starting and stopping the Tivoli Integrated Portal
server.

Important: Before establishing the desired authorization configuration for
Tivoli Integrated Portal, Tivoli Storage Productivity Center, and Tivoli Storage
Productivity Center for Replication, you must ensure that there are no
duplicated user names or group names within the local file-based repository
and the localOS repository.
After you have completed the removal of the LDAP repository from the Tivoli
Storage Productivity Center federated repositories authentication
configuration, you should establish the desired authorization configuration for
Tivoli Integrated Portal. Tivoli Integrated Portal administrators require the
iscadmins and administrator roles. Operators viewing Tivoli Common
Reporting reports require the tcrPortalOperator role. For information about
user roles and groups, go to the Tivoli Integrated Portal administrative console
online help. On the Welcome page, open the online help by clicking ?. On the
help welcome page, click Using the Tivoli Integrated Portal > Users and
Groups in the navigation pane.
You should also assign Tivoli Storage Productivity Center roles to groups
using the Role-to-Group Mapping node in the Tivoli Storage Productivity
Center stand-alone GUI. You can map Tivoli Storage Productivity Center roles,
such as Tape Operator or Fabric Administrator, to user groups that you create
in your local operating system repository. For information about the
Role-to-Group Mapping node, go to the Tivoli Storage Productivity Center
information center. Search for Role-to-Group Mappings.
For information about assigning roles to users and roles to groups for Tivoli
Storage Productivity Center for Replication, go to the Tivoli Storage

Figure 22. Deleting the LDAP repository
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Productivity Center information center. Search for Managing replication. On the
Managing replication page, click Security.

Changing the LTPA token expiration for single sign-on
For single sign-on, the user authentication information is passed between
applications using Lightweight Third-Party Authentication (LTPA) tokens. By
default, the tokens expire after eight hours. You can change the LTPA token
expiration time using the Tivoli Integrated Portal user interface.

To change the expiration time for the LTPA tokens, complete the following steps.
1. Start an Internet Explorer or Firefox web browser, and type the following

information in the address bar: https://hostname:port/ibm/console/
logon.jsp where hostname defines the server that is running Tivoli Integrated
Portal, such as the server name or IP address, and port defines the port
number for Tivoli Integrated Portal.
To view information about Tivoli Integrated Portal port numbers, see “Tivoli
Integrated Portal port numbers” on page 229. Contact your Tivoli Storage
Productivity Center administrator if you must verify the host name and port
number.

2. On the Tivoli Integrated Portal logon page, log on using the appropriate user
ID and password. Your user ID must have Tivoli Integrated Portal
administrator authorization.

3. In the Tivoli Integrated Portal navigation tree, click Settings > WebSphere
Administrative Console.

4. In the Tivoli Integrated Portal content pane, click Launch WebSphere
administrative console.

5. In the WebSphere Administrative Console navigation tree, click Security >
Global security.

6. On the Global security page, under "Authentication" and "Authentication
mechanisms and expiration", ensure that the LTPA radio button is selected.
Click the LTPA link.

7. On the Global security > LTPA page, under "LTPA Timeout", type the
expiration time in minutes in the "LTPA Timeout value for forwarded
credentials between servers" field. The default expiration time is 480 minutes
(eight hours). The expiration time must be greater than the authentication
cache timeout value. The authentication cache timeout value can be found by
clicking the Authentication cache settings link in the "Authentication" section
of the Global security page. The default authentication cache timeout value is
10 minutes. Click OK.

8. In the messages dialog box displayed on the Global security page, click the
Save link in Save directly to the master configuration.

9. Log out from the WebSphere Administrative Console.
10. Log out from the Tivoli Integrated Portal Administrative Console.
11. Stop and restart the Tivoli Integrated Portal server. For information about

stopping and starting the server, go to the Tivoli Storage Productivity Center
information center. Search for starting and stopping the Tivoli Integrated Portal
server.
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Administering data sources
Use the following topics for information about how to administer CIM agents,
Storage Resource agents, out-of-band Fabric agents, storage systems, Tivoli Storage
Productivity Center servers, and VMware VI data sources.

Checking the health of your data sources
This topic provides information about checking the health of your data sources.

The storage systems that use the native interfaces (for example, DS8000, the XIV
system, SAN Volume Controller, and Storwize V7000) do not use CIMOM agents.
Once you successfully connect to the storage system, Tivoli Storage Productivity
Center can display the status.

Expand Administrative Services > Data Sources and left-click the following
nodes:
v CIMOM Agents
v Data/Storage Resource Agents
v Inband Fabric Agents
v Out of Band Fabric Agents
v Storage Subsystems
v TPC Servers
v VMware VI Data Source

A list of data sources is displayed in the content pane. If the agents are up and
running, there is a green health status icon in the State column. For the CIMOM
Agents and Storage Subsystems, a green health status icon is displayed in the
Connection Status column.

Manually changing the Windows service logon for the agent
This topic describes how to change the Windows service logon for the Common
agent.

To change the Windows service logon for the Common agent, complete the
following steps:
1. In Windows, open the Services panel: Start > Settings > Control Panel >

Administrative Tools > Services.
2. On the Services panel, right-click IBM Tivoli Common agent - 'C:\Program

Files\IBM\TPC\ca'. Select Properties.
3. Select the Log On tab. Change This account field with your changed logon ID.

If your Tivoli Storage Productivity Center server is part of a Windows domain,
change this logon to <domain>\<account>. For example, mydomain\myaccount.
Enter the password if you have changed the password. Click Enable and then
OK. The Common agent requires that the domain account have local
administrator privileges as well as "Log on as a service" and "Act as part of the
operating system" user rights.

CIM agents
Common Information Model (CIM) agents provide a CIM interface for storage
entities. IBM Tivoli Storage Productivity Center uses CIM agents to collect
information about the entities that you want to monitor.
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These entities include IBM TotalStorage Enterprise Storage Server, IBM System
Storage DS4000, IBM System Storage DS5000 Storage Manager, IBM System Storage
DS6000, tape, switch, and any SMI-S certified Common Information Model Object
Manager (CIMOM).

CIM agents are no longer required for the following storage systems:
v System Storage DS8000
v SAN Volume Controller
v The XIV system
v Storwize V7000
v Storwize V7000 Unified
v IBM SONAS

Before you can monitor the entities that are managed by CIM agents, you must
configure the agents in the Tivoli Storage Productivity Center user interface. Use
either of the following methods to add a CIM agent:
v Use the Configure Devices wizard to automatically add a CIM agent and

discover the entities that it manages. For more information, see “Configure
Devices wizard” on page 307.

v Manually add the CIM agent using the CIMOM Agents node under
Administrative Services > Data Sources in the navigation tree. For more
information, see “Adding a CIM agent connection.”
After you manually add a CIM agent, you must run a discovery to detect the
entities that it manages. For more information about the discovery process, see
“Discover storage subsystem, tape library, and fabric information with CIM
agents” on page 333 and “Discover CIM agents automatically” on page 252.

Adding a CIM agent connection
CIM agents provide a Common Information Model (CIM) interface for
management applications. This topic discusses how to add a CIM agent
connection.

You can add a CIM agent connection to Tivoli Storage Productivity Center by
using the Configure Devices wizard or use the manual steps in this procedure.

To add a CIM agent connection using the Configure Devices wizard, see
“Configure Devices wizard” on page 307.

To add a CIM agent connection to Tivoli Storage Productivity Center manually,
complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Data Sources

and click CIMOM Agents.
2. In the content pane, click Add CIMOM. The Add CIMOM window opens.
3. Specify information about the CIM agent:

Host The hostname of the computer on which the CIMOM is installed. For
element managers, you can enter a host name, IPv4, or IPv6 address
depending on what is supported within your environment:
v Enter an IPv4 address in the following format: ###.###.###.###. For

example: 192.168.1.65
v Enter an IPv6 address. The preferred IPv6 address representation is

written as eight groups of four hexadecimal digits:
xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx, where each x is a
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hexadecimal digit representing 4 bits. For example:
2001:DB8:0000:1234:0000:0000:5678:ABCD. You can also specify IPv6
addresses using shortened formats that omit leading zeros
2001:DB8:0:1234:0:0:5678:ABCD or use double colons
2001:DB8:0000:1234::5678:ABCD in place of a series of zeros.
You can enter an IPv6 address for a CIMOM if the computer where
IBM Tivoli Storage Productivity Center is installed is IPv6 or dual
stack (IPv4 and IPv6) enabled.

Port The port on which the CIMOM is listening. By default this port is 5989
for a secure connection and 5988 for an unsecured connection. See the
documentation for the appropriate SMI-S CIM Provider for more
information about available ports.

Username
The user ID used for authentication, if required by the CIMOM.

Password
The password, if required by the CIMOM.

Interoperability Namespace
This namespace within the CIMOM allows for accessing the CIM
Interop Schema (including the class instances of the Server Profile) and
determines how IBM Tivoli Storage Productivity Center interacts with
the CIMOM when retrieving information. For information about the
namespace to use, see http://www-01.ibm.com/support/
docview.wss?uid=swg21386446. Click the appropriate version for
Switches & Directors.

To view a list of default namespaces for CIMOM agents for storage
subsystems that is included with Tivoli Storage Productivity Center,
open the following file in a text editor: install_directory/data/
config/namespace.config, where install_directory represents the
directory where the product is installed.

Check the documentation of the appropriate SMI-S CIM Provider or
contact the storage system vendor to ensure that you use the most
current namespaces.

Protocol
The version of the cim-xml protocol. Can be http or https.

Display Name
The name of the CIMOM, as specified by the CIMOM provider, to be
displayed in the Tivoli Storage Productivity Center interface.

Description
An optional description of the CIMOM. This description can be any
combination of alphanumeric characters.

Test CIMOM connectivity before adding
Select this option to have Tivoli Storage Productivity Center ensure that
communication to the CIMOM is working properly before adding
information about that CIMOM.

4. Click Save.

This procedure does not physically add a CIMOM, but adds the information you
have given about the CIMOM to Tivoli Storage Productivity Center so that Tivoli
Storage Productivity Center can communicate with the CIMOM.
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Discover CIM agents automatically
This topic discusses how to discover storage subsystem CIMOMs that are visible to
the Device server using Service Location Protocol (SLP).

In many cases CIM agents can be automatically discovered using SLP. The criteria
is that the CIM agent must be visible to the Device server.

To automatically discover all CIM agents that are visible to the Device server,
complete the following steps:
1. In the navigation tree pane, expand Administrative Services > Discovery and

click CIMOM.
a. Click the Options tab.
b. Enter the IP address or host name for the SLP directory agents for CIMOM

discovery. Or select the Scan local subnet check box.
c. Click File > Save on the menu bar to save the information.

2. Right-click CIMOM and click Run Now.
3. After you submit a CIMOM discovery job, a message window is displayed

with the text CIMOM Discovery Job submitted. Click OK. The job name is
located in the navigation tree after CIMOM. While it is running, the CIMOM
job has a blue circle outline by the job name.

4. To determine if the job has completed, right-click CIMOM and click Update
Job Status. If the job has completed successfully, a green box is shown by the
job name. If the job has completed but failed, a red circle is shown.

Note: The job returns as failed if one or more sub-jobs failed. Some CIMOMs
might still have been discovered.

5. After the job completes, the discovered CIM agents are listed in the CIMOM
Agents table. Expand Administrative Services > Data Sources and click
CIMOM Agents.

6. For each CIM agent that you want to use, highlight the CIM agent and click
the magnifying glass for the listing. You must select the CIM agents one at a
time. The CIMOM Agents window is opened.

7. Enter additional information for the CIM agent, such as the user name and
password, and select the Test CIMOM connectivity before updating check
box.

8. Click File > Save on the menu bar to save the information and perform a
connectivity check.

Note: This procedure does not physically add the CIM agent to your environment,
but provides IBM Tivoli Storage Productivity Center with the information it needs
to communicate with that CIM agent. This includes information that you have
defined and CIM agents discovered using SLP.

Viewing information about a CIM agent
Use panels and reports in IBM Tivoli Storage Productivity Center to view detailed
information about a CIM agent.

Use the following reports to view information about a CIM agent:
v In the Navigation Tree pane, expand IBM Tivoli Storage Productivity Center >

Reporting > Data Source Reports > CIMOM Agents and click By CIMOM
Agent or By Managed Device. See “Data source reports - CIMOM agents” on
page 1133 for more information about these reports.
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v In the Navigation Tree pane, expand Administrative Services > Data Sources
and click CIMOM Agents. A list of CIM agents appears in the content pane.
Click the magnifying glass next to a CIM agent to view the following
information about that agent:

Service URL
The service URL of the CIMOM containing the IP address of the
CIMOM, the port on which the CIMOM is listening, and the protocol
used for communication. This URL has a protocol [http|https], an IP or
Hostname, and a port number. This field displays IPv4 and IPv6
addresses as appropriate.

Display Name
The name of the CIMOM as specified by the CIMOM provider that will
appear in the IBM Tivoli Storage Productivity Center interface.

Description
The optional description that was entered on the Add CIMOM window.

Username
The CIMOM user ID used for authentication.

Password
The password for the CIMOM.

Interoperability Namespace
Enter the interoperability namespace of the CIMOM. This namespace
within the CIMOM allows for accessing the CIM Interop Schema
(including the class instances of the Server Profile) and determines how
Tivoli Storage Productivity Center interacts with the CIMOM when
retrieving information.

Truststore Location
The location (path on this computer) of a certificate file for certificate
based authentication in the https protocol.

User Interface Description
The name of the Human Interface Service (if any) supported by this
CIMOM.

Software Level
The software version level of the CIMOM agent.

Protocol Version
The version of the cim-xml protocol.

Authentication Mechanism
The authentication mechanism supported by the CIMOM. This field can
contain the following values: Unknown, None, Other, Basic, Digest.

Alias The alias of the CIMOM.

Service ID
The service ID for the CIMOM.

Protocol
The communication protocol used for the CIMOM. Possible values are
http and https.

SLP Attributes
The standard set of attributes for this CIMOM. The attributes are
retrieved via SLP.
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Connection Status
The status of this CIMOM with respect to Tivoli Storage Productivity
Center. Possible values are: SUCCESS, UNCONFIGURED, UNKNOWN,
INVALID_NAMESPACE, TIMEOUT, REFUSED, LOGIN_FAILED,
SSL_HANDSHAKE_ERROR, SSL_REGISTRATION_INVALID,
CIMCLIENT_ERROR

Status Timestamp
The date/time when the Connection Status information was last
collected.

Test CIMOM connectivity before updating
If this box is checked Tivoli Storage Productivity Center ensures that
communication to the CIMOM is working properly before making any
changes.

Updating CIM agent user identification
After a CIM agent has been added to the CIMOM node, you can update the user
ID, password, and other information.

To update the CIM agent user identification, follow this procedure:
1. In the Navigation Tree window, expand Administrative Services > Data

Sources. Left-click CIMOM.
2. In the content pane, click the magnifying glass icon for the agent for which you

want to change information.
3. Information about the CIM agent is displayed in the Information window. The

fields which can be updated are:

Display Name
The name of the CIM agent, as specified by the CIMOM provider, that
will appear in the IBM Tivoli Storage Productivity Center interface.

Description
The optional description of the CIM agent that was entered on the Add
CIMOM Agent window.Tivoli Storage Productivity Center

Username
The user ID used for authentication, if required by the CIM agent.

Password
The password for the CIM agent, if required by the CIM agent.

Interoperability Namespace
This namespace within the CIM agent allows for accessing the CIM
Interop Schema (including the class instances of the Server Profile) and
determines how Tivoli Storage Productivity Center interacts with the
CIM agent when retrieving information.

Test CIMOM connectivity before updating
Check box. Check this box to have Tivoli Storage Productivity Center
ensure that communication to the CIM agent is working properly
before updating information about that CIM agent.

4. Save your changes by clicking the Save icon.
v If you have selected Test CIMOM connectivity before updating, the

CIMOM connectivity check will be run when you save the changes.
v If Test CIMOM connectivity before updating is not selected, a discovery

will be started immediately after you save the changes.
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Testing a CIM agent connection
Manually check to make sure that communication to the CIM agent is working
properly.

To test a CIM agent connection, follow this procedure:
1. In the Navigation Tree, expand Administrative Services > Data Sources.

Left-click CIMOM.
2. In the content pane, select a CIM agent. Click Test CIMOM Connection. a

confirmation dialog appears: "Testing CIMOM connectivity can take up to
several minutes in case of an incorrectly entered port number, network
problems or an unpassed firewall. Would you like to continue anyway?" Select
yes to perform the CIMOM connection test.

3. To close the Test CIMOM Connection window, click OK.

Removing a CIM agent
You can remove a CIM agent from the navigation tree and the repository database.
Data discovered by the CIM agent is not removed from the repository.

To remove a CIM agent, follow this procedure:
1. In the Navigation Tree pane, expand Administrative Services > Data Sources.

Click CIMOM Agents.
2. In the content pane, select a CIM agent. Click Remove CIMOM.
3. The Remove CIMOM confirmation window opens. Click Yes. The CIM agent is

immediately deleted from the list.

Show managed devices for a CIM agent
You can display the managed devices for a CIM agent.

To show the managed devices for a CIM agent, follow these steps:
1. In the Navigation Tree pane, expand Administrative Services > Data Sources.

Click CIMOM Agents.
2. In the content pane, select a CIM agent. Click Show Managed Devices.
3. The CIMOM Managed Devices window opens displaying the managed devices.

Click OK to close the window.

Collecting CIM agent logs
You can collect logs for certain IBM CIM agents using the command line interface.

Remember: Storage systems that use the native interfaces (for example, DS8000,
the XIV system, SAN Volume Controller, and Storwize V7000) do not use CIM
agents.
1. Change to the directory where the CIM agent is installed.

v On Linux operating systems, DS3000, DS4000, DS5000, DS6000 are installed
at /opt/IBM/cimagent/cimom

v On Windows operating systems, DS3000, DS4000, DS5000, DS6000 are
installed at C:\Program Files\IBM\cimagent\cimom

2. Run one of the following commands:

On Linux operating systems
collectLogs.sh

On Windows operating systems
collectLogs.bat
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A collectedLogs.zip file is created.

Important: This file is overwritten if you run the script again.

Verifying that a CIM agent is running
You can verify that a CIM agent is running from the command line interface.

To verify that a CIM agent is up and running, run the following command:
telnet <IP> <port>

Where <IP> is the IP address of the system where the CIM agent is installed, and
<port> is the port number. By default, this is 5989 for a secure connection and 5988
for an unsecure connection.

Storage Resource agents
This topic provides information about administering, configuring, and viewing
information about Storage Resource agents.

See “Deployment guidelines and limitations for Storage Resource agents” on page
118 for information about deploying Storage Resource agents.

Viewing information about an agent
View detailed information about a Storage Resource agent.

To view information about a Storage Resource agent from the Tivoli Storage
Productivity Center GUI, complete the following steps:
1. In the navigation tree, click Administrative Services > Data Sources. Left-click

Data/Storage Resource Agents.
2. In the content pane, click the magnifying glass icon for an agent under the list

of agents. In the content pane, a notebook window opens. On the General page,
the following information is displayed:

Agent Displays the name of an agent and indicates whether the agent is up or
down.

Port Displays the port number on which an agent is listening for requests.

Installation Location
Displays where the agent is installed.

Host Address
Displays the host address of the computer on which an agent is
running.

Last update
Displays the date and time when an agent was last updated.

Time Zone
Displays the current time zone for an agent.

Connection Errors
Displays any connection errors that occurred for an agent.

Consecutive Errors
Displays how many errors occurred consecutively.

HBA Data
Displays information about the HBA installed.
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3. Click the Details tab to view more detailed information. The following
information is displayed:

Agent Displays the name of the agent.

Host Displays the host name of the system on which the agent is running.

Host ID
Displays the identifier of the host computer in hexadecimal format.
Tivoli Storage Productivity Center collects only Host ID information for
Solaris systems. All other platforms display GUID information in the
Host ID column.

Start Time
Displays the date and time that the agent was started.

Elapsed Time
Displays the time elapsed since the agent was last updated.

VM Size
Displays the size (in MB) of the disk space that is allotted to virtual
memory for an agent. This value does not apply to Storage Resource
agents. This size applies only to the size of the Java virtual machines
for the agents.

Manufacturer
Displays the manufacturer of the system.

OS Type
Displays the operating system that is running on the system.

CPU Architecture
Displays the architecture of the system.

Job Count
Displays the number of jobs scheduled to run against the agent.

4. Click the Jobs tab to view information about the jobs scheduled to run on the
managed system.

Viewing an agent log file
The log file for a Storage Resource agent contains informational, warning, and
error messages for the previous sessions of the agent. You can use the log file to
troubleshoot errors that might occur when starting an agent, processing, or
shutting down the agent.

The log file is located in the agent installation directory:

Storage Resource agents
For Windows default: C:\Program Files\IBM\TPC\agent\log\
<computer_name>\agent.log.

For Linux or AIX (default): /opt/IBM/TPC/agent/log/
<computer_name>agent.log.

To view the log for a Storage Resource agent, complete the following steps:
1. In the navigation tree, click Administrative Services > Data Sources. Left-click

Data/Storage Resource Agents.
2. In the content pane, select an agent and click View Log.

Migrating a Data agent
Migrate a selected Data agent to a Storage Resource agent.
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Tivoli Storage Productivity Center provides the following benefits when you
migrate an existing Data agent or Inband Fabric agent to a Storage Resource agent:
v Storage Resource agents require less resources on a host computer than a Data

agent or Fabric agent that is based on Common Agent Services. Additionally,
you can deploy a Storage Resource agent as a daemon or non-daemon service.

v Reduced complexity when deploying agents. You can deploy Storage Resource
agents directly from the Tivoli Storage Productivity Center user interface and
they do not require you to install Agent Manager.

v Improved interface when deploying, upgrading, and administering agents. You
can manage Storage Resource agents using the nodes in the Administrative
Services section of the navigation tree. You can deploy and upgrade Storage
Resource agents on schedules that you define.

To migrate a Storage Resource agent from the Administrative Services > Data
Sources node in the user interface, complete the following steps:
1. In the navigation tree, expand Administrative Services > Data Sources.

Left-click Data/Storage Resource Agents.
2. In the content pane, click Migrate Agents.
3. The Create Data/Fabric Agent Migration panel is displayed. Use this panel to

schedule the migration of Data agents and Inband Fabric agents to Storage
Resource agents.

4. Select File > Save to save the migration schedule. The agents on the computers
that you specified are migrated according to the schedule that you defined.

The migration process deploys a Storage Resource agent on the target computer
and then uninstalls the Data agent. The new Storage Resource agent retains the
existing scheduled jobs that were defined for the Data agent. The scripts and batch
reports for the Data agent are copied over to the Storage Resource agent. If for any
reason the migration fails, Tivoli Storage Productivity Center restores the Data
agent so that it can continue to monitor the target computer.

Migrate Data/Fabric Agent
Define schedules to migrate existing Data agents or in-band Fabric agents to
Storage Resource agents. The migration process deploys a Storage Resource agent
on a target host and then uninstalls the existing agent.

Tivoli Storage Productivity Center provides the following benefits when you
migrate an existing Data agent or in-band Fabric agent to a Storage Resource
agent:
v Storage Resource agents require less resources on a host computer than a Data

agent or Fabric agent that is based on Common Agent Services. Additionally,
you can deploy a Storage Resource agent as a daemon or non-daemon service.

v Reduced complexity when deploying agents. You can deploy Storage Resource
agents directly from the Tivoli Storage Productivity Center user interface and
they do not require you to install Agent Manager.

v Improved interface when deploying, upgrading, and administering agents. You
can manage Storage Resource agents using the nodes in the Administrative
Services section of the navigation tree. You can deploy and upgrade Storage
Resource agents on schedules that you define.

To migrate a Data agent or Fabric agent to a Storage Resource agent from the
Administrative Services > Configuration node in the user interface, complete the
following steps:
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1. Use either of the following methods to access the panel for scheduling an agent
migration:
v Expand Administrative Services > Data Sources in the navigation tree.

Left-click Data/Storage Resource Agents. In the topic pane, click Migrate
Agents.

v Expand Administrative Services > Configuration in the navigation tree.
Right-click Migrate Data/Fabric Agent and select Create Data/Fabric Agent
Migration from the menu.

The content pane displays a panel for defining a migration schedule.
2. Use the following pages on the panel to define information about the

migration:

Computers
Use this page to select the computers and groups of computers that
contain the Data and Fabric agents that you want to migrate to Storage
Resource agents.

When to Run
Use this page to determine when the Data and Fabric agents in a
schedule are migrated.

Options
Use this page to specify the runtime settings of a Storage Resource
agent, the method for migrating an agent, and the login credentials for
an agent. If you include multiple agents in a migration schedule, the
settings that you define on this panel are applied to all those agent
migrations.

Alerts Use this page to define the actions that occur if a Data/Fabric Agent
Migration schedule fails.

3. Select File > Save to save the migration schedule. The agents on the computers
that you specified are migrated according to the schedule that you defined.

The migration process deploys a Storage Resource agent on the target computer
and then uninstalls the Data agent. The new Storage Resource agent retains the
existing scheduled jobs that were defined for the Data agent. The scripts and batch
reports for the Data agent are copied over to the Storage Resource agent.

Upgrading the Storage Resource agent by using the Data
Sources node
Use this information to upgrade a previous Storage Resource agent to the current
release.

To upgrade a Storage Resource agent, follow these steps:
1. In the navigation tree, expand Administrative Services > Data Sources.

Left-click Data/Storage Resource Agents.
2. In the topic pane, select one or more agents for which you want to upgrade.

Click Upgrade Agents.
3. The Create Storage Resource Agent Upgrade page is displayed. Use this page

to schedule an upgrade of the Storage Resource agent. You have the following
tabs:

Computers
You can select Computer Groups or Computers.

When to Run
You can specify how often to run the job or how to handle time zones.
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Options
You can specify to force an upgrade for an agent, maintenance upgrade
for an agent, or language pack to apply to an agent.

Alerts You can specify the triggering conditions and triggering actions.

Enter your information in the appropriate fields.
4. Save and run the job.

Note: The Storage Resource agent upgrade job delivers the software upgrade
packages to the agent computer. The job log displays the status of the delivery. The
actual status of the upgrade is found in the agent log on the agent computer. If the
agent log indicates that the upgrade failed and the state of the Storage Resource
agent remains in the “Upgrading agent software status”, try restarting the agent
and running the upgrade job again.

Storage Resource Agent Upgrades
You can configure IBM Tivoli Storage Productivity Center for a Storage Resource
agent upgrade.

When you apply maintenance to Tivoli Storage Productivity Center, you can
upgrade the Storage Resource agent now or upgrade the agent at a later time. To
ensure that all your agents are at the current release level and to manage your
network load, schedule upgrades on a regular basis.

To configure Tivoli Storage Productivity Center for a Storage Resource agent
upgrade, complete the following steps:
1. In the navigation tree, expand Administrative Services > Configuration >

Storage Resource Agent Upgrades.
2. Right-click on Storage Resource Agent Upgrades. Click Create Storage

Resource Agent Upgrade.
3. The Create Storage Resource Agent Upgrade page is displayed in the topic

pane. You have the following tabs:

Computers
You can select Computer Groups or Computers.

When to Run
You can specify how often to run the job or how to handle time zones.

Options
You can specify to force an upgrade for an agent, maintenance upgrade
for an agent, or language pack to apply to an agent.

Alerts You can specify the triggering conditions and triggering actions.

Enter your information in the appropriate fields.
4. Save and run the job.

Configuring tracing for an agent
You can configure and enable tracing for a Storage Resource agent. This provides
extensive logging of exception and trace messages; it can provide useful
information for the IBM Support center.

You must have administrator authority to perform this procedure.

To configure tracing for a Storage Resource agent, complete the following steps:

260 IBM Tivoli Storage Productivity Center: User's Guide



1. In the navigation tree, click Administrative Services > Data Sources . Left-click
Data/Storage Resource Agents.

2. In the topic pane, select a Storage Resource agent. Under the Select Action
menu, click Configure Tracing. The Tracing Configuration window opens.

3. Select the Enable Trace check box.
4. Specify the tracing options:

a. In the Level field, select one of the following options:

DEBUG_MIN
Minimum level of debugging

DEBUG_MID
Medium level of debugging

DEBUG_MAX
Maximum level of debugging

b. In the Maximum Number of Files field, specify the maximum number of
trace files that are created. When this number is reached, the oldest file is
overwritten. By default, this value is set to five.

c. In the Maximum File Size (kilobytes) field, specify the maximum size of
each trace file.

5. Click OK. The settings are saved to the AgentTraceLog.config file

Disabling an agent
You can disable a Storage Resource agent. Disabling the agent signifies that the
Storage Resource agent is unavailable and the Data server should not contact that
agent for any job processing.

You might want to disable a Storage Resource agent in the following situations:
v The agent computer is undergoing maintenance and is unavailable. This action

prevents the server from flagging the agent as "down" if it cannot reach the
agent. The amount of times that the server tries to contact the agent is defined
by the agentErrorLimit parameter in the server.config file.

v The agent computer is busy with resource-intensive processing and you do not
want to add any jobs to that processing load.

While disabled, the agent name in the user interface is outlined with a red circle
with a line through it. The server does not attempt to contact the agent.

To disable a Storage Resource agent, complete the following steps:
1. In the navigation tree, click Administrative Services > Data Sources > .

Left-click Data/Storage Resource Agents.
2. In the topic pane, select a Storage Resource agent. Under the Select Action

menu, click Disable.

Enabling an agent
You can enable an agent that is currently disabled. After it is enabled, the Data
server resumes communication with that agent. This action is available for disabled
agents only.

If the server cannot contact an agent, the server automatically flags the agent as
"down". Click Enable to reestablish communication between the agent and server.
The number of times the server tries to contact the agent is specified in the
agentErrorLimit parameter in the server.config file. The default is 3.
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The default directory for the server.config file is:

Windows
C:\Program Files\IBM\TPC\Data\config

Linux or UNIX
/opt/IBM/TPC/Data/config

Tip: Clicking Check also enables an agent that is disabled.

To enable an agent, complete the following steps:
1. In the navigation tree, click Administrative Services > Data Sources. Left-click

Data/Storage Resource Agents.
2. In the content pane, select an agent. Under the Select Action menu, click

Enable.

Shutting down an agent
You can shut down Storage Resource agents (run as daemon processes) from the
graphical user interface.

To shut down an agent, complete the following steps:
1. In the navigation tree, click Administrative Services > Data Sources. Left-click

Data/Storage Resource Agents.
2. In the topic pane, select a Storage Resource agent. Under the Select Action

menu, click Shutdown. This button is unavailable for Storage Resource agents
that are deployed as non-daemons.

3. Select how you want an agent to shut down. You can select from the following
options:

Normal
Shut down the agent software and let all running processes complete.
The agent continues to accept new jobs that are submitted and is not
shut down until the following conditions are met:
v All running processes are complete.
v There are no new jobs submitted.

Immediate
Shut down the agent software when the currently running processes
complete. No new jobs are accepted by the agent and shutdown occurs
immediately after the last job completes.

Abort Shut down the agent software and stop whatever processes are
currently running.

For Storage Resource agents that are run as daemon processes, click Start on
the Data/Storage Resource agent page to start those agents. See “Starting a
Storage Resource agent” for more information about how to start Storage
Resource agents.

Starting a Storage Resource agent
You can start a Storage Resource agent if the daemon process for that Storage
Resource agent is down.

You can only perform this task for Storage Resource agents running as a daemon
service.

To start a Storage Resource agent, complete the following steps:
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1. In the navigation tree, click Administrative Services > Data Sources. Left-click
Data/Storage Resource Agents.

2. In the content pane, select a Storage Resource agent. Under the Select Action
menu, click Start.

3. Enter the user ID and password that Tivoli Storage Productivity Center uses
when logging in to the host computer for a Storage Resource agent agent and
click Ok.

Checking whether an agent can communicate with the Data
server
You can check whether an agent can communicate with the Data server.

To check an agent, complete the following steps:
1. In the navigation tree, click Administrative Services > Data Sources. Left-click

Data/Storage Resource Agents.
2. In the topic pane, select an agent and click Check.

This operation verifies that the Data server can communicate with the host
system where the Storage Resource agent is deployed with the appropriate
authentication information. After verifying that the Data server can
communicate with the selected agent, the process checks for the existence of the
runtime files for Storage Resource agents.

Changing authentication for a Storage Resource agent
There are times when you might need to change the user ID, password, and
certificate location for a Storage Resource agent.

To change the authentication for a Storage Resource agent, follow these steps:
1. In the navigation tree, expand Administrative Services > Data Sources.

Left-click Data/Storage Resource Agents.
2. In the content pane, select one or more Storage Resource agents for which you

want to change authentication information. Use ctrl + click or shift + click to
select multiple agents.

3. Click Change Authentication from the Select Action menu.
4. In the Change Authentication window, enter the following information:

User Enter the user ID that IBM Tivoli Storage Productivity Center should
use when logging on to the computer on which the Storage Resource
agent is installed.

Requirement: This ID must have administrative or root privileges
when installing a Storage Resource agent on a computer.

Password
Enter the password.

Certificate Location
Enter the fully qualified path of the certificate on the computer where
the Data server is located. This file is used for certificate-based
authentication. If you do not enter a value in this field the default
location is used. When deploying Storage Resource agents, Tivoli
Storage Productivity Center uses the Secure Shell (SSH) protocol to
communicate with the target computer.

Passphrase
Enter the passphrase for the certificate file. The passphrase was created
when the certificate was generated.
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Click Save.

Related Tasks:

See Planning > General Planning > Planning for Storage Resource agents section
in the IBM Tivoli Storage Productivity Center Installation and Configuration Guide for
additional configuration information about certificates used after deployment.

Adding Storage Resource agents
You can add Storage Resource agents to your system by scheduling a job or by
adding an agent immediately.

To add a Storage Resource agent, complete the following steps:
1. In the navigation tree, click Administrative Services > Configuration.

Right-click Storage Resource Agent Deployments. On the menu, click Create
Storage Resource Agent Deployments.

2. The Create Storage Resource agent Deployments window opens displaying the
Computers page. Enter the following information:

Header fields

Creator
Predefined creator name.

Name Predefined name.

Description (optional)
Enter a user-defined description name for the job.

Enabled
Check this box to enable Storage Resource agent deployments.

Add Host List
Click this button to manually enter names and logon credentials for the
computers on which you want to deploy Storage Resource agents.

If you click this button, the Login Information window opens. You can
enter information in the following ways:
v Click Add Agents from MS Directory to install Storage Resource

agents on one or more Windows computers that are members of a
Windows domain. Enter the domain controller name and login
information about the displayed window. On the next window, select
the domain and click Get List of Domain Computers. The host
names of computers that you add using this method are displayed in
the Remote Agent Machines section of the window. In that section,
you can also specify an installation location for each computer and
indicate whether you are reinstalling a Storage Resource agent on a
computer.

v Click this button to retrieve a list of computer names from a flat text
file. The computers listed in the file are automatically added to the
deployment schedule and displayed in the Remote Agent Machines
section. In that section, you can also specify an installation location
for each computer and indicate whether you are reinstalling a
Storage Resource agent on a computer.
The file that you retrieve must contain one host name or IP address
per line. For example:
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systemxyz.storage.usa.ibm.com
9.79.179.179
systemzyx.storage.usa.ibm.com
9.89.189.189

If Tivoli Storage Productivity Center discovers any syntax problems
in the file, none of the host entries in the file are added to the
deployment job.

v In the Remote Agent Machines section, enter the names or IP
addresses of the computers where you want to deploy the Storage
Resource agents. Specify the installation location for the Storage
Resource agent runtime files. If you do not enter an installation
location, the default location is used. The default installation
directories are:
– For Windows: C:\Program Files\IBM\TPC\agent

– For Linux and UNIX: /opt/IBM/TPC/agent
v Select Force under the following circumstances:

– If an earlier Storage Resource agent installation failed and there
are damaged agent files on the computer that cause further
installations to fail. If you select this option, Tivoli Storage
Productivity Center attempts to overwrite the previous failed
deployment on the computer with a new Storage Resource agent.

– If you want an existing Storage Resource agent to communicate
with an additional Tivoli Storage Productivity Center server. To do
this, you must create the deployment job from the additional
Tivoli Storage Productivity Center server to which you want the
Storage Resource agent to communicate.
To install the Storage Resource agent to communicate with two
different servers using the same location, follow the example in
these steps:
a. From server 1 (S1), install the Storage Resource agent to the

location C:\Program Files\IBM\TPC\agent using port 9510.
b. From server 2 (S2), install the Storage Resource agent in the

same location using the same port 9510 and specify the Force
option. This option is required when you install the Storage
Resource agent in the same location.

If you want to install two Storage Resource agents on the same
system, each with a different port, install the agents using
different port numbers and different locations.

Note:

– You cannot change the communication type for a Storage Resource
agent (daemon or non-daemon) when you select the Force option.
Make sure to select the same communication type as the existing
Storage Resource agent when you create a deployment job.

– If a Storage Resource agent exists on a target computer and you
do not select Force, an error occurs during validation and the
Storage Resource agent is not installed.

v Select the Initial Scan option to perform a file system scan on the
computer where a Storage Resource agent is deployed. If this box is
checked, the scan is run immediately after a Storage Resource agent
is deployed.
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v Click the Windows Services Information button to enter login
information that Tivoli Storage Productivity Center uses to create a
Windows service for the Storage Resource agent. Use the Windows
Service Information window to select the local system account, enter
information about an existing user account, or create a new local
account. If you do not specify a Windows service account, the default
itcauser account is created. This action is only available for agents
that are deployed to Windows computers as daemon services. This
button is disabled if Use Daemon Service for Runtime Operation is
not selected.

Enter the following information:

User Enter the user ID that Tivoli Storage Productivity Center uses
when logging in to the host computer to install a Storage
Resource agent. The value in the field is applied to all the
computers that appear in the Remote Agent Machines table.

Requirement: This ID must have administrative or root
privileges on the target computer.

Password
Enter the password for the user ID.

Certificate Location
Enter the fully qualified path of the certificate on the computer
where the Data server is located. This file is used for
certificate-based authentication. If you do not enter a value in
this field the default location is used.

Passphrase
Enter the passphrase for the certificate file. The passphrase was
created when the certificate was generated.

Port Enter the port number on which a Storage Resource agent
listens for requests. The default is 9510.

Tip: This value is required if you run the Storage Resource
agent as a daemon service.

Use Daemon Service for Runtime Operation
Select this option to run a Storage Resource agent on the
monitored computer as a daemon service.

See Storage Resource agent Deployment Considerations for
more information about deploying agents as daemon and
non-daemon services.

Restriction: Do not select this option to run the Storage
Resource agent as a stand-alone executable file on the
monitored computer.

Validate before Save
Check this box to indicate that Tivoli Storage Productivity
Center should attempt to communicate with the computers that
are added to the deployment job when you click the Save
button on this page. If the validation fails for a computer, the
agent is not installed on that computer.

Edit Selected Entries
Click this button to edit settings for the selected Storage Resource
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agents. This information includes user ID, password, certificate location,
passphrase, and port. You must submit the deployment job for the
changes to take effect.

Remove
Click this button to remove a Storage Resource agent from the
deployment job.

Tip: This button does not remove the agent from Tivoli Storage
Productivity Center if it is already installed; it only removes it from the
deployment job.

3. Click the When to run tab to enter the following information:

How often to run
Specify a time to run:
v Run now

v Run once at (specify a date and time to run)

How to handle time zones
Specify a time zone to use:
v Use the time zone that the server runs in

v Use this time zone (select a time zone)
4. Click the Alert tab to specify the following information:

Triggering-Condition
The triggering condition you can specify is: Storage Resource agent
Deployment Failed

Triggered-Actions
Choose from the following check boxes:
v SNMP Trap

v TEC / OMNIbus Event

v Login Notification

v Windows Event Log

v Email

Depending on what action you select, you might have other choices to
make. For example, if you select the Windows Event Log check box,
the Event Type field becomes active so that you can specify a severity
for the event in the Windows event log.

5. Click File > Save.

For related tasks, see the Planning > General Planning > Planning for Storage Resource
agents section in the Tivoli Storage Productivity Center Installation and Configuration
Guide for additional configuration information about certificates used after
deployment.

Check the TPCD_#####.log file in the Tivoli Storage Productivity Center
installation directory to view the error messages related to failed validations. The
following are the default locations for this log file:
v Windows: C:\Program Files\IBM\TPC\data\log

v UNIX/Linux: /opt/IBM/TPC/data/log

If multiple Storage Resource agents are set up to probe or scan the same storage
resources, the Storage Resource agent that was added to Tivoli Storage
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Productivity Center first is used for the probe or scan. Therefore, only data that is
gathered by the first Storage Resource agent is shown.

Collecting service data
Collect service data about the selected Storage Resource agent. Service data
includes diagnostic information such as logs, trace files, configuration information,
and computer details. Use this data to troubleshoot any errors that might occur
during startup, processing, or shutdown of a Storage Resource agent.

If the collection of service data is successful, Tivoli Storage Productivity Center
displays a message that indicates where the resulting archive file (.zip) is stored.
The archive file is stored in a directory on the same computer as the Tivoli Storage
Productivity Center server. The file is located in the following default locations:
v Windows operating system: C:\Program Files\IBM\TPC\data\log\SRATraces\

SRA_computer_name\TPCServiceInfo.zip
v UNIX or Linux operating system: /opt/IBM/TPC/data/log/SRATraces/

SRA_computer_name/TPCServiceInfo.zip

SRA_computer_name represents the name of the computer on which the Storage
Resource agent is deployed.

If the collection of service data fails, Tivoli Storage Productivity Center displays a
message that indicates the job was unsuccessful. See the server log file or the
services script output for more information about why the data collection failed.
These files are located in the following default locations:
v Server log file (on the computer where the Tivoli Storage Productivity Center

server is installed):
– Windows operating system: c:\Program Files\IBM\TPC\data\log
– UNIX or Linux operating system: /opt/IBM/TPC/data/log

v Services script output file (on the computer where the Storage Resource agent is
deployed):
– Windows operating system: C:\Program Files\IBM\TPC\agent\service\

TPCServiceInfo.html
– UNIX or Linux operating system: /opt/IBM/TPC/agent/service/

TPCServiceInfo.html

where SRA_computer_name represents the name of the computer on which the
Storage Resource agent is located.

To collect service data for a Storage Resource agent,complete the following steps:
1. In the navigation tree, click Administrative Services > Data Sources. Left-click

Data/Storage Resource agents.
2. In the content pane, select a Storage Resource agent.
3. In the Select Action menu, click Collect Service Data.

Enabling or disabling scripts for Storage Resource agents
You can enable or disable the running of scripts that are sent from the Tivoli
Storage Productivity Center server to a Storage Resource agent. If enabled, a
Storage Resource agent accepts and runs scripts that are sent from the server for
scheduling. If disabled, a Storage Resource agent does not accept scripts that are
sent from the server and only runs scripts that are stored on the computer where
the agent is deployed.

To enable or disable the running of scripts, complete the following steps:
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1. In the navigation tree, expand Administrative Services > Data Sources >
Data/Storage Resource Agents.

2. In the content pane under the Select Action menu, click Enable Scripts to
enable the running of scripts. Click Disable Scripts to disable the running of
scripts.

Enabling or disabling the monitoring of fabrics by the Storage
Resource agents
Enable or disable the monitoring of fabrics by the Storage Resource agent. By
default a Storage Resource agent is enabled for fabric monitoring.

To enable or disable the monitoring of fabrics by the Storage Resource agent,
complete the following steps:
1. In the navigation tree, expand Administrative Services > Data Sources >

Data/Storage Resource Agents.
2. In the content pane under the Select Action menu, click Enable Fabric to enable

the monitoring of fabrics. Click Disable Fabric to disable the monitoring of
fabrics.

Help command for Storage Resource agent
The help command for the Storage Resource agent provides information about the
parameters for installing, uninstalling, and upgrading Storage Resource agents.

For information about the Storage Resource agent commands, run the help
command. Follow these steps:
1. Go to the installation location for the Storage Resource agent:

cd <installation_location>

2. Run the following command:
bin/Agent -help

3. The output from the help command is as follows:
Usage:
Agent -INSTALL

[-COMMTYPE DAEMON -AGENTPORT portnumber]
[-FORCE]
-INSTALLLOC pathname
-SERVERIP address[,address,...]
-SERVERPORT portnumber
[-USERID username -PASSWORD password -CERT file -PASSPHRASE phrase]

Agent -UNINSTALL
[-FORCE]
-SERVERNAME servername

Agent -UPGRADE
-INSTALLLOC pathname

For information about how to install the Storage Resource agent using commands,
see the information about installing agents in the Tivoli Storage Productivity Center
Installation and Configuration Guide.

For information about how to uninstall the Storage Resource agent using
commands, see the information about uninstalling agents in the Tivoli Storage
Productivity Center Installation and Configuration Guide.
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For information about how to upgrade the Storage Resource agent using
commands, see the information about upgrading agents in the Tivoli Storage
Productivity Center Installation and Configuration Guide.

Enabling and disabling NFS timeouts
You can enable or disable NFS timeouts for a Storage Resource agent when
running scans on network file system (NFS) mounts. Enabling an agent for NFS
timeouts prevents scans from locking up indefinitely when NFS mounts the agents
are monitoring become unavailable.

This option determines the number of seconds a Storage Resource agent waits for a
status system call on an NFS file system before it times out. The default wait time
is 10 seconds.

Note: Enabling this option might decrease the performance of scans slightly.
Disabling this option might increase the performance of scans slightly.

You might want to enable NFS timeouts when the NFS server is down or an NFS
file system is stale. This condition can also occur when a scan is running for an
agent and that agent is uninstalled.

The FileSystemScanNFSTimeout option is in the Data server configuration file
(server.config). The default location of the server.config file is c:\Program
Files\IBM\TPC\config for Windows and /opt/IBM/TPC/config for UNIX and Linux.

To enable or disable NFS timeouts, follow these steps:
1. In the navigation tree, click Administrative Services > Data Sources. Left-click

Data/Storage Resource Agents.
2. In the content pane, select a Storage Resource agent.
3. To enable NFS timeouts for a Storage Resource agent, under the Select Action

menu, click Enable NFS Timeout.
4. To disable NFS timeouts for a Storage Resource agent, under the Select Action

menu, click Disable NFS Timeout.

Deleting or uninstalling an agent using the GUI
You can delete or uninstall a Storage Resource agent and all the data that is
collected by that agent from the database repository. The information that is
collected by the agent is no longer available within Tivoli Storage Productivity
Center reports. When you delete an agent, the agent is uninstalled and you can no
longer activate the agent.

To delete or uninstall a Storage Resource agent:
1. In the navigation tree, click Administrative Services > Data Sources. Left-click

Data/Storage Resource Agents.
2. In the content pane, select an agent and under the Select Action menu, click

Delete.
3. In the confirmation dialog, select Yes Delete the agent.

Exporting a Storage Resource agent list
You can export a Storage Resource agent list to a formatted flat file. This list is
used to manage user authentication through a script file. This option is enabled for
Storage Resource agents that use non-daemon based communication only.
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This list contains the host name, installation location, user ID, encrypted password,
and fully qualified certificate file for the selected Storage Resource agents. You can
change the user authentication data such as user ID, password, and fully qualified
certificate location.

When the file is created, the passwords for the agents are written as "*********" for
security reasons. Before using this file with the Update Storage Resource Agent
List action, you must enter an encrypted or non-encrypted password for each host.
See the description of the Update Storage Resource Agent List action for more
information about passwords.

Storage Resource agents can either be run as a daemon service or non-daemon
service (on-demand service). If the agent is run as a non-daemon service, there is
no agent process running on the managed host. Programs on the host system are
run as needed.

To export a Storage Resource agent list, complete the following steps:
1. In the navigation tree, click Administrative Services > Data Sources. Left-click

Data/Storage Resource Agents.
2. In the content pane, select a Storage Resource agent and click Export Storage

Resource Agent List from the Select Action menu.

Updating a Storage Resource agent list
The Storage Resource agent list file is used to manage user authentication through
a script file. This list contains the host name, installation location, user ID,
encrypted password, and fully qualified certificate file for the selected Storage
Resource agents. The password is in encrypted format with @ENC@ appended to
the encrypted password. You can change the user authentication data such as user
ID, password, and fully-qualified certificate location.

To update a Storage Resource agent list, complete the following steps:
1. In the navigation tree, click Administrative Services > Data Sources. Left-click

Data/Storage Resource Agents.
2. In the content pane, select the Storage Resource agents you want to update.
3. Under the Select Action menu, click Update Storage Resource Agent List to

update information about the agent.
4. Edit the information in that file to match the changes that you want to make

for the agent. You can update the logon credentials for the Storage Resource
agents that are listed with the information in a file that you specify. The file
must use the following format for the host names you want to update:
host_name|installation_location|user_ID|password

If the Data server cannot find any Storage Resource agent with a host name
and location that you specify in the file, that entry is ignored and the error is
logged.
Keep in mind the following considerations when including a password in the
update file:
v For non-encrypted passwords: If you use "|" in the line for an agent, you

must provide an "escape" character before it. The escape character is "\". For
example, if the password you want to include in an update file is
"native|agent", use native\|agent in the update file.
If you use "\" in the line for an agent, you must provide an additional "\" as
an escape character. For example, if the password is "native\agent", use
native\\agent in the update file.
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v For encrypted passwords:
– To encrypt a password, start IBM Tivoli Storage Productivity Center's

command-line tool (tpctool) from the \cli directory where Tivoli Storage
Productivity Center is installed and run the following command: tpctool
encrypt [password], where [password] represents the password you want
to encrypt. This command will generate a text string that represents the
encrypted version of the password. For example, output might appear like
the following: iDroqToC07Oubh5i4mxMHQ==. Copy this encrypted password
to the correct location in the update file.

– To include an encrypted password in an update file, you must add the
following after the encrypted text: @ENC@. For example, an encrypted
password in an update file might appear like this:
iDroqToC07Oubh5i4mxMHQ==@ENC@

Note:

– Do not include @ENC@ at the end of non-encrypted passwords.
– See the IBM Tivoli Storage Productivity Center Command-Line Interface

Reference for more information about tpctool.

Registering the Storage Resource agent with a different server
This topic provides information on how to register the Storage Resource agent with
a different server.

To register the Storage Resource agent with a different server, complete the
following steps:
1. You have a Storage Resource agent that is installed on Server A and you want

the Storage Resource agent to also point to Server B.
2. From Server B, in the navigation tree, expand Administrative Services >

Configuration > Storage Resource Agent Deployments. Right-click Storage
Resource Agent Deployments.

3. Specify the same port and location with the force option.

Note: For an RXA Storage Resource agent, just specify the same location with
the force option.

4. Run the deployment job. The Storage Resource agent now points to Server A
and Server B. If you no longer want the Storage Resource agent to point to
Server A, just go to the GUI on Server A and delete the Storage Resource agent.

Managing the daemon Storage Resource agent service
Use this information to start and stop the daemon Storage Resource agent service
for the Virtual I/O Server.

Starting and stopping the daemon Storage Resource agent service

To start or stop the daemon service, follow these steps:
1. Log in to the Virtual I/O Server using the padmin user ID.
2. Run the following command to set up the AIX environment:

oem_setup_env

3. Change to the base directory where the Storage Resource agent is located. For
example:
v To stop the service, run this command:

/SRA_install_directory/agent/bin/agent.sh stop

v To start the service, run this command:
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/SRA_install_directory/agent/bin/agent.sh start

Deployment guidelines and limitations for Storage Resource
agents
There are a number of guidelines and limitations that you must consider when
managing the Storage Resource agents in your environment.

Use the following information when you deploy Storage Resource agents and
migrate existing Data agents:
v Multiple Storage Resource agents that are probing or scanning the same storage

resources
v Platforms that support Storage Resource agents deployments
v Product functions that are not available for storage devices monitored by Storage

Resource agents
v Required authority for deploying Storage Resource agents
v Orphan zones
v Firewalls and Storage Resource agent deployments
v Multiple computers in a deployment
v Communication between the Tivoli Storage Productivity Center server and a

Storage Resource agent
v Daemon and non-daemon services
v Authentication between the Tivoli Storage Productivity Center server and a

Storage Resource agent
v Storage Resource agents on the same computer
v Time zones for computers monitored by Storage Resource agents
v UNIX systems using RSH protocol
v Deployments on Windows - NetBIOS setting
v Deployments on Windows - User Account Control (UAC) remote restrictions
v Additional information about Storage Resource agents

Multiple Storage Resource agents that are probing or scanning the same storage
resources

If multiple Storage Resource agents are set up to probe or scan the same
storage resources, the Storage Resource agent that was added to Tivoli
Storage Productivity Center first is used for the probe or scan. Therefore,
only data that is gathered by the first Storage Resource agent is shown.

Platforms that support Storage Resource agents for the same
For a list of platforms on which you can deploy Storage Resource agents,
go to the Tivoli Storage Productivity Center support site at
http://www.ibm.com/support/entry/portal/Overview/Software/Tivoli/
Tivoli_Storage_Productivity_Center_Standard_Edition, click the
Documentation link, and enter Platform Support: Agents, Servers and
GUI in the Search box. Click the link to the document for the appropriate
release.

Product functions that are not available for storage devices monitored by Storage
Resource agents

Before you migrate an existing Data agent to a Storage Resource agent or
deploy a new Storage Resource agent, make sure that the product
functions you want to use on the monitored devices are available for those
agents. The following functions are not available for storage devices that
are monitored by Storage Resource agents:
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v Certain relational database monitoring. For list of relational databases
that can be monitored by Storage Resource agents, go to the Tivoli
Storage Productivity Center support site at http://www.ibm.com/
support/entry/portal/Overview/Software/Tivoli/
Tivoli_Storage_Productivity_Center_Standard_Edition, click the
Documentation link, and enter Platform Support: Agents, Servers and
GUI in the Search box. Click the link to the document for the
appropriate release.

v The changing of zone configurations and the reporting of HBA, fabric
topology, or zoning information for fabrics connected to hosts running
Linux on IBM System z hardware. These limitations also apply to
Storage Resource agents on all guest operating systems for VMware
configurations.

Required authorities for deploying and running Storage Resource agents
Before you can create deployment schedules and deploy Storage Resource
agents on target computers, you must meet the following requirements:
v To create deployment schedules, you must be logged in to Tivoli Storage

Productivity Center with a user ID that has the Productivity Center
Administrator role. See the IBM Tivoli Storage Productivity Center and
IBM Tivoli Storage Productivity Center for Replication Installation and
Configuration Guide for more information about user roles.

v To deploy Storage Resource agents on target computers, you must
provide a user ID that has administrative rights on those computers. You
enter this ID when creating a deployment schedule. Tivoli Storage
Productivity Center uses this ID to log on to the target computers and
install and configure the necessary runtime files for the agents.

The user under which a Storage Resource agent (daemon or non-daemon)
runs must have the following authorities on the target computers:
v On Linux or UNIX, the user must have root authority. By default, an

agent runs under the user 'root'.
v On Windows, the user must have Administrator authority and be a

member of the Administrators group. By default, a Storage Resource
agent runs under the 'Local System' account.

Orphan zones
Storage Resource agents do not collect information about orphan zones. An
orphan zone is a zone that does not belong to at least one zoneset.

Firewalls and Storage Resource agent deployments
Before you can deploy a Storage Resource agent on a computer, you must
turn off the firewall on that computer. If you do not turn off the firewall,
the deployment fails. To turn off the firewall on a Windows 2008 computer,
complete the following steps:
1. On the desktop of the Windows 2008 computer, click Start >

Administrative Tools.
2. Click Windows Firewall with Advanced Security.
3. Click Windows Firewall Properties.
4. Change the Firewall state field to Off on the following tabs: Domain

Profile, Private Profile, Public Profile.
5. Click OK to accept the changes and exit.
6. Deploy a Storage Resource agent to the Windows 2008 computer.

Multiple computers in a deployment
You can define a deployment schedule to include multiple computers on
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which to install Storage Resource agents. The computers you include in a
deployment schedule must share the same administrative user ID and
password. IBM Tivoli Storage Productivity Center uses these user
credentials to log on to the computers when installing Storage Resource
agents. If the computers in a deployment schedule do not share the same
administrative user credentials, you must create separate deployment jobs
for them.

Note: When you deploy a Storage Resource agent to multiple computers, a
globally unique identifier (GUID) is created for each computer (if one does
not exist).

Communication between the Tivoli Storage Productivity Center server and a
Storage Resource agent

The Tivoli Storage Productivity Center server connects to a monitored
computer when a Storage Resource agent is deployed and whenever a data
collection schedule runs against that agent.

During deployment, the server communicates with the target computer
using one of the following protocols:
v Windows server message block protocol (SMB)
v Secure Shell protocol (SSH)
v Remote execution protocol (REXEC)
v Remote shell protocol (RSH)

After deployment, the type of communication between the server and
agent on that computer depends on whether you deployed the agent as
daemon service or non-daemon service. See the IBM Tivoli Storage
Productivity Center and IBM Tivoli Storage Productivity Center for Replication
Installation and Configuration Guide for more information about these
protocols.

Daemon and non-daemon services
You can deploy a Storage Resource agent agent as a daemon or
non-daemon service:
v A Storage Resource agent that is deployed as a daemon service runs in

the background on the monitored computer and listens for requests from
the Tivoli Storage Productivity Center server. Connectivity between the
server and agent is established using SSL. The server and agent have
their respective certificates and no additional information is required
besides those certificates and the security that is provided by the SSL
protocol.

v A Storage Resource agent deployed as a service on demand
(non-daemon service) runs as a stand-alone executable file on the
monitored computer. Communication from the server to the agent uses
the same protocol that was used during the deployment of the agent.
Communication from the agent to the server uses SSL.

Authentication between the Tivoli Storage Productivity Center server and a
Storage Resource agent

Tivoli Storage Productivity Center requires the correct authentication
information (user ID, password, port, certificate location, or passphrase) for
monitored computers each time it communicates with Storage Resource
agents on those computers. If the authentication information changes for a
host computer on which a Storage Resource agent is deployed, the
authentication information for that agent must be updated using the
Change Authentication or Update Storage Resource agent List functions
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on the Data/Storage Resource agents panel located under the
Administrative Services > Data Sources node in the navigation tree.

Storage Resource agents on the same computer
You cannot deploy a Storage Resource agent on a computer where a
Storage Resource agent is already installed and pointing to the same Data
server. You can deploy a Storage Resource agent on the same computer as
another Storage Resource agent if those agents communicate with different
Data servers and use different ports when listening for requests.

Time zones for computers monitored by Storage Resource agents
The time zones of computers that are monitored by Storage Resource
agents are shown as Greenwich Mean Time (GMT) offsets in Tivoli Storage
Productivity Center reports. For example, a computer in Los Angeles
shows the following time zones in the By Computer report in Asset
reporting:
(GMT-8:00) GMT-8:00

UNIX operating systems using Remote Shell protocol (RSH)
If RSH is configured to use a user ID and password, the connection fails.
To successfully connect to a system using RSH, you must set up the .rhosts
file (in the home directory of the account). RSH must be configured to
accept a login from the system that is running your application.

Deployments on Windows operating systems - NetBIOS setting
If you want to install a Storage Resource agent on Windows targets, the
Enable NetBIOS over TCP/IP option must be selected in the Control Panel
settings for the computer's network connections properties. To set this
option, click Start > Settings > Control Panel > Network and Dial-Up
Connections > <some_connection> > Properties > Internet Protocol
(TCP/IP) > Advanced > WINS > Enable NetBIOS over TCP/IP.

See the documentation for your firewall to determine if these ports are not
blocked for inbound requests.

To determine if security policies are blocking the connection ports, click
Start > Settings > Control Panel > Administrative Tools.

Depending on whether your policies are stored locally or in Active
Directory, follow these directions:

Locally stored policies
For locally stored policies, click Start > Settings > Control Panel >
Administrative Tools > Local Security Policy > IP Security
Policies on Local Computer.

Policies stored in Active Directory
For policies stored in Active Directory, examine the IP security
policies and edit or remove filters that block the ports:
v Click Administrative Tools > Default Domain Security Settings

> IP Security Policies on Active Directory.
v Click Administrative Tools > Default Domain Controller

Security Settings > IP Security Policies on Active Directory.

For all Windows systems, the Server service must be running to connect to
a Windows system using the Windows protocol.

The following table lists the ports reserved for NetBIOS. Ensure that these
ports are not blocked.
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Port Description

135 NetBIOS Remote procedure call. (Not currently used.)

137 NetBIOS name service.

138 NetBIOS datagram. (Not currently used.)

139 NetBIOS session (for file and print sharing).

445 CIFS (on Windows XP).

For Windows Server 2008, shares must be shared for the Guest or
Everyone accounts, and password protected sharing must be disabled. To
disable password protected sharing, follow these steps:
1. Click Control Panel > Networking and Sharing Center.
2. Click the down arrow next to Password protected sharing.
3. Click Turn off password protected sharing.
4. Click Apply. Exit from the Control Panel.

Deployments on Windows 2008 - User Account Control (UAC) remote
restrictions

If you are planning to install Storage Resource agents remotely on a
Windows 2008 operating system, you must disable the User Account
Control (UAC) remote restrictions on the Windows operating system. User
Account Control is a security component on Windows operating systems.

Note: This task contains steps that tell you how to modify the registry.
Serious problems might occur if you modify the registry incorrectly.
Therefore, make sure that you follow these steps carefully. For added
protection, back up the registry before you modify it. Then you can restore
the registry if problems occur. For information about how to back up and
restore the registry, see http://support.microsoft.com/kb/322756/.

To disable UAC remote restrictions, follow these steps:
1. Click Start > Run. Enter regedit and click OK.
2. Locate and click the following registry subkey:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
Policies\System

3. If the LocalAccountTokenFilterPolicy registry entry does not exist,
follow these steps:
a. On the Edit menu, click New > DWORD Value.
b. Enter LocalAccountTokenFilterPolicy as the name for the DWORD

value in the content pane. Click Enter.
c. Right-click LocalAccountTokenFilterPolicy, then click Modify.
d. In the Edit DWORD Value window, enter 1, then click OK.

This value can be 0 or 1:

0 This value builds a filtered token. This value is the default
value. The administrator credentials are removed.

1 This value builds an elevated token.
e. Exit the registry editor.

Additional information about Storage Resource agents
See Planning for Storage Resource agents in the IBM Tivoli Storage Productivity
Center Installation and Configuration Guide for more information about
Storage Resource agents.
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In-band Fabric agents
In-band Fabric agents are no longer installed or supported by Tivoli Storage
Productivity Center. You can migrate in-band Fabric agents to Storage Resource
agents.

For information about the supported agent types for switch performance
management and fabric zone configuration, see “Supported Fabric Agent Types”
on page 1426.

Deleting an in-band Fabric agent
You can delete an in-band Fabric agent from the navigation tree and the database.
Data discovered by the agent is removed from the database repository. This action
is available for inactive agents only. You must first stop the agent before deleting
the information for the agent. The agent is not uninstalled from IBM Tivoli Storage
Productivity Center.

To remove information for an in-band Fabric agent, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources.

Left-click Inband Fabric Agents.
2. In the content pane, select the agent and click Delete.

Migrating an in-band Fabric agent
Migrate a selected in-band Fabric agent to a Storage Resource agent.

The migration process deploys a Storage Resource agent on the target computer
and then uninstalls the in-band Fabric agent. Before the migration, Tivoli Storage
Productivity Center must shut down the Fabric agent. The agent is not shut down
until 1) all running processes are complete, and 2) there are no new schedules
submitted for the agent.

Out-of-band Fabric agents
Out-of-band agents are used by Fabric Manager for out-of-band SAN operations.

For information about the supported agent types for switch performance
management and fabric zone configuration, see “Supported Fabric Agent Types”
on page 1426.

Displaying information about an out-of-band agent
You can view information about an out-of-band agent including the IP address,
status, and SNMP community.

To display information about an out-of-band agent, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources. Click

Out of Band Fabric Agents.
2. In the content pane, click the icon to the left of the agent for which you want

information. In the content pane, a notebook window opens. On the General
Information page, the following information is displayed:

Status The status of the agent.

Host Name
The host name of the system on which the agent is installed.

IP Address
The IP address of the system on which the agent is installed. This
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column displays Internet Protocol Version 4 (IPv4) and Internet Protocol
Version 6 (IPv6) addresses as appropriate.

SNMP Community Read
The name of the Simple Network Management Protocol (SNMP)
community to which the agent belongs. The SNMP community name
acts as a password that is shared by one or more SNMP hosts. The
community name is used to authenticate messages being received by
this SNMP host. This field is optional and might be blank if the SNMP
community has not been set.

Note: The default SNMP community is public. If the community name
is not the correct community name for your environment, the
out-of-band agent might not be able to properly perform scans.

SNMP Community Write
The community string for SNMP writes. Tivoli Storage Productivity
Center uses the write community string to refresh information for the
Out of Band Fabric Agent. The default is private. This value is used for
Cisco switches only.

Updating out-of-band agent information
After an out-of-band agent has been added, you can update the SNMP community
information.

To update information for an out-of-band agent, follow this procedure:
1. In the Navigation Tree pane, expand Administrative Services > Data Sources.

Left-click Out of Band Fabric Agents.
2. In the content pane, click on the icon by the agent.
3. In the content pane, a notebook window opens. On the General page, update

the following information:

SNMP Community Read
Enter the name of the Simple Network Management Protocol (SNMP)
community to which the agent belongs. The SNMP community name
acts as a password that is shared by one or more SNMP hosts. The
community name is used to authenticate messages being received by
this SNMP host. This field is optional.

Note: The default SNMP community is public. If this is not the correct
community name for your environment, the out-of-band agent might
not be able to properly perform scans.

SNMP Community Write
Enter the community string for SNMP writes. Tivoli Storage
Productivity Center uses the write community string to refresh
information for the Out of Band Fabric Agent. The default is private.
This value is used for Cisco switches only.

Checking the out-of-band agent connection
You can check to determine if an out-of-band agent is running.

To check the agent connection, follow this procedure:
1. In the Navigation Tree pane, expand Administrative Services > Data Sources.

Left-click Out of Band Fabric Agents.
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2. In the content pane, select an agent and click Check. The status of the agent is
displayed in the Agent Status window. If updates are required, they are
automatically installed.

Adding an out-of-band Fabric agent
This topic provides information about adding an out-of-band Fabric agent.

You can add an out-of-band Fabric agent with the Configure Devices wizard or by
using the manual steps in this procedure. To add an out-of-band Fabric agent with
the Configure Devices wizard, see “Configure Devices wizard” on page 307.

To add an out-of-band Fabric agent manually, complete the following steps:
1. In the navigation tree, expand Administrative Services > Data Sources.

Left-click Out of Band Fabric Agents.
2. In the content pane, click Add.
3. In the Add Out of Band Fabric Agent window, complete the host name, SNMP

community read (optional), and SNMP community write (optional) fields. Click
OK.

Deleting an out-of-band agent
You can remove an out-of-band agent from the navigation tree and the database.
Data discovered by the agent is not removed from the database repository.

To remove an out-of-band agent, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources.

Left-click Out of Band Fabric.
2. In the content pane, select an agent and click Delete.

Tivoli Storage Productivity Center servers
Use the Administrative Services > Data Sources > IBM Tivoli Storage
Productivity Center Servers > function to manage the relationships between a
master Tivoli Storage Productivity Center server and its subordinate Tivoli Storage
Productivity Center servers.

By creating master and subordinate relationships between Tivoli Storage
Productivity Center servers, you can then use a single interface to generate reports
based on data and metrics collected by multiple servers in a storage environment:
v A master server is a server that performs normal monitoring and reporting of

storage resources like a standard server, but also gathers the storage information
(using Tivoli Storage Productivity Center server probes) that was collected by
subordinate servers.

v A subordinate server is a server that monitors and reports on storage resources
like a standard server, but also communicates with the master server during
Tivoli Storage Productivity Center server probes. During these probes, the
master server collects the storage information gathered by a subordinate server's
agents and stores that information in its own database repository.
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The rollup reports that reflect the storage information collected by the master
server from subordinate servers are available in the Tivoli Storage Productivity
Center > Rollup Reports node. This node is available in the navigation tree for the
master server.

If the master server is on an IPv6–only server, it can communicate with existing
subordinate servers under the following conditions:
v The subordinate servers are upgraded to Tivoli Storage Productivity Center V5.1

or higher and
v The IPv6 protocol is enabled on the machines where they are located.

Before you can configure and manage subordinate servers, keep in mind the
following items:
v The master server must be up and running.
v You must be log on to the user interface as an Tivoli Storage Productivity Center

administrator or superuser
v We recommend that the master server monitor no more than 500 unique data

sources. This number includes subordinate servers, Storage Resource agents,
CIMOM agents, and VM servers (VMWare).

v We recommend that each subordinate server monitors no more than 1200 unique
data sources. This number includes Storage Resource agents, CIMOM agents,
and VM servers (VMWare). After this threshold is met for a server, a new server
is deployed and all new agents point to it.

v After upgrading to Tivoli Storage Productivity Center 5.1, you must run probes
against the monitored storage assets for the master server to have information
about those assets displayed in Tivoli Storage Productivity Center > Reporting
> Rollup Reports.

Figure 23. Master and subordinate server architecture
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v After you remove a data source (agent) from a subordinate server or a storage
entity that it monitors, the master server continues to display information about
that agent or storage resource in rollup reports for a specified amount of time.
You can specify how quickly that information is removed by accessing the
Administrative Services > Configuration > Removed Resource Retention panel
and changing the settings for TPC servers. Additionally, if a master server is
unable to contact a subordinate server for the number of days defined in the
TPC Servers setting on the Removed Resource Retention panel, that server is
removed from the subordinate server as well as information about the storage
entities it was monitoring.

v A host might appear more than once in a rollup report and its data is counted
multiple times in report totals. Multiple entries for a host might occur if the
following conditions are true:
– An agent is removed from a host, the GUID (globally unique identifier) for

the host is changed, and then an agent is redeployed on the host.
– The amount of time that information about a host is retained is longer than

the time it took to remove the original agent and change the GUID for the
host.

For example, if the number of days to retain information about a host is 14 days,
and then you 1) remove the agent on the host, 2) change the GUID of the host,
and 3) redeploy an agent on that host all in less than 14 days, duplicate entries
for the host appears in rollup reports. After 14 days have passed, the entry for
the host before the GUID change is removed from the database and only one
entry appears for the host in rollup reports.
You can specify how quickly information is removed by changing the settings
for TPC servers on the Administrative Services > Configuration > Removed
Resource Retention panel.

Adding an Tivoli Storage Productivity Center Server
Learn how to add an Tivoli Storage Productivity Center server as a subordinate
sever.

Keep in mind the following when adding a Tivoli Storage Productivity Center
server as a subordinate server:
v How subordinate servers are configured to monitor storage entities within your

environment can determine if fragmentation occurs within rollup reports. See
Rollup reports - Fragmentation for more information.

v Tivoli Storage Productivity Center servers must be at version 3.3 or greater to be
added as a subordinate server.

v We recommend that the master server monitor no more than 500 unique data
sources. This number includes subordinate servers, Storage Resource agents,
CIMOM agents, and VM servers (VMWare).

v We recommend that each subordinate server monitors no more than 1200 unique
data sources. This number includes Storage Resource agents, CIMOM agents,
and VM servers (VMWare). After this threshold is met for a server, a new server
is deployed and all new agents point to it.

v If the master server is located on an IPv6–only server, it can communicate with
existing subordinate servers under the following conditions:
– The subordinate servers are upgraded to Tivoli Storage Productivity Center

V4.1 or higher and
– The IPv6 protocol is enabled on the machines where they are located.

To add a server as a subordinate server, follow this procedure:
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1. In the Navigation Tree pane, expand Administrative Services > Data Sources >
Tivoli Storage Productivity Center Servers.

2. In the content pane, click Add Tivoli Storage Productivity Center Server.
3. In the Add Tivoli Storage Productivity Center Server window, enter the

following information:

Host Name
Enter the host name of the machine on which the subordinate server is
installed.

Host Device server Port
Enter the port with which the subordinate server's Device server is
listening for requests. The default port for Tivoli Storage Productivity
Center servers is 9550.

Host Authentication Password
Enter the password for the subordinate Tivoli Storage Productivity
Center server. This host authentication password is entered when
installing Tivoli Storage Productivity Center. Contact your system
administrator or the person who installed Tivoli Storage Productivity
Center to determine this password.

Display Name (optional)
Enter a name for the subordinate server.

Description (optional)
Enter a description for the subordinate server.

Test Tivoli Storage Productivity Center Server Connectivity before adding
Select this check box to have the master server connect and log into the
subordinate server using the information provided on this window.
This test is performed when you click Save.

4. Click Save to add the server as a subordinate server.
v If you selected Test Tivoli Storage Productivity Center Server Connectivity

before adding, IBM Tivoli Storage Productivity Center attempts to connect to
the subordinate server using the information provided on this window.

v If you did not select Test Tivoli Storage Productivity Center Server
Connectivity before adding, the subordinate server is automatically added
as a subordinate server but has a connection status of Unknown on the
Administrative Services > Data Sources > Tivoli Storage Productivity
Center Servers window.

Note: If the login information for a subordinate server is incorrect, an error
occurs and an associated error message dialog box is displayed.

Viewing subordinate server details
Learn how to view information about the subordinate servers that have been
associated with a master server.

After you add a subordinate server to a master server, basic information about that
server appears on the Administrative Services > Data Sources > TPC Servers
window. To view additional information about a subordinate server on the TPC
Servers window, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources > TPC

Servers.
2. In the content pane, double-click a server row or click the icon next to a server

for more detailed information about that server. Information about a
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subordinate server appears on the Administrative Services > Data Sources >
TPC Servers > TPC Server Details window.

Testing the connection to subordinate servers
Learn how to test the connection from a master server to its associated subordinate
servers.

After you add a subordinate server to a master server, basic information about that
server appears on the Administrative Services > Data Sources > TPC Servers
window. To verify that the master server can use the information provided to
connect to subordinate server, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources > TPC

Servers.
2. In the content pane, highlight the row for a subordinate server and click Test

TPC Server Connection to test its connection to the master server. A message
window will appear with the results of the tested connection. The information
that appears in the Connection Status field will be updated to reflect its status.

Removing subordinate servers
Learn how to remove a subordinate server from its association with a master
server.

Use the Administrative Services > Data Sources > TPC Servers window to
remove a subordinate server from a master server. Removing a subordinate server
removes subordinate server information from:
v The master server database repository
v All rollup reports
v The TPC Servers list on the Administrative Services > Data Sources > TPC

Servers window

To remove a subordinate server, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources > TPC

Servers.
2. In the content pane, highlight the row of a subordinate server and click

Remove TPC Server. A confirmation window appears.
3. Click Yes to confirm the removal of the subordinate server.

Modifying subordinate server information
Learn how to modify information about the subordinate servers that have been
associated with a master server.

After you add a subordinate server to a master server, basic information about that
server appears on the Administrative Services > Data Sources > TPC Servers
window. You can edit the information for a subordinate server by modifying its
Display Name, Description, and Host Authentication Password. To view modify
information about a subordinate server on the TPC Servers window, follow this
procedure:
1. In the navigation tree, expand Administrative Services > Data Sources > TPC

Servers.
2. In the content pane, double-click a server row or click the icon next to a server

to edit information about that server. Information about a subordinate server
appears on Administrative Services > Data Sources > TPC Servers > TPC
Server Details.

3. Edit the information in the following fields:
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Host Authentication Password
Enter the password for the subordinate IBM Tivoli Storage Productivity
Center server.

Display Name (optional)
Enter a name for the subordinate server.

Description (optional)
Enter a description for the subordinate server.

Test TPC Server Connectivity before adding
Select this check box to have the master server connect and log into the
subordinate server using the information provided on this window.
This test is performed when you click Save.

4. Select File > Save . If successful, the TPC Servers window appears and any
new values for Display Name and Description are shown for a subordinate
server.

Rollup reports - fragmentation
Fragmentation occurs when related storage entities are being monitored by
different subordinate IBM Tivoli Storage Productivity Center servers.

The following example shows when fragmentation can occur using subordinate
servers and rollup reports:
v Example: Host A is assigned a volume from storage subsystem 1. Host A is

being monitored only by one Tivoli Storage Productivity Center subordinate
server (Server 1) and storage subsystem 1 is being monitored by another
subordinate server (Server 2). Server 1 and Server 2 are subordinate servers to
the master server (Server 3).
Reason for fragmentation: In this example, the host and subsystem are
fragmented because they are not being monitored by the same Tivoli Storage
Productivity Center server. This will cause the Correlated Volume Space value
in the rollup reports for storage subsystems and volumes to be incorrect.

To prevent fragmentation when using master and subordinate server relationships
to generate rollup reports, we recommend the following:
v Do not monitor a storage subsystem and the hosts to which its volumes are

assigned with different subordinate servers that are associated with the same
master server.

v Do not monitor a fabric and its related switches with different subordinate
servers that are associated with the same master server.

v If an agent machine is using storage from a subsystem, then both the agent and
subsystem should be monitored by the same subordinate server.

v Configure all the subordinate servers to discover all the storage subsystems
within your environment. Note that if a subordinate server is monitoring a
subsystem with an agent other than the agent that is using storage on that
subsystem, the value for the Correlated Volume Space column in rollup reports
will be incorrect. For example:
– Host A has storage from Subsystem 1
– Subordinate server B is Monitoring Host A and Subsystem 1
– Subordinate server C is Monitoring Subsystem 1 and probed the subsystem

more recently than server B.
– The master server is monitoring subordinate servers B and server C.
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The master server will report the storage subsystem data from server C. Because
the master server does not know about Host A, the value for the Correlated
Volume Space column will be incorrect.

Storage systems
This topic provides information about administering, configuring, and viewing
information about monitored storage systems in your IBM Tivoli Storage
Productivity Center environment.

You can add many different types of storage systems to your Tivoli Storage
Productivity Center environment. Use the native storage system interfaces
provided to connect to the following storage systems:
v DS8000
v SAN Volume Controller
v Storwize V7000
v IBM Storwize V7000 Unified
v The XIV system
v IBM SONAS

For other storage systems, use the Common Interface Model (CIM) agent
interfaces.

Adding a storage system
Learn how to add a storage system to your IBM Tivoli Storage Productivity Center
environment.

Tivoli Storage Productivity Center provides multiple ways to add a storage system
to your environment. Use the Configure Devices wizard to guide you through the
steps for adding a storage subsystem using its native interface or a CIMOM, or
manually add a CIMOM and discover the storage subsystem that it manages. See
“Configuring storage subsystems” on page 308 for details of how to use the
Configure Devices wizard.

To add a storage subsystem, use any of the following methods:
v If you want to add a new storage subsystem to Tivoli Storage Productivity

Center using its native interface, use the Configure Devices wizard. The wizard
guides you through the steps for adding a storage subsystem and running a
discovery. To use this method, you can click the Configure Devices icon in the
toolbar or you can complete the following steps:
1. In the navigation tree, expand Administrative Services > Data Sources >

Storage Subsystems.
2. Click Add. This action launches the Configure Devices wizard. See

“Configuring storage subsystems” on page 308 for details of how to use the
Configure Devices wizard.

v If you want to add a CIMOM to Tivoli Storage Productivity Center and discover
the storage subsystem that it manages, use the Configure Devices wizard. The
wizard guides you through the steps for adding a CIMOM and running a
discovery. To use this method, you can click the Configure Devices icon in the
toolbar or you can complete the following steps:
1. In the navigation tree, expand Administrative Services > Data Sources >

Storage Subsystems.
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2. Click Add. This action launches the Configure Devices wizard. See
“Configuring storage subsystems” on page 308 for details of how to use the
Configure Devices wizard.

v If you want to manually add a new CIMOM to Tivoli Storage Productivity
Center and then manually discover the storage subsystem that it manages, use
the following steps:
1. In the navigation tree, expand Administrative Services > Data Sources and

click CIMOM Agents.
2. In the content pane, click Add CIMOM. The Add CIMOM window opens.

See “Adding a CIM agent connection” on page 250 for details of how to add
the CIMOM.

3. To discover the storage subsystem that a CIMOM manages, in the navigation
tree pane, expand Administrative Services > Discovery and click CIMOM.
See “Discover storage subsystem, tape library, and fabric information with
CIM agents” on page 333 for details about how to discover the storage
subsystems managed by the CIMOMs that you manually added.

Viewing storage system details
Learn how to view information about monitored storage systems in your IBM
Tivoli Storage Productivity Center.

After you add storage systems, basic information about those systems appears on
the Administrative Services > Data Sources > Storage Subsystems panel. To view
information about a storage system on the Storage Subsystems panel, follow this
procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

Storage Subsystems.
2. In the content pane, you can view basic information about the storage systems

in the Storage Subsystems area.

Magnifying glass icon
The function of this icon depends on the value that is in the Credential
Status column:
v If the value is Present, click the icon to view and modify more

detailed information about the system.
v If the value is Missing, click the icon to start the Configure Devices

wizard and provide the configuration information for the storage
system.

v If the value is Required, click the icon to open the subsystem
credentials update dialog box.

Name The name of the storage system.

Label A user-defined name of the system.

Type The type of storage system.

IP Address
The IP address of the storage system.

Credential Status
The status of the credentials that are used to connect to the storage
system. Possible values are:
v Present (the credentials are available).
v Missing (no credentials are available because the system had been

discovered using the automated discovery process. To add the
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required credentials, click the icon to open the Configure
Devices wizard. Follow the steps in the wizard.

v Required (the system must be updated from CIM object manager
[CIMOM] to native interface connection). To update the connection

method, click the icon to open the Update Subsystem
Credentials dialog box.

Connection Status
The status of the connection between Tivoli Storage Productivity Center
and the storage system.

Data Source IP Address
The IP address of the entity that Tivoli Storage Productivity Center uses
to connect to the storage system. If Tivoli Storage Productivity Center
uses the native interface of a system for connection, this IP address is
the same as the address in the IP Address field. If Tivoli Storage
Productivity Center uses a CIMOM for connection, the data source IP
address is the address for the CIMOM.

Modifying XIV system details
Learn how to modify information for an IBM XIV Storage System device that
connects to IBM Tivoli Storage Productivity Center.

After you add an XIV system device, basic information about that system appears
on the Administrative Services > Data Sources > Storage Subsystems panel. To
modify information about the XIV system device on the Storage Subsystems panel,
follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

Storage Subsystems.
2. In the content panel, double-click a storage subsystem row or click the icon

next to a row to edit information about that storage subsystem. Information
about the storage subsystem appears on the Storage Subsystems Details
window.

3. You can edit the information in the following fields:

Username
Displays the user name for the device.

Password
Displays the password for the device.

The information in the following fields cannot be edited:

Storage Subsystem
Displays the name of the device.

IP Address
Displays the IP address or host name for the device.

4. Select File > Save. If successful, the Storage Subsystems window appears and
any new values for the storage subsystem are shown.

Modifying SAN Volume Controller or Storwize V7000 storage
system details
Learn how to modify information about SAN Volume Controller or Storwize V7000
storage systems that connect to IBM Tivoli Storage Productivity Center.

After you add a SAN Volume Controller or Storwize V7000 device, basic
information about that system appears on the Administrative Services > Data
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Sources > Storage Subsystems panel. To modify information about a SAN Volume
Controller on the Storage Subsystems panel, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

Storage Subsystems.
2. In the content panel, double-click a storage subsystem row or click the icon

next to a row to edit information about that storage subsystem. Information
about the storage subsystem appears on the Storage Subsystems Details
window.

3. You can edit the information in the fields that are specified in bold in the
window:

Software Version
Displays the version of the SAN Volume Controller or Storwize V7000
device.

Storage Subsystem
Displays the name of the device.

IP Address
Displays the IP address or host name for the device.

Select Key
Lists the actions that are available for the public Secure Shell (SSH) key:
v Use existing uploaded key. This action is the default. If you select

this action, the Admin Username and Admin Password fields are
optional.

v Upload new key. If you select this action, the Admin Username and
Admin Password are required.

Admin Username
If you selected Upload new key in the Select Key list, enter the name
of a user that has the administrator role for the SAN Volume Controller
or Storwize V7000 cluster that contains the device. If you selected Use
existing uploaded key, this field is optional.

Admin Password
Enter the password for the user that you entered in the Admin
Username field.

Username
Enter an authorized user for the device. This field is active if you have
selected Upload new key in the Select Key list and have entered a user
name and password in the Admin Username and Admin Password
fields. To search for a user, click Select User. You must enter a valid
administrator name and password to retrieve a list of users.

Private SSH Key
Displays the path for the private SSH key. If you want to change this
path, enter a new path or click the Browse button to search for a new
path.

Passphrase (optional)
Displays the passphrase for the SSH key pair.

4. Select File > Save. If successful, the Storage Subsystems window appears and
any new values for the storage subsystem are shown.
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Modifying Storwize V7000 Unified storage system details
After you add a Storwize V7000 Unified storage system, information about the
system is displayed in the Storage Subsystems Details page. You can modify the
information that is in the available fields that are on this page.

Storwize V7000 Unified is composed of Storwize V7000 and Storwize V7000 File
Module. You can connect to only Storwize V7000 or to both Storwize V7000 and
Storwize V7000 File Module. Storwize V7000 provides block-level data and
Storwize V7000 File Module provides file-level data.

To modify information about a Storwize V7000 Unified storage system, follow this
procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

Storage Subsystems.
2. On the Storage Subsystems page, double-click a storage subsystem row to edit

information about that storage subsystem. The following information about the
storage subsystem is displayed:

Storwize V7000

Storage Subsystem
Displays the name of the storage system.

IP Address
Enter the IP address or host name of the Storwize V7000
storage system. You can enter an IPv4 or IPv6 address, for
example:
v 127.0.0.1
v [2001:DB8:0:0:0:0:0:0/32]

Select Key
An SSH key is required to access Storwize V7000. Select one of
the following actions for the SSH key:
v Upload new key: Select this option to upload a new key.

Public key content is extracted from the private key that is
provided in the Private SSH Key field and is uploaded to
the Storwize V7000 cluster. If you select this action, the
Administrator User Name and Administrator Password
fields are required.

v Use existing uploaded key: Select this option if you want to
use a public key that was already uploaded by using a
method other than through Tivoli Storage Productivity
Center, such as the Storwize V7000 web interface. Enter the
location of the private key file that corresponds to the public
key in the Private SSH Key field. The Administrator User
Name and Administrator Password fields are not required if
you select this option.

Administrator User Name
If you selected Upload new key in the Select Key list, enter the
name of a user that has the Security Administrator role for the
Storwize V7000 cluster that contains the storage system. Tivoli
Storage Productivity Center uses this value during the setup
process to contact the cluster and configure the SSH keys for
the user. This user must belong to the Security Administrator
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role, which has privileges to modify other user accounts.
Otherwise, Tivoli Storage Productivity Center cannot configure
the SSH keys.

If you selected Use existing uploaded key, this field is
optional.

Administrator Password
Enter the password for the user name that you entered in the
Administrator User Name field.

If you selected Use existing uploaded key, this field is
optional.

User Name
Enter an authorized user name for the storage system. Tivoli
Storage Productivity Center uses this value to monitor and
configure the storage system. If the user name does not exist, it
is created. This user name must belong to the Administrator
role.

This field is active if you selected Upload new key in the
Select Key list and entered a user name and password in the
Administrator User Name and Administrator Password fields.
Important: If you upload a new key for the existing Storwize
V7000 user by using Tivoli Storage Productivity Center, that
new key overrides the existing key for the user name. If you
have another application that is using that user name (for
example Tivoli Storage Productivity Center for Replication), the
application cannot log on to Storwize V7000 because the key
associated with the user is overwritten.
If this situation occurs, create a user ID specifically for Tivoli
Storage Productivity Center or Tivoli Storage Productivity
Center for Replication on the Storwize V7000 cluster. Add the
Storwize V7000 storage system to Tivoli Storage Productivity
Center for Replication using the new user ID and password (or
change the user ID and password while the storage system is in
the disconnected state).

Select User
Select a user name from the list. The names are defined
on Storwize V7000.

Private SSH Key
By default, the private key entry includes ${device.conf}\
tpc_svc.pem, which represents the Tivoli Storage Productivity
Center default key tpc_svc.pem. The tpc_svc.pem key is in the
conf directory where the Device server is installed. If you want
to use your own key, the key must exist on the system where
you are running the Tivoli Storage Productivity Center user
interface. The key is uploaded to the Tivoli Storage Productivity
Center server system. To identify a new key, click Browse.

The private SSH key must be in OpenSSH format or in PuTTY
(.ppk) format that is not password protected. If you have a
password protected PuTTY .ppk key, use the PuTTYgen utility
on a Windows operating system to convert that key to
OpenSSH format by following these steps:
a. Start the PuTTYgen utility.
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b. Load the .ppk file by clicking File > Load private key.
c. From the menu bar, click Conversion > Export

OpenSSH key conversion.

This action saves the key in OpenSSH format.

Passphrase (Optional)
Enter the passphrase for the private SSH key. The passphrase
protects your private SSH key file. If you do not have a
passphrase, leave this field blank.

Storwize V7000 File Module (Optional)
If this check box was not selected when the storage system was added,
you can select the check box to connect to the Storwize V7000 File
Module. If this check box was selected when the storage system was
added, you cannot clear the box.

Depending on the configuration of Storwize V7000 Unified, the
information that is required to connect to this system can be the same
as or different from the information for Storwize V7000. The fields and
field descriptions are the same as the fields in the Storwize V7000 pane
with the following exceptions:
v The IP Address field is not displayed because the IP address is

retrieved automatically.
v The User Name field is always required.
v The private SSH key must be in OpenSSH format. The PuTTY format

is not supported. You can use the PuTTYgen utility to convert the
key to the OpenSSH format.

v The Select Key list contains the option Use user password in
addition to the Upload new key and Use existing uploaded key
options. If you select Use user password, the User Password field is
enabled and you can use a user name and password to connect to
the file module.
If you select Use user password, the Administrator User Name and
Administrator Password fields are optional.

3. Click File > Save on the menu bar. If the modifications are successful, the
Storage Subsystems page is displayed and any new values for the storage
subsystem are shown.

Modifying System Storage DS8000 details
Learn how to modify information about a IBM System Storage DS8000 device that
connects to IBM Tivoli Storage Productivity Center.

After you add a System Storage DS8000 device, basic information about that
system appears on the Administrative Services > Data Sources > Storage
Subsystems panel. To modify information about a System Storage DS8000 device
on the Storage Subsystems panel, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

Storage Subsystems.
2. In the content panel, double-click a storage subsystem row or click the icon

next to a row to edit information about that storage subsystem. Information
about the storage subsystem appears on the Storage Subsystems Details
window.

3. You can edit the information in the fields that are specified in bold in the
window:
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Storage Subsystem
Displays the name of the System Storage DS8000 device.

HMC Address
Displays the IP address or host name for the Hardware Management
Console (HMC) that is used to manage the device.

HMC2 Address (optional)
Displays the IP address or host name for a second HMC that is used to
manage the device.

Username
Displays the user name for the device.

Password
Displays the password for the device.

4. Select File > Save. If successful, the Storage Subsystems window appears and
any new values for Username and Password for the storage subsystem are
shown.

Modifying other storage system details
Learn how to modify information about the storage systems that connect to IBM
Tivoli Storage Productivity Center using CIM object managers (CIMOMs).

After you add a CIMOM, basic information about that CIMOM appears on the
Administrative Services > Data Sources > Storage Subsystems panel. To modify
information about a CIMOM on the Storage Subsystems panel, follow this
procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

Storage Subsystems.
2. In the content panel, double-click a storage subsystems row or click the icon

next to a row to display a table of the CIMOMs that the storage subsystem is
registered with.

Service URL
Displays the service Web address of the CIMOM. This Web address
contains the IP address of the CIMOM, the port on which the CIMOM
is listening, and the protocol used for communication. This Web
address has a protocol (http|https), an IP address (IPv4 or IPv6), and a
port number. For example: IPv4: https://127.0.0.1:5989 IPv6:
https://2001:DB8:0:0:0:0:0:0:5989.

Connection Status
Displays the status of the connection between Tivoli Storage
Productivity Center and the CIMOM.

Interoperability Namespace
Displays the interoperability namespace of the CIMOM. This
namespace within the CIMOM allows the CIM Interop Schema
(including the class instances of the Server Profile) to be accessed. The
namespace also determines how Tivoli Storage Productivity Center
interacts with the CIMOM when retrieving information. For a NetApp
CIMOM, the value is /interop.

Display Name
Displays the name of the CIMOM as specified by the CIMOM provider.

Description (optional)
Displays the description that was entered on the Add CIMOM Agent
window.
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3. In the content panel, double-click a CIMOM row or click the icon next to a row
to display details for the CIMOM. The connection information that you enter
for a CIMOM is like the information that you enter on the Add CIMOM Agent
panel. See “Adding a CIM agent connection” on page 250 for descriptions of
the fields on this panel.

4. Select File > Save. If successful, the View and Edit CIMOM window appears
and any new values for the CIMOM are shown.

Testing the connection to a storage system
Learn how to test the connection from IBM Tivoli Storage Productivity Center to a
storage system.

You must have Administrator privileges to perform this action.

After you add a storage system to Tivoli Storage Productivity Center, basic
information about that system appears on the Administrative Services > Data
Sources > Storage Subsystems panel. To verify that Tivoli Storage Productivity
Center can use the information provided to connect to the storage system, follow
this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

Storage Subsystems.
2. In the content panel, highlight the row for a storage system and click Test

Connection to test its connection to Tivoli Storage Productivity Center. The
results of the test are displayed in the Test Subsystem Connection dialog box.

3. Click OK to close the dialog box. The Connection Status field is updated to
reflect the status.

Removing a storage system
Learn how to remove the connection between a storage system and IBM Tivoli
Storage Productivity Center.

You must have Administrator privileges to perform this action.

Use the Administrative Services > Data Sources > Storage Subsystems panel to
remove a storage system. Removing a storage system will:
v Remove the storage system information from master server database repository
v Remove the storage system information from all rollup reports
v Remove the storage system from the Storage Subsystems table

To remove a storage system, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

Storage Subsystems.
2. In the content panel, select a storage system and click Remove. A dialog box

appears.
3. Click Yes to confirm the removal of the connection between the storage system

and Tivoli Storage Productivity Center.

VMware data source
VMware Virtual Infrastructure data sources are used by IBM Tivoli Storage
Productivity Center to collect information from the hypervisors and virtual
machines within them.

When you add a VMware data source in IBM Tivoli Storage Productivity Center,
you need a user ID that has permission to browse through the data stores on
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VMware. IBM Tivoli Storage Productivity Center needs to browse through the data
stores to collect information from the ESX Servers. However the "Read Only" role
as defined by VMware does not allow IBM Tivoli Storage Productivity Center to
browse the data stores. You can use the "Virtual Machine Power User" role as a
choice if you do not want to use the Administrator role, or you can create a
custom role with the required permissions.

To check what user role you have for VMware, follow these steps:
1. Connect a VI client to the ESX Server or VirtualCenter (whichever is used as

the data source). Click the ESX Server and go to the Summary tab. Select a data
source, right-click the data source and select Browse, to confirm that the
browse permission is working correctly.

2. Connect the VI client to the data source with the admin role, go to the
Permission tab and determine if the role name is used for the user.

3. Open the Permissions view, select that role, then right-click and select the Edit
role. See what permissions are checked. Expand the check groups to find the
specific ones.

For more information about VMware user roles, see: http://www.vmware.com/
pdf/vi3_vc_roles.pdf.

Adding a VMware VI Data Source
This topic provides information about adding a VMware Virtual Infrastructure data
source.

To add a VMware VI data source, follow this procedure:
1. In the Navigation Tree pane, expand Administrative Services > Data Sources >

VMware VI Data Source.
2. In the content pane, click Add VMware VI Data Source.
3. In the Add VMware VI Data Source window, enter the following information:

Host Name
The host name for the VMware data source (ESX Server or
VirtualCenter).

Protocol
This is http or https. If you use https, you must have first imported the
SSL certificate into IBM Tivoli Storage Productivity Center. For
information about how to import the SSL certificate, see the IBM Tivoli
Storage Productivity Center and IBM Tivoli Storage Productivity Center for
Replication Installation and Configuration Guide Version 4 Release 1. The
protocol must match the same protocol that is set for the ESX Server or
VirtualCenter.

Port The port used by the VMware data source.

Username
The user name for the VMware data source.

Password
The password for the VMware data source.

Password Confirm
The password is confirmed for the VMware data source.

Display Name
The name displayed in reports for the VMware data source.
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Description
The description for the VMware data source.

Test VMware VI Data Source connectivity before adding
Check this box to check the connectivity for the VMware data source.

4. Click Save.

Updating VMware data source information
After a VMware data source has been added, you can update the administrator
name or password for the VMware data source.

To update information for a VMware data source, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

VMware VI Data Source.
2. In the content pane, click on the icon by the VMware data source you wish to

change.
3. In the content pane, a notebook window opens. Make the appropriate changes.

Displaying information about a VMware data source
You can view information about a VMware data source including its host name,
protocol, port, and type.

To display information about a VMware data source, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

VMware VI Data Source.
2. In the content pane, click on the magnifying glass icon for the VMware data

source for which you want information for. In the content pane, a notebook
window opens. The following information is displayed:

Host Name
The IP address of the data source.

Protocol
This is http or https.

Port The port used by the VMware data source.

Type Virtual Center.

Administrator Name
The name of the administrator for the VMware data source.

Password
The password for the VMware data source.

Password Confirm
Confirm the password for the VMware data source.

Display Name
The name displayed for the VMware data source.

Description
Description for the VMware data source.

Software Level
The software level for the VMware data source.

ConnectionStatus
The connection status to the VMware data source.

Status Timestamp
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Test VMware VI Data Source connectivity before updating
Check this box to check the connectivity to the VMware data source.

Show managed devices for VMware
You can view information about the managed devices for VMware.

To show the managed devices for VMware, follow this procedure:
1. In the navigation tree, expand Administrative Services > Data Sources >

VMware VI Data Source.
2. In the content pane, click Show Managed Devices.
3. A pop-up window displays the VMware managed devices. Click OK to close

the window.

Deleting a VMware VI Data Source
This topic provides information about deleting a VMware Virtual Infrastructure
data source.

To delete a VMware VI data source, follow this procedure:
1. In the Navigation Tree pane, expand Administrative Services > Data Sources >

VMware VI Data Source.
2. In the content pane, click Remove VMware VI Data Source.
3. In the confirmation dialog window to remove a VMware data source, click OK.

Managing schedules, jobs, and runs
Use the Job Management panel to view and manage all the schedules, runs, and
jobs related to the storage devices that are monitored by IBM Tivoli Storage
Productivity Center.

Specifically, you can use the Job Management panel to perform the following tasks:
v View information about all schedules, runs, and jobs in one central location. In

previous versions of the product, this information was available only through
nodes under each schedule type in the navigation tree.

v Identify all the schedules that include a particular storage device.
v Identify all the schedules, runs, and jobs that are encountering problems when

executing.
v Ensure that a storage device is fully monitored by Tivoli Storage Productivity

Center.
v Edit, rename, delete, and run schedules. You must be logged in as the user who

created a schedule to perform some of these actions.

Use either of the following methods to access the Job Management panel:

v Click the job management icon in the toolbar.
v Open the definition of a schedule and click the View Job History button to view

the runs and jobs related to the schedule. For example, in the navigation tree,
click IBM Tivoli Storage Productivity Center > Monitoring > Probes >
TPCUser.Default Probe to view the probe definition panel and click View Job
History.

The following terms are used on this panel:
v Schedule: A schedule is a definition of a monitoring task that collects data about

storage resources. Monitoring tasks include scans, probes, pings, quotas,
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discovery, and performance monitors. For example, define a probe schedule to
collect data about storage subsystems; define a scan schedule to collect file-level
information about hosts.

v Run: A run is a single invocation of a schedule.
v Job: A job is a unit of work within a run for a schedule. One run might have

multiple jobs. For example, a subsystem probe schedule has one job created per
subsystem for which it collects data.

The Job Management panel is divided into the following sections:

Filters section
Use this section to perform the following tasks:
v Determine the type of storage entities whose schedules are displayed on

the panel.
v View recommendations for storage entities that are not fully monitored

by Tivoli Storage Productivity Center.

Filtering the contents of this panel based on entity type is optional. You
select Show All from the Entity Type menu to display all the schedules
defined in Tivoli Storage Productivity Center.

Schedules section
Use this section to manage the schedules related to the entities you
selected in the Filters section. You can perform the following actions for
each schedule:
v View and edit the definition of a schedule.
v Run a schedule immediately.
v Rename a schedule.
v Delete a schedule.
v Display schedules that have a certain status, such as Success, Running,

or Failed.
v View basic information about a schedule, including the ID of the user

who created it, description, job type (for example, ping, probe, or scan),
the last time the schedule was run, and the next time the schedule is
run.

Jobs for Selected Schedule section
Use this section to manage each run of a schedule and the jobs associated
with a run. You can perform the following tasks for jobs and runs:
v View the status of a run and the date and time when it was executed.
v View information about the jobs associated with each run, including the

name of the computer on which a job was run, the type of the
monitored device, and the status of the job.

v View the log files for one or more jobs at a time.
v Display jobs that have started or completed within a specified length of

time. For example, display jobs that have completed in the last two
weeks.

v Display jobs that have a certain status, such as Success, Running, or
Failed.

Click and drag the horizontal lines on the panel to resize each section. Click the
names of columns in the Schedules and Jobs for Selected Schedule sections to
sort the contents of lists based on the clicked column.
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Filters

Refresh All
Click this button to update all the lists that are displayed on the panel.

Entity Type
Select the type of storage entity whose related schedule information you
want to view. By default all schedules are displayed when you first access
this panel. When you select a specific entity type, the following actions
take place:
v The schedules, runs, and jobs related to the entity type are displayed in

the appropriate sections on the panel.
v The names of the devices that belong to that entity type are displayed in

the Entity Name list box.
v The text that is displayed above the Show Recommendations button

indicates if the devices are fully monitored.

You can select from the following entity types in the Entity Type menu:

Show All
(default) View all the schedules defined in Tivoli Storage
Productivity Center.

Storage Subsystem
View the schedules for storage subsystems that are monitored by
Tivoli Storage Productivity Center.

Fabric View the schedules for fabrics that are monitored by Tivoli Storage
Productivity Center.

Computer
View the schedules for computers that are monitored by Tivoli
Storage Productivity Center.

Switch
View the schedules for switches that are monitored by Tivoli
Storage Productivity Center.

Tape Library
View the schedules for tape libraries that are monitored by Tivoli
Storage Productivity Center.

Monitoring Group
View the schedules that contain monitoring groups.

Storage Resource Group
View the schedules for all the devices contained within a particular
storage resource group.

Entity Name Filter
Enter text to filter the names of entities that are displayed in the Entity
Name list box. You can enter a combination of letters, numbers, dashes,
underscores, and spaces. The filter text is not case sensitive. You can also
enter the following wildcard characters:
v Use an asterisk (*) to represent zero or more unknown characters of any

value. For example, enter DS8* to display devices of the selected type
that begin with DS in their names, such as DS6000-A12-IBM,
DS8000-B34-IBM, and DS5000-B35-IBM.
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v Use a question mark to represent a single unknown character of any
value. For example, enter D?000-B3?-IBM to include devices such as
DS8000-B34-IBM, DS8000-B36-IBM, and DS5000-B35-IBM in the Entity
Name list box.

Text that is displayed above the Show Recommendations button
Warning text is displayed above the Show Recommendations button if the
devices selected in the Entity Name list box are not fully monitored.

A device is considered not fully monitored if it is not included in all data
collection schedules that are available in the licensed edition of Tivoli
Storage Productivity Center that is installed. For example, if using the
Advanced edition of Tivoli Storage Productivity Center to monitor a host,
that host must appear in the following schedule definitions to be
considered fully monitored: ping, probe, and scan. If using the Disk edition
of Tivoli Storage Productivity Center to monitor a storage subsystem, that
storage subsystem must appear in the following schedule definitions to be
considered fully monitored: probe.

If a device is considered not fully monitored, click Show
Recommendations to view a list of recommended actions you can take to
address the warning.

Show Recommendations
Click this button to view recommended actions for a selected device that is
not fully monitored. From the Recommendations panel, you can perform
the following tasks:
v View the schedules that are recommended for a device.
v Click the Take Action button to create the recommended schedule for a

device.

Schedules

View Detail
View the definition of a schedule that is selected in the schedule list. The
schedule definition panel opens when you click this button. Use this panel
to view and edit the definition of a schedule.

Run Now
Run the selected schedule immediately. This option is only available if the
job is not currently running.

Refresh
Update the status of the schedule that is selected in the schedule list. The
process to refresh the status of a schedule might take a few moments based
on the current server load and network speed.

action drop down menu
Use the options in this menu to perform actions against the selected
schedule. The menu includes View Detail, Run Now, Stop Now (for
performance monitor schedules) and the following actions:

Rename
Rename a schedule. You must be the owner of a schedule or the
Tivoli Storage Productivity Center superuser to perform this action.
This action is not available for the default schedules that are
owned by TPCUser.

Delete Delete a schedule. When you delete a schedule, all the runs and
jobs associated with the schedule are also deleted. You must be the
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owner of a schedule or the Tivoli Storage Productivity Center
superuser to perform this action. This action is not available for the
default schedules that are owned by TPCUser.

Only show schedules with status
Filter the schedules that appear in the schedules list based on their status.
For example, use this menu to indicate that only schedules with a status of
Running are displayed in the schedules list. The default setting displays all
schedules.

You can filter schedules using the following statuses:
v Show All
v Show All Unsuccessful
v Success
v Running
v Warnings
v Failed
v The job is waiting
v The job is running

Tivoli Storage Productivity Center automatically updates the schedules list
if you change the value selected in this menu.

schedules list
Use this list to view the schedules for the storage entities that are selected
in the Filters section of the panel. The schedules that are displayed must
also meet the filter selected in the Only show schedules with status menu.
Click the name of a column to sort the contents of this list based on that
column.

Some jobs that run in Tivoli Storage Productivity Center do not have a
schedule associated with them. For example, jobs that are run through the
command-line interface (CLI) do not have a schedule defined for them. To
ensure that these job types are displayed on the Job Management panel, a
new schedule called CLI and Event Driven Jobs was created. Select this
schedule to view the runs and jobs that do not have user-created schedules
associated with them. The job log files for the CLI and Event Driven Jobs
schedule are automatically retained for 90 days and then deleted.

The following information is displayed for each schedule:

Creator
The ID of the Tivoli Storage Productivity Center user who created
the schedule.

Name The name of a schedule.

Description
The description of a schedule.

Job Type
The type of the schedule, such as Probe, Ping, Scan, Aggregator
Job, CIMOM Discovery, or Subsystem Performance Monitor.

Last Run Finished
The data and time when the most recent run of a schedule
completed. This column is blank if the schedule has never been
run.
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Last Run Status
The status of the most recent run of a schedule.

Next Run
The date and time when the next run of the schedule is planned.
The value On Demand is displayed for schedules that are defined
with the Run Now option. The value Never is displayed for
schedules that are defined with the Run Once option and have
already run.

row number
Appears in the lower right corner of the schedules list and indicates the
number of rows in the schedules list. One row is displayed for each
schedule. Use the horizontal lines on the panel to resize the section and
increase or decrease the number of rows that are displayed.

Jobs for Selected Schedule

View Log File(s)
View the log files of jobs that are selected in the runs list. Use the Shift +
click and Ctrl + click keyboard shortcuts to select multiple jobs. You can
view up to 10 logs at one time. The Log File Viewer panel opens when you
click this button or when you double-click a row for a job. Use this panel
to view all the processing performed by the Tivoli Storage Productivity
Center server and agents for jobs.

Note: The number of job log files that are retained for a schedule is
determined by the values defined on the Log File and Cached Batch
Report Retention panel under Administrative Services > Configuration.
However, for CLI and Event Driven Jobs schedules, job log files are
automatically retained for 90 days.

Show Jobs, in the last
Use these fields to determine the runs that are displayed for the selected
schedule. Use the following conditions in the filter:
v Select Started or Completed from the Show Jobs menu to display runs

based on whether they started or completed in the time frame specified
on the last field.

v Specify a time frame for started or completed runs by entering a number
in the last field and selecting a unit of measurement from the menu.

For example, select Started, enter 4, and select weeks to display the runs
for a schedule that have started within the last four weeks. Tivoli Storage
Productivity Center automatically updates the runs list if you change the
value selected in these fields.

Only show jobs with status
Determine the runs that are displayed in the runs list based on their status.
For example, use this menu to indicate that only runs with a status of
Completed with warning(s) are displayed. The default setting displays all
runs for the selected schedule.

You can filter the display of runs using the following statuses:
v Show All
v Show All Unsuccessful
v The job is waiting
v Running
v The job is running
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v Completed successfully
v Running with warning(s)
v Completed with warning(s)
v Completed with error(s)
v System error occurred
v The agent did not respond (to a request from the server)
v The agent is being upgraded
v The agent is not licensed
v Agent not found
v Agent could not be reached
v The job delay limit was exceeded.
v The agent disconnected
v Host was shutdown or recycled
v Cluster resource group unreachable: no IP
v Scripts are disabled for this agent
v Script was not found or has an invalid extension
v The agent disk space is low

Tivoli Storage Productivity Center automatically updates the runs list if
you change the value selected in this menu.

runs list
Use this list to view the runs and jobs of the schedule selected in the
Schedules section of the panel. This list displays runs based on the criteria
specified in the Show jobs and in the last fields.

Click the + symbol next to an entry in the Run field to view the jobs
associated with a run. Click the name of a column to sort the contents of
this list based on that column.

The following information is displayed for each run or job:

Run Status
The status of a run.

Run The run number assigned to a run and the date and time when the
run was started.

Computer
(jobs only) The name of the computer where a job is executed. For
database probes, this column displays the name of the Storage
Resource agent that is performing the probe. For storage subsystem
probes, this column displays localhost because the probe is
performed by the Tivoli Storage Productivity Center server.

Device
(jobs only) The name of the device to which a job applies. This
column is blank if the job is not related to a specific device.

Status (jobs only) The status of a job.

Start Time
(jobs only) The date and time when a job started.

Finish Time
(jobs only) The data and time when a job completed.
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Log File Name
(jobs only) The name of the log file for a job. Click the View Log
File to view the contents of a job log.

row number
Appears in the lower right corner of the runs list and indicates the number
of rows in the runs list. One row is displayed for each run. You can expand
each run row to view the jobs related to that run. Use the horizontal lines
on the panel to resize the section and increase or decrease the number of
rows that are displayed.

Job Management - Recommendations
Use this window to view and apply the recommendations for storage devices that
are not fully monitored by IBM Tivoli Storage Productivity Center.

A device is not fully monitored if it is not included in all the data collection
schedules that are available in the licensed edition of Tivoli Storage Productivity
Center that is installed. For example, if using the IBM Tivoli Storage Productivity
Center Advanced license to monitor a host, that host must appear in the following
schedule definitions to be considered fully monitored: ping, probe, and scan. If
using IBM Storage Productivity Center Select Edition to monitor a storage
subsystem, that storage subsystem must appear in a probe schedule to be
considered fully monitored.

Recommendation Severity
Indicates whether a recommendation is a Warning or Informational.

v A Warning message indicates an action that you can take to more fully
use Tivoli Storage Productivity Center to monitor a device. For example,
when using a probe schedule in the IBM Tivoli Storage Productivity
Center Advanced license to collect data about a storage system, a
warning message is displayed. This message recommends that you also
include the storage subsystem in a performance monitor schedule. You
can then use the data collected by performance monitor to identify the
bottlenecks in storage usage and performance for the storage subsystem.

v An Informational message is a recommendation to upgrade Tivoli
Storage Productivity Center to an edition that includes additional
monitoring functions. For example, when using probe schedules in IBM
Storage Productivity Center Select Edition to collect data about a fabric,
an informational message is displayed. This message indicates that if
you upgrade to IBM Tivoli Storage Productivity Center Advanced,
performance data can be collected about the fabric.

For Warning messages, select the corresponding row and click Take Action
to perform the recommended action.

Entity Displays the name of a storage entity to which the recommendation
applies.

Recommendation
Indicates the recommended actions for a storage entity. One row is
displayed per recommendation. Click Take Action to resolve
recommendations that have a Warning severity.

If multiple recommendations are displayed for a device, sometimes
performing one of the recommended actions might resolve the other
recommendations. For example, consider if these two recommendations are
displayed for a fabric:
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v In order to collect information about device configuration, define
a probe schedule for fabric {0}

v To enable zone control, add a data source that is capable of zone
control for fabric {0}

If you click Take Action for the first recommendation and include the
fabric in a probe, the second recommendation is also resolved. Both
recommendations are then automatically removed from the
Recommendation list

Take Action
Perform the recommended action for a warning. When you click this
button, the corresponding panel for the action is displayed. For example, if
the recommended action is to include a storage subsystem in a
performance monitor, the panel is displayed.

Cancel
Exit the window without taking action.
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Chapter 5. Managing resources in the stand-alone GUI

You can use the stand-alone GUI to manage and monitor the resources and storage
infrastructure in an enterprise environment. This interface provides all the tools to
manage data, disk, fabric, tape, and replication.

Tivoli Storage Productivity Center also provides a web-based GUI for monitoring
resources. Each GUI provides different functions for managing your storage. To
view a comparison of the functions that are available in each GUI, see “Available
functions and report information in the interfaces” on page 19.
Related concepts:
Chapter 6, “Managing resources in the web-based GUI,” on page 623
You can use the web-based GUI to monitor the condition, capacity, and
relationships of the monitored resources within your storage environment.

Configure Devices wizard
Use the Configure Devices wizard to set up storage devices for monitoring by IBM
Tivoli Storage Productivity Center. The wizard guides you through the steps for
adding a device as a data source, running a discovery, including devices in groups,
specifying alerts, and setting up data collection schedules.

In previous versions of IBM Tivoli Storage Productivity Center, setting up a storage
device for monitoring required performing tasks in different locations of the user
interface, and each type of device required different steps. In Tivoli Storage
Productivity Center v4.2 and later, all the tasks for setting up and configuring a
device are included in the Configure Devices wizard.

Use the wizard to configure the following device types for monitoring:
v Storage subsystems
v Fabrics and switches
v Computers
v Tape libraries

You can add multiple devices of the same type using a single session of the
wizard. For example, you can add an IBM DS8000, IBM XIV, IBM SAN Volume
Controller, IBM Storwize V7000, IBM Storwize V7000 Unified, IBM SONAS, and
storage subsystems associated with CIM agents by using a single session of the
wizard. You cannot configure multiple devices of different types at the same time.
For example, you cannot add a storage subsystem and a fabric using a single
session of the wizard.

Note: The Configure Devices wizard queries all schedules to identify whether a
subsystem or entity is part of a scheduled probe. If a probe schedule has been
defined for a global entity such as All Computers or All Storage subsystems, the
Configure Devices wizard will not display a new device as an entity requiring
configuration.

The pages in the wizard are divided into two sections:
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Steps Displays the steps for completing in the wizard. An icon is displayed next
to the current step. The wizard includes the following steps for configuring
a device:
1. Select the device type that you want to configure.
2. Select the specific devices that you want to configure.
3. Determine how data is collected from the devices.
4. Review your selections and run the wizard.
5. Review the results of the wizard.

How you access the wizard determines on what step you begin. For
example, if you click the Configure Devices icon in the toolbar or select
the Configure Devices node in the navigation tree, you start by selecting
the device type that you want to configure. If you click the Add Storage
Subsystem button on the Disk Manager > Storage Subsystem panel, you
begin by entering connection information about the storage systems that
you want to configure.

Options
Displays the options and fields that you must select and complete for each
step.

Related reference:
“Alerts and schedules associated with monitoring groups and templates” on page
1419
Use alerts to notify you when conditions for storage devices are detected by a data
collection schedule. Include storage devices in monitoring groups or templates to
automatically associate alerts and schedules with those devices.

Configuring storage subsystems
Use the Configure Devices wizard to configure storage systems so that these
storage systems can be monitored by Tivoli Storage Productivity Center. Storage
subsystems that you configure using the wizard are automatically included in
probe schedules and associated with alert conditions.

You can configure more than one storage system at a time by using the Configure
Devices wizard. All the storage systems that you configure by using the wizard
share probe schedule and alert conditions.

Depending on the type of storage system that you want to configure, you must
define connection information for its native interface or associated CIMOM. Enter
information in the wizard about the native interfaces for the following storage
systems:
v System Storage DS8000
v SAN Volume Controller
v The XIV system
v Storwize V7000
v Storwize V7000 Unified
v IBM SONAS

For all other storage systems, you must enter information about the CIM agents
that manage them.

To configure storage systems to be monitored by Tivoli Storage Productivity
Center, complete the following steps:
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1. Select one of the following ways to access the wizard:
v To configure existing storage systems, click the Configure Devices icon on

the toolbar. You cannot configure existing storage systems if they are already
included in a probe schedule.
If you select this method, you must also complete the following steps:
a. On the Select Device Type page, select Storage Subsystem.
b. Click Configure existing storage subsystems. The page displays the

storage systems that are known to Tivoli Storage Productivity Center.
Continue to next step.

v To only add storage systems, select one of the following methods and
proceed to step 4:
– In the navigation tree, expand Disk Manager > Storage Subsystems and

click Add Storage Subsystem.
– In the navigation tree, expand IBM Tivoli Storage Productivity Center >

Configuration Utility > Services > Storage Subsystem Interfaces and
click Add.

2. Select the existing storage systems that you want to configure. Storage systems
that are already included in probe schedules are not displayed.
If the Credentials column indicates Missing or New Credentials Required for
the storage systems that you select, you must update the storage system
connection properties before you continue.

3. Enter valid connection properties for each storage system that you want to
configure, and continue to step 6.

4. Configure the storage system or CIMOM connections. Tivoli Storage
Productivity Center uses this information to connect to a storage system or
CIMOM.
Enter information for a storage system or CIMOM, and then click Add. Repeat
steps 1 - 3 to configure multiple storage systems or CIMOMs in the same
session of the wizard.
Tivoli Storage Productivity Center will discover the storage systems managed
by each of the CIMOM connections that you entered.

5. Select the storage systems that you want to configure. Any storage systems that
were added in previous steps are automatically selected. Deselect storage
systems that you do not want to configure.

6. Specify how data is collected for storage systems by including them in a
monitoring group or template. Use monitoring groups and templates to
determine when data is collected and what alert conditions are checked for the
storage systems that you are configuring.
v Select a monitoring group if you want to manage a collection of storage

systems in the same manner. By default, the monitoring group that you
select is associated with an existing probe schedule and set of alerts. When
you select the group, its data collection schedule and alerts are automatically
applied to all the storage systems that you are configuring. After completing
the wizard, the storage systems remain in the group and you can use that
group when working in other parts of the user interface, such as in reports.

Tip: Tivoli Storage Productivity Center provides a number of default
monitoring groups for storage systems. If you want to include a storage
system in a user-defined group rather than in a default group, that group
must be associated with a data collection schedule. If the user-defined group
is not associated with a data collection schedule, it is not displayed in the list
of monitoring groups from which you can select.
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v Select a template if you want to create a unique probe schedule and set of
alerts for a storage system rather than using the settings of an existing group.

The option that you select in this step determines the next step in the wizard.
v If you select a monitoring group, the following actions occur:

– The storage systems are automatically included in a probe schedule to
which the group is associated. For example, if you select Subsystem Basic
Group, the storage systems are included in the Subsystem Basic Probe
schedule. The Subsystem Basic Probe schedule runs one time per week on
Tuesday at 1:00 am.

– A set of alert conditions are applied to the storage systems in a group.
When any of these conditions are detected during data collection, an alert
is triggered. The group that you select determines the alerts that are
associated with the storage systems. For example, if you select Subsystem
Basic Group, 14 alert conditions are automatically checked for the storage
systems.

– The storage systems are included in the group. You can use that group in
other parts of the user interface, such as in reports.

v If you select a monitoring template, the following actions occur:
– The storage systems are automatically included in a probe schedule that is

created for the template. For example, if you select the Basic Subsystem
Monitoring template, the storage systems are automatically included in a
new probe that runs one time per week on Tuesday. The probe is created
after the wizard is completed. Tivoli Storage Productivity Center
determines the time when the probe is run based on server load to ensure
optimal performance.

– A set of alert conditions is applied to storage systems in the template.
When any of these conditions are detected during data collection, an alert
is triggered. The template you select determines the alerts that are
associated with the storage systems. For example, if you select to the Basic
Subsystem Monitoring template, 14 alert conditions are automatically
checked for the storage systems.

– You must enter a prefix for the probe schedule and alerts that are created
for the template. This prefix is used to identify the probe and alerts in the
user interface. For example, if you select the Basic Subsystem Monitoring
template and enter the prefix "ABC", a probe schedule named
"userID.ABCssBasicProbe" and alerts such as "userID.ABCPool Discovered
(Basic)" are created, where userID represents the ID of the user that is
logged on toTivoli Storage Productivity Center.
The new probe and alerts are displayed under the corresponding node in
the navigation tree for you to view and edit. For example, a probe
schedule created from a template in the wizard appears under the IBM
Tivoli Storage Productivity Center > Monitoring > Probes node; new
storage system alerts appear under the Disk Manager > Alerting node.

See Alerts and schedules associated with monitoring groups and templates for
a list of groups and templates with their associated schedules and alerts.

7. On the summary page of the wizard, review the selections that you made.

View the results of the device configuration and close the wizard. The devices that
you configured are probed.
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Configure storage subsystem connections page
Use this page in the Configure Devices wizard to enter or update connection
properties for the storage systems and CIMOMs that you are configuring. Tivoli
Storage Productivity Center uses this information to collect data about the storage
systems.

Use the Configure storage system connections page to enter or update connection
properties for the following storage entities. Depending on the type of storage
system that you want to configure, you must define connection information for its
native interface or associated CIMOM. Enter information on the page about the
native interfaces for the following storage systems:
v System Storage DS8000
v XIV system
v SAN Volume Controller / Storwize V7000
v Storwize V7000 Unified
v IBM SONAS

The entity that is selected from the Device Type list determines the information
that Tivoli Storage Productivity Center requires to connect to that entity. The
following sections describe the fields for each entity.

Requirement: If you are adding or updating connection properties for a SAN
Volume Controller or Storwize V7000 storage system, select IBM SAN Volume
Controller / IBM Storwize V7000 in the Device Type list. If you are adding or
updating connection properties for a Storwize V7000 Unified storage system, select
IBM Storwize V7000 Unified.

IBM DS8000

Enter or update the following information to have Tivoli Storage Productivity
Center connect to a System Storage DS8000 storage system.

HMC Address
Enter the IP address or host name for the Hardware Management Console
(HMC) that is used to manage the System Storage DS8000 storage system.

HMC2 Address (Optional)
Enter the IP address or host name for a second HMC that is used to
manage the storage system.

Username
Enter the user name for logging in to the System Storage DS8000 element
manager. The default user name is admin.

Note: This user name is the same as the ESSNI user name.

Password
Enter the password for the user name.

IBM XIV

Enter or update the following information to have Tivoli Storage Productivity
Center connect to the XIV system.

IP Address
Enter the IP address or host name for the XIV system that you want to
configure.
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Username
Enter the user name for the XIV system.

Password
Enter the password for the user name.

IBM SAN Volume Controller / IBM Storwize V7000

Enter or update the following information to have Tivoli Storage Productivity
Center connect to a SAN Volume Controller or Storwize V7000 storage system.

Software Version
Enter the version of the SAN Volume Controller or Storwize V7000
software that you want to configure.

IP Address
Enter the IP address or host name of the SAN Volume Controller or
Storwize V7000. You can enter an IPv4 or IPv6 address, for example:
v 127.0.0.1
v [2001:DB8:0:0:0:0:0:0/32]

Select Key
A Secure Shell (SSH) key is required to access the storage system. Select
one of the following actions for the SSH key:
v Upload new key: Select this option to upload a new key. Public key

content is extracted from the private key that is provided in the Private
SSH Key field and is uploaded to the SAN Volume Controller or
Storwize V7000 cluster. If you select this option, the Admin Username
and Admin Password fields are required.

v Use existing uploaded key: Select this option if you want to use a
public key that was already uploaded by using a method other than
through Tivoli Storage Productivity Center, such as the SAN Volume
Controller or Storwize V7000 web interface. Enter the location of the
private key file that corresponds to the public key in the Private SSH
Key field. The Admin Username and Admin Password fields are not
required if you select this option.

Administrator User Name
If you selected Upload new key in the Select Key list, enter the name of a
user that has the Security Administrator role for the SAN Volume
Controller or Storwize V7000 cluster that contains the storage system.
Tivoli Storage Productivity Center uses this value during the setup process
to contact the cluster and configure the SSH keys for the user. This user
name must have privileges to modify other user accounts (Security
Administrator role); otherwise, Tivoli Storage Productivity Center cannot
configure the SSH keys.

If you selected the Use existing uploaded key option, this field is optional.

Note: The Administrator User Name applies to only SVC5.x+; it does not
apply to SVC 4.x.

Administrator Password
Enter the password for the user name that you entered in the
Administrator User Name field.

User Name
Enter an authorized user name for the storage system. Tivoli Storage
Productivity Center uses this value when monitoring and configuring the
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storage system. If the user name does not exist it is created. This user
name must be assigned the Administrator role.

This field is active if you selected Upload new key in the Select Key list
and entered a user name and password in the Administrator User Name
and Administrator Password fields.
Important: If you upload a new key for the existing SAN Volume
Controller or Storwize V7000 user by using Tivoli Storage Productivity
Center, that new key overrides the existing key for the user. If you have
another application that is using that user (for example Tivoli Storage
Productivity Center for Replication), the application cannot log on to SAN
Volume Controller or Storwize V7000 because the key associated with the
user is overwritten.
If you have this situation, create a user ID specifically for Tivoli Storage
Productivity Center or Tivoli Storage Productivity Center for Replication
on the SAN Volume Controller or Storwize V7000 cluster. Add the SAN
Volume Controller or Storwize V7000 to Tivoli Storage Productivity Center
for Replication using the new user ID and password (or change the user ID
and password while the storage system is in the disconnected state).

Select User
Click this button to select from a list of existing users that are
defined on the SAN Volume Controller or Storwize V7000.

Private SSH Key
By default, the private key entry includes ${device.conf}\tpc_svc.pem,
which represents the Tivoli Storage Productivity Center default key
tpc_svc.pem. The tpc_svc.pem key is in the conf directory where the
Device server is installed. If you want to use your own key, the key must
exist on the system where you are running the Tivoli Storage Productivity
Center user interface. The key is uploaded to the Tivoli Storage
Productivity Center server system. To identify a new key, click Browse.

The private SSH key must be in OpenSSH format or in PuTTY (.ppk)
format that is not password protected. If you have a password
protected PuTTY .ppk key, use the PuTTYgen utility on a Windows
operating system to convert that key to OpenSSH format by following
these steps:
1. Start the PuTTYgen utility.
2. Load the .ppk file by clicking File > Load private key.
3. From the menu bar, click Conversion > Export OpenSSH key

conversion.

This action saves the key in OpenSSH format.

Passphrase (Optional)
Enter the passphrase for the private SSH key. The passphrase protects your
private SSH key file. If you do not have a passphrase, leave this field
blank.

Storwize V7000 Unified

Enter or update the following information to have Tivoli Storage Productivity
Center connect to a Storwize V7000 Unified storage system.

Storwize V7000 Unified is composed of Storwize V7000 and Storwize V7000 File
Module. You can connect to only Storwize V7000 or to both Storwize V7000 and
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Storwize V7000 File Module. Storwize V7000 provides block-level data and
Storwize V7000 File Module provides file-level data.

Storwize V7000
Use the information in this section to connect Storwize V7000.

IP Address
Enter the IP address or host name of the Storwize V7000 storage
system. You can enter an IPv4 or IPv6 address, for example:
v 127.0.0.1
v [2001:DB8:0:0:0:0:0:0/32]

Select Key
An SSH key is required to access Storwize V7000. Select one of the
following actions for the SSH key:
v Upload new key: Select this option to upload a new key. Public

key content is extracted from the private key that is provided in
the Private SSH Key field and is uploaded to the Storwize
V7000 cluster. If you select this action, the Administrator User
Name and Administrator Password fields are required.

v Use existing uploaded key: Select this option if you want to use
a public key that was already uploaded by using a method other
than through Tivoli Storage Productivity Center, such as the
Storwize V7000 web interface. Enter the location of the private
key file that corresponds to the public key in the Private SSH
Key field. The Administrator User Name and Administrator
Password fields are not required if you select this option.

Administrator User Name
If you selected Upload new key in the Select Key list, enter the
name of a user that has the Security Administrator role for the
Storwize V7000 cluster that contains the storage system. Tivoli
Storage Productivity Center uses this value during the setup
process to contact the cluster and configure the SSH keys for the
user. This user must belong to the Security Administrator role,
which has privileges to modify other user accounts. Otherwise,
Tivoli Storage Productivity Center cannot configure the SSH keys.

If you selected Use existing uploaded key, this field is optional.

Administrator Password
Enter the password for the user name that you entered in the
Administrator User Name field.

If you selected Use existing uploaded key, this field is optional.

User Name
Enter an authorized user name for the storage system. Tivoli
Storage Productivity Center uses this value to monitor and
configure the storage system. If the user name does not exist, it is
created. This user name must belong to the Administrator role.

This field is active if you selected Upload new key in the Select
Key list and entered a user name and password in the
Administrator User Name and Administrator Password fields.
Important: If you upload a new key for the existing Storwize
V7000 user by using Tivoli Storage Productivity Center, that new
key overrides the existing key for the user name. If you have
another application that is using that user name (for example Tivoli
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Storage Productivity Center for Replication), the application cannot
log on to Storwize V7000 because the key associated with the user
is overwritten.
If this situation occurs, create a user ID specifically for Tivoli
Storage Productivity Center or Tivoli Storage Productivity Center
for Replication on the Storwize V7000 cluster. Add the Storwize
V7000 storage system to Tivoli Storage Productivity Center for
Replication using the new user ID and password (or change the
user ID and password while the storage system is in the
disconnected state).

Select User
Select a user name from the list. The names are defined on
Storwize V7000.

Private SSH Key
By default, the private key entry includes ${device.conf}\
tpc_svc.pem, which represents the Tivoli Storage Productivity
Center default key tpc_svc.pem. The tpc_svc.pem key is in the conf
directory where the Device server is installed. If you want to use
your own key, the key must exist on the system where you are
running the Tivoli Storage Productivity Center user interface. The
key is uploaded to the Tivoli Storage Productivity Center server
system. To identify a new key, click Browse.

The private SSH key must be in OpenSSH format or in PuTTY
(.ppk) format that is not password protected. If you have a
password protected PuTTY .ppk key, use the PuTTYgen utility on
a Windows operating system to convert that key to OpenSSH
format by following these steps:
1. Start the PuTTYgen utility.
2. Load the .ppk file by clicking File > Load private key.
3. From the menu bar, click Conversion > Export OpenSSH key

conversion.

This action saves the key in OpenSSH format.

Passphrase (Optional)
Enter the passphrase for the private SSH key. The passphrase
protects your private SSH key file. If you do not have a
passphrase, leave this field blank.

Storwize V7000 File Module (Optional)
To connect to the Storwize V7000 Unified system, select the check box.

Depending on the configuration of Storwize V7000 Unified, the
information that is required to connect to this system can be the same as or
different from the information for Storwize V7000. The fields and field
descriptions are the same as the fields in the Storwize V7000 pane with the
following exceptions:
v The IP Address field is not displayed because the IP address is retrieved

automatically.
v The User Name field is always required.
v The private SSH key must be in OpenSSH format. The PuTTY format is

not supported. You can use the PuTTYgen utility to convert the key to
the OpenSSH format.

v The Select Key list contains the option Use user password in addition to
the Upload new key and Use existing uploaded key options. If you
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select Use user password, the User Password field is enabled and you
can use a user name and password to connect to the file module.
If you select Use user password, the Administrator User Name and
Administrator Password fields are optional.

IBM SONAS

Enter or update the following information so that Tivoli Storage Productivity
Center can connect to an IBM SONAS system.

IP Address
Enter the IP address or host name of the IBM SONAS system. You can
enter an IPv4 or IPv6 address, for example:
v 127.0.0.1
v 2001:DB8:0:0:0:0:0:0/32

Select Key
You must use a Secure Shell (SSH) key to access the storage system. Select
one of the following actions for the SSH key:
v Upload new key: Select this option to upload a new key. Public key

content is extracted from the private key that is provided in the Private
SSH Key field and is uploaded to the IBM SONAS system. If you select
this action, you must specify a value for the Administrator User Name
and Administrator Password fields.

v Use existing uploaded key: Select this option if you want to use a
public key that was already uploaded by using a method outside of
Tivoli Storage Productivity Center, such as the IBM SONAS system web
interface. Enter the location of the private key file that corresponds to
the public key in the Private SSH Key field. You do not have to specify
a value in the Administrator User Name and Administrator Password
fields.

v Use user password: Select this option if you want to use a user name
and password to connect to the file module. If you select this option, the
User Password field is enabled and you can use a user name and
password to connect to the file module.
If you select Use user password, the User Password field is enabled and
the Administrator User Name and Administrator Password fields are
optional.

Administrator User Name
If you selected Upload new key in the Select Key list, enter the name of a
user that has the Security Administrator role for the IBM SONAS system.
Tivoli Storage Productivity Center uses this value during the setup process
to contact the system and configure the SSH keys for the user. This user
name must have privileges to modify other user accounts (Security
Administrator role); otherwise, Tivoli Storage Productivity Center cannot
configure the SSH keys.

If you selected Use existing uploaded key, this field is optional.

Administrator Password
Enter the password for the user name that you entered in the
Administrator User Name field.

User Name
Enter an authorized user name for the storage system. Tivoli Storage
Productivity Center uses this value when it configures and monitors the
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storage system. If the user name does not exist it is created. This user
name must have the Administrator role.

This field is active if you selected Upload new key in the Select Key list
and entered a user name and password in the Administrator User Name
and Administrator Password fields.

Select User
Select from a list of existing user names that are defined on the
IBM SONAS system.

Private SSH Key
By default, the private key entry includes ${device.conf}\tpc_svc.pem,
which represents the Tivoli Storage Productivity Center default key
tpc_svc.pem. The tpc_svc.pem key is in the conf directory where the
Device server is installed. If you want to use your own key, the key must
exist on the system where you are running the Tivoli Storage Productivity
Center user interface. The key is uploaded to the Tivoli Storage
Productivity Center server system. To identify a new key, click Browse.

The private SSH key must be in OpenSSH format or in PuTTY (.ppk)
format that is not password protected. If you have a password
protected PuTTY .ppk key, use the PuTTYgen utility on a Windows
operating system to convert that key to OpenSSH format by following
these steps:
1. Start the PuTTYgen utility.
2. Load the .ppk file by clicking File > Load private key.
3. From the menu bar, click Conversion > Export OpenSSH key

conversion.

This action saves the key in OpenSSH format.

Passphrase (Optional)
Enter the passphrase for the private SSH key. The passphrase protects the
private SSH key file. If you do not have a passphrase, leave this field
blank.

User Password
Enter the password for the user name that you entered in the User Name
field.

Other (CIMOM)

Enter or update connection properties for a CIMOM. Tivoli Storage Productivity
Center uses this information to discover the storage systems that are managed by a
CIMOM. You can then configure those storage systems as part of the wizard
session.

The connection information that you enter for a CIMOM is similar to the
information that you enter when adding a CIMOM on the Add CIMOM page. See
“Adding a CIM agent connection” on page 250 for descriptions of the fields on this
page.

Discovered Storage Systems

After you run a discovery job, a table is displayed on the "Configure storage
subsystem connections" page. This table provides information about the storage
systems that were discovered for the selected storage system type.
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You can remove the connection to a storage system by clicking the row for the
system in the table, and then clicking Remove.

Configure fabrics and switches
Use the Configure Devices wizard to set up fabrics and switches for monitoring by
Tivoli Storage Productivity Center. Fabrics and switches that you configure in the
wizard are automatically included in probe schedules and associated with alert
conditions.

You can use the wizard to configure the following fabric and switch types for
monitoring:
v Brocade
v Cisco
v QLogic

You can configure one or more fabrics using a single session of the Configure
Devices wizard. All the fabrics and switches that you configure in a single pass
through the wizard share the same probe schedule and alert conditions.

To configure fabrics and switches using the wizard, complete the following steps:
1. Access the wizard based on the task you want to perform:

v If you want to add new or configure existing fabrics and switches, click the
configure devices icon in the toolbar or select the Configure Devices node in
the navigation tree. If you use this method, you must also complete the
following steps:
a. Select Fabrics/Switches on the Select Device Type page.
b. Determine whether to add new fabrics or configure existing fabrics that

are known to Tivoli Storage Productivity Center.
– To add fabrics and switches, select Add and configure new fabrics

and go to step 3.
– To configure existing fabrics and switches, select Configure existing

fabrics. The page displays the fabrics that are known to Tivoli Storage
Productivity Center. Go to step 2.

v If you only want to add new fabrics and switches, go to Fabric Manager >
Fabrics and click the Add Fabric button. Go to step 3.

2. Select the existing fabrics that you want to configure. Fabrics that are already
included in probe schedules are not displayed. Go to step 6 after selecting the
fabrics that you want to configure.

3. Configure CIMOM or agent connections. The fields for entering connection
information for a fabric changes based on the type of fabric you are adding.
Tivoli Storage Productivity Center uses the information you enter in this step to
connect to a fabric or CIMOM. Click Add to configure multiple fabrics in a
session of the wizard.

Note: Depending on the type of fabric you are adding, the wizard recommends
whether to enter CIMOM or agent information. For example, if you are
configuring a Brocade fabric, the recommended way to administer it is with a
CIMOM. If a CIMOM is not available, enter connection information for an out
of band fabric agent.

4. Discover the fabrics and fabrics managed by the CIMOMs that you entered in
the previous step. Tivoli Storage Productivity Center collects initial
configuration information for these entities.
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5. Select the fabrics that you want to configure for monitoring. Any fabrics that
were added in previous steps are automatically selected. Clear the checkboxes
for the fabrics that you do not want to configure.

6. Specify how data is collected for fabrics by including them in a monitoring
group or template. Use monitoring groups and templates to determine when
data is collected and what alert conditions are checked for the fabrics that you
are configuring.
v Select a monitoring group if you want to manage a collection of fabrics in

the same manner. Each monitoring group that you can select is associated
with an existing probe schedule and set of alerts. When you select a group,
its data collection schedule and alerts are automatically applied to all the
fabrics that you are configuring. After completing the wizard, the fabrics
remain in the group and you can use that group when working in other
parts of the user interface, such as in reports.

Tip: Tivoli Storage Productivity Center provides a number of default
monitoring groups for fabrics. If you want to include a fabric in a
user-defined group rather than in a default group, that group must be
associated with a data collection schedule. If the user-defined group is not
associated with a data collection schedule, it is not displayed in the list of
monitoring groups from which you can select.

v Select a template if you want to create a unique probe schedule and set of
alerts for a fabric rather than using the settings of an existing group.

The option that you select in this step determines the field and pages that
appear next in the wizard.
v If you select a monitoring group, the following actions occur:

– The fabrics are automatically included in a probe schedule to which the
group is associated. For example, if you select Fabric Basic Group, the
fabrics are included in the Fabric Basic Probe schedule. The Fabric Basic
Probe schedule runs two times per week on Monday and Wednesday at
3:00 am.

– A set of alert conditions it applied to the fabrics in a group. When any of
these conditions are detected during data collection, an alert is triggered.
The group that you select determines the alerts that are associated with
the fabrics. For example, if you select Fabric Basic Group, nine alert
conditions are automatically checked for the fabrics.

– The fabrics are included in the group. You can use that group in other
parts of the user interface, such as in reports.

v If you select a monitoring template, the following actions occur:
– The fabrics are automatically included in a probe schedule that is created

for a template. For example, if you select the Basic Fabric Monitoring
template, the fabrics are automatically included in a new probe that runs
two times per week on Monday and Wednesday. The probe is created
after the wizard is completed.Tivoli Storage Productivity Center
determines the time when the probe is run based on server load to ensure
optimal performance.

– A set of alert conditions it applied to the fabrics in a template. When any
of these conditions are detected during data collection, an alert is
triggered. The template you select determines the alerts that are associated
with the fabrics. For example, if you select to the Basic Fabric Monitoring
template, nine alert conditions are automatically checked for the fabrics.

– You must enter a prefix for the probe schedule and alerts that are based
on a template. This prefix is used to identify the probe and alerts in the
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user interface. For example, if you select the Basic Fabric Monitoring
template and enter the prefix "ABC", a probe schedule named
"userID.ABCfabBasicProbe" and alerts such as "userID.ABCFabric State
Change (Basic)" are created, where userID represents the ID of the user
that is logged on toTivoli Storage Productivity Center.
The new probe and alerts are displayed under the corresponding node in
the navigation tree for you to view and edit. For example, a probe
schedule created from a template in the wizard appears under the Tivoli
Storage Productivity Center >Monitoring > Probes node; new storage
system alerts appear under the Fabric Manager > Alerting node.

See Alerts and schedules associated with monitoring groups and templates for
a list of groups and templates with their associated schedules and alerts.

7. On the summary page of the wizard, review the selections that you made.

View the results of the device configuration and close the wizard. The devices that
you configured are probed.

Configure computers
Use the Configure Devices wizard to set up computers for monitoring by Tivoli
Storage Productivity Center. Computers that you configure in the wizard are
automatically included in probe and ping schedules and associated with alert
conditions.

Use the Configure Devices wizard to configure computers that meet the following
conditions:
v A Storage Resource agent was deployed on the computer.
v The computer is not included in an existing probe schedule. Devices that are

included in existing probe schedules are not displayed in the Configure Devices
wizard because they are considered to be already configured for monitoring.

Important: When computers are added to Tivoli Storage Productivity Center,
they are automatically included in the default computer group, and that group is
included in the default probe schedule (TPCUser.Default Probe). Because the
computers are included in TPCUser.Default Probe, they are considered to be
configured for monitoring and are not displayed in the wizard.

To use the Configure Devices wizard to configure computers that were included
in TPCUser.Default Probe, move them into a group that is not associated with
an existing probe schedule. To move them into a new group, complete the
following steps:
1. In the navigation tree, go to Data Manager > Monitoring > Groups >

Computer.
2. Right click Computer and select Create Computer Group.
3. Select the computers that you want to configure in the Configure Devices

wizard and click the right arrow icon to move them into the new group.
4. Click the save icon in the toolbar to save the group. Do not associate this

group with a probe schedule.
5. Start the Configure Devices wizard to the configure computers. The

computers in the new group are displayed in the wizard.

You can configure one or more computers using a single session of the Configure
Devices wizard. All the computers that you configure in a single pass through the
wizard share the same probe schedule, ping schedule, and alert conditions.
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To configure computers using the wizard, complete the following steps:
1. Click the configure devices icon in the toolbar or select the Configure Devices

node in the navigation tree.
2. Select Computers on the Select Device Type page.
3. Select the computers that you want to configure. Computers that are already

included in an existing probe schedule are not displayed.
4. Specify how data is collected for computers by including them in a monitoring

group or template. Use monitoring groups and templates to determine when
data is collected and what alert conditions are checked for the computers that
you are configuring.
v Select a monitoring group if you want to manage a collection of computers

in the same manner. Each monitoring group that you can select is associated
with existing probe and ping schedules and a set of alerts. When you select a
group, its data collection schedules and alerts are automatically applied to all
the computers that you are configuring. After completing the wizard, the
computers remain in the group and you can use that group when working in
other parts of the user interface, such as in reports.

Tip: Tivoli Storage Productivity Center provides a number of default
monitoring groups for computers. If you want to include a computer in a
user-defined group rather than in a default group, that group must be
associated with a data collection schedule. If the user-defined group is not
associated with a data collection schedule, it is not displayed in the list of
monitoring groups from which you can select.

v Select a template if you want to create a unique probe schedule, ping
schedule, and set of alerts for a computer rather than using the settings of an
existing group.

The option that you select in this step determines the field and pages that
appear next in the wizard.
v If you select a monitoring group, the following actions occur:

– The computers are automatically included in probe and ping schedules to
which the group is associated. For example, if you select Computer Basic
Group, the computers are included in the Computer Basic Probe and
Computer Basic Ping schedules. The Computer Basic Probe schedule runs
two times per week on Monday and Wednesday at 3:00 am. The
Computer Basic Ping schedule runs every 3 hours.

– A set of alert conditions is applied to the computers in a group. When any
of these conditions are detected during data collection, an alert is
triggered. The group that you select determines the alerts that are
associated with the computers. For example, if you select Computer Basic
Group, seven alert conditions are automatically checked for the
computers.

– The computers are included in the group. You can use that group in other
parts of the user interface, such as in reports.

v If you select a monitoring template, the following actions occur:
– The computers are automatically included in a probe and ping schedule

that are created for the template. For example, if you select the Basic
Computer Monitoring template, the computers are automatically included
in a new probe that runs two times per week on Monday and Wednesday
and a ping that runs every three hours. The probe and ping are created
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after the wizard is completed. Tivoli Storage Productivity Center
determines the time when the probe is run based on server load to ensure
optimal performance.

– A set of alert conditions is applied to the computers in a template. When
any of these conditions are detected during data collection, an alert is
triggered. The template you select determines the alerts that are associated
with the computers. For example, if you select to the Basic Computer
Monitoring template, seven alert conditions are automatically checked for
the computers.

– You must enter a prefix for the probe schedules, ping schedules, and alerts
that are based on a template. This prefix is used to identify these
definitions in the user interface. For example, if you select the Standard
Computer Monitoring template and enter the prefix "ABC", the following
definitions are created in the user interface after the wizard is completed:
- A probe schedule named "userID.ABCcompStandardProbe"
- A ping schedule named "userID.ABCcompStandardPing"
- Seven alerts that follow this naming convention: userID.ABCStatus

Change Online (Standard)

Where userID represents the ID of the user that is logged in toTivoli
Storage Productivity Center.
The new schedule definitions and alerts are displayed under the
corresponding node in the navigation tree for you to view and edit. For
example, a probe schedule created from a template in the wizard is
displayed under the Tivoli Storage Productivity Center >Monitoring >
Probes node; a ping schedule is displayed under the Data Manager >
Monitoring > Pings node; new storage system alerts appear under the
Data Manager > Alerting node.

See Alerts and schedules associated with monitoring groups and templates for
a list of groups and templates with their associated schedules and alerts.

5. Review the selections that you made in the wizard. The Review user selections
page includes the following information:
v A list of devices that you are configuring.
v The name of the monitoring group that you selected. This value is not

displayed if you selected a template.
v The name of the probe and ping schedules that are created based on the

template you selected. This value is not displayed if you selected a
monitoring group.

v Information about the schedules created for a template.
v The names of the alerts that are created based on the template you selected.

This value is not displayed if you selected a monitoring group.

View the results of the device configuration and close the wizard. The devices that
you configured are probed.

Configure tape libraries
Use the Configure Devices wizard to set up tape libraries for monitoring by IBM
Tivoli Storage Productivity Center. Tape libraries that you configure in the wizard
are automatically included in probe schedules.
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You can configure one or more tape libraries using a single session of the
Configure Devices wizard. All the tape libraries that you configure in a single pass
through the wizard share the same probe schedule.

To configure tape libraries using the wizard, complete the following steps:
1. Access the wizard based on the task you want to perform:

v If you want to add new or configure existing tape libraries, click the
configure devices icon in the toolbar or select the Configure Devices node in
the navigation tree. If you use this method, you must also complete the
following steps:
a. Select Tape Libraries on the Select Device Type page.
b. Determine whether to add new tape libraries or configure existing tape

libraries that are known to Tivoli Storage Productivity Center.
– To add tape libraries, select Add and configure new tape libraries and

go to step 3.
– To configure existing tape libraries, select Configure existing tape

libraries. The page displays the tape libraries that are known to Tivoli
Storage Productivity Center. Go to step 2.

v If you only want to add new tape libraries, go to Tape Manager > Tape
Libraries and click the Add Tape Library button. Go to step 3.

2. Select the existing tape libraries that you want to configure. Tape libraries that
are already included in probe schedules are not displayed. Go to step 6 after
selecting the tape libraries that you want to configure.

3. Configure CIMOM connections for tape libraries. Tivoli Storage Productivity
Center uses the information you enter in this step to connect to a CIMOM.
Click Add to configure multiple CIMOMs in a session of the wizard.
The connection information that you enter for a CIMOM is like the information
that you enter on the Add CIMOM panel.

4. Discover the tape libraries that are managed by the CIMOMs you entered in
the previous step. Tivoli Storage Productivity Center uses the information you
enter in this step to connect to a CIMOM. Click Add to configure multiple
CIMOMs in a session of the wizard.

5. Select the tape libraries that you want to configure for monitoring. Any tape
libraries that were added in previous steps are automatically selected. Deselect
tape libraries that you do not want to configure.

6. Specify how data is collected for tape libraries by including them in a
monitoring group or template. Use monitoring groups and templates to
determine when data is collected for the tape libraries that you are configuring.
v Select a monitoring group if you want to manage a collection of tape libraries

in the same manner. Each monitoring group that you can select is associated
with an existing probe schedule. When you select a group, its data collection
schedule is automatically applied to all the tape libraries that you are
configuring. After completing the wizard, the tape libraries remain in the
group and you can use that group when working in other parts of the user
interface, such as in reports.

Tip: Tivoli Storage Productivity Center provides a number of default
monitoring groups for tape libraries. If you want to include a tape library in
a user-defined group rather than in a default group, that group must be
associated with a data collection schedule. If the user-defined group is not
associated with a data collection schedule, it is not displayed in the list of
monitoring groups from which you can select.
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v Select a template if you want to create a unique probe schedule for a tape
library rather than using the settings of an existing group.

The option that you select in this step determines the field and pages that
appear next in the wizard.
v If you select a monitoring group, the following actions occur:

– The tape libraries are automatically included in a probe schedule to which
the group is associated. For example, if you select Tape Basic Group, the
tape libraries are included in the Tape Basic Probe schedule. The Tape
Basic Probe schedule runs one time per week on Sunday at 4:00 am.

– The tape libraries are included in the group. You can use that group in
other parts of the user interface, such as in reports.

v If you select a monitoring template, the following actions occur:
– The tape libraries are automatically included in a probe schedule that is

created for a template. For example, if you select the Basic Tape
Monitoring template, the tape libraries are automatically included in a
new probe that runs one time per week on Sunday. The probe is created
after the wizard is completed.Tivoli Storage Productivity Center
determines the time when the probe is run based on server load to ensure
optimal performance.

– You must enter a prefix for the probe schedule and alerts that are based
on a template. This prefix is used to identify the probe and alerts in the
user interface. For example, if you select the Basic Tape Monitoring
template and enter the prefix "ABC", a probe schedule named
"userID.ABCtapeBasicProbe" is created, where userID represents the ID of
the user that is logged in toTivoli Storage Productivity Center.
The new probe is displayed under the corresponding node in the
navigation tree for you to view and edit. For example, a probe schedule
created from a template in the wizard appears under the Tivoli Storage
Productivity Center >Monitoring > Probes node.

See Alerts and schedules associated with monitoring groups and templates for
a list of groups and templates with their associated schedules and alerts.

7. On the summary page of the wizard, review the selections that you made.

View the results of the device configuration and close the wizard. The devices that
you configured are probed.

Discovering storage resources
Run discovery schedules to collect information about the storage resources in your
environment.

The process of finding storage resources within an enterprise, including detection
of network topology, is called discovery. Use discovery schedules in Tivoli Storage
Productivity Center to collect basic information about the storage resources in your
environment, including computers, CIMOMs, storage systems, fabrics and
switches, filers, clusters, and tape libraries. You must run discovery schedules
before you can collect more detailed information about storage resources using
other data collection schedules, such as probes, scans, and pings.

You are not required to run discovery schedules for storage resources that meet
either of the following conditions:
v Storage resources that use native interfaces to connect to the Tivoli Storage

Productivity Center.
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v Storage resources that are configured using the Configure Devices wizard.

Discovery overview
IBM Tivoli Storage Productivity Center supports various discovery types. Use
discovery schedules to find new CIMOMs, Out of Band Fabrics, Windows
Domains, NAS filers, and SAN File System that have been introduced into your
environment.

The discovery types in Tivoli Storage Productivity Center are summarized in the
following table. Additionally the table summarizes the types of information that
each discovery provides.

Table 34. Discovery types, their data sources, and top-level entities that are discovered

Type of discovery Data source Top-level entities

CIMOM CIM Agent v Fabric (switches)
v Storage subsystems
v Tape subsystems

Out-of-band SNMP agents on the switches Fabric (switches). A fabric
discovery gets all the fabric
information switches that
have been added as
out-of-band agents. All
information is collected by
using the SNMP protocol to
send queries across the IP
network to the management
information bases (MIBs)
supported on the switch.

Storage Resource agents or
In-band Fabric agents

Storage Resource agent or
In-band Fabric agents

Fabric (switches). If you have
deployed Storage Resource
agents or have In-band Fabric
agents on the computers
attached to the fabric, you do
not need to perform a
specific discovery step for
these Storage Resource agent.
The fabric is automatically
discovered.
Note: In Tivoli Storage
Productivity Center v4.2 and
later, you can deploy Storage
Resource agents only. If you
want to install an Inband
fabric agent (Fabric agent),
you must own a previous
version of the product. See
the documentation for the
previous version of the
product for information
about how to install a Fabric
agent.

Windows domain, NAS, and
SAN File System

Data agent or Storage
Resource agent

v Computers
v Filers
v Clusters
v Names or agents
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Table 34. Discovery types, their data sources, and top-level entities that are
discovered (continued)

Type of discovery Data source Top-level entities

VMWare VI VMWare VI data source The data source can be a
hypervisor (ESX Server or
VirtualCenter).

Generally, discovery only provides information about the existence of a resource.
Use probes and scans to obtain detailed information about a specific resource after
it has been discovered.

For a Windows domain, Tivoli Storage Productivity Center only performs a
discovery on the first Windows system on the domain; not all the systems on the
domain.

CIMOM discovery
This topic describes how the IBM Tivoli Storage Productivity Center manages and
monitors disk, switch, and tape devices through Common Information Model
Object Managers (CIMOMs).

Note: CIMOM can be referred to by a variety of names, such as CIM agents or
SMIS agents. A CIM agent consists of a CIMOM and an SMIS provider for the
managed device.

CIM agents on the same subnet as the Tivoli Storage Productivity Center Device
server are automatically discovered with CIMOM discovery. If CIM agents are not
in the same subnet, they can be discovered using a Service Location Protocol (SLP)
Directory Agent (DA) or they can be added manually. If you do not want Tivoli
Storage Productivity Center to discover CIM agents in the local subnet, clear the
Scan local subnet box in the CIMOM discovery Options panel. To include SLP
Directory Agents in the discovery, add the IP address of the DA in the CIMOM
discovery Options panel and click Add. CIMOM discovery has several purposes. It
can scan the local subnet to find CIM agents and contact CIM agents that have
been added through the dialog. After it has found a CIM agent, it attempts to log
in and discover the storage entities being managed by the CIM agent. If a CIM
agent is discovered but requires login information, you need to enter it in the View
and Edit CIMOM panel and then rerun the discovery to collect the information for
the storage entities. The amount of time CIMOM discovery takes depends on the
number of CIM agents, the number of storage entities, and whether you are
scanning the local subnet.

CIMOM discovery can be run on a schedule. How often you run it depends on
how dynamic your environment is. It must be run to detect a new subsystem.
CIMOM discovery also performs basic health checks of the CIM agent and
subsystem.

For Tivoli Storage Productivity Center to successfully communicate with the CIM
agents, the CIMOM service must be accessible through the IP network. The
TCP/IP network configuration on the host where Tivoli Storage Productivity
Center is installed must include in its list of domain names, all the domains that
contain storage devices that are discoverable by Tivoli Storage Productivity Center.

The CIM agents are installed outside of Tivoli Storage Productivity Center. Contact
your device vendor for information about installing the CIM agent.
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SLP registration with slptool
This topic describes how IBM Tivoli Storage Productivity Center uses Service
Location Protocol (SLP) discovery.

SLP discovery requires that all of the CIMOMs that Disk Manager discovers are
registered using the SLP. However, for CIMOMs outside of the IP subnet, you need
to use an SLP DA and register the CIMOM using slptool. In a non-multicast
network environment, you must use the slptool as SLP can only discover CIMOMs
that are registered in its IP subnet. When you use slptool, ensure that the
CIM_InteropSchemaNamespace and Namespace attributes are specified.

For example, enter the following command:
slptool register service:wbem:https://<myhost.com>:<port>

Where myhost.com is the name of the machine hosting the CIMOM, and port is the
port number of the service, for example 5989.

Note: slptool is installed with a CIMOM. Run the command from the machine
hosting the CIMOM.

SMI-S discovery
This topic describes how the IBM Tivoli Storage Productivity Center can discover
storage devices that comply with the Storage Management Initiative Specification
(SMI-S).

SMI-S-compliant CIM Agents are discovered using the Service Location Protocol
(SLP). The Tivoli Storage Productivity Center server software performs SLP
discovery on the network. The SLP User Agent (UA) looks for all registered
services with a service type of service:wbem.

The Tivoli Storage Productivity Center performs the following discovery tasks:
v Locates individual storage devices
v Retrieves vital characteristics for those storage devices
v Populates the internal Tivoli Storage Productivity Center databases with the

discovered information

Device server and discovery on a SAN
Storage Management Initiative (SMI) agents, out-of-band Simple Network
Management Protocol (SNMP) agents, and Storage Resource agents can be used to
discover and probe switches and fabrics. When multiple agents are available, Tivoli
Storage Productivity Center creates a list of the agents. The first agent on the list is
started first. If an agent fails, the next agent on the list is started.

Host and device information is gathered by Storage Resource agents. Topology
information is gathered using SMI (Brocade switches only), out-of-band, or Storage
Resource agents. The topology discovery operations of all agent types provide a
similar level of information. However, zone information is available only through
certain agent types for certain vendors. See Table 35 on page 328 for details.

For Brocade fabrics, the preferred type of agent is the SMI agent. The SMI agent
provides most fabric functions and the other agent types can be added for
redundancy. However, Storage Resource agents are required to gather host bus
adapter (HBA) information.
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For QLogic and Cisco fabrics, a combination of different agent types is required to
enable all functions. If Storage Resource agents are not used, the devices and hosts
are displayed as entities of unknown type. You can change the icon and labels of
the unknown entities to something more appropriate for your enterprise.

If you want to use out-of-band fabric agents, you must configure the switches to
send SNMP traps to the the Device server. A similar configuration is not required
for CIM indications for SMI agents because they are automatically subscribed to
after a CIMOM discovery. However, in some environments, manual configuration
of certain settings might be required. SNMP traps and CIM indications determine
when to start an automatic rediscovery operation

The following table shows the actions that trigger data collection and the data that
is collected depending on the type of agent that is used.

Table 35. Information collected by agent

Action that
triggers data
collection Storage Resource agent

Out-of-band fabric agent
(SNMP) SMI agent (Brocade)

SMI agent (Cisco
and QLogic)

Administrative
Services >
Discovery > Out
of Band Fabric

– v Discovers switches and
connections within an
IP range

v Retrieves switch and
topology information

v Retrieves Cisco VSAN
information

– –

Administrative
Services >
Discovery >
CIMOM

– – v Discovers SMI
agents through
Service Location
Protocol (SLP)

v Retrieves switch
information

v Retrieves fabric
information

v Discovers SMI
agents through
SLP

v Retrieves switch
information

v Retrieves fabric
information

IBM Tivoli
Storage
Productivity
Center > Probe
(including fabric)

v Retrieves zoning
information,
excluding zone alias
information, for
QLogic and Cisco

v Retrieves switch and
topology information

v Retrieves attribute
information for hosts
and devices
connected to the
fabric

v Retrieves switch and
topology information

v Retrieves Cisco VSAN
information

v Retrieves detailed
fabric, switch,
switch port, and
blade information

v Retrieves zoning
information,
including zone
aliases for Brocade
devices

v Retrieves fabric
topology
connectivity
information

v Subscribes to CIM
indications

v Retrieves
detailed fabric,
switch, switch
port, and blade
information
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Table 35. Information collected by agent (continued)

Action that
triggers data
collection Storage Resource agent

Out-of-band fabric agent
(SNMP) SMI agent (Brocade)

SMI agent (Cisco
and QLogic)

Action of Storage
Resource agent1:

v Turns on

v Connectivity
changes

v Change event
detected

v Retrieves zoning
information,
excluding zone alias
information

v Retrieves switch and
topology information

v Retrieves attribute
information for hosts
and devices
connected to the
fabric

v Retrieves switch and
topology information

v Retrieves Cisco VSAN
information

SNMP trap
received from
switch

v Retrieves zoning
information,
excluding zone alias
information

v Retrieves switch and
topology information

v Retrieves attribute
information for hosts
and devices
connected to the
fabric

v Retrieves switch and
topology information

v Retrieves Cisco VSAN
information

CIM indication
received from
fabric SMI agent

Performs a
mini-probe to collect
information that is
relevant to the
indication received,
or sets entities as
missing. Might do
one of the following
actions:

v Retrieves switches
and fabrics, or

v Retrieves zoning
data, or

v Retrieves switch
port status and
connection to
node, or

v Retrieves switch
blade status and
all port
connections for the
blade, or

v Sets fabric, switch,
blades,
connections, or
nodes as missing
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Table 35. Information collected by agent (continued)

Action that
triggers data
collection Storage Resource agent

Out-of-band fabric agent
(SNMP) SMI agent (Brocade)

SMI agent (Cisco
and QLogic)

1. The Storage Resource agent has two distinct functions:

v Discovery

When a discovery job is run, Tivoli Storage Productivity Center gathers information about the fabrics, fabric to
switch relationships, and other key attributes about the switches in the fabrics.

v Probe

When a probe job is run, Tivoli Storage Productivity Center gathers additional details for topology and zoning
information.

If you deploy a Storage Resource agent and a fabric probe job is not run, the connections from the Storage
Resource agents to the switches are not displayed, and all the Fibre Channel (FC) ports are reported as unused

SMI agents

In general, it is most beneficial to use SMI agents as the primary agent type for
Brocade fabrics. See Table 35 on page 328 for the fabric information that is gathered
by SMI agents. The use of SMI agents enables support for fabrics composed of
switches from Brocade.

The following SMI agent profiles and their respective subprofiles are supported:

Table 36. Supported SMI agent profiles and subprofiles

Profile Subprofile

Fabric v Zone Control

v Enhanced Zoning and Enhanced Zoning
Control

Switch v Blades

v Access Points

v Multiple Computer System

v Physical Package

v Software

The level of support depends on the subprofiles registered with the SMI agent. For
example, zone control support requires that the SMI agent has the Zone Control
subprofile registered with it.

SMI agents also notify the Device server of changes on the fabric, such as changes
to the topology or to the zoning. This notification is done through CIM indications.
The CIM indications are subscribed to for a SMI agent through the CIMOM
discovery job. Some extra configuration might be required set up CIM indications
for environments with systems that have multiple IP addresses.

The CIM indications send specific details of a change on the fabric to the Device
server. Rather than recollect the complete topology and zoning information for
every CIM indication received, the Device server analyzes the CIM indication. In
most cases, the Device server either sends a small set of post-indication discovery
requests to the SMI agent to collect information pertinent to that event, or sets
certain devices as missing without any post-indication requests made to the SMI
agent. For CIM Indications that represent a zoning change, the complete zoning
information is recollected from the SMI agent.
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Other agents

Although the SMI agents provide the most benefits, the use of multiple agent types
also has advantages, such as redundant collection of information if one type of
agent fails. Also, some types of agents provide certain features the other agents do
not. However, the use of multiple agent types can increase network traffic and
management load on the switches.

See Table 35 on page 328 for a list of the different types of jobs that collect data for
the fabrics. You can use this table to determine which agent types to use for your
fabric.

Out-of-band agents and Storage Resource agents provide the same information,
such as a change that occurred in the SAN, by indicating that a discovery
operation should be performed. The agents notify the Device server when
something happened in the SAN and then a discovery is done to identify the
changes.

The fabric agents that are running on the managed hosts detect Storage Resource
agent events.

The the Device server out-of-band change agent detects the SNMP traps. For the
Device server to receive the SNMP traps, configure the device, such as a switch, to
send traps to the Device server.

The SNMP traps that are sent by the devices and by the Device server can be sent
to the IBM Tivoli Storage Productivity Center graphical user interface (GUI). The
events can be displayed in the event browser, or they can be sent to another trap
console for monitoring. You then can provide error recovery or other advanced
processing, such as paging.

Fabric discovery
This topic describes how the Fabric Manager uses SNMP queries to discover
information about selected fabric switches.

Management Information Base (MIB) information is collected from those switches.
Out-of-band agents are configured for the Device server and contacted from the
server through SNMP.

Discovering computers in the Windows domain, NAS, and
SAN File System

This topic describes how a NAS discovery finds SAN File System clusters.

When you run a discovery to find Windows computers on a domain, it discovers
only new Windows computers. For IBM Tivoli Storage Productivity Center to
recognize a non-Windows computer, you must install an agent on that computer.

For a Windows domain, Tivoli Storage Productivity Center only performs a
discovery on the first Windows system on the domain; not all the systems on the
domain.

A NAS discovery finds NAS Filers, and a SAN File System discovery finds the
SAN File System clusters.
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For information about configuring your system for NAS and SAN File System
discovery, see the section about the Manual NAS/NetWare Server Entry node in
the IBM Tivoli Storage Productivity Center and IBM Tivoli Storage Productivity Center
for Replication Installation and Configuration Guide.

Discovering NetWare Filer systems that do not have agents
This topic describes how you can discover NetWare Filer systems that do not have
installed Storage Resource agents or Data agents.

To discover NetWare Filer systems, complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Discovery.
2. Right-click NetWare Filers and click Run Now.

Discovering Windows computers that do not have agents
Use discovery schedules to detect Windows computers that do not have Data
agents or Storage Resource agent deployed on them.

To discover Windows computers that do not have agents in your Windows
domain, perform the following steps:
1. In the navigation tree, expand Administrative Services > Discovery.
2. Right-click Windows Domain, NAS, and SAN FS and click Run Now.
3. After you have identified the computers, you can deploy Storage Resource

agent on the computers to get detailed information about the computers and
file systems. Computers that are discovered by Tivoli Storage Productivity
Center but do not have Data agents or Storage Resource agents deployed on
them are displayed on the Data Manager > Reporting > System-wide >
Unmanaged Computers report.

Discovering VMware VI data sources
This topic describes how you can discover VMware VI data sources.

To display information about VMware VI data sources, complete the following
steps:
1. In the Navigation Tree pane, expand Administrative Services > Discovery >

VMware VI Data Source.
2. Right-click VMware VI Data Source. Click Run Now.

Discovering computers
This topic describes how Tivoli Storage Productivity Center gathers information
from the computers that are discovered.

You must install Storage Resource agents directly on the computer it manages so
that you can gather information about that computer. To gather information from
the agents, you create ping, probe, and scan jobs. A scan job discovers the largest
amount of information but is the most time-consuming and intensive job.

When an agent shuts down and Tivoli Storage Productivity Center detects that the
agent is no longer responding, the agent is put into the missing state (represented

by a black circle ) to indicate that it is not detectable. Tivoli Storage
Productivity Center also does a heartbeat ping to the agents every 30 minutes. If
this ping detects the host while the agent is not running, the host is put into the

warning state (represented by a warning status icon ) to indicate that the host
is responding but the agent is not.

332 IBM Tivoli Storage Productivity Center: User's Guide



If Tivoli Storage Productivity Center can no longer communicate with an agent, the

agent is marked as missing (a black circle ) . Information about the host
continues to be displayed until the host is removed from the database. To remove
the host from the database, you must uninstall the Storage Resource agent.

Discover storage subsystem, tape library, and fabric
information with CIM agents

This topic describes how you can discover storage subsystems, tape libraries, and
fabrics in your environment using CIM agents.

CIM agents can be referred to by various names, such as CIMOM (CIM Object
Manager) or SMIS agent. A CIM agent consists of a CIMOM and an SMI-S
provider for the managed device. CIMOM discovery performs basic health checks
of the CIMOMs. Even if you do not expect the number of CIMOMs to vary, be
sure to schedule a CIMOM discovery often enough to be kept informed about your
environment.

To automatically discover CIMOMs that are visible to the Device server with SLP,
follow the instructions in “Discover CIM agents automatically” on page 252.

To add and discover CIMOMs manually, follow the instructions in “Adding a CIM
agent connection” on page 250.

When your CIMOMs are manually added you must perform a CIMOM discovery
to gather information about the CIMOMs so that IBM Tivoli Storage Productivity
Center can communicate with them.

You are not required to run discovery jobs for storage resources that connect to
Tivoli Storage Productivity Center using native interfaces:
v DS8000
v SAN Volume Controller
v Storwize V7000
v IBM Storwize V7000 Unified
v The XIV system
v IBM SONAS

To discover CIMOM information for any CIMOMs that you manually added,
complete the following steps:
1. Expand Administrative Services > Data Sources > CIMOM Agents. CIMOMs

are listed in the CIMOM Agents table along with their connection status. For
each automatically discovered CIMOM you want to use, click the magnifying
glass by the CIMOM name in the table. The View and Edit window for that
CIMOM opens. Enter missing information, such as user name and password,
for that CIMOM. Also make sure that you check the Test CIMOM connectivity
before updating box. Click File > Save on the menu bar. This action saves your
information and performs a connectivity check based on the information you
entered. You must repeat this process for each SLP-discovered CIMOM you
choose to use.

2. Expand Administrative Services > Discovery > CIMOM. The Edit CIMOM
page opens in the content pane.

3. Optional: Click the Options tab. Enter the IP addresses or host names for the
directory agents to be discovered.
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Note: If you do not want to discover every CIMOM in the local subnet of your
system, clear the Scan Local Subnet check box. If you clear this box the CIMOM
discovery runs only on those CIMOMs already listed under Administrative
Services > Data Sources > CIMOM Agents. If you chose not to clear this box
CIMOM discovery searches for and discover all the CIMOMs in your subnet
which might take a long time.

4. Click the When to Run tab and indicate how often and when to run this
discovery job.

5. Click File > Save to save the job.

6. After you set the parameters for a CIMOM discovery, perform the discovery to
gather information about all the CIMOMs you entered in the Options page.

Figure 24. Editing the CIMOM discovery job (Options tab)

Figure 25. Editing the CIMOM discovery job (When to Run tab)
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Expand Administrative Services > Discovery. Right-click on CIMOM and click
Run Now.

7. Click the Job Management icon ( ) in the toolbar to view the status of the
discovery.

8. When the discovery finishes, view the list of discovered storage subsystems or
tape libraries by expanding either Disk Manager and click Storage
Subsystems, or Tape Manager and click Tape Libraries.

Discovering fabrics with Storage Resource agents
When you deploy Storage Resource agents to computers, the agents automatically
run discovery and provide information about the fabrics or switches to which the
computers are attached. You do not need to run a specific discovery step for the
fabrics connected to computers on which Storage Resource agent are deployed.

For example, if you have QLogic switches and have Storage Resource agents
deployed on the computers that are attached to these switches, the switches are
automatically discovered when you deploy the Storage Resource agents.

Discovering fabrics with the Storage Resource agent provides the following
information:
v Fabric WWN, information about fabric-to-switch relationships, and key attributes
v Host and device information (collected from Storage Resource agents only),

including HBA information
v Basic information to identify the host and devices in the fabric

After a discovery is run, you can run probes to collect topology and zoning
information for the fabrics.

The vendors of fabric switches can help you determine whether to use CIM agents
or Storage Resource agents to discover and monitor fabrics. For example, for
Brocade switches, use CIM agents to collect all fabric data and enable performance
monitoring and zone control. Use Storage Resource agents to collect information
about HBAs. For Cisco and QLogic switches, you must have one or more Storage
Resource agents on the fabric to collect full topology and zoning information, and
to enable the zone control functions.

See the Planning for Fabric Manager section in the Tivoli Storage Productivity Center
Information Center or Installation and Configuration Guide for more information about
using CIM and Storage Resource agents to collect information about fabrics.

Figure 26. Checking storage subsystems
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Discovering storage subsystems and switches
Use the Switches and Subsystems (IP Scan) discovery schedule to find switches
and storage systems in your environment. This discovery schedule searches for
devices with a range of IP addresses that you specify.

Keep in mind the following considerations before running this discovery schedule:
v Switches and storage systems that require a CIM object manager (CIMOM) are

not discovered using an IP scan. Use CIMOM discovery to discover these
devices.

v Before a switch can be discovered, you must have an out-of-band fabric agent
installed on the computer where the switch is installed or have the agent
installed on a computer that has access to the switch.

v Before you can discover storage devices, ensure that port 7 (ECHO port) is open
on the devices, and Internet Control Message Protocol (ICMP) is available. If you
run Internet Protocol Version 6 (IPv6), it can take up to 30 seconds to discover
the storage devices.

v If no CIM Agents for your Brocade switches are configured, you must discover
out-of-band Fabric agents to get zone information for the Brocade switches.

To edit a discovery schedule for scanning a range of IP addresses, complete these
steps:
1. In the navigation tree, expand Administrative Services > Discovery.
2. Click Switches and Subsystems (IP Scan). The Edit Switches and Subsystems

(IP Scan) panel is displayed.
3. Click Options to display the Options page.
4. Specify the IP address ranges that you want to scan in the From and To fields.

You can enter an IPv4 or IPv6 address depending on what is supported within
your environment:
v Enter IPv4 addresses in the following format: ###.###.###.###. For example, if

you enter 192.168.1.68 in the From field and 192.168.1.254 in the To field,
Tivoli Storage Productivity Center scans IP addresses that fall in the range
between 192.168.x.68 and 192.168.x.254.

v Enter IPv6 addresses according to the standards in your environment. The
preferred IPv6 address representation is written as eight groups of four
hexadecimal digits: xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx, where each x is
a hexadecimal digit representing 4 bits. For example:
2001:DB8:0000:1234:0000:0000:5678:ABCD. You can also specify IPv6
addresses using shortened formats that omit leading zeros
2001:DB8:0:1234:0:0:5678:ABCD or use double colons
2001:DB8:0000:1234::5678:ABCD in place of a series of zeros.
For example, if you enter 2001:DB8::0 in the From field and 2001:DB8::FF in
the To field, Tivoli Storage Productivity Center scans the IP addresses that
fall in the range between 2001:DB8:x:0 to 2001:DB8:x:FF.
The address range that you specify determines how long an SNMP scan
takes to run. For example, if the range includes over 256 addresses, the scan
might take some time to complete. A warning message is displayed if you
indicate a range that includes between 257 and 4096 (0xFFF) addresses. This
warning message notifies you that the scan requires significant time to run as
more addresses are included. Keep in mind that the scan range you enter
cannot exceed 4096 (0xFFF) addresses.
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Note: It takes about 5 minutes to search a subnet. For out of band fabric
discovery to work, the FC Management MIB and FE MIB must be enabled on
the switch.

5. On the When to Run page, determine when and how often to run the
discovery.

6. On the Alert page, specify any alerts to trigger if the discovery schedule fails to
run.

7. Click File > Save to save the discovery. The discovery runs according to the
schedule that you defined on the When to Run page.

Gathering switch performance data
This topic describes how to gather performance data from a switch to evaluate the
switches that are in your environment.

To complete the discovery process for switch performance functions, a SMI agent
must be enabled for your switch.
v For some switches, if you have the prerequisite firmware, you must enable the

SMI agent (also referred to as an embedded SMI agent).
v For other switch vendors, you must install the SMI agent on any host computer

and configure the agent to run providers for one or more switches. An SMI
agent that is installed on a host is referred to as an external SMI agent.

Contact your switch vendor for information about how to enable the embedded
SMI agent or to install the external CIM agent. For the SMI agents that are
supported by IBM Tivoli Storage Productivity Center, see the support matrix at
http://www.ibm.com/support/docview.wss?rs=40&q1=switch&uid=swg21384219
&loc=en_US&cs=utf-8&lang=en.

To gather switch performance data, complete the following steps:
1. Run a CIMOM discovery for a switch SMI agent.
2. Run a Fabric Probe for the Fabric that the switch is a part of.

For information about creating a switch performance monitor, see “Creating a
switch performance monitor” on page 377.

Collecting data
Create data collection jobs to gather information about the storage resources in
your environment. There are different data collection jobs within IBM Tivoli
Storage Productivity Center depending on the type of information is collected and
from which types of resources the information is retrieved: discovery, probes, Tivoli
Storage Productivity Center Server probes, scans, and pings.

Collecting storage statistics
Use probes to collect statistics about the monitored storage resources in your
environment, such as computers, storage systems, fabrics, volumes, disk
controllers, hard disks, and file systems. Probe jobs can also discover information
about new or removed disks and file systems. You can view the information
collected by probes in Asset, Capacity, Storage Subsystems, and System reports.

You can define any number of probes to collect statistics for different storage
resources at different times.
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v From the IBM Tivoli Storage Productivity Center node, you can collect statistics
on computers, disk controllers, hard disks, clusters, fabrics, storage subsystems,
volumes, tape libraries, and file systems.

Important: For file system probes, the default behavior of the probe is to discard
export paths that are not at the root of the file system. This behavior prevents a
situation in which the product counts information twice on a file system. If you
want to collect data for all file systems regardless of their location, add the
saveNonRoot=1 parameter to the [server] section of the TPCD.config file. Restart
the Data server after you have saved the updated the file. The TPCD.config file
is located in the TPC_installation_directory/data/config directory where
TPC_installation_directory is where Tivoli Storage Productivity Center is
installed.

v From the Data Manager for Databases node you can itemize and create an
inventory of the files, instance, logs, and objects that make up your enterprise's
monitored RDBMSs.
The login ID that Data Manager for Databases uses to log into Microsoft SQL
Server instances that you want to probe must have "Permit" access. For
information about how to set the logins for Microsoft SQL Server instances, see
the IBM Tivoli Storage Productivity Center and IBM Tivoli Storage Productivity
Center for Replication Installation and Configuration Guide.

To ensure the accuracy and consistency of the data that appears in the reports, run
regularly scheduled probes against the hosts that use/import volumes and the
storage systems upon which you want to report. You should run probes against
storage systems after running probes against any hosts.

Creating probes
Create and schedule a probe to job to gather information about your storage
resources. You can define any number of probes to gather information about
different storage resources at different times.

To create a probe, complete the following steps:
1. Expand IBM Tivoli Storage Productivity Center > Monitoring > Probes. For

Data Manager for Databases, expand Data Manager for Databases >
Monitoring > Probes.

2. Right-click Probes A menu is displayed.
3. Select Create Probe.
4. In the What to Probe or Instance page, perform the following steps:

a. In the Available list box, highlight the resources you want to probe.

b. Click . The resources are moved to Current Selections list box. Use

to move resources to the Available list box.
5. In the When to Run page, schedule when you want the probe to run. You have

the following options:
v Run the job immediately
v Run the job once at a specified time and date. Use the list boxes to specify

the month, day, year, and the hour, minute, and AM or PM.
v Run the job repeatedly according to a schedule you specify. You can perform

the following tasks:
– Specify the month, day, year, and the hour, minute, and AM or PM when

the job is to run.
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– Indicate how often the job runs. You can use the list boxes to specify the
number of minutes, hours, days, weeks, or months.

– Indicate which days on which run the job. A check mark is displayed next
to the days you select.

Use the fields in the How to handle timezones section to indicate the time
zone that Data Manager for Databases uses when scheduling and running the
action. For example, if you selected to run the job at 9:00 AM, you can use the
fields in this section to run it at:
v 9:00 AM of the time zone where the server resides
v 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on a Storage
Resource agent or Data agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

6. In the Alert page, set the following options:
v The condition that triggers an alert. The default setting is Probe Failed. No

other conditions are currently available.
v The notification method of an alert: SNMP Trap, IBM Tivoli Enterprise

Console Event, Login Notification, Windows Event Log, UNIX Syslog,
running a script, and email. If you select SNMP Trap, Tivoli Enterprise
Console Event, or email for the method by which you are notified of an alert,
you must define a destination for the method on the Administrative
Services → Configuration → Alert Dispositions window.

7. Click to save the probe. You must save the probe before Tivoli Storage
Productivity Center can collect data about storage resources.

8. Enter a name for the probe and click OK. An entry for the probe is displayed
under the Probes node in the navigation tree. The probe is run at the date and
time specified in the schedule definition.

9. Use the Job Management panel to manage view information about the runs and
jobs that are related to the probe. For example, use the Job Management panel
to view the status of a run for a schedule, the date and time when it was run,
and the log files of the jobs associated with the run.

Related reference:
“Managing schedules, jobs, and runs” on page 297
Use the Job Management panel to view and manage all the schedules, runs, and
jobs related to the storage devices that are monitored by IBM Tivoli Storage
Productivity Center.

Editing probes
Change the settings in an existing probe job.

To edit an existing probe, complete the following steps:
1. Expand IBM Tivoli Storage Productivity Center > Monitoring > Probes. For

Data Manager for Databases, expand Data Manager for Databases >
Monitoring > Probes.
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2. Click the name of the probe you want to edit. The content pane displays
information about that job.

3. Edit the probe definition.

4. Click to save the updated probe definition.

Creating fabric probes
Use probes to collect statistics about fabrics and fabric groups.

After you have defined your fabric groups, you can use Fabric Manager to run
probes against fabrics and fabric groups to collect information.

To run probes against fabrics, complete the following steps:
1. Expand IBM Tivoli Storage Productivity Center → Monitoring, right-click

Probes, and select Create Probe.
2. In the What to Probe tab enter a description for the probe, and from the

Available column, select the fabrics and fabric groups to be probed. Move them

to the Current Selections column by clicking .
3. In the When to Run tab specify when the probe is to begin. You can begin the

probe immediately, schedule it to begin at a later time, and specify whether to
run the probe repeatedly.

4. In the Alert tab specify the action to be taken if the probe fails. See “Running
scripts with alerts” on page 493 for a description of these triggered actions.

5. Click to save the probe. You must save the probe before Tivoli Storage
Productivity Center can collect data about storage resources.

6. Enter a name for the probe and click OK. An entry for the probe is displayed
under the Probes node in the navigation tree. The probe is run at the date and
time specified in the schedule definition.

7. Use the Job Management panel to manage view information about the runs and
jobs that are related to the probe. For example, use the Job Management panel
to view the status of a run for a schedule, the date and time when it was run,
and the log files of the jobs associated with the run.

Related reference:
“Managing schedules, jobs, and runs” on page 297
Use the Job Management panel to view and manage all the schedules, runs, and
jobs related to the storage devices that are monitored by IBM Tivoli Storage
Productivity Center.

Creating tape library probes
Probes collect data from the tape libraries that have been discovered.

You can create tape library probes that collect information from all your tape
libraries, or a subset. Probes can be scheduled to run immediately, or at a
scheduled point in time. The data that probes collect is put into the database and is
displayed in various places throughout the product, such as the topology viewer
and the Tape Manager > Tape Libraries node.

To create a tape library probe:
1. Expand IBM Tivoli Storage Productivity Center > Monitoring > Probes and

select Create Probe

2. Enter the information in the three tabbed pages:
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v What to Probe - select the tape libraries and tape library groups to include in
this probe

v When to Probe - specify the scheduling information for this probe
v Alert - specify the triggering condition that will cause an alert to be

generated for this probe, and the actions taken when an alert is generated

3. Click to save the probe. You must save the probe before Tivoli Storage
Productivity Center can collect data about storage resources.

4. Enter a name for the probe and click OK. An entry for the probe is displayed
under the Probes node in the navigation tree. The probe is run at the date and
time specified in the schedule definition.

5. Use the Job Management panel to manage view information about the runs and
jobs that are related to the probe. For example, use the Job Management panel
to view the status of a run for a schedule, the date and time when it was run,
and the log files of the jobs associated with the run.

There are some special situations to note when creating and running probes of tape
libraries:
v Do not include more than three tape libraries in the same probe if they are all

registered with the same IBM SMI-S Agent for Tape. Doing so can increase the
load on the SMI-S agent and can increase the possibility of timeouts. To avoid
timeouts, create multiple probes with different start times, and split the libraries
up among the probes.

v After the list of tape libraries that are registered with the IBM SMI-S Agent for
Tape has been altered, a condition can occur in which not all of the tape
cartridges are returned to the CIM client, in this case, Tivoli Storage Productivity
Center. To resolve this situation, restart the IBM SMI-S Agent for Tape. For
instructions, see the documentation for the SMI-S Agent.

v When the probe of a tape library successfully completes, some of the buttons in
the Tape Libraries GUI panel might be disabled. To enable the buttons, close and
then redisplay the panel.

Related reference:
“Managing schedules, jobs, and runs” on page 297
Use the Job Management panel to view and manage all the schedules, runs, and
jobs related to the storage devices that are monitored by IBM Tivoli Storage
Productivity Center.

Locating a tape cartridge:

View a list of all the cartridges for each discovered tape library.

Tape libraries can contain many cartridges (sometimes called tape volumes), and it
can be difficult to find a particular tape cartridge among all the cartridges for a
particular tape drive. IBM Tivoli Storage Productivity Center simplifies this task by
listing all the cartridges for each discovered tape library. To find a particular tape
cartridge:
1. Expand the Tape Manager node and click Tape Libraries.
2. Select a tape library from the list of discovered tape libraries.
3. Click Cartridges.
4. Click the Label column header to sort the list of cartridges by label.
5. Scroll through the list of cartridges to find the one you are looking for.
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6. The Location column will indicate exactly where the tape is located in the
library.

Note: You can also sort by other columns by clicking on the column headers. For
example, if you know that the cartridge you are looking for is dual sided, you can
sort the list by that criterion. This can make finding a particular cartridge much
easier, especially for libraries that have many cartridges.

Creating a VMware VI probe
Probes collect data from the VMware VI data sources that have been discovered.

To create a VMware probe, complete the following steps:
1. In the Navigation Tree pane, expand IBM Tivoli Storage Productivity Center >

Monitoring > Probes.
2. Right-click on Probes and click Create Probes.
3. Enter the information in the three tabbed pages:

What to Probe
Enter a description for the probe and from the Available column, select
Hypervisors to include in the group to be probed. Click >> to move the
group to the Current Selections column.

When to Run
Specify when the probe is to begin. You can begin the probe
immediately, schedule it to begin at a later time, and specify if it should
be run repeatedly.

Alert Specify the triggering condition that will cause an alert to be generated
for this probe, and the actions that should be taken when an alert is
generated.

4. To save the probe, click Save.
5. In the Save As window, enter the probe name and click OK.

Collecting storage statistics from Tivoli Storage Productivity
Center servers

Schedule probes from the master server for Tivoli Storage Productivity Center to
collect storage information that has been gathered by subordinate servers. The
information gathered by probes of subordinate servers is displayed in the Tivoli
Storage Productivity Center > Rollup Reports node in the navigation tree of the
master server. You can define server probes by selecting TPC Server Probe in the
navigation tree.

A subordinate server is a server that monitors and reports on storage resources like
a standard server, but also communicates with the master server during TPC
server probes. During these probes, the master server collects the storage
information gathered by a subordinate server's agents and stores that information
in its own database repository.

Note: If the same storage entity is managed by multiple subordinate servers,
rollup reports reflect the storage information from the subordinate server that most
recently probed that entity.

Before you run TPC server probes, make sure to perform the following:
1. Associate subordinate servers with the master server on the Administrative

Services > Data Sources > TPC Servers window. See “Adding an Tivoli
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Storage Productivity Center Server” on page 282 for information on how to
associate subordinate servers with a master server.

2. Run discoveries, probes, and scans on the subordinate servers to gather
information about their locally-managed entities.

The information collected by TPC server probes from subordinate servers includes
the following:
v Asset information: detailed statistics about agents (Tivoli Storage Productivity

Center), computers, storage subsystems, disk and volume groups, disks,
filesystems, logical volumes, volumes, and fabrics.

v Database asset information: detailed statistics about the RDBMSs in your
environment, including Oracle, SQL Server, Sybase, and UDB.

v Capacity information: storage metrics related to the disk capacity, filesystem
capacity, filesystem used space, and filesystem freespace of the storage entities in
your environment.

v Database capacity information: storage metrics related to the storage capacity of
the RDBMSs in your environment, including Oracle, SQL Server, Sybase, and
UDB.

Additional storage information collected by a subordinate server and used within
such Tivoli Storage Productivity Center functions as the topology viewer, data path
explorer, volume provisioning, volume performance, and SAN Planner is available
for only that subordinate server. That information is not collected by the master
server, and thus not rolled up into the reports available through the master server.

Also, the Tivoli Storage Productivity Center functions within the master server use
the storage information collected by only the master server.

Creating Tivoli Storage Productivity Center server probes
Use Tivoli Storage Productivity Center server probes from the master server to
collect storage information that has been gathered by subordinate servers.

To create a Tivoli Storage Productivity Center server probe, complete the following
steps:
1. Expand IBM Tivoli Storage Productivity Center > Monitoring > TPC Server

Probes.
2. Right-click TPC Server Probes and select Create TPC Server Probes from the

menu.
3. Enter a brief description of the probe in the Description field.
4. In the What to Probe page, perform the following steps:

a. In the Available list box, highlight the Tivoli Storage Productivity Center
servers you want to probe. You can do any of the following: 1. Select the
All TPC Servers item to automatically include all subordinate servers in the
probe. 2. Select the name of a specific subordinate server and all its related
storage entities that you want to probe. 3. Select the specific entities on a
subordinate server that you want to probe. For example, you can expand
the node for a subordinate server and select the specific entities for which
you want to collect data: All Resources, Clusters, Computer Groups,
Computers (including Hypervisors), Database Instances, Fabrics, RDBMS
Computer Groups, Storage Subsystem Groups, and Storage Subsystems.

b. Click to include highlighted Tivoli Storage Productivity Center
servers or storage entities in the probe. The entities that you selected are
moved to Current Selections list box.
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5. In the When to Run page, schedule when you want the probe to run. You have
the following options:
v Run the job immediately
v Run the job once at a specified time and date. Use the list boxes to specify

the month, day year, and the hour, minute, and AM/PM.
v Run the job repeatedly according to a schedule you specify. You can perform

the following tasks:
– Specify the month, day, year, and the hour, minute, and AM or PM when

the job is to run.
– Indicate how often the job runs. Use the list boxes to specify the number

of minutes, hours, days, weeks, or months.
– Indicate which days on which run the job. A check mark is displayed next

to the days you select.
Use the fields in the How to handle timezones section to indicate the time
zone that Data Manager for Databases uses when scheduling and running the
action. For example, if you selected to run the job at 9:00 AM, you can use the
fields in this section to run it at:
v 9:00 AM of the time zone where the server resides
v 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on a Storage
Resource agent or Data agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

6. In the Alert page, set the following options:
v The condition that triggers an alert. The default setting is Probe Failed. No

other conditions are currently available.
v The notification method of an alert: SNMP Trap, IBM Tivoli Enterprise

Console Event, Login Notification, Windows Event Log, UNIX Syslog,
running a script, and email. If you select SNMP Trap, Tivoli Enterprise
Console Event, or email for the method by which you are notified of an alert,
you must define a destination for the method on the Administrative
Services → Configuration → Alert Dispositions window.

7. Click to save the probe. You must save the probe before Tivoli Storage
Productivity Center can collect data about storage resources.

8. Enter a name for the probe and click OK. An entry for the probe is displayed
under the TPC Server Probes node in the navigation tree. The probe is run at
the date and time specified in the schedule definition.

9. Use the Job Management panel to manage view information about the runs and
jobs that are related to the probe. For example, use the Job Management panel
to view the status of a run for a schedule, the date and time when it was run,
and the log files of the jobs associated with the run.

344 IBM Tivoli Storage Productivity Center: User's Guide



Related reference:
“Managing schedules, jobs, and runs” on page 297
Use the Job Management panel to view and manage all the schedules, runs, and
jobs related to the storage devices that are monitored by IBM Tivoli Storage
Productivity Center.

Editing TPC Server probes
Learn how to edit the definition of a TPC server probe.

To edit an existing TPC server probe, complete the following steps:
1. Expand IBM Tivoli Storage Productivity Center > Monitoring > TPC Server

Probes.
2. Click the name of the TPC server probe you want to edit. The content pane

displays information about that probe.
3. Edit the values on the What to PROBE, When to Run, and Alert pages to

change the TPC server probe definition.

4. Click to save the updated TPC server probe definition.

Managing the runs and jobs for TPC Server Probes
View information about the runs, jobs, and log files for TPC Server Probes.

Tivoli Storage Productivity Center creates a run each time a TPC Server Probe
schedule collects data from subordinate servers. A job is a unit of work within a
run for a schedule. Use the Job Management panel to manage TPC Server Probe
schedules and view information about the related runs and jobs. Specifically, use
this panel to perform the following tasks for schedules:
v View or edit the definition of a schedule.
v Run a schedule immediately.
v Rename or delete a schedule.
v View basic information about a schedule, including the ID of the user who

created it, description, the last time the schedule was run, and the next time the
schedule is run.

Use the Job Management panel to perform the following tasks for the runs and
jobs related to TPC Server Probe schedules:
v View the status of a run and the date and time when it was executed.
v View information about the jobs associated with each run, including the name of

the computer on which a job was run, the type of the monitored device, and the
status of the job.

v View the log files for one or more jobs at a time.
v Display jobs that have started or completed within a specified length of time.

For example, display jobs that have completed in the last two weeks.
v Display jobs that have a certain status, such as Success, Running, or Failed.

To access the Job Management panel for a TPC Server Probe schedule, complete
the following steps:
1. In the navigation tree, expand IBM Tivoli Storage Productivity Center >

Monitoring > TPC Server Probes.
2. Select the probe schedule whose runs and jobs you want to manage. The

content pane displays information about the schedule.
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3. In the content pane, click View Job History. The Job Management panel is
displayed and the selected schedule is highlighted in the Schedules section.
View the entries in the Jobs for Selected Schedules section to manage the jobs
and runs for the schedule.

You can also access the Job Management panel at any time by clicking the related

icon ( ) in the toolbar. Use the Filters section on the Job Management panel to
display the TPC Server Probe schedule that you want to manage. See “Managing
schedules, jobs, and runs” on page 297 for more information.

Collecting storage usage and trending information
Use scans to collect statistics about the usage and trending of storage consumption
of storage resources in your environment. You can view the information collected
by scans in reports and use it as part of a quota analysis.

Use a Data agent or Storage Resource agent to collect information for a scan. These
agents must be deployed on the storage resources that you want to monitor. By
running scans and generating the results of those scans in reports, you can perform
the following tasks:
v View when files were created, accessed, and modified and by what group or

user.
v Map storage resources to the consumers of those resources.
v Generate historical views of storage consumption and utilization that show

usage trends over time. System administrators can use these views to project
and plan for future storage consumption.

v Collect detailed RDBMS space usage reports at the table, index, and user levels.
v Gather individual user space usage at the table space, database, instance,

computer, and network wide levels.
v Collect detailed space usage information about monitored tables and their

associated indexes. For example, when scanning UDB tables, this information
includes many of the calculated REORGCHK values. These include Used Page
%, Used Space %, and Cluster Ratio.

v Historically track database, table space, and user usage and use that data to
forecast and display future usage.

v Gather information for quotas that can be created to trigger alerts (and create
reports) when users exceed a specified amount of space usage.

v (UDB only) Perform (optionally) runstats on all tables involved in the scan
process.

v Assign costs to space used at the user level when combined with Data Manager
for Chargeback.

Note:

1. A licensed agent must be installed on a computer that contains instances
against which you want to run a scan. You must run a probe against an
instance before you can select any tablespaces against which you want to run a
scan.

2. The login ID that Data Manager uses to log in to Microsoft SQL Server
instances that you want to scan must have "Permit" access.

Creating scans
Create and schedule a scan to gather usage information about your storage
resources. You can specify which file systems, computers, clusters, directories,
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databases, and other storage resources that you want to scan. You can define any
number of scans to gather information about different storage resources at different
times.

To create a scan, complete the following steps:
1. Expand Data Manager > Monitoring > Scans. For Data Manager for Databases,

expand Data Manager for Databases > Monitoring > Scans.
2. Right-click the Scans node and select Create Scan.
3. For Data Manager, define the following scan properties:

v The computers and file systems whose storage usage and consumption you
want to monitor. For more information, see “Including storage resources in a
scan” on page 348.

v The directory groups to scan. For more information, see “Selecting directory
groups to scan” on page 349.

v The profiles to use during a scan. For more information, see “Using profiles
in a scan” on page 350.

v The schedule when you want a scan to run. For more information, see
“When to run the scan” on page 351.

v An alert to notify you if the scan fails. For more information, see “Defining
alert values for a scan” on page 352.

4. For Data Manager for Databases, define the following scan properties:
v The databases, table spaces, instances, and computers whose storage usage

and consumption you want to scan. For more information, see “Selecting
databases, tablespaces to scan” on page 349.

v The table groups you want to scan. For more information, see “Select the
table groups to scan” on page 350.

v The profiles to use during a scan. For more information, see “Using profiles
in a scan” on page 350.

v The schedule when you want a scan to run. For more information, see
“When to run the scan” on page 351.

v The options for Oracle and UDB. For more information, see “Specify options
for Oracle and UDB” on page 352.

v An alert to notify you if the scan fails. For more information, see “Defining
alert values for a scan” on page 352.

5. Click to save the scan. You must save the scan before Tivoli Storage
Productivity Center can collect data about storage resources.

6. Enter a name for the scan and click OK. An entry for the scan is displayed
under the Scans node in the navigation tree. The scan is run at the date and
time specified in the schedule definition.

7. Use the Job Management panel to manage view information about the runs and
jobs that are related to the scan. For example, use the Job Management panel to
view the status of a run for a schedule, the date and time when it was run, and
the log files of the jobs associated with the run.
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Related reference:
“Managing schedules, jobs, and runs” on page 297
Use the Job Management panel to view and manage all the schedules, runs, and
jobs related to the storage devices that are monitored by IBM Tivoli Storage
Productivity Center.

Including storage resources in a scan:

In a scan, include the computers, computer groups, file systems, file system
groups, and clusters whose storage usage and consumption that you want to
monitor.

Use the Filesystems page to select the storage resources that you want to scan.
Include clusters, individual file systems and computers, or file system and
computer groups (that have been predefined using the “Working with groups of
resources” on page 373 facility).

The Current Selections list box shows the storage resources that have been
selected for the scan. The Available list box shows which storage resources are still
available for selection in the scan.

Note: A cluster name is displayed next to individual computers that are members
of a PowerHA or Microsoft Cluster Server cluster. Cluster resource groups are
identified with a special icon. Clusters displayed in the Available list box cannot
be expanded to show member nodes. You can move a cluster to the Current
Selections list box to view and, if necessary, exclude member nodes.

To include storage resources in a scan:

1. Highlight the file systems, file system groups, computer groups, computers,
and clusters you want to include in the scan in the Available list box.

Note: Before you can include file systems in a scan, you must probe the
computers that contain those file systems. If you do not probe a computer
before you define a scan, the file systems on that computer are unavailable for
the scan.

2. Click . The storage resources that you selected are displayed in the
Current Selections list box.

To remove storage resources from a scan:

v Highlight the file systems, file system groups, computer groups, computers, and

clusters that you want to remove and click . This action removes the
storage resources from the Current Selections list box and moves them to the
Available list box.

To exclude one or more file systems or computers from a selected cluster or
group:

Perform the following steps if you want to exclude specific file systems or
computers from a cluster or group that you included in a scan:
1. Double click the cluster or group name in the Current Selections list box.
2. Right click on the file systems or computers that you want to exclude. A

pop-up menu is displayed.
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3. Select Exclude. This action creates an Excludes section in the Current
Selections list box that displays the names of the file systems or computers that
you have excluded from a scan. This action is useful when you want to select a
group or cluster for scanning, but you want to exclude a few file systems or
computers from that monitoring.

Selecting directory groups to scan:

This topic describes how to select the directory groups that you want to scan.

Use the Directory Groups tab to select the groups of directories that you want to
scan. Including directory groups within a scan enables you to monitor and gather
information about specific directories across a number of machines.

The Selected Directory Groups list box shows what directory groups have been
included in the scan. The Available Directory Groups list box shows the groups
that are still available for selection. You can select directory groups that have been
predefined using the groups facility.

To select a directory group:

1. Highlight the desired directory group in the Available Directory Groups list
box.

2. Click . The group you selected appears in the Selected Directory
Groups list box.

To remove a directory group from a scan:

v Highlight the groups you want to remove and click . This will remove
the groups from the Selected Directory Groups list box and move them to the
Available Directory Groups list box.

To create a new directory group:

v Click New Directory Group. The New Directory Group window opens,
enabling you to create a new group. See “Creating directory groups” on page
374 for more information on how to create a directory group.

Selecting databases, tablespaces to scan:

This topic describes how to select the databases and tablespaces that you want to
scan.

Use the Database-Tablespaces page to select what databases, tablespaces, instances,
and computers whose storage usage and consumption you want to monitor. You
can include single or groups of databases, tablespaces, and computers against
which to run the scan.

The Current Selections list box shows the databases, tablespaces, tablespace
groups, computers, and computer groups that have been selected for the job. The
Available list box shows what items are still available for selection.

To include a database, tablespace, computer, instance, or group in a scan:

1. Highlight the desired databases, tablespaces, computers, instances, or groups in
the Available list box.
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2. Click . The databases, tablespaces, computers, instances, or groups you
selected appear in the Current Selections list box.
For example, if you select a computer to include in a scan, that job will scan all
the databases and/or tablespaces on all the instances that reside on that
computer.

To remove a database, tablespace, computer, instance, or group from a scan:

v Highlight the items you want to remove and click . This will remove the
databases, tablespaces, computers, instances, or groups from the Current
Selections list box and move them to the Available list box.

Select the table groups to scan:

Select the table groups that you want to scan.

Use this page to select the table groups you want to scan. A table group represents
a group of defined tables. By choosing a table group on this window, you can
perform more detailed scans of tables that might not appear within other Data
Manager for Databases reports (such as the Largest Table or Monitored Tables
reports).

Note: Before you can view detailed information about tables in an RDBMS, you
must have 1) defined a table group that contains the tables about which you want
to view storage information and 2) scheduled and run a scan against that table
group.

The Selected Table Groups list box shows the table groups that have been selected
for the job. The Available Table Groups list box shows the table groups that are
still available for selection.

To include a table group in a scan:

1. Highlight the desired group in the Available Table Groups list box.

2. Click . The group you selected appears in the Selected Table Groups
list box.

To remove a table group from a scan:

v Highlight the groups you want to remove and click . This will remove
the groups from the Selected Table Groups list box and move them to the
Available Table Groups list box.

To create a new table group:

v Click New Table Group. The New Table Group window opens, enabling you to
create a new group.

Using profiles in a scan:

Select the profile to use as part of a scan. Profiles enable you to control what files
are scanned and what statistics are gathered.

Use the Profiles page to select which profiles to use during a scan. Using profiles
is a powerful method for determining the statistics you want to gather during
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scans. Keep in mind that the more profiles you include within a scan, the longer
the scan will take to gather the statistics specified by those profiles.

To include profiles in a scan:

1. Highlight the desired profiles in the Available Profiles list box.

2. Click the for the Profiles to apply to Filesystems list box to apply the

selected profiles to file systems; click the for the Profiles to apply to
Directories list box to apply the selected profile(s) to directories. The profiles
you selected appear in the either the Profiles to apply to Filesystems or
Profiles to apply to Directories list box

Note: To collect statistics according to Data Manager default settings, select all
of the default profiles.

To remove profiles from a scan:

v Highlight the profiles you want to remove and click the corresponding .
This will move the selected profiles to the Available Profiles list box.

To create a new profile:

v Click New Profile. The Statistics tab on the Create Profile window is displayed,
enabling you to create a new profile. See “Using profiles” on page 354 for more
information.

Related concepts:
“Using profiles” on page 354
Use profiles to specify what statistical information is gathered and to fine tune and
control what files are scanned during a scan. You can also use profiles with some
reports to determine what statistics are displayed.

When to run the scan:

Schedule when and how often to run a scan.

You have the following options for determining when to run a scan:
v Run the job immediately
v Run the job once at a specified time and date. Use the list boxes to specify the

month, day, year, and the hour, minute, and AM or PM.
v Run the job repeatedly according to a schedule you specify. You can:

– use the list boxes to specify the month, day, year, and the hour, minute, and
AM or PM when the job should begin running.

– indicate how often the job should run. You can use the list boxes to specify
the number of minute(s), hour(s), day(s), week(s), or month(s).

– select which days you wish to run the job.

Use the fields in the How to handle timezones section to indicate the time zone
that Data Manager should use when scheduling and running the scan. For
example, if you selected to run the job at 9:00 AM, you can use the fields in this
section to run it at:
v 9:00 AM of the time zone where the server resides
v 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an agent
located in the PST time zone.
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Use the timezone that the server runs in. Select this option to use the time zone of
the location where the Data server resides.

Use this timezone. Select this option to indicate a specific time zone for when to
run the job. When you select this option, a list box is activated. Select a timezone
from the list box.

Specify options for Oracle and UDB:

Specify options for Oracle and UDB when defining a scan.

Use the Options page to do the following:
v Determine if the job should scan the freelist chains associated with the segments

in your Oracle environment. Free list chains represent the pages allocated to a
segment that have enough free space for additional rows. Note that checking
this option will increase the time required by the scan to complete.

v Set the number of pages Data Manager for Databases should scan on a chain
before stopping.

v Determine if the job should gather segment extent data for locally-managed
tablespaces.

v Run the DB2 utility runstats against the tables being scanned. Checking this box
will enable Data Manager for Databases to collect the most up-to-date storage
statistics about tables from the DB2 catalog. Note that checking this option will
increase the time required by the scan to complete, but will ensure that table and
user statistics are up-to-date in UDB/DB2 databases. Alerts based on table and
user stats will not function until runstats is run.

Defining alert values for a scan:

This topic describes how to set an alert that will be triggered if the scan job fails.

Use the Alert page to can define an alert to notify you if a scan fails and how to
notify you. You can choose to be notified by SNMP trap, IBM Tivoli Enterprise
Console event, login notification, Windows event log, UNIX Syslog, running a
script, and e-mail. If you select SNMP trap, Tivoli Enterprise Console event, or
e-mail, you must also define a destination (for example, an e-mail address). Define
this destination by expanding Administrative Services > Configuration > Alert
Dispositions.

To define an alert for a scan, complete the following steps:
1. Click the Alert tab; the Alert page opens.
2. In the Triggering Condition area, select Scan Failed. This indicates that an alert

will be triggered if the scan fails to run.
3. In the Triggered Actions area, select the actions that occur as a result of the

triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage Productivity
Center events according to the event definitions specified in the
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tivoliSRM.baroc file (provided with the product). It also performs
responses such as sending further notification, creating or updating
trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity Center.
In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.

Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The parameters
listed in the Specify Script window are passed to the script when the
alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

4. Click File > Save to save the scan.
5. Enter a name for the scan and click OK. An entry for the scan appears under

the Scans node.

Editing scans
Change the settings in an existing scan job.

To edit an existing scan, complete the following steps:
1. Expand Data Manager > Monitoring > Scans. For Data Manager for Databases,

expand Data Manager for Databases > Monitoring > Scans.
2. Click the name of the scan you want to edit. The content pane displays

information about that job.
3. Edit the scan definition by changing the values that appear on the following

pages:
v Filesystems. Use this page to edit the computers and file systems whose

storage usage and consumption you want to monitor as part of a scan.
v Directory Groups. Use this page to edit the groups of directories that you

want to scan.
v Databases-Tablespaces. Use this page to edit the databases, tablespaces,

instances, and computers whose storage usage and consumption you want to
monitor as part of a scan.
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v Table Groups. Use this page to edit the table groups that you want to scan. A
table group represents a group of defined tables.

v Profiles. Use this page to edit which profiles are used during a scan. Using
profiles is a powerful method for determining the statistics you want to
gather during scans.

v When to Run. Use this page to edit when a scan is run.
v Options (Oracle and UDB only). Use this page to edit the scan options for

Oracle or UDB.
v Alert. Use this page to edit how you are notified if a scan fails.

4. Click to save the updated scan definition.

Using profiles
Use profiles to specify what statistical information is gathered and to fine tune and
control what files are scanned during a scan. You can also use profiles with some
reports to determine what statistics are displayed.

Until you begin creating your own profiles, you can use the default profiles that
are supplied with IBM Tivoli Storage Productivity Center. Each of these default
profiles allows you to select a specific statistic that you want to gather. If you want
to scan a computer or filesystem, and want to gather all of the statistical
information available, simply select all of the default profiles when you create your
scan job.

See “Default profiles” for more information about default profiles.

Default profiles:

Default Profiles are provided for your use with IBM Tivoli Storage Productivity
Center. Each default profile represents a specific statistic that you can gather
(which is included in the name of the profile for convenient identification).

If you want to scan a computer or filesystem and gather all of the statistical
information available, select all of the default profiles when you create your scan.
TPCUser is shown as the creator of the default profiles, and TPCUser is the prefix
name for each of the profiles. The following list identifies the default Data
Manager profiles and describes their functions.

By Access
Gathers statistics by length of time since last access of files.

By Creation
Gather storage statistics by the length of time since the creation of files.
This profile applies to scans run against Windows computers only. Scans
with this profile do not gather any creation time data from non-Windows
computers.

By Mod Not Backed Up
Gathers statistics by length of time since last modification, only for files not
backed up since modification. (Windows operating systems only)

By Modification
Gathers statistics by length of time since last modification of files.

Size Distribution
Gathers information on the size distribution of files.
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Largest Directories
Gathers statistics on the n largest directories. (20 is the default amount.)

Largest Files
Gathers statistics on the n largest files. (20 is the default amount.)

Largest Orphans
Gathers statistics on the n largest orphan files. (20 is the default amount.)

Most At Risk
Windows operating systems only: Gathers statistics on the n files that have
been modified the longest time ago and have not yet been backed up since
they were modified. (20 is the default amount.)

Oldest Orphans
Gathers statistics on the n oldest orphan files. (20 is the default amount.)

Most Obsolete Files
Gathers statistics on the n most obsolete files (i.e., files that have not been
accessed or modified for the longest period of time). (20 is the default
amount.)

Summary By File Type
Summarizes space usage by file types (for example, .exe., .dll, .doc, .mp3,
etc.).

Summary By Filesystem/Directory
Summarizes space usage by file system or directory.

Summary By Group
Summarizes space usage by OS Group.

Summary By Owner
Summarizes space usage by Owner.

Temporary Files
Gathers statistics on the non-OS files not accessed in the last year and
orphan files.

Wasted Space
Gathers statistics on the non-OS files not accessed in the last year and
orphaned files.

The following list identifies the default Data Manager for Databases profiles and
describes their functions.

DB User Space
Gathers statistics about the user space usage within a database or
tablespace.

Largest Tables
Gathers statistics on the n largest tables. (20 is the default amount)

Segment Most Extents
Gathers statistics on the n segments with the most extents. (20 is the
default amount)

Segment Most Unused Space
Gathers statistics on the n segments with the most empty used space. (20 is
the default amount). Empty used space represents the space allocated to a
segment that is currently empty/not being used. Gathering this
information can help you discover space that can be reclaimed and
allocated to other objects. Specifically, use this Profile to:
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v find objects that are over-allocated (not using all their associated free
space)

v find the free space that exists in excess of a table's high-water mark (the
high water mark is the highest block that was written for a table)

v find segments that have the largest amount of blocks that are not filled

Summary
Summarizes space usage by database or tablespace, such as how many
segments are in a tablespace (Oracle only), how many of those segments
are tables (Oracle only), indexes, etc.

Creating a profile:

Create a profile for use within a scan.

To create a profile perform the following steps:
1. Expand Data Manager > Monitoring. For Data Manager for Databases,

expand Data Manager for Databases > Monitoring.
2. Perform one of the following actions:

v Select Create Profile from the pop-up menu.
v Click New Profile from the Profiles tab of the Create scan window.

Use the Create Profile window to specify exactly what level of detail to collect
when running a scan. The more information that you specify, the more reports
that you will be able to run against the information that you collect during the
scan. Statistics are tied to a specific profile.

3. The Statistics tab on the Create Profile window is displayed.
4. Select statistics you want the scan to collect. Statistics are tied to a specific

profile.
See “Default profiles” on page 354 for more information about statistics.

5. If you want to further limit specific files to be scanned, select the File Filters
tab. You can define exclusive conditions that filter what files are analyzed
during the scan.
See the “Creating file filters” on page 359 section for more information on
using this tab.

6. The first time you view a new profile, this window is blank except for the text
All files selected. That is the default and indicates that information will be
collected for all files. To create your first group or condition, simply right-click
All files selected and choose to create a new group or condition.

7. In the File Filters page, the default condition All files selected is displayed.
Right-click All files selected and select New Condition from the pop-up
menu. You can also specify groups for these conditions, by selecting New
Group.
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8. In the preceding figure, New Condition is selected. The Create Condition
window opens, enabling you to define your file conditions. You can create
conditions based on access time, creation time, file name or group,
modification time, file attributes, size, type, owner, or length.

Figure 27. File Filters tab, pop-up menu
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9. Press OK after defining each condition.
10. If you are defining more than one condition, the Create Group dialog box

displays to help you associate the conditions you created:

11. Select how you want to associate the conditions you have defined. See
“Associating conditions with groups” on page 364 for more information on
creating groups.

12. The condition is displayed in the File Filter window.

Figure 28. Create Condition window

Figure 29. Create Group Window
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13. Click to save the profile.
14. Enter a name for the profile and click OK. An entry for the profile appears as

a node under the Profiles node.

Creating file filters:

Use file filters as part of a profile to further define the files that you want to
include or exclude in a scan. Filters limit the files on which you are gathering data
during the scan based on criteria that you define.

In the following example, a group (All of) has been created with three conditions:
v The first controls the type of files to collect information on (MP3, GIF, AVI, and

JPG files).
v The second specifies that the files must have been created within the last year.
v The third limits the profile to analyzing only files greater than 500 KB.

To create file filters within profile, complete the following steps:
1. To edit the filer filters in an existing profile, expand Data Manager >

Monitoring > Profiles and select an existing profile in the navigation tree. To
create a new profile and add file filters, expand Data Manager > Monitoring,
right-click Profiles, and select Create Profile.

2. Click the File Filters tab.
3. The first time you view a new profile, this window is blank except for All files

selected. Selecting all files is the default and indicates that information is
collected for all files. To create your first group or condition, right-click All
files selected and choose to create a new group or condition.

4. In the File Filters page, the default condition All files selected is displayed.
Right-click All files selected and select New Condition. You can also specify
groups for these conditions by selecting New Group.

Figure 30. File Filter window
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The Create Condition window opens, enabling you to define your file
conditions. You can create conditions based on access time, creation time, file
name or group, modification time, file attributes, size, type, owner, or length.

5. Press OK after defining each condition. See “Defining a filter condition” for
more information on creating groups.
Each condition is displayed in the File Filter window.
If you are defining more than one condition, the Create Group dialog box
helps you associate the conditions you create.

6. Associate the conditions you have defined.
See “Associating conditions with groups” on page 364 for more information on
creating groups.

Defining a filter condition:

Define a condition for a filter.

On the File Filters page, right-click All files selected and select New Condition.
The Create Condition window opens.

The first drop down list displays file criteria that you can select to define your
condition. You can define file criteria based on access time, creation time, file name
or group, modification time, file attributes, size, type, owner, or length. Depending
on the criteria you choose to define, the second drop down list and window fields
change dynamically to help you set parameters for the selected criteria. The
following table describes the file criteria you can select for your file filter.

Condition Description
Method for
filtering the files Condition Modifiers

Last
Accessed

Use this condition to limit files
based on the last time they were
accessed. For example, you can
define a filter that includes files
that were last accessed between
12:01 on January 1, 2005 and
11:59 on January 30, 2005.

v later than

v earlier than

v between

v not between

v Length of time before scan: enter the years,
weeks, days, hours, or minutes before a scan

v Timestamp - select files based on the
timestamp

Created Use this condition to limit files
based on when they were
created. For example, you can
define a filter that includes files
that were created between 12:01
on January 1, 2005 and 11:59 on
January 30, 2005.

v later than

v earlier than

v between

v not between

v Length of time before scan: enter the years,
weeks, days, hours, or minutes before a scan

v Timestamp: select files based on the
timestamp
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Condition Description
Method for
filtering the files Condition Modifiers

Name Use this condition to limit files
based on their name. For
example, you can define a filters
that include files that end in
*.html, or include files that end
in .cmd and appear within a
specified subdirectory.

v matches any of

v matches none of

v matches

v does not match

Enter the file name upon which you want the
condition to be based. For example, you can
specify, *.exe, *.mp3, *.avi. in the Match field.
See “Using wildcards in file filters” on page 365
for information about how to use wildcards (*,
%, etc.) in this field.

Select the location where the file name will be
searched during the scan:

v In any directory. During a scan, Data
Manager will look for the file name in any
directory. In this condition, the search string
will occur at the end of the full directory
path.

v Append to scanned directory. This option
enables you to restrict what directory to scan.
Data Manager will look for the file type in
the specified file system root directory or in a
monitored directory in a directory group tied
to a scan. In this option, you must first
specify what directory groups you want
scanned in the Directory Groups tab of the
Scan window. See “Selecting directory groups
to scan” on page 349 for more information.

v Fully-qualified path. Enter the fully-qualified
path when you enter the file type in the
Match field. During a scan, Data Manager
will look for the file type in the exact path
you specify here. This is useful when you
want to exclude system directories and files
in a Most Obsolete Files report.

Group Use this condition to limit files
based on the OS group to which
those files belong.

v matches any of

v matches none of

v between

v not between

v matches

v does not match

v >=

v <

v >

v <=

Name of the OS group

Last
Modified

Use this condition to limit files
based on when they were last
modified.

v later than

v earlier than

v between

v not between

Specify the time as:

v Length of time before scan: enter the years,
weeks, days, hours, or minutes before a scan

v Timestamp: select files based on the
timestamp
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Condition Description
Method for
filtering the files Condition Modifiers

Attributes Use this condition to limit files
based on file attributes such as
read only, system, temporary,
etc.

v include any of

v include none of

v include all of

v don’t include all
of

Select the file attribute upon which you want
the condition to be based. You can select:

v Read only: Users cannot write to the file.

v Hidden: A file that cannot be seen by users
during a normal directory listing.

v System: A file used by the operating system
that cannot normally be viewed by users.

v Archive: A file that has been backed-up and
the archive bit is turned off. An Archive bit
signifies that the file has been changed since
it was last archived.

v Normal: A file with no special attributes set
to it.

v Temporary: (Windows only) A temporary or
backup copy of a file.

v Sparse: A file with a special kind of
compression that does not take up a lot of
CPU time. The logical size of the file looks
bigger than is actually allocated. It contains
some blank pages which are not on disk.

v Reparse Point: New NTFS file system objects
that have a definable attribute containing
user-controlled data and are used to extend
functionality in the input/output (I/O)
Subsystem.

v Compressed: A file to which a compression
algorithm was applied. This file takes up less
space on disk, but it will be slower to read.

v Offline: A file that was migrated to tape.

v Not Content Indexed: A file that is not
indexed--the Windows indexing service was
told that this is not a file that should be
searched through for text strings.

v Encrypted: A file that was saved with a
password (is password-protected).

v Orphaned: (for Windows, UNIX, and Linux)
The user who owns the file is no longer
present in the system database.
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Condition Description
Method for
filtering the files Condition Modifiers

Attributes
(continued)

v

Block Device: (UNIX/Linux only) A disk
device file (not a real file).

Executable: A file that you can run or
execute.

Sticky: A special type of executable file that is
read into memory when it is first run and
never released. Use Scans to find these types
of files and set them to "unsticky".

SETGID: (UNIX/Linux only, for executable
files) When a file is run, its group changes to
the group of the file. For example, if a user
belongs to User group and runs a file from a
different group (e.g., Root), than the user's
group will be changed to Root while running
the file (for security purposes).

SETUID: (UNIX/Linux only, for executable
files) When a file is run, the user's effective
user will be changed when the file is run. For
example, if a file is SETUID =Root, a users
effective user ID becomes Root when running
the file. This is considered a security hole by
UNIX Administrators, so you can define a
Profile to search for files that have a SETUID
= Root.

Size Use this condition to limit files
based on their physical file size.

v between

v not between

v >=

v <

v >

v <=

v KB (kilobytes)

v MB (megabytes)

v GB (gigabytes)

v TB (terabytes)

Type Use this condition to limit files
based on pre-defined file types.

v in

v not in

v =

v <

v >

v Link

v Directory

v Fifo

v Socket

v Device

Owner Use this condition to limit files
based on their owner.

v matches any of

v matches none of

v between

v not between

v matches

v does not match

v >=

v <

v >

v <=

Enter the name of the owner upon which you
want the condition to be based in the Entry
field.
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Condition Description
Method for
filtering the files Condition Modifiers

Length Use this condition to limit files
based on the logical size of the
files contents.

v between

v not between

v >=

v <

v >

v <=

Enter the file length range. You can qualify both
values by selecting from one of the following:

v KB (kilobytes)

v MB (megabytes)

v GB (gigabytes)

v TB (terabytes)

Associating conditions with groups:

Associate multiple conditions in a group or groups.

Groups can further define your file filter by including or excluding certain files
based on specific criteria.
1. Create a new group using one of the following options.

v In the File Filters tab, right-click a condition and select New Group from the
pop-up menu.
The Create Group dialog box is displayed.

v Create each file condition for your file filter.
As you create a new file condition, the Create Group dialog box is
displayed.

2. Select the grouping for the file conditions you created. The grouped condition
is displayed in the File Filters tab.

Select one of the following groups.

Group Description

All of All inclusive. All the conditions must be met.

For example:

v a and b and c

Any of Any one or more of the following conditions will be met.

For example:

v a or b or c

None of None of the conditions are met.

For example:

v not (a or b or c)

Not all of All of the following conditions are not met.

For example:

v not (a and b and c)

For example, say you want to create a file filter with the following conditions:
v Name in (*.gif, *.jpg)
v Size > 1 MB
v Attribute is Read Only
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How you group the conditions produces different results. The following table
shows the different results depending on the group you select:

File Group Result

A.gif 500KB read only v All of

v Any of

v None of

v Not all of

v False

v True

v False

v True

B.jpg 2 MB read only v All of

v Any of

v None of

v Not all of

v True

v True

v False

v False

C.gif 2 MB read/write v All of

v Any of

v None of

v Not all of

v False

v True

v False

v True

D.txt 500KB read/write v All of

v Any of

v None of

v Not all of

v False

v False

v True

v True

Using wildcards in file filters:

Use wildcard characters within the conditions of file filters to perform pattern
matching of file names. A wildcard is a special symbol that represents one or more
characters.

You can use wildcards in File Filter conditions to identify multiple files and
directories with a single specification. The following table describes the wildcards
that are available inData Manager:

Wildcard Character Description Examples

* Use the asterisk (*) to represent
unknown characters in file
names. It can act as a wildcard
for zero or more characters of
any value within a directory or
file name.

v s* refers to all files that begin
with s

v *.exe refers to all files that have
.exe as an extension

v /user/* refers to all files under the
/user directory

% Use the percent (%) character to
specify a wildcard for a
directories within the path of a
file. It can act as a wildcard for
zero or more directories within a
path.

v /home/%/*.cmd will match all
files with the extension .cmd and
located in any of the
subdirectories under the /home
directory

v /usr/%/* will match all files and
subdirectories under the /usr
directory (for example,
/usr/files/c, /usr/c,
/usr/files/documents/c)
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Wildcard Character Description Examples

? Use the question mark (?) to
represent a character within a file
name or directory name. It can
as a wildcard for a character
within a directory or file name.

v /home/usr?/ will match
directories like: /home/usr1/,
/home/usr2/, etc.

v /usr/temp/temp??.tmp will match
files like /usr/temp/temp01.tmp,
/usr/temp/temp02.tmp, etc.

Data Manager supports standard UNIX shell path name expansion wildcarding
within file filter conditions. See the appropriate UNIX man pages for more
information about the wildcards that you can use.

Determining the availability of storage resources
Use pings to collect information about the availability of the storage resources in
your environment. You can view the information collected by pings in Availability
and System reports.

Pings enable you to monitor and report on the availability of your storage from a
network point of view or from a computer uptime perspective. See the percentage
of off-network time due to network problems or system downtime. Define any
number of pings that each check the availability of a unique storage resource.

Creating pings
Create pings to collect information about the availability of the storage resources in
your environment. You can define any number of pings to gather information
about different storage resources at different times.

To create a ping, complete the following steps:
1. Expand Data Manager > Monitoring > Pings.
2. Right-click Pings A menu is displayed.
3. Select Create Ping.
4. Select the computers whose availability you want to check. “Select computers

to ping” on page 367.
5. Schedule when you want a ping to run. “When to run the ping” on page 367.
6. Specify how often you want the server to write out the ping results to the

database repository for viewing in reports. “Specify ping options” on page 368.

7. Click to save the ping. You must save the ping before Tivoli Storage
Productivity Center can collect data about storage resources.

8. Enter a name for the ping and click OK. An entry for the ping is displayed
under the Pings node in the navigation tree. The ping is run at the date and
time specified in the schedule definition.

9. Use the Job Management panel to manage view information about the runs and
jobs that are related to the ping. For example, use the Job Management panel to
view the status of a run for a schedule, the date and time when it was run, and
the log files of the jobs associated with the run.
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Related reference:
“Managing schedules, jobs, and runs” on page 297
Use the Job Management panel to view and manage all the schedules, runs, and
jobs related to the storage devices that are monitored by IBM Tivoli Storage
Productivity Center.

Select computers to ping:

Select the computers and clusters that you want to ping.

Use the Computers page to select the computers and clusters whose availability
statistics you want to collect. The Available list box shows the computers,
computer groups, or clusters that are currently being monitored and available for
inclusion in the ping. After you include storage resources in the ping it is removed
from this list and moved to the Current Selections list box. The Current Selections
list box shows the computers, computer groups, or clusters that have been selected
for the ping.

Note: A cluster name is displayed next to individual computers that are members
of a PowerHA or Microsoft Cluster Server cluster. Cluster resource groups are
identified with a special icon. Clusters displayed in the Available list box cannot
be expanded to show member nodes. You can move a cluster to the Current
Selections list box to view and, if necessary, exclude member nodes.

You can include individual computers, computer groups, or clusters against which
to run a ping. See “Working with groups of resources” on page 373 for information
about groups.
v To include storage resources in a ping:

1. In the Available list box, highlight the computers, computer groups, and
clusters that you want to include in the ping.

2. Click . The storage resource that you selected is moved to the
Current Selections list box.

v To remove storage resources from a ping:

– Highlight the computers, computer groups, and clusters that you want to

remove and click . The storage resource is removed from the ping and
moved from the Current Selections list box to the Available list box.

v To exclude one or more computers from a selected computer group or cluster:

1. Double click the group or name of the cluster in the Current Selections list
box.

2. Right click the computers that you want to exclude. A menu is displayed.
3. Select Exclude. An Excludes section is created in the Current Selections list

box that displays the names of the computers that you have excluded from
the ping.

When to run the ping:

Schedule when and how often to run a ping.

You have the following options for determining when to run a ping:
v Run the job immediately
v Run the job once at a specified time and date. Use the list boxes to specify the

month, day, year, and the hour, minute, and AM or PM.
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v Run the job repeatedly according to a schedule you specify. You can do the
following:
– Use the list boxes to specify the month, day, year, and the hour, minute, and

AM or PM when the job should begin running.
– Indicate how often the job should run. Use the list boxes to specify the

number of minutes, hours, days, weeks, or months.
– Select which days you wish to run the job.

Use the fields in the How to handle timezones section to indicate the time zone
that Data Manager should use when scheduling and running the ping. For
example, if you selected to run the job at 9:00 AM, you can use the fields in this
section to run it at:
v 9:00 AM of the time zone where the server resides
v 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an agent
located in the PST time zone.

Use the timezone that the server runs in. Select this option to use the time zone of
the location where the Data server resides.

Use this timezone. Select this option to indicate a specific time zone for when to
run the job. Select the timezone from the list provided.

Specify ping options:

Determine how often the results of pings are written from memory and stored in
the database repository.

For greater efficiency, the server temporarily stores ping results in memory. The
unit of time you specify in the Options tab determines how often these results are
externalized to the repository.

You can specify a unit of time in a number of pings, minutes, hours or days.

Define alert values for a ping:

Set an alert that will be triggered if the ping job fails.

Use the Alert page to define an alert to notify you if a computer that a ping is
trying to check is unreachable for a certain amount of time. You can choose to be
notified by SNMP trap, IBM Tivoli Enterprise Console event, login notification,
Windows event log, UNIX Syslog, running a script, and e-mail. If you select SNMP
trap, Tivoli Enterprise Console event, or e-mail, you must also define a destination
(for example, an e-mail address). Define this destination by expanding
Administrative Services > Configuration > Alert Dispositions.

To define an alert for a ping, complete the following steps:
1. Click the Alerts tab; the Alert page opens.
2. Define the conditions that will trigger the alert. The default setting is Computer

Is Unreachable More Than. No other alerting conditions are currently
available. Enter the Value and Value Units. These values specify how many
pings occur before an error is generated. By default, Value Units is set to
Times.
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3. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage Productivity
Center events according to the event definitions specified in the
tivoliSRM.baroc file (provided with the product). It also performs
responses such as sending further notification, creating or updating
trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity Center.
In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.

Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The parameters
listed in the Specify Script window are passed to the script when the
alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

4. Click File > Save to save the ping.
5. Enter a name for the ping and click OK. An entry for the ping appears under

the Pings node.

Editing pings
Change the settings in an existing ping job.

To edit an existing ping, complete the following steps:
1. Expand Data Manager > Monitoring > Pings.
2. Click the name of the ping you want to edit. The content pane displays

information about that job.
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3. Edit the ping definition by changing the values that appear on the following
pages:
v Computers. Use this page to edit the computers, computer groups, and

clusters whose availability you want to monitor as part of a ping.
v When to Run. Use this page to edit when a ping is run.
v Options Use this page to edit how often the results of pings are written from

memory and stored in the database repository.
v Alert. Use this page to edit how long a storage entity is unreachable before

you are notified that the ping has failed.

4. Click to save the updated ping definition.

Data collection groups
Groups enable you to define a set of related resources such as a computer, fabric,
or storage subsystem once and save these selections as a named group for future
use in scans, pings, and probes, making data collection more efficient. For example,
you can create a group that contains a number of related computers. You can then
reference that group within a monitoring job when you want to collect data about
all those computers at the same time.

Each type of group is represented by a node under the Monitoring > Groups and
IBM Tivoli Storage Productivity Center > Monitoring > Probes sections. You can
expand the tree for each type of group to see what groups exist for that type.
Resources can belong to only one group at a time. For example, if a computer
already belongs to a computer group and you attempt to add it to a different
computer group, the system removes it from the first computer group before
adding it to the new computer group (this includes removing it from the default
group if it had never been previously assigned to a user defined group). This is to
prevent a resource from being counted twice statistically.

Additionally, you can use Data Manager for Chargeback to create invoices for these
groups. When implementing your chargeback system, it is recommended that you
group the IT resources within your organization into functional groups. Accurately
identifying the types and locations of your stored data and resources is the first
step in implementing an effective and equitable chargeback policy. Defining groups
with Data Manager enables you to classify your data and resources into billable
entities, which in turn provides information on who is using what storage. This
enables you to bill specific groups according to their usage of storage space.

The following table lists and describes the types of groups that you can create.

Group Type Description

Data Manager

Computer A logical grouping of related computers. A computer can belong to
one computer group only. A computer will automatically be removed
from a group if you add it to another group. You can use computer
groups to monitor computers that are related to each other or belong
to a common group such as a department, location, territory, and so
on.

Examples of computer groups include Sales, Accounting,
Development, IT, West, East, Midwest, NAS Filers, Remote Servers
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Group Type Description

Filesystem A grouping of file systems across multiple computers. A file system
can belong to one file system group only. A file system will
automatically be removed from a group if you add it to another
group.

Here is an example of file system groups: C:\, D:\, /boot, /home, /usr

Directory A grouping of directories across multiple computers. You can include
a directory in multiple directory groups.

Examples of directory groups include:

WindowsTempDir Included Computer Name:Directory -
a:\machine1\winnt\temp, b:\machine2\winnt\temp,
c:\machine3\winnt\temp
Note: To monitor directories from the IBM Tivoli Storage SAN File
Systems, you must create a directory group and add the desired
directories as follows:

/<SAN File System cluster name>/<directory name>

where <SAN File System cluster name> represents the name of the
SAN File System cluster that contains the directory that you want to
add and <directory name> represents the name of the directory you
want to add (for example, /IBM/myFilesetName/myDirectoryName,
/IBM/myDirectoryName.

User A grouping of related users. A user can belong to one user group
only. A user will automatically be removed from a group if you add it
to another group. Users that were discovered by Tivoli Storage
Productivity Center can be included in a user group.
Note: The user groups that you define in Data Manager for
Databases will also available in Data Manager, and vice versa.

Examples of user groups include Administrators, Developers,
Marketing staff, HR staff

OS User Group A grouping of OS user groups that were defined outside of Tivoli
Storage Productivity Center at the operating system level. OS user
groups are the operating system groups that Tivoli Storage
Productivity Center finds that own files and directories in the
environment.

Examples of OS user groups include Windows, Linux, UNIX

Data Manager for Databases

Computer A logical grouping of related computers. A computer can belong to
one computer group only. A computer will automatically be removed
from a group if you add it to another group. You can use computer
groups to monitor computers that are related to each other or belong
to a common group such as a department, location, territory, and so
on.

Examples of computer groups include Sales, Accounting,
Development, IT, West, East, Midwest, NAS Filers, Remote Servers
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Group Type Description

Databases-
Tablespaces

A grouping of RDBMS databases or tablespaces. You can use
database-tablespace groups to monitor entire databases or tablespaces
(depending on the RDBMS) across multiple instances. A database or
tablespace will automatically be removed from a group if you add it
to another group. A database or tablespace can belong to one
database-tablespace group only.

Examples of database-tablespace groups include DB2 databases,
system tablespaces

Table A grouping of related RDBMS tables.

User A grouping of related users. A user can belong to one user group
only. A user will automatically be removed from a group if you add it
to another group. Users that were discovered by Tivoli Storage
Productivity Center can be included in a user group.
Note: The user groups that you define in Data Manager for
Databases will also available in Data Manager, and vice versa.

Examples of user groups include Administrators, Developers,
Marketing staff, HR staff

Disk Manager

Storage Subsystem A storage subsystem group can contain subsystems and SAN Volume
Controllers.

Fabric Manager

Fabric A grouping of fabrics.

Tape Manager

Tape Libraries A grouping of tape libraries.

Default groups
Default groups for each storage resource are also provided within each group type
node. As IBM Tivoli Storage Productivity Center discovers these resources within
your enterprise through discovery, probes, and scans, the resources are
automatically added to the corresponding default groups.

The following table lists the names of the default groups for each group type.

Manager Group Type Default Group Name

Data Manager Computer TPCUser.Default Computer Group

Filesystem TPCUser.Default FS Group

Directory n/a

User TPCUser.Default User Group

OS User
Group

TPCUser.Default OSGroup Group

Data Manager -
Databases

Computer TPCUser.Default Computer Group

Databases-
Tablespaces

TPCUser.Default Tablespace Group

Table n/a

User TPCUser.Default User Group
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Manager Group Type Default Group Name

Disk Manager Storage
Subsystems

TPCUser.Default Storage Subsystem Group

Fabric Manager Fabrics TPCUser.Default Fabric Group

Tape Manager Tape Library TPCUser.Default Tape Group

Working with groups of resources
Create resource groups to logically arrange resources and to permit actions against
the entire group.

Creating a group
You can create named groups that represent a set of resources, such as computers,
databases, table spaces, tables, and users, to later use in pings, scans, and probes.

To create a new group, perform the following steps.
1. Expand Monitoring > Groups. For example, Data Manager > Monitoring >

Groups.
2. Right-click the type of group you want to create and select Create group type,

where group type represents the group you want to create, such as a Create
Computer Group, Create Filesystem Group, or Create Table Group.

3. In the Create group type Groups page, select the resources in the Available
column that you want to include in the group. Hold down the Ctrl key as you
click to select multiple resources.

Note: For computer and file system groups in Data Manager, a Group By
Cluster check box is displayed. When this option is not selected, the Available
pane displays a cluster name next to any clustered computers and cluster
resource groups. When this option is selected, any computer or cluster resource
group that belongs to a PowerHA or MSCS cluster is grouped under its cluster
name. Cluster resource groups are identified with a special icon along with the
name of the current host node. All other computers will be grouped under
Non-Clustered Computers.

4. Click to move the selected resources to the Current Selections column.

Click to move resources from the Current Selections column and move
them to the Available column.

5. Optional: Type a description of the group in the Description field.
6. Click the save icon in the menu bar to save the group.
7. Type a descriptive name for the group and click OK.

Creating tape library groups
Create groups of tape libraries that have similar attributes to make it easier to
perform storage management tasks on the grouped libraries.
1. Expand the Tape Manager > Monitoring > Groups node and right-click Tape

Library.
2. Select Create Tape Library Groups.
3. In the Create Tape Library Groups page, select the libraries in the Available

column to include the libraries in the group.
Hold down Ctrl to click multiple libraries.

4. Click to move selected libraries to the Current Selections column.

Chapter 5. Managing resources in the stand-alone GUI 373



5. Optional: Enter a description of the tape library group in the Description field.

6. Click to type a descriptive name for the group in the Save As dialog.
Then click OK to save the group.

The new tape library group is listed under the Tape Library node in the navigation
tree.

Grouping fabrics
You can group fabrics to run reporting jobs against all the fabrics in the group. A
fabric can belong to multiple groups at a time.

For more information on groups, see “Data collection groups” on page 370.

To create a fabric group, complete the following steps:
1. Expand Fabric Manager > Monitoring > Groups, right-click on Fabric, and

select Create Fabric Group.
2. Enter a description for the group, and from the Available column, select the

fabrics to be added to the group. Move them to the Current Selections column

by clicking .
3. To save the group, click File > Save.
4. In the Save As window, enter the group name and click OK.

Editing groups
When you update the resources that are included within a group, those updates
are automatically picked up by the jobs that reference that group.

To edit an existing group, perform the following steps.
1. Expand Monitoring > Groups. For example, to edit groups within Disk

Manager, expand Disk Manager > Monitoring > Groups > Storage
Subsystem.

2. Expand a group type to view the list of groups defined for that type. For
example, to view storage subsystem groups, expand the Storage Subsystem
node under Disk Manager.

3. Click the name of the group you want to edit. Details for the selected group are
displayed in the Create group type Groups page, where group type is the type
of group (for example, Directory or Computer).

4. Edit the values defined for the group as desired. Click to move the

selected resources to the Current Selections column. Click to move
resources from the Current Selections column and move them to the Available
column.

5. Click the save icon in the menu bar to save the group.

Creating directory groups
Create and use directory groups within scans to monitor and gather information
about specific directories within filesystems across a number of machines.

Note: IBM Tivoli Storage SAN File Systems information: To monitor directories
from the SAN File System, you must create a directory group and add the desired
directories as follows:

/<IBM Tivoli Storage SAN File Systems cluster name>/<directory name>
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where:
v <IBM Tivoli Storage SAN File Systems cluster name> represents the name of

the IBM Tivoli Storage SAN File Systems cluster that contains the directory you
want to add

v <directory name> represents the name of the directory you want to add

Examples:
v /IBM/myFilesetName/myDirectoryName

v /IBM/myFilesetName

v /IBM/myDirectoryName

To create a directory group, perform the following steps.
1. Expand Data Manager > Monitoring > Groups > Directory or click Create

Directory Group from the Directory Groups tab of the Scan window. The
Create Directory Group window opens.

2. Use the New Directory window to edit or add directories to a directory group.

Field Description

Creator Displays the creator of the group.

Name Displays the name of the group you are adding or editing. This name
can be helpful in determining the content of the group. For example,
a directory group named UnixUserHomes might consist of the /home
directory on all the UNIX and Linux computers within an
organization.

Description A description of the group you are adding or editing.

New Computer,
New Directory

Click these buttons to add a directory or computer to the group.

Viewing directory groups:
When adding directories to a group, you can determine how you want to view
groups of directories. You can choose either of the following options:
v Directories by computer. Use this option to display the directories in the

directory group according to the computer on which they exist.
1. Expand Data Manager.
2. Expand Monitoring.
3. Expand Groups.
4. Expand Directory.
5. Double-click a directory object.
6. In the content pane, under View, select Directories by Computer which is the

default setting.

Note: You might need to try more than one directory object to find one with
data.

v Computers by directory. Use this option to display the computers in the group
according to the directories included in the directory group.
1. Expand Data Manager.
2. Expand Monitoring.
3. Expand Groups.
4. Expand Directory.
5. Double-click a directory object.
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6. In the content pane, under View, select Computers by Directory.

Note: You might need to try more than one directory object to find one with
data.

Tip: Choosing these different buttons enables you to add directories to a directory
group in different ways. For example, if you want to monitor or receive alerts on
different directories on multiple computers, choose the Directories by Computer
option. If you want to monitor or receive alerts on the same directory across
multiple computers, choose the Computers by Directory option.

Adding new directories by computer:
If you want to add new directories to a directory group by first selecting the
computers on which they exist, perform the following steps:
1. Select directories by computer on the Create Directory Group window.
2. Click New computer. The Edit Directories for Computer window opens. This

window enables you to select the computer for which you want to monitor
specific directories, and enter the directories for the selected computer.

3. Click the Computer list box.
4. Select the computer for which you want to monitor specific directories.
5. Enter the directory you want to add to the group in the Directories field. For

example: c:\or /home/*.
6. Click Add. The directory is added to the list box.
7. Click OK when you are done adding directories. The New Directory Group

window opens. The computer you added will be displayed as a node in the
display area, with the specified directories under the node.

Adding new computers by directory:
If you want to add new directories to a directory group by first specifying the
directory and then selecting the computers on which they exist, perform the
following steps:
1. Select computers by directory on the Create Directory Group window.
2. Click New computer. The Edit Computers for Directory window opens. This

window enables you to enter the directories you want to add to the directory
group and specify which computers contain those directories.

3. Enter the directory you want to add to the group in the Directory field. For
example: c:\, /home/*, \user\*, \windows\temp\, /usr/*.
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4. Select the computers you want to include in the group and click . The
computer will be displayed in the Current Selections column. Select the All
computers option to include all computers that contain the directory in the
Directory Group.

5. Click OK. The New Directory Group window opens. The directory you added
will be displayed as a node in the display area, with the selected computers
under the node.

Collecting performance data
Use the tasks in this section to collect performance data about your storage
subsystems, fabric switches, and tape libraries.

Monitoring switch performance
You can monitor the performance of those switches in your fabrics from which you
can collect performance data.

Creating a switch performance monitor
You can monitor the performance of selected fabric switches. Fabric Manager can
collect performance data for the switches and generate reports from the results of
those monitors.

Report data is collected on data rates, operations rates, switch port errors, and
other performance statistics. For information about generating those reports, see
“Creating switch performance reports” on page 1003.

Note: A fabric probe is now required after a CIMOM discovery before a switch
performance monitor job can be run.

To create a switch performance monitor, complete the following steps:
1. Expand Fabric Manager > Monitoring, right-click Switch Performance

Monitors, and select Create Switch Performance Monitors.
2. In the Switches tab, enter a description for the performance monitor, and from

the Available column, select the switches to be added to the monitor definition.

Move them to the Current Selections column by clicking .

Note: Only those switches from which Fabric Manager can collect performance
data are listed in the Available column. If a switch is added to a performance
monitor, it is no longer listed as an available switch.

3. In the Sampling and Scheduling tab, specify an interval for the performance
averages, the duration of the data collections, and a schedule for the monitor.
You can begin the monitor immediately, schedule it to begin at a later time, and
specify whether to run the monitor repeatedly.

4. In the Alert tab, specify the action to be taken if the monitor fails. See
“Running scripts with alerts” on page 493 for a description of these triggered
actions.

5. Click to save the performance monitor. You must save the monitor before
Tivoli Storage Productivity Center can collect data about storage resources.
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6. Enter a name for the performance monitor and click OK. An entry for the
monitor is displayed under the Switch Performance Monitors node in the
navigation tree. The monitor is run at the date and time specified in the
schedule definition.

7. Use the Job Management panel to manage view information about the runs and
jobs that are related to the performance monitor. For example, use the Job
Management panel to view the status of a run for a schedule, the date and time
when it was run, and the log files of the jobs associated with the run.

Editing a switch performance monitor
Edit a saved switch performance monitor to change settings, such as which
switches to include in the collection.
1. Expand Fabric Manager > Monitoring > Switch Performance Monitors. There

will be a node for each saved monitor definition.
2. Click the name of the monitor you want to edit.
3. Edit the monitor definition.
4. To save the edited monitor, click Save.

Monitoring storage-subsystem performance
Discover, probe, define performance thresholds, and view performance data and
alerts to monitor a storage system.
1. Configure the storage system for monitoring by IBM Tivoli Storage Productivity

Center. Use one of the following methods based on the storage system connects
with Tivoli Storage Productivity Center:
v To monitor any of the following storage systems, use the Configure Devices

wizard to enter connection information for their native interfaces:
– System Storage DS8000
– SAN Volume Controller
– The XIV system
– Storwize V7000
– Storwize V7000 Unified
– IBM SONAS

v To monitor storage systems that use CIM object manager (CIMOM)
connections, there are a number of ways to enter the connection information
into Tivoli Storage Productivity Center. If the CIMOM is in the same subnet
as the Device server, it can be discovered through Service Location Protocol
(SLP). You can manually add the CIMOM to Tivoli Storage Productivity
Center by expanding the Administrative Services > Data Sources node and
clicking CIMOM Agents. See Adding a CIM agent manually for details of
how to add the CIMOM. Alternatively, you can also use the Configure
Devices wizard to enter the CIMOM information.

2. Discover the storage system.
Discovery gets general information about the devices that affiliated with the
CIMOMs. These devices are switches and other storage systems such as IBM
System Storage DS5000 and other DS series systems, and IBM TotalStorage
Enterprise Storage Server. You can run discovery for CIMOMs by expanding
the Administrative Services > Discovery > CIMOM node. Alternatively, you
can also use the Configure Devices wizard to run discovery for CIMOMs.
The discovery step is not required for the storage systems that are connected to
Tivoli Storage Productivity Center using native interfaces.

3. Probe the storage system.
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Probes collect information about logical devices, such as volumes and virtual
disks, that are associated with the storage system. Probes also collect
information about hosts that are mapped to the logical devices.
If you use the Configure Devices wizard, storage subsystems are included
automatically in probes. To create probes manually, expand IBM Tivoli Storage
Productivity Center > Monitoring > Probes. For Data Manager for Databases,
expand Data Manager for Databases > Monitoring > Probes.

4. Define storage-system performance thresholds.
Thresholds draw your attention to exceptions to normally expected values in
the data that you collect.

5. Collect storage-system performance data.
Collect performance data for an individual storage system.

6. View storage system performance data.
Related information:
For details of how to use the Configure Devices wizard to enter connection
information for any of the storage systems that connect to Tivoli Storage
Productivity Center using native interfaces, see “Configuring storage subsystems”
on page 308.

Creating storage subsystem performance monitor
Create a subsystem performance monitor to gather performance data for storage
systems.

Note: If you schedule a performance monitor to collect data about a storage
subsystem at the same time you plan to create many volumes on that subsystem,
the performance of the volume creation job and the general performance of the
associated CIMOM might decrease. Consider scheduling a performance monitoring
job at a different time than when you plan to create many volumes on a
subsystem.

Complete the following steps to collect performance data for a storage system:
1. In the navigation tree pane, expand Disk Manager → Monitoring.
2. Right-click Subsystem Performance Monitor and click Create Performance

Monitor.
The Create Storage Subsystem Performance Monitor window opens in the
content pane.

3. Optional: In the Description field, type a description of the threshold.
4. Click the Storage Subsystems tab. The Storage Subsystems page is displayed

and all storage subsystems that have been discovered are listed.
5. In the Available subsystems field, click storage subsystems to select them for

collection. Then click .
The selected storage subsystems are displayed in the Current selections field.

6. Verify that you have created and run a probe for each selected storage
subsystem, as described in “Creating probes” on page 338.
Storage-subsystem reports use data gathered by probes, including data on
storage assets in the enterprise, such as computers, storage subsystems, disk
controllers, hard disks, and file systems. Data collection fails if a selected
system has not yet been probed.

7. Click the Sampling and Scheduling tab. The Sampling and Scheduling page
is displayed.
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8. In the Sampling area, specify the length of the sampling window and how
frequently the performance data is gathered.
a. In the Interval length field, select the length of the sampling window.

The interval length is the number of minutes over which performance data
is averaged. For example, if you select 15 minutes, all performance-data
samples gathered from the storage subsystem represent an average of the
performance of the subsystem over the previous 15 minute interval.

b. In the Duration field, specify how long the monitoring task will run.
You can specify that the task runs indefinitely or specify the length of time
that the performance data is gathered.

c. In the Scheduling area, click either Begin immediately or Schedule to
begin later.
If you click Schedule to begin later, specify the data and time that you
want to the data collection to start. You also can specify that the data
collection recurs, how frequently it recurs, and whether certain days of the
week are excluded.

Important: When you specify a start time for using performance monitor
data in a plan, a report, or an optimization plan, the start time might not
coincide with the start of a performance monitor data collection interval. If
the requested start time is after the start of a data collection interval and
the duration of the data collection interval is long enough so that it ends at
or after the requested start time, Tivoli Storage Productivity Center
includes all data from the collection interval that began before the
requested start time. This might include data collected before the start time
that you specified. This processing ensures that the maximum amount of
available performance data is utilized. For example, if a performance
monitor collects data every 20 minutes starting at 01:00, but you request
performance data starting at 1:15, Tivoli Storage Productivity Center still
analyzes performance data starting at 01:00 that has a duration of 20
minutes.

9. Click the Alert tab. The Alert page is displayed. In the Condition area
Monitor Failed is the triggering condition.

10. In the Triggered Actions area, select actions to trigger when the data
collection task fails.
You can select from the following check boxes:
v SNMP Trap

v TEC / OMNIbus Event

v Login Notification

v Windows Event Log

v Run Script

v Email

Depending on what action you select, you might have other choices to make.
Suppose that you select the Windows Event Log check box, for example. The
Event Type field becomes activate to specify a severity for the event in the
Windows event log.

11. Click File → Save. You must save the performance monitor before Tivoli
Storage Productivity Center can collect data about storage resources.

12. Enter a name for the performance monitor and click OK.
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An entry for the monitor is displayed under the Subsystem Performance
Monitors node in the navigation tree. The monitor is run at the date and time
specified in the schedule definition.

13. After the monitoring job completes, expand the name of the
storage-subsystem performance monitor.
The following information is displayed:
v A status icon that indicates whether the task completed successfully
v Number of times that the task ran
v Date that the task ran
v Time that the task began

14. To view additional information, click the task information.
In the content pane, the following additional information is displayed:
v Time that the task finished
v Number of jobs in the task
v Number of jobs that failed
A table contains information about the storage subsystems in the data
collection.

15. In the table, click a storage subsystem, and then click to display the
contents of the log file.

16. Use the Job Management panel to manage view information about the runs
and jobs that are related to the monitor. For example, use the Job Management
panel to view the status of a run for a schedule, the date and time when it
was run, and the log files of the jobs associated with the run.
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Example log file

The following example is a log file for a SAN Volume Controller:

Job log file: <Location of log file>
<date><time>HWNPM21131 The performance monitor for device
<name> (<IP address>:<?>) is starting in an active state
<date><time>HWNPM21151 Monitor Policy:name="svcProbe",
creator="administrator", description=""
<date><time>HWNPM21161 Monitor Policy:retention period:
sample data=14 days,hourly data=30 days,daily data=90 days
<date><time>HWNPM21171 Monitor Policy:interval length=900 secs,
frequency=900 secs, duration=1 hours
<date><time>HWNPM21181 Threshold Policy:name=
"Default Threshold Policy for SVC",creator="System",
description="Current default performance threshold policy for
SAN Volume Controller"
<date><time>HWNPM21191 Threshold Policy:retention period:
exception data=14 days
<date><time>HWNPM21201 Threshold Policy:threshold name=
Total I/O Rate Threshold,enabled=no,boundaries=-1,-1,-1,-1 ops/sec
<date><time>HWNPM21201 Threshold Policy:threshold name=
Total Data Rate Threshold,enabled=no,boundaries=-1,-1,-1,-1 MB/sec
<date><time>HWNPM21201 Threshold Policy:threshold name=
Total Backend I/O Rate Threshold,enabled=no,boundaries=3,2,1,0 ops/sec
<date><time>HWNPM21201 Threshold Policy:threshold name=
Total Backend Data Rate Threshold,enabled=yes,boundaries=3,2,1,0 MB/sec
<date><time>HWNPM21201 Threshold Policy:threshold name=
Overall Backend Response Time Threshold,enabled=yes,
boundaries=-1,-1,-1,-1 ms/sec
<date><time>HWNPM02001 This operation (startPerfCollection())
on Performance Manager was successful.
<date><time>HWNPM22001 Successfully retrieved the configuration
data for the storage system.
Found 1 I/O Groups,2MDisk Groups,25MDisks, and 1 VDisk
<date><time>HWNPM21231 Performance data was collected and processed
successfully.
27 performance data records were inserted into the database.
<date><time>HWNPM21231 Performance data was collected and processed
successfully.
54 performance data records were inserted into the database.
<date><time>HWNPM21261 The performance monitor for device
<name> (<IP address>:<?>) is stopping because its
intended duration has elapsed.

Descriptions of variables in the log file include:
v <date> is the date, for example, 1/23/06.
v <time> is the time, for example, 12:45:20 PM.
v <name> is the device ID of the storage subsystem, for example,

SVC-2145-RedC3-IBM.
v <IP address> is the IP address of the storage subsystem, for example, 9.47.97.159.

This log also provides the following information:
v The monitoring task was targeted against a single SAN Volume Controller,

SVC-2145-RedC3-IBM.
v The name of the monitoring task is svcProbe, and it was created by a user with

an ID administrator.
v The retention period for exception data.
v The user had provided the following values for the task: interval length:

sampling window of 900 seconds (15 minutes) and duration of one hour.
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v The monitoring task successfully retrieved the configuration data from the SAN
Volume Controller. The task associated the following logical entities with the
SAN Volume Controller:
– One I/O group
– Two managed-disk groups (MDisk groups)
– 25 managed disks (MDisks)
– One virtual disk (VDisk)

v The monitoring task successfully collected and processed data for two
performance metrics. A total of 81 performance records were written to the
database.

v The monitoring task stopped when its duration (one hour) had elapsed.

Editing a storage-subsystem performance monitor
Edit a storage-subsystem performance monitor.

Complete the following steps to edit storage subsystem performance monitor:
1. In the left-hand pane, expand Disk Manager > Monitoring > Subsystem

Performance Monitors. The list of existing subsystem performance monitors is
displayed.

2. Click the monitor that you want to edit. The Edit Subsystem Performance
Monitor window opens.
The Create Storage Subsystem Performance Monitor window opens in the
right-hand pane.

3. Make any necessary changes.
4. Click File → Save.

Monitoring tape libraries
Monitor the performance of tape libraries to be aware of events that occur, and to
respond to alerts.
1. Create one or more tape library groups, as described in “Creating tape library

groups” on page 373.
2. Create a probe job to collect data about your tape libraries and library groups,

as described in “Creating tape library probes” on page 340.
3. View alerts that are generated by your tape libraries, as described in “Viewing

alert logs” on page 403.

Viewing performance data
View collected performance data and recognized threshold exceptions in various
user-friendly formats to stay aware of usage trends and exceptions.

Display data in a tabular format (actual values of the collected metrics), a graphical
format (primarily as line-graphs), or export the data to a file. Select whether recent
data, historical data, or information about threshold exceptions (constraint
violations) is displayed.

Select a device or a device component, select a particular metric, and specify a time
range to plot the data over the time range.

Use constraint violation reports to view a list of any threshold exceptions that
occurred during a particular time range. Bar graphs of exceptions are commonly
used to show the total number of threshold violations.
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Viewing storage-subsystem performance data
View collected storage-subsystem performance data and recognized threshold
exceptions to stay aware of storage-subsystem usage trends and exceptions.
1. In the navigation tree, expand Disk Manager → Reporting → Storage

Subsystem Performance.
A list of reports is displayed under Storage Subsystem Performance node.
The following reports generate information concerning SAN Volume
Controller models:
v By Storage Subsystem
v By Controller
v By I/O Group
v By Module/Node
v By Array
v By Managed Disk Group
v By Volume
v By Managed Disk
v By Port
v Constraint Violations

2. Click By I/O Group to view information about I/O groups.
In the content pane, the Selection page is displayed. By default, all applicable
performance metrics are selected for inclusion in the report.

3. Select the data or performance metrics that you want to exclude from the
report in the Included Columns field. See “Performance metrics” on page
1468 for a list of performance metrics.
a. Click the items that you want to exclude from the report.

b. Click .
Excluded items are displayed in the Available Columns field.

c. Select a metric and click either or to change the
order of the selected metric in the report.

4. Type the number of I/O groups to include in the report, in the Return
maximum of field.
Limit the number of I/O groups to reduce the amount of performance
information in the report. By default, this value is set to 2500.

5. Click Selection to open the Select Resources window.
6. Select check boxes to select I/O groups for the report, then click OK.
7. Click Filter to open the Edit Filter window.
8. Specify filter conditions for the report.
9. Click Generate Report.

An I/O Group page opens and the report is displayed.
10. Optional: View the report in chart format.

a. Click , to specify charting options, then click OK.
b. Click Customize this chart to further customize the chart.
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11. Optional: Click and type a name to save the report settings for future
use.
The report is saved under the IBM Tivoli Storage Productivity Center node.

Viewing tape library information
View collected tape library data to stay aware of discovered tape libraries and
usage information.
v Click Tape Manager. Left-click Tape Libraries. In the content pane, the Tape

Libraries page is displayed, which lists the discovered tape libraries.
Select a library from the table and then click one of the buttons to see further
details about that library. For example, select a library and click Drives to open
a page that lists all the drives for that library.
You can also right-click a library in the Tape Libraries table and select View
Details.

v Use the View Details feature in the topology viewer, as described in “Working
with tape libraries in the topology viewer” on page 539.

Working with alerts
Create an alert, configure how the alert is publicized, or edit, delete, disable,
rename, or view an alert.
Related reference:
“Performance thresholds” on page 1457
Performance thresholds are triggering conditions which are used to monitor a
component with user-defined values.

Creating alerts
You can define alerts so that IBM Tivoli Storage Productivity Center notifies you
when a specified event occurs. The specific triggering conditions that you can use
depend on the type of storage resource that you are monitoring.

Note: Alerts are not generated in a Tivoli Storage Productivity Center instance for
actions that you perform from that instance. For example, if you start Tivoli
Storage Productivity Center and use Disk Manager to assign or unassign volumes
for a subsystem, you will not receive alerts for those volume changes in that
instance. However, if you assign and unassign volumes outside of that Tivoli
Storage Productivity Center instance, an alert is generated.
Related reference:
“Performance thresholds” on page 1457
Performance thresholds are triggering conditions which are used to monitor a
component with user-defined values.

Creating computer alerts
You can use these alerts to monitor computers for changes in configuration or
status. When a condition is detected during a probe, an alert is generated.
Computer alerts can be applied to computers, computer groups, and clusters.

If necessary, complete the following prerequisites before you begin the task:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
v If you want to use Simple Network Management Protocol (SNMP) traps, IBM

Tivoli Enterprise Console events, or e-mail as an alert notification, you must
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specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

To create a computer alert, complete the following steps:
1. In the Navigation Tree pane, expand Data Manager > Alerting.
2. Right-click Computer Alert and click Create Alert. The Create Alert window

opens and the Alert page is displayed.
3. Select the Enabled check box.
4. In the Description field, type a brief description of the job.
5. In the Triggering-Condition area, specify the event that will trigger the alert:

a. In the Condition field, select the triggering condition.
b. In the Value field, type a numeric value. Depending on the triggering

condition that you selected, this field might be unavailable.
c. In the Value Units field, select the unit of measurement. Depending on the

triggering condition that you selected, this field might be unavailable.
6. In the Triggered-Actions pane, select the actions that occur as a result of the

triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

7. Click the Computer tab; the Computers page opens.
8. Select the resources to which you want the alert to apply:

a. In the Available field, click the resources.

b. Click . The resources are moved to the Current Selections field.
9. Save the alert:

a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert name

field and click OK. The alert is displayed in the navigation tree.

Creating directory alerts
You can use these alerts to be notified when either a directory is not found or a
directory consumes more than a specified amount of storage space. When a
condition is detected during a scan, an alert is generated. These alerts can be
applied to directories only.

Before you can create a directory alert, you must have completed the following
prerequisites:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
v If you want to use Simple Network Management Protocol (SNMP) traps, IBM

Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

v Directories must be grouped into a directory group before they can be included
in an alert.

To create a directory alert, complete the following steps:
1. In the Navigation Tree pane, expand Data Manager > Alerting

2. Right-click Directory Alert and click Create Alert. The Create Alert window
opens and the Alert page is displayed.

3. Select the Enabled check box.
4. In the Description field, type a brief description of the job.
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5. In the Triggering-Condition area, specify the event that will trigger the alert:
a. In the Condition field, select the triggering condition.
b. In the Value field, type a numeric value. Depending on the triggering

condition that you selected, this field might be unavailable.
c. In the Value Units field, select the unit of measurement. Depending on the

triggering condition that you selected, this field might be unavailable.
6. In the Triggered-Actions pane, select the actions that occur as a result of the

triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

7. Click the Directories tab; the Directories windows opens.
8. Select the resources to which you want the alert to apply:

a. In the Available field, click the resources.

b. Click . The resources are moved to the Current Selections field.
9. Save the alert:

a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert name

field and click OK. The alert is displayed in the navigation tree.

Creating file system alerts
You can use these alerts to monitor file systems for available free space, changes in
configuration, or a file system being removed or unmounted. When the condition
is detected during a scan, a probe, or upon an SNMP event, an alert is generated.

If necessary, complete the following prerequisites before you begin the task:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
v If you want to use Simple Network Management Protocol (SNMP) traps, IBM

Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

File system alerts can be applied to file systems, file system groups, computers,
computer groups, storage systems, storage system groups, and clusters. To create a
file system alert, complete the following steps:
1. In the navigation tree, expand Data Manager > Alerting.
2. Right-click Filesystem Alert, and then click Create Alert. The Create Alert

panel opens and the Alert page is displayed.
3. Select the Enabled check box.
4. In the Description field, type a brief description of the job.
5. In the Triggering-Condition area, specify the event that will trigger the alert:

a. In the Condition field, select the triggering condition.
b. In the Value field, type a numeric value. Depending on the triggering

condition that you selected, this field might be unavailable.
c. In the Value Units field, select the unit of measurement. Depending on the

triggering condition that you selected, this field might be unavailable.
6. In the Triggered-Actions pane, select the actions that occur as a result of the

triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

7. Click the Filesystems tab; the Filesystems window opens.
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8. Select the resources to which you want the alert to apply:
a. In the Available field, click the resources.

b. Click . The resources are moved to the Current Selections field.
9. Save the alert:

a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert name

field and click OK. The alert is displayed in the navigation tree.

Creating other NAS alerts
You can use other network-attached storage (NAS) alerts to monitor systems that
include NAS and are not included in other alert types. When a change in
configuration or status is detected during a probe or from an SNMP event, an alert
is generated.

If necessary, complete the following prerequisites before you begin the task:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
v If you want to use Simple Network Management Protocol (SNMP) traps, IBM

Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

Other NAS alerts can be applied to NAS clusters, nodes, storage systems, and
storage system groups. To create a NAS alert, complete the following steps:
1. In the navigation tree, expand Data Manager > Alerting.
2. Right-click Other NAS Alerts, and then click Create Alert. The Create Alert

panel opens and the Alert page is displayed.
3. Select the Enabled check box.
4. In the Description field, type a brief description of the job.
5. In the Triggering-Condition area, specify the event that will trigger the alert:

a. In the Condition field, select the triggering condition.
b. In the Value field, type a numeric value. Depending on the triggering

condition that you selected, this field might be unavailable.
c. In the Value Units field, select the unit of measurement. Depending on the

triggering condition that you selected, this field might be unavailable.
6. In the Triggered-Actions pane, select the actions that occur as a result of the

triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

7. Click the NAS tab; the NAS page opens.
8. Select the resources to which you want the alert to apply:

a. In the Available field, click the resources.

b. Click . The resources are moved to the Current Selections field.
9. Save the alert:

a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert name

field and click OK. The alert is displayed in the navigation tree.
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Creating instance alerts
You can use these alerts to monitor instances for changes. When the condition is
detected during a probe, an alert is generated. These alerts can be applied to
instances, computers, and computer groups.

If necessary, complete the following prerequisites before you begin the task:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
v If you want to use Simple Network Management Protocol (SNMP) traps, IBM

Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

To create an instance alert, complete the following steps:
1. From the Navigation Tree pane, expand Data Manager for Databases >

Alerting.
2. Right-click Instance Alerts and click Create Alert.. The Create Alert window

opens and the Alert page is displayed.
3. Select the Enabled check box.
4. In the Description field, type a brief description of the job.
5. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Rdbms Type field, select the type of database application. You can
choose All Rdbms, Oracle, SQL\Server, Sybase, or UDB.

b. In the Condition field, select the triggering condition.
c. In the Value field, type a numeric value. Depending on the triggering

condition that you selected, this field might be unavailable.
d. In the Value Units field, select the unit of measurement. Depending on the

triggering condition that you selected, this field might be unavailable.
6. In the Triggered-Actions pane, select the actions that occur as a result of the

triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

7. Click the Instances tab; the Instances window opens.
8. Select the resources to which you want the alert to apply:

a. In the Available field, click the resources.

b. Click . The resources are moved to the Current Selections field.
9. Save the alert:

a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert name

field and click OK. The alert is displayed in the navigation tree.

Creating database and tablespace alerts
You can use these alerts to monitor database and tablespaces for changes. When a
scans or probes are run, events are recognized and alerts triggered. These alerts
can be applied to databases, database groups, table spaces, table space groups,
instances, computers, and computer groups.

If necessary, complete the following prerequisites before you begin the task:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
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v If you want to use Simple Network Management Protocol (SNMP) traps, IBM
Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

Note: (DB2 only) Alerts triggered by table and user statistics will not function
until the runstats utility is run. This utility ensures that table and user statistics are
up-to-date. When you define a scan job for DB2 databases, select the Perform
runstats on all tables being scanned check box on the Options page.

Note: (DB2 only) When the following conditions apply, an alert is not generated:
v The triggering condition selected is Database-Tablespace Free Space Less Than.
v The storage entities selected are DB2 databases.
v The table spaces affected by the triggering condition are System Managed Space

(SMS) tablespaces.

The alert is not triggered because IBM Tivoli Storage Productivity Center considers
SMS containers to be directories on a file system

To create a database-table space alert, complete the following steps:
1. From the Navigation Tree pane, expand Data Manager for Databases >

Alerting.
2. Right-click Database-Tablespace Alerts and click Create Alert.. The Create

Alert window opens and the Alert page is displayed.
3. Select the Enabled check box.
4. In the Description field, type a brief description of the job.
5. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Rdbms Type field, select the type of database application. You can
choose All Rdbms, Oracle, SQL\Server, Sybase, or UDB.

b. In the Condition field, select the triggering condition.
c. In the Value field, type a numeric value. Depending on the triggering

condition that you selected, this field might be unavailable.
d. In the Value Units field, select the unit of measurement. Depending on the

triggering condition that you selected, this field might be unavailable.
6. In the Triggered-Actions pane, select the actions that occur as a result of the

triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

7. Click the Databases-Tablespaces tab; the Databases-Tablespaces window
opens.

8. Select the resources to which you want the alert to apply:
a. In the Available field, click the resources.

b. Click . The resources are moved to the Current Selections field.
9. Save the alert:

a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert name

field and click OK. The alert is displayed in the navigation tree.

Creating table alerts
You can use these alerts to monitor tables for certain conditions. When the
condition is detected during a scan, an alert is generated. These alerts can be
applied to table groups and tables only.
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v If you want a script to be run after an event has triggered an alert, you must
create the script before you create the alert.

v If you want to use Simple Network Management Protocol (SNMP) traps, IBM
Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

v Tables must be grouped into a table group before they can be included in an
alert.

To create a table alert, complete the following steps:
1. From the Navigation Tree pane, expand Data Manager for Databases >

Alerting.
2. Right-click Table Alerts and click Create Alert.. The Create Alert window

opens and the Alert page is displayed.
3. Select the Enabled check box.
4. In the Description field, type a brief description of the job.
5. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Rdbms Type field, select the type of database application. You can
choose All Rdbms, Oracle, SQL\Server, Sybase, or UDB.

b. In the Condition field, select the triggering condition.
c. In the Value field, type a numeric value. Depending on the triggering

condition that you selected, this field might be unavailable.
d. In the Value Units field, select the unit of measurement. Depending on the

triggering condition that you selected, this field might be unavailable.
6. In the Triggered-Actions pane, select the actions that occur as a result of the

triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

7. Click the Tables tab; the Tables window opens.
8. Select the resources to which you want the alert to apply:

a. In the Available field, click the resources.

b. Click . The resources are moved to the Current Selections field.
9. Save the alert:

a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert name

field and click OK. The alert is displayed in the navigation tree.

Creating fabric alerts
You can use these alerts to monitor fabrics for changes. When the condition is
detected during a probe, an alert is generated. These alerts can be applied to
fabrics, zones, and zone sets.

If necessary, complete the following prerequisites before you begin the task:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
v If you want to use Simple Network Management Protocol (SNMP) traps, IBM

Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

1. In the Navigation Tree pane, expand Fabric Manager > Alerting.
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2. Right-click Fabric Alert and click Create Fabric Alerts. The Create Fabric Alerts
window opens and the Alert page is displayed.

3. Select the Enabled check box.
4. In the Description field, type a brief description of the job.
5. In the Triggering Condition area, specify the event that will trigger the alert.
6. In the Triggered-Actions pane, select the actions that occur as a result of the

triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

7. Click the Fabrics tab; the Fabrics page opens.
8. Select the resources to which you want the alert to apply:

a. In the Available field, click the resources.

b. Click . The resources are moved to the Current Selections field.
9. Save the alert:

a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert name

field and click OK. The alert is displayed in the navigation tree.

Creating storage system alerts
You can use storage systems alerts to monitor systems for changes in configuration
or status. When the condition is detected during a probe, an alert is generated.
These alerts can be applied to storage subsystem groups and storage subsystems.

If necessary, complete the following prerequisites before you begin the task:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
v If you want to use Simple Network Management Protocol (SNMP) traps, IBM

Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

To create a storage subsystem alert, complete the following steps:
1. Expand the Disk Manager > Alerting node in the navigation tree.
2. Right-click Storage Subsystem Alerts, and click Create Storage Subsystem

Alert. The Create Storage Subsystem Alert window is opened.
3. In the Description field, type a brief description of the job.
4. Select the Enabled check box.
5. In the Triggering Condition pane, specify the event that will trigger the alert:

a. In the Condition field, select the triggering condition. See “Triggering
conditions for alerts” on page 1439 for a list of triggering conditions that
are available for each alert type.

b. If you selected a performance threshold, specify the thresholds:
1) In the Critical Stress field, type the upper-threshold boundary. When

this boundary is exceeded, a critical condition is recognized.
2) In the Warning Stress field, type the upper-threshold boundary. When

this boundary is exceeded, a warning condition is recognized.
3) In the Warning Idle field, type the lower-threshold boundary. When

the value falls under this boundary, a warning condition is recognized.
4) In the Critical Idle field, type the lower-threshold boundary. When the

value falls under this boundary, a critical condition is recognized.
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For more information about thresholds, see “Performance thresholds” on
page 1457.

6. In the Alert Suppression pane, choose the condition under which alerts are
triggered, and then choose how to manage repeating alerts. For an explanation
of the options in this pane, see “Alert suppression actions” on page 1453.

7. In the Triggered-Actions pane, select the actions that occur as a result of the
triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

8. Click the Storage Subsystems tab. The Storage Subsystems page is displayed.
9. Select the storage systems and storage system groups to which you want the

alert to apply:
a. In the Available field, click the storage entities.

b. Click . The storage entities are moved to the Current Selections
field.

10. Save the alert:
a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert

name field and click OK. The alert is displayed in the navigation tree.

Creating switch alerts
You can use these alerts to monitor switches for changes in configuration or status.
When the condition is detected during a probe, an alert is generated. These alerts
can only be applied to switches.

If necessary, complete the following prerequisites before you begin the task:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
v If you want to use Simple Network Management Protocol (SNMP) traps, IBM

Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

To create a switch alert, complete the following steps:
1. In the Navigation Tree pane, expand Fabric Manager > Alerting.
2. Right-click Switch Alerts and click Create Switch Alerts. The Create Switch

Alerts page opens and the Alert page is displayed.
3. Select the Enabled check box.
4. In the Description field, type a brief description of the job.
5. In the Triggering Condition pane, specify the event that will trigger the alert:

a. In the Condition field, select the triggering condition. See “Triggering
conditions for alerts” on page 1439 for a list of triggering conditions that
are available for each alert type.

b. If you selected a performance threshold, specify the thresholds:
1) In the Critical Stress field, type the upper-threshold boundary. When

this boundary is exceeded, a critical condition is recognized.
2) In the Warning Stress field, type the upper-threshold boundary. When

this boundary is exceeded, a warning condition is recognized.
3) In the Warning Idle field, type the lower-threshold boundary. When

the value falls under this boundary, a warning condition is recognized.
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4) In the Critical Idle field, type the lower-threshold boundary. When the
value falls under this boundary, a critical condition is recognized.

For more information about thresholds, see “Performance thresholds” on
page 1457.

6. In the Alert Suppression pane, choose the condition under which alerts are
triggered, and then choose how to manage repeating alerts. For an explanation
of the options in this pane, see “Alert suppression actions” on page 1453.

7. In the Triggered-Actions pane, select the actions that occur as a result of the
triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

8. Click the Switches tab. The Switches page is displayed.

Note: If you selected a performance threshold as the triggering condition,
only those switches for which performance data can be collected are listed.

9. Select the storage entities to which you want the alert to apply:
a. In the Available field, click the storage entities.

b. Click . The storage entities are moved to the Current Selections
field.

Note: You can select one or more switches from the Switches category. For
device triggering conditions only, you can select one or more fabrics from the
Switches In Fabric category. Selecting fabrics will include all switches in those
fabrics. You can also select from both categories.

10. Save the alert:
a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert

name field and click OK. The alert is displayed in the navigation tree.

Creating endpoint device alerts
You can use these alerts to monitor endpoint devices. When the condition is
detected during a probe, an alert is generated. These alerts can be applied to
endpoint devices only.

If necessary, complete the following prerequisites before you begin the task:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
v If you want to use Simple Network Management Protocol (SNMP) traps, IBM

Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

To create an endpoint device alert, complete the following steps:
1. In the Navigation Tree pane, expand Fabric Manager > Alerting.
2. Right-click Endpoint Device Alerts and click Create Endpoint Device Alerts.

The Create Endpoint Device Alerts window opens and the Alert page is
displayed.

3. Select the Enabled check box.
4. In the Description field, type a brief description of the job.
5. In the Triggering Condition area, specify the event that will trigger the alert.
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6. In the Triggered-Actions pane, select the actions that occur as a result of the
triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

7. Click the Endpoint Devices tab; the Endpoint Devices page opens.
8. Select the resources to which you want the alert to apply:

a. In the Available field, click the resources.

b. Click . The resources are moved to the Current Selections field.
9. Save the alert:

a. Click File > Save.
b. In the Save As window, type a name for the alert in the Specify Alert name

field and click OK. The alert is displayed in the navigation tree.

Database connection alerts
Database connection alerts notify the Tivoli Storage Productivity Center
administrator when the database connection used by the Tivoli Storage
Productivity Center server is lost unexpectedly and when the database connection
is restored.

If necessary, complete the following prerequisites before you begin the task:
v If you want a script to be run after an event has triggered an alert, you must

create the script before you create the alert.
v If you want to use Simple Network Management Protocol (SNMP) traps, IBM

Tivoli Enterprise Console events, or e-mail as an alert notification, you must
specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

The database connection alerts are always enabled and configured to add the alert
to the alert log and send an e-mail to the data administrator.

The database connection alerts are:
v DB connection failed
v DB connection successful

You cannot create, configure, delete, disable, edit, or rename these alerts. You can,
however, change the destination for the database connection alerts. Expand
Administrative Services > Configuration. Left-click Alert Disposition. In the
content pane, under Email, you can change all of the fields.

Configuring alert destinations
Entries in the Alert Disposition window define destination host addresses for
SNMP, IBM Tivoli Enterprise Console, and e-mail.

If you want to send SNMP traps, IBM Tivoli Enterprise Console events, or e-mail
when an alert is triggered, you must configure IBM Tivoli Storage Productivity
Center with the alert destinations and e-mail settings.

To configure alert dispositions, complete the following steps:
1. In the Navigation Tree pane, expand Administrative Services > Configuration.

2. Click Alert Disposition. The Edit Alert Disposition window opens.
3. In the SMNP area, specify the information about where SNMP traps are sent:
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a. In the Community field, type the name of the SNMP community. By
default, this is set to public.

b. In the Host field, type the fully qualified name of the system that you have
configured to receive SNMP traps.

c. In the Port field, type the port number to which Tivoli Storage Productivity
Center will direct SNMP traps. By default, this is set to 162.

d. If you want to configure a second SNMP destination, type the required
information in the fields in the SNMP Destination 2 area.

4. In the TEC area, specify information about where Tivoli Enterprise Console
events are sent:
a. In the Server field, type the fully qualified name of the Tivoli Enterprise

Console server.
b. In the Port field, type the port number to which Tivoli Storage Productivity

Center will direct Tivoli Enterprise Console events. By default, this is set to
5529.

5. In the Email area, configure e-mail settings:
a. In the Mail Server field, type the name of the mail server.
b. In the Mail Port field, type the port number for the SMTP server.
c. In the Default Domain field, type the domain, for example,

MyCompany.com.
d. In the Return to field, type the e-mail address to which undeliverable mail

is sent.
e. In the Reply to field, type the e-mail address to which e-mail is sent when

someone replies to an e-mail notification about an alert. (It is a best practice
to specify the e-mail address of an Tivoli Storage Productivity Center
administrator.)

f. In the Data Administrator field, type the e-mail address of the Data
Administrator.

6. In the Alert Log Disposition field, select the length of time to keep entries in
the alert logs. The default is 90 days.

Deleting alerts
To ensure that the list of alerts in the navigation tree is up-to-date, you can delete
alerts that you no longer want to implement.

To delete an alert, complete the following steps:
1. In the navigation tree, complete one of the following actions:

Alert type Action

For computer alerts Expand Data Manager > Alerting >
Computer Alerts.

For file system alerts Expand Data Manager > Alerting >
Filesystem Alerts.

For directory alerts Expand Data Manager > Alerting >
Directory Alerts.

For hypervisor alerts Expand Data Manager > Alerting >
Hypervisor Alerts

For other NAS alerts Expand Data Manager > Alerting > Other
NAS Alerts
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For instance alerts Expand Data Manager for Databases >
Alerting > Instance Alerts.

For database-tablespace alerts Expand Data Manager for Databases >
Alerting > Database-Tablespace Alerts.

For table alerts Expand Data Manager for Databases >
Alerting > Table Alerts.

For storage subsystem alerts Expand Disk Manager > Alerting > Storage
Subsystem Alerts.

For fabric alerts Expand Fabric Manager > Alerting > Fabric
Alerts.

For switch alerts Expand Fabric Manager > Alerting > Switch
Alerts.

For endpoint device alerts Expand Fabric Manager > Alerting >
Endpoint Device Alerts.

The list of existing alerts is displayed.
2. Right-click the alert and click Delete. The Delete Alert window opens.

Tip: If Delete is not available, you do not have authority to delete the alert.
3. Click Yes.

Disabling an alert
You can disable an alert. This retains the alert definition but prevents the alert
from being run.

To disable an alert, complete the following steps:
1. In the Navigation Tree pane, complete one of the following actions:

For computer alerts
Expand Data Manager > Alerting > Computer Alerts.

For file system alerts
Expand Data Manager > Alerting > Filesystem Alerts.

For directory alerts
Expand Data Manager > Alerting > Directory Alerts.

For hypervisor alerts
Expand Data Manager > Alerting > Hypervisor Alerts.

For other NAS alerts
Expand Data Manager > Alerting > Other NAS Alerts.

For instance alerts
Expand Data Manager for Databases > Alerting > Instance Alerts.

For database-tablespace alerts
Expand Data Manager for Databases > Alerting >
Database-Tablespace Alerts.

For table alerts
Expand Data Manager for Databases > Alerting > Table Alerts.

For storage subsystem alerts
Expand Disk Manager > Alerting > Storage Subsystem Alerts.

For fabric alerts
Expand Fabric Manager > Alerting > Fabric Alerts.
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For switch alerts
Expand Fabric Manager > Alerting > Switch Alerts.

For endpoint device alerts
Expand Fabric Manager > Alerting > Endpoint Device Alerts.

The list of existing alerts is displayed.
2. Click the alert that you want to disable. The Edit Alert page opens.
3. Clear the Enabled check box.
4. Click File > Save.

Related topics:
“Alerts” on page 108

Editing alerts
You can edit an alert if you want to change the triggering condition, triggered
action, or the storage resources against which it is deployed.

To edit an alert, complete the following steps:
1. In the navigation tree, complete one of the following actions:

Alert type Action

For computer alerts Expand Data Manager > Alerting >
Computer Alerts.

For file system alerts Expand Data Manager > Alerting >
Filesystem Alerts.

For directory alerts Expand Data Manager > Alerting >
Directory Alerts.

For hypervisor alerts Expand Data Manager > Alerting >
Hypervisor Alerts

For other NAS alerts Expand Data Manager > Alerting > Other
NAS Alerts

For instance alerts Expand Data Manager for Databases >
Alerting > Instance Alerts.

For database-tablespace alerts Expand Data Manager for Databases >
Alerting > Database-Tablespace Alerts.

For table alerts Expand Data Manager for Databases >
Alerting > Table Alerts.

For storage subsystem alerts Expand Disk Manager > Alerting > Storage
Subsystem Alerts.

For fabric alerts Expand Fabric Manager > Alerting > Fabric
Alerts.

For switch alerts Expand Fabric Manager > Alerting > Switch
Alerts.

For endpoint device alerts Expand Fabric Manager > Alerting >
Endpoint Device Alerts.

The list of existing alerts is displayed.
2. Click the alert that you want to edit. The Edit Alert page opens.
3. Make any necessary changes.
4. Click File > Save.
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Tip: Some alerts are shown automatically when a client application is registered to
receive alerts from Tivoli Storage Productivity Center. You can identify these alerts
by the keyword Pre-defined in their names. You can hide these alerts from view in
the GUI. For more information, see the IBM Tivoli Storage Productivity Center
Problem Determination Guide.

Renaming alerts
You can rename alerts. This might be useful if the original name is ambiguous or
lacks clarity.

To rename an alert, complete the following steps:
1. In the navigation tree, complete one of the following actions:

Alert type Action

For computer alerts Expand Data Manager > Alerting >
Computer Alerts.

For file system alerts Expand Data Manager > Alerting >
Filesystem Alerts.

For directory alerts Expand Data Manager > Alerting >
Directory Alerts.

For hypervisor alerts Expand Data Manager > Alerting >
Hypervisor Alerts

For other NAS alerts Expand Data Manager > Alerting > Other
NAS Alerts

For instance alerts Expand Data Manager for Databases >
Alerting > Instance Alerts.

For database-tablespace alerts Expand Data Manager for Databases >
Alerting > Database-Tablespace Alerts.

For table alerts Expand Data Manager for Databases >
Alerting > Table Alerts.

For storage subsystem alerts Expand Disk Manager > Alerting > Storage
Subsystem Alerts.

For fabric alerts Expand Fabric Manager > Alerting > Fabric
Alerts.

For switch alerts Expand Fabric Manager > Alerting > Switch
Alerts.

For endpoint device alerts Expand Fabric Manager > Alerting >
Endpoint Device Alerts.

The list of existing alerts is displayed.
2. Right-click the alert, and click Rename. The Rename Alert window opens.
3. Type the new name, and click OK.

Viewing alerts
This section describes different methods for viewing alerts.

To view an alert, choose one of the following methods:

Alert log

Click IBM Tivoli Storage Productivity Center > Alerting > Alert Log.
Click All Alerts or any node that is highlighted in red and preceded by a
red circle. Depending on what you select, the Alert History page displays
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all alerts or only the alerts that you selected. Figure 31 shows the alert
history page.

To view details about each alert, click or double-click . The
Detail for Alert page displays additional information (see Figure 32). You
can obtain similar information about any alert by clicking Topology to
access the topology viewer. Details are available through the alert overlay in
the graphical view and the Alert tab in the table view. The following figure
shows the Detail for Alert page, which lists the name of the job, number of
the run, type of alert, state of the alert, timestamp, name of the alert
creator, name of the alert, and text about the alert

Alert overlay

The alert overlay represents various types of alerts. You can enable or
disable the alert overlay in the graphical view of the topology viewer by
right-clicking a blank space in the background of the graphical view,
clicking Global Settings from the pop-up menu, and clicking Alert under
Active overlays (see Figure 33 on page 401). After you make your selection,

Figure 31. Alert History page

Figure 32. Detail for Alert page
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click OK.

When the alert overlay is active, entities that have alerts associated with

them display a red alert overlay icon by the pinning icon. The icon
also appears in the title bar of groups and tabs. Note that in the
Configuration History page the alert overlay is disabled.

The alert overlay provides rollup, similar to pinning. If alerts are inside a
collapsed group, the number of alerts within that group are aggregated
and indicated in the collapsed group with an alert icon. All alerts are
aggregated into one count, independent of type or entity involved. Hover
over the alert icon for a tab or group to determine the total number of
alerts that are rolled up into that icon and the time stamp of the newest
alert.

In the topology viewer, right-click an entity with an alert icon to display
the pop-up menu. Click Show Alerts in Tabular View to move to the Alert
tab and to highlight alerts that are associated with that entity in the table
view (see Figure 34 on page 402). When you select an alert under the Alert
tab, entities that are associated with that alert are highlighted in purple in
the graphical view. Such an action might highlight more than one entity in
the topology viewer.

Figure 33. Enabling or disabling the alert overlay. In this example, the alert overlay is
enabled.
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External alerts do not display in the alert overlay. These alerts are usually
Common Information Model (CIM) indications that cannot be tied to
specific resources. To view the list of external alerts, click IBM Tivoli
Storage Productivity Center > Alerting > Alert Log > External.

Alert tab

The Alert tab is located in the table view of the topology viewer (see
Figure 35). Click this tab to view a hierarchical list of all current alerts that
are associated with entities shown in the topology. For configuration
analysis alerts, the highest level provides information about which policy
was violated during a particular analyzer run. The next level indicates the
number of times that the policy was violated. This list contains one node
for each policy violation. The Alert tab only lists the policy violations that
contain at least one of the affected entities that are displayed in the
graphical view. The remaining policy violations are filtered. The only
exception is the Overview panel where the Alert tab lists all of the Tivoli
Storage Productivity Center alerts. Click each violation to view a list of
affected entities. Parent (enclosing) entities display in a separate column.

For information about fixing policy violations, see “Resolving policy
violations” on page 416. You can resort the alert list by clicking the headers
in the table. To find entities associated with an alert in the graphical view,
click the alert in the table to highlight (in purple) the corresponding entity
and any associated entities.

Figure 34. Using the pop-up menu to view alerts in the table view

Figure 35. Viewing alerts by using the Alert tab in the table view. Expand the levels to view
information about each violation.
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Viewing alert logs
Use the alert log to view and manage the alert conditions that were detected on
the monitored resources in your environment. The alert log contain entries for all
alert conditions so that you can monitor and address critical storage events from a
central location.

There are two alert logs that are available in the stand-alone GUI. The type of alert
determines where information about the alert is shown:
v For alerts generated by Data Manager for Databases, expand Data Manager for

Databases > Alerting > Alert Log. You can view:
– All alerts or alerts organized by RDBMS such as by Oracle, SQL Server,

Sybase, and UDB. If you do not license for a specific RDBMS, no nodes for
that RDBMS are displayed under the Alert Log node.

– Alerts by type (such as by Instance, Database-Tablespace, Table, User)
– Alerts directed to you (the user currently logged on to the UI component)

v For alerts generated by all other components, expand IBM Tivoli Storage
Productivity Center > Alerting > Alert Log. The alert types that are displayed
depend on the Tivoli Storage Productivity Center license type. The following is a
list of the possible alert types that are displayed under Alert Log:
– All
– Alerts Directed to <user-id> - Alerts directed to the user logged on to the

interface.
– Authentication Configuration
– Replication
– Storage Subsystem
– Computer
– Disk
– Filesystem
– Directory
– User
– OS User Group
– Fabric
– Switch
– Endpoint Device
– External
– Tape Library
– Configuration Analysis
– Hypervisor

For alert types that are not displayed for certain license types, see “Product
licenses for Tivoli Storage Productivity Center” on page 12

Each alert node has an icon next to it that indicates its status:
v Red-outlined circle: a negative alert occurred, such as job failed, new disk defect.
v Green-outlined box: a neutral alert was detected, such as a new disk detected.

When you click an alert node, the alert log window opens a table that contains

information for all the alerts for that node. Click on a row to drill down for
more information.

The following table describes the buttons on the Alert Log window:
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Button Description

Clear Clear the selected alerts. When you click this button, the
icon for the alert changes to indicate that the alert was
cleared. The alert continues to be displayed in the alert log.

Delete Delete the selected alerts from the alert log.

Clear ALL Clear all of the alerts in the report. When you click this
button, the icon for all the alerts changes to indicate that the
alerts were cleared. The alerts continue to be displayed in
the alert log.

Delete ALL Delete all of the alerts in the current report from the alert
log.

Refresh Regenerate the report you are viewing to pick up any newly
generated alerts that were triggered since you last generated
the report.

Tip: Some alerts are shown automatically when a client application is registered to
receive alerts from Tivoli Storage Productivity Center. You can identify these alerts
by the keyword Pre-defined in their names. You can hide these alerts from view in
the GUI. For more information, see the IBM Tivoli Storage Productivity Center
Problem Determination Guide.

Restriction: For database tables, the values in the Resource Type and Resource
Name columns are set to N/A for the following alerts:
v Total Table Size Greater Than
v Chained Row Count Greater Than

Viewing tape library alerts
View discovered alert conditions in the tape libraries. Alerts are based on the
CIM_AlertIndication specification of SMI-S.

To view these alerts, expand IBM Tivoli Storage Productivity Center > Alerting >
Alert Log and click the Tape Library node.

Checking storage configurations
This section introduces methods that a system administrator can use to assess
changes that have occurred in SAN configurations over time and to check whether
SAN configurations comply with predefined policies.

Using configuration history
This topic describes how system administrators can capture and analyze historical
data that identifies possible problems with a storage area network (SAN)
configuration.

Note: The configuration history feature is available only with the IBM Tivoli
Storage Productivity Center Advanced Edition.

The configuration history feature takes and displays snapshots of changes that
occurred in your SAN configuration over a period of time that you specify. After
you set the time period (how often to take snapshots and how long to store them),
in a page similar to the topology viewer you can manipulate a snapshot selection
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panel to show changes that occurred between two or more points in the time
period. System administrators can use the configuration history feature to:

Correlate performance statistics with configuration changes
For example, during collection of performance statistics (including volume
performance statistics) on an TotalStorage Enterprise Storage Server system
you might delete a volume. While no new statistics are reported on that
volume, the Tivoli Storage Productivity Center Performance Manager
would have already collected partial statistical information prior to the
deletion. At the end of the data collection task, reporting of the partially
collected statistics on the (now) deleted volume would require access to its
properties which would not be available. The configuration history feature,
with its ability to take and store snapshots of a system's configuration,
could provide access to the volume's properties.

Analyze end-to-end performance
You want to know why performance changed on volume A during the last
24 hours. To learn why, it is useful to know what changes were made to
the storage subsystem's configuration that might affect the volume's
performance, even if performance statistics were not recorded on some of
those elements. For example, even if performance statistics on a per-rank
basis are not collected, but the number of volumes allocated on a rank is
increased from 1 to 100 over time, access to that configuration history
information helps with analyzing the volume's degraded performance over
time.

Aid in planning and provisioning
The availability of configuration history can enhance the quality of both
provisioning and planning. For example, historical data is useful when
using the Tivoli Storage Productivity Center Volume Performance Advisor
to provision a volume or when using the Tivoli Storage Productivity
Center Version 3.3 Integrated Host, Security and Subsystem Planner to
plan tasks.

To use the configuration history feature, complete the following steps:
1. In the Navigation tree pane, expand Administrative Services > Configuration

> Configuration History Settings. The Configuration History Settings page
displays for you to indicate how often to capture SAN configuration data and
how long to retain it.

2. Perform the following to collect historical data:
a. In the Create snapshot every field, click the check box to enable this option

and type how often (in hours) you want the system to take snapshot views
of the configuration.

b. In the Delete snapshots older than field, click the check box to enable this
option and type how long (in days) you want the snapshots to be stored.

c. The page displays the total number of snapshots in the database and the
date and time of when the latest snapshot was taken. To refresh this
information, click Update.

d. To optionally create and title a snapshot on demand, in the Title this
snapshot field type a name for the on demand snapshot and click Create
Snapshot Now. If you do not want to title the on demand snapshot, simply
click Create Snapshot Now.

e. To return to the default settings (the default settings are create snapshots
every 12 hours and delete snapshots older than 14 days), click Reset to
defaults.
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f. To save your settings, click File > Save.
3. In the Navigation tree pane, expand Tivoli Storage Productivity Center >

Analytics > Configuration History, and click Configuration History. The
software loads the snapshot data for the length of time that you specified. The
Configuration History page (a variation of the topology viewer) displays the
configuration's entities and a floating snapshot selection panel. The panel
allows you to define the time periods against which the configuration is
compared to determine whether changes have occurred.

4. To define the time periods that you want to compare, perform the following:
a. Using the mouse, drag the two “thumbs” in the Time Range slider to

establish the desired time interval. The Time Range slider covers the range
of time from the oldest snapshot in the system to the current time. It
indicates the date as mm/dd/yyyy, where mm equals the month, dd equals the
day, and yyyy equals the year.

b. Drag the two thumbs in the Snapshots in Range slider to indicate the two
snapshots to compare. The Snapshots in Range slider allows you to select
any two snapshots from the time interval specified by the Time Range
slider. The value in parentheses for the Snapshots in Range slider indicates
the total snapshots in the currently selected time range. The Snapshots in
Range slider has one tick mark for each snapshot from the time interval that
you specified in the Time Range slider. Each snapshot in the Snapshots in
Range slider is represented as time stamp mm/dd/yyyy hh:mm, where the first
mm equals the month, dd equals the day, yyyy equals the year, hh equals the
hour, and the second mm equals the minute. The value in parentheses for
each snapshot indicates the number of changes that have occurred between
this and the previous snapshot. Snapshots with zero changes are referred to
as empty snapshots. If you provided a title while creating an on demand
snapshot, the title displays after the time stamp. If you want to remove
empty snapshots, click the check box to display a check mark in Hide
Empty Snapshots. The Displaying Now box indicates the two snapshots
that are currently active.

c. Click Apply.
5. Determine the changes that have occurred to the entities by examining the

icons and colors associated with them in the graphical and table views: For

Figure 36. Snapshot selection panel. Use the thumb sliders to establish the time interval that
you want to examine.
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information about viewing the changes, see “Viewing configuration changes in
the graphical view” and “Viewing configuration changes in the table view” on
page 409.

One single snapshot selection panel applies for all Configuration History views
that are open at the same time. Any change that you make in this panel is applied
to all of the Configuration History views.

Important: If you manually deleted a missing entity from the Tivoli Storage
Productivity Center, the configuration history feature rediscovers and displays the
entity in the configuration history viewer as both Missing and in a Normal state.
For example, Entity A (with ID 12) is missing and you decide to manually delete it
by using the Remove From Database option from the pop-up menu for Entity A in
the topology viewer or configuration history viewer. Later, the Tivoli Storage
Productivity Center rediscovers Entity A and assigns it a new ID (ID 22). The
configuration history feature treats the same Entity A (with ID 12 and ID 22) as
two different entities and displays them in both Missing and Normal states in the
configuration history viewer. This scenario can also occur if a missing entity is
removed by the Tivoli Storage Productivity Center removed resource retention
function and is rediscovered by the Tivoli Storage Productivity Center again at a
later time.

Important: Name changes for volumes, storage pools, and managed disks are not
highlighted as being changed in the Configuration History topology viewer.

Viewing configuration changes in the graphical view
This section describes how to determine the changes that have occurred to a
configuration over time by examining the icons and colors of the change overlay in
the graphical view of the Configuration History page.

In the Configuration History page, a change overlay presents icons and colors that
indicate changes in the configuration between the time that a snapshot was taken
and the time that a later snapshot was taken:
v The icons display next to the name of the entity in the graphical view and in the

change status column of the table view.
v The colors display as background colors for entities in the graphical view and

for affected rows in the table view.

Table 37 describes the icons and colors of the change overlay.

Table 37. Icons and colors of the change overlay

Change overlay icon
Change overlay color

indicator Description

Yellow pencil

Blue background Entity changed between the time that the snapshot was
taken and the time that a later snapshot was taken.

Light gray circle

Dark gray background Entity did not change between the time that the
snapshot was taken and the time that a later snapshot
was taken.

Green cross

Green background Entity was created or added between the time that the
snapshot was taken and the time that a later snapshot
was taken.

Red minus sign

Red background Entity was deleted or removed between the time that
the snapshot was taken and the time that a later
snapshot was taken.
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Table 37. Icons and colors of the change overlay (continued)

Change overlay icon
Change overlay color

indicator Description

Not applicable Light gray background
Entity did not exist at the time that the snapshot was
taken or at the time that a later snapshot was taken.

To distinguish them from tabs in the topology viewer page, tabs in the
Configuration History page (Overview, Computers, Fabrics, Storage, and Other)
have a light gray background and are outlined in orange. The minimap in the
Configuration History page uses the following colors to indicate the aggregated
change status of groups:
v Blue - One or more entities in the group have changed. Note that the addition

or removal of an entity is considered a change.
v Gray - All of the entities in the group are unchanged.

Entities in the graphical view may be active (they existed at one or both snapshots)
or inactive (not yet created or deleted). Active entities act like they normally do in
the topology viewer; when you select them all relevant information also appears in

Figure 37. Icons and colors of the change overlay. In the graphical view, the pencil icon next to the switches and
storage entities and the blue background color indicate that change occurred to these entities. The pencil icon and
blue background also appears for these entities in the table view. In the snapshot selection panel, use the Time Range
and Snapshots in Range sliders to determine when the change occurred.
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the table view. You can adjust a grouping of active entities, but you may not
perform actions that change the database, such as pinning. Inactive entities do not
exist in the selected snapshots, but exist in the other snapshots. They are shown in
a light gray background and do not have a change icon associated with them.
Inactive entities display to keep the topology layout stable and to make it easier to
follow what has changed (instead of having the entities flicker in and out of
existence when you change the snapshot selection). Inactive entities are not listed
in the table view.

An entity that is moved from one group to another group appears only once in the
new group in the graphical view. For example, if the health status of a computer
has changed from Normal to Warning, the Configuration History page displays the
computer as changed in the Warning health group (and no longer displays the
computer in the Normal health group).

Note: In the Configuration History view, the performance and alert overlays are
disabled and the minimap's shortcut to the Data Path Explorer is not available.

Viewing configuration changes in the table view
This section describes how to determine the changes that have occurred to a
configuration over time by examining the icons and colors of the change overlay in
the table view of the Configuration History page.

In the table view, a changed cell or tab is color coded. The change overlay uses the
same colors and icons for the table view as for the graphical view (see Table 37 on
page 407). The changed cell or tab displays both the old and new values as Old
Value > New Value. To display a summary of change for the entire row, hover
over the changed row. The summary displays the title of the column. It also
displays the old and new value for each cell or tab that changed. For example, if a
group contains one new entity but everything else in the group is unchanged, the
group as a whole displays as “changed.” If you click the group, the one new entity
displays as “created” and all other entities display as “unchanged.”

The Change column in the table view also indicates changed entities.

An object that is moved from one group to another group appears only once in the
new group in the graphical view. For example, if the health status of a computer
has changed from Normal to Warning, the Configuration History page displays the
computer as changed in the Warning health group (and no longer displays the
computer in the Normal health group).

Using configuration analysis
This topic describes how system administrators can determine whether an existing
SAN configuration complies with predefined best practices (policies).

Note: The configuration analysis feature is available only with the IBM Tivoli
Storage Productivity Center Advanced Edition.

The configuration analysis feature allows a system administrator to select up to 16
policies and to specify the name of a target SAN (or zone set) for the analysis. The
analysis tool reads the specified SAN data and the policy information for the
specified policies from the IBM Tivoli Storage Productivity Center database. It
outputs the policy violations as Tivoli Storage Productivity Center alerts. To view
an alert, you can use one of three methods:
v Click the alert in the Configuration Analysis alert log
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v Click the alert overlay icon ( ) next to the affected entity
v Click the Alert tab in the table view of the topology viewer

System administrators can use configuration analysis to learn of any best-practices
violations their actions might have caused. For example, in provisioning a new
storage subsystem, an administrator might inadvertently violate a zoning-related
policy. If the zoning-related configuration changes persist in the database,
configuration analysis can detect this policy violation.

To perform configuration analysis, complete the following steps:
1. Ensure that you have previously run discovery and probe jobs for the

computers, fabrics, switches, storage, and other objects of interest.
2. Ensure that the Tivoli Storage Productivity Center Data Server and Device

server are running. To do so, in the navigation tree pane, expand the
following:
v Administrative Services > Services > Data Server > Server

v Administrative Services > Services > Device Server > Device server

3. Ensure that the following Tivoli Storage Productivity Center agents are
installed and configured.

Tip: The agent information that is required to evaluate a policy for violations
must be collected and stored in the Tivoli Storage Productivity Center
database.
v You can have a combination of in-band or Storage Resource agent,

out-of-band agent, and CIMOM fabric agents to collect all fabric topology
information. This information includes switches, interconnections, and
zoning, and is required to evaluate all configuration analysis policies.

v You can have CIMOM agents for storage subsystems, which collect the
storage subsystem information. This information includes subsystem details,
storage volumes, storage ports, and storage volumes to hosts mappings,
and is required to evaluate configuration analysis policies 2, 3, 5, 7 and 11.
CIMOMs are not required to communicate with storage systems that use
native interfaces. Tivoli Storage Productivity Center uses native interfaces to
connect to the following storage systems:
– DS8000
– SAN Volume Controller
– Storwize V7000
– IBM Storwize V7000 Unified
– The XIV system
– IBM SONAS

v Data agents or Storage Resource agents to collect the host information
(operating system type and version). This information is needed for the
evaluation of configuration analysis policies 3 and 9.

v In-band Fabric agents or Storage Resource agents to collect the attribute
information from the host information (HBA and host port details). This
information is needed for the evaluation of configuration analysis policies 2,
3, 4, 8 and 9.

v CIMOM agents for Tape to collect the tape information. This information is
needed for the evaluation of configuration analysis policy 2.

4. In the navigation tree pane, expand IBM Tivoli Storage Productivity Center >
Analytics.
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5. Right-click Configuration Analysis. A selection list displays.
6. Click Create Analyzer. The Create Analyzer window opens (see Figure 38).

7. To define the analysis, do the following steps:
a. Select the check box for Enabled.
b. In the Description field, type a brief description of the analysis job.
c. To specify the scope of the SAN data to be checked, make a selection from

the Configuration Analysis Scope list. Choices include:
v All Fabrics
v One fabric
v One Zoneset
If you select One fabric or One Zoneset, an adjacent list displays for you to
click a specific fabric or zone set.

d. Check the SAN data against up to 16 policies by performing one of the
following:
v Choose all of the policies by selecting the Select All/UnSelect All check

box.
v Choose one or more individual policies by selecting the check box for

each policy.

Note: For Policies 12 and 13, type values up to a maximum of 9999.

The policies are described in the following list. You can also access each

explanation by clicking for that policy.

Each connected computer and storage subsystem port must be in at least
one zone in the specified zone sets.

Determines whether an administrator forgot to zone a connected port.
Putting connected ports into zones is useful for security and
performance reasons. Ports are usually grouped into zones based on
applications, server operating systems, or HBA vendors. The Fabric
scope is not supported by this policy.

Each HBA accesses storage subsystem ports or tape ports, but not both.
Determines whether an HBA accesses both storage subsystem and
tape ports. Because HBA buffer management is configured differently
for storage subsystems and tape, it is not desirable to use the same

Figure 38. The Create Analyzer window. The figure shows a partial view of the window. Use
the Create Analyzer window to select the scope and the policies of the configuration analysis.
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HBA for both disk and tape traffic. The Fabric and Zone Set scopes
are not supported by this policy because an HBA can be connected to
multiple fabrics.

Each volume is accessed only by computers running the same type and
version of operating system.

Determines whether computers that run different operating systems
access the same storage volumes. Use of the same volumes by
computers that run different operating systems may corrupt the data
that is stored on the volumes. This applies, regardless of whether the
computers are in the same zone.

Each zone contains only HBAs from a single vendor.
Determines whether HBAs from different vendor types are in their
own zone. Receiving a registered state change notification (RSCN)
may cause an HBA to lose a zoned device, preventing the HBA from
seeing or communicating with other devices in the zone. To avoid
losing a zoned device, keep HBAs from different vendor types in their
own zone.

Each zone contains only a single model of storage subsystem.
Determines whether different storage subsystems are in the same
zone. While no technical problem is associated with storage
subsystems from different vendors and of different models being in
the same zone, an administrator may find them more difficult to
organize. When similar storage systems are in the same zone, an
administrator can easily group them for different applications.

Each zone is part of a zone set.
Determines the presence of orphan zones. Orphan zones are not
associated with any zone set. They are not useful because their
definitions are not used and they take up switch resources.

Each host must be zoned so that it can access all of its assigned volumes.
Determines whether the zones that were configured by the storage
administrator allow each computer to access all of the storage
volumes that are assigned to it. The administrator specifies the storage
subsystem ports through which the computer port accesses volumes,
but may forget to configure zones that enable the ports to
communicate during volume assignment. This policy also determines
whether zoning makes assigned volumes inaccessible to the computer
ports. The Fabric scope is not supported by this policy.

Each computer has only HBAs of the same model and firmware version.
Checks whether there is only one type of HBA in each computer.
Using only one type of HBA minimizes configuration problems. The
policy also checks whether firmware upgrades have been done
properly for all HBAs in a computer. The Zone Set scope is not
supported by this policy.

For each host type and operating system, every HBA of a given model must
have the same firmware version.

Determines whether all firmware upgrades have been done for the
HBAs in the operating system. The Zone Set scope is not supported
by this policy.

Every SAN switch of a given model must have the same firmware version.
Determines whether firmware upgrades have been done for all
switches of the same type. For example, if you have four identical
models of SAN switches from the same vendor and you perform a
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firmware upgrade on one, it is best to perform the upgrade on all of
the others. The Zone set scope is not supported by this policy.

Every storage subsystem of a given model must have the same firmware
version.

Determines whether firmware upgrades have been done for all storage
subsystems of the same type. For example, if you have four identical
storage subsystems from the same vendor and you perform a
firmware upgrade on one, it is best to perform the upgrade on all of
the others. The Zone Set scope is not supported by this policy.

Each fabric may have a maximum of x zones.
Checks whether the number of zone definitions in the fabric is larger
than the number that you entered. In large fabrics, too large a number
of zone definitions can become a problem. Fabric zone definitions are
controlled by one of the switches in that fabric, and limiting their
number ensures that the switch's zoning tables do not run out of
space. The Zone Set scope is not supported by this policy. You can
enter up to a maximum of 9999 zones.

Each zone may have a maximum of x zone members.
Checks whether the number of zone members in a zone is larger than
the number that you entered. In large fabrics, too large a number of
zone members can become a problem. Fabric zone members are
controlled by one of the switches in that fabric, and limiting their
number ensures that the switch's zoning tables do not run out of
space. You can enter up to a maximum of 9999 zones.

Replication Plan is intact with respect to the SRG(s) and the replication
session associated during planning through SAN Planner.

Determines whether SRGs that have associated resiliency profiles are
intact with respect to their members and their replication
relationships.

All the source volumes involved in Metro Mirror Failover/Failback sessions
are conforming to 1:4 primary to secondary LSS for a failback direction
scenario.

Metro Mirror (Failover/Failback) can be directional, and up to 4 LSS
secondaries can be connected to a primary LSS.

Inter/intra site connectivity is valid for replication plan deployments.
Checks whether connectivity either direct or through fiber channel
fabric exists for resiliency session deployments.

8. To specify how often to run the analysis, scroll to Scheduling.
9. In the How often to run area, schedule how often you want the job to run.

Choose from the following actions:

Run Now
Run the job immediately.

Run Once at
Run the job once at a specified date and time. Use the list boxes to
specify the month, day, and year. Type the hour and minutes over the
existing defaults. Click AM or PM.

Note: The Tivoli Storage Productivity Center framework that starts
the Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
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time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.

Run Repeatedly
Run the job repeatedly according to a schedule that you specify:
v Indicate when to begin the job. Use the list boxes to specify the

month, day, and year. Type the hour and minutes over the existing
defaults. Click AM or PM.

v Indicate how often to run the job. Select one of the following:
– In the Repeat Every field, click the desired number of minutes,

hours, days, weeks, or months.
– In the Run on these days field, click to display a check mark

next to the desired days.
10. In the How to handle time zones area, indicate the time zone to be used

when scheduling and running the policy. Click one of the following:

Use the time zone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this time zone
Select this option to indicate a specific time zone for when to run the
job. From the list box, select the time zone.

11. From the menu bar, select File > Save. The Save As pop-up opens.
12. Type a name for the analyzer and click OK. The Notice pop-up displays

Analyzer submitted.
13. Click OK to begin the job. To display the newly named analyzer job in the

Navigation tree pane, expand IBM Tivoli Storage Productivity Center >
Analytics > Configuration Analysis. The format of the name is
creator.analyzer, where creator is the name that is displayed on the Create
Analyzer window and analyzer is name that you assigned in step 12 (for
example db2admin.analyzer2).

14. Expand the job to view information about the run. The information includes
the number of times that the job was run, and the date and time of the run.
The color of the type indicates the status:
v Blue indicates that the run is in progress.
v Green indicates that the run is finished.
To refresh the status, right-click the job and click Update Job Status.

15. Click the run to view information about it. On a page titled with the name of
the job and run number, the following information is displayed:

Run Number of the run

Status The status of the run (Success or Failed), not whether policy violations
occurred

Start Time
The time at which the run started

Finish Time
The time at which the run ended

# Jobs The number of jobs

# failed
The number of jobs that failed

414 IBM Tivoli Storage Productivity Center: User's Guide



Computer
The IP address of the computer on which the job was run

Status The status of the run

Start Time
The time at which the run started

Finish Time
The time at which the run ended

Log File Name
The complete path name of the log file

16. To view whether a policy violation occurred, click . The Job log file page
displays the following information:
v Scope of the run (all fabrics, one fabric, or one zone set)
v Policies that were checked
v Total violations
v Breakdown of violations per policy
v Whether the run completed successfully or the errors it encountered

Note: To avoid overloading the Topology Viewer, the analysis job stores and
displays the first 50 policy violations only. You must resolve these violations
and run the job again to view any remaining violations, or you can change
this policy violation limit by using the setdscfg command. The attribute to set
is MaxPolicyViolationsStored.

17. To view one or more alerts generated by policy violations, in the Navigation
tree expand IBM Tivoli Storage Productivity Center > Alerting > Alert Log >
Configuration Analysis. The Alert History - All Policy Violations page
displays a log of job runs that generated alerts for policy violations. A policy
violation alert is generated for each policy that was violated during a run. A
policy might be violated several times, but only one alert is generated. The
text in the alert indicates the number of times the policy was violated. The
Alert History - All Policy Violations page includes the following information:

Column Description

When clicked, this provides details about the
alert.

When clicked, this makes the Clear and
Delete buttons active. When double-clicked,
provides details about the alert.

Computer Not applicable (N/A)

Configuration Analysis The name of the configuration analysis job

Alert Type The type of alert generated during the run

First Triggered The date and time of when the first alert
was generated

Last Triggered The date and time of when the last alert was
generated

# Times The number of times that an alert was
generated for a run

Alert Creator The userid of the person who created the
run

Alert Name The official name of the alert
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Column Description

Script Not applicable (N/A)

For more information about the alert log, see “Viewing alert logs” on page
403.

18. To view details about each alert, in the Alert History - All Policy Violations

page click the run that you want, then click or double-click . The
Detail for Alert page displays the following information:

Field Description

Configuration Analysis The name and scope of the analyzer job.

Run The number of run in which the alert
occurred.

Alert Type The type of alert (Policy Violation).

State The status of the alert. An active
(unresolved) state displays a red exclamation
mark

; an acknowledged (resolved) state displays a
green check mark

Timestamp The date and time that the alert was created.
Expressed as the month, day, year, hour,
minute, second, and AM or PM.

Alert Creator The userid of the person who created the
analyzer job.

Alert Name The name of the alert.

Alert Text A description of the policy that was violated
and the number of times that it was violated
during that analyzer run.

You can also use the topology viewer to view alerts about policy violations. To
launch the viewer, click Topology. For more information, see “Viewing alerts” on
page 399.

Resolving policy violations
When you click the Alert tab in the topology viewer and expand the entries in the
table view, information displays about each configuration analysis policy violation.
To verify and fix the policy violation, use the information in the following table.

Configuration Analysis Policy Enclosing Entity Affected Entity How to Verify and Fix the Policy
Violation

Policy 1. Each connected computer
and storage subsystem port must be
in at least one zone in the specified
zone sets.

Computer,
Subsystem, or
Other

Port In the zone tab within the L2:Fabric
view, verify that the port is not a
member of the zone set. Fix the
violation by adding the port to the
appropriate zone within the zone set.

Fabric Zone set
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Configuration Analysis Policy Enclosing Entity Affected Entity How to Verify and Fix the Policy
Violation

Policy 2. Each HBA accesses storage
subsystem ports or tape ports, but
not both.

Computer HBA In the zone tab within the
L2:Computer view, verify that HBA
ports are accessing both the disk and
tape subsystems. Fix the violation by
configuring the computer access to
disk and tape in two separate zone
sets, and ensuring that only one of
these is active at a given time.

Policy 3. Each volume is accessed
only by computers running the same
type and version of operating
system.

Subsystem Volume In L1:Computers view, one can see
that the computers accessing the
volume do not have the same OS
type and version. This violation can
be fixed by mapping or assigning the
volume only to the computers with
same OS type and version.

Computer Port

Computer Port

Policy 4. Each zone contains only
HBAs from a single vendor.

Fabric Zone In the zone tab within the L2:Fabric
view, find the computers in the zone.
Open the respective L2:Computer
views and select the HBA tab in the
table view to view the vendor of the
HBAs on those computers. Fix the
violation by editing the zone
definition and ensuring that all the
HBAs in the zone are from the same
vendor.

Policy 5. Each zone contains only a
single model of storage subsystem.

Fabric Zone In the L2:Fabric view, verify that the
models of the subsystems in the
zone are different. Fix the violation
by editing the zone definition and
ensuring that all the subsystems in
the zone have the same model.

Subsystem Port

Policy 6. Each zone is part of a zone
set.

Fabric Zone In the zone tab within the L2:Fabric
view, verify that the zone does not
belong to any of the zone sets and is
listed under Orphan Zones. Fix the
violation by adding the zone to a
zone set or by deleting the zone.

Policy 7. Each host must be zoned so
that it can access all of its assigned
volumes.

Computer or
Other

Port None of the zones in the
L2:Computer or L2:Subsystem views
has both the computer and
subsystem port. Fix the violation by
adding or editing the zone
definition, and by ensuring that both
the computer and subsystem port are
in the same zone.

Subsystem Port

Subsystem Volume

Policy 8. Each computer has only
HBAs of the same model and
firmware version.

Computer Computer Open the L2:Computer view and
select the HBA tab in the table view
to verify that the model and
firmware version for the HBAs on
that computer are different. Fix the
violation by installing the HBAs of
the same model or upgrading the
firmware version of the HBA on that
computer.
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Configuration Analysis Policy Enclosing Entity Affected Entity How to Verify and Fix the Policy
Violation

Policy 9. For each host type and
operating system, every HBA of a
given model must have the same
firmware version.

Computer HBA Open the respective L2:Computer
views and select the HBA tab in the
table view to verify that the
firmware and driver version for the
HBAs on those computers are
different. Fix the violation by
upgrading the firmware and driver
versions of the HBAs on those
computers.

Computer HBA

Policy 10. Every SAN switch of a
given model must have the same
firmware version.

Switch Switch Open the L1:Switches view and
select the switch tab to verify that
the firmware versions on those
switches are different. Fix the
violation by upgrading the firmware
versions on those switches.

Switch Switch

Policy 11. Every storage subsystem
of a given model must have the
same firmware version.

Subsystem Subsystem Open the L1:Subsystems view and
select the subsystem tab to verify
that the firmware versions on those
subsystems are different. Fix the
violation by upgrading the firmware
versions on those subsystems.

Subsystem Subsystem

Policy 12. Each fabric may have a
maximum of x zones.

Fabric Fabric In the zone tab within the L2:Fabric
view, verify that the number of
zones present in the fabric is greater
than x (the value entered by the user
in this policy). Fix the violation by
reducing the number of zones to a
value less than x.

Policy 13. Each zone may have a
maximum of x zone members.

Fabric Zone Search for the zone in the zone tab
in the L2:Fabric view. Verify that the
number of zone members present in
that zone is greater than x (the value
entered by the user in this policy).
Fix the violation by reducing the
number of zone members to a value
less than x.

Policy 14. Replication Plan is intact
with respect to the SRG(s) and the
replication session associated during
planning through SAN Planner.

Storage Resource
Group (SRG)

Replication
session

In the alert tab in the L0:Storage
Resource Groups view, verify that
the numbers of source and target
volumes in the SRG are not equal or
that the volumes are not in a
replication relationship. Fix the
violation by running the SAN
Planner again and provisioning
additional volumes or provisioning
resiliency for the existing volumes.

SRG Volume
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Configuration Analysis Policy Enclosing Entity Affected Entity How to Verify and Fix the Policy
Violation

Policy 15. All the source volumes
involved in Metro Mirror
Failover/Failback sessions are
conforming to 1:4 primary to
secondary LSS for a failback
direction scenario.

SRG Logical Subsystem
(LSS)

IBM Tivoli Storage Productivity
Center does not have an LSS view,
but in the L2:Storage view, you can
verify the details of the LSSs
responsible for the violation. This
violation only occurs if the copy
session is created incorrectly in IBM
Tivoli Storage Productivity Center
for Replication. Fix the violation by
changing the session details in Tivoli
Storage Productivity Center for
Replication to conform with the
policy.

Policy 16. Inter/intra site
connectivity is valid for replication
plan deployments.

SRG Replication
session

In the alert tab in the L0:Storage
Resource Groups view, verify that
there is no connectivity between
source and target volumes. Fix the
violation by manually providing a
common fibre channel fabric or
direct connection.

Planning and modifying storage configurations
This section describes SAN Planner and how to use it to plan and modify changes
to the system configuration.

Configuring a provisioning plan by using SAN Planner
Use SAN Planner to select configuration information for a provisioning plan and to
modify a configuration.

You must run a fabric, disk, and data discovery, and system and fabric
configuration probes on the storage controllers that you want to use for planning
purposes. You must also run a performance monitor on the storage controllers. You
can use the following storage products with SAN Planner:
v TotalStorage Enterprise Storage Server
v System Storage DS6000
v System Storage DS8000
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified
v The XIV system

For other storage products, SAN Planner works with the Space Only workload
profile.

To obtain host information that is used in volume assignments, you must use a
Storage Resource agent. To obtain fabric information, you can do so from another
Storage Resource agent in the same fabric, from an out-of-band agent, or through
the CIM object manager (CIMOM) that manages the switch. If you do not run a
Storage Resource agent, and the storage controller does not have information about
the host operating system, an asterisk is displayed next to the host port. The
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operating system imposes limits on the number of volumes that you can access.
Ensure that you do not exceed these limits.
1. Expand the IBM Tivoli Storage Productivity Center > Analytics or Disk

Manager node in the navigation tree.
2. Right-click SAN Planner and select Create Plan. The SAN Planner wizard is

displayed. The wizard provides the interface for user input to put together a
plan for volume, path, zone, and replication planning. It also provides
configuration recommendations based on the current storage configurations
and the user inputs.

Note: Clicking a saved plan (located under the SAN Planner node in the
navigation tree) opens the wizard with the Edit Plan TPCuserid.plan_name pane
instead of the Create Plan pane, where TPCuserid is the Tivoli Storage
Productivity Center user ID and plan_name is the name the plan was given
when it was previously saved.

3. To move to the next page in the wizard, click Next.

SAN Planner wizard: Selecting the planning task
Select the type of storage provisioning plan that you want to create. The type of
plan that you select determines the content of the remaining pages in the SAN
Planner Wizard.
1. Select the type of provisioning plan from the following options:

Provision storage only, including optional multipath and zone considerations
Click to create a plan for provisioning new storage. The plan does not
include provisioning for storage replication.

Provision storage with replication, including optional multipath and zone
considerations on the source resources

Click to create a plan for provisioning new storage and storage
replication.

Provision replication to existing storage
Click to create a plan for provisioning replication for existing storage
(provision target volumes for existing source volumes).

Configure multipathing or zoning only
Click to create a plan for provisioning multipathing and zoning for
existing storage.

2. To move to the next page in the wizard, click Next.

SAN Planner wizard: Selecting the provision plan details
Select the type of storage that you want to provision: volumes or virtual disks. You
can also select whether you want to include multipath and zoning provisioning in
the SAN plan.
1. To specify the type of storage that you want to provision, click Volumes or

Virtual Disks. If you are provisioning storage for IBM System Storage SAN
Volume Controller, you must select Virtual Disks.

2. Click Include multipath planning in the plan to enable multipath provisioning
later in the wizard. This option is unavailable if you selected Provision
replication to existing storage on the previous page of the wizard.

3. Click Include fabric rezoning for host planning in the plan to enable zoning
provisioning later in the wizard. This option is unavailable if you selected
Provision replication to existing storage on the previous page of the wizard.

4. To move to the next page in the wizard, click Next.
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SAN Planner wizard: Specifying the plan content
Select the input resources that you want to use in your Storage Area Network
(SAN) plan. Input resources can be storage systems, volumes, hosts, or a storage
resource group (SRG).

If you plan to use an SRG, you can select the SRG when you add the input
resources at the top of this page, or you can select a candidate SRG from the Use a
candidate SRG at the bottom of this page.

A candidate SRG is an SRG grouping storage resources together. By providing an
SRG as a candidate SRG to SAN Planner, you are instructing SAN Planner to
consider storage resources from this SRG when doing the capacity planning. Using
a candidate SRG provides you with a means of separating your application data
from your pool of unused resources.

You can create SRGs using the Storage Resource Group Management panel.
1. To specify the type of storage that you want to provision, click Add. The

Topology Viewer in the Planner Selection window is opened. The Topology
Viewer provides a topology view of the current system configuration.

2. Double-click the box title for a storage item in the topology viewer to expand
the storage view into the L0 level view of the available systems. Before
selecting systems, you might want to view the relationship between the
systems and switch connectivity. To view relationships, double-click a specific
system at the L0 Storage tab view. The L1 Subsystems view is opened, which
displays the Subsystems and the Connectivity (Switches) boxes. Double-clicking
a specific system displays the L2 view of that system and everything the
system is connected to.

3. In the L0, L1 or L2 view, first expand the system using the + or – buttons in the
upper right corner of the icon for the system. Then you must click the system
itself to activate the >> button to include the system in the plan. Click each
SAN Planner supported element in the same manner, that you want to include
in the SAN plan. To select multiple elements, press and hold the Ctrl key and
click each element icon.

4. Click to move the selected elements into the Selected Elements pane.

Tips:

v The Selected Elements pane lists the storage resource groups, fabrics,
computers, storage systems, pools, and volumes that are selected. When
using the Selected Elements pane, the subsystem selections are not required
to be in the same fabric. The Fabrics section lists the fabrics (by WWN) and
the corresponding selected systems and selected hosts within each fabric. If a
system has been configured in different fabrics, it is listed multiple times.
The Subsystems section contains the selected storage systems. The number
of fabrics to which the system belongs is shown next to each system. Selected
pools are listed under their storage systems. Selected volumes are listed
under their pools. The Computers section lists the selected hosts and the
number of fabrics the host belongs to. The hosts are used in path planning
and zone planning if Include multipath planning in the plan and Include
fabric rezoning for host planning in the plan are selected in the Select
Planning Tasks page.

v To remove an element from the Selected Elements pane, select the element
and click Remove.
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5. Click OK to save your selections and return to the Specify Plan Content page
where the storage elements that you selected are displayed. If an SRG is
selected as an input resource, the name of the associated provisioning profile, if
any, is displayed.

6. To use a candidate SRG as a pool of storage resources from which to provision
new storage, click Use a candidate SRG. Select the SRG that you want to use
from the Candidate SRG list. If you select a candidate SRG, existing
unassigned volumes belonging to the candidate SRG are used or new volumes
are created from a candidate SRG. The name of the candidate SRG is displayed.
Unassigned volumes in the SRGs selected as input resources in the Selected
Elements pane are not used and new volumes are not created from the input
SRG.

7. If you have selected a candidate SRG, click View SRG to view the SRG details.
8. To move to the next page in the wizard, click Next.
Related tasks:
“Working with storage resource groups” on page 489
Use storage resource groups to organize logically related storage entities into
named groups. For example, a storage resource group that represents a business
critical email application might include all the hosts that participate in the email
application cluster, the storage subsystems that provide storage to the application,
and the switches and fabrics through which the application’s data is configured to
travel.

SAN Planner wizard: Specifying selected volume assignments
for input resources
Select how the SAN Planner uses any individual unassigned volumes contained in
the plan input resources.

If one of more of the volumes in your plan input resources is assigned to hosts,
but not all of them are, then you can decide how to assign them.
1. Select the type of volume assignment for your input resources from the

following options:

Use these volumes as candidates for capacity planning
Click to use the unassigned volumes as candidates for provisioning
storage on the Specify Capacity Plan page.

Assign these volumes to the hosts and skip capacity planning
Click to omit the Specify Capacity Plan page and continue on with the
next steps in the planner. You can view the volume assignment on the
Review User Selections page.

Ignore these volumes in the capacity planning
Click to remove the volumes from consideration in the plan. If there are
no storage pools or storage systems in the input resources, then no
capacity planning can be done.

2. To move to the next page in the wizard, click Next.

SAN Planner wizard: Specifying selected volume assignments
for an SRG
Select how the SAN Planner uses any unassigned volumes contained in a
candidate storage resource group (SRG).

If one of more of the volumes in your plan candidate SRG is assigned to hosts, but
not all of them are, then you can decide how to assign them.
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1. Select the type of volume assignment for your candidate SRG from the
following options:

Assign these volumes to the hosts
Click to assign the volumes to all the hosts and continue to the Specify
Capacity Plan page. You can view the volume assignment on the
Review User Selections page.

Ignore these volumes in the capacity planning
Click to remove the volumes from consideration in the plan and
continue to the Specify Capacity Plan page.

2. To move to the next page in the wizard, click Next.

SAN Planner wizard: Specifying capacity plan
Create and configure new storage volumes or virtual disks specified in your SAN
plan.
v If you want to select any predefined workload profile other than Space only,

you must have run a performance monitor on the storage controller.
v If you want to select a user-defined workload profile, you must first create a

workload profile using the Workload Profiles panel.

Some of the field names that are displayed on the Specify Capacity Plan page
differ depending on the type of storage (volumes or virtual disks) that you selected
on the Select Provision Plan Details page.
1. In the Total Capacity field, enter the total capacity of the volumes or virtual

disks that are to be used for provisioning storage in GB. The Topology Viewer
in the Planner Selection window is opened. The Topology Viewer provides a
topology view of the current system configuration.

2. In the Number of Volumes or Number of Virtual Disks field, enter the
number of volumes or virtual disks that you want to create.

3. In the RAID level field, select an Array of Independent Disks (RAID) level for
the volume or virtual disk.

4. In the Volume Name Prefix or Virtual Disk Name Prefix field, enter the prefix
to be used in the volume or virtual disk name. If the prefix is longer than 14
characters, a warning prompt is displayed. On the plan recommendation page,
if the SAN Planner determines that the prefix length exceeds the naming
limitation of the storage system, you are prompted to change the prefix. The
following values represent the maximum volume name length for IBM storage
systems. The maximum volume name length includes the prefix that you enter
+ the volume name.

Table 38. Maximum volume name lengths for storage systems

Storage system Maximum volume name length (in characters)*

ESS 8

DS4000, DS5000 30

DS6000, DS8000 16

XIV 63

SAN Volume Controller 5.1 and
earlier

15

SAN Volume Controller 6.1 60
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Table 38. Maximum volume name lengths for storage systems (continued)

Storage system Maximum volume name length (in characters)*

Note: Tivoli Storage Productivity Center adds one or more characters to the volume name
depending upon how many volumes you are creating. For example, if 1-9 volumes are
created, one character is added; if 10-99 volumes are created, two characters are added, and
so on.

5. In the Workload Profile field, select a workload profile for the volume or
virtual disk. All predefined profiles other than Space only are supported by
IBM System Storage DS8000, IBM System Storage DS6000, SAN Volume
Controller, and IBM TotalStorage Enterprise Storage Server only.

6. For The recommended provisioning will be based on the performance data
collected between section, enter a Start Date and End Date for the collection of
performance data that you want to use in planning.

7. Click Use unassigned volumes not involved in copy relationship if you want
to use existing unassigned volumes. Unassigned volumes that are in a copy
relationship are excluded. Exception: The following unassigned volumes are
excluded regardless of their copy relationship:
v Unassigned volumes on IBM storage systems that have copy relationships

that were not created in IBM Tivoli Storage Productivity Center or IBM Tivoli
Storage Productivity Center for Replication.

8. To move to the next page in the wizard, click Next.

SAN Planner wizard: Specifying advanced capacity plan
Select additional options for creating and configuring new storage volumes or
virtual disks specified in your SAN plan.
1. To create thin volumes or virtual disks for IBM System Storage SAN Volume

Controller, IBM System Storage DS8000, or IBM XIV Storage System, select one
of the predefined profiles from the Thin Provisioning Profile field. You can
also create a profile in the Thin Provisioning Profiles panel. The predefined
options are as follows:

Ignore thin provisioning
A thin provisioning profile is not used.

Standard
This profile sets the over allocation limit for a pool at 200%. This
percentage sets the virtual capacity at up to two times the real capacity.

Conservative
This profile sets the over allocation limit for a pool at 150%. This
percentage sets the virtual capacity at up to one and a half times the
real capacity.

Aggressive
This profile sets the over allocation limit for a pool at 300%. This
percentage sets the virtual capacity at up to three times the real
capacity.

2. To specify whether you want to use or exclude solid-state disks from
provisioning, click one of the following options from the Solid State Disks
field:

Use Solid State Disks
Click to use only solid-state disks for provisioning.

Do not use Solid State Disks
Click to exclude solid-state disks from provisioning,
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3. To create new volumes on extent pools that belong to an encryption group,
select a value from the Encryption Group list. If there are no encryption groups
available, <none selected> is displayed in this box.

4. Click Show Recommended Pools to show the pools to be used for
provisioning. The recommended pools are displayed under the corresponding
storage systems in the The following resources are selected for planning box.

5. Optional: To remove pools from the provisioning process, select a pool or pools
from the The following resources are selected for planning box and click
Remove Pool.

6. To move to the next page in the wizard, click Next.
Related tasks:
“Thin provisioning profiles” on page 549
Learn how to create, modify, and delete thin provisioning profiles.

SAN Planner wizard: Specifying path plan
Set multipath options for provisioning in your SAN plan.

The supported multipath driver on a host is the IBM Subsystem Device Driver
(SDD). For Linux-based hosts starting with Red Hat Enterprise Linux Version 5
and SUSE Linux Enterprise Server Version 10, only the DM_Multipath driver is
available. The SDD driver is no longer supported on HP, starting with HP-UX 11i
v3 with Itanium®. HP-UX 11i v3 provides a native multipathing feature which is
supported by SAN Planner.
1. To specify how the driver uses the paths between the host and the storage

system, select one of the following options from the Multipath Option field:

Load Balancing
Sends input/output on all paths.

Round Robin
Sends input/output on one path until a time interval that is set in an
SDD setting at the host expires, then switches to another path.

Fail-Over
Sends input/output on one path until a failure occurs, then switches to
another path.

On HP-UX 11i v3 with Itanium®, the multipath options used by the SAN
Planner are as follows:

Load Balancing
If you select this option for HP-UX 11i v3, the option implemented is
Least Command Load. This option selects the path with the least
number of pending I/O requests for the next I/O operation.

Round Robin
On HP-UX 11i v3, this policy distributes the I/O load equally across all
active paths irrespective of the current load on each path.

Fail-Over
If you select this option for HP-UX 11i v3, the policy implemented is
Preferred Path. For this policy, you specify a path to an optimized
controller. This path is preferred for I/O transfers. The preferred path
must be set manually.

2. Select the Specify number of paths check box and enter the number of paths
that you want to configure between the host and storage system. If you do not
specify the number of paths in this field, the default is two paths (<auto>)
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3. To use the paths from host to storage systems through a minimum of two
fabrics, select Use fully redundant paths (requires at least 2 fabrics).

4. To move to the next page in the wizard, click Next.

SAN Planner wizard: Specifying zone plan
Use SAN Planner to specify zoning between ports on the hosts and systems in a
fabric.

The supported multipath driver on a host is the IBM Subsystem Device Driver
(SDD). For Linux-based hosts starting with Red Hat Enterprise Linux Version 5
and SUSE Linux Enterprise Server Version 10, only the DM_Multipath driver is
available. The SDD driver is no longer supported on HP, starting with HP-UX 11i
v3 with Itanium®. HP-UX 11i v3 provides a native multipathing feature which is
supported by SAN Planner.
1. To specify how the zones are created, select one of the following options from

the Automatically Create Zone field:

<auto-zone>
The plan generates using the maximum number of zones without
grouping the data paths based on hosts, host ports, or host bus
adapters (HBAs).

...for each host
Creates a zone for each host.

...for each HBA
Creates a zone for each host bus adapter.

...for each port
Creates a zone for each port.

2. Optional: Select the Specify maximum number of zones check box and enter
the maximum number of zones that you want to create between the host and
storage system.

3. Optional: Select the Maximum zone members per zone check box and enter
the maximum number of zone members for each zone.

4. Optional: If you do not want two controllers with different types to be used in
the same zone, select the No two controllers with different types should be
used in the same zone check box.

5. Optional: If you want to apply updates to the active zone set, select the Use
active zone set check box. This action applies changes to the inactive zone set
that has the same name as the active zone set and then the zone set is
activated. Before using this option, ensure that the zones and zone members in
the active zone set matches the zones and zone members in the inactive zone
set with the same name.

6. Optional: If you want to append a zone prefix to each zone name, select the
Append zone name prefix check box and enter a prefix.

7. To move to the next page in the wizard, click Next.

SAN Planner wizard: Selecting replication sessions
Create a replication session for the storage being provisioned, or, if one is available,
use an existing replication session.

This task is available if you have selected either Provision storage with
replication, including optional multipath and zone considerations on the source
resources or Provision replication to existing storage provisioning plans on the
Select Planning Task page.
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1. To create a replication session for the storage being provisioned, click Create a
new replication session for the storage being protected.

2. If an existing replication session is available, click Use an existing replication
session for the storage being protected and select the session that you want.
An existing session is listed here only if the input contains a storage resource
group and that storage resource group has a replication session associated with
it.

3. To move to the next page in the wizard, click Next.

SAN Planner wizard: Specifying replication session properties
Provide a name for the replication session and select the type of session to create.

This task is available if you have selected either Provision storage with
replication, including optional multipath and zone considerations on the source
resources or Provision replication to existing storage provisioning plans on the
Select Planning Task page.
1. In the Session Name field, enter a name for the replication session.
2. Select a value from the Session Type list that displays those replication session

types applicable to the kind of planning you have chosen. For example, if you
selected Volumes on the Select Provision Plan Details page, only the session
types pertaining to volume planning are shown. To filter the Session Type list,
select a value from the Filter by Copy Technology list. The value that you
select here combined with the value in the Location list determines the
replication sessions that are shown in the Session Type list. The options are:

No filtering
No filtering is performed.

Point-in-time Copy
The replication session FlashCopy is displayed in the Session Type list.

Continuous Copy
The replication sessions that are displayed in the Session Type list
perform continuous replication and depend on the value in the
Location list.

3. Select a location for the target volumes or virtual disks from the Location list.
This list is disabled if you selected No filtering or Point-in-time Copy for
filtering. The options are: Same Region, Across Regions, and Same and Across
Regions

4. Select the Use practice volume check box to include a practice volume in the
plan. If you want to practice what you would do in the event of a disaster,
without interrupting current data replication, you can use a practice volume.
Practice volumes are available in Metro Mirror, Global Mirror, and Metro
Global Mirror replication sessions.

5. Click the replication session type that you want to create. The copy type that is
associated with the session determines the actions that can be performed
against all copy sets in the session, the number of volumes or virtual disks in
each copy set, and the role that each volume or virtual disk plays. The options
are:
v FlashCopy
v VDisk Mirroring
v Metro Mirror Failover/Failback
v Metro Mirror Failover/Failback with Practice
v Metro Mirror Single Direction
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v Global Mirror Either Direction with Two Site Practice
v Global Mirror Failover/Failback
v Global Mirror Failover/Failback with Practice
v Global Mirror Single Direction
v Metro Global Mirror with Practice
v Metro Global Mirror

When you select a session type, a session image is displayed. The image is a
visual aid to help you create your session. It shows how many roles there are
in the session, and how the roles are distributed between the sites. The arrows
indicate the type of copy between roles:
v Straight arrows = synchronous Metro Mirror copies
v Zigzag arrows = asynchronous Global Copy relationships
v Lightning bolts = FlashCopy relationships

Note: For Global Mirror sessions on IBM(r) System Storage(tm) devices, SAN
Planner might report a successful creation and start of the session, but the
actual session start might take much longer. Verify the session using IBM Tivoli
Storage Productivity Center for Replication.

6. From the Copy Synchronization Rate, select the rate that data is copied from
the source virtual disk to the target virtual disk. This check box is enabled only
if VDisk Mirroring is selected in the Session Type list.

7. To move to the next page in the wizard, click Next.

SAN Planner wizard: Specifying a secondary location
Specify a secondary location for creating target volumes and virtual disks. You can
use an existing storage resource group (SRG), create an SRG, or use a candidate
SRG. You can also select a provisioning profile for the secondary SRG.

This task is available if you have selected either Provision storage with
replication, including optional multipath and zone considerations on the source
resources or Provision replication to existing storage provisioning plans on the
Select Planning Task page. If you did not specify an SRG in the input for the
source volumes in the Specifying the Plan Content page, the secondary SRG inputs
are disabled here. The list of SRGs displayed contains SRGs that are not part of
any existing replication sessions. If all SRGs are part of replication sessions, these
input fields are disabled.
1. To specify a secondary location, select from the following options:

Secondary Candidate SRG
Click to select the candidate SRG that you want to use. Click View
SRG to view the candidate SRG. The secondary candidate SRG is used
as the secondary source for the volume creation.

Create a new storage resource group
Click to create an SRG. Enter the name for the SRG in the Name field.
This secondary SRG is where the replication target volume will be
placed after the replication plan is executed.

Use existing storage resource group
Click to use an existing SRG. Select the SRG and click View SRG to
view. This secondary SRG is where the replication target volume will
be placed after the replication plan is executed.

2. To select a provisioning profile for the secondary SRG, select from the following
options:
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Use the source storage resource group profile
Click to select the provisioning profile that is associated with the source
SRG.

Use existing provisioning profile
Click to use the existing provisioning profile.

3. To move to the next page in the wizard, click Next.

SAN Planner wizard: Specifying a tertiary location
Specify a tertiary location for creating target volumes and virtual disks. You can
use an existing storage resource group (SRG), create an SRG, or use a candidate
SRG. You can also select a provisioning profile for the tertiary SRG.

This task is available if you have selected either Provision storage with
replication, including optional multipath and zone considerations on the source
resources or Provision replication to existing storage provisioning plans on the
Select Planning Task page, and Metro Global Mirror session as the replication
session type. If you did not specify an SRG in the input for the source volumes in
the Specifying the Plan Content page, the tertiary SRG inputs are disabled here.
The list of SRGs displayed contains SRGs that are not part of any existing
replication sessions. If all SRGs are part of replication sessions, these input fields
are disabled.
1. To specify a tertiary location, select from the following options:

Tertiary Candidate SRG
Click to select the candidate SRG that you want to use. Click View
SRG to view the candidate SRG. The tertiary candidate SRG is used as
the tertiary source for the volume creation.

Create a new storage resource group
Click to create an SRG. Enter the name for the SRG in the Name field.
This tertiary SRG is where the replication target volume will be placed
after the replication plan is executed.

Use existing storage resource group
Click to use an existing SRG. Select the SRG and click View SRG to
view. This tertiary SRG is where the replication target volume will be
placed after the replication plan is executed.

2. To select a provisioning profile for the tertiary SRG, select from the following
options:

Use the source storage resource group profile
Click to select the provisioning profile that is associated with the source
SRG.

Use existing provisioning profile
Click to use the existing provisioning profile.

3. To move to the next page in the wizard, click Next.

SAN Planner wizard: Reviewing user selections
Review your selections in the SAN Planner wizard.

Review your selections in the wizard. If you want to change any settings, click
Back, and make your changes. Click Next to generate the plan. The Getting
Recommendation dialog box is displayed while the settings in the wizard are
validated and the planning is performed. If the process runs without errors, the
Execute Plan page is opened showing the recommended storage configuration
plan. If an error occurs, a message that explains the error is displayed.
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SAN Planner wizard: Executing the plan
View the SAN Planner recommended storage configuration. Execute the plan as a
job.
1. In the "Plan involves the following changes" pane, review the configuration

changes that the SAN Planner job can make.
2. Click Show Plan Topology to look at a more detailed view of the planned

storage configuration.
3. To accept the configuration changes, click one of the following options to

specify when you want the job to run:

Run now
Click to run the job immediately.

Run Once at
Click to specify a date and time to run the job and select the
appropriate date and time.

4. To specify the time zone that you want to use, click one of the following
options:

Use the time zone that the server runs in
Click to use the time zone where the IBM Tivoli Storage Productivity
Center server runs.

Use this time zone
Select the time zone from the list.

5. Click Execute Plan to save the plan and run the job. The job is run at the date,
time, and time zone specified by the When to run and How to handle time
zones settings. The plan is saved under the SAN Planner node in the Tivoli
Storage Productivity Center navigation tree.

Note: For Global Mirror sessions on IBM(r) System Storage(tm) devices, SAN
Planner might report a successful creation and start of the session, but the
actual session start might take much longer. Verify the session using IBM Tivoli
Storage Productivity Center for Replication.

SAN Planner wizard: Editing the plan
Use the Edit panel to edit the plan that was created using the SAN Planner wizard
or to change the run time configuration for a plan.
1. Expand the Disk Manager node in the navigation tree. Right-click SAN

Planner and select a saved plan to open the wizard with the Edit Plan
TPCuserid.plan_name panel, where TPCuserid is the Tivoli Storage Productivity
Center user ID and plan_name is the name the plan was given when it was
previously saved.

2. Click View Job History to view a detailed history of job runs for the plan.
The Job Management panel is displayed.

3. In the Plan involves the following changes pane, review the configuration
changes that the SAN Planner job can make.

4. Click Show Plan Topology to look at a more detailed view of the planned
storage configuration.

5. In the When to run pane pane, click one of the following options to specify
when you want the job to run. This pane is disabled if Run now is selected
for the plan.

Run now
Click to run the job immediately.
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Run Once at
Click to specify a date and time to run the job and select the
appropriate date and time.

6. To specify the time zone that you want to use, click one of the following
options in the How to handle timezones pane. This pane is disabled if Run
now is selected for the plan.

Use the time zone that the server runs in
Click to use the time zone where the IBM Tivoli Storage Productivity
Center server runs.

Use this time zone
Select the time zone from the list.

7. Click Open Plan Wizard to open the SAN Planner wizard where you can
view or edit the contents of the plan.

8. Click Save to save the changes to the plan that you have made on this panel.
This option is disabled if the When to run and How to handle time zone
panes are disabled.

9. Click Execute Plan to run the plan immediately. This option is disabled if the
When to run and How to handle time zone panes are disabled. settings.

10. Click Cancel to cancel the edits that you have made on this panel.

Working with storage resource group sessions
This topic describes viewing and deleting replication sessions that are created in
the SAN Planner wizard for a storage resource group.

You can delete the replication session from IBM Tivoli Storage Productivity
Center and optionally also from IBM Tivoli Storage Productivity Center for
Replication.
1. In the navigation tree pane, expand Replication Manager > Storage Resource

Group Sessions. A table of the currently defined storage resource group
sessions is displayed in the content pane.

2. To select a storage resource group session to delete, click a row in the table.
You can use Ctrl+click and Shift+click to select multiple sessions
simultaneously.

3. Click Delete Storage Resource Group Session. Tivoli Storage Productivity
Center does not automatically delete the replication session from Tivoli Storage
Productivity Center for Replication. A dialog box opens enabling you to specify
how you want to delete the session. You can select from the following options:
v Click Yes to remove the selected replication session from the Tivoli Storage

Productivity Center database and the Tivoli Storage Productivity Center for
Replication database.

v Click No to remove the selected replication session from the Tivoli Storage
Productivity Center database only.

v Click Cancel to close the dialog box without deleting the selected replication
session from the Tivoli Storage Productivity Center database or Tivoli Storage
Productivity Center for Replication database.
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Optimizing storage configurations
Use the Storage Optimizer to analyze storage subsystems to identify performance
bottlenecks and to help you improve subsystem performance. You can also use the
report for migration and consolidation recommendations. You can optimize the
tiered storage of your system by using the recommendations of the tiering policy
analysis to efficiently manage the different storage tiers.

Storage Optimizer overview
The Storage Optimizer uses data in the IBM Tivoli Storage Productivity Center
database to analyze your storage subsystems to identify performance bottlenecks,
and recommend changes to improve performance. This topic lists the supported
subsystems and describes the general steps for using Storage Optimizer.

The Storage Optimizer helps you develop storage migration or storage
consolidation plans, and helps you plan for the growth of your storage
infrastructure. For example, you can use the Storage Optimizer to create a weekly
report that provides details on the performance of your storage subsystems and
makes recommendations for how to improve performance.

Note: The Storage Optimizer does not actually perform any migrations or modify
subsystem configurations. Its primary purpose is to provide you with a
performance analysis and optimization recommendations that you can choose to
implement at your discretion.

Important: Storage Optimizer does not take into account any established
replication relationships or sessions. Follow migration recommendations with care
to ensure continuity of all replication relationships.

To use the Storage Optimizer, you must have an IBM Tivoli Storage Productivity
Center Advanced license.

The following IBM storage subsystems or applications are supported:
v DS8000
v DS6000
v DS5000
v DS4000
v TotalStorage Enterprise Storage Server
v SAN Volume Controller
v Storwize V7000
v IBM Storwize V7000 Unified block level support
v The XIV system
v IBM SONAS

Before running Storage Optimizer, you must set up performance monitors to
collect performance data at least once a day for all storage subsystems that you
want Storage Optimizer to analyze. You must also collect performance monitoring
data for the back-end subsystems for SAN Volume Controller or Storwize V7000.
The performance data for the subsystems produce the most accurate Storage
Optimizer analysis.

The analysis is less accurate if there are any gaps in the data collection for the time
interval being analyzed. It is recommended that you collect at least one week's
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worth of performance monitoring data before using Storage Optimizer. Providing a
longer time interval for data collection increases the accuracy of the Storage
Optimizer analysis and recommendations. For more information, see “Creating
storage subsystem performance monitor” on page 379.

You must provide the Storage Optimizer with the following input:
v Configuration and performance data that you collect for the supported storage

subsystems before running the Storage Optimizer
v One or more selected storage subsystems that you specify as input to the

Storage Optimizer.
v Connected fabric topology and zoning information is used in the analysis if it is

available.

The Storage Optimizer produces the following output:
v An analysis report that displays performance heat maps and tables that

graphically illustrate the performance utilization of the storage subsystems that
you specified as input.

v An optimization report that provides migration and consolidation
recommendations for improving performance.

The Storage Optimizer produces more accurate results if you provide both the
required and optional input data requested by the Storage Optimizer, and if you
collect storage subsystem performance monitoring data over a longer time interval
before using the Storage Optimizer.

Note: Since running the Storage Optimizer is a processor-intensive task for the IBM
Tivoli Storage Productivity Center server, schedule a time to run the Storage
Optimizer when processor demand on the IBM Tivoli Storage Productivity Center
server is expected to be at a minimum.

The general steps for using the Storage Optimizer are as follows:
1. In the Create Analysis window, enter information in the required fields and

choose File > Save to submit the analysis report job. For more information, see
“Creating an analysis report” on page 434.

2. Review the Storage Optimizer analysis report. For more information, see
“Viewing an analysis report” on page 435.

3. Create an optimization report based on this analysis. For more information, see
“Creating an optimization report” on page 437.

4. View the optimization report. For more information, see “Viewing an
optimization report” on page 438.

5. At your discretion, implement the recommendations suggested in the
optimization report, or rerun the analysis using different inputs.

Using the Storage Optimizer
This topic describes how to use the Storage Optimizer to analyze storage
subsystem performance and create an optimization report that includes
recommendations to improve performance.

Before running Storage Optimizer, you must set up performance monitors and
collect performance monitoring data for all storage subsystems that you want
Storage Optimizer to analyze. Storage Optimizer analyzes performance monitoring
data for the time interval you specify. The analysis will be less accurate if there are
any gaps in the data collection for the time interval being analyzed. For best
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results, collect at least one week's worth of performance monitoring data before
using Storage Optimizer. Providing a longer time interval for data collection will
increase the accuracy of the Storage Optimizer analysis and recommendations. See
“Creating storage subsystem performance monitor” on page 379 for more
information.

Tip: The Storage Optimizer does not make any modifications to subsystem
configurations. Its primary purpose is to provide you with a performance analysis
and optimization recommendations that you can choose to implement at your
discretion.

Creating an analysis report
Creating a performance analysis report is the first step in using Storage Optimizer.

When you specify a start time for using performance monitor data in an
optimization plan, the start time might not coincide with the start of a performance
monitor data collection interval. If the requested start time is after the start of a
data collection interval and the duration of the data collection interval is long
enough so that it ends at or after the requested start time, Tivoli Storage
Productivity Center includes all data from the collection interval that began before
the requested start time. This might include data collected before the start time that
you specified. This processing ensures that the maximum amount of available
performance data is utilized. For example, if a performance monitor collects data
every 20 minutes starting at 01:00, but you request performance data starting at
1:15, Tivoli Storage Productivity Center still analyzes performance data starting at
01:00 that has a duration of 20 minutes.

To create the analysis, complete the following steps:
1. Navigate to one of the following nodes:

v IBM Tivoli Storage Productivity Center > Analytics > Storage Optimizer

v Disk Manager > Storage Optimizer.
2. Right-click Storage Optimizer and select Create Analysis to open the Create

Analysis panel. Use this panel to specify the storage subsystems that you
want to analyze.

3. Optional: In the Create Analysis panel, enter a short description of the
analysis job in the Description field.

4. The Select Storage pane lists the storage subsystems that you want to include
in the analysis. Use the Add button to add elements to the plan:
a. Click Add. The Optimizer Selection panel opens. This provides a

topology view of the current system configuration. Select the storage
subsystems that you want to include in the analysis.
Tip: The Topology Viewer pane displays the configuration from which
selections are made. The Select Elements pane displays the selections that
will be used in the analysis.

Note: When using the Select Elements pane, the subsystem selections do
not need to be in the same fabric.

b. Double-click the Storage box title to expand the storage view into the L0
level view of the available subsystems.

c. Click an element to select it. To select multiple elements, press and hold
the CTRL key and click on each element icon.
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d. Click >> to move the selected elements into the Select Elements pane. If
you decide to remove the selected elements from the Select Elements
pane, click <<.

e. When you are satisfied with all your selections, click OK. You return to the
Storage Optimizer Create Analysis panel with the selections displayed in
the Select Storage pane.

5. Optional: select an element to remove it by clicking Remove.
6. In the Performance Time Interval section, for Data Type, choose Daily to get

average performance data for each 24 hour period, or choose Sample/Hourly
to analyze a specific time period each day. Select the Start Date and End Date
to define the date interval that the Storage Optimizer uses to extract
performance monitoring data from the IBM Tivoli Storage Productivity Center
database. Performance monitoring data must exist in the database for the
entire interval you specify. The default date interval is the start and end date
of the current date. If you choose Sample/Hourly, specify the Start Time and
End Time of the daily time period that you want to analyze. For example, if
you choose Sample/Hourly with November 1 as the start date, November 15
as the end date, and 6 PM as the start time and 8 PM as the end time, then
data will be analyzed between 6 PM and 8 PM only for days between
November 1 and November 15.

7. Click Run Now to begin the analysis as soon as you save the analysis job
using File > Save. Alternatively, click Run Once at to begin the analysis at a
time you specify. When you save the analysis job using File > Save, the
analysis job appears under the Storage Optimizer node in the navigation tree,
but the job status is not displayed until the job has started running.

8. For How to handle time zones, specify which time zone to use.
9. Click File > Save to save and submit the analysis report job. After the analysis

report job starts, you can view the analysis job status under the Storage
Optimizer node in the navigation tree.

10. When the analysis report job is complete, select it to view the analysis report.

Viewing an analysis report
The analysis report displays a performance analysis for storage systems, and lets
you generate an optimization report that lists storage migration and consolidation
recommendations. You can experiment with different migration and consolidation
scenarios to help you achieve the desired performance improvements for your
storage infrastructure.

To view the analysis report:
1. Navigate to one of the following nodes:

v IBM Tivoli Storage Productivity Center > Analytics > Storage Optimizer

v Disk Manager > Storage Optimizer.
2. Expand the Storage Optimizer node and select a completed (green) analysis job

to display the analysis report. By default, the heat maps display the
performance utilization of all components.

3. To display the performance utilization for a specific component, select the
component from the Heat map based on list.

4. Drag the Performance Threshold slider to change the performance threshold
for all the selected subsystems. The heat maps are automatically updated to
reflect changes in the performance threshold. This allows you to see the
performance threshold at which different subsystems or components become
bottlenecked.
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There is one heat map for each storage subsystem included in the analysis. The
heat map uses different colors to represent the actual performance of a storage
subsystem, as measured against the default performance threshold of 80%. If you
change the performance threshold, the heat maps are automatically updated to
display the changes.

Each cell represents a storage pool. If there aren't enough storage pools to fill an
entire row, the remaining cells in that row will be gray. Select a cell to display
more information about that storage pool. Right-click a cell and choose show
optimizer view to display performance metrics for volumes in the selected pool.

Green, blue, yellow, orange, and red cells indicate storage pool performance as
follows:

Green storage pools that are performing at less than or equal to 25% of the
performance threshold.

Blue storage pools that are performing at less than or equal to 50% of the
performance threshold.

Yellow
storage pools that are performing at less than or equal to 75% of the
performance threshold.

Orange
storage pools that are performing at less than or equal to 100% of the
performance threshold.

Red storage pools that exceed the performance threshold.

The Performance tables represent the same information that is displayed in each
heat map, but in more detail. There is one table for each storage subsystem. Each
row represents a storage pool. You can sort the table by clicking a column. Column
descriptions are as follows:

Pool Name
the name of the storage pool.

Utilization
the aggregated performance utilization of all components, as measured
against the performance threshold.

Host Adaptor
the performance utilization of the host adapter ports on the storage
subsystem.

Hard Disk
the performance utilization of the disk arrays.

Controller
processor and memory performance utilization.

Device Adapter
the performance utilization of the device adapter which connects the
controller to the disk arrays.

Space The physical disk space utilization.
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Creating an optimization report
You can create an optimization report that lists storage migration and consolidation
recommendations. You can experiment with different migration and consolidation
scenarios to help you achieve the desired performance improvements for your
storage infrastructure.

To create the optimization report, follow these steps:
1. Navigate to one of the following nodes:

v IBM Tivoli Storage Productivity Center > Analytics > Storage Optimizer

v Disk ManagerStorage Optimizer.
2. Select a completed analysis job to display the analysis report.
3. To include a storage pool or storage subsystem as a source entity that you

want to migrate or consolidate to improve performance:
a. In the heat map or table, select a storage pool or storage subsystem. Select

Select all pools for storage subsystem to select all storage pools in a
storage subsystem so that you can include them as source entities.

b. Click >> for Source Entities to add the selected item to the source entities.
The same storage pool cannot be added as both a source and target entity.

c. For the list of source entities, if you select Make retirement
recommendations for the selected entity, the optimization report will
make retirement recommendations for all source entities.

d. To remove an item from the list of source entities, select it and click <<.

Note: The values in the optimization report are estimates and could be
influenced by data activity on the selected entity
The Storage Optimizer does not support Easy Tier (mixed pools) as source in
a migration or consolidation plan. However, Easy Tier pools are displayed in
the Performance Heat Maps and Performance Tables when you create an
optimization report. These pools are marked with the text E.T. and cannot be
selected.

4. To include a storage pool or storage subsystem as a target entity that you
want to keep after storage migration and consolidation:
a. In the heat map or table, select a storage pool or storage subsystem. Select

Select all pools for storage subsystem to select all storage pools in a
storage subsystem so that you can include them as target entities.

b. Click >> for Target Entities to add the selected item to the target entities.
The same storage pool cannot be added as both a source and target entity.

c. To remove an item from the list of target entities, select it and click <<.

When the Storage Optimizer considers potential pools as targets of a
migration, it takes into consideration whether the source and target pools
have the same RAID level, format (CKD or FB), and whether or not the
potential target has enough available capacity. The Storage Optimizer does not
support Easy Tier (mixed pools) as target entities in a migration or
consolidation plan.

5. Choose when to run the optimization report using one of the following
options:
v Run Now: creates the optimization report as soon as you save your report

settings by clicking File > Save. After the report job begins, you can view
the report and job status under the View Previously Run Optimization
Reports pane.
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v Run Once at: begins the report job at a specified date and time. When you
save the report job by clicking File > Save, the report job is displayed under
the View Previously Run Optimization Reports pane, but the job status
will not appear until the job has started running.

6. Drag the Performance Threshold slider to change the performance threshold
for the selected subsystems and pools. The heat maps are automatically
updated to reflect changes in the performance threshold. This allows you to
see the performance threshold at which different subsystems and pools
become bottlenecked. Keep in mind that if you select the Make retirement
recommendations for the selected entity option, the threshold you choose
using the Performance Threshold slider determines if the move to the target
subsystem will keep the target subsystem under the chosen threshold.

7. Click File > Save to save and submit the optimization report job.
8. To update the job status for all optimization reports, click Refresh Job Status.

9. To view a completed optimization report, click .
10. To see how the optimization recommendations change if you use a different

performance threshold, select a different performance threshold and run
another optimization report. You can continue creating optimization reports
using different performance thresholds until you achieve the expected
performance improvements.

Viewing an optimization report
The optimization report displays a storage migration and consolidation report that
lists recommendations for improving storage subsystem performance.

The Storage Optimizer does not actually perform any migrations or make any
modifications to subsystem configurations. Its primary purpose is to provide you
with recommendations that you can choose to implement at your discretion.

Important: Storage Optimizer does not take into account any established
replication relationships or sessions. Migration recommendations should be
followed with care to ensure continuity of all replication relationships.

To view the optimization report:
1. Navigate to one of the following nodes:

v IBM Tivoli Storage Productivity Center > Analytics > Storage Optimizer

v Disk ManagerStorage Optimizer.
2. Select a completed analysis job.
3. Optional: Under the View Previously Run Optimization Reports pane, click

Refresh Job Status to update the job status for all optimization reports.

4. Click to open an optimization report.
5. To view the results of implementing only some of the recommendations,

remove the check mark next to Select all recommendations and select a subset
of the recommendations from the table of recommendations. Only the selected
recommendations will be included in the printed report.

6. To display the performance utilization for a specific component, select the
component next to Heat map based on.

7. To print the report, click the Print button in the optimization report. If a PDF
printer driver is installed, you can print the report to a PDF file. Alternatively,
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you can print the report to a printer. The printed report includes an explanation
of each recommendation, and sample migration scripts for the SAN Volume
Controller.

The optimization recommendations include the following information:

Recommendation number
The sequential number associated with the recommendation.

Source subsystem
The name of the source subsystem.

Target subsystem
The name of the target subsystem.

Source volume
The name of the source volume.

Target volume
The name of the target volume.

Source pool
The name of the source pool.

Target pool
The name of the target pool.

Reason
The reason why the storage pool utilization has exceeded the performance
threshold.

Port information
The recommendation on which ports need to be configured on the target
subsystem for the target volume. This information only appears in the
printed report.

Zone information
The recommended zoning changes necessary so that the target volume is
visible to the host. This information only appears in the printed report.

SVC pseudoscript
The sample migration script that serves as a guide to the commands that
you must enter using the SAN Volume Controller command-line interface.
This information only appears in the printed report.

After you implement the recommendations, if you want to verify that you have
achieved the expected performance improvements, you must first collect more
performance monitoring data before running the Storage Optimizer again.

Deleting analysis jobs
You can delete analysis job definitions or individual analysis jobs if you no longer
need them.

To delete an analysis job definition or job run:
1. Navigate to one of the following nodes:

v IBM Tivoli Storage Productivity Center > Analytics > Storage Optimizer

v Disk ManagerStorage Optimizer> Disk Manager.
2. Expand the Storage Optimizer node.
3. Right-click an analysis job definition or an analysis job.
4. Click Delete.
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Keep in mind that deleting an analysis job definition also deletes all analysis jobs
and optimization reports that are associated with that job definition. If you delete
an analysis job, all optimization reports associated with that job are also deleted.

Deleting an optimization report
You can delete optimization reports if you no longer need them.

To delete an optimization report job:
1. Navigate to one of the following nodes:

v IBM Tivoli Storage Productivity Center > Analytics > Storage Optimizer

v Disk ManagerStorage Optimizer.
2. Expand the Storage Optimizer node.
3. Select a completed analysis job to display the list of optimization reports that

are associated with that analysis job.
4. Under View Previously Run Optimization Reports, right-click a completed

report and choose Delete.

Retrieving an optimization report job definition
You can retrieve the report job definition that was used to generate an optimization
report.

To retrieve the optimization report job definition associated with an optimization
report:
1. Navigate to one of the following nodes:

v IBM Tivoli Storage Productivity Center > Analytics > Storage Optimizer

v Disk ManagerStorage Optimizer.
2. Expand the Storage Optimizer node.
3. Select a completed analysis job to display the list of optimization reports that

are associated with that analysis job under View Previously Run Optimization
Reports.

4. Right-click an optimization report and choose Retrieve.

The Generate Optimization Report pane displays the inputs that were used to
create the selected optimization report.

Understanding zoning recommendations
This topic describes the zoning recommendations provided by Storage Optimizer
in the printed optimization report.

Note: Storage Optimizer only provides zoning recommendations in the printed
optimization report. The report lists the zoning recommendations for all volumes
under each volume.

Where possible, Storage Optimizer provides zoning recommendations for each
migration recommendation. The zoning recommendations will be to put the target
subsystem's port(s) into the same zones as that of the source subsystem's ports,
regardless of which zones the host is also a member of.

For example, suppose you want Storage Optimizer to provide zoning
recommendations using the following source and target subsystems.

Source subsystem A includes the following:
v Port 1 (member of zones: host1_zone, host2_zone, host3_zone)
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v Port 2 (member of zones: host4_zone, host5_zone, host6_zone)
v Volume X (mapped to host1 using Port 1)
v Volume Y (mapped to host4 using Port 2)

Target subsystem B includes the following:
v Port 1
v Port 2

Suppose that Storage Optimizer recommends migrating Volume X from Source
subsystem A to Target subsystem B. The zoning recommendations that accompany
this migration recommendation will be to add Target subsystem B's Port 1 to zones
host1_zone, host2_zone, and host3_zone.

Optimizing tiered storage
You can optimize the tiered storage of your system by defining storage tiering
policies that specify criteria that determine when volumes should be moved from
one storage pool to another. Using the recommendations of the tiering policy
analysis, you can ensure that the different storage tiers are efficiently managed.

You can optimize the tiered storage on SAN Volume Controller, Storwize V7000,
and Storwize V7000 Unified storage systems.

For example, you might have three different storage tiers with the first tier having
the highest performance capacity and being the most expensive storage. You can
manage each storage tier, especially the high performing storage, to meet the
performance and access goals of your system. To help you achieve this goal, you
can use the CLI tiering policy commands.

By creating storage tiering policies and running the tiering policy analysis, you can
use the analysis information to ensure that storage volumes are in the appropriate
storage tier. The tiering policy analysis compares recent performance data and file
system usage data with policy conditions that you specify for the tiering policies.
This comparison determines whether volumes are in an incorrect storage tier.

The tiering policy analysis recommends the appropriate storage pools to which
volumes should be migrated. You can then move the volumes to the appropriate
storage tier. For example, you might want to move infrequently accessed volumes
from a high-performance storage tier to a lower-performance storage tier, which is,
correspondingly, less expensive. The tiering policy analysis does not migrate the
volumes.

In addition, you can use the Volume Migration Recommendation Report to help
you analyze tiering policies and to improve your storage utilization.
Related reference:
“Volume Migration Recommendation Report” on page 1271
The Volume Migration Recommendation Report, shows the volumes that comply
with the criteria for migrating volumes to a pool in another storage resource
group. Use the report to identify volumes that might require migration based on
the conditions that are set in tiering policies.

Storage tiering policies
You can define storage tiering policies and specify criteria for volumes to be
migrated from one storage resource group to another. Using the information that is
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provided by the tiering policy analysis, you can optimize the usage of the different
storage tiers by ensuring that volumes are moved to the correct tier.

Use CLI commands to specify storage tiering policies. For example, in a typical
scenario, you create, analyze, and modify tiering policies:
v Create a tiering policy that is associated with specific storage resource groups by

using the mktp command.
v Add conditions to the tiering policy by using the addtpcondition command.
v Evaluate tiering policies by using the analyzetp command, which recommends

which storage entities to migrate.
v Change the attributes of the tiering policy by using the modifytp command.
v Modify the conditions of the tiering policy by using the rmtpconditions

command and then the addtpcondition command.
v Verify the changes to the tiering policy by using the lstp command.
v Retrieve the results of the most recent tiering policy analysis by using the

gettprec command.
v Remove the tiering policy by using the rmtp command.

You add conditions to a tiering policy that are used during the tiering policy
analysis to determine which storage entities to recommend for migration. For
example, you can add any of the following conditions:
v Specify that the candidate volumes should be moved by using the force

condition type.
v Exclude volumes from consideration by subsequent policies for being moved by

using the ignore condition type.
v Compare the percentage of files with last accessed times that are less or greater

than an age that you specify to a percentage you specify by using the age
condition type.

v Compare the measured I/O rate per GB of a volume to the I/O rate that you
specify by using the iodensity condition type.

The tiering policy analysis does not migrate volumes; it recommends which
volumes to migrate based on the tiering policy conditions that you specify.

Volumes must meet the qualifying criteria before they can be recommended for
migration, for example:
v The volumes must be in an online storage pool.
v There must be online storage pools in the destination storage resource groups

that are on the same storage system and that have sufficient space.
v Both the current and destination storage pools must be in a non-error state.

When there are no suitable destination pools, the tiering policy analysis cannot
make recommendations. Therefore, it is possible that only some or none of the
volumes in the source storage resource group are recommended if the destination
storage resource group does not have sufficient space.

You can also use the Volume Migration Recommendation Report to help you
analyze tiering policies. This report provides migration recommendations by
tiering policy.
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Related concepts:
“Optimizing tiered storage” on page 441
You can optimize the tiered storage of your system by defining storage tiering
policies that specify criteria that determine when volumes should be moved from
one storage pool to another. Using the recommendations of the tiering policy
analysis, you can ensure that the different storage tiers are efficiently managed.
Related reference:
“Volume Migration Recommendation Report” on page 1271
The Volume Migration Recommendation Report, shows the volumes that comply
with the criteria for migrating volumes to a pool in another storage resource
group. Use the report to identify volumes that might require migration based on
the conditions that are set in tiering policies.

Enforcing storage policies
Enforcing policies for storage usage can be critical to ensuring the proper and most
cost-effective use of storage devices. Policies are enforced when conditions that you
defined are detected by a monitoring job. Use quotas, constraints, and scheduled
actions to manage and enforce your storage policies.

Use the Policy Management node in Data Manager and Data Manager for
Databases to manage and enforce storage policies.

For example, if you want to enforce a policy that limits the amount of space a
group of users can consume on the network, use a Data Manager quota. That
quota will be triggered: 1) after a scan is run and 2) the scan detected that a group
of users is consuming more storage space than was indicated in the quota.

The following table describes the jobs you can use to enforce policies for storage
usage in your environment:

Table 39. Descriptions of policy types and their triggering conditions

Policy Type / Manager What can I do with this job?
What conditions can trigger an
alert?

Quotas

(Data Manager, Data Manager for
Databases)

v Policy Management > Quotas
> User

v Policy Management > Quotas
> OS User Group

Use quotas to define limits on and monitor the
amount of storage that a user or a group of
users can consume. You can set quotas to
specify limits for storage usage at different
levels, which enables you to control precisely
how much storage a user can consume on
specific storage entities:

v Define quotas in Data Manager to set limits
on the amount of storage that a user or a
group of users can consume at a network,
filesystem, or computer level.

v Define quotas in Data Manager for Databases
to set limits on the amount of storage that a
user or a group of users can consume at a
network, instance, database, or tablespace
level.

Monitoring job that detects conditions in quotas:
scan

User consumes more than n,
where n represents a number
measured in kilobytes,
megabytes, or gigabytes.

OS User Group consumes
more than n, where n
represents a number measured
in kilobytes, megabytes, or
gigabytes.
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Table 39. Descriptions of policy types and their triggering conditions (continued)

Policy Type / Manager What can I do with this job?
What conditions can trigger an
alert?

Network Appliance Quotas

(Data Manager)

v Policy Management >
Network Appliance Quotas >
Schedules

v Policy Management >
Network Appliance Quotas >
Imported User Quotas

v Policy Management >
Network Appliance Quotas >
Imported OS User Group
Quotas

Use Network Appliance Quotas to import, view,
and report on the NetApp Quotas defined on
NAS filers.

Monitoring job that detects conditions in
Network Appliance quotas: scan

% of hard limit, where n
represents a percentage of the
hard limit defined in the
NetApp Quota.

Constraints

(Data Manager)

Policy Management >
Constraints

Use constraints to:

v define the acceptable and unacceptable file
types, file sizes, and file owners for
computers in your environment. For example,
you can use constraints to alert you when
users store certain files (such as MP3 or .avi
files) on a monitored computer.

v Request an IBM Tivoli Storage Productivity
Center archive and backup of the largest
violating files identified by a constraint. IBM
Tivoli Storage Manager protects your
organization's data from hardware failures
and other errors by storing backup and
archive copies of data on offline storage.

Monitoring job that detects conditions in
constraints: scan

Violating files consume more
than n , where n represents a
number measured in kilobytes,
megabytes, or gigabytes.

Scheduled Actions

(Data Manager, Data Manager for
Databases)

Policy Management > Scheduled
Actions > Scripts

Use scheduled actions to schedule scripts to run
against computers and computer groups.
Scheduled actions are script-based, enabling you
to use any third-party tools for actions, such as
recovery or provisioning.

Monitoring job that detects conditions in
scheduled actions: n/a

Not applicable. The Scheduled
Action facility enables you to
run scripts according to the
schedule that you define. You do
not have to associate the script
with an alert.

Archive/Backup

(Data Manager)

Policy Management >
Archive/Backup

View and edit archive and backup jobs that
were created based on files selected from
reports in the Reporting facility.

Monitoring job that detects conditions in
archive/backups: scan

Not applicable. Any
archive/backup jobs displayed
under this node were created
based on files shown in the
following reports:

v Usage > Files > Largest Files

v Usage > Files > Most
Obsolete Files

v Usage > Files > Orphan Files

v Usage > Files > Duplicate
Files

v Backup > Most At Risk Files

v Usage Violations >
Constraint Violations
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Setting storage usage quotas
Use quotas to set limits on the amount of storage space that a user or group of
users can consume. You can use Data Manager and Data Manager for Databases to
set quotas at the filesystem, computer, network, database, tablespace, and instance
levels.

Use quotas in the to set limits on the amount of storage that a user or a group of
users can consume.

The following steps provide an overview of how quotas work:
1. A scan gathers extensive information about the storage resources within an

enterprise. This information is stored in the database repository.
2. When a quota job runs, it checks the information in the repository to determine

if any quota violations exist.
3. If there are any violations, an alert is triggered and the appropriate action is

taken.

Note: Because the information analyzed by quotas is provided by scans, you
should schedule a quota to run after the scan to collect that information. This
ensures that quotas are using the latest information about an enterprise to
determine violations.

You can define two different kinds of quotas: User and OS User Group.
v User Quota. Select users and groups of users for a quota that have been defined

within Data Manager or Data Manager for Databases.
v OS User Group Quota. Select OS User Groups for a quota. OS User Groups are

groups of users that have been defined in the operating system outside of Data
Manager. You can create Groups that contain many OS User Groups. When
creating a quota of this type, you can select individual OS User Groups and
groups that consist of multiple OS User Groups.

By providing you with the ability to define quotas at different levels, you can
control precisely how much storage a user or user group can consume on specific
filesystems, computers, network, databases, tablespaces, and instances:

Filesystem
Set storage usage limits on specific filesystems and groups of filesystems
that are monitored by Data Manager. This means that you will be alerted if
a user or group of users has exceeded the storage usage limit you defined
for the specific filesystem or groups of filesystems in the quota.

Computer
Set storage usage limits on specific computers and groups of computers
that are monitored by Data Manager. This means that you will be alerted if
a user or group of users has exceeded the storage usage limit you defined
for the specific computers or groups of computers in the quota.

Database-Tablespace
Set storage usage limits on specific databases, tablespaces, groups of
databases, and groups of tablespaces that are monitored by Data Manager
for Databases. This means that you will be alerted if a user or group of
users has exceeded the storage usage limit you defined for those storage
resources in the quota.

Instance
Set storage usage limits on specific instances, computers, and groups of
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computers that are monitored by Data Manager for Databases. This means
that you will be alerted if a user or group of users has exceeded the
storage usage limit you defined for the specific instances, computers, and
groups of computers in the quota.

Network
Set network-level storage usage limits for multiple computers, groups of
computers, filesystems, databases, and tablespaces within your network
that are monitored by Data Manager and Data Manager for Databases.

Creating a network-wide quota
Learn how to create a quota that generates an alert when a user or group of users
consumes more than a specified amount of storage space across the filesystems and
computers on a network.

To create a network-wide quota, complete the following steps:
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Quotas.
2. Expand the User or OS User Group node depending upon which entity you

want to apply a quota.
3. Select the level at which you want to apply the quota by right-clicking

Network.
4. Select Create Quota from the pop-up menu. The Create Quota window opens.
5. In the Description field, type a brief description of the quota.
6. Select a profile from the Profile selection list to control which storage usage

statistics are used when checking for quota violations. You can select any of
the GROUP_BY_OWNER type profiles shown. Make sure that the selected
profile is used in scans of all the filesystems chosen on the Filesystems tab.
This ensures that the quota is fairly enforced for all users.

7. Select users or user groups against which you want to apply the quota:
a. In the Available field, click the users or groups of users against which you

want to apply the quota.

b. Click . The users or groups are moved to the Current Selections
field.

8. Click the Filesystems tab; the Filesystems page opens.
9. Select filesystems, filesystem groups, computers, and computers groups on

which you want to limit the storage usage of users and user groups.
a. In the Available field, click the storage resources to which you want to

apply the quota. The groups displayed in this field were created using
Data Manager > Monitoring > Groups.

b. Click . The resources are moved to the Current Selections field.
10. Click the When to Run tab; the When to Run page opens.
11. In the How often to run area, schedule how often you want the quota to be

checked You can choose from the following actions:

Run Now
Check the quota immediately.

Run Once at
Check the quota once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.
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Note: The Tivoli Storage Productivity Center framework that starts the
Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.

Run Repeatedly
Check the quota repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days you select.

12. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

13. Click the Alert tab; the Alert page opens.
14. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Condition field, the default setting is User Consumes More Than n,
where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, type a numeric value that represents the storage usage
limit for the quota. If the storage entities selected for the quota (for
example, users and user groups) exceed this limit, the quota is triggered.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

15. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage
Productivity Center events according to the event definitions specified
in the tivoliSRM.baroc file (provided with the product). It also
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performs responses such as sending further notification, creating or
updating trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity
Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.

Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The
parameters listed in the Specify Script window are passed to the
script when the alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

16. Save the quota:
a. Click File > Save. The Save As window opens.
b. In the Specify Quota name field, type a name for the quota and click OK.

The quota is displayed in the navigation tree pane

Creating a network-wide quota for databases
Learn how to create a quota that generates an alert when a user or group of users
consumes more than a specified amount of RDBMS storage space across the
databases, tablespaces, groups of database-tablespaces, computers, and groups of
computers on a network.

To create a network-wide quota, complete the following steps:
1. In the Navigation tree pane, expand Data Manager for Databases > Policy

Management > Quotas.
2. Select the level at which you want to apply the quota by right-clicking

Network.
3. Select Create Quota from the pop-up menu. The Create Quota window opens.
4. In the Description field, type a brief description of the quota.
5. Select a profile from the Profile selection list to control which storage usage

statistics are used when checking for quota violations. You can select any of
the GROUP_BY_OWNER type profiles shown. Make sure that the selected
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profile is used in scans of all the databases and tablespaces chosen on the
Databases-Tablespaces tab. This ensures that the quota is fairly enforced for
all users.

6. Select users or user groups against which you want to apply the quota:
a. In the Available field, click the users or groups of users against which you

want to apply the quota.

b. Click . The users or groups are moved to the Current Selections
field.

7. Click the Databases-Tablespaces tab; the Databases-Tablespaces page opens.
8. Select the databases, tablespaces, database-tablespaces groups, computers, and

computer groups on which you want to limit the storage usage of users and
user groups.
a. In the Available field, click the storage resources to which you want to

apply the quota. The groups displayed in this field were created using
Data Manager for Databases > Monitoring > Groups.

b. Click . The resources are moved to the Current Selections field.
9. Click the When to Run tab; the When to Run page opens.

10. In the How often to run area, schedule how often you want the quota to be
checked You can choose from the following actions:

Run Now
Check the quota immediately.

Run Once at
Check the quota once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: The Tivoli Storage Productivity Center framework that starts
the Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.

Run Repeatedly
Check the quota repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days you select.

11. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.
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Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

12. Click the Alert tab; the Alert page opens.
13. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Condition field, the default setting is User Consumes More Than n,
where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, type a numeric value that represents the storage usage
limit for the quota. If the storage entities selected for the quota (for
example, users and user groups) exceed this limit, the quota is triggered.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

14. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage
Productivity Center events according to the event definitions specified
in the tivoliSRM.baroc file (provided with the product). It also
performs responses such as sending further notification, creating or
updating trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity
Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.
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Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The
parameters listed in the Specify Script window are passed to the
script when the alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

15. Save the quota:
a. Click File > Save. The Save As window opens.
b. In the Specify Quota name field, type a name for the quota and click OK.

The quota is displayed in the navigation tree pane

Creating a computer quota
Learn how to create a quota that generates an alert when a user or group of users
consumes more than a specified amount of storage space across computers and
groups of computers.

To create a computer quota, complete the following steps:
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Quotas.
2. In the Description field, type a brief description of the job.
3. Expand the User or OS User Group node depending upon which entity you

want to apply a quota.
4. Select the level at which you want to apply the quota by right-clicking

Computer.
5. Select Create Quota from the pop-up menu. The Create Quota window opens.
6. In the Description field, type a brief description of the quota.
7. Select a profile from the Profile selection list to control which storage usage

statistics are used when checking for quota violations. You can select any of
the GROUP_BY_OWNER type profiles shown.

8. Select users or user groups against which you want to apply the quota:
a. In the Available field, click the users or groups of users against which you

want to apply the quota.

b. Click . The users or groups are moved to the Current Selections
field.

9. Click the Computers tab; the Computers page opens.
10. Select computers and computers groups on which you want to limit the

storage usage of users and user groups.
a. In the Available field, click the computers and computers groups to which

you want to apply the quota. The groups displayed in this field were
created using Data Manager > Monitoring > Groups.

b. Click . The resources are moved to the Current Selections field.
11. Click the When to Run tab; the When to Run page opens.
12. In the How often to run area, schedule how often you want the quota to be

checked You can choose from the following actions:

Run Now
Check the quota immediately.
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Run Once at
Check the quota once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: The Tivoli Storage Productivity Center framework that starts
the Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.

Run Repeatedly
Check the quota repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days you select.

13. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

14. Click the Alert tab; the Alert page opens.
15. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Condition field, the default setting is User Consumes More Than n,
where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, type a numeric value that represents the storage usage
limit for the quota. If the storage entities selected for the quota (for
example, users and user groups) exceed this limit, the quota is triggered.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

16. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.
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TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage
Productivity Center events according to the event definitions specified
in the tivoliSRM.baroc file (provided with the product). It also
performs responses such as sending further notification, creating or
updating trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity
Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.

Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The
parameters listed in the Specify Script window are passed to the
script when the alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

17. Save the quota:
a. Click File > Save. The Save As window opens.
b. In the Specify Quota name field, type a name for the quota and click OK.

The quota is displayed in the navigation tree pane

Creating a filesystem quota
Learn how to create a quota that generates an alert when a user or group of users
consumes more than a specified amount of storage space across filesystems, groups
of filesystems, computers, and groups of computers.

To create a filesystem quota, complete the following steps:
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Quotas.
2. Expand the User or OS User Group node depending upon which entity you

want to apply a quota.
3. Select the level at which you want to apply the quota by right-clicking

Filesystem.
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4. Select Create Quota from the pop-up menu. The Create Quota window opens.
5. In the Description field, type a brief description of the job.
6. Select a profile from the Profile selection list to control which storage usage

statistics are used when checking for quota violations. You can select any of
the GROUP_BY_OWNER type profiles shown. Make sure that the selected
profile is used in scans of all the filesystems chosen on the Filesystems tab.
This ensures that the quota is fairly enforced for all users.

7. Select users or user groups against which you want to apply the quota:
a. In the Available field, click the users or groups of users against which you

want to apply the quota.

b. Click . The users or groups are moved to the Current Selections
field.

8. Click the Filesystems tab; the Filesystems page opens.
9. Select filesystems, filesystems, computers, and computer groups on which you

want to limit the storage usage of users and user groups.
a. In the Available field, click the storage resources to which you want to

apply the quota. The groups displayed in this field were created using
Data Manager > Monitoring > Groups.

b. Click . The resources are moved to the Current Selections field.
10. Click the When to Run tab; the When to Run page opens.
11. In the How often to run area, schedule how often you want the quota to be

checked You can choose from the following actions:

Run Now
Check the quota immediately.

Run Once at
Check the quota once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: The Tivoli Storage Productivity Center framework that starts the
Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.

Run Repeatedly
Check the quota repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days you select.

12. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
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b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For
example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

13. Click the Alert tab; the Alert page opens.
14. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Condition field, the default setting is User Consumes More Than n,
where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, type a numeric value that represents the storage usage
limit for the quota. If the storage entities selected for the quota (for
example, users and user groups) exceed this limit, the quota is triggered.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

15. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage
Productivity Center events according to the event definitions specified
in the tivoliSRM.baroc file (provided with the product). It also
performs responses such as sending further notification, creating or
updating trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity
Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.
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Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.

Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The
parameters listed in the Specify Script window are passed to the
script when the alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

16. Save the quota:
a. Click File > Save. The Save As window opens.
b. In the Specify Quota name field, type a name for the quota and click OK.

The quota is displayed in the navigation tree pane

Creating an instance quota
Learn how to create a quota that generates an alert when a user or group of users
consumes more than a specified amount of RDBMS storage space across instances,
computers, and groups of computers.

To create an instance quota, complete the following steps:
1. In the Navigation tree pane, expand Data Manager for Databases > Policy

Management > Quotas.
2. Select the level at which you want to apply the quota by right-clicking

Instance.
3. Select Create Quota from the pop-up menu. The Create Quota window opens.
4. In the Description field, type a brief description of the quota.
5. Select a profile from the Profile selection list to control which storage usage

statistics are used when checking for quota violations. You can select any of
the GROUP_BY_OWNER type profiles shown.

6. Select users or user groups against which you want to apply the quota:
a. In the Available field, click the users or groups of users against which you

want to apply the quota.

b. Click . The users or groups are moved to the Current Selections
field.

7. Click the Instances tab; the Instances page opens.
8. Select the instances, computers, and computer groups on which you want to

limit the storage usage of users and user groups.
a. In the Available field, click the storage resources to which you want to

apply the quota. The groups displayed in this field were created using
Data Manager for Databases > Monitoring > Groups.

b. Click . The resources are moved to the Current Selections field.
9. Click the When to Run tab; the When to Run page opens.

10. In the How often to run area, schedule how often you want the quota to be
checked You can choose from the following actions:

Run Now
Check the quota immediately.
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Run Once at
Check the quota once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: The Tivoli Storage Productivity Center framework that starts
the Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.

Run Repeatedly
Check the quota repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days you select.

11. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

12. Click the Alert tab; the Alert page opens.
13. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Condition field, the default setting is User Consumes More Than n,
where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, type a numeric value that represents the storage usage
limit for the quota. If the storage entities selected for the quota (for
example, users and user groups) exceed this limit, the quota is triggered.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

14. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.
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TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage
Productivity Center events according to the event definitions specified
in the tivoliSRM.baroc file (provided with the product). It also
performs responses such as sending further notification, creating or
updating trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity
Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.

Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The
parameters listed in the Specify Script window are passed to the
script when the alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

15. Save the quota:
a. Click File > Save. The Save As window opens.
b. In the Specify Quota name field, type a name for the quota and click OK.

The quota is displayed in the navigation tree pane

Creating a database-tablespace quota
Learn how to create a quota that generates an alert when a user or group of users
consumes more than a specified amount of RDBMS storage space across databases,
tablespaces, groups of databases, and groups of tablespaces.

To create a databases-tablespaces quota, complete the following steps:
1. In the Navigation tree pane, expand Data Manager for Databases > Policy

Management > Quotas.
2. Select the level at which you want to apply the quota by right-clicking

Databases-Tablespaces.
3. Select Create Quota from the pop-up menu. The Create Quota window opens.
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4. In the Description field, type a brief description of the quota.
5. Select a profile from the Profile selection list to control which storage usage

statistics are used when checking for quota violations. You can select any of
the GROUP_BY_OWNER type profiles shown. Make sure that the selected
profile is used in scans of all the databases and tablespaces chosen on the
Databases-Tablespaces tab. This ensures that the quota is fairly enforced for
all users.

6. Select users or user groups against which you want to apply the quota:
a. In the Available field, click the users or groups of users against which you

want to apply the quota.

b. Click . The users or groups are moved to the Current Selections
field.

7. Click the Databases-Tablespaces tab; the Databases-Tablespaces page opens.
8. Select the databases, tablespaces, database-tablespaces groups, computers, and

computer groups on which you want to limit the storage usage of users and
user groups.
a. In the Available field, click the storage resources to which you want to

apply the quota. The groups displayed in this field were created using
Data Manager for Databases > Monitoring > Groups.

b. Click . The resources are moved to the Current Selections field.
9. Click the When to Run tab; the When to Run page opens.

10. In the How often to run area, schedule how often you want the quota to be
checked You can choose from the following actions:

Run Now
Check the quota immediately.

Run Once at
Check the quota once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: The Tivoli Storage Productivity Center framework that starts
the Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.

Run Repeatedly
Check the quota repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days you select.

11. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
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b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For
example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

12. Click the Alert tab; the Alert page opens.
13. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Condition field, the default setting is User Consumes More Than n,
where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, type a numeric value that represents the storage usage
limit for the quota. If the storage entities selected for the quota (for
example, users and user groups) exceed this limit, the quota is triggered.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

14. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage
Productivity Center events according to the event definitions specified
in the tivoliSRM.baroc file (provided with the product). It also
performs responses such as sending further notification, creating or
updating trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity
Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.
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Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.

Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The
parameters listed in the Specify Script window are passed to the
script when the alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

15. Save the quota:
a. Click File > Save. The Save As window opens.
b. In the Specify Quota name field, type a name for the quota and click OK.

The quota is displayed in the navigation tree pane

Editing a storage usage quota
Learn how to change the settings for a quota, including the users or user groups to
which the quota applies, the resources on which the quota is set, and the amount
set as the limit for storage usage.

To edit a quota, complete the following steps:
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Quotas.
2. Expand the User or OS User Group node depending upon the type of quota

you want to edit.
3. Expand the level of the quota you want to edit. For example, if you want to

edit a computer quota, expand the Computer node.
4. Select the quota you want to edit. Information about the quota you want to

edit appears in the right-hand content pane.
5. In the Description field, type a brief description of the quota.
6. Select a profile from the Profile selection list to control which storage usage

statistics are used when checking for quota violations. You can select any of
the GROUP_BY_OWNER type profiles shown.

7. Select additional users or user groups against which you want to apply the
quota:
a. In the Available field, click the users or groups of users against which you

want to apply the quota. The groups displayed in this field were created
using Data Manager > Monitoring > Groups

b. Click . The users or groups are moved to the Current Selections
field.

8. Remove users or user groups previously included in the quota:
a. In the Current Selections field, click the users or groups of users that you

want to remove from the quota.

b. Click . The users or groups are moved back to the Available field.
9. Click the Computers or Filesystems tab depending on quota you are editing;

the Computers or Filesystems page opens.
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10. Select additional filesystems, filesystem groups, computers, or computers
groups on which you want to limit the storage usage of users and user
groups.
a. In the Available field, click the storage resources to which you want to

apply the quota. The groups displayed in this field were created using
Data Manager > Monitoring > Groups.

b. Click . The resources are moved to the Current Selections field.
11. Remove any filesystems, filesystem groups, computers, or computers groups

that you do not want included in the quota.
a. In the Current Selections field, click the storage resources to remove.

b. Click . The resources are moved to the Current Selections field.
12. Click the When to Run tab; the When to Run page opens.
13. In the How often to run area, schedule how often you want the quota to be

checked You can choose from the following actions:

Run Now
Check the quota immediately.

Run Once at
Check the quota once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: The Tivoli Storage Productivity Center framework that starts
the Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.

Run Repeatedly
Check the quota repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days you select.

14. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
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job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

15. Click the Alert tab; the Alert page opens.
16. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Condition field, the default setting is User Consumes More Than n,
where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, type a numeric value that represents the storage usage
limit for the quota. If the storage entities selected for the quota (for
example, users and user groups) exceed this limit, the quota is triggered.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

17. Click File > Save to save your changes.

Editing a storage usage quota for databases
Learn how to change the settings for a quota, including the users or user groups to
which the quota applies, the resources on which the quota is set, and the amount
set as the limit for storage usage.

To edit a quota, complete the following steps:
1. In the Navigation tree pane, expand Data Manager for Databases > Policy

Management > Quotas.
2. Expand the level of the quota you want to edit. For example, if you want to

edit a instance quota, expand the Instance node.
3. Click the quota you want to edit. Information about the quota you want to

edit appears in the right-hand content pane.
4. In the Description field, type a brief description of the quota.
5. Select a profile from the Profile selection list to control which storage usage

statistics are used when checking for quota violations. You can select any of
the GROUP_BY_OWNER type profiles shown.

6. Select additional users or user groups against which you want to apply the
quota:
a. In the Available field, click the users or groups of users against which you

want to apply the quota. The groups displayed in this field were created
using Data Manager > Monitoring > Groups

b. Click . The users or groups are moved to the Current Selections
field.

7. Remove users or user groups previously included in the quota:
a. In the Current Selections field, click the users or groups of users that you

want to remove from the quota.

b. Click . The users or groups are moved back to the Available field.
8. Click the Databases-Tablespaces or Instances tab depending on quota you are

editing; the Databases-Tablespaces or Instances page opens.
9. Select additional databases, tablespaces, instances, computers, or computers

groups on which you want to limit the storage usage of users and user
groups.
a. In the Available field, click the storage resources to which you want to

apply the quota. The groups displayed in this field were created using
Data Manager for Databases > Monitoring > Groups.
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b. Click . The resources are moved to the Current Selections field.
10. Remove any databases, tablespaces, instances, computers, or computers

groups that you do not want included in the quota.
a. In the Current Selections field, click the storage resources to remove.

b. Click . The resources are moved to the Current Selections field.
11. Click the When to Run tab; the When to Run page opens.
12. In the How often to run area, schedule how often you want the quota to be

checked You can choose from the following actions:

Run Now
Check the quota immediately.

Run Once at
Check the quota once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: The Tivoli Storage Productivity Center framework that starts
the Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.

Run Repeatedly
Check the quota repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days you select.

13. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

14. Click the Alert tab; the Alert page opens.
15. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Condition field, the default setting is User Consumes More Than n,
where n represents a value that you define in the Value field. No other
conditions are available.
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b. In the Value field, type a numeric value that represents the storage usage
limit for the quota. If the storage entities selected for the quota (for
example, users and user groups) exceed this limit, the quota is triggered.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

16. Click File > Save to save your changes.

Storage usage for Network Appliance quotas
Use Network Appliance quotas to import quotas from Network Appliance file
servrs and determine how and when you will be alerted to the hard limits defined
in those quotas.

Restriction: You can only import quotas if the NetApp device is configured as a
file server. It is not available if the NetApp device was added only as a CIMOM.

You can use the NAS support within IBM Tivoli Storage Productivity Center to
work with quotas defined using the software provided with Network Appliance
(NetApp) File Servers. Using the Network Appliance node under Policy
Management, you can do the following:
v Use the Schedules node to define a Data Manager quota that will import

NetApp quotas and alert you to when those quotas are close to being exceeded.
v Use the Imported User Quotas node to view the definitions of User quotas

stored on the NetApp file servers against which you ran a Data Manager quota
(defined in the Schedules node).

v Use the Imported OS User Group Quotas node to view the definitions of OS
User Group quotas stored on the NetApp file servers against which you ran a
Data Manager quota (defined in the Schedules node).

For example, you can define to be alerted when:
v A user or user group is close to reaching the hard limit defined within the

corresponding NetApp Quota
v The space consumed on a QTree is approaching the hard limit defined within

the corresponding NetApp Quota

Specifically, the Data Manager NAS component enables you to work with the
following types of Network Appliance quotas:
v Quotas that limit the space that QTree directories can consume on a volume
v Quotas that limit the space consumed by specific users on a volume
v Quotas that limit the space consumed by specific user groups on a volume

Quick Steps for Working with Network Appliance quotas

The following describes the general steps you must perform to work with Network
Appliance Quotas:
1. Run a Data Manager scan against the Network Appliance file servers whose

quotas you want to check. This ensures that Data Manager is using the latest
statistics when determining quota violations.

2. Expand Policy Management > Network Appliance Quotas.
3. Right click the Schedules node and select Create NetApp Quota Job to define

a quota job. The NetApp Quota window appears.
4. Use the tabs in the NetApp Quota window to specify:

v the Network Appliance file servers whose quotas you want to import
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v when and how often to run the quota
v the condition (% of hard limit) that will trigger an alert for the Network

Appliance quotas and how you will be notified of that alert. For example, if
you enter 90% for the alert condition, Data Manager will notify you
whenever any of the quotas you are importing are within 10% of being
violated.

5. Run the quota job from the Schedules node to import the Network Appliance
quota definitions from the target NAS filer. When quotas are imported, the
following occurs:
v any User or OS User Group quotas violations are shown in the Quota

Violation reports
v any directory quota (Qtree) violations and definitions are displayed in Alert

Log > > Directory.

Creating a Network Appliance storage usage quota
Learn how to create a Network Appliance storage usage quota that imports
Network Appliance quotas from filers and alert you to violations of those quotas.

Complete the following steps to:
v define the NetApp filers whose quotas you want to import
v determine when and how often to run the quota that checks for user-defined

violations (% of hard limit) of NetApp Quotas
v specify the condition (% of hard limit) that will trigger an alert violation for a

quota and how you will be notified of that alert
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Network Appliance Quotas.
2. Right click the Schedules node.
3. Select New NetApp Quota Job from the pop-up menu. The content pane

displays the What to PROBE page.
4. In the Description field, type a brief description of the quota.
5. Select the NetApp filers against which you want to run the quota job:

a. In the Available field, click the NetApp filers or NetApp filer groups
against which you want to apply the quota.

b. Click . The NetApp filers or NetApp filer groups are moved to the
Current Selections field.

6. Click the When to Run tab; the When to Run page opens.
7. In the How often to run area, schedule how often you want the quota to be

checked You can choose from the following actions:

Run Now
Check the quota immediately.

Run Once at
Check the quota once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: The Tivoli Storage Productivity Center framework that starts
the Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.
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Run Repeatedly
Check the quota repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days you select.

8. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

9. Click the Alert tab; the Alert page opens.
10. In the Triggering Condition area, specify the event that will trigger the alert:

a. In the Condition field, the default setting is User Consumes More Than n,
where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, enter the value that represents the percentage of a
NetApp's hard limit at which the alert is triggered. The hard limit
represents the most amount of space a user or directory (Qtree) can
consume on a NAS filer. For example, if the hard limit defined within a
NetApp Quota for a user group is 150 MB, and you enter 90 in the Value
field, the Data Manager quota will report a violation when that user group
consumes 135 or more megabytes.

c. In the Value Units field, the only value units available is the % of Hard
Limit.

11. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage Productivity
Center events according to the event definitions specified in the
tivoliSRM.baroc file (provided with the product). It also performs
responses such as sending further notification, creating or updating
trouble tickets, running programs, and so on.
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Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity
Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.

Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The parameters
listed in the Specify Script window are passed to the script when the
alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

12. Save the quota:
a. Click File > Save. The Save As window opens.
b. In the Specify NetApp Quota job name field, type a name for the quota

and click OK. The quota is displayed in the Navigation Tree pane

Viewing user quotas imported from Network Appliance filers
Learn how to view the definitions of user quotas stored on the NetApp filers
against which you ran a Data Manager quota.

Before you can import Network Appliance user quotas and view them through
Data Manager > Policy Management > Network Appliance Quotas > Imported
User Quotas, you must:
1. Run a scan against the Network Appliance filers whose user quotas you want

to import.
2. Use Policy Management > Network Appliance Quotas > Schedules to define

and run a quota checking job against the NetApp filers whose user quotas you
want to import.

Complete the following steps to view imported Network Appliance user quotas:
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Network Appliance Quotas > Imported User Quotas.
2. Click the NetApp Quota whose definition you want to view. The content pane

displays information about the NetApp user quota.
3. In the Users page of the Edit quota_name window, view the following

information about imported Network Appliance user quotas:
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Hard Limit
The hard limit for used space defined within the NetApp quota.

Current Selections
The users against which the NetApp quota applies.

4. In the Filesystems page of the Edit quota_name window, view the filesystems to
which the NetApp Quota applies.

Viewing OS user quotas imported from Network Appliance filers
Learn how to view the definitions of OS User Quotas stored on the NetApp filers
against which you ran a Data Manager quota.

Before you can import Network Appliance OS user quotas and view them through
Data Manager > Policy Management > Network Appliance Quotas > Imported
OS User Group Quotas, you must:
1. Run a scan against the Network Appliance filers whose OS user quotas you

want to import.
2. Use Policy Management > Network Appliance Quotas > Schedules to define

and run a quota checking job against the NetApp filers whose OS user quotas
you want to import.

Complete the following steps to view imported Network Appliance OS user
quotas:
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Network Appliance Quotas > Imported OS User Quotas.
2. Click the NetApp Quota whose definition you want to view. The content pane

displays information about the NetApp OS user quota.
3. In the OS Users page of the Edit quota_name window, view the following

information about imported Network Appliance OS user quotas:

Hard Limit
The hard limit for used space defined within the NetApp quota.

Current Selections
The OS users against which the NetApp quota applies.

4. In the Filesystems page of the Edit quota_name window, view the filesystems to
which the NetApp Quota applies.

Viewing directory (QTree) quotas and violations
Learn how to view the definitions of user quotas stored on the Network Appliance
filers against which you ran a Data Manager quota.

Before you can view QTree quotas and violations, perform the following steps:
1. Use Policy Management > Network Appliance Quotas > Schedules to define

and run a quota checking job against the Network Appliance filers containing
the QTree quotas you want to import.

2. Create and run a scan job that includes the following objects:
v the NetApp filers containing the QTrees whose quotas you want to import
v the directory group named TPCUser.NetApp QTree Group

3. Use Policy Management > Network Appliance Quotas > Schedules to rerun
the quota checking job you defined in step 1.

Complete the following steps to view a QTree quota violation and definition:
1. In the Navigation tree pane, expand Alerting > Alert Log.
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2. Click the Directory node. The Alert History — All Directories window appears.
This window lists all the alerts triggered by directory and QTree quota
violations.

3. To view details about a violation you can do either of the following:
v Double click the entry representing the QTree violation to view details about

that violation and the QTree quota definition.
v Right click the entry representing the QTree violation and select Edit

Definition from the pop-up menu to view the QTree quota definition.

Note: You cannot edit a QTree quota definition using Data Manager. To edit
a QTree quota definition you must use the software provided with your
Network Appliance filer.

Setting file constraints
Use constraints to define the acceptable and unacceptable file types, file sizes, and
file owners for a NAS filer or a set of NAS filers in your environment. You can
also use constraints to request an IBM Tivoli Storage Manager archive and backup
of the largest violating files identified by a constraint.

Creating a file constraint
Learn how to create a constraint that defines the acceptable and unacceptable file
types, file sizes, and file owners for a computer or a set of computers in your
environment.

To create a constraint, complete the following steps:
1. In the Navigation tree pane, expand Data Manager > Policy Management.
2. Right-click Constraints, and click Create Constraint. The Create Constraint

window opens.
3. In the Description field, type a brief description of the job.
4. Select file systems, file system groups, computers, and computer groups

against which to apply the constraint:
a. In the Available field, click the storage resources against which you want

to apply the constraint. Select individual filesystems and computers, as
well as file system and computer groups that you have previously defined
using the group facility. Note that cluster resource groups in a PowerHA
or MSCS clustered environment are listed as computers.

b. Click . The storage resources are moved to the Current Selections
field.

5. Click the File Types tab; the File Types page opens. Use this page to select the
file types that you want to allow or forbid.

6. Click one of the following:

Forbid file matching these patterns
Do not allow files of the specified type on the storage resources
selected on the Filesystems page.

Allow ONLY file matching these patterns
Allow files only of the specified type on the storage resources selected
on the Filesystems page.

7. Click the file types that you would like to allow or forbid in the Choose a file
type list box. The file types listed in this box are predefined in the system.
a. In the Choose a file type: field, click the file types that you would like to

allow or forbid.
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b. Click . The file types are moved to the Forbidden files field.
8. Optionally, create a custom file type:

a. Enter the pattern in the Or enter a pattern field.

b. Click . The file type is moved to the Forbidden files field.
9. Click the Users tab; the Users page opens. Use this page to allow or forbid

files owned by specific users
10. Click one of the following:

Forbid file owned by selected users
Do not allow files owned by the specified users.

Allow ONLY file owned by the specified owner
Allow files owned by the specified users only.

11. Select the users whose files you want to allow or forbid:
a. In the Available Users field, click the users you want to include.

b. Click . The users are moved to the Forbidden Users field.
12. Click the Options tab; the Options page opens. Use this page to define alerts

for files based on characteristics other than file type and file owner, and to
view a where clause that will be used as a filter for locating files that violate
the constraint definition. This page contains the following information:

Violating File Limits
Indicate the maximum number of violating filenames that should be
kept per agent.

number of days since last access greater than
Click this box and enter a length of time (in days) in which files have
not been accessed. When a constraint job locates a file that has not
been accessed in the length of time you indicated in this field, an alert
is triggered.

bigger than ##
Check this box and enter a file size that should trigger an alert. When
a constraint job locates a file of the size (or greater) that you indicated
in this field, an alert is triggered. Select the unit of measurement for
the value you entered in the list box. The valid choices are: bytes, KB
(kilobytes)MB (megabytes), GB (gigabytes), and TB (terabytes).

set-UID root
Check this box trigger alerts on files that have the SET-UID root bit on
(because this can be a security consideration).

not backed up (Windows only) and number of days since last modification
greater than

Click this box and enter the number of days since a file was last
modified and not backed up. When the constraint job locates a file
that was modified and not backed up in the amount of days that you
indicate in this field, an alert is triggered.

File Filter text
This section displays a where clause that will be used as a filter for
locating files that violate the Constraint definition. The choices you
make on this tab and the choices you made on the Users and File
Types pages are reflected in the content of this where clause. To edit
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the where clause filter text, click Edit Filter. This will allow you to
create new where conditions and groupings using the where clause
interface.

13. Click the Alert tab; the Alert page opens. Use the Alert tab to define the
alerting criteria for a constraint.

14. In the Triggering Condition area, specify the event that will trigger the
constraint alert:
a. In the Condition field, the default setting is User Consumes More Than n,

where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, type a numeric value that represents the amount of
space a file must consume to violate the constraint.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

Once Data Manager has found enough files that violate the condition (i.e., that
exceed the total size amount you specified in this section), the constraint is
considered violated and the alert is triggered. When the alert is triggered, the
actions that you specify in the Triggered Actions section are taken.

15. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage
Productivity Center events according to the event definitions specified
in the tivoliSRM.baroc file (provided with the product). It also
performs responses such as sending further notification, creating or
updating trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity
Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.
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Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The
parameters listed in the Specify Script window are passed to the
script when the alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

16. Save the constraint:
a. Click File > Save. The Save As window opens.
b. In the Specify Constraint name field, type a name for the constraint and

click OK. The constraint is displayed in the navigation tree pane. The
constraint is automatically checked whenever an appropriate scan job is
run.

Editing a constraint
Edit a constraint to: change the acceptable and unacceptable file types, file sizes,
and file owners, add or remove users and user groups to which the constraint
applies, edit the constraint options, and change the alert settings.

To edit a constraint, complete the following steps:
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Constraints.
2. Click the constraint you want to edit. Information about the constraint you

want to edit appears in the content pane.
3. Add or remove the filesystems, filesystem groups, computers, and computer

groups against which to apply the constraint:
a. In the Available field, click the storage resources that you want add. Click

. The users or groups are moved to the Current Selections field.
b. In the Current Selections field, click the storage resources that you want

remove from the constraint. Click . The users or groups are moved
to the Available field.

4. Click the File Types tab; the File Types page opens. Use this page to edit the
file types that you want to allow or forbid.

5. Click one of the following:

Forbid file matching these patterns
Do not allow files of the specified type on the storage resources
selected on the Filesystems page.

Allow ONLY file matching these patterns
Allow files only of the specified type on the storage resources selected
on the Filesystems page.

6. Click the file types that you would like to allow or forbid in the Choose a file
type list box. The file types listed in this box are predefined in the system.
a. In the Choose a file type: field, click the file types that you would like to

allow or forbid.

b. Click . The file types are moved to the Forbidden files field.
7. Optionally, create a custom file type:

a. Enter the pattern in theOr enter a pattern field.
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b. Click . The file type is moved to the Forbidden files field.
8. Click the Users tab; the Users page opens. Use this page to allow or forbid

files owned by specific users
9. Click one of the following:

Forbid file owned by selected users
Do not allow files owned by the specified users.

Allow ONLY file owned by the specified owner
Allow files owned by the specified users only.

10. Select the users whose files you want to allow or forbid:
a. In the Available Users field, click the users you want to include.

b. Click . The users are moved to the Forbidden Users field.
11. Click the Options tab; the Options page opens. Use this page to edit alerts for

files based on characteristics other than file type and file owner, and to view a
where clause that will be used as a filter for locating files that violate the
constraint definition. This page contains the following information:

Violating File Limits
Indicate the maximum number of violating filenames that should be
kept per agent.

number of days since last access greater than
Click this box and enter a length of time (in days) in which files have
not been accessed. When a constraint job locates a file that has not
been accessed in the length of time you indicated in this field, an alert
is triggered.

bigger than ##
Check this box and enter a file size that should trigger an alert. When
a constraint job locates a file of the size (or greater) that you indicated
in this field, an alert is triggered. Select the unit of measurement for
the value you entered in the list box. The valid choices are: bytes, KB
(kilobytes)MB (megabytes), GB (gigabytes), and TB (terabytes).

set-UID root
Check this box trigger alerts on files that have the SET-UID root bit on
(because this can be a security consideration).

not backed up (Windows only) and number of days since last modification
greater than

Click this box and enter the number of days since a file was last
modified and not backed up. When the constraint job locates a file
that was modified and not backed up in the amount of days that you
indicate in this field, an alert is triggered.

File Filter text
This section displays a where clause that will be used as a filter for
locating files that violate the Constraint definition. The choices you
make on this tab and the choices you made on the Users and File
Types pages are reflected in the content of this where clause. To edit
the where clause filter text, click Edit Filter. This will allow you to
create new where conditions and groupings using the where clause
interface.

12. Click the Alert tab; the Alert page opens. Use the Alert tab to define the
alerting criteria for a constraint.
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13. In the Triggering Condition area, specify the event that will trigger the
constraint alert:
a. In the Condition field, the default setting is User Consumes More Than n,

where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, type a numeric value that represents the amount of
space a file must consume to violate the constraint.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

Once Data Manager has found enough files that violate the condition (i.e., that
exceed the total size amount you specified in this section), the constraint is
considered violated and the alert is triggered. When the alert is triggered, the
actions that you specify in the Triggered Actions section are taken.

14. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage
Productivity Center events according to the event definitions specified
in the tivoliSRM.baroc file (provided with the product). It also
performs responses such as sending further notification, creating or
updating trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity
Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.

Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The
parameters listed in the Specify Script window are passed to the
script when the alert is triggered
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E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

15. Click File > Save to save your changes.

Requesting an archive or backup
Request anIBM Tivoli Storage Manager archive and backup of the largest violating
files identified by a constraint. Tivoli Storage Manager protects your data from
hardware failures and other errors by storing backup and archive copies of data on
auxiliary storage.

Data Manager provides a method within the alerting function of a constraint
where you can automatically start a Tivoli Storage Manager archive or backup to
run against the files that violate that constraint. For example, you can do the
following actions:
v Define a constraint to identify the .vbs files within your organization that are

larger than 2 megabytes. Other file types include .avi, .dll, .doc, .exe, .gif, .jpg,
.mp3, .rtf, .txt., wsh, and .zip. You can also define a pattern to use when
identifying files that need to be archived or backed up.

v Define a constraint that runs Tivoli Storage Manager to archive and then delete
those files

Before you begin

Before you can use the Tivoli Storage Manager archive and backup functions with
Data Manager constraints, you must ensure that the following conditions are met:
v Your user ID has Administrator authority within Tivoli Storage Productivity

Center.
v Tivoli Storage Manager client software is installed on each of the hosts where a

Data agent or Storage Resource agent is used to perform archive and backup
functions.

v (For SAN attached storage only) Tivoli Storage Manager client software must be
installed on a host computer where a Data agent or Storage Resource agent is
configured to act as the scanning agent for NAS storage.

v A Tivoli Storage Manager client must be configured to run without a password.
This condition is typically done by either including the password in the client
options (dsm.opt) file, or using the options PASSWORDACCESS = GENERATE
in the client options file.

v The Tivoli Storage Manager client must be version 5.1 or higher

Defining an archive or backup in a constraint:

Learn how to request an IBM Tivoli Storage Manager archive and backup of the
largest violating files identified by a constraint. Request a Tivoli Storage Manager
archive and backup on the alert page of a constraint definition.

Create a new constraint:

1. In the Navigation tree pane, expand Data Manager > Policy Management.
2. Right-click Constraints, and click Create Constraint. The Create Constraint

window opens.
3. Select filesystems, filesystem groups, computers, and computer groups against

which to apply the constraint:
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a. In the Available field, click the storage resources against which you want
to apply the constraint. Select individual filesystems and computers, as
well as file system and computer groups that you have previously defined
using the group facility. Note that cluster resource groups in a PowerHA
or MSCS clustered environment are listed as computers.

b. Click . The users or groups are moved to the Current Selections
field.

4. Click the File Types tab; the File Types page opens. Use this page to select the
file types that you want to allow or forbid.

5. Click one of the following:

Forbid file matching these patterns
Do not allow files of the specified type on the storage resources
selected on the Filesystems page.

Allow ONLY file matching these patterns
Allow files only of the specified type on the storage resources selected
on the Filesystems page.

6. Click the file types that you would like to allow or forbid in the Choose a file
type list box. The file types listed in this box are predefined in the system.
a. In the Choose a file type: field, click the file types that you would like to

allow or forbid.

b. Click . The file types are moved to the Forbidden files field.
7. Optionally, create a custom file type:

a. Enter the pattern in the Or enter a pattern field.

b. Click . The file type is moved to the Forbidden files field.
8. Click the Users tab; the Users page opens. Use this page to allow or forbid

files owned by specific users
9. Click one of the following:

Forbid file owned by selected users
Do not allow files owned by the specified users.

Allow ONLY file owned by the specified owner
Allow files owned by the specified users only.

10. Select the users whose files you want to allow or forbid:
a. In the Available Users field, click the users you want to include.

b. Click . The users are moved to the Forbidden Users field.
11. Click the Options tab; the Options page opens. Use this page to define alerts

for files based on characteristics other than file type and file owner, and to
view a where clause that will be used as a filter for locating files that violate
the constraint definition. This page contains the following information:

Violating File Limits
Indicate the maximum number of violating filenames that should be
kept per agent.

number of days since last access greater than
Click this box and enter a length of time (in days) in which files have
not been accessed. When a constraint job locates a file that has not
been accessed in the length of time you indicated in this field, an alert
is triggered.
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bigger than ##
Check this box and enter a file size that should trigger an alert. When
a constraint job locates a file of the size (or greater) that you indicated
in this field, an alert is triggered. Select the unit of measurement for
the value you entered in the list box. The valid choices are: bytes, KB
(kilobytes)MB (megabytes), GB (gigabytes), and TB (terabytes).

set-UID root
Check this box trigger alerts on files that have the SET-UID root bit on
(because this can be a security consideration).

not backed up (Windows only) and number of days since last modification
greater than

Click this box and enter the number of days since a file was last
modified and not backed up. When the constraint job locates a file
that was modified and not backed up in the amount of days that you
indicate in this field, an alert is triggered.

File Filter text
This section displays a where clause that will be used as a filter for
locating files that violate the Constraint definition. The choices you
make on this tab and the choices you made on the Users and File
Types pages are reflected in the content of this where clause. To edit
the where clause filter text, click Edit Filter. This will allow you to
create new where conditions and groupings using the where clause
interface.

12. Click the Alert tab; the Alert page opens. Use the Alert tab to define the
alerting criteria for a constraint.

13. In the Triggering Condition area, specify the event that will trigger the
constraint alert:
a. In the Condition field, the default setting is User Consumes More Than n,

where n represents a value that you define in the Value field. No other
conditions are available.

b. In the Value field, type a numeric value that represents the amount of
space a file must consume to violate the constraint.

c. In the Value Units field, select the unit of measurement: kilobytes,
megabytes, or gigabytes.

Once Data Manager has found enough files that violate the condition (i.e., that
exceed the total size amount you specified in this section), the constraint is
considered violated and the alert is triggered. When the alert is triggered, the
actions that you specify in the Triggered Actions section are taken.

14. In the Triggered Actions area, select Archive/Backup and click Define. The
Archive / Backup Options window appears. Click one of the following:

Archive
Perform an archive on the files that violate a constraint. Archives are
copies of data from online storage copies to offline storage. If you
select the Archive option, you can also check the Delete After
Successful Archival box to automatically delete the files that violated
the constraint after the files have been successfully archived.

Selective Backup
Perform a selective backup of the files that violate a constraint. A
selective backup enables you to back up specified files. These files are
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not excluded in the include-exclude list and meet the requirement for
serialization in the backup copy group of the management class
assigned to each file.

Incremental Backup
Perform an incremental backup of the files that violate a constraint.
An incremental backup enables you to back up new or changed files
or directories from a client domain or from specified directories or
files. These directories or files are not excluded in the include-exclude
list and meet the requirements for frequency, mode, and serialization
as defined by a backup copy group of the management class assigned
to each file.

Tivoli Storage Manager Command Options
Enter additional that will be passed on to the Tivoli Storage Manager
dsmc command. You can enter up to 512 bytes of text.

15. Save the constraint:
a. Click File > Save. The Save As window opens.
b. In the Specify Constraint name field, type a name for the constraint and

click OK. The constraint is displayed in the navigation tree pane. The
constraint is automatically checked whenever an appropriate scan job is
run.

See the IBM Tivoli Storage Manager Client User's Guide for more information
about each of the TSM actions you can select when defining triggered actions
for a constraint.

Scheduling script-based actions
Use scheduled actions to run user-defined scripts against selected computers and
computer groups.

You can access the scheduled actions facility using either Data Manager or Data
Manager for Chargeback. The actions that you schedule to run are based on
user-defined scripts, allowing you to use any third-party tools for actions, such as
recovery or provisioning. You can schedule scripts to run:
v Immediately
v Once at a specified time and date
v Repeatedly according to a schedule you specify

Select the option you want and then edit the time and date information
accordingly. You can also select the time zone for the schedule you specify. You can
either select the time zone that the Data server is in or any other time zone.

Note: Scheduled actions should not be confused with triggered actions. Triggered
actions enable you to run scripts based upon conditions and alerts that are
detected within your storage environment. Scheduled actions enable you to run
scripts according to the schedule that you define, without having to associate the
script with an alert.

Running scripts using scheduled actions
Use the scheduled action facility to run a script according to a schedule that you
define. The scheduled action facility is available in Data Manager and Data
Manager for Databases.
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Use scheduled actions to run scripts against selected computers and computer
groups. The scheduled actions facility is script-based, so you can use any
third-party tools for actions, such as recovery, or provisioning. You can schedule
scripts to run:
v Immediately
v Once at a specified time and date
v Repeatedly according to a schedule you specify

Scheduled actions are different from triggered actions. Use triggered actions to run
scripts based upon conditions and alerts that are detected within your storage
environment. Use scheduled actions to run scripts according to the schedule that
you define, without having to associate the script with an alert.

To create a scheduled action, complete the following steps:
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Scheduled Actions or Data Manager for Databases > Policy Management >
Scheduled Actions.

2. Right-click Scripts, and click Create Script. The Create Script panel opens.
3. In the Description field, type a brief description of the job.
4. Select computers and computer groups against which to run the action:

a. In the Available field, click the computers and computer groups against
which you want to run the action. You can select individual computers as
well as computer groups that you have previously defined using the group
facility. Cluster resource groups in a PowerHA or MSCS clustered
environment are listed as computers.

b. Click . The computers and computer groups are moved to the
Current Selections field.

5. Click the Script Options tab; the Script Options page opens. Use this page to
select the script that you want to run against the selected computers and
computer groups.

6. Select a script from Script Name. The scripts that appear in Script Name are
stored in the \<TPC_installation_directory>\scripts directory on the Data
server. The default installation directory where scripts are located is:
v Windows: C:\Program Files\IBM\TPC\data\scripts

v UNIX, Linux: /opt/IBM/TPC/data/scripts or /usrs/IBM/TPC/data/scripts

Note: The scripts that appear in the Script Name list are stored on the
computer where the Data server component is located. If you want to run a
script that is stored on a Storage Resource agent or Data agent, you must type
the name of that script in the Script Name field.

7. Click the When to Run tab; the When to Run page opens. Use the When to
Run page to specify when the scheduled action is run.

8. In the How often to run area, schedule how often you want to run the script
associated with the action. You can choose from the following options:

Run Now
Run the script immediately.

Run Once at
Run the script once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.
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Note: TheTivoli Storage Productivity Center framework that starts the
Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This process ensures that if many jobs are planned to run at a
certain time, they will not all start after the scheduled start time.

Run Repeatedly
Run the script repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days that you select.

9. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

10. Click the Alert tab; the Alert page opens. Use the Alert page to define the
alerting criteria for a scheduled action.

11. In the Triggering Condition area, the only condition is Script Failed. An alert
is automatically triggered if the scheduled action fails to run.

12. In the Triggered-Actions pane, select the actions that occur as a result of the
triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

13. Save the scheduled action:
a. Click File > Save. The Save As window opens.
b. In the Specify Script name field, type a name for the job and click OK.

The scheduled action is displayed in the navigation tree pane.

Editing a scheduled action
Edit a scheduled action to change: the computers and groups against which the
action is run, the script that is run, when the script is run, and the alerting
conditions if the action fails to run.

To edit a scheduled action, complete the following steps:
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Scheduled Actions > Scripts or Data Manager for Databases > Policy
Management > Scheduled Actions > Scripts.
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2. Select the scheduled action that you want to edit. Information about the action
appears in the right-hand content pane.

3. In the Description field, type a brief description of the job.
4. Select computers and computer groups against which to run the action:

a. In the Available field, click the computers and computer groups against
which you want to run the action. Select individual computers, as well as
computer groups that you have previously defined using the group
facility. Note that cluster resource groups in a PowerHA or MSCS clustered
environment are listed as computers.

b. Click . The computers and computer groups are moved to the
Current Selections field.

5. Click the Script Options tab; the Script Options page opens. Use this page to
change the script you want to run against the selected computers and
computer groups.

6. Select a script from Script Name. The scripts that appear in Script Name are
stored in the \<TPC_installation_directory>\scripts directory on the Data
server. The default installation directory where scripts are located is:
v Windows: C:\Program Files\IBM\TPC\data\scripts

v UNIX, Linux: /opt/IBM/TPC/data/scripts or /usrs/IBM/TPC/data/scripts

Note: The scripts that appear in the Script Name list are stored on the
computer where the Data server component is located. If you want to run a
script that is stored on a Storage Resource agent or Data agent, you must type
the name of that script in the Script Name field.

7. Click the When to Run tab; the When to Run page opens. Use this page to
change when the scheduled action is set to run.

8. In the How often to run area, schedule how often you want to run the script
associated with the action. You can choose from the following options:

Run Now
Run the script immediately.

Run Once at
Run the script once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: TheTivoli Storage Productivity Center framework that starts the
Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This process ensures that if many jobs are planned to run at a
certain time, they will not all start after the scheduled start time.

Run Repeatedly
Run the script repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.

v Indicate which days on which run the job. A check mark is
displayed next to the days that you select.
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9. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

10. Click the Alert tab; the Alert page opens. Use the Alert tab to change the
alerting criteria for a scheduled action.

11. In the Triggering Condition area, the only condition is Script Failed. This
indicates that an alert will automatically be triggered if the scheduled action
fails to run.

12. In the Triggered Actions area, select the actions that occur as a result of the
triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage
Productivity Center events according to the event definitions specified
in the tivoliSRM.baroc file (provided with the product). It also
performs responses such as sending further notification, creating or
updating trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The user
receives the alert upon logging in to Tivoli Storage Productivity
Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging in to
the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging in to
the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational, Notice,
Warning, Error, Critical, or Alert.
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Run script
A script is run when the condition occurs. Click Define to specify the
script that is run when the triggering condition occurs. The
parameters listed in the Specify Script window are passed to the
script when the alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change the
actual e-mail message.

13. Click File > Save to save your changes.

Archive and backup functions
Data Manager provides a method within the alerting function of a constraint by
which you can automatically invoke a IBM Tivoli Storage Manager archive or
backup to run against the files that violate that constraint.

An archive is a "snapshot in time". Each time an archive is done, a new "snapshot"
is taken. When an archive is performed, everything that has been specified is
captured. So, for example, if an archive was performed on a C: drive, everything
on C: will be archived. If, the next day, another archive of C: was performed,
everything on the C: drive would be archived again. Files and file systems that
have been archived as part of the Archive/Backup job can be deleted after
archiving, but you must select Delete After Successful Archival specifically.

Lets say that, as a result of running a report, you find a large number of files that
haven't been accessed in over two years. Looking at the cumulative sizes of these
files you determine they are taking up space that would be better utilized
elsewhere. You can archive and delete these files to reclaim that space. If, at some
time in the future those files are needed, they can be retrieved from the archive.
The result of the archive job is more free space without data loss.

A backup can be incremental (Selective Backup) or full. Usually a full backup is
done first and subsequent backups are incremental. For example, say that a backup
is performed on C: drive. All the files on the C: drive are then backed up, which is
the full backup operation. The next day we need to back up C: drive again.
Usually, this will be an incremental backup since a full backup was done the day
before. In the incremental backup, only the files that have changed on the drive
since the last backup will be backed up.

The archived or backed up files are sent to theTivoli Storage Manager server and
are stored on that machine. Files are put into storage groups that are controlled
through a Tivoli Storage Manager policy that the Tivoli Storage Manager server
administrator usually creates.

Constraints

Data Manager provides a method within the alerting function of a constraint by
which you can automatically invoke a Tivoli Storage Manager archive or backup to
run against files that violate constraints you have defined. You can do the
following:
v Define a constraint that will invoke Tivoli Storage Manager to archive and (if

that option is selected) delete those files
v Define a constraint to run an incremental or full backup
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See the scenario Archive and delete files to see an example of how constraints are
developed.

Before you begin

Before you can use the Tivoli Storage Manager archive/backup functionality with
Data Manager constraints, you must ensure the following:
v Your user ID has Administrator authority within IBM Tivoli Storage Productivity

Center.
v Tivoli Storage Manager client software is installed on each of the hosts where a

Storage Resource agent or Data agent is used to perform archive and backup
functions.

v (for SAN attached storage only) Tivoli Storage Manager client software must be
installed on the Storage Resource agent or Data agent host computer that is
configured to act as the scanning agent for NAS storage.

v A Tivoli Storage Manager client must be configured to run without a password.
This is typically done by either including the password in the client options
(dsm.opt) file, or using the options PASSWORDACCESS= GENERATE in the
client options file.

v The Tivoli Storage Manager client must be version 5.1 or higher.

Create an archive/backup job
Create a IBM Tivoli Storage Manager archive/backup job for files in a report

You follow these general steps when you create an archive or backup.
1. Make sure you have followed the prerequisite steps
2. Decide whether to create a new constraint or use one of the default constraints
3. Generate the report using the constraint you decided to use
4. Create an archive or backup job from files in the report

To create an Archive/Backup job on files from a report, complete the following
steps:
1. Generate and view a Largest Files, Most Obsolete Files, Orphan Files,

Duplicate Files, Most At Risk, Constraint Violations report, or a report that
you have created.

2. Click on the files you want to include in the archive or backup job. Use ctrl +
click to select multiple, non-consecutive files; use shift + click to select
multiple, consecutive files.

3. Right click on the reports and select Create a new archive/backup job from
the pop-up menu. The Create File Archive/Backup Action window is
displayed.

4. In the Description field, type a brief description of the job.
5. In the Archive/Backup Options tab, select the type of the job and its TSM

command options, if any:

Archive
Use this option to archive the files that violate a constraint. Archives
are copies of data from online storage copies to offline storage.

Delete After Successful Archival
Automatically delete the files that violated the constraint after
they have been successfully archived. See the IBM Tivoli
Storage Manager Client User's Guide for more information about
Tivoli Storage Productivity Center archives.
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Note: Tivoli Storage Productivity Center administrators
(Productivity Center Administrator role) have the ability to
delete files even if they do not have the required authority on
the systems where the files are stored. This authority is
provided by the Tivoli Storage Productivity Center agents
which run as root on UNIX systems or with administrator
privileges on Windows computers.

Selective Backup
Select this option to perform a selective backup of the files that violate
a constraint. A selective backup enables you to back up specified files.
These files are not excluded in the include-exclude list and meet the
requirement for serialization in the backup copy group of the
management class assigned to each file. See the IBM Tivoli Storage
Manager Client User's Guide for more information about selective
backups.

Incremental Backup
Select this option to perform an incremental backup of the files that
violate a constraint. An incremental backup enables you to back up
new or changed files or directories from a client domain or from
specified directories or files. These directories or files are not excluded
in the include-exclude list and meet the requirements for frequency,
mode, and serialization as defined by a backup copy group of the
management class assigned to each file. See the IBM Tivoli Storage
Manager Client User's Guide for more information about incremental
backups.

IBM Tivoli Storage Manager Command Options
Enter additional Tivoli Storage Manager command line options in this
field that will be passed on to the Tivoli Storage Manager dsmc
command. You can enter up to 512 bytes of text. See the IBM Tivoli
Storage Manager Client User's Guide for more information about valid
Tivoli Storage Manager command-line options.

6. Click the Files tab; the Files page opens. Use this page to view or remove the
files included in an archive/backup job.

7. Click the When to Run tab. Use the How often to run area to specify when
the archive or backup job runs.

8. In the How often to run area, schedule how often you want the quota to be
checked You can choose from the following actions:

Run Now
Check the quota immediately.

Run Once at
Check the quota once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: The Tivoli Storage Productivity Center framework that starts
the Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This ensures that if many jobs are planned to run at a certain
time, they will not all start after the scheduled start time.

9. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
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a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

10. Click the Alert tab; the Alert page opens. Use the Alert page to define the
alerting criteria for an archive or backup job.
a. In the Triggering Condition area, the only condition is File

Archive/Backup Failed. This condition indicates that an alert is triggered
automatically if the archive or backup fails to run.

b. In the Triggered Actions area, select the actions that occur as a result of
the triggering condition You can choose from the following actions:

SNMP trap
An SNMP trap is sent to any NMS, console, or terminal when the
condition occurs.

TEC / OMNIbus Event
A IBM Tivoli Enterprise Console event is sent when the condition
occurs. The Tivoli Enterprise Console administrator can write
correlation and automation rules to analyze Tivoli Storage
Productivity Center events according to the event definitions
specified in the tivoliSRM.baroc file (provided with the product). It
also performs responses such as sending further notification,
creating or updating trouble tickets, running programs, and so on.

Login notification
The alert is sent to a Tivoli Storage Productivity Center user. The
user receives the alert upon logging in to Tivoli Storage
Productivity Center. In the Login ID field, type the user ID.

Login ID
The ID of the user who receives alert notification upon logging on
to the system.

Windows Event Log, UNIX Syslog
The ID of the user who receives alert notification upon logging on
to the system.

Event Type (Windows Event Log only)
The type of event that is recorded to the OS log.

Facility (UNIX Syslog only)
The location where the UNIX Syslog is sent. You can select User or
Local.

Level (UNIX Syslog only)
The level of UNIX Syslog event. You can select Informational,
Notice, Warning, Error, Critical, or Alert.

Run script
A script is run when the condition occurs. Click Define to specify
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the script that is run when the triggering condition occurs. The
parameters listed in the Specify Script window are passed to the
script when the alert is triggered

E-mail An e-mail is sent. Click Add or Delete to edit the list of e-mail
addresses to which an e-mail is sent. Click Edit e-mail to change
the actual e-mail message.

11. Save the archive or backup:
a. Click File > Save. The Save As window opens.
b. In the Specify File Archive/Backup Action name field, type a name for

the job and click OK. The new job is listed in Data Manager > Policy
Management > Archive/Backup as <creator>.<job name>.

View and edit an Archive/Backup job
Learn how to edit IBM Tivoli Storage Manager archive and backup jobs that were
defined to run against the files selected from Data Manager reports or from reports
you have generated yourself.

Each archive and backup that you have created appears as a node under
Archive/Backup.

To view and edit a Tivoli Storage Manager archive or backup job, complete the
following steps:
1. In the Navigation tree pane, expand Data Manager > Policy Management >

Archive/Backup. Select the archive or backup job that you want to edit.
Information about the job appears in the content pane. All the user-defined
information can be edited.

2. Change the description for the archive/backup job.
3. In the Options tab, you can select the Archive/Backup options. You can change

whether the job is an archive or a backup, and add or change any additional
Tivoli Storage Manager commands that should be run with the job.

4. In the Files tab the files that were included in the job are listed.
5. In the When to Run tab, select how often to run and how to handle time

zones. You can change the How often to run and How to handle time zones
settings.

6. In the Alert tab, File Archive/Backup Failed is the only Triggering-Condition.
In Triggered-Actions, change the action you wish to occur if the job fails. You
do not need to select any of the actions. Notification will be written to the error
log by default.

7. Select File > Save. Name the Archive/Backup job. After you save a the job, an
entry for it will appear under the Data Manager > Policy Management >
Archive/Backup > <Creator>.<Name>.

Add additional files to an archive/backup job
Add files to an existing IBM Tivoli Storage Manager archive or backup job from a
report.

To add files to an existing Archive/Backup job, complete the following steps:
1. Add files to an existing Tivoli Storage Manager archive or backup job from a

report
2. Click on the files you want to add to an archive or backup job. Use ctrl + click

to select multiple, non-consecutive files; use shift + click to select multiple,
consecutive files.
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3. Right click on the report and select Add to an existing archive/backup job
from the pop-up menu. The Archive/Backup Job Selection window appears.

4. Select the archive or backup job to which you want to add the files from the
list box.

5. Click OK to add the files. The Archive/Backup - Files window appears and
shows the file(s) you added to the selected job.

Working with storage resource groups
Use storage resource groups to organize logically related storage entities into
named groups. For example, a storage resource group that represents a business
critical email application might include all the hosts that participate in the email
application cluster, the storage subsystems that provide storage to the application,
and the switches and fabrics through which the application’s data is configured to
travel.

You can use storage resource groups as input to the SAN Planner for planning and
provisioning considerations. For example, if a storage resource group represents a
business critical email application, you can use that group as input into the SAN
planner to help consistently determine when and where to add capacity to the
application while minimizing the manual entry of storage entities.

Storage resource group management
Use the storage resource group management list panel to view, create, and delete
storage resource groups.

This panel contains the following information about each storage resource group:

Storage resource group name
Specifies a user-defined name of the storage resource group.

State Specifies the state of the storage resource group:

Normal
The storage resource group is operating normally.

Warning
At least one part of the storage resource group is not operating or
has serious problems.

Critical
The storage resource group is either not operating or has serious
problems.

Missing
The storage resource group was previously discovered by IBM
Tivoli Storage Productivity Center, but was not detected in the
most recent discovery.

Unknown
The storage resource group was discovered but is not recognized
by IBM Tivoli Storage Productivity Center.

Note: The state of a storage resource group might display as
Unknown after it is created. This occurs because the status of a
new storage resource group might not yet be updated when the
Storage Resource Group Management panel is redisplayed. To
resolve this issue, exit the Storage Resource Group Management
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panel, wait for the processing of the group to complete, and open
the Storage Resource Group Management panel again to view the
updated State.

Type The type of storage resource group. Two types are available:

General
A storage resource group made up of a combination of storage
entities such as storage subsystems, switches, fabrics, and other
entities. These storage entities can be a logical grouping based on a
particular application or usage, such as accounting-related storage
entities.

Cloud Capacity Pool
A storage resource group used specifically for cloud automation.
This type of storage resource group is used by applications that
provide cloud automation services.

Description (optional)
Displays the user-defined description for the storage resource group.

Create Creates a storage resource group that you selected.

Delete
Deletes a storage resource group that you selected.

Refresh Table
Refreshes the storage resource group management table with the most
recent changes.

Create or Edit a Storage Resource Group
Use the Create or Edit Storage Resource group panel to create or modify storage
resource groups.

To create a storage resource group:
v In the navigation tree, expand IBM Tivoli Storage Productivity Center, click

Storage Resource Group Management, then click Create... in the content pane.
v In the navigation tree, expand IBM Tivoli Storage Productivity Center >

Topology, click a node that represents a storage entity, right-click an entity that
appears in the content pane, and select Add to new Storage Resource Group...
from the drop-down menu.

To edit a storage resource group:
v In the navigation tree, expand IBM Tivoli Storage Productivity Center, click

Storage Resource Group Management, then click the magnifying glass icon next
to the storage resource group you want to edit.

v In the navigation tree, expand IBM Tivoli Storage Productivity Center >
Topology, click Storage Resource Groups, right-click the storage resource group
you want to edit in the content pane, and select Launch Detail Panel from the
drop down menu.

Field Descriptions

Creator
Displays the user name of the creator.

Name Displays the name of the storage resource group or unnamed, if it is not yet
named.
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Description
Optional: Displays the user-defined description for the storage resource
group.

Selected Elements
Lists the elements selected to be members of this storage resource group.

Add Adds one or more selected elements to the list.

The Storage resource group element selection panel is displayed.

Remove
Removes one or more selected elements from the Selected Elements list.

Group Type
Specifies the type of storage resource group to create.

General
A storage resource group comprised of a combination of storage
entities such as storage subsystems, switches, fabrics, and other
entities. These storage entities can be a logical grouping based on a
particular application or usage, such as accounting-related storage
entities.

Cloud Capacity Pool
A storage resource group used specifically for cloud automation.
This type of storage resource group is used by applications that
provide cloud automation services.

Default Provisioning Profile
Lists the available provisioning profiles which can be associated with
storage resource groups. The list also includes None. If this storage resource
group is used as input to the SAN Planner, the settings defined in this
profile will be used to pre-populate the planner inputs.

Create a New Profile
Opens the Provisioning Profile creation wizard. When you complete the
wizard, the Provisioning Profile list is updated.

User-defined property 1 (UDP1)
Specifies any user-defined properties that will be used by the topology
viewer to provide custom groupings.

User-defined property 2 (UDP2)
Specifies any user-defined properties that will be used by the topology
viewer to provide custom groupings.

User-defined property 3 (UDP3)
Specifies any user-defined properties that will be used by the topology
viewer to provide custom groupings.

Storage Resource Group Element Selection
Use the Storage Resource Group Element Selection panel to select the storage
entities that you want to include in a storage resource group. The storage entities
that you can select are displayed in the topology viewer.

Available elements section

Displays the storage entities that you can include in a storage resource group. Use
the topology viewer to select storage entities. See Overview of Topology Viewer for
more information about the topology viewer.
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Topology viewer
Use the topology viewer to select the storage entities that you want to
include in a storage resource group. To do this, perform the following
steps.
1. Open a detailed view of a storage entity type on the topology viewer's

Overview page.
2. Expand the storage entity type to view the storage entities that are part

of that type.
3. Select the storage entities you want to include in the storage resource

group.
4. Click >>.

Selected elements section

>> Click >> to move the selected subsystems into the Selected Elements pane.

<< Click << to remove the selected subsystems from the Selected Elements
pane.

Selected Elements
Displays the storage entities that are included in a storage resource group.
You can include the following entities in a storage resource group:
v computer (vm, physical or hypervisor)
v computer disk (including vm disks)
v fabric
v switch
v other entities
v storage subsystem
v storage pool
v subsystem disk
v subsystem volume
v tape drive
v tape library
v tape media changer
v other storage resource groups

Restriction: For storage resource groups that are defined as a Cloud
Capacity Pool type, you can only include IBM SONAS and Storwize V7000
Unified systems.

OK Click OK when you are satisfied with all your selections. The Create
Storage Resource Group panel displays with your selections.

Cancel
Click Cancel if you do not want to add storage entities to a storage
resource group. The Create Storage Resource Group panel displays. No
data is saved.

Working with storage resource group sessions
This topic describes viewing and deleting replication sessions that are created in
the SAN Planner wizard for a storage resource group.
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You can delete the replication session from IBM Tivoli Storage Productivity
Center and optionally also from IBM Tivoli Storage Productivity Center for
Replication.
1. In the navigation tree pane, expand Replication Manager > Storage Resource

Group Sessions. A table of the currently defined storage resource group
sessions is displayed in the content pane.

2. To select a storage resource group session to delete, click a row in the table.
You can use Ctrl+click and Shift+click to select multiple sessions
simultaneously.

3. Click Delete Storage Resource Group Session. Tivoli Storage Productivity
Center does not automatically delete the replication session from Tivoli Storage
Productivity Center for Replication. A dialog box opens enabling you to specify
how you want to delete the session. You can select from the following options:
v Click Yes to remove the selected replication session from the Tivoli Storage

Productivity Center database and the Tivoli Storage Productivity Center for
Replication database.

v Click No to remove the selected replication session from the Tivoli Storage
Productivity Center database only.

v Click Cancel to close the dialog box without deleting the selected replication
session from the Tivoli Storage Productivity Center database or Tivoli Storage
Productivity Center for Replication database.

Working with scripts
Use the triggered action facility to run scripts based upon conditions/alerts that
are detected within your storage environment. Use the scheduled action facility to
run scripts according to the schedule that you define, without having to associate
the script with an alert.

Both the triggered action and scheduled action facilities are script-based, allowing
you to use any third-party tools for actions, such as recovery and provisioning.

Running scripts with alerts
Monitoring, alerting, and policy management jobs enable you to use the triggered
action facility to run scripts based on storage events that you define.

The triggered action facility allows you to define thresholds and constraints that
result in notification or action. A script can be run when a job fails, an alert
condition is detected in a storage resource, a constraint is violated (Data Manager
only), or a quota is exceeded (Data Manager only). The triggered action facility is
script-based, allowing you to use any third-party tools for actions such as recovery
or provisioning.

Perform the following steps to run a script in response to a condition in a job:
1. Create or edit a monitoring, alerting, or policy management job. For example,

the following jobs enable you to define a condition that triggers a script:
v Data Manager:

– Monitoring > <all_monitoring_jobs>

– Alerting > <all_alert_jobs>

– Policy Management > Constraints

– Policy Management > Quotas

– Policy Management > Scheduled Actions
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v Data Manager for Databases:
– Monitoring > <all_monitoring_jobs>

– Alerting > <all_alert_jobs>

– Policy Management > Quotas

– Policy Management > Scheduled Actions

v Disk Manager:
– Monitoring > Subsystem Performance Monitors

– Alerting > Storage Subsystem Alerts

v Fabric Manager:
– Monitoring > Switch Performance Monitors

– Alerting > <all_alert_jobs>

2. Check Run Script on the Alert page for the job.
3. Click Define. The Specify Script dialog box displays.
4. Enter the name of the script in the Script Name field. This script name is used

to tell the server what script to send to the agent. If the script sent by the
server is run by the agent, the name of the script will not be the name you
specify in the Script Name field. Instead, the agent names the script as
temporary file, runs it, then deletes it after the script has run. Because of this,
you should not have code in your script that depends on this script name.

5. Specify where you want the script to run in the Where to Run field. You can
select a specific agent, or the triggering computer. For example, if a file system
alert is triggered on a on a specific computer, you would typically want the
script to run on the computer that triggered the alert. (For some types of alerts
such as Job Failed, you will not have the option to run the script on the
triggering computer. Here you can run the script on any agent you choose.)

6. The Script Parameters section displays what parameters will be passed to the
script when it is run. Each triggering condition passes different parameters. The
parameters will be passed in the order specified on the dialog box.

7. Click OK.

Running scripts using scheduled actions
Use the scheduled action facility to run a script according to a schedule that you
define. The scheduled action facility is available in Data Manager and Data
Manager for Databases.

Use scheduled actions to run scripts against selected computers and computer
groups. The scheduled actions facility is script-based, so you can use any
third-party tools for actions, such as recovery, or provisioning. You can schedule
scripts to run:
v Immediately
v Once at a specified time and date
v Repeatedly according to a schedule you specify

Scheduled actions are different from triggered actions. Use triggered actions to run
scripts based upon conditions and alerts that are detected within your storage
environment. Use scheduled actions to run scripts according to the schedule that
you define, without having to associate the script with an alert.

To create a scheduled action, complete the following steps:
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1. In the Navigation tree pane, expand Data Manager > Policy Management >
Scheduled Actions or Data Manager for Databases > Policy Management >
Scheduled Actions.

2. Right-click Scripts, and click Create Script. The Create Script panel opens.
3. In the Description field, type a brief description of the job.
4. Select computers and computer groups against which to run the action:

a. In the Available field, click the computers and computer groups against
which you want to run the action. You can select individual computers as
well as computer groups that you have previously defined using the group
facility. Cluster resource groups in a PowerHA or MSCS clustered
environment are listed as computers.

b. Click . The computers and computer groups are moved to the
Current Selections field.

5. Click the Script Options tab; the Script Options page opens. Use this page to
select the script that you want to run against the selected computers and
computer groups.

6. Select a script from Script Name. The scripts that appear in Script Name are
stored in the \<TPC_installation_directory>\scripts directory on the Data
server. The default installation directory where scripts are located is:
v Windows: C:\Program Files\IBM\TPC\data\scripts

v UNIX, Linux: /opt/IBM/TPC/data/scripts or /usrs/IBM/TPC/data/scripts

Note: The scripts that appear in the Script Name list are stored on the
computer where the Data server component is located. If you want to run a
script that is stored on a Storage Resource agent or Data agent, you must type
the name of that script in the Script Name field.

7. Click the When to Run tab; the When to Run page opens. Use the When to
Run page to specify when the scheduled action is run.

8. In the How often to run area, schedule how often you want to run the script
associated with the action. You can choose from the following options:

Run Now
Run the script immediately.

Run Once at
Run the script once at a specified time and date. You can use the
drop-down lists to specify the month, day year, and the hour, minute,
and AM/PM.

Note: TheTivoli Storage Productivity Center framework that starts the
Tivoli Storage Productivity Center jobs finds all jobs in an interval
between one minute to the scheduled time and the scheduled start
time. This process ensures that if many jobs are planned to run at a
certain time, they will not all start after the scheduled start time.

Run Repeatedly
Run the script repeatedly according to a schedule you specify. You
can:
v Use the drop-down lists to specify the month, day year, and the

hour, minute, and AM/PM when the job should begin running.
v Indicate how often the job should run. You can use the drop-down

lists to specify the number of minutes, hours, days, weeks, or
months.
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v Indicate which days on which run the job. A check mark is
displayed next to the days that you select.

9. In the How to Handle Time Zones area, indicate the time zone to be used
when scheduling and running the policy. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run it at:
a. 9:00 AM of the time zone where the Data server resides
b. 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the job will run at 7:00 AM on an
agent located in the PST time zone.

Use the timezone that the server runs in
Select this option to use the time zone of the location where the Data
server resides.

Use this timezone
Select this option to indicate a specific time zone for when to run the
job. When you select this option, a drop-down list is activated. Select
the timezone from this drop-down list.

10. Click the Alert tab; the Alert page opens. Use the Alert page to define the
alerting criteria for a scheduled action.

11. In the Triggering Condition area, the only condition is Script Failed. An alert
is automatically triggered if the scheduled action fails to run.

12. In the Triggered-Actions pane, select the actions that occur as a result of the
triggering condition. For an explanation of triggered actions, see “Triggered
actions for alerts” on page 1453.

13. Save the scheduled action:
a. Click File > Save. The Save As window opens.
b. In the Specify Script name field, type a name for the job and click OK.

The scheduled action is displayed in the navigation tree pane.

How scripts are run
Scripts can be run from the Data server, Data agents, or Tivoli Storage Productivity
Centers.

During installation, IBM Tivoli Storage Productivity Center creates a directory on
every server and agent computer called: \<install_directory >\scripts, where
<install_directory > represents the directory where the agent or server is
installed. The default installation directory is:
v (Windows Data agents) C:\Program Files\IBM\TPC\ca\subagents\TPC\Data\

scripts

v (UNIX, Linux Data agents) /opt/IBM/TPC/ca/subagents/TPC/Data/scripts or
/usr/tivoli/ep/subagents/TPC/Data/scripts

v (Windows Storage Resource agents) C:\Program Files\IBM\TPC\agent\scripts

v (UNIX, Linux Storage Resource agents) /opt/IBM/TPC/agent/scripts or
/usr/tivoli/ep/subagents/TPC/Data/scripts

v (Windows Data server) C:\Program Files\IBM\TPC\Data\scripts

v (UNIX, Linux Data server) /opt/IBM/TPC/Data/scripts or /usr/IBM/TPC/Data/
scripts

When a script is run:
1. The Agent looks in the agent's local \scripts directory; if the Agent can resolve

that script name, it is executed from that location.
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2. Otherwise, (if the agent cannot resolve the script name) and the Agent is
configured to accept scripts from the server, the server looks in the local
\scripts directory. If the server can resolve that script name, it loads that script
and sends it to the agent where you designated the script to be run.
When running a script against a NAS filer, the script is run from the agent
assigned to the file system where the triggering condition occurred.

3. The Agent receives the script, names it as a temporary file, and runs it.
4. After the Agent has finished running the script, the temporary file is deleted.

Because the script is handled in this way, any script which is written to redirect
any output must specify a fully-qualified unique directory path for that output.

There are two main reasons to run a script:

v In response to an alert
v For batch reports

There are two reasons why a script might not run when sent by the server:

v The script exists in an agent's \scripts directory. In this case, the agent ignores
the script sent by the server and run its local version.

v If you did not check the Agent may run scripts sent by server option in the
installation parameters screen, the agent ignores the script sent by the server.
If you selected the Agent may run scripts sent by server option in the
installation parameters screen, the agent runs scripts sent by the server.
The advantage of selecting this option is you need only store one copy of the
script in the \scripts directory for the server and do not have to keep a copy of
the script on every agent computer. When a script must be run on a particular
agent, the server accesses the script from the local \scripts directory and sends
it to the agent to be run.

Note:

– You can change this option by editing the honorSentScripts parameter in the
agent.config file. The agent.config file exists in every installation directory
for the agent. See IBM Tivoli Storage Productivity Center and IBM Tivoli Storage
Productivity Center for Replication Installation and Configuration Guide for
information about the agent.config file.

– After a Storage Resource agent is deployed, you can change the script
configuration in the user interface. In the navigation tree, expand
Administrative Services > Data Sources > Data/Storage Resource Agents.
Select the target Storage Resource agent from the list, then open the Select
Action menu and select the Enable Scripts or Disable Scripts option as
appropriate.

When the script is deployed to the agent, it is named as a temporary file. After the
agent has finished running the script, the temporary file is deleted.

If the Agent may run scripts sent by server option is cleared, you must make sure
that the script is stored in every \scripts directory for the agent. If the Agent may
run scripts sent by server option is checked, the server deploys the script to the
agent computer that has the low free space condition. In this case, you must ensure
that the script exists in the \scripts directory for the server, and not on any of the
\scripts directory for the agents.

Note:
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v A good practice is to store the scripts you want to run globally (across all your
agents) on the server. Store the scripts you want to run locally on the agent
computers where you want them to run.

v When running a script for Data agents (4.1.1 and earlier), the job is immediately
indicated as successfully run. Tivoli Storage Productivity Center does not wait
for the script results. If there are any script errors, the errors are not reflected in
the job status.

How the server and agent resolve script names
An IBM Tivoli Storage Productivity Center server processes requests for agents
running under UNIX, Linux, and Windows.

When associating and running scripts with triggered and scheduled actions, the
Tivoli Storage Productivity Center server resolves the names of those scripts based
on the following criteria:
v The OS under which an agent is running
v How the script name is specified on the Specify Script dialog box

Agent and Operating System

The operating system under which an agent runs determines the scripts that can
be run by that agent:

UNIX, Linux operating systems
An agent running under a UNIX or Linux operating system will not run or
receive (from the server) scripts that have an extension. Agents running
under UNIX or Linux only accept and run script files that do not contain
an extension within their name. The first line in a script file determines
what interpreter is needed to run the script.

Windows operating systems
An agent running under a Windows operating system will only run or
receive (from the server) scripts that have an extension. The extension of a
script file determines what interpreter is needed to run the script.

Specifying a Script Name

Use the Specify Script dialog box when associating a script with a triggered or
scheduled action. Enter the name of a script on the Script Name field to associate
that script with the action you want to perform.

The name of the script you enter might or might not contain an extension
(including an extension is optional). Depending on the agent that receives the
script, the following occurs after a triggered or scheduled action that contains a
script is run:

Agent running under UNIX or Linux operating systems
If the specified script name contains an extension, the agent ignores the
extension and searches for a file of the same name (without an extension).
For example, if you enter backup.vbs in the Script Name field, a UNIX or
Linux agent will search for a file with the name backup. If the script exists,
UNIX or Linux will read the first line of the script and use the appropriate
interpreter to run the script. If the file does not exist, the triggered or
scheduled action will not run the script.

Agent running under Windows operating systems
If the specified script name contains an extension, the agent will search for
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a file of the same name/extension. For example, if you enter backup.vbs in
the Script Name field, an agent will search for a file with the name
backup.vbs. If the script does exist, the agent will determine what
interpreter is needed to run the script based on its extension. If the file
does not exist, the triggered or scheduled action will not run the script. If
the specified script name does not contain an extension, an agent will look
for the file name in the following order (based on its extension): .com,
.exe, .bat, .cmd, .vbs, .vbe, .js, .jse

The process for script name resolving enables you to run scripts with the same
name across multiple operating systems. To run a script on both a UNIX or Linux
and Windows operating systems, you must have two versions of that file on either
the server or the agent. For example, if you want to run a provisioning script
against a UNIX or Linux and Windows agent, you must have two versions of that
file (provision.bat and provision) stored in the \scripts directory on either the
server or agent.

Using the topology viewer
This topic describes how to use the topology viewer to view detailed information
about your storage environment and monitor entities and groups of entities.

You can view health status, performance, and other details about switches,
computers, storage subsystem servers, fabrics, and other entities. To launch the
topology viewer, expand IBM Tivoli Storage Productivity Center Topology in the
Navigation Tree pane.

To display detailed information about an entity (for example, the host name of a
computer, the used and unused capacity of a storage subsystem), right-click the
entity and select Launch Detail Panel.

To select an entity in the graphical view, click the entity image. In the table view,
click the name of the entity. To make multiple selections, press CTRL and click.

Note:

v The availability of certain action items depends on the entity class and view
level.

v When you right-click an object in the graphical view, a context menu is
displayed. The action items in this menu are identical to the action items
displayed when you right-click the corresponding object in the table view and
click the arrow in the Action field.

v If the discovery process is not completed and there are entities in the
environment that have not been rendered into the current view, the view will
build dynamically as entities are discovered.

v Some columns and fields displayed within the Topology Viewer might not be
populated with data for the storage resources that you are monitoring. Columns
and fields appear empty if you have not configured Tivoli Storage Productivity
Center to discover or collect the information intended for those columns and
fields. Use discovery, probe, ping, or scan schedules to ensure that you collect
information for all the columns and fields that appear in the Topology Viewer.
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The topology viewer
This topic describes how the topology viewer provides a graphical representation
of the physical and logical resources that have been discovered in your storage
environment by IBM Tivoli Storage Productivity Center.

The information displayed by the topology viewer is collected by discovery,
probing, performance data collection, and alerting. The topology viewer consists of
two views, a graphical view and a table view, organized vertically with the
graphical view over of the table view. The table view shows the same information
as the graphical view, but in a tabular format.

The topology viewer supports four levels of detail, from a high-level overview of
the entire storage environment to detailed information about individual entities.
This allows you to view as much or as little detail as you need.

Overview
A global, highly aggregated view of the entire storage environment. This is
the default view when you expand IBM Tivoli Storage Productivity
Center > Topology.

Groups level (L0)
This level focuses on groups of a particular type. The default groups are:
v Computers: All discovered computer groups in your storage

environment
v Fabrics: All fabric groups in your storage environment. A fabric is a

network of entities that are attached through one or more switches. The
topology viewer also displays Virtual SANs (VSANs) and Logical SANs
(LSANs).

v Switches: All switches in your environment.
v Storage: All storage subsystems and tape libraries in your environment.
v Other: All entities that are discovered in your environment but that do

not fit in either the computer, fabric or storage classes.

The groups level is the default level upon launching the topology viewer
by clicking either Computers, Fabrics, Switches, Storage or Other under
the Topology node. The groups level shows one or more groups of entities
that correspond to the topology class that you selected. Information in the
graphical view at this level can include any individually pinned entities.

Group level (L1)
This level focuses on one selected group and its related entities (for
example, a group of computers). At L1, individual entities can be shown
by expanding the group box. You can also display lines representing
connections between entities or between entities and groups.

Detail level (L2)
This level focuses on individual entities (for example, a single computer,
switch, subsystem, or tape library) and the paths to associated logical and
physical entities. This level shows details all the way to the port level.
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In addition, the topology viewer depicts the relationships among resources (for
example, the disks comprising a particular storage subsystem). Detailed, tabular
information (for example, attributes of a disk) is also provided. With all the
information that the topology viewer provides, you can more quickly and easily
monitor and troubleshoot your storage environment and perform critical
storage-management tasks.

Topology viewer interface controls
Progressive information disclosure reduces the visual complexity of a system. In
the topology viewer, this means that you can identify and focus on entities in your
storage environment that are of particular interest and hide other entities from
view.

The tabs displayed in the tabular view represent classes of entities (a physical
device or logical resource discovered byIBM Tivoli Storage Productivity Center ).
Individual entities (for example, a computer named accounting1, a tape library
named tapelib4) are listed in their corresponding tabs. Entity attributes (for
example, the operating system of a computer) are organized into table columns.
The classes entities are assigned to are Computers, Fabrics, Storage Subsystems,
and Other.

Note: The Other class contains entities discovered by Tivoli Storage Productivity
Center but for which the type cannot be determined.

Figure 39. Topology overview
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Changes to the graphical view or the tabular view are automatically applied to the
other view, keeping both views synchronized. For example, if an entity is selected
in the graphical view, it is also highlighted in the table view.

As more of your resources are discovered and displayed in the topology viewer, it
is not possible to see all the discovered resources in a single topology window. To
make it easier for you to find the resources you want to view, Tivoli Storage
Productivity Center provides a tool called the minimap. The minimap allows you to
shift the focus of the topology viewer to different areas within a particular view.
The minimap is a small window within the topology view.

Linux/AIX users: you must use SHIFT+ALT+mouse drag to reposition the
minimap.

The minimap provides a miniature representation of the current topology view.
Clicking on the minimap displays a multidirectional cursor that allows you to
move the focus of the current topology view in any direction. As you drag the
cursor around the minimap, the topology view will move accordingly. This makes
navigating around complex topologies much easier.

The minimap uses the following colors to indicate the aggregated health status of
groups:
v Green (normal): All entities in the group are operating normally.
v Yellow (warning): At least one entity is operating normally, and one or more

entities have a health status of warning, critical, unknown, or missing.
v Red (critical): The status of all entities is either critical or warning.
v Gray (unknown): None of the entities in the group has an known health status.
v Black (missing): All of the entities of the group are missing.

In the Configuration History page, the minimap uses the following colors to
indicate the aggregated change status of groups:
v Blue (changed): One or more entities in the group changed (an addition or

deletion of an entity is considered a change).
v Gray (unchanged): All entities in the group are unchanged.

Included in the minimap are shortcuts that you can click to launch the Data Path
Explorer or to view or change the topology settings:
v To launch the Data Path Explorer, select one or more hosts, subsystems, disks,

volumes, or Mdisks and click the Data Path Explorer shortcut.

Figure 40. Minimap. You can click the shortcuts to launch Data Path Explorer or to view or
change topology settings.
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Note: The shortcut to Data Path Explorer is not available in the Configuration
History topology view.

v To view or change the topology settings, click the Topology Settings shortcut.
The Settings window displays for you to specify the type of overlays to display,
the type of filtering to perform, whether connections between topology objects
should display, and whether the Zone tab should display in the table view.

The graphical view:

This topic describes how the topology viewer groups entities that share certain
characteristics. A collapsed group consisting of many entities or subgroups takes
up much less space in the graphical view than the individual entities or subgroups
would.

In the topology viewer, you can expand or collapse a group or subgroup by
clicking the plus (+) character or minus (-) character, respectively, located in the
group box.

Note: Pinned entities within a group remain visible, even when the group is
collapsed.

By default, the topology viewer groups entities by class (computers, fabrics,
switches, storage subsystems, and other entities). However, you can create
additional groups (but not additional classes) using your own criteria. These
custom groups can provide new perspectives on and important information about
your storage environment. For example, you can create a special group belonging
to the computer class that consists of computers that use the same operating
system or storage subsystems of a particular model.

The following figure shows an expanded computer group representation in the
graphical view:

The title bar of the group box shows the following:
v An icon indicating the health status of the group (for example, normal).
v An icon indicating the types of entities contained in the group.
v The class of group (for example, computers).
v The grouping criterion (for example, Windows).
v The total number of entities in the group. If filtering is turned on, the number in

the brackets is the ratio of displayed entities to total entities. For example, 5/10
indicates that 5 entities are shown out of 10 total entities.

The topology viewer provides the following default groups. These groups are
accessible, if they exist in your topology, in the overview or by expanding the
primary default groups (Computers, Fabrics, Switches, Storage and Other) that
are displayed when you first launch the topology viewer.

Figure 41. Computer group
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Table 40. Group locations in the topology viewer

Type of group Description Path to group in topology viewer

Computers All the computers that are
discovered in your environment
or a group of computers
associated with a particular fabric
or switch

Computers

Fabrics All the fabrics and virtual fabrics
that are discovered in your
environment

Fabrics

Storage All the storage-related devices
that are discovered in your
environment

Storage

Other All the entities that are discovered
in an environment but that do not
fit in either the computer, fabric,
or storage categories

Other

Fabric All entities (for example,
switches) that belong to or are
related to a fabric

Fabrics > Fabric

Virtual Fabric All entities that belong to a
virtual fabric

Fabrics > Fabric

Switches A set of switches Fabrics > Fabric

Subsystems A set of subsystems Storage > Subsystems

Tape libraries A set of tape libraries Storage > Tape Libraries

Device Devices associated with a
particular entity (for example, a
computer)

Computers > Computers

Volumes A set of volumes that are
associated with an entity

Different types of volumes groups exist at
the L2 level of each of the four main
categories: Computers, Fabrics, Storage,
Other

HBA A set of HBAs that are associated
with an entity

Computers > Computers > Computer

Disks A set of disks that are associated
with an entity

Storage > Subsystems > Subsystem

Pools A set of pools that are associated
with an entity

Storage > Subsystems > Subsystem

FC Ports A set of FC ports that belong to
an entity

Fabrics > Fabric > Switch

Media All media attached to an entity Storage > Tape Libraries > Tape Library

Media Changers All media changers attached to an
entity

Storage > Tape Libraries > Tape Library

Tape Drives All tape drives attached to an
entity

Storage > Tape Libraries > Tape Library

Tape Drive All ports on a tape drive attached
to an entity

Storage > Tape Libraries > Tape Library

Switch All ports on a switch. Due to the
large number of ports on some
switches, ports are shown as FC
port groups within the switch

Fabrics > Fabric > Switch
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As shown by the tabs of the graphical panel (L0:Computers, L1:Computers, and
L2:Computers), other views have been opened but are hidden by the overview.
The topology tab in the table view displays information about the entities in the
groups. You can use the minimap to shift the focus in the view.

Right-click the object and select Open Detail View to view entities in a more
detailed view. For example, at a high level an object representing a storage
subsystem is depicted as an icon with a label. In a more detailed view, the same
storage subsystem can be rendered as a box containing sub-entities representing
disks, with the corresponding table view showing attributes of each individual
disk. At yet another detail level, the ports of the storage subsystem might be
shown as well as status information for each port.

GUI Topology Viewer has new L0 and L1 Switches views:

The IBM Tivoli Storage Productivity Center GUI has a Switches node under the
Topology node. The Switches node opens the new L0 Switches view, from which
you can also access the new L1 Switches view.

Overview
The Overview panel now shows a box with the number of switches
present in your environment.

L0 Switches
The L0 Switches view shows all switches in your environment.

If you right-click on a Switches group, then click Group By, you will get a
dialog box for group settings. You can choose to group by a single group
or you can group by multiple categories:
v ByHealth
v ByUDP1
v ByUDP2
v ByUDP3
v ByFabric
v ByGroupSize

Click OK to close the dialog box and update the group settings.

L1 Switches
The L1 Switches view shows information on a group of switches in your
environment that you selected to display. This also includes connectivity
information: what entities this group is connected to.

L2 Switch
This view shows one switch, with all detailed port and connectivity
information. You can access this view by double-clicking a single switch
icon in either the L0 or L1 Switches view, or through the other Topology
Viewer views.

The table view:

This topic describes how tabs in the table view provide detailed information about
the entities (for example, computers, subsystems, and fabrics) that are relevant in
the current view.
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The following is a list of all the tabs available in the topology viewer. Not all tabs
are visible in all views.

Topology
Detailed information about all the entities in the topology grouped by class
of the entity (computers, fabric, storage, and other).

Computer
Detailed information about any computer in the computer group or groups
in the current topology view.

Fabric Detailed information about fabric groups and virtual fabric groups in the
current topology view.

Switch
Detailed information about switch groups and switch entities in the current
topology view.

Subsystem
Detailed information about volume groups and volume entities in the
current topology view.

Disk Detailed information about disk groups and disk entities in the current
topology view.

Pool Detailed information about pool groups and pool entities in the current
topology view.

Note: One of the columns in the tabular view refers to whether a storage
pool is primordial. A primordial pool represents unallocated storage
capacity on a storage device. Storage capacity can be allocated from
primordial pools to create storage pools. This means that primordial pools
are disk/device sources for allocation of storage pools.

Volume
Detailed information about volume groups and volume entities in the
current topology view.

Tape Library
Detailed information about tape-library groups and tape-library entities in
the current topology view.

Media Changer
Detailed information about media-changer groups and media-changer
entities in the current topology view.

Tape Drive
Detailed information about tape-drive groups and tape-drive entities in the
current topology view.

Other/Unknown
Detailed information about objects in your environment other than
computers, switches, subsystems, and tape libraries in the current topology
view.

FC Port
Detailed information about port groups and port entities in the current
topology view.

Connection
Detailed information about all relationships between objects in the current
topology view.
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Alert Detailed information about all alerts that are associated with entities in the
current view of the topology.

Zone Detailed information about any of the following groups or entities in a
zone. By default, the Zone tab is disabled.
v Fabric groups
v Zone-set groups
v Zone groups
v Computer entities
v Switch entities
v Subsystem entities
v Tape library entities

Cluster
Detailed information about clusters in the current topology view.

Node Detailed information about nodes in the current topology view.

File Pool
Detailed information about file pools in the current topology view.

Filesystem
Detailed information about file systems in the current topology view.

Network Shared Disk
Detailed information in Network Shared Disks in the current topology
view.

Export or Share
Detailed information about exports or shares in the current topology view.

File Set
Detailed information about files sets in the current topology view.

Identifying storage resources using icons:

This topic describes how the topology viewer displays entities and groups of
entities with an appropriate icon based on the entity class.

The storage resource icons can help you quickly and easily identify storage
resources. For example, an entity of class "computer" is displayed in the graphical
view with an icon that resembles a computer.

The following table shows the icons for individual resources and for resource
groups.

Topology Object Icon Group Icon

Computer

Computer HBA

Fabric
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Topology Object Icon Group Icon

Switch

Switch port

Storage subsystem

Storage subsystem port

Storage virtualizer (for example, SAN
Volume Controller, HDS Tagmastore)

Tape library

Tape library media changer

Database volume

File system volume

Storage volume

Other volume

Storage disk

Storage backend disk n/a

Storage pool

Unknown

Note: Unknown entities are entities that are discovered by IBM Tivoli Storage
Productivity Center but that do not have an agent installed or the agent is not
working.
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Identifying icons for storage resources that contain full disk encryption disks

The icons in the following table identify whether a storage system contains
encrypted or encryptable disks. The group icon for encrypted storage disks, pools,
and volumes is the same as the group icons that are shown in the first table.

For more information on supported systems that provide full disk encryption, see
“Supported storage systems providing full disk encryption and solid-state drives”
on page 1427.

Topology Object Encrypted Icon Encryptable Icon

Storage disk

Storage pool

Storage volume

Identifying icons for storage resources that contain solid state drives

A solid-state drive is a storage device that stores persistent data on solid-state flash
memory. The icons in the following table identify whether a storage system
contains solid-state drives. The group icons for storage disk, pool, and volume in
the following table are the same as the group icons that are shown in the first
table.

For more information on supported systems that provide solid-state drives, see
“Supported storage systems providing full disk encryption and solid-state drives”
on page 1427.

Topology Object Icon

Solid-state drive storage disk

Solid-state drive storage pool

The topology viewer and virtual SANs:

This topic describes how Cisco switches support virtual SANs (VSANs), which is
the logical partitioning of a fabric into multiple fabrics. The overall network is
referred to as the physical infrastructure, and the logical fabrics are the VSANs.

SNMP queries to a Cisco switch collect information about the Cisco physical
infrastructure and about any VSANs in that infrastructure. Storage Resource agents
or In-band fabric agents can also collect information about the VSANs but are
unable to collect information about the physical infrastructure. The status of Cisco
physical infrastructures shown in the topology view is determined based on the
status propagated from the VSANs in the infrastructure and the status of the
infrastructure itself. If the status of the physical infrastructure is missing but the
status of all or some of the VSANs in the infrastructure is normal, infrastructure
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information can no longer be collected. This typically indicates that the out-of-band
agent is no longer working properly or that SNMP queries to the Cisco switches
are no longer configured because the switch has been removed from the list of
agents in the Out of Band Fabric node.

The consequences of this situation are illustrated in the following scenario: A fabric
includes a Cisco switch with a VSAN on it. An out-of-band agent on the switch
collects physical infrastructure and VSAN information, and an in-band Fabric
agent collects information about the VSAN. If the out-of-band agent is removed or
Fabric Manager is no longer able to communicate with the agent, IBM Tivoli
Storage Productivity Center still detects the VSAN through Storage Resource
agents or in-band agents, but physical infrastructure information can no longer be
collected. As result, in the fabric topology view, the status of the physical
infrastructure box is shown as missing, while the status of one or more VSANs in
the infrastructure shows as normal. To correct this situation ensure that the
out-of-band agent is configured for the Cisco switch.

The topology viewer and VMware:

This topic describes what the topology viewer displays for VMware support.

The Overview view of the topology viewer displays a count of hypervisors and
virtual machines in the Computers summary.

The L0: Computers view displays the hypervisors and virtual machines in addition
to other computers and includes the grouping By Virtualizer.

The L1: Computer view for a hypervisor displays volumes that were assigned to
the hypervisor and the connectivity to fabrics.

The L1: Computer view for a virtual machine displays volumes that were assigned
to the hypervisor and have been mapped to the VMware computer (virtual
machine) as raw disks.

The L2: Computer view for a hypervisor includes a mapping of virtual machines
and shows the virtual machine disk to physical disk relationship.

The L2: Computer view for a virtual machine displays the physical disk (what the
virtual machine recognizes as a physical disk) to virtual machine disk relationship
and hypervisor connectivity.

Note: IBM Tivoli Storage Productivity Center supports the mapping of storage
between the storage system volume and ESX Server corresponding disk. This
mapping is supported for the ESX Server 3.5 or VirtualCenter 2.5 or later. Previous
versions of ESX Server or VirtualCenter are not supported for the mapping of
storage to the storage system.

Viewing large environments in the Topology Viewer:

In environments where you are monitoring a large number of storage entities, IBM
Tivoli Storage Productivity Center might not be able to display all of those entities
within the Topology Viewer. To avoid this issue, there are some tasks you can
perform to improve overall scalability and performance of the user interface.

If the Topology Viewer is unable to display all the entities in your environment,
the user interface generates javacore and heapdump files in its installation
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directory. It is recommended that you check this directory to determine if this
display problem is occurring in your environment. To do this, perform the
following steps:
1. View the contents of the installation directory where Tivoli Storage Productivity

Center's user interface is installed. The default installation directories are as
follows:
v Windows: C:\Program Files\IBM\TPC\gui\
v UNIX/Linux: /<usr or opt>/IBM/TPC/gui/

2. Determine if javacore and heapdump files appear in the installation directory.
You can identify these files by searching for files that begin with the word
javacore or heapdump and have a .txt or .phd extension. For example:
javacore.20080605.151906.8088.txt and heapdump.20080605.151903.8088.phd.

If these files appear in the installation directory, it might indicate that the display
problem is occurring when you use the Topology Viewer.

There are two methods for working around this issue:
v Reducing the number of open topology views and disable unneeded overlays

(such as the alert, performance, and zoning overlays). The number of topology
views that are open and overlays that are enabled can affect how many storage
entities are able to be displayed in the Topology Viewer.

v Increasing the memory allocation for IBM Tivoli Storage Productivity Center's
user interface component. If reducing the number of open topology views and
disabling unneeded overlays does not correct the problem, you can increase the
amount of memory that is allocated to the user interface to help resolve the
issue.

Reducing the number of open topology views and disabling unneeded overlays:

Perform these tasks to help improve the scalability of the Topology Viewer.

The number of topology views that are open can affect how many storage entities
are able to be displayed within those views. The more views (tabs) that are open in
the Topology Viewer, the more memory is used by the user interface. If the user
interface requires more memory than is available to display all the entities within
the open views of the Topology Viewer, some of the entities are not displayed. To
workaround this problem, close any views that you no longer need to view and
refresh the content of the views that you leave open.

The number of overlays that are enabled in the Topology Viewer can also affect
how many storage entities are able to be displayed. The topology viewer uses color
and icons to indicate the status of objects in the topology and tabular views.
Overlays are colors and icons that used to indicate health, performance, change,
and alerts. To disable overlays that you do not need, complete the following steps:
1. Right-click on any blank space within a topology view.
2. Select Global Settings... from the pop-up menu.
3. Uncheck the overlays you do not need to view. For example, clear the

Performance and Alert check boxes.
4. Click OK to accept the changes. The content of the open views within the

Topology Viewer are automatically refreshed according to your changes.
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Increasing the memory allocation for the user interface:

Perform this task to allocate more system memory to the IBM Tivoli Storage
Productivity Center user interface.

Increasing the amount of allocated memory might enable the user interface to
correctly display a large number of storage entities in the Topology Viewer. This
task is generally recommended and encouraged in larger environments.

To do this, perform the following steps:
1. Close any current sessions of the Tivoli Storage Productivity Center user

interface.
2. Locate the batch or script file that is used to start the user interface. This file is

located in the Tivoli Storage Productivity Center installation directory on the
computer where the user interface is installed. The default file names and
installation directories are as follows:
v Windows: C:\Program Files\IBM\TPC\gui\tpc.bat
v UNIX/Linux: /<usr or opt>/IBM/TPC/gui/TPCD.sh

3. Open the tpc.bat or TPCD.sh file in a text editor and locate both occurrences of
the parameter that defines how much memory is allocated to the GUI
component:
v Windows parameter: -mx256M. The default setting for Windows is 256

megabytes.
v UNIX/Linux parameter: -xmx512M. The default setting for UNIX and Linux

is 512 megabytes.
4. Increase the value for all occurrences of this parameter. For example:

v Windows: change -mx256M to -mx1024M

v UNIX/LINUX: change -xmx512M to -xmx1024M

Note: Make sure that the computer on which the user interface is installed has
enough memory to support the setting that you define.

5. Save the batch or script file and restart the user interface.
6. Check the Topology Viewer to ensure that all the monitored storage entities are

displayed as a result of increasing the amount of memory allocated to the user
interface. If you still experience this display problem, repeat steps 1-5 and
further increase the value for the parameter in the startup file.

Contact an IBM service representative if changing the memory allocation for the
user interface does not help resolve the issue.

Arranging entities in a group
This topic describes how to arrange entities in an expanded group.

You can arrange entities within the group box by health status or by entity label if
an expanded group contains many entities. With either type of arrangement, you
can specify ascending or descending order. To arrange entities, follow this
procedure:
1. Right-click the graphical view and select Arrange By.
2. Select one of the following:

v Label (ascending)

v Label (descending)

v Health (ascending)
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v Health (descending)

Checking the status of entities and groups
This topic describes how the topology viewer uses icons to indicate the health,
performance, and operational status for entities.

To quickly check the health, performance, operational, change, and alert status of
entities or groups of entities, look for the following icons associated with a
particular entity or group in the topology. Position the cursor over these icons to
see the health string in text format:

Table 41. Topology status indicators and their icons

Indicator Icon

Health - Normal

Health - Warning

Health - Critical

Health - Unknown

Health - Missing

Operational - Running

Operational - Upgrading

Operational - Missing

Performance - Normal

Performance - Unknown

Performance - Warning

Performance - Critical

Performance - Missing

Change - Objects did not exist at the two
specified time periods

Objects in light gray with no icon

Change - Objects changed between the two
specified time periods

Change - Objects did not change between
the two specified time periods

Change - Objects were created between the
two specified time periods

Change - Objects were deleted between the
two specified time periods
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Table 41. Topology status indicators and their icons (continued)

Indicator Icon

Alert - Critical, Warning, or Informational

The operational status icons (running, upgrading, missing) are displayed by
default and cannot be hidden. However, you can specify whether to display health,
performance, or alert icons. To display these icons, follow this procedure:
1. Right-click a blank space in the background of the graphical panel and select

Global Settings.
2. In the Settings window, select Health, Performance, or Alert. Click OK.

Health status
This topic describes how the topology viewer displays the health status of entities.

The health of an entity falls into one of the following categories:
v Normal: The entity is operating normally.
v Warning: At least one part of the entity is not operating or has serious problems.
v Critical: The entity is either not operating or has serious problems.
v Unknown: The entity was discovered but is not recognized by IBM Tivoli

Storage Productivity Center.
v Missing: The entity was previously discovered by Tivoli Storage Productivity

Center, but was not detected in the most recent discovery.

The health of a group falls into one of the following four categories:
v Normal: All the entities in the group are operating normally.
v Warning: At least one entity in the group has normal status.
v Critical: All entities are either in critical or warning states.
v Unknown: None of the entities in the group have a known health status.

Health indicators for some entities, such as ports, are only normal and critical. In
certain situations, the health of an entity might not be available. This happens, for
example, when the entity is identified as missing. In the graphical view, missing
entities are shown with a semitransparent light gray layer over an existing icon.

Level-indicator buttons on the graphical view (for example, L0:Computers) display
icons for health.

Multiple states from single entities are aggregated into group states or states of
entities, using the following rules:
v If all entities are in the same state, the aggregated state will represent this state.
v You will get an aggregated critical state (red) if:

– One entity is in the missing state and at least one other entity shows a critical
state.

– One entity is in the critical state and at least one other entity shows a missing
state.

v You will get an aggregated normal state if:
– One entity is in the normal state and all others are in normal or undefined

state.
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– One entity is in the undefined state and all others are in normal or undefined
state.

v All other combinations will aggregate to warning state (yellow).
v States displayed within the tabs of the topology view will be aggregated

according to the focus of the specific entity class.
– For Computers and Storage, only the states of these entities are used for

aggregation.
– For Fabric, only the switch status is used for aggregation.
– For level 1 and 0, the states of all displayed entities are used for aggregation.

See “How status is determined for individual resources” for more information
about how the status of individual entities are displayed in the topology viewer.

At the Overview level, the health status indicated by the icon on Overview for the
graphical view indicates the aggregated status of all the groups inside the
graphical view (Computers, Fabrics, Switches, Storage and Other). At the L0
level, the health status indicated by the icon on the L0 tab of the graphical view
indicates the aggregated status of all the groups inside that particular L0 graphical
view (for example, the health status for the L0:Computers view would aggregate
the health status of all discovered computers, including those that are missing,
computers whose health status is critical, computers whose health status is
warning). At the L1 level, the health status indicated by the icon on the L1 tab of
the graphical view indicates the status of the particular group that is the focus of
the view. (The status of the group is based on the aggregated status of the entities
within the group.) The health status for the group is also indicated in the table
view. At the L2 level, the health status indicated by the icon on the L2 tab of the
graphical view is the same as the status of the particular entity that is the focus of
the view. The health status for the entity is also indicated in the table view.

Note:

v At the L1:Fabric level the health status indicated by the icon on the L1:Fabric tab
of the graphical view might not be the same as the overall health of the group,
based upon the aggregated status of all the entities within the group.

v At the L2:Subsystem level, the status of the volume group is the aggregated
status of all the volumes that comprise the group and not the status of the host
that owns those volumes.

v The number of computers that are displayed in the Computers view of the
topology viewer might be more than the number of Tivoli Storage Productivity
Center agents that are deployed in the environment. These additional nodes are
displayed with an "unknown" status. For example, if Tivoli Storage Productivity
Center determines that a node in a fabric is an HBA, that node is displayed in
the Computers view (rather than in the Other view). This situation occurs
because during a probe, inband fabric agents can identify nodes in the topology
viewer as HBAs in computers.
To update nodes that have an unknown status in the Computers view, deploy an
Storage Resource agent on the computer that has the HBA whose WWN is
shown in the topology viewer.

How status is determined for individual resources:

The topology viewer shows the status for individual resources and for groups of
resources. The status of an individual resource is determined by its consolidated
status and the propagated status of its internal resources.
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The following statuses are possible for individual resources:
v Normal: The resource is operating normally.

v Warning: At least one part of the resource is not operating or has potential
problems.

v Missing: The resource was previously discovered by Tivoli Storage
Productivity Center, but was not detected in the most recent discovery.

v Critical: The resource is either not operating or has serious problems.

v Unknown: The resource was discovered but is not recognized by Tivoli
Storage Productivity Center.

Tivoli Storage Productivity Center determines the status of a resource by using its
consolidated status and the propagated status of its internal components:
v A consolidated status is the status that is reported by the top-level resource for

its own hardware. For example, if the cooling fans in a storage system are
stopped and the internal temperature is too high, that status is reported to Tivoli
Storage Productivity Center.

v A propagated status is the combined statuses of the monitored, internal
resources for a top-level resource. For example, if a Warning status is detected
on a volume in a storage system, that Warning status is used to determine the
overall status of the storage system.

The statuses of the following internal resources are used to calculate the status of
top-level resources.

Table 42. Internal resources that are used to determine the status of top-level resources

Top-level resource
Internal resources that are used to determine the status of a
top-level resource

Fabric
, Blades, and ports on blades

Ports that are not blades

Switches

Hypervisor Controllers

Ports on controllers

Virtual machines

Server
, Controllers, and ports on controllers

Volume groups

Monitored directories

516 IBM Tivoli Storage Productivity Center: User's Guide



Table 42. Internal resources that are used to determine the status of top-level
resources (continued)

Top-level resource
Internal resources that are used to determine the status of a
top-level resource

Storage system
Clusters

Controllers

Disks

External disks

Modules

Network shared disks

Nodes

Pools, and the internal resources that are associated with
pools:

v Volumes

v RAID arrays

v Managed disks

Ports

Switch Blades

Logical switches

Ports

Internal resources for a top-level resource might have different statuses. Tivoli
Storage Productivity Center uses the most severe status of an internal resource
when determining the overall status for a top-level resource. For example, in a
storage system, a port might have a Critical status, a pool might have a Warning
status, and a number of controllers might have an Unknown status. In this case,
the overall status for the storage system is Critical because it is the most severe
status that was detected on the internal resources.

Statuses for internal resources are propagated in the following way to determine
the status of a top-level resource:
v If an internal resource has a Critical status, then the related top-level resource

has a Critical status.
v If an internal resource has a Missing status, and no other internal resources have

a Critical status, the related top-level resource has a Missing status.
v If an internal resource has a Warning status, and no other internal resources

have a Critical or Missing status, the related top-level resource has a Warning
status.

v If an internal resource has a Normal status, and no other internal resources have
a Critical, Missing, or Warning status, the related top-level resources has a
Normal status.
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v If an internal resource has an Unknown status, and no other internal resources
have a Critical, Missing, Warning, or Normal status, the related top-level
resource has an Unknown status.

The following table shows some of the possible combinations of statuses and their
resulting, propagated status.

Table 43. Propagation of the statuses for internal resources in the stand-alone GUI

Critical Missing Warning Normal Unknown Resulting status
for top-level
resource

X Unknown

X Normal

X X Normal

X
Warning

X X
Warning

X X X
Warning

X
Missing

X X
Missing

X X X
Missing

X X X X
Missing

X Critical

X X Critical

X X X Critical

X X X X Critical

X X X X X Critical

Operational status
This topic describes how the topology viewer has three categories of operational
status for entities.

The operational status of most entities falls into one of the following three
categories:

Table 44. Categories of operational status for storage entities

Status Description

Running The entity is running.

Upgrading The entity is upgrading.

Missing The entity was not discovered during the
last refresh cycle.

However, some entities display additional operational status. For example,
switches can display a status of OK, Error, Stopped, and other types of status.

Note: When IBM Tivoli Storage Productivity Center no longer detects an entity
that was previously displayed in the Topology viewer, the operational status of
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that entity remains as the last known status before it went missing. This means
that the operational status of an entity is not cleared or reset if that entity is not
found in subsequent data collection jobs.

Performance status
This topic describes performance status details collected for entities.

Performance information is collected for entities in the L2:Switch and L2:Subsystem
views. You can see the performance indicators for individual switches and
subsystems in these two views by turning on the performance feature in the Global
Settings window. This feature is not enabled by default.

The performance status of an entity falls into one of the following five categories:
v Normal: The entity is performing at the expected level.
v Warning: At least one part of the entity is not operating at the expected

performance level.
v Critical: The entity is not operating at the expected performance level.
v Unknown: The performance of the entity is not known.
v Missing: The entity was not found during the last refresh cycle and the

performance status is not available.

The performance status does not get carried up to the L0 and L1 views. It is only
available in the L2:Switch and L2:Subsystem views.

Performance status of an entity is not propagated upwards to its parent entity. For
example, a SAN Volume Controller can cross several critical or warning stress
thresholds (and show as yellow or red in the topology viewer) even though the
underlying pools, disks or volumes do not have a degraded performance status.

After performance has been enabled, you will see a performance status indicator
for any entity in these views that has performance data available. Position the
cursor over a performance icon to see a list of performance metrics for that entity.

To enable the collection of performance information, perform the following steps:
1. Right-click a blank space in the background of the graphical panel and select

Global Settings.
2. In the Settings window, select Performance and click OK.

Change status
This topic describes how the Configuration History topology view displays the
status of entities over time.

The Configuration History feature uses the icons and colors of the change overlay
to indicate historical changes in a SAN configuration's entities. The same icons and
colors are used in the graphical view, table view, and snapshot selection panel. The
following table lists the five possible states of an entity and shows the associated
icons and colors.

State of an entity
Change overlay icon

Change overlay color
indicator

Entity changed between the time that the
snapshot was taken and the time that a
later snapshot was taken. Yellow pencil

Blue background
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State of an entity
Change overlay icon

Change overlay color
indicator

Entity did not change between the time that
the snapshot was taken and the time that a
later snapshot was taken. Light gray circle

Dark gray
background

Entity was created or added between the
time that the snapshot was taken and the
time that a later snapshot was taken. Green cross

Green background

Entity was deleted or removed between the
time that the snapshot was taken and the
time that a later snapshot was taken. Red minus sign

Red background

Entity did not exist at the time that the
snapshot was taken or at the time that a
later snapshot was taken.

Not applicable
Light gray
background

Level-indicator buttons in the graphical view (for example, L0:Computers) display
the change icons.

For groups and other collections, the change overlay provides only aggregated
status. That is, the change status for a group of entities is either “changed” or
“unchanged.” Details for the group as a whole are not provided. Aggregated status
displays in the minimap. In the Configuration History page, the minimap uses the
following colors to indicate the aggregated change status of groups:
v Blue (changed): One or more entities in the group changed (an addition or

deletion of an entity is considered a change).
v Gray (unchanged): All entities in the group are unchanged.

An object that is moved from one group to another group appears only once in the
new group in the graphical view. For example, if the health status of a computer
has changed from Normal to Warning, the Configuration History page displays the
computer as changed in the Warning health group (and no longer displays the
computer in the Normal health group).

Important: If you manually deleted a missing entity from the Tivoli Storage
Productivity Center , the configuration history function rediscovers and displays
the entity in the configuration history viewer as both Missing and in a Normal
state. For example, Entity A (with ID 12) is missing and you decide to manually
delete it by using the Remove From Database option from the pop-up menu for
Entity A in the topology viewer or configuration history viewer. Later, the Tivoli
Storage Productivity Center rediscovers Entity A and assigns it a new ID (ID 22).
The configuration history function treats the same Entity A (with ID 12 and ID 22)
as two different entities and displays them in both Missing and Normal states in
the configuration history viewer. This scenario can also occur if a missing entity is
removed by the Tivoli Storage Productivity Center removed resource retention
function and is rediscovered by theTivoli Storage Productivity Center again at a
later time.

To display a summary of change for the entire row, hover over the changed row.
The summary displays the title of the column. It also displays the old and new
value for each cell or tab that changed. For example, if a group contains one new
entity but everything else in the group is unchanged, the group as a whole
displays as “changed.” If you click the group, the one new entity displays as
“created” and all other entities display as “unchanged.”
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The Change column in the table view also indicates changed entities.

Alert status
This topic describes how the topology viewer displays alert status for all entities in
the current view.

The alert status of an entity falls into one of the following categories:
v Warning: At least one part of the entity is not operating or has serious problems.
v Critical: The entity is either not operating or has serious problems.
v Informational: Related data about the entity is supplied to aid you in decision

making.

When enabled, in the topology viewer the alert overlay is located next to entity
icons, near the pinning indicator. The icon for the alert overlay is a red exclamation

mark for the presence of alerts. In the title bar of groups and tabs, the alert
icon is similarly located near the entity label. The alert overlay is disabled in the
Configuration History page.

To find alerts that are associated with an entity in the table view, click the alert
overlay indicator to go to the corresponding alert on the Alert tab. Or, right-click
the entity to display a pop-up menu and click Show Alerts in Tabular View to go
to the Alert tab and any corresponding alerts that are associated with that entity.
The corresponding alerts are highlighted in purple. When you select an alert in the
Alert tab, the entities that are associated with that alert are highlighted in purple in
the graphical view. Note that more than one entity may become highlighted. An
alert icon for a collapsed group indicates that alerts exist within the collapsed
group.

The alert overlay provides rollup, similar to pinning. If alerts are inside a collapsed
group, the number of alerts within that group are aggregated and indicated in the
collapsed group. All alerts are aggregated into one count, independent of type or
entity involved. Hover over the alert indicator for a tab or group to determine the
total number of alerts that are rolled up into that indicator and the time stamp of
the newest alert.

In the table view, click the Alert tab to view all alerts associated with entities in the
current view of the topology. The Alert tab contains alerts as a hierarchical list. For
configuration analysis alerts, the highest level provides information about which
policy was violated during a particular analyzer run. The next level indicates the
number of times that the policy was violated. This list contains one node for each
policy violation. The Alert tab only lists the policy violations that contain at least
one of the affected entities that are displayed in the graphical view. The remaining
policy violations are filtered. The only exception is the Overview panel where the
Alert tab lists all of the policy violations. Click each violation to view a list of
affected entities. The parent entities for these affected entities are displayed in a
separate column. You can resort the alert list by clicking the headers in the table.
For instance, by clicking on the header for the entity the alert table is reorganized
into a hierarchical list sorted by entity, then by alert type. If no alert was generated
for an entity, the Alert column is blank.

To find an entity associated with an alert in the graphical view, click the alert on
the Alert tab. The corresponding entity and any associated entities are highlighted
(but not selected) in the graphical view. The highlighting is purple.

For more information, see “Viewing alerts” on page 399.
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Creating custom groups
This topic describes how custom groups can be created based on criteria that is
useful and relevant to you.

Custom groups are visible in both the graphical view and the table view. You can
create custom groups using any of the following criteria. The grouping criterion is
displayed in parentheses in the title bar of the group box.

For example, using the topology viewer, you can organize a collection of
computers into groups based on the type of operating system (for example,
Windows, Linux and so on). Using a UDP, you could also create subgroups for
each operating system-based group of computers (for example, the Windows group
could contain subgroups for Windows 2000 and Windows NT). Organization into
groups can also be based on physical location of associated devices; for example,
devices in Lab A could be organized in one group, devices in Lab B could be
organized in another group, and so on. To create these types of groups, use UDPs
(for example, a text string of "Lab A"). To set UDPs use the pop-up menu item,
Launch Detail Panel.

If you specify grouping by UDP, the groups are sorted in alphanumeric order in
the graphical view. If the grouping is by health status, groups are sorted in the
following order: missing, critical, warning, normal and unknown. You can also
specify the arrangement of entities within a group box based on health status and
label.

To group entities, follow this procedure:
1. Right-click a group and select Group By.
2. Select a group-by option. Options differ depending upon the class of the group.

Single Group
All entities are included in one group.

Health
Groups are based on health status (for example, normal or warning).

Model The model of the storage subsystems server (for example, DS8000). This
option is available for subsystem groups only.

OS Type
Groups are based on operating systems. This option is available for
computer groups only.

RAID level
Groups are based on RAID level. This option is available only for pool
groups at the L2:Subsystems level.

Fabric This option is available for switch groups only.

User-defined properties (UDPs)
UDPs are characteristics that you define for an entity. For example, you
could create a UDP for several entities using the text string "new
installation." All the entities with that UDP would be grouped together.
The topology viewer provides three UDPs so that you can group
resources in three different ways, depending on your needs. UDPs are
not available for fabric groups.
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Defining properties for grouping entities
This topic describes how User-defined properties (UDPs) are useful for describing
specific properties of an entity or a set of entities.

You can also use UDPs to group entities with similar characteristics. The topology
viewer lets you define three UDPs for an entity. UDPs are not available for fabric
groups. To define one or more UDPs for an entity, follow this procedure:
1. Right-click an entity and select Launch Detail Panel.
2. Type a property in the User Defined Property 1 field (for example, a specific

operating system, location of computers, and so on).
3. Optional: Type additional properties in the User Defined Property 2 and User

Defined Property 3 fields, and then click Set.
4. Type a description of the element manager and click OK.
5. Click Launch.

Displaying data paths from one endpoint in the topology to
another

This topic describes how to view connectivity for selected entities in the topology
using Data Path Explorer.

Data Path Explorer Overview
The Data Path Explorer allows you to follow connectivity between a host disk or
computer and a storage subsystem. The Data Path Explorer also provides SAN
Volume Controller support. Using Data Path Explorer you can follow the
connectivity from a computer to SAN Volume Controller, and from an SAN
Volume Controller to a storage subsystem.

Viewing a single data path allows you to monitor performance status and pinpoint
weaknesses without navigating the many entities typically seen in Topology
Viewer.

Data Path Explorer shows only those entities that are part of the selected data
path, and only certain types of entities, such as host, switch, host bus adapter
(HBA), port, storage subsystem, and storage volume.

Data Path Explorer functions like the rest of the Topology Viewer, with key
variations.

Note: The shortcut to Data Path Explorer is not available in the Configuration
History topology view.

Before Using Data Path Explorer

Different amounts of information can be shown by the Data Path Explorer,
depending on which agents are deployed throughout the fabric.

To use Data Path Explorer for debugging performance problems, follow these steps
to ensure that the information displayed in the Data Path Explorer view is current:
1. Enable Performance overlays. To see the overlays, go to topology Global

Settings > Active Overlays: and select the Performance checkbox.
2. Ensure I/O is running on the host machine.
3. Create a threshold alert (see “Creating a performance threshold within an alert”

on page 148).
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4. Create and run performance monitors on the switches and storage subsystems
of interest. See “Monitoring switch performance” on page 377 or “Monitoring
storage-subsystem performance” on page 378 for detailed descriptions on
creating and running performance monitors.

5. Run a discovery job for the CIM agents and Storage Resource agents or Data
agents.

6. Run a probe job for the subsystem, fabric, and Storage Resource agents or Data
agents.

7. Run a performance monitoring job for the subsystem and switches if you want
to see performance information.

See the section about planning for the Data Path Explorer view in the IBM Tivoli
Storage Productivity Center and IBM Tivoli Storage Productivity Center for Replication
Installation and Configuration Guide for more information on configuring data path
explorer.

Graphical View

When you open a data path view, three tiles display in the graphical view: Initiator
Entities, Fabrics, and Target Entities. These contain all the entities in all the data
paths related to the selected host or storage entity.

v Selecting an entity in any of the tile groups at any level displays connector lines
showing the data paths the entity is involved in.

Figure 42. Data Path Explorer view
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v Each tile behaves like an active topology viewer tab, allows grouping and
regrouping, expanding and collapsing of groups and so forth. Each tile can be
expanded to view the lower-level details such as the disks, ports and volumes
involved in a data path.

Initiator Entities
The Initiator Entities tile contains the computers and related volumes,
disks, and HBA ports that have valid data paths to the storage system.
Expanded computer tiles display each computer, its health status icons,
and a count of the entities within the computer that are part of the valid
data paths. Expanded computer tiles show the controllers and disks, HBA
ports, and volumes on the computer that are part of valid data paths. The
initiator entities tile can also contain SAN Volume Controllers. An SAN
Volume Controller is a storage virtualization device and can act as an
initiator entity. Expanded SAN Volume Controller tiles show the SAN
Volume Controller managed disks and ports that are part of valid data
paths.

Fabrics
The Fabrics tile contains the fabrics entities, mainly switches and ports,
through which valid data paths for the selected endpoint traverse. A count
of the switches and switch ports with health status icons and labels are
shown in the group title. Expanded Fabric tiles display a view of the
switches to the port level. Only switches and ports with valid data paths
traversing through them are displayed.

Target Entities
The Target Entities tile contains the endpoint storage systems in data paths
for the selected endpoint. Expanded Target tiles display each storage
subsystem, its status icons, a count of entities, and the number of
subsystem front-end ports and volumes involved. When these are
expanded, the associated port and volume tiles display. These can also be
expanded to show individual entities.

Table View

The data path table displays under the graphical view. Each row in the table view
shows a valid data path for the selected endpoint.

Display a single data path in the graphical view by selecting a row in the data
path table.

The data path table has two tabs: Data Path and Data Path Segment.

Data Path tab
This is the default view. This tab shows each data path associated with the
entity for which the data path was opened.
v Select an entity in the graphical view to display individual data paths in

the table.
v The health status shown for each data path is aggregated.
v The data path table can be sorted by any of the column headers.

See “Columns in Data Path tab” on page 528.

Data Path Segment tab
This tab displays the segments in a data path. One segment is listed per
row.

There are two ways to populate the Data Path Segment table:
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v Select a data path in the Data Path tab. The Segment tab then lists the
segments in the selected data path.

v Click an entity in the graphical view. The Segment tab lists the segments
in all of the data paths the entity is involved in. These are identified by
data path number (0, 1, 4, and so on).

See “Columns in Data Path Segment tab” on page 528.
Related reference:
“Opening a Data Path View”
Data Path Explorer provides an end-to-end topology view of the storage
environment from a host disk to a storage volume. It displays the different data
paths (SAN access paths or I/O paths) for each host disk.
“Displaying an entity's data paths” on page 527
You can view the data paths associated with any entity by selecting the entity in
the graphical view. Lines connect the related entities in the data path or paths.
“Example use cases for Data Path Explorer” on page 529
The following examples show some of the use scenarios for Data Path Explorer:

Opening a Data Path View
Data Path Explorer provides an end-to-end topology view of the storage
environment from a host disk to a storage volume. It displays the different data
paths (SAN access paths or I/O paths) for each host disk.

You can open a data path view on any of the following endpoints:

host The host (computer) must have at least one disk that is assigned from a
subsystem.

subsystem
The subsystem must have at least one volume assigned to a host.

volume
The volume must be assigned to a computer, and the fabric must be zoned
so that the computer can see the volume.

disk The disk must be from a subsystem. Note that the disk can be host disk or
SAN Volume Controller managed disk.

Open a data path explorer view in one of the following ways:
v Right click on an endpoint, and then select Open Data path view.
v Select an endpoint, and then select Open Data path view from the Action menu.
v Select an endpoint, and then select the Data Path Explorer shortcut in the

minimap
v For multiple entities: Select one or more endpoints of the same type (for

example, one or more storage volumes), and then select Open Data Path View.
The data paths display for all of the endpoints selected. If you select an SAN
Volume Controller entity, all other entities you select must be SAN Volume
Controller entities.

Note:

1. Opening the Data Path Explorer view for a subsystem (including an SAN
Volume Controller) that has several associated data paths can consume
extensive system resources. Select volumes or disks instead, and then open the
Data Path Explorer view.

2. If the endpoint is an SAN Volume Controller, two data path views are opened
because the SAN Volume Controller can act as both a initiator and target entity.
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The first view displays the data paths associated with the SAN Volume
Controller acting as a storage subsystem or a target entity. The second view
displays the data paths associated with the SAN Volume Controller acting as an
initiator entity.

When a data path view is opened, three tiles display: the Initiator Entities, Fabric,
and Target Entities tiles. These tiles contain all the associated entities in the data
paths. Select an entity within one of the tiles to see the data paths associated with
it. You may need to further expand the tiles.

If you select an entity or a group of entities that do not have a valid data path, a
dialog box displays with the following message: "No available DataPath for the
selected entities."

The Data Path Table lists each data path (one per row).

To return to a normal topology view, right-click an entity in the graphical or table
view and select Open Detail View from the pop-up menu.

Displaying an entity's data paths
You can view the data paths associated with any entity by selecting the entity in
the graphical view. Lines connect the related entities in the data path or paths.
v In the table view-Data Path tab, the selected entity's data paths are highlighted.
v The table view-Data Path Segment tab displays the data paths belonging to the

selected entity and the individual segments that make up the data path.

Multiple paths

IBM Tivoli Storage Productivity Center shows the multiple paths from the
disks to the storage subsystem volumes in the Data Path Explorer view.
IBM Subsystem Device Driver (SDD) software allows the operating system
to use multiple paths (that is, different initiator and target port pairs)
through the SAN for storage access. On the L2 Computer View and the
Data Path Explorer view, the disks with multiple paths managed by SDD
are grouped in a controller representing the SDD driver.

For a Windows computer with multiple paths managed by SDD to
subsystem volumes, a controller representing the SDD driver is displayed,
and this controller contains the disks managed by the SDD.

For a non-Windows computer with multiple paths managed by SDD to
subsystem volumes, Data Path Explorer displays a controller representing
the SDD driver, and this controller contains the vpath disks. A separate
disk (for example, hdisk on AIX) is created by the operating system on the
non-Windows computer for each path to the storage volume. These disks
are grouped by the controller that contains the initiator port present in the
path.

The Linux SDD driver is no longer available. Starting with Red Hat
Enterprise Linux Version 5 and SUSE Linux Enterprise Server Version 10,
only the DM_Multipath is available. The DM_Multipath is supported by
SAN Planner. The SDD driver is no longer supported on HP, starting with
HP-UX 11i v3 with Itanium®. HP-UX 11i v3 provides a native multipathing
feature which is supported by SAN Planner.
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Related reference:
“Columns in Data Path tab”
When an entity in the Data Path Explorer graphical view is selected, its data paths
display in the Data Path tab.
“Columns in Data Path Segment tab”
The Data Path Explorer Segment tab shows each segment in a data path.

Columns in Data Path tab
When an entity in the Data Path Explorer graphical view is selected, its data paths
display in the Data Path tab.

The Data Path tab columns display the following information:

Located
This column is associated with the Locate function in the Topology Viewer.
If search text is present in a row, the Locate column displays a magnifier
icon.

Health (status)
The aggregated status of the data path.

Group The number of the data path.

Initiator Entity
The name of the computer or SAN Volume Controller in the data path.

Initiator Disk
The computer disk or SAN Volume Controller managed disk in the data
path.

Initiator FCPort
The computer Fibre Channel port in the data path. Data in this column
comes from the HBA port entity in the Computer tile. If an SAN Volume
Controller is the initiator entity, this column contains the SAN Volume
Controller fibre channel port in the data path.

Target Entity
The storage subsystem in the data path.

Target Volume
The storage volume in the data path. An asterisk indicates that this is a
space-efficient volume or vdisk.

Target FCPort
The storage Fibre Channel port in the data path.

Columns in Data Path Segment tab
The Data Path Explorer Segment tab shows each segment in a data path.

Each segment has two endpoints: the beginning device and the ending device
connected by a communication link. Each endpoint resides in a parent entity,
which can be a computer, fabric, or subsystem.

The Data Path Segment tab columns display the following information:

Located
This column is associated with the Locate function in the Topology Viewer.
If search text is present in a row, the Locate column displays a magnifier
icon.
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Segment Health
The health status of the segment is an aggregation of From Endpoint
Health, To Endpoint Health, From Entity Health, To Entity Health, and
Connection Health.

Label The number of the data path and its segments. The data path number
corresponds to the numbering on the Data Path tab. Segment numbering
advances from computer tile through fabric tile to subsystem tile.

From Entity Health
The health status of the parent entity beginning the segment.

From Entity Performance
The performance status of the parent entity that begins the segment. This
column is displayed only when the performance overlay is enabled.

From Entity
The name of the computer, fabric, or subsystem that is the parent of the
beginning device (endpoint) in the segment.

From Endpoint Health
The health status of the endpoint device that begins the segment.

From Endpoint Performance
The performance status of the endpoint device that begins the segment.
This column is displayed only when the performance overlay is enabled.

From Endpoint
The name of the endpoint device that begins the segment.

To Entity Health
The health status of the parent entity that ends a segment.

To Entity Performance
The performance status of the parent entity that ends the segment. This
column is displayed only when the performance overlay is enabled.

To Entity
The name of the computer, fabric, or subsystem that is the parent of the
ending device (endpoint) in the segment.

To Endpoint Health
The health status of the endpoint device that ends the segment.

To Endpoint Performance
The performance status of the endpoint device that ends the segment. This
column is displayed only when the performance overlay is enabled.

To Endpoint
The name of the endpoint device that ends the segment.

Connection Health
The health status of the connection between the endpoint device that
begins the segment (From Endpoint) and the endpoint device that ends the
segment (To Endpoint). The Connection Health is displayed as N/A if the
health status data for the connection is not available.

Example use cases for Data Path Explorer
The following examples show some of the use scenarios for Data Path Explorer:
v An application on a host is running slowly, which causes you to question the

health of the I/O path for that application. Are there component level
performance problems that might cause the slow application response?
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v Disk utilization on the storage subsystem is high, triggering performance alerts.
You decide to see which hosts or applications, residing on separate host disks,
are causing the problem.

v You suspect that the I/O paths for two applications (on separate host disks) are
in conflict with each other. They could be sharing a common component (such
as a switch). After viewing the I/O paths for these two applications, you make
the required zoning or connectivity change to alleviate the problem.

v I/O path information can be used do load balancing and storage planning. For
example, a host adapter port on a host has I/O from three host disks passing
through it, but a second port has I/O from ten host disks (and has more I/O).
This information can be used to provision a new host disk using the first host
adapter port.

Note: Application to host disk mapping is not shown in the Topology Viewer. This
mapping must be done outside IBM Tivoli Storage Productivity Center. However,
Tivoli Storage Productivity Center can provide mapping from database
applications to host disks if configured to do so.

Planning for Data Path Explorer view
This topic provides information on planning for the Data Path Explorer view in the
topology viewer.

The Data Path Explorer is a new type of view in the topology viewer. Data path
explorer combines several of the usual topology views into a visualization that
allows users to follow connectivity from one end point in the topology view to
another. Storage administrators can use this view to debug connectivity and
performance problems in the storage environment. Data Path Explorer displays the
different data paths (SAN access paths or I/O paths) for each host disk. This
allows you to use the Data Path Explorer to check the health and performance
statistics of the storage components along the I/O path.

To use Data Path Explorer for debugging performance problems, follow these steps
to ensure that the information displayed in the Data Path Explorer view is current:
1. Enable Performance overlays. To see the overlays, go to topology Global

Settings > Active Overlays: and select the Performance checkbox.
2. Ensure I/O is running on the host machine.
3. Create a threshold alert (see “Creating a performance threshold within an alert”

on page 148).
4. Create and run performance monitors on the switches and storage subsystems

of interest. See “Monitoring switch performance” on page 377 or “Monitoring
storage-subsystem performance” on page 378 for detailed descriptions on
creating and running performance monitors.

5. Run a discovery job for the CIM agents and Storage Resource agents or Data
agents.

6. Run a probe job for the subsystem, fabric, and Storage Resource agents or Data
agents.

7. Run a performance monitoring job for the subsystem and switches if you want
to see performance information.

Different agents play different roles when discovering information and affect what
can be shown in the Topology Viewer. The Data Path Explorer view is also subject
to those limitations. Different amounts of information can be shown by the Data
Path Explorer view depending on the agents deployed throughout the fabric.
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To display data paths from a host to a subsystem in this view, it is necessary to
have the following agents installed and configured:
v CIM agent to monitor the storage subsystem
v Data agent to monitor the host
v In-band Fabric agent to monitor the fabric. Also a CIM agent for the fabric to

collect fabric performance information.

To show the host disk assignment from a given storage subsystem, IBM Tivoli
Storage Productivity Center Data Server needs access to the subsystem's CIM
agents (SMI-S agent). In the case of the subsystem, the data path for the subsystem
is defined by the host masking or mapping information maintained by the CIM
agent.

Analysis on data paths involving SAN Volume Controllers requires one or more
CIM agents pointing to the SAN Volume Controller and the back-end system.

To show accurate information, it is important to have the most current information
from the CIM agents, Fabric agents, and Data agents. You must probe all the
components within the data path (or a set of agents strategically placed throughout
the fabric) before using the Data Path Explorer.

To show physical fabric connectivity, you must have an in-band Fabric agent,
out-of-band Fabric agent, or a CIM agent for the fabric.

To show performance overlay in the Data Path Explorer view, you must first create
and run performance monitors on the switches and storage subsystems of interest.
To see the overlays you must also go to Topology > Global Settings >
ActiveOverlays and select the Performance check box. See “Collecting
performance data” on page 377 for detailed descriptions on creating and running
performance monitors.

To show zone overlay, you need an in-band Fabric agent connected to the fabric
along the data paths defined or a CIM agent for the fabric. To see the overlays you
must also go to topology Global Settings and select Show zone tab check box.
Topology > Global Settings and select the Show zone tab check box.

If you want to launch the Data Path Explorer view for a host, that host must have
a Data agent running on it.

These are the general setup requirements for using the Data Path Explorer:
1. Install and configure the SMI-S agents (CIM agents) for the subsystems

(including SAN Volume Controllers) and fabric to collect subsystem and fabric
data. Contact your vendor for information on installing and configuring the
CIM agent for the subsystem or fabric.

2. Install and configure the in-band Fabric agent, or out-of-band Fabric agent to
monitor a given fabric.

3. Install the Data agent on the hosts.

Displaying membership in zones and zone sets
This topic describes how the topology viewer allows you to examine zones and
zone sets.

Zone information is shown in the Zone tab in the table view. The Zone tab is
disabled by default. Selecting a zone or zone set in the Zone tab highlights zone
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and zone set members in the graphical view. Ports and entities that are members of
the selected zone or zone set are indicated in the graphical view by highlighting.
You can select highlighted entities to show details (for example, connections).

The entities listed in the Zone tab are only those entities that are in the current
view. However, zone or zone-set selections apply to all currently open views in the
topology viewer. Therefore, switching to another view might indicate other entities
in the selected zone.

Note: You cannot use the Zone tab to change membership status of entities.

To activate the Zone tab, follow this procedure:
1. Right-click in the graphical view and select Global Settings.
2. In the Settings window, select Show zone tab and click OK.

Displaying detailed information about entities
This topic describes how to view detailed information about entities using the
topology viewer.

There are two ways to display information about entities:
1. Right-click the entity and select Launch Detail Panel to display detailed

information about an entity (for example, the operating system of a computer,
the used and unused capacity of a storage subsystem)

2. Right-click the entity or entities and select Reports. From the dialog displayed,
you can choose which report to create. The reports you can choose depend on
which entities you selected. Asset reports are available only if you selected a
single entity. Select a report and click Create Report

Displaying storage resource connections
This topic describes how physical and logical connections among entities in the
environment can be displayed using the topology viewer.

Connections are shown in both the graphical and table views. In the graphical
view, connections are represented by lines between entities or groups. In the table
view, a Connections tab lists both ends of a connection.
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In the graphical view, the color of a connecting line between entities indicates the
status of a connection. The color of the line between groups, individual entities, or
between an individual entity and a group can be green (normal), yellow (warning),
red (critical), black (missing), or grey (status unavailable).

Note: When you have a host with two HBAs or FC ports that are both in the same
switch and you switch the ports between them, the connection will be shown with
two yellow (warning) lines. This is because you have not reset the history retention
setting. Until the settings are reset, the connecting lines will remain yellow.

Connections between two individual entities are represented by a thin line.
Connections between groups or between a group and an individual entity are
represented by a thick line. A connection to a collapsed group can represent either
a single connection or several connections.

To show connections, follow this procedure:
1. Right-click a blank space in background of the graphical view and select

Global Settings.
2. In the Settings window, select Show Connections and click OK.

Filtering entities based on health status
This topic describes how to quickly narrow the health status of normal or
non-normal entities in your environment.

In views with many entities and connections, the display can become very
cluttered and can make it difficult to determine where problems are occurring. You
can filter entities to display only those entities whose health status is non-normal
(critical, warning, missing, or unknown).

When you apply filtering, you can also choose to display entities with a health
status of normal but that are connected to entities whose health status is either
critical or warning. To filter entities by health status:
1. Right-click in the background area of the graphical view and select Global

Settings.

Figure 43. Connections
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2. In the Settings window, select Hide Normal Entities and, optionally, Unless
connected to non-normal, and click OK.

Labeling entities
This topic describes how you can specify or change label entities.

In both the graphical and table views, entities are identified by labels (for example,
the name of a computer). You can specify or change these labels. To specify or
change the existing label for an entity, follow this procedure:
1. Right-click the entity and select Launch Detail Panel.
2. Type a label for the entity in the Label field.
3. Click the save icon in the menu bar to save the label, and then close the

window.

Starting element managers
This topic describes how to start element managers for the entities that are defined
in IBM Tivoli Storage Productivity Center.

If element managers on a system, tape library, switch, or other entity are defined,
you can start the element managers to access vendor-provided management tools.

To start an element manager for an entity, right-click the entity. A menu that
contains launch options is displayed. The options that are displayed depend on the
element managers that you configured on the Element Manager page of the
Configuration Utility. The following options are displayed on this menu:
v Launch in context defined application. This menu item is displayed for each

application that is defined by a launch descriptor file. Tivoli Storage Productivity
Center provides launch descriptor files for the following applications:
– System Storage DS8000 Storage Manager
– The management console for the storage systems that are listed under

Management GUI.
– Tivoli Storage Productivity Center for Replication
If the corresponding launch descriptor files are found for the applications, the
following menu items are displayed:

DS8000 Storage Manager
Click this menu item to start DS8000 Storage Manager.

Management GUI
Click this menu item to start the management console for the following
storage systems:
– SAN Volume Controller
– Storwize V7000
– Storwize V7000 Unified
– IBM SONAS

Replication Storage Systems Overview
Click this menu item to start Tivoli Storage Productivity Center for
Replication. The window that is opened in the Tivoli Storage
Productivity Center for Replication GUI depends on the context for the
entity that you selected. For example, if you right-click a storage device
on the Element Manager tab of the Configuration Utility and click
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Replication Storage Systems Overview, the Tivoli Storage Productivity
Center for Replication Storage Systems window opens.

If the launch descriptor file cannot be found, the Launch file items error menu
item is displayed. Click this item to view a description of the problem. The
Launch file items error menu item is also displayed in situations such as the
IBM Tivoli Integrated Portal server is not installed or is not accessible, the Tivoli
Storage Productivity Center Data server is not accessible, or another system error
occurred.

v External Tools. This menu item shows any external tools that are defined in the
Configuration Utility. Examples of external tools include Web-based user
interfaces and local executable files. For example, you might add the address of
a website that you frequently access or an application that you often use such as
a text editor or a spreadsheet.

v Element Manager. This menu item shows any element managers discovered for
the device by a Storage Management Initiative Specification (SMI-S) query. To
avoid menu item duplication, this item is not displayed when the associated
element manager is defined by a launch descriptor file. In this situation, the
element manager is displayed as a separate menu item.

v User Defined Tools. This menu item shows any user-defined element managers
that are defined in the Configuration Utility. These element managers differ from
the element managers in the Element Manager menu because they are
user-defined and are not discovered by an SMI-S query.

If the selected entity has no element manager, these options are not available in the
menu.

Launching SAN Planner
This topic describes how to launch the SAN Planner wizard for an entity from the
topology viewer. SAN Planner assists end-to-end planning for SAN components.

Right-click a computer, fabric, or storage subsystem and select SAN Planner >
New Plan. A new SAN Planner wizard introduction page is displayed. When you
have made your selections on the Select Planning Task and Select Provision Plan
Details pages, the element you selected is added to input resources on the Specify
Plan Content page. To provision replication for an existing session associated with
a storage resource group, right-click the storage resource group, select SAN
Planner, and then select the session you want to work with.

Starting Storage Optimizer
This topic describes how to start the Storage Optimizer from the topology viewer.
The Storage Optimizer uses data in the Tivoli Storage Productivity Center database
to analyze your storage subsystems to identify performance bottlenecks, and
recommend changes to improve performance.

Right-click one or more storage subsystems and select Launch Optimizer. A new
Storage Optimizer analysis definition is created, and the storage subsystems you
selected are added to the Select Storage pane.
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Related concepts:
“Storage Optimizer overview” on page 432
The Storage Optimizer uses data in the IBM Tivoli Storage Productivity Center
database to analyze your storage subsystems to identify performance bottlenecks,
and recommend changes to improve performance. This topic lists the supported
subsystems and describes the general steps for using Storage Optimizer.

Locating storage resources in the topology
This topic describes how you can search for a particular entity using the entity
name or a keyword (for example, a host name or operating system).

The open view (for example, L0:Other) will be searched for the string you enter.
The results of a locate action are shown by highlighting.

To locate an entity, type a search string in the Locate field in the table view and
click Find. The current view (for example, L0:Other) will be searched for the string
you enter. The locate function does not search the entire topology, only the
currently open view.

When the entity is found, it will be displayed in both the graphical and table
views. If the located entity is inside a collapsed group in the topology, you will not
be able to see that entity until you expand that group. However, the entity will be
highlighted in the table view. If the entity is in a collapsed group in the table view,
that group will automatically be expanded and the highlighted table entry will
receive focus. You can then click on that table entry to see the located entity in the
topology view.

If you specify a Locate criterion that applies to more than one entity in a view, all
the applicable entities are displayed.

Managing Storage Subsystems
This topic describes how to display the Storage Subsystems page, where you can
perform storage-subsystem management tasks.

Right-click a storage subsystem and select Manage Storage Subsystems.

Managing Zone Control
This topic describes how to display the Fabric page, where you can perform
zone-control tasks.

Right-click a fabric and select Manage Zone Control.

Figure 44. Highlighted entity
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Pinning entities
This topic describes how pinning entities is an easy way to identify selected
entities for future reference or quick access.

Pinned entities display a small flag next to the entity. This flag is propagated to all
views that contain that entity. This is useful for marking entities for various
reasons, such as a reminder to look at this entity later and for upward propagation.
For example, the user may pin a computer in an L0 or L1 Computers view and
then quickly wish to see which fabric it belongs to by opening an L0 Fabrics view
and looking at which fabric group contains the pinned entity - indicated by the
small flag. Pinned objects remain visible as you change views in the topology
viewer and when you log off and log back in. Pin lists are stored on a per user
basis. This means that different users can have separate pin lists. Pinned objects are
indicated by a pin icon in the Pinned column of a table or by a flag icon next to
the entity in the graphical view.

To pin an entity, right-click the entity in the graphical view and select Pin. To
unpin an entity, right-click the entity in the graphical view and select Unpin. The
same function is available in the Action list in the table view.

Pinned entities are visible in groups at all levels and in all views regardless
whether the group is expanded or collapsed. You can only pin individual entities;
you cannot pin groups (for example, a group of computers).

Printing information from the topology viewer
You can print information displayed in the topology viewer on a single page for
reference.

Printing capability is available for the graphical view but is not available in the
tabular view. To print the information displayed in the topology viewer, right-click
the graphical view and select Print or Print Preview. The content is scaled to fit
onto one page if necessary.

Refreshing views
This topic describes how you can refresh the topology viewer to view the most
up-to-date details about your environment.

To provide you with the most up-to-date information, the topology viewer
automatically refreshes all open views, including graphics and tables, every five
minutes from the IBM Tivoli Storage Productivity Center database. You can also
refresh views manually or change the default refresh rate. Opening a new view
automatically shows the most current information. To manually refresh views or
change the refresh rate, right-click in the graphical view or click the arrow in the
Action field in the table view and choose one of the following options:

Figure 45. Pinned entity
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v Refresh View: Updates the view that is currently displayed.
v Refresh All Views: Updates all views that are currently open. You can also use

this option to remove the alert indicators from the devices in the topology view.
v Refresh Settings: Opens the Refresh Rate Settings window, in which you can

select a new automatic refresh rate (specified in minutes).

Removing entities from the database
Computers in the missing state were once in the topology viewer, but were not
discovered by IBM Tivoli Storage Productivity Center during the latest refresh
cycle. You might want to remove them from the view and the database in order to
make it easier to work with other resources.

To remove a computer from the topology viewer (both graphical and tabular
views) and the database, you first need to uninstall the agents on that system.

Note: This action is available only for entities that are in the missing state.
1. See Uninstalling the agents in the IBM Tivoli Storage Productivity Center and IBM

Tivoli Storage Productivity Center for Replication Installation and Configuration
Guide for instructions on uninstalling the agents.

2. In the topology viewer graphical view, right-click the computer entity and select
Remove From Database..

3. In the topology viewer tabular view, right-click the computer entity and select
Remove From Database.

Removing deleted entities
When a discovered entity (fabric, subysystem, switch, or volume) is deleted using
another application, such as an element manager or other management application,
the next discovery or probe of the topology viewer displays a missing entity. The
status of missing entities is aggregated and propagated up through the device
hierarchy.

It can be difficult to determine if there are other lower-level entities that have
"missing" status, but have not been intentionally removed by a management
application. The Removed Resource Retention setting in the topology viewer can
be set to a low value, such as 0 or 1 day to remove the missing entity from the
display. This removes the missing entities from the display the next time the
Removed Resource Retention process runs.

You can also remove deleted entities from the topology viewer using the following
procedure:
1. Highlight the intentionally deleted entities in the topology view and select

Remove Resource in the Action list in the tabular view.

Note: Not all entity classes can be removed from the topology using the Action
list. For those entities, use the Removed Resource Retention setting.

2. A prompt asks you if you are sure you want to remove the resource from the
database. Click Yes.

3. To refresh the view, click Refresh View in the Action list. The missing entities
will no longer be displayed in the topology viewer.
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Selecting entities in graphical and table views
This topic describes how to select entities in the graphical and table views of the
topology viewer.

To select an entity in the graphical view, click the entity image. In the table view,
click the name of the entity. To make multiple selections, press CTRL and click.

Showing Alerts
This topic describes how to display alert logs for entities in the topology viewer.

You can display alert logs for:
v computers
v fabrics
v storage subsystems
v tape libraries
v switches

All alerts for the entity-type you select will be displayed, even if no alerts exist for
the entity.

Right-click an entity and select Show <entity type> Alerts.

For example:

Right-click a computer and select Show Computer Alerts.

Showing the monitoring status of entities
View how Tivoli Storage Productivity Center is monitoring a storage entity that is
displayed in the topology viewer.

Display all the data collection schedules, runs, and jobs that are related to a storage
entity in the topology viewer.

To view monitoring status, right-click an entity and select Show Monitoring
Status. For example, right-click a computer and select Show Monitoring Status.

When you select this action, the Job Management panel is displayed. Use this
panel to view information about how a storage entity is monitored by Tivoli
Storage Productivity Center. For storage resource groups, when you click this
option the schedules for all the storage entities in that group are displayed.
Related reference:
“Managing schedules, jobs, and runs” on page 297
Use the Job Management panel to view and manage all the schedules, runs, and
jobs related to the storage devices that are monitored by IBM Tivoli Storage
Productivity Center.

Working with tape libraries in the topology viewer
Perform storage management functions on your tape library using the topology
viewer.

The topology viewer displays information about the discovered tape libraries and
tape library groups. The topology viewer has two views:
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v Topology view
v Tabular view

Each view shows information about the discovered storage devices in your
enterprise. Changes to one view are automatically displayed in the other view, so
that both views are always synchronized.

To see tape library information in the topology viewer, click the Storage node in
the IBM Tivoli Storage Productivity Center > Topology node in the console.
The level zero (L0) view of the storage topology view is displayed. The view
includes the tape libraries and tape library groups that have been discovered.

Viewing tape libraries in the topology view
This topic describes how you can see information about your tape libraries and
tape library groups in the topology view.

Clicking a tape library icon in the topology view highlights (selects) that tape
library in both the topology view and the tabular view. Right-click a tape library to
display a pop-up menu that lists actions that you can perform on the library, as
well as other general actions that you can perform. The actions specific to tape
libraries are:

Open Detail View
Opens the next level of detail for the selected topology object. For tape
libraries, the view hierarchy is
v L0:Storage- overall view of the discovered storage subsystems and tape

libraries
v L1:Tape Libraries- tape library groups
v L2:Tape Library- view of an individual tape library and its related

devices and connections

Launch Detail Panel
Displays the detail panel for the tape library. The detail panel shows
detailed information about the tape library, such as the name of the tape
library vendor, the serial number, status, owner/administrator contact
information, and properties that can be defined by the user. It also has
Launch button that will launch the element manager for the tape library.

Launch Element Manager
Launches the element manager application for the selected tape library.
The element manager is an application or Web site provided by the tape
library vendor for performing management tasks for the selected tape
library. For example, the element manager for and IBM 3584 tape library is
the IBM Tivoli Storage UltraScalable Tape Library Specialist.

Pin Pins the selected tape library. When a topology object is pinned, it remains
visible even after its respective group or view level has been collapsed. A
small blue flag icon by the object's icon indicates that the object is pinned.
Once an object has been pinned, this action will change to Unpin in the
pop-up menu for the object.

As you add more storage devices to your enterprise, your topology view can
become very crowded and increasingly difficult to navigate. You can use the
minimap in the topology view to quickly move around the view and locate the
objects you need to work with.
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Viewing tape libraries in the tabular view
This topic describes how you can see information about your tape libraries and
tape library groups in a tabular view.

The tabular view presents the same information as the topology view. Changes to
the tabular view are immediately reflected in the topology view, so that both views
are always synchronized.

The tabular view contains the following fields:

Action
Lists the actions that can be performed on the selected object in the table,
as well as the more general actions, such as Expand All Groups, that can
be performed. These actions are the same ones that appear in the context
menu for a selected object.

Locate Allows you to find objects in the tabular view. This is very useful when
your tabular view has many entries.

The columns in the tabular view change as you select different objects in the
topology. For example, the columns available for objects in the L1:Tape Libraries
view are different than the columns in the L2:Tape Library view. These columns
show information about the tape libraries, such as the operational status, vendor
name, and number of drives in the library.

Managing disk storage
This section describes managing storage subsystems, virtual disks, volumes, and
creating and managing alerts.

Working with workload profiles
This topic describes creating, modifying, and deleting workload profiles.

Only storage subsystems that have been discovered and had performance data
successfully collected can be used with the Volume Planner function of the SAN
Planner. You can use the following products with SAN Planner:
v TotalStorage Enterprise Storage Server
v DS6000
v DS8000
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified block level support
v The XIV system

For information about storage subsystem discovery, see “Discover storage
subsystem, tape library, and fabric information with CIM agents” on page 333. For
information about the Volume Planner, see “Configuring a provisioning plan by
using SAN Planner” on page 419.

Creating a workload profile
In SAN Planner, you can create or reuse volumes based on a workload profile.
Create a workload profile from the performance information of the selected
storage-system volumes.
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1. In the navigation tree pane, expand Disk Manager > Profile Management >
Workload Profiles. In the content pane, the currently defined workload profiles
are displayed.

2. Click Create; the Workload Profile wizard starts.
3. On the Welcome to the Workload Profile Wizard page, click Next.
4. On the Creation Method page, select the basis for the new workload profile.

Click one of the following choices:

Create profile from volume performance data
Base the new profile on the volume-performance data that you provide.

Create from an existing profile
Base the new profile on an existing workload profile. In the Profile
Name field, select the workload profile.

Click Next. If you clicked Create from existing profile, go to step 6. Otherwise,
the Name and Description page opens.

5. On the Name and Description page, provide information about the new
workload profile:
a. In the Name field, type the name of the workload profile.
b. Optional: In the Description field, type a description of the workload

profile.
c. Click Next.

6. On the Select Volumes page, specify the volumes whose performance data will
be used as the basis for the workload profile.
a. In the Available volumes field, select the volumes, and then move them to

the Selected volumes field.
b. Click Next.

7. On the Peak Activity periods page, specify the time period for the performance
data:
a. To use all available performance data, click Use all available performance

data, and go to step 8.

Note: Analyzing all performance data might be a lengthy process.
b. To use performance data for a specified time period, specify the time

period. In the Start date field, select the month, day, and year. In the End
date field, select the month, day, and year. By default, the time period is set
to the previous month. In the Time reference field, select one of the
following options:

Client Time

Server Time

GMT

Device Time

c. To specify that performance data is collected only during specified hours,
click Use only a portion of each day. In the Start time field, select the hour
and minutes. In the End time field, select the hour and minutes.

d. Click Next.
8. On the Review Profile Results page, review the following performance data:
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Data quality
Lists a data-quality rating. This rating is based on the percentage of
volumes that had valid data:
v Good (100% - 67%)
v Fair (66% - 33%
v Poor (32% - 0%)

I/O Demand

I/O rate per GB per sec
The data-transfer rate in gigabytes per seconds (GBps).

Avg. transfer size (KB)
Default size for data transfer in kilobytes (KB). You can edit this
value.

Read / Write

Sequential reads (%)
Percentage of read/write activity that was sequential reads.

Sequential writes (%)
Percentage of read/write activity that was sequential writes.

Random reads (%)
Percentage of read/write activity that was random reads.

Random writes (%)
Percentage of read/write activity that was random writes.

Total (%, must be 100)
Total of the preceding percentages. This value must equal 100%.
If it does not, you cannot continue with the wizard.

Cache

Random read cache hits (%)
Percentage of cache activity that was random hits to read cache.

Random write destage (%)
Percentage of cache activity that consisted of moving data from
cache to nonvolatile storage.

9. Click Finish.

Deleting a workload profile
This topic describes how to delete a workload profile.

Only user-defined workload profiles can be deleted.
1. In the navigation tree pane, expand Disk Manager > Profile Management >

Workload Profiles. A list of the currently defined workload profiles is
displayed in the content pane.

2. Select the workload profile you want to delete.
3. Click Delete.

Modifying a workload profile
This topic describes how to modify a workload profile.

Only user-defined workload profiles can be modified.
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1. In the left-hand pane, expand Disk Manager > Profile Management >
Workload Profiles. A list of the currently defined workload profiles is
displayed in the right-hand pane.

2. Select a workload profile and click Details. The Workload Profile Properties
window displays.

3. Click the General tab to view the name and description of the workload
profile. You can modify only the description of the workload profile.

4. Click the Performance tab to view I/O demand, read/write, and cache
performance data for the workload profile. You can modify any of the
performance data for the workload profile.

Viewing a workload profile
This topic describes how to view a workload profile.
1. In the navigation tree pane, expand Disk Manager > Profile Management >

Workload Profiles.
2. In the content pane, select a workload profile and click Details. The Workload

Profile Properties window displays.
3. Click the General tab to view the name and description of the workload

profile.
4. Click the Performance tab to view I/O demand, read/write, and cache

performance data for the workload profile.
5. Click the Activity tab to view peak activity settings for the workload profile. To

view all data collected during a period of time, select Use all available
performance data and specify a time reference (options are Client Time, Server
Time, GMT, and Device Time) and start and end dates. To view only the data
collected during a portion of each day, select Use only a portion of each day
and specify start and end times. Click OK to view the peak activity.

Working with provisioning profiles
This topic describes creating, modifying, and deleting provisioning profiles.

Only storage subsystems that have been discovered and had performance data
successfully collected can be used with the storage provisioning function of the
SAN Planner. SAN Planner and storage provisioning are only available for the
following systems:
v TotalStorage Enterprise Storage Server
v SAN Volume Controller
v DS6000
v DS8000
v Storwize V7000
v Storwize V7000 Unified block-level support

For information about storage subsystem discovery, see “Discover storage
subsystem, tape library, and fabric information with CIM agents” on page 333. For
information about SAN Planner, see “Configuring a provisioning plan by using
SAN Planner” on page 419

Creating a provisioning profile
This topic describes how to create a provisioning profile. Provisioning profiles are
used by SAN Planner, and in general, by features that require a model for volume,
multipathing, and zoning requirements.
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1. In the navigation tree pane, expand Disk Manager > Profile Management >
Provisioning Profiles. In the content pane, the currently defined provisioning
profiles display.

2. Click Create. The Provisioning Profile wizard starts.
3. On the Welcome to the Provisioning Profile Wizard page, provide information

about the new provisioning profile.
a. In the Profile Name field, type the name of the provisioning profile.
b. Optional: In the Profile Description field, type a description of the

provisioning profile.
4. In the Creation Method section, choose the method that you want to use to

create the profile. Select one of the following options:

Create profile from scratch.
Click to create the profile without using an existing profile.

Create from an existing profile.
Click to create the profile by using an existing provisioning profile as a
template. Select the profile from the Profile name list.

Click Next.
5. If you want to include volume planning in the provisioning profile, use the

Volume Settings page to configure and create volumes or virtual disks.
a. Select Specify how the storage will be allocated and the storage

performance characteristics to enable the options on this page.
b. Select one of the following options:

v Provision Volumes. Click to use volumes for provisioning.
v Provision Virtual Disks. Click to use virtual disks for provisioning.

c. In the Total Capacity field, enter the total capacity of the volumes or virtual
disks that are to be used for provisioning storage in GB.

d. Enter the number of volumes or virtual disks that you want to create in the
Number of Volumes/Virtual Disks field.

e. From the RAID level list, select one of the following Redundant Array of
Independent Disks (RAID) levels for the volume or virtual disk:
v <system selected>. The best possible RAID level of the volume is

selected based on user input and the available performance and capacity
of the underlying storage systems.

v RAID 1. The format type of the volume will be RAID 1 format.
v RAID 5. The format type of the volume will be RAID 5 format.
v RAID 6. The format type of the volume will be RAID 6 format.
v RAID 10. The format type of the volume will be RAID 10 format.

f. In the Volume/Virtual Disk Name Prefix field, type in a prefix to be used in
the volume or virtual disk name. This value is used as the prefix for all
volumes or virtual disks that are created.

g. From the Workload Profile list, select a workload profile for the volume or
virtual disk. You can use one of the following predefined profiles or you
can create a profile from the Workload Profiles panel. A performance
monitor must have been run on the storage controller to select any
predefined workload profile other than Space only.
v OLTP Standard. Use for typical online transaction processing.
v OLTP High. Use for very active online transaction processing.
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v Data Warehouse. Use for applications with inquires into large data
warehouses.

v Batch Sequential. Use for batch applications involving large volumes of
data.

v Document Archival. Use for document archival applications.
v Space only. Use to select pools based on pool space information rather

than storage controller performance. Use for a storage system that has not
been monitored for a performance data collection.

h. From the Thin Provisioning Profile list, select a thin provisioning profile if
you want to create thin volumes or virtual disks for IBM System Storage
SAN Volume Controller, IBM System Storage DS8000, or IBM XIV Storage
System. You can use one of the following predefined profiles or you can
create a profile from the Thin Provisioning Profiles panel.
v Ignore thin provisioning. A thin provisioning profile is not used.
v Standard. This profile sets the over-allocation limit for a pool at 200%.

This percentage sets the virtual capacity to as much as two times the real
capacity.

v Conservative. This profile sets the over-allocation limit for a pool at
150%. This percentage sets the virtual capacity to as much as one and a
half times the real capacity.

v Aggressive. This profile sets the over-allocation limit for a pool at 300%.
This percentage sets the virtual capacity to as much as three times the
real capacity.

The over-allocation value identifies the limit on the virtual capacity
allocated for a pool. A smaller over-allocation percentage is considered
conservative because the virtual capacity is closer to the real capacity. A
greater over-allocation percentage is considered aggressive because the
virtual capacity is farther from the real capacity. For example, the
over-allocation limit that is set in the Aggressive profile is 300%. Pools that
contain volumes or virtual disks that are created using this profile will be
allocated to as much as three times the real capacity. If you use the
Aggressive profile and the pool size is 15 GB, the virtual capacity allocated
for the pool can be as much as 45 GB.

i. Select one of the Solid State Disks options to specify whether you want to
use or exclude solid-state disks from provisioning:
v Do not use Solid State Disks. Click to exclude solid-state disks from

provisioning.
v Use Solid State Disks. Click to use only solid-state disks for provisioning.

These options are disabled if you clicked Provision virtual disks.
j. From the Encryption Group list, select an encryption group if you want new

volumes to be created on extent pools that belong to that encryption group.
If there are no encryption groups available, <none selected> is displayed in
this box. This box is disabled if you clicked Provision virtual disks.

k. Select Use unassigned volumes not involved in copy relationship if you
want to use existing unassigned volumes. Unassigned volumes that are in a
copy relationship are not used. If this check box is selected, the following
volumes are excluded:
v Unassigned volumes on non-IBM storage systems.
v Unassigned volumes on IBM storage systems that have copy relationships

that were not created in IBM Tivoli Storage Productivity Center or IBM
Tivoli Storage Productivity Center for Replication.

546 IBM Tivoli Storage Productivity Center: User's Guide



l. Enter the number of days of performance data that you want to use for
planning in the Planning will be based on the performance data collected
in the last x days field.

Click Next.
6. If you want to include path planning in the provisioning profile, use this page

to set multipath options. The supported multipath driver on a host is the IBM
Subsystem Device Driver (SDD). The Linux SDD driver is no longer available.
Starting with Red Hat Enterprise Linux Version 5 and SUSE Linux Enterprise
Server Version 10, only the DM_Multipath is available. The DM_Multipath is
supported by SAN Planner. The SDD driver is no longer supported on HP,
starting with HP-UX 11i v3 with Itanium®. HP-UX 11i v3 provides a native
multipathing feature which is supported by SAN Planner.
a. To set up the multipath options, click Setup multipath options (if

supported by the host drivers).
b. From the Multipath Option list, select one of the following options to

specify how the driver uses the paths between the host and the storage
system.
v Load Balancing sends input/output on all paths.
v Round Robin sends input/output on one path until a time interval that

is set in an SDD setting at the host expires, then switches to another path.
v Fail-Over Sends input/output on one path until a failure occurs, then

switches to another path.
On HP-UX 11i v3 with Itanium®, the multipath options used by the SAN
Planner are as follows:
v Load Balancing on HP-UX 11i v3, is implemented as Least Command

Load. This option selects the path with the least number of pending I/O
requests for the next I/O operation.

v Round Robin on HP-UX 11i v3, distributes the I/O load equally across
all active paths irrespective of the current load on each path.

v Fail-Over on HP-UX 11i v3, is implemented as Preferred Path. For this
policy, you specify a path to an optimized controller. This path is
preferred for I/O transfers. The preferred path must be set manually.

c. Select the Specify number of paths check box and enter the number of
paths that you want to configure between the host and storage system. If
you do not specify the number of paths in this field, the default is two
paths.

d. Select Use fully redundant paths (requires at least 2 fabrics) to use the
paths from host to storage systems through a minimum of two fabrics.

Click Next.
7. Use the Security Settings section to specify zoning between ports on the hosts

and systems in a fabric.
a. Select Automatically change zoning to ensure hosts can see the new

storage to enable the options on this page.
b. Select from the Automatically create zone list to specify how the zones will

be created. The predefined options are:

<auto-zone>
This option is the default. The plan generates using the maximum
number of zones without grouping the data paths based on hosts,
host ports, or host bus adapters (HBAs).
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...for each host
Creates a zone for each host.

...for each HBA
Creates a zone for each host bus adapter.

...for each host port
Creates a zone for each host port.

c. Select the Specify maximum number of zones check box and enter the
maximum number of zones.

d. Select the Maximum zone members per zone check box and enter the
maximum number of zone members per zone.

e. Select No two controllers with different types should be used in the same
zone if you do not want two controllers with different types to be used in
the same zone.

f. Select Use active zone set if you want any zone set that is available to be
selected.

g. Select the Append zone name prefix check box and enter a prefix to be
used in the zone name.

8. Click Finish.

Deleting a provisioning profile
This topic describes how to delete a provisioning profile.

Only user-defined provisioning profiles can be deleted.
1. In the navigation tree pane, expand Disk Manager > Profile Management >

Provisioning Profiles. A list of the currently defined provisioning profiles is
displayed in the content pane.

2. Select the provisioning profile you want to delete.
3. Click Delete.

Modifying and viewing a provisioning profile
This topic describes how to modify and view a provisioning profile.

Only user-defined provisioning profiles can be modified.
1. In the left-hand pane, expand Disk Manager > Profile Management >

Provisioning Profiles. A list of the currently defined provisioning profiles is
displayed in the right-hand pane.

2. Select a provisioning profile and click Details. The Provisioning Profile
Properties window displays.

3. Click the General tab to view the name and description of the provisioning
profile. You can modify only the description of the provisioning profile.

4. Click the Volume Settings tab to view or modify the volumes or virtual disks
in the provisioning profile. You can modify any of the volume settings for the
provisioning profile.

5. Click the Path Settings tab to view or modify multipath planning in the
provisioning profile. You can modify any of the multipath settings for the
provisioning profile.

6. Click the Security Settings tab to view or modify zoning between ports on the
hosts and systems in a fabric. You can modify any of the security settings for
the provisioning profile.
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Thin provisioning profiles
Learn how to create, modify, and delete thin provisioning profiles.

Only storage subsystems that have been discovered and had performance data
successfully collected can be used with the volume planning function of SAN
Planner. SAN Planner and the volume planning option are only available for the
following systems:
v TotalStorage Enterprise Storage Server
v SAN Volume Controller
v DS6000
v DS8000
v Storwize V7000
v Storwize V7000 Unified block-level support

For information about storage subsystem discovery, see “Discover storage
subsystem, tape library, and fabric information with CIM agents” on page 333. For
information about the volume planning option, see “Configuring a provisioning
plan by using SAN Planner” on page 419

Creating a thin provisioning profile
Learn how to create a thin provisioning profile. Thin provisioning profiles serve as
templates for specifying the parameters for thin provisioned volumes to be created
through SAN Planner.
1. In the navigation tree pane, expand Disk Manager > Profile Management >

Thin Provisioning Profiles. In the content pane, the currently defined thin
provisioning profiles display.

2. Click Create. The Thin Provisioning Profile window opens.
3. On the Thin Provisioning Profile page, provide information about the new thin

provisioning profile.
a. In the Profile Name field, type the name of the provisioning profile.
b. Optional: In the Profile Description field, type a description of the

provisioning profile.
c. In the Overallocation Limit (%) field, type the over-allocation limit

percentage. Specify this value as an integer. The over-allocation value
identifies the limit on the virtual capacity that is allocated for a pool. A
smaller over-allocation percentage is considered conservative because the
virtual capacity is closer to the real capacity. A greater over-allocation
percentage is considered aggressive because the virtual capacity is farther
from the real capacity. For example, the over-allocation limit that is set in
the Aggressive profile is 300%. Pools that contain volumes or virtual disks
that are created using this profile will be allocated to as much as three times
the real capacity. If you use the Aggressive profile and the pool size is 15
GB, the virtual capacity allocated for the pool can be as much as 45 GB.

4. In the DS8000 Settings section, specify the parameters for creating a thin
provisioning profile for IBM System Storage DS8000.

Specify DS8000
Select the Specify DS8000 check box to create a thin provisioning
profile for System Storage DS8000.

Space-Efficiency Type
Specify the type of thin provisioning to use for System Storage DS8000.
The options are:
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Extent Space Efficient (ESE)
An ESE logical volume has a set of virtual extents that are not
associated with a repository. The logical volume is dynamically
allocated and deallocated from the extent pool.

Track Space Efficient (TSE)
A TSE logical volume has a set of virtual extents and is
associated with a repository.

5. In the SVC Settings section, specify the parameters for creating a thin
provisioning profile for IBM System Storage SAN Volume Controller.

Specify SVC
Select the Specify SVC check box to create a thin provisioning profile
for SAN Volume Controller.

Real Size (%)
Enter the percentage of disk space to be allocated for the space-efficient
copy of the selected VDisk. Setting the real space for a space-efficient
copy protects the copy from going offline when its managed disk
(MDisk) group runs out of space.

Auto Expand
Select a value to specify whether the thin provisioning profile volumes
automatically expand their real capacities by allocating new extents
from their MDisk group.

Grain Size (KB)
Select the grain size in KB for a space-efficient copy of the VDisk.

Warning Level (%)
Enter a threshold to send a warning message for the VDisk copy when
the capacity that is used exceeds the specified percentage level.

6. In the XIV Settings section, specify the parameters for creating a thin
provisioning profile for the XIV system.

Specify XIV
Select the Specify XIV check box to create a thin provisioning profile
for the XIV system.

Locking Behavior
Select the Locking Behavior required if the thin provisioned pool runs
out of space:

Read Only
If the thin provisioned pool has run out of capacity, all the
volumes in the pool are locked and no write commands are
allowed. This option is the default.

No IO If the thin provisioned pool has run out of capacity, no write or
read commands are allowed.

7. Click Apply to save your changes. To exit without adding a thin provisioning
profile, click Cancel.

Deleting a thin provisioning profile
Learn how to delete a thin provisioning profile.

You can only delete user-defined thin provisioning profiles.
1. In the navigation tree pane, expand Disk Manager > Profile Management >

Thin Provisioning Profiles. A list of the currently defined thin provisioning
profiles is displayed in the content pane.
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2. Select the thin provisioning profile you want to delete.
3. Click Delete.

Modifying and viewing a thin provisioning profile
Learn how to modify and view a thin provisioning profile.

You can only modify user-defined thin provisioning profiles.
1. In the left-hand pane, expand Disk Manager > Profile Management > Thin

Provisioning Profiles. A list of the currently defined thin provisioning profiles
is displayed in the right-hand pane.

2. Click the magnifying glass icon next to a thin provisioning profile. The Thin
Provisioning Profile Properties window displays.

3. View the details of the thin provisioning profile. You can modify any of the
profile settings except for the Profile Name.

4. Click Apply to save your changes. To exit without modifying a thin
provisioning profile, click Cancel.

Managing storage subsystems
This topic contains information about storage-subsystem management tasks.

Grouping storage subsystems
A storage-subsystem group is a user-defined set of storage subsystems. You might
want to group storage subsystems in order to make it easier to run monitoring or
reporting jobs.

Note: A storage subsystem can belong to only one storage-subsystem monitoring
group, but can belong to multiple storage subsystem reporting groups.

Creating a storage subsystem group:

This topic describes how to create a storage subsystem group.
1. In the navigation tree pane, expand Disk Manager > Monitoring > Groups.
2. Right-click Storage Subsystem and then click Create Storage Subsystem

Group. In the content pane, the Create Storage Subsystem Group window
opens.

3. In the Description field, type a short description of the group.
4. In the Available field, click the storage subsystems that you want to add to the

group, and then click . The storage subsystems are added to the
Current Selections field.

5. Click File > Save. A window opens requesting a name for the
storage-subsystem group.

6. Type the name of the storage-subsystem group and click OK.

Deleting a storage-subsystem group:

This topic describes how to delete a storage-subsystem group.
1. In the left-hand pane, expand Disk Manager > Monitoring > Groups >

Storage Subsystems. All existing storage-subsystem groups are listed.
2. Right-click the storage-subsystem group that you want to delete.
3. Click Delete. A window opens, asking if you are sure that you want to delete

this group.
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4. Click Yes.

Editing a storage-subsystem group:

This topic describes how to edit a storage-subsystem group.
1. In the left-hand pane, expand Disk Manager > Monitoring > Groups >

Storage Subsystem. All existing storage-subsystem groups are listed.
2. Click the storage-subsystem group that you want to edit. The Edit Storage

Subsystem Group window opens.
3. Make any necessary changes.
4. Click File > Save.

Defining element managers
Element managers are programs that you can use to configure and manage your
storage devices. An example of an element manager is DS8000 Storage Manager,
which is the default element manager that is provided with IBM System Storage
DS8000.

Element managers are managed in Tivoli Storage Productivity Center using the
Configuration Utility. You can access the Configuration Utility from a storage
system that is visible in the Storage Subsystems page of Tivoli Storage Productivity
Center as shown in the following steps:
1. Expand Disk Manager > Storage Subsystems in the navigation tree. The

Storage Subsystems page is displayed.
2. In the Storage Subsystems table, double-click a storage subsystem. The Details

dialog page is displayed.
3. Click Element Management. The Element Manager tab in the Configuration

Utility is displayed.
Related concepts:
“Managing DS8000 storage systems using element managers” on page 585
Use the Configuration Utility in IBM Tivoli Storage Productivity Center to add and
manage element managers for IBM System Storage DS8000. Element managers are
applications that are used to configure and manage a storage device. You can add
and manage connections to the element manager that is provided with DS8000,
DS8000 Storage Manager, or you can specify other element managers for a device.
“Managing other storage systems using element managers” on page 592
Use the Configuration Utility in IBM Tivoli Storage Productivity Center to add and
manage element managers for storage devices other than IBM System Storage
DS8000. Element managers are applications that are used to configure and manage a
storage device. You manage connections to the element managers that are provided
with the storage device or you can specify other element managers for a device.

Starting element managers
You can start element managers from a storage system that is visible on the
Storage Subsystems page of Tivoli Storage Productivity Center. You can also start
element managers from other points in Tivoli Storage Productivity Center as
described in other areas of this documentation.

To start an element manager from the Storage Subsystem page, complete the
following steps:
1. Expand Disk Manager > Storage Subsystems in the navigation tree. The

Storage Subsystems page is displayed.
2. In the Storage Subsystems table, select a storage system.
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3. Use one of the following methods to start the element manager:
v To start the default element manager for the storage system, select Launch

Element Manager.
v To start another element manager for the storage system, right-click the

system and click Launch Element Manager. Select the element manager that
you want to start from the menu.

If the connection information for an element manager is valid, the element
manager is started. If unsuccessful, an error message is displayed. The error
messages that you receive describes one of the following problems:
v that the element manager at the specified IP address could not be started
v that the required connection information for the element manager has not been

provided.
v that the element manager is not installed and configured correctly (for local

element manager installations such as XIV Storage Manager)

If you are prompted to enter additional information such as an ID and password
for the element manager, complete the following steps:
1. Click OK in the message dialog box. The Modify Element Manager dialog box

is displayed.
2. Enter the required information for the element manager and click Save.

Removing a storage subsystem
This topic describes how to remove a storage subsystem.
1. In the navigation tree pane, expand Disk Manager and click Storage

Subsystems. In the content pane, the Storage Subsystems page is displayed.
2. In the Storage Subsystem table, click a storage subsystem, and then click

Remove. The Remove Storage Subsystem window opens.
3. Click Yes.

Note: You can also remove a storage subsystem using the following method:
“Removing a storage system” on page 294.

Removing a storage subsystem
This topic describes how to remove a storage subsystem.
1. In the navigation tree pane, expand Disk Manager and click Storage

Subsystems. In the content pane, the Storage Subsystems page is displayed.
2. In the Storage Subsystem table, click a storage subsystem, and then click

Remove. The Remove Storage Subsystem window opens.
3. Click Yes.

Note: You can also remove a storage subsystem using the following method:
“Removing a storage system” on page 294.

Setting user-defined properties
This topic describes how to set properties for storage subsystems. You can define a
name and up to three properties for each storage subsystem.
1. In the navigation tree, expand Disk Manager and click Storage Subsystems. In

the content pane, the Storage Subsystems page is displayed.
2. In the Storage Subsystem table, double-click a storage subsystem. The

Storage-Subsystem Details page opens.
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3. Set the user-defined properties:
a. In the Label field, type a name for the storage subsystem.
b. In the User-defined properties fields, type information that you want to

associate with the storage subsystem.
4. Click File > Save.

Viewing storage subsystem information
You can view information about the storage subsystems that are in your
environment. You can view general information about all storage subsystems or
you can view detailed information about a specific storage subsystem. This
information includes the available and used space for the subsystem.

Viewing general information about a storage subsystem
You can view general information about a storage subsystem.
In the navigation tree, expand Disk Manager and click Storage Subsystems. On
the Storage Subsystems Page, the Storage Subsystems table contains the following
information about each storage subsystem:

Subsystem
A system ID that is in the following format:
Type-Model-ID-Vendor

Figure 46. Storage-Subsystem Details page
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Type The type of the storage system, for example, TotalStorage
Enterprise Storage Server or SAN Volume Controller.

Model The model number, for example, 2105 or 2145.

ID The serial number or cluster name. Cluster names are used only
for storage systems such as SAN Volume Controller and Storwize
V7000.

Vendor The manufacturer of the storage system, for example, IBM.

Label A user-defined name for the storage system or the ID of the storage
system.

Type The type of system:
v DS4000
v DS5000
v DS6000
v DS8000
v EMC
v ESS
v Hitachi
v Storwize V7000
v Storwize V7000U
v SONAS
v SVC
v XIV
v Other

Model The model of the storage system.

Status The status of the system:
v Normal
v Critical
v Warning
v Unreachable

Available Space (GB)
The total storage capacity that is not formatted in volumes or virtual disks
and that is assigned to hosts.

For the following storage systems, this value represents managed disk
space that is not allocated to virtual disk space within the managed disk
groups and managed disk space that is not defined to a managed disk
group:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

Tip: For space-efficient volumes, this value is the amount of storage space
requested for these volumes, not the actual allocated amount. This can
result in discrepancies in the overall storage space reported for a storage
system using space-efficient volumes. This also applies to other space
calculations, such as the calculations for the storage system's Consumable
(Available) Volume Space and FlashCopy Target Volume Space.
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Consumed Space (GB)
The total storage capacity that is formatted in volumes or virtual disks and
assigned to hosts.

For the following storage systems, this value represents all space that is
allocated from MDisk groups to VDisks (space that is consumed by
volumes):
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

Configured Capacity Limit (GB)
The total amount of real available and formatted storage space in the
storage pools that are associated with the storage system.

Remaining Configured Capacity (GB)
The amount of real storage space available to allocate to volumes in the
storage pools that are associated with the storage system.

Tiers Indicates the tiers that are used by the storage system. Each tier is
delimited by a semi-colon (;). Possible values are: generic_hdd and
generic_ssd.

Information about tiers is available only for the following storage systems:
v SAN Volume Controller 6.1 or later
v Storwize V7000
v Storwize V7000 Unified

The value N/A is displayed in tier-related columns for other storage
systems.

Tier Capacities (GB)
The total storage capacity of each tier that is used by the storage system.
The capacity of each tier is delimited by a semi-colon (;).

Tier Free Capacities (GB)
The free storage capacity (available space) of each tier that is used by the
storage system. The free capacity of each tier is delimited by a semi-colon
(;).

Viewing detailed storage subsystem information
You can view detailed information about a specific storage subsystem. This
information includes the available and used space for the subsystem.
To view detailed information about a specific storage subsystem, click the storage

subsystem, and then click the magnifying glass icon ( ).
The tab that you can view is determined by the type of storage subsystem that you
selected:
v The Storage-Subsystems Details tab shows detailed information for storage

systems such as System Storage DS4000, System Storage DS8000, or XIV system.
v The SAN Volume Controller, Storwize V7000, or Storwize V7000 Unified Details

tab shows detailed information for those storage subsystems.
v The Storwize V7000 File Module Details tab shows detailed information about a

Storwize V7000 File Module storage system.
v The IBM SONAS Details tab shows detailed information about an IBM SONAS

system.
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Tip: The contents of the Storage-Subsystem Details tab is determined by the type
of storage subsystem that you selected.
Storage-Subsystems Details tab
The Storage-Subsystem Details tab contains the following information:

Storage Subsystem
The storage system identifier.

Label The user-defined name of the storage system. You can edit this field.

Status The status of the storage system:
v Normal
v Critical
v Warning
v Unreachable

Vendor
The manufacturer of the storage system.

Type The type of storage system:
v DS4000
v DS5000
v DS6000
v DS8000
v EMC
v ESS
v Hitachi
v XIV
v Other

Model The model of the storage system.

Available Space (GB)
The total storage capacity that is not formatted in volumes or virtual disks
and assigned to hosts.

Tip: For space-efficient volumes, this value is the amount of storage space
requested for these volumes, not the actual allocated amount. This can
result in discrepancies in the overall storage space reported for a storage
system using space-efficient volumes. This also applies to other space
calculations, such as the calculations for the storage system's Consumable
(Available) Volume Space and FlashCopy Target Volume Space.

Consumed Space (GB)
The total storage capacity that is formatted in volumes or virtual disks and
assigned to hosts.

Serial Number
The serial number.

Revision
The revision number.

User-defined property 1 (UDP1)
A user-defined property. You can edit this field.

User-defined property 2 (UDP2)
A user-defined property. You can edit this field.
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User-defined property 3 (UDP3)
A user-defined property. You can edit this field.

IP Address
The IP address of the element manager.

Element Manager
Identifies the element manager. This value can be a URL, the fully
qualified name of the executable file that starts the element manager, or the
short name for the XIV system.

Element Management
Opens the Configuration Utility. Use the Configuration Utility to modify
the element manager information.

Replication Information
If the storage system is not configured for replication, one of the following
messages is displayed:
v The device is not supported.
v The replication information for the device is unavailable.
v The device is not configured for replication.

If the storage system is configured for replication, the following
information that is specific to the device type and connection type is
displayed:

IP Address/Domain Name
Identifies the IP address or host name of the storage system. If the
IP address was not defined, this field is blank.

Port Identifies the port number of the storage system. If the port
number was not defined, this field is blank. This field is not
applicable for storage systems that use the HMC connection
method.

Username
Identifies the user name to access the storage system. If the user
name was not defined, this field is blank.

Connection Type
Identifies the connection method.

SAN Volume Controller, Storwize V7000, or Storwize V7000 Unified Details tab
This tab contains the following information:

Storage Subsystem
The storage system identifier.

Label The user-defined name of the storage system. You can edit this field.

Status The status of the storage system:
v Normal
v Critical
v Warning
v Unreachable

Vendor
The manufacturer of the storage system.

Type The type of storage system:
v Storwize V7000
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v Storwize V7000U
v SVC

Model The model of the storage system.

Available Space (GB)
The total storage capacity that is not formatted in volumes or virtual disks
and assigned to hosts.

For these types of storage systems, this value represents managed disk
space that is not allocated to virtual disk space within the managed disk
groups and managed disk space that is not defined to a managed disk
group.

Tip: For space-efficient volumes, this value is the amount of storage space
requested for these volumes, not the actual allocated amount. This can
result in discrepancies in the overall storage space reported for a storage
system using space-efficient volumes. This also applies to other space
calculations, such as the calculations for the storage system's Consumable
(Available) Volume Space and FlashCopy Target Volume Space.

Consumed Space (GB)
The total storage capacity that is formatted in volumes or virtual disks and
assigned to hosts.

For these types of storage systems, this value represents all space that is
allocated from MDisk groups to VDisks (space that is consumed by
volumes).

Tiers Indicates the tier levels that are used by the storage system. Each tier is
displayed as a row in a table. Information about tiers is available only for
these types of storage systems.

Tier Indicates a tier level that is used by the storage system. Possible
values are: generic_hdd and generic_ssd.

Tier Capacity (GB)
Total storage capacity of a tier.

Tier Free Capacity (GB)
Free storage capacity (available space) of a tier.

Serial Number
The serial number.

Revision
The revision number.

User-defined property 1 (UDP1)
A user-defined property. You can edit this field.

User-defined property 2 (UDP2)
A user-defined property. You can edit this field.

User-defined property 3 (UDP3)
A user-defined property. You can edit this field.

IP Address
The IP address of the element manager.

Element Manager
Identifies the element manager. This value can be a URL or the fully
qualified name of the executable file that starts the element manager.
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Element Management
Opens the Configuration Utility. Use the Configuration Utility to modify
the element manager information.

Replication Information
If the storage system is not configured for replication, one of the following
messages is displayed:
v The device is not supported.
v The replication information for the device is unavailable.
v The device is not configured for replication.

If the storage system is configured for replication, the following
information that is specific to the device type and connection type is
displayed:

IP Address/Domain Name
Identifies the IP address or host name of the storage system. If the
IP address was not defined, this field is blank.

Port Identifies the port number of the storage system. If the port
number was not defined, this field is blank. This field is not
applicable for storage systems that use the HMC connection
method.

Username
Identifies the user name to access the storage system. If the user
name was not defined, this field is blank.

Connection Type
Identifies the connection method.

Storwize V7000 File Module Details tab
The Storwize V7000 File Module Details tab contains the following information:

Available FileSystem Space
The amount of available file system space for the file module.

Consumed FileSystem Space
The amount of used file system space for the file module.

Version
The version of the file module.

IBM SONAS Details tab
The IBM SONAS Details tab contains the following information:

Storage Subsystem
The storage system identifier.

Label The user-defined name of the storage system. You can edit this field.

Status The status of the storage system:
v Normal
v Critical
v Warning
v Unreachable

Vendor
The manufacturer of the storage system.

Type The type of storage system: IBM SONAS.
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Model The model of the storage system.

Available FileSystem Space
The total amount of unique file system storage space that is not used or
available to the computers where a Data agent or Storage Resource agent is
installed. Tivoli Storage Productivity Center does not include the following
file systems in its calculation of the value for this field:
v File systems that become missing after a probe
v File systems that are mounted remotely and are not identified to a

network-attached storage server
v File systems that are not mounted

Consumed FileSystem Space
The total amount of unique file system storage space that is used or
consumed by the computers where a Data agent or Storage Resource agent
is installed. Tivoli Storage Productivity Center does not include the
following file systems in its calculation of the value for this field:
v File systems that become missing after a probe
v File systems on discovered hypervisors that are assigned to virtual

machines where an agent is installed
v File systems on virtual machines where an agent is installed, but the

hypervisors for the virtual machines have not been discovered and the
total used space exceeds the capacity of the total file system capacity

v File systems that are mounted remotely and are not identified to a
network-attached storage server

v File systems that are not mounted

Version
The version number.

User-defined property 1 (UDP1)
A user-defined property. You can edit this field.

User-defined property 2 (UDP2)
A user-defined property. You can edit this field.

User-defined property 3 (UDP3)
A user-defined property. You can edit this field.

IP Address
The IP address of the element manager.

Element Manager
Identifies the element manager. This value can be a URL, the fully
qualified name of the executable file that starts the element manager, or the
short name for the IBM SONAS.

Element Management
Opens the Configuration Utility. Use the Configuration Utility to modify
the element manager information.

Replication Information
You cannot use IBM SONAS for replication.

Managing virtual disks
This topic contains information about managing virtual disks.
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Adding a managed disk to a managed-disk group
This topic describes how to add a managed disk to a managed-disk group.

Attention: If you add a managed disk that contains existing data to a managed
disk group, you will lose the data that it contains. The image mode is the only mode
that will preserve this data.
1. In the navigation tree pane, expand Disk Manager and click Storage

Subsystems. In the content pane, the Storage Subsystems page is displayed.
2. In the Storage Subsystems table, click a SAN Volume Controller.
3. Click Create Virtual Disk. The Create Virtual Disk wizard starts and the

"Define the virtual disks" page opens.
4. In the Managed-disk group field, select the managed-disk group to which you

want to add a managed disk.
5. Click Add Managed Disk. The "Add managed disk" window opens.
6. Select the managed disk, and then click OK.

Assigning host ports
This topic describes how to assign host ports to a virtual disk. You also can make
host-port assignments when you create a virtual disk.

Note: When you assign a host port to a virtual disk, all host ports defined on the
SAN Volume Controller model are assigned to the virtual disk. If you want to
assign only one host port to a virtual disk, you must define the host with only one
host port on the SAN Volume Controller.
1. In the navigation tree pane, expand Disk Manager and click Storage

Subsystems. In the content pane, the Storage Subsystems window is
displayed.

2. In the Storage Subsystems table, click the SAN Volume Controller with which
you want to work.

3. Click Virtual Disks. The Virtual Disks page is displayed.
4. Click either Filter by MDisk group or Filter by host port, and then select the

specific filtering condition.
5. Click Go. A list of virtual disks associated with the selected SAN Volume

Controller is displayed.
6. In the Virtual Disks table, select the virtual disk, and then click Assign Host

Ports. The Assign Host Ports wizard starts. A virtual disk that is marked with
an asterisk (*) indicates that the virtual disk is a space-efficient volume. The *
is not part of the actual virtual disk name.

7. On the "Assign the virtual disk to host ports" page, assign or unassign host
ports:
a. Optional: In the Available ports field, select the ports that you want to

assign to the virtual disks, and then click .
b. Optional: In the Assigned ports field, select any ports that you want to

unassign from the virtual disks, and then click .
c. Click Next.

8. (This page only is displayed if Fabric Manager is installed, and you have
Fabric administrator authority.) On the "Zone actions" page, perform one of
the following zone actions:
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Create a new zone
Click Create new Zone. In the Zone name field, type the name of the
zone. The ports listed on the page are added to the new zone.

Update an existing zone
Click Update existing zone, and then select a zone. The ports listed
on the page are added to the selected zone.

Leave the zone configuration as it is
Click Do neither to avoid performing any fabric-control tasks. The
ports listed on the page cannot communicate with the subsystem on
this fabric.

9. Click Next. The "Review settings" page opens.
10. Review the settings that you made earlier in the wizard, and then click Finish.

Creating virtual disks
This topic describes how to create virtual disks.
1. Expand the Disk Manager node in the navigation tree and click Storage

Subsystems. In the right pane, the Storage Subsystems page is displayed.
2. In the Storage Subsystem table, click a IBM System Storage SAN Volume

Controller, and then click Create Virtual Disk. The Create Virtual Disk wizard
starts.

3. On the Define the virtual disks page, specify the attributes for the virtual disks:
a. In the Type field, select one of the following values:

v Striped
v Sequential

b. In the Number of virtual disks field, select the number of virtual disks that
you want to create. Each available input/output (I/O) group can contain
1024 virtual disks.

c. In the Virtual-disk size field, select the size of the virtual disks to be
created.

d. In the Units field, select one of the following units of measurement for the
size of the virtual disks:
v Bytes (byte)
v GB (gigabyte)
v KB (kilobyte)
v MB (megabyte)
v PB (petabyte)
v TB (terabyte)

e. In the Name field, enter a string to identify the virtual disk.
v For SAN Volume Controller 4.x and 5.x, the following naming

conventions apply:
– The maximum length of the name is 14 characters. The number of

virtual disks also determines the maximum length of the name. For
example, if the number of virtual disks is 10 - 99, the maximum length
of the name is 13 characters. If the number of virtual disks is 100 - 999,
the maximum length of the name is 12 characters, and so on.

– Permissible characters include uppercase letters (A-Z), lowercase letters
(a-z), numerals (0-9), hyphens (-), and underscores (_).

v For SAN Volume Controller 6.1 and Storwize V7000, and Storwize V7000
Unified block-level support, the following rules apply:

Chapter 5. Managing resources in the stand-alone GUI 563



– Specify a single virtual-disk name that is no longer than 63 characters.
The number of virtual disks also determines the maximum length of
the name. For example, if the number of virtual disks is 2 - 9, the
maximum length of the name is 62 characters. If the number of virtual
disks is 10 - 99, the maximum length of the name is 61 characters. If
the number of virtual disks is 100 - 999, the maximum length of the
name is 60 characters.

– Specify a name that includes only the following characters:
- uppercase letters (A-Z)
- lowercase letters (a-z)
- numerals (0 - 9)
- hyphen (-)
- underscore (_)
- blank space
- period (.)

v Names must begin with a letter or an underscore. The first character
cannot be a number, hyphen (-), blank space, or period(.).

v Names cannot begin with text or abbreviations commonly used to specify
the object type, for example, the name cannot begin with VDisk, VDISK,
vdisk, or virtual disk.

v Names cannot end with a space.
v Object names must be unique within an object type. For example, it is

acceptable to have a vdisk named "XYZ" and an mdisk named "XYZ", but
not acceptable to have two vdisks named "XYZ".

If you leave this field blank, a name is generated automatically. If you create
multiple virtual disks, the name is used as a prefix.

f. In the I/O group field, select the I/O group. By default, Let the system
choose is selected. Other options are the actual I/O groups on the cluster.

g. In the Space-efficient properties pane, use the following options to specify
the space-efficient properties of the virtual disk. This pane is disabled if the
SAN Volume Controller does not support the creation of space-efficient
virtual disks:
1) Space efficient check box (precedes the Real size field). Select this check

box to specify that the virtual disk will be space efficient. Selecting this
check box activates the other fields in this section.

2) Real size Specify the actual allocated size of the virtual disk at creation
time. This size is the initial allocated disk size that can be increased as
needed by the SAN Volume Controller when the applications using the
VDisk need more storage. The real size of the disk cannot exceed the
managed free space that is currently available. Use the dropdown list to
specify the size of the allocation unit.

3) Summary This field displays a summary of the space-efficient properties
for this virtual disk.

4) Define Click this button to open the Define Space Efficient Properties
window.

h. Select the Show solid state based Managed Disk Groups only check box if
you want only managed disk groups that are on solid-state drives to be
displayed in the Managed-disk group field. Solid-state drives are available
in SAN Volume Controller 5.1 and later.
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i. In the Managed-disk group field, select the managed disk group. The
managed disk groups are listed using the following convention:
MDisk-group name (N)

where N is the available capacity. After you select the managed disk group,
the managed disks in the managed disk group are displayed.
To add a managed disk to the managed disk group, click Add Managed
Disk.

j. This check box is available only for sequential virtual disks. If you are
creating more than one sequential virtual disk, select the Round robin
sequential assignment to managed disks check box to ensure that the
virtual disks are assigned to the managed disks in a round-robin manner. If
selected, the number of virtual disks must equal the number of managed
disks selected in the managed disk table.
Clear the Round robin sequential assignment to managed disks check box
to ensure that all virtual disks are created on a single managed disk. If the
check box is cleared, there must be only one managed disk selected in the
managed-disk table.

k. Select the Format virtual disks check box to ensure that the virtual disks are
formatted (written with zeros) after they are created.

l. Click Next.
4. On the Assign the virtual disk to host ports page, assign host ports:

a. Optional: In the Available ports field, select the ports that you want to

assign to the virtual disks, and then click .
b. Click Next.

5. On the Zone actions page, perform one of the following zone actions. The Zone
actions page is displayed only if Fabric Manager is installed, and you have
Fabric administrator authority.

Create a new zone
Click Create new Zone. In the Zone name field, type the name of the
zone. The ports that are listed are added to the new zone.

Update an existing zone
Click Update existing zone, and then select a zone. The ports that are
listed are added to the selected zone.

Leave the zone configuration as it is
Click Do neither to avoid performing any fabric-control tasks. The
ports that are listed are not able to communicate with the subsystem on
this fabric.

6. Click Next.
7. On the Summary page, review the selections that you made earlier in the

wizard.
8. Click Finish to create the virtual disks.

Deleting a virtual disk
This topic describes how to delete a virtual disk.
1. In the navigation tree pane, expand Disk Manager and click Storage

Subsystems. In the content pane, the Storage Subsystems window is displayed.
2. In the Storage Subsystems table, click a SAN Volume Controller, and then click

Virtual Disks. The Virtual Disks page opens.
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3. Click either Filter by MDisk group or Filter by host ports, and then select the
specific filtering condition.

4. Click Go. A list of virtual disks associated with the selected SAN Volume
Controller is displayed.

5. In the VDisk table, click the virtual disk that you want to delete, and then click
Delete.

6. When prompted to confirm that you want to delete the virtual disk, click Yes.

Viewing virtual-disk information
This topic describes how to view information about the virtual disks in your
environment.
1. Expand the Disk Manager node in the navigation tree and click Storage

Subsystems. In the content pane, the Storage Subsystems page is displayed.
2. In the Storage Subsystems table, click a SAN Volume Controller, and then click

Virtual Disks. The Virtual Disks page opens.
3. Click either Filter by MDisk group or Filter by host ports, and then select the

specific filtering condition.
4. Click Go. A list of virtual disks associated with the selected SAN Volume

Controllers is displayed. The VDisk table contains the following information
about each virtual disk:

Name Name of the virtual disk or mirror copy.

I/O Group
Name of the I/O group that is associated with the virtual disk or
mirror copy.

Status Status of the virtual disk or mirror copy:
v Offline
v Online
v Degraded

Figure 47. Virtual Disks page
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Copy Type
Indicates the type of the virtual disk. Valid values for this column
include the following:
v Standard: Indicates standard VDisks (from pre-SAN Volume

Controller 4.3 systems)
v Primary: Indicates VDisks from SAN Volume Controller 4.3 or newer

systems.
v Copy: Indicates a mirror copy (not the primary copy) of a VDisk.

Note: You can assign virtual disks to hosts if those disks have a Copy
Type of Standard or Primary.

Copy ID
Indicates the ID of a mirror copy for a virtual disk. Depending on the
configuration history, a single mirror copy might have an ID of either 0
or 1.

Note: The value N/A appears in this column for virtual disks.

MDisk Group Name
Name of the managed-disk groups to which the virtual disk or mirror
copy belongs.

Capacity (MB)
Capacity of the virtual disk or mirror copy in MB. This value is
rounded to 0.1 MB.

Type Type of virtual disk or mirror copy:
v Image
v Sequential
v Striped

FlashCopy Name
Name of the FlashCopy mapping to which the virtual disk belongs.

MM Name
Name of the Metro Mirror relationship to which the virtual disk
belongs.

5. To view detailed information about a specific virtual disk, click the virtual disk,

and then click . The Virtual-Disk Details page opens.
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The Virtual-Disk Details page contains the following information:

VDisk ID
ID of the virtual disk.

Name Name of the virtual disk. A virtual disk that is marked with an asterisk
(*) indicates that the virtual disk is a space-efficient volume. The * is
not part of the actual virtual disk name.

I/O group ID
ID of the I/O group.

I/O group name
Name of the I/O group.

Status Status of a virtual disk:
v Offline
v Online
v Degraded

MDisk group name
Name of the managed-disk group.

Capacity (MB)
Capacity of a virtual disk in MB. This value is rounded to 0.1 MB.

Easy Tier
Indicates the enablement of tiering. Possible values are: auto, on, off.

Information about virtual disk tiers is available for SAN Volume
Controller 6.1 and Storwize V7000 only. The fields related to tiers are
not displayed for other storage systems.

Easy Tier Status
Indicates the status of tiering. Possible values are: active, inactive.

Figure 48. Virtual-Disk Details page
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Tiers Indicates the tier levels used by the virtual disk. Each tier is displayed
as a row in a table. Possible values are: generic_hdd, generic_ssd.

Tier Capacity
Total storage capacity of a tier.

Type Type of a virtual disk:
v Image
v Sequential
v Striped

Formatted
Indicates if a virtual disk is formatted.

MDisk ID
IDs of the MDisks that a virtual disk is using.

MDisk name
Names of the MDisks that a virtual disk is using.

FlashCopy
Indicates if the virtual disk is in a FlashCopy (FC) relationship and
whether it is an FC source or FC target. Virtual disks that are not in an
FC relationship are displayed with a None value whether or not the
virtual disk is on a system that supports FC.

Note:

v This value is available for virtual disks of the following systems only:
IBM TotalStorage Enterprise Storage Server, IBM System Storage
DS6000, IBM System Storage DS8000, and SAN Volume Controller.

v TotalStorage Enterprise Storage Server systems must have at least the
following microcode levels: ess800mincodelevel = 2.4.3.56,
essf20mincodelevel = 2.3.3.89. IBM Tivoli Storage Productivity Center
does not report FC information if the TotalStorage Enterprise Storage
Server systems do not meet this requirement.

FlashCopy ID
ID of the FlashCopy mapping to which the virtual disk belongs.

FlashCopy name
Name of the FlashCopy mapping to which the virtual disk belongs.

Metro mirror ID
ID of the Metro Mirror relationship to which the virtual disk belongs.

Metro mirror name
Name of the Metro Mirror relationship to which the virtual disk
belongs.

I/O throttling rate
Maximum rate at which an I/O transaction is accepted for a virtual
disk.

Preferred node for I/O
IP address of the node to be used for I/O operations.

Mapped to a host
Yes or No.

Fast-write state
Yes or No. This value indicates whether the virtual disk has data in the
cache.
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UID Unique ID.

Managing volumes
This topic contains information about managing volumes.

Assigning host ports
This topic describes how to assign host ports to volumes. You also can make
host-port assignments when you create volumes.
1. In the navigation tree pane, expand Disk Manager and click Storage

Subsystems. In the content pane, the Storage Subsystems window is
displayed.

2. In the Storage Subsystems table, click the storage subsystem with which you
want to work.

3. Click Volumes. The Volumes page is displayed.

4. Select a filtering condition, and then click Go. A list of volumes is displayed.
5. In the Volumes table, select the volume, and then click Assign Host Ports.

The Assign Host Ports wizard starts.
6. On the "Assign the volume to host ports" page, assign or unassign host ports:

a. Optional: In the Available ports field, select the ports that you want to

assign to the virtual disks, and then click .
b. Optional: In the Assigned ports field, select any ports that you want to

unassign from the virtual disks, and then click . To avoid lost or
inconsistent data, make sure that the volume is unmounted before
unassigning.
Note: if a host (agent) with multiple host ports is defined to a storage
subsystem, assigning a volume to the host ports will create a single host
definition with all of those ports.

Figure 49. Volumes page
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If a host (agent) with multiple host ports is not defined to a storage
subsystem on the same fabric, assigning a volume to the host ports will
create a separate host definition for each port (multiple host definitions,
each with a single port).

c. Click Next.
7. On the "Assign the volume to subsystem ports" page, assign the volumes to

specific subsystem ports.
a. Optional: In the Available ports list, select subsystem ports and click >> to

assign them to the volumes. The ports are identified using the following
convention: <Worldwide port name> (<host name>).

b. Click Next.
8. (This page only is displayed if Fabric Manager is installed, and you have

Fabric administrator authority.) On the "Zone actions" page, perform one of
the following zone actions:

Create a new zone
Click Create new Zone. In the Zone name field, type the name of the
zone. The ports listed on the page are added to the new zone.

Update an existing zone
Click Update existing zone, and then select a zone. The ports listed
on the page are added to the selected zone.

Leave the zone configuration as it is
Click Do neither to avoid performing any fabric-control tasks. The
ports listed on the page will not be able to communicate with the
subsystem on this fabric.

9. Click Next. The "Review settings" page opens.
10. Review the selections that you made earlier in the wizard, and then click

Finish.

Creating volumes and assigning volumes to a host
This task describes how to create volumes and assign the volumes to a host
storage system. This task also describes how to perform zone configuration tasks if
Fabric Manager is installed, and you have Fabric administrator authority

The performance of a volume creation job and the general performance of a CIM
object manager (CIMOM) might decrease if you create many volumes on a system
at the same time that a performance monitor is collecting data about that system.
To avoid this issue, create volumes on a system when a performance monitoring
job is not runnings or is not scheduled to run on the target system.

The following steps describe how to create volumes, assign the volumes to a
storage system. Some fields described in these steps are dependent on the type of
storage system that you have selected.
1. Expand Disk Manager and click Storage Subsystems.
2. In the Storage Subsystem table, select a storage system, and click Create

Volume. The Create Volume wizard is started.
3. On the Define the volumes page, specify the attributes for the volumes:

a. In the RAID level field, select one of the following Redundant Array of
Independent Disks (RAID) levels, based on the type of storage system:
v IBM System Storage DS6000 and IBM System Storage DS8000: RAID 5,

RAID 6 (DS8000 only), RAID 10, or Mixed. RAID 5 is the default setting.
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v IBM TotalStorage Enterprise Storage Server: RAID 5 or RAID 10. RAID 5
is the default setting.

v IBM System Storage FAStT/DS4000 and IBM System Storage DS5000
Storage Manager: RAID 0, RAID 1, RAID 3, or RAID 5. RAID 0 is the
default setting.

b. In the Encryption group field, select an encryption group if you want the
new volumes to be created on extent pools that use full disk encryption. If
an encryption group is selected, only pools that belong to the selected
encryption group are displayed in the Available extent pools field. If there
are no encryption groups available, No selection is displayed in the
Encryption group field.

c. Select the Solid state based pools only check box if you want the new
volumes to be created on extent pools that are on solid-state drives. If this
check box is selected, only pools on solid-state drives are displayed in the
Available extent pools field. If there are no solid-state drives available, the
Solid state based pools only check box is disabled.

d. In the Available extent pools field, select an extent pool from the list of
extent pools with the specified RAID level. These extent pools are identified
using the following convention: Device-specific extent pool name (free space
GB). This field is displayed if the system is DS6000 or DS8000. Only extent
pools with fixed-block (FB) tracks are listed.

e. In the Available arrays field, select an array from the list of arrays with the
specified RAID level. These arrays are identified using the following
convention: Device-specific array name (free space GB). This field is displayed
if the system is neither DS6000 nor DS8000.

f. In the Number of volumes field, select the number of volumes that you
want to create. The default is 1. For an TotalStorage Enterprise Storage
Server system, the maximum is 255.

g. In the Volume size field, select the size of the volumes to be created. The
maximum and minimum size depends on the type of storage system.

h. In the Units field, select one of the following units of measurement for the
size of the volumes:
v KB
v MB
v GB

i. In the Name field, type a name for the volume. If you are creating multiple
volumes, this string is used as a prefix. The string cannot be longer that 15
characters. This field is disabled for TotalStorage Enterprise Storage Server
systems. TotalStorage Enterprise Storage Server volume names are
determined by TotalStorage Enterprise Storage Server.

j. Click Next.
4. On the Assign the volume to host ports page, assign the volume to specific host

ports:

a. In the Available ports list, select host ports and click to assign the
ports to the volumes. The ports are identified using the following
convention: Worldwide port name (host name).

b. Click Next.
5. On the Restrict access to subsystem ports page, you can restrict the host access

to specific system ports:
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a. Optional: In the Unassigned ports list, select system ports and click
to remove the ports from the list of ports assigned to the volume. The ports
are identified using the following convention: Worldwide port name (host
name). To avoid lost or inconsistent data, make sure that the volume is
unmounted before you unassign ports.

b. Click Next.
6. On the Zone actions page, perform one of the following zone actions. This page

is displayed only if Fabric Manager is installed, and you have Fabric
administrator authority.
Use a Zone Action if you want to apply updates to the active zone set. This
action applies changes to the inactive zone set that has the same name as the
active zone set and then the zone set is activated. Before using this option,
ensure that the zones and zone members in the active zone set matches the
zones and zone members in the inactive zone set with the same name.

Create a new zone
Click Create new Zone. In the Zone name field, type the name of the
zone. The ports that are listed are added to the new zone.

Update an existing zone
Click Update existing zone, and then select a zone. The ports that are
listed are added to the selected zone.

Leave the zone configuration as it is
Click Do neither to avoid performing any fabric-control tasks. The
ports listed that are listed are not able to communicate with the
subsystem on this fabric.

Click Next.
7. On the Summary page, review the selections that you made earlier in the

wizard.
8. Click Finish.

Deleting volumes
This topic describes how to delete volumes.

Note that volumes that are part of a replication session cannot be deleted.
1. In the navigation tree pane, expand Disk Manager and click Storage

Subsystems. In the content pane, the Storage Subsystems page is displayed.
2. In the Storage Subsystems table, click a storage subsystem, and then click

Volumes. The Volumes page is displayed.
3. On the Volumes page, select the specific filtering condition, and then click Go.

A list of volumes on the selected storage subsystem is displayed.
4. In the Volumes table, select the volume that you want to delete, and then click

Delete. You can select one volume at a time only. You cannot delete
TotalStorage Enterprise Storage Server volumes from within IBM Tivoli Storage
Productivity Center.

5. When prompted to confirm that you want to delete the volume, click Yes. The
volume is deleted automatically when you click Yes. You can reuse the volume
name immediately after the volume is deleted.

Note: For SAN Volume Controller (SVC), if you choose to delete a volume
using the SVC console rather than the IBM Tivoli Storage Productivity Center
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user interface, that volume is retained for 14 days before being deleted. You
cannot reuse the volume name during that time.

Viewing volume information
This topic describes how to view information about the volumes in your
environment.

Note: If a probe is run against a CIM object manager (CIMOM) that is not
available, the volumes defined on the storage system are not displayed in the IBM
Tivoli Storage Productivity Center graphical user interface (GUI). Check that
probes run successfully and consider configuring an alert to ensure that you are
notified when a scheduled probe fails.
1. Expand the Disk Manager node in the navigation tree and click Storage

Subsystems. In the content pane, the Storage Subsystems page is displayed.
2. In the Storage Subsystems table, click a storage system, and then click

Volumes. The Volumes page opens.
3. Select the specific filtering condition, and then click Go. A list of volumes

associated with the selected storage system is displayed. The Volume table
contains the following information about each volume:

Volume
Volume ID.

Subsystem
A system ID in the following format:
Type-Model-ID-Vendor

v Type is the type of the storage system, for example, TotalStorage
Enterprise Storage Server or SAN Volume Controller.

v Model is the model number, for example, 2105 or 2145.
v ID is the serial number or cluster name. Cluster names only are used

for SAN Volume Controllers.
v Vendor is the manufacturer of the storage system, for example, IBM.

Subsystem Label
A user-defined name or the system ID.

LCU Logical control unit (LCU), which can have one of the following values:
v DS6000, DS8000, and TotalStorage Enterprise Storage Server -- logical

system (LSS) ID
v SAN Volume Controller --1

Type Type of volume, either fixed-block (FB) or count-key data (CKD).

Volume Space
Size of the volume.

Unit GB for fixed-block (FB) volumes and cyl for count-key data (CKD)
volumes.

4. To view detailed information about a specific volume, click the volume, and

then click . The Volume Details page is opened. The Volume Details page
contains the following information:

Volume
Volume ID.

Volume size
Volume size.
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Volume real space
Physical allocated space of the volume. For normal volumes, this value
is equal to the volume space. For space efficient/thin provisioned
volumes, this value is equal to the real space allocated when data is
written to the volume. If IBM Tivoli Storage Productivity Center detects
that a volume is thin provisioned but cannot retrieve the Volume real
space value, N/A is displayed.

Array Array on which the volume is created.

RAID level
Redundant Array of Independent Disks (RAID) level of the volume.

FlashCopy
Indicates if the volume is in a FlashCopy (FC) relationship and whether
it is an FC source or FC target. Volumes that are not in an FC
relationship are displayed with a None value whether or not the
volume is on a system that supports FC.

Note:

v This value is available for volumes of the following systems only:
IBM TotalStorage Enterprise Storage Server (TotalStorage Enterprise
Storage Server), IBM System Storage DS6000, IBM System Storage
DS8000, and IBM System Storage SAN Volume Controller.

v TotalStorage Enterprise Storage Server systems must have at least the
following microcode levels: ess800mincodelevel = 2.4.3.56,
essf20mincodelevel = 2.3.3.89. IBM Tivoli Storage Productivity Center
does not report FC information if the TotalStorage Enterprise Storage
Server systems do not meet this requirement.

Subsystem
A system ID in the following format:
Type-Model-ID-Vendor

where:
v Type is the type of the storage system, for example, TotalStorage

Enterprise Storage Server or SAN Volume Controller.
v Model is the model number, for example, 2105 or 2145.
v ID is the serial number or cluster name. Cluster names only are used

in for SAN Volume Controllers.
v Vendor is the manufacturer of the storage system, for example, IBM.

Subsystem Label
This value can be either a user-defined name or the system ID.

Is Encryptable
Indicates Yes when the volume is encryptable and No when the
volume is not encryptable.

Is Encrypted
Indicates Yes when the volume is encrypted and No when the volume
is not encrypted.

Assigned host ports
Host ports to which the volume is assigned.

Subsystem ports
System ports to which the volume is assigned.
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Managing fabrics
This section describes operations available for directly manipulating the zone
configuration in a fabric.

Zone control functions are also integrated in the Storage Provisioning function (see
“Provisioning planner” on page 109) and the SAN Planner functions.

For further information, see “Planning and modifying storage configurations” on
page 419).

Note:

v After you click Change to begin your zone configuration changes and before
you click Update and Activate or Update Only to conclude your changes, it is
possible that other users might have made zoning changes to the same fabric.
This situation might have happened through a switch element manager or
switch CLI, as some switch vendors and models lack zone control session
locking across the fabric. This lack of zone control session locking might allow
overwrite conditions of the changes to the active zoneset for the fabric and to
the set of inactive zonesets.

v If the zoning on a fabric has an active configuration and you use a switch
element manager to delete the inactive copy of the active zoneset, Tivoli Storage
Productivity Center still displays the inactive copy of the active zoneset on the
Fabric Manager > Fabrics > Zone Configuration panels. Tivoli Storage
Productivity Center displays the inactive copy even though it does not exist in
the fabric zone configuration so that you can edit the active zoneset.
The contents of this inactive copy of zoneset displayed is identical to contents of
the active copy of the zoneset. If you use Tivoli Storage Productivity Center to
make any subsequent zoning changes for the fabric, the inactive copy of the
active zoneset is created in the fabric zone configuration.

Working with zones
This topic describes how to create, change, duplicate, activate or deactivate, and
delete zones.

Creating zones
When you add zones, you assign assets to the zone and specify the zone set or sets
to which the zone belongs.

To create a zone:
1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zones area, click Add.
5. In the Zone Configuration window enter the name of the zone and, optionally,

a description. The zone name must be unique in the fabric. Click Next.
6. In the next Zone Configuration window, select the assets (switches, devices,

aliases) that you want to include in the zone, move them from the Available
Assets column to the Selected Assets column, and click Next.
If the fabric is set on Interop Mode, you can select only the port WWN number
and the device port number from the Available Assets column.
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7. In the next Zone Configuration window, select one or more zone sets, move
them from the Available Zone Sets column to the Selected Zone Sets column,
and click Finish.

Adding storage to a server and setting up a zone

To add storage to a server and set up a zone, do the following:
1. Add the CIMOM

a. Expand Administrative Services → Data Sources → CIMOM Agents .
b. Click Add CIMOM in the content pane.
c. In the Add CIMOM window, enter the required values and click Save.

2. Run a CIMOM discovery

a. Expand Administrative Services → Discovery.
b. Right-click CIMOM and select Run Now.
c. Right-click CIMOM and select Refresh Job List for the submitted job to

appear in the list of discovery jobs. The date and time of the job is
displayed in the navigation tree pane. To see the latest status of the job,
right-click CIMOM and select Update Job Status.

3. Run a probe

When the discovery has completed successfully, perform the following steps:
a. Expand IBM Tivoli Storage Productivity Center → Monitoring .
b. Right-click Probes and select Create Probe.
c. Make your selections and click Save to submit the job.
d. Right-click Probes and select Refresh Job List to display the job in the list

of probes. The date and time of the job will be displayed in the navigation
tree pane. To see the latest status of the job, right-click Probes and select
Update Job Status.

4. In the navigation tree pane, expand Data Manager and click Storage
Subsystems. In the content pane, the Storage Subsystems window opens.

5. In the Storage Subsystems table, click the storage subsystem with which you
want to work.

6. Click Volumes.
7. In the Volumes page select a filtering condition, and click Go.
8. In the Volumes table, select the volume, and then click Assign Host Ports.

The Assign Host Ports wizard starts.
9. On the "Assign the volume to host ports" page, you can assign and unassign

host ports:
a. In the Available ports field, select the ports that you want to assign to the

virtual disks, and then click .
b. In the Assigned ports field, select any ports that you want to unassign

from the virtual disks, and then click .
c. Click Next.

10. On the "Assign the volume to subsystem ports" page, assign the volumes to
specific subsystem ports.
a. Optional: In the Available ports list, select subsystem ports and click

to assign them to the volumes. The ports are identified using the
following convention: <Worldwide port name> (<host name>).

b. Click Next.
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11. "Zone actions" page is displayed only if Fabric Manager is installed, and you
have Fabric administrator authority. Perform one of the following zone
actions:

Create a new zone
Click Create new Zone. In the Zone name field, type the name of the
zone. The ports listed on the page are added to the new zone.

Update an existing zone
Click Update existing zone, and then select a zone. The ports listed on
the page are added to the selected zone.

Leave the zone configuration as it is
Click Do neither to avoid performing any fabric-control tasks. The
ports listed on the page will not be able to communicate with the
subsystem on this fabric.

Click Next.
12. In the "Review settings" page, review your selections and click Finish.

Changing zone properties
You can change a zone name, a description, the assets assigned to a zone, and the
zone set or sets to which a zone belongs.

To change zone properties, perform the following steps:
1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zones area, click Change.
5. In the Zone Configuration window enter the name of the zone and, optionally,

a description. The zone name must be unique in the fabric. Click Next.
6. In the next Zone Set Configuration window, you can change the assets to be

included in the zone:
v In the Available Assets column, select any zone assets to be added and click

to move them to the Selected Assets column.
v In the Selected Assets column, select any zone assets to be removed from

the zone and click to move them to the Available Assets column.
v Click Next.

7. In the next Zone Set Configuration window, you can change the zone sets to
which the zone is assigned:
v In the Available Zone Sets column, select any zone sets to which the zone is

to be assigned and click to move them to the Selected Zone Sets
column.

v In the Selected Zone Sets column, select any zone sets to which the zone is

not to be assigned and click to move them to the Available Zone
Sets column.

8. Click Finish.

Duplicating zones
You can use the Zones dialog to duplicate a zone.

To duplicate zones, perform the following steps:
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1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zones area, click Duplicate.
5. In the Zone Configuration window enter the name of the zone and, optionally,

a description. The zone name must be unique in the fabric. Click Next.
6. In the next Zone Configuration window, you can change the assets to be

included in the zone:
v In the Available Assets column, select any zones to be added and click

to move them to the Selected Assets column. To remove selected
zone assets, select the assets from the Selected Assets column and click

to move them to the Available Assets column.
v Click Finish.

7. In the next Zone Configuration window, you can change the zone sets to which
the zone is assigned:
v In the Available Zone Sets column, select any zone sets to which the zone is

to be assigned and click to move them to the Selected Zone Sets
column.

v In the Selected Zone Sets column, select any zone sets to which the zone is

not be assigned and click to move them to the Available Zone Sets
column.

8. Click Finish.

Removing zones
You can use the Zones dialog to remove one or more zones from the list of
available zones.

To delete zones, perform the following steps:
1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zones area, select one or more zones and click Remove. Hold down the

Control or Shift key to select multiple zones.
5. In the Zone Deletion window, click Yes to delete the selected zones or No to

cancel the deletion.

Working with zone sets
This topic describes how to create, change, duplicate, activate or deactivate, and
delete zone sets.

A zone set is group of zones that function together on the fabric. Each zone set can
accommodate up to 256 zones. All devices in a zone detect only devices assigned
to that zone, but any device in that zone can be a member of other zones in the
zone set.

Creating zone sets
This topic provides information about creating new zone sets.

To create a zone set, follow this procedure:
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1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zone Sets area, click Add.
5. Type a name and description for the zone set, and click Next. The zone set

name must be unique within the fabric.
6. In the Zone Set Configuration window, do one of the following:

v Select one or more zones from the Available Zones column, move them to
the Selected Zones column, and click Finish.

v If there are no zones yet defined or if you are not adding any of the zones
available at this time, click Finish. A Zone Set Configuration Error window
opens stating: "This zone set does not contain any zones. This could result in
an error when the zone configuration is applied later. Do you want to
continue?" Click Yes.

Changing zone set properties
You can change the zone set definition, which includes the name, description, and
the zones that belong to the zone set. When you change and save a zone set
definition, the properties are checked by the switches when that definition is stored
in the fabric. This can help identify possible problems with that definition before
the definition is activated, giving you a chance to correct any problems found
before they affect the operation of the fabric.

Note: Changing and saving the definition for the active zone set does not change
the active zone set itself. You must perform an additional step to apply the new
definition to the active zone set.

Note: After you click Change to begin your zoning changes and before you click
Update and Activate or Update Only to conclude your zoning changes, it is
possible that other users might have made zoning changes to the same fabric. This
may have happened through a switch element manager or switch CLI, as some
switch vendors and models lack zone control session locking across the fabric. This
could allow overwrite conditions of the changes to the active zoneset for the fabric
and to the set of inactive zonesets.

To change the zone set properties, perform the following steps:
1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zone Sets area, click the zone set to be changed and click Change.
5. In the Zone Set Configuration window, type a name and description for the

zone set, and click Next. The zone set name must be unique within the fabric.
6. In the next Zone Set Configuration window, you can change the zones to be

included in the zone set:
v In the Available Zones column, select any zones to be added and click

to move them to the Selected Zones column.
v In the Selected Zones column, select any zones to be removed from the zone

set and click to move them to the Available Zones column.
7. Click Finish.
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Activating and deactivating a zone set
Only one zone set can be active at a time. If you deactivate the active zone set, no
zone sets are active until you activate another zone set.

To activate or deactivate a zone set, follow these steps:
1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zone Sets area, click Activate or Deactivate.
5. In the Zone Configuration area, click one of the following actions:

v Update and Activate to commit the changes you have made to the zone set
configuration and immediately activate the zone set.

v Update Only to commit the changes you have made to the zone set
configuration without making them active.

Duplicating zone sets
This section provides information about duplicating zone sets.

To create a duplicate zone set, perform the following tasks.
1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zone Sets area, click the zone set to be duplicated and click Duplicate.
5. In the Zone Set Configuration window, type a name and description for the

zone set, and click Next. The zone set name must be unique within the fabric.
6. In the Zone Set Configuration window, you can change the zones to be

included in the new zone set:
v In the Available Zones column, select any zones to be added and click

to move them to the Selected Zones column.
v In the Selected Zones column, select any zones to be removed from the zone

set and click to move them to the Available Zones column.
7. Click Finish.

Working with zone aliases
This topic describes how to add, change, duplicate, and remove zone aliases. Using
zone aliases is a convenient way to work with a named collection of zone members
that you want to manage together.

Creating zone aliases
Creating a zone alias is a convenient way to assign a name to a collection of zone
members that you want to manage together.

To create a zone alias:
1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zones Aliases area, click Add.
5. Enter a unique name for the zone alias that will have zone members. Use the

following guidelines for naming a zone alias:
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a. The maximum length for the zone alias name is 54 characters.
b. Allowed characters are: A-Z and a-z; _ (underscores)
c. The name must not begin with a number.
d. Spaces are not allowed.

6. Enter an optional description of the zone alias. The description can be any
combination of alphanumeric characters.

7. Click Next.
8. In the next Zone Alias Configuration window, select the assets (switches,

devices, aliases) that you want to include in the zone alias, and move them
from the Available assets column to the Selected assets column, and click
Next.

9. In the final Zone Alias Configuration window, select one or more zones, move
them from the Available Zones column to the Selected Zones column, and
click Finish.

Note: Not all devices support zone aliases. Please refer to the device manufacturer
documentation for further information on zone aliases.

Changing zone alias properties
You can change a zone alias name, description, the assets assigned to it, and the
zone members that are specified in the zone alias.

To change zone alias properties, perform the following steps:
1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zone Aliases area, select the zone alias you want to change and click

Change.
5. In the Zone Alias Configuration window change the name of the zone alias

and, optionally, enter or change the description. The zone alias name must be
unique in the fabric. Use the following naming guidelines:
a. The maximum length for the zone alias name is 54 characters.
b. Allowed characters are: A-Z and a-z; _ (underscores)
c. The name must not begin with a number.
d. Spaces are not allowed.

6. Click Next.
7. In the next Zone Alias Configuration window, you can change the assets to be

included in the zone alias:
v In the Available Assets column, select one or more assets to be added and

click the to move them to the Selected Assets column.
v In the Selected Assets column, select one or more assets to be removed from

the zone alias and click the to move them to the Available Assets
column.

v Click Next.
8. In the final Zone Alias Configuration window, you can change the zone

members as follows:
v In the Available Zones column, select one or more zone members and click

the to move them to the Selected Zones column.
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v In the Selected Zones column, select one or more zone members and click

the to move them to the Available Zones column.
9. Click Finish.

Duplicating zone aliases
To create a new zone alias that's based on an existing one, you can duplicate a
zone alias and then make changes to it.

To duplicate an existing zone alias and make changes to it, perform the following
steps:
1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
3. In the Zone Configuration area, click Change.
4. In the Zone Aliases area, select the zone alias you want to duplicate and click

Duplicate.
5. In the Zone Alias Configuration window change the name of the zone alias

and, optionally, enter or change the description. The zone alias name must be
unique in the fabric. Use the following naming guidelines:
a. The maximum length for the zone alias name is 54 characters.
b. Allowed characters are: A-Z and a-z; _ (underscores)
c. The name must not begin with a number.
d. Spaces are not allowed.

6. Click Next.
7. In the next Zone Alias Configuration window, you can change the assets to be

included in the new zone alias:
v In the Available Assets column, select any assets to be added and click the

to move them to the Selected Assets column.
v In the Selected Assets column, select any assets to be removed from the

zone alias and click the to move them to the Available Assets
column.

v Click Next.
8. In the final Zone Alias Configuration window, you can change the zone alias as

follows:
v In the Available Zones column, select one or more zones and click the

to move them to the Selected Zones column.

v In the Selected Zones column, select one or more zones and click the
to move them to the Available Zones column.

9. Click Finish.

Removing zone aliases
The following procedure removes a selected zone alias from all zones in the
currently selected fabric, and removes the zone alias from the fabric's zoning
configuration definition. To remove a zone alias from an individual zone or a
specific set of zones, use the Zone Configuration wizard.

To remove a zone alias, perform the following steps:
1. In the navigation pane, expand the Fabric Manager node and click Fabrics.
2. Click a fabric in the list and click Zone Configuration.
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3. In the Zone Configuration area, click Change.
4. In the Zone Aliases area, select the zone alias you want to remove and click

Remove. Hold down the Control or Shift key to select multiple zone aliases.
5. In the Zone Alias Deletion window, click Yes to delete the selected zone alias.

Managing Tape Libraries
IBM Tivoli Storage Productivity Center provides the capability to manage your
tape libraries. For this release, tape library management capabilities are limited to
support for the IBM 3584 tape library (full support) and the IBM 3494 tape library
(partial support).

You must have at least Tape Operator authority in order to access the functions in
the Tape Manager node. To view your authority level, open the "Role-to-Group
Mappings" window in the Administrative Services > Configuration node in the
navigation tree.
1. Discover IBM tape libraries attached to your SAN fabrics.
2. View tape library information.
3. Monitor the performance of groups of tape libraries by probing for data and

viewing alerts. .
4. Create and view asset and capacity reports using data collected from your tape

libraries.
Asset reports can include such information as the library identifier and the
status of the library. Capacity reports include such information as the number
of drives in a library, the number of tape slots, and the number of occupied
tape slots.

5. Use the topology viewer to view information about tape libraries, as described
in “Working with tape libraries in the topology viewer” on page 539.

Discovering tape libraries
Discovering tape libraries uses the same general process for discovering CIMOMs
as discovering storage subsystems does.
v Tape Manager automatically discovers available devices by contacting the CIM

agent that is running on those devices.
v You can add Tape CIMOMs by automatic SLP or manually.
v You can create discovery jobs to discover other Tape Library CIM agents, as

described in “Discover storage subsystem, tape library, and fabric information
with CIM agents” on page 333.

v You can set up your discoveries to run on a regular schedule, for example
weekly.

However, you view your tape libraries from a different location in the navigation
tree.
v To confirm the tape libraries that were discovered, complete the following steps:

1. In the navigation tree, expand Tape Manager.
2. Click Tape Libraries. The tape libraries that have been discovered will be

listed in the right pane.

IBM Tivoli Storage Productivity Center can detect a tape library that is connected
to a fabric through queries to the switches in the fabric and through CIMOM
queries. However, only basic information is available at this point, and the
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information from the two discoveries is not correlated. As a consequence, the tape
library is displayed in the topology L0:Storage view as two separate icons:
v After the in-band discovery, as a tape library of unknown status (a blue

diamond ) identified only by its world-wide name (WWN)
v After the CIMOM discovery, a tape library is identified as, for example, a 3494

or a TS3500

In order to correlate the information collected through the in-band and CIMOM
discoveries, you must run a tape library probe. Then the tape library will be
displayed by only one icon with its type identified.

Viewing tape library information
View collected tape library data to stay aware of discovered tape libraries and
usage information.
v Click Tape Manager. Left-click Tape Libraries. In the content pane, the Tape

Libraries page is displayed, which lists the discovered tape libraries.
Select a library from the table and then click one of the buttons to see further
details about that library. For example, select a library and click Drives to open
a page that lists all the drives for that library.
You can also right-click a library in the Tape Libraries table and select View
Details.

v Use the View Details feature in the topology viewer, as described in “Working
with tape libraries in the topology viewer” on page 539.

Monitoring tape libraries
Monitor the performance of tape libraries to be aware of events that occur, and to
respond to alerts.
1. Create one or more tape library groups, as described in “Creating tape library

groups” on page 373.
2. Create a probe job to collect data about your tape libraries and library groups,

as described in “Creating tape library probes” on page 340.
3. View alerts that are generated by your tape libraries, as described in “Viewing

alert logs” on page 403.

Managing DS8000 storage systems using element managers
Use the Configuration Utility in IBM Tivoli Storage Productivity Center to add and
manage element managers for IBM System Storage DS8000. Element managers are
applications that are used to configure and manage a storage device. You can add
and manage connections to the element manager that is provided with DS8000,
DS8000 Storage Manager, or you can specify other element managers for a device.

The Element Manager tab in the Configuration Utility is used to add and manage
DS8000 element managers. The Element Manager tab contains multiple sections.
The DS8000 Element Manager section shows the DS8000 element managers that
have been added to Tivoli Storage Productivity Center.

To expand or collapse the DS8000 Element Manager section, click the + or - icon
by the section heading.
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The DS8000 Element Manager section

The DS8000 Element Manager section contains a table listing the element
managers that are visible to Tivoli Storage Productivity Center and a Select Action
list. This list enables you to add an element manager to the section and to manage
existing element managers. The menu items that are shown in the Select Action
list depend on whether you have selected an element manager in the table. This
table contains the following fields:

Element Manager
Shows the IP address of the element manager or the display name if a
display name was defined.

Connection Status
Shows the status of the element manager. The values that appear in this
field are:
v Online (The element manager is accessible.)
v Offline (The element manager is not accessible)

Device
The name for the device as defined in Tivoli Storage Productivity Center.

UID/PWD
Shows whether a user ID and password have been defined for
authentication to the element manager. The values that appear in this field
are:
v Yes (A user ID and password have been defined.)
v No (A user ID and password have not been defined.)

LIC Enabled
Shows whether a launch descriptor file has been registered for the element
manager. An launch descriptor file is an XML file that describes the menus
and the detailed uniform resource locators (URLs) for applications. A
launch descriptor file is required to enable the launch in context feature for
the device. Tivoli Storage Productivity Center provides a launch descriptor
file for the element manager that is provided with DS8000.

The values that appear in this field are:
v Yes (Launch descriptor file has been registered.)
v No (Launch descriptor file has not been registered.)

Managed
Shows whether the element manager is associated with a DS8000 that has
subsystem interface connection for the device. The values that appear in
this field are:
v Yes (The element manager is associated with a DS8000 that has

subsystem interface connection for the device.)
v No (The element manager is not associated with a DS8000 that has

subsystem interface connection for the device.)

Configuring the DS8000 element manager
DS8000 Storage Manager is the element manager that is provided with IBM System
Storage DS8000. This section describes how to add and manage DS8000 Storage
Manager in IBM Tivoli Storage Productivity Center.

You can perform the following tasks for DS8000 element managers:
v Add DS8000 element managers that you want to manage.
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v Start a DS8000 element manager (for example, DS8000 Storage Manager) to
configure and administer the storage subsystems associated with the element
manager. On Windows, the DS8000 Storage Manager is started in a browser
window that is embedded in Tivoli Storage Productivity Center. On AIX, Linux,
and UNIX, DS8000 Storage Manager is started in an external Web browser
window.

v Modify or remove element managers.
v Test the connection between Tivoli Storage Productivity Center and element

managers.

DS8000 credentials

The configuration of DS8000 credentials depends on whether you are using the
single sign-on feature in your environment. Single sign-on is an authentication
process that enables you to start an application from another application using a
single user ID and password. For more information about single sign-on, refer to
“Single sign-on” on page 53.

To use single sign-on with DS8000, the DS8000 system must be release 4.2 or later
and must be configured for Lightweight Directory Access Protocol (LDAP). Tivoli
Storage Productivity Center passes the DS8000 user credentials as a Lightweight
Third Party (LTPA) token.

If you are not using single sign-on, the DS8000 element manager user name and
password are stored for each Tivoli Storage Productivity Center user. A set of user
credentials must be stored for each Tivoli Storage Productivity Center user who
wants to access an DS8000 element manager. The Element Manager tab lists all
element managers known to Tivoli Storage Productivity Center, regardless of the
presence of valid user credentials. Element manager credentials might be out of
date or absent for that Tivoli Storage Productivity Center user.

If the element manager has been added to Tivoli Storage Productivity Center using
different credentials from the ones you are using, or if you attempt to open the
DS8000 element manager for the first time after the element manager was added to
Tivoli Storage Productivity Center by DS CIM Agent discovery, the following
message is shown:

The element manager GUI cannot be accessed because the user name and
password are missing. Update the required fields in the next dialog. The
GUI will be displayed after the fields have been correctly completed and
the dialog closed.

If you created an element manager with one set of credentials and are currently
logged on to Tivoli Storage Productivity Center as another user with different
credentials, you can open the DS8000 element manager in one of two ways:
v Add credentials. Close the warning message. The Modify Element Manager

window opens. Add the current credentials and click Save. You can then open
the DS8000 element manager for that element manager.

Important: Use this method with caution because anyone who knows the Tivoli
Storage Productivity Center credentials can manage the DS8000 device, including
performing destructive operations.

v Log on as the user who added the element manager. Close the warning
message and the Modify Element Manager window. Log off of Tivoli Storage
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Productivity Center. Log on with the user ID that was used to create the element
manager. From the Configuration Utility Element Manager tab, start the DS8000
element manager.

Adding DS8000 element managers using the Configuration Utility
Use the Configuration Utility when you want to add one element manager at a
time.

To add an element manager in Tivoli Storage Productivity Center, follow these
steps:
1. Click Element Management in the toolbar, or expand the IBM Tivoli Storage

Productivity Center node in the navigation tree, click Configuration Utility,
and open the Element Manager tab. Any existing element managers are
automatically added to the Element Manager section when the tab opens.

2. In the DS8000 Element Manager section, select Add Element Manager from
the Select Action list. The add Element Manager dialog box displays.

3. Define the information that is required to connect to the element manager
using the following fields. Required fields are specified in bold in the dialog
box. In the following field descriptions, required fields are marked by an
asterisk.

*Host Enter the Domain Name System (DNS) name or Internet Protocol (IP)
address of the host computer where the element manager is located.
You can enter an IPv4 or IPv6 name or address depending on what
address types are configured on the element manager and on the
system where Tivoli Storage Productivity Center is installed.
v Enter an IPv4 address in the following format: ###.###.###.###. For

example: 192.168.1.65.
v Enter an IPv6 address. These addresses are typically written as eight

groups of four hexadecimal digits, but might vary from site to site.
For example: 2001:db8:0:0:1812:5b9e:3391:3156. You can use IPv6
addresses if the computer where Tivoli Storage Productivity Center is
dual-stack enabled (IPv4 and IPv6).

Restriction: If the computer on which the element manager is located is
IPv6-only, the Tivoli Storage Productivity Center servers must be
installed on an IPv6-only or dual stack (IPv4 and IPv6 addresses are
configured) computer.

*Port Enter the port number on which the element manager listens for
requests. The default port number that is shown depends on the value
that is selected in the Protocol field. You can modify the port number if
required for your environment.

Username
Enter the user name that Tivoli Storage Productivity Center will use to
log on to the element manager.

Password
Enter the password associated with the user name that is defined in the
Username field.

If the DS8000 element manager you want to add is a new installation
and the enterprise storage server network interface (ESSNI) user
password has not been changed from the initial value of admin, you
are prompted to change the password. Be prepared to enter a password
and record the new password in a safe place.
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*Protocol
Select the protocol (http or https) for the element manager.

Display Name
Enter a display name for the element manager. The display name is
shown in the Element Manager field in the DS8000 element manager
table. If this field is blank, the IP address of the computer on which the
element manager is located is shown in the Element Manager field of
the table. The display name is used in Tivoli Storage Productivity
Center and does not affect the element manager itself.

Save Click this button to add the DS8000 element manager. Tivoli Storage
Productivity Center tests the connection to the element manager. If the
connection is successful, the element manager is displayed in the
DS8000 element manager table. If the connection is unsuccessful, an
error message displays indicating that the element manager at the
specified IP address could not be added.

Cancel
Click this button to close the dialog box without adding the DS8000
element manager.

Starting DS8000 element managers
Use the Configuration Utility to start IBM System Storage DS8000 element
managers from IBM Tivoli Storage Productivity Center. You can also start DS8000
element managers from other points in Tivoli Storage Productivity Center.

To start DS8000 element managers using the Configuration Utility follow these
steps:
1. Expand the IBM Tivoli Storage Productivity Center node in the navigation

tree, click Configuration Utility, and open the Element Manager tab. Note:
You can also access the Element Manager tab by selecting Element
Management in the tool bar.

2. In the DS8000 Element Manager section, click the element manager that you
want to start from the DS8000 element manager table.

3. Use one of the following methods to start the element manager:
v To start the default element manager for DS8000, select Launch Default

Element Manager from the Select Action list.
v To start another element manager for DS8000, right-click the element

manager that you want to start and click Launch Element Manager. Select
the element manager that you want to start from the menu.

If the connection information for an element manager is valid, the element
manager is started. If unsuccessful, an error message is displayed. The error
messages that you receive describes one of the following problems:
v that the element manager at the specified IP address could not be started
v that the required connection information for the element manager has not been

provided
v that the element manager is not installed and configured correctly (for local

element manager installations such as XIV Storage Manager)

If you are prompted to enter additional information such as an ID and password
for the element manager, complete the following steps:
1. Click OK in the message dialog box. The Modify Element Manager dialog box

is displayed.
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2. Enter the required information for the element manager and click Save.

Modifying DS8000 element managers
Use the Configuration Utility to modify information for IBM System Storage
DS8000 element managers in IBM Tivoli Storage Productivity Center.

To modify an element manager in Tivoli Storage Productivity Center, follow these
steps:
1. Click Element Management in the toolbar, or expand the IBM Tivoli Storage

Productivity Center node in the navigation tree, click Configuration Utility,
and open the Element Manager tab.

2. In the DS8000 Element Manager section, select the element manager that you
want to modify from the DS8000 element manager table.

3. Select Modify Element Manager from the Select Action list. The Modify
Element Manager dialog box is displayed.

4. Modify any of the following fields:

Username
Enter the user name that Tivoli Storage Productivity Center will use to
log on to the element manager.

Password
Enter the password associated with the user name that is defined in the
Username field.

If the DS8000 element manager you want to add is a new installation
and the enterprise storage server network interface (ESSNI) user
password has not been changed from the initial value of admin, you
are prompted to change the password. Be prepared to enter a password
and record the new password in a safe place.

Password Confirm
Enter the same password that you entered in the Password field.

Display Name
Enter a display name for the element manager. The display name is
shown in the Element Manager field in the DS8000 element manager
table. If this field is blank, the IP address of the computer on which the
element manager is located is shown in the Element Manager field of
the table. The display name is used in Tivoli Storage Productivity
Center and does not affect the element manager itself.

Save Click this button to modify the element manager information. Tivoli
Storage Productivity Center tests the connection to the element
manager. If the connection is successful, the element manager
information is saved. If the connection is unsuccessful, an error
message appears indicating that the element manager at the specified
IP address could not be added.

Cancel
Click this button to close the dialog box without modifying the element
manager information

Removing DS8000 element managers
Use the Configuration Utility to remove IBM System Storage DS8000 element
managers from IBM Tivoli Storage Productivity Center. This action does not affect
DS8000 Storage Manager on the Hardware Management Console (HMC).
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To remove an element manager from Tivoli Storage Productivity Center, complete
the following steps:
1. Click Element Management in the toolbar, or expand the IBM Tivoli Storage

Productivity Center node in the navigation tree, click Configuration Utility,
and open the Element Manager tab.

2. In the DS8000 Element Manager section, select the element manager that you
want to remove from the DS8000 element manager table.

3. Select Remove Element Manager from the Select Action list. A confirmation
dialog box is displayed.

4. Click OK. The element manager is deleted from the DS8000 element manager
table. When you remove an element manager, it is removed only from the list
of element managers that are visible to Tivoli Storage Productivity Center.
To exit the window without removing the element manager, click Cancel.
You can remove only one element manager from the DS8000 element manager
table at a time.

Testing the connection to DS8000 element managers
Use the Configuration Utility to test the connection to DS8000 element managers
from IBM Tivoli Storage Productivity Center.

To test the connection to an element manager from Tivoli Storage Productivity
Center, follow these steps:
1. Click Element Management in the toolbar, or expand the IBM Tivoli Storage

Productivity Center node in the navigation tree, click Configuration Utility,
and open the Element Manager tab.

2. In the DS8000 Element Manager section, select the element manager for which
you want to test the connection from the DS8000 element manager table.

3. Select Test Element Manager Connection from the Select Action list. IBM
Tivoli Storage Productivity Center tests the status of the element manager
connection. A message dialog box that states whether the test passed or failed
is displayed.

Configuring other element managers for DS8000
DS8000 Storage Manager is the element manager that is provided with IBM System
Storage DS8000. However, you can add other element managers for DS8000 as
described in this section.

Adding user-defined element managers for DS8000
A user-defined element manager for IBM System Storage DS8000 is an element
manager other than DS8000 Storage Manager. Use the Configuration Utility to add
user-defined element managers for IBM System Storage DS8000 in IBM Tivoli
Storage Productivity Center.

User-defined element managers are not displayed in the DS8000 Element Manager
table. These element managers are displayed in the various launch menus that are
provided in IBM Tivoli Storage Productivity Center.

To add user-defined element managers in Tivoli Storage Productivity Center,
follow these steps:
1. In the navigation tree, expand IBM Tivoli Storage Productivity Center.

Left-click Configuration Utility. In the content pane, click the Element
Manager tab.
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2. In the DS8000 Element Manager section, select the row in the DS8000 element
manager table that contains the device to which you want to add a
user-defined element manager.

3. Select Add User Defined Element Manager from the Select Action list. The
Add User Defined Element Manager dialog box is displayed.

4. Enter a Uniform Resource Locator (URL) or command to start the element
manager, and click Save.
To exit without adding a element manager, click Cancel.

Removing user-defined element managers for DS8000
Use the Configuration Utility to remove user-defined element managers for IBM
System Storage DS8000 in IBM Tivoli Storage Productivity Center.

To remove a user-defined element manager from Tivoli Storage Productivity
Center, follow these steps:
1. Click Element Management in the toolbar, or expand the IBM Tivoli Storage

Productivity Center node in the navigation tree, click Configuration Utility,
and open the Element Manager tab.

2. In the DS8000 Element Manager section, select the row in the DS8000 element
manager table that contains the device from which you want to remove a
user-defined element manager.

3. Select Remove Element Manager from the Select Action list. The Remove
Element Manager dialog box opens.

4. Select the element manager that you want to remove from the list and click
OK. The element manager is removed. When you remove an element manager,
it is removed only from the list of element managers that are visible to Tivoli
Storage Productivity Center.
To exit the window without removing the element manager, click Cancel.

Managing other storage systems using element managers
Use the Configuration Utility in IBM Tivoli Storage Productivity Center to add and
manage element managers for storage devices other than IBM System Storage
DS8000. Element managers are applications that are used to configure and manage a
storage device. You manage connections to the element managers that are provided
with the storage device or you can specify other element managers for a device.

The Element Manager tab in the Configuration Utility is used to add and manage
element managers. The Element Manager tab contains multiple sections. The
Other Device Element Manager section shows element managers that have been
added using a discovery job or existing element managers that were added to
Tivoli Storage Productivity Center prior to release 4.1.

If you are gathering data from IBM XIV Storage System, the XIV system element
manager is displayed in the Other Device Element Manager section. However, the
tasks available for the other element managers in this section are not available for
the XIV system element manager. Use the Storage Subsystem page to work with
the XIV system element manager (see “Managing storage subsystems” on page
551).

To expand or collapse the Other Device Element Manager section, click the + or -
icon by the section heading.
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Other Device Element Manager section

The Other Device Element Manager section contains a table listing the element
managers or external tools that are visible to Tivoli Storage Productivity Center
and a Select Action list. This list enables you to manage existing element
managers. The menu items that are shown in the Select Action list depend on
whether you have selected an element manager in the table. This table contains the
following fields:

Element Manager
Shows the IP address of the element manager or the display name if a
display name was defined.

Connection Status
Shows the status of the element manager. The values that appear in this
field are:
v Online (The element manager is accessible.)
v Offline (The element manager is not accessible)

Device
The name for the device as defined in Tivoli Storage Productivity Center.

UID/PWD
Shows whether a user ID and password have been defined for
authentication to the element manager. The values that appear in this field
are:
v Yes (A user ID and password have been defined.)
v No (A user ID and password have not been defined.)

LIC Enabled
Shows whether a launch descriptor file has been registered for the element
manager. A launch descriptor file is an XML file that describes the menus
and the detailed uniform resource locators (URLs) for applications. A
launch descriptor file is required to enable the launch in context feature for
the device.

The values that appear in this field are:
v Yes (Launch descriptor file has been registered.)
v No (Launch descriptor file has not been registered.)

Adding element managers using CIMOM discovery
Use the CIM object manager (CIMOM) discovery process in IBM Tivoli Storage
Productivity Center to add element managers that are managing the same storage
subsystems as CIMOMs in your environment. The element managers discovered
through the CIMOM discovery process are automatically added to the Element
Manager tab in the Configuration Utility.

Use this method when you want to add multiple element managers to Tivoli
Storage Productivity Center simultaneously. For example, use these steps when:
v You want to run a discovery against multiple CIMOMs and each of those

CIMOMs has a registered storage system.
v You have more than one registered storage system per CIMOM.

This method does not apply to storage systems that use native interfaces:
v System Storage DS8000
v SAN Volume Controller
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v The XIV system
v Storwize V7000
v Storwize V7000 Unified
v IBM SONAS

This procedure does not physically add the CIMOM to your environment, but
provides Tivoli Storage Productivity Center with the information it requires to
communicate with that CIMOM.

To add an element manager using CIMOM discovery in Tivoli Storage Productivity
Center, complete the following steps:
1. Expand Administrative Services > Data Sources > CIMOM Agents in the

navigation tree.
2. In the right-side pane, click Add CIMOM. The Add CIMOM dialog box is

displayed.
3. Define the information that is required to add the CIMOM using the following

fields. Required fields are specified in bold in the dialog box. In the following
field descriptions, required fields are marked by an asterisk.

*Host Enter the IP address of the computer on which the CIMOM is installed.
You can enter an IPv4 or IPv6 address depending on what is supported
on the computer where the CIMOM is located:
v Enter an IPv4 address in the following format: ###.###.###.###. For

example: 192.168.1.65
v Enter an IPv6 address. These addresses are typically written as eight

groups of four hexadecimal digits, but might vary from site to site.
For example: 2001:DB8::/32:1812:5b9e:3391:3156. You can use IPv6
addresses if the computer where Tivoli Storage Productivity Center is
installed is IPv6 or dual stack (IPv4 and IPv6) enabled.

Note: If the computer on which the CIMOM is located is IPv6-only, the
Tivoli Storage Productivity Center servers must be installed on an
IPv6-only or dual stack (IPv4 and IPv6 enabled) computer.

Port Enter the port through which Tivoli Storage Productivity Center
contacts the CIMOM. You can modify the default port number if
required for your environment.

Username
If required by the CIMOM, enter the user name that Tivoli Storage
Productivity Center uses to log on to the CIMOM.

Password
Enter the password for the user name that is defined in the Username
field.

*Interoperability Namespace
Enter the interoperability namespace of the CIMOM. This namespace
within the CIMOM allows for accessing the CIM Interop Schema
(including the class instances of the Server Profile) and determines how
Tivoli Storage Productivity Center interacts with the CIMOM when
retrieving information.

Protocol
Select the protocol (http or https) for the CIMOM.
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Truststore Location
Enter the location (path on this computer) of the truststore for the
CIMOM. The truststore is the certificate file for certificate-based
authentication in the https protocol.

Truststore Passphrase
Enter the passphrase of the truststore for the CIMOM.

Display Name
Enter the name for the CIMOM as you want it to be shown in Tivoli
Storage Productivity Center.

Description
Enter a short description for the CIMOM as you want it to be shown in
Tivoli Storage Productivity Center.

Test CIMOM connectivity before adding
Select this check box to ensure that communication to the CIMOM is
working properly before the CIMOM is added. If this box is not
checked, the CIMOM is added without verifying connectivity with the
specified parameters.

Important: Failure to check the CIMOM connection can cause a failure
later if the CIMOM cannot be scanned or probed.

Save Click this button add the CIMOM.
v If you selected Test CIMOM connectivity before adding, Tivoli

Storage Productivity Center attempts to connect to the CIMOM using
the information provided in this dialog box. If the logon information
for a CIMOM is incorrect, an error occurs and an associated error
message dialog box is displayed.

v If you did not select Test CIMOM connectivity before adding, the
CIMOM is associated with the element manager but connectivity
with Tivoli Storage Productivity Center is not verified.

Cancel
Click this button to close the dialog box without adding the CIMOM.

4. Expand Administrative Services > Discovery in the navigation tree.
5. Right-click CIMOM and select Run Now. The CIMOM discovery process adds

the element managers that are managing the same storage system as the
CIMOM. The element managers are displayed on the appropriate element
manager section on the Element Manager tab of the Configuration Utility.
Element managers that are added through CIMOM discovery might exist on a
Hardware Management Console (HMC) other than the HMC where the
CIMOM is located.

Modifying other element managers
Use the Configuration Utility to modify information for element managers in IBM
Tivoli Storage Productivity Center.

To modify an element manager other than an IBM System Storage DS8000 element
manager in Tivoli Storage Productivity Center, follow these steps:
1. Click Element Management in the toolbar, or expand the IBM Tivoli Storage

Productivity Center node in the navigation tree, click Configuration Utility,
and open the Element Manager tab.

2. In the Other Device Element Manager section, select the element manager that
you want to modify from the element manager table.
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3. Select Modify Element Manager from the Select Action list. The Modify
Element Manager dialog box is displayed.

4. Modify any of the following fields:

Username
Enter the user name that Tivoli Storage Productivity Center will use to
log on to the element manager.

Password
Enter the password associated with the user name that is defined in the
Username field.

Password Confirm
Enter the same password that you entered in the Password field.

Display Name
Enter a display name for the element manager. The display name is
shown in the Element Manager field in the element manager table. If
this field is blank, the IP address of the computer on which the element
manager is located is shown in the Element Manager field of the table.
The display name is used in Tivoli Storage Productivity Center and
does not affect the element manager itself.

Save Click this button to modify the element manager information. Tivoli
Storage Productivity Center tests the connection to the element
manager. If the connection is successful, the element manager
information is saved. If the connection is unsuccessful, an error
message appears indicating that the element manager at the specified
IP address could not be added.

Cancel
Click this button to close the dialog box without modifying the element
manager information

Starting other element managers
Use the Configuration Utility to start element managers from IBM Tivoli Storage
Productivity Center. You can also start element managers from other points in
Tivoli Storage Productivity Center.

To start element managers other than IBM System Storage DS8000 element
managers from the Configuration Utility follow these steps:
1. Click Element Management in the toolbar, or expand the IBM Tivoli Storage

Productivity Center node in the navigation tree, click Configuration Utility,
and open the Element Manager tab.

2. In the Other Device Element Manager section, click the element manager that
you want to start from the element manager table.

3. Use one of the following methods to start the element manager:
v To start the default element manager for a storage system, select Launch

Default Element Manager from the Select Action list.
v To start another element manager for a storage system, right-click the

element manager that you want to start and click Launch Element Manager.
Select the element manager that you want to start from the menu.

If the connection information for an element manager is valid, the element
manager is started. If unsuccessful, an error message is displayed. The error
message that you receive describes one of the following problems:
v that the element manager at the specified IP address could not be started
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v that the required connection information for the element manager has not been
provided

v that the element manager is not installed and configured correctly (for local
element manager installations such as XIV Storage Manager)

If you are prompted to enter additional information such as an ID and password
for the element manager, complete the following steps:
1. Click OK in the message dialog box. The Modify Element Manager dialog box

is displayed.
2. Enter the required information for the element manager and click Save.

Testing the connection to other element managers
Use the Configuration Utility to test the connection to element managers from IBM
Tivoli Storage Productivity Center.

To test the connection to an element manager other than an IBM System Storage
DS8000 element manager from Tivoli Storage Productivity Center, follow these
steps:
1. Click Element Management in the toolbar, or expand the IBM Tivoli Storage

Productivity Center node in the navigation tree, click Configuration Utility,
and open the Element Manager tab.

2. In the Other Device Element Manager section, select the element manager for
which you want to test the connection from the element manager table.

3. Select Test Element Manager Connection from the Select Action list. IBM
Tivoli Storage Productivity Center tests the status of the element manager
connection. A message dialog box that states whether the test passed or failed
is displayed.

Adding user-defined element managers for other storage
systems

A user-defined element manager is an element manager other than the manager that
is provided with the storage system. Use the Configuration Utility to add
user-defined element managers in IBM Tivoli Storage Productivity Center.

User-defined element managers are not displayed in the Other Device Element
Manager table. These element managers are displayed in the various launch
menus that are provided in IBM Tivoli Storage Productivity Center.

To add user-defined element managers for a storage device other than DS8000 in
Tivoli Storage Productivity Center, follow these steps:
1. Click Element Management in the toolbar, or expand the IBM Tivoli Storage

Productivity Center node in the navigation tree, click Configuration Utility,
and open the Element Manager tab.

2. In the Other Device Element Manager section, select the select the row in the
element manager table that contains the storage system to which you want to
add a user-defined element manager.

3. Select Add User Defined Element Manager from the Select Action list. The
Add User Defined Element Manager dialog box is displayed.

4. Enter a Uniform Resource Locator (URL) or command to start the element
manager, and click Save.
To exit without adding a element manager, click Cancel.
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Removing user-defined element managers for other storage
systems

Use the Configuration Utility to remove user-defined element managers for storage
systems in IBM Tivoli Storage Productivity Center.

To remove a user-defined element managers for a storage device other than
DS8000 in Tivoli Storage Productivity Center, follow these steps:
1. Click Element Management in the toolbar, or expand the IBM Tivoli Storage

Productivity Center node in the navigation tree, click Configuration Utility,
and open the Element Manager tab.

2. In the Other Device Element Manager section, select the row in the element
manager table that contains the storage system from which you want to remove
a user-defined element manager.

3. Select Remove Element Manager from the Select Action list. The Remove
Element Manager dialog box opens.

4. Select the element manager that you want to remove from the list and click
OK. The element manager is removed. When you remove an element manager,
it is removed only from the list of element managers that are visible to Tivoli
Storage Productivity Center.
To exit the window without removing the element manager, click Cancel.

Launch and launch in context
The launch and launch in context features are used to start IBM Tivoli Storage
Productivity Center and to start other applications from Tivoli Storage Productivity
Center. The terms inbound and outbound are used to differentiate starting Tivoli
Storage Productivity Center (inbound) and starting another application from Tivoli
Storage Productivity Center (outbound).

Inbound launch in context refers to starting Tivoli Storage Productivity Center at a
specific point in the graphical user interface (GUI). You can use inbound launch in
context in either of the following ways:
v Configure an application such as Tivoli Enterprise Portal to start Tivoli Storage

Productivity Center at functionally related locations in the Tivoli Storage
Productivity Center GUI.

v Start Tivoli Storage Productivity Center from Java Web Start, the command line,
or the Windows Start menu using parameters to specify the starting location in
the Tivoli Storage Productivity Center GUI.

Outbound launch in context refers to starting other applications, such as
administrative applications for storage systems and switches, from functionally
related points in the Tivoli Storage Productivity Center GUI.

Launch refers to starting an application at the starting point for that application.
Launch primarily refers to starting applications from the Tivoli Storage
Productivity Center GUI. Starting applications from Tivoli Storage Productivity
Center is referred to as an outbound launch.
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Related concepts:
“Inbound launch in context feature” on page 57
With the inbound launch in context feature you can start IBM Tivoli Storage
Productivity Center at a specified point in the graphical user interface (GUI).
“Outbound launch and launch in context features” on page 64
With the outbound launch and launch in context features, you can start the
administrative applications for devices such as storage systems and switches from
various points in the graphical user interface (GUI).

Inbound launch in context feature
With the inbound launch in context feature you can start IBM Tivoli Storage
Productivity Center at a specified point in the graphical user interface (GUI).

Prerequisite: You must have View and Modify permissions to use the launch in
context feature.

You can use the launch in context feature to perform the following tasks in Tivoli
Storage Productivity Center:
v Create a volume or VDisk
v Open the storage area network SAN Planner
v Create a capacity report
v Create a wasted space report

You can run the launch in context feature in the following ways:
v Use Java Web Start from a Web browser. See “Launch with Java Web Start” on

page 57.
v Use the command line on Windows, AIX, Linux, or UNIX to enter the

command and arguments on the command line. See “Launch from the command
line” on page 59.

v Use the Windows Start menu. See “Launch from Start menu” on page 60.
v Use the Tivoli Enterprise Portal GUI to define, edit, and launch commands. See

“Launch from Tivoli Enterprise Portal” on page 61.

The launch in context feature has a number of parameters. See “Launch in context
parameters” on page 1432, “Launch in context task parameters” on page 1434, and
“Available windows” on page 1435.

Launch with Java Web Start
Using Java Web Start, you can use the launch in context feature from a Uniform
Resource Locator (URL).

The launch in context feature requires Java Web Start 6 on the computer that is
running the Web browser. If the correct release of Java Web Start is not present,
you receive an error message when you enter the URL. The message states that
you must download the Java Runtime Environment, which includes Java Web
Start. Follow the link provided in the message to install the required software.

If you are using Internet Protocol Version 6 (IPv6) and are using Java Web Start to
start IBM Tivoli Storage Productivity Center on a Windows system, use a system
host name such as tpc332.storage.newyork.xyz.com:9549 in the Web browser
address field rather than an IPv6 address such as
[2001:DB8:0000:1234:0000:0000:5678:ABCD]:9549.
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To use the launch in context feature to perform a task or display a window on a
remote server from your browser, complete the following steps:
1. Open your browser and type the launch in context command.

URLs cannot include spaces. In the command, a parameter and its value are
separated by an equal sign (=). Parameter=value pairs are separated by an
ampersand (&).
The format of a command to create a volume is:
https://device_server:device_port/ITSRM/jsp/jnlp/
tpcgui.jsp?consoleClass=com.ibm.usmi.console.lic.tpc.LICConsole&-
server=server:port&-function=disk.create_volume&-subsystem_id=ESS-2105-
17844-IBM&-name=myvol&-number=2&-size=10&-unit=MB

The format of a command to view a window on a remote server is:
http://device_server:device_port/ITSRM/jsp/jnlp/
tpcgui.jsp?consoleClass=com.ibm.usmi.console.lic.tpc.LICConsole&-
server=server:port&-function=window_name

Tip: The Data server port value is 9549. The port value for the Device server is
9551 for https and 9550 for http. If the wrong the Device server port value is
used, the return page cannot be interpreted by the browser. If the wrong Data
server port value is used, the following error message is returned.
Unable to connect to the server

2. The first time a window or task is started, you receive a security warning
informing you that the downloaded jar files have been digitally signed using a
certificate from a trusted company. To prevent this message from being
displayed in the future, select Always trust content from this publisher and
click Run. If the Tivoli Storage Productivity Center graphical user interface
(GUI) has not been downloaded on the local computer using Java Web Start, or
the local computer does not have the latest version of the Tivoli Storage
Productivity Center GUI, the GUI is downloaded.

3. If you included the user ID and password in the command, the sign-in dialog
is bypassed, otherwise log on to the Tivoli Storage Productivity Center GUI.
The Tivoli Storage Productivity Center GUI navigates to the tree node
corresponding to the window name that you specified. You are connected using
the user name and password that you entered. Depending on the value you
specified for the -function parameter, the following actions might occur:
v The specified window opens
v For disk.create_volume, depending on the parameters, the Create Volume

wizard or Create VDisk wizard opens.
v For disk.san_planner, the SAN Planner panel opens with the given SAN plan

ID.
v For data.filesystem_capacity_by_computer, the Capacity Report opens.
v For TPC.reports_data_wasted_space, the Wasted Space Report opens.

Restrictions:

v When you open a plan in the SAN Planner using launch in context, you must
enter the exact name of the plan. The value for the -plan_id parameter is
case-sensitive and must match the name of the plan when it was created. For
example, if you created a plan named UserPlan1, you must specify -plan_id
UserPlan1 in the launch in context command.

v There is a known limitation when you launch the Filesystem Capacity > By
Computer report using launch in context, you must specify the ID for the
computer upon which you want to report. For example:
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http://tpcserver14:9550/ITSRM/jsp/jnlp/
tpcgui.jsp?consoleClass=com.ibm.usmi.console.lic.tpc.LICConsole&-
server=tpcserver14.storage.xyz.com:9549&-
function=data.filesystem_capacity_by_computer&-computer_id=tpcserver14

The value you enter for the computer_id parameter might not match the ID for
that computer that is stored in the Tivoli Storage Productivity Center database
repository. You receive a warning message if the ID for the computer that you
enter in the URL does not match the ID that is stored in the data repository. To
ensure that this report is displayed properly when you run from the launch in
context facility, enter an ID for the computer that matches the ID that is
displayed for it through the Topology Viewer or appropriate report in the
product user interface.

Use the information in the following links to enter parameters. If any of the
parameters are spelled incorrectly, an error message indicates the incorrect
parameter.

“Launch in context parameters” on page 1432
You can use the launch in context parameters, definitions, and examples.
“Launch in context task parameters” on page 1434
Use the launch in context feature task parameters to perform tasks.
“Available windows” on page 1435
You can use windows with the inbound launch in context feature to start IBM
Tivoli Storage Productivity Center. These windows are called with the
-function window name argument.

Launch from the command line
This topic describes how to start windows and tasks from the Windows AIX,
Linux, or UNIX command line.

The bat file tpc.bat is used for Windows operating systems. The .sh file TPCD.sh is
used for AIX, Linux, or UNIX systems. The parameters follow the file name.
Parameters are separated by spaces. Parameters are optional and can appear in any
order. See “Launch in context parameters” on page 1432, “Launch in context task
parameters” on page 1434, and “Available windows” on page 1435 for the
parameters.

Frequently used commands can be saved as unique command files and rerun as
needed.
1. In the Command Prompt window, type the command for the action that you

want to take, and press Enter.
The action occurs on the remote Data server. The graphical user interface (GUI)
window for that action opens on the local computer.

2. Enter parameters if you previously did not enter any parameters. If you do not
provide a user name, password, or server name, the IBM Tivoli Storage
Productivity Center GUI opens the connection dialog box. If you do not
provide these values, the GUI presents an error message box and requests the
values. If you specify incorrect parameters, you receive an error message.

The following example launches a task from the Windows command line:

tpc.bat -user admin -passwd password1 -server
tivolii122.storage.usca.ibm.com:9549 -function
data.filesystem_capacity_by_computer -computer_id <computerID>
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The following example uses the launch in context feature to view a window on the
remote machine:

tpc.bat -user admin -passwd password1 -server
tivolii122.storage.usca.ibm.com:9549 -function disk.storage_subsystem

Restrictions:

v When you open a plan in the SAN Planner using the command line or a Web
browser for launch in context, you must enter the exact name of the plan. The
value for -plan_id in the command line is case-sensitive and must match the
name of the plan when it was created. For example, if you created a plan named
UserPlan1, you might enter the following command on the command line:
./TPCD.sh -user administrator -passwd passw0rd -server
tpcserver14.storage.xyz.com:9549 -function disk.san_Planner -plan_id
UserPlan1

v There is a known limitation when you start the Filesystem Capacity > By
Computer report using launch in context. To start this report, you must specify
the ID for the computer upon which you want to report. For example:
./TPCD.sh -user root -passwd "passw0rd" -server
tpcserver14.storage.xyz.com:9549 -function
data.filesystem_capacity_by_computer -computer_id tpcserver14

The value you enter for "computer_id" might not match the ID for that computer
that is stored in the Tivoli Storage Productivity Center database repository. You
will receive a warning message if the ID for the computer you enter in the
command line does not match the ID stored in the data repository. To ensure
that this report is displayed properly when run from the launch in context
command line or through Java Web Start, make sure to enter an ID for the
computer that matches the ID that is displayed for it through the Topology
Viewer or appropriate report in the product's user interface.

Launch from Start menu
This topic describes how to start windows and actions from the Windows Start
menu.

The bat file, tpc.bat, is used for Windows operating systems. The parameters
follow the bat file name. Parameters are optional and can appear in any order. To
use the launch in context feature from the Windows Start menu, complete the
following steps:
1. Click Start > Programs > IBM Tivoli Storage Productivity Center, right-click

Productivity Center and select Properties. The Productivity Center Properties
window opens.

2. Enter the command-line arguments in the Target text field and click Enter.
If the Data server is remote, the action occurs on the Data server and the
graphical user interface (GUI) window the action opens is on the local
computer.

3. Enter the parameters if you did not previously enter the necessary parameters.
If you do not provide the user name, password, or server name, the Tivoli
Storage Productivity Center GUI opens the connection dialog box. If you do not
provide these values, the GUI presents an error message box and requests the
values.

The following example starts a task from the Windows Start menu:
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"C:\Program Files\IBM\TPC\gui\tpc.bat" -user admin -passwd password1
-server tivolii122.storage.usca.ibm.com:9549 -function
data.filesystem_capacity_by_computer -computer_id computerID

The following example uses the Windows Start menu to view a window on the
remote server:

"C:\Program Files\IBM\TPC\gui\tpc.bat" -user admin -passwd password1
-server tivolii122.storage.usca.ibm.com:9549 -function
disk.storage_subsystem

For more information see:

“Launch in context parameters” on page 1432
You can use the launch in context parameters, definitions, and examples.
“Launch in context task parameters” on page 1434
Use the launch in context feature task parameters to perform tasks.
“Available windows” on page 1435
You can use windows with the inbound launch in context feature to start IBM
Tivoli Storage Productivity Center. These windows are called with the
-function window name argument.

Launch from Tivoli Enterprise Portal
This topic shows you how to start an existing launch definition from the Tivoli
Enterprise Portal graphical user interface (GUI).

You must configure Tivoli Enterprise Portal before you can use the launch in
context feature. For information on prerequisites and details on how to configure
the launch in context feature with Tivoli Enterprise Portal, see “Configuring Tivoli
Enterprise Portal” on page 62. After Tivoli Enterprise Portal has been configured,
you can start the application from the configuration window or use Launch from
the Tivoli Enterprise Portal navigation tree.

If you use the Tivoli Enterprise Portal navigation tree, Launch will open the Tivoli
Enterprise Portal graphical user interface with your predefined launch in context
commands. To use one of these commands, complete the following steps:
1. In the Tivoli Enterprise Portal window, expand Enterprise > Windows Systems

your_server_name > Windows OS. Right-click Disk and select Launch. Disk is
one of several values you can select. Values include Disk, Network, Enterprise
Services, Memory, Printer, Process, Processor, and System.

2. The Create or Edit Launch Definitions window opens showing a list of defined
launch definitions in the Existing Launch Definitions area.

3. Select the launch definition you want to use from the list and click Launch. The
window or task that is defined by that launch definition opens.

For information on editing the launch in context command with the Tivoli
Enterprise Portal GUI, see:
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Related tasks:
“Editing launch definitions” on page 63
You can edit an existing launch definition with the Tivoli Enterprise Portal
graphical user interface (GUI).

Configuring Tivoli Enterprise Portal:

You can configure Tivoli Enterprise Portal so that you can use the launch in
context feature.

To configure Tivoli Enterprise Portal complete the following steps:
1. The initial steps depend on whether you are going to open a window or

perform a task.
a. If you are opening a window, in the Tivoli Enterprise Portal navigation

window on the local computer, select where you want the launch
definition to originate from. This opens the corresponding view on the
target computer. Right-click one of the following locations.
v The navigator item
v A row in a table or situation event console view
v A slice of a pie chart
v A bar of a bar chart
If the launch definition originates from a table, chart, or situation event
console view, open the workspace containing the view. If you think you
might edit the argument later, create the launch definition from a table or
chart view.

b. If you are going to perform a task, create a launch definition for one of the
following tasks:
v Create a volume or VDisk
v Open the SAN Planner
v Create a capacity report
v Create a wasted space report

2. In the Tivoli Enterprise Portal window, expand Enterprise > Windows
Systems > your_server_name > Windows OS. Right-click Disk and select
Launch. Disk is one of several values you can select. Values include Disk,
Network, Enterprise Services, Memory, Printer, Process, Processor, and System.

3. The Create or Edit Launch Definitions window opens. Click Create New.
4. In the Name text field, type a descriptive name for this launch definition. This

name is used in the definition list.
5. In the Target text box click Browse to locate the tpc.bat file. The Select files

for directories for Launch Definitions window opens. A typical location for
Windows systems is C:\Program Files\IBM\TPC\gui\tpc.bat. Select the correct
directory and click OK.
When you start a launch definition from the command line, if any part of the
path contains spaces, enclose the entire entry in quotation marks.

6. In the Arguments text field, enter any parameters that will be added when
the application is started. Arguments are entered as -parameter value. In the
Create or Edit Launch Definitions window, click Browse next to Arguments to
locate the parameters that you want to use. The Select Browser Options
window opens. Click Substitutable Items and then click OK. Select
parameters from the Selected Context and Extended Context lists.
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The help argument lists the available function values. You must type the help
parameter by itself into the Arguments text field or into the form tpc.bat
-help functions on the command line for Windows or TPCD.sh -help
functions for UNIX. The -help functions parameter provides a window that
lists the nodes in the navigation tree that are available to start. If you type
-help without the functions parameter, it results in an error message.
When all parameters have been selected, click OK to return to the Create or
Edit Launch Definitions window.

7. If the parameters can be changed at launch time (for example, you want to
change the system ID), check the Edit arguments before execution box.

8. Specify a value for the Start in location. Click Browse to locate the IBM Tivoli
Storage Productivity Center installation and select the folder gui where
tpc.bat is located.

9. Click Evaluate to see how the command resolves when the application starts.
Correct any of the parameters that are incorrect and reevaluate the command.

10. When you are satisfied with the launch definition, click Apply to save your
changes. This keeps the window open so that you can start the current launch
definition or create a new one. Click OK to save the launch definition and
close the window.

11. To start the current definition, select Launch. The Tivoli Storage Productivity
Center graphical user interface (GUI) with the function parameter that you
have provided is opened.

Related reference:
“Launch in context parameters” on page 1432
You can use the launch in context parameters, definitions, and examples.
“Launch in context task parameters” on page 1434
Use the launch in context feature task parameters to perform tasks.
“Available windows” on page 1435
You can use windows with the inbound launch in context feature to start IBM
Tivoli Storage Productivity Center. These windows are called with the -function
window name argument.

Editing launch definitions:

You can edit an existing launch definition with the Tivoli Enterprise Portal
graphical user interface (GUI).

If the Edit arguments before execution box was checked when a launch definition
was configured, you can edit the launch definition by changing the attribute
values. To edit a launch definition, complete the following steps:
1. In the Tivoli Enterprise Portal window, expand Enterprise > Windows Systems

> your_server_name > Windows OS. Right-click Disk and select Launch. Disk
is one of several nodes you can select. Nodes include Disk, Network, Enterprise
Services, Memory, Printer, Process, Processor, and System.

2. The Create or Edit Launch Definitions window opens showing a list of launch
definitions in the Existing Launch Definitions area.

3. Select the launch definition that you want to edit. The values are displayed.
4. Make the necessary changes in the text fields.
5. Click Evaluate to see how the arguments will resolve when the application

starts. Correct any incorrect arguments and re-evaluate the command.
6. Click Apply to save the changes and keep the window open. Click OK to save

the launch definition and close the window.
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If you do not want to overwrite the existing launch definition, save the new
launch definition with a unique name.

Outbound launch and launch in context features
With the outbound launch and launch in context features, you can start the
administrative applications for devices such as storage systems and switches from
various points in the graphical user interface (GUI).

There are two options for starting an application from Tivoli Storage Productivity
Center. The option that is available depends on the device that you want to start.

The launch feature starts an application at the starting point for that application.

The launch in context feature starts an application at a functionally related location
in that application. Launch in context is available for the following applications:
v Tivoli Storage Productivity Center for Replication
v SAN Volume Controller 6.1 or later
v Storwize V7000
v Storwize V7000 Unified
v IBM SONAS

Launch menu

When you right-click one of the following entities in Tivoli Storage Productivity
Center GUI, you see a launch menu for that entity. The content of the launch menu
varies as described in “Launch menu items” on page 65.
v Alert Log Viewer. Each row of the alert log is enabled for a launch in context

menu. The context is determined by the type of the alert. Alert types include:
– Replication
– Storage Subsystem
– Computer
– Fabric
– Switch
– Port
– Tape Library

v Disk Manager Storage Subsystems table
v Fabric Manager Fabrics table
v Tape Manager Tape Libraries table
v Element Manager page (of the Configuration Utility)
v Topology Viewer objects. To see the icons that are associated with each Topology

Viewer object, refer to the following list.

Topology Viewer objects

Topology Object Icon

Fabric
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Topology Object Icon

Switch

Switch port

Tape library

Storage subsystem

Storage subsystem port

File system volume

Storage disk

Storage pool

Launch menu items

The following are the possible menu items that can be displayed in the launch
menu:

Launch in context defined application
This menu item is displayed for each application that is defined by a
launch descriptor file. Tivoli Storage Productivity Center provides launch
descriptor files for the following applications:
v DS8000 Storage Manager
v The management console for the storage systems that are listed under

Management GUI.
v Tivoli Storage Productivity Center for Replication

If the corresponding launch descriptor files are found for the applications,
the following menu items are displayed:

DS8000 Storage Manager
Click this menu item to start DS8000 Storage Manager.

Management GUI
Click this menu item to start the management console for the
following storage systems:
v SAN Volume Controller 6.1 or later
v Storwize V7000
v Storwize V7000 Unified
v IBM SONAS
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Replication Storage Systems Overview
Click this menu item to start Tivoli Storage Productivity Center for
Replication. The window that is opened in the Tivoli Storage
Productivity Center for Replication GUI depends on the context for
the entity that you selected. For example, if you right-click a
storage device on the Element Manager tab of the Configuration
Utility and click Replication Storage Systems Overview, the Tivoli
Storage Productivity Center for Replication Storage Systems
window opens.

If the launch descriptor file cannot be found, the Launch file items error
menu item is displayed. Click this item to view a description of the
problem. The Launch file items error menu item is also displayed in
situations such as the IBM Tivoli Integrated Portal server is not installed or
is not accessible, the Tivoli Storage Productivity Center Data server is not
accessible, or another system error occurred.

External Tools
This menu item shows any external tools that are defined in the
Configuration Utility. Examples of external tools include web-based user
interfaces and local executable files. For example, you might add the
address of a website that you frequently access or an application that you
often use such as a text editor or a spreadsheet.

Element Manager
This menu item shows any element managers that were discovered for the
device by a Storage Management Initiative Specification (SMI-S) query. To
avoid menu item duplication, this item is not displayed when the
associated element manager is defined by a launch descriptor file. In this
situation, the element manager is displayed as a separate menu item.

User Defined Tools
This menu item shows any user-defined element managers that are defined
in the Configuration Utility. These element managers differ from the
element managers in the Element Manager menu because they are
user-defined and are not discovered by an SMI-S query.

Example launch menu

The following figure shows an example launch menu for a storage system in the
L0:Storage topology view. In this example, the menu items Replication Storage
Systems Overview, DS8000 Storage Manager, and External Tools are displayed.
The Element Manager menu item is not displayed because no element managers
other than DS8000 Storage Manager were discovered. The User Defined Tools
menu item is not displayed because there are no user-defined element managers
that are defined in the Configuration Utility.
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Using the single sign-on feature with launch or launch in context

Single sign-on is an authentication process in which you can access more than one
system or application by entering a single user ID and password. Single sign-on
enables you to start applications from Tivoli Storage Productivity Center without
providing logon credentials for the application. Single sign-on is available only for
Tivoli Storage Productivity Center for Replication, DS8000, SAN Volume Controller
6.1 and later, and Storwize V7000.

For Tivoli Storage Productivity Center for Replication Storage Manager, single
sign-on is enabled by default. For DS8000 Storage Manager, SAN Volume
Controller, and Storwize V7000, single sign-on must be enabled.

To enable single sign-on, see the following topics in the Tivoli Storage Productivity
Center information center:
v Configuring Tivoli Storage Productivity Center for DS8000 LDAP authentication
v Configuring Tivoli Storage Productivity Center for SAN Volume Controller and

Storwize V7000 single sign-on
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Related concepts:
“Single sign-on” on page 53
Single sign-on is an authentication process that enables you to enter one user ID
and password to access multiple applications. For example, you can access IBM
Tivoli Integrated Portal and then access IBM Tivoli Storage Productivity Center and
IBM Tivoli Storage Productivity Center for Replication from Tivoli Integrated
Portal using a single user ID and password. Single sign-on integrates with the
launch and launch in context features to enable you to move smoothly from one
application to another application.

External tools
External tools include Web-based user interfaces and local executable files, scripts,
and batch files that you want to access from IBM Tivoli Storage Productivity
Center. For example, you might define the address of a Web site that you
frequently access or an application that you often use (a text editor, a spreadsheet
application, and so on) as an external tool. External tools such as executable files,
scripts, and batch files must exist on the same system as the Tivoli Storage
Productivity Center graphical user interface (GUI).

Both element managers and external tools are configured on the Element Manager
tab of the Configuration Utility (IBM Tivoli Storage Productivity Center >
Configuration). The following tasks can be performed for external tools in the
External Tools section of the Element Manager tab. The tasks that you can
perform depend on your Tivoli Storage Productivity Center authorization
v Add external tools (Administrator)
v Start external tools (all authorization levels)
v View external tools (all authorization levels)
v Edit external tools (Administrator)
v Remove external tools (Administrator)

Adding external tools
Use the Configuration Utility to add external tools to IBM Tivoli Storage
Productivity Center.

Possibilities for external tools include:
v Executable files, shell scripts, or batch files. These files must exist on the same

system as the Tivoli Storage Productivity Center graphical user interface (GUI).
v Uniform Resource Locators (URLs) for search engines or web encyclopedias

To add an external tool in Tivoli Storage Productivity Center, follow these steps:
1. Expand the IBM Tivoli Storage Productivity Center node in the navigation

tree, click Configuration Utility, and open the Element Manager page.
2. In the External Tools section, select Add Tool from the Select Action list. The

Add External Tool dialog box is displayed.
3. Define the information that is required to connect to the element manager in

the following fields. Required fields are specified in bold in the dialog box. In
the following field descriptions, required fields are marked by an asterisk.

4. The Add External Tool window opens. Enter definitions in the following fields:

*URL/Command
Enter the URL or shell command representing the external tool. You can
enter an IPv4 or IPv6 address depending on what is supported on the
machine where the external tool is located:
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v Enter an IPv4 address in the following format: ###.###.###.###. For
example: 127.0.0.1

v Enter an IPv6 address. The preferred IPv6 address representation is
written as eight groups of four hexadecimal digits:
xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx, where each x is a
hexadecimal digit representing 4 bits. For example:
2001:DB8:0000:1234:0000:0000:5678:ABCD. You can also specify IPv6
addresses using shortened formats that omit leading zeros
(2001:DB8:0:1234:0:0:5678:ABCD) or use double colons
(2001:DB8:0000:1234::5678:ABCD) in place of a series of zeros.
You must include brackets [] around IPv6 addresses to separate those
addresses from their port numbers. For example:
[2001:DB8::1234:0000:0000:5678:ABCD]:9550.

Note: If the computer on which the element manager is located is
IPv6-only, the Tivoli Storage Productivity Center servers must be
installed on an IPv6-only or dual stack (IPv4 and IPv6 addresses are
configured) computer.

Label Enter the name of the tool. The label name is shown in the Name field
in the external tools table. If this field is blank, the Name field is blank.

Description
Enter a short description for the external tool.

Save Click this button to save the external tool. Information about the
external tool is stored in the tools.xml file. This file is stored in the
following locations:
v Windows: \Documents and Settings\Administrator\Application

Data\IBM\TPC\config\

v UNIX and Linux: .TPC/config/

Cancel
Click this button to close the dialog box without saving the external
tool.

Modifying external tools
Use the Configuration Utility to modify information for external tools in IBM
Tivoli Storage Productivity Center.

To modify an external tool in Tivoli Storage Productivity Center, follow these steps:
1. Expand the IBM Tivoli Storage Productivity Center node in the navigation

tree, click Configuration Utility, and open the Element Manager tab.
2. In the External Tools section, select the tool that you want to modify from the

external tools table.
3. Select Modify Tool from the Select Action list. The Modify External Tool

dialog box is displayed.
4. Modify any of the following fields:

URL/Command
Enter the URL or shell command representing the external tool. You can
enter an IPv4 or IPv6 address depending on what is supported on the
machine where the external tool is located:
v Enter an IPv4 address in the following format: ###.###.###.###. For

example: 127.0.0.1
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v Enter an IPv6 address. The preferred IPv6 address representation is
written as eight groups of four hexadecimal digits:
xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx, where each x is a
hexadecimal digit representing 4 bits. For example:
2001:DB8:0000:1234:0000:0000:5678:ABCD. You can also specify IPv6
addresses using shortened formats that omit leading zeros
(2001:DB8:0:1234:0:0:5678:ABCD) or use double colons
(2001:DB8:0000:1234::5678:ABCD) in place of a series of zeros.
You must include brackets [] around IPv6 addresses to separate those
addresses from their port numbers. For example:
[2001:DB8::1234:0000:0000:5678:ABCD]:9550.

Note: If the computer on which the element manager is located is
IPv6-only, the Tivoli Storage Productivity Center servers must be
installed on an IPv6-only or dual stack (IPv4 and IPv6 addresses are
configured) computer.

Label Enter the name of the tool. The label name is shown in the Name field
in the external tools table. If this field is blank, the Name field is blank.

Description
Enter a short description for the external tool.

Save Click this button to save the external tool.

Cancel
Click this button to close the dialog box without saving the external
tool.

Starting external tools
Use the Configuration Utility to start external tools from IBM Tivoli Storage
Productivity Center.

To start an external tool from Tivoli Storage Productivity Center, follow these steps:
1. Expand the IBM Tivoli Storage Productivity Center node in the navigation

tree, click Configuration Utility, and open the Element Manager tab.
2. In the External Tools section, select the tool that you want to start from the

external tools table.
3. Select Launch Tool from the Select Action list. The URL or command defined

for the tool is run immediately.

Removing external tools
Use the Configuration Utility to remove external tools from IBM Tivoli Storage
Productivity Center.

To remove an external tool from Tivoli Storage Productivity Center, follow these
steps:
1. Expand the IBM Tivoli Storage Productivity Center node in the navigation

tree, click Configuration Utility, and open the Element Manager tab.
2. In the External Tools section, select the tool that you want to remove from the

external tools table.
3. Select Remove Tool from the Select Action list. The Remove External Tool

dialog box is displayed.
4. Click OK. The element manager is deleted from the external tools table.

To exit the window without removing the external tool, click Cancel.
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Note: If the computer on which the element manager is located is IPv6-only,
the Tivoli Storage Productivity Center servers must be installed on an IPv6-only
or dual stack (IPv4 and IPv6 addresses are configured) computer.

Working with invoices
With IBM Tivoli Storage Productivity Center you can develop invoice definitions
and create invoices associated with data or resource usage.

Using Tivoli Storage Productivity Center you can:
v Charge users for the amount of storage they are consuming across a network and

within relational database management system (RDBS) instances
v Charge users for the amount of space they own within the database and

tablespace of RDBMS instances.

With Tivoli Storage Productivity Center you can collect usage information on a
departmental, group, or user level. You can allocate costs by storage usage by user,
disk capacity by computer, tablespace, or file system or physical device. You can
create cost centers by creating user, computer, or tablespace groups, allowing
organizations to chargeback individuals or business units for their storage usage.
By understanding the costs associated with existing and future storage usage, you
can improve the use of that storage and reduce the costs associated with its
maintenances and upgrades.

Tivoli Storage Productivity Center uses the storage usage information gathered by
probes and scans to generate invoices that chargeback for storage usage.
Chargeback is the process of breaking down costs associated with data or resource
usage and then distributing those costs back to the organizational consumers.

To collect the information needed for chargeback, you need to run probes and
scans:

Probes
Define probes when you want to charge by Disk Capacity. Probes collect
statistics on the storage assets in your enterprise, such as computers, disk
controllers, hard disks, file systems, storage subsystems, instances, logs,
RDBMS objects, and so on. The results of probes are stored in the database
repository and are used to supply the data necessary for Tivoli Storage
Productivity Center's reporting function.

Scans Define scans when you want to charge by OS User groups. Scans collect
statistics on the usage and trending of your actual storage consumption.
The results of scans are stored in the database repository and are used to
supply the data necessary for Tivoli Storage Productivity Center’s Capacity,
Usage, Usage Violations, and Backup Reporting facilities.

In addition to providing basic storage usage invoicing, Tivoli Storage Productivity
Center integrates with the chargeback systems already implemented in your
environment. It provides you with a higher level, application-specific CIMS output
format. CIMS is IBM Tivoli Usage and Accounting Manager (ITUAM) which
provides IT financial knowledge by measuring, analyzing, reporting, and billing
based on usage and costs of shared computing resources. With Tivoli Storage
Productivity Center, you can export chargeback data directly into ITUAM, giving
you the ability to integrate your storage usage data with other enterprise
chargeback information and processes.
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Planning for chargeback
Before generating data that will be used for chargeback, it is a good idea to plan
ahead and gather basic information about your system and organization.

Understand your environment
Understanding the users, data, and resources within your organization will
help you determine the most reasonable and enforceable chargeback
policies. In the planning stages of developing a chargeback policy, it will
help you to understand such things as:
v The types of data stored within your environment
v Patterns of data usage
v Different types of users and user groups
v The IT resources that exist within your organization

Determine the chargeback policy you want to implement
It is important to learn and understand the advantages and disadvantages
of the charge back policy you want to implement. For example, with IBM
Tivoli Storage Productivity Center, you can:
v Divide the cost of storage usage by all users
v Divide the cost of storage usage by individual users or groups of users
v Charge by resource
v Charge by individual usage of resources

Define monitoring groups
Organize the IT resources within your environment into functional groups.
Defining groups enables you to classify your data and resources into
billable entities, which in turn provides the information on who is using
what storage. This enables you to bill specific groups according to their
usage of storage space. See “Creating a group” on page 373.

Computer groups
Computer groups collect operating system and RDBMS storage
statistics on computers that are related to each other or belong to a
common group such as a department, a location, a territory, and so
forth. Examples of computer groups are Sales, Accounting,
Development, IT.

A computer can belong to one computer group only.

User groups
User groups are users that are related to each other or belong to a
common group such as a department, a location, a territory, and so
forth. Examples of user groups are Administrators, Developers,
Marketing staff, HR staff.

A user can belong to one user group only.

OS User groups
OS user groups are users that are grouped together within the
operating system.

Database-tablespace groups
Database-tablespace groups monitor entire databases or tablespaces
across multiple instances or databases. Examples of tablespace
groups are System Tablespaces, System Databases,
databases-tablespaces related to a specific application or
applications, and so forth.
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A database-tablespace can belong to one database-tablespace group
only.

Determine what information you want to gather
Determining what information you want to gather about the storage
resources within your enterprise is critical to helping you implement a
chargeback strategy. Probes and scans are the monitoring jobs you can
define to collect information about operating system and RDBMS storage
resources. The information gathered by these jobs is reflected in the data
included within a Tivoli Storage Productivity Center invoice.

As you become more familiar with how a specific charge back model works for
your organization, you can continue to review and implement to more advanced
charge back models.

Setting up invoices
This topic takes you through the task of setting up an invoice.

To set up an invoice, complete the following steps:
1. In the Navigation Tree pane, expand Data Manager for Chargeback >

Parameter Definition. Data Manager for Chargeback - Configuration window
opens.

2. In the Output Format area, specify the format for the output. You can click
either of the following options:

Invoice
Creates a formatted text file suitable for opening in or importing into
word processing applications.

CIMS Creates a text file with comma-separated fields suitable for importing
into a ITUAM application.

3. In the Type of Charges area, specify the information that you want the invoice
to contain. You can select one or more of the following check boxes:

OS Storage Usage By User
The resulting invoice includes the following information:
v Total space consumed by user groups and the cost of that usage
v Total space consumed by each user in the environment and the cost

charged to each user

OS Disk Capacity By Computer
The resulting invoice includes the following information:
v Total space consumed by computer groups and the cost of that usage
v Total space consumed on each computer in the environment and the

cost of that usage

Storage Usage By Database User
The resulting invoice includes the following information:
v Total space consumed by DB user groups and the cost of that usage
v Total space consumed by each DB user in the environment and the

cost charged to each user

Total Size By Database-Tablespace
The resulting invoice includes the following information:
v Total space consumed by database-tablespace groups and the cost of

that usage
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v Total space consumed on each database or tablespace in the
environment and the cost of that usage

4. (Invoice output format only) For each type of charge that you selected in step 3
on page 615, select the unit of measurement (kilobyte, megabyte, or gigabyte)
and type a numerical value. For example, if you want to charge $1.25 per
megabyte of storage usage, select Megabyte and type 1.25 in the Cost per field.
(CIMS output format only) If you select CIMS as the output type, the Cost Per
field will be deselected. This is because you will set the rates and costing
within the ITUAM application.

5. If you selected OS Storage Usage by User or Storage Usage by Database User,
select the profile that is used in the scan job. By default, this is either
TPCUser.Summary By Owner for OS Storage by User or TPCUser.Db User
Space for Storage Usage by Database User.

6. Click to save the invoice definition.

Invoice definitions are not saved in actual files, but the last invoice definition
saved is the one that will be used to create the invoice.

Generating an invoice
Generate an invoice and save it as a file.

To generate an invoice, complete the following steps:
1. In the Navigation Tree pane, expand the Data Manager for Chargeback node.
2. Click Online Execution. The Online Execution page opens.
3. Click the Browse button. The Open window opens, listing previously generated

invoice files in the default directory. The default directory, or the directory
where you have chosen to save the invoice files, is not part of the IBM Tivoli
Storage Productivity Center application but on the computer where Tivoli
Storage Productivity Center is installed.
a. Click on an existing file or type a new file name, including extension, in the

File name text field. A text file (.txt) is the default file type for both output
types.

Note: Unless you save the invoice as a separate file name, the default file
(StorageChargeback.txt) will be overwritten each time you run an invoice. It
is recommended that you save your invoices as a separate file name each
time you run them.

b. Click the Open button. You will be returned to the Online Execution page.
Alternatively, in the Online Execution page, without clicking the Browse
button, type the full path name of the invoice file to be generated in the
Output File text field.

4. Click the Generate Output File button to generate the invoice.

The invoice is saved to the file name and path you specified.

Viewing and printing invoices
This topic discusses viewing or printing a generated invoice in both Invoice and
CIMS output formats.
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If you have generated the invoice in the Invoice output format, you can view and
print that invoice with any text editor or word processing program. If you chose
CIMS as the output format, use your ITUAM application to work with the invoice
data.

To view and print an invoice generated in the Invoice output format, complete the
following steps:
1. Start the text editor or word processing program.
2. Follow the steps in the word processing program to open the invoice. Open the

invoice from the location you specified in the Output File field in the Online
Execution page.

3. View the file and make any changes. If you make any changes to the file, be
sure and save it under a different name.

4. Print the file from the word processing program.

To view and print an invoice generated in the CIMS output format, integrate IBM
Tivoli Storage Productivity Center accounting data into the Tivoli Usage and
Accounting Manager, by following the instructions in the Tivoli Usage and
Accounting Manager Information Center. Alternatively, you can view the original
invoice data in a text editor or word processing program. Remember that the data
will be in the form of comma-separated fields.

Sample Invoices
This section gives examples of sample invoices.

OS Storage Usage By User
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OS Disk Capacity By Computer

Figure 50. Sample Invoice — OS Storage Usage By User

618 IBM Tivoli Storage Productivity Center: User's Guide



Storage Usage By Database User

Figure 51. Sample Invoice — OS Disk Capacity by Computer
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Total Size By Database -Tablespace

Figure 52. Sample Invoice — Storage Usage by Database User
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Figure 53. Sample Invoice — Total Size by Database-Tablespace
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Chapter 6. Managing resources in the web-based GUI

You can use the web-based GUI to monitor the condition, capacity, and
relationships of the monitored resources within your storage environment.

Tivoli Storage Productivity Center also provides a stand-alone GUI for managing
the storage infrastructure in an enterprise environment. Each GUI provides
different functions for working with monitored resources. To view a comparison of
the functions that are available in each GUI, see “Available functions and report
information in the interfaces” on page 19.

Use the web-based GUI to complete the following storage-management tasks:
v View and acknowledge the status of resources that are monitored by Tivoli

Storage Productivity Center. Resources include storage systems, servers,
hypervisors, fabrics, and switches. Use this information to quickly determine the
state of your storage environment.

v View summary and detailed information about resources, including properties,
storage usage, storage capacity, and several key performance metrics. Use this
information to monitor the storage on your hardware. For example, when
migrating large amounts of data, you can identify the target resources that have
enough storage capacity to accommodate the data and require the least amount
of reconfiguration.

v View the relationships and storage mapping among resources. For example, you
can view the resources such as servers and hypervisors to which volumes from a
storage system are assigned.

v Identify potential problems and troubleshoot existing problems in a storage
environment. For example, you can locate the internal resources of a storage
system that might be causing a bottleneck in storage utilization.

v In the reporting, web-based interface, use a drag-and-drop approach to design
custom reports that contain detailed information about the properties and
performance of monitored resources. All the performance metrics from the
stand-alone GUI are available in the reporting interface. For example, you can
drag key metrics into a report to create and generate a performance chart for a
specific volume of a storage system. The reporting interface also includes a set of
predefined reports that provides quick access to preformatted data about
resources.
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Related concepts:
“Starting Tivoli Storage Productivity Center” on page 175
IBM Tivoli Storage Productivity Center provides two graphical user interface (GUI)
applications for managing and monitoring the resources in a storage environment:
a stand-alone GUI and a stand-alone GUI. You can start these GUIs on the Tivoli
Storage Productivity Center server or on a remote system.
Related reference:
Chapter 5, “Managing resources in the stand-alone GUI,” on page 307
You can use the stand-alone GUI to manage and monitor the resources and storage
infrastructure in an enterprise environment. This interface provides all the tools to
manage data, disk, fabric, tape, and replication.
“Available functions and report information in the interfaces” on page 19
IBM Tivoli Storage Productivity Center 5.1 provides two graphical user interfaces
(GUI) for managing the resources in a storage environment: a stand-alone GUI and
a web-based GUI. Each interface provides different functions for working with
monitored resources.

Configuring resources for monitoring
You can use the stand-alone GUI to configure the resources that you want to
monitor in web-based GUI. You must configure before you can collect data,
generate reports, and manage storage that is related to those resources.

The Configure Devices wizard in the stand-alone GUI guides you through the
steps for adding resources as a data source, running a discovery, specifying alerts,
and setting up data collection schedules. After data is collected, you can use the
web-based GUI to monitor the following resources:
v Storage systems
v Servers
v Fabrics
v Switches
v Hypervisors

To configure storage resources for monitoring, complete the following steps:
1. Start the stand-alone GUI for Tivoli Storage Productivity Center.
2. Access the Configure Devices wizard. There are two methods for accessing the

wizard:
v To start the wizard and then select the type of resource that you want to

configure, click the Configure Devices icon on the toolbar or select the
Configure Devices node in the navigation tree.

v To start the wizard for a specific type of resource that you want to configure,
access the panel for that resource and click Add resource_type, where
resource_type represents the type of resource. For example, click the Add
Storage Subsystem button on the Disk Manager > Storage Subsystem
panel.

3. Follow the steps in the wizard to add storage resources, set up alerts, and
define data collection schedules.

4. After data is collected, use the web-based GUI to quickly monitor, manage, and
troubleshoot resources and generated alerts.
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Related concepts:
“Starting Tivoli Storage Productivity Center” on page 175
IBM Tivoli Storage Productivity Center provides two graphical user interface (GUI)
applications for managing and monitoring the resources in a storage environment:
a stand-alone GUI and a stand-alone GUI. You can start these GUIs on the Tivoli
Storage Productivity Center server or on a remote system.

Resources that you can monitor in the web-based GUI
You can use the web-based GUI to monitor storage systems, servers, hypervisors,
fabrics, and switches. Information about these top-level resources includes
information about their internal resources and related resources. Internal resources
are components that exist in a top-level resource. Related resources are external to
a top-level resource, but are related to it through assigned storage, a network
connection, or virtual hosting.

Fabrics

A fabric is a network of hubs, switches, adapter endpoints, and connecting cables
that support a communication protocol between devices. The following table
shows the internal resources and related resources that you can monitor for fabrics.

Table 45. Fabric resources that you can monitor in the web-based GUI

Top-level resource icon Internal resources Related resources

Blades

Ports

Switches

Zone sets

Hypervisors

Servers

Storage systems

Unknown resources

Hypervisors

A hypervisor is a layer of software or a physical device that manages multiple,
virtual instances of operating systems on the same hardware. Hypervisors that you
can monitor in the web-based GUI include VMWare vSphere data sources such as
ESX, ESXi, and vCenter servers.

The following table shows the internal resources and related resources that you can
monitor for hypervisors.

Table 46. Hypervisor resources that you can monitor in the web-based GUI

Top-level resource icon Internal resources Related resources

Virtual machines

Disks

Controllers

File systems and logical
volumes

Storage systems

Fabrics

Switches
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Servers

A server is a computer or host that is connected to a network and provides an
access point to that network. If a server is part of a cluster, information about that
cluster is also available. The following table shows the internal resources and
related resources that you can monitor for servers.

Table 47. Server resources that you can monitor in the web-based GUI

Top-level resource icon Internal resources Related resources

Disks

Controllers

Volume groups

File systems and logical
volumes

Hypervisors

Shares and exports

Monitored directories

Storage systems

Fabrics

Switches

Storage systems

A storage system is a device, such as a Redundant Array of Independent Disks
(RAID) controller, that creates and manages other storage devices. A storage
virtualizer is a storage system that virtualizes storage space from internal storage
or from another storage system.

Storage systems can be configured for block storage, file storage, or a combination
of block and file storage. The method that a storage system uses for managing data
determines the internal resources that are monitored.

The following table shows the internal resources and related resources that you can
monitor for storage systems.
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Table 48. Storage system resources that you can monitor in the web-based GUI

Top-level resource icon Internal resources Related resources

Block storage resources
Controllers

Disks

External disks

Host connections

I/O groups

Managed disks

Modules

Nodes

Pools

Ports

RAID arrays

Volumes

File storage resources

Controllers

Clusters

Disks

Exports

File systems

Network shared
disks

Nodes

Pools

Back-end storage systems

Fabrics

Hypervisors

Servers

Switches

Switches

A switch is a network infrastructure component to which multiple nodes attach. In
Tivoli Storage Productivity Center, you can monitor Fibre Channel (FC) switches.
The following table shows the internal resources and related resources that you can
monitor for switches.
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Table 49. Switch resources that you can monitor in the web-based GUI

Top-level resource icon Internal resources Related resources

Blades

Fabrics

Logical switches

Parent switches

Ports

Fabrics

Hypervisors

Servers

Storage systems

Switches

Unknown resources

Display differences in the interfaces
Tivoli Storage Productivity Center stores information about monitored resources in
a database repository. You can view this information in the stand-alone GUI or in
the web-based GUI. Depending on the interface that you use, there might be some
differences in how the information is presented.

The web-based GUI does not show a fabric for a physical, Cisco
SAN

The stand-alone GUI shows a "fabric" for a physical, Cisco SAN, whereas the
web-based GUI does not show a "fabric" for a physical, Cisco SAN.
v In the stand-alone GUI, Tivoli Storage Productivity Center automatically

generates a worldwide name (WWN) to represent a physical, CISCO SAN as a
fabric. This WWN typically starts with the numbers "3000". The WWN for the
fabric is shown on the Topology > Fabrics panel and in reports for fabrics.

v In the web-based GUI, a fabric is not shown for physical, Cisco SANs on the
Fabrics page. Only the virtual fabrics, physical switches, and logical switches for
Cisco Fibre Channel switches are shown in the web-based GUI.

The number of unidentified endpoints on fabrics is different from
the stand-alone GUI

The web-based GUI and stand-alone GUI might display a different number of
unidentified endpoints on a fabric:
v In the web-based GUI, unidentified endpoints are labeled as Unknown

Resources and each endpoint port is considered one Unknown Resource.
v In the stand-alone GUI, unidentified endpoints are labeled as Other and each

endpoint node is considered one Other.

For example, an endpoint with two ports is shown as one Other resource in the
stand-alone GUI, but in the web-based GUI it is shown as two Unknown
Resources.

Pool space for NetApp filers

For NetApp filers that are configured with block data, the values for pool space
that are shown in the web-based GUI are different from the values shown in a
storage management tool for NetApp filers, such as FilerView. The values that are
different include total pool capacity and available pool space.
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This discrepancy occurs because the pool space information that is collected by
SMI-S agents for Tivoli Storage Productivity Center includes Write Anywhere File
Layout (WAFL) and Snapshot reserve space, whereas tools like FilerView do not
include this additional space.

Viewing information about resources
You can view detailed information about the resources that are monitored by Tivoli
Storage Productivity Center. Resources include storage systems, volumes, pools,
servers, hypervisors, fabrics, and switches. You can also view information about
internal and related resources.

Remember: Data collection jobs retrieve information about monitored resources.
To ensure that the latest information about resources is available in the web-based
GUI, run data collection jobs regularly. To learn about how to collect data, see
“Collecting data” on page 337.

How information is organized
Information about monitored resources is organized into different pages in the
web-based GUI. You can use these pages to view summary information about all
resources, detailed information about top-level resources, and detailed information
about internal and related resources.

The dashboard

The dashboard is displayed when you start a new session of Tivoli Storage
Productivity Center or when you click Home > Dashboard in the navigation pane.
Use the dashboard to view the following summary information about a storage
environment:
v A topology or resource diagram of the top-level resources that are monitored by

Tivoli Storage Productivity Center. This diagram shows the number of top-level
resources that are monitored and their overall status. You can also click the icons
in the resource diagram to view more detailed information about a top-level
resource on a resource list page.

v Capacity information that was aggregated for storage systems, servers, and
hypervisors. Use this information to view the overall storage capacity for each
type of resource. This information is presented as horizontal bar charts.

v The status of Tivoli Storage Productivity Center jobs that were run during a
specific time. You can also click links to access a complete list of jobs.

v The number of unacknowledged alerts that were detected on resources during a
specific time. You can also click a link to access a complete list of alerts that
were detected on all monitored resources.

To learn about how to view summary information on the dashboard, see “Viewing
summary information about all resources” on page 631.

Jobs page

Use the Jobs page to view the following information about Tivoli Storage
Productivity Center jobs:
v The overall status of all jobs. Use this information to identify the number of jobs

that are encountering problems when running.
v Information about specific jobs, including status, related resource, type, and

schedule.

Chapter 6. Managing resources in the web-based GUI 629



v Information about performance monitors, including status, last successful
collection attempt, start time, end time, and remaining duration.

v Information in the log files for jobs.

To access the Jobs page, click Home > Jobs in the navigation pane.

Alerts page

Use the Alerts page to view and manage the alert conditions that were detected on
monitored resources. You can complete the following tasks on this page:
v View the overall number of alerts that were detected on monitored resources.

This information is presented in a bar chart for the following types of alerts:
– Database
– Fabric
– Hypervisor
– Other
– Performance
– Replication
– Server
– Storage system
– Tape library
– Tivoli Storage Productivity Center

v View information about specific alerts, including severity, last occurrence, and
the resources where they were detected.

v Acknowledge alerts that were reviewed but are not yet resolved.
v Unacknowledge alerts.
v Remove alerts from the page.

To access the Alerts page, click Home > Alerts in the navigation pane.

Resource list pages

Use a resource list page as central location for viewing information about the
top-level resources of a specific type. For example, use the Storage Systems page to
view a list of the storage systems that are monitored by Tivoli Storage Productivity
Center. Each resource list page corresponds to a specific type of resource, which
includes storage systems, volumes, pools, servers, hypervisors, switches, and
fabrics. You can view the following information on resource list pages:
v The overall status of the resources
v Key information about the resources
v Alerts that were generated for the resources
v Jobs that were run for the resources

To learn about how to access the list pages for resources, see “Viewing information
about top-level resources” on page 633.

Note: Volumes and pools are internal resources of storage systems, but have their
own resource list pages so that you can view them all in a central location.
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Resource detail pages

Use resource details pages to view information about resources that are internal or
related to a top-level resource. For example, use the Storage System details page to
view detailed information about a specific storage system. You can view the
following information on resource detail list pages:
v The overall capacity and storage usage for a resource
v Key information about a resource
v Alerts that were generated for a resource
v Jobs that were run for a resource
v Information about components that exist in top-level resources
v Information about the resources that are related to another resource

To learn about how to access detail pages for resources, see “Viewing information
about internal and related resources” on page 634.

Reporting

Use the IBM Tivoli Common Reporting tool in the web-based GUI to view detailed
reports about resources. The following reports are available:

Predefined reports
These reports are included with Tivoli Storage Productivity Center. The
following types of predefined reports are available:
v Resources
v Performance
v Historical space
v Storage tiering

Custom reports
Unlike predefined reports, you can select the information that you want to
include in custom reports. Custom reports can contain detailed information
about the relationships between monitored resources, the properties of
monitored resources, and detailed information about the performance of
monitored resources.

To learn about how to use the IBM Tivoli Common Reporting tool, see Chapter 9,
“Reporting in the web-based GUI,” on page 1143.

Viewing summary information about all resources
Use the dashboard to monitor the overall status of monitored resources and
identify potential problem areas in a storage environment. You can learn about the
status and capacity of top-level resources, the jobs that are running monitoring
actions, and the unacknowledged alert conditions that were detected.
1. In the navigation pane, click Home > Dashboard. The information on the

dashboard is organized into the following sections:
v The resource diagram
v Capacity
v Recent Jobs
v Unacknowledged Alerts

2. Use the following sections on the dashboard to monitor resources, jobs, and
alerts:
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The resource diagram
You can use the resource diagram to complete the following tasks:
v View the number of resources that are monitored for a resource type.

A number in parentheses is shown next to each resource icon. This
number represents the number of resources for a type that is
monitored. For example, if 20 storage systems are monitored, the
value Storage Systems (20) is shown.

v View a list of the resources that are monitored for a resource type.
Each type of resource in the diagram is represented by an icon. To
learn more about the individual resources for a resource type, click
the related icon in the diagram. For example, if you click the icon for
storage systems, a resource list page shows the storage systems that
are being monitored.

v View the overall status for each resource type. A status icon is shown
with each resource icon. The status icon represents the most critical
status that was detected on a top-level resource. For example, if
Tivoli Storage Productivity Center monitors 20 storage systems, and
an error condition was detected for one of those storage systems, an
error status icon is shown with the storage systems icon in the
diagram. If no errors, warnings, or unreachable statuses were
detected for the monitored storage systems, then a normal status icon
is shown. To learn more about the status of resources, see
“Monitoring the status of resources” on page 635.

v View the number of statuses that were detected and acknowledged
for each resource type. To view the total number of statuses for a
type of resource, move the mouse pointer over the status icon for
that resource type. Hover help shows the total number of
occurrences for each status, and the number of statuses that were
acknowledged by a Tivoli Storage Productivity Center user.

Capacity
You can use the Capacity section of the dashboard to view horizontal
bar charts that show aggregated storage information for each type of
top-level resource. You can use these charts to quickly determine
overall storage capacity and available space.

To cycle through the storage information for different types of
resources, click the forward and backward arrows . Hover the
mouse pointer over areas in the charts that are not labeled for
additional information.

Recent Jobs
You can use the Recent Jobs section of the dashboard to view a status
summary of the Tivoli Storage Productivity Center jobs that completed
during the selected time. This summary includes the number of jobs
that have the following statuses: Running, Error, Warning, and Normal.
Use the following actions to manage the display of job statuses:
v To select the time period for showing job statuses, click the forward

and backward arrows . You can view the status of all jobs that
were run in the last hour, last day, or last week.

v To view detailed information about all jobs, click View all jobs to
access the Jobs page.

v To view detailed information about performance jobs only, click
View performance jobs to access the Performance Monitors tab on
the Jobs page.
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Unacknowledged Alerts
You can use the Unacknowledged Alerts section of the dashboard to
view the status summary of alerts that were detected on monitored
resources during a specified time period. Alerts are generated when
Tivoli Storage Productivity Center detects certain conditions or events
on monitored resources. An unacknowledged alert is an alert that was
not reviewed or resolved by a Tivoli Storage Productivity Center user.

Use the following actions to manage the display of statuses for
unacknowledged alerts:
v To select the time period in which you want to view alert statuses,

click the forward and backward arrows to cycle through the
choices. You can view the status of all unacknowledged alerts that
were detected in the last hour, last day, or last week.

v To view detailed information about alerts, click View all alerts to
access the Alerts home page.

3. Optional: To view descriptions of the information that is available on the
dashboard, click the help icon in the upper-right corner of the page.

Viewing information about top-level resources
Use a resource list page as a central location for viewing information about all the
monitored resources of a specific type. Resources that have a list page include
storage systems, volumes, pools, servers, hypervisors, switches, and fabrics.
1. In the navigation pane, hover the mouse pointer over the resource icon for the

type of resource that you want to view. You can use the icons to access the
following types of resources:
v Storage Resources: storage systems, volumes, pools
v Server Resources: servers, hypervisors
v Network Resources: switches, fabrics

2. Select the type of resource that you want to view. For example, if you want to
view information about servers, select Server Resources > Servers. A list of
monitored servers is displayed on Servers page.

3. Locate the resource that you want to view in the list. Each column in the list
shows information about the resource.

4. Optional: To view key attributes of a specific top-level resource without leaving
the page, right-click the resource and select View Properties. A properties
notebook is displayed. Information in a properties notebook can include storage
statistics, hardware attributes, volume assignments, disk assignment, and
performance metrics.

5. Optional: To view more detailed information about a specific top-level resource,
including its internal and related resources, right-click the resource and select
View Details. A resource details page is displayed. This page includes
information about storage statistics, alerts, jobs, internal resources, and related
resources.

A resource list page shows information about the monitored resources for the
selected type. You can view the following information on this page:
v The overall status of the resources for a specific type
v Key information about the resources
v Alerts that were generated for the resources
v Jobs that were run for the resources
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Tip: To view descriptions of the information that is available on a resource list
page, click the Help icon in the upper-right corner of the page.
Related reference:
“Resources that you can monitor in the web-based GUI” on page 625
You can use the web-based GUI to monitor storage systems, servers, hypervisors,
fabrics, and switches. Information about these top-level resources includes
information about their internal resources and related resources. Internal resources
are components that exist in a top-level resource. Related resources are external to
a top-level resource, but are related to it through assigned storage, a network
connection, or virtual hosting.

Viewing information about internal and related resources
Use resource details pages to view information about a specific top-level resource
and its internal and related resources.
1. In the navigation pane, hover the mouse pointer over the resource icon for the

type of resource that you want to view. The icons provide access to the
following types of resources:
v Storage Resources: storage systems, volumes, pools
v Server Resources: servers, hypervisors
v Network Resources: switches, fabrics

2. Select the type of the resource that you want to view. A resource list page
shows the monitored resources for the selected type. For example, if you want
to view a storage system, select Storage Resources > Storage Systems. A list of
monitored storage systems is displayed on the Storage Systems page.

3. In the list of resources, right-click the resource that you want to view and select
View Details. A resource details page is displayed. This page includes
information about storage statistics, alerts, jobs, internal resources, and related
resources.

4. To view information about the internal resources of the top-level resource, click
the name of the internal resource in the Internal Resources section. A list of the
internal resources is displayed. Each column in the list shows information
about the resources. For example, on the details page for a server, click
Controllers to view a list of the controllers that are associated with the server.

5. Optional: To view key attributes of a specific internal resource without leaving
the page, right-click the resource and select View Properties.

6. To view information about resources that are related to the top-level resource,
click the name of the related resource in the Related Resources section. A list of
the related resources is displayed. For example, on the server details page, click
Storage Systems to view a list of the storage systems that have at least one
disk (volume) assigned to the server.

7. Optional: To view key attributes of a specific related resource without leaving
the page, right-click the resource and select View Properties.

8. Optional: To view the resource details page for a related resource, right-click
the resource and select View Details.

A resource details page shows information about a top-level resource. The
information is available in the following links and sections on the page:
v Overview: The overall capacity and storage usage for a resource.
v Properties: Key information about a resource.
v Alerts: Alerts that were generated for a resource.
v Jobs: Jobs that were run for a resource.
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v Internal Resources: Information about the components that exist in a
higher-level resource.

v Related Resources: Information about the resources that are related to another
resource. A related resource is external to a higher-level resource, but is related
to it through assigned storage, a network connection, or virtual hosting.

Tip: To view descriptions of the information that is available on a resource details
page, click the Help icon in the upper-right corner of the page.
Related reference:
“Resources that you can monitor in the web-based GUI” on page 625
You can use the web-based GUI to monitor storage systems, servers, hypervisors,
fabrics, and switches. Information about these top-level resources includes
information about their internal resources and related resources. Internal resources
are components that exist in a top-level resource. Related resources are external to
a top-level resource, but are related to it through assigned storage, a network
connection, or virtual hosting.

Monitoring the status of resources
You can use the web-based GUI to monitor the status of resources and identify
potential problem areas in a storage environment. Monitored resources include
top-level resources and their internal and related resources.

Use status information to quickly determine the condition of your storage and if
any actions must be taken. Tivoli Storage Productivity Center provides a number
of different statuses to help you determine the condition of resources. Each status
is represented by an icon in the web-based GUI.

Table 50. Possible statuses of monitored resources

Icon Status Description

Error A serious problem was detected on a resource or on its
internal resources. Resolve these problems as soon as
possible.

Error -
Acknowledged

An Error status was detected and acknowledged. An Error
- Acknowledged status indicates that a status was reviewed
and is either resolved or can be ignored.

An acknowledged status is not used when determining the
status of related, higher-level resources. For example, if the
status of a volume is Error, the status of the related storage
system is also Error. If the Error status of the volume is
acknowledged, its status is not used to determine the
overall status of the storage system.

Unreachable A resource is not responding to requests from the Tivoli
Storage Productivity Center server. This status might be
caused by a problem in the network or by a Storage
Resource agent that is no longer running and did not
communicate that it was shutting down.
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Table 50. Possible statuses of monitored resources (continued)

Icon Status Description

Unreachable -
Acknowledged

An Unreachable status was detected and acknowledged. An
Unreachable - Acknowledged status indicates that a status
was reviewed and is either resolved or can be ignored.

An acknowledged status is not used when determining the
status of related, higher-level resources. For example, if the
status of a controller is Unreachable, the status of the
related server is also unreachable. If the Unreachable status
of the controller is acknowledged, its status is not used to
determine the overall status of the server.

Warning A Warning status represents potential problems on a
resource or on its internal resources. This status is not
critical.

Warning -
Acknowledged

A Warning status was detected and acknowledged. An
Warning - Acknowledged status indicates that a status was
reviewed and is either resolved or can be ignored.

An Warning - Acknowledged status is not used when
determining the status of related, higher-level resources.
For example, if the status of a controller is Warning, the
status of the related server is also Warning. If the Warning
status of the controller is acknowledged, its status is not
used to determine the overall status of the server.

Normal No warnings or errors were detected on a monitored
resource.

Unknown A resource is known to Tivoli Storage Productivity Center
but is not monitored. To change an Unknown status, use a
data collection job to collect status information about the
resource.

For top-level resources, use the resource details page to view the status of their
internal resources.

How status is determined
Top-level resources that are monitored in the web-based GUI include storage
systems, servers, hypervisors, fabrics, and switches. The status of a top-level
resource is determined by its consolidated status and the propagated status of its
internal resources.

A consolidated status is the status that is reported by the top-level resource for its
own hardware. For example, if the cooling fans in a storage system are stopped
and the internal temperature is too high, that status is reported to Tivoli Storage
Productivity Center.

A propagated status is the combined statuses of the monitored, internal resources
for a top-level resource. For example, if a Warning status is detected on a volume
in a storage system, that Warning status is used to determine the overall status of
the storage system.

Tivoli Storage Productivity Center uses the values for consolidated status and
propagated status to calculate the overall status of a top-level resource. The
statuses of the following internal resources are used to calculate the status of
top-level resources.
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Table 51. Internal resources that are used to determine the status of top-level resources

Top-level resource
Internal resources that are used to determine the status of a
top-level resource

Fabric
, Blades, and ports on blades

Ports that are not blades

Switches

Hypervisor Controllers

Ports on controllers

Virtual machines

Server
, Controllers, and ports on controllers

Volume groups

Monitored directories

Storage system
Clusters

Controllers

Disks

External disks

Modules

Network shared disks

Nodes

Pools, and the internal resources that are associated with
pools:

v Volumes

v RAID arrays

v Managed disks

Ports

Switch Blades

Logical switches

Ports
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Tivoli Storage Productivity Center uses the following statuses of internal resources
to help calculate the status top-level resources:
v Unknown
v Normal
v Error
v Warning
v Unreachable

Tip: Statuses that are acknowledged are not used to calculate the overall status of
a top-level resource.

Internal resources for a top-level resource might have different statuses. Tivoli
Storage Productivity Center uses the most severe status of an internal resource
when determining the overall status for a top-level resource. For example, in a
storage system, a port might have an Error status, a pool might have a Warning
status, and a number of controllers might have an Unknown status. In this case,
the overall status for the storage system is Error because it is the most severe
status that was detected on the internal resources.

Statuses for internal resources are propagated in the following way to determine
the status of a top-level resource:
v If an internal resource has an Error status, then the related top-level resource has

an Error status.
v If an internal resource has an Unreachable status, and no other internal resources

have an Error status, the related top-level resource has an Unreachable status.
v If an internal resource has a Warning status, and no other internal resources

have an Error or Unreachable status, the related top-level resource has a
Warning status.

v If an internal resource has a Normal status, and no other internal resources have
an Error, Unreachable, or Warning status, the related top-level resources has a
Normal status.

v If an internal resource has an Unknown status, and no other internal resources
have an Error, Unreachable, Warning, or Normal status, the related top-level
resource has an Unknown status.

The following table shows some of the possible combinations of statuses and their
resulting, propagated status.

Table 52. Propagation of the statuses for internal resources in the web-based GUI

Error Unreachable Warning Normal Unknown Resulting status
for top-level
resource

X
Unknown

X
Normal

X X
Normal

X
Warning

X X
Warning
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Table 52. Propagation of the statuses for internal resources in the web-based
GUI (continued)

Error Unreachable Warning Normal Unknown Resulting status
for top-level
resource

X X X
Warning

X
Unreachable

X X
Unreachable

X X X
Unreachable

X X X X
Unreachable

X
Error

X X
Error

X X X
Error

X X X X
Error

X X X X X
Error

Viewing the overall status of resources
Use the dashboard to monitor the overall status of monitored resources and
identify potential problem areas in a storage environment. The dashboard shows
the overall status of storage systems, servers, hypervisors, fabrics, and switches,
and the total number of different statuses that were detected on the individual
resources for each type.
1. In the navigation pane, click Home > Dashboard. Information about the overall

status of top-level resources is shown on the resource diagram.
2. View the status icon that is shown with each resource icon to determine the

overall status of a resource type. The status icon represents the most critical
status that was detected on the resources for a specific type.
For example, if Tivoli Storage Productivity Center monitors 20 storage systems,
and an error condition was detected for one of those storage systems, the
following status icon is shown with the storage systems icon:

Storage Systems (20)

If no Error, Warning, or Unreachable statuses were detected on the monitored
storage systems, the following status icon is shown with the storage systems
icon:

Storage Systems (20)

3. Move the mouse pointer over the status icon for a resource type to view the
number of statuses that were detected and acknowledged for that resource
type. Hover help shows the total number of occurrences for each status, and
the number of statuses that were acknowledged by a Tivoli Storage
Productivity Center user.
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For example, move the mouse pointer over the status symbol for fabrics to
view the number of monitored fabrics that have an Error, Unreachable,
Warning, Normal, or Unknown status. If five fabrics have an Unreachable
status, three fabrics have a Normal status, and no fabrics have an Error or
Warning status, the following information is shown when you hover over the
status icon for fabrics:

0 Error

5 Unreachable

0 Warning

3 Normal

Related reference:
“How status is determined” on page 636
Top-level resources that are monitored in the web-based GUI include storage
systems, servers, hypervisors, fabrics, and switches. The status of a top-level
resource is determined by its consolidated status and the propagated status of its
internal resources.

Viewing the status of top-level resources
Use a resource list page as a central location for viewing the propagated statuses of
top-level resources. Resources that have a list page with status information include
storage systems, volumes, pools, servers, hypervisors, switches, and fabrics.
1. In the navigation pane, select the type of top-level resource that you want to

view. For example, if you want to view the status of monitored switches, select
Network Resources > Switches.

2. To view the total number of different statuses that were detected for the type of
resource, check the status icons at the top of the resource list page. The number
next to the icon represents how many of each status was detected.
For example, if 20 switches are monitored, and 10 have a Normal status while
the other 10 have a Warning status, the following status information is
displayed at the top of the page:

10 Normal

10 Warning

0 Error

3. To view the status for specific resources, check the Status column in the list of
resources. The value in the Status column represents the propagated status for
a top-level resource.

4. Optional: Click the Search icon to filter the list so that only resources with a
specified status are shown. You can use filtering to identify the resources with
the most serious Error conditions in your environment.

5. Optional: Select Status.
6. Optional: In the Choose Value list, select the status on which you want to filter.

The list of resources is automatically refreshed and only resources with the

filtered status are shown. For example, select Warning to view only the
resources on which a Warning status was detected.

640 IBM Tivoli Storage Productivity Center: User's Guide



Viewing the status of internal resources
Use a resource details page to view the propagated status of a top-level resource
and the status of its internal resources.
1. In the navigation pane, select a type of top-level resource. For example, if you

want to view the status of monitored storage systems and their internal
resources, select Storage Resources > Storage Systems.

2. Locate the resource in the list and check the Status column. The value in the
Status column represents the propagated status for the top-level resource.

3. To view the status of internal resources, right-click the top-level resource and
select View Details. A resource details page shows the internal resources for
the selected resource.

4. Check for any status icons that are associated with an internal resource. If
Tivoli Storage Productivity Center detects a status other than normal, an icon is
displayed for the most critical status.
For example, if a server has three controllers with an Error status and two
controllers with a Warning status, the Error status icon is shown for controllers
in the Internal Resources section:

Controllers (5) .
5. To view the status of specific internal resources, click the name of the internal

resource in the Internal Resources section. A list of the monitored internal
resources is displayed. For example, on the details page for a server, click
Controllers (5) to view a list of the five controllers that are associated with the
server.

6. Check the Status column to view the status for each internal resource.

Tip: When viewing information about some internal resources, the Status
column might show values that are more specific than Error, Unreachable,
Warning, Unreachable, Unknown, and Normal. Use this additional status to
determine the cause of the problem for an internal resource.

For example, in the Internal Resources section on the details page for a storage
system, an Error status is shown for managed disks:

Managed Disks (5)

This status means that one or more managed disks have an Error condition.
When you view the list of managed disks, the Status column might show an
Offline status for a specific managed disk. When an Offline status is detected,
the web-based GUI shows it as an Error status on the details page for the
storage system.

Acknowledging the status of resources
The web-based GUI shows Error, Unreachable, and Warning statuses for top-level
resources and internal resources. Sometimes these statuses might represent
problems that commonly occur but can be ignored. In such cases, you can
acknowledge the resources so that they are not used when propagating statuses for
top-level resources or when calculating the total number of Error, Warning, and
Unreachable conditions that were detected.
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Acknowledging the status of top-level resources
The web-based GUI shows a summary of the statuses for top-level resources on
the dashboard and resource list pages. You can acknowledge the status of a
top-level resource so that its status is not shown as Error, Unreachable, or Warning
on those pages.
1. In the navigation pane, select the type of resource that has a status you want to

acknowledge. For example, if you want to acknowledge the status of a switch,
select Network Resources > Switches.

2. In the list of resources, locate the resource with the Error, Unreachable, or
Warning status that you want to acknowledge.

3. Right-click the resource and select Acknowledge status. A window shows that
the status for the specified resource was acknowledged.

4. Optional: To acknowledge multiple resources at the same time, press Ctrl and
click each resource. To select a series of resources, select the first resource, and
then press Shift and click the last resource. When the resources are selected,
right-click a row in the list and select Acknowledge status.

5. Click Close.

When you acknowledge the status of a top-level resource, the following actions are
taken on pages in the web-based GUI:
v The dashboard:

– The status of the acknowledged resource is not used to determine the status
icon that is displayed for that resource on the resource diagram. For example,
if you acknowledge the Unreachable status for a switch, that Unreachable
status is not used to determine the status icon that is displayed for the switch
icon on the dashboard.

– The acknowledged status is shown as Acknowledged when you point to the
status icon for a resource. For example, if 10 switches have an Unreachable
status and you acknowledge the status for one of them, the following
information is shown when you hover the mouse over the switch icon:

9 Unreachable (1 Acknowledged)

Restriction: The dashboard shows status icons and hover information for
servers, hypervisors, switches, fabrics, and storage systems. The statuses of pools
and volumes are used to calculate the status of these top-level resources, so their
individual statuses are not shown on the dashboard.

v The resource details page:
– The status icons at the top of the page are updated. For example, if 10

switches have an Unreachable status, and you acknowledge one of them, the
total number Unreachable statuses decreases by one and the number of
Unreachable - Acknowledged statuses increases by one. The following
information is updated at the top of the Switches page:

9 Unreachable 1 Unreachable - Acknowledged

– The value in the Status column for the resource is updated to show an
acknowledged status. For example, if you acknowledge the Unreachable
status for a switch, the following value is shown in the Status column:

Unreachable
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Related reference:
“Resources that you can monitor in the web-based GUI” on page 625
You can use the web-based GUI to monitor storage systems, servers, hypervisors,
fabrics, and switches. Information about these top-level resources includes
information about their internal resources and related resources. Internal resources
are components that exist in a top-level resource. Related resources are external to
a top-level resource, but are related to it through assigned storage, a network
connection, or virtual hosting.

Acknowledging the status of internal resources
The web-based GUI uses the status of internal resources to determine the status of
top-level resources. Sometimes these statuses might represent problems that
commonly occur or are known, but can be ignored. In such cases, you can
acknowledge the status of an internal resource so that it is not used when
determining the status of a top-level resource.

For example, if the status of a volume is Error, the status of the related storage
system is also Error. If the Error status of the volume is acknowledged, its status is
not used to determine the overall status of the storage system. In this case, if the
other internal resources of the storage system are Normal, then the status of the
storage system is also Normal.
1. In the navigation pane, select the type of resource in which the internal

resource is located. For example, if you want to acknowledge the status of
internal resources for a switch, select Network Resources > Switches.

2. Right-click a resource and select View Details. For example, if you want to
acknowledge the status of a port on a switch, right-click that switch and select
View Details.

3. In the Internal Resources section of the resource details page, click the name of
the internal resource. For example, if you want to acknowledge the status of a
port on a switch, click Ports.

4. Right-click the resource and select Acknowledge status. A window shows that
the status for the specified resource was acknowledged. For example, if you
want to acknowledge the status of a port, right-click the port and select
Acknowledge status.

5. Optional: To acknowledge multiple resources at the same time, press Ctrl and
click each resource. To select a series of resources, select the first resource, and
then press Shift and click the last resource. When the resources are selected,
right-click a row in the list and select Acknowledge status

6. Click Close. The status of the related, top-level resource might take several
minutes to update.

When you acknowledge the status of an internal resource, the following actions
occur:
v The status of the internal resource is no longer used to determine the status of

the related, top-level resource.
For example, if you acknowledge the Error status for a controller on a server, the
status of that controller is not used when determining the overall status of the
server.

v The status icons at the top of the page for the internal resource are updated.
For example, if you acknowledge the Error status for a controller on a server, the
total number of Error statuses decreases by one and the number of Error -
Acknowledged statuses increases by one on the Controllers page. If originally
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there were five controllers with Error statuses, the following updated status
information is shown at the top of the page:

4 Error 1 Error - Acknowledged

Related reference:
“Resources that you can monitor in the web-based GUI” on page 625
You can use the web-based GUI to monitor storage systems, servers, hypervisors,
fabrics, and switches. Information about these top-level resources includes
information about their internal resources and related resources. Internal resources
are components that exist in a top-level resource. Related resources are external to
a top-level resource, but are related to it through assigned storage, a network
connection, or virtual hosting.

Viewing jobs
Jobs are used to collect data about storage resources and complete other tasks that
are related to monitoring a storage environment. Use the Jobs page in the
web-based GUI to view all the jobs that are used by Tivoli Storage Productivity
Center to monitor resources. Use resource list and resource details pages to view
the jobs for specific resources and types.

Specifically, you can use the web-based GUI to complete the following tasks:
v View the status of all jobs in a central location
v View the status of performance monitor jobs on a dedicated tab
v Identify all the jobs that are related a specific type of resource
v Identify all the jobs that are related a specific resource
v Identify all the jobs that are encountering problems when running

The following terms are used in the web-based GUI:
v Job: A unit of work that monitors, manages, or collects data about a storage

resource. In the stand-alone GUI, the term schedule is also used. These
monitoring tasks include the following job actions:
– Collecting data about resources with scans, probes, quotas, discovery, or

performance monitors. For example, define a probe job to collect asset and
status data about storage systems; define a scan job to collect file-level
information about servers.

– Running scripts.
– Checking for quota violations.
– Backing up and archiving files.
– Analyzing storage configurations to determine whether existing SAN

configurations violate defined best practices or policies.
– Creating and implementing end-to-end storage plans.
– Creating volumes.
– Upgrading or deploying agents.

v Run: A run is a single invocation of a job.

Tip: If multiple resources are included in the same data collection job, a separate
row for each resource is shown in the list of jobs. For example, if five storage
systems are monitored by the same probe, a row for each storage system is shown
in the list.
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There is an exception for fabric jobs. Probes that collect data about multiple fabrics
are not shown in the list. Only probes that collect data about one fabric are shown.
For example, if five fabrics are monitored by the same probe, there is no entry for
the probe or fabrics in the list. If one fabric is monitored by a probe, a row for the
fabric is shown.

Configuring the display of jobs
You can use the stand-alone GUI to configure how jobs are displayed in the
web-based GUI.

Setting the retention of jobs and logs
The jobs and logs that are shown in the web-based GUI are determined by
configuration settings in the stand-alone GUI. The default setting is to show the
last five runs of a job. Use the stand-alone GUI to change how many runs of a job
are displayed in the web-based GUI.
1. Start the stand-alone GUI.
2. In the navigation pane, go to Administrative Services > Configuration.
3. Click Log File and Cached Batch Report Retention.
4. In the Maximum number of runs to keep of each schedule field, enter the

maximum number of runs for a job (schedule) that you want to display in the
web-based GUI.

5. Save the changes.

After you update the value for Maximum number of runs to keep of each
schedule in the stand-alone GUI, the list of jobs on the Jobs page in the web-based
GUI is automatically updated within a few minutes.

Setting the retention of removed resources
Removed resources are resources that are no longer monitored by Tivoli Storage
Productivity Center. When a resource is no longer monitored, use the stand-alone
GUI to determine how long its related jobs are show in the web-based GUI.

For example, if a storage system is removed from Tivoli Storage Productivity
Center, and the retention setting is set to two weeks, the jobs for that storage
system are shown for an additional two weeks before they are removed from the
Jobs page. The default setting for retaining job information about removed storage
systems is two weeks.
1. Start the stand-alone GUI.
2. In the navigation pane, go to Administrative Services > Configuration.
3. Click Removed Resource Retention.
4. Select a resource and enter the number of days to retain information after it is

no longer monitored by Tivoli Storage Productivity Center.
5. Save the changes.

After you change the retention settings in the stand-alone GUI, the list of jobs on
the Jobs page in the web-based GUI is automatically updated within a few
minutes.

Viewing all jobs
Use the Jobs page as a central location to view and manage all the jobs that Tivoli
Storage Productivity Center is using to monitor resources. You can view all data
collection jobs for resources, including performance monitors.
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1. In the navigation pane, go to Home > Jobs.
2. Use the Jobs tab to view a list of all Tivoli Storage Productivity Center jobs.

The information about jobs is organized into columns. These columns include
information about the status of jobs, the names of resources that are associated
with jobs, the schedule for jobs, and links to job logs.

3. Optional: Click the Performance Monitors tab to only view information about
performance monitor jobs. Performance monitor jobs collect performance
statistics about storage systems and switches.
The information about performance monitors is organized into columns. These
columns include information about the status of jobs, the name of the storage
systems or switches that are monitored, the most recent success percentage and
collection attempt, the number of failed collections, and links to job logs.

4. Optional: View the icons at the top of the page to view a summary of the
statuses for jobs. This summary includes the number of jobs that have a Failed,
Warning, Successful, or Running status.

Tip: To view descriptions of the icons and columns on the Jobs page, click the
Help icon in the upper-right corner of the page.

Viewing jobs for a type of resource
Use resource list pages to view only the jobs for a specific type of top-level
resource. Each resource list page has a Jobs tab that lists only the jobs for
monitored storage systems, servers, hypervisors, switches, or fabrics. For example,
you can use the list page for storage systems to view only the jobs that are
associated with storage systems.
1. In the navigation pane, select a type of top-level resource. For example, if you

want to view the jobs that are related to storage systems, select Storage
Resources > Storage Systems.

2. Click the Jobs tab to view a list of all the jobs for the monitored resources of
that type. For storage systems and switches, performance jobs are also listed in
the Jobs tab.
The information about jobs is organized into columns. These columns include
information about the status of jobs, the names of resources that are associated
with jobs, the schedule for jobs, and links to job logs.

Tip: The icon on the Jobs tab represents the most critical status of the jobs that
are associated with monitored resources. For example, if one of the jobs for
storage systems failed, the following icon is shown on the tab:

Jobs

3. Optional: View the icons at the top of the Jobs tab for a summary of job
statuses. This summary includes the number of jobs that have a Failed,
Warning, Successful, or Running status.

Tip: To view descriptions of the icons and columns on the Jobs tab, click the
Help icon in the upper-right corner of the page.

Viewing jobs for a specific resource
Use resource detail pages to view only the jobs for a specific resource. Each
resource details page has a Jobs link that lists only the jobs for a monitored storage
system, server, hypervisor, switch, or fabric.
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1. In the navigation pane, select a type of top-level resource. For example, if you
want to view the jobs that are related to storage systems, select Storage
Resources > Storage Systems.

2. Right-click a resource in the list and select View Details. In the General
section, the number next to Jobs represents the number of jobs that are
associated with the resource. For example, Jobs (3) indicates that there are three
jobs that you can view.
The icon next to the Jobs link represents the most critical status of the jobs that
are associated with the resource. For example, if a job failed, the following icon
is shown:

Jobs (3)

3. Click the Jobs link in the General section to view the jobs for the resource. The
information about jobs is organized into columns. These columns include
information about the status of jobs, the names of resources that are associated
with jobs, the schedule for jobs, and links to job logs.

4. Optional: View the icons at the top of the page to view a summary of the
statuses for jobs. This summary includes the number of jobs that have a Failed,
Warning, Successful, or Running status.

Tip: To view descriptions of the icons and columns that are shown for jobs,
click the Help icon in the upper-right corner of the page.

Viewing job logs
Job logs include detailed information about the status, actions, and progress of a
job. Status information includes informational, warning, and error messages that
are related to each action in a job that is taken during processing. You can use this
information to troubleshoot any errors that might occur when a job is run.
1. In the navigation pane, go to the Jobs page, a list of jobs for a specific type of

resource, or a list of jobs for a specific resource. For example, to view a list of
jobs for storage systems, go to Storage Resources > Storage Systems and click
the Jobs tab.

2. Locate the job that has a log file you want to view.
3. In the Logs column, click View Logs. A separate window opens to show

information about the most recent run of the job.
4. Optional: In the Logs window, to view the log for previous runs of a job, select

a run from the Select a log list.
5. Optional: To view only the actions in a job run that have a Warning or Error

status, select an option from the Show all list. You can choose to view only
actions that have the following statuses:

v Only error entries

v Only warning entries

v Error and warning entries
6. Optional: To view an explanation of the message that is associated with an

action, click the link in the ID column.

The information on the Logs page is automatically updated every 30 seconds. New
entries are added to end of the log. You can view the following information on a
Logs page:
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v The overall status of a job. The icon that is shown in the Select a log list
represents the most critical status that was generated by an action in the job.

v The status for each action in a job. An icon and type of status is shown in the
Status column for each action.

v The date and time when an action was completed. The date, time, and time zone
when the action was taken is shown in the Date and Time column.

v The ID of the message that is associated with an action. You can click the value
in ID column to view more information about a message.

v A description of an action. This value is shown in the Description column.

Tip: You can use the navigation and search functions of the web browser to locate
information on the page.

Managing alerts
Alerts are generated when Tivoli Storage Productivity Center detects certain
conditions or events on monitored resources. Many conditions can trigger alerts.
You can set up Tivoli Storage Productivity Center so that it generates alert
notifications for conditions that you specify.

Before you use the web-based GUI to view and manage alerts, you must complete
these tasks:
v Add resources for monitoring by Tivoli Storage Productivity Center. Use the

Configure Devices wizard in the stand-alone GUI to add resources for
monitoring.

v Specify the conditions on resources that trigger alert notifications. Use the
stand-alone GUI to create alerts.

v Collect data about storage resources. Alerts are triggered by conditions that are
detected during data collection. Use the stand-alone GUI to create data collection
schedules.

The conditions that trigger alert notifications depend on the type of resource that
you are monitoring. Some triggering conditions, like thresholds, require you to
enter values for triggering alerts. In general, the following types of conditions can
trigger alerts:
v A data collection schedule did not complete
v A change occurred in the storage infrastructure
v A performance threshold was violated

Tip: Tivoli Storage Productivity Center does not use the alert conditions that are
detected on a resource to determine the overall status of the resource.
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Related concepts:
“Monitoring the status of resources” on page 635
You can use the web-based GUI to monitor the status of resources and identify
potential problem areas in a storage environment. Monitored resources include
top-level resources and their internal and related resources.
Related tasks:
“Configuring resources for monitoring” on page 624
You can use the stand-alone GUI to configure the resources that you want to
monitor in web-based GUI. You must configure before you can collect data,
generate reports, and manage storage that is related to those resources.
“Working with alerts” on page 385
Create an alert, configure how the alert is publicized, or edit, delete, disable,
rename, or view an alert.
“Collecting data” on page 337
Create data collection jobs to gather information about the storage resources in
your environment. There are different data collection jobs within IBM Tivoli
Storage Productivity Center depending on the type of information is collected and
from which types of resources the information is retrieved: discovery, probes, Tivoli
Storage Productivity Center Server probes, scans, and pings.

Alert severities
Tivoli Storage Productivity Center determines the severity of alert conditions that it
detects on monitored resources. Use the severity level to help determine the
priority in which you resolve alerts.

Each severity is represented by an icon in the web-based GUI.

Table 53. Possible severities of alerts

Icon Status Description

Critical An alert with a Critical severity represents a serious
problem on a resource or on its internal resources. Resolve
these problems as soon as possible.

Critical -
Acknowledged

An alert with a Critical severity was acknowledged. A
Critical - Acknowledged severity indicates that an alert was
reviewed and is either resolved or can be ignored.

Warning An alert with a Warning severity represents potential
problems on a resource or on its internal resources. The
condition that generated the alert is not critical.

Warning -
Acknowledged

An alert with a Warning severity was acknowledged. A
Warning - Acknowledged severity indicates that an alert
was reviewed and is either resolved or can be ignored.

Informational An alert with an Informational severity does not represent
a problem, but is intended to provide information about
actions related to a resource.

Informational -
Acknowledged

An alert with an Informational severity was acknowledged.
An Informational - Acknowledged severity indicates that an
alert was reviewed and can be ignored.
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Related reference:
“Triggering conditions for alerts” on page 1439
You can define alerts so that IBM Tivoli Storage Productivity Center notifies you
when a specified event occurs. Such events are the triggering conditions for the alert.
The specific triggering conditions that you can use to define an alert depend on the
sort of storage resource that you are monitoring.

Viewing all alerts
Use the Alerts page as a central location to view and manage all the alerts that
were detected by Tivoli Storage Productivity Center.

The Alerts page is organized into two sections:

Alerts summary chart

The summary chart at the top of the page is a visual representation of the
alerts that were detected on monitored resources. The chart consists of
stacked bars with the number and severity of current alerts on the y-axis
and the resource type on the x-axis. The y-axis labeling scales dynamically
according to the highest number of alerts in any of the categories.

Alerts list
The alerts list shows information about all the alerts that were detected on
monitored resources. Information in the list is organized into columns.
These columns include information about the condition that was detected,
the severity of the alert, when the alert was detected, and the names of the
resources where the alert condition was detected.

The version of Tivoli Storage Productivity Center that detected an alert determines
where information about the alert is displayed. Alerts that were generated in
version 5.1 or later are displayed on the Alerts page and in the Alerts tab on the
pages for the related resources. Alerts that were generated in versions of the
product before 5.1, also called migrated alerts, are only displayed on the Alerts
page.

Tip: Depending on how data is configured for a NetApp filer, alerts are shown on
different pages in the interface:
v Alerts for the block data in a NetApp filer are shown in the Alerts tab on the

Storage Systems page and in the list of alerts on the Alerts page.
v Alerts for the file data in a NetApp filer are only shown in the list of alerts on

the Alerts page.
1. In the navigation pane, go to Home > Alerts. Information about alerts is shown

in the list of alerts.
2. Optional: To view the number of alerts for a specific type of resource, hover the

mouse pointer over the related icon in the summary chart. For example, if you
want to view the number of Critical, Warning, and Informational alerts that
were triggered by hypervisors, hover the mouse pointer over the Hypervisors

icon .
3. Optional: To filter the list of alerts for a specific type of resource, click the icon

for that resource in the summary chart. For example, if you only want to view

a list of alerts for hypervisors, click the Hypervisors icon .
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Tip: To view descriptions of the icons and columns on the Jobs page, click the
Help icon in the upper-right corner of the page.

Viewing alerts for a type of resource
Use resource list pages to view only the alerts for a specific type of top-level
resource. Each resource list page has an Alerts tab that lists only the alerts for
monitored storage systems, servers, hypervisors, switches, or fabrics. For example,
you can use the list page for storage systems to view only the alerts that were
detected on monitored storage systems.
1. In the navigation pane, select a type of top-level resource. For example, if you

want to view the alerts that are related to storage systems, select Storage
Resources > Storage Systems.

2. Click the Alerts tab to view a list of all the alerts for the monitored resources of
that type. The information about alerts is organized into columns. These
columns include information about the condition that was detected, the severity
of the alert, when the alert was detected, and the names of the resources where
the alert condition was detected.

Tip: The icon on the Alerts tab represents the most severe alert condition that
was detected on the monitored resources. For example, if one of the jobs for
storage systems failed, the following icon is shown on the tab:

Alerts.
3. Optional: View the icons at the top of the Alerts tab for a summary of alert

severities. This summary includes the number of alerts that have a Critical,
Warning, Informational, or Acknowledged status.

Tip: To view descriptions of the icons and columns on the Alerts tab, click the
Help icon in the upper-right corner of the page.

Viewing alerts for a specific resource
Use resource detail pages to view only the alerts for a specific top-level resource.
Each resource details page has an Alerts link that lists only the alerts for a
monitored storage system, server, hypervisor, switch, or fabric. For example, you
can use the details page for a storage system to view only the alerts that were
detected for that storage system.
1. In the navigation pane, select a type of top-level resource. For example, if you

want to view the alerts that are related to storage systems, select Storage
Resources > Storage Systems.

2. Right-click a resource in the list and select View Details. In the General
section, the number next to Alerts represents the number of alert conditions
that were detected on the resource. For example, Alerts (25) indicates that 25
alerts were detected on the resource.
The icon next to the Alerts link represents the most severe alert condition that
was detected on the resource. For example, if alerts with an Error severity were
detected the following icon is shown:

Alerts (25)

3. Click the Alerts link in the General section to view the alerts that were
detected on the resource. The information about alerts is organized into
columns. These columns include information about the condition that was
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detected, the severity of the alert, when the alert was detected, and the names
of the resources where the alert condition was detected.

4. Optional: View the icons at the top of the page for a summary of alert
severities that were detected. This summary includes the number of alerts that
have a Critical, Warning, Informational, or Acknowledged status.

Tip: To view descriptions of the icons and columns that are shown for alerts,
click the Help icon in the upper-right corner of the page.

Removing alerts
Remove alerts when you no longer require to view them in the web-based GUI. By
default, alerts are automatically removed based on retention settings that are
defined in the stand-alone GUI. However, you can use the remove actions to
manually remove alerts from the web-based GUI.
1. Go to a list of alerts that includes the alerts that you want to remove. For

example, if you want to remove alerts for different types of top-level resources,
go to Home > Alerts.

2. Right-click the alert that you want to remove and select Remove alerts.
3. Click Remove to remove the alert. When you remove an alert, it is no longer

shown on the Alerts page or in the Alerts tabs on the related resource list and
resource detail pages.
For example, if you remove an alert for a fabric, that alert is removed from the
Alerts page, Fabrics page, and Fabric details page.

4. Optional: To remove all the alerts that are shown in a list, select Remove all
alerts from the Actions menu.

5. Optional: To remove all the acknowledged alerts that are shown in a list, select
Remove acknowledged alerts from the Actions menu.

Acknowledging alerts
Some alerts in Tivoli Storage Productivity Center are triggered by conditions that
commonly occur and can be ignored. In such cases, you acknowledge these alerts
to indicate that they were reviewed and do not require immediate resolution. By
acknowledging alerts, you can more quickly identify the other alerts in lists that
must still be reviewed and resolved.
1. Go to a list of alerts that includes the alerts that you want to acknowledge. For

example, if you want to acknowledge the alerts for a specific server, complete
the following steps.
a. In the navigation pane, go to Server Resources > Servers.
b. Right-click the server that has alerts you want to acknowledge and select

View Details.
c. Click the Alerts link.

2. Right-click the alert that you want to acknowledge and select Acknowledge
alerts. The severity of the alert is changed to Acknowledged on the Alerts page,
resource list page, and resource details page.
For example, if you acknowledge a server alert that has a Warning severity, it is
shown on the Alerts page, Servers page, and Server details page with the
following severity:

Warning - Acknowledged
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3. Optional: To acknowledge multiple alerts at the same time, press Ctrl and click
each alert. To select a series of alerts, select the first alert, and then press Shift
and click the last alert. When the alerts are selected, right-click a row in the list
and select Acknowledge alerts.

4. Optional: To acknowledge all the alerts that are shown in a list, select
Acknowledge all alerts from the Actions menu.

5. Optional: To acknowledge all the alerts with an Informational severity in a list,
select Acknowledged informational alerts from the Actions menu. You might
want to acknowledge all Informational alerts when you want to view only
alerts that represent potential or serious problems that require action to resolve.

Exporting information about resources, jobs, and alerts
You can save information about resources, jobs, or alerts to a PDF, CSV, or HTML
file. Information that you can export from the web-based GUI includes all the
values that are being shown in the columns for a list of resources, jobs, or alerts.

The information that you export to a file is organized according to the sorting,
filtering, and column order that is defined for a list. Before you export information,
complete the following tasks to configure a list:
v Change the order of columns in the list as you want them to appear in the

generated file.
v Hide columns in the list that you do not want to include in the generated file.

Information in hidden columns is not exported.
v Sort the rows in the list as you want them to appear in the generated file. Each

list in the web-based GUI has a column or set of columns that determines the
order of its rows.

v Filter the list to show only the resources, jobs, or alerts that you want to export.
Use filtering to limit the rows that are shown in a list based on value in a
specific column or set of default columns.

You can export information that is shown on the following pages:

Resource list and resource details pages
You can export information about the top-level resources, internal
resources, or related resources that are shown on resource list pages and
resource details pages. For top-level resources, you can also export
information about related jobs or alerts.

For example, you can export information about monitored switches on the
Switches page. When you select the export action, the generated file
includes the column values for each monitored switch in the list. In the
Jobs or Alerts tabs on the Switches page, you can export information
about all the jobs or alerts that are related to switches.

The Alerts page
On the Home > Alerts page, you can export information about all the
alerts that were detected for monitored resources. Information that you can
export includes all the values that are being shown in the columns for the
list of alerts.

The Jobs page
On the Home > Jobs page, you can export information about all the jobs
that are associated with monitored resources. Information that you can
export includes all the values that are being shown in the columns for the
list of jobs.
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1. In the web-based GUI, go to a list of resources, jobs, or alerts for which you
want to export information.

2. Click Actions and select Export > file_format, where file_format represents the
format that you want to use for a file. The following formats are available:

CSV (comma-separated values)
A CSV file is a file that contains comma-delimited values and can be
viewed with a text editor or imported into a spreadsheet application.
The information in a CSV file has the following format:
"Column_name","Column_name","Column_name","Column_name","Column_name","Column_name"
"data","data","data","data","data","data"

where Column_name represents the name of a column in a table and data
represents the data that is associated with a column.

PDF You can view a PDF file with Acrobat reader. The information that you
export to a PDF file is formatted into a table.

Tip: When you export a table of data that contains many columns, the
rows in that table might span multiple pages in the resulting PDF. For
example, if a table contains 20 columns, then the row for a specific
resource might be shown on more than one page (10 columns on the
first page and 10 columns on the second page).

To reduce the amount of pages that a table spans, before you select the
export action, hide the columns that you do not want to include in the
PDF. Continue hiding columns until the table no longer spans multiple
pages.

HTML
You can view an HTML file with a web browser. The information that
you export to an HTML file is formatted into a table.

3. Optional: Depending on how your web browser is configured, you can specify
the name and location of the generated file.

4. Click the save option to export the information to a file.
Related concepts:
“Viewing information about resources” on page 629
You can view detailed information about the resources that are monitored by Tivoli
Storage Productivity Center. Resources include storage systems, volumes, pools,
servers, hypervisors, fabrics, and switches. You can also view information about
internal and related resources.
“Customizing lists of resources, jobs, and alerts”
The web-based GUI uses lists to show information about resources, jobs, and
alerts. The information in each list is organized into columns and rows. You can
customize these lists by filtering information, sorting rows, and showing, hiding,
and reordering columns.

Customizing lists of resources, jobs, and alerts
The web-based GUI uses lists to show information about resources, jobs, and
alerts. The information in each list is organized into columns and rows. You can
customize these lists by filtering information, sorting rows, and showing, hiding,
and reordering columns.
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Filtering lists
You can filter the items that are shown in a list. Use filtering when you want to
limit the rows that are shown in a list based on values in a specific column or set
of columns. For example, when viewing alerts, you can filter the list so that only
alerts with a value of Warning in the Severity column are shown.
1. In the web-based GUI, go to a list of resources, jobs, or alerts that you want to

filter.

2. Click the Filter icon to determine how to filter the list. The following
options are available:

Filter by Default Columns
Select this option to apply the filter to the set of the default columns in
a list. Each list contains a set of default columns on which you can
filter.

For example, in the lists of alerts on the Home > Alerts page, select this
option to apply filter text to the following columns at the same time:
Condition, Severity, Alert Category, Resource, Internal Resource,
Total Occurrences, Alert Name.

Filter by a Specific Column
Select this option to apply filter text to a specific column in a list. For
example, on the Home > Alerts page, select the Condition column if
you want to apply filter text to values in that column only.

Restriction: Some columns in lists cannot be used for filtering and are not
shown under the Filter by a Specific Column option.

3. In Filter text box , type the text for filtering a list. You can
type letters, whole words, partial words, and numbers. When filtering on
certain columns, you can select from a list of values rather than typing in filter
text.
For example, when filtering on the Status column, you can select one of the
following values as the filter text: Error, Unreachable, Warning, Normal,
Unknown.

4. Press Enter to apply the filter to the list. Only rows with values that match or
partially match the filter text are shown.
For example, on the Home > Alerts page, if you select to filter on the Severity
column and type critical as the filter text, only alerts that have a severity of
critical and critical - acknowledged are shown in the list.

Tip: The name of a column to which a filter applies is shown next to the Filter
icon .

5. Optional: To remove the filtering for a list, click Reset.

Sorting lists
Each list of resources in the web-based GUI has a column or set of columns that
determines the order of its rows. You can sort the columns in a list to organize the
rows according to your requirements.

For example, the list of ports on a fabric is ordered by switch name, blade slot, and
port number, in that order. You can change the sort order of these columns to
organize a list of resources according to your requirements.
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Tip: A visual indicator is shown next to the primary column that determines
the sort order of a list.
1. In the web-based GUI, go to a list of resources, jobs, or alerts that you want to

sort.
2. Complete the following tasks to sort the rows in the list:

v To change whether the rows in a list are sorted by ascending or descending
order, click the name of the primary column in the heading row. Click the
name of the column again to reverse the sort order.

v To change the column that determines the sort order of resources, click the
name of that column. For example, click the Name column to sort the list of
resources alphabetically, or click the Status column to sort the list according
to the status of resources.

Tip: When you click a column other than the primary sort column, that
column becomes the new primary sort column. However, the previous
primary column maintains its sort order (ascending or descending).

For example, if a list of resources is ordered by the Name column in
ascending order and you click the Status column, the rows are sorted
according to the statuses of resources. At the same time, the resources for
each type of status are still sorted in ascending order by the Name column.
There is a maximum of three columns that can be sorted upon at the same
time.

3. Optional: To reset the order of the rows for a column to the default setting,
right-click the heading row in the list and select Reset Table Preferences.

Showing, hiding, and reordering columns in lists
Each list in the web-based GUI has a set of columns that contain information about
resources, jobs, or alerts. You can change the order of columns, show columns that
are hidden, and hide columns that are shown in these lists.
1. In the web-based GUI, go to a list of resources, jobs, or alerts that you want to

customize.
2. Complete the following tasks to customize the columns in the list:

v To show or hide the columns in a list, right-click any of the column headings
and select or clear the check box next to a column name.

v To change the order of columns, click a column heading and drag it to a new
position in the list.

Tip: The changes that you make to column settings are saved from session to
session.

3. Optional: To reset the order and display of columns to the default setting,
right-click any of the column headings and select Reset Table Preferences.
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Chapter 7. Managing replication

Manage replication components, including setting up the management servers,
adding storage connections and paths, creating sessions and copy sets, setting up
data replication, performing planned maintenance, and recovering from a disaster.

Administering
Administer IBM Tivoli Storage Productivity Center for Replication to authorize
users, start and use the graphical user interface (GUI), start and stop services, and
many other administrative tasks.

Starting and stopping Tivoli Storage Productivity Center for
Replication

Use these procedures to start and stop Tivoli Storage Productivity Center for
Replication, including the embedded WebSphere Application Server and DB2.

Starting Tivoli Storage Productivity Center for Replication
To start IBM Tivoli Storage Productivity Center for Replication, the embedded IBM
WebSphere Application Server instance must be started. WebSphere Application
Server is started by default after Tivoli Storage Productivity Center for Replication
is installed.

This topic contains references to WAS_HOME, which refers to the path for the Tivoli
Storage Productivity Center for Replication ewas directory. The path depends on
the operating system and the location of the Tivoli Storage Productivity Center for
Replication installation. The default path for Windows operating systems is
C:\Program Files\IBM\TPC\ewas. The default path for AIX and UNIX operating
systems is opt/IBM/TPC/ewas.

Starting Tivoli Storage Productivity Center for Replication on Windows:
You can start Tivoli Storage Productivity Center for Replication from the desktop
or from the command line.

From the desktop, start the WebSphere Application Server service by using the
Windows Services interface.

From the command line, issue the following command:
WAS_HOME/profiles/ReplicationServerProfile/bin/
startServer.bat ReplicationServer

Starting Tivoli Storage Productivity Center for Replication on AIX or Linux:
To start Tivoli Storage Productivity Center for Replication, issue the following
command from the command line:
WAS_HOME/profiles/ReplicationServerProfile/bin/
startServer.sh –username user_name –password password ReplicationServer

Where user_name and password are your WebSphere Application Server user name
and password.

Starting Tivoli Storage Productivity Center for Replication on z/OS:
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If you use IBM WebSphere Application Server OEM Edition for z/OS with IBM
Tivoli Storage Productivity Center for Replication for System z, see the IBM
WebSphere Application Server OEM Edition for z/OS Configuration Guide to start Tivoli
Storage Productivity Center for Replication for System z.

If you use WebSphere Application Server for z/OS, complete the following steps to
start Tivoli Storage Productivity Center for Replication for System z:
1. Ensure that the WebSphere Application Server hierarchical file system (HFS),

IBM DB2 HFS, and Tivoli Storage Productivity Center for Replication for
System z HFS are all mounted on the UNIX System Services. The root
installation directory for Tivoli Storage Productivity Center for Replication for
System z is path_prefix/usr/lpp/Tivoli/RM. The root production directory is
path_prefix/opt/lpp/Tivoli/RM.

2. Obtain the symbolic link for the was.env file. The symbolic link is in the format
cell_short_name.node_short_name.server_short_name. For example,
SYS7.SYS7.BBOS001. To get the symbolic link, complete the following steps:
a. Issue the TSO ISH command to start the Interactive System Productivity

Facility (ISPF) shell.
b. Enter the path for the was.env file. For example, path_prefix/zWebSphere/

version/config1.
c. Find the symbolic link to the was.env file. This is the value that is required

for the ENV parameter in the following step.
3. Issue the command from the IBM z/OS System Display and Search Facility

(SDSF) panel to start the WebSphere Application Server, as shown in the
following example. The address spaces that are shown might be different in
your environment.
/START BBO6ACR,JOBNAME=BBOS001,ENV=was.env_symbolic_link

The initiator is BB06ACR, and the job name is BBOS001. When you start the
BB06ACR address space, the BBODMNB address space also starts.

Stopping Tivoli Storage Productivity Center for Replication
To stop IBM Tivoli Storage Productivity Center for Replication, you must stop the
embedded IBM WebSphere Application Server instance.

This topic contains references to WAS_HOME, which refers to the path for the Tivoli
Storage Productivity Center for Replication ewas directory. The path depends on
the operating system and the location of the Tivoli Storage Productivity Center for
Replication installation. The default path for Windows operating systems is
C:\Program Files\IBM\TPC\ewas. The default path for AIX and UNIX operating
systems is opt/IBM/TPC/ewas.

Stopping Tivoli Storage Productivity Center for Replication on Windows:
You can stop Tivoli Storage Productivity Center for Replication from the desktop
or from the command line.

From the desktop, stop the WebSphere Application Server service from the
Windows Services interface.

From the command line, issue the following command:
WAS_HOME/profiles/ReplicationServerProfile/bin/
stopServer.bat ReplicationServer

Stopping Tivoli Storage Productivity Center for Replication on AIX or Linux:
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To stop Tivoli Storage Productivity Center for Replication, issue the following
command from the command line:
WAS_HOME/profiles/ReplicationServerProfile/bin/
stopServer.sh –username user_name –password password ReplicationServer

Where user_name and password are your WebSphere Application Server user name
and password.

Stopping Tivoli Storage Productivity Center for Replication on z/OS:
If you use IBM WebSphere Application Server OEM Edition for z/OS with IBM
Tivoli Storage Productivity Center for Replication for System z, see the IBM
WebSphere Application Server OEM Edition for z/OS Configuration Guide to stop Tivoli
Storage Productivity Center for Replication for System z.

If you use WebSphere Application Server for z/OS, complete the following steps to
stop Tivoli Storage Productivity Center for Replication for System z:
1. Issue commands from the IBM z/OS System Display and Search Facility (SDSF)

panel to stop the WebSphere Application Server for z/OS daemon, as shown in
the following example commands. The address spaces that are shown might be
different in your environment.
/STOP BBOS001

/STOP BBODMNB

Where /STOP BBOS001 stops the server address space and /STOP BBODMNB
stops the WebSphere Application Server for z/OS daemon address space.

2. Issue the /D A,L command to display the processes that are running and verify
that the stop command completed. If the BBOS001 or BBODMNB address
spaces are displayed, issue the /CANCEL command for each address space.

Verifying that components are running
This information describes how to verify that the IBM Tivoli Storage Productivity
Center for Replication components are running.

Verifying that WebSphere Application Server is running
The method that you use to verify that IBM WebSphere Application Server is
running in your environment depends on the operating system. By default, the
WebSphere Application Server is started automatically after IBM Tivoli Storage
Productivity Center for Replication is installed.

Verifying that WebSphere Application Server is running on Windows:
To verify that IBM WebSphere Application Server is running, open the Windows
Services interface and check the status of the WebSphere Application Server
service.

Verifying that WebSphere Application Server is running on AIX or Linux:
To verify that WebSphere Application Server is running, issue the ps command.

Verifying that WebSphere Application Server is running on z/OS:
To verify that WebSphere Application Server is running, use the IBM z/OS System
Display and Search Facility (SDSF) panel to issue the /D A,L command.

If the server and daemon address spaces for IBM WebSphere Application Server
for z/OS are started, for example BBOS001 and BBODMNB, then WebSphere
Application Server for z/OS is running.
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If the server and daemon address spaces for IBM WebSphere Application Server
OEM Edition for z/OS are started, for example WASOM1S, WASOM1, and
WASOM1D, then WebSphere Application Server OEM Edition for z/OS is running.

Verifying that the IBM Tivoli Storage Productivity Center for
Replication server is running
This information describes how to verify whether the IBM Tivoli Storage
Productivity Center for Replication server is running.

Perform one or more of these tasks to determine whether the IBM Tivoli Storage
Productivity Center for Replication server is running:
v Start the IBM Tivoli Storage Productivity Center for Replication GUI or start up

the IBM Tivoli Storage Productivity Center for Replication command line
interface shell. If either of these methods is successful, then the IBM Tivoli
Storage Productivity Center for Replication server is running.

v Determine whether IBM WebSphere Application Server is running. If IBM
WebSphere Application Server is not running, then the IBM Tivoli Storage
Productivity Center for Replication server is also not running.

v If IBM WebSphere Application Server is running, perform these steps to
determine if IBM Tivoli Storage Productivity Center for Replication is configured
correctly in IBM WebSphere Application Server:
1. From a command prompt, change to the WAS_HOME/profiles/

ReplicationServerProfile/bin directory.
2. Enter the wsadmin command.
3. Enter the$AdminApp list command.

If you see CSM and CSMGUI in the resulting list, then IBM Tivoli Storage
Productivity Center for Replication is configured correctly.

v View the csmTrace.log file in the WAS_HOME/profiles/
ReplicationServerProfile/logs/CSM directory. If the csmTrace.log is being
updated regularly and increasing in size, then IBM Tivoli Storage Productivity
Center for Replication is running.

Identifying the version of IBM Tivoli Storage Productivity
Center for Replication

The version of code on the IBM Tivoli Storage Productivity Center for Replication
server determines the available features and enhancements added to the product.

By clicking About, located in the Main menu, you can view the version and release
of the IBM Tivoli Storage Productivity Center for Replication. The -ver command
that is described in the IBM Tivoli Storage Productivity Center Command-Line Interface
Reference also displays the current version of the product.

Backing up and restoring IBM Tivoli Storage Productivity
Center for Replication configuration data

You can back up the entire IBM Tivoli Storage Productivity Center for Replication
database. You can also back up copy sets in a specific session. You can then use the
backup files to restore a previous configuration or recover from a disaster.

Back up and recovery
You can backup and recover copy set data for a specific session and the complete
Tivoli Storage Productivity Center for Replication database.
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Copy sets

You can export data about all copy sets in a specific session to maintain a backup
copy that you can use to recover if you lose the session or to upgrade to a different
management server.

When exporting copy sets, Tivoli Storage Productivity Center for Replication
creates a backup of the session and saves the data in a comma separated value
(CSV) file, which you can view or edit in a spreadsheet program such as Microsoft
Excel. The exported CSV file includes the session name, session type, date that the
data was exported, and the copy sets for each role pair. There is one line per copy
set, and the volumes in the copy set are separated by a comma (for example:
ESS:2105.FCA57:VOL:17C7,ESS:2105.12043:VOL:17C7).

The following example illustrates the content of the CSV file for a FlashCopy
session. Note that the first valid row must contain the appropriate role names for
the session. The order of the copy sets does not matter, and you can include extra
roles. A copy set is created from each row that follows the role names. All rows
must have data in each column to be a valid row. Note that the number sign (#)
indicates that the line is a comment. Lines that are comments are ignored.
#Session1,
#FlashCopy,
#Oct 2, 2009 10:03:18 AM

H1,T1
DS8000:2107.FRLL1:VOL:1004,DS8000:2107.FRLL1:VOL:1104
DS8000:2107.FRLL1:VOL:1011,DS8000:2107.FRLL1:VOL:1101
DS8000:2107.FRLL1:VOL:1005,DS8000:2107.FRLL1:VOL:1105

Important: You must manually save this file on the local system when you export
copy sets from the Tivoli Storage Productivity Center for Replication Web interface.

IBM Tivoli Storage Productivity Center for Replication database

Tivoli Storage Productivity Center for Replication database contains all product
data, including data about storage systems, sessions, copy sets, paths, user
administration and management servers. You can back up this data and use the
backup file to recover from a disaster or restore a previous configuration.

Important: You must have Administrator privileges to back up and recover the
database.

The current data is stored in a new file each time you create a backup. The backup
file is named yyyyMMdd_HHmmssSSS.zip, where yyyy is the year, MM is the month,
dd is the day, HH is the hour, mm is the minute, ss is the seconds, SSS is the
milliseconds when the backup command was run. It is your responsibility to delete
backup versions that are no longer needed.

By default, the backup file is stored in the WAS_HOME/profiles/
ReplicationServerProfile/database/backup directory. You can change the default
location by editing the db.backup.location property in the rmserver.properties
file, which is located in the WAS_HOME/profiles/ReplicationServerProfile/
properties directory.

The backup file contains the Tivoli Storage Productivity Center for Replication
database data at the time the backup was performed. Any changes that were made
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after the backup are not reflected when the backup files are used to restore an
Tivoli Storage Productivity Center for Replication database. It is recommended that
you create a new backup file:
v After changing the Tivoli Storage Productivity Center for Replication database

data, such as adding or deleting a storage system, changing properties, and
changing user privileges

v After an Tivoli Storage Productivity Center for Replication session changes
direction. For example, if a Metro Mirror session was copying data from H1 to
H2 when the backup was taken, and later, the session was started in the H2 to
H1 direction. The session must be in the Prepared state before you create the
backup.

v After a site switch has been declared and the Enable Copy To Site command has
been issued. After you create a backup, consider deleting the previous backup to
prevent Tivoli Storage Productivity Center for Replication from starting the copy
in the wrong direction.

When you create a backup, ensure that all Tivoli Storage Productivity Center for
Replication sessions are either in the Defined, Prepared or Target Available state.

Restoring the Tivoli Storage Productivity Center for Replication database from a
backup copy puts Tivoli Storage Productivity Center for Replication back to the
point in time when the backup was made. Relationships that exist on the storage
systems that were created by Tivoli Storage Productivity Center for Replication
after the backup was made will no longer be managed by Tivoli Storage
Productivity Center for Replication until you add the copy set to the session and
Tivoli Storage Productivity Center for Replication assimilates the relationship into
the session. Copy sets that were deleted after the backup will be restored and a
subsequent Start command to the session will create new relationships; therefore,
you must remove the deprecated copy sets before issuing the Start command.

After restoring a Global Mirror session, you must stop the Global Mirror master
and subordinates before restarting the Global Mirror session. Refer to your DS6000
and DS8000 storage system documentation for more information.

Backing up the IBM Tivoli Storage Productivity Center for
Replication database
This topic describes how to create a backup of the IBM Tivoli Storage Productivity
Center for Replication database, including data about storage systems, sessions,
copy sets, user administration and management server configuration.

To back up the IBM Tivoli Storage Productivity Center for Replication database,
run the mkbackup command from the command line, for example:
csmcli> mkbackup

Prerequisites:

v You must have Administrator privileges to run this command.
v This procedure applies to only the zero-administration embedded repository.

This procedure is not applicable when DB2 is being used as the persistent
datastore for the IBM Tivoli Storage Productivity Center for Replication
database. For information about restoring your DB2 environment, refer to your
DB2 documentation.

By default, the backup file is stored in the WAS_HOME/profiles/
ReplicationServerProfile/database/backup directory. You can change the default

662 IBM Tivoli Storage Productivity Center: User's Guide



location by editing the db.backup.location property in the rmserver.properties
file, which is located in the WAS_HOME/profiles/ReplicationServerProfile/
properties directory.

Restoring the IBM Tivoli Storage Productivity Center for
Replication database
You can restore IBM Tivoli Storage Productivity Center for Replication database
that was previously backed up to the local system.

Important:

v Restoring the database does not require Administrator privileges. However, you
must be able to access the files on the IBM Tivoli Storage Productivity Center for
Replication server that are listed in the procedure.

v This procedure applies to only the zero-administration embedded repository.
This procedure is not applicable when DB2 is being used as the persistent
datastore for the IBM Tivoli Storage Productivity Center for Replication
database. For information about restoring your DB2 environment, refer to your
DB2 documentation.

Perform these steps to restore the IBM Tivoli Storage Productivity Center for
Replication database from a backed up version:
1. Stop IBM Tivoli Storage Productivity Center for Replication on the active

management server by running the stopServer command from a command
line.

2. Delete the WAS_HOME/profiles/ReplicationServerProfile/database/csmdb
directory and all contents in it.

3. Uncompress the backup file into the WAS_HOME/profiles/
ReplicationServerProfile/database directory.

4. If IBM Tivoli Storage Productivity Center for Replication is running on z/OS,
change the permissions of the csmdb directory by running the following
commands:
v chgrp -R $WAS_GROUP csmdb
v chmod -R u+rwx csmdb
v chmod -R g+rwx csmdb
v chmod -R o+r csmdb

5. Restart IBM Tivoli Storage Productivity Center for Replication on the active
management server by running the startServer command from a command
line.

6. Resolve any changes that might have occurred since the backup was created.
7. Start the IBM Tivoli Storage Productivity Center for Replication sessions using

the appropriate start commands. The start commands reestablishe the
relationship between the volume pairs and synchronize data on those volumes.

8. If you have a standby management server, reestablish that standby relationship
to update the database on the standby server.

Exporting copy set data
You can export data about all copy sets in a specific session, to maintain a backup
copy that can be used to recover if you lose your session or upgrade to a different
server.

Perform these steps to export the copy sets in a specific session:
1. In the navigation tree, select Sessions. The Sessions panel is displayed
2. Select the session for which you want to export copy sets.
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3. Select Export Copy Sets from the Actions list, and click Go. The Export Copy
Set wizard displays the status of the export and a link to the exported file.

4. Click that link and save the file to the local system.

Important: You must save the file to your local system. After you close the
panel, the data will be lost.

5. Click Finish.

Importing copy set data
You can import copy set data that was previously exported to a comma separated
value (CSV) file.

Perform the following steps to import copy sets into an existing session:
1. In the navigation tree, select Sessions. The Session panel is displayed.
2. Select the session for which you want to import copy sets.
3. Select Add Copy Sets from the Actions list, and click Go. The Add Copy Sets

wizard is displayed.
4. Select Use a CSV file to import copy sets.
5. Type the location and name of the CSV file to import, or use Browse to select

the file. Then, click Next.
6. Verify that the matching results were successful, and then click Next.
7. Select the copy sets you want to add, and then click Next.
8. Confirm the number of copy sets that you want to create, and click Next. A

progress bar displays.
9. Click Next.

10. Verify the matches, and click Finish.

Managing management servers
This section provides information about how to set up active and standby
management servers, restore a lost connection between the management servers, or
perform a takeover on the standby management server.

Management servers
The management server is a system that has IBM Tivoli Storage Productivity Center
for Replication installed. The management server provides a central point of
control for managing data replication.

You can create a high-availability environment by setting up a standby management
server. A standby management server is a second instance of Tivoli Storage
Productivity Center for Replication that runs on a different physical system, but is
continuously synchronized with the primary (or active) Tivoli Storage Productivity
Center for Replication server. The active management server issues commands and
processes events, while the standby management server records the changes to the
active server. As a result, the standby management server contains identical data to
the active management server and can take over and run the environment without
any loss of data. If the active management server fails, you can issue the Takeover
command to make the standby management server take over.
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Connecting the active management server to the standby
management server

Ensure that the active management server is connected to the standby management
server. This connection creates the management server relationship that begins the
synchronization process. Each management server can be in only one management
server relationship.

A management server relationship might become disconnected for a number of
reasons, including a connectivity problem or a problem with the alternate server.
Issue the Reconnect command to restore synchronization.

Performing a takeover on the standby management server

If you must perform a takeover and use the standby server, ensure that you shut
down the active management server first. You must ensure that you do not have
two active management servers. If there are two active management servers and a
condition occurs on the storage systems, both management servers respond to the
same conditions, which might lead to unexpected behavior.

If you perform an action on the active management server when the servers are
disconnected, the servers will be out of synch.

Viewing the status of the management servers

You can view the status of the active and standby management severs from the
Management Servers panel in the Tivoli Storage Productivity Center for
Replication graphical user interface (GUI). If you are logged on to the active
management server, the icons on this panel show the status of the standby
management server. If you are logged on to the standby management server, the
icons on this panel show the status of the active management server.

When the status is Synchronized, the standby management server contains the
same data that the active management server contains. Any update to the active
management server database is replicated to the standby server database.

Managing volumes on storage systems

When you add direct connections, Hardware Management Console (HMC)
connections, or z/OS connections on the active management server, Tivoli Storage
Productivity Center for Replication automatically enables the management of
attached extended count key data (ECKD™) volumes, non-attached count key data
(CKD) volumes, and all fixed-block volumes on the storage system. To disable
management of volumes on the storage system, use the volume protection
function.

Information specific to management servers in z/OS
environments

If the standby management server is not in the active server z/OS sysplex, the
standby server is not be able to communicate with the storage systems using a
z/OS connection; therefore, another connection must be made using a TCP/IP
connection.

If DB2 is configured for data sharing mode across the z/OS sysplex, one of the
Tivoli Storage Productivity Center for Replication servers must be configured to
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use the zero-administration embedded repository. If the embedded repository is
not used, the two servers will overwrite the same data in the Tivoli Storage
Productivity Center for Replication database.

SNMP alerts
This topic describes the SNMP alerts that are sent by IBM Tivoli Storage
Productivity Center for Replication and the associated object IDs (OIDs).

SNMP alerts are sent during the following general events:
v Session state change
v Configuration change
v Suspending-event notification
v Communication failure
v Management Server state change

Session state change SNMP trap descriptions
This topic lists the SNMP traps that are sent during a session state change. A
different trap is sent for each state change. These alerts are sent by only the active
management server.

A session state change SNMP trap is sent each time the session changes to one of
the following states:
v Defined
v Preparing
v Prepared
v Suspended
v Recovering
v Flashing
v Target Available
v Suspending
v (Metro Global Mirror only) SuspendedH2H3
v (Metro Global Mirror only) SuspendedH1H3

An SNMP trap is also sent when a recovery point objective (RPO) threshold is
exceeded for a role pair that is in the session.

Table 54. Session state change traps

Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.1 The state of session X has transitioned to Defined.

1.3.6.1.4.1.2.6.208.0.2 The state of session X has transitioned to Preparing.

1.3.6.1.4.1.2.6.208.0.3 The state of session X has transitioned to Prepared.

1.3.6.1.4.1.2.6.208.0.4 The state of session X has transitioned to Suspended.

1.3.6.1.4.1.2.6.208.0.5 The state of session X has transitioned to Recovering.

1.3.6.1.4.1.2.6.208.0.6 The state of session X has transitioned to Target Available.

1.3.6.1.4.1.2.6.208.0.19 The state of session X has transitioned to Suspending.

1.3.6.1.4.1.2.6.208.0.20 The state of session X has transitioned to SuspendedH2H3.

1.3.6.1.4.1.2.6.208.0.21 The state of session X has transitioned to SuspendedH1H3.

1.3.6.1.4.1.2.6.208.0.22 The state of session X has transitioned to Flashing.

1.3.6.1.4.1.2.6.208.0.23 The state of session X has transitioned to Terminating.

1.3.6.1.4.1.2.6.208.0.26 The recovery point objective for the role pair of X in
session Y has passed the warning threshold of Z seconds.
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Table 54. Session state change traps (continued)

Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.27 The recovery point objective for the role pair of X in
session Y has passed the severe threshold of Z seconds.

Related reference:
“Session states” on page 769
You can view the health and status of a session in the Tivoli Storage Productivity
Center for Replication GUI.
“Session properties” on page 771
You can view and modify the description and options for a session. The options
that are presented depend on the storage system type and the session type that
you select.

Configuration change SNMP trap descriptions
This topic lists the SNMP traps that are sent when the configuration changes.
These alerts are sent by only the active management server.

Configuration change SNMP traps are sent after the following configurations
changes are made:
v One or more copy sets have been added or deleted from a session

An alert is sent for each set of copy sets added to or removed from a session.
Note that an alert for copy set changes is sent only once within 15 minutes of a
configuration change, so you might not see alerts from successive changes that
occur within that 15-minute period. For example, if you make a copy set
configuration change that causes an alert to be sent at 10:41:01, and if you were
to make additional copy set changes at 10:42:04 and 10:50:09, no alerts would be
sent for these two changes because they occurred within the 15-minute
minimum interval from the first alert.

v PPRC path definitions have been changed
An alert is sent for each path configuration change made.

Table 55. Configuration change traps

Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.7 One or more copy sets have been added or deleted from this
session.
Note: An event is sent for each session at least every 15 minutes.

1.3.6.1.4.1.2.6.208.0.8 Peer-to-Peer Remote Copy (PPRC) path definitions have been
changed. An event is sent for each path configuration change.

Suspending-event notification SNMP trap descriptions
These SNMP traps that are sent during a suspending-event notification. The traps
are sent by the active and standby management server.

Suspending-event notification SNMP traps indicate that a session has transitioned
to a Severe status due to an unexpected error.

Table 56. Suspending-event notification traps

Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.9 The session is in a Severe state due to an unexpected error.
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Communication-failure SNMP trap descriptions
This topic lists the SNMP traps that are sent during a communication-failure. These
alerts are sent by both the active and standby management servers.

Communication-failure SNMP traps are sent after the following events occur:
v A server times out attempting to communicate with a storage system.
v A server encounters errors attempting to communicate with a storage system.
v An active server terminates communication with a standby server as a result of

communication errors.
v A standby encounters communication errors with an active server.

After an SNMP trap for a given failure is sent, it is not resent unless
communication has been reestablished and failed again.

Table 57. Communication-failure traps

Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.10 Server X has timed out attempting to communicate with storage
system Y.

1.3.6.1.4.1.2.6.208.0.11 Server X has encountered errors attempting to communicate with
storage system Y.

1.3.6.1.4.1.2.6.208.0.12 Active server X has terminated communication with standby
server Y as a result of communication errors.

1.3.6.1.4.1.2.6.208.0.13 Standby server X has encountered communication errors with
active server Y.

Management Servers state-change SNMP trap descriptions
This topic lists the SNMP traps that are sent when the state of the management
server changes. These alerts are sent by both the active and standby management
servers.

A management server state change SNMP trap is sent each time the management
server changes to one of the following states:
v Unknown
v Synchronization Pending
v Synchronized
v Disconnected Consistent
v Disconnected

Table 58. Management Servers state-change traps

Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.14 The IBM Tivoli Storage Productivity Center for Replication Server
Management Server connection X->Y has changed state to
Unknown (previously Offline).

1.3.6.1.4.1.2.6.208.0.15 The IBM Tivoli Storage Productivity Center for ReplicationServer
Management Server connection X->Y has changed state to
Synchronized.

1.3.6.1.4.1.2.6.208.0.16 The IBM Tivoli Storage Productivity Center for Replication Server
Management Server connection X->Y has changed state to
Disconnected Consistent (previously Consistent Offline).
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Table 58. Management Servers state-change traps (continued)

Object ID (OID) Description

1.3.6.1.4.1.2.6.208.0.17 The IBM Tivoli Storage Productivity Center for Replication Server
Management Server connection X->Y has changed state to
Synchronization Pending.

1.3.6.1.4.1.2.6.208.0.18 The IBM Tivoli Storage Productivity Center for Replication Server
Management Server connection X->Y has changed state to
Disconnected.

Setting up a standby management server
You can set up a standby management server in two ways: setting up the
management server you are logged in to as the standby management server, or
designating another server as the standby management server.

Note: When you define a standby management server, the IBM Tivoli Storage
Productivity Center for Replication code must be at the same level on both the
standby and active management servers.

Setting the local management server as the standby server
This topic describes how to set the management server on which you are currently
logged in as the standby management server.

Attention: When you set the local management server, the server you are logged
in at will be wiped of all session information, and replaced with the session
information belonging to the server you specified.

Important: The standby management server port number must be the same on
both the management server and the standby management server in a
high-availability relationship. If you change the standby management server port
number on either the management server or the standby management server, you
must also change the port number on the other server.

Perform these steps to set the local management server as the standby server:
1. In the navigation tree, select Management Servers.
2. From the Action menu, select Set This Server as Standby, and click Go. This

opens the Set This Server As Standby panel.
3. Enter the domain name or IP address of the desired active management server.
4. Click OK to connect to the active server. You have now designated the server

you are logged in at as the standby server.

Setting a remote management server as the standby server
This topic describes how to set up a management server on which you are not
logged in as the standby server.

Attention: When you set a remote management server as the standby server, the
remote management server is wiped of all session information and replaced with
the session information belonging to the management server you specified.

Important: The standby management server port number must be the same on
both the management server and the standby management server in a
high-availability relationship. If you change the standby management server port
number on either the management server or the standby management server, you
must also change the port number on the other server.

Chapter 7. Managing replication 669



Perform these steps to set a remote management server as the standby server:
1. In the navigation tree, select Management Servers.
2. Select Define Standby from the drop-down menu, and click Go. The Define

Standby panel appears.
3. Type the domain name or IP address of the server that you are defining as the

new standby management server. Log in to the standby management server by
entering the username and password.

4. Click OK to connect to the standby management server.

Applying maintenance to an active management server
If an active management server develops a problem during an active session, you
can reinstall Tivoli Storage Productivity Center for Replication on the server
without affecting the session.

Follow these steps to reinstall Tivoli Storage Productivity Center for Replication on
the active management server.
1. If the heartbeat is enabled, disable it:

a. In the navigation tree, select Advanced Tools.
b. Click Disable Heartbeat.

2. On the standby server, Server 2, issue a take-over. This makes Server 2 the
active server. It is possible that the original active server, Server 1, is still listed
on the Server 2 Management Servers page. If so, select Remove Standby.

3. Disable the heartbeat on Server 2, in case there are any problems.
4. Uninstall Tivoli Storage Productivity Center for Replication on Server 1.
5. Reinstall Tivoli Storage Productivity Center for Replication on Server 1.

Note: If no changes have been made to the configuration while Server 1 was
being reinstalled, steps 6 and 7 are not necessary.

6. When Tivoli Storage Productivity Center for Replication is running on Server
1, log into Server 2 and set Server 1 as the standby server for Server 2.
This step copies the configuration from Server 2 to Server 1. This process takes
a few minutes.

7. When the management servers status is synchronized, issue a take-over on
Server 1.
This makes Server 1 an active server, able to control sessions.

Note: It is possible that Server 2 is still listed on the Server 1 Management
Servers page. If this is the case, select Remove Standby.

8. Disable the heartbeat on Server 1 to make sure this active server does not
have any problems.

Note: If you do not need to reinstall Tivoli Storage Productivity Center for
Replication on Server 2, skip steps 9 and 10.

9. Uninstall Tivoli Storage Productivity Center for Replication from Server 2.
10. Reinstall Tivoli Storage Productivity Center for Replication on Server 2.
11. On Server 2, go to the Management Servers page and select the Set This

Server As Standby option, entering the information for Server 1. When this
step is complete, Server 1 is the active server, and Server 2 is the standby
server.
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12. When you are confident that the active server is running without any
problems, enable the heartbeat again, if desired.

Reconnecting the active and standby management servers
If the active and standby management servers become disconnected, reestablish
that connection.

Perform these steps to cause the standby management server to become the active
management server:
1. In the navigation tree, select Management Servers. The Management Servers

panel is displayed.
2. Select Reconnect from the Actions list, and click Go.

Performing a takeover on the standby management server
If the active management server fails, you can force the standby management
server to take over monitoring and managing replication responsibilities.

Important: If the current active management server is still active, you must not
attempt to control the replication environment simultaneously from both
management servers. Instead, either reconfigure the current active management
server to be a standby management server, or shut it down.

Perform these steps to cause the standby management server to become the active
management server:
1. If the active management server is functioning, take it offline so you do not

have two active management servers managing the same sessions.
2. Log in to the IBM Tivoli Storage Productivity Center for Replication Web

interface running on the standby management server.
3. In the navigation tree, select Management Servers. The Management Servers

panel is displayed.
4. Select Takeover from the Actions list, and click Go.
5. To reestablish high-availability, perform one of these steps:

v Choose another server to be the standby management server. See instructions
for setting up a standby management server.

v Bring the failed management server back online, and then make that server
the standby management server. See “Setting up a standby management
server” on page 669.

v Bring the failed management server back online, and then make that server
the active management server to return to the original configuration. Repeat
the steps in this section and then add the original standby server as the
standby server.

Important: Do not use the Reconnect command if you perform a takeover. You
would use the Reconnect command when the active server loses its connection
with the standby server; it reconnects the two servers. Do not use the Reconnect
command after a takeover to reconnect to the original active server.

Configuring SNMP
The SNMP community name has a default value of public.
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To change the community name, modify or add the
csm.server.snmp_community_string property in the rmserver.properties file,
which is located in the WAS_HOME/profiles/ReplicationServerProfile/properties
directory.

Adding SNMP managers
Use the mksnmp command to add an SNMP manager to the list of servers to
which IBM Tivoli Storage Productivity Center for Replication sends SNMP alerts.

IBM Tivoli Storage Productivity Center for Replication uses management
information base (MIB) files to provide a textual description of each SNMP alert
sent by IBM Tivoli Storage Productivity Center for Replication. You must configure
the SNMP manager to use both the SYSAPPL-MIB.mib and ibm-TPC-Replication.mib
files. These MIB files are located in the WAS_HOME/profiles/
ReplicationServerProfile/etc directory. Follow the directions provided by your
SNMP manager application to configure it to use the MIB files.

Tip: You can also find the MIB files on the installation DVD in the
TPCRM/CSM-Client/etc directory.

Note: IBM Tivoli Storage Productivity Center for Replication sends all SNMP alerts
to each registered SNMP manager. SNMP alerts are not specific to any particular
session, and all alerts for any session are sent. You cannot choose to send a subset
of SNMP alerts.

Changing the standby management server port number
The standby management server port is used is used for communication between
the active and standby management server. This port is initially defined during the
installation. You can manually change this port after installation.

Important: The standby management server port number must be the same on
both the management server and the standby management server in a
high-availability relationship. If you change the standby management server port
number on either the management server or the standby management server, you
must also change the port number on the other server.
1. Open the rmserver.properties file in the WAS_HOME/profiles/

ReplicationServerProfile/properties directory.
2. Modify the port number for the following property:

communications.haPort=port_number

3. Restart IBM Tivoli Storage Productivity Center for Replication. You must restart
IBM Tivoli Storage Productivity Center for Replication to activate property
changes. Properties are not synchronized between the IBM Tivoli Storage
Productivity Center for Replication management servers and must be done on
each IBM Tivoli Storage Productivity Center for Replication management
server.

Changing the client port number
The client port is used to log in to the graphical user interface and command line
interface from a remote system. This port is initially defined during the
installation. You can manually change this port after installation.

Important: The client port number must be the same on both the management
server and the standby management server in a high-availability relationship. If
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you change the client port number on either the management server or the standby
management server, you must also change the port number on the other server.
1. Open the rmserver.properties file in the WAS_HOME/profiles/

ReplicationServerProfile/properties directory.
2. Modify the port number for the following property:

communications.port=port_number

3. Open the repcli.properties file in the install_root/cli directory.
4. Modify the port number for the following property:

port=port_number

5. Restart IBM Tivoli Storage Productivity Center for Replication. You must restart
IBM Tivoli Storage Productivity Center for Replication to activate property
changes. Properties are not synchronized between the IBM Tivoli Storage
Productivity Center for Replication management servers and must be
maintained on each IBM Tivoli Storage Productivity Center for Replication
management server.

Managing storage systems
To replicate data among storage systems using IBM Tivoli Storage Productivity
Center for Replication, you must add connections to the storage systems. After a
storage system is added, you can associate a location, modify connection
properties, set volume protection, and refresh the storage configuration for that
storage system.

Storage systems
A storage system is a hardware device that contains data storage. Tivoli Storage
Productivity Center for Replication can control data replication within and between
various storage systems.

To replicate data among storage systems using Tivoli Storage Productivity Center
for Replication, you must manually add a connection to each storage system in the
Tivoli Storage Productivity Center for Replication configuration. This allows you to
omit storage systems for which Tivoli Storage Productivity Center for Replication
is not to manage replication and omit storage systems that are being managed by
another Tivoli Storage Productivity Center for Replication management server.

For redundancy, you can connect a single storage system using a combination of
direct, Hardware Management Console (HMC), and z/OS connections.

You can use the following storage systems:
v IBM TotalStorage Enterprise Storage Server (ESS) Model 800
v IBM System Storage DS6000
v IBM System Storage DS8000
v IBM System Storage SAN Volume Controller
v IBM Storwize V7000
v IBM Storwize V7000 Unified
v IBM XIV Storage System

A System Storage SAN Volume Controller or Storwize V7000 can virtualize a
variety of storage systems. Although Tivoli Storage Productivity Center for
Replication does not support all storage systems, you can manage these storage
systems through a single System Storage SAN Volume Controller or Storwize
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V7000 cluster interface. Tivoli Storage Productivity Center for Replication connects
directly to the System Storage SAN Volume Controller or Storwize V7000 clusters.

You can define a location for each storage system and for each site in a session.
When adding copy sets to the session, only the storage systems whose location
matches the location of the site are allowed for selection. This ensures that a
session relationship is not established in the wrong direction.

Notes:

v Tivoli Storage Productivity Center for Replication does not automatically
discover the physical locations of storage systems. You can manually assign a
location to a storage system from the GUI and CLI.

v Throughout this document, ESS/DS refers to the following models:
– IBM TotalStorage Enterprise Storage Server Model 800
– IBM System Storage DS8000
– IBM System Storage DS6000

Storage connections
You must create a connection from the IBM Tivoli Storage Productivity Center for
Replication management server to each storage system. You can connect either
directly or through a Hardware Management Console (HMC) or IBM z/OS
connection.

A single storage system can be connected using multiple connections for
redundancy. For example, you can connect a IBM System Storage DS8000 storage
system using an HMC connection and a z/OS connection. Tivoli Storage
Productivity Center for Replication monitors how a storage system has been added
to the configuration.

When you add a storage connection to the Tivoli Storage Productivity Center for
Replication configuration, the storage system and the connection are added to the
active management server configuration. For direct and HMC connections, the
storage system and connection are also added to the standby management server
configuration. For z/OS connections, only the storage system is added to the
standby management server configuration. The connection is not added because
the standby management server might not be running on z/OS and might not
have access to the volumes on the storage system through a z/OS connection.

The storage systems are not required to be connected to the standby management
server. However, if a storage system does not have a connection on the standby
management server, you cannot manage copy services on the storage system from
the standby server.

Important: If the Metro Mirror heartbeat is enabled, do not connect to a IBM
TotalStorage Enterprise Storage Server Model 800, System Storage DS8000, or
System Storage DS6000 storage system using both an HMC connection and a direct
connection. If you have both types of connections and the direct connection is lost,
the session changes to the suspended state even though the HMC connection is
still valid. If both connections are lost and the session is in the suspended state,
restart the session when connectivity is regained to synchronize the session with
the hardware.

When Tivoli Storage Productivity Center for Replication is running on z/OS and a
storage system is added to the Tivoli Storage Productivity Center for Replication
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configuration through a TCP/IP (direct or HMC) connection, all ECKD volumes
that are attached to the management server are managed through the TCP/IP
connection. To use the Fibre Channel connection, you must explicitly add the
storage system to the Tivoli Storage Productivity Center for Replication
configuration through a z/OS connection.

If a storage system was previously added to the Tivoli Storage Productivity Center
for Replication configuration through a z/OS connection and later the storage
system is added through a TCP/IP connection, all non-attached ECKD volumes
and fixed block volumes are added to the Tivoli Storage Productivity Center for
Replication configuration.

When you remove a storage system, Tivoli Storage Productivity Center for
Replication automatically removes all connections that the storage system is using
with exception of the z/OS connection. You can also individually remove each
connection through which the storage system is connected.

If Tivoli Storage Productivity Center for Replication has multiple connections to a
specific storage system, the order in which you remove the connections produces
different results:
v If you remove all direct and HMC connections first, the fixed block and

non-attached ECKD volumes are removed from the Tivoli Storage Productivity
Center for Replication configuration. The remaining ECKD volumes that are
attached through the z/OS connection remain in the Tivoli Storage Productivity
Center for Replication configuration until the z/OS connection is removed.
Removing the TCP/IP connection also disables the Metro Mirror heartbeat.

v If you remove the z/OS connection first and if there is an HMC or direct
connection to volumes, those volumes are not removed from the Tivoli Storage
Productivity Center for Replication configuration.

v HyperSwap can run provided that volumes are attached and available to z/OS
storage, even if you are using a TCP/IP connection to storage.

Direct connection
By using a TCP/IP connection, the Tivoli Storage Productivity Center for
Replication management server can connect directly to certain storage systems. The
TCP/IP connection is required to discover a system’s configuration (such as LSSs,
volumes, volume size, and format), issue queries, and receive asynchronous events.

The Tivoli Storage Productivity Center for Replication management server can
connect directly with the following systems:
v TotalStorage Enterprise Storage Server
v DS6000
v DS8000
v System Storage SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified
v The XIV system

DS8000 storage systems on an IPv4 network can be connected directly to the
management server. A direct connection requires an Ethernet card in the cluster.
DS8000 systems on an IPv6 network cannot use a direct connection. They can be
connected only through an HMC or z/OS connection.
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When you add a direct connection to a DS or ESS cluster, specify the following
information for cluster 0 and 1:
v IP addresses or domain names
v Ports
v User names
v Passwords

System Storage SAN Volume Controller or Storwize V7000 can virtualize various
storage systems. Although Tivoli Storage Productivity Center for Replication does
not support all storage systems, you can manage these storage systems through a
single System Storage SAN Volume Controller or Storwize V7000 cluster interface.
Tivoli Storage Productivity Center for Replication connects directly to the System
Storage SAN Volume Controller or Storwize V7000 clusters. When you add a direct
connection to a System Storage SAN Volume Controller or Storwize V7000 cluster
to the Tivoli Storage Productivity Center for Replication configuration, specify the
cluster IP address of the System Storage SAN Volume Controller or Storwize V7000
cluster, which in turn points to multiple System Storage SAN Volume Controller or
Storwize V7000 storage systems. Ensure that the user name and password are
correct for the cluster. If incorrect values are used, significant communication
problems can occur, such as never advancing to the Prepared state.

Important: The System Storage SAN Volume Controller or Storwize V7000 user
name must have privileges to maintain SSH keys. For information about
troubleshooting Secure Shell connections to the System Storage SAN Volume
Controller or Storwize V7000, see the Ethernet Connection Restrictions on System
Storage SAN Volume Controller website at www-01.ibm.com/support/
docview.wss?uid=ssg1S1002896.

Hardware Management Console connection
The IBM Tivoli Storage Productivity Center for Replication management server can
connect to DS8000 storage systems through a Hardware Management Console
(HMC). An HMC can have multiple DS8000 storage systems connected to it. When
you add an HMC to the IBM Tivoli Storage Productivity Center for Replication
configuration, all DS8000 storage systems that are behind the HMC are also added.
You cannot add or remove individual storage systems that are behind an HMC.

You can also add a dual-HMC configuration, in which you have two HMCs for
redundancy. You must configure both HMCs identically, including the user ID and
password.

If planned maintenance is necessary on the HMC, it is recommended that you
disable the Metro Mirror heartbeat on the management server while the
maintenance is performed.

If the HMC needs to go down frequently or reboots frequently, it is recommended
that you disable the Metro Mirror heartbeat. If the Metro Mirror heartbeat is
required, the direct connection is recommended instead of an HMC connection.

Important: If a DS8000 storage system uses an HMC connection, the Metro Mirror
heartbeat could trigger a freeze on the storage system and impact applications for
the duration of the long busy timeout timer if the HMC is shut down for any
reason, including upgrading microcode. The long busy timeout timer is the time
after which the storage system will allow I/O to begin again after a freeze occurs if
no run command has been issued by Tivoli Storage Productivity Center for
Replication. The default value is two minutes for ECKD volumes or one minute for
fixed block volumes.
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Notes:

v The user ID that you use to connect to the HMC must have admin, op_storage,
or op_copy_services privileges on the DS8000 storage system. In addition, the
user ID must have Copy Services access to any volumes that are in resource
groups on the DS8000 storage system.

v For minimum microcode requirements to connect to a DS8000 through a
management console, see the Supported Storage Products List website at
www-01.ibm.com/support/docview.wss?uid=swg21386446.

z/OS connections
An IBM Tivoli Storage Productivity Center for Replication management server that
runs on z/OS can connect to IBM TotalStorage Enterprise Storage Server (ESS)
Model 800, DS8000, and DS6000 storage systems through a z/OS connection. The
z/OS connection is used to issue replication commands and queries for attached
ECKD volumes over an existing Fibre Channel network and to receive
asynchronous events. When a storage system is added to IBM Tivoli Storage
Productivity Center for Replication through the z/OS connection, all ECKD
volumes that are attached to the IBM Tivoli Storage Productivity Center for
Replication management system are added to the IBM Tivoli Storage Productivity
Center for Replication configuration. ECKD volumes that are not attached to the
IBM Tivoli Storage Productivity Center for Replication z/OS management server
are not added to the IBM Tivoli Storage Productivity Center for Replication
configuration through the z/OS connection.

Notes:

v Ensure that all volumes in the logical storage subsystem (LSS) that you want to
manage through a z/OS connection are attached to z/OS. Either the entire LSS
must be attached to z/OS or none of the volumes in the LSS should be attached
to z/OS for IBM Tivoli Storage Productivity Center for Replication to properly
manage queries to the hardware.

v The z/OS connection is limited to storage systems that are connected to an IBM
Tivoli Storage Productivity Center for Replication management server running
z/OS.

v The Metro Mirror heartbeat is not supported through the z/OS connection. To
use the Metro Mirror heartbeat, the storage systems must be added using a
direct connection or Hardware Management Console (HMC) connection. If the
Metro Mirror heartbeat is enabled, a storage system is added through a direct
connection and z/OS connection, and the direct connection becomes
disconnected, then a suspend results as there is no heartbeat through the z/OS
connection.

If at least one volume in a Logical Storage Subsystem (LSS) is attached through a
z/OS connection, then all volumes in that LSS must be similarly attached. For
example, if there are two ECKD volumes in an LSS, and one volume is attached to
the IBM Tivoli Storage Productivity Center for Replication system using a z/OS
connection and the other is attached through a direct connection, IBM Tivoli
Storage Productivity Center for Replication would have knowledge of
direct-connected volume. IBM Tivoli Storage Productivity Center for Replication
issues commands to both volumes over the Fibre Channel network; however,
commands issued to the direct-connection volume will fail, and IBM Tivoli Storage
Productivity Center for Replication will show that the copy set that contains that
volume has an error.

Use the following guidelines to add storage systems through a z/OS connection:
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v Use the z/OS connection to manage ECKD volumes that are attached to an IBM
Tivoli Storage Productivity Center for Replication management server running
z/OS.

v To manage z/OS attached volumes through a z/OS connection (for example, for
HyperSwap), you must explicitly add the z/OS connection for that storage
system in addition to a TCP/IP connection (either the direct connection or the
HMC connection).

v Create a z/OS connection before all TCP/IP connections if you want to continue
to have IBM Tivoli Storage Productivity Center for Replication manage only the
attached ECKD volumes.

Tip: It is recommended that you create both TCP/IP and z/OS connections for
ECKD volumes to allow for greater storage accessibility.

Protected volumes
You can mark volumes as protected if you do not want those volumes used for
replication.

When a volume is marked as protected, you cannot include that volume in a copy
set. This protection applies only to IBM Tivoli Storage Productivity Center for
Replication.

You might want to protect a volume in the following instances:
v The volume contains data that you never want to be copied to another volume.

For example, the volume is secure, but if the data is copied to an unsecured
volume, the data could be read. For this reason, the volume should not be the
source for a relationship.

v The volume contains data that you do not want to be overwritten. For this
reason, the volume should not be the target of a relationship.

Only administrators can change the volume protection settings.

Site awareness
You can associate a location with each storage system and each site in a session.
This site awareness ensures that only the volumes whose location matches the
location of the site are allowed for selection when you add copy sets to the session.
This prevents a session relationship from being established in the wrong direction.

Note: To filter the locations for site awareness, you must first assign a site location
to each storage system.

IBM Tivoli Storage Productivity Center for Replication does not perform automatic
discovery of locations. Locations are user-defined and specified manually.

You can change the location associated with a storage system that has been added
to the IBM Tivoli Storage Productivity Center for Replication configuration. You
can choose an existing location or add a new one. Locations are deleted when
there is no longer a storage system with an association to that location.

When adding a copy set to a session, a list of candidate storage systems is
presented, organized by location. Storage systems that do not have a location are
displayed and available for use when you create a copy set.
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You can also change the location for any site in a session. Changing the location of
a session does not affect the location of the storage systems that are in the session.

Changing the location of a storage system might have consequences. When a
session has a volume role with a location that is linked to the location of the
storage system, changing the location of the storage system could change the
session's volume role location. For example, if there is one storage system with the
location of A_Location and a session with the location of A_Location for its H1
role, changing the location of the storage system to a different location, such as
B_Location, also changes the session's H1 location to Site 1. However, if there is a
second storage system that has the location of A_Location, the session's role
location is not changed.

Important: Location matching is enabled only when adding copy sets. If you
change the location of a storage system or volume role, IBM Tivoli Storage
Productivity Center for Replication does not audit existing copy sets to confirm or
deny location mismatches.

Adding a storage connection
You can add one or more connections to a storage system. To replicate data among
storage systems by using Tivoli Storage Productivity Center for Replication, you
must add connections to the storage systems.

Prerequisites: You must have Administrator privileges to add a storage
connection.

A single storage system can be connected by a combination of direct,
management-console, and z/OS connections. Perform these steps to add a storage
system connection:
1. In the navigation tree, select Storage Systems. The Storage Systems panel is

displayed in the Storage Systems view.
2. Click Add Storage Connection. The Add Storage System wizard Type page is

displayed.
3. Select the connection type that you want to use to add the storage systems and

click Next. The Connection page is displayed.
4. Perform one of these steps depending on the type of storage connection that

you selected:
v DS8000 / ESS 800 / DS6000 (Direct Connection): Enter the IP address or

domain name, port number, user name, and password for both cluster 0 and
cluster 1 in the appropriate fields.
In a System Storage DS8000 environment, if resource groups are defined on
the System Storage DS8000 that you are connecting to, the user name you
define here must have the appropriate access level on the System Storage
DS8000 to manage copy services for the volumes that are used by Tivoli
Storage Productivity Center for Replication.

v DS8000 (HMC Connection): Enter the primary HMC IP address or domain,
user name, password, and optionally the secondary HMC IP address or
domain name in the appropriate fields.

v SAN Volume Controller / Storwize V7000 / Storwize V7000 Unified (Direct
Connection): Enter the cluster IP address or domain name, user name, and
password in the appropriate fields.
The following are considerations for connection:
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a. Authentication with the storage system cluster is performed by public
key exchange. When adding a storage system cluster to the Tivoli Storage
Productivity Center for Replication configuration, specify the user ID and
password of an administrator on the cluster that has sufficient privileges
to maintain the Secure Shell (SSH) keys.

b. When a valid user name and password are specified, Tivoli Storage
Productivity Center for Replication audits the public keys installed on the
storage system cluster to ensure that the Tivoli Storage Productivity
Center for Replication key has the correct access levels. If the key is not
installed on the cluster, Tivoli Storage Productivity Center for Replication
attempts to install the key. If you install the key yourself, install the
public key found in the WAS_HOME/profiles/ReplicationServerProfile/
etc directory on the storage system cluster by using the SSH Key
Maintenance panel on the storage system graphical user interface. The
public key ID is installed under tpcr.

c. You must use a storage system cluster superuser user name and
password to correctly receive indications from the storage system cluster.

d. For Storwize V7000, Storwize V7000 Unified, or SAN Volume Controller
version 5.0 or later, you must create a user ID through the storage system
administration console on the cluster to which you want to attach Tivoli
Storage Productivity Center for Replication. This user ID must have local
authentication type and have the Administrator role authority.

v XIV (Direct Connection): Enter the IP address or domain name of the XIV
system node. Enter a user name and password of a user with appropriate
access rights to the XIV system.

v z/OS (FICON Connection): Select one or more storage systems from the list
of candidate systems that match the selected storage type, or click All to
select all storage systems.

5. Click Next.
6. Click Finish.
Related information:

http://publib.boulder.ibm.com/infocenter/dsichelp/ds8000ic/index.jsp

Removing a storage connection
You can remove a single connection to a storage system from the IBM Tivoli
Storage Productivity Center for Replication configuration.

Prerequisites: You must have Administrator privileges to remove a storage
connection.

When removing a connection, the storage system might have other connections
and therefore still be connected to IBM Tivoli Storage Productivity Center for
Replication.

When removing a connection, all storage systems that rely on only that connection
are removed. If a storage system is removed, the volumes for that storage system
are removed from management server control. All copy sets with a volume on the
removed storage systems are also removed from their respective sessions, making
the target volume unrecoverable.

If Tivoli Storage Productivity Center for Replication has multiple connections to a
specific storage system, the order in which you remove the connections produces
different results:
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v If you remove all direct and HMC connections first, the fixed block and
non-attached ECKD volumes are removed from the Tivoli Storage Productivity
Center for Replication configuration. The remaining ECKD volumes that are
attached through the z/OS connection remain in the Tivoli Storage Productivity
Center for Replication configuration until the z/OS connection is removed.
Removing the TCP/IP connection also disables the Metro Mirror heartbeat.

v If you remove the z/OS connection first and if there is an HMC or direct
connection to volumes, those volumes are not removed from the Tivoli Storage
Productivity Center for Replication configuration.

v HyperSwap can run provided that volumes are attached and available to z/OS
storage, even if you are using a TCP/IP connection to storage.

Perform one of these procedures to remove a storage connection:
1. In the navigation tree, select Storage Systems. The Storage Systems panel is

displayed in the Storage Systems view.
2. Click the Connections tab.
3. Select the storage connection that you want to remove.

Important: If you choose to delete an HMC connection, all storage systems that
share the HMC connection will also be removed.

4. Select Remove Connection from the Actions list, and click Go.
5. Click Yes to remove the storage system.

Removing a storage system
You can remove a storage system from the IBM Tivoli Storage Productivity Center
for Replication configuration.

Prerequisites: You must have Administrator privileges to remove a storage system.

Removing a storage system removes all volumes on that storage system from
management server control. All copy sets with a volume on the removed storage
system are removed from their respective sessions, making the target volume
unrecoverable. All connections to the removed storage system are removed, and
any storage systems sharing these connections are also removed.

Perform these steps to remove a storage system:
1. In the navigation tree, select Storage Systems. The Storage Systems panel is

displayed in the Storage Systems view.
2. Select the storage system that you want to remove.

Important: All connections to this storage system will be removed, all volumes
on the storage system will be removed from management server control, and
all copy sets that have a volume on this storage system will be removed from
their respective sessions, leaving the target volume unrecoverable. Any storage
systems sharing these connections will be removed as well.

3. Select Remove Storage System from the Actions list, and click Go.
4. Click Yes to remove the storage system.

Modifying the location of storage systems
You can associate a location with a storage system after a connection has been
made to that storage system.
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Prerequisites: You must have Administrator privileges to modify the location of a
storage system.

Changing the location of a storage system might have consequences. When a
session has a volume role with a location that is linked to the location of the
storage system, changing the location of the storage system could change the
session's volume role location. For example, if there is one storage system with the
location of A_Location and a session with the location of A_Location for its H1
role, changing the location of the storage system to a different location, such as
B_Location, also changes the session's H1 location to Site 1. However, if there is a
second storage system that has the location of A_Location, the session's role
location is not changed.

Perform these steps to modify the location of a storage system:
1. In the navigation tree, select Storage Systems. The Storage Systems panel is

displayed in the Storage Systems view.
2. Change the location of the storage system by selecting a previously defined

location from the drop-down list or type a new name in the table cell.
To disable site awareness, set the location to None.

Note: Locations are deleted from the drop-down list when there is no longer a
storage system with an association to that location.

Modifying storage connection properties
You can modify the connection properties for a storage system, including IP
addresses, user name and password.

Prerequisites:

v You must have Administrator privileges to modify storage connection properties.
v The storage system must be in the Disconnected state to change most storage

connection parameters. You can add a secondary HMC to an existing HMC
connection without the HMC being disconnected.

A storage system can lose connection to the management server, for example, if a
port is blocked by a firewall or the user name or password is changed on the
storage system. If the storage system loses connection, you might need to modify
parameters (for example, user name or password) manually on the storage system,
and then update the parameters in IBM Tivoli Storage Productivity Center for
Replication.

Perform these steps to modify storage connection properties:
1. In the navigation tree, select Storage Systems. The Storage Systems panel is

displayed in the Storage Systems view.
2. Click the Connections tab.
3. Perform one of these steps to view details for a specific storage connection:

v Click the storage connection ID.
v Select the storage connection, click View/modify Connection Details from

the actions list, and then click Go.
4. Modify the appropriate settings match the settings for the storage system.
5. Click Apply to continue making changes, and click OK when finished.
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Refreshing the storage system configuration
You can refresh the storage system configuration to query the storage system for
changes, such as which volumes are contained in an LSS. You might do this when
you reconfigure a storage system and you want IBM Tivoli Storage Productivity
Center for Replication to be aware of the changes.

Prerequisites: You must have Administrator privileges to modify storage
connection settings.

Perform these steps to refresh the storage configuration:
1. In the navigation tree, select Storage Systems. The Storage Systems panel is

displayed in the Storage Systems view.
2. Select the storage system for which you want to refresh the configuration.
3. Select Refresh Configuration from the Actions list, and click Go.

Setting volume protection
To ensure that data on a volume is not overwritten, you set its status to protected.
Protected volumes are excluded from replication.

You must have Administrator privileges to change the protection setting of a
volume.
1. In the navigation tree, select Storage Systems. The Storage Systems page is

opened.
2. Click Volume Protection. The Volume Protection wizard is opened.
3. Select a storage system.
4. Optional: Depending on the type of storage system:

a. Select All IO Groups or a specific I/O group.
b. Select All Logical Storage Subsystems or a specific logical storage

subsystem.
c. Select All Pools or a specific pool.

5. Optional: In the Volume field, select a single volume.
6. Optional: In the Volume Mask field, enter a sequence of characters and

wildcards that match user-defined or system-defined volume IDs. To protect a
specific volume, enter the volume ID such as ESS:2105.FCA57:VOL:1000. To
use a pattern to retrieve one or more volume IDs, you can enter a partial
volume ID and use the wildcard character (*) to represent zero or more
characters. For example, to retrieve all volume IDs that contain the characters
FCA57, you enter *FCA57*.

7. Click Next.
8. Verify the search results, and click Next.
9. Click Select All to protect all the volumes. Alternatively, select a check box

next to the volumes that you want to protect.
10. Click Next.
11. Click Finish.

Restoring data from a journal volume
This topic provides information on restoring data from a journal (J) volume. It
describes how to restore data from journal volume used as part of a
ESS/DS6000/DS8000 Global Mirror session, or as part of a Metro Global Mirror
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session, if data was corrupted on a host volume after you issued a Recover
command. Following these steps will enable you to return to a consistent copy of
the data on the host volume.

Perform the following steps to move the data from the journal volume back to the
host volume:

Note: Follow these instructions only if you have already issued a Recover
command to the site containing the journal volume. After the Recover command is
issued, the journal volume will hold a copy of the consistent data at the time the
command was issued.
1. Outside of IBM Tivoli Storage Productivity Center for Replication, using the

DS8000 GUI /CLI, issue withdraw initiate background copy (issue a rmflash
-cp command) on pairs containing the journal volume (for example, H2J2). This
copies the remaining uncopied tracks from the host to the journal. Then, ensure
all the Out of Sync (OOS) tracks reach zero.

2. Create a separate FlashCopy session either with IBM Tivoli Storage
Productivity Center for Replication, or with the DS8000 GUI /CLI (issue a
mkflash command with background copy), with the following conditions:
v The journal volume (Jx) is the source volume.
v The host volume (Hx or Ix if using a session with Practice capabilities) is the

target volume.
v x is the site the Recover command was issued to.

Managing host systems
Host system refers to an IBM AIX 5.3 or 6.1 server that is connected to IBM System
Storage DS8000 devices. A connection from Tivoli Storage Productivity Center for
Replication to the host system is used to enable the automatic swap of
input/output (I/O) from the primary storage unit to the secondary storage unit in
the case of a primary error.

A connection to the host system is required to use the Tivoli Storage Productivity
Center for Replication Open HyperSwap feature. For the software and hardware
required to support Open HyperSwap, see “Setting up the environment for Open
HyperSwap” on page 100.

Connecting to a host system requires the IP address or host name of the system
and the port number for communication. All connections are secured via a Secure
Socket Layer (SSL) connection.

Restriction: Open HyperSwap is not supported for AIX host servers that are in a
clustered environment such as PowerHA (previously known as HACMP).
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Related tasks:
“Managing a session with HyperSwap and Open HyperSwap replication” on page
99
HyperSwap and Open HyperSwap provide high availability of data if a primary
disk storage system failure occurs. When a failure occurs in writing I/O to the
primary storage system, the failure is detected by IOS, and IOS automatically
swaps the I/O to the secondary site with no user interaction and minimal
application effect.

Adding a host system connection
You can add a connection to one or more host systems to the IBM Tivoli Storage
Productivity Center for Replication configuration.

Prerequisites: You must have Administrator privileges to add a host system
connection.

For the software and hardware required to support Open HyperSwap, see “Setting
up the environment for Open HyperSwap” on page 100.

Perform these steps to add a host system connection:
1. In the navigation tree, select Host Systems. The Host Systems panel is

displayed.
2. Click Add Host Connection. The Add Host Connection dialog box is

displayed.
3. Enter the host name or IP address and the port for the host system and click

Add Host. The host system is displayed on the Host Systems panel. The
default port is 9930. Unless the port has been modified in Subsystem Device
Driver Path Control Module (SDDPCM), use the default port.

The host system is displayed in the Host System table. If the connection is
successful, the status Connected is displayed for the connection. If the connection
was not successful, the status Disconnected is displayed.

Modifying a host system connection
You can modify host system connections in the IBM Tivoli Storage Productivity
Center for Replication configuration.

Prerequisites: You must have Administrator privileges to modify a host system
connection and the connection must be in a disconnected state.

Perform these steps to modify a host system connection:
1. In the navigation tree, select Host Systems. The Host Systems panel is

displayed.
2. Select the host system connection that you want to modify.
3. Select Modify Host Connection from the Select Action list, and click Go.
4. Modify the information that is presented for the host system and click Update

Host. The updated host system information is displayed on the Host Systems
panel.

The updated host system information is displayed in the Host System table. If the
connection is successful, the status Connected is displayed for the connection. If
the connection was not successful, the status Disconnected is displayed.
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Removing a host system connection
You can remove host system connections from the IBM Tivoli Storage Productivity
Center for Replication configuration.

Prerequisites: You must have Administrator privileges to remove a host system.

Removing a host system connection disables the ability to use Open HyperSwap.
Any session using the host system to provide Open HyperSwap capabilities can no
longer communicate with the host and Open HyperSwap is disabled for the entire
session.

Perform these steps to remove a host system connection:
1. In the navigation tree, select Host Systems. The Host Systems panel is

displayed.
2. Select the host system connection that you want to remove.
3. Select Remove Host Connection from the Select Action list, and click Go.
4. Click OK to remove the host system connection.

Removing a session from a host system connection
You can remove a session that is associated with a host system from the IBM Tivoli
Storage Productivity Center for Replication configuration. Once removed, the host
no longer recognizes the session that is managing the volumes attached to that
host. This function is to be used primarily for cleanup purposes.

When a session has Open HyperSwap enabled, the session communicates with the
host system and the host system stores an association to that session on the IBM
Tivoli Storage Productivity Center for Replication server. If the Tivoli Storage
Productivity Center for Replication server that made the association becomes
inaccessible, it might be necessary to clean up and remove the session association
from a different Tivoli Storage Productivity Center for Replication server.

If a host system has an associated session, the session name is displayed in the
Sessions column of the Host Systems table. If the session is a session that is
currently defined on the Tivoli Storage Productivity Center for Replication server,
the session name is displayed as a link. The link opens the Session Details panel.

If the session name is not a session on the server, an icon is displayed. This session
must be removed because the host system can support only a single session
association. The session association must be removed before a Tivoli Storage
Productivity Center for Replication server can re-establish capabilities with the host
system.

Prerequisites: You must have Administrator privileges to remove a host system.

Perform these steps to remove session association from a host system connection:
1. In the navigation tree, select Host Systems. The Host Systems panel is

displayed.
2. Select the host system connection that contains the session that you want to

remove.
3. Select Remove Session Association from the Select Action list, and click Go.
4. Click OK to remove the host system connection.

The session name is removed from the Session column on the Host Systems table.
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Managing logical paths
Logical paths define the relationship between a source logical subsystem (LSS) and
a target LSS that is created over a physical path. To configure logical paths for
TotalStorage Enterprise Storage Server, System Storage DS8000, and DS6000, use
the ESS/DS Paths panel in Tivoli Storage Productivity Center.

To configure partnerships for the following storage systems, use the graphical user
interface (GUI) or command-line interface (CLI):
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified
v The XIV system

Viewing logical paths
You can view all logical paths that are defined on an IBM TotalStorage Enterprise
Storage Server, IBM System Storage DS8000, or IBM System Storage DS6000
storage system.

Perform one of these procedures to view logical paths:
v From the ESS/DS Paths panel of IBM Tivoli Storage Productivity Center for

Replication:
1. In the navigation tree, select ESS/DS Paths. The ESS/DS Paths panel is

displayed.
2. Click the storage system ID to display logical paths for that storage system.

v From the Storage Systems panel:
1. In the navigation tree, select Storage Systems. The Storage Systems panel is

displayed in the Storage Systems view.
2. Select an ESS, DS6000, or DS8000 storage system for which you want to view

logical paths.
3. Select View Paths from the Select Action list, and click Go. The ESS/DS

Paths panel is displayed with a list of defined logical paths.

Adding logical paths
This topic describes how to add IBM TotalStorage Enterprise Storage Server, IBM
System Storage DS8000, and IBM System Storage DS6000 logical paths.

Ensure that you have defined the appropriate storage systems on the Storage
Systems panel.

Perform these steps to add logical paths:
1. In the IBM Tivoli Storage Productivity Center for Replication navigation tree,

select ESS/DS Paths.
2. Click Manage Paths. The Path Management wizard is displayed.
3. From the drop-down boxes in the Path Management wizard, select the source

storage system, source logical storage system, target storage system, and target
logical storage system. Then, click Next.

4. From the drop-down boxes in the Path Management wizard, select the source
port and target port and click Add. You can add multiple paths between the
logical storage subsystems, or just one at a time. When you have made your
selections, click Next.
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5. Confirm your selections and click Next.
6. Verify the remaining wizard panels and click Next.
7. Click Finish.

Adding logical paths using a CSV file
You can create a comma separated (CSV) file to define logical paths. The CSV file
specifies storage systems pairings and associated port pairings that are used for
replication. IBM Tivoli Storage Productivity Center for Replication uses the port
pairings defined in the CSV file to establish logical paths

Perform these steps to add IBM TotalStorage Enterprise Storage Server, IBM
System Storage DS8000, and IBM System Storage DS6000 logical paths using a CSV
file:
1. Create a CSV file named portpairings.csv in the WAS_HOME/profiles/

ReplicationServerProfile/properties directory. You can create the CSV file in
a spreadsheet such as Microsoft Excel or in a text editor. An example CSV file
is as follows:
#
# Example CSV file
#
2107.04131:2107.01532,0x0331:0x0024,0x0330:0x0100,0x0331:0x000C
2107.05131:2107.01532,0x0330:0x0029,0x0331:0x0001

Each line represents a storage system to storage system pairing. The first value
represents the storage systems, which are delimited by a colon. The remaining
values are the port pairs, which are delimited by a colon. All values are
separated by a comma. Commented lines must start with #,

2. To enable the changes in the file, perform a task that requires new paths to be
established. For example, suspend a session to remove the logical paths and
then issue the Start H1->H2 command to enable the paths to use the port
pairings in the CSV file.

Considerations when creating and using the CSV file:

v The CSV file does not affect Global Mirror control paths.
v Port mapping is bi-directional. A logical path is established from system A to

system B and from system B to system A depending on the direction of the pairs
on the hardware.

v If the CSV file contains multiple lines that specify the same storage system to
storage system pairing, Tivoli Storage Productivity Center for Replication uses
the last line. This rule applies regardless of the order of the storage system
pairing. For example, if you have storage systems 2107.04131:2107.01532 defined
on the first line of the CSV file and then have 2107.01532:2107.04131 defined on
the second line, Tivoli Storage Productivity Center for Replication uses second
line.

v If a line in the CSV contains information that is not formatted correctly, the line
is ignored. This rule includes lines that specify storage systems but do not
include ports or include ports that are not formatted correctly.

v If the CSV file contains valid and invalid port pairs, the valid port pairs might
or might not be established. Invalid port pairs can cause the following errors to
be displayed in the Tivoli Storage Productivity Center for Replication console
and in the ESS/DS Paths panel:
– Return Code F52: This error is displayed if a port is invalid.
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– Return Code 0400: This error is displayed if a port is invalid and out of the
range for the device.

Other storage system error codes might be displayed also, depending on the
path topology, types of paths, and the incorrect port pairings specified in the
CSV file.

v If the CSV file contains no valid port pairs, no logical paths are established and
subsequent commands to the storage systems that require logical paths might
fail. If there are existing logical paths for a storage system, those paths are used
until they are removed.

Removing logical paths
This topic describes how to remove IBM TotalStorage Enterprise Storage Server,
IBM System Storage DS8000, and IBM System Storage DS6000 logical paths.
1. In the IBM Tivoli Storage Productivity Center for Replication navigation tree,

select ESS/DS Paths.
2. Click the link for the storage system that contains the paths that you want to

remove.
3. Select the paths that you want to remove.
4. From the drop-down box, select Remove.
5. Click Go.

Setting up data replication
This topic describes the how to set up data replication in your environment,
including creating sessions and adding copy sets to those sessions.

A session is a container of multiple copy sets managed by a replication manager. A
copy set is a set of volumes that contain copies of the same data. All the volumes in
a copy set are the same format (count key data [CKD] or fixed block) and size. In a
replication session, the number of volumes in a copy set and the role that each
volume in the copy set plays are determined by the session type.

Sessions
A session is used to perform a specific type of data replication against a specific set
of volumes. The source volume and target volumes that contain copies of the same
data are collectively referred to as a copy set. A session can contain one or more
copy sets.

The type of data replication that is associated with the session determines the
actions that you can perform against all copy sets in the session, the number of
volumes that a copy set can contain, and the role that each volume plays.

Attention: Use only the Tivoli Storage Productivity Center for Replication
graphical user interface (GUI) or command-line interface CLI to manage session
relationships, such as volume pairs and copy sets. Do not modify session
relationships through other interfaces such as the System Storage DS CLI. If you
modify relationships through other interfaces, a loss of consistency can across the
relationships that are managed by the session. The exceptions to this requirement
are failover operations that are managed by external applications for certain
session and storage system types as described in “Failover and failback operations”
on page 695.
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Copy sets
During data replication, data is copied from a source volume to one or more target
volumes, depending on the session type. The source volume and target volumes
that contain copies of the same data are collectively referred to as a copy set.

Each volume in a copy set must be of the same size and volume type (for example,
3380 volumes must be used with other 3380 volumes and SAN Volume Controller
volumes must be used with other SAN Volume Controller volumes). The number
of volumes in the copy set and the role that each volume plays is determined by
the session type (or copy type) that is associated with the session to which the
copy set belongs.

Use the Add Copy Sets wizard to add copy sets to an existing session. You can
select a storage system; a logical subsystem (LSS), I/O group, or pool; or single
volume for reach role and then create one or more copy sets for the session.

You can use one of the following volume pairing options to automatically create
multiple copy sets in the same session.

Storage system matching (System Storage DS8000, System Storage DS6000, or
TotalStorage Enterprise Storage Server Model 800 Metro Mirror sessions only)

Creates copy sets by matching volumes (based on the volume IDs) across
all logical subsystems (LSSs) for the selected storage systems. For example,
volume 01 on the source LSS is matched with volume 01 on the target LSS.

You cannot select the storage system and select All Logical Subsystems in
the list of LSSs. You can also do auto-matching at the LSS level for Metro
Mirror sessions.

LSS, I/O group, or pool matching
Creates copy sets by matching all volumes based on the selected LSS, I/O
group, or pool for each role in copy set.

Select the storage system and LSS, I/O group, or pool, and then select All
Volumes in the Volume list.

If you do not want to use the auto-generated volume pairing for a copy set, clear
that copy set so that it is not added during the wizard. Then, add the remaining
copy sets and reopen the Add Copy Set wizard and manually enter the volume
pairings that you want.

Invalid copy set are not added to the session. Copy sets can be invalid if their
volumes are not the same type or size.

You can remove copy sets that you do not want to add to the session, even if they
are valid. This process enables you to filter and eliminate unwanted copy sets
before they are added to the session.

You can export the copy sets to take a snapshot of your session at a particular
point in time for backup purposes.

Note: You can copy an entire storage system only for Metro Mirror sessions.

Considerations for adding copy sets

When you create a copy set for a session, a warning is displayed if one or more of
the selected volumes exist in another session. If the volume you selected is in
another session, confirm whether you want to add the volume to this session.
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Ensure that you intend to have the volume in multiple sessions because having the
volume in multiple sessions can create conflicts. A scenario in which you would
want the same volumes in multiple sessions is one in which you create a session
for normal replication and then create another session for a disaster recovery
practice. You must use the same target volumes in both sessions.

You can use extent space-efficient volumes as copy set volumes for the following
System Storage DS8000 session types. Extent space-efficient volumes must be fixed
block (FB). You cannot use count key data (CKD) volumes.

FlashCopy (System Storage DS8000 6.2 or later)
You can use a combination of extent space-efficient and other volume types
as source and target volumes in the copy set.

Metro Mirror (System Storage DS8000 6.3 or later)
If you use an extent space-efficient volume as a source or target volume in
the copy set, you must use extent space-efficient volumes for all source and
target volumes in the copy set.

Global Mirror or Metro Global Mirror (System Storage DS8000 6.3 or later)
You can use extent space-efficient volumes as source, target, and journal
volumes. If you use an extent space-efficient volume as a source or target
volume in the copy set, you must use extent space-efficient volumes for all
source and target volumes in the copy set. In this situation, the journal
volumes can be extent space-efficient volumes, track space-efficient
volumes, or a combination of both volume types. If extent space-efficient
volumes are not used as source or target volumes, journal volumes can be
extent space-efficient, track space-efficient, and other types of volumes.

Considerations for removing copy sets

You remove a copy set or range of copy sets by selecting the following items:
v Source volume
v LSS, I/O group, or pool
v Storage system

When the list of copy sets that meet your criteria is displayed, you can select the
copy sets that you want to remove.

The consequence of removing copy sets varies depending on the state of the
session:

Defined
There is no relationship on the hardware. The copy set is removed from
Tivoli Storage Productivity Center for Replication data store.

Preparing or Prepared
The copy set is currently copying data, so Tivoli Storage Productivity
Center for Replication terminates the hardware relationship for the copy
set. The rest of the copy sets continue to run uninterrupted.

Suspended or Target Available
Any existing relationships on the hardware are removed for the copy set.

Before removing all copy sets from that session, terminate the session. Removing
the copy sets when the session is active can considerably increase the amount of
time it takes for the copy set removal to complete. Copy sets are removed one at a
time, and when the session is active, commands are issued to the hardware.
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However, if you terminate the session first, then commands are not issued to the
hardware and the removal process completes faster.

Tip: When you a remove copy set from Tivoli Storage Productivity Center for
Replication, you might want to keep hardware relationships on the storage
systems. These relationships are useful when you want to migrate from one session
type to another or when resolving problems. For more information about keeping
the hardware relationships when removing copy sets, see Removing Copy Sets.

The behavior that occurs when a copy set is removed varies depending on the
storage system:

ESS 800, DS6000, and DS8000:

v The complete copy set is removed from Tivoli Storage Productivity
Center for Replication.

v Any peer-to-peer remote copy (PPRC) pair that is part of a Global
Mirror consistency group is removed from the consistency group on the
storage system.

v If the PPRC pair is part of a Global Mirror consistency group and is the
last remaining source volume in a subordinate session, the subordinate
session is removed from the storage system.

v If the PPRC pair is the last remaining participant in a Global Mirror
session, the Global Mirror session is removed from the storage system.

v Any PPRC relationship remains on the storage system.
v A Metro Mirror (synchronous PPRC) pair that is in a HyperSwap

configuration is removed from that configuration but the pair remains
on the hardware.

v FlashCopy relationship remains on the storage system if the hardware
has not completed any background copy.

SAN Volume Controller, Storwize V7000, Storwize V7000 Unified, or the XIV
system

v The complete copy set is removed from Tivoli Storage Productivity
Center for Replication.

v FlashCopy, Metro Mirror, and Global Mirror relationships are pulled out
of their consistency group. If they are the last remaining relationship in a
consistency group, that consistency group is removed from the
hardware.

When you specify the force removal option, all knowledge of the specified copy set
is removed from Tivoli Storage Productivity Center for Replication, even if the
relationship itself still exists. In this situation, you are not able to remove the
relationship using Tivoli Storage Productivity Center for Replication, because no
information about the relationship exists. If you force a removal of a copy set and
the removal fails, you must manually remove the relationship from the hardware.
If you do not, you cannot to create new relationships.

One benefit of forcing a removal of the copy sets is that Tivoli Storage Productivity
Center for Replication does not manage the consistency of copy sets that it has no
knowledge of. This means that additional commands to the session do not affect
the removed copy sets, even though they are still in a relationship on the
hardware.

If you do not specify the force removal option and an error occurs that prevents
the hardware relationships from being removed, the copy set is not removed from
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Tivoli Storage Productivity Center for Replication. The copy set remains as part of
the session, and you can still perform actions on it.

Volume roles
Volume roles are given to every volume in the copy set. The role defines how the
volume is used in the copy set and, for multi-site sessions, the site location of the
volume. For example, the H1 role is made up of host-attached volumes that are
located at the primary site.

The site determines the location of the volumes. The number of sites in a copy set
is determined by the type of data replication (also known as the session type) that
is associated with the session. Tivoli Storage Productivity Center for Replication
supports up to three sites:

Site 1 The location of the primary storage that contain the source data. Upon
initial configuration, this site contains the host volumes with updates that
are copied to the target volumes.

Site 2 The location of the secondary storage that receives the copy updates from
the primary storage.

Site 3 (Metro Global Mirror only) The location of the tertiary storage that receives
data updates from the secondary storage.

The volume roles that are needed in a copy set are determined by the type of
replication that is associated with the session. Tivoli Storage Productivity Center
for Replication supports these volume roles:

Host volume
A volume that is connected to a server that reads and writes I/O. A host
volume can be the source of updated tracks when the server connected to
the host volume is actively issuing read and write input/output (I/O). A
host volume can also be the target of the replication. When the host
volume is the target, writes are inhibited.

Host volumes are abbreviated as Hx, where x identifies the site.

Journal volume
A volume that stores data that has changed since the last consistent copy
was created. This volume functions like a journal and holds the required
data to reconstruct consistent data at the Global Mirror remote site. When
a session must be recovered at the remote site, the journal volume is used
to restore data to the last consistency point. A FlashCopy replication
session can be created between the host or intermediate volume and the
corresponding journal volume after a recover request is initiated to create
another consistent version of the data.

Journal volumes are abbreviated as Jx, where x identifies the site.

Intermediate volume
A volume that receives data from the primary host volume during a
replication with practice session. During a practice, data on the
intermediate volumes is flash copied to the practice host volumes.

Depending on the replication method being used, data on intermediate
volumes might not be consistent.

Intermediate volumes are abbreviated as Ix, where x identifies the site.

Target volume
(FlashCopy only) A volume that receives data from a source, either a host
or intermediate volume. Depending on the replication type, that data
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might or might not be consistent. A target volume can also function as a
source volume. For example, a common use of the target volume is as a
source volume to allow practicing for a disaster (such as data mining at the
recovery site while still maintaining disaster recovery capability at the
production site).

Role pairs
A role pair is the association of two volume roles in a session that take part in a
copy relationship. For example, in a Metro Mirror session, the role pair can be the
association between host volumes at the primary site and host volumes at the
secondary site (H1-H2).

The flow of data in the role pair is shown using an arrow. For example, H1>H2
denotes that H1 is the source and H2 is the target.

Participating role pairs are role pairs that are currently participating in the session's
copy.

Non-participating role pairs are role pairs that are not actively participating in the
session's copy.

Snapshot sessions do not use role pairs.

Practice volumes
You can use a practice volume to practice what you would do in the event of a
disaster, without interrupting current data replication. Practice volumes are
available in Metro Mirror, Global Mirror, and Metro Global Mirror sessions.

To use the practice volumes, the session must be in the prepared state. Issuing the
Flash command against the session while in the Prepared state creates a usable
practice copy of the data on the target site.

Note: You can test disaster-recovery actions without using practice volumes;
however, without practice volumes, you cannot continue to copy data changes
between volumes while testing disaster-recovery actions.

Consistency groups
For Global Mirror and Metro Global Mirror sessions, IBM Tivoli Storage
Productivity Center for Replication manages the consistency of dependant writes
by creating a consistent point-in-time copy across multiple volumes or storage
systems. A consistency group is a set of target volumes in a session that have been
updated to preserve write order and are therefore recoverable.

Data exposure is the period when data is written to the storage at the primary site
until data is replicated to storage at the secondary site. Data exposure is influenced
by factors such as:
v Requested consistency-group interval time
v Type of storage systems
v Physical distance between the storage systems
v Available bandwidth of the data link
v Input/output (I/O) load on the storage systems

To manage data exposure, you can change the consistency group interval time. The
consistency group time interval specifies how often a Global Mirror and Metro Global
Mirror session attempts to form a consistency group. When you reduce this value,
it might be possible to reduce the data exposure of the session. A smaller interval
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value causes the session to attempt to create consistency groups more frequently,
which might also increase the processing load and message-traffic load on the
storage systems.

Failover and failback operations
If a session has failover and failback capabilities, you can perform a site switch in
which you move the operation of Tivoli Storage Productivity Center for Replication
from one site to another, and change the direction of the copy without completing
a full copy.

Failover is the process of temporarily switching production to a backup facility
following a scheduled maintenance period or a disaster at a production site. A
failover operation can be followed by a failback operation, which is the process of
returning production to its original location and resuming the copy between the
two sites.

The failover and failback operations use remote mirror and copy functions for
these tasks:
v To reduce the time that is required to synchronize volumes after switching sites

during planned or unplanned outages.
v To eliminate the need to perform a full volume copy from the recovery site to

the production site, which can reduce the time that is required to resume
operations at the production site.

Failover operations that are managed by other applications

Applications such as the IBM Series i Toolkit, VMware Site Recovery Manager, and
Veritas Cluster Server can also manage failover operations for the session types
that are listed in the following table.

Session type Storage systems

Metro Mirror Single Direction v System Storage DS8000

v System Storage DS6000

v System Storage SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Metro Mirror Failover/Failback v System Storage DS8000

v System Storage DS6000

v System Storage SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

v The XIV system

Metro Mirror Failover/Failback
with Practice

v System Storage DS8000

v System Storage DS6000

v System Storage SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Chapter 7. Managing replication 695



Session type Storage systems

Global Mirror Single Direction v System Storage DS8000

v System Storage DS6000

v System Storage SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Global Mirror Either Direction with
Two-Site Practice

v System Storage DS8000

v System Storage DS6000

Global Mirror Failover/Failback v System Storage DS8000

v System Storage DS6000

v System Storage SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

v The XIV system

Global Mirror Failover/Failback
with Practice

v System Storage DS8000

v System Storage DS6000

v System Storage SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

If an application completes a failover operation for a session, the Severe status is
displayed for the session on the Session Details page in Tivoli Storage Productivity
Center for Replication and an error message is generated for the role pairs for
which the failover occurred. To view the error message:
1. On the Session Details page, click the link for each role pair for which the

failover occurred.
2. On the Role Pair Details page, click the Show link for each role pair. This link

is in the Details column.

To change the session status to Normal, use the application to confirm that the role
pairs that are in the session are consistent and then restart the session.

Data replication
With Tivoli Storage Productivity Center for Replication, you can use several
methods to replicate data. The type of data replication that is associated with a
session is known as the session type.

The following sections describe the session types that are supported by Tivoli
Storage Productivity Center for Replication. Depending on the edition of Tivoli
Storage Productivity Center for Replication that you are using, some of these
session types might not be available.

Basic HyperSwap

Basic HyperSwap sessions are available for the following license types and storage
systems.
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Table 59. Basic HyperSwap

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication
Basic Edition
for System z

v Tivoli Storage
Productivity
Center for
Replication for
System z

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

Basic HyperSwap replication is a
Metro Mirror replication method
that provides high availability if a
disk storage system failure occurs.
Using Basic HyperSwap with
Metro Mirror, you can configure
and manage your synchronous
Peer-to-Peer Remote Copy (PPRC)
pairs.

FlashCopy

FlashCopy sessions are available for the following license types and storage
systems.

Table 60. FlashCopy

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication
Basic Edition
for System z

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

FlashCopy replication creates a
point-in-time copy in which the
target volume contains a copy of
the data that was on the source
volume when the FlashCopy was
established. Using FlashCopy, the
data exists on the second set of
volumes in the same storage
system, and you can restore the
data to the first set of volumes.

SAN Volume Controller or
Storwize V7000 FlashCopy
sessions are managed by using
FlashCopy consistency groups.
Sessions for IBM TotalStorage
Enterprise Storage Server (ESS)
and IBM DS6000 and DS8000 are
not managed by using FlashCopy
consistency groups.
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Snapshot

Snapshot sessions are available for the following license types and storage systems.

Table 61. Snapshot

Supported software Supported storage systems Description

v Tivoli Storage Productivity
Center for Replication
Basic Edition for System z

v Tivoli Storage Productivity
Center for Replication for
System z

v All editions of Tivoli
Storage Productivity
Center

The XIV system Snapshot is a session type
that creates a point-in-time
copy of a volume or set of
volumes without having to
define a specific target
volume. The target volumes
of a Snapshot session are
automatically created when
the snapshot is created.

Metro Mirror Single Direction

Metro Mirror Single Direction sessions are available for the following license types
and storage systems.

Table 62. Metro Mirror Single Direction

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Metro Mirror is a method of
synchronous, remote data
replication that operates between
two sites that are up to 300 KM
apart. The source is located in one
storage system and the target is
located in another storage system.
Using Metro Mirror, the data exists
on the second site that is less than
300 KM away, and you can restore
the data to the first site.

Metro Mirror Failover/Failback

Metro Mirror Failover/Failback sessions are available for the following license
types and storage systems.
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Table 63. Metro Mirror Failover/Failback

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

v The XIV system

Metro Mirror is a method of
synchronous, remote data
replication that operates between
two sites that are up to 300 KM
apart. Using Metro Mirror
Failover/Failback, the data exists
on the second site that is less than
300 KM away. You can use failover
and failback to switch the direction
of the data flow. Using this
method, you can run your
business from the secondary site.

Using Metro Mirror with
HyperSwap, the data exists on the
second site that is less than 300
KM away. You can restore the data
to the first site. You can also use
failover for a backup copy of the
data if your primary volumes
encounter a permanent I/O error.

Metro Mirror Failover/Failback with Practice

Metro Mirror Failover/Failback with Practice sessions are available for the
following license types and storage systems.

Table 64. Metro Mirror Failover/Failback with Practice

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Metro Mirror is a method of
synchronous, remote data
replication that operates between
two sites that are up to 300 KM
apart. The source is located in one
storage system and the target is
located in another storage system.
Metro Mirror Failover/Failback
with Practice combines Metro
Mirror and FlashCopy to provide a
point-in-time copy of the data on
the remote site.

Global Mirror Single Direction

Global Mirror Single Direction sessions are available for the following license types
and storage systems.
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Table 65. Global Mirror Single Direction

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Global Mirror is a method of
asynchronous, remote data
replication between two sites that
are over 300 KM apart. It
maintains identical data in both
the source and target, where the
source is located in one storage
system and the target is located in
another storage system. Using
Global Mirror, the data exists on
the second site that is more than
300 KM away, and you can restore
the data to the first site.

Global Mirror Either Direction with Two-Site Practice

Global Mirror Either Direction with Two-Site Practice sessions are available for the
following license types and storage systems.

Table 66. Global Mirror Either Direction with Two-Site Practice

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

Global Mirror is a method of
asynchronous, remote data
replication between two sites that
are over 300 KM apart. It
maintains identical data in both
the source and target, where the
source is located in one storage
system and the target is located in
another storage system. Global
Mirror Either Direction with
Two-Site Practice combines Global
Mirror and FlashCopy to provide a
point-in-time copy of the data on
either the primary or secondary
sites that are over 300 KM apart.

Global Mirror Failover/Failback

Global Mirror Failover/Failback sessions are available for the following license
types and storage systems.
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Table 67. Global Mirror Failover/Failback

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

v The XIV system

Global Mirror is a method of
asynchronous, remote data
replication between two sites that
are over 300 KM apart. It
maintains identical data in both
the source and target, where the
source is located in one storage
system and the target is located in
another storage system. Using
Global Mirror Failover/Failback,
the data exists on the second site
that is more than 300 KM away,
and you can use failover and
failback to switch the direction of
the data flow. This ability enables
you to run your business from the
secondary site.

Global Mirror Failover/Failback with Practice

Global Mirror Failover/Failback with Practice sessions are available for the
following license types and storage systems.

Table 68. Global Mirror Failover/Failback with Practice

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800

v System Storage DS8000

v System Storage DS6000

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Global Mirror is a method of
asynchronous, remote data
replication between two sites that
are over 300 KM apart. It
maintains identical data in both
the source and target, where the
source is located in one storage
system and the target is located in
another storage system. Global
Mirror Failover/Failback with
Practice combines Global Mirror
and FlashCopy to provide a
point-in-time copy of the data on a
remote site at a distance over 300
KM away from your first site.

Metro Global Mirror

Metro Global Mirror sessions are available for the following license types and
storage systems.
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Table 69. Metro Global Mirror

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800 (only H1 site)

v System Storage DS8000

Metro Global Mirror is a method
of continuous, remote data
replication that operates between
three sites that varying distances
apart. Metro Global Mirror
combines Metro Mirror
synchronous copy and Global
Mirror asynchronous copy into a
single session, where the Metro
Mirror target is the Global Mirror
source. Using Metro Global Mirror
and Metro Global Mirror with
HyperSwap, the data exists on a
second site that is less than 300
KM away, and a third site that is
more than 300 KM away. Metro
Global Mirror uses both Metro
Mirror and Global Mirror
Failover/Failback to switch the
direction of the data flow. This
ability enables you to run your
business from the secondary or
tertiary sites.

Using Basic HyperSwap with
Metro Global Mirror, you can
configure and manage three-site
continuous replication that is
needed in a disaster recovery
event.

Metro Global Mirror with Practice

Metro Global Mirror with Practice sessions are available for the following license
types and storage systems.

Table 70. Metro Global Mirror with Practice

Supported
software Supported storage systems Description

v Tivoli Storage
Productivity
Center for
Replication for
System z

v All editions of
Tivoli Storage
Productivity
Center

v TotalStorage Enterprise Storage
Server Model 800 (only H1 site)

v System Storage DS8000

Using Metro Global Mirror with
Practice, you can practice your
disaster recovery actions while
maintaining disaster recovery
capabilities. The data exists on a
second site that is less than 300
KM away, and a third site that is
more than 300 KM away. Metro
Global Mirror uses both Metro
Mirror and Global Mirror
Failover/Failback to switch the
direction of the data flow. You can
run your business from the
secondary or tertiary sites, and
simulate a disaster.
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Basic HyperSwap (ESS, DS6000, and DS8000)
Basic HyperSwap is a copy services solution for z/OS version 1.9 and later. It
provides high availability of data if a disk storage system failure occurs. Basic
HyperSwap does not replace a disaster recovery solution. If a session is suspended
but the suspend operation was not caused by a HyperSwap trigger, the session is
not frozen to ensure that it is consistent.

When HyperSwap is combined with Metro Mirror and Metro Global Mirror
replication, you can prepare your system for disaster recovery and ensure high
availability of data. If a session is suspended but the suspend operation was not
caused by a HyperSwap trigger, the session is frozen to ensure that it is consistent.

Restriction: This replication method is only available on ESS, DS6000, and DS8000
storage systems, and on management servers that run IBM Tivoli Storage
Productivity Center for Replication Basic Edition for System z or IBM Tivoli
Storage Productivity Center for Replication for System z.

Basic HyperSwap replication performs the following actions:
v Manages CKD volumes in Metro Mirror to manage synchronous peer-to-peer

remote copy (PPRC) relationships.
v Permits only CKD volumes to be added to the HyperSwap session. The

graphical user interface (GUI) shows only CKD volumes when you add a copy
set. The command-line interface (CLI) does not add a copy set if a fixed block
volume is specified.

v Monitors events that indicate a storage device failed.
v Determines whether the failing storage device is part of a Metro Mirror

synchronous PPRC pair.
v Determines the action to be taken from policy.
v Ensures that data remains consistent.
v Swaps the I/O between the primary logical devices in the consistency group

with the secondary logical devices in the consistency group. A swap can occur
from the preferred logical devices to the alternate logical devices or from the
alternate logical devices to the preferred logical devices.

Metro Mirror Failover/Failback with HyperSwap

Metro Mirror Failover/Failback uses HyperSwap to configure and manage
synchronous PPRC pairs.

Metro Global Mirror with HyperSwap

Metro Global Mirror with HyperSwap is a z/OS replication feature that provides
the three-site continuous replication that you can use if a disaster occurs.

Restriction: If a HyperSwap event occurs when you run a Metro Global Mirror
operation with a HyperSwap session, a full copy operation of the data occurs to
return the system to a full three-site configuration. If you issue a HyperSwap
command when you run a Metro Global Mirror operation with a HyperSwap
session, a full copy operation does not occur. A full copy is required only for an
unplanned HyperSwap session or a HyperSwap-initiated session by using the
z/OS SETHS SWAP command.
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Example

Jane is using multiple DS8000 storage systems. The host applications run on a
z/OS operating system and the z/OS environment is connected to the DS8000
storage systems. She has a site in Manhattan and a secondary DS8000 in Hoboken.
While it is not required that she has a disaster recovery solution in effect, she does
need to have a high-availability solution to keep her applications running all the
time. Jane is worried that if a volume fails on the DS8000 in Manhattan, her
database application might fail. Even a small downtime can be costly to Jane.

Jane uses a Basic HyperSwap session to mirror the data on the DS8000 in
Manhattan to the secondary DS8000 in Hoboken. If a volume at the Manhattan site
fails, Basic HyperSwap automatically directs application I/O to the mirrored
volumes in Hoboken.

FlashCopy
FlashCopy replication creates a point-in-time copy in which the target volume
contains a copy of the data that was on the source volume when the FlashCopy
was established.

The ESS, DS6000, and DS8000 provide multiple logical subsystems (LSSs) within a
single physical subsystem, while the following platforms provide multiple I/O
groups:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

All platforms can use local replication in which the source volume is located in one
LSS or I/O group and the target volume is located in the same or another LSS or
I/O group. Using the FlashCopy feature, you can reference and update the source
volume and target volume independently.

The following figure illustrates how a FlashCopy session works.

Example

Jane works for a bank. Jane uses a FlashCopy session to make a point-in-time copy
of the customer data in existing international accounts. Every night, the bank's
servers start batch processing. Jane uses the FlashCopy session to create checkpoint
restarts for the batch processing if the batch processing fails. In the batch
processing, the first step is to balance all international accounts and to make a
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FlashCopy point-in-time copy of the resulting data. The second step in the batch
processing is to complete the international disbursements.

If the second step in the batch process fails, Jane can use the data from the
FlashCopy session that was taken of the first step to repeat the second step. In this
way, Jane does not have to begin the entire process again. Jane also uses a CLI
script that performs a FlashCopy operation every night at 11:59 PM, and another
script that quiesces the database. She backs up the data to tape on the target
storage system, and then sends the tape to the bank's data facility for storage.

Snapshot
Snapshot is a session type that creates a point-in-time copy of a volume or set of
volumes. You do not have to define a specific target volume. The target volumes of
a Snapshot session are automatically created when the snapshot is created.

The XIV system uses a snapshot session to create a large number of volume copies
without affecting system performance. By using the snapshot function to create a
point-in-time copy, and to manage the copy, you can save storage. With the XIV
system snapshots, no storage capacity is used by the snapshot until the source
volume or the snapshot is changed.

The following figure illustrates how a Snapshot session works.

Example

Jane's host applications are using an XIV system for their back-end storage. With
the XIV system, Jane can create a large number of point-in-time copies of the data.
The snapshot function ensures that if data becomes corrupted, she can restore the
data to any point in time.

Jane sets up a Snapshot session by using Tivoli Storage Productivity Center for
Replication and specifies the volumes on the XIV system that are used by the host
applications. Jane does not have to provision target volumes for all the snapshots
she intends to make. She can quickly configure a single Snapshot session.

When the session is configured, Jane uses a CLI script that runs a Create Snapshot
command to the session every two hours. If a problem occurs, such as data
becoming corrupted, Jane can find a snapshot of the data from a time before the
problem occurred. She can restore the data to that point.

By creating a set of snapshots of the data, Jane can also schedule batch processing
against that data every day. She can use the batch processing to analyze certain
trends in the market without affecting the host applications.

Metro Mirror
Metro Mirror is a method of synchronous, remote data replication that operates
between two sites that are up to 300 KM apart. The source is located in one storage
system and the target is located in another storage system.
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Attention: If you have Tivoli Storage Productivity Center for Replication for
System z sessions that contain Metro Mirror relationships, ensure that the session
does not contain system volumes (such as paging volumes) unless you select the
Manage H1-H2 with HyperSwap or the Enable Hardened Freeze option for the
session. By using these options, z/OS Input/Output Supervisor (IOS) manages
freeze operations for the volumes in the session, which prevents Tivoli Storage
Productivity Center for Replication from freezing the volumes and possibly
freezing itself.

Metro Mirror replication maintains identical data in both the source and target.
When a write operation is issued to the source copy, the changes made to the
source data are propagated to the target before the write operation finishes
processing. If the storage system ends, no data is lost when you use Metro Mirror
if data must be used from the recovery site.

A Metro Mirror session in Global Copy mode creates an asynchronous relationship
to accommodate the high volume of data that is migrated. As a result, the data on
the target system might no longer be consistent with the source system. The Metro
Mirror session switches back to a synchronous relationship when Metro Mirror
reissues a Start command. In addition, you can start a Metro Mirror session in
Global Copy mode and toggle between Metro Mirror and Global Copy modes to
accommodate periods in which you require host I/O response time over data
consistency.

Tip: To determine whether there is any out-of-sync data that must to be copied
before the session is consistent, check the percent that is complete in the session
details page.

Metro Mirror Single Direction

The following figure illustrates how a Metro Mirror Single Direction session works.

Metro Mirror Failover/Failback

Using Metro Mirror Failover/Failback, the data exists on the second site, which is
less than 300 KM away, and you can switch the direction of the data flow. You can
use this session type to run your business from the secondary site, and to copy
changes made at the second site back to the primary site when you want to
resume production at the primary site.

The following figure illustrates how a Metro Mirror with Failover/Failback session
works.
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Metro Mirror Failover/Failback with Practice

A Metro Mirror Failover/Failback with Practice session combines Metro Mirror and
FlashCopy features to provide a point-in-time copy of the data on the remote site.
You can use this session type to practice what you might do if a disaster occurs,
without losing your disaster recovery capability.

This solution consists of two host volumes and an intermediate volume.

The following figure illustrates how a Metro Mirror Failover/Failback with Practice
session works.

Metro Mirror Failover/Failback with HyperSwap

You can enable a Metro Mirror Failover/Failback session to have HyperSwap
capabilities. To enable the HyperSwap feature, the following conditions must
apply:
v The session is running on an Tivoli Storage Productivity Center for Replication

server that runs on IBM z/OS.
v The volumes are only for TotalStorage Enterprise Storage Server, DS6000, and

System Storage DS8000 systems.
v The volumes are count key data (CKD) volumes that are attached to the z/OS

system.

Metro Mirror Failover/Failback with HyperSwap combines the high availability of
Basic HyperSwap with the redundancy of a two-site Metro Mirror
Failover/Failback solution when managing count key data (CKD) volumes on
z/OS. If the primary volumes encounter a permanent I/O error, the I/O is
automatically swapped to the secondary site with minimal effect on the
application.

A swap can be planned or unplanned. A planned swap occurs when you issue a
HyperSwap command from the Select Action list in the graphical user interface
(GUI) or when you issue a cmdsess -action hyperswap command.

The following figure illustrates how a Metro Mirror Failover/Failback session that
is enabled for HyperSwap works.

Chapter 7. Managing replication 707



For more information about enabling HyperSwap, see “Managing a session with
HyperSwap and Open HyperSwap replication” on page 99.

Metro Mirror Failover/Failback with Open HyperSwap

You can enable a Metro Mirror Failover/Failback session to have Open HyperSwap
capabilities. To enable Open HyperSwap processing, the following conditions must
apply:
v The volumes in the session are System Storage DS8000 5.1 or later volumes.
v The volumes in the session are fixed block and are mounted to IBM AIX 5.3 or

AIX 6.1 hosts with the following modules installed:
– Subsystem Device Driver Path Control Module (SDDPCM) version 3.0.0.0 or

later
– Multi-Path Input/Output (MPIO) module (the version that is provided with

AIX version 5.3 or 6.1)
v The connections between the AIX host systems and the Tivoli Storage

Productivity Center for Replication server are established.

Metro Mirror Failover/Failback with Open HyperSwap combines the high
availability of Basic HyperSwap on z/OS for fixed-block AIX volumes with the
redundancy of a two-site Metro Mirror Failover/Failback solution. If the primary
volumes encounter a permanent I/O error, the I/O is automatically swapped to
the secondary site with minimal effect on the application.

A swap can be planned or unplanned. A planned swap occurs when you issue a
HyperSwap command from the Select Action list in the GUI or when you issue a
cmdsess -action hyperswap command.

The following figure illustrates how a Metro Mirror Failover/Failback session that
is enabled for Open HyperSwap works.

For more information about enabling Open HyperSwap, see “Managing a session
with HyperSwap and Open HyperSwap replication” on page 99.
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Examples

Read the following scenarios for information on using Metro Mirror for
synchronous, remote data replication between two sites.

Metro Mirror Single Direction

At the beginning of a work week, Jane is notified that between 10:00 AM
and 11:00 AM on the next Friday, power in her building is going to be shut
off. Jane does not want to lose any transactions during the power outage,
so she decides to transfer operations to the backup site during the outage.
She wants a synchronous copy method with no data loss for the critical
business functions, so she chooses Metro Mirror, which can be used
between locations that are less than 300 KM apart.

In a synchronous copy method, when a write is issued to change the
source, the change is propagated to the target before the write is posted.
This method of replication maintains identical data in both the source and
target. The advantage of this method is when a disaster occurs, there is no
data loss at the recovery site because both writes must complete before
signaling completion of a write to the source application. Because the data
must be copied to both System Storage DS8000 devices before the write is
completed, Jane can be sure that the data is safe.

The night before the planned outage, Jane quiesces the database and
servers in San Francisco and starts the database and servers in Oakland. To
accomplish this task, Jane issues the Suspend and Recover commands, and
then issues the Start command on the secondary site. She shuts down the
equipment in San Francisco to avoid any power spikes when she restarts
the system after the power is turned on.

Metro Mirror in Global Copy mode

At the beginning of a work week, Jane is notified that between 10:00 AM
and 11:00 AM on the next Friday, power in her building is going to be shut
off. Jane does not want to lose any transactions during the power outage,
so she decides to transfer operations to the backup site during the outage.
She wants a synchronous copy method with no data loss for the critical
business functions, so she chooses Metro Mirror, which can be used
between locations that are less than 300 KM apart.

Jane wants to limit the effect on any applications while completing the
initial Metro Mirror synchronization, so she begins the session in Global
Copy mode. After she sees that approximately 70% of the data is copied,
Jane decides to switch the session to Metro Mirror mode, assuring data
consistency.

Metro Mirror with Practice

Jane wants to run a Metro Mirror with Practice from San Francisco to
Oakland. She wants to verify the recovery procedure for the Oakland site,
but she cannot stop running the Metro Mirror session while she takes time
to practice a recovery. By using a Metro Mirror with Practice session, Jane
can practice the disaster recovery scenario in Oakland while the Metro
Mirror session runs uninterrupted. By practicing running the applications
at the Oakland site, Jane is better prepared to recover data if a disaster
occurs at the San Francisco site.

While her session is running in Prepared state, Jane practices a recovery at
the Oakland site by issuing the Flash command. This command
momentarily pauses the session and starts a FlashCopy to the H2 volumes.
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As soon as the FlashCopy is started, the session is restarted. These
FlashCopy files create a consistent version of the data on the H2 volume
that she can use for recovery testing, while the session continues to
replicate data from San Francisco to Oakland. As a result, she can carry out
the recovery testing without stopping the replication for any extended
duration of time.

If, at some point, the Metro Mirror session is suspended because of a
failure, Jane can use the practice session to restart the data replication
process. She maintains a consistent copy of the data at the Oakland site, in
case of a failure during the resynchronization process. When the session is
suspended, she can issue a Recover command to create a consistent
version of the data on the H2 volumes. After the Recover command
completes, she can issue the Start H1->H2 command to resynchronize the
data from the San Francisco site to the Oakland site.

If a failure occurs before the restarted session is in Prepared state, she has
a consistent version of the data on the H2 volumes. She only has to issue
the Recover command to put the session into Target Available state and
make the H2 volumes accessible from the servers. If the session was not in
Prepared state when it was suspended, the subsequent Recover command
does not issue the FlashCopy files to put the data on the H2 volumes. This
means that the consistent data on the H2 volumes is not overwritten if the
data to be copied to them is not consistent.

Metro Mirror Failover/Failback enabled for Open HyperSwap

Jane wants to run a Metro Mirror with Practice from San Francisco to
Oakland. She wants to verify the recovery procedure for the Oakland site,
but she cannot stop running the Metro Mirror session while she takes time
to practice a recovery. By using a Metro Mirror with Practice session, Jane
can practice the disaster recovery scenario in Oakland while the Metro
Mirror session runs uninterrupted. By practicing running the applications
at the Oakland site, Jane is better prepared to recover data if a disaster
occurs at the San Francisco site.

While the session is running in a Prepared state, Jane practices a recovery
at the Oakland site by issuing the Flash command. This command
momentarily pauses the session and starts a FlashCopy to the H2 volumes.
As soon as the FlashCopy is started, the session is restarted. These
FlashCopy files create a consistent version of the data on the H2 volume
that she can use for recovery testing, while the session continues to
replicate data from San Francisco to Oakland. As a result, she can carry out
the recovery testing without stopping the replication for any extended
duration of time.

If the Metro Mirror session is suspended because of a failure, Jane can use
the practice session to restart the data replication process while she
maintains a consistent copy of the data at the Oakland site, in case of a
failure during the resynchronization process. When the session is
suspended, she can issue a Recover command to create a consistent
version of the data on the H2 volumes. After the Recover command
completes, she can issue the Start H1->H2 command to resynchronize the
data from the San Francisco site to the Oakland site.

If a failure occurs before the restarted session is in Prepared state, she has
a consistent version of the data on the H2 volumes. She only has to issue
the Recover command to put the session into Target Available state and
make the H2 volumes accessible from the servers. If the session was not in
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Prepared state when it was suspended, the subsequent Recover command
does not issue the FlashCopy files to put the data on the H2 volumes. This
means that the consistent data on the H2 volumes is not overwritten if the
data to be copied to the volumes is not consistent.

Selecting a HyperSwap session
A global insurance company decided to use Tivoli Storage Productivity
Center for Replication to manage its disaster recovery environment. Jane
wants minimal data exposure, both for planned outages such as routine
maintenance, and for unplanned disasters. They have CKD volumes on
System Storage DS8000 devices, and use z/OS operating systems. They
have two data centers in New York.

Jane chooses a Metro Mirror recovery solution, because her priority is to
protect the system from regional disasters. Jane decides to use Metro
Mirror solution, because her company has two data centers located near
each other. Jane realizes that because she uses a z/OS operating system,
CKD, and System Storage DS8000 hardware, she can also use a
HyperSwap solution. Using Metro Mirror Failover/Failback with
HyperSwap, Jane can minimize the effects on any applications, while she
maintains the failover process to the secondary site. Jane decides Metro
Mirror Failover/Failback with HyperSwap is the best solution.

After installing and configuring Tivoli Storage Productivity Center for
Replication on z/OS, Jane starts the Tivoli Storage Productivity Center for
Replication GUI. She adds the Tivoli Storage Productivity Center for
Replication storage devices that she intends to use on all sites. From the
Session Overview page, Jane uses the Create Session wizard, and selects
the Metro Mirror Failover/Failback session type. She selects the Manage
H1H2 with HyperSwap option. After finishing the wizard, Jane clicks
Launch Add Copy Sets Wizard. She completes this wizard, and issues a
Start H1->H2 command. After the initial copy is completed, Jane can safely
replicate the data between both sites. She can also issue the HyperSwap
command between sites 1 and 2 to switch sites with minimal effect on the
application during either a disaster or maintenance period.

Performing a planned HyperSwap
Jane's company used Metro Mirror Failover/Failback with HyperSwap
sessions for the past three months. However, Jane needs to perform
maintenance on an H1 volume. During this time, Jane does not want the
applications or replication to be interrupted. To prevent this interruption,
before the maintenance is scheduled to begin, Jane uses the Tivoli Storage
Productivity Center for Replication GUI to perform a HyperSwap
operation to the H2 volumes. This process transitions the applications so
that the data is written to H2. To perform a planned HyperSwap operation,
Jane issues a HyperSwap command.

Understanding what happens when an unplanned HyperSwap occurs
Several weeks after the planned maintenance at Jane's company is
completed, an incident occurs at the H1 site. A disk controller fails, causing
one of the H1 volumes to encounter a permanent I/O error. Jane's data is
safe because she used Metro Mirror Failover/Failback with HyperSwap,
and the H2 volume is an exact duplicate of the H1 volume. When the
permanent I/O error is detected, a HyperSwap is triggered. The
application transitions to write data to the H2 volumes. The applications
are not interrupted.

Jane configured a Simple Network Management Protocol (SNMP) listener
to alert her to any events, so she receives the SNMP event that indicates
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that a HyperSwap occurred. Jane investigates the cause of the HyperSwap
process and uses the z/OS console to identify the volume that triggered
the HyperSwap process. Jane replaces the faulty disk controller. Then, to
recover from the unplanned HyperSwap process, Jane issues the Start
H2->H1 command.

Global Mirror
Global Mirror is a method of asynchronous, remote data replication between two
sites that are over 300 kilometers (km) apart. It maintains identical data in both the
source and target, where the source is located in one storage system and the target
is located in another storage system.

The data on the target is typically written a few seconds after the data is written to
the source volumes. When a write is issued to the source copy, the change is
propagated to the target copy, but subsequent changes are allowed to the source
before the target verifies that it received the change. Because consistent copies of
data are formed on the secondary site at set intervals, data loss is determined by
the amount of time since the last consistency group was formed. If the system fails,
Global Mirror might lose some data that was being transmitted when the failure
occurs. Using Global Mirror, you can ensure that data is recoverable and consistent
if a disaster occurs.

Global Mirror Single Direction

You can use a Global Mirror Single Direction session to run a Global Mirror
replication process from only the primary site.

For ESS, DS6000, and DS8000 storage systems, each copy set in the single direction
session consists of two host volumes and a journal volume. The following figure
illustrates how a Global Mirror Single Direction session works on an ESS, DS6000,
or DS8000 storage system.

For the following storage systems, each copy set in the Global Mirror Single
Direction session consists of two host volumes:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

The following figure illustrates how a Global Mirror Single Direction session works
on these storage systems.
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Global Mirror Either Direction with Two-Site Practice (ESS, DS6000,
and DS8000)

By using a Global Mirror Either Direction with Two-Site Practice session, you can
run Global Mirror replication from either the primary or secondary site. It
combines Global Mirror and FlashCopy to provide a point-in-time copy of the data
on a remote site at a distance over 300 km away from your first site. By using this
practice session, you can create volumes on both the primary and secondary site to
practice what you might do if a disaster occurred, without affecting the disaster
recovery capability.

Restriction: This replication method is available on only ESS, DS6000, and DS8000
storage systems.

The session consists of two host volumes, two intermediate volumes, and two
journal volumes. The following figure illustrates how a Global Mirror Either
Direction with Two-Site Practice session works.

Global Mirror Failover/Failback

Using Global Mirror Failover/Failback, your data exists on the second site that is
more than 300 km away, and you can use failover or failback processing to switch
the direction of the data flow. You can run your business from the secondary site.

For ESS, DS6000, and DS8000 storage systems, each copy set in the Global Mirror
Failover/Failback session consists of two host volumes and a journal volume. The
following figure illustrates how a Global Mirror Failover/Failback session works
on an ESS, DS6000, or DS8000 storage system.
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For the following storage systems, each copy set in the Global Mirror
Failover/Failback session consists of two host volumes:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified
v The XIV system

The following figure illustrates how a Global Mirror Failover/Failback session
works on these storage systems.

Global Mirror Failover/Failback with Practice

A Global Mirror Failover/Failback with Practice session combines Global Mirror
and FlashCopy features to provide a point-in-time copy of the data on a remote
site at a distance over 300 KM away from your primary site. You can use this to
practice what you might do if a disaster occurred, without affecting the disaster
recovery capability.

For ESS, DS6000, and DS8000 storage systems, each copy set in the Global Mirror
Failover/Failback with Practice session consists of two host volumes, an
intermediate volume, and a journal volume. The following figure illustrates how a
Global Mirror Failover/Failback with Practice session works on an ESS, DS6000, or
DS8000 storage system.
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For the following storage systems, each copy set in the Global Mirror
failover/failback with Practice session consists of two host volumes and an
intermediate volume:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

The following figure illustrates how a Global Mirror Failover/Failback with
Practice session works on these storage systems.

Examples

Read the following scenarios for information on using Global Mirror for
asynchronous, remote data replication between two sites.

Global Mirror Single Direction
Although Jane's FlashCopy and Metro Mirror copies were both planned,
Jane realizes that sometimes a failure can occur, and she wants to ensure
that the data is safe. Because Jane works in San Francisco, she wants her
other site to be far away if a disaster occurs locally. Her other site is based
in Houston. A minor earthquake occurs in San Francisco and power and
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communications both fails. Jane arranged for the data on customer
accounts that recently opened or closed to be asynchronously copied in
Houston, using Global Mirror. Jane risks losing the bytes of data that were
being processed when the tremor disrupted the processing in San
Francisco. However, she understands that it is minor inconvenience when
weighed next to the value of backing up her data to an area that is not
prone to earthquakes.

Global Mirror with Practice
Jane wants to run a Global Mirror with practice from San Francisco to
Houston. She plans to verify her recovery procedure for the Houston site,
but she cannot stop running the Global Mirror session while she takes time
to practice a recovery. By using a Global Mirror with Practice session, Jane
can practice her disaster recovery scenario in Houston while the Global
Mirror session runs uninterrupted. When she practices running the
applications at the Houston site, Jane is better prepared to recover the data
if a disaster ever strikes the San Francisco site.

Global Mirror Either Direction with Two-Site Practice
Jane wants to run a Global Mirror with Practice from San Francisco to
Houston. She plans to verify her recovery procedure for the Houston site,
but she cannot stop running the Global Mirror session while she takes time
to practice a recovery. By using a Global Mirror Either Direction with
Two-Site Practice session, Jane can practice her disaster recovery scenario
in Houston while the Global Mirror session runs uninterrupted. When she
practices running the applications at the Houston site, Jane is better
prepared to recover the data if a disaster ever strikes the San Francisco site.

Jane can use the Global Mirror Either Direction with Two-Site Practice
session to run asynchronous consistent data replication from either the San
Francisco site or the Houston site. She can practice the disaster-recovery
tasks at the target site, regardless of the location of the current production
site. Jane's business can run a consistent Global Mirror session from its
Houston site back to San Francisco while it runs a production site at
Houston.

Setting up Global Mirror for Resource Groups on System Storage
DS8000

If resource groups are defined on a System Storage DS8000, Global Mirror session
IDs might be defined for some users. To determine which session IDs are valid,
you must modify the rmserver.properties file and add the following property:
gm.master.sessionid.gm_role,session_name = xx

where gm_role is the role that has the master volume (for example, H1 in a Global
Mirror failover/failback session), session_name is the name of the session that uses
the session ID, and xx is the decimal number for the session ID.

Tip: System Storage DS8000 represents session IDs as a two-digit hexadecimal
number. Use the decimal version of that number. For example, if you want a
Global Mirror Failover/Failback session to use a session ID of 0F, the decimal
number is 15, as shown in the following example:
gm.master.sessionid.H2.11194_wprac=15

Metro Global Mirror (ESS and DS8000)
Metro Global Mirror is a method of continuous, remote data replication that
operates between three sites that are varying distances apart. Metro Global Mirror
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combines Metro Mirror synchronous copy and Global Mirror asynchronous copy
into a single session, where the Metro Mirror target is the Global Mirror source.

This replication method is available on only TotalStorage Enterprise Storage Server
Model 800 and System Storage DS8000 storage systems. You can select ESS storage
systems in only the H1 volume role. All other volume roles must use DS8000
volumes.

You can use both ESS and DS8000 volumes in the H1 volume role. If ESS
andDS8000 storage systems are both used in the H1 role, the DS8000 storage
system performs Incremental Resync processing, and the ESS storage system
performs a full copy operation. Because you cannot use the Incremental Resync
function with ESS, a full copy is required when you change from H1->H2->H3 to
H1>H3 and from H2->H1->H3 to H2->H3.

Attention: If you have Tivoli Storage Productivity Center for Replication for
System z sessions that contain Metro Global Mirror relationships, ensure that the
session does not contain system volumes (such as paging volumes) unless you
select the Manage H1-H2 with HyperSwap or the Enable Hardened Freeze option
for the session. By using these options, z/OS Input/Output Supervisor (IOS)
manages freeze operations for the volumes in the session, which prevents Tivoli
Storage Productivity Center for Replication from freezing the volumes and possibly
freezing itself.

Metro Global Mirror maintains a consistent copy of data at the remote site, with
minimal effect on applications at the local site. This remote mirroring function
works in combination with FlashCopy to provide a disaster-recovery solution that
includes the following features:
v Fast failover and failback
v Rapid reestablishment of three-site mirroring, without production outages
v Data currency at the remote site with minimal time lag at the local site, an

average of only 3 - 5 seconds for many environments
v Quick resynchronization of mirrored sites using only incremental changes

If Tivoli Storage Productivity Center for Replication runs on a z/OS operating
system, you can configure a Metro Global Mirror session to control the Metro
Mirror relationship between the primary and secondary site by using the
HyperSwap feature. With HyperSwap enabled, a failure on the primary storage
system causes an automatic HyperSwap operation, which transparently redirects
application I/O to the auxiliary storage system. The Global Mirror relationship
continues to run uninterrupted throughout this process. With this configuration,
you can achieve almost a zero data loss at larger distances.

Using synchronous mirroring, you can switch from local site H1 to remote site H2
during a planned or unplanned outage. It also provides continuous disaster
recovery protection of the H2 and H3 sites. You do not have to configure H2, if a
switch from site H1 occurs. With this configuration, you can reestablish
H2->H1->H3 recoverability while production continues to run at site H2.
Additionally, this setup can reduce the workload on site H1.

Important:

v If HyperSwap occurs by event when running a Metro Global Mirror with a
HyperSwap session, a full copy of the data occurs to return to a full three-site
configuration. If you issue a HyperSwap command when running a Metro
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Global Mirror with a HyperSwap session, a full copy does not occur. A full copy
is required only for an unplanned HyperSwap or a HyperSwap initiated using
the z/OS SETHS SWAP command.

v In Metro Global Mirror and Metro Global Mirror with Practice sessions, when
the H1 is on an ESS storage system, you might risk filling up the space efficient
journal volumes. Because incremental resynchronization is not available on the
ESS storage system, full copies are performed in many of the transitions.

Metro Global Mirror

A Metro Global Mirror session with Practice combines Metro Mirror, Global Mirror,
and FlashCopy across three sites to provide a point-in-time copy of the data on the
third site.

The following figure illustrates how a Metro Global Mirror session works.

Metro Global Mirror with Practice

A Metro Global Mirror session with Practice combines Metro Mirror, Global Mirror,
and FlashCopy across three sites to provide a point-in-time copy of the data on the
third site. You can use this session to practice what you might do if a disaster
occurred without losing your disaster recovery capability.

The session consists of three host volumes, an intermediate volume, and a journal
volume. The following figure illustrates how a Metro Global Mirror with Practice
session works.
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Note: In Metro Global Mirror and Metro Global Mirror with Practice sessions,
when the H1 is on an ESS storage system, you might risk filling up the space
efficient journal volumes. Because incremental resynchronization is not available on
the ESS storage system, full copies are performed in many of the transitions.

Examples

Read the following scenarios for information on using Metro Global Mirror for
continuous, remote data replication between three sites.

Metro Global Mirror
Although Jane works in San Francisco, she wants to run the business from
either Oakland, the secondary site, or Houston, the tertiary site. Jane can
use Metro Global Mirror with Failover/Failback to switch the direction of
the data flow, so that she can run the business from either Oakland or
Houston. Using Metro Global Mirror, Jane has zero data loss at the
secondary site and minimal data loss at the tertiary site.

Metro Global Mirror with Practice
Jane wants to run a Metro Global Mirror with Practice from San Francisco
to Houston. She plans to verify her recovery procedure for the Houston
site. However, she cannot stop running the Metro Global Mirror session
while she takes time to practice a recovery. By using a Metro Global Mirror
with Practice session, Jane can practice her disaster recovery scenario in
Houston while the Metro Global Mirror session runs uninterrupted. When
she practices running the applications at the Houston site and is prepared
to run the applications at the Oakland site, if necessary, Jane is prepared to
recover data if a disaster occurs at the San Francisco site.

Jane can use Metro Global Mirror with Practice to switch the direction of
the data flow, so that she can run the business from either Oakland or
Houston. Using Metro Global Mirror, Jane has zero data loss at the
secondary site and minimal data loss at the tertiary site.
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Managing a session with HyperSwap and Open HyperSwap
replication
HyperSwap and Open HyperSwap provide high availability of data if a primary
disk storage system failure occurs. When a failure occurs in writing I/O to the
primary storage system, the failure is detected by IOS, and IOS automatically
swaps the I/O to the secondary site with no user interaction and minimal
application effect.

Sessions that can be enabled for HyperSwap or Open HyperSwap:

You can create sessions that enable swapping, which provides a session with a
highly available business continuity solution.

Sessions that can enable HyperSwap

The following session types can enable HyperSwap processing:
v Basic HyperSwap
v Metro Mirror with Failover/Failback
v Metro Global Mirror

To enable HyperSwap processing, the following conditions must apply:
v The session is running on a Tivoli Storage Productivity Center for Replication

server that is running on IBM z/OS.
v The volumes are only for TotalStorage Enterprise Storage Server, System Storage

DS8000, and DS6000 systems.
v The volumes are count key data (CKD) volumes that are attached to the z/OS

system.

Sessions that can enable Open HyperSwap

Only Metro Mirror with Failover/Failback session type can enable Open
HyperSwap processing.

To enable Open HyperSwap processing, the following conditions must apply:
v The volumes in the session are System Storage DS8000 5.1 or later volumes.
v The volumes in the session are fixed block and mounted to IBM AIX 5.3 or AIX

6.1 hosts with the following modules installed:
– Subsystem Device Driver Path Control Module (SDDPCM) version 3.0.0.0 or

later
– Multi-Path Input/Output (MPIO) module (the version that is provided with

AIX version 5.3 or 6.1)
v The connections between the AIX host systems and the Tivoli Storage

Productivity Center for Replication server are established.

Setting up the environment for HyperSwap:

You must set up an environment in which you can run HyperSwap processing
before you can enable HyperSwap for a IBM Tivoli Storage Productivity Center for
Replication session.

Complete the following steps before you enable HyperSwap. For more information
about these steps, see the IBM Tivoli Storage Productivity Center for Replication
for System z Installation and Configuration Guide.
1. Install IBM Tivoli Storage Productivity Center for Replication for System z.
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2. Set up the data store and configure other necessary system settings.
3. Ensure that all RESERVEs are converted to global enqueues (ENQs).
4. Ensure that all volumes in the session that you are enabling for HyperSwap are

attached to the IBM z/OS system that runs Tivoli Storage Productivity Center
for Replication.

5. Set up and start the IOSHSAPI and HSIB tasks.

Setting up the environment for Open HyperSwap:

You must set up an environment in which you can run Open HyperSwap
processing before you can enable Open HyperSwap for a IBM Tivoli Storage
Productivity Center for Replication session.

Complete the following steps before you enable Open HyperSwap.
1. Ensure that the IBM AIX hosts and IBM System Storage DS8000 meet the

following hardware and software requirements:

AIX requirements
You can find the supported AIX version for each Tivoli Storage
Productivity Center for Replication release in the support matrix at
http://www.ibm.com/support/docview.wss?uid=swg21386446. Click
the link for the applicable release under Agents, Servers, and GUI.

You must have the following AIX modules installed:
v Subsystem Device Driver Path Control Module (SDDPCM) version

3.0.0.0 or later
v Multi-Path Input/Output (MPIO) module (the version that is

provided with AIX)

System Storage DS8000 hardware requirements
The Open HyperSwap function requires System Storage DS8000 5.1 or
later.

You cannot use Open HyperSwap with High Availability Cluster
Multi-Processing (HACMP).

2. Create connections from Tivoli Storage Productivity Center for Replication to
the AIX hosts by following the instructions at “Adding a host system
connection” on page 685.

3. Assign copy set volumes from the storage device to the host by using the
System Storage DS8000 command-line interface (CLI) or the graphical user
interface (GUI).

4. Run the AIX cfgmgr command to discover the volumes that are assigned to the
host.

Considerations for Open HyperSwap and the AIX host:

v A single session that has the Open HyperSwap function enabled can manage
multiple hosts; however, each host can be associated with only one session.
Multiple hosts can share the session.

v For AIX 5.3, a single host can manage a maximum of 1024 devices that are
enabled for Open HyperSwap processing on the host, with eight logical paths
configured for each copy set in the session. For AIX 6.1, a single host can
manage a maximum of 1024 devices that are enabled for Open HyperSwap
processing on the host, with 16 logical paths that are configured for each copy
set in the session.

Chapter 7. Managing replication 721

http://www.ibm.com/support/docview.wss?uid=swg21386446


v If an application on the host opened a device, a Tivoli Storage Productivity
Center for Replication session for that device cannot be ended. The Terminate
command fails. To end the session, you must either close the application or
remove the copy sets from the session. If you remove copy sets from the session,
you must ensure that the application writes the data to the correct volume when
the copy set relationship is restored.

v Open HyperSwap processing can fail on a subset of hosts for the session and
continue to run on the remaining hosts for the same session. In this situation,
you must determine the best action to take if the application is writing data to
volumes on the source system and to volumes on the target system.

v To enable Open HyperSwap processing on the host, see the IBM System Storage
Multipath Subsystem Device Driver User's Guide.

Configuring timers to support Open HyperSwap:

You can configure timeout values for the storage system, Tivoli Storage
Productivity Center for Replication, and AIX hosts systems. These values can affect
the operation of Open HyperSwap.

The following various timeout values can affect Open HyperSwap:

Storage system quiesce timeout value
This value is the time when the storage system starts a quiesce operation.
When the timer value expires, I/O is resumed on the primary device. The
default timeout value is 2 minutes, but the value can be set from 30 to 600
seconds. To set the quiesce timeout value, use the chdev command in the
IBM System Storage Multipath Subsystem Device Driver User's Guide.

Storage system long busy timeout value
This value is the time in seconds that the logical subsystem (LSS)
consistency group volume stays in the long busy state after a remote
mirror and copy error is reported.

Timeout values for the applications that are on the host
The various applications that are running on the host have timeout values.
The timeout values vary depending on the application.

Considerations for setting timers

Consider the following information for setting timers:
v If the host quiesce timer is set to a shorter value than the Tivoli Storage

Productivity Center for Replication response timer, an I/O swap failure can
occur. If a storage system triggers an unplanned failover and if the storage
system quiesce timer expires before Tivoli Storage Productivity Center for
Replication responds, the host attempts to write I/O to the primary volume
where the loss of access occurred. If the hardware condition that caused the loss
of access continues, the write I/O operation fails again and an unplanned Open
HyperSwap is not performed.

v If the host quiesce timer is set to a longer value than the Tivoli Storage
Productivity Center for Replication response timer, an application timeout might
occur if Open HyperSwap takes too long to complete.

Enabling a session for HyperSwap or Open HyperSwap:

Enabling HyperSwap or Open HyperSwap for a session provides business recovery
and business continuity.

722 IBM Tivoli Storage Productivity Center: User's Guide



Ensure that you can use the HyperSwap or Open HyperSwap functions in your
environment. See “Setting up the environment for HyperSwap” on page 99 or
“Setting up the environment for Open HyperSwap” on page 100.

Enable a HyperSwap or Open HyperSwap session by completing the following
steps:
1. In the Tivoli Storage Productivity Center for Replication navigation tree, select

Sessions. Click the button next to the session that you want to enable.
2. From the Select Action menu, select View/Modify Properties and click Go. If

you did not create the session, click Create Session. You can enable the
HyperSwap or Open HyperSwap function on the Properties page

3. In ESS / DS Metro Mirror Options, select the appropriate HyperSwap or Open
HyperSwap options:
v Manage H1-H2 with HyperSwap. This option enables a session to manage

the H1-H2 sequence using HyperSwap. If you select this option, select from
the following additional options.
– Disable HyperSwap. Select this option to prevent a HyperSwap from

occurring by command or event.
– On Configuration Error. Choose one of the following options:

- Partition the system(s) out of the sysplex. Select this option to partition
out of the sysplex when a new system is added to the sysplex and
encounters an error in loading the configuration. A restart of your
system is required if you select this option.

- Disable HyperSwap. Select this option to prevent a HyperSwap from
occurring by command or event.

– On Planned HyperSwap Error. Choose one of the following options:
- Partition out the failing system(s) and continue swap processing on

the remaining system(s). Select this option to partition out the failing
system and continues the swap processing on any remaining systems.

- Disable HyperSwap after attempting backout. Select this option to
stop the HyperSwap action, and disable the HyperSwap commands or
events.

– On Unplanned HyperSwap. Choose one of the following options:
- Partition out the failing system(s) and continue swap processing on

the remaining system(s). Select this option to partition out the failing
systems and continues the HyperSwap processing on the remaining
systems when a new system is added to the sysplex and HyperSwap
does not complete. A restart of your system is required if you select this
option.

- Disable HyperSwap after attempting backout. Select this option to
stop the HyperSwap action, and disable the HyperSwap commands or
events.

v Manage H1-H2 with Open HyperSwap. If volumes are attached to an IBM
AIX host, Tivoli Storage Productivity Center for Replication can manage the
H1-H2 sequence of a Metro Mirror session using Open HyperSwap. If this
option is selected, a failure on the host accessible volumes triggers a swap,
which redirects application I/O to the secondary volumes. Only volumes
that are currently attached to the host systems that are defined on the Tivoli
Storage Productivity Center for Replication Host Systems panel are eligible
for Open HyperSwap.
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– Disable Open HyperSwap. Select this option to prevent a swap from
occurring by a command or event while keeping the configuration on the
host system and all primary and secondary volumes coupled.

4. Click OK to apply the selected options.

Restarting an AIX Host System that is enabled for Open HyperSwap:

When an AIX host system is restarted, the host automatically opens any volumes
for I/O that were open before the system was restarted. If Open HyperSwap was
enabled for a set of volumes on the host system, the host must determine which
storage system is the primary system before the host can allow the volumes to be
opened.

If the Metro Mirror relationship for the set of volumes is in Prepared or Suspended
state and the host has connectivity to both the primary and secondary storage
systems, the host can determine through the hardware which storage system is the
primary system. In this situation, the host automatically opens the volumes.

If the Metro Mirror relationship for the set of volumes is in Prepared state and the
host has connectivity to only the secondary storage system, all I/O to the volumes
might be blocked on the host system. The I/O might be blocked until the host can
verify the primary volume in the relationship. The AIX varyonvg command fails to
open the volumes for I/O to prevent the application from writing to an incorrect
volume. If the host can determine which volume is the primary volume in the
relationship and connectivity to the primary storage system is still lost, a
Hyperswap event is triggered. This event causes all I/O to be automatically
opened and directed to the secondary storage system.

If the Metro Mirror relationship for the set of volumes is in Target Available state
or the host system does not have connectivity and is unable to determine which
site is the primary site, all I/O to the volumes are blocked on the host system. The
Target Available state occurs after a Hyperswap or a Recover command is issued
for the session. The varyonvg command fails to open the volumes for I/O to
prevent the application from writing to an incorrect volume.

Unblocking I/O on the host system after a host system restart

When any of the previous scenarios cause I/O to be blocked, manual actions might
be necessary to remove the block.

If the relationships are in Target Available state on the hardware, issue the Start
command to the session in the required direction of the relationship. This action
defines the primary storage system for the host. The host system can allow the
volumes to be opened for I/O processing.

If the relationships cannot be restarted, or the host cannot determine the primary
storage system, it might be necessary to manually decouple the volumes on the
host system.

To decouple the volumes, complete one of the following tasks:
v Stop the session or remove the copy set. This action requires a full copy when

the relationships are restarted.
v Remove Object Data Manager (ODM) entries by using the following command:

odmdelete -o Volume_Equivalency
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Restriction: This command deletes copy set information; use it only for this
scenario.

Planned and unplanned swaps:

After a session is enabled for HyperSwap or Open HyperSwap processing and
reaches Prepared state, Tivoli Storage Productivity Center for Replication loads the
configuration of volumes that can be swapped to a z/OS or AIX operating system.

When the load is complete, the session can start a planned or unplanned swap.
The H1-H2 role pair of the session shows a type of HS. An "H" is displayed over
the connection in the dynamic image for that role pair, as shown in the following
figure.

Completing a Planned Swap

When the session configuration is loaded on z/OS for HyperSwap or AIX for
Open HyperSwap, the session is considered swap capable. There may be cases
such as a planned maintenance or a migration from the primary storage, in which
a planned swap might be required. When the session is in swap capable state, a
planned swap can be completed by issuing the HyperSwap command for the
session.

After you run a planned swap for z/OS HyperSwap and Open HyperSwap, the
session transitions to Target Available state and all the H1-H2 pairs are in Target
Available state. If the H1-H2 role pair was consistent at the time of the swap, the
session has a status of Normal, which indicates that H1-H2 is consistent. If the
H1-H2 role pair was not consistent at the time of the swap, the session has a status
of SEVERE. The active host on the session is shown as H2.

All I/O is redirected to the H2 volumes. After a successful swap to site 2, you
cannot enable the copy function to site 2. The only way to restart the copy
processing is by issuing the Start H2->H1 command. To have the volumes
protected with high availability and disaster recovery again, correct the error that
caused the swap to occur, and manually restart the session to begin copying data
to the other site.

The following figure illustrates a planned swap operation.
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Unplanned swaps

When the session configuration is loaded on z/OS for HyperSwap processing or
on AIX for Open HyperSwap processing, the session is considered swap capable. If
a primary I/O error occurs, a swap occurs automatically. For HyperSwap, z/OS
completes the swap and then alerts Tivoli Storage Productivity Center for
Replication that a swap occurred. For Open HyperSwap, Tivoli Storage
Productivity Center for Replication and the AIX host work together to complete
the swap.

When an unplanned swap occurs for HyperSwap and Open HyperSwap, the
session transitions to Target Available state and all the H1-H2 pairs are in Target
Available state. If the H1-H2 role pair was consistent at the time of the swap, the
session has a status of Normal and indicates that H1-H2 is consistent. If the H1-H2
role pair was not consistent at the time of the swap, the session might show a
status of SEVERE. The active host on the session is shown as H2.

All I/O is redirected to the H2 volumes. After a successful swap to site 2, you
cannot enable the copy function to site 2. Therefore, it is not possible to issue a
Start H1->H2 command. The only way to restart the copy processing is by issuing
a Start H2->H1 command. To have the volumes protected with high availability
and disaster recovery again, correct the error that caused the swap to occur, and
manually restart the session to begin copying data to the other site.

The following figure illustrates an unplanned swap.
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Scenarios that require a full copy in Metro Global Mirror with HyperSwap
sessions

You must run a full copy to return to the three-site configuration after a swap
when the following conditions occur:
v If you run a Metro Global Mirror session with the HyperSwap function and you

issue the HyperSwap command by using the z/OS HyperSwap API.
v If you run a Metro Global Mirror session with the HyperSwap function and an

unplanned swap occurs.

Verifying a session for a planned or unplanned swap:

You can verify whether a session is capable of a planned or unplanned swap from
the z/OS console on HyperSwap or the AIX host on Open HyperSwap.

Verify the status of HyperSwap from the z/OS console:
1. View the overall status of the HyperSwap session. Issue the ds hs,status

command. For example:
15.03.06 SYSTEM1 d hs,status
15.03.06 SYSTEM1 STC00063 IOSHM0303I HyperSwap Status 531
Replication Session: SR_HS
HyperSwap enabled
New member configuration load failed: Disable
Planned swap recovery: Disable
Unplanned swap recovery: Disable
FreezeAll: No
Stop: No

2. Verify all the volumes in the configuration. Issue the ds hs,config(detail,all)
command. For example:
15.03.51 SYSTEM1 d hs,config(detail,all)
15.03.51 SYSTEM1 STC00063 IOSHM0304I HyperSwap Configuration 534
Replication Session: SR_HS
Prim. SSID UA DEV# VOLSER Sec. SSID UA DEV# Status
06 02 00F42 8K3602 06 04 00FA2
06 01 00F41 8K3601 06 03 00FA1
06 00 00F40 8K3600 06 02 00FA0

Verify the status of Open HyperSwap from the AIX host:
1. View the session association and the path that the I/O is being routed to. The

path is indicated by an asterisk. Issue the pcmpath query device command. For
example:
host1> pcmpath query device 14

DEV#: 14 DEVICE NAME: hdisk14 TYPE: 2107900 ALGORITHM: Load Balance
SESSION NAME: session1
OS Direction: H1<-H2
==========================================================================
PRIMARY SERIAL: 25252520000
-----------------------------
Path# Adapter/Path Name State Mode Select Errors

0 fscsi0/path0 CLOSE NORMAL 6091 0
1 fscsi0/path2 CLOSE NORMAL 6300 0
2 fscsi1/path4 CLOSE NORMAL 6294 0
3 fscsi1/path5 CLOSE NORMAL 6187 0

SECONDARY SERIAL: 34343430000 *
-----------------------------
Path# Adapter/Path Name State Mode Select Errors

4 fscsi0/path1 CLOSE NORMAL 59463 0
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5 fscsi0/path3 CLOSE NORMAL 59250 0
6 fscsi1/path6 CLOSE NORMAL 59258 0
7 fscsi1/path7 CLOSE NORMAL 59364 0

Temporarily disabling HyperSwap or Open HyperSwap:

In some situations, it might be necessary to temporarily disable the HyperSwap or
Open HyperSwap function for a session.

You might want to disable HyperSwap or Open HyperSwap in the following
circumstances:
v If you are performing maintenance on the system
v If one sysplex member cannot communicate with one or more volumes

Complete these steps to disable Open HyperSwap for a specific session:
1. In the Tivoli Storage Productivity Center for Replication navigation tree, select

Sessions.
2. Select the sessions for which you want to disable the HyperSwap or Open

HyperSwap function.
3. Select View/Modify Properties from the Select Actions list, and click Go.
4. Select Disable HyperSwap or Disable Open HyperSwap, and click OK.

Tip: On management servers that run on a z/OS operating system, you can
disable the HyperSwap function from an MVS command prompt window by
entering the SETHS DISABLE command.

Using active and standby Tivoli Storage Productivity Center for Replication
servers with HyperSwap or Open HyperSwap:

You can set up an active and standby management server configuration with
HyperSwap or Open HyperSwap.

Active and standby servers with HyperSwap

When the storage system is set up to connect through the z/OS interface, the
connection information is sent to the standby server and a connection is attempted.
The connection might fail if the standby server does not run on a z/OS operating
system or does not have access to the same volumes. If the connection fails and the
standby server resumes the processing, the standby server cannot manage the
HyperSwap processing.

On the z/OS system, if the session configuration was successfully loaded before
the HyperSwap processing, the z/OS system can manage the HyperSwap
processing. If the z/OS system swaps the volumes but cannot communicate with
the Tivoli Storage Productivity Center for Replication server, the session is set to
Suspended or Severe state. To set the session to Target Available state, clear the
Manage H1-H2 with Hyperswap option, and issue the Recover command for the
session.

Active and standby servers with Open HyperSwap

When there is an active and standby management server configuration and a host
system connection is added to the active server, a connection is attempted between
the host system and the standby server. After AIX loads the session configuration,
Open HyperSwap processing is possible only if there is communication between
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AIX and the Tivoli Storage Productivity Center for Replication server. If a standby
server resumes the processing and is unable to connect to the host system that
manages the swap, the session cannot run Open HyperSwap processing. You must
activate communication to the host system before the session can run Open
HyperSwap processing.
Related tasks:
“Managing management servers” on page 664
This section provides information about how to set up active and standby
management servers, restore a lost connection between the management servers, or
perform a takeover on the standby management server.

Session commands
The commands that are available for a session depend on the session type.

Commands are issued synchronously to IBM Tivoli Storage Productivity Center for
Replication sessions . Any subsequent command issued to an individual session is
not processed until the first command has completed. Some commands can take an
extended amount of time to complete, such as the Start command as it sets up the
hardware. The GUI continues to allow you to issue commands to other sessions
and not hold up functionality. When a command has completed, the console
displays the results of the command.

Basic HyperSwap commands
Use this information to learn about commands available for Basic HyperSwap
sessions.

Note: Individual suspend and recover commands are not available in HyperSwap.

Table 71. Basic HyperSwap commands

Command Action

HyperSwap Triggers a HyperSwap where I/O is redirected from the source
volume to the target volume, without affecting the application
using those volumes. You can use this command if you want to
perform maintenance on the original source volumes.

Start H1->H2 Starts copying data synchronously from H1 to H2 in a Metro
Mirror session.
Note: A session might go into a Severe state with error code
1000000 before the session returns to Normal/Prepared State
and HyperSwap Capable. The duration of the Severe state
depends on how large of a session is running.

Start H2->H1 Starts copying data synchronously from H2 to H1 in a Metro
Mirror session. You can issue this command only after the
session has been swapped and the production site is H2. To
enable data protection when the H1 volumes are available
again, start I/O to the H2 volumes, and issue this command to
replicate data from the H2 volumes to H1 volumes.

Stop Suspends updates to all the targets of pairs in a session. You
can issue this command at any time during an active session.
Note: After you issue the stop command, targets might not be
consistent.

Terminate Removes all physical copies and relationships from the
hardware during an active session.
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FlashCopy commands
Use this information to learn about commands available for FlashCopy sessions.

Table 72. FlashCopy commands

Command Action

Start Performs any steps necessary to define the relationship before
performing a FlashCopy operation. For ESS, DS6000, and
DS8000, this command is not an option. Issue this command to
put the session in the prepared state for the following storage
systems:

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

Flash Performs the FlashCopy operation using the specified options.
Issue the Flash command to create a data consistent
point-in-time copy for a FlashCopy Session with volumes on
the following storage systems:

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

For a FlashCopy session containing ESS, DS6000, and DS8000
volumes, the Flash command by itself is not sufficient to create
a consistent copy. To create a consistent copy using the ESS,
DS6000, and DS8000 Flash commands, you must quiesce
application I/O before issuing the Flash command.

InitiateBackgroundCopy Copies all tracks from the source to the target immediately,
instead of waiting until the source track is written to. This
command is valid only when the background copy is not
already running.

Terminate Removes all active physical copies and relationships from the
hardware during an active session.

If you want the targets to be data consistent before removing
their relationship, you must issue the InitiateBackgroundCopy
command if NOCOPY was specified, and then wait for the
background copy to complete by checking the copying status of
the pairs.

Snapshot commands
Use this information to learn about commands that are available for Snapshot
sessions and groups. A snapshot group is a grouping of snapshots of individual
volumes in a consistency group at a specific point in time.

Table 73. Snapshot session commands

Command Action

Create Snapshot Creates a snapshot of the volumes in the session

Restore Restores the H1 volumes in the session from a set of snapshot
volumes. You must have at least one snapshot group to restore
from. When you issue this command in the Tivoli Storage
Productivity Center for Replication graphical user interface
(GUI), you are prompted to select the snapshot group.
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Table 74. Snapshot group commands

Command Action

Delete Deletes the snapshot group and all the individual snapshots
that are in the group from the session and from the XIV
system. If the deleted snapshot group is the last snapshot
group that is associated with the session, the session returns to
the Defined state.

Disband Disbands the snapshot group. When a snapshot group is
disbanded, the snapshot group no longer exists. All snapshots
in the snapshot group become individual snapshots that are no
longer associated to the consistency group or the session. After
a snapshot group is disbanded, it is no longer displayed in or
managed by Tivoli Storage Productivity Center for Replication.
If the disbanded snapshot group is the last snapshot group that
is associated with the session, the session returns to the
Defined state.

Duplicate Duplicates the snapshot group. When a snapshot group is
duplicated, a new snapshot group is created with new
snapshots for all volumes that are in the duplicated group. The
name of the duplicated snapshot group is generated
automatically by the XIV system.

Lock Locks a snapshot group. If the snapshot group is locked, write
operations to the snapshots that are in the snapshot group are
prevented. By default, a snapshot group is locked when it is
created. This action is valid only if the snapshot group is
unlocked.

Overwrite Overwrites the snapshot group to reflect the data that is on the
H1 volume.

Rename Renames the snapshot group to a name that you provide. The
name can be a maximum of 64 alphanumeric characters.

Restore Restores the contents of a snapshot group by using another
snapshot group in the session. Both of the snapshot groups
must contain the same subset of volumes.

Set Priority Sets the priority in which a snapshot group is deleted. The
value can be the number 1 - 4. A value of 1 specifies that the
snapshot group is deleted last. A value of 4 specifies that the
snapshot group is deleted first.

Unlock Unlocks a snapshot group. If the snapshot group is unlocked,
write operations to the snapshots that are in the snapshot
group are enabled and the snapshot group is displayed as
modified. This action is valid only if the snapshot group is
locked.

Metro Mirror commands
Use this information to learn about commands available for Metro Mirror sessions.

Table 75. Metro Mirror commands

Command Action

Enable Copy to Site 1 Run this command and confirm that you want to reverse the
direction of replication before you reverse the direction of
copying in a failover and failback session. After you issue this
command, the Start H2->H1 command becomes available.
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Table 75. Metro Mirror commands (continued)

Command Action

Enable Copy to Site 2 Run this command and confirm that you want to reverse the
direction of replication before reversing the direction of
copying in a failover and failback session. After you issue this
command, the Start H1->H2 command becomes available.

HyperSwap Triggers a HyperSwap where I/O is redirected from the source
volume to the target volume, without affecting the application
using those volumes. You can use this command if you want to
perform maintenance on the original source volumes. This
command is available only for Tivoli Storage Productivity
Center for Replication for System z.

Start Establishes a single-direction session with the hardware and
begins the synchronization process between the source and
target volumes.

Start H1->H2 Establishes Metro Mirror relationships between the H1 volumes
and the H2 volumes, and begins data replication from H1 to
H2.

Start H2->H1 Establishes Metro Mirror relationships between the H2 volumes
and the H1 volumes and starts data replication from H2 to H1.
Indicates direction of a failover and failback between two hosts
in a Metro Mirror session. If the session has been recovered
such that the production site is now H2, you can issue the Start
H2->H1 command to start production on H2 and start data
replication.

Stop Inconsistently suspends updates to all the targets of pairs in a
session. This command can be issued at any point during an
active session.
Note: Targets after the suspend are not considered to be
consistent.

StartGC Establishes Global Copy relationships between the H1 volumes
and the H2 volumes, and begins asynchronous data replication
from H1 to H2. While in the Preparing state, it will not change
to the Prepared state unless you switch to Metro Mirror.

Suspend Causes all target volumes to remain at a data-consistent point
and stops all data that is moving to the target volumes. This
command can be issued at any point during a session when the
data is actively being copied.
Note: It is recommended that you avoid using the same LSS
pairs for multiple Metro Mirror sessions. Metro Mirror uses a
freeze command on ESS, DS6000, and DS8000 storage systems
to create the data-consistent point. If there are other Metro
Mirror sessions overlapping the same LSS pairs as in this
session, those sessions are also suspended.

When a Suspend command is issued to a source volume in an
LSS that has source volumes in another active Metro Mirror
session, the other source volumes are affected only if they have
the same target LSS. The primary volumes are suspended, but
volumes in the same source LSS that have target volumes in a
different LSS are not affected because they use a different PPRC
path connection.

Recover Issues the Recover command to suspended sessions. This
command performs the steps necessary to make the target
available as the new primary site. Upon completion of this
command, the session becomes Target Available.
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Table 75. Metro Mirror commands (continued)

Command Action

Terminate Removes all copy relationships from the hardware during an
active session. If you want the targets to be data consistent
before removing their relationship, you must issue the Suspend
command, then the Recover command, and then the Terminate
command.

Metro Mirror with Practice commands
Use this information to learn about commands available for Metro Mirror with
Practice sessions.

Table 76. Metro Mirror with Practice commands

Command Action

Enable Copy to Site 1 Run this command and confirm that you want to reverse the
direction of replication before you reverse the direction of copying
in a failover and failback session. After you issue this command,
the Start H2->H1 command becomes available.

Enable Copy to Site 2 Run this command and confirm that you want to reverse the
direction of replication before reversing the direction of copying
in a failover and failback session. After you issue this command,
the Start H1->H2 command becomes available.

Flash Creates a FlashCopy image from I2 volumes to H2 volumes. The
amount of time for this to occur will vary depending on the
number of copy sets in the session.
Note: For ESS, DS6000, and DS8000 storage systems, the Flash
command uses the freeze and thaw processing to create a data
consistent point for the FlashCopy. If there is another Metro
Mirror session overlapping on one or more of the same LSS pairs,
that session will be suspended. It is also possible that the
suspension of the other session might cause the Metro Mirror
session to remain suspended after the flash command is issued
instead of returning to Prepared state. Avoid using the same LSS
pairs for multiple Metro Mirror sessions if possible.

Start H1->H2 Establishes a Metro Mirror relationship from the H1 volumes to
the I2 volumes, and begins data replication.

Start H2->H1 Establishes a Metro Mirror relationship from H2 to H1 and begins
data replication.

StartGC_H1H2 Distinguishes when the session is in the Preparing state from H1
to I2 and begins the asynchronous process between the source
and target volumes. While in the Preparing state the session will
not change to the Prepared state unless you switch to Metro
Mirror.

StartGC_H2H1 Distinguishes when the session is in the Preparing state from H2
to H1 and begins the asynchronous process between the source
and target volumes. While in the Preparing state the session will
not change to the Prepared state unless you switch to Metro
Mirror.
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Table 76. Metro Mirror with Practice commands (continued)

Command Action

Suspend Causes all target volumes to remain at a data-consistent point and
stops all data that is moving to the target volumes. This
command can be issued at any point during a session when the
data is actively being copied.
Note: The Metro Mirror command uses a freeze command on the
ESS, DS6000, and DS8000 devices to create the data-consistent
point. If there are other Metro Mirror sessions overlapping the
same LSS pairs as in this session, those sessions will also become
suspended. Avoid using the same LSS pairs for multiple Metro
Mirror sessions.

When a Suspend command is issued to a source volume in an
LSS that has source volumes in another active Metro Mirror
session, the other source volumes are affected only if they have
the same target LSS. The primary volumes are suspended, but
volumes in the same source LSS that have target volumes in a
different LSS are not affected because they use a different PPRC
path connection.

Stop Inconsistently suspends updates to all the targets of pairs in a
session. This command can be issued at any point during an
active session.
Note: Targets after the suspend are not considered to be
consistent.

Terminate Terminates all copy relationships on the hardware.

Recover Takes a point-in-time copy of the data on I2 to the H2 volumes,
enabling the application to be attached and run from the H2
volumes on site 2.
Note: The point-in-time copy is performed when the session is in
a recoverable state to avoid that previous consistent data on H2
are overwritten by inconsistent data upon Recover. You can issue
the Flash command if you want to force a point-in-time copy
from I2 to JH2 volumes afterwards.

Global Mirror commands
Use this information to learn about commands available for Global Mirror sessions.

Table 77. Global Mirror commands

Command Action

Enable Copy to Site 1 Run this command and confirm that you want to reverse the
direction of replication before you reverse the direction of
copying in a failover and failback session. After you issue this
command, the Start H2->H1 command becomes available.

Enable Copy to Site 2 Run this command and confirm that you want to reverse the
direction of replication before reversing the direction of
copying in a failover and failback session. After you issue this
command, the Start H1->H2 command becomes available.

Start Establishes all relationships in a single-direction session and
begins the process necessary to start forming consistency
groups on the hardware.
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Table 77. Global Mirror commands (continued)

Command Action

Start H1->H2 Starts copying data from H1 to H2 in a Global Mirror
Failover/Failback session. Establishes the necessary
relationships in the session and begins the process necessary to
start copying data from the H1 site to the H2 site and to start
forming consistency groups.

Start H2->H1 Starts copying data from H2 to H1 in a failover and failback
session for TotalStorage Enterprise Storage Server Model 800,
System Storage DS6000, and System Storage DS8000. If a
recover was performed on a session such that the production
site is now H2, you can issue a Start H2->H1 to start moving
data back to Site 1. However, this start does not provide
consistent protection as it copies only asynchronously back
because of the long distance. A Global Copy relationship is
used. When you are ready to move production back to Site 1,
issue a suspend to the session; this puts the relationships into a
synchronized state and suspends them consistently. Sessions
are consistent when copying H2->H1 for the following storage
systems:

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

StartGC H1->H2

This command is
available only for Global
Mirror Failover/Failback
and Global Mirror
Failover/Failback with
Practice sessions.

Establishes Global Copy relationships between site 1 and site 2
and begins asynchronous data replication from H1 to H2. To
change the session state from Preparing to Prepared, you must
issue the Start H1->H2 command and the session must begin to
form consistency groups.

There is no disaster recovery protection for Global Copy
relationships. If a disaster such as the loss of a primary storage
system or a link failure between the sites occurs, the session
might be inconsistent when you issue the Recover command.

This command is available for the following storage systems:

v TotalStorage Enterprise Storage Server Model 800

v System Storage DS6000

v System Storage DS8000

Suspend Stops all consistency group formation when the data is actively
being copied and suspends the H1->H2 Global Copy pairs. To
issue the pause command to the Global Mirror session on the
hardware without suspending the Global Copy pairs, open the
rmserver.properties file and add the following property to
disable the Global Copy suspension on the Suspend command:
csm.server.sus_gc_pairs_on_gm_pause = false. The default
property is true and the Suspend command automatically
suspends the Global Copy pairs.

Recover Issue this command to recover the session to the target site.
This command performs the steps necessary to make the target
host volumes consistent and available for access as the new
primary site. Upon completion of this command, the session
becomes Target Available. Do not access H2 volumes until the
Recover command is completed and the session displays Target
Available and Recoverable. A Recover to H2 also establishes a
point-in-time copy to J2 to preserve the last consistent data.
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Table 77. Global Mirror commands (continued)

Command Action

Terminate Removes all physical copies and relationships from the
hardware during an active session.

If you want the targets to be data consistent before removing
their relationship, you must issue the Suspend command, the
Recover command, and then the Terminate command.

Global Mirror with Practice commands
Use this information to learn about commands available for Global Mirror with
Practice sessions.

Table 78. Global Mirror with Practice commands

Command Action

Enable Copy to Site 1 Run this command and confirm that you want to reverse the
direction of replication before you reverse the direction of copying
in a failover and failback session. After you issue this command,
the Start H2->H1 command becomes available.

Enable Copy to Site 2 Run this command and confirm that you want to reverse the
direction of replication before reversing the direction of copying in
a failover and failback session. After you issue this command, the
Start H1->H2 command becomes available.

Flash The Flash command on a Global Mirror Practice session for
TotalStorage Enterprise Storage Server Model 800, System Storage
DS6000, and System Storage DS8000 temporarily pauses the
formation of consistency groups. The Flash command ensures that
all I2s are consistent, and then flashes the data from I2 to the H2
volumes. After the flash is complete, the Global Mirror session is
automatically restarted, and the session begins forming
consistency groups on I2. You can then use the H2 volumes to
practice your disaster recovery procedures.

Start H1->H2 Starts copying data from H1 to H2. After the first pass of the copy
is complete for all pairs, the session establishes the I2->J2
FlashCopy pairs. The session starts the Global Mirror master so
that the hardware begins to form consistency groups, to ensure
that consistent data is at site 2.

Start H2->H1 Starts copying data from H2 to H1 in a failover and failback
session. If a recover was performed on a session such that the
production site is now H2, you can issue a Start H2->H1 to start
moving data back to Site 1. However, this start does not provide
consistent protection as it copies only asynchronously back
because of the long distance.
Note: TotalStorage Enterprise Storage Server Model 800, System
Storage DS6000, and System Storage DS8000 volumes are not
consistent for the Start H2->H1 command.A Global Copy
relationship is used. When you are ready to move production
back to Site 1, issue a suspend command to the session. The
relationships are put into a synchronized state and are suspended
consistently.
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Table 78. Global Mirror with Practice commands (continued)

Command Action

StartGC H1->H2

This command is
available only for
Global Mirror
Failover/Failback and
Global Mirror
Failover/Failback with
Practice sessions.

Establishes Global Copy relationships between site 1 and site 2
and begins asynchronous data replication from H1 to I2. To
change the session state from Preparing to Prepared, you must
issue the Start H1->H2 command and the session must begin to
form consistency groups.

There is no disaster recovery protection for Global Copy
relationships. If a disaster such as the loss of the primary Tivoli
Storage Productivity Center for Replication server occurs, the
session might be inconsistent when you issue the Recover
command.

This command is available for the following storage systems:

v TotalStorage Enterprise Storage Server Model 800

v System Storage DS6000

v System Storage DS8000

Terminate Removes all physical copies and relationships on the hardware.

Suspend Stops all consistency group formation when the data is actively
being copied and suspends the H1-I2 Global Copy pairs. To issue
the pause command to the Global Mirror session on the hardware
without suspending the Global Copy pairs, open the
rmserver.properties file and add the following property to
disable the Global Copy suspension on the Suspend command:
csm.server.sus_gc_pairs_on_gm_pause = false. The default
property is true and the Suspend command automatically
suspends the Global Copy pairs..

Recover Restores consistent data on I2 volumes and takes a point-in-time
copy of the data on I2 to the H2 volumes, enabling the
application to be attached and run from the H2 volumes on site 2.
The I2 volumes continue to hold the consistent data and can be
flashed again to H2 by using the Flash command.

Metro Global Mirror commands
Use this information to learn about commands available for Metro Global Mirror
sessions.

Table 79. Metro Global Mirror commands

Command Action

Enable Copy to Site 1 Run this command and confirm that you want to reverse the
direction of replication before you reverse the direction of copying
in a failover and failback session. After you issue this command,
the Start H2->H1->H3 command becomes available.

Enable Copy to Site 2 Run this command and confirm that you want to reverse the
direction of replication before reversing the direction of copying in
a failover and failback session. After you issue this command, the
Start H1->H2->H3 command becomes available.

HyperSwap Causes a site switch, equivalent to a suspend and recover for a
Metro Mirror with failover and failback individual suspend and
recover commands are not available. This command is available
only for Tivoli Storage Productivity Center for Replication for
System z.
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Table 79. Metro Global Mirror commands (continued)

Command Action

Start H1->H2->H3 (This is the Metro Global Mirror initial start command.)
Establishes Metro Mirror relationships between H1 and H2, and
Global Mirror relationships between H2 and H3. For Metro Global
Mirror, this includes the J3 volume to complete the Global Mirror
configuration. (The J3 volume role is the journal volume at site 3.).
Start H1->H2->H3 can be used from some Metro Global Mirror
configurations to transition back to the starting H1->H2->H3
configuration.

This command is valid only when the session is in a defined,
preparing, prepared, or suspended state.

Start H1->H3 From the H1->H2->H3 configuration, this command changes the
session configuration to a Global Mirror-only session between H1
and H3, with H1 as the source. Use this command in case of an
H2 failure with transition bitmap support provided by
incremental resynchronization. It can be used when a session is in
preparing, prepared, and suspended states because there is not a
source host change involved.

This command allows you to bypass the H2 volume in case of an
H2 failure and copy only the changed tracks and tracks in flight
from H1 to H3. After the incremental resynchronization is
performed, the session is running Global Mirror from H1 to H3
and thus loses the near-zero data loss protection achieved with
Metro Mirror when running H1->H2->H3. However, data
consistency is still maintained at the remote site with the Global
Mirror solution.

From H2->H1->H3 configuration, this command changes the
session configuration to a Global Mirror-only session
configuration between H1 and H3, with H1 as the source. Use this
command when the source site has a failure and production is
moved to the H1 site. This can be done for unplanned
HyperSwap. The Global Mirror session is continued. This is a
host-volume change so this command is valid only when
restarting the H1->H3 configuration or from the TargetAvailable
H2->H1->H3 state.

Start H2->H3 From the H1->H2->H3 configuration, this command moves the
session configuration to a configuration between H2 and H3, with
H2 as the source. Use this command when the source site has a
failure and production is moved to the H2 site, for example, for
unplanned HyperSwap. The Global Mirror session is continued.
This session is a host-volume change so this command is valid
only when restarting the H1->H3 configuration or from the
TargetAvailable H2->H1>H3 state.

From the H2->H1->H3 configuration, this command changes the
session configuration to a configuration between H2 and H3 with
H2 as the source. Use this command in case of an H1 failure with
transition bitmap support provided by incremental
resynchronization. Because there is not a source-host change
involved, it can be used when the session is in preparing,
prepared, and suspended states Start H2->H1->H3 can be used to
transition back to the starting H2->H1->H3 configuration.
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Table 79. Metro Global Mirror commands (continued)

Command Action

Start H2->H1->H3 (This is the Metro Global Mirror start command.) This is the
configuration that completes the HyperSwap processing. This
command creates Metro Mirror relationships between H2 and H1
and Global Mirror relationships between H1 and H3. For Metro
Global Mirror, this includes the J3 volume to complete the Global
Mirror configuration.

Start H3->H1->H2 After recovering to H3, this command sets up the hardware to
allow the application to begin writing to H3, and the data is
copied back to H1 and H2. However, issuing this command does
not guarantee consistency in the case of a disaster because only
Global Copy relationships are established to cover the long
distance copy back to site 1.

To move the application back to H1, you can issue a suspend
while in this state to drive all the relationships to a consistent
state and then issue a freeze to make the session consistent. You
can then issue a Rcover followed by a Start H1->H2->H3 to go
back to the original configuration.

SuspendH2H3 When running H1->H2->H3, this command issues a pause to the
Global Mirror master and causes the Global Mirror master to stop
forming consistency groups.

This command is valid only when the session is in a prepared
state. Stops all consistency group formation when the data is
actively being copied and suspends the H2>H3 Global Copy
pairs. To issue the pause command to the Global Mirror session
on the hardware without suspending the Global Copy pairs, open
the rmserver.properties file and add the following property to
disable the Global Copy suspension on the Suspend command:
csm.server.sus_gc_pairs_on_gm_pause = false. The default
property is true and the Suspend command automatically
suspends the Global Copy pairs..

SuspendH1H3 When running H2->H1->H3, this command issues a pause to the
Global Mirror master and causes the Global Mirror master to stop
forming consistency groups.

This command is valid only when the session is in a prepared
state. Stops all consistency group formation when the data is
actively being copied and suspends the H2->H3 Global Copy
pairs. To issue the pause command to the Global Mirror session
on the hardware without suspending the Global Copy pairs, open
the rmserver.properties file and add the following property to
disable the Global Copy suspension on the Suspend command:
csm.server.sus_gc_pairs_on_gm_pause = false. The default
property is true and the Suspend command automatically
suspends the Global Copy pairs..

RecoverH1 Specifying H1 makes the H1 volume TargetAvailable. Metro Global
Mirror (when running H2->H1->H3) can move production to
either the H1 or H3 set of volumes. IBM Tivoli Storage
Productivity Center for Replication processing differs, depending
on the recovery site. Therefore, the site designation is added to
the Recover command so IBM Tivoli Storage Productivity Center
for Replication can set up for the failback.
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Table 79. Metro Global Mirror commands (continued)

Command Action

RecoverH2 Specifying H2 makes the H2 volume TargetAvailable. Metro Global
Mirror (when running H1->H2->H3) can move production to
either the H2 or H3 set of volumes. IBM Tivoli Storage
Productivity Center for Replication processing is different
depending on the recovery site. Therefore the site designation is
added to the Recover command so IBM Tivoli Storage
Productivity Center for Replication can prepare for the failback.

RecoverH3 Specifying H3 makes the H3 volume TargetAvailable. Metro Global
Mirror (when running H1->H2->H3) can then move production to
the H3 set of volumes. Because Tivoli Storage Productivity Center
for Replication processing differs depending on the recovery site,
the site designation is added to the Recover command so that
Tivoli Storage Productivity Center for Replication can prepare for
the failback.

This command prepares H3 so that you can start the application
on H3. H3 becomes the active host, and you then have the option
start H3->H1->H2 to perform a Global Copy copy back. The
recovery establishes point-in-time copy to J3 volumes to preserve
the last consistent data.

Metro Global Mirror with Practice commands
Use this information to learn about commands available for Metro Global Mirror
with Practice sessions.

Table 80. Metro Global Mirror with Practice commands

Command Action

Enable Copy to Site 1 Run this command and confirm that you want to reverse the
direction of replication before you reverse the direction of copying
in a failover and failback session.

Enable Copy to Site 2 Run this command and confirm that you want to reverse the
direction of replication before reversing the direction of copying in
a failover and failback session.
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Table 80. Metro Global Mirror with Practice commands (continued)

Command Action

Flash This command is available in the following states:

v Target Available state when the active host is H3
Note: Use this command if the FlashCopy portion of the
Recover command from I3 to H3, fails for any reason. The
problem can be addressed; and a Flash command issued to
complete the flash of the consistent data from I3 to H3.

v Prepared state when the active host is H1 and data is copying
H1 to H2 to I3, or the active host is H2 and data is copying H2
to H1 to H3.

v Prepared state when the active host is H2 and data is copying
H2 to I3.

v Prepared state when the active host is H1 and data is copying
H1 to I3.

Use this command if the FlashCopy portion of the Recover
command from I3 to H3, fails for any reason. The problem can be
addressed, and a Flash command issued to complete the flash of
the consistent data from I3 to H3.

Issuing a Flash command on a Global Mirror Practice session for
ESS, DS6000 and DS8000 will temporarily pause the formation of
consistency groups, ensure that all I3s are consistent, and then
flash the data from I3 to the H3 volumes. After the flash is
complete, the Global Mirror session will be automatically
restarted, and the session will begin forming consistency groups
on I3. You can then use the H3 volumes to practice your disaster
recovery procedures.

RecoverH1 Specifying H1 makes the H1 volume TargetAvailable. Metro Global
Mirror (when running H1->H2->H3) can move production to
either the H2 or H3 set of volumes. IBM Tivoli Storage
Productivity Center for Replication processing differs, depending
on the recovery site. Therefore the site designation is added to the
Recover command so IBM Tivoli Storage Productivity Center for
Replication can prepare for the failback. The FlashCopy creates a
consistent copy of the data on the H3 volumes so that an
application can recover to those volumes and begin writing I/O.
When the FlashCopy is complete, the session will reach a Target
Available state, and you can attach your volumes on Site 3.

RecoverH2 Specifying H2 makes the H2 volume TargetAvailable. Metro Global
Mirror (when running H1->H2->H3) can move production to
either the H2 or H3 set of volumes. IBM Tivoli Storage
Productivity Center for Replication processing differs, depending
on the recovery site. Therefore the site designation is added to the
Recover command so IBM Tivoli Storage Productivity Center for
Replication can prepare for the failback.

RecoverH3 Specifying H3 makes the H3 volume the TargetAvailable. When
running H1->H2->H3, Metro Global Mirror can move production
to either the H2 or H3 set of volumes. IBM Tivoli Storage
Productivity Center for Replication processing differs, depending
on the recovery site; therefore, the site designation is added to the
Recover command so IBM Tivoli Storage Productivity Center for
Replication can prepare for the failback.

Re-enable Copy to
Site 1

After issuing a RecoverH1 command, you can run this command
to restart the copy to the original the direction of replication in a
failover and failback session.
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Table 80. Metro Global Mirror with Practice commands (continued)

Command Action

Re-enable Copy to
Site 2

After issuing a RecoverH2 command, you can run this command
to restart the copy to the original the direction of replication in a
failover and failback session.

Re-enable Copy to
Site 3

After issuing a RecoverH3 command, you can run this command
to restart the copy to the original the direction of replication in a
failover and failback session.

Start H1->H2->H3 Metro Global Mirror initial start command. This command creates
Metro Mirror relationships between H1 and H2, and Global
Mirror relationships between H2 and H3. For Metro Global
Mirror, this includes the J3 volume to complete the Global Mirror
configuration. (The J3 volume role is the journal volume at site 3.).
Start H1->H2->H3 can be used from some Metro Global Mirror
configurations to return to the starting H1>H2>H3 configuration.

This command is valid only when the session is in a defined,
preparing, prepared, target-available, or suspended state.

Start H1->H3 From the H1->H2->H3 configuration, this command changes the
session configuration to a Global-Mirror-only session between H1
and H3, with H1 as the source. Use this command in case of an
H2 failure with transition bitmap support provided by
incremental resynchronization. Because there is not a source host
change involved, it can be used when a session is in preparing,
prepared, and suspended states.

You can use this command to bypass the H2 volume in case of an
H2 failure and copy only the changed tracks and tracks in flight
from H1 to H3. After the incremental resynchronization is
performed, the session is running Global Mirror from H1 to H3
and thus loses the near-zero data loss protection achieved with
Metro Mirror when running H1->H2->H3. However, data
consistency is still maintained at the remote site with the Global
Mirror solution.

From H2->H1->H3 configuration, this command changes the
session configuration to a Global-Mirror-only session
configuration between H1 and H3, with H1 as the source. Use this
command when the source site has a failure and production is
moved to the H1 site. This can be done for unplanned
HyperSwap. The Global Mirror session is continued. This is a
host-volume change so this command is valid only when
restarting the H1->H3 configuration or from the TargetAvailable
H2->H1->H3 state.
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Table 80. Metro Global Mirror with Practice commands (continued)

Command Action

Start H2->H3 From the H1->H2->H3 configuration, this command moves the
session configuration to a configuration between H2 and H3, with
H2 as the source. Use this command when the source site has a
failure and production is moved to the H2 site. This can be done
for unplanned HyperSwap. The Global Mirror session is
continued. This is a host-volume change so this command is valid
only when restarting the H1>H3 configuration or from the
TargetAvailable H2->H1->H3 state.

From the H2->H1->H3 configuration, this command changes the
session configuration to a configuration between H2 and H3 with
H2 as the source. Use this command in case of an H1 failure with
transition bitmap support provided by incremental
resynchronization. Because there is not a source-host change
involved it can be used when the session is in preparing,
prepared, and suspended states. Start H2->H1->H3 can be used to
return to the starting H2->H1->H3 configuration.

SuspendH2H3 When running H1->H2->H3, this command issues a pause to the
Global Mirror master and causes the Global Mirror master to stop
forming consistency groups.

This command is valid only when the session is in a prepared
state. It stops all consistency group formation when the data is
actively being copied and suspends the H2->H3 Global Copy
pairs. To issue the pause command to the Global Mirror session
on the hardware without suspending the Global Copy pairs, open
the rmserver.properties file and add the following property to
disable the Global Copy suspension on the Suspend command:
csm.server.sus_gc_pairs_on_gm_pause = false. The default
property is true and the Suspend command automatically
suspends the Global Copy pairs..

SuspendH1H3 When running H2->H1->H3, this command issues a pause to the
Global Mirror master and causes the Global Mirror master to stop
forming consistency groups.

This command is valid only when the session is in a prepared
state. Stops all consistency group formation when the data is
actively being copied and suspends the H2->H3 Global Copy
pairs.To issue the pause command to the Global Mirror session on
the hardware without suspending the Global Copy pairs, open the
rmserver.properties file and add the following property to
disable the Global Copy suspension on the Suspend command:
csm.server.sus_gc_pairs_on_gm_pause = false. The default
property is true and the Suspend command automatically
suspends the Global Copy pairs..

Terminate This command terminates all copy relationships on the hardware.

Site awareness
You can associate a location with each storage system and each site in a session.
This site awareness ensures that only the volumes whose location matches the
location of the site are allowed for selection when you add copy sets to the session.
This prevents a session relationship from being established in the wrong direction.

Note: To filter the locations for site awareness, you must first assign a site location
to each storage system.
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IBM Tivoli Storage Productivity Center for Replication does not perform automatic
discovery of locations. Locations are user-defined and specified manually.

You can change the location associated with a storage system that has been added
to the IBM Tivoli Storage Productivity Center for Replication configuration. You
can choose an existing location or add a new one. Locations are deleted when
there is no longer a storage system with an association to that location.

When adding a copy set to a session, a list of candidate storage systems is
presented, organized by location. Storage systems that do not have a location are
displayed and available for use when you create a copy set.

You can also change the location for any site in a session. Changing the location of
a session does not affect the location of the storage systems that are in the session.

Changing the location of a storage system might have consequences. When a
session has a volume role with a location that is linked to the location of the
storage system, changing the location of the storage system could change the
session's volume role location. For example, if there is one storage system with the
location of A_Location and a session with the location of A_Location for its H1
role, changing the location of the storage system to a different location, such as
B_Location, also changes the session's H1 location to Site 1. However, if there is a
second storage system that has the location of A_Location, the session's role
location is not changed.

Important: Location matching is enabled only when adding copy sets. If you
change the location of a storage system or volume role, IBM Tivoli Storage
Productivity Center for Replication does not audit existing copy sets to confirm or
deny location mismatches.

Preserve Mirror option
This topic presents recommendations for using the Preserve Mirror option in
FlashCopy and Metro Mirror sessions.

When the source of the FlashCopy relationship is a source of a Metro Mirror
relationship, and the target of the FlashCopy relationship is the source of a Metro
Mirror relationship, the Preserve Mirror option attempts to preserve the
consistency of the Metro Mirror relationship at the target of the FlashCopy
relationship, preventing a full copy from being performed over the Metro Mirror
link. Instead, parallel flashes will be performed (if possible) on both sites. If the
consistency cannot be preserved, the Flash for the FlashCopy relationships will fail,
and the data of the Metro Mirror relationship at the target of the FlashCopy
relationship will not be changed.

Note: This option is available only on DS8000 storage devices with the required
code levels installed.

However, in some instances, the Preserve Mirror option can cause a Metro Mirror
session to go into a Preparing state, or even a Suspended state. This topic describes
the recommended usage of the Preserve Mirror feature. Using this feature in other
ways might lead to a Metro Mirror session going into a Preparing or Suspended
state.
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FlashCopy session

You can use the Preserve Mirror option in FlashCopy sessions in two different
methods:

Perform an incremental resynchronization
To perform an incremental resynchronization, select the Incremental and
Persistent options in the FlashCopy session: do not select the No Copy
option.

Perform a single full copy
To perform a single full copy, ensure that the Incremental, Persistent and
No Copy options are not selected before you issue a Flash command. If
you use the No Copy option, issue either an Initiate Background Copy
command or Terminate command before you issue the Flash command.

Refer to your DS8000 documentation for more information about the Preserve
Mirror function.

Metro Mirror session

You can set up your Metro Mirror pairs in two different ways, depending on the
level of consistency you need, and your preferences.

Note: For the examples in this section, the source pair is H1a->H2a and the target
pair is H1b->H2b. The source pair will contain volumes that will be the source of
the FlashCopy relationship and the target pair will always contain volumes that
will be the target of the FlashCopy relationship.

Create one Metro Mirror session, and add the Metro Mirror pairs as copy sets to
that session

The benefit to this approach is that you do not need to worry about
whether the host considers the H1a->H2a and H1b->H2b volumes to be
consistent with one another. IBM Tivoli Storage Productivity Center for
Replication will ensure that all of the volumes remain consistent.

A drawback to this approach is that when using the Attempt to preserve
Metro Mirror consistency, but fail FlashCopy if Metro Mirror target
consistency cannot be preserved option (Preserve Mirror Required), there
is a chance that the target pair (H1b->H2b) might suspend unexpectedly:
this causes all other pairs in the Metro Mirror session to suspend
(including H1a->H2a). This can occur when a FlashCopy establish or
withdraw fails unexpectedly on the remote (H1b->H2b) site. If the host
requires the H1a->H2a and H1b->H2b volumes to be consistent, then you
should suspend all other volumes.

Create one Metro Mirror session for the H1a->H2a volumes, and another Metro
Mirror session for the H1b->H2b volumes

Use this option when the hosts and applications do not require the
H1a->H2a and H1b->H2b volumes to be consistent with one another. In
this case, you should create one Metro Mirror session for all of the
H1a->H2a volumes, and another Metro Mirror session for the H1b->H2b
volumes. The H1a->H2a pair is added to the first session, while the
H1b->H2b pair is added to the second Metro Mirror session. As long as the
host does not require consistency between the H1a and H1b volumes, this
option benefits you when you use the Attempt to preserve Metro Mirror
consistency, but fail FlashCopy if Metro Mirror target consistency cannot
be preserved option (Preserve Mirror Required). The benefit is that if one
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pair is suspended (such as H1a->H2a), the pairs in the other session will
not be affected, since it is in a different Metro Mirror session. Using this
method, you can avoid the situation in which a critical application is
writing to the source pair (H1a->H2a), while a batch job is writing to the
target pair (H1b->H2b), and both pairs are in the same IBM Tivoli Storage
Productivity Center for Replication session. These factors cause both
applications to receive extended long busy signals, instead of just the batch
job.

Creating sessions and adding copy sets
This section describes how to create a session for a specific replication method and
then add copy sets to that session.

Creating a FlashCopy session and adding copy sets
FlashCopy replication creates a point-in-time copy in which the target volume
contains a copy of the data that was on the source volume when the FlashCopy
session was established.

When you create a FlashCopy session for Global Mirror or Metro Global Mirror
space-efficient target volumes, you must select No Copy for the FlashCopy session.
With space-efficient volumes, you can use your FlashCopy repository more
efficiently. Instead of requiring an equal amount of space to write data to, you can
set aside a smaller amount of space in which to write data, where only the tracks
that are changed are recorded. When your pool of storage is full, you can no
longer perform a FlashCopy operation, and your session goes into a Severe state.
1. Follow these steps to create a FlashCopy session:

a. In the navigation tree, select Sessions.
b. Click Create Session.
c. In the Create Session wizard, for the Choose Hardware Type list, select the

item that shows the type of storage system for the session.
d. In the Choose Session Type list, select FlashCopy and click Next.
e. On the Properties page, enter a session name and a description. Select the

options that you want, as described in “Session properties” on page 771.
The options that are displayed depend on the storage system type. After
you select the options that you want, click Next.

f. On the Site Locations page, select a location for Site 1 and click Next.
g. On the Results page, verify that the session was added successfully.

2. Follow these steps to add copy sets to the session:
a. On the Results page of the Create Session wizard, click Launch Add Copy

Sets Wizard.
b. In the Add Copy Sets wizard, complete the following information. The field

names that are displayed depend on the storage system type. When you
complete the information, click Next.

Storage system
Select a storage system. If the role has a location assigned to it,
acceptable values for the storage system list are storage systems
assigned to the same location as the role, and storage systems
assigned to no location. In this case, the storage systems are
grouped under different headings. If the role does not have a
location, any storage system is acceptable.

Logical storage system or I/O Group
Select a logical storage system (LSS) or I/O group.
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Volume
Select one volume or all volumes. The volumes are limited to the
volumes within the LSS or I/O group that you selected.

You can use extent space-efficient volumes as source and target
volumes for System Storage DS8000 6.2 or later. You can use a
combination of extent space-efficient and other volume types as
source and target volumes.

Extent space-efficient volumes must be fixed block (FB). You cannot
use count key data (CKD) volumes.

Session image
Shows an image that represents the session in which the role for
which you are selecting volumes is highlighted. This image shows
how many roles are in the session and how the roles are distributed
between the sites.

Volume Details
Shows information about the selected volume, including the volume
name, full name, type, capacity, and whether the volume is
protected and space-efficient.

Use a CSV file to import copy sets
Select this option to import copy sets from a comma-separated
value (CSV) file, click Use a CSV file to import copy sets. Type the
full path name of the CSV file or click Browse to select the CSV file.

c. On the Choose Target page, select the target storage system, LSS or I/O
group, and volume. Click Next.

d. On the Select Copy Sets page, select the copy sets that you want to add.
You can click Select All to select all copy sets, Deselect All to select none of
the copy sets, or Add More to add more copy sets to this session. Click
Next.

e. On the Confirm page, the number of copy sets to be added is displayed.
Click Next.

f. A progress bar is displayed. When the copy sets are added, review the
results and click Finish.

Related concepts:
“Sessions” on page 689
A session is used to perform a specific type of data replication against a specific set
of volumes. The source volume and target volumes that contain copies of the same
data are collectively referred to as a copy set. A session can contain one or more
copy sets.
“Data replication” on page 75
With Tivoli Storage Productivity Center for Replication, you can use several
methods to replicate data. The type of data replication that is associated with a
session is known as the session type.

Creating a Snapshot session and adding copy sets
A Snapshot session is a session type that creates a point-in-time copy of a volume
or set of volumes without having to define a specific target volume. Snapshot
sessions are available only for the XIV system.
1. Follow these steps to create a Snapshot session:

a. In the navigation tree, expand Sessions.
b. Click Create Session.
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c. In the Create Session wizard, for the Choose Hardware Type list, select
XIV.

d. In the Choose Session Type list, select Snapshot and click Next.
e. On the Properties page, type a session name and description, and click

Next.
f. On the Site Locations page, select a location for Site 1 and click Next.
g. On the Results page, verify that the session was added successfully.

2. Follow these steps to add copy sets to the session:
a. On the Results page of the Create Session wizard, click Launch Add Copy

Sets Wizard.
b. From the Host1 storage system list, select the storage system that contains

the volumes that you want to add.
If the H1 role has an assigned location, only those storage systems that have
the same location as the H1 role or storage systems that do not have a set
location are displayed for selection.
If the H1 role does not have an assigned location, all storage systems are
displayed for selection.
Storage systems that are assigned to a location are listed under the location
name. Storage systems that are not assigned to a location are listed under
the None. column.

c. From the Host1 pool list, select the pool that contains the volumes.
d. From the Host1 volume list, select the volumes. To select multiple volumes,

press Ctrl or Shift and click the volumes in the list.
e. If you want to import copy sets from a comma-separated value (CSV) file,

click Use a CSV file to import copy sets. Type the full path name of the
CSV file or click Browse to select the CSV file. Click Next.

f. On the Matching Results page, click Next if the match was successful.
g. On the Select Copy Sets page, select from the following options and click

Next.

Select All
Click this button to select all of the copy sets in the table.

Deselect All
Click this button to clear all of the copy sets in the table.

Add More
Click this button to add another copy set to the list of copy sets to
be created.

When you click Add More, you are returned to the Choose Host1
page of the wizard. The Host1 storage system and Host1 pool lists
are populated with the values from the previously selected copy set.
When you select the volumes for the various roles, the volumes are
matched together and added to the list of copy sets on this page.

Selection check boxes
Select one or more copy sets that you want to create.

Host 1 Lists the volume IDs that are associated with the Host1 role. You
can click the link to display information about the volume,
including the full name, type, capacity, and whether the volume is
protected and space efficient.
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Copy Set
Displays the copy set information for the specified copy sets and
any warning or error messages that are associated with the copy set.

A warning or icon next to the Show button indicates that you
cannot create a copy set for the H1 volume. Click Show to view the
message.

h. On the Confirm page, the number of copy sets to be added is displayed.
Click Next.

i. A progress bar is displayed. When the copy sets are added, review the
results and click Finish.

Related concepts:
“Sessions” on page 689
A session is used to perform a specific type of data replication against a specific set
of volumes. The source volume and target volumes that contain copies of the same
data are collectively referred to as a copy set. A session can contain one or more
copy sets.
“Data replication” on page 75
With Tivoli Storage Productivity Center for Replication, you can use several
methods to replicate data. The type of data replication that is associated with a
session is known as the session type.

Creating a Metro Mirror session and adding copy sets
A Metro Mirror session is a method of synchronous, remote data replication that
operates between two sites that are up to 300 KM apart.
1. Follow these steps to create a Metro Mirror session:

a. In the navigation tree, select Sessions.
b. Click Create Session.
c. In the Create Session wizard, for the Choose Hardware Type list, select the

item that shows the type of storage system for the session.
d. In the Choose Session Type list, select a Metro Mirror session type and

click Next.
e. On the Properties page, enter a session name and description. Depending

on the session type and storage system, additional options are displayed.
Select the options that you want, as described in “Session properties” on
page 771. After you select the options that you want on the Properties page,
click Next.

f. On the Site Locations pages, select a location for Sites 1 and 2, and click
Next.

g. On the Results page, verify that the session was added successfully.
2. Follow these steps to add copy sets to the session:

a. On the Results page of the Create Session wizard, click Launch Add Copy
Sets Wizard.

b. In the Add Copy Sets wizard, enter the following information for the Host
pages. The field names that are displayed depend on the storage system
type. When you complete the information on each page, click Next.

Storage system
Select a storage system. If the role has a location assigned to it,
acceptable values for the storage system list are storage systems
assigned to the same location as the role, and storage systems
assigned to no location. In this case, the storage systems are
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grouped under different headings. If the role does not have a
location, any storage system is acceptable.

Logical storage system, I/O Group, or Pool
Select a logical storage system (LSS), I/O group, or pool.

Volume
Select one volume or all volumes. The volumes are limited to the
volumes within the LSS, I/O group, or pool that you selected.

You can use extent space-efficient volumes as source and target
volumes for System Storage DS8000 6.3 or later. If you use an extent
space-efficient volume as a source or target volume in the copy set,
all source and target volumes in the copy set must be extent
space-efficient volumes.

Extent space-efficient volumes must be fixed block (FB). You cannot
use count key data (CKD) volumes.

Session image
Shows an image that represents the session in which the role for
which you are selecting volumes is highlighted. This image shows
how many roles are in the session and how the roles are distributed
between the sites.

Volume Details
Shows information about the selected volume, including the volume
name, full name, type, capacity, and whether the volume is
protected and space-efficient.

Use a CSV file to import copy sets
Select this option to import copy sets from a comma-separated
value (CSV) file, click Use a CSV file to import copy sets. Type the
full path name of the CSV file or click Browse to select the CSV file.

c. On the Select Copy Sets page, select the copy sets that you want to add.
You can click Select All to select all copy sets, Deselect All to select none of
the copy sets, or Add More to add more copy sets to this session. Click
Next.

d. On the Confirm page, the number of copy sets to be added is displayed.
Click Next.

e. A progress bar is displayed. When the copy sets are added, review the
results and click Finish.

Related tasks:
“Managing a session with HyperSwap and Open HyperSwap replication” on page
99
HyperSwap and Open HyperSwap provide high availability of data if a primary
disk storage system failure occurs. When a failure occurs in writing I/O to the
primary storage system, the failure is detected by IOS, and IOS automatically
swaps the I/O to the secondary site with no user interaction and minimal
application effect.

Creating a Global Mirror session and adding copy sets
A Global Mirror session is a method of asynchronous, remote data replication
between two sites that are over 300 KM apart.
1. Follow these steps to create a Global Mirror session:

a. In the navigation tree, select Sessions.
b. Click Create Session.
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c. In the Create Session wizard, for the Choose Hardware Type list, select the
item that shows the type of storage system for the session.

d. In the Choose Session Type list, select a Global Mirror session type and
click Next.

e. On the Properties page, enter a session name and description. Depending
on the session type and storage system, additional options are displayed.
Select the options that you want, as described in “Session properties” on
page 771. After you select the options that you want on the Properties page,
click Next.

f. On the Site Locations pages, select a location for Sites 1 and 2, and click
Next.

g. On the Results page, verify that the session was added successfully.
2. Follow these steps to add copy sets to the session:

a. On the Results page of the Create Session wizard, click Launch Add Copy
Sets Wizard.

b. In the Add Copy Sets wizard, complete the following information for the
Host and Journal pages. The field names that are displayed depend on the
storage system type. When you complete the information on each page,
click Next.

Storage system
Select a storage system. If the role has a location assigned to it,
acceptable values for the storage system list are storage systems
assigned to the same location as the role, and storage systems
assigned to no location. In this case, the storage systems are
grouped under different headings. If the role does not have a
location, any storage system is acceptable.

Logical storage system, I/O Group, or Pool
Select a logical storage system (LSS), I/O group, or pool from this
list.

Volume
Select one volume or all volumes. The volumes are limited to the
volumes within the LSS, I/O group, or pool that you selected.

You can use extent space-efficient volumes as source, target, and
journal volumes for System Storage DS8000 6.3 or later. If you use
an extent space-efficient volume as a source or target volume in the
copy set, all source and target volumes in the copy set must be
extent space-efficient volumes. In this situation, the journal volumes
can be extent space-efficient volumes, track space-efficient volumes,
or a combination of both volume types. If you do not use an extent
space-efficient volume as the source or target volume, journal
volumes can be extent space-efficient, track space-efficient, and
other types of volumes.

Extent space-efficient volumes must be fixed block (FB). You cannot
use count key data (CKD) volumes.

Session image
Shows an image that represents the session in which the role for
which you are selecting volumes is highlighted. This image shows
how many roles are in the session and how the roles are distributed
between the sites.
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Volume Details
Shows information about the selected volume, including the volume
name, full name, type, capacity, and whether the volume is
protected and space-efficient.

Use a CSV file to import copy sets
Select this option to import copy sets from a comma-separated
value (CSV) file, click Use a CSV file to import copy sets. Type the
full path name of the CSV file or click Browse to select the CSV file.

c. On the Select Copy Sets page, select the copy sets that you want to add.
You can click Select All to select all copy sets, Deselect All to select none of
the copy sets, or Add More to add more copy sets to this session. Click
Next.

d. On the Confirm page, the number of copy sets to be added is displayed.
Click Next.

e. A progress bar is displayed. When the copy sets are added, review the
results and click Finish.

Related concepts:
“Sessions” on page 689
A session is used to perform a specific type of data replication against a specific set
of volumes. The source volume and target volumes that contain copies of the same
data are collectively referred to as a copy set. A session can contain one or more
copy sets.
“Data replication” on page 75
With Tivoli Storage Productivity Center for Replication, you can use several
methods to replicate data. The type of data replication that is associated with a
session is known as the session type.

Creating a Metro Global Mirror session and adding copy sets
A Metro Global Mirror session is a method of continuous, remote data replication
that operates between three sites of varying distances apart. Metro Global Mirror
combines Metro Mirror synchronous copy and Global Mirror asynchronous copy
into a single session, where the Metro Mirror target is the Global Mirror source.
1. Follow these steps to create a Metro Global Mirror session:

a. In the navigation tree, select Sessions.
b. Click Create Session.
c. In the Create Session wizard, for the Choose Hardware Type list, select the

item that shows the type of storage system for the session.
d. In the Choose Session Type list, select a Metro Global Mirror session type

and click Next.
e. On the Properties page, enter a session name and a description. Select the

options that you want, as described in “Session properties” on page 771.
After you select the options that you want, click Next.

f. On the Site Locations pages, select a location for Sites 1, 2, and 3, and click
Next.

g. On the Results page, verify that the session was added successfully.
2. Follow these steps to add copy sets to the session:

a. On the Results page of the Create Session wizard, click Launch Add Copy
Sets Wizard.
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b. In the Add Copy Sets wizard, complete the following information for the
Host and Journal pages. The field names that are displayed depend on the
storage system type. When you complete the information on each page,
click Next.

Storage system
Select a storage system. If the role has a location assigned to it,
acceptable values for the storage system list are storage systems
assigned to the same location as the role, and storage systems
assigned to no location. In this case, the storage systems are
grouped under different headings. If the role does not have a
location, any storage system is acceptable.

Logical storage system
Select a logical storage system.

Volume
Select one volume or all volumes. The volumes are limited to the
volumes within the LSS that you selected.

You can use extent space-efficient volumes as source, target, and
journal volumes for System Storage DS8000 6.3 or later. If you use
an extent space-efficient volume as a source or target volume in the
copy set, all source and target volumes in the copy set must be
extent space-efficient volumes. In this situation, the journal volumes
can be extent space-efficient volumes, track space-efficient volumes,
or a combination of both volume types. If you do not use an extent
space-efficient volume as the source or target volume, journal
volumes can be extent space-efficient, track space-efficient, and
other types of volumes.

Extent space-efficient volumes must be fixed block (FB). You cannot
use count key data (CKD) volumes.

Session image
Shows an image that represents the session in which the role for
which you are selecting volumes is highlighted. This image shows
how many roles are in the session and how the roles are distributed
between the sites.

Volume Details
Shows information about the selected volume, including the volume
name, full name, type, capacity, and whether the volume is
protected and space-efficient.

Use a CSV file to import copy sets
Select this option to import copy sets from a comma-separated
value (CSV) file, click Use a CSV file to import copy sets. Type the
full path name of the CSV file or click Browse to select the CSV file.

c. On the Select Copy Sets page, select the copy sets that you want to add.
You can click Select All to select all copy sets, Deselect All to select none of
the copy sets, or Add More to add more copy sets to this session. Click
Next.

d. On the Confirm page, the number of copy sets to be added is displayed.
Click Next.

e. A progress bar is displayed. When the copy sets are added, review the
results and click Finish.
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Using the Metro Mirror heartbeat
This topic provides information about Metro Mirror heartbeat, including how to
enable and disable the heartbeat.

Metro Mirror heartbeat
The heartbeat is a Metro Mirror function. When the Metro Mirror heartbeat is
disabled, data consistency across multiple storage systems is not guaranteed if the
IBM Tivoli Storage Productivity Center for Replication management server cannot
communicate with one or more storage systems. The problem occurs as a result of
the Hardware Freeze Timeout Timer function within the storage system. If the
controlling software loses connection to a storage system, the Metro Mirror
relationships that it is controlling stay established and there is no way to freeze
those pairs to create consistency across the multiple storage systems. When the
freeze times out, dependent I/O is written to the target storage systems, which
might corrupt data consistency. Freeze refers to a Metro Mirror (peer-to-peer
remote copy [PPRC]) freeze function.

When determining whether to use the Metro Mirror heartbeat, analyze your
business needs. Disabling the Metro Mirror heartbeat might result in data
inconsistency. If you enable the Metro Mirror heartbeat and a freeze occurs, your
applications will be unable to write during the freeze.

Metro Mirror heartbeat is disabled by default.

Metro Mirror heartbeat is not available for Metro Mirror with HyperSwap or Metro
Global Mirror with HyperSwap.

There are two cases where lost communication between the coordination software
(controller) and one or more storage systems can result in data consistency loss:

Freeze event not detected by a disconnected storage system
Consider a situation with four storage system machines in a primary site
and four in a secondary site. One of the four storage systems on the
primary loses the connection to the target site. This causes the affected
storage system to prevent any writes from occurring, for a period
determined by the Freeze timeout timer. At the same time, the affected
storage controller loses communication with the controlling software and
cannot communicate the Freeze event to the software.

Unaware of the problem, the controlling software does not issue the Freeze
command to the remaining source storage systems. The freeze will stop
dependent writes from being written to connected storage systems.
However, once the Freeze times out and the long-busy is terminated,
dependent write I/Os continue to be copied from the storage systems that
did not receive the Freeze command. The Metro Mirror session remains in
a state where one storage system has suspended copying while the other
three storage systems are still copying data. This state causes inconsistent
data on the target storage systems.

Freeze event detected, but unable to propagate the Freeze command to all
storage systems

Consider a situation with four storage system machines in a primary site
and four in a secondary site. One of the four storage systems on the
primary loses the connection to the target site. This causes the affected
storage system to issue long-busy to the applications for a period
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determined by the Freeze timeout timer. At the same time, one of the
remaining three source systems loses communications with the controlling
software.

The storage system that had an error writing to its target cannot
communicate the Freeze event to the controlling software. The controlling
software issues the Freeze command to all but the disconnected storage
system (the one that lost communication with the software). The long-busy
stops dependent writes from being written to the connected storage
systems.

However, once the Freeze times out on the frozen storage system and the
long-busy is terminated, dependent write I/Os continue to the target
storage system from the source storage system that lost communication
and did not receive the Freeze command. The Metro Mirror session
remains in a state where three storage systems have suspended copying
and one storage system is still copying data. This state causes inconsistent
data on the target storage systems.

Before IBM Tivoli Storage Productivity Center for Replication V3.1, if the
controlling software within a Metro Mirror environment detected that a managed
storage system lost its connection to its target, the controlling software stopped all
the other source systems to ensure consistency across all the targets. However, if
the controlling software lost communication with any of the source subsystems
during the failure, it could not notify those storage systems of the freeze event or
ensure data consistency. The Metro Mirror heartbeat helps to overcome this
problem. In a high-availability configuration, the Metro Mirror heartbeat is
continued by the standby server after the Takeover command is issued on the
standby, enabling you to perform actions on the standby server without causing a
freeze.

IBM Tivoli Storage Productivity Center for Replication registers with the managed
ESS 800, DS6000 or DS8000 storage systems within a Metro Mirror session when
the start command is issued to the session. After this registration occurs, a constant
heartbeat is sent to the storage system. If the storage system does not receive a
heartbeat from the IBM Tivoli Storage Productivity Center for Replication
management server within the allotted time (a subset of lowest LSS timeout value
across all the source LSSs), the storage system initiates a freeze. If IBM Tivoli
Storage Productivity Center for Replication did not successfully communicate with
the storage system, it initiates a freeze on the remaining storage system after the
allotted time is expired.

Note: It is recommended that you avoid using the same LSS pairs for multiple
Metro Mirror sessions. Metro Mirror uses a freeze command on ESS, DS6000, and
DS8000 storage systems to create the data-consistent point. If there are other Metro
Mirror sessions overlapping the same LSS pairs as in this session, those sessions
are also suspended.

When you are using the Metro Mirror heartbeat, be aware that:
v The Metro Mirror heartbeat can cause a single point of failure: if an error occurs

on just the management server and not the storage system, a freeze might occur.
v When the Metro Mirror heartbeat timeout occurs, the storage system remains in

a long busy state for the duration of the LSS freeze timeout.
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Note: If Metro Mirror heartbeat is enabled for storage systems that are connected
through a HMC connection, a connection loss might cause lost Metro Mirror
heartbeats, resulting in Freeze actions with application I/O impact for configured
Extended Long Busy timeout.

The Metro Mirror heartbeat is supported on storage systems connected though a
TCP/IP (direct connect or HMC) connection. It is not supported on storage
systems connected though a z/OS connection. Enabling the Metro Mirror heartbeat
with a z/OS connection does not fail; however, a warning message is displayed
specifying that the Metro Mirror heartbeat function does not work unless you have
an IP connection.

If Metro Mirror heartbeat is enabled for storage systems that are connected
through a TCP/IP (either direct connect or HMC) connection and z/OS connection,
and the TCP/IP connection fails, IBM Tivoli Storage Productivity Center for
Replication suspends the Metro Mirror session because there is no heartbeat
through the z/OS connection.

If Metro Mirror heartbeat is enabled for storage systems that are connected
through a TCP/IP connection and z/OS connection and you remove all TCP/IP
connections, IBM Tivoli Storage Productivity Center for Replication suspends the
Metro Mirror sessions and the applications using those volume will be in Extended
Long Busy timeout until the storage system's internal timeout timer expires. Ensure
that you disable the Metro Mirror heartbeat for all Metro Mirror sessions before
removing the last TCP/IP connection to avoid the Extended Long Busy timeout.

Enabling and disabling the Metro Mirror heartbeat
The Metro Mirror heartbeat guarantees data consistency across multiple storage
systems when the IBM Tivoli Storage Productivity Center for Replication
management server cannot communicate with one or more storage systems. The
Metro Mirror heartbeat is disabled by default.

To enable the Metro Mirror heartbeat, perform the following steps:
1. In the navigation tree, select Advanced Tools.
2. To enable the Metro Mirror heartbeat, click Enable Heartbeat.
3. To disable the Metro Mirror heartbeat, click Disable Heartbeat.

Exporting copy set data
You can export data about all copy sets in a specific session, to maintain a backup
copy that can be used to recover if you lose your session or upgrade to a different
server.

Perform these steps to export the copy sets in a specific session:
1. In the navigation tree, select Sessions. The Sessions panel is displayed
2. Select the session for which you want to export copy sets.
3. Select Export Copy Sets from the Actions list, and click Go. The Export Copy

Set wizard displays the status of the export and a link to the exported file.
4. Click that link and save the file to the local system.

Important: You must save the file to your local system. After you close the
panel, the data will be lost.

5. Click Finish.
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Importing copy set data
You can import copy set data that was previously exported to a comma separated
value (CSV) file.

Perform the following steps to import copy sets into an existing session:
1. In the navigation tree, select Sessions. The Session panel is displayed.
2. Select the session for which you want to import copy sets.
3. Select Add Copy Sets from the Actions list, and click Go. The Add Copy Sets

wizard is displayed.
4. Select Use a CSV file to import copy sets.
5. Type the location and name of the CSV file to import, or use Browse to select

the file. Then, click Next.
6. Verify that the matching results were successful, and then click Next.
7. Select the copy sets you want to add, and then click Next.
8. Confirm the number of copy sets that you want to create, and click Next. A

progress bar displays.
9. Click Next.

10. Verify the matches, and click Finish.

Exporting historical data for Global Mirror role pairs
You can export data for a Global Mirror role pair that is in a session to a
comma-separated value (CSV) file. You can then use the data in the CSV file to
analyze trends in your storage environment that affect your recovery point
objective (RPO).

Complete these steps to export data to a CSV file:
1. In the IBM Tivoli Storage Productivity Center for Replication navigation tree,

click Sessions.
2. Click the Global Mirror session for which you want to export data.
3. Click Export Global Mirror Data from the Select Action menu, and click Go.

The Export Historical Data for Global Mirror wizard is displayed.
4. Complete the following information, and then click Next.

Select the role pair
Select the role pair for the data that you want to show in the CSV file.

Select the type of data
Select the type of data that you want to export to a CSV file.
Depending on the data type that you select, the CSV file contains data
about the RPO or data about logical subsystem (LSS) out-of-sync tracks.

To better analyze trends, you can create a CSV file with one data type
and then create a file with the other data type. For example, the file
that contains data for the RPO might show that the RPO threshold is
often exceeded on a particular day and time. You can then view the file
that contains data for logical subsystem (LSS) out-of-sync tracks to see
whether a particular LSS or set of LSSs have high out-of-sync track
values for that day and time.

RPO Select this option to export data for the RPO. The data that is
shown in the export file includes the average RPO for the dates
that you select and information related to the formation of
consistency groups.
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LSS Out-of-Sync Tracks
Select this option to export data for the out-of-sync tracks that
are in the LSSs.

Start date
Select the start date for the data that you want to show in the export
file.

By default, the date range maximum for RPO files is 31 days of data
and the maximum for LSS out-of-sync track files is 7 days of data.

End date
Select the end date for the data that you want to show in the export
file.

If the export was successful, a link to the CSV file is provided on the Results page.
You can save the CSV file to your local system.

Modifying the location of session sites
You can change the location associated with each site of in session.

Prerequisites: You must have Administrator privileges to modify the location of a
site.

Changing the location of a site in a session does not affect the location of the
storage systems associated with that site.

Perform these steps to modify the location of a site:
1. In the navigation tree, select Sessions. The Sessions panel is displayed.
2. Select the session whose site locations you want to change.
3. Click Modify Site Location(s) from the actions list, and then click Go. The

Modify Site Locations wizard is displayed.
4. Select the location for the site from the drop-down list, and then click Next.

Repeat for each available site.
To disable site awareness, set the location to None.

Note: You can select only locations that have already been associated with one
or more storage systems.

5. Click Next.
6. Click Finish.

Removing sessions
This topic describes how to remove sessions.

Important: You can remove only sessions that are in the Defined state.

Perform these steps to remove a session:
1. In the navigation tree, select Sessions.
2. Click the radio button next to the session you want to remove.
3. Select Remove Session from the Actions drop-down menu, and click Go.
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Removing copy sets
This topic describes how to remove copy sets.

Perform these steps to remove a copy set:
1. In the IBM Tivoli Storage Productivity Center for Replication navigation tree,

select Sessions. Click the radio button next to the session that you want to
remove copy sets from.

2. From the Select Action menu, select Remove Copy Sets and click Go. This
starts the Remove Copy Sets wizard.

3. From the drop-down menus in the Remove Copy Sets wizard, select the Host 1
storage system, logical storage subsystem, and volume or select the all option.
If you select all for a filter, the lower-level filter or filters are disabled. Click
Next.

4. Select the copy sets that you want to remove and click Next.
5. The number of copy sets to be removed is displayed. Select the following

options for removing the copy sets and click Next:
v Do you want to keep the base relationships on the hardware, but remove

the copy sets from the session?

– Yes. This option specifies that the base relationships remain on the
hardware, but the copy sets are removed from the Tivoli Storage
Productivity Center for Replication session. This option supports scenarios
in which it might be best to leave the relationship on the hardware to
avoid performing a full copy. For example, when you are migrating from
one session type to another.
Only the base relationships (Metro Mirror, Global Copy, Snapshot, and
FlashCopy) remain on the hardware. The relationships are removed from
any consistency groups that are defined on the storage system.

– No. This option specifies that all relationships for the copy sets are
removed from the hardware as well as the Tivoli Storage Productivity
Center for Replication session. This option is the default.

v If there are errors removing relationships on the hardware, do you want to
force the copy sets to be removed from the session?

– Yes. This option forces the removal of copy sets despite any errors that
occur when removing the relationships from the storage system. Once a
forced removal is complete, any relationships that remain on the storage
system for that copy set must be removed manually using the storage
system interface.

– No. This option does not force the removal of copy sets. This option
enables you to correct the errors and try to remove the copy sets again.
This option is the default.

6. After the copy sets are removed, click Finish.

Important: If an application on the host has opened a device, the copy sets in a
Tivoli Storage Productivity Center for Replication session for that device are
removed, but the copy sets remain coupled on the host. To decouple the copy sets,
see the Troubleshooting and support section of theTivoli Storage Productivity
Center for Replication Information Center at http://publib.boulder.ibm.com/
infocenter/tivihelp/v4r1/index.jsp.
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Related concepts:
“Copy sets” on page 690
During data replication, data is copied from a source volume to one or more target
volumes, depending on the session type. The source volume and target volumes
that contain copies of the same data are collectively referred to as a copy set.

Migrating an existing configuration to Tivoli Storage
Productivity Center for Replication

This topic describes how to convert an existing DS6000 or DS8000 hardware
relationship for a Metro Mirror, Global Mirror, or Metro Global Mirror session. This
topic also describes how to assimilate pairs in a relationship for a Metro Mirror or
Global Mirror session with SAN Volume Controller, Storwize V7000 Unified or
Storwize V7000 volumes.

You can either complete this action manually or use the data migration utility for
Tivoli Storage Productivity Center for Replication. You can download the data
migration utility from the Data Migration Utility for IBM Tivoli Storage
Productivity Center for Replication website at http://www-01.ibm.com/support/
docview.wss?uid=swg24000625. The data migration utility can handle all session
types, and produces the Tivoli Storage Productivity Center for Replication CLI
command script files and DSCLI script files necessary to migrate the relationships
to Tivoli Storage Productivity Center for Replication.

Metro Mirror
To manually assimilate pairs in a relationship for a Metro Mirror session, complete
the following steps:
1. Determine which existing Metro Mirror pairs you want Tivoli Storage

Productivity Center for Replication to manage, and record the names of your
source and target volumes.

2. Create a Metro Mirror session in Tivoli Storage Productivity Center for
Replication.

3. Using the Add Copy Set Wizard, choose the same source and target volumes
that you identified in step 1.

4. Complete the Add Copy Set Wizard, and ensure that all copy sets are created
successfully.

5. Issue a Start command from Tivoli Storage Productivity Center for Replication.
At this time, the session automatically assimilates the relationships on the
hardware (for example, if they are already in a Prepared state, Tivoli Storage
Productivity Center for Replication will show them as Prepared).

Note: The Start command does not fully resynchronize data; instead, it detects
the existing relationships and adopts them.

Global Mirror
To manually assimilate pairs in a relationship for a Global Mirror session, complete
the following steps:
1. Terminate the Global Mirror session on the hardware using the IBM System

Storage DS command-line interface (DSCLI) or another application.
2. Remove the volumes from the Global Mirror session using the DSCLI or

another application
3. Close the session on each LSS upon which it is open using the DSCLI or

another application.
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4. Determine which existing Global Mirror pairs you want Tivoli Storage
Productivity Center for Replication to manage, and record the names of your
source and target volumes.

5. Create a Global Mirror session in Tivoli Storage Productivity Center for
Replication.

6. Using the Add Copy Set Wizard, choose the same source and target volumes
that you identified in step 4.

7. Complete the Add Copy Set Wizard, and ensure that all copy sets are created
successfully.

8. Issue a Start command from Tivoli Storage Productivity Center for Replication.
At this time, the session automatically assimilates the relationships on the
hardware.

Note: The Start command does not fully resynchronize data; instead, it detects
the existing relationships and adopts them.

Assimilating Metro Mirror pairs into a Three Site Metro Global
Mirror session
To manually assimilate a set of Metro Mirror pairs into a Three Site Metro Global
Mirror session, complete the following steps:
1. Determine which existing Metro Mirror pairs you want Tivoli Storage

Productivity Center for Replication to manage, and record the names of your
source and target volumes.

2. Create a Metro Global Mirror session in Tivoli Storage Productivity Center for
Replication.

3. Using the Add Copy Set Wizard, choose the same source and target volumes
for the H1 and H2 roles of the Metro Global Mirror copy set, that you
identified in step 1.

4. Complete the Add Copy Set Wizard, and ensure that all copy sets are created
successfully.

5. Issue a Start command from Tivoli Storage Productivity Center for Replication.
At this time, the session automatically assimilates the Metro Mirror
relationships on the hardware (for example, if they are already in a Prepared
state, Tivoli Storage Productivity Center for Replication will show them as
Prepared). In addition, the Start command will establish the Global Copy
relationships.

Note: The Start command does not fully resynchronize data on the Metro
Mirror pairs assimilated; instead, it detects the existing relationships and adopts
them. However, a full synchronization will be required for the Global Copy
pairs.

Assimilating Three Site pairs into a Three Site Metro Global
Mirror session
To assimilate a full Three Site set of pairs into a Three Site Metro Global Mirror
session, complete the following steps:
1. Terminate the Global Mirror session on the hardware using the IBM System

Storage DS command-line interface (DSCLI) or another application.
2. Remove the volumes from the Global Mirror session using the DSCLI or

another application
3. Close the session on each LSS upon which it is open using the DSCLI or

another application.
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4. Determine which existing Metro Mirror and Global Copy pairs you want Tivoli
Storage Productivity Center for Replication to manage, and record the names of
your source and target volumes.

5. Create a Metro Global Mirror session in Tivoli Storage Productivity Center for
Replication.

6. Using the Add Copy Set Wizard, choose the same source and target volumes
for the H1, H2 and H3 roles of the Metro Global Mirror copy set, that you
identified in step 4.

7. Complete the Add Copy Set Wizard, and ensure that all copy sets are created
successfully.

8. Issue a Start command from IBM Tivoli Storage Productivity Center for
Replication. At this time, the session automatically assimilates the Metro Mirror
and Global Copy relationship on the hardware.

Note: The Start command does not fully resynchronize data on the Metro
Mirror and Global Copy pairs assimilated; instead, it detects the existing
relationships and adopts them.

Global Mirror and Metro Mirror assimilation for SAN Volume
Controller, Storwize V7000, Storwize V7000 Unified, or the XIV
system
To manually assimilate pairs in a relationship for a Metro Mirror or Global Mirror
session with SAN Volume Controller, Storwize V7000. Storwize V7000 Unified or
the XIV system volumes, complete the following steps:
1. Remove all pairs from the consistency group and delete the consistency group

on the storage system using CLI for the storage system.
2. Determine which existing Metro Mirror and Global Mirror pairs you want

Tivoli Storage Productivity Center for Replication to manage, and record the
names of your source and target volumes.

3. Create a Metro Mirror or Global Mirror session in Tivoli Storage Productivity
Center for Replication.

4. Using the Add Copy Set Wizard, choose the same source and target volumes
that you identified in step 2.

5. Complete the Add Copy Set Wizard, and ensure that all copy sets are created
successfully.

6. Issue a Start command from Tivoli Storage Productivity Center for Replication.
The session automatically assimilates the relationships on the hardware and
adds them to a new consistency group on the storage system.

Note: The Start command does not fully resynchronize data; instead, it detects
the existing relationships and adopts them placing them in a consistency group
managed by the session.

Practicing disaster recovery
You can use practice volumes to test your disaster recovery actions while
maintaining disaster recovery capability. Practice volumes are available in Metro
Mirror Failover and Failback sessions, Global Mirror Failover and Failback, Global
Mirror Either Direction sessions, and Metro Global Mirror with Practice sessions.

Important: You can test your disaster recovery actions without using practice
volumes. However, without practice volumes, you cannot maintain disaster
recovery capability while continuing to copy the data.
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Practice volumes
You can use a practice volume to practice what you would do in the event of a
disaster, without interrupting current data replication. Practice volumes are
available in Metro Mirror, Global Mirror, and Metro Global Mirror sessions.

To use the practice volumes, the session must be in the prepared state. Issuing the
Flash command against the session while in the Prepared state creates a usable
practice copy of the data on the target site.

Note: You can test disaster-recovery actions without using practice volumes;
however, without practice volumes, you cannot continue to copy data changes
between volumes while testing disaster-recovery actions.

Practicing disaster recovery for a Metro Mirror
Failover/Failback with Practice session

A Metro Mirror Failover and Failback session with Practice combines Metro Mirror
and FlashCopy to provide a point-in-time copy of the data on the remote site. You
can use this to practice what you might do if a disaster occurred, without losing
your disaster recovery capability.

This function is available on the following storage systems:
v System Storage SAN Volume Controller
v Storwize V7000
v TotalStorage Enterprise Storage Server Model 800
v System Storage DS8000
v System Storage DS6000

Perform these steps to practice disaster recover actions for a Metro Mirror
Failover/Failback with Practice session:
1. Start a Metro Mirror with Practice session.
2. When the Metro Mirror session reaches the Prepared state, issue a Flash

command to make a point-in-time copy of the data on H2. This creates a
consistent point-in-time copy of your data on the H2 volume and then restarts
the session so the copying from H1 to I2 continues. This temporarily stops
copying of the data from site 1 to site 2, and creates a consistent point-in-time
copy. The data replication from H1 to I2 is then restarted.

Note: For ESS, DS6000, and DS8000 storage systems, the Flash command uses
the freeze and thaw processing to create a data consistent point for the
FlashCopy. If there is another Metro Mirror session overlapping on one or more
of the same LSS pairs, that session will be suspended. It is also possible that
the suspension of the other session might cause the Metro Mirror session to
remain suspended after the flash command is issued instead of returning to
Prepared state. Avoid using the same LSS pairs for multiple Metro Mirror
sessions if possible.

3. Practice the same actions you would take in an actual disaster, using H2 as
your new host volume, while running the real application on H1.

Practicing disaster recovery for a Global Mirror either
Direction with two-site Practice session

A Global Mirror (either direction) with two-site Practice combines Global Mirror
and FlashCopy to provide a point-in-time copy of the data on a remote site at a
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distance over 300 km away from your first site. You can use this to practice what
you might do if a disaster occurred, without losing your disaster recovery
capability.

Note: This function is available only on ESS, DS6000, and DS8000 storage systems.

Perform these steps to practice disaster recover actions for a Global Mirror either
Direction with two-site Practice session:
1. Start a Global Mirror with Practice session.
2. When the session reaches the Prepared state, issue a Flash command to restore

consistent data on I2 and make a point-in-time copy of the data on H2. This
creates a consistent point-in-time copy of your data on the H2 volume and then
restarts the session so the copying from H1 to I2 continues. This temporarily
stops copying of the data from site 1 to site 2, and creates a consistent
point-in-time copy. The data replication from H1 to I2 is then restarted.

Note: FlashCopy must be always a full copy due to limitations of the
hardware.

3. Practice the same actions you would take in an actual disaster, using H2 as
your new host volume, while running the real application on H1.

Note: With two directions, you can reverse the direction of your data flow.

Practicing disaster recovery for a Global Mirror
Failover/Failback with Practice session

A Global Mirror Failover and Failback with Practice combines Global Mirror and
FlashCopy to provide a point-in-time copy of the data on a remote site at a
distance over 300 km away from your first site. You can use this to practice what
you might do if a disaster occurred.

You can do this practice without losing your disaster recovery capability. The
number of volumes used for the device varies, but the steps to conduct a Global
Mirror Failover and Failback with Practice are the same for both devices.

This function is available on the following storage systems:
v System Storage SAN Volume Controller
v Storwize V7000
v TotalStorage Enterprise Storage Server Model 800
v System Storage DS8000
v System Storage DS6000

Perform these steps to practice disaster recover actions for a Global Mirror
Failover/Failback with Practice session:
1. Start a Global Mirror with Practice session.
2. When the session reaches the Prepared state, issue a Flash command to restore

consistent data on I2 and make a point-in-time copy of the data on H2. This
creates a consistent point-in-time copy of your data on the H2 volume and then
restarts the session so the copying from H1 to I2 continues. This temporarily
stops copying of the data from site 1 to site 2, and creates a consistent
point-in-time copy. The data replication from H1 to I2 is then restarted.

Note: FlashCopy must be always a full copy due to limitations of the
hardware.
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3. Practice the same actions you would take in an actual disaster, using H2 as
your new host volume, while running the real application on H1.

Practicing disaster recovery for a Metro Global Mirror
Failover/Failback with Practice session

A Metro Global Mirror Failover/Failback with Practice session combines Metro
Mirror, Global Mirror and FlashCopy across three sites to provide a point-in-time
copy of the data on the third site. You can use this to practice what you might do
if a disaster occurred without losing your disaster recovery capability.

Note: This function is available on ESS, DS6000, and DS8000 storage systems.

The intermediate volume is on the third site (I3). This maintains disaster recovery
capability while a copy is kept on the H3 volume for practice purposes.

Perform these steps to practice disaster recover actions for a Metro Global Mirror
Failover/Failback with Practice session:
1. Start a Metro Global Mirror with Practice session.
2. When the session reaches the Prepared state, issue a Flash command to take a

point-in-time copy of the data that is on I3, on H3. This creates a consistent
point-in-time copy of your data on the H3 volume, and then automatically
restarts the session so that copying from H1 to H2 to I3 continues. The Flash
command temporarily stops copying the data from site 2 to site 3, in order to
create a consistent point-in-time copy on I3, while maintaining disaster
recovery capabilities on site 2 using the Metro Mirror portion of the session.
Then, data replication from H2 to I3 is restarted.

Note: FlashCopy must be always a full copy due to hardware limitations.
3. Practice the same actions you would take in an actual disaster, using H3 as

your practice host volume, while you run the real application on H1. This
enables you to use the same scripts and commands to run on H3 that you
would use in an actual disaster.

Monitoring health and status

Viewing the health summary
Use the Health Overview panel to view overall health and status of sessions,
storage systems, host systems, and management servers.

The Health Overview panel is the first panel that you see after you log on. You can
display this panel by selecting Health Overview in the Tivoli Storage Productivity
Center for Replication navigation tree. This panel provides the following
information:

Overall session status
Indicates session status, which can be normal, warning, or severe. The
status can also be inactive, if all sessions are defined or if no sessions exit.

Overall storage system status
Indicates the connection status of storage systems.

Overall host system status
Indicates the connection status of host systems.
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Management server status
Indicates the status of the standby server if you are logged on to the local
server. If you are logged on to the standby server, this status indicates the
status of the local server. Management server status is not available if you
are using Tivoli Storage Productivity Center for Replication Basic Edition
for System z.

Health information is always shown as a mini-panel under the navigation tree.

Viewing SNMP alerts
IBM Tivoli Storage Productivity Center for Replication SNMP trap descriptions can
be viewed from the IBM Tivoli Storage Productivity Center Alert panel.

From the IBM Tivoli Storage Productivity Center GUI, in the navigation tree,
expand Alerting > Alert Log > All and select Replication.

Viewing sessions
This section describes how to view sessions details and session properties.

Session status icons
The IBM Tivoli Storage Productivity Center for Replication GUI uses icons to
represent the status of each session.

The following table describes each session status icon.

Table 81. Session status icons

Icon Meaning Description

Inactive The session is in a defined state, with no activity on
the hardware.

Normal A consistent copy of the data either exists or is being
maintained.

Warning For Metro Mirror, Global Mirror, and Metro Global
Mirror, the session might have volumes that are
being synchronized or are about to be synchronized,
with no suspended volumes. For FlashCopy, the
warning status is valid only after the start command
is issued and before the flash. This warning status
means that the session is either preparing or is ready
for a flash command but targets do not yet have a
consistent copy.

If a HyperSwap session is degraded, which means it
is enabled on one or more sysplex members and
disabled on at least one sysplex member, then the
session is in a warning state.

Severe One or more errors must be dealt with immediately.
Possible causes include the following:
v One or more volumes are suspended
v A session is suspended
v A volume is not copying correctly

Session images
The IBM Tivoli Storage Productivity Center for Replication GUI provides a visual
aid to help you create and manage your sessions. The visual aid shows the number
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of volume roles in the session and how the roles are distributed between the sites.
It also shows the copy method and direction.

Volume role symbols

The volume role symbols represent the replication status on the volumes.

Table 82. Volume role symbols

Symbol Description Meaning

Active host volumes This symbol represents volumes that
contain the source of updated tracks to
which the application is actively issuing
read and write input/output (I/O).

Recoverable volumes This symbol represents volumes that
contain a consistent copy of the data.

Inconsistent volumes This symbol represents the volumes that
do not contain a consistent copy of the
data.

Selected volumes This symbol represents the volumes that
are selected for an operation (for
example, changing location or
displaying role pair information).

Data copying symbols

The data copying symbols are arrows indicate the type of copy that occurs
between the volume roles. The direction of the arrow indicates the direction of the
copy.

Table 83. Data copying symbols

Symbol Description Meaning

FlashCopy copying
(the lightning bolt
indicates the
direction of the
FlashCopy)

This symbol represents a FlashCopy
relationship in which data is being
copied from the host to the target.

FlashCopy copying
with errors (the
lightning bolt
indicates the
direction of the
FlashCopy)

This symbol represents a FlashCopy
relationship in which data is being
copied from the host to the target, but
there are errors on one or more pairs.

FlashCopy inactive
(the lightning bolt
indicates the
direction of the
FlashCopy)

This symbol represents an inactive
FlashCopy relationship.
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Table 83. Data copying symbols (continued)

Symbol Description Meaning

FlashCopy inactive
with errors (the
lightning bolt
indicates the
direction of the
FlashCopy)

This symbol represents an inactive
FlashCopy relationship in which there
are errors on one or more pairs.

Metro Mirror copying This symbol represents a copying Metro
Mirror relationship.

Metro Mirror copying
with errors

This symbol represents a Metro Mirror
relationship that is copying, but with
errors on one or more pairs.

Metro Mirror inactive This symbol represents an inactive
Metro Mirror relationship.

Metro Mirror inactive
with errors

This symbol represents an inactive
Metro Mirror relationship with errors
on one or more pairs.

Global Copy copying This symbol represents a copying
Global Copy relationship.

Global Copy copying
with errors

This symbol represents a copying
Global Copy relationship with errors on
one or more pairs.

Global Copy inactive This symbol represents an inactive
Global Copy relationship.

Global Copy inactive
with errors

This symbol represents an inactive
Global Copy relationship with errors on
one or more pairs.

HyperSwap or Open
HyperSwap

This symbol HyperSwap or Open
HyperSwap for a session. If a failure
occurs when input/output (I/O) is
being written to the primary storage
system, HyperSwap or Open
HyperSwap automatically swap the I/O
to the secondary site with no user
interaction and little or no application
impact.
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Session states
You can view the health and status of a session in the Tivoli Storage Productivity
Center for Replication GUI.

Attention: Use only the Tivoli Storage Productivity Center for Replication
graphical user interface (GUI) or command-line interface CLI to manage session
relationships, such as volume pairs and copy sets. Do not modify session
relationships through other interfaces such as the System Storage DS CLI. If you
modify relationships through other interfaces, a loss of consistency can across the
relationships that are managed by the session. The exceptions to this requirement
are failover operations that are managed by external applications for certain
session and storage system types as described in “Failover and failback operations”
on page 695.

You can use the Refresh States command is used to refresh the states of the
session. Issue this command to query the states of the copy sets on the hardware.
You do not need to run this command under typical circumstances; Tivoli Storage
Productivity Center for Replication refreshes the states of its sessions through
multiple means. However, if you discover an inconsistency between Tivoli Storage
Productivity Center for Replication and the hardware, you can use this command
to enable IBM Tivoli Storage Productivity Center for Replication to update itself.
Because this command triggers multiple queries on the hardware (having an
adverse impact on hardware performance if you run it too often), you can only
execute this command every few minutes in each session.

The following table describes each session state.

Table 84. Session states

State Session type Description

Defined All The session exists but is inactive.

Flashing All In a Metro Mirror or Global Mirror
session, data copying is temporarily
suspended while a consistent practice
copy of data is being prepared on site 2.

In a Metro Global Mirror session, data
copying is temporarily suspended while
a consistent practice copy of data is
being prepared on site 3.
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Table 84. Session states (continued)

State Session type Description

Prepared All The source to target data transfer is
active.

In a Metro Mirror, Global Mirror, or
Metro Global Mirror session, the data
written to the source is transferred to the
target, and all volumes are consistent
and recoverable.

In a FlashCopy session, the volumes are
not yet consistent, but the flash is ready
to begin.
Important: For sessions on the following
storage systems, do not alter the
relationships on the hardware that you
established with Tivoli Storage
Productivity Center for Replication:

v System Storage SAN Volume
Controller

v Storwize V7000

For example, if a Metro Mirror session
with one copy set is in the Prepared
state, and you stop the role pair, the
session is still displayed in the Prepared
state.

Preparing All The volumes are initializing,
synchronizing, or resynchronizing.

In a Metro Mirror, Global Mirror, or
Metro Global Mirror session,
synchronization occurs after the first
Start command is issue on a session.
Resynchronization occurs when a volume
was prepared and then suspended. The
hardware records the changed tracks so
that on the next startup, only the
changed tracks are copied.

In a FlashCopy session, the volumes are
initializing. The preparing state for
FlashCopy sessions applies only to the
System Storage SAN Volume Controller
or Storwize V7000.

Recovering All The session is in the process of
recovering.

Suspended All Data copying has temporarily stopped.
Important: The suspended state applies
only to Global Mirror, Metro Mirror, and
Metro Global Mirror sessions.

SuspendedH1H2 MGM Metro Global Mirror Data copying between site 1 and site 2 is
suspended.

SuspendedH1H3 MGM Metro Global Mirror Data copying between site 1 and site 3 is
suspended.

770 IBM Tivoli Storage Productivity Center: User's Guide



Table 84. Session states (continued)

State Session type Description

Suspending All The session is transitioning into a
Suspended state.
Important: The Suspending state applies
only to Global Mirror and Metro Global
Mirror sessions and does not apply to
the System Storage SAN Volume
Controller or Storwize V7000.

Target available All Target volumes are available for
application updates.

Terminating FlashCopy The session is being terminated because
you issued a Terminate action under the
following conditions:

v You permitted the target to be Metro
Mirror or Global Copy.

v You set the Require or Attempt to
Preserve Mirror option.

The session displays as Terminating until
the FlashCopy background copy is
complete and no longer exists on the
hardware.

Session properties
You can view and modify the description and options for a session. The options
that are presented depend on the storage system type and the session type that
you select.

Session properties include the following attributes:

Description
Type the description for this session.

ESS/DS FlashCopy Options
Select the FlashCopy options that you want to associate with this session:

Incremental
Select this option to set up the relationship for recording changes
to the H1 volume. Any subsequent FlashCopy operation for that
session copies only the tracks that changed since the last flash.
Incremental always assumes persistence.

Note: This option is used along with the Persistent and No-Copy
options.

Persistent
Select this option to keep the relationship established on the
hardware after all source tracks are copied to the target. If this
option is not selected, the local replication relationship ends after
the T1 volume contains a complete point-in-time image of the H1
volume.

Note: If you select the Incremental option, the Persistent option is
automatically selected as well.
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No Copy
Select this option if you do not want the hardware to write the
background copy until the source track is written to. Data is not
copied to the H1 volume until the blocks or tracks of the T1
volume are modified. If you want a complete point-in-time copy of
the T1 volume to be created on the H1 volume, do not use the No
Copy option.

Allow FlashCopy target to be Metro Mirror source
Select this option if the target of the FlashCopy relationship is to
overwrite all data on the source of a Metro Mirror relationship. If
this option is cleared, a flash to a Metro Mirror source volume
fails.

If you select this option, you must also select one of the following
policies:

Do not attempt to preserve Metro Mirror consistency
Select this option if the Metro Mirror or Global Copy pair
at the target of the FlashCopy relationship is to perform a
full copy of the data to the secondary of the Metro Mirror
or Global Copy pair.

Attempt to preserve Metro Mirror consistency, but allow
FlashCopy even if Metro Mirror target consistency cannot be
preserved

Select this option to attempt to preserve the consistency of
the Metro Mirror relationship at the target of the
FlashCopy relationship when both the source and target of
the FlashCopy relationship are a source of a Metro Mirror
relationship. If the consistency cannot be preserved, a full
copy of the Metro Mirror relationship at the target of the
FlashCopy relationship is performed. To preserve
consistency, parallel flashes are performed (if possible) on
both sites.

Note: This option is available only on IBM System Storage
DS8000 storage systems with the required code levels
installed.

Attempt to preserve Metro Mirror consistency, but fail FlashCopy
if Metro Mirror target consistency cannot be preserved

This option prevents a full copy from being performed
over the Metro Mirror link. Instead, parallel flashes are
performed (if possible) on both sites. If the consistency
cannot be preserved, the Flash for the FlashCopy
relationships fails, and the data of the Metro Mirror
relationship at the target of the FlashCopy relationship is
not changed.

Note: This option is available only on System Storage
DS8000 storage systems with the required code levels
installed.

SAN Volume Controller / Storwize V7000 / Storwize V7000 Unified FlashCopy
Options

Select the FlashCopy options that you want to associate with this session.
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Incremental
Select this option to set up the relationship for recording changes
to the H1 volume. Any subsequent FlashCopy operation for that
session copies only the tracks that changed since the last flash.
Incremental always assumes persistence.

Background Copy Rate
Type the copy rate that the Storage System uses to perform the
background copy of the FlashCopy role pair. You can specify a
percentage between 0 and 100. The default is 50. Specifying 0 is
equivalent to specifying the No-Copy option on a TotalStorage
Enterprise Storage Server Model 800, System Storage DS8000, or
System Storage DS6000 FlashCopy session.

You can modify this value at any time during the session. If the
session is performing a background copy when you change the
option, Tivoli Storage Productivity Center for Replication
immediately modifies the background copy rate of the consistency
group on the storage system. The storage system consistency group
immediately starts by using this new rate to complete the
background copy.

Basic HyperSwap Options
Select the Basic HyperSwap options that you want to associate with this
session.

If Tivoli Storage Productivity Center for Replication is running on z/OS,
and volumes are attached by a Fibre Channel connection, Tivoli Storage
Productivity Center for Replication can manage a HyperSwap session.
With this option selected, a failure on the host accessible volumes triggers
a HyperSwap, redirecting application input/output (I/O) to the secondary
volumes.

These options are available only for Basic HyperSwap sessions:

Disable HyperSwap
Select this option to prevent a HyperSwap from occurring by
command or event.

On Configuration Error:

Partition the system(s) out of the sysplex
Select this option to partition out of the sysplex when a
new system is added to the sysplex and encounters an
error in loading the configuration. Restart the system if you
select this option.

Disable HyperSwap
Select this option to prevent a HyperSwap from occurring
by command or event.

On Planned HyperSwap Error:

Partition out the failing system(s) and continue swap processing
on the remaining system(s)

Select this option to partition out the failing system and
continue the swap processing on any remaining systems.

Disable HyperSwap after attempting backout
Select this option to stop the HyperSwap action, and
disable the HyperSwap commands or events.
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On Unplanned HyperSwap Error:

Partition out the failing system(s) and continue swap processing
on the remaining system(s)

Select this option to partition out the failing systems and
continue HyperSwap processing on the remaining systems
when a new system is added to the sysplex and
HyperSwap does not complete. You must restart the
system if you select this option.

Disable HyperSwap after attempting backout
Select this option to stop the HyperSwap action, and
disable the HyperSwap commands or events.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a copy set if the
session is online and if the target volume in the copy set is visible
to a host.

ESS/DS Metro Mirror Options
Select the Metro Mirror options that you want to associate with this
session. These options are available only for TotalStorage Enterprise
Storage Server Model 800, System Storage DS8000, or System Storage
DS6000 storage systems in a Metro Mirror session:

Reset Secondary Reserve
Select this option to remove any persistent reserves that might be
set on the target volumes of the copy sets being started when a
Start command is issued for the session.

Note:
Before enabling the Reset Secondary Reserves option, be aware that
this action causes the session to overwrite all data on the target
volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a copy set if the
session is online and if the target volume in the copy set is visible
to a host.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor
(IOS) to manage freeze operations. This option is enabled by
default.

If you select the Manage H1-H2 with HyperSwap option for the
session, the Enable Hardened Freeze option is ignored. IOS
support for managing freeze operations is included with
HyperSwap. The Enable Hardened Freeze option ensures data
integrity if Tivoli Storage Productivity Center for Replication
freezes and HyperSwap is not enabled for a session.

If you select the Enable Hardened Freeze option, the following
actions can occur:
v IOS can freeze volumes regardless of whether the Tivoli Storage

Productivity Center for Replication server is started or stopped.
v You can include z/OS system volumes such as paging, database,

and WebSphere Application Server hierarchical file system (HFS)
as Metro Mirror volumes in the session. When you select the
Enable Hardened Freeze option, IOS manages the freeze
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operations for all Metro Mirror volumes in the session, which
prevents Tivoli Storage Productivity Center for Replication from
freezing the volumes and possibly freezing itself. The Enable
Hardened Freeze option does not enable IOS to manage freeze
operations for Global Mirror volumes.

Requirement: The Enable Hardened Freeze option requires the
z/OS address spaces Basic HyperSwap Management and Basic
HyperSwap API. For instructions about how to start these address
spaces, see the information about preparing to use Basic
HyperSwap from z/OS in the IBM Tivoli Storage Productivity Center
for Replication for System z Installation and Configuration Guide.

Metro Mirror Suspend Policy
You must select either Hold I/O after Suspend or Release I/O
after Suspend when a replication link suspends. A replication link
suspends for various reasons. In some cases, it happens because
the replication link is down or the auxiliary storage controller
failed. In other cases, it might be the first failure in an eventual full
failure at the primary site.

If your primary goal is zero data loss, specify Hold I/O after
Suspend. Selecting this option means that no additional
updates are made to storage until the entire scope of the failure
can be determined. If you select this option, the systems by
using that storage become unavailable until a decision is made
about how to proceed. It might also require restarting the
systems.
If your primary goal is availability, specify Release I/O after
Suspend. This option enables workloads to continue running
after all the replication links are suspended, maintaining a
consistent copy of data at the remote site. If the failure spreads
through the primary site after the workloads resume running
and results in a site failure, data loss occurs. The I/O requests
that are issued after the resume and before the failure at the
primary site are lost. The storage at the secondary site remains
consistent, however, and you can recover it there.

Hold I/O after Suspend
Select this option to block the application from writing
while a consistent copy of the data is maintained on the
remote site; however, it does not automatically release the
application. This option keeps the source equal to the
target. You must use the Release I/O command on the
session or wait for the Hardware Freeze Timeout timer to
expire before the application can continue to write to the
source.

Release I/O after Suspend
Select this option to block writes to the application while a
consistent copy of the data is formed on the remote site.
This operation is followed immediately by releasing the
block so that the application can continue writing to the
source. This option allows for little application impact, but
causes the source to potentially be different from the target.

This option is the default setting for all new sessions.
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DS FlashCopy Options for Role pair H2-I2
The following option is available only for System Storage DS8000
version 4.2 or later.

Persistent
Select this option to keep FlashCopy pairs persistent on the
hardware.

Manage H1-H2 with HyperSwap
Select this option to trigger a HyperSwap, redirecting application
I/O to the secondary volumes, when there is a failure on the host
accessible volumes. For Metro Global Mirror sessions, the Global
Mirror portion of the session continues to run uninterrupted.

Tivoli Storage Productivity Center for Replication can manage the
H1-H2 sequence of a Metro Mirror or Metro Global Mirror session
by using HyperSwap if Tivoli Storage Productivity Center for
Replication is running on z/OS, and volumes are attached by a
Fibre Channel connection.

Notes:

v When this option is selected, the Suspend H1-H2 command is
available only if the Disable HyperSwap option is also selected.

v Setting this option automatically sets the Release IO after
suspend Metro Mirror policy.

Disable HyperSwap
Select this option to prevent a HyperSwap from occurring
by command or event.

On Configuration Error:

Partition the system(s) out of the sysplex
Select this option to partition out of the sysplex
when a new system is added to the sysplex and
encounters an error in loading the configuration.
Restart the system if you select this option.

Disable HyperSwap
Select this option to prevent a HyperSwap from
occurring by command or event.

On Planned HyperSwap Error:

Partition out the failing system(s) and continue swap
processing on the remaining system(s)

Select this option to partition out the failing system
and continue the swap processing on any
remaining systems.

Disable HyperSwap after attempting backout
Select this option to stop the HyperSwap action,
and disable the HyperSwap commands or events.

On Unplanned HyperSwap Error:

Partition out the failing system(s) and continue swap
processing on the remaining system(s)

Select this option to partition out the failing
systems and continue HyperSwap processing on
the remaining systems when a new system is
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added to the sysplex and HyperSwap does not
complete. You must restart the system if you select
this option.

Disable HyperSwap after attempting backout
Select this option to stop the HyperSwap action,
and disable the HyperSwap commands or events.

Manage H1-H2 with Open HyperSwap
If volumes are attached to an IBM AIX host, Tivoli Storage
Productivity Center for Replication can manage the H1-H2
sequence of a Metro Mirror session by using Open HyperSwap. If
this option is selected, a failure on the host accessible volumes
triggers a swap, which redirects application I/O to the secondary
volumes. Only volumes that are currently attached to the host
systems that are defined on the Tivoli Storage Productivity Center
for Replication Host Systems panel are eligible for Open
HyperSwap.

Disable Open HyperSwap
Select this option to prevent a swap from occurring by a
command or event while keeping the configuration on the
host system and all primary and secondary volumes
coupled.

SAN Volume Controller / Storwize V7000 / Storwize V7000 Unified Metro
Mirror Options

Select the Metro Mirror options that you want to associate with this
session. The following options are available only for storage systems that
are in a Metro Mirror Failover/Failback with Practice session:

Incremental
Select this option to set up the relationship for recording changes
to the practice volume (H2). All subsequent FlashCopy operations
between the intermediate volume and the host volume copy only
the data that changed since the previous FlashCopy operation.
Incremental always assumes persistence.

Background Copy Rate for H2-I2
Type the copy rate that the Storage System uses to perform the
background copy of the FlashCopy role pair. You can specify a
percentage between 0 and 100. The default is 50. Specifying 0 is
equivalent to specifying the No-Copy option on a TotalStorage
Enterprise Storage Server Model 800, System Storage DS8000, or
System Storage DS6000 FlashCopy session.

You can modify this value at any time during the session. If the
session is performing a background copy when you change the
option, Tivoli Storage Productivity Center for Replication
immediately modifies the background copy rate of the consistency
group on the storage system. The storage system consistency group
immediately starts by using this new rate to complete the
background copy.

ESS/DS Global Mirror Options
Select the Global Mirror options that you want to associate with this
session. These options are available only for TotalStorage Enterprise
Storage Server Model 800, System Storage DS8000, and System Storage
DS6000 storage systems in a Global Mirror session:
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Consistency group interval time (seconds)
Type how often, in seconds, the Global Mirror session attempts to
form a consistency group. When you reduce this value, it might be
possible to reduce the data exposure of the session. A smaller
interval value causes the session to attempt to create consistency
groups more frequently, which might affect the storage systems
(for example, by increasing the processing load and message traffic
load).

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery
point objective (RPO) thresholds. The values determine whether a
Warning or Severe alert is generated when the RPO threshold is
exceeded for a role pair. The RPO represents the length of time in
seconds of data exposure that is acceptable in the event of a
disaster.

Use the following options to set the RPO threshold values. For
both options, you can specify an RPO threshold of 0 - 65535
seconds. The default is 0 seconds, which specifies that no alerts are
generated. If the Severe level threshold is set to a value other than
0, the Warning level threshold must be less than the Severe level
threshold or set to 0.

Warning level threshold (seconds)
Type the number of seconds that you want to set for the
warning level RPO threshold. If the RPO is greater than
this value, an alert is generated.

Severe level threshold (seconds)
Type the number of seconds that you want to set for the
severe level RPO threshold. If the RPO is greater than this
value, an alert is generated and the session status changes
to Severe.

Reset Secondary Reserve
Select this option to remove any persistent reserves that might be
set on the target volumes of the copy sets being started when a
Start command is issued for the session.

Note:
Before enabling the Reset Secondary Reserves option, be aware that
this action causes the session to overwrite all data on the target
volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a copy set if the
session is online and if the target volume in the copy set is visible
to a host.

DS FlashCopy Options for Role pair H2-I2
The following options are available only for System Storage
DS8000 version 4.2 or later.

Persistent
Select this option to keep FlashCopy pairs persistent on the
hardware.

No Copy
Select this option if you do not want the hardware to write
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the background copy until the source track is written to.
Data is not copied to the H2 volume until the blocks or
tracks of the I2 volume are modified. If you want a
complete point-in-time copy of the I2 volume to be created
on the H2 volume, do not use the No Copy option.

DS FlashCopy Options for Role pair I2-J2
The following option is available only for System Storage DS8000
version 4.2 or later.

Reflash After Recover
Select this option if you want to create a FlashCopy
replication between the I2 and J2 volumes after the
recovery of a Global Mirror session. If you do not select
this option, a FlashCopy replication is created only
between the I2 and H2 volumes.

SAN Volume Controller / Storwize V7000 / Storwize V7000 Unified Global
Mirror Options

Select the Global Mirror options that you want to associate with this
session. These options are available only for storage systems that are in a
Global Mirror Failover/Failback with Practice session:

Incremental
Select this option to set up the relationship for recording changes
to the practice volume (H2). All subsequent FlashCopy operations
between the intermediate volume and the host volume copy only
the data that changed since the previous FlashCopy operation.
Incremental always assumes persistence.

Background Copy Rate for H2-I2
Type the copy rate that the Storage System uses to perform the
background copy of the FlashCopy role pair. You can specify a
percentage between 0 and 100. The default is 50. Specifying 0 is
equivalent to specifying the No-Copy option on a TotalStorage
Enterprise Storage Server Model 800, System Storage DS8000, or
System Storage DS6000 FlashCopy session.

You can modify this value at any time during the session. If the
session is performing a background copy when you change the
option, Tivoli Storage Productivity Center for Replication
immediately modifies the background copy rate of the consistency
group on the storage system. The storage system consistency group
immediately starts by using this new rate to complete the
background copy.

XIV Global Mirror Options
Select the Global Mirror options that you want to associate with this
session. These options are available only for the XIV systems in a Global
Mirror Failover/Failback session:

Recovery point objective threshold (seconds)
Type the number of seconds that you want to set for the recovery
point objective (RPO) threshold. RPO represents a measure of the
maximum data loss that is acceptable in the event of a failure or
unavailability of the master.

If the XIV system determines that the RPO is greater than this
value, the session state becomes Severe. You can specify an RPO
between 30 and 86400 seconds. The default is 30 seconds.
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Synchronization schedule (HH:MM:SS)
Select an interval for the creation of the XIV system
synchronization schedule. The XIV system attempts to form
consistent points of data by taking automatic snapshots of the
volumes in the session at this interval. The default is Minimum
Interval, which is 20 seconds.

If you select Never, synchronization is not scheduled and the XIV
system does not create consistency groups. When the XIV system
determines that the RPO threshold is passed, the session state
becomes Severe.

ESS/DS Metro Global Mirror Options
Select the Metro Global Mirror options that you want to associate with this
session These options are available only for TotalStorage Enterprise Storage
Server Model 800, System Storage DS8000, or System Storage DS6000
storage systems in a Metro Global Mirror session:

Consistency group interval time (seconds)
Type how often, in seconds, the Metro Global Mirror session
attempts to form a consistency group. When you reduce this value,
it might be possible to reduce the data exposure of the session. A
smaller interval value causes the session to attempt to create
consistency groups more frequently, which might affect the storage
systems (for example, by increasing the processing load and
message traffic load).

Recovery Point Objective Alerts
Specify the length of time that you want to set for the recovery
point objective (RPO) thresholds. The values determine whether a
Warning or Severe alert is generated when the RPO threshold is
exceeded for a role pair. The RPO represents the length of time in
seconds of data exposure that is acceptable in the event of a
disaster.

Use the following options to set the RPO threshold values. For
both options, you can specify an RPO threshold of 0 - 65535
seconds. The default is 0 seconds, which specifies that no alerts are
generated. If the Severe level threshold is set to a value other than
0, the Warning level threshold must be less than the Severe level
threshold or set to 0.

Warning level threshold (seconds)
Type the number of seconds that you want to set for the
warning level RPO threshold. If the RPO is greater than
this value, an alert is generated.

Severe level threshold (seconds)
Type the number of seconds that you want to set for the
severe level RPO threshold. If the RPO is greater than this
value, an alert is generated and the session status changes
to Severe.

Reset Secondary Reserve
Select this option to remove any persistent reserves that might be
set on the target volumes of the copy sets being started when a
Start command is issued for the session.
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Note:
Before enabling the Reset Secondary Reserves option, be aware that
this action causes the session to overwrite all data on the target
volume.

Fail MM/GC if target is online (CKD only)
Select this option to fail any session commands for a copy set if the
session is online and if the target volume in the copy set is visible
to a host.

Enable Hardened Freeze
Select this option to enable the z/OS Input/Output Supervisor
(IOS) to manage freeze operations. This option is enabled by
default.

If you select the Manage H1-H2 with HyperSwap option for the
session, the Enable Hardened Freeze option is ignored. IOS
support for managing freeze operations is included with
HyperSwap. The Enable Hardened Freeze option ensures data
integrity if Tivoli Storage Productivity Center for Replication
freezes and HyperSwap is not enabled for a session.

If you select the Enable Hardened Freeze option, the following
actions can occur:
v IOS can freeze volumes regardless of whether the Tivoli Storage

Productivity Center for Replication server is started or stopped.
v You can include z/OS system volumes such as paging, database,

and WebSphere Application Server hierarchical file system (HFS)
as Metro Mirror volumes in the session. When you select the
Enable Hardened Freeze option, IOS manages the freeze
operations for all Metro Mirror volumes in the session, which
prevents Tivoli Storage Productivity Center for Replication from
freezing the volumes and possibly freezing itself. The Enable
Hardened Freeze option does not enable IOS to manage freeze
operations for Global Mirror volumes.

Requirement: The Enable Hardened Freeze option requires the
z/OS address spaces Basic HyperSwap Management and Basic
HyperSwap API. For instructions about how to start these address
spaces, see the information about preparing to use Basic
HyperSwap from z/OS in the IBM Tivoli Storage Productivity Center
for Replication for System z Installation and Configuration Guide.

Metro Mirror Suspend Policy
You must select either Hold I/O after Suspend or Release I/O
after Suspend when a replication link suspends. A replication link
suspends for various reasons. In some cases, it happens because
the replication link is down or the auxiliary storage controller
failed. In other cases, it might be the first failure in an eventual full
failure at the primary site.

If your primary goal is zero data loss, specify Hold I/O after
Suspend. Selecting this option means that no additional
updates are made to storage until the entire scope of the failure
can be determined. If you select this option, the systems by
using that storage become unavailable until a decision is made
about how to proceed. It might also require restarting the
systems.
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If your primary goal is availability, specify Release I/O after
Suspend. This option enables workloads to continue running
after all the replication links are suspended, maintaining a
consistent copy of data at the remote site. If the failure spreads
through the primary site after the workloads resume running
and results in a site failure, data loss occurs. The I/O requests
that are issued after the resume and before the failure at the
primary site are lost. The storage at the secondary site remains
consistent, however, and you can recover it there.

Hold I/O after Suspend
Select this option to block the application from writing
while a consistent copy of the data is maintained on the
remote site; however, it does not automatically release the
application. This option keeps the source equal to the
target. You must use the Release I/O command on the
session or wait for the Hardware Freeze Timeout timer to
expire before the application can continue to write to the
source.

Release I/O after Suspend
Select this option to block writes to the application while a
consistent copy of the data is formed on the remote site.
This operation is followed immediately by releasing the
block so that the application can continue writing to the
source. This option allows for little application impact, but
causes the source to potentially be different from the target.

This option is the default setting for all new sessions.

Manage H1-H2 with HyperSwap
Select this option to trigger a HyperSwap, redirecting application
I/O to the secondary volumes, when there is a failure on the host
accessible volumes. For Metro Global Mirror sessions, the Global
Mirror portion of the session continues to run uninterrupted.

Tivoli Storage Productivity Center for Replication can manage the
H1-H2 sequence of a Metro Mirror or Metro Global Mirror session
by using HyperSwap if Tivoli Storage Productivity Center for
Replication is running on z/OS, and volumes are attached by a
Fibre Channel connection.

Notes:

v When this option is selected, the Suspend H1-H2 command is
available only if the Disable HyperSwap option is also selected.

v Setting this option automatically sets the Release IO after
suspend Metro Mirror policy.

Disable HyperSwap
Select this option to prevent a HyperSwap from occurring
by command or event.

On Configuration Error:

Partition the system(s) out of the sysplex
Select this option to partition out of the sysplex
when a new system is added to the sysplex and
encounters an error in loading the configuration.
Restart the system if you select this option.
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Disable HyperSwap
Select this option to prevent a HyperSwap from
occurring by command or event.

On Planned HyperSwap Error:

Partition out the failing system(s) and continue swap
processing on the remaining system(s)

Select this option to partition out the failing system
and continue the swap processing on any
remaining systems.

Disable HyperSwap after attempting backout
Select this option to stop the HyperSwap action,
and disable the HyperSwap commands or events.

On Unplanned HyperSwap Error:

Partition out the failing system(s) and continue swap
processing on the remaining system(s)

Select this option to partition out the failing
systems and continue HyperSwap processing on
the remaining systems when a new system is
added to the sysplex and HyperSwap does not
complete. You must restart the system if you select
this option.

Disable HyperSwap after attempting backout
Select this option to stop the HyperSwap action,
and disable the HyperSwap commands or events.

ESS / DS FlashCopy Options for Role pair H3-I3
The following option is available only for System Storage DS8000
version 4.2 or later.

No Copy
Select this option if you do not want the hardware to write
the background copy until the source track is written to.
Data is not copied to the H3 volume until the blocks or
tracks of the I3 volume are modified. If you want a
complete point-in-time copy of the I3 volume to be created
on the H3 volume, do not use the No Copy option.

Role pair status and progress
In a session, a role pair is the association of two volume roles that take part in a
copy relationship. Tivoli Storage Productivity Center for Replication provides
detailed role pair status and progress messages for sessions.

The role pair status and progress messages are updated to provide a message that
indicates what the session is doing at the time. By hovering over a progress bar,
you can see specific information about the action running on the session. Some
status messages might include an estimated time-to-completion for the action in
hours and minutes.

Role pair status is not provided for the XIV system Snapshot sessions because role
pairs are not used for these sessions.

The status messages are displayed in the Session Details and Role Pair Details
page.
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Table 85. Detailed status messages for Participating and Non-Participating role pairs

Supported session type Status message

FlashCopy
Metro Mirror
Global Copy
Global Mirror

Starting role_pair_name relationships on the
hardware

Metro Mirror
Global Mirror

Waiting for all pairs in the role pair
role_pair_name to reach state of state

FlashCopy
Metro Mirror
Global Copy
Global Mirror

Terminating all pairs in role pair
role_pair_name

FlashCopy
Metro Mirror
Global Mirror

Recovering all pairs in role pair
role_pair_name

Metro Mirror
Global Copy
Global Mirror

Suspending all pairs in role pair
role_pair_name

FlashCopy Background copy is running for role pair
role_pair_name

Global Copy Waiting for all pairs in role pair
role_pair_name to become consistent

Global Copy Waiting for all pairs in role pairs
role_pair_name to complete the initial copy

FlashCopy Waiting for all pairs in role pairs
role_pair_name to complete FRR

Global Mirror Waiting for all pairs in role pairs
role_pair_name to join the Global Mirror
session

Viewing session properties
This topic describes how to view session properties.

To view a session's properties, perform the following steps:
1. In the navigation tree, select Sessions. The Sessions panel is displayed.
2. Click the name of the session with the properties you want to view.
3. Select View/Modify Properties from the Actions menu and click Go.

Viewing session details
You can view detailed information about a session, including role pairs, error
count, whether the session is recoverable, copying progress, session type, and the
timestamp.

Perform these steps to view session details:
1. In the navigation tree, select Sessions.
2. Select the session that you want to view.
3. Select View Details from the Actions drop-down menu, and click Go.
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Viewing additional details for Global Mirror sessions
Additional detail information is available for Global Mirror sessions, including
information about the Global Mirror master, consistency groups that have been
formed, and data exposure.

Perform these steps to view additional details for Global Mirror sessions:
1. In the IBM Tivoli Storage Productivity Center for Replication navigation tree,

select Sessions.
2. Select the Global Mirror session that you want to view.
3. Select View Details from the Actions drop-down menu, and click Go.
4. Click the Global Mirror Info tab. The following information is displayed on

the tab:

Global Mirror Master
Shows the name of the storage system acting as the Global Mirror
master.

Last Master Consistency Group Time
Shows the time that the last consistency group was formed

Master Time During Last Query
Shows the time on the master storage device when the query was
performed,

Data Exposure
Shows the average exposure to potential data loss in seconds over the
query interval.

Session ID
Shows the Global Mirror session ID.

Master State
Shows the state of the master session on the hardware.

Unsuccessful CGs since last successful CG
Shows the number of consistency groups that have failed to form since
the last successful consistency group was formed.

CG Interval Time
Shows the interval time between attempts to form a consistency group.

Max Coordination Interval
Shows the extended distance consistency maximum coordination
interval.

Max CG Drain Time
Shows the maximum time the consistent set of data is allowed to drain
at the remote site before failing consistency group formation.

Unsuccessful CGS/Previous Query
Shows the number of consistency groups and percentage of consistency
groups that were unsuccessful since the previous query.

Unsuccessful CGS/Total
Shows the total number of unsuccessful consistency groups and
percentage of consistency groups that have failed.

Successful CGS/Previous Query
Shows the number of consistency groups and percentage of consistency
groups that were successful since the previous query.
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Successful CGS/Total
Shows the total number of successful consistency groups and
percentage of consistency groups that have been successful.

Consistency Group Failure Messages
Shows the failure messages that have occurred on the Global Mirror
session that prevented the formation of a consistency group.

Data Exposure chart
Shows the data exposure values in seconds for the last 15 minutes or 24
hours.

Highlight Data Exposure
Use the following fields to define a value in seconds for which you
want data exposure to tracked in the Data Exposure chart.

Show Data Exposure over
Data exposure that is over the value that is entered in this field
is shown in the Data Exposure chart.

Show Data Exposure under
Data exposure that is under the value that is entered in this
field is shown in the Data Exposure chart.

Viewing storage system details
You can view detailed information about storage system, including the name,
location, type, vendor, and the status of all connections to the storage system.

Perform these steps to view storage system details:
1. In the navigation tree, select Storage Systems. The Storage Systems panel is

displayed in the Storage Systems view.
2. Perform one of these steps to view details for a specific storage system:

v Click the storage system ID.
v Select the storage system, click View storage system details from the Actions

list, and then click Go.

Viewing storage connection details
You can view storage connection details and a list of all storage systems that are
located behind the connection.

Perform these steps to view storage connection details:
1. In the navigation tree, select Storage Systems. The Storage Systems panel is

displayed in the Storage Systems view.
2. Click the Connections tab.
3. Perform one of these steps to view details for a specific storage connection:

v Click the storage connection ID.
v Select the storage connection, click View/modify Connection Details from

the actions list, and then click Go.

Viewing volume details
You can view information about volumes such as the name of the volume, the
capacity of the volume, and the type of volume.
1. In the navigation tree, select Volumes.
2. Select a storage.
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3. Depending on the type of storage system, do one of the following actions:
a. Select All IO Groups or a specific I/O group.
b. Select All Logical Storage Subsystems or a specific logical storage

subsystem.
c. Select All Pools or a specific pool.

4. Click Perform Query. Information about the volumes is displayed in a table.

Viewing logical paths
You can view all logical paths that are defined on an IBM TotalStorage Enterprise
Storage Server, IBM System Storage DS8000, or IBM System Storage DS6000
storage system.

Perform one of these procedures to view logical paths:
v From the ESS/DS Paths panel of IBM Tivoli Storage Productivity Center for

Replication:
1. In the navigation tree, select ESS/DS Paths. The ESS/DS Paths panel is

displayed.
2. Click the storage system ID to display logical paths for that storage system.

v From the Storage Systems panel:
1. In the navigation tree, select Storage Systems. The Storage Systems panel is

displayed in the Storage Systems view.
2. Select an ESS, DS6000, or DS8000 storage system for which you want to view

logical paths.
3. Select View Paths from the Select Action list, and click Go. The ESS/DS

Paths panel is displayed with a list of defined logical paths.

Viewing console messages
This topic describes how to view the console and messages.

IBM Tivoli Storage Productivity Center for Replication provides detailed
information about actions taken by users, errors that occur during normal
operation, and hardware error indications.

From the graphical user interface, you can view console messages by selecting
Console in the navigation tree. You can then click the link for the specific message
code to get more information on the message.

You can also get detailed information and help for specific messages in the IBM
Tivoli Storage Productivity Center information center at http://
publib.boulder.ibm.com/infocenter/tivihelp/v59r1/index.jsp .

Security
The IBM Tivoli Storage Productivity Center for Replication authentication process
uses a configured user registry from either the operating system or Lightweight
Directory Access Protocol (LDAP) server. To perform a specific action and manage
specific sessions in the IBM Tivoli Storage Productivity Center for Replication GUI
or CLI, the user must also have the appropriate authorization. Authorization is
granted by assigning a specific role to the user account or user group.
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Users and groups
For authentication and authorization, IBM Tivoli Storage Productivity Center for
Replication uses users and groups that are defined in a configured user registry on
the management server, which is associated with either the local operating system
or a Lightweight Directory Access Protocol (LDAP) server.

IBM Tivoli Storage Productivity Center for Replication does not provide the
capability to create, update, or delete users or groups in the user registry. To
manage users or groups, you must use the appropriate tool associated with the
user registry in which the users and groups are stored.

IBM Tivoli Storage Productivity Center for Replication uses roles to authorize users
to manage certain sessions and perform certain actions.

For more information about authentication, see the information about single
sign-on in the IBM Tivoli Storage Productivity Center documentation.

Primary administrative ID

If you switch the authentication method, either from the local operating system to
an LDAP server or vice versa, IBM Tivoli Storage Productivity Center for
Replication removes all access to existing users and user groups. This occurs
because the user IDs might not be on the same local operating system and the
LDAP server; however, you must have at least one user ID that can log in to IBM
Tivoli Storage Productivity Center for Replication.

When you change the authentication method using Tivoli Integrated Portal, you
can specify a primary administrative ID for both local operating system and LDAP
authentication. Use this primary administrator to log in to IBM Tivoli Storage
Productivity Center for Replication and manually add user IDs requiring access to
IBM Tivoli Storage Productivity Center for Replication.

You can log in to both IBM Tivoli Storage Productivity Center for Replication and
IBM Tivoli Storage Productivity Center using the primary administrative ID and
password.

You cannot use the following characters for the IBM Tivoli Storage Productivity
Center for Replication administrative password:
v square brackets ([ and ])
v semicolon (;)
v backward slash (\)

User roles
A user role is a set of privileges that is assigned to a user or user group to allow the
user or user group to perform certain tasks and manage certain sessions.

To be assigned to a role, each user or group of users must have a valid user ID or
group ID in the user registry on the management server.

Both individual users and a group of users can be assigned to a role. All users in a
group are assigned the role of the group. If a user is assigned to one role as an
individual and a different role as a member of a group, the user has access to the
permissions of the role that has greater access.
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Restricting access to sessions prevents unwarranted administrative access. This is
especially useful in an open environment, where there can be many storage
administrators who are responsible for their servers, applications, databases, file
systems, and so on.

IBM Tivoli Storage Productivity Center for Replication provides a set of predefine
user roles: monitor, session operator, and administrator.

Monitor

Monitors can view the health and status in the IBM Tivoli Storage Productivity
Center for Replication GUI and CLI; however, they cannot modify or perform any
commands or actions.

Monitors can view the following information:
v All storage systems and storage system details
v All connections and connection details
v All sessions and session details
v All path information
v Management server status and details

Operator

Session operators can manage sessions to which they have been assigned,
including:
v Adding or removing a session. The user ID that created the session is

automatically granted access to manage that session.
v Performing actions on an assigned session, such as start, flash, terminate, and

suspend.
v Modifying session properties.
v Adding copy sets to a session. The session operator can add volumes to a copy

set only when the volume is not protected and not in another session.
v Removing copy sets from a session.
v Adding Peer To Peer Remote Copy (PPRC) paths, and removing paths with no

hardware relationships. PPRC paths are a common resource used in IBM Tivoli
Storage Productivity Center for Replication sessions and also in an ESS, DS6000,
or DS8000 storage-system relationship that is established between two common
logical subsystems (LSSs).

Note: The session operator cannot issue a force removal of a path.

Note: A path can also be auto-generated when starting a session.
v Monitoring health and status, including viewing the following information:

– All storage systems and storage system details
– All connections and connection details
– All sessions and session details
– All path information
– Management server status and details

Note: Session operators can make changes only to the volumes that they own.
They are not able to make changes to volumes being managed by other users.

Chapter 7. Managing replication 789



Administrator

During installation of IBM Tivoli Storage Productivity Center for Replication, the
installation wizard requests an ID to use for the initial administrator user ID.

Administrators have unrestricted access. They can manage all sessions and perform
all actions associated with IBM Tivoli Storage Productivity Center for Replication,
including:
v Granting permissions to users and groups of users.
v Adding or removing a session. The user ID that created the session is

automatically granted access manage that session.
v Performing actions on all sessions, such as start, flash, terminate, and suspend.
v Modifying session properties.
v Adding and removing copy sets from a session. The administrator can add

volumes to a copy set only when the volume is not protected and not in another
session.

v Protecting volumes and removing volume protection.
v Adding or removing storage system connections.
v Modifying connection properties.
v Assigning or changing storage system locations.
v Adding PPRC paths and removing paths with no hardware relationships. PPRC

paths are a common resource used in IBM Tivoli Storage Productivity Center for
Replication sessions and also in an ESS, DS6000, or DS8000 storage-system
relationship that is established between two common logical subsystems (LSSs).

Note: A path can also be auto-generated when starting a session.
v Managing management servers. The standby management server is a common

resource that is available to multiple sessions.
v Packaging program error (PE) log files.
v Monitoring health and status, including viewing the following information:

– All storage systems and storage system details
– All connections and connection details
– All sessions and session details
– All path information
– Management server status and details

Important: IBM Tivoli Storage Productivity Center supports multiple user roles,
including the Superuser role. A superuser can perform all IBM Tivoli Storage
Productivity Center functions. For IBM Tivoli Storage Productivity Center
superusers to have full access to IBM Tivoli Storage Productivity Center for
Replication, the Superuser group must be added to the IBM Tivoli Storage
Productivity Center for Replication and assigned to the Administrator role. Then,
you can manage the IBM Tivoli Storage Productivity Center and IBM Tivoli
Storage Productivity Center for Replication products by groups, instead of by user
IDs.

Note: Administrators cannot revoke their own administrative access rights.
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Adding the IBM Tivoli Storage Productivity Center for
Replication Administrator role to the IBM Tivoli Storage
Productivity Center Superuser group

If you use local operating system or Lightweight Directory Access Protocol (LDAP)
authentication, you must add the IBM Tivoli Storage Productivity Center superuser
group to IBM Tivoli Storage Productivity Center for Replication with administrator
privileges.

Prerequisite: You must have Administrator privileges to perform this action.

Perform these steps to add the superuser group to IBM Tivoli Storage Productivity
Center for Replication:
1. Log in to IBM Tivoli Storage Productivity Center as the superuser.
2. In the navigation tree, expand Administrative Services > Configuration and

select Role-to-Group Mappings.
3. Locate the name of the superuser user group.
4. Log in to IBM Tivoli Storage Productivity Center for Replication using a user

ID with administrator privileges.
5. In the navigation tree, select Administration. The Administration panel is

displayed.
6. Click Add Access. The Add Access wizard is displayed.
7. Type the name of the superuser group in the User or group names field, and

click Next.
8. Select the name of the superuser group, and click Next.
9. Select Administrator privileges, and click Next.

10. Click Next to confirm this action.
11. Click Finish.

Granting access privileges for a user
You can assign user roles to an IBM Tivoli Storage Productivity Center for
Replication user to grant access privileges to individual sessions and tasks.

Perform the following steps to authorize a user:
1. Create the user ID or group ID if it does not already exist in the user registry,

either the operating system of the active management server or Lightweight
Directory Access Protocol (LDAP) server.

2. Log in to IBM Tivoli Storage Productivity Center for Replication as a user
with administrator privileges.

3. In the navigation tree, select Administration. The Administration panel is
displayed.

4. Click Add Access. The Add Access wizard is displayed.
5. Type the name of the user to whom you want to give access, and click Next.

The Select Users and Groups panel is displayed.

Tip: You can enter a partial name and use the * wildcard character to
represent zero or more characters.

6. Select one or more names from the list of found users.
7. Select the role to associate with this user.
8. If you selected the Operator role, select one or more session that this user can

manage, and click Next.
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9. Click Next to confirm this action.
10. Click Finish.

Viewing access privileges for a user
You can view a list of all IBM Tivoli Storage Productivity Center for Replication
user and their assigned roles. You can also view the assigned sessions for each
user.

Perform the following steps to view access privileges for a user:
1. Log in to IBM Tivoli Storage Productivity Center for Replication as a user with

administrator privileges.
2. In the navigation tree, select Administration. The Administration page is

displayed with a list of IBM Tivoli Storage Productivity Center for Replication
users and user groups and their associated role.

3. Select the user whose access privileges you want to view.
4. Select View/Modify Access from the Actions drop-down list, and click Go. The

View/Modify Access panel is displayed. This panel shows the role assigned to
the user and lists the sessions that the user can manage.

5. Click Cancel.

Modifying access privileges for a user
You can change the user role and assigned sessions for an IBM Tivoli Storage
Productivity Center for Replication user.

Prerequisite: You must have Administrator privileges to perform this action.

Perform the following steps to modify the access privileges for a user:
1. Log in to IBM Tivoli Storage Productivity Center for Replication as a user with

administrator privileges.
2. In the navigation tree, select Administration. The Administration panel is

displayed with a list of users and user groups and their associated role
3. Select the user whose access privileges you want to view.
4. Select View/Modify Access from the Select Action drop-down list, and click

Go. The View/Modify Access panel is displayed. This panel shows the role
assigned to the user and lists the sessions that the user can manage.

5. Select the role to associate with this user.
6. If you selected the Operator role, select one or more session that this user can

manage and click Next.
7. Click OK.

Removing access privileges for a user
You can remove access privileges for an IBM Tivoli Storage Productivity Center for
Replication user. When you remove access, the user ID cannot access the IBM
Tivoli Storage Productivity Center for Replication GUI or run commands from the
command line.

Prerequisite: You must have Administrator privileges to perform this action.

Perform the following steps to remove user access:
1. Log in to IBM Tivoli Storage Productivity Center for Replication as a user with

administrator privileges.
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2. In the navigation tree, select Administration. The Administration panel is
displayed with a list of users and user groups and their associated role.

3. Select the user from which you want to remove access.
4. Select Remove Access from the Actions list, and click Go.
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Chapter 8. Reporting in the stand-alone GUI

Use Tivoli Storage Productivity Center reports to view detailed information about
the storage resources in your environment. These reports are organized into
different types and categories and provide both summary and detailed information
depending on your needs.

Data in reports is based on statistical information accumulated by data collection
schedules and stored in the database repository. You can select the specific systems,
storage subsystems, switches, fabrics, NAS filers, clusters, disks, file systems, and
even users upon which you want to report.

Reports are organized into report types and categories that you can expand to
reveal additional subcategories of reporting. Many reports are also accessible
through the topology viewer.
v Reporting types: system reports, batch reports, user ID reports, user-defined

online reports
v Report categories: asset, availability, capacity, usage, usage violation, backup,

storage subsystem performance, switch performance

Consider the following steps when determining how to best use Tivoli Storage
Productivity Center reports:
1. Determine how you want to generate and view reports. See “Choosing a

reporting type” for more information.
2. Identify which reports contain the most important information about your

storage environment. See “Choosing a report category” on page 797 for more
information.

Choosing a reporting type
Use pre-defined (system reports), saved reports, batch reports, rollup reports, and
user-defined reports, tables, and charts to view the information collected by
monitoring and quota jobs. Tivoli Storage Productivity Center includes these
different reporting types to provide you with the flexibility to view data about
your storage resources according to the needs of your environment.

The following table describes the reporting types available in Tivoli Storage
Productivity Center. Use this table to help determine how to best deliver and view
reports about your storage resources.
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Reporting type Description Location in the navigation tree

User-defined online
reports

These reports can be generated at any time during a
product session and are only available for that
session. Each manager within Tivoli Storage
Productivity Center has a set of reports specific to
that manager. For example, to view detailed reports
about storage subsystems, access the reporting
function within Disk Manager.

See the following topics for more information about
online reports:

v “Working with user-defined online reports” on
page 820

v “Data Manager reports” on page 831

v “Using Data Manager for Databases reports” on
page 962

v “Disk Manager reports” on page 990

v “Fabric Manager reports” on page 1003

Data Manager > Reporting

Data Manager for Databases >
Reporting

Disk Manager > Reporting

Fabric Manager > Reporting

System reports System reports are automatically generated by
Tivoli Storage Productivity Center and contain some
of the most common information about your
monitored storage resources. These pre-defined
reports enable you to view your storage enterprise
data quickly and efficiently with one click. Data for
these system reports are gathered every time that
monitoring jobs are run against your storage
resources.

See the following topics for more information about
online reports:

v “System reports - Data” on page 1011

v “System reports - Data Manager for Databases”
on page 1025

v “System Reports - Disk Manager” on page 1037

v “System reports - Fabric Manager” on page 1054

IBM Tivoli Storage Productivity
Center > Reporting > System
Reports

User ID (saved) reports Create saved reports when you want specific
reports generated for you whenever you log in to a
product session. This enables you to save reports
that you can generate at any time without having to
define your report criteria again. Saved reports are
only visible to the user ID that created them.

See “User ID (saved) reports” on page 1075 for
more information.

IBM Tivoli Storage Productivity
Center > Reporting > My Reports >
user ID Reports

where user ID represents the IBM
Tivoli Storage Productivity Center
ID of the user that saved the report
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Reporting type Description Location in the navigation tree

Batch reports A batch report represents any Tivoli Storage
Productivity Center report that you want to run on
a regular basis and save its data to a file. You can
view the information in a generated batch report file
directly or import it into an application of your
choice.

To create a batch report, you must determine which
Tivoli Storage Productivity Center report you want
to generate, the schedule on which to generate the
report, and the file to which to save its data.

You can save the data generated for a batch report
to any of the following file formats: CSV, HTML,
formatted text, PDF chart, and HTML chart.

See “Batch reports” on page 1061 for more
information.

IBM Tivoli Storage Productivity
Center > Reporting > My Reports >
Batch Reports

Rollup Reports Use rollup reports to view the storage information
collected by the master Tivoli Storage Productivity
Center server from its associated subordinate
servers. Rollup reports enable you to have a
network-wide perspective of storage usage in an
environment where multiple Tivoli Storage
Productivity Center servers are deployed and
collecting storage metrics.

See the following topics for more information about
online reports:

v “Rollup reports” on page 1075

v “Tivoli Storage Productivity Center servers” on
page 280

v “Collecting storage statistics from Tivoli Storage
Productivity Center servers” on page 342

IBM Tivoli Storage Productivity
Center > Reporting > Rollup
Reports

Data Source reports Use these reports to view detailed information
about the agents from which Tivoli Storage
Productivity Center collects information about
storage resources. Data sources include CIMOM
agents, Storage Resource agents, Data agents, Fabric
agents, VMWare, and subordinate Tivoli Storage
Productivity Center servers.

See Data Source reports for more information.

IBM Tivoli Storage Productivity
Center > Reporting > Data Source
Reports

Choosing a report category
IBM Tivoli Storage Productivity Center provides a number of categories for reports
that help you identify which reports contain the information you want to view
about your storage environment. Each category of report contains information
gathered by different data collection and quota jobs.

The following table describes the reporting categories. Use this table to help
determine which reports are most useful to you and which data collection jobs to
run for those reports.
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Report Category Description

What data collection job
should I run for this
report?

Asset reports View itemized statistics about your
storage resources in a hierarchical view
that enables you to drill down to view
those resources in greater detail.

Location: These reports are available in
the following locations on the navigation
tree:

v Data Manager > Reporting > Asset

v Data Manager for Databases >
Reporting > Asset

v IBM Tivoli Storage Productivity Center
> Reporting > My Reports (if you save
the definition of an online report it
appears in this location)

v Data Manager for Databases > My
Reports

Example: View information about a
storage subsystem and drill down into its
related storage pools, disks, volumes, and
disk groups.

See “Asset reports” on page 834 for more
information about Asset reports.

Probes, Discovery

Data for System-wide Users
and Monitored Directory
reports are gathered by
Scans.

Availability reports View availability statistics about your
storage resources, both from a network
point of view and from a computer
uptime perspective.

Location: These reports are available in
the following locations on the navigation
tree:

v Data Manager > Reporting >
Availability

v IBM Tivoli Storage Productivity Center
> Reporting > My Reports (if you save
the definition of an online report it
appears in this location)

Example: Use a Computer Uptime report
to determine the percentage of time that a
computer was up, the number of times it
was rebooted, and the total time it was
down within a user-defined period of
time.

See “Availability Reports” on page 858 for
more information about Availability
reports.

Ping data: Pings

Computer Uptime: Probes
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Report Category Description

What data collection job
should I run for this
report?

TPC-wide Storage Space Examine storage capacities of storage
resources at a file system, computer, or
network level.

Location: These reports are available in
the following locations on the navigation
tree:

v Data Manager > Reporting > TPC-wide
Storage Space

v Data Manager for Databases>
Reporting > Capacity

v IBM Tivoli Storage Productivity Center
> Reporting > My Reports (if you save
the definition of an online report it
appears in this location)

v Data Manager for Databases > My
Reports

Example: Identify how much storage
space is being used on the file systems
within your environment, and how much
unused storage space is available.

See “TPC-wide Storage Space Reports” on
page 860 for more information about
Capacity reports.

Probes

Usage reports View information about the usage and
growth of consumption of your storage
resources, as well as select files against
which to run an Tivoli Storage
Productivity Center archive/backup job.

Location: These reports are available in
the following locations on the navigation
tree:

v Data Manager > Reporting > Usage

v Data Manager for Databases >
Reporting > Usage

v IBM Tivoli Storage Productivity Center
> Reporting > My Reports (if you save
the definition of an online report it
appears in this location)

v Data Manager for Databases > My
Reports (if you save the definition of an
online report it appears in this location)

Example: Determine how much of the
storage being used in your environment
can be considered wasted space
(orphaned, obsolete, or forbidden files).

See “Usage Reports” on page 920 for
more information about Usage reports.

Scans
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Report Category Description

What data collection job
should I run for this
report?

Usage Violation reports View quota and constraint violations as
well as select files for archive/backup
jobs.

Location: These reports are available in
the following locations on the navigation
tree:

v Data Manager > Reporting > Usage
Violations

v Data Manager for Databases >
Reporting > Usage Violations

v IBM Tivoli Storage Productivity Center
> Reporting > My Reports (if you save
the definition of an online report it
appears in this location)

v Data Manager for Databases > My
Reports (if you save the definition of an
online report it appears in this location)

Example: Identify the users or groups of
users that are using storage space on
machines where they should not.

See “Usage Violation reports” on page 927
for more information about Usage
Violation reports.

Scans, Quotas, Constraints

Backup reports Investigate the sizes of data that would be
required to backup to achieve full
backups, determine the amount of space
required to perform an incremental
backup of any or all of your data at any
given point in time, and select files for
archive/backup jobs.

Location: These reports are available in
the following locations on the navigation
tree:

v Data Manager > Reporting > Backup

v IBM Tivoli Storage Productivity Center
> Reporting > My Reports (if you save
the definition of an online report it
appears in this location)

v Data Manager for Databases > My
Reports (if you save the definition of an
online report it appears in this location)

Example: Determine if you have enough
storage space to perform a backup of your
data (incremental or full).

See “Backup reports” on page 929 for
more information about Usage Violation
reports.

Scans
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Report Category Description

What data collection job
should I run for this
report?

Monitored Computer Storage Space Use these host-based reports to view the
data that is collected by probes for
computers, Network Attached Storage,
and hypervisors. These reports contain
detailed information about the
consumption of file system space and
enable you to relate that space back to
external or internal storage without
counting shared space multiple times.

Location: These reports are available in
the following locations on the navigation
tree:

v Data Manager > Reporting > Monitored
Computer Storage Space

v IBM Tivoli Storage Productivity Center
> Reporting > My Reports (if you save
the definition of an online report it
appears in this location)

See “Monitored Computer Storage Space
reports” on page 931 for more information
about Monitored Computer Storage Space
reports.

Probes

Storage subsystem reports View storage capacity for a computer, file
system, storage subsystem, volumes, array
sites, ranks, and disks. These reports also
enable you to view the relationships
among the components of a storage
subsystem.

Location: Disk Manager > Reporting >
Storage Subsystems

Example: Determine if you have enough
storage space to perform a backup of your
data (incremental or full).

See “Disk Manager reports” on page 990
for more information about Storage
Subsystem reports.

Probes

Storage Subsystem Performance reports View performance data for storage
subsystems.

Location: Disk Manager > Reporting >
Storage Subsystem Performance

Example: Check the performance rate for
storage subsystem activities, such as read
I/O rate, read data rate, total port I/O
rate, etc.

See “Disk Manager reports” on page 990
for more information about Storage
Subsystem Performance Monitor reports.

Subsystem Performance
Monitors
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Report Category Description

What data collection job
should I run for this
report?

Switch Performance reports View performance data for fabric
switches.

Location: Fabric Manager > Reporting >
Switch Performance

Example: Check the performance rate for
switch activities, such as port send packet
rate, port send data rate, total port data
rate, etc.

See “Fabric Manager reports” on page
1003 for more information about Switch
Performance Monitor reports.

Switch Performance
Monitors

Rollup reports: Asset, Capacity, Database
Asset, Database Capacity

View the storage information that has
been collected by IBM Tivoli Storage
Productivity Center servers through a
single interface. These rollup reports
enable you to have a consolidated
perspective of storage usage in an
environment where multiple IBM Tivoli
Storage Productivity Center servers are
deployed and collecting storage metrics.

Location: IBM Tivoli Storage Productivity
Center > Reporting > Rollup Reports

Example: Check the disk capacity of all
the computers monitored by different
servers in your environment.

See “Rollup reports” on page 1075 for
more information about rollup reports.

IBM Tivoli Storage
Productivity Center Server
Probes

Data Source reports Use data source reports to view detailed
information about the agents from which
Tivoli Storage Productivity Center collects
information about storage resources. Data
sources include CIMOM agents, Storage
Resource agents, Data agents, Fabric
agents, VMWare, and subordinate Tivoli
Storage Productivity Center servers.

Location: IBM Tivoli Storage Productivity
Center > Reporting > Data Source Reports

Example: View detailed information about
the CIMOM Agents that have been added
to Tivoli Storage Productivity Center as
data sources.

See “Data source reports - overview” on
page 1133 for more information about
data source reports.

These reports are available
for data sources that have
been associated with Tivoli
Storage Productivity Center.
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What can I find out using reports?
Learn about some of the key storage questions that you can answer by generating
Tivoli Storage Productivity Center reports.

Use the following table to view a list of reports that can be generated to answer
key questions about storage resources that are monitored by Tivoli Storage
Productivity Center.

What do you want to know? Which report answers this question?
Which schedule can I run
to generate this report?

What hardware is currently being used
within the enterprise?

Data Manager > Reporting > Asset > By
<storage_resource_type>

Probes

How much storage space is being used? Data Manager > Reporting > TPC-wide
Storage Space > Consumed File System
Space

Probes

Of the space that is being used, how
much is wasted space? (orphaned,
obsolete, or duplicate files)

Data Manager > Reporting > Usage >
Files

Data Manager > Reporting > Usage
Violations > Constraint Violations

Scans

How much unused or unallocated storage
space is available?

Data Manager > Reporting > TPC-wide
Storage Space > Available File System
Space

Probes

Is there enough space to do a backup of
our data? (incremental or full)

Data Manager > Reporting > Backup >
Backup Storage Requirements

Scans

Which files in the environment are at risk
if a disaster hits?

Data Manager > Reporting > Backup >
Most at Risk Files

Scans

What "forbidden files" are taking up
storage space on the network?

Data Manager > Reporting > Usage
Violations > Constraint Violations

Scans

Which user or group of users is
consuming space on computers that they
should not?

Data Manager > Reporting > Usage
Violations > Quota Violations

Scans

How fast are storage resources being
consumed?

Data Manager > Reporting > TPC-wide
Storage Space > Consumed File System
Space

Probes

Which user or business unit is consuming
the most storage resources?

Data Manager > Reporting > Usage >
Users

Data Manager > Reporting > Usage > OS
User Groups

Scans

Where is disk space reaching a critical
shortage?

Data Manager > Reporting > TPC-wide
Storage Space > Disk Space

Probes

Which devices have been experiencing
the most use/traffic? Which devices have
been experiencing the least use/traffic?

Data Manager > Reporting > Usage >
Access Load

Scans

Based on historical consumption, how
much storage space should be added and
when should it be added?

Data Manager > Reporting > TPC-wide
Storage Space > Available File System
Space

Probes

What files have not been used within a
certain time period?

Data Manager > Reporting > Usage >
Files > Most Obsolete Files

Scans

What are the largest files or directories
within the environment?

Data Manager > Reporting > Usage >
Files > Largest Files

Scans
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What do you want to know? Which report answers this question?
Which schedule can I run
to generate this report?

What are the most modified files within
the environment?

Data Manager > Reporting > Usage >
Access Load > Modification Time

Scans

Which computers are “up” or “down”
within the environment?

Data Manager > Reporting > Availability
> Ping

Pings

What hardware is most prone to error?
(for example, disk defects)

Data Manager > Reporting > Asset >
System-wide > Disks

Probes

Which file owners no longer exist in the
environment?

Data Manager > Reporting > Usage >
Files > Orphan files

Scans

How much storage space is an instance
consuming?

v Oracle: Data Manager for Databases >
Reporting > Capacity > Oracle > Total
Instance Storage

v SQL/Server: Data Manager for
Databases > Reporting > Capacity >
SQL/Server > Total Instance Storage

v Sybase: Data Manager for Databases >
Reporting > Capacity > Sybase > Total
Instance Storage

v UDB: Data Manager for Databases >
Reporting > Capacity > UDB > Total
Instance Storage

Probes

804 IBM Tivoli Storage Productivity Center: User's Guide



What do you want to know? Which report answers this question?
Which schedule can I run
to generate this report?

Which user or business unit is consuming
the most storage resources and on which
instances are they consuming those
resources?

Oracle:

v Data Manager for Databases >
Reporting > Usage > Oracle >
Users > Group by User Name,
or

v Data Manager for Databases >
My Reports > System Reports
> Oracle - User Database
Space Usage

SQL/Server:

v Data Manager for Databases >
Reporting > Usage >
SQL/Server > Users > Group
by User Name, or

v Data Manager for Databases >
My Reports > System Reports
> SqlServer - User Database
Space Usage

Sybase:

v Data Manager for Databases >
Reporting > Usage > Sybase >
Users > Group by User Name,
or

v Data Manager for Databases >
My Reports > System Reports
> Sybase - User Database
Space Usage

UDB:

v Data Manager for Databases >
Reporting > Usage > UDB >
Users > Group By User Name,
or

v Data Manager for Databases >
My Reports > System Reports
> UDB - User Database Space
Usage

Scans

Which tablespaces are reaching a critical
shortage of free space?

v Oracle: Data Manager for Databases >
Reporting > Capacity > Oracle > Data
File Free Space > By Tablespace

v UDB: Data Manager for Databases >
Reporting > Capacity > UDB >
Container Free Space > By Tablespace

Probes

Which tablespaces contain the most free
space?

v Oracle: Data Manager for Databases >
Reporting > Capacity > Oracle > Data
File Used Space > By Tablespace

v UDB: Data Manager for Databases >
Reporting > Capacity > UDB >
Container Used Space > By Tablespace

Probes
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What do you want to know? Which report answers this question?
Which schedule can I run
to generate this report?

Which databases are reaching a critical
shortage of free space?

v SQL/Server: Data Manager for
Databases > Reporting > Capacity >
SQL/Server > Data File Free Space >
By Database

v Sybase: Data Manager for Databases >
Reporting > Capacity > Sybase >
Fragment Free Space > By Database

Probes

Which databases contain the most used
space?

v SQL/Server: Data Manager for
Databases > Reporting > Capacity >
SQL/Server > Data File Used Space >
By Database

v Sybase: Data Manager for Databases >
Reporting > Capacity > Sybase >
Fragment Used Space > By Database

Probes

Based on historical consumption of
storage space for an RDBMS, how much
storage space should be added and when
should it be added?

v Oracle: Data Manager for Databases >
Reporting > Capacity > Oracle > Data
File Free Space > By Database >
History Chart:Free Space % for selected

v SQL/Server: Data Manager for
Databases > Reporting > Capacity >
SQL/Server > Data File Free Space >
By Instance > History Chart:Free Space
% for selected

v Sybase: Data Manager for Databases >
Reporting > Capacity > Sybase >
Device Free Space > By Device >
History Chart:Free Space % for selected

v UDB: Data Manager for Databases >
Reporting > Capacity > UDB >
Container Free Space > By Instance >
History Chart:Free Space % for selected

Probes

What are the largest tables within the
environment?

v Oracle: Data Manager for Databases >
Reporting > Usage > Oracle > Tables >
Largest Tables

v SQL/Server: Data Manager for
Databases > Reporting > Usage >
SQL/Server > Tables > Largest Tables

v Sybase: Data Manager for Databases >
Reporting > Usage > Sybase > Tables >
Largest Tables

v UDB: Data Manager for Databases >
Reporting > Usage > UDB > Tables >
Largest Tables

Scans

Which segments in an instance contain
the most extents?

v Oracle: Data Manager for Databases >
Reporting > Usage > Oracle > Segments
> Most Extents

Scans

How much allocated space for an object is
being wasted?

v Oracle: Data Manager for Databases >
My Reports > System Reports > Oracle
- Segments with Wasted Space

Scans
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What do you want to know? Which report answers this question?
Which schedule can I run
to generate this report?

How many free extents does a tablespace
have?

v Oracle: Data Manager for Databases >
Reporting > Asset > By DBMS Type >
Oracle > instance_name > By
Tablespace

Probes

How many tables, indexes, and
datafiles/containers are associated with a
tablespace?

v Oracle: Data Manager for Databases >
Reporting > Asset > System-wide >
Oracle > Tablespaces

v UDB: Data Manager for Databases >
Reporting > Asset > System-wide >
UDB > Tablespaces

Scans

How many tables, indexes, and
datafiles/fragments are associated with a
database?

v SQL/Server: Data Manager for
Databases > Reporting > Asset >
System-wide > SQL/Server > Databases

v Sybase: Data Manager for Databases >
Reporting > Asset > System-wide >
Sybase > Databases

Scans

How can I determine which users have
violated a quota on a specific instance?

v All DBMSs: Data Manager for
Databases> Reporting > Usage
Violations > Quota Violations >
Instance Quotas > By Instance

Scans

What are the sizes and locations of
Control Files and log files for an instance
within the environment?

v Oracle: Data Manager for Databases >
Reporting > Asset > By DBMS Type >
Oracle > instance_name

v SQL/Server: Data Manager for
Databases > Reporting > Asset > By
DBMS Type > SQL/Server >
instance_name > Databases

Probes

How can I determine how close a user is
to exceeding a quota?

v All DBMSs: Data Manager for
Databases > Usage Violations > Quota
Violations > All Quotas > By User

Scans

Report considerations and limitations
Keep in mind these considerations and limitations when viewing reports in Tivoli
Storage Productivity Center.

Data collection for reports
Some columns within reports might not be populated with data for the
storage resources that you are monitoring. Columns are empty if you did
not configure Tivoli Storage Productivity Center to discover or collect the
information intended for that column. Use discovery, probe, ping, or scan
schedules to ensure that you collect information for all the columns that
appear in reports.

When you specify a start time for using performance monitor data in a
report, the start time might not coincide with the start of a performance
monitor data collection interval. If the requested start time is after the start
of a data collection interval and the duration of the data collection interval
is long enough so that it ends at or after the requested start time, Tivoli
Storage Productivity Center includes all data from the collection interval
that began before the requested start time. This data might include data
collected before the start time that you specified. This processing ensures
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that the maximum amount of available performance data is used. For
example, if a performance monitor collects data every 20 minutes starting
at 01:00, but you request performance data that starts at 1:15, Tivoli Storage
Productivity Center still analyzes performance data that starts at 01:00 that
has a duration of 20 minutes.

Report charts that contain long path names
If you generate charts for reports and these charts contain long path names
or many segments, the text on the charts might overlap and make them
difficult to read.

Information about directories
Before information about directories is displayed in reports, you must
complete the following tasks:
1. Include directories that were discovered by Tivoli Storage Productivity

Center in a directory group.
2. Include the directory group in a data collection scan.

After a scan schedule collects data about the directories in a directory
group, information about the directories is displayed in By Directory
reports

Storage totals for Network-wide reports
Tivoli Storage Productivity Center provides a number of network-wide
reports that display storage totals based on the data collected from the
monitored computers and storage subsystems in your network. Click the
magnifying glass icon next to a row in a network-wide report to view the
details about the computers that are included in those storage totals.
However, the reports that you drill down into display information about
computers only. Storage information about storage subsystems is not
included in the values for reports that are shown when you drill down
from a network-wide report.

For example, the Data Manager > Reporting > Capacity > Disk Capacity >
Network-wide report displays disk capacity totals for the computers and
storage subsystems in your network that are monitored by Tivoli Storage
Productivity Center. However, when you click the magnifying glass icon
next to a row in that report, the resulting report displays disk totals for
computers only. This action might cause the totals displayed in the
network-wide report to be larger than the totals reflected in the report that
you drill down in to (if you have disks that are part of both computers and
storage subsystems within your network).

Report values for General Parallel File Systems (GPFS) file systems
For reports that display information collected by scans, Tivoli Storage
Productivity Center does not include statistics for GPFS snapshot
directories and the files in those directories. Because of this issue, the
values in these columns might be smaller than the actual numbers for the
file systems.

For example, when viewing data collected by scans of GPFS file systems in
the Data Manager > TPC-wide Storage Space > File System Space report,
the values for the File Count, Directory Count, and File System Space
columns might be smaller than the actual numbers for the file systems.

IBM XIV Storage System reporting limitation for disk drives
Tivoli Storage Productivity Center does not collect physical serial number
information about the disk drives that are associated with the XIV system
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devices. Therefore, any reports that display information about the XIV
system do not include the physical serial numbers of the disk drives.

Hitachi Data Systems storage subsystems limitations

v There is a limitation within reports when Tivoli Storage Productivity
Center collects information about Hitachi Data Systems (HDS) storage
subsystems that are configured as storage virtualizers. Specifically, any
reports that display a value for the Disk Unallocated Space column do
not count the storage used by volumes that exist on external disks when
the HDS is used as a virtualizer.

v Tivoli Storage Productivity Center does not support Logical Unit Size
Expansion (LUSE) with Hitachi storage subsystems. Because of this
limitation, Tivoli Storage Productivity Center might report a different
number of volumes for a subsystem than is reflected in the HiCommand
Device Manager (HDvM) when LUSE is used.

Time zones for computers monitored by Data agents and Storage Resource
agents The time zones of computers that are monitored by Storage Resource

agents are shown as Greenwich mean time (GMT) offsets in Tivoli Storage
Productivity Center reports. The time zones of computers that are
monitored by Data agents are shown as the local time zone in Tivoli
Storage Productivity Center reports. For example, a computer in Los
Angeles shows the following time zones in the By Computer report in
Asset reporting:
v If monitored by a Storage Resource agent: (GMT-8:00) GMT-8:00
v If monitored by a Data agent: (GMT-8:00) America/Los_Angeles Time

zone

SQL access to data collected by Tivoli Storage Productivity Center for use in
external reports and applications

You can use the data collected by data collection jobs to create custom
reports in external tools. Tivoli Storage Productivity Center provides a set
of DB2® views that represent key data that was stored in the database
repository. Use Structured Query Language (SQL) commands to retrieve
the data in these views. Use this data in external tools such as Business
Intelligence and Reporting Tools (BIRT), Microsoft Excel, and Tivoli
Common Reporting. See Planning to retrieve information from views in the
database repository topic in the IBM Tivoli Storage Productivity Center and IBM
Tivoli Storage Productivity Center for Replication Installation and Configuration
Guide for more information about how to use SQL to retrieve data for use
in custom reports and tools.

Storage Pools in EMC storage subsystems
The data that Tivoli Storage Productivity Center collects about EMC
storage subsystems is based on SMI-S standards. Within SMI-S model,
different types of storage pools are defined and several subsystem
attributes can be modeled as special pool types. Beside the pools that are
available for volume creation, additional storage space from the EMC
storage subsystem might be represented as a pool within the SMI-S model.
Because of this representation, Tivoli Storage Productivity Center reports
and CLI commands might display more pools for EMC storage subsystems
than what is reported through the EMC Navisphere agent.

Computers in a Windows domain
Once computers are discovered in a domain, they remain in the database
until three discoveries do not report them. If you remove the computer
that is doing the discovery in a domain, no further discovery results are
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processed by the server. Therefore, any remaining domain computers that
were previously discovered continue to show their unreachable value in
Unmanaged Computers reports.

UDB reports
For UDB reports, the "User Name" and "Creator" columns represent the
schema (not the operating system user) which is using the storage space.
Each schema is associated with one operating system user. The reports
show usage at the schema level.

Reports display incorrect number of folders for Windows computers
On monitored computers that run Windows, the number of folders that is
reported by Tivoli Storage Productivity Center might be different from the
number of folders that is indicated by Windows Explorer. This situation
occurs when settings on the computer indicate that files, folders, and
drives are hidden. For example, the Data Manager > Reporting > Usage >
files > File Summary > by Computer report might display a number of
folders for a Windows computer that is less than the number of folders
provided by Windows Explorer on that computer.

To ensure that the number of folders reported by Tivoli Storage
Productivity Center more closely matches the number reported by
Windows Explorer, complete the following steps:
1. On each of the Windows computers that you are monitoring, start

Windows Explorer.
2. Navigate to the file system whose settings that you want to change.
3. Select Folder and search options... or Folder options... from the

Organize or View menus.
4. Click the View tab.
5. In the Advanced Settings section, make the following changes:

v Select Show hidden files, folders, and drives.
v Clear Hide protected operating system files.

6. Run probe and scan data collection schedules on the computers.
7. View the reports that display the number of folders for Windows

computers.

Information about space efficient volumes
Keep in mind the following information about space-efficient volumes:
v A volume name or virtual disk in a report that is marked with an

asterisk (*) indicates that the volume or virtual disk is a space-efficient
volume. The * is not part of the actual volume or virtual disk name.

v Tivoli Storage Productivity Center does not include space efficient
volumes when calculating the values for consumed and available space
on DS8000 storage systems. Therefore, the values for these columns in
Tivoli Storage Productivity Center reports might be different from the
space that is available on DS8000 storage systems with space efficient
volumes.

v Tivoli Storage Productivity Center does not display information about
space-efficient volumes for IBM DS8000 storage systems in the following
reports:
– Disk Manager > Reporting > Storage Subsystems > Computer Views

> By Filesystem/Logical Volume
– Disk Manager > Reporting > Storage Subsystems > Storage

Subsystem Views > Disks
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The mapping of volumes to an ESX hypervisor might not display correctly
When assigning and unassigning volumes to an ESX hypervisor, the
mapping of the volumes might not display correctly in Tivoli Storage
Productivity Center reports. For example, if you assign a volume to a
hypervisor, unassign it, and then assign a different volume to the
hypervisor, information about the original volume might still be displayed
in the Correlated Storage Subsystem volume report that is available under
Data Manager > Reporting > Asset > By Hypervisor.

To ensure that Tivoli Storage Productivity Center reports display the
correct volume information, complete the following tasks before generating
the reports:
v After unassigning a storage system volume from a hypervisor, use

VMware vSphere Client to rescan the HBA.
v After assigning a new storage system volume to the hypervisor, use

VMware vSphere Client to rescan the HBA.
v In Tivoli Storage Productivity Center, rerun probes for the computer,

hypervisor, and storage system.

IBM Storwize V7000 Unified/IBM SONAS cluster names in reports
In reports that display file level information for IBM Storwize V7000
Unified/IBM SONAS clusters, the storage system name is included with
the cluster name in the Computer or Device column. The format of the
column is storagesystem_name: cluster_name, where storagesystem_name
is the name of the IBM Storwize V7000 Unified/IBM SONAS device that
the cluster belongs to. For example, subsystem-03.lab.austin.us.com:
kq98n5d.acct displays storage system subsystem-03.lab.austin.us.com that
cluster kq98n5d.acct belongs to.

Pool space for NetApp filers
For NetApp filers that are configured with block data, the values for pool
space that are shown in reports are different from the values shown in a
storage management tool for NetApp filers, such as FilerView. The values
that are different include total pool space (capacity) and available pool
space.

This discrepancy occurs because the pool space information that is
collected by SMI-S agents for Tivoli Storage Productivity Center includes
Write Anywhere File Layout (WAFL) and Snapshot reserve space, whereas
tools like FilerView do not include this additional space.

Working with reports
Learn how to drill down through reports, navigate report tabs, view historical
trends in reports, and view reports as tables of data or as graphical charts. The
ability to customize your view of reports provides you with the flexibility to get a
very detailed look at your information or a very high level overview.

Generating and viewing reports
Learn how to generate and view reports.

Each of the report types available in IBM Tivoli Storage Productivity Center are
generated in different ways to provide you with the flexibility to meet your
environment's changing needs. Click the following links to learn more about how
to generate the different report types and determine what works best for your
organization.
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Report type How to generate

User-defined online reports “Generating reports” on page 820

System reports “Generating and viewing system reports” on page 1010

User ID (saved) reports “Creating a user-defined report” on page 1075

Batch reports “Creating batch reports” on page 1062

Rollup reports “Generating rollup reports” on page 1076

Sorting report columns
Learn how to sort the columns in reports.

Reports appear in a tabular format and are comprised of rows and columns. You
can scroll the report to view the entire report. Use the View menu to hide/show
the navigation tree to increase the viewable area of the report. You can also drag
the divider bar in the middle of the screen back and forth to reallocate the amount
of space that is given each pane.

To sort the columns or change the order of the columns in a report:

v Re-sorting columns. To resort a column, click on the column header. The
column will resort in ascending or descending order.

v Moving columns. To change a column order, press <Alt>, and then click and
drag the column you want to move.

Printing reports or charts
Learn how to print reports to a printer, a PDF, an HTML file, a CSV file, or a
formatted text file.

You can print any IBM Tivoli Storage Productivity Center report or chart displayed
in the content pane.

To print a report or chart, complete the following steps:
1. Generate the report you want.

2. Click File > Print or click on the tool bar. A print window opens.
3. Select the output that you want:

v Select Printer to send the output directly to a printer
v Select PDF file to save the output as a PDF file
v Select HTML file to save the output as an HTML file
v Select CSV file to save the output as a comma delimited file. Select Include

Headers to include column headers in the report output file. Select Include
Totals to include the totals column in the report output file.

v Select Formatted file to save the output as a formatted text file
4. Click Continue.

v If you selected Printer, the Page Setup window opens. Specify any custom
settings for the print job on the Page Setup window and click OK. The report
or chart is printed to your default printer.

v If you selected PDF file, HTML file, CSV file or Formatted file, the Save As
window opens. Select the location where you want to store the file and enter
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a name for the file in the File Name field. Click Save. Depending on the file
type you selected, the report or chart is saved as a PDF or HTML file.

Including charts in reports
Learn how to create charts from the reports that you generate.

There are a large number of charts and chart types that can be generated from

reports. All reports that support charting will have a button at the start of
the report. Any row in a report that supports charting on that row will also have a

.

Many charts can be generated simultaneously from the same report. After
generating a chart, return to the Report tab and choose another chart or another
set of objects to generate a chart upon. Another Chart tab will be generated in
addition to the existing tabs and you will be positioned to the new chart tab.

See “Generating charts” for information on how to generate charts from reports.

You can also customize the appearance of charts to determine how you want to
present data. For example, you can create pie chart, bar chart, stacked bar chart,
determine how many charts appear per page, specify time increments, and so on.
See “Customizing charts” on page 814 for information on how to customize charts.

Generating charts
Learn how to generate charts.

To view a chart of all of the rows in the table:

1. Click , which is at the start of the report. All reports that support charting
will have this multi-colored pie chart icon at the start of the report.

2. Select the type of chart you would like to generate. The types of charts
available will vary depending on the report. After you select the chart type, a
new tab for that chart will appear in the content pane.

To generate a chart for just the element in that row:

v Click the chart icon for that report row.

To generate a chart for multiple, non-consecutive rows in a report:

1. Select rows in the report by holding down the control key (Ctrl key) on the
keyboard while clicking on the desired rows.

2. Click a button for any of the selected rows and select the type of chart
you would like to generate. After you select the chart type, a new tab for that
chart will appear in the content pane.

To generate a chart for a range of rows in a report:

1. Click on the first row in the range and then hold down the Shift and Ctrl while
clicking on the end row in the range.

Chapter 8. Reporting in the stand-alone GUI 813



2. Click a button for any of the selected rows and select the type of chart
you would like to generate. After you select the chart type, a new tab for that
chart will appear in the content pane.

Customizing charts
Learn how to customize the appearance of charts.

While viewing a chart, you can customize its appearance using the Chart
Customization window. This includes:
v Entering the title of a chart
v Determining the maximum number of charts or series that appear per screen
v Specifying how to show values for data points or areas
v Selecting a type for a chart such as a pie, bar, stacked bar, and 100% stacked bar
v Determining the orientation (vertical or horizontal) of a chart
v Specifying history chart settings such as trends and time increment values

To access this window from a chart, right-click on the chart and select Customize
this chart from the pop-up menu. The Chart Customization window appears.

Use this window to customize the chart generated from a report, a report created
in the Reporting facility, a batch report, user reports, and dashboard reports. You
can use the settings on this window to:
v Customize the display of the current chart.

Figure 54. Chart Generation
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v Customize the display of the current chart and save those changes. If you save
the customization settings for a report chart, that chart will use those settings
whenever it is generated.

If a field on this window does not apply to a selected report it will appear as
grayed out and cannot be edited. The following list describes the fields:

Chart title
Enter the name you want to give to the generated chart.

Maximum number of charts or series per screen
Select the maximum number of charts or series per page that should
appear in the generated report from this list. For example, how many pie
charts will appear on one page. When the number of charts that appear on
one page exceeds the number in this field, the additional charts will be
shown on a separate page. The most charts or series you can define to
appear on a page is 30.

Show values for data points or areas
Determine how to display the data points/areas on a chart. You can choose
to display the data points areas:
v Only when hovering - display values for data points on an online chart

when the mouse hovers over an appropriate place on that chart
v Always - always display and print values for data points

Graph charts
Use the fields in this section to customize the appearance of graphs and
charts.

Chart type
Select a type for the generated chart including:
v Pie Chart
v Bar Chart
v Stacked Bar
v 100% Stacked Bar

Chart orientation
Determine whether the chart graphic will appear vertically or horizontally
on a page. You can set the orientation for the following chart types only:
Bar Chart, Stacked Bar, and 100% Stacked Bar.

Maximum number of series per graph
Select the maximum number of series that should appear in one graph or
chart. For example, how many slices will appear in one pie chart. When
the number of series that appear in one graph exceeds the number in this
field, the additional charts will be shown on a separate page. The default
maximum is 12. The most series that can appear in one chart is 30.

Note: Disk Capacity batch reports always display one series per chart, and
one chart per page.

History Charts
Use the fields in this section to customize the appearance of history charts.

Show Trends
Check this box if you want IBM Tivoli Storage Productivity Center to show
a trend for the data in a history chart. The trend attempts to show future
storage usage in a chart based on earlier usage.

Chapter 8. Reporting in the stand-alone GUI 815



Time increment for x-axis
Select which value to use for the time increment that appears on the x-axis
of a history chart. You can select By Scan, Weekly, Monthly. For example, if
you choose Monthly, the x-axis will measure storage usage in monthly
increments.

Restore Defaults
Reset the values in the fields on this window to their original default
settings.

Apply Apply the settings defined in this window to the current chart.

Save Apply the settings defined in this window to the current chart and save
those settings. When the chart is generated in the future, it will
automatically use the saved settings.

Cancel
Exit the window without applying or saving the settings in the window.

Drilling down a report row
Learn how to drill down into report rows to view more detailed information about
your storage resources.

Many of the rows that are presented in the generated reports allow you to drill
down and get more reports of more detailed information. For example, if you are
looking at a report on computers, you might be able to drill down on a row for a
specific computer and generate a report for the file systems contained on that
computer.

When detailed drill down is allowed within a report, there is a icon for that

row. To drill down, simply click on and a new tab with the drill down
report will be generated and added to the tab dialog. You will then be positioned
on that tab viewing the new detail report that you have generated.

Navigating tabs
Learn how to navigate report tabs to view detailed sub reports.

As you generate reports and drill down on rows to generate detailed sub reports,
the number of tabs in the Reporting window will grow. You can move about from
tab to tab simply by clicking on the tab name.
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You can also return to the Selection tab and change your selection criteria to start
all over again with a newly generated report at any time. If you change your
selection criteria and generate a new report, all subsequent or dependent tabs (for
example, drill down and chart tabs) are closed.

To close a tab, right-click on the tab name and select Close from the pop-up menu.

Trending with historical data
Learn how to view trends related to the capacity and usage of your storage
resources.

Use the trending of historical data to view patterns of your data across your entire
network. For example, if you set up a graph that shows the disk capacity of a
computer between January 1 and December 31, you can view "trended" data that
will predict the disk capacity for that computer over the next 6 months. The
trended data appears as a dashed line that is appended to the last probed or
scanned data point.

The length of time for how far in the future that trended data will show is
determined by 50% of the length of time displayed in the graph. For example, if
the data in the non-trended portion of the graph displays data between January 1

Figure 55. Tabs
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and December 31, the predicted trend for that data will be shown for the next 6
months (January 1 to December 31 = 12 months, 50% of 12 months = 6 months
trended). You can change the amount of time trended by changing the length of
time of the graphed data using the Limit days from and To fields.

Before viewing trends in the data collected by IBM Tivoli Storage Productivity
Center, use the history aggregator function to define and run jobs to sum data in
the database repository for historical reporting purposes. For example, after
running the history aggregator, you can view the sum of usage across multiple
resources, by database.

To view a historical data, generate a report, right-click on the row or rows for
which you want to view the data, and select an option from the menu.

Depending on the type of report you generated, you can create the following
history charts for the storage resources that you select:

History chart Description

Free Space for Selected Shows the free space available over a specified period of
time.1

Free Space % for Selected Shows the percentage of free space available over a
specified period of time.1

Used Space for Selected Shows used space over a specified period of time.1

Figure 56. Trending with Historical Data
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History chart Description

Used Space % for Selected Shows percentage of used space over a specified period
of time.1

Capacity for Selected Shows capacity for selected over a specified period of
time.1

Unallocated Space for Selected Shows the unallocated space available for the selected
resources over a specified period of time.1

Unallocated Space for All Shows the unallocated space available for all the storage
resources in the report over a specified period of time.1

File Count Shows the number of files accessed or modified over a
period of:
v 1 day
v 1 day - 1 week
v 1 week - 1 month
v 1 month - 1 year
v > year

File Count % Shows the percentage of files accessed or modified over
a period of:
v 1 day
v 1 day - 1 week
v 1 week - 1 month
v 1 month - 1 year
v > year

Size Shows the size of files accessed or modified over a
period of:
v 1 day
v 1 day - 1 week
v 1 week - 1 month
v 1 month - 1 year
v > year

Size % Shows the percentage of file size accessed or modified
over a period of:
v 1 day
v 1 day - 1 week
v 1 week - 1 month
v 1 month - 1 year
v > year

1 The time options for data points in a chart are By Aggregator, Weekly, and Monthly. You
can select one of these options from the list menu on the History Chart page for the report.
(See Figure 57 on page 820.)

v Select By Aggregator to generate a chart in which its data points correspond to each time
a history aggregator job is run. By default, the history aggregator runs daily at 3:30 a.m.,
so when you generate a history chart with this default setting there is a point in the chart
for every day in the selected time range. If you change the schedule of the history
aggregator, the points in the history chart that you generate change accordingly.

v Select Weekly to generate a chart that includes one data point for each week in the
selected time range.

v Select Monthly to generate a chart that includes one data point for each month in the
selected time range.

Figure 57 on page 820 shows a history chart for used space for a file system:
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Select File → Export data to export history data to a comma delimited file (.csv).
You can include or not include headers in the comma delimited file that you
create. The column headings within the header reflect the type of report from
which you are exporting history data.

Working with user-defined online reports
Use the information in this section to learn how to generate and view online
reports. These reports are available in the Reporting nodes under Data Manager,
Data Manager for Databases, Disk Manager, and Fabric Manager.

Generating reports
Learn how to generate and view online reports in Data Manager, Data Manager for
Databases, Disk Manager, and Fabric Manager.
1. Expand the navigation tree to display the type of report you want to generate.

For example, if you want to generate a disk capacity report, expand Data
Manager > Reporting > Capacity > Disk Capacity.

2. Highlight a By Clause to determine how you want to view a report. For
example, to view capacity information according to computer group, click
Reporting > Capacity > Disk Capacity > By Computer Group. The Selection
page is displayed.

Figure 57. History Chart for File System Used Space
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3. Use the Selection page to select the profile to use when generating a report
and determine what columns appear within a report. See “Selecting resources
to appear on a report” on page 823 for information.

4. Click Selection... to select the objects that you want to report upon from the
Select Resources window.

5. Click Filter... to further filter the objects that appear in a report. Filters enable
you to apply general rules to the report based on the rows in that report. See
“Filtering the resources that appear on a report” on page 825 for more
information on filtering.

6. Use the Available Columns and Included Columns list boxes to determine
what columns are displayed in a generated report.

7. Click Generate Report. A new tab will be added to the tab dialog representing
the report that you generated.

8. Click the new tab to view the report. Reports are tabular in format and
composed of rows and columns. You can scroll the report to view the entire
report. Use the View menu to hide/show the navigation tree to increase the
viewable area of the report or drag the divider bar in the middle of the screen
back and forth to reallocate the amount of space that is given each pane.

Defining options for a report
Learn how to customize a report before generating it.

Depending on the report that you want to generate and the level upon which you
have chosen to report (for example, by computer, by filesystem, network wide, and
so on), you are typically presented with a Selection page. For example, if you
want to generate the Most Obsolete Files report, expand Data Manager >
Reporting > Usage > Files > Most Obsolete Files > By Computer. Use the
Selection page to:
v Select the profile to use when generating a report
v Select the resources (for example, computers, computer groups, storage

subsystems, and so on) to display in a generated report
v Apply filters to the columns within a report (for example, show only the systems

that contain over 80% used space) to determine what resources appear within
the rows of a report

v Determine what columns appear within a report

The following table describes the interface elements that might appear on the
Selection page (depending on the report that you want to generate):

Interface element Description

Profile

(Data Manager only)

This field indicates the profile to use when generating the report. If you
just want to use the supplied default profile, then leave the field as is
and generate the report. However, if you want to use a customized
profile that you have set up for this reporting, choose that profile from
the list.

Keep in mind that profiles control what statistics are gathered and also
what files are included in that statistical analysis.
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Interface element Description

Return maximum of __ rows per
storage_resource

This field controls how many rows appear in a generated report. The
value that appears as the storage_resource in this field depends on the
selected By clause. For example, if you select Data Manager > Reporting
> Usage > Files > Most Obsolete Files > By Computer, you can enter
10 in the Return maximum of __ rows per computer field and to limit
the number of rows in the report to only 10 obsolete files per computer.
If you have set up scans to collect many more rows than that per
computer, this is an effective and efficient way to control the size of the
generated report.

This field enables you to control the size of the report that is generated
for different by clauses.

Limit to this time range: The fields in this section determine the date range from which to gather
availability information for the objects that you select.

Relate Computers to:

(Disk Manager - Storage Subsystem
reports only)

This field generates a report that shows the relationship between the
computer and one of these options: storage subsystems, volumes, or
disks.

v Storage Subsystem. Choose this option to view the Storage Subsystems
that the logical volumes within a computer are using.

v volumes. Choose this option to show the volumes within a storage
subsystem that the logical volumes within a computer are using.

v Disks. Choose this option to show the disks within a disk array that
the logical volumes within a computer are using.

Relate Filesystems/Logical Volumes to:

(Disk Manager - Storage Subsystem
reports only)

This field generates a report that shows the relationship between the file
systems/logical volumes and one of these options: storage subsystems,
volumes, or disks.

v Storage Subsystem. Choose this option to view the storage subsystems
on which a file system/logical volume is allocated.

v volumes. Choose this option to view the volumes on which the file
system/logical volume is allocated.

v Disks. Choose this option to show the disks on which a file
system/logical volume is allocated.

Relate Storage Subsystems to:

(Disk Manager - Storage Subsystem
reports only)

This field generates a report that shows the relationship between a
storage subsystem and one of these options: computer or file
system/logical volume.

v Computer. Choose this option to view the computers that are using a
storage subsystem.

v Filesystem/Logical Volume. Choose this option to view the file
systems/logical volumes that are using a storage subsystem.

Relate Volumess to:

(Disk Manager - Storage Subsystem
reports only)

This field generates a report that shows the relationship between a
volume and one of these options: computer or file system/logical
volume.

v Computer. Choose this option to view the computers that are using a
volume.

v Filesystem/Logical Volume. Choose this option to view the file
systems/logical volumes that are using a volume.

Relate Disks to:

(Disk Manager - Storage Subsystem
reports only)

This field generates a report that shows the relationship between a disk
and one of these options: computer and file system/logical volume.

v Computer. Choose this option to view the computers that are using a
disk.

v Filesystem/Logical Volume. Choose this option to view the file
systems/logical volumes that are using a disk.
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Interface element Description

Selection... This button is used to determine the storage resources (computers, file
systems, logical volumes, storage subsystems, and so on) upon which
you want to report. When you click Selection..., the Select Resources
window opens. If you clear the check box for a resource on the Select
Resource window, a push-pin icon displays on the Selection... button.

If you are generating a Network-wide report, the Selection... button will
be disabled because you have chosen to generate the report network
wide, for all objects.

Filter... Use this button to further select or restrict the values within the columns
you want to include on a report. Filters enable you to apply general
rules to the selected columns. When you click Filter..., the Edit Filter
window opens.

For example, select all computers with the name beginning with w2s-*,
or select all file systems with percent used space >= to a specific value.

If a filter is defined for this report, a pushpin icon displays on the
Filter... button.
Note: For storage entities that contain an asterisk (*) within their names,
the * is used as a wildcard character if you select LIKE from the
Operator menu on the Edit Filter panel. See “Filtering the resources that
appear on a report” on page 825 for more information.

Available Columns / Included Columns These panels display the columns that can be included or are already
included in the generated report.

v The Available Columns list displays the columns that you can include
in the generated report that are not already included.

v The Included Columns list displays the columns that will appear in
the generated report. By default, all the columns for a report are listed
in this list box and will be displayed in the generated report. You can
highlight the columns and use the up and down arrows to rearrange
columns in the report. The order of the items in this list determines
the order in which the columns will appear in the generated report.
The columns with grayed-out names are frozen columns. They cannot
be selected, removed, or reordered.

To include a column in a report:

1. In the Available Columns list, click the name of the column. To
select additional columns, press Shift and click the columns that you
want to add or press Ctrl and click the first and last column to select
a range of columns.

2. Click the right-arrow button (>>) to add the columns to the Included
Columns list.

To remove a column in a report:

1. In the Included Columns list, click the name of the column. To select
additional columns, press Shift and click the columns that you want
to add or press Ctrl and click the first and last column to select a
range of columns.

2. Click the left-arrow button (<<) to add the columns to the Available
Columns list.

Selecting resources to appear on a report
Learn how to select the storage resources that will appear in a report.
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Use the Select Resource window to determine the objects (computers, filesystems,
logical volumes, storage subsystems, etc.) upon which you want to report. To select
the resources on which you want to report:
1. Select the type of report you want to generate. For example, Data Manager >

Reporting > Capacity > Disk Capacity > By Disk.
2. Click Selection. The Select Resources window opens.

Figure 58. Selection Resources window

824 IBM Tivoli Storage Productivity Center: User's Guide



The objects that appear in this window are determined by the report you are
generating and the By Clause you selected. For example, if you choose to generate
the report Data Manager > Reporting > Capacity > Disk Capacity > By Disk, the
Select Resource window will display a list of computers and subsystems that you
can include in the report.

When the Select Resource window is initially opened, all objects in the list are
selected.
v If you would like to generate the report for all the objects that have been

selected, click OK.
v To select/deselect individual objects in the selection list, simply select the check

box for the object. When there is a check mark in the check box, then the object
has been selected for inclusion in the report.

You can use Select All and Deselect All to quickly select and deselect all of the
objects in the list.

Note: If you are generating a Network-wide report, the Selection button is
disabled on the Selection tab because you have chosen to generate the report
network wide, for all objects.

Filtering the resources that appear on a report
Learn how to apply conditions to the columns in a report to further filter the
resources that appear in a report.

Use the Edit Filter window to apply conditions to the columns within a report to
further select or restrict objects on which you want to report. Filters enable you to
apply general rules to the report. For example, you can show only the file systems
that contain over 80% used space, or show computers that match "w2s-*", or select
all disks with percent used space >= to a specific value. To filter the objects that
appear in a report:
1. Select the type of report you want to generate. For example, Data Manager >

Reporting > TPC-wide Storage Space > Disk Space > By Disk.
2. Click Filter.... The Edit Filter window opens.

Note: For storage entities that contain an asterisk (*) within their names, the * is
used as a wildcard character if you select LIKE from the Operator menu on this
panel. For example, if you enter *XYZ in the Value 1 field and select LIKE from
the Operator menu, the resulting report includes any entities named "*XYZ", and
also all entities whose names end with the letters "XYZ". To create a filter that
includes only the storage entity named "*XYZ" in the resulting report, enter *XYZ
in the Value 1 field and select IN from the Operator menu.

The following table describes the interface elements that appear on the Edit Filter
window:

Interface element Description

Add This button is used to specify multiple conditions for the
filter. When you click Add, report columns will be
displayed enabling you to define conditions for those
columns.

Delete All This button is used to delete all the conditions displayed
on the table.
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Interface element Description

Case-sensitive string
comparisons

This check box indicates that case-sensitive string
comparisons should be done. Select this check box to
ensure that values appearing in the generated report
match the case of the values entered in the Value 1 and
Value 2 fields.

Records must meet This field specifies how the conditions in the filter are
grouped together.

v All conditions. All of the entered conditions (rows on
the dialog box), must be true in order for the record to
show up as a row in the report.

v At least one condition. At least one of the entered
condition must be true in order for the record to show
up as a row in the report.

Column This field is used to select specific columns on which you
want to define conditions. The list on this field shows
the columns available for the report. As you select a
column from the list, it is displayed on the table, and the
column name is removed from all other lists.

Click

to delete the column.

Operator This field is used to select the condition's operator. Not
all operators apply to all the column data-types.
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Interface element Description

Value 1/ Value 2 This field is used to specify fixed value(s) to be
compared against the record's column value.

Depending on the operator and data type, this field may
be absent or display-only. If the field is display-only, an
Edit... button will be enabled. If both this field and the
Edit... button are enabled, this field allows shorthand
value entry. If you click Edit , a window opens to
provide more assistance in editing the value.

A Value 2 field will be present only for (NOT)
BETWEEN.

For certain columns that contain string text, you can:

v put the string in quotes for the LIKE operator, or

v use the = operator without quotes instead of LIKE (the
default)

For example, if you want to filter the Device Path
(computer) column on the Reporting → Storage
Subsystems → Computer Views → By Filesystem/Logical
Volume report, you can search/filter on a name such as
"Disk 1" or "Disk 2" with the LIKE operator. For the =
operator, you can enter Disk 1 or Disk 2 with no quotes.
Note: An asterisk is prepended to the names of
space-efficient VDisks in the IBM Tivoli Storage
Productivity Center database repository. When you use a
filter to determine which volume names appear in a
report, you must include the "*" as the first character in
the filter value to ensure that those VDisks are included.
For example, if you want to include VDisks whose name
begins with "*vdisk1", you must enter *vdisk1 in the
Value 1 field and select LIKE or IN from the Operator
menu. If you select the LIKE operator, the *vdisk1 VDisk
is included in the report, as well as other VDisks whose
names end in "vdisk1".

Edit This button is used to edit values pertaining to size, date,
and for specific values used for IN, LIKE, etc. operators.
Depending on the condition you are creating, a dialog
box displays to help you to enter values that correspond
to the condition.

Selection... This button is used to determine the objects (computers,
file systems, logical volumes, storage subsystems, etc.)
upon which you want to report. The Select Resources
window opens. If you clear the check box for a resource
on the Select Resource window, a pushpin icon displays
on the Selection... button.

If you are generating a Network-wide report, the
Selection... button will be disabled because you have
chosen to generate the report network wide, for all
objects.

OK This button is used to save the filter. You are returned to
the Selection tab. The Filter button will display a
pushpin to indicate that a filter has been defined for the
report.

Cancel This button is used to return to the Selection tab without
saving the filter.
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Using reporting groups
A reporting group is a user-defined set of storage assets, monitoring groups, and
reporting groups upon which you want to report.

Use reporting groups to view storage information about:
v Resources that appear in different monitoring groups. Because a resource can

appear in only one monitoring group at a time, you can use reporting groups to
include resources from different monitoring groups and view reports on them.

v A subset of resources within a monitoring group. For example, you can create a
reporting group for a specific subset of computers with the Payroll monitoring
group and generate a report containing information about those computers.

v Resources that appear in other reporting groups.
v A subset of resources within other reporting groups.

Note: Unlike monitoring groups, a resource can appear in one or more reporting
groups.

You can create the following types of reporting group:
v Data Manager: Computer, Filesystem. Within a computer reporting group, you

can include computer monitoring groups, specific computers, and other
reporting groups. Within a file system reporting group, you can include file
system monitoring groups, specific file systems, and other reporting groups.

v Data Manager for Databases: Computer, Databases-Tablespaces. Within a
computer reporting group, you can include computer monitoring groups,
specific computers, and other computer reporting groups. Within a
databases-tablespaces reporting group, you can include databases-tablespace
monitoring groups, specific databases or tablespaces, and other
databases-tablespaces reporting groups.

v Disk Manager: Storage Subsystems. Within a storage subsystem reporting
group, you can include storage subsystem monitoring groups, specific storage
subsystems, and other storage subsystem reporting groups.

When you generate a report, storage statistics about a reporting group will appear
in the corresponding "By Group" clause for that report. The following lists the
reports that reflect reporting group information.

Computer reporting groups (Data Manager and Data Manager for Databases )
The following reports display computer reporting group information:
v Data Manager > Reporting > Capacity reports, Data Manager for

Databases > Reporting > Capacity reports
v Data Manager > Reporting > Usage reports, Data Manager for Databases

> Reporting > Usage reports
v Data Manager > Reporting > Usage Violation reports, Data Manager for

Databases > Reporting > Usage Violation reports
v Data Manager> Reporting > Backup reports
v IBM Tivoli Storage Productivity Center > Rollup Reports > Capacity
v IBM Tivoli Storage Productivity Center > My Reports > Batch Reports >

Create Batch Report > Report page, select one of the following:
– Capacity > capacity_report_type > By Computer Group
– Usage > usage_reporting_type > By Computer Group
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– Usage Violations > usage_violation_reporting_type > By Computer
Group

– Backup > backup_reporting_type > By Computer Group
– Rollup Reports > Capacity > capacity_report_type > By Computer

Group
– Rollup Reports > Database Capacity > rdbms_type > By Computer

Group

Filesystem reporting groups (Data Manager)
The following reports display filesystem reporting group information:
v Data Manager > Reporting > Capacity reports
v Data Manager > Reporting > Usage reports
v Data Manager > Reporting > Usage Violation > Constraint Violations

reports
v Data Manager > Reporting > Backup reports
v IBM Tivoli Storage Productivity Center > My Reports > Batch Reports >

Create Batch Report > Report page, select one of the following:
– Capacity > capacity_report_type > By Filesystem Group
– Usage > usage_reporting_type > By Filesystem Group
– Usage Violations > Constraint Violations > By Filesystem Group
– Backup > backup_reporting_type > By Filesystem Group

Databases-Tablespaces reporting groups (Data Manager for Databases)
The following reports display databases reporting group and tablespaces
reporting group information:
v Data Manager for Databases > Reporting > Capacity reports
v Data Manager for Databases > Reporting > Usage reports
v Data Manager for Databases > Reporting > Usage Violations >

Database-Tablespace Quotas reports

Storage subsystem reporting groups
The following reports display storage subsystem reporting group
information:
v Data Manager > Reporting > Storage Subsystems > Storage Subsystem

Views > By Storage System Group
v Data Manager > Reporting > Capacity > Disk Capacity > By Storage

Subsystem Group
v IBM Tivoli Storage Productivity Center > My Reports > Batch Reports >

Create Batch Report > Report page, select one of the following:
– Storage Subsystems > Storage Subsystem Views > By Storage

Subsystem Group
– Capacity > Disk Capacity > By Storage Subsystem Group

Creating a reporting group
To create a reporting group:
1. Expand Reporting > Groups under:

v Data Manager to create computer and filesystem reporting groups.
v Data Manager for Databases to create computer and databases-tablespaces

reporting groups
v Disk Manager to create storage subsystem reporting groups

2. Right click the type of group you want to create. A pop-up menu appears.
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3. Select Create <group type> from the pop-up menu. The content pane displays
a window for defining the group.

4. Define information about the group. See the IBM Tivoli Storage Productivity
Center online Help for detailed information about the windows for creating a
group.

5. Click File > Save to save the group definition. The group is saved to the
database repository. You will now be able to generate and view reports based
on these groups.

Note: You can define filters to select specific computers, filesystems, storage
subsystems, tablespaces, and databases for a reporting group. Tivoli Storage
Productivity Center uses these filters to dynamically include resources to the group
as they are discovered within your environment. When defining dynamic filters for
reporting groups, keep in mind that the filters you enter might or might not be
case sensitive depending on the database under which the Tivoli Storage
Productivity Center database repository is stored. For example:
v The dynamic filters you enter for reporting groups are case sensitive when the

database repository is stored on Oracle, Sybase, and UDB/DB2.
v The dynamic filters you enter for reporting groups are not case sensitive when

the database repository is stored on Microsoft SQL Server.

Keep in mind these case-sensitive issues when defining filters for reporting groups
to prevent inaccurate reporting caused by unintended resources being included in
reports.

Editing a reporting group
To edit an existing reporting group:
1. Expand Reporting > Groups under:

v Data Manager to edit computer and filesystem reporting groups.
v Data Manager for Databases to edit computer and databases-tablespaces

reporting groups
v Disk Manager to edit storage subsystem reporting groups

2. Expand the type of the reporting group you want to edit. For example, expand
Disk Manager > Reporting > Groups > Storage Subsystem to edit a storage
subsystem reporting group.

3. Click the reporting group you want to edit. The content pane displays a
window for editing the group.

4. Edit information about the group. See the IBM Tivoli Storage Productivity
Center online Help for detailed information about the windows for creating a
group.

5. Click File > Save to save the updated group definition.

Note: You can define filters to select specific computers, filesystems, storage
subsystems, tablespaces, and databases for a reporting group. Tivoli Storage
Productivity Center uses these filters to dynamically include resources to the group
as they are discovered within your environment. When defining dynamic filters for
reporting groups, keep in mind that the filters you enter might or might not be
case sensitive depending on the database under which the Tivoli Storage
Productivity Center database repository is stored. For example:
v The dynamic filters you enter for reporting groups are case sensitive when the

database repository is stored on Oracle, Sybase, and UDB/DB2.
v The dynamic filters you enter for reporting groups are not case sensitive when

the database repository is stored on Microsoft SQL Server.
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Keep in mind these case-sensitive issues when defining filters for reporting groups
to prevent inaccurate reporting caused by unintended resources being included in
reports.

Data Manager reports
Use Data Manager reports to view both overview and detailed information about
your storage resources, including computers, disks, filesystems, storage
subsystems, clusters, and users. These reports are constructed from the statistical
information gathered by data collection jobs and accumulated in the database
repository.

Note: You need to run appropriate data collection jobs on the storage resources
before you generate reports. If you do not run the data collection jobs before
generating reports, you might see inconsistent or inaccurate results.

Data Manager - Report categories
Use the report categories within Data Manager to collect information about storage
assets, availability, backup requirements, capacity, usage, usage violations, and
monitored computer storage space.

The following table describes the categories of reports available in Data Manager.

Report Category Use these reports to do the following

What job collects
information for
these reports?

Asset reports View information about the agents, computers, disk
controllers, hard disks, clusters, fabrics, storage
subsystems, volumes, tape libraries, file systems, and
general hardware inventory of storage assets within
your environment.

See “Asset reports” on page 834 for more information
about Asset reports.

Probes, discovery
Data for
System-wide Users
and Monitored
Directory reports are
gathered by scans.

Availability reports View information about the availability of your
storage, both from a network point of view and from
a computer up-time perspective. This allows you to
see what percentage of the time the storage in your
enterprise (or on particular server or group of
servers), is off-network due to network problems or
perhaps is unavailable due to system downtime.

See “Availability Reports” on page 858 for more
information about Availability reports.

Ping data: pings

Computer uptime —
probes

TPC-wide Storage Space reports View storage capacity at a file system, computer, or
entire network level. For a specific computer, group of
computers, or all the computers in your enterprise,
you can view the following:

v How much storage you have

v How much storage is being used

v What percentage of storage is free for expansion

See “TPC-wide Storage Space Reports” on page 860
for more information about Capacity reports.

Probes
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Report Category Use these reports to do the following

What job collects
information for
these reports?

Usage reports View information about the usage and growth of the
consumption of your storage. Use these reports to do
the following:

v View which servers and file systems are
experiencing the heaviest (or lightest) load of data
and storage access.

v Identify wasted space by pinpointing files that are
no longer needed or have not been accessed for the
longest time.

v Associate users with the amount of storage they are
consuming on specific file systems, groups of file
systems, specific computers, groups of computers,
and throughout the entire network.

v Select the files against which to run an IBM Tivoli
Storage Manager archive/backup job. Tivoli Storage
Manager protects your organization's data from
hardware failures and other errors by storing
backup and archive copies of data on offline
storage.

See “Usage Reports” on page 920 for more
information about Usage reports.

Scans

Usage Violation reports View information about the storage usage violations
committed by users and user groups within your
environment. Use these reports to do the following:

v Create and enforce corporate storage usage policies.
You can report on violations of quotas and
constraints.

v Select files in Constraint Violation reports against
which to run an Tivoli Storage Manager archive or
backup job.

v Add files from Constraint Violation reports to an
existing Tivoli Storage Manager archive or backup
job.

See “Usage Violation reports” on page 927 for more
information about Usage Violation reports.

Scans, Quotas,
Constraints

Backup reports Investigate the sizes of data that would be required to
backup to achieve full backups, determine the amount
of space required to perform an incremental backup
of any or all of your data at any given point in time,
and select files for archive/backup jobs.

See “Backup reports” on page 929 for more
information about Usage Violation reports.

Scans
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Report Category Use these reports to do the following

What job collects
information for
these reports?

Monitored Computer Storage Space
reports

Use these host-based reports to view the data that is
collected by probes for computers, Network Attached
Storage, and hypervisors. These reports contain
detailed information about the consumption of file
system space and enable you to relate that space back
to external or internal storage without counting
shared space multiple times.

See “Monitored Computer Storage Space reports” on
page 931 for more information about Monitored
Computer Storage Space reports.

Probes

Using By clauses
Use the By clauses associated with Data Manager reports as a method for viewing
the data in those reports from different perspectives.

As you drill down through Data Manager reports, there is a set of options that
repeats for each report type. Use these By Clauses to generate variations of the
reports with different perspectives and groupings of data.

The available By Clauses are described in the following table:

By Clause Description

By Directory Use this clause to select the directories that you want to include
in a report.

By Directory Group Use this clause to select the directory groups that you want to
include in a report.

By Disk Use this clause to select the disks that you want to include in a
report.

By Filesystem Use this clause to select the file systems that you want to
include in a report.

By Filesystem Group Use this clause to select the file system groups that you want to
include in a report.

By Cluster Use this clause to select the clusters or cluster resource groups
that you want to include in a report. Cluster resource groups in
a PowerHA or MSCS-clustered environment are listed as
computers.

By Computer Use this clause to select the computers that you want to
include in a report.

By Computer Group Use this clause to select the computer groups that you want to
include in a report.

By Storage Subsystem Use this clause to select the storage subsystems that you want
to include in a report.

By Domain Use this clause to select the Window Domains that you want to
include in a report.

Network Wide The reports and charts that you seeare on all data, network
wide. Use this view to generate a global view of the storage
and storage usage for your whole enterprise.
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Asset reports
Use asset reports to view itemized statistics for your storage resources. Tivoli
Storage Productivity Center provides a hierarchical view of your storage resources
so that you can navigate to view your resources in greater detail.

The following section is a description of each of the report types that are under
Data Manager > Reporting > Asset.

Asset Reporting Type Description

By Cluster View storage assets based on PowerHA or MSCS cluster membership. You can
navigate to a cluster and view its nodes and cluster resource groups. For each
cluster resource group, you can navigate to show its controllers, disks, file
systems, logical volumes, and exports or shares. For a cluster node, you can
view local resources.

By Computer Navigate through storage assets in a hierarchical manner. You can navigate to
a computer and show its controllers, disks, file systems, logical volumes, and
directories. You can then navigate further to view more detailed information
such as the disks that are under a specific controller or file systems that are
under a disk.

By Hypervisor Navigate through hypervisors in a hierarchical manner. You can use this
report to navigate to and view details about the virtual machines, controllers,
disks and file systems, or logical volumes.

By IBM Storwize V7000
Unified/IBM SONAS

Navigate through Storwize V7000 Unified or IBM SONAS clusters and
directories in a hierarchical manner. You can use this report to navigate to and
view details about the nodes, pools, Network Shared Disks, file systems,
monitored directories, and exports that are associated with the clusters.

By OS Type View storage assets based upon the operating systems that are running on
those storage servers. This report type provides a way to see what your
operating system dependencies are throughout your organization.

By navigating to any or each of these different supported operating system
types, you can see how many of each server type you have and you can
navigate to investigate the underlying storage.

By Storage Subsystem View storage capacity at a computer, file system, storage system, volume, and
disk level. These reports also show the relationships between the components
of a storage system.

System Wide View storage assets as a whole, across the entire system. Use these reports to
view lists of all of your disks, computers, file systems, Storage Resource
agents and Data agents that are installed in your environment.

By Cluster:
Use the "By Cluster" reports to navigate to a cluster to view its nodes and cluster
resource groups.
v For a node, you can view its local resources, including controllers, disks, file

systems, logical volumes, exports, shares, and directories.
v For a cluster resource group, you can view controllers, disks, file systems, logical

volumes, exports, and shares.
v For a node, the number of processors that are reported are the logical processors.

The amount of RAM that is reported is the available RAM.
1. Expand Asset → By Cluster node to display the nodes for each cluster that has

been discovered and monitored by Data Manager.
2. Click a node to view cluster information, or further expand the cluster node to

navigate to greater detail.
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Cluster Information
Click the name of a cluster that appears under Asset → By Cluster to view
information about that cluster such as:
v Name
v Domain
v IP address
v Discovered Time

Controller Information
As you navigate to Asset Reporting By Cluster for a cluster node or cluster
resource group, you can expand the assets under a controller, or you can
select a controller to view its detailed information.

The name of the controller's computer is shown, as well as the driver
name, instance number, bus number, address, and type of driver (for
example, SCSI, IDE, etc).

Note: Host Bus Adapter (HBA) controllers must be connected to the SAN
and see volumes in order to be displayed under the Controllers node.

Disk Information
As you navigate to Asset Reporting By Cluster for a cluster node or cluster
resource group, you can expand the assets under a disk, or you can select
a disk to view its detailed information.

The disk detail information is shown in a tab dialog that is made of up
three pages: General, Paths, and Latest Probe.

General page
Use the General page to view the computer name, the path name,
SCSI Target ID, logical unit number, and the number of access
paths. The disk information shown includes the hardware
manufacturer of the disk, the model number of the disk, the
firmware revision, the disk serial number, and the manufacture
date along with the time when Data Manager discovered the disk.
The page also includes a breakdown of how the disk is allocated,
including the disk allocation point and the length of the allocation.

Latest Probe page
Use the Latest Probe page to view the information that was
obtained by Data Manager about this disk during the most recent
probe of that disk. This information on this page includes:
v Sector size and sector information
v the number of heads
v the number of cylinders
v the logical block size
v the capacity of the disk
v the RPM or revolutions per minute that the disk spins at
v the elapsed time the disk has been powered on
v spare blocks
v the current write protection setting
v the cache enabled setting
v whether failure is predicted for this disk
v the time and date of the last Probe
v the unallocated space
v the number of primary defects
v the number of grown defects
v the NonMedium errors
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v the recorded operating temperature

Some of these values are manufacturer specific, so if they are
unavailable, then you will see N/A for a value. Additional
information about the breakdown of recovered errors, unrecovered
errors, and the number of bytes broken down by Write, Read, and
Verify is shown in this report. Also included are three SCSI disk bit
settings that you can turn on/off and the change will actually be
made to the disk settings the next time a probe is run on that disk.
These include on/off settings for:
v Automatic read reallocation
v Automatic write reallocation
v Read continuous (no error correction)

Probe History page
Use the Probe History page to view the history of probes that have
been run on the disk you are reporting on. Each row on this report
represents one time that a probe has been run against the disk.
Each row shows what time the probe ran, the type of record
(which could be daily, weekly or monthly), bytes written, bytes
read, number of grown defects.

Filesystem and Logical Volume Information
The Asset Reporting By Cluster Filesystem or Logical Volume information
report contains two pages: Filesystem and Logical Volume.

Filesystem page

Use this page to view a pie chart that depicts used space and free
space on the file system and includes the following information:
v Computer name
v File system type
v Use count
v Mount point
v Physical size of the file system
v Capacity of the file system
v The time and date of the last probe and scan
v When the file system was discovered on the system by Data

Manager
v If the file system has been removed then a removed date/time

will be shown

Logical Volume page
Use this page to view:
v The path name of the logical volume
v The capacity of the logical volume
v The use count
v The type of logical volume
v Whether it is a swap volume and mirrored
v A tree displaying the mapping of the logical volume on the disk

area(s) that make up the logical volume

Exports or Shares Information
The Asset Reporting By Computer Exports or Shares information
report includes the following information:
v the name of the computer the share is on
v the export name that it will be known by
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v the path on the computer the share resides upon
v the protocol being used and the date and time that Data

Manager discovered the export or share

Monitored Directory Information
To view a report on a directory that you are monitoring, expand the
Monitored Directories node on the navigation tree and select the directory
on which you want to report. This information is available for clustered
nodes, but not cluster resource groups.

The Asset Reporting By Cluster Monitored Directory report includes the
following information:
v computer name the directory resides on
v name of the directory
v owner
v OS Group
v total size of the directory
v number of files in the directory
v count of subdirectories in the directory
v average file size
v access time
v modification time and creation time of the directory
v last scan time and the time that Data Manager discovered the directory
v file attributes that are set
v list of the Directory Groups that the directory is a part of

By Computer:
Use the "By Computer" reports to navigate to a computer and view detailed
information about its controllers, disks, file systems, logical volumes, and
directories.

Computer Information
As you navigate to Asset Reporting By Computer, you can expand the
assets under a computer, or you can select a computer to view the details
for that computer. The detailed report shows the following information:
v Computer
v Host ID: the identifier of the host computer in hexadecimal format.

Currently, IBM Tivoli Storage Productivity Center collects Host ID
information for Solaris computers only. All other platforms display
GUID information in the Host ID column.

v Group and Domain
v Network Address, IP address
v Time zone
v Hardware manufacturer and model numbers
v Processor type
v Count and speed
v Amount of RAM
v Operating System (OS) information such as:

– Type of OS and version
– The storage attributes of the server
– The computer disk capacity, unallocated space, and free space

Controller Information
As you navigate to Asset Reporting By Computer, you can expand the
assets under a controller, or you can select a controller to view the details
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for that controller. The name of the computer controller is shown, as well
as the driver name, instance number, bus number, address, and type of
driver (for example, SCSI, IDE, and so on).

Note: Host Bus Adapter (HBA) controllers must be connected to the SAN
and see volumes in order to be displayed under the Controllers subnode.

Disk Information
As you navigate to Asset Reporting By Computer, you can expand the
assets under a disk, or you can select a disk to view the details for that
disk. The disk detail information is shown in a tab dialog that is made of
up four tabs: General, Paths, Latest Probe, and Probe History.

General page
The General page includes the computer name, the path name,
SCSI Target ID, logical unit number, the number of access paths.

The disk information shown includes:
v The hardware manufacturer of the disk
v The model number of the disk
v The disk firmware revision
v The disk serial number
v The disk manufacture date
v Indicators that specify whether the disk is encrypted or

encryptable
v The time when Data Manager discovered the disk

The tab also includes a breakdown of how the disk is allocated,
including the disk allocation point and the length of the allocation.

Paths The Paths page shows the following information:
v Host
v OS type
v Path
v Controller
v Instance
v Bus number
v SCSI target id
v Logical unit number

Latest Probe page
The Latest Probe page shows the information that was obtained by
Data Manager about this disk during the most recent probe of that
disk. This information on this tab includes:
v Sector size and sector information
v The number of heads
v The number of cylinders
v The logical block size
v The capacity of the disk
v The RPM or revolutions per minute that the disk spins at
v The elapsed time the disk has been powered on
v Spare blocks
v The current write protection setting
v The cache enabled setting
v Whether failure is predicted for this disk
v The time and date of the last Probe
v The unallocated space
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v The number of primary defects
v The number of grown defects
v The NonMedium errors
v The recorded operating temperature

Some of these values are manufacturer-specific. If the values are
unavailable, N/A is displayed.

Additional information about the breakdown of recovered errors,
unrecovered errors, and the number of bytes broken down by
Write, Read, and Verify is shown in this report.

Also included are three SCSI disk bit settings that you can turn
on/off and the change will actually be made to the disk settings
the next time a probe is run on that disk. These include on/off
settings for:
v Automatic read reallocation
v Automatic write reallocation
v Read continuous (no error correction)

Probe History page
The Probe History page shows the history of probes that have
been run on the disk you are reporting on. Each row on this report
represents one time that a probe has been run against the disk.
Each row shows what time the probe ran, the type of record
(which could be daily, weekly, or monthly), bytes written, bytes
read, number of grown defects.

Volume Group Information
Data Manager provides support for the following volume managers:
v Veritas Volume Manager (Solaris)
v Logical Volume Manager (AIX)

These volume managers allow you to group logical volumes and disks. As
you navigate to Asset Reporting By Computer for an AIX or Solaris
computer, you can expand the assets under a volume group to see the
group disks and file systems or logical volumes.

You can also select a volume group to view detailed information about it.
The group name is shown, as well as the type (LVM or Veritas), capacity,
free space, number of volumes, number of disks, discovered time, and
probe time.

File System / Logical Volume Information
The Asset Reporting By Computer File System / Logical Volume
information report contains two pages: File System and Logical Volume.

File System page
This page shows a pie chart depicting used space and free space
on the file system and includes the following information:
v Computer name
v File system type
v Use count
v Mount point
v Physical size of the file system
v Capacity of the file system
v The time and date of the last probe and scan
v When the file system was discovered on the system by Data

Manager
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v If the file system has been removed, then a removed date/time
is shown

Also shown for UNIX-based systems are:
v The maximum file count
v Used inodes
v Free inodes. Inodes are areas reserved for index entries within

the UNIX file systems. For Windows computers, these values are
zero.

v The amount of used space and free space is shown

Logical Volume page
The information on this page includes:
v The path name of the logical volume
v The capacity of the logical volume
v The use count
v The type of logical volume
v Whether it is a swap volume and mirrored
v A tree displaying the mapping of the logical volume on the disk

areas that make up the logical volume

Exports/Shares Information
The Asset Reporting By Computer Exports/Shares information report
includes the following information:
v The name of the computer the share is on
v The export name that it will be known by
v The path on the computer the share resides upon
v The protocol being used and the date/time that Data Manager

discovered the export/share

Monitored Directory Information
To view a report on a directory that you are monitoring, expand the
Monitored Directories node on the navigation tree and select the directory
on which you want to report.

Note: This information is not shown for cluster resource groups.
The Asset Reporting By Computer Monitored Directory report includes the
following information:
v Computer name the directory resides on
v Name of the directory
v Owner
v OS Group
v Total size of the directory
v Number of files in the directory
v Count of subdirectories in the directory
v Average file size
v Access time
v Modification time and creation time of the directory
v Last scan time and the time that Data Manager discovered the directory
v File attributes that are set
v List of the Directory Groups that the directory is a part of

The Asset Reporting By Computer Monitored Directory report includes the
following information:
v Computer name the directory resides on
v Name of the directory
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v Owner
v OS Group
v Totalsize of the directory
v Number of files in the directory
v Count of subdirectories in the directory
v Average file size
v Access time
v Modification time and creation time of the directory
v Last scan time and the time that Data Manager discovered the directory
v File attributes that are set
v List of the Directory Groups that the directory is a part of

By OS Type:
Use the "By OS Type Asset" report to view your storage assets based upon the
operating systems under which they are running. This provides you with a an easy
way to see what your OS dependencies are throughout your organization. You can
navigate to any of the storage resources that appear under an operating system
node to access all of the same sub-reports that as described for other asset reports.

By Storage Subsystem:

Browse your storage subsystem assets in a hierarchical manner. Data Manager
provides reports for individual storage subsystems and any disk array subsystems
whose SMI-S Providers are CTP certified by SNIA for SMI-S 1.0.2 or later.

For disk array systems, you can view information about:
v Disk groups
v Array sites
v Ranks
v Storage pools
v Disks
v Volumes

For virtualization systems, you can view information about:
v SAN Volume Controller clusters
v Storwize V7000
v Storwize V7000 Unified
v Managed disk groups
v Managed disks
v Virtual disks
v Virtual disk copies

Keep in mind the following considerations:
v A volume name in a report that is marked with an asterisk (*) indicates that the

volume is a space-efficient volume. The * is not part of the actual volume name.
v The total capacity value for storage pools in TotalStorage Enterprise Storage

Server subsystems includes only the formatted (usable) capacity for storage
pools.

v For the following storage systems, you can navigate from storage subsystems
and show managed disks, managed disk groups, and virtual disks:
– SAN Volume Controller
– Storwize V7000
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– Storwize V7000 Unified

For Storwize V7000 and Storwize V7000 Unified, you can also navigate from the
internal disks node to view the internal storage on the system.
– Information that is displayed for managed disks and internal disks is the

same as for storage subsystem disks. See “By Storage Subsystem” on page 841
for a description of the available views.

– Information that is displayed for virtual disks is the same as for storage
subsystem volumes. See “By Storage Subsystem” on page 841 for a
description of the available views.

v For IBM FAStT, HP StorageWorks, and the XIV system, you can navigate to
storage subsystems and show storage pools, disks, and volumes.

Note: The total capacity value for storage pools in these storage subsystems
includes raw (unconfigured) capacity—it does not include formatted/usable
capacity.

v For Hitachi Data Systems TagmaStore subsystem, the relationship between a
disk or volume is not displayed if the volume is using imported extents (virtual
disks).

Note: The total capacity value for storage pools in HDS subsystems includes the
formatted/usable capacity for storage pools only.

v Some of the columns in the totals row for these reports can count storage
multiple times if the report includes the following:
– A storage virtualizer like a SAN Volume Controller
– The disk arrays that host the backend storage to a storage virtualizer like a

SAN Volume Controller
In this situation, disks and logical unit numbers (LUNs) appear to belong to
both a storage virtualizer like SAN Volume Controller and the disk arrays, and
are counted multiple times in some of the columns in the totals row. To avoid
this situation, filter the report to display only the storage virtualizer or the disk
arrays. If this situation is unavoidable, then some of the columns in the totals
row can be adjusted as follows:
1. Use the Physical Disk Space column to determine the actual physical disk

space on all arrays. This disk space is not counted multiple times.
2. Sum the Disk Space column for the disk arrays and subtract this result from

the totals row to determine the total backend storage for a virtualizer.
3. To prevents counting the backend volumes multiple times, subtract the

Backend Volume Space column from the Volume Space column in the totals
row to determine the amount of volume space.

See “Report considerations and limitations” on page 807 for additional information
about reports.

Disk Groups
When you expand the Disk Group node, the navigation tree shows a list
of disk groups for the storage subsystem. You can expand the name of a
disk group to view the disks and volume spaces within that disk group.
Navigate through both Volume Spaces and Disks subnodes to view:
v Disks and volumes associated with a volume space
v Volumes with segments on a disk
v Disks containing segments from a volume
v Detailed information about a disk
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Array Sites
(IBM Tivoli Storage DS8000 only) When you expand the Array Site node,
the navigation tree shows a list of array sites for the storage subsystem.
Click Array Site to view a description of the information displayed about
array sites. You can expand the name of an array site to view the ranks,
storage pools, and disks associated with that array site.

Storage Pools
When you expand the Storage Pool node, the navigation tree shows a list
of storage pools for the storage subsystem. You can expand the name of a
storage pool to view the disks and volumes within that storage pool,
including:
v Volumes with segments on a disk
v Disks containing segments from a volume
v Detailed information about a disk

Disks When you expand the Disks node, the navigation tree shows a list of disks
for the storage subsystem. You can expand the name of disk to view the
volumes associated with that disk. Click the name of a volume associated
with a disk to view detailed information about that volume.

Volume Spaces
When you expand the Volume Spaces node, the navigation tree shows a
list of volume spaces for the storage subsystem. You can expand the name
of a volume space to view the disks and volumes within that volume
space. Navigate through both the Disks and volumes subnodes to view:
v Volumes with segments on a disk
v Disks containing segments from a volume
v Detailed information about a disk
v Detailed information about a volume

Volumes
When you expand the volumes node, the navigation tree shows a list of
volumes for the storage subsystem. Click the name of a volume to view
detailed information about that volume.

Note:

v Volume Reporting is not available for IBM FAStT FlashCopy logical
drive and repository logical drive.

v After creating a volume on a storage subsystem, you must run a probe
on that storage subsystem to collect accurate information about disk
allocation.

Managed Disk Groups
When you expand the Managed Disk Group node, the navigation tree
shows a list of disk groups that are managed by the following storage
systems:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

You can expand the name of a disk group to view the physical disks and
virtual disks that are associated with it.
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Managed Disks
When you expand the Managed Disk node, the navigation tree shows a list
of disks that are managed by the following storage systems:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

You can expand the name of a disk to view the virtual disks and any
available internal disks that are associated with it.

Virtual Disks and Virtual Disk Copies
There are three nodes in the navigation tree that are related to virtual disks
(VDisks). These nodes might be included under the nodes for the SAN
Volume Controllers in your environment:
v Virtual Disks (at the same level as Managed Disk and Managed Disk

Groups): Expand this node to view a list of the logical disks that a
cluster provides to the SAN. You can further expand each virtual disk
(VDisk) to view its mirror copies (primary copies and additional copies).

v Virtual Disks (under Managed Disk and Managed Disk Groups):
Expand this node to view the VDisks for which the primary copies are
on the selected Managed Disk.

v Virtual Disk Copies (under Managed Disk and Managed Disk
Groups): Expand this node to view all the virtual disk copies that are on
the selected Managed Disk. The primary copies are not listed under this
node because they are displayed under the Virtual Disks node.

Tip:

– The Virtual Disk Copies node is displayed in the navigation tree
only if a monitored SAN Volume Controller supports virtual disk
mirrors. If it supports virtual disk mirrors, all virtual disks will have a
related primary virtual disk copy regardless of whether the virtual
disk is mirrored. This is because all virtual disks on a SAN Volume
Controller that supports virtual disk mirrors are primary copies that
can be updated to have mirrored disks or virtual disk copies.

– The icons for all virtual disk copies are shown as folders in the
navigation tree because they represent logical extensions of a virtual
disk.

v If the virtual disk is a virtual disk copy, the primary virtual disk copy is
noted by -0 in the name of the logical volume, and all secondary copies
are noted by a hyphen and a value larger than zero. If the virtual disk is
not a virtual disk copy, only one logical volume is created and is noted
by -0. The logical disk representation of a virtual disk should always
exist, but if a probe is started for SAN Volume Controller 4.3.1 or later,
the logical disk representation of the virtual disk expands to one or more
logical volumes where virtual disk copies are represented by multiple
logical volumes, and non-virtual disk copies are represented by a single
logical volume.

Internal Disks
Internal storage information about the Storwize V7000 or Storwize V7000
Unified systems in your environment is displayed in the Internal Disks
nodes in the navigation tree:
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Internal Disks (at the same level as Virtual Disks, Managed Disk, and
Managed Disk Groups)

Expand this node to view a list of the internal disks that a
Storwize V7000 or Storwize V7000 Unified system provides to the
SAN.

Internal Disks (under Managed Disk Groups > Managed Disk)
The internal disks for this node are only displayed if there are
internal disks that are available on the managed disk.

Internal Disks (under Managed Disk)
The internal disks for this node are only displayed if there are
internal disks available.

System-wide:
Use "System-wide" reports to do the following tasks:
v View your storage assets as a whole across the entire system. You can view lists

of all of your disks, computers, storage subsystems, disk/volume groups, disks,
file systems, logical volumes, storage subsystem volumes, exports or shares,
monitored directories, users, and OS users. Additionally, you can view
aggregated reports based upon certain filters, such as grown defects per disk.

v View detailed information about Storage Resource agents and Data agents. Use
these reports to monitor your agents and track their status.

v The Selection button is disabled for system-wide reports because all the
monitored storage entities are automatically displayed for each report type. For
example, all the computers monitored by IBM Tivoli Storage Productivity Center
are displayed in the System-wide > Computers report.

Note: A volume name in a report that is marked with an asterisk (*) indicates that
the volume is a space-efficient volume. The * is not part of the actual volume
name. See “Report considerations and limitations” on page 807 for additional
information about reports.

System-wide reports include options to navigate to storage resources for more
detail, view charts of current statistics, and generate historical charts to show
storage trends. The following icons are available on some system-wide reports:

Chart icon
Click this button to generate charts for the selected rows in the table. You
can generate a chart based on the statistics currently displayed in the
report, or you can generate a history chart that provides trending data for
the selected storage subsystems. See Viewing historical trends for more
information about history charts.

Magnifying glass icon
Click this button to view detailed information about a specific file system
or logical volume in a row.

Agents reports
Use these reports to track and monitor the Storage Resource agents and
Data agents that are deployed in your environment. With this report, you
can export a comma-separated file that contains the name and status of an
agent. Specifically, use this report to perform the following tasks:
v View information about the agents deployed in your environment
v Perform actions against one or more agents shown in the report
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Each agent that is shown in the report has a magnifying glass icon next to
it. Click this icon to display detailed information about an agent (which is
identical to the information on the Administrative Services → Data Sources
→ Data/Storage Resource agents node in the navigation tree).

You can also select one or more rows on the report and right-click to
display a menu. Use the options in this menu to perform an action against
multiple agents at the same time. The menu contains all the other
operations available from the Administrative Services → Data Sources →
Data/Storage Resource agents node in the navigation tree.

Computers reports

Use these reports to view all the computers in the system, sorted in order
of the time they were last booted, probed, or discovered. This information
is valuable in environments where computers become more unreliable after
they have been up and running for long periods of time.

Storage Subsystem reports
Use these reports to view all your monitored storage subsystems and SAN
Volume Controllers, sorted by their total capacity (By Disk Space) or alias
(By Storage Subsystem).

Unmanaged Virtual Machines reports
Use these reports to view detailed information about the unmanaged
virtual machines in your environment. Each row in the report gives you
information for each unmanaged virtual machine.

Virtual Machines With No VMware reports
Use these reports to view detailed information about the virtual machines
that have Storage Resource agents or Data agents installed but are not
discovered through the VMWare data sources. Each row in the report gives
you information for each virtual machine.

Disk/Volume Groups reports
Data Manager provides support for the following volume managers:
v Veritas Volume Manager (Solaris)
v Logical Volume Manager (AIX)

These volume managers enable you to create groups of logical volumes
and disks. Use these reports to view all your disk and volume groups,
sorted by their computer (By Computer), storage capacity (By
Disk/Volume Group Space) total freespace (By Available Disk/Volume
Group Space), time when they were last probed (By Probe Time), and time
when they were discovered (By Discovered Time).

Disks reports
Use these reports to view all the disks in the system, sorted in order of
how many recovered (By Recovered Errors) and unrecovered errors (By
Unrecovered Errors) they have, time when they were probed (By Probe
Time), and time when they were discovered (By Discovered Time).

Use the Asset Reporting → System-wide → Disks → By Grown Defects
report to view the following information:
v All the disks in the system sorted in order of the number of grown

defects they have on them
v What disks in your system are experiencing problems and might be in

danger of an imminent failure
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The Asset Reporting → System-wide → Disks → By Primary Defects report
returns no data if disk defects are not detected. Use this report to view the
following information:
v All the disks in the system sorted in order of the number of primary

defects they have on them
v What disks in your system are in good condition and which ones are

more or less defective

File systems / Logical Volumes reports
Use these reports to view detailed information about file systems and
logical volumes on your monitored computers. A logical volume is a
partition on a disk that does not have a file system (raw partition). Use
these reports to view the following information:
v Available file system space on monitored computers.
v All the file systems in the system that is sorted in order of the amount of

free space they have on them.
v Which file systems have less free space and might be in danger of

running out of free space.
v Which file systems have too much free space and where space

consolidation might be necessary.
v A list of virtual disk files which are not assigned to any of the virtual

machines. This situation represents wasted storage capacity.
v The path from the file system on a virtual machine to the back-end

storage volumes on a hypervisor or mapped to the hypervisor.
v The path from the file system on a virtual machine to the back-end

storage volumes on an IBM SONAS or Storwize V7000 Unified system,
or mapped to the IBM SONAS or Storwize V7000 Unified system.

Note: The values in the By Available File System Space report are based on
data that is collected by probes. Probes collect space information as
measured in blocks (1 block = 512 bytes). Tivoli Storage Productivity
Center calculates file system space, including used space and free space,
based on the number of blocks it retrieves from a probe. It multiplies the
number of blocks by 512 and displays the resulting value in the report.

Volumes reports
Use these reports to view the following information:
v Information about the storage subsystems that host volumes
v Storage capacity of the volumes hosted by storage subsystems
v Information about the storage subsystems that host volumes sorted by

the date/time when they were probed

Exports or Shares report
Use this report to view all the Exports or Shares in your environment,
sorted in the order that they were discovered.

Monitored Directories reports
Use these reports to view all the monitored directories in the system,
sorted in order of the amount of storage space they are taking up (By
Space Used), the time when they were last scanned (By Scan Time), the
time when they were discovered (By Discovered Time), and when they
were removed (Removed Directories).

Unmanaged Computers report
Use this report to view all of the new computers that have been introduced
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into your system and that do not have Storage Resource agents or Data
agents installed on them. It also lists other computers that you have not
put under Data Manager control.

Users report
Use this report to view all the users in your environment sorted in the
order that they were discovered.

OS User Groups report
Use this report to view all the OS User Groups in your environment sorted
in the order when they were discovered.

By IBM Storwize V7000 Unified/IBM SONAS:

Use "By IBM Storwize V7000 Unified/IBM SONAS" reports to navigate to the
components of a Storwize V7000 Unified storage system or an IBM SONAS system.
These components include the clusters, nodes, pools, Network Shared Disks, file
systems, and exports that are associated with the storage system.

To view Storwize V7000 Unified or IBM SONAS asset reports, follow these steps:
1. Expand Data Manager > Reporting > Asset > By IBM Storwize V7000

Unified/IBM SONAS. The Storwize V7000 Unified storage systems or IBM
SONAS systems that were discovered by Tivoli Storage Productivity Center are
displayed.

2. Expand a storage system to view detailed information. The following tabbed
pages are displayed:

Storage Subsystem Details
Use this page to view detailed information about the Storwize V7000
Unified storage system or the IBM SONAS system. The information
available for the storage system includes the status, vendor, type and
model, and the available and used space. You can also use this page to
modify some information about the Storwize V7000 Unified storage
system or the IBM SONAS system.

File Module Details
Use this page to view information about Storwize V7000 Unified.

You can view information about the components of the Storwize V7000 Unified
storage system or the IBM SONAS system. When you click a component, report
pages for that component are displayed.

Storwize V7000 Unified or IBM SONAS - Cluster Information:

This page shows general information about a selected cluster that is associated
with a Storwize V7000 Unified storage system or an IBM SONAS system.

The following information is displayed on this page.
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Table 86. Information about clusters associated with a Storwize V7000 Unified storage
system or an IBM SONAS system

Field Name Description

Cluster The name of the cluster. For Storwize V7000
Unified or IBM SONAS clusters, the storage
system name is included with the cluster
name in the Computer or Device column.
The format of the column is
storagesystem_name: cluster_name, where
storagesystem_name is the name of the
Storwize V7000 Unified or IBM SONAS
device that the cluster belongs to. For
example, subsystem-03.lab.austin.us.com:
kq98n5d.acct displays storage system
subsystem-03.lab.austin.us.com that cluster
kq98n5d.acct belongs to.

Cluster ID The identifier of the cluster.

Type The cluster can be one or more of the
following types:

Interface
An interface cluster contains nodes
that connect a system to an IP
network for file-serving capabilities
by using service protocols.

Management
A management cluster contains
nodes that are used to configure,
administer, and monitor a system.

Storage
A storage cluster contains nodes
that provide the storage and file
system for the data in a system.

Storwize V7000 Unified or IBM SONAS - Node Information:

This page shows general information about a selected node that is associated with
a Storwize V7000 Unified storage system or an IBM SONAS system.

The following information is displayed on this page.

Table 87. Information about nodes associated with a Storwize V7000 Unified storage system
or an IBM SONAS system

Field Name Description

Node The name of the node.

Description The description of the node.

IP Address The IP address for the node.
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Table 87. Information about nodes associated with a Storwize V7000 Unified storage system
or an IBM SONAS system (continued)

Field Name Description

Role The role of the node. The node can serve
one or more of the following roles:

Interface
An interface node connects a
system to an IP network for
file-serving capabilities by using
service protocols.

Management
A management node is used to
configure, administer, and monitor
a system.

Storage
A storage node provides the storage
and file system for the data in a
system.

Status The status of the node. The status can be
one of the following values:

Normal
The node is operating normally.

Critical The node is either not operating or
an error occurred.

Warning
At least one component of the node
is not operating or an error
occurred.

Unreachable
Tivoli Storage Productivity Center
cannot reach the node.

Storwize V7000 Unified or IBM SONAS - Pool Information:

This page shows general information about a selected pool that is associated with
a Storwize V7000 Unified storage system or an IBM SONAS system.

The following information is displayed on this page.

Table 88. Information about pools associated with a Storwize V7000 Unified storage system
or an IBM SONAS system

Field Name Description

Pool The name of the pool.

Capacity The capacity of the pool.

Available Space The amount of unused space that is in the
pool.
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Storwize V7000 Unified or IBM SONAS - NSD Information:

This page shows general information about a selected Network Shared Disk (NSD)
that is associated with a Storwize V7000 Unified storage system or an IBM SONAS
system.

The following information is displayed on this page.

Table 89. Information about a selected NSD associated with a Storwize V7000 Unified
storage system or an IBM SONAS system

Field Name Description

NSD The name of the NSD.

NSD ID The identifier of the NSD.

Failover Group The failure group that the NSD belongs to.

Type The NSD type. The possible values are:

v Metadata and Data

v Metadata Only

v Data Only

Pool The pool that the NSD belongs to.

Status The status of the NSD. The possible values
are:

Normal
The NSD is operating normally.

Critical The NSD is either not operating or
an error occurred.

Warning
At least one component of the NSD
is not operating or an error
occurred.

Unreachable
Tivoli Storage Productivity Center
cannot reach the NSD.

Disk Space The total disk space for the NSD.

Available Space The amount of unused disk space for the
NSD.

Storwize V7000 Unified - NSD Probe History:

This page shows the probe history for a selected Network Shared Disk (NSD) that
is associated with a Storwize V7000 Unified storage system.

The following information is displayed on this page.

Table 90. Information about a selected NSD associated with a Storwize V7000 Unified
storage system

Field Name Description

Time of Probe The time that the probe ran.
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Table 90. Information about a selected NSD associated with a Storwize V7000 Unified
storage system (continued)

Field Name Description

Record Type The record type that is shown in the report.
Valid values are:

v Daily

v Weekly

v Monthly

Bytes Written The total number of bytes that were written
since the NSD was formatted or
manufactured.

Bytes Read The total number of bytes that were read
since the NSD was formatted or
manufactured.

Grown Defects The number of defects that were detected on
the NSD after the NSD was used.

Recovered Write Errors The number of write errors that were
successful on a subsequent attempt.

Unrecovered Write Errors The number of write errors that were not
successful on a subsequent attempt.

Recovered Read Errors The number of read errors that were
successful on a subsequent attempt.

Unrecovered Read Errors The number of read errors that were not
successful on a subsequent attempt.

Recovered Verify Errors The number of verify errors that were
successful on a subsequent attempt.

Unrecovered Verify Errors The number of verify errors that were not
successful on a subsequent attempt.

Non-Medium Errors The number of errors that are not related to
the physical disk platter, such as a
mechanical problem in the head movement
or communication errors.

Available Disk Space The amount of unused space on the NSD.

Primary Defects The number of defects on the NSD when the
NSD was new.

Temperature The temperature of the NSD in degrees
Celsius.

Storwize V7000 Unified - Correlated Storage Subsystem Volume:

This page shows information about the relationship between a selected Network
Shared Disk (NSD) and the associated virtual disk or volume that is on the
Storwize V7000 Unified storage system.

The following information is displayed on this page.

Table 91. Information about the relationship between a selected NSD and an associated
virtual disk or volume on a Storwize V7000 Unified storage system

Field Name Description

Virtual Disk Name The name of the virtual disk.
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Table 91. Information about the relationship between a selected NSD and an associated
virtual disk or volume on a Storwize V7000 Unified storage system (continued)

Field Name Description

Unavailable Virtual Disk Space The amount of storage space for Redundant
Array of Independent Disks (RAID) or
mirror redundancy.

Type The organization of the virtual disk. Values
are:

v Sequential

v Striped

RAID Level The RAID level of the virtual disk. For
example, 0, 1, 5, and so on.

Is Encryptable Indicates whether the virtual disk is
encryptable. If the virtual disk is
encryptable, the virtual disk uses full disk
encryption, but does not belong to a defined
System Storage DS8000 or System Storage
DS5000 encryption group. Values are:

v True (the virtual disk is encryptable)

v False (the virtual disk is not encryptable)

Is Encrypted Indicates whether the virtual disk is
encrypted. If the virtual disk is encrypted,
the volume uses full disk encryption and
belongs to a defined DS8000 or DS5000
encryption group. Values are:

v True (the virtual disk is encrypted)

v False (the virtual disk is not encrypted)

Easy Tier Indicates whether Easy Tier is on or off for
the virtual disk.

Easy Tier Status Indicates the Easy Tier functions that are
active for the virtual disk copy. Values are:

v Active (can move extents of this virtual
disk copy for performance [automatic data
placement])

v Inactive (no Easy Tier function is active)

v Measured (statistics are being gathered for
the virtual disk copy, but no extents are
moved)

Tiers The tier levels that are used by the virtual
disk. Each tier is displayed as a row in a
table.

Flash Copy Indicates whether the virtual disk or copy is
in a FlashCopy relationship and whether it
is a FlashCopy source or a FlashCopy target.
A virtual disk or copy that is not in a
FlashCopy relationship is displayed with a
None value, regardless of whether the
virtual disk is on a system that supports
FlashCopy.

Attributes Indicates whether the disk is surfaced or not
surfaced.
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Storwize V7000 Unified or IBM SONAS - File System Information:

This page shows general information about a selected file system that is associated
with a Storwize V7000 Unified storage system or an IBM SONAS system.

The following information is displayed on this page.

Table 92. Information about a selected file system associated with a Storwize V7000 Unified
storage system or an IBM SONAS system

Field Name Description

Computer The name of the computer that contains the
file system.

File System Type The file system type, which is General
Parallel File System (GPFS).

Mount Point The name or mount point of the file system
(for example, /ibm/gpfs0, or /ibm/testfs).

Physical Space The physical size of the file system.

File System Space The capacity of the file system.

Probe Last Run The date and time that the last probe ran for
the file system.

Scan Last Run The time that the last scan ran for the file
system.

Discovered Time The date and time that the file system was
discovered.

Removed Time The date and time that the file system was
removed, if applicable.

Maximum File Count The maximum number of files allowed on
the file system.

Used I-Nodes The number of used i-nodes in the file
system.

Free I-Nodes The number of free i-nodes within a file
system.

Used Space The amount of used storage space within a
file system. The amount of used and free
space is also shown in a chart on the page.

Free Space The amount of unused storage space in the
file system.

Storwize V7000 Unified or IBM SONAS - File Set Information:

This page shows general information about a selected file set that is associated
with a Storwize V7000 Unified storage system or an IBM SONAS system.

The following information is displayed on this page.

Table 93. Information about a selected file set associated with a Storwize V7000 Unified
storage system or an IBM SONAS system

Field Name Description

File Set The name of the file set.
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Table 93. Information about a selected file set associated with a Storwize V7000 Unified
storage system or an IBM SONAS system (continued)

Field Name Description

Path The path for the file set. The path is
displayed only if Linked is displayed in the
Status field.

File System The name of the file system that is
associated with the file set.

Status The status of the file system. Valid values
are:

Linked The file set is linked to the file
system that is displayed in the File
System field.

Unlinked
The file set is not linked to the file
system that is displayed in the File
System field.

Used Space The amount of space that is used by the file
set.

Used I-Nodes The number of i-nodes that are used by the
file set.

Storwize V7000 Unified or IBM SONAS - Export Information:

This page shows general information about a selected export that is associated
with a Storwize V7000 Unified storage system or an IBM SONAS system.

The following information is displayed on this page.

Table 94. Information about a selected export associated with a Storwize V7000 Unified
storage system or an IBM SONAS system

Field Name Description

Export or Share The name of the export.

Cluster The name of the cluster that the export is
associated with.

Path The name of the path for the export.

Discovered The date and time that the export was
discovered.

Active Indicates whether the export is active or
inactive within the cluster. Valid values are:

Yes The export is active.

No The export is inactive. If an export
is inactive, it is included in the list
of exports, but the data that is
associated with the export cannot
be accessed.

Storwize V7000 Unified or IBM SONAS - Configured Protocol Information:

This page shows the protocols for a selected export that is associated with a
Storwize V7000 Unified storage system or an IBM SONAS system.
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Protocols are specified for an export when the export is created. The following
protocols can be specified for an export:
v HTTP
v FTP
v Secure Copy Protocol (SCP)
v Network File System (NFS)
v Common Internet File System (CIFS)

For each protocol that is listed on this page, Configured or Not Configured is
shown to designate whether the protocol as been specified for the export. In
addition, the information in the following tables is provided for the NFS and the
CIFS protocols when they are specified for the export.

Protocol Type NFS

Table 95. NFS protocols for a selected export associated with a Storwize V7000 Unified
storage system or an IBM SONAS system

Field Name Description

Client Name The name of the client that can access the
NFS protocol. If an asterisk (*) is shown, the
settings apply to multiple clients.

Read Only Specifies whether the export is read only. If
the export is read only, files cannot be
modified or created on this export. Values
are:

Yes Files cannot be modified or created.

No Files can be modified or created.

Root Squash Specifies whether root users on clients
should be prevented from having privileged
access to exported files. Values are:

Yes Root squash is enabled.

No Root squash is not enabled.

Secure Specifies whether NFS access to the export is
secure. Values are:

Yes NFS is secure.

No NFS is not secure.

Protocol Type CIFS

Table 96. CIFS protocols for a selected export associated with a Storwize V7000 Unified
storage system or an IBM SONAS system

Field Name Description

Read Only Specifies whether the export is read only. If
the export is read only, files cannot be
modified or created on this export. Values
are:

Yes Files cannot be modified or created.

No Files can be modified or created.
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Table 96. CIFS protocols for a selected export associated with a Storwize V7000 Unified
storage system or an IBM SONAS system (continued)

Field Name Description

Browsable by Client Specifies whether the export is hidden from
the client. The export is not shown in the list
of available exports. Values are:

Yes The export is not hidden from the
client.

No The export is hidden from the
client.

Hide Objects with No Read Access Specifies whether the export is excluded
from lists of files and directories when the
user does not have permission to those files
and directories. Values are:

Yes The export is excluded.

No The export is included.

Client/Group/SID The client, group, or security identifier that
can access the CIFS protocol.

Access Specifies whether the client, group, or
security identifier has access to the export.

v Allowed

v Denied

Value Specifies the level of access that is granted to
the client, group, or security identifier.
Values are:

v Full

v Read

v Write

Comment A user-defined comment for the CIFS export.
If a comment is not available, this field is
blank.

Storwize V7000 Unified or IBM SONAS - Monitored Directory Information:

This page shows general information about a directory that is associated with a
Storwize V7000 Unified storage system or an IBM SONAS system.

The following information is displayed on this page.

Table 97. Information about a directory associated with a Storwize V7000 Unified storage
system or an IBM SONAS system

Field Name Description

Computer The name of the computer that contains the
directory.

Directory The name of the directory.

Owner The owner of the directory.

OS Group The operating system group that the
directory belongs to.

Total Size The total size of the directory.
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Table 97. Information about a directory associated with a Storwize V7000 Unified storage
system or an IBM SONAS system (continued)

Field Name Description

File Count The number of files in the directory.

Directory Count The number of subdirectories in the
directory.

Average File Size The average size of the files in the directory.

Access Time The date and time that the directory was last
accessed.

Modification Time The date and time that the directory was last
modified.

Creation Time The date and time that the directory was
created.

Scan Time The date and time that the directory was last
scanned.

Discovered Time The date and time that the directory was
discovered.

Removed Time The date and time that the directory was
removed.

File attributes that are set If any attributes were set for the files in the
directory (for example, read only), the
attributes are displayed. If no attributes were
set, No File Attributes Are Set is
displayed.

This Directory belongs to the following
Directory Groups

A list of the directory groups that the
directory belongs to.

Availability Reports
Use Availability reports to monitor and report on the availability of your storage,
both from a network point of view and from a computer uptime perspective.

Use these reports to view the percentage of time that the storage in your enterprise
is off-network due to network problems or is unavailable due to system downtime.
In a fast-paced business environment, 24x7 application availability is critical. These
reports help you monitor the availability of the storage and data that back up your
applications.
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Reporting Type Description

Ping Use the ping report to monitor how available your storage is
on the network. To do this monitor, regularly scheduled pings
are sent out from the Data server to all of the monitored
computers in your environment. The Tivoli Storage
Productivity Center server checks not only for whether a
Storage Resource agent or Data agent is available on the
network, but records the amount of time that the request was
in transit. This information indicates the responsiveness of the
various storage servers on the network as well.

Use the Report Filter Specification section on the Selection
panel to limit the time range of the information in a report.
Check the Limit To This Time Range option and use the date
selection fields to limit the time range for a report.

A ping report shows the following information:

v the name of a computer

v percentage of time the computer is available on the network

v number of pings that have been transmitted and the number
that have been received

v number of damaged requests and the average transit time for
the request to go between the Tivoli Storage Productivity
Center server and the computer that is being monitored

v maximum transit time

v minimum transit time

v report start time and report end time for each computer in
the report

Note: You can sort on any of these columns by clicking on the
column name. You can also generate charts and drill down on
each computer for more detail.
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Reporting Type Description

Computer Uptime Use the computer uptime report to track the availability of the
storage based upon the percentage of the time the computer
that hosts that storage is down or not running. The Storage
Resource agent or Data agent on the computer tracks this
information and sends it to the server.

A computer uptime report shows the following information:

v name of a computer

v percentage of time the computer is up and running

v number of reboots that have been recorded

v total amount of time the computer has been down and
unavailable

v average downtime that has been recorded

v report start time and report end time for each computer in
the report

Note: Computer Uptime reports are not available for Storage
Resource agents that are invoked using the non-daemon
protocol for data collection. These reports do not contain data
for computers on which non-daemon based Storage Resource
agents are deployed. To collect computer uptime information
using a Storage Resource agent, that agent must use a daemon
service for runtime operation.

You can sort on any of these columns by clicking on the
column name. You can also generate charts and drill down on
each computer for more detail.

TPC-wide Storage Space Reports
Use these reports to view storage capacity of your resources at a file system,
computer, or entire network level.

For a specific computer, group of computers, or all the computers in your
enterprise, you can view the following:
v How much storage you have
v How much storage is being used
v What percentage of storage is free for expansion
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Reporting Type Description

Disk Space Use these reports to view and chart disk capacity, per disk, per computer, per
computer group, per domain, and for the whole network. These reports include
one row for each computer that shows the total amount of storage capacity on
that computer and the associated computer and disk storage information.

For detail on any computer in the report, click on the magnifying glass next to
the report row. You can also click on the chart button within a report to view an
easy-to-interpret bar chart, showing the total storage capacity of each computer
that you have chosen to report on and chart. To get the exact amount of storage
for a computer, simply position the cursor over the associated bar and a box will
appear showing the total amount for the selected computer.
Note: To ensure the accuracy and consistency of the data that appears in Disk
Capacity reports, run regularly scheduled probes against the hosts that import
volumes and the storage subsystems upon which you want to report. You should
run probes against storage subsystems after running them against any hosts.

You can use the following By clauses to view disk space for the following
storage entities: By Disk, By Storage Subsystem, By Cluster, By Computer, By
Computer Group, By Domain, and Network-wide.

File System Space Use these reports to view information for monitored file systems, including the
total amount of storage capacity on those file systems and statistics for used
space, free space, and total number of files. You can use the following By clauses
to view file system space for the following storage entities: By Filesystem, By
Filesystem Group, By Cluster, By Computer, By Computer Group, By Domain,
Network-wide.

Consumed File System Space Use these reports to view information about the amount of space consumed on a
filesystem. You can use the following By clauses to view consumed file system
space for the following storage entities: By Filesystem, By Filesystem Group, By
Cluster, By Computer, By Computer Group, By Domain, Network-wide.

Available File System Space Use Filesystem Used Space reports to view information about the amount of free
space on a filesystem. You can use the following By clauses to view available file
system space for the following storage entities: By Filesystem, By Filesystem
Group, By Cluster, By Computer, By Computer Group, By Domain,
Network-wide.

TPC-Wide Storage Space - Disk Space report:

Use this report to view and chart disk storage capacity at the following levels: by
disk, by computer, by cluster, by storage system, by computer monitoring or
reporting group, by storage system monitoring or reporting group, by domain, and
for the whole network.

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

By Disk

Chart icon
Click this button to generate charts about the capacity of disks that are
displayed in the report.

Magnifying glass icon
Click this button to view a more detailed report about the capacity of a
disk.

Chapter 8. Reporting in the stand-alone GUI 861



Device
Name of the device on which a disk resides. The following disks are
displayed in this report:
v Computer disks that are internal to the computers monitored by IBM

Tivoli Storage Productivity Center.
v Computer disks on virtual machines that are monitored by Tivoli

Storage Productivity Center.
v Storage system disks on storage subsystems that are monitored by Tivoli

Storage Productivity Center.
v Storage system disks that no longer exist after a probe of a storage

system because information about that system was removed based on
settings in the Removed Resource Retention panel.

v Back-end storage volumes that are not identified by Tivoli Storage
Productivity Center as being assigned to a monitored storage system
virtualizer.

v Computer disks that are not identified by Tivoli Storage Productivity
Center as being assigned to a monitored storage system.

The following disks are not displayed in this report:
v Computer disks that are assigned to storage subsystems monitored by

Tivoli Storage Productivity Center.
v Back-end storage volumes that are assigned to storage system

virtualizers monitored by Tivoli Storage Productivity Center.

Path Name of a disk.

Disk Space (Capacity)
Total storage capacity for a disk. Keep in mind the following information
about the TOTAL row for this column:
v The value that appears in TOTAL row for this column includes the disk

space of spare disks within a storage subsystem.
v The value that appears in the TOTAL row for this column does not

include computer disk space that is on virtual machines monitored by
Tivoli Storage Productivity Center.

Note: When using the stand-alone GUI, the Disk Space entries for
Storwize V7000 virtualizers report the sum of backend capacity. Local disk
space is not included. When using the web-based GUI, local disk space is
included in the calculation of the total device disk space of Storwize V7000
virtualizers.

Available Disk Space (Unallocated Space)
Amount of space on the disk that is not allocated to any logical volume (or
volumes for disks within storage subsystems). This value does not include
RAID overhead on storage subsystems that are identified by Tivoli Storage
Productivity Center. The value that appears in the TOTAL row for this
column includes the unallocated capacity of all disks within the storage
system, including the capacity of spare disks.

In Storage Subsystem
Indicates Yes when a disk is either of the following:
v An actual physical disk within a storage system that is monitored by

Tivoli Storage Productivity Center.
v A back-end storage volume within a storage system virtualizer that is

monitored by Tivoli Storage Productivity Center.
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Manufacturer
Name of the manufacturer of a disk.

Note: The value Unknown is displayed in this column for IBM ESS
storage subsystems.

Model
Model number of a disk.

Note: The value Unknown is displayed in this column for IBM ESS
storage subsystems.

Serial Number
Serial number of a disk.

Primary Defects
Number of defects on the disk when it was new.

Note: Defect data is not collected for IBM TotalStorage Enterprise Storage
Server, IBM FAStT, HP StorageWorks, Hitachi Data Systems storage
subsystems.

Grown Defects
Number of defects detected on the disk since it was new.

Note: Defect data is not collected for TotalStorage Enterprise Storage
Server, FAStT, HP StorageWorks, Hitachi Data Systems storage subsystems.

Fibre Attached
Indicates Yes when a disk is attached to a port that Tivoli Storage
Productivity Center identifies as fibre.

Mapped to Storage Subsystem
Indicates Yes when a computer disk or a back-end storage volume can be
mapped to a storage system.

Detectable
Indicates Yes when a disk is identified as being available to the server or
the storage system following a successful probe.

Is Virtual
Indicates Yes when a disk resides on a computer that Tivoli Storage
Productivity Center identifies as a virtual machine.

Is Solid State
Indicates Yes when a disk is on a solid-state drive.

Is Encryptable
Indicates Yes when a disk is encryptable.

Is Encrypted
Indicates Yes when a disk is encrypted.

Tier Indicates the tier level of a disk. Disks can have only one tier. For example,
this column displays either the value generic_ssd or generic_hdd.

By Storage Subsystem

Chart icon
Click this button to generate charts about the disk capacity of storage
subsystems that are displayed in the report.
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Magnifying glass icon
Click this button to view a more detailed report about the capacity of disks
associated with a storage system.

Name
Name or alias of a storage system that contains the disks or the name or
alias of a storage system virtualizer (for example, SAN Volume Controller)
that manages the disks. This report does not display storage subsystems
that have been discovered but not probed.

Disk Space (Disk Capacity)
Total raw (unformatted) disk capacity of a storage system. Tivoli Storage
Productivity Center does not include the following capacity information in
its calculation of the value for this column:
v Capacity of spare disks identified on TotalStorage Enterprise Storage

Server, DS8000, and IBM System Storage DS6000 storage subsystems.
v Capacity of storage system disks that become missing after a Tivoli

Storage Productivity Center storage system probe.
v The value that appears in the TOTAL row for this column does not

include spare disks in its calculation.

Available Disk Space (Disk Unallocated Space)
Total unformatted disk freespace of a storage system. Tivoli Storage
Productivity Center does not include the following storage space in its
calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
v RAID overhead on storage subsystems that are identified by Tivoli

Storage Productivity Center.
v External back-end storage for TagmaStore subsystems.
v Storage space that is consumed by volumes that reside on external disks

when Hitachi Data Systems (HDS) storage subsystems are configured as
storage virtualizers.

v The value that appears in the TOTAL row for this column does not
include spare disks in its calculation.

Number of Disks
Total number of disks in a storage system. Tivoli Storage Productivity
Center does not include the following disks in its calculation of the value
for this column:
v Storage system disks that become missing after a storage system probe.
v External back-end storage for TagmaStore subsystems.
v Disks in partner storage pools for NetApp storage devices.

Note: If you click the magnifying glass icon next to storage system, the
resulting drill-down report generates a list of detectable storage system
disks or back-end storage volumes only. Therefore, the total number of
disks for each storage system drill-down report will equal this value.

Number of Volumes (LUNs)
Total number of storage volumes in a storage system or the total number
of virtual volumes that are virtual storage. This value does not include
storage system volumes or virtual storage volumes that become missing
after a storage system probe.
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Volume Space (LUN Capacity)
Total capacity of all storage system volumes or virtual storage volumes
within a storage system. This value does not include capacity information
for storage system volumes or virtual storage volumes that become
missing after a storage system probe.

Note: For space-efficient FlashCopy volumes, the volume capacity is the
amount of storage space requested for these volumes, not the actual
allocated amount. This can result in discrepancies in the overall storage
capacity reported for a storage system using space-efficient FlashCopy
volumes. This also applies to the Total Usable Volume Space and Total
FlashCopy Target Capacity calculations.

Consumable Volume Space (Usable LUN Capacity)
Total amount of unique storage system volume space and virtual storage
volume space on monitored storage system arrays that you can assign to
servers within the network or are already assigned to servers within the
network.

Tivoli Storage Productivity Center does not include the following volumes
in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a probe.
v Storage system volumes or virtual storage volumes that are used as flash

copy targets.
v Storage system volumes or virtual storage volumes that are identified as

Business Continuance Volume extended (BCVx).
v Storage system volumes or virtual storage volumes used as a Volume

Configuration Management (VCM) database.
v Storage system volumes or virtual storage volumes that Tivoli Storage

Productivity Center identifies as back-end storage volumes on monitored
storage system virtualizers. For example, SAN Volume Controller.

Note: For FAStT, the XIV system, HP StorageWorks, and Hitachi Data
Systems storage subsystems, the value in this column is the same as the
value in the Volume Capacity column.

FlashCopy Target Volume Space (Capacity)
Total amount of unique storage system volume space and virtual storage
volume space on monitored storage system arrays that is identified as flash
copy target space. Tivoli Storage Productivity Center does not include the
following storage space in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Storage system volumes or virtual storage volumes that are not used as

flash copy targets.

Correlated Volume Space (LUN Capacity Visible to Data Manager)
Total amount of storage system volume space or virtual storage volume
space on systems where the systems disks are identified by Tivoli Storage
Productivity Center as residing within a monitored storage system. This
includes storage system volumes or virtual storage volumes identified as
back-end storage volumes on monitored storage system virtualizers. Tivoli
Storage Productivity Center does not include the following capacity
information in its calculation of the value for this column:
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v Storage system volumes or virtual storage volumes that become missing
after a storage system probe.

v Disks that are assigned to a monitored storage system but are not
identified by Tivoli Storage Productivity Center as a disk residing within
the storage system. Some reasons why these disks are not identified as
residing within the storage system include:
– Tivoli Storage Productivity Center does not support the identification

of disks for some storage system types.
– The connection of the disk to the storage system is lost and is no

longer detectable during a probe.
v Storage system volumes or virtual storage volumes that are identified as

Business Continuance Volume extended (BCVx).
v Storage system volumes or virtual storage volumes used as a Volume

Configuration Management (VCM) database.

Volume Space Not Correlated (LUN Capacity not Visible to Data Manager)
Total amount of unique storage system volume space and virtual storage
volume space discovered on monitored storage system arrays that can be
assigned or are assigned to systems within the network. Tivoli Storage
Productivity Center does not include the following capacity information in
its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Disks that reside within a monitored storage system.
v Storage system volumes or virtual storage volumes that Tivoli Storage

Productivity Center identifies as back-end storage volumes on monitored
storage system virtualizers.

Unavailable Disk Space (Overhead)
Amount of storage system volume or virtual storage volume space that is
dedicated to redundancy. This value is dependent on the storage system
SMI-S provider returning a valid RAID value that is used to determine the
overhead. If the value is zero for a storage system, the overhead cannot be
calculated.

This amount does not include storage space information from storage
system volumes or virtual storage volumes that become missing after a
storage system probe.

Formatted Space (Capacity)
Total amount of formatted storage space associated with the storage system
that is used or can be used for system storage volumes or virtual storage
volumes. This value is dependent on the storage system SMI-S provider
returning a formatted value.

For some storage subsystems, this is the total managed space which
includes space that cannot be used for storage volumes or virtual storage
volumes. This can occur due to a number of reasons, such as space not
being formatted until storage volumes are created.

For SAN Volume Controller, this value represents the total size of the
managed disk groups created on the SAN Volume Controller. This value
does not include managed disk space that is not defined to a managed
disk group.

Formatted Space with No Volumes
Total amount of formatted storage space associated with the storage system
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that can be used for system storage volumes or virtual storage volumes.
This value is dependent on the storage system SMI-S provider returning a
formatted value.

For some subsystems, this value represents the remaining managed space
that includes space that cannot be used for storage volumes or virtual
storage volumes. This can occur due to a number of reasons, such as space
not being formatted until storage volumes are created.

For SAN Volume Controller, this value represents the space within the
managed disk groups that does not include the size of the virtual disks
created and the corresponding virtual disk extent overhead.

Overall Unavailable Disk Space (Total Overhead)
(TotalStorage Enterprise Storage Server, DS6000, and DS8000 storage
systems only) Total amount of unformatted space within disk groups or
array sites.

Unformatted Disk Space
This value does not apply to all storage subsystems. For FAStT,
TotalStorage Enterprise Storage Server, DS6000, and DS8000 storage
systems, this is the total raw disk space of any unformatted disk groups or
array sites. This column displays N/A for the storage systems where this
value is not applicable. For the XIV system, this value shows the physical
(hard) space of the XIV system available for pool creation or expansion.

Cache
Amount of cache memory that is internal to the storage system.

Note: This column is blank for SAN Volume Controllers.

Manufacturer
Name of the manufacturer of a disk.

Model
Model number of a disk.

Serial Number
Serial number of a disk. This information is displayed for physical disks
only. For MDisks, the value Unknown is displayed.

Firmware Revision
Microcode (OS) version.

Assigned Volume Space (Subsystem Assigned LUN Capacity)
Total storage system volume space within the storage system that is
mapped or assigned to host systems. Tivoli Storage Productivity Center
does not include the following capacity information in its calculation of the
value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Storage system volumes that are not mapped or are not assigned to host

systems.

Unassigned Volume Space (Subsystem Unassigned LUN Capacity)
Total storage system volume space within a storage system that is not
mapped or not assigned to host systems. Tivoli Storage Productivity Center
does not include the following capacity information in its calculation of the
value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
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v Storage system volumes that are mapped or assigned to host systems.

Unassigned and Available Formatted Disk Space (Subsystem Total Formatted
Free Space)

Total storage system space that is not mapped or not assigned to host
systems and the total amount of formatted storage space associated with
the storage system that can be used for system storage volumes.

This total amount of formatted storage space is dependent on the storage
system SMI-S provider returning a formatted value. For some subsystems,
this value represents the remaining managed space that might include
space that cannot be used for storage volumes or virtual storage volumes.
This can occur due to a number of reasons, such as space not being
formatted until storage volumes are created.

Tivoli Storage Productivity Center does not include the following volumes
in its calculation of the value for this column:
v Storage system volumes that become missing after a storage system

probe.
v Storage system volumes that are mapped or assigned to host systems.

zOS Volume Space (zOS LUN Capacity)
Total storage system space that is reserved for use on mainframe storage
such as used by z/OS. Tivoli Storage Productivity Center does not include
the following volumes in its calculation of the value for this column:
v Storage system volumes that become missing after a storage system

probe.
v Storage system volumes that are reserved for use on open system server

or non-mainframe storage.

Open System Volume Space (Open System LUN Capacity)
Total storage system space that is reserved for use on open system storage
such as used by operating systems like LINUX, AIX, HP/UX, Oracle
Solaris, and Windows. Tivoli Storage Productivity Center does not include
the following volumes in its calculation of the value for this column:
v Storage system volumes that become missing after a storage system

probe.
v Storage system volumes that are reserved for use on mainframe storage.

Physical Disk Space (Capacity)
Total amount of physical disk space discovered on the monitored storage
system arrays. Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
v Back-end storage volumes on monitored storage system virtualizers (for

example, SAN Volume Controller) that are attached from a storage
system.

Backend Volume Space (Backend LUN Capacity)
Total amount of storage system volume space or virtual storage space that
Tivoli Storage Productivity Center identifies as the back-end disk space on
a monitored storage system virtualizer (for example, SAN Volume
Controller). Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
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v Storage system volumes or virtual storage volumes that are back-end
disks on a storage system virtualizer that is not monitored.

Configured Real Space (GB)
Total amount of real available and formatted storage space in the storage
pools that are associated with a storage subsystem.

Available Real Space (GB)
Amount of real storage space available to allocate to volumes in the
storage pools that are associated with a storage subsystem.

Tiers Indicates the tiers that are used by the storage system. Each tier is
delimited by a semi-colon (;). Possible values are: generic_hdd, generic_ssd

Information about tiers is available for SAN Volume Controller 6.1 and
Storwize V7000 only. The value N/A is displayed in tier-related columns
for other storage systems.

Tier Capacities
Total storage capacity for each tier that is used by the storage system. The
capacity for each tier is delimited by a semi-colon (;).

Tier Free Capacities
Free storage capacity (available space) for each tier that is used by the
storage system. The free capacity for each tier is delimited by a semi-colon
(;).

By Storage Subsystem Group

Chart icon
Click this button to generate charts about the disk capacity of storage
subsystems in the groups that are displayed in the report.

Magnifying glass icon
Click this button to view a more detailed report about the disk capacity of
storage subsystems in a group.

Creator
ID of the user who created the storage system monitoring group or storage
system reporting group.

Group Name of a group.

Disk Space (Disk Capacity)
Total raw (unformatted) disk capacity of the storage subsystems that are in
a group. Tivoli Storage Productivity Center does not include the following
disks in its calculation of the value for this column:
v Capacity of spare disks identified on TotalStorage Enterprise Storage

Server, DS8000, and DS6000 storage systems.
v Capacity of storage system disks that become missing after a Tivoli

Storage Productivity Center storage system probe.

Available Disk Space (Disk Unallocated Space)
Total unformatted disk free space of the storage subsystems that are in a
group. Tivoli Storage Productivity Center does not include the following
storage space in its calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
v RAID overhead on storage subsystems that are identified by Tivoli

Storage Productivity Center.
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v External back-end storage for TagmaStore subsystems.
v Storage space that is consumed by volumes that reside on external disks

when Hitachi Data Systems (HDS) storage subsystems are configured as
storage virtualizers.

Number of Disks
Total number of disks in the storage subsystems that are in a group. Tivoli
Storage Productivity Center does not include the following disks in its
calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
v External back-end storage for TagmaStore subsystems.
v Disks in partner storage pools for NetApp storage devices.

Note: If you click the magnifying glass icon next to storage system, the
resulting drill-down report generates a list of detectable storage system
disks or back-end storage volumes only. Therefore, the total number of
disks for each storage system drill-down report will equal this value.

Number of Volumes (LUNs)
Total number of storage volumes in a storage system or the total number
of virtual volumes that are virtual storage. This value does not include
storage system volumes or virtual storage volumes that become missing
after a storage system probe.

Volume Space (LUN Capacity)
Total capacity of all storage system volumes or virtual storage volumes
within the storage system. This value does not include capacity
information of storage system volumes or virtual storage volumes that
become missing after a storage system probe.

Note: For space-efficient FlashCopy volumes, the volume capacity is the
amount of storage space requested for these volumes, not the actual
allocated amount. This can result in discrepancies in the overall storage
capacity reported for a storage system using space-efficient FlashCopy
volumes. This also applies to the Total Usable Volume Space and Total
FlashCopy Target Capacity calculations.

Consumable Volume Space (Usable LUN Capacity)
Total amount of unique storage system volume space and virtual storage
volume space on monitored storage system arrays in a group that you can
assign to servers within the network or are already assigned to servers
within the network.

Tivoli Storage Productivity Center does not include the following volumes
in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a probe.
v Storage system volumes or virtual storage volumes that are used as flash

copy targets.
v Storage system volumes or virtual storage volumes that are identified as

Business Continuance Volume extended (BCVx).
v Storage system volumes or virtual storage volumes used as a Volume

Configuration Management (VCM) database.
v Storage system volumes or virtual storage volumes that Tivoli Storage

Productivity Center identifies as back-end storage volumes on monitored
storage system virtualizers. For example, SAN Volume Controller.
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Note: For FAStT, the XIV system, HP StorageWorks, and Hitachi Data
Systems storage subsystems, the value in this column is the same as the
value in the Volume Space column.

FlashCopy Target Volume Space (Capacity)
Total amount of unique storage system volume space and virtual storage
volume space on monitored storage system arrays in a group that is
identified as flash copy target space. Tivoli Storage Productivity Center
does not include the following volumes in its calculation of the value for
this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Storage system volumes or virtual storage volumes that are not used as

flash copy targets

Correlated Volume Space (LUN Capacity Visible to Data Manager)
Total amount of storage system volume space or virtual storage volume
space on systems where the systems disks are identified by Tivoli Storage
Productivity Center as residing within the monitored storage subsystems in
a group. This includes storage system volumes or virtual storage volumes
identified as back-end storage volumes on monitored storage system
virtualizers.Tivoli Storage Productivity Center does not include the
following scenarios in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Disks that are assigned to a monitored storage system but are not

identified by Tivoli Storage Productivity Center as a disk residing within
the storage system. Some reasons why these disks are not identified as
residing within the storage system include:
– Tivoli Storage Productivity Center does not support the identification

of disks for some storage system types.
– The connection of the disk to the storage system is lost and is no

longer detectable during a probe.
v Storage system volumes or virtual storage volumes that are identified as

Business Continuance Volume extended (BCVx).
v Storage system volumes or virtual storage volumes used as a Volume

Configuration Management (VCM) database.

Volume Space Not Correlated (LUN Capacity not Visible to Data Manager)
Total amount of unique storage system volume space and virtual storage
volume space discovered on monitored storage system arrays in a group
that can be assigned or are assigned to systems within the network. Tivoli
Storage Productivity Center does not include the following in its
calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Disks that reside within a monitored storage system.
v Storage system volumes or virtual storage volumes that Tivoli Storage

Productivity Center identifies as back-end storage volumes on monitored
storage system virtualizers.

Unavailable Disk Space
Amount of volume or virtual storage volume space of storage subsystems
in a group that is dedicated to redundancy. This value is dependent on the
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storage system SMI-S provider returning a valid RAID value that is used
to determine the overhead. If the value is zero for a storage system, the
overhead cannot be calculated.

This amount does not include storage space information from storage
system volumes or virtual storage volumes that become missing after a
storage system probe.

Formatted Space
Total amount of formatted storage space associated with the storage
subsystems in a group that is used or can be used for system storage
volumes or virtual storage volumes. This value is dependent on the storage
system SMI-S provider returning a formatted value.

For some storage subsystems, this is the total managed space which
includes space that cannot be used for storage volumes or virtual storage
volumes. This can occur due to a number of reasons, such as space not
being formatted until storage volumes are created.

For SAN Volume Controller, this value represents the total size of the
managed disk groups created on the SAN Volume Controller. This value
does not include managed disk space that is not defined to a managed
disk group.

Formatted Space with No Volumes
Total amount of formatted storage space associated with the storage
subsystems in a group that can be used for system storage volumes or
virtual storage volumes. This value is dependent on the storage system
SMI-S provider returning a formatted value.

For some subsystems, this value represents the remaining managed space
that includes space that cannot be used for storage volumes or virtual
storage volumes. This can occur due to a number of reasons, such as space
not being formatted until storage volumes are created.

For SAN Volume Controller, this value represents the space within the
managed disk groups that does not include the size of the virtual disks
created and the corresponding virtual disk extent overhead.

Unformatted Disk Space
This value does not apply to all storage subsystems. For FAStT,
TotalStorage Enterprise Storage Server, DS6000, and DS8000 storage
systems, this is the total raw disk space of any unformatted disk groups or
array sites. For the XIV system, the total available physical (hard) space
that is left for pool creation. This column displays N/A for the storage
subsystems where this value is not applicable.

Cache
Amount of cache memory that is internal to the storage subsystems in the
group.

Note: This column does not include values for SAN Volume Controllers.

Assigned Volume Space (Subsystem Assigned LUN Capacity)
Total volume space of the storage subsystems within a group that is
mapped or assigned to host systems. Tivoli Storage Productivity Center
does not include the following capacity information in its calculation of the
value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
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v Storage system volumes that are not mapped or are not assigned to host
systems.

Unassigned Volume Space (Subsystem Unassigned LUN Capacity)
Total volume space of the storage subsystems in a group that is not
mapped or not assigned to host systems. Tivoli Storage Productivity Center
does not include the following capacity information in its calculation of the
value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Storage system volumes that are mapped or assigned to host systems.

zOS Volume Space (zOS LUN Capacity)
Total space of storage subsystems in a group that is reserved for use on
mainframe storage such as used by z/OS. Tivoli Storage Productivity
Center does not include the following volumes in its calculation of the
value for this column:
v Storage system volumes that become missing after a storage system

probe.
v Storage system volumes that are reserved for use on open system server

or non-mainframe storage.

Open System Volume Space (Open System LUN Capacity)
Total space of the storage subsystems in a group that is reserved for use on
open system storage such as used by operating systems such as Linux,
AIX, HP/UX, Oracle Solaris, and Windows. Tivoli Storage Productivity
Center does not include the following volumes in its calculation of the
value for this column:
v Storage system volumes that become missing after a storage system

probe.
v Storage system volumes that are reserved for use on mainframe storage.

Physical Disk Space (Capacity)
Total amount of physical disk space on the storage system arrays that are
in a group. Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
v Back-end storage volumes on monitored storage system virtualizers (for

example, SAN Volume Controller) that are attached from a storage
system.

Backend Volume Space (Backend LUN Capacity)
Total amount of storage system volume space or virtual storage space that
Tivoli Storage Productivity Center identifies as the back-end disk space on
the monitored storage system virtualizers (for example, SAN Volume
Controller) that are in a group. Tivoli Storage Productivity Center does not
include the following volumes in its calculation of the value for this
column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Storage system volumes or virtual storage volumes that are back-end

disks on a storage system virtualizer that is not monitored.
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By Cluster

Chart icon
Click this button to generate charts about the disk capacity of the clusters
that are displayed in the report.

Magnifying glass icon
Click this button to view a more detailed report about the capacity of disks
in a cluster.

Cluster
Name of a cluster.

Note: For Storwize V7000 Unified or IBM SONAS clusters, the storage
system name is included with the cluster name in the Computer or Device
column. The format of the column is storagesystem_name: cluster_name,
where storagesystem_name is the name of the Storwize V7000 Unified or
IBM SONAS device that the cluster belongs to. For example,
subsystem-03.lab.austin.us.com: kq98n5d.acct displays storage system
subsystem-03.lab.austin.us.com that cluster kq98n5d.acct belongs to.

Disk Space (Total Capacity)
Total amount of unique disk storage space for the computers in a cluster.
Tivoli Storage Productivity Center does not include the following disks in
its calculation of the value in this column:
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Note:

v If the computer is an IBM SAN File System client, then this value will
also include the capacity of any storage system volumes visible to this
computers that are owned by the SAN File System.

v The drill-down reports for each computer generates a list of detectable
computer disks only. Therefore, the total capacity of disks for each
computer drill-down report will equal this value.

Available Disk Space (Total Unallocated Space)
Total amount of unique disk storage space for a computer that is not
allocated to any logical volume on the computer. Tivoli Storage
Productivity Center does not include the following disks in its calculation
of the value for this column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Note: If the computer is a SAN File System client, then this value does not
include the unallocated space on any storage system volumes visible to it
that are owned by the SAN File System.

Owned Disk Space (Capacity)
Total amount of unique disk storage space for computers in a cluster that
is owned by those computers. If Data Manager determines that a disk is
configured for a different host, that disk's capacity is not counted in this
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column. Tivoli Storage Productivity Center does not include the following
disks in its calculation of the value for this column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Note:

v If the computer is a SAN File System client, this value does not include
the capacity of any volumes that are visible to it that are owned by the
SAN File System.

v If the host is Solaris and Veritas Volume Manager (VxVM) is in use, the
product examines the Veritas disk-label and reads from the host ID. If
this does not agree with the local host ID, the disk is classified as
belonging to a different (Solaris) host.

Owned Available Disk Space (Owned Unallocated Space)
Total amount of unique disk storage space for computers in a cluster that
is not allocated to any logical volume within the computers and is owned
by the computers. If Data Manager determines that a disk is configured for
a different computer, that disk's unallocated space is not counted in this
column. Tivoli Storage Productivity Center does not include the following
disks in its calculation of the value for this column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

If the computer is a SAN File System client, then this value excludes the
unallocated space on any storage system volumes visible to it that are
owned by the SAN File System.

If the host is Solaris and Veritas Volume Manager (VxVM) is in use, the
product will examine the Veritas disk-label and read off the host-ID. If this
does not agree with the local host-ID, the disk is classified as belonging to
a different (Solaris) host.

Non-Fibre Channel Attached Disk Space (Total Other Attached Capacity)
Total amount of unique disk space on the computers in a cluster that is not
attached through a fibre channel port. Tivoli Storage Productivity Center
does not include the following disks in its calculation of the value for this
column:
v Computer disks that reside behind a fibre channel port.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Non-Fibre Channel Attached Available Disk Space (Total Other Attached
Unallocated Space)

Total amount of disk storage space on the computers in a cluster that is not
allocated to any logical volume within the computers and is not attached
through a fibre channel port. Tivoli Storage Productivity Center does not
include the following disks in its calculation of the value for this column:
v Computer disks that reside behind a fibre channel port.
v Computer disks on a computer that has not been probed.
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v Computer disks that become missing after a probe. Disks can become
undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Fibre Channel Attached Disk Space (Total Fibre Channel Attached Capacity)
Total amount of unique disk space on the computers in a cluster that is
attached through a fibre channel port. Tivoli Storage Productivity Center
does not include the following disks in its calculation of the value for this
column:
v Computer disks that do not reside behind a fibre channel port.
v Computer disks that reside behind a fibre channel port that is not

identified by a Storage Resource agent or Data agent.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Fibre Channel Attached Available Disk Space (Total Fibre Channel Attached
Unallocated Space)

Total amount of disk storage space on the computers in a cluster that is not
allocated to any logical volume within the computers and is attached
through a fibre channel port. Tivoli Storage Productivity Center does not
include the following disks in its calculation of the value for this column:
v Computer disks that do not reside behind a fibre channel port.
v Computer disks that reside behind a fibre channel port that is not

identified by a Storage Resource agent or Data agent.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

By Computer

Chart icon
Click this button to generate charts about the disk capacity of the
computers that are displayed in the report.

Magnifying glass icon
Click this button to view a more detailed report about the disks on a
computer.

Computer
Name of a computer.

Disk Space (Total Capacity)
Total amount of unique disk storage space for a computer. Tivoli Storage
Productivity Center does not include the following disks in its calculation
of the value for this column:
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Note:
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v The value that appears in the TOTAL row for this column does not
include disks on virtual machines where the Storage Resource agent or
Data agent is installed.

v If the computer is a SAN File System client, then this value will also
include the capacity of any storage system volumes visible to this
computers that are owned by the SAN File System.

v The drill-down reports for each computer generates a list of detectable
computer disks only. Therefore, the total capacity of disks for each
computer drill-down report will equal this value.

Available Disk Space (Total Unallocated Space)
Total amount of unique disk storage space for a computer that is not
allocated to any logical volume on the computer. Tivoli Storage
Productivity Center does not include the following disks from in its
calculation of the value in this column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Note: If the computer is a SAN File System client, then this value does not
include the unallocated space on any storage system volumes visible to it
that are owned by the SAN File System.

Owned Disk Space (Capacity)
Total amount of unique disk storage space for a computer that is owned by
that computer. If Data Manager determines that a disk is configured for a
different host, that disk's capacity is not counted in this column. Tivoli
Storage Productivity Center does not include the following disks in its
calculation of the value for this column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

If the computer is a SAN File System client, this value does not include the
capacity of any volumes that are visible to it that are owned by the SAN
File System.

If the host is Solaris and Veritas Volume Manager (VxVM) is in use, the
product examines the Veritas disk-label and reads from the host ID. If this
does not agree with the local host ID, the disk is classified as belonging to
a different (Solaris) host.

Owned Available Disk Space (Owned Unallocated Space)
Total amount of unique disk storage space for a computer that is not
allocated to any logical volume within the computer and is owned by the
computer. If Data Manager determines that a disk is configured for a
different computer, that disk's unallocated space is not counted in this
column. Tivoli Storage Productivity Center does not include the following
disks in its calculation of the value for this column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.
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Note:

v If the computer is a SAN File System client, then this value excludes the
unallocated space on any storage system volumes visible to it that are
owned by the SAN File System.

v If the host is Solaris and Veritas Volume Manager (VxVM) is in use, the
product will examine the Veritas disk-label and read off the host-ID. If
this does not agree with the local host-ID, the disk is classified as
belonging to a different (Solaris) host.

Non-Fibre Channel Attached Disk Space (Total Other Attached Capacity)
Total amount of unique disk space on a computer that is not attached
through a fibre channel port. Tivoli Storage Productivity Center does not
include the following disks in its calculation of the value for this column:
v Computer disks that reside behind a fibre channel port.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Non-Fibre Channel Attached Available Disk Space (Total Other Attached
Unallocated Space)

Total amount of disk storage space for a computer that is not allocated to
any logical volume within the computer and is not attached through a
fibre channel port. Tivoli Storage Productivity Center does not include the
following disks in its calculation of the value for this column:
v Computer disks that reside behind a fibre channel port.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Fibre Channel Attached Disk Space (Total Fibre Channel Attached Capacity)
Total amount of unique disk space on a computer that is attached through
a fibre channel port. Tivoli Storage Productivity Center does not include
the following disks in its calculation of the value for this column:
v Computer disks that do not reside behind a fibre channel port.
v Computer disks that reside behind a fibre channel port that is not

identified by a Storage Resource agent or Data agent.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Fibre Channel Attached Available Disk Space (Total Fibre Channel Attached
Unallocated Space)

Total amount of disk storage space on a computer that is not allocated to
any logical volume within the computer and is attached through a fibre
channel port. Tivoli Storage Productivity Center does not include the
following disks in its calculation of the value for this column:
v Computer disks that do not reside behind a fibre channel port.
v Computer disks that reside behind a fibre channel port that is not

identified by a Storage Resource agent or Data agent.
v Computer disks on a computer that has not been probed.
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v Computer disks that become missing after a probe. Disks can become
undetectable for a number of reasons, including a physical removal of
the disks from a computer.

OS Type
Operating system running on a computer.

Network Address
Network address of a computer.

IP Address
IP address of a computer.

Time Zone
Time zone in which a computer is running.

CPU Architecture
Architecture of the processor (for example, IA32).

By Computer Group

Chart icon
Click this button to generate charts about the disk capacity of computers in
the groups that are displayed in the report.

Magnifying glass icon
Click this button to view a more detailed report about the disk capacity of
computers in a group.

Creator
Creator of a computer monitoring group or computer reporting group.

Group
Name of a group.

Disk Space (Total Capacity)
Total amount of unique disk storage space for the computers in a group.
Tivoli Storage Productivity Center does not include the following disks in
its calculation of the value for this column:
v Computer disks that are on a virtual machine monitored by Tivoli

Storage Productivity Center.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Available Disk Space (Total Unallocated Space)
Total amount of unique disk storage space for computers in a group that is
not allocated to any logical volume on the computers. Tivoli Storage
Productivity Center does not include the following disks in its calculation
of the value for this column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Note: If the computer is a SAN File System client, then this value does not
include the unallocated space on any storage system volumes visible to it
that are owned by the SAN File System.
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Owned Disk Space (Capacity)
Total amount of unique disk storage space for computers in a group that is
owned by those computers. If Data Manager determines that a disk is
configured for a different host, that disk's capacity is not counted in this
column. Tivoli Storage Productivity Center does not include the following
disks in its calculation of the value for this column:
v Computer disks on a cluster of virtual machines that is monitored by

Tivoli Storage Productivity Center.
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Note:

v If the computer is a SAN File System client, this value does not include
the capacity of any volumes that are visible to it that are owned by the
SAN File System.

v If the host is Solaris and Veritas Volume Manager (VxVM) is in use, the
product examines the Veritas disk-label and reads from the host ID. If
this does not agree with the local host ID, the disk is classified as
belonging to a different (Solaris) host.

Owned Available Disk Space (Owned Unallocated Space)
Total amount of unique disk storage space for the computers in a group
that is not allocated to any logical volume within the computer group and
is owned by a computer within the group. If Data Manager determines
that a disk is configured for a different computer, that disk's unallocated
space is not counted in this column. Tivoli Storage Productivity Center
does not include the following disks in its calculation of the value for this
column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Note:

v If the computer is a SAN File System client, then this value excludes the
unallocated space on any storage system volumes visible to it that are
owned by the SAN File System.

v If the host is Solaris and Veritas Volume Manager (VxVM) is in use, the
product will examine the Veritas disk-label and read off the host-ID. If
this does not agree with the local host-ID, the disk is classified as
belonging to a different (Solaris) host.

Non-Fibre Channel Attached Disk Space (Total Other Attached Capacity)
Total amount of unique disk space on the computers in a group and is not
attached through a fibre channel port. Tivoli Storage Productivity Center
does not include the following disks in its calculation of the value for this
column:
v Computer disks that reside behind a fibre channel port.
v Computer disks discovered on virtual machine servers where the

Storage Resource agent or Data agent is installed.
v Computer disks on a computer that has not been probed.
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v Computer disks that become missing after a probe. Disks can become
undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Non-Fibre Channel Attached Available Disk Space (Total Other Attached
Unallocated Space)

Total amount of disk storage space on the computers in a group that is not
allocated to any logical volume within the computers and is not attached
through a fibre channel port. Tivoli Storage Productivity Center does not
include the following disks in its calculation of the value for this column:
v Computer disks that reside behind a fibre channel port.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Fibre Channel Attached Disk Space (Total Fibre Channel Attached Capacity)
Total amount of unique disk space on the computers in a group that is
attached through a fibre channel port. Tivoli Storage Productivity Center
does not include the following disks in its calculation of the value for this
column:
v Computer disks that do not reside behind a fibre channel port.
v Computer disks that reside behind a fibre channel port that is not

identified by a Storage Resource agent or Data agent.
v Computer disks discovered on virtual machine servers where the

Storage Resource agent or Data agent is installed.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Fibre Channel Attached Available Disk Space (Total Fibre Channel Attached
Unallocated Space)

Total amount of disk storage space on the computers in a group that is not
allocated to any logical volume within the computers and is attached
through a fibre channel port. Tivoli Storage Productivity Center does not
include the following disks in its calculation of the value for this column:
v Computer disks that do not reside behind a fibre channel port.
v Computer disks that reside behind a fibre channel port that is not

identified by a Storage Resource agent or Data agent.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

By Domain

Chart icon
Click this button to generate charts about the disk capacity of the
computers in a domain.

Magnifying glass icon
Click this button to view a more detailed report about the disk capacity of
computers in a domain.
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Domain
Name of a domain.

Disk Space (Capacity)
Total amount of unique disk storage space for the computers in a domain.
Tivoli Storage Productivity Center does not include the following disks in
its calculation of the value for this column:
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Available Disk Space (Unallocated Space)
Total amount of unique disk storage space for computers in a domain that
is not allocated to any logical volume on the computers. Tivoli Storage
Productivity Center does not include the following disks in its calculation
of the value for this column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Network-wide

Chart icon
Click this button to generate charts about the disk capacity across a
network.

Magnifying glass icon
Click this button to view a more detailed report about the disk capacity of
computers in a network.

Disk Space (Capacity)
Total amount of internal physical disk space on monitored storage system
arrays and disk space on monitored systems that are not storage system
volumes. Tivoli Storage Productivity Center does not include the following
capacity information in its calculation of the value for this column:
v Storage system disks or computer disks that become missing after a

probe.
v Back-end storage volumes that are not identified by Tivoli Storage

Productivity Center as being assigned to a monitored storage system
virtualizer.

v Computer disks that are identified by Tivoli Storage Productivity Center
as being assigned to a monitored storage system.

v Computer disks that reside within a virtual machine server where the
Storage Resource agent or Data agent is installed.

Consumed File System Space (Filesystem Used Space)
Total amount of unique file system storage space that is used or consumed
by the systems where the Storage Resource agent or Data agent is installed.
Tivoli Storage Productivity Center does not include the following file
systems in its calculation of the value for this column:
v File systems that become missing after a probe.
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v File systems on discovered hypervisors that are assigned to discovered
virtual machines where the Storage Resource agent or Data agent is
installed.

v File systems on discovered virtual machines where the Storage Resource
agent or Data agent is installed, but the hypervisor for the virtual
machine has not been discovered and the total used space exceeds the
capacity of the total file system capacity.

v File systems that are mounted remotely and are not identified to a
network attached storage server.

v File systems that are not mounted.

Available File System Space (Filesystem Free Space)
Total amount of unique file system storage space that is not used or
available to the systems where the Storage Resource agent or Data agent is
installed. Tivoli Storage Productivity Center does not include the following
file systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Raw Volume Space
Total amount of storage system volume space that is the following:
v Assigned or mapped to hosts.
v Storage system volume space on a system that it is monitored by Tivoli

Storage Productivity Center.
v Logical volume space on hosts that do not reside within a storage

system monitored by Tivoli Storage Productivity Center.

Unavailable Disk Space (Overhead)
Total amount of storage system volume space that is identified as the
following:
v For RAID or mirror redundancy on a storage system.
v As storage system volume space used for replication targets.
v As logical volume space on hosts that is for RAID or mirror redundancy

on those hosts.

Available Disk Space (Unallocated Space)
Total amount of disk space that does not include the following from the
network capacity:
v Network Raw Volume Space
v Network Overhead
v Network Unknown Volume Space

Unknown Storage Subsystem Volume Space (Unknown LUN Capacity)
Total amount of storage system volume space that is not mapped or
assigned to a host and is not identified as residing on a host that has been
probed by a Storage Resource agent or Data agent.

TPC-Wide Storage Space - File System Space report:

Use these reports to view detailed information about the storage capacity of file
systems on machines in your environment. You can view this information in
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different ways using the following By clauses: by filesystem, by filesystem group,
by cluster, by computer, by computer group, by domain, and for the entire
network.

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

By Filesystem

Chart icon
Click this button to generate charts about the storage space for a file
system.

Computer
Name of the computer on which a file system resides.

Mount Point
Name or mount point (UNIX/Linux) of the file system (for example, c:\,
d;\, /opt, /export/home, etc.). The file systems displayed in this report
include the following:
v File systems on virtual machines that are monitored by IBM Tivoli

Storage Productivity Center.
v File systems on hypervisors that are monitored by Tivoli Storage

Productivity Center.
v File systems that become missing after a probe.

File System Space (Capacity)
Amount of file system storage space for a file system.

Note:

v The value that appears in the TOTAL row for this column does not
include file systems on virtual machines where the Storage Resource
agent or Data agent is installed.

v The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space
reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value
in the Capacity field is greater than or equal to the value of Used Space
+ Free Space, the difference representing the space wasted due to the
system overhead.

Detectable
Indicates Yes when a file system is identified as being available to the
server following a successful probe.

Percent Used Space
Percentage of file system storage space that is used within a file system.

Consumed File System Space (Used Space)
Amount of used storage space within a file system. On some UNIX file
systems, this value does not include storage space reserved by the
operating system (overhead). Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
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v File systems that are mounted remotely and are not identified to a
network attached storage server.

v File systems that are not mounted.

The value that appears in the TOTAL row for this column represents the
difference between the TOTAL values in the File System Space and
Available File System Space columns. If the calculated value for the
TOTAL row is negative, the column displays 0.

The TOTAL row does not add the used space coming from VMWare
computers. See the VMWare capacity reports topic in the Planning chapter of
the Tivoli Storage Productivity Center Installation and Configuration Guide for
information about how file system and disk capacity are calculated in this
report for VMWare computers. This topic is also available in the Planning
section of the Tivoli Storage Productivity Center Information Center.

The value that appears in the TOTAL row for this column does not
include the following file systems:
v File systems on discovered hypervisors that are assigned to virtual

machine servers where the Storage Resource agent or Data agent has
been installed.

v File systems on discovered virtual machine servers where the Storage
Resource agent or Data agent is installed, but the hypervisor for the
virtual machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

Available File System Space (Free Space)
Amount of unused storage space within a file system.

File Count
Total number of files within a file system. This value does not include files
on file systems that have not been scanned.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, Tivoli Storage
Productivity Center calculates both the number of files and the number of
directories for the value in this column. For example, if a Windows
computer contains 150 files and 50 directories, the number in the File
Count column is 200.

Directory Count
Total number of directories within a file system. This value does not
include directories on file systems that have not been scanned.

Percent Used Inodes
Percentage of used Inodes within a file system.

Used Inodes
Number of used Inodes within a file system.

Free Inodes
Number of free Inodes within a file system.

Volume Group
Volume group to which a logical volume belongs. If the volume is not part
of a volume group this column displays N/A.

Logical Volume Space (Logical Volume Allocation)
Logical volume space used by the logical volume containing the file
system.
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Disk Detectable
Indicates Yes when a file system's logical volume is identified as having an
underlying host disk.

By Filesystem Group

Chart icon
Click this button to generate charts about the capacity of file systems in file
system monitoring groups or file system reporting groups.

Magnifying glass icon
Click this button to view more detailed information about the capacity of
file systems in a file system monitoring group or file system reporting
group.

Creator
ID of the user who created a group.

Group Name of a file system monitoring group or file system reporting group.

File System Space (Capacity)
Amount of file system storage space for the file systems in a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on virtual machines where the Storage Resource agent or

Data agent is installed.
v File systems that become missing after a probe.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

Percent Used Space
Percentage of total file system storage space that is used within a group.

Consumed File System Space (Used Space)
Total amount of used file system storage space within a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on hypervisors that are assigned to virtual machine servers

where the Storage Resource agent or Data agent is installed if both the
virtual machine file systems and hypervisor file systems reside within
the group.

v File systems on virtual machine servers where the Storage Resource
agent or Data agents are deployed, but the hypervisor for the virtual
machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

v File systems on virtual machine servers that are in a group without the
underlying hypervisor file systems, and the total used space exceeds the
capacity of the total file system capacity.

v File systems that become missing after a probe.
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v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available within a group. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are not mounted.

File Count
Total number of files within a group. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, Tivoli Storage
Productivity Center calculates both the number of files and the number of
directories for the value in this column. For example, if a Windows
computer contains 150 files and 50 directories, the number in the File
Count column is 200.

Directory Count
Total number of directories within a group. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a group.

Used Inodes
Number of used Inodes within a group.

Free Inodes
Number of free Inodes within a group.

By Cluster

Chart icon
Click this button to generate charts about the used file system space for a
cluster.

Magnifying glass icon
Click this button to view more detailed information about the used storage
space on file systems that are in a cluster.
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Cluster
Name of cluster.

File System Space (Capacity)
Total amount of unique file system storage space in a cluster. Tivoli Storage
Productivity Center does not include the following file systems in its
calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

Percent Used Space
Percentage of total file system storage space that is used within a cluster.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the file systems in a cluster. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available in a cluster. Tivoli Storage Productivity Center does not include
the following file systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

File Count
Total number of files within a cluster. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by an agent.

When monitoring computers where the Windows operating system is
installed, the number of files indicated in this column might be lower than
the number of files reported by the operating system.
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Directory Count
Total number of directories within a cluster. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by an agent.

When monitoring computers where the Windows operating system is
installed, the number of folders indicated in this column might be higher
than the number of folders that is reported by the operating system.

Percent Used Inodes
Percentage of used Inodes within a cluster.

Used Inodes
Number of used Inodes within a cluster.

Free Inodes
Number of free Inodes within a cluster.

By Computer

Chart icon
Click this button to generate a chart about the used file system storage
space of the computers that are displayed in the report.

Magnifying glass icon
Click this button to view a more detailed report about the used file system
storage space on a computer.

File System Space (Capacity)
Total amount of unique file system storage space that was discovered on
the computer where the Storage Resource agent or Data agent is installed.
Tivoli Storage Productivity Center does not include the following file
systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note:

v The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space
reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value
in the Capacity field is greater than or equal to the value of Used Space
+ Free Space, the difference representing the space wasted due to the
system overhead.

v The value that appears in the TOTAL row for this column does not
include file systems on virtual machines where the Storage Resource
agent or Data agent is installed.

v The drill-down reports for each computer will generate a list of
detectable file systems only. Therefore, the total capacity of file systems
for each computer drill-down report will equal this value.
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Percent Used Space
Percentage of total file system storage space that is used within a
computer.

Consumed File System Space (Used Space)
Amount of unique file system storage space that is used or consumed by
the computer where the Storage Resource agent or Data agent is installed.
On some UNIX file systems, this value does not include storage space
reserved by the operating system (overhead). Tivoli Storage Productivity
Center does not include the following file systems in its calculation of the
value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

The value that appears in the TOTAL row for this column represents the
difference between the TOTAL values in the File System Space and
Available File System Space columns. If the calculated value for the
TOTAL row is negative, the column displays 0.

The TOTAL row does not add the used space coming from VMWare
computers. See the VMWare capacity reports topic in the Planning chapter of
the Tivoli Storage Productivity Center Installation and Configuration Guide for
information about how file system and disk capacity are calculated in this
report for VMWare computers. This topic is also available in the Planning
section of the Tivoli Storage Productivity Center Information Center.

The value that appears in the TOTAL row for this column does not
include the following file systems:
v File systems on discovered hypervisors that are assigned to virtual

machine servers where the Storage Resource agent or Data agent has
been installed.

v File systems on discovered virtual machine servers where the Storage
Resource agent or Data agent is installed, but the hypervisor for the
virtual machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available to a computer. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

File Count
Total number of files within a computer. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.
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Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, Tivoli Storage
Productivity Center calculates both the number of files and the number of
directories for the value in this column. For example, if a Windows
computer contains 150 files and 50 directories, the number in the File
Count column is 200.

Directory Count
Total number of directories within a computer. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a computer.

Used Inodes
Number of used Inodes within a computer.

Free Inodes
Number of free Inodes within a computer.

By Computer Group

Chart icon
Click this button to generate charts about the used file system storage
space for a computer monitoring group or computer reporting group.

Magnifying glass icon
Click this button to view more detailed information about the file systems
in a computer monitoring group or computer reporting group.

Creator
ID of the user who created a group.

Group Name of a computer monitoring group or computer reporting group.

File System Space (Capacity)
Amount of file system storage space for the computers in a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on virtual machines where the Storage Resource agent or

Data agent is installed.
v File systems that become missing after a probe.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.
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Percent Used Space
Percentage of total file system storage space that is used within a group.

Consumed File System Space (Used Space)
Total amount of used file system storage space within a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on hypervisors that are assigned to virtual machine servers

where the Storage Resource agent or Data agent is installed if both the
virtual machine file systems and hypervisor file systems reside within
the group.

v File systems on virtual machine servers where the Storage Resource
agent or Data agent is installed, but the hypervisor for the virtual
machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

v File systems on virtual machine servers that are in a group without the
underlying hypervisor file systems, and the total used space exceeds the
capacity of the total file system capacity.

v File systems that become missing after a probe.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available within a group. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are not mounted.

File Count
Total number of files within a group. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: For groups that contain Windows computers, AIX systems, and
systems using IBM General Parallel File System (GPFS) for file
management, Tivoli Storage Productivity Center calculates both the
number of files and the number of directories for the value in this column.
For example, if a Windows computer contains 150 files and 50 directories,
the number in the File Count column is 200.

Directory Count
Total number of directories within a group. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
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v Directories on file systems that have not been scanned by a Storage
Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a group.

Used Inodes
Number of used Inodes within a group.

Free Inodes
Number of free Inodes within a group.

By Domain

Chart icon
Click this button to generate charts about the file system used space for a
domain.

Magnifying glass icon
Click this button to view more detailed information about the file system
used space of computers that are in a domain.

Domain
Name of a domain.

File System Space (Capacity)
Total amount of unique file system storage space that was discovered on
the computers within a domain. Tivoli Storage Productivity Center does
not include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

Percent Used Space
Percentage of total file system storage space that is used within a domain.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the computers within a domain. Tivoli Storage Productivity Center does
not include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

Chapter 8. Reporting in the stand-alone GUI 893



Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available to the computers within a domain. Tivoli Storage Productivity
Center does not include the following file systems in its calculation of the
value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server
v File systems that are not mounted.

File Count
Total number of files within a domain. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, Tivoli Storage
Productivity Center calculates both the number of files and the number of
directories for the value in this column. For example, if a Windows
computer contains 150 files and 50 directories, the number in the File
Count column is 200.

Directory Count
Total number of directories within a domain. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a domain.

Used Inodes
Number of used Inodes within a domain.

Free Inodes
Number of free Inodes within a domain.

Network-wide

Chart icon
Click this button to generate a chart about the file system used space in a
network.

Magnifying glass icon
Click this button to view more detailed information about the file system
used space in a network.

File System Space (Capacity)
Total amount of unique file system storage space that was discovered on
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the computers within a network. Tivoli Storage Productivity Center does
not include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agent or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

Percent Used Space
Percentage of total file system storage space that is used within a network.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the computers within a network. Tivoli Storage Productivity Center
does not include the following file systems in its calculation of the value
for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available to the computers within a network. Tivoli Storage Productivity
Center does not include the following file systems in its calculation of the
value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server
v File systems that are not mounted.

File Count
Total number of files within a network. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, Tivoli Storage
Productivity Center calculates both the number of files and the number of
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directories for the value in this column. For example, if a Windows
computer contains 150 files and 50 directories, the number in the File
Count column is 200.

Directory Count
Total number of directories within a network. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a network.

Used Inodes
Number of used Inodes within a network.

Free Inodes
Number of free Inodes within a network.

TPC-Wide Storage Space - Consumed File System Space report:

Use these reports to view detailed information about the used storage space in file
systems on computers in your environment. You can view this information in
different ways using the following By clauses: by filesystem, by filesystem group,
by cluster, by computer, by computer group, by domain, and for the entire
network.

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

By Filesystem

Chart icon
Click this button to generate charts about the used space information for a
file system.

Computer
Name of the computer on which a file system resides.

Mount Point
Name or mount point (UNIX/Linux) of the file system (for example, c:\,
d;\, /opt, /export/home, etc.). The file systems displayed in this report
include the following:
v File systems on virtual machines that are monitored by IBM Tivoli

Storage Productivity Center.
v File systems on hypervisors that are monitored by Tivoli Storage

Productivity Center.
v File systems that become missing after a probe.

Consumed File System Space (Used Space)
Amount of used storage space within a file system. On some UNIX file
systems, this value does not include storage space reserved by the
operating system (overhead).
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The value that appears in the TOTAL row for this column does not
include the following file systems:
v File systems on discovered hypervisors that are assigned to virtual

machine servers where the Storage Resource agent or Data agent has
been installed.

v File systems on discovered virtual machine servers where the Storage
Resource agent or Data agent is installed, but the hypervisor for the
virtual machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

Detectable
Indicates Yes when a file system is identified as being available to the
server following a successful probe.

Percent Used Space
Percentage of file system storage space that is used within a file system.

Available File System Space (Free Space)
Amount of unused storage space within a file system.

File System Space (Capacity)
Amount of file system storage space for a file system.

Note:

v The value that appears in the TOTAL row for this column does not
include file systems on virtual machines where the Storage Resource
agent or Data agent is installed.

v The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space
reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value
in the Capacity field is greater than or equal to the value of Used Space
+ Free Space, the difference representing the space wasted due to the
system overhead.

File Count
Total number of files within a file system. This value does not include files
on file systems that have not been scanned.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, IBM Tivoli
Storage Productivity Center calculates both the number of files and the
number of directories for the value in this column. For example, if a
Windows computer contains 150 files and 50 directories, the number in the
File Count column is 200.

Directory Count
Total number of directories within a file system. This value does not
include directories on file systems that have not been scanned.

Percent Used Inodes
Percentage of used Inodes within a file system.

Used Inodes
Number of used Inodes within a file system.

Free Inodes
Number of free Inodes within a file system.
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Volume Group
Volume group to which a logical volume belongs. If the volume is not part
of a volume group this column displays N/A.

Logical Volume Space (Allocation)
Logical volume space used by the logical volume containing the file
system.

Disk Detectable
Indicates Yes when a file system's logical volume is identified as having an
underlying host disk.

By Filesystem Group

Chart icon
Click this button to generate charts about the used file system storage
space in a file system monitoring group or file system reporting group.

Magnifying glass icon
Click this button to view more detailed information about the used file
system storage space in a file system monitoring group or file system
reporting group.

Creator
ID of the user who created a group.

Group Name of a file system monitoring group or file system reporting group.

Consumed File System Space (Used Space)
Total amount of used file system storage space within a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on hypervisors that are assigned to virtual machine servers

where the Storage Resource agent or Data agent is installed if both the
virtual machine file systems and hypervisor file systems reside within
the group.

v File systems on virtual machine servers where the Storage Resource
agent or Data agent is installed, but the hypervisor for the virtual
machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

v File systems on virtual machine servers that are in a group without the
underlying hypervisor file systems, and the total used space exceeds the
capacity of the total file system capacity.

v File systems that become missing after a probe.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

Percent Used Space
Percentage of total file system storage space that is used within a group.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available within a group. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
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v File systems that are not mounted.

File System Space (Capacity)
Amount of file system storage space for the file systems in a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on virtual machines where the Storage Resource agent or

Data agent is installed.
v File systems that become missing after a probe.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

File Count
Total number of files within a group. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, IBM Tivoli
Storage Productivity Center calculates both the number of files and the
number of directories for the value in this column. For example, if a
Windows computer contains 150 files and 50 directories, the number in the
File Count column is 200.

Directory Count
Total number of directories within a group. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a group.

Used Inodes
Number of used Inodes within a group.

Free Inodes
Number of free Inodes within a group.
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By Cluster

Chart icon
Click this button to generate charts about the used file system space for a
cluster.

Magnifying glass icon
Click this button to view more detailed information about the used storage
space on file systems that are in a cluster.

Cluster
Name of cluster.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the file systems in a cluster. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

Percent Used Space
Percentage of total file system storage space that is used within a cluster.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available in a cluster. Tivoli Storage Productivity Center does not include
the following file systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

File System Space (Capacity)
Total amount of unique file system storage space in a cluster. Tivoli Storage
Productivity Center does not include the following file systems in its
calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.
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File Count
Total number of files within a cluster. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

When monitoring computers where the Windows operating system is
installed, the number of files indicated in this column might be lower than
the number of files reported by the operating system.

Directory Count
Total number of directories within a cluster. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

When monitoring computers where the Windows operating system is
installed, the number of folders indicated in this column might be higher
than the number of folders that is reported by the operating system.

Percent Used Inodes
Percentage of used Inodes within a cluster.

Used Inodes
Number of used Inodes within a cluster.

Free Inodes
Number of free Inodes within a cluster.

By Computer

Chart icon
Click this button to generate charts about the used file system storage
space of the computers that are displayed in the report.

Magnifying glass icon
Click this button to view a more detailed report about the used file system
storage space on a computer.

Computer
Name of the computer on which a file system resides.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the computer where the Storage Resource agent or Data agent is
installed. Tivoli Storage Productivity Center does not include the following
file systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.
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Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

Percent Used Space
Percentage of total file system storage space that is used within a
computer.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available to a computer. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

File System Space (Capacity)
Total amount of unique file system storage space that was discovered on
the computer where the Storage Resource agent or Data agent is installed.
Tivoli Storage Productivity Center does not include the following file
systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note:

v The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space
reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value
in the Capacity field is greater than or equal to the value of Used Space
+ Free Space, the difference representing the space wasted due to the
system overhead.

v The value that appears in the TOTAL row for this column does not
include file systems on virtual machines where the Storage Resource
agent or Data agent is installed.

v The drill-down reports for each computer will generate a list of
detectable file systems only. Therefore, the total capacity of file systems
for each computer drill-down report will equal this value.

File Count
Total number of files within a computer. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, IBM Tivoli
Storage Productivity Center calculates both the number of files and the

902 IBM Tivoli Storage Productivity Center: User's Guide



number of directories for the value in this column. For example, if a
Windows computer contains 150 files and 50 directories, the number in the
File Count column is 200.

Directory Count
Total number of directories within a computer. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a computer.

Used Inodes
Number of used Inodes within a computer.

Free Inodes
Number of free Inodes within a computer.

By Computer Group

Chart icon
Click this button to generate charts about the used file system storage
space for a computer monitoring group or computer reporting group.

Magnifying glass icon
Click this button to view more detailed information about the file systems
in a computer monitoring group or computer reporting group.

Creator
ID of the user who created a group.

Group Name of a computer monitoring group or computer reporting group.

Consumed File System Space (Used Space)
Total amount of used file system storage space within a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on hypervisors that are assigned to virtual machine servers

where the Storage Resource agent or Data agent is installed if both the
virtual machine file systems and hypervisor file systems reside within
the group.

v File systems on virtual machine servers where the Storage Resource
agent or Data agent is installed, but the hypervisor for the virtual
machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

v File systems on virtual machine servers that are in a group without the
underlying hypervisor file systems, and the total used space exceeds the
capacity of the total file system capacity.

v File systems that become missing after a probe.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).
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Percent Used Space
Percentage of total file system storage space that is used within a group.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available within a group. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are not mounted.

File System Space (Capacity)
Amount of file system storage space for the computers in a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on virtual machines where the Storage Resource agent or

Data agent is installed.
v File systems that become missing after a probe.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

File Count
Total number of files within a group. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: For groups that contain Windows computers, AIX systems, and
systems using IBM General Parallel File System (GPFS) for file
management, IBM Tivoli Storage Productivity Center calculates both the
number of files and the number of directories for the value in this column.
For example, if a Windows computer contains 150 files and 50 directories,
the number in the File Count column is 200.

Directory Count
Total number of directories within a group. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a group.

904 IBM Tivoli Storage Productivity Center: User's Guide



Used Inodes
Number of used Inodes within a group.

Free Inodes
Number of free Inodes within a group.

By Domain

Chart icon
Click this button to generate charts about the file system used space for a
domain.

Magnifying glass icon
Click this button to view more detailed information about the file system
used space of computers that are in a domain.

Consumed File System Space (Domain)
Name of a domain.

Used Space
Total amount of unique file system storage space that is used or consumed
by the computers within a domain. Tivoli Storage Productivity Center does
not include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

Percent Used Space
Percentage of total file system storage space that is used within a domain.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available to the computers within a domain. Tivoli Storage Productivity
Center does not include the following file systems in its calculation of the
value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server
v File systems that are not mounted.

File System Space (Capacity)
Total amount of unique file system storage space that was discovered on
the computers within a domain. Tivoli Storage Productivity Center does
not include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Chapter 8. Reporting in the stand-alone GUI 905



Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

File Count
Total number of files within a domain. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, IBM Tivoli
Storage Productivity Center calculates both the number of files and the
number of directories for the value in this column. For example, if a
Windows computer contains 150 files and 50 directories, the number in the
File Count column is 200.

Directory Count
Total number of directories within a domain. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a domain.

Used Inodes
Number of used Inodes within a domain.

Free Inodes
Number of free Inodes within a domain.

Network-wide

Chart icon
Click this button to generate charts about the file system used space in a
network.

Magnifying glass icon
Click this button to view more detailed information about the file system
used space in a network.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the computers within a network. Tivoli Storage Productivity Center
does not include the following file systems in its calculation of the value
for this column:
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v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

Percent Used Space
Percentage of total file system storage space that is used within a network.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available to the computers within a network. Tivoli Storage Productivity
Center does not include the following file systems in its calculation of the
value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server
v File systems that are not mounted.

File System Space (Capacity)
Total amount of unique file system storage space that was discovered on
the computers within a network. Tivoli Storage Productivity Center does
not include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

File Count
Total number of files within a network. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, IBM Tivoli
Storage Productivity Center calculates both the number of files and the
number of directories for the value in this column. For example, if a
Windows computer contains 150 files and 50 directories, the number in the
File Count column is 200.
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Directory Count
Total number of directories within a network. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a network.

Used Inodes
Number of used Inodes within a network.

Free Inodes
Number of free Inodes within a network.

TPC-Wide Storage Space - Available File System Space report:

Use these reports to view detailed information about the available storage space in
file systems on systems in your environment. You can view this information in
different ways using the following By clauses: by filesystem, by filesystem group,
by cluster, by computer, by computer group, by domain, and for the entire
network.

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

By Filesystem

Chart icon
Click this button to generate a chart about the used space information for a
file system.

Computer
Name of the computer on which a file system resides.

Mount Point
Name or mount point (UNIX/Linux) of a file system (for example, c:\, d;\,
/opt, /export/home, etc.). The file systems displayed in this report include
the following:
v File systems on virtual machines that are monitored by IBM Tivoli

Storage Productivity Center.
v File systems on hypervisors that are monitored by Tivoli Storage

Productivity Center.
v File systems that become missing after a probe.

Available File System Space (Free Space)
Amount of unused storage space within a file system.

Detectable
Indicates Yes when a file system is identified as being available to the
server following a successful probe.

Percent Available File System Space (Percent Free Space)
Percentage of file system storage space that is unused within a file system.
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Consumed File System Space (Used Space)
Amount of used storage space within a file system. On some UNIX file
systems, this value does not include storage space reserved by the
operating system (overhead).

The value that appears in the TOTAL row for this column does not
include the following file systems:
v File systems on discovered hypervisors that are assigned to virtual

machine servers where the Storage Resource agent or Data agent has
been installed.

v File systems on discovered virtual machine servers where the Storage
Resource agent or Data agent is installed, but the hypervisor for the
virtual machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

File System Space (Capacity)
Amount of file system storage space for a file system.

Note:

v The value that appears in the TOTAL row for this column does not
include file systems on virtual machines where the Storage Resource
agent or Data agent is installed.

v The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space
reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value
in the Capacity field is greater than or equal to the value of Used Space
+ Free Space, the difference representing the space wasted due to the
system overhead.

File Count
Total number of files within a file system. This value does not include files
on file systems that have not been scanned.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, IBM Tivoli
Storage Productivity Center calculates both the number of files and the
number of directories for the value in this column. For example, if a
Windows computer contains 150 files and 50 directories, the number in the
File Count column is 200.

Directory Count
Total number of directories within a file system. This value does not
include directories on file systems that have not been scanned.

Percent Used Inodes
Percentage of used Inodes within a file system.

Used Inodes
Number of used Inodes within a file system.

Free Inodes
Number of free Inodes within a file system.

Volume Group
Volume group to which a logical volume belongs. If the volume is not part
of a volume group this column displays N/A.
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Logical Volume Space (Allocation)
Logical volume space used by the logical volume containing the file
system.

Disk Detectable
Indicates Yes when a file system's logical volume is identified as having an
underlying host disk.

By Filesystem Group

Chart icon
Click this button to generate charts about the used file system storage
space in a file system monitoring group or file system reporting group.

Magnifying glass icon
Click this button to view more detailed information about the used file
system storage space in a file system monitoring group or file system
reporting group.

Creator
ID of the user who created a group.

Group Name of a file system monitoring group or file system reporting group.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available within a group. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are not mounted.

Percent Available File System Space (Percent Free Space)
Percentage of total file system storage space that is not used or available
within a group.

Consumed File System Space (Used Space)
Total amount of used file system storage space within a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on hypervisors that are assigned to virtual machine servers

where the Storage Resource agent or Data agent is installed if both the
virtual machine file systems and hypervisor file systems reside within
the group.

v File systems on virtual machine servers where the Data agents installed,
but the hypervisor for the virtual machine servers has not been
discovered and the total used space exceeds the capacity of the total file
system capacity.

v File systems on virtual machine servers that are in a group without the
underlying hypervisor file systems, and the total used space exceeds the
capacity of the total file system capacity.

v File systems that become missing after a probe.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).
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File System Space (Capacity)
Amount of file system storage space for the file systems in a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on virtual machines where the Storage Resource agent or

Data agent is installed.
v File systems that become missing after a probe.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

File Count
Total number of files within a group. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, IBM Tivoli
Storage Productivity Center calculates both the number of files and the
number of directories for the value in this column. For example, if a
Windows computer contains 150 files and 50 directories, the number in the
File Count column is 200.

Directory Count
Total number of directories within a group. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a group.

Used Inodes
Number of used Inodes within a group.

Free Inodes
Number of free Inodes within a group.

By Cluster

Chart icon
Click this button to generate a chart about the used file system space for a
cluster.
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Magnifying glass icon
Click this button to view more detailed information about the used storage
space on file systems that are in a cluster.

Cluster
Name of cluster.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available in a cluster. Tivoli Storage Productivity Center does not include
the following file systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Percent Available File System Space (Percent Free Space)
Percentage of total file system storage space that is available within a
cluster.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the file systems in a cluster. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

File System Space (Capacity)
Total amount of unique file system storage space in a cluster. Tivoli Storage
Productivity Center does not include the following file systems in its
calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

File Count
Total number of files within a cluster. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
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v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by an agent.

When monitoring computers where the Windows operating system is
installed, the number of files indicated in this column might be lower than
the number of files reported by the operating system.

Directory Count
Total number of directories within a cluster. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by an agent.

When monitoring computers where the Windows operating system is
installed, the number of folders indicated in this column might be higher
than the number of folders that is reported by the operating system.

Percent Used Inodes
Percentage of used Inodes within a cluster.

Used Inodes
Number of used Inodes within a cluster.

Free Inodes
Number of free Inodes within a cluster.

By Computer

Chart icon
Click this button to generate a chart about the used file system storage
space of the computers that are displayed in the report.

Magnifying glass icon
Click this button to view a more detailed report about the used file system
storage space on a computer.

Computer
Name of the computer on which a file system resides.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available to a computer. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Percent Available File System Space (Percent Free Space)
Percentage of total file system storage space that is available within a
computer.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the computer where the Storage Resource agent or Data agent is
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installed. Tivoli Storage Productivity Center does not include the following
file systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

File System Space (Capacity)
Total amount of unique file system storage space that was discovered on
the computer where the Storage Resource agent or Data agent is installed.
Tivoli Storage Productivity Center does not include the following file
systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note:

v The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space
reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value
in the Capacity field is greater than or equal to the value of Used Space
+ Free Space, the difference representing the space wasted due to the
system overhead.

v The value that appears in the TOTAL row for this column does not
include file systems on virtual machines where the Storage Resource
agent or Data agent is installed.

v The drill-down reports for each computer will generate a list of
detectable file systems only. Therefore, the total capacity of file systems
for each computer drill-down report will equal this value.

File Count
Total number of files within a computer. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, IBM Tivoli
Storage Productivity Center calculates both the number of files and the
number of directories for the value in this column. For example, if a
Windows computer contains 150 files and 50 directories, the number in the
File Count column is 200.
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Directory Count
Total number of directories within a computer. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a computer.

Used Inodes
Number of used Inodes within a computer.

Free Inodes
Number of free Inodes within a computer.

By Computer Group

Chart icon
Click this button to generate charts about the used file system storage
space for a computer monitoring group or computer reporting group.

Magnifying glass icon
Click this button to view more detailed information about the file systems
in a computer monitoring group or computer reporting group.

Creator
ID of the user who created a group.

Group Name of a computer monitoring group or computer reporting group.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available within a group. Tivoli Storage Productivity Center does not
include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are not mounted.

Percent Available File System Space (Percent Free Space)
Percentage of total file system storage space that is available within a
group.

Consumed File System Space (Used Space)
Total amount of used file system storage space within a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on hypervisors that are assigned to virtual machine servers

where the Storage Resource agent or Data agent is installed if both the
virtual machine file systems and hypervisor file systems reside within
the group.

v File systems on virtual machine servers where the Storage Resource
agent or Data agent is installed, but the hypervisor for the virtual
machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.
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v File systems on virtual machine servers that are in a group without the
underlying hypervisor file systems, and the total used space exceeds the
capacity of the total file system capacity.

v File systems that become missing after a probe.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

File System Space (Capacity)
Amount of file system storage space for the computers in a group. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems on virtual machines where the Storage Resource agent or

Data agent is installed.
v File systems that become missing after a probe.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

File Count
Total number of files within a group. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: For groups that contain Windows computers, AIX systems, and
systems using IBM General Parallel File System (GPFS) for file
management, IBM Tivoli Storage Productivity Center calculates both the
number of files and the number of directories for the value in this column.
For example, if a Windows computer contains 150 files and 50 directories,
the number in the File Count column is 200.

Directory Count
Total number of directories within a group. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a group.

Used Inodes
Number of used Inodes within a group.
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Free Inodes
Number of free Inodes within a group.

By Domain

Chart icon
Click this button to generate charts about the file system used space for a
domain.

Magnifying glass icon
Click this button to view more detailed information about the file system
used space of computers that are in a domain.

Domain
Name of a domain.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available to the computers within a domain. Tivoli Storage Productivity
Center does not include the following file systems in its calculation of the
value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server
v File systems that are not mounted.

Percent Available File System Space (Percent Free Space)
Percentage of total file system storage space that is available within a
domain.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the computers within a domain. Tivoli Storage Productivity Center does
not include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

File System Space (Capacity)
Total amount of unique file system storage space that was discovered on
the computers within a domain. Tivoli Storage Productivity Center does
not include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
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agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

File Count
Total number of files within a domain. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, IBM Tivoli
Storage Productivity Center calculates both the number of files and the
number of directories for the value in this column. For example, if a
Windows computer contains 150 files and 50 directories, the number in the
File Count column is 200.

Directory Count
Total number of directories within a domain. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a domain.

Used Inodes
Number of used Inodes within a domain.

Free Inodes
Number of free Inodes within a domain.

Network-wide

Chart icon
Click this button to generate a chart about the file system used space in a
network.

Magnifying glass icon
Click this button to view more detailed information about the file system
used space in a network.

Available File System Space (Free Space)
Total amount of unique file system storage space that is not used or is
available to the computers within a network. Tivoli Storage Productivity
Center does not include the following file systems in its calculation of the
value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server
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v File systems that are not mounted.

Percent Available File System Space (Percent Free Space)
Percentage of total file system storage space that is available within a
network.

Consumed File System Space (Used Space)
Total amount of unique file system storage space that is used or consumed
by the computers within a network. Tivoli Storage Productivity Center
does not include the following file systems in its calculation of the value
for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: On some UNIX file systems, this value does not include storage
space reserved by the operating system (overhead).

File System Space (Capacity)
Total amount of unique file system storage space that was discovered on
the computers within a network. Tivoli Storage Productivity Center does
not include the following file systems in its calculation of the value for this
column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Note: The value in this column might be greater than Used Space + Free
Space on some UNIX systems. This occurs because the used space reported
on UNIX (both by the APIs used by the Storage Resource agents or Data
agents and by the df command) does not include some space reserved by
the operating system (overhead). Therefore, the value in the Capacity field
is greater than or equal to the value of Used Space + Free Space, the
difference representing the space wasted due to the system overhead.

File Count
Total number of files within a network. Tivoli Storage Productivity Center
does not include the following files in its calculation of the value for this
column:
v Files on file systems that become missing after a probe.
v Files on file systems that are not mounted.
v Files on file systems that have not been scanned by a Storage Resource

agent or Data agent.

Note: On Windows computers, AIX systems, and systems using IBM
General Parallel File System (GPFS) for file management, IBM Tivoli
Storage Productivity Center calculates both the number of files and the
number of directories for the value in this column. For example, if a
Windows computer contains 150 files and 50 directories, the number in the
File Count column is 200.
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Directory Count
Total number of directories within a network. Tivoli Storage Productivity
Center does not include the following directories in its calculation of the
value for this column:
v Directories on file systems that become missing after a probe.
v Directories on file systems that are not mounted.
v Directories on file systems that have not been scanned by a Storage

Resource agent or Data agent.

Percent Used Inodes
Percentage of used Inodes within a network.

Used Inodes
Number of used Inodes within a network.

Free Inodes
Number of free Inodes within a network.

Usage Reports
Use Usage reports to view the usage and growth of the consumption of your
storage. You can view these reports based on specific filesystems and computers,
groups of filesystems and computers, or throughout your entire enterprise. These
reports help you project storage consumption for the future and maximize the
current storage assets that you have in place by eliminating wasted space and
making the most of the space you have.

Use these reports to do the following:
v View which servers and filesystems are experiencing the heaviest (or lightest)

load of data and storage access.
v Identify wasted space by pinpointing files that are no longer needed or have not

been accessed for the longest time.
v Associate users with the amount of storage they are consuming on specific

filesystems, groups of filesystems, specific computers, groups of computers, and
throughout the entire network.

v Select the files against which to run an IBM Tivoli Storage Manager
archive/backup job. Tivoli Storage Manager protects your organization's data
from hardware failures and other errors by storing backup and archive copies of
data on offline storage.

Access Load reports: Use Access Load reports to view which machines and file
systems within your environment are experiencing the heaviest (or lightest) load of
data and storage access.

Access Time reports
Use Access Time reports to view and chart the amount of data and the
number of files that have been accessed during the last day, the last week,
the last month, the last year, and over. You can view this information at the
directory level, the file system level, the computer level, at the domain
level, and for the entire network.

The following report shows a single pie chart that depicts all of the data
across the entire enterprise, giving you an easy way to see how much of
your corporate data is accessed every day, every week, and even data that
has not been accessed in over a year.

920 IBM Tivoli Storage Productivity Center: User's Guide



Modification Time reports

Use Modification Time reports to view and chart the amount of data and
the number of files that have been modified during the last day, the last
week, the last month, the last year, and over. You can view this
information at the directory level, the file system level, the computer level,
at the domain level, and for the entire network.

The following report shows a single pie chart that depicts all of the data
across the entire enterprise, allowing you to see how much of your
corporate data is modified every day, every week, and even data that has
not been modified in over a year.

Creation Time reports
Use Creation Time reports to view and chart the amount of data and the
number of files that have been created during the last day, the last week,

Figure 59. Usage Reporting—Access Load—Access Time—Chart Network Wide

Figure 60. Usage Reporting—Access Load—Modification Time—Chart Network Wide
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the last month, the last year, and over. You can view this information at the
directory level, the file system level, the computer level, at the domain
level, and for the entire network.

Note: Because scans do not collect creation time information for the files
stored on UNIX machines, creation time reports do not contain any data
for the non-Windows machines in your environment.

Files reports: Use Files Reports to report on the files found on the storage in your
environment during theData Manager scan process. During the scan process, Data
Manager gathers statistics on your files and attributes about the files. Select the
files against which to run an IBM Tivoli Storage Manager archive or backup job.
See “Archive and backup functions” on page 484 for information on how to create
archive and backup jobs from the files shown in a Files report. The information
gathered can be reported on in a variety of ways using this facility:

Largest Files reports

Use these reports to view information about the largest files in your
environment. Largest Files reports enable you to do the following:
v Generate reports that contain detailed information about the largest files

found in your environment. You can view reports on the largest files in
the following ways: by directory, by directory group, by file system, by
file system group, by cluster, by computer, by computer group, by
domain, and for the entire network.

Note: The number of files that are gathered and stored in the repository
is dependent upon the number that you specify in the profile that you
use during scanning. The default profile gathers information on the 20
largest files. You can select a profile for the report by clicking the Profile
list box.

v Select files against which to run anTivoli Storage Manager archive or
backup job. See “Archive and backup functions” on page 484 for
information on how to create archive/backup jobs from the files shown
in a Files report.

v Add files to an existing Tivoli Storage Manager archive/backup job. See
“Archive and backup functions” on page 484 for information on how to
add files from reports to an archive/backup job.

Duplicate Files reports

Use these reports to view information about the files found in your
environment during a scan that contain duplicate file names. Duplicate
Files reports enable you to do the following:
v Generate reports on the files found in your environment during a scan

that contain duplicate file names. Use this report to view a list of files
that might no longer be needed and could be wasting storage space. You
can use the data generated in a duplicate files report to view a list of
files that might no longer be needed and could be wasting storage space.
You can view reports on duplicate files in the following ways: by
directory, by directory group, by file system, by file system group, by
cluster, by computer, by computer group, by domain, and for the entire
network.

Note: The number of files that are gathered and stored in the repository
is dependent upon the number that you specify in the profile that you
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use during scanning. The default profile gathers information on the 20
largest files. You can select a profile for the report by clicking the Profile
list box.

v Select files against which to run an Tivoli Storage Manager archive or
backup job. See “Archive and backup functions” on page 484 for
information on how to create archive and backup jobs from the files
shown in a Files report.

v Add files to an existing Tivoli Storage Manager archive or backup job.
See “Archive and backup functions” on page 484 for information on
how to add files from reports to an archive or backup job.

Before generating a Duplicate Files report for environments that contain a
large amount of files (i.e., environments that might contain over 100,000
duplicate files), we recommend you tune theData Manager repository. To
do this, run the appropriate RDBMS utility to collect statistics on the
repository tables. Run the following utilities depending on the RDBMS
where the repository is stored:
v UDB: runstats
v Oracle: analyze
v Microsoft SQL Server: update stats
v Sybase: update stats

Run the appropriate utility against all the tables in the repository schema
you specified during the installation process.

To generate the data for a duplicate files report, you can either create a
constraint that will save filenames for n number of violation files, or run a
scan that includes one or all of the following existing profiles:
v TPCUser.Largest Files
v TPCUser.Largest Orphans
v TPCUser.Most at Risk
v TPCUser.Most Obsolete

There is not a specific Duplicate Files profile that collects information on
all duplicate files in a file system. The filenames that are triggered by the
previously listed profiles or constraints will be saved to the repository and
the duplicate files report is generated from the data gathered from the scan
or constraint.

For example, create a scan using the Largest Files profile to collect
information on the 100 largest files. The 100 largest files are saved in the
t_stat_file table in the repository. If five duplicate files were saved as a
result of being flagged by the Largest File Profile, then those files will be
reported as duplicates in the Duplicate file Report.

Most Obsolete Files reports
Use these reports to view information about the files found in your
environment that have not been accessed in the longest period of time.
Most Obsolete Files reports enable you to do the following:
v Generate reports on the files found in your environment that have not

been accessed in the longest period of time. It is very likely that many of
these files are no longer needed, at least online, and could be wasting
space. You can view reports on the largest files in the following ways: by
directory, by directory group, by file system, by file system group, by
cluster, by computer, by computer group, by domain, and for the entire
network.
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Note: The number of files that are gathered and stored in the repository
is dependent upon the number that you specify in the profile that you
use during scanning. The default profile gathers information on the 20
largest files. You can select a profile for the report by clicking the Profile
list box.

v Select files against which to run an Tivoli Storage Manager archive or
backup job. See “Archive and backup functions” on page 484 for
information on how to create archive/backup jobs from the files shown
in a Files report.

v Add files to an existing Tivoli Storage Manager archive or backup job.
See “Archive and backup functions” on page 484 for information on
how to add files from reports to an archive or backup job.

Orphan Files reports

Use these reports to view information about files that are owned by users
that are no longer active in the environment. Orphan files reporting
enables you to do the following:
v Generate reports on files that are owned by users that are no longer

active in the environment. It is very likely that many of these files are no
longer needed and could be wasting space. You can view reports on
orphan files in the following ways: by directory, by directory group, by
file system, by file system group, by cluster, by computer, by computer
group, by domain, and for the entire network.
You can also generate reports on the oldest orphan files that have not
been accessed for the longest periods of time, as well as largest orphan
files.

Note: The number of files that are gathered and stored in the repository
is dependent upon the number that you specify in the profile that you
use during scanning. The default profile gathers information on the 20
largest files. You can select a profile for the report by clicking the Profile
list box.

v Select files against which to run an Tivoli Storage Manager archive or
backup job. See “Archive and backup functions” on page 484 for
information on how to create archive and backup jobs from the files
shown in a Files report.

v Add files to an existing Tivoli Storage Manager archive or backup job.
See “Archive and backup functions” on page 484 for information on
how to add files from reports to an archive or backup job.

File Size Distribution reports

Use these reports to view information about the distribution of file sizes
across storage resources. Use File Size Distribution reports to generate
reports that show the distribution of file sizes on a specific directory, a file
system, a computer, the domain, or across your entire network.

The following report shows a single pie chart for each computer in the
report.
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Each pie chart depicts the number of files that fall into each file size bucket
that are described in the legend. For example, the blue portion of the pie
represents the number of files on each computer that are smaller than 1024
bytes long. This gives you an easy way to get a quick grasp of what are
the size distribution of your data files.

File Summary reports

Use these reports to view general information about the files in your
environment. Use File Summary reports generate overview information for
files, also at the directory level, the file system level, the computer level,
the domain level or for the whole network.

This report shows you the following (for each entity at the level you are
reporting by):
v The total size of the files
v The number of files
v The number of directories
v The average file size

File Types reports

Use these reports to view information about the storage usage of different
file types in your environment. File Types reports enable you to generate
reports on the file types found in your environment during a scan. The
scan that collects data for these reports must use the TPCUser.Summary By
File Type profile. For example, when you run a scan using the
TPCUser.Summary By File Type profile,Data Manager will collect storage
usage information about such file types as .exe, .zip, .sys, .pdf, .doc, .dll,
.wav, .mp3, .avi, etc. Each of these file types is represented by its own row
in the generated reports.

Use these reports to do the following:

Figure 61. Usage Reporting—Files—File Size Distribution—File Count Chart Tab
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v Relate the space used by applications to the total capacity and used
space. For example, you can use these reports to view the total amount
of storage consumed by Adobe Acrobat files and Lotus Notes mail
databases.

v View which applications are consuming the most space across a given
set of storage resources

You can view these reports in the following ways:
v Group by Resource. These reports organize data by storage resource (for

example, file system, computer, cluster, etc.) and space used.
v Group by File Type. These reports organizes data by file type and space

used. They show where the most spaced used by each type of file
resides.

Archive/Backup jobs from reports:

Use the Archive/Backup function from Reporting to define an archive or backup
job to run against the files that you select from specified reports.

Tivoli Storage Manager protects your organization's data from hardware failures
and other let you back up specified files. These files are not excluded in the
include-exclude list and meet the requirement for serialization in the backup copy
group of the management class assigned to each file. An incremental backup
enables you to back up new or changed files or directories from a client domain or
from specified directories or files. These directories or files are not excluded in the
include-exclude list and meet the requirements for frequency, mode, and
serialization as defined by a backup copy group of the management class assigned
to each file. See IBM Tivoli Storage Manager Client User's Guide for more information
about Tivoli Storage Manager archives and backups.

This function enables you to select a specific file or group of files fromData
Manager reports that you want to archive or back up using the Tivoli Storage
Manager tool.

Archive/backup is run fromData Manager -> Reporting. You cannot create archive
and backup jobs from the Archive/Backup node - rather you create these jobs by
selecting files from the previously listed reports or the reports that you create. Each
archive and backup that you create from reports appears as a node under the
Archive/Backup node. The reports that contain files against which you can run an
archive or backup job include:
v Data Manager -> Reporting -> Usage -> Files -> Largest Files

v Data Manager -> Reporting -> Usage -> Files -> Most Obsolete Files

v Data Manager -> Reporting -> Usage -> Files -> Orphan Files

v Data Manager -> Reporting -> Usage -> Files -> Duplicate Files

v Data Manager -> Reporting -> Backup -> Most at Risk Files ->

v Data Manager -> Reporting -> Usage Violations -> Constraint Violations

You can also run an archive or backup job from a report you create.

Note:

See Creating Archive/Backup jobs in Reporting for information about how to create an
archive or backup job from the files shown in reports.
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Directories reports:
Use Directories reports to report upon the directories found on the storage in your
environment during the scan process. During the scan process, Data Manager
gathers a vast number of statistics on your directories and a number of attributes
about the directories. Before you can view information about directories in these
reports, you must do the following:
1. Use the Monitoring → Groups → Directory function to create directory groups

that contain the directories upon which you want to report.
2. Include the directory groups you created in scans.
3. Schedule and run the scans that contain the directory groups (and directories)

upon which you want to report.

Largest Directories reports

Use Largest Directories reports to view reports on the n largest directories
found in your environment:
v for specific directories
v on specific computers or groups of computers
v on specific file systems or groups of file systems
v in specific domains
v on the entire network

The number of largest (or the value of n in finding the n largest
directories), is determined by the profile that you use for doing the
reporting. When you define a profile in the Monitoring → Profiles node,
you specify the number of largest directories upon which to collect
information. When you generate a Largest Directories report, you can
select what profile to use.

Monitored Directory Space reports
Use Monitored Directory reports to report on the monitored directories that
you have included in a group via the Monitoring → Groups → Directory
facility and included in a scan. During the scan process, Data Manager
gathers a number of statistics on your directories and a number of
attributes about the directories.

Users reports: Use Users Reports to view information about the users that are
found as file owners in your environment. These reports provide an easy and
convenient way to view and aggregate storage resource consumption by owner
across directories, file systems, computers, domains, and across your entire
network.

OS User Groups reports: OS User Groups reports give you the exact same
capabilities as the reports under Users reports. The only difference is that you are
doing your analysis of OS User Groups as opposed to actual single users.

Usage Violation reports
Use Usage Violation reports to view information about quota and constraint
violations.

Usage Violation reports enable you to:
v Create and enforce corporate storage usage policies based on reports that show

quota and constraint violations.
Use quotas to control how much storage a user, or a group of users, can
consume on a filesystem or group of filesystems, a computer or group of
computers, and throughout the entire network. Use Constraints to set policies
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about which types of files, owners, and file sizes are allowed on a filesystem or
group of file systems, a computer or group of computer, and throughout the
entire network.

v Select files in Constraint Violation reports against which to run an IBM Tivoli
Storage Manager archive/backup job. See “Archive and backup functions” on
page 484 for information on how to create archive/backup jobs from the files
shown in a Files report.

v Add files from Constraint Violation reports to an existing Tivoli Storage
Manager archive or backup job. See “Create an archive/backup job” on page 485
for information on how to add files from reports to an archive/backup job.

Constraint Violations reports: Constraint Violations reporting enables you to do
the following:
v View the files that have violated a constraint. The report shows one row for each

Constraint. The row shows the detail of the constraint and the violating space
totals for the files that violate the constraint. You can view reports on the files
that violate constraints in the following ways: by file system, by file system
group, by computer, by computer group, by domain, and by constraint.

v Select files against which to run an Tivoli Storage Manager archive or backup
job. See the “Archive and backup functions” on page 484 section for information
on how to create archive and backup jobs from the files shown in a Files report.

v Add files to an existing Tivoli Storage Manager archive or backup job. See the
“Archive and backup functions” on page 484 section for information on how to
add files from reports to an archive or backup job.

Quota Violations reports: Use Quota Violations reports to report on the quotas
that you have defined and see how much space is being used by the various
entities that have quotas defined upon them.

Quotas can be defined on either of two categories of users: on a specific user or
group of users that you have defined within either Users or on OS User Groups.
The two categories are described in the following list:

User This allows you to define a quota on a user or group of users. The users
are the owners of the files that Data Manager finds as it scans your
systems.

OS User Group
This allows you to define a quota on an OS user group or group of OS
user groups. OS user groups are defined outside the tool and are found by
Data Manager as it scans your systems.

Within each of those categories, you can define quotas at any one of following
three levels:

Network
This allows you to define quotas on users or groups of users at the entire
network level. This enables you to control how much any single user or
group of users is using on all of the storage throughout your enterprise.

Computer
This allows you to define quotas on users or groups of users at the
computer level. This enables you to control how much any single user or
group of users is using on a single computer, or on any given group of
computers.
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Filesystem
This allows you to define quotas on users or groups of users at the file
system level. This enables you to control how much any single user or
group of users is using on a single file system, or on any given group of
file systems.

All Quotas reports

Use All Quotas reports to report on all quotas that have been violated, including
those at the network level, computer level, and file system level. The Selection tab
allows you to select upon what users you wish to do quota reporting.

The Objects tab shows you for each user and computer and file system:
v how much space is being used
v what the Quota threshold is
v what the percentage of the Quota that is being consumed

This gives you a simple way to analyze how much space is being used relative to
the Quotas that you have defined on your systems and users.

Network-wide Quotas reports

Use Network-wide Quota reports to view all the network-wide quotas that have
been violated by users and OS user groups in your environment. Information
about the quotas that appear on these reports includes the amount of space being
used, the threshold value, and the percentage over the threshold value. You can
view these reports sorted by user, by OS user group, and by the creator of the
quota.

Computer Quotas reports

Use Computer Quota reports to view all the computer quotas that have been
violated by users and OS user groups in your environment. Information about the
quotas that appear on these reports includes the amount of space being used, the
threshold value, and the percentage over the threshold value. You can view these
reports sorted by user, by OS user group, and by the creator of the quota.

Filesystem Quotas reports

Use Filesystem Quota reports to view all the computer quotas that have been
violated by users and OS user groups in your environment. Information about the
quotas that appear on these reports includes the amount of space being used, the
threshold value, and the percentage over the threshold value. You can view these
reports sorted by user, by OS user group, and by the creator of the quota.

Backup reports
Use Backup reports to identify the most at risk files in your enterprise that are not
backed up properly. Critical data that is not backed up might expose you to costly
losses of information.

Backup reports also enable you to:
v Investigate the sizes of data that would be required to backup to achieve full

backups of any subset of your enterprise (including the whole enterprise).
v Determine the amount of space required to perform an incremental backup of

any or all of your data at any given point in time.
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v Select files in Most at Risk Files reports against which to run an IBM Tivoli
Storage Manager archive/backup job.

v Add files from Most at Risk Files reports to an existing Tivoli Storage Manager
archive/backup job.

Most At Risk Files reports: Most At Risk Files reporting enables you to do the
following:
v View the files that have the earliest modification time, but have not been backed

up since they were modified. This can alert you to a dangerous situation where
you may have vulnerable data that could be lost and not recovered due to lack
of backups.

v Select files against which to run an IBM Tivoli Storage Manager archive or
backup job. See the “Archive and backup functions” on page 484 section for
information on how to create archive or backup jobs from the files shown in a
Files report.

v Add files to an existingTivoli Storage Manager archive or backup job. See the
“Archive and backup functions” on page 484 section for information on how to
add files from reports to an archive or backup job.

Modified Files not Backed Up reports: Use Modified Files not Backed Up reports
to view the numbers of files that have the earliest modification time, but have not
been backed up since they were modified. This can alert you to a dangerous
situation where you may have vulnerable data that could be lost and not recovered
due to lack of backups.

Backup Storage Requirements reports: Use Backup Storage Requirements reports
to determine, at a network, domain computer, file system, or directory level, how
much storage will be required to do backups. You can determine how much
storage will be required to do both full backups and to do incremental backups.

Reporting Type Description

Full Backup Size Use Full Backup Size reports to view how much space it will
take to do full backups of specific computers, file systems,
directories, groups of those entities, domains, and the entire
network.

Incremental Backup Size (Windows only) Use this report to view the total size of all the
files that have not been backed up since the last scan. You can
generate this report by Directory, by Directory Group, by
Filesystem, by Filesystem Group, by Computer, by Computer
Group, by Domain and Network Wide. This allows you to see
for any of these levels, how much data would need to be
backed up for any of these desired time intervals. This is useful
for backup sizing and can be used to determine appropriate
backup groups and sets for timing your backups.
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Reporting Type Description

Incremental Range Sizes Use this report to determine how much storage space you
would need to back up data that has been modified in the last
day, week, month, two months, three months, six months, nine
months, or year. For example, if you want to back up the files
that have been modified in the last 3 months only, generate this
report and view the values in the "Last Modified <= 3 months"
column to determine 1) how many files changed and 2) how
much storage those changed files are consuming.

You can generate this report by Directory, by Directory Group,
by Filesystem, by Filesystem Group, by Cluster, by Computer,
by Computer Group, by Domain and Network Wide. This
allows you to see for any of these levels, how much data
would need to be backed up for any of these desired time
intervals. This is useful for backup sizing and can be used to
determine appropriate backup groups and sets for timing your
backups.

Monitored Computer Storage Space reports
Use these host-based reports to view the data that is collected by probes for
computers, network attached storage, and hypervisors. These reports contain
detailed information about the consumption of file system space and enable you to
relate that space back to external or internal storage without counting shared space
multiple times.

Monitored computer storage space reports are organized into the following
categories:

Disk Storage
Use these reports to view information about disks that reside on computers
monitored by IBM Tivoli Storage Productivity Center. This includes
information about storage subsystem disks, known disks with serial
numbers, or unknown disks without serial numbers.

Non-Disk Storage
Use these reports to view information about storage space that does not
reside on computer disks that are monitored by Tivoli Storage Productivity
Center. This type of storage includes the following:
v Storage that resides on a remote mount or a network attached server.
v Storage that is temporarily allocated to processor memory.

You must perform the following actions before viewing these reports:
v Run a probe against the storage entities upon which you want to report.
v If you want to generate By Computer Group, By Filesystem Group, and By

Storage Subsystem Group reports, perform the following tasks:
– Create computer monitoring group and file system monitoring groups using

the Data Manager > Monitoring > Groups node and then probe them.
– Create storage subsystem monitoring group using the Disk Manager >

Monitoring > Groups node and probe them.
– Create a computer reporting group or file system reporting group using the

Data Manager > Reporting > Groups and Disk Manager > Reporting >
Groups node. Probe the entities in the group.

– Create a subsystem reporting group using the Disk Manager > Reporting >
Groups node. Probe the storage subsystems in the group.
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Related Topics
v See Storage entities to view descriptions of the storage entities that appear in

these reports.
v See Common storage space values to view descriptions of the common storage

space values that appear in these reports.

Monitored Computer Storage Space reports - Storage entities:

Monitored Computer Storage Space reports display information about storage
entities that you probe. Use this topic to view descriptions of those entities.

You can use Monitored Computer Storage Space reports to view information about
the following storage entities:

Computer
Computer that is monitored by a Storage Resource agent or Data agent.
This computer can be a single host, a virtual machine, or a hypervisor. A
hypervisor is a machine that hosts one or more virtual machines.

Disk on a storage subsystem
Computer disk that originates from a storage subsystem. If the disk's
storage subsystem is not monitored by IBM Tivoli Storage Productivity
Center, that storage subsystem is represented by a portion of the serial
number of the disk. If the storage subsystem is monitored by Tivoli Storage
Productivity Center, that storage subsystem is represented by the name
collected by a probe.

Disk not on a storage subsystem with a serial number
Computer disk that Tivoli Storage Productivity Center is unable to
determine if it originates from a storage subsystem. Tivoli Storage
Productivity Center is able to extract the serial number of that disk.

Disk not on a storage subsystem without a serial number
A valid computer disk for which Tivoli Storage Productivity Center is
unable to do the following:
v Determine if the disk originates from a storage subsystem.
v Extract the serial number of the disk.

Disk Group
A collection of disk drives on a computer.

File System
Storage entity that creates, removes, and modifies files on a computer. File
systems can be shared among monitored computers and span portions of
different disks. If a file system spans disk entities, then there will be a
single logical volume beneath it that describes how the file system is
spanned.

(Parent) Logical Volume
Logical representation of a volume that spans many logical volumes. If
there is no file system created on this logical volume, information about
the parent logical volume is displayed in the reports.

(Child) Logical Volume
Logical representation of a volume that spans one or more portions of a
single or multiple disks. This entity helps determine how the parent logical
volumes and file systems are allocated on the disks. If there is no file
system created on this logical volume, or there is no parent logical volume
for this logical volume, the child logical volume is displayed in the reports.
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Non-Disk Storage
Storage space that does not reside on a computer disk. This includes
storage residing on a remote mount or a network attached server and
storage that is temporarily allocated to processor memory.

Volume Group
A collection of logical volumes on a computer.

Virtual Machine (VM) Disk File
Storage entity that represents a computer disk on a computer that is a
virtual machine.

Virtual Machine File System (VMFS)
Storage entity that creates, removes, and modifies VM Disk files on a
computer that is a hypervisor hosting one or more virtual machines.

Monitored Computer Storage Space reports - Common storage space values:

Monitored Computer Storage Space reports provide detailed storage space
information about the computers probed by IBM Tivoli Storage Productivity
Center. Use this topic to view descriptions of the common storage values that
appear in these reports.

You can view the following storage space information in Monitored Computer
Storage Space reports:

Space Total amount of storage space for the entity that a row represents:
v For file system rows, this is the total logical volume space where a file

system resides.
v For logical volume rows, this is the total logical volume space.
v For computer disk rows, this is the total disk space of a computer disk.
v For computer space rows, this is the total storage subsystem volume

space on a computer.
v For storage subsystem space rows, this is the total storage subsystem

volume space on all monitored computers.

Consumed Space
Amount of consumed storage space for the entity that a row represents:
v For file system rows, this is the space that is consumed by data that can

be accessed by the end user of a computer.
v For logical volume rows, this is the space that can be consumed by a file

system, but is not yet consumed by a file system.
v For computer disk rows, this is the space that is consumed by the file

systems and logical volumes on a disk.
v For computer space rows, this is the storage subsystem volume space

that is consumed on a monitored computer.
v For storage subsystem space rows, this is the storage subsystem volume

space that is consumed on all monitored computers.

Available Space
Amount of available storage space for the entity that a row represents:
v For file system rows, this is the space that is available for consumption.
v For logical volume rows, this value is zero (0) because no file system has

been created on the logical volume that would help determine the
amount of available space.
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v For computer disk rows, this is the space that is available on the file
systems on a computer disk and the space on a computer disk not yet
allocated to a logical volume.

v For computer space rows, this is the storage subsystem volume space
that is available for consumption on a computer.

v For storage subsystem space rows, this is the storage subsystem volume
space that is available for consumption on all monitored computers.

Unavailable Space
Amount of unavailable storage space for the entity that a row represents:
v For file system rows, this space is unavailable for consumption because

it is reserved by the software RAID level on the underlying logical
volume and is required for data that is used by the operating system to
maintain a file system.

v For logical volume rows, this space is unavailable because it is reserved
for the software RAID level of a logical volume.

v For computer disk rows, this is the space that is unavailable on the file
systems and the logical volumes on a computer disk.

v For computer space rows, this is the storage subsystem volume space
that is unavailable on a computer.

v For storage subsystem space rows, this is the storage subsystem volume
space that is unavailable on all monitored computers.

Monitored Computer Storage Space - Disk Storage reports:

Use these reports to view information about disks residing within computers that
are monitored by IBM Tivoli Storage Productivity Center. This includes information
about storage subsystem disks, known disks with serial numbers, and unknown
disks without serial numbers.

Disk Storage reports are organized into the following categories:

All Disk Storage
Use these reports to view information about all the disks residing on
computers that are monitored by Tivoli Storage Productivity Center.

Disk Storage On Storage Subsystems
Use these reports to view information about disks that Tivoli Storage
Productivity Center has identified as storage subsystem volumes.

Disk Storage Not On Storage Subsystems
Use these reports to view information about disks that Tivoli Storage
Productivity Center has not identified as storage subsystem volumes.

Related Topics

v Monitored Computer Storage Space reports overview
v See Storage entities to view descriptions of the storage entities that appear in

these reports.
v See Common storage space values to view descriptions of the common storage

space values that appear in these reports.

Disk Storage - All Disk Storage reports:

Use these reports to view information about all the disks residing on computers
that are monitored by IBM Tivoli Storage Productivity Center.
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See All Disk Storage reports - Column Descriptions for descriptions of all the
columns that appear in All Disk Storage reports.

Use By clauses to filter the entities that appear in a report. For example, if you
want to view an All Disk Storage report that displays specific computers, select By
Computer and use the Selection and Filter options to determine which computers
appear in that report.

You can customize the information in each report by relating the monitored entities
to other storage. The following options for relating entities to storage in these
reports includes the following:
v Use the Relate To: options in the By Computer, By Computer Group, and By

Disk/Volume Group reports to relate storage entities to the following storage:
– File System or Logical Volume Space
– Distributed File System or Logical Volume Space
– Computer Disk Space
– Distributed Computer Disk Space

v Use the Relate To: options in the By File System/Logical Volume and By File
System Groups reports to relate storage entities to the following storage:
– File System or Logical Volume Space
– Distributed File System or Logical Volume Space

Related Topics

v All Disk Storage reports - Column Descriptions
v Monitored Computer Storage Space reports overview
v See Storage entities to view descriptions of the storage entities that appear in

these reports.
v See Common storage space values to view descriptions of the common storage

space values that appear in these reports.

All Disk Storage reports - Column Descriptions:

Use these reports to view information about all the disks residing on computers
that are monitored by IBM Tivoli Storage Productivity Center. Use this topic to
view descriptions of the columns that appear in these reports.

The following buttons and columns appear in the By clauses of All Disk Storage
reports:

Note: Not all of the following columns appear in each By clause.

Selection...
Click this button to select the specific entities that you want to include in
the report. For example, in the By Filesystem/Logical Volume report, click
this button to select the specific file systems or logical volumes upon which
you want to report.

Filter Click this button to apply conditions to the columns within a report to
further select or restrict the entities that you want to include in the report.

Relate <entity> To:
Select how you want to relate monitored storage entities in the report to
other storage.
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Magnifying glass icon
This button appears on all By <entity> Group reports. Click this button to
view a more detailed report about the entities in a group.

Available Disk Space
Amount of space on a disk that is available for use. For computer groups,
this is the amount of space on disks that is available for use by the
computers in a group. For disk and volume groups, this is the external
disk space available for use within those groups.

This space includes the file system space that is available on the disk and
the space that is not allocated to a logical volume. For example,
unpartitioned space.

The XIV system GUI and the XIV system command-line interface (CLI)
report sizes in GB of disks, volumes, pools, and so on, based on 10^9.
Tivoli Storage Productivity Center reports sizes in GB based on 2^30. For
example, a volume showing a size of 17 GB in the XIV system GUI is
reported as 16 GB (XIV GB size * 1000 * 1000 * 1000 / 1024 /1024 / 1024
rounded to the nearest GB) in Tivoli Storage Productivity Center.

Available Disk/Volume Group Space
Amount of available space in a disk group or volume group.

Available File System/Logical Volume Space
Amount of space on the file system or logical volume that is available for
use. For computers groups, this is the amount of space on file systems or
logical volumes that is available for use by the computers within those
groups. For file system groups, this is the amount of space on file systems
or logical volumes within those groups that can be consumed. For disk
groups and volume groups, this is the external logical volume or file
system space available for use within those groups.

Computer
Name of a computer where a disk, file system, logical volume, or disk
group is located.

Computer OS Type
The operating system running on a computer.

Consumed Disk Space
Amount of space on a disk that is consumed. For computer groups, this is
the amount of disk consumed by the computers within those groups. For
disk and volume groups, this is the external disk space consumed within
those groups.

This space includes the file system space that is consumed on a disk. If a
logical volume on this disk space has no file system, then this space
includes the consumed portion of the logical volume that has been
allocated to the disk.

Consumed Disk/Volume Group Space
Amount of consumed disk or volume group space.

Consumed File System or Logical Volume Space
Amount of space on the file system or logical volume consumed by the
computer on a disk. For computer groups, this is the amount of space on
file systems or logical volumes that is consumed by the computers within
those groups. For file system groups, this is the amount of space on file
systems or logical volumes within those groups that is consumed. For disk
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groups and volume groups, this is the external logical volume or file
system space consumed within those groups.

Correlated
Indicates Yes if Tivoli Storage Productivity Center is able to relate the host
storage directly to a storage subsystem. You can relate this correlated
storage back to the actual storage subsystem storage for a more detailed
view of how the host storage is allocated.

If a computer disk, file system, or logical volume appears in the Disk
Storage On Storage Subsystem reports but is not correlated, it might be the
result of the following reasons:
v The storage subsystem was not probed. Run a probe to collect data

about the storage subsystem then generate this report.
v The storage subsystem storage was unassigned from the host storage,

but the host has not been probed. Run a probe to collect data about the
host then generate this report.

v The storage subsystem storage was not correctly identified by a probe of
the host. If this is the problem, check the probe log of the host for
messages relating to SCSI command errors and the probe results of the
storage subsystem.

Creator
ID of the user who created a group.

Disk Path
Path name of a disk as seen by the computer.

Disk Space
Total amount of space allocated to a computer disk. For computer groups,
this is the total amount of space allocated to the disks on the computers
within those groups. For disk and volume groups, this is the external disk
space within the disk group or volume group.

Note:

v This space is distributed across the hypervisor disk space from where
the virtual machine disk's file resides. The portion of space identified to
a particular external hypervisor disk is reported only. This is true for all
space values in this report.

v The XIV system GUI and the XIV system command-line interface (CLI)
report sizes in GB of disks, volumes, pools, and so on, based on 10^9.
Tivoli Storage Productivity Center reports sizes in GB based on 2^30. For
example, a volume showing a size of 17 GB in the XIV system GUI is
reported as 16 GB (XIV GB size * 1000 * 1000 * 1000 / 1024 /1024 / 1024
rounded to the nearest GB) in Tivoli Storage Productivity Center.

Disk/Volume Group Name
Name of a disk group or volume group where a logical volume or file
system was created. This column displays N/A if a disk group or volume
group does not exist on a disk.

Disk/Volume Group Space
Total amount of disk group or volume group space. This is space inclusive
of all storage space and applies to all space values related to disk groups
or volume groups.

Disk/Volume Group Type
Type of a disk group.
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Fibre Attached
Indicates Yes when Tivoli Storage Productivity Center determines that a
disk is behind a fibre channel adapter port.

File System Type
Type of a file system, such as NTFS.

File System/Logical Volume Path
Name of a file system or logical volume path.

Group Name of a group.

Grown Defects
Number of defects detected on the disk since it was new.

Hypervisor Name
Name of the hypervisor where a virtual machine was created. This column
displays N/A if not applicable to a disk.

Logical Volume Space
Total amount of space allocated to the logical volume on a disk. For
computer groups, this is the total amount of space allocated to the logical
volumes on disks within those groups. For file system groups, this is the
total amount of space allocated to the logical volumes within those groups.
For disk groups and volume groups, this is the external logical volume
space within those groups.

This space includes the file system space on the disk reported if the entity
displayed is a file system. The actual size of the file system on the disk
reported is in addition to the consumed and available space.

Note: When relating a monitored entity to distributed file system/logical
volume space, the space is distributed across the disks where a logical
volume or file system resides. The portion identified to a disk is reported
only.

(Disk) Manufacturer
The manufacturer of a disk.

Mapped to Storage Subsystem
Indicates Yes if Tivoli Storage Productivity Center has identified a disk as
being located on a storage volume from a storage subsystem. The storage
subsystem might no be monitored by Tivoli Storage Productivity Center.

(Disk) Model
Model number of a disk.

Number of Disks
Number of disks in a computer group. For disk groups and volume
groups, this is the number of external disks within those groups.

Number of File Systems/Logical Volumes
Number of logical file systems or logical volumes within a group. For disk
groups and volume groups, this is the number of external logical file
systems or logical volumes within those groups.

The logical volumes underlying the file systems are not counted for the
value in the column.

Overallocated
Indicates Yes if Tivoli Storage Productivity Center is unable to uniquely
identify disk storage across more than one host. Check the probe log of the
host for messages relating to SCSI command errors.
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Path Type
Path type of the entity being reported: file system or a logical volume.

Primary Defects
Number of defects on the disk when it was new.

Shared
Indicates Yes if a file system or logical volume is shared by more than one
computer.

Serial Number
Serial number of a disk.

Unavailable Disk Space
Amount of space on the disk not available to be consumed. For the
computer groups, this is the amount of space on disks that is not available
to be consumed by the computers in a group. For disk and volume groups,
this is the external disk space that is not available for use within those
groups.

This space is used for logical volume overhead and is reserved by the
operating system to manage a file system.

Unavailable Logical Volume Space
Amount of space on a logical volume that is not available for use by a
computer. For computer groups, this is the amount of space on logical
volumes that is not available for use by the computers within those
groups. For file system groups, this is the amount of space on the logical
volumes within those groups that is not available for use. For disk groups
and volume groups, this is the external logical volume space that is not
available for use within those groups.

This space is used for logical volume overhead and is reserved by the
operating system to manage a file system.

VM Disk File
Virtual machine disk's file on a monitored hypervisor that represents the
disk on the virtual machine. This column displays N/A if not applicable to
a disk.

VMFS Disk
Hypervisor disk where the virtual machine disk resides. This column
displays N/A if not applicable to a disk.

Note: If a virtual machine disk's file spans multiple hypervisor disks,
duplicate entries for the virtual machine disk are generated. If the report is
distributed, the space is distributed across the hypervisor disks that are not
external.

VFMS Mount Point
Hypervisor file system's mount point where the virtual machine disk's file
resides. This column displays N/A if not applicable to a disk.

Related Topics

v All Disk Storage reports overview
v See Storage entities to view descriptions of the storage entities that appear in

these reports.
v See Common storage space values to view descriptions of the common storage

space values that appear in these reports.
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Disk Storage - Disk Storage on Storage Subsystems reports:

Use these reports to view information about computer disks that IBM Tivoli
Storage Productivity Center has identified as storage subsystem volumes.

See Disks On Storage Subsystems - Column Descriptions for descriptions of all the
columns that appear in Disk Storage on Storage Subsystem reports.

Use By clauses to filter the entities that appear in a report. For example, if you
want to view a report that displays specific computers, select By Storage
Subsystem and use the Selection and Filter options to determine which storage
subsystems appear in the generated report.

You can customize the information in each By clause by relating the monitored
entities to other storage. The following options for relating storage entities (storage
subsystems, computers, groups, file systems, logical volumes, disk groups, volume
groups) to other storage in these reports includes the following:
v Use the Relate Storage Subsystems To: options in the By Storage Subsystem

and By Storage Subsystem Group reports to relate storage subsystems to the
following storage:
– Computer Space
– File System or Logical Volume Space
– Distributed File System or Logical Volume Space
– Computer Disk Space
– Distributed Computer Disk Space

v Use the Relate Computers To: and Relate Disk/Volume Group To: options in
the By Computer, By Computer Group, and By Disk/Volume Group reports to
relate storage computers, computer groups, disk groups, or volume groups to
the following storage:
– File System or Logical Volume Space
– Distributed File System or Logical Volume Space
– Computer Disk Space
– Distributed Computer Disk Space
– Storage Subsystem Space (not available for disk groups and volume groups)

v Use the Relate FileSystems/Logical Volumes To: options in the By File
System/Logical Volume and By Filesystem Group reports to relate file systems
or logical volumes to the following storage:
– File System or Logical Volume Space
– Distributed File System or Logical Volume Space

Considerations

Keep in mind the following considerations when generating Disk Storage on
Storage Subsystems reports:

By Storage Subsystem (Relate Storage Subsystems To: File System/Logical
Volume Space, Distributed File System/Logical Volume Space)

Duplicate entries appear in By Storage Subsystem reports for file systems
or logical volumes that span multiple storage subsystems. The storage
space shown in the report is adjusted in the totals. The storage space
values include space that is not storage subsystem storage if a file system
or logical volume spans disks that are both storage subsystem disks and
other storage disks.
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When relating storage subsystems or computers to distributed file
system/logical volume space, the reports displays duplicate entries for file
systems or logical volumes that span multiple disks, but the displayed
storage space unique. The values for storage space exclude space that is
not storage subsystem storage if a file system or logical volume spans
disks that are both storage subsystem disks and other storage disks.

By Storage Subsystem (Relate Storage Subsystems To: Computer Disk Space,
Distributed Computer Disk Space)

Duplicate entries appear in these reports for virtual machines whose disks
spans multiple hypervisor disks. The storage space shown in the report is
adjusted in the totals. The storage space values include space that is not
storage subsystem storage if the file system on a virtual machine spans
hypervisor disks that are external or if the file system spans other storage
disks.

When relating storage subsystems or computers to distributed computer
disk space, this report displays duplicate entries for virtual machines
whose disks spans multiple hypervisor disks, but the storage space shown
in the report is unique. The storage space values exclude space that is not
storage subsystem storage if the virtual machine disk's file system spans
hypervisor disks that are external or the virtual machine disk's file system
spans other storage disks.

By XIV system
The XIV system GUI and the XIV system command-line interface (CLI)
report sizes in GB of disks, volumes, pools, and so on, based on 10^9.
Tivoli Storage Productivity Center reports sizes in GB based on 2^30. For
example, a volume showing a size of 17 GB in the XIV system GUI is
reported as 16 GB (XIV GB size * 1000 * 1000 * 1000 / 1024 /1024 / 1024
rounded to the nearest GB) in Tivoli Storage Productivity Center.

Related Topics

Keep in mind the following considerations when generating Disk Storage on
Storage Subsystems reports:
v Disks On Storage Subsystems - Column Descriptions
v Monitored Computer Storage Space reports overview
v See Storage entities to view descriptions of the storage entities that appear in

these reports.
v See Common storage space values to view descriptions of the common storage

space values that appear in these reports.

Disks On Storage Subsystems - Column Descriptions:

Use these reports to view information about disks on monitored computers that
IBM Tivoli Storage Productivity Center has identified as storage subsystem
volumes.

The following buttons and columns appear in the By clauses of Disks On Storage
Subsystems reports:

Note: Not all of the following columns appear in each By clause.

Selection...
Click this button to select the specific entities that you want to include in
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the report. For example, in the By Storage Subsystem report, click this
button to select the specific storage subsystems upon which you want to
report.

Filter Click this button to apply conditions to the columns within a report to
further select or restrict the entities that you want to include in the report.

Relate <entity> To:
Select how you want to relate monitored storage entities in the report to
other storage. See Disk Storage - Disk Storage Not On Storage Subsystems
reports for more information.

Magnifying glass icon
This button appears on all By <entity> Group reports. Click this button to
view a more detailed report about the entities in a group.

Available Disk Space
Amount of disk space on a storage subsystem that is available for a
computer to consume. For computer groups, this is the amount of space on
disks that is available for use by the computers within those groups. For
storage subsystem groups, this is the amount of space on disks that is
available for use by the storage subsystems within those groups. For disk
and volume groups, this is the external disk space available for use within
those groups.

This space includes the file system space that is available on the disk and
the space that has not been allocated to a logical volume.

Available Disk/Volume Group Space
Amount of available space in a disk group or volume group.

Available File System/Logical Volume Space
Amount of space on the file system or logical volume that is available for
use by the computer on a storage subsystem. For computers groups and
storage subsystem groups, this is the amount of space on file systems or
logical volumes that is available for use on storage subsystems by the
entities within those groups. For file system groups, this is the amount of
space on file systems or logical volumes within those groups that can be
consumed. For disk groups and volume groups, this is the external logical
volume or file system space available for use within those groups.

Computer
Name of a computer where a disk, file system, logical volume, or disk
group is located.

Computer OS Type
The operating system running on a computer.

Consumed Disk Space
Amount of disk space on a storage subsystem that is consumed by a
computer. For storage subsystem groups, this is the amount of consumed
disk space within those groups. For computer groups, this is the amount of
disk space consumed by the computers those groups. For disk and volume
groups, this is the external disk space consumed within those groups.

This space includes the file system space that is consumed on a disk. If a
logical volume on this disk space has no file system, then this space
includes the consumed portion of the logical volume that has been
allocated to the disk.
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Consumed Disk/Volume Group Space
Amount of consumed disk or volume group space.

Consumed File System/Logical Volume Space
Amount of space on the file system or logical volume that is consumed by
the computer on a storage subsystem. For computer groups and storage
subsystem groups, this is the amount of space on file systems or logical
volumes that is consumed by the entities within those groups. For file
system groups, this is the amount of storage subsystem space on file
systems or logical volumes within those groups that is consumed. For disk
groups and volume groups, this is the external logical volume or file
system space consumed within those groups.

Correlated
Indicates Yes if Tivoli Storage Productivity Center is able to relate the host
storage directly to a storage subsystem. You can relate this correlated
storage back to the actual storage subsystem storage for a more detailed
view of how the host storage is allocated.

If a computer disk, file system, or logical volume appears in the Disk
Storage On Storage Subsystem reports but is not correlated, it might be the
result of the following reasons:
v The storage subsystem was not probed. Run a probe to collect data

about the storage subsystem then generate this report.
v The storage subsystem storage was unassigned from the host storage,

but the host has not been probed. Run a probe to collect data about the
host then generate this report.

v The storage subsystem storage was not correctly identified by a probe of
the host. If this is the problem, check the probe log of the host for
messages relating to SCSI command errors and the probe results of the
storage subsystem.

Creator
ID of the user who created a group.

Disk Path
Path name of a disk as seen by the computer.

Disk Space
Total disk space on a storage subsystem seen by a computer. For computer
groups, this is the total disk space within those groups that is associated
with storage subsystems. For storage subsystem groups, this is the total
disk space on the storage subsystems within those groups. For disk and
volume groups, this is the external disk space within the disk group or
volume group.

Note: This space is distributed across the hypervisor disk space from
where the virtual machine disk's file resides. The portion of space
identified to a particular external hypervisor disk is reported only. This is
true for all space values in this report.

Disk/Volume Group Name
Name of a disk group or volume group where a logical volume or file
system was created. This column displays N/A if a disk group or volume
group does not exist on a disk.
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Disk/Volume Group Space
Total amount of disk group or volume group space. This is space inclusive
of all storage space and applies to all space values related to disk groups
or volume groups.

Disk/Volume Group Type
Type of a disk group. For example, a volume group might be LVM or
Veritas. This column displays N/A if a disk group or volume group does
not exist on a disk.

Fibre Attached
Indicates Yes when Tivoli Storage Productivity Center determines that a
disk is behind a fibre channel adapter port.

File System Type
Type of a file system, such as NTFS.

File System/Logical Volume Path
Name of a file system or logical volume path.

Group Name of a group.

Grown Defects
Number of defects detected on the disk since it was new.

Hypervisor Name
Name of the hypervisor where a virtual machine was created. This column
displays N/A if not applicable to a disk.

Logical Volume Space
Total amount of space allocated to the logical volume on a disk. For
computer groups, this is the total logical volume space in computer groups
that is associated with storage subsystems. For storage subsystem groups,
this is the total logical volume space on the storage subsystems within
those groups. For file system groups, this is the total amount of space
allocated to the logical volumes within those groups. For disk groups and
volume groups, this is the external logical volume space within those
groups.

This space includes the file system space on the disk reported if the entity
displayed is a file system. The actual size of the file system on the disk
reported is in addition to the consumed and available space.

Note: When relating a monitored entity to distributed file system/logical
volume space, the space is distributed across the disks where a logical
volume or file system resides. The portion identified to a disk is reported
only.

(Disk) Manufacturer
The manufacturer of a disk.

Mapped to Storage Subsystem
Indicates Yes if Tivoli Storage Productivity Center has identified a disk as
being located on a storage volume from a storage subsystem. The storage
subsystem might not be monitored by Tivoli Storage Productivity Center.

(Disk) Model
Model number of a disk.

Number of Disks
Number of disks assigned to a storage subsystem or group. For disk
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groups and volume groups, this is the number of external disks within
those groups. For NetApp storage devices, this number does not include
disks in partner storage pools.

Number of File Systems/Logical Volumes
Number of logical file systems or logical volumes within a group. For disk
groups and volume groups, this is the number of external logical file
systems or logical volumes within those groups.

The logical volumes underlying the file systems are not counted for the
value in the column.

Overallocated
Indicates Yes if Tivoli Storage Productivity Center is unable to uniquely
identify disk storage across more than one host. Check the probe log of the
host for messages relating to SCSI command errors.

Path Type
Path type of the entity being reported: file system or a logical volume.

Primary Defects
Number of defects on the disk when it was new.

Shared
Indicates Yes if a file system or logical volume is shared by more than one
computer.

Serial Number
Serial number of a disk.

Storage Subsystem Manufacturer
The manufacturer of a storage subsystem.

Storage Subsystem Type
The type of storage subsystem.

Unavailable Disk Space
Amount of disk space on the storage subsystem that is not available for a
computer to consume. For the computer groups, this is the amount of
space on disks that is not available to be consumed by the computers
within those groups. For the storage subsystem groups, this is the amount
of space on disks that is not available to be consumed within those groups.
For disk and volume groups, this is the external disk space that is not
available for use within those groups.

This space is used for logical volume overhead and is reserved by the
operating system to manage a file system.

Unavailable Logical Volume Space
Amount of space on the logical volume that is not available for use by the
computer on a storage subsystem. For computer groups and storage
subsystem groups, this is the amount of space on logical volumes that is
not available for use by the entities within those groups. For file system
groups, this is the amount of space on the logical volumes within those
groups that is not available for use. For disk groups and volume groups,
this is the external logical volume space that is not available for use within
those groups.

This space is used for logical volume overhead and is reserved by the
operating system to manage a file system.
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VM Disk File
Virtual machine disk's file on a monitored hypervisor that represents the
disk on the virtual machine. This column displays N/A if not applicable to
a disk.

VMFS Disk
Hypervisor disk where the virtual machine disk resides. This column
displays N/A if not applicable to a disk.

Note: If a virtual machine disk's file spans multiple hypervisor disks,
duplicate entries for the virtual machine disk are generated. If the report is
distributed, the space is distributed across the hypervisor disks that are not
external.

VFMS Mount Point
Hypervisor file system's mount point where the virtual machine disk's file
resides. This column displays N/A if not applicable to a disk.

Related Topics

v Disks On Storage Subsystems reports overview
v See Storage entities to view descriptions of the storage entities that appear in

these reports.
v See Common storage space values to view descriptions of the common storage

space values that appear in these reports.

Disk Storage - Disk Storage Not On Storage Subsystems reports:

Use these reports to view information about computer disks that IBM Tivoli
Storage Productivity Center has not identified as storage subsystem volumes.

These reports are organized into the following categories:

Disks With Serial Numbers
These reports display information about non-storage subsystem disks that
Tivoli Storage Productivity Center has identified with a valid serial
number.

Disks Without Serial Numbers
These reports display information about non-storage subsystem disks that
Tivoli Storage Productivity Center has not identified with serial numbers
that uniquely identify those disks. This might occur on internal disks
within a hypervisor and virtual machines that have storage created from
internal disks within a hypervisor. If this problem occurs for other types of
storage, check the probe log of the host for messages relating to SCSI
command errors.

See Disks Not On Storage Subsystems - Column Descriptions for descriptions of all
the columns that appear in Disk Storage Not On Storage Subsystems reports.

Use By clauses to filter the entities that appear in a report. For example, if you
want to view a Disk Storage Not On Storage Subsystems report that displays
specific computers, select By Computer and use the Selection and Filter options to
determine which computers appear in that report.

You can customize the information in each By clause by relating the monitored
entities to other storage. The following options for relating storage entities
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(computers, computer groups, file systems, file system groups, logical volumes,
disk groups, volume groups) to other storage in these reports includes the
following:
v Use the Relate Computers To: and Relate Disk/Volume Group To: options in

the By Computer, By Computer Group, and By Disk/Volume Group reports to
relate computers, computer groups, disk groups, and volume groups to the
following storage:
– File System or Logical Volume Space
– Distributed File System or Logical Volume Space
– Computer Disk Space
– Distributed Computer Disk Space

v Use the Relate FileSystems/Logical Volumes To: options in the By File
System/Logical Volume and By Filesystem Group reports to relate file systems
or logical volumes to the following storage:
– File System or Logical Volume Space
– Distributed File System or Logical Volume Space

Related Topics

v Disks Not On Storage Subsystems - Column Descriptions
v Monitored Computer Storage Space reports overview
v See Storage entities to view descriptions of the storage entities that appear in

these reports.
v See Common storage space values to view descriptions of the common storage

space values that appear in these reports.

Disks Not On Storage Subsystems - Column Descriptions:

Use Disks Not On Storage Subsystems reports to view information about disk
storage that is not associated with storage subsystems. IBM Tivoli Storage
Productivity Center has not identified the disks in this report as storage subsystem
volumes. Use this topic to view descriptions of the columns that appear in these
reports.

The following buttons and columns appear in the By clauses of Disks Not On
Storage Subsystems reports:

Note: Not all of the following columns appear in each By clause.

Selection...
Click this button to select the specific entities that you want to include in
the report. For example, in the By Filesystem/Logical Volume report, click
this button to select the specific file systems or logical volumes upon which
you want to report.

Filter Click this button to apply conditions to the columns within a report to
further select or restrict the entities that you want to include in the report.

Relate <entity> To:
Select how you want to relate monitored storage entities in the report to
other storage. See Disk Storage - Disk Storage Not On Storage Subsystems
reports for more information.
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Magnifying glass icon
This button appears on all By <entity> Group reports. Click this button to
view a more detailed report about the entities in a group.

Available Disk Space
Amount of space on a disk that is available for use by a computer. For
computer groups, this is the amount of space on disks that is available for
use by the computers in a group. For disk and volume groups, this is the
external disk space available for use within those groups.

This space includes the file system space that is available on the disk and
the space that has not been allocated to a logical volume.

Available Disk/Volume Group Space
Amount of available space in a disk group or volume group.

Available File System/Logical Volume Space
Amount of space on the file system or logical volume that is available for
use on a disk. For computers groups, this is the amount of space on file
systems or logical volumes that is available for use by the computers
within those groups. For file system groups, this is the amount of space on
file systems or logical volumes within those groups that can be consumed.
For disk groups and volume groups, this is the external logical volume or
file system space available for use within those groups.

Computer
Name of a computer where a disk, file system, logical volume, or disk
group is located.

Computer OS Type
The operating system running on a computer.

Consumed Disk Space
Amount of space on a disk that is consumed. For computer groups, this is
the amount of disk consumed by the computers in those groups. For disk
and volume groups, this is the external disk space consumed within those
groups.

This space includes the file system space that is consumed on a disk. If a
logical volume on this disk space has no file system, then this space
includes the consumed portion of the logical volume that has been
allocated to the disk.

Consumed Disk/Volume Group Space
Amount of consumed disk or volume group space.

Consumed File System/Logical Volume Space
Amount of space on the file system or logical volume consumed by the
computer on a disk. For computer groups, this is the amount of space on
file systems or logical volumes that is consumed by the computers within
those groups. For file system groups, this is the amount of space on file
systems or logical volumes within those groups that is consumed. For disk
groups and volume groups, this is the external logical volume or file
system space consumed within those groups.

Creator
ID of the user who created a group.

Disk Path
Path name of a disk as seen by the computer.
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Disk Space
Total amount of space allocated to a computer disk. For computer groups,
this is the total amount of space allocated to the disks on the computers
within those groups. For disk and volume groups, this is the external disk
space within the disk group or volume group.

Note: This space is distributed across the hypervisor disk space from
where the virtual machine disk’s file resides. The portion of space
identified to a particular external hypervisor disk is reported only. This is
true for all space values in this report.

Disk/Volume Group Name
Name of a disk group or volume group where a logical volume or file
system was created. This column displays N/A if a disk group or volume
group does not exist on a disk.

Disk/Volume Group Space
Total amount of disk group or volume group space. This is space inclusive
of all storage space and applies to all space values related to disk groups
or volume groups.

Disk/Volume Group Type
Type of a disk group. For example, a volume group might be LVM or
Veritas. This column displays N/A if a disk group or volume group does
not exist on a disk.

Fibre Attached
Indicates Yes when Tivoli Storage Productivity Center determines that a
disk is behind a fibre channel adapter port.

File System Type
Type of a file system, such as NTFS.

File System/Logical Volume Path
Name of a file system or logical volume path.

Group Name of a group.

Grown Defects
Number of defects detected on the disk since it was new.

Hypervisor Name
Name of the hypervisor where a virtual machine was created. This column
displays N/A if not applicable to a disk.

Logical Volume Space
Total amount of space allocated to the logical volume on a disk. For
computer groups, this is the total amount of space allocated to the logical
volumes on disks within those groups. For file system groups, this is the
total amount of space allocated to the logical volumes within those groups.
For disk groups and volume groups, this is the external logical volume
space within those groups.

This space includes the file system space on the disk reported if the entity
displayed is a file system. The actual size of the file system on the disk
reported is in addition to the consumed and available space.

Note: When relating a monitored entity to distributed file system/logical
volume space, the space is distributed across the disks where a logical
volume or file system resides. The portion identified to a disk is reported
only.
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(Disk) Manufacturer
The manufacturer of a disk.

(Disk) Model
Model number of a disk.

Number of Disks
Number of disks in a computer group. For disk groups and volume
groups, this is the number of external disks within those groups.

Number of File Systems/Logical Volumes
Number of logical file systems or logical volumes within a group. For disk
groups and volume groups, this is the number of external logical file
systems or logical volumes within those groups.

The logical volumes underlying the file systems are not counted for the
value in the column.

Overallocated
Indicates Yes if Tivoli Storage Productivity Center is unable to uniquely
identify disk storage across more than one host. Check the probe log of the
host for messages relating to SCSI command errors.

Path Type
Path type of the entity being reported: file system or a logical volume.

Primary Defects
Number of defects on the disk when it was new.

Shared
Indicates Yes if a file system or logical volume is shared by more than one
computer.

Serial Number
Serial number of a disk.

Unavailable Disk Space
Amount of space on the disk not available to be consumed. For the
computer groups, this is the amount of space on disks that is not available
to be consumed by the computers in a group. For disk and volume groups,
this is the external disk space that is not available for use within those
groups.

This space is used for logical volume overhead and is reserved by the
operating system to manage a file system.

Unavailable Logical Volume Space
Amount of space on a logical volume that is not available for use by a
computer. For computer groups, this is the amount of space on logical
volumes that is not available for use by the computers within those
groups. For file system groups, this is the amount of space on the logical
volumes within those groups that is not available for use. For disk groups
and volume groups, this is the external logical volume space that is not
available for use within those groups.

This space is used for logical volume overhead and is reserved by the
operating system to manage a file system.

VM Disk File
Virtual machine disk’s file on a monitored hypervisor that represents the
disk on the virtual machine. This column displays N/A if not applicable to
a disk.
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VMFS Disk
Hypervisor disk where the virtual machine disk resides. This column
displays N/A if not applicable to a disk.

Note: If a virtual machine disk’s file spans multiple hypervisor disks,
duplicate entries for the virtual machine disk are generated. If the report is
distributed, the space is distributed across the hypervisor disks that are not
external.

VFMS Mount Point
Hypervisor file system’s mount point where the virtual machine disk’s file
resides. This column displays N/A if not applicable to a disk.

Related Topics

v Disks Not On Storage Subsystems reports overview
v See Storage entities to view descriptions of the storage entities that appear in

these reports.
v See Common storage space values to view descriptions of the common storage

space values that appear in these reports.

Disk Storage - Non-Disk Storage reports:

Use these reports to view information about storage space that does not reside on
disks that are monitored by IBM Tivoli Storage Productivity Center. This includes
storage that resides on a remote mount or a network attached server and storage
that is temporarily allocated to processor memory.

Use By clauses to filter the entities that appear in a report. For example, if you
want to view a report that displays specific computers, select By Computer and
use the Selection and Filter options to determine which computers appear in the
generated report.

The following By clauses are available for Non-Disk Storage reports:
v By Computer
v By Computer Group
v By Filesystem/Logical Volume
v By Filesystem Group
v By Disk/Volume Group

You can customize the information in each By clause by relating the monitored
entities to other storage. The following options for relating storage entities
(computers, computer groups, file systems, file system groups, logical volumes,
disk groups, volume groups) to other storage in these reports includes the
following:
v File System or Logical Volume Space
v Distributed File System or Logical Volume Space

Related Topics

v Monitored Computer Storage Space reports overview
v See Storage entities to view descriptions of the storage entities that appear in

these reports.
v See Common storage space values to view descriptions of the common storage

space values that appear in these reports.
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Non-Disk Storage - By Computer report, By Filesystem/Logical Volume report:

Use these reports to view information about non-disk storage. This includes
storage that resides on a remote mount or a network attached server and storage
that is temporarily allocated to processor memory. Select By Computer if you want
to determine which computers are displayed in the report. Select By
Filesystem/Logical Volume if you want to determine which file systems or logical
volumes appear in the report.

Selection...
For the By Computer reports, click this button to select the specific
computers upon which you want to report. For the By Filesystem/Logical
Volume reports, click this button to select the specific file systems or
logical volumes upon which you want to report.

Filter Click this button to apply conditions to the columns within a report to
further select or restrict computers or file system/logical volumes upon
which you want to report.

Relate <entity> To:
Select how you want to relate computers or file systems in the report to
other storage entities. See ]Disk Storage - Non-Disk Storage reports for
more information.

Computer
Name of a computer.

File System/Logical Volume Path
Name of a file system or logical volume path.

Note: Each monitored file system or logical volume path is displayed only
once in this report because if the storage space is not distributed (there are
no underlying disks), then there is no need to report distribution.

Logical Volume Space
Total amount of space allocated to the logical volume on a disk. This space
includes the file system space if the entity displayed is a file system. The
actual size of the file system is in addition to the consumed and available
space.

Note: When relating computers to distributed file system/logical volume
space, the space is distributed across the logical volumes where the file
system or parent logical volume resides. The portion identified to a
particular file system or parent logical volume is reported only. If a file
system does not have an underlying logical volume, the logical volume
space is the size of that file system.

Consumed File System/Logical Volume Space
Amount of space on a file system or logical volume that is consumed by a
computer.

Available File System/Logical Volume Space
Amount of space on a file system or logical volume that is available for
use by a computer.

Unavailable Logical Volume Space
Amount of space on the logical volume that is not available for use by a
computer. This space is used for logical volume overhead and is reserved
by the operating system to manage a file system.
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Computer OS Type
Operating system running on a computer.

Disk/Volume Group Name
Name of a disk or volume group where the logical volume or file system
was created. This column displays N/A if a disk group or volume group
does not exist on a disk.

Disk/Volume Group Type
Type of a disk or volume group where the logical volume or file system
was created. This column displays N/A if a disk group or volume group
does not exist on a disk.

File System Type
Type of a file system, such as NTFS.

Path Type
Path type of an entity: file system or a logical volume.

Shared
Indicates Yes if a file system or logical volume is shared by more than one
computer.

Non-Disk Storage - By Computer Group report, By Filesystem Group report:

Use these reports to view information about non-disk storage. This includes
storage that resides on a remote mount or a network attached server and storage
that is temporarily allocated to processor memory. Select By Computer Group if
you want to determine which computer groups are displayed in the report. Select
By Filesystem Group if you want to determine which file system groups appear in
the report.

Selection...
For the By Computer Group reports, click this button to select the specific
computer groups upon which you want to report. For the By Filesystem
Group reports, click this button to select the specific file system group
upon which you want to report.

Filter Click this button to apply conditions to the columns within a report to
further select or restrict groups upon which you want to report.

Relate <entity> To:
Select how you want to relate groups in the report to other storage entities.
See Disk Storage - Non-Disk Storage reports for more information.

A unique row appears for each group in this report.

Magnifying glass icon
Click this button to view a more detailed report about the computers or
file systems in a group.

Creator
ID of the user who created the group.

Group Name of a group.

Logical Volume Space
Total amount of space allocated to the computers or file systems in a
group. This space includes the file system space if the entity displayed is a
file system. The actual size of the file system is in addition to the
consumed and available space.
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Note: When relating groups to distributed file system/logical volume
space, this space is distributed across the disks from where the logical
volume or file system reside. This is true for all space values in the
Distributed File System/Logical Volume Space report.

Consumed File System/Logical Volume Space
Amount of space on file systems or logical volumes within a group that is
consumed.

Available File System/Logical Volume Space
Amount of space on file systems or logical volumes within a group that
can be consumed.

Unavailable Logical Volume Space
Amount of space on the logical volumes in a group that is not available for
use. This space is used for logical volume overhead and is reserved by the
operating system to manage a file system.

Number of File Systems/Logical Volumes
Number of file systems or logical volumes in a group.

Non-Disk Storage - By Computer report, By Filesystem/Logical Volume report:

Use these reports to view information about non-disk storage. This includes
storage that resides on a remote mount or a network attached server and storage
that is temporarily allocated to processor memory. Select By Computer if you want
to determine which computers are displayed in the report. Select By
Filesystem/Logical Volume if you want to determine which file systems or logical
volumes appear in the report.

Selection...
For the By Computer reports, click this button to select the specific
computers upon which you want to report. For the By Filesystem/Logical
Volume reports, click this button to select the specific file systems or
logical volumes upon which you want to report.

Filter Click this button to apply conditions to the columns within a report to
further select or restrict computers or file system/logical volumes upon
which you want to report.

Relate <entity> To:
Select how you want to relate computers or file systems in the report to
other storage entities. See ]Disk Storage - Non-Disk Storage reports for
more information.

Computer
Name of a computer.

File System/Logical Volume Path
Name of a file system or logical volume path.

Note: Each monitored file system or logical volume path is displayed only
once in this report because if the storage space is not distributed (there are
no underlying disks), then there is no need to report distribution.

Logical Volume Space
Total amount of space allocated to the logical volume on a disk. This space
includes the file system space if the entity displayed is a file system. The
actual size of the file system is in addition to the consumed and available
space.
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Note: When relating computers to distributed file system/logical volume
space, the space is distributed across the logical volumes where the file
system or parent logical volume resides. The portion identified to a
particular file system or parent logical volume is reported only. If a file
system does not have an underlying logical volume, the logical volume
space is the size of that file system.

Consumed File System/Logical Volume Space
Amount of space on a file system or logical volume that is consumed by a
computer.

Available File System/Logical Volume Space
Amount of space on a file system or logical volume that is available for
use by a computer.

Unavailable Logical Volume Space
Amount of space on the logical volume that is not available for use by a
computer. This space is used for logical volume overhead and is reserved
by the operating system to manage a file system.

Computer OS Type
Operating system running on a computer.

Disk/Volume Group Name
Name of a disk or volume group where the logical volume or file system
was created. This column displays N/A if a disk group or volume group
does not exist on a disk.

Disk/Volume Group Type
Type of a disk or volume group where the logical volume or file system
was created. This column displays N/A if a disk group or volume group
does not exist on a disk.

File System Type
Type of a file system, such as NTFS.

Path Type
Path type of an entity: file system or a logical volume.

Shared
Indicates Yes if a file system or logical volume is shared by more than one
computer.

Non-Disk Storage - By Computer Group report, By Filesystem Group report:

Use these reports to view information about non-disk storage. This includes
storage that resides on a remote mount or a network attached server and storage
that is temporarily allocated to processor memory. Select By Computer Group if
you want to determine which computer groups are displayed in the report. Select
By Filesystem Group if you want to determine which file system groups appear in
the report.

Selection...
For the By Computer Group reports, click this button to select the specific
computer groups upon which you want to report. For the By Filesystem
Group reports, click this button to select the specific file system group
upon which you want to report.

Filter Click this button to apply conditions to the columns within a report to
further select or restrict groups upon which you want to report.

Chapter 8. Reporting in the stand-alone GUI 955



Relate <entity> To:
Select how you want to relate groups in the report to other storage entities.
See Disk Storage - Non-Disk Storage reports for more information.

A unique row appears for each group in this report.

Magnifying glass icon
Click this button to view a more detailed report about the computers or
file systems in a group.

Creator
ID of the user who created the group.

Group Name of a group.

Logical Volume Space
Total amount of space allocated to the computers or file systems in a
group. This space includes the file system space if the entity displayed is a
file system. The actual size of the file system is in addition to the
consumed and available space.

Note: When relating groups to distributed file system/logical volume
space, this space is distributed across the disks from where the logical
volume or file system reside. This is true for all space values in the
Distributed File System/Logical Volume Space report.

Consumed File System/Logical Volume Space
Amount of space on file systems or logical volumes within a group that is
consumed.

Available File System/Logical Volume Space
Amount of space on file systems or logical volumes within a group that
can be consumed.

Unavailable Logical Volume Space
Amount of space on the logical volumes in a group that is not available for
use. This space is used for logical volume overhead and is reserved by the
operating system to manage a file system.

Number of File Systems/Logical Volumes
Number of file systems or logical volumes in a group.

Disk Storage on Storage Subsystems reports - By Disk/Volume Group:

Use this report to view information about non-disk storage. This includes storage
that resides on a remote mount or a network attached server and storage that is
temporarily allocated to processor memory. This report enables you to determine
which disk groups or volume groups are displayed.

Selection...
Click this button to select the specific disk groups or volume groups upon
which you want to report.

Filter Click this button to apply conditions to the columns within a report to
further select or restrict disk groups or volume groups upon which you
want to report.

Relate Disk/Volume Group To:
Select how you want to relate the non-disk storage in disk groups or
volume groups to other storage entities. See Disk Storage - Non-Disk
Storage reports for more information.
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A unique row appears for each disk group or volume group.

Magnifying glass icon
Click this button to view a more detailed report about the disk or file
system within the disk group or volume group.

Disk/Volume Group Name
Name of a group.

Disk/Volume Group Type
Type of a group. For example, a volume group might be LVM or Veritas.

Computer
Name of the computer where a disk group or volume group resides.

Computer OS Type
Operating system running on a computer.

Disk/Volume Group Space
Total amount of disk group or volume group space. This is space inclusive
of all storage space and applies to all space values related to disk groups
or volume groups.

Consumed Disk/Volume Group Space
Amount of consumed disk group or volume group space.

Available Disk/Volume Group Space
Amount of available disk group or volume group space.

Logical Volume Space
External logical volume space within a disk group or volume group.

Consumed File System/Logical Volume Space
External logical volume or file system space that is consumed within a disk
group or volume group.

Available File System/Logical Volume Space
External logical volume or file system space that is available for use within
a disk group or volume group.

Unavailable Logical Volume Space
External logical volume space that is not available for use within a disk
group or volume group. This space is used for logical volume overhead
and is reserved by the operating system to manage a file system.

Number of File Systems/Logical Volumes
Number of external logical file systems or logical volumes within a disk or
volume group. The logical volumes underlying the file systems are not
counted.

Additional reporting support and information
Learn about the additional storage devices upon which you can report within Data
Manager.

IBM FAStT Subsystem support: The IBM FAStT subsystem reporting feature
further extends the subsystem reporting capabilities of Data Manager. You can use
the Reporting facility to view information about the capacity, allocation, and
volumes of an IBM FAStT subsystem. You can view IBM FAStT subsystem
information by using the following menu options to generate reports:
v Reporting → Asset → By Storage Subsystem → <IBM FAStT subsystem name>
v Reporting → Asset → System-wide → Storage Subsystems
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v Reporting → Asset → System-wide → Volumes

v Reporting → Asset → System-wide → Disks

Note: Data Manager shows an incorrect value for the Storage Pool Free Space
column in IBM FAStT subsystem reports (for example, Asset → By Storage
Subsystem → <FAStT_subsystem_name>, and Asset → System-wide → Storage
Subsystems). The value for Storage Pool Free Space in these reports reflects the
space from one Free Capacity node rather than all the free space within the
defined arrays on a FAStT subsystem.

Hitachi Data Systems Subsystem support: Use the Reporting facility to report on
Hitachi Data Systems (HDS) storage subsystems. You can view reports that contain
information about the capacity, allocation, and volumes of an HDS subsystem.

Any storage pools or volumes created using the HDS HiCommand software will
not be reported through the HDS CIMOM provider. HiCommand is the native
interface for HDS subsystems. If you configure an HDS subsystem through
HiCommand , IBM Tivoli Storage Productivity Center will not be able to gather
information about storage pools and volumes from that subsystem. The HDS CIM
agent provider will return all storage pools created through the HiCommand
interface as a single pool containing all of the HiCommand created pools. This
single pool is always reported as Raid 5.

Note: Data Manager does not report on the raw capacity of disks internal to the
HDS subsystem. Information on the internal disks of the HDS subsystem is not
available through the CIMOM interface provided by the Hitachi HiCommand
Device Manager.

You can view HDS storage subsystem information by using the following menu
options to generate reports:
v Reporting → Asset → By Storage Subsystem → <HDS subsystem name>
v Reporting → Asset → System-wide → Storage Subsystems

v Reporting → Asset → System-wide → Volumes

v Reporting → Asset → System-wide → Disks

v Reporting → TPC-wide Storage Space → Disk Space

HP StorageWorks Subsystem support: Use the Reporting facility to report on HP
StorageWorks storage subsystems. You can view reports that contain information
about the capacity, allocation, and volumes of an HP StorageWorks subsystem.

You can view HP StorageWorks storage subsystem information by using the
following menu options to generate reports:
v Reporting → Asset → By Storage Subsystem → <HP StorageWorks subsystem

name>
v Reporting → Asset → System-wide → Storage Subsystems

v Reporting → Asset → System-wide → Volumes

v Reporting → Asset → System-wide → Disks

IBM Tivoli Storage SAN File Systems support: You can also perform scans and
probes to gather information about IBM Tivoli Storage SAN File Systems and
generate reports based on that information using the Reporting facility. You can
view information gathered by probes of the SAN File System by using the
following menu options to generate reports:
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v Reporting → Asset → By OS Type → IBM SAN File System

v Reporting → Asset → By Computer

v Reporting → TPC-wide Storage Space → File System Space

v Reporting → TPC-wide Storage Space → Consumed File System Space

v Reporting → TPC-wide Storage Space → Available File System Space

Note: Due to the complexity of the SAN File System, the values displayed for total
capacity, used space and free space in the Capacity and Asset reports might not be
accurate. The values displayed are the values returned by the probe or scane and
they may not represent actual values for your SAN File System. Use the SAN File
System admin console to obtain the actual values.
You can view information gathered by scans of the SAN File System by using the
following menu options to generate reports:
v Reporting → Usage

v Reporting → Usage Violations

v Reporting → Backup

Refer to the Creating Directory Groups section in the Monitoring chapter for more
information about how to configure SAN File System support within the Reporting
facility.

Report Array, Loop, and Adapter Pair for IBM TotalStorage Enterprise Storage
Server Disk Groups support: Disk Manager provides report information on
Array, Loop, and Adapter Pairs for TotalStorage Enterprise Storage Server Disk
Groups. This information is available when managing an TotalStorage Enterprise
Storage Server through IBM CIM Agent (ICAT) for TotalStorage Enterprise Storage
Server version 1.2.0.13. Contact IBM Customer Support to obtain IBM CIM Agent
for TotalStorage Enterprise Storage Server version 1.2.0.13.

You can view Array, Loop, and Adapter Pair information by using the menu
option Reporting → Asset Reporting → By Storage Subsystem to generate reports.

Conversion of volume sizes by IBM Tivoli Storage Productivity Center:

Tivoli Storage Productivity Center uses 1024 bytes to represent a kilobyte.
However, some element managers use 1000 bytes to represent a kilobyte. When
reporting volume sizes, Tivoli Storage Productivity Center converts base-1000
values to base-1024 values.

The following table shows the byte values that are associated with base-1024 and
base-1000 systems:

Unit Abbreviation Bytes in base-1024 Bytes in base-1000

Kilobyte KB in base-1024

kB in base-1000 see

note

210 or 1024 103 or 1000

Megabyte MB 10242 or 1,048,576 106 or 1,000,000

Gigabyte GB 10243 or 1,073,741,824 109 or 1,000,000,000

Terabyte TB 10244 or
1,099,511,627,716

1012or 1,000,000,000,000

Note: In SI Metric Style, the abbreviation of the prefix kilo is lowercase k. IBM distinguishes
between lowercase k (meaning 1000 or 103) and uppercase K (meaning 1024 or 210).
Therefore, KB means 1024 bytes, and kB means 1000 bytes.
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You can verify the volume size reported by Tivoli Storage Productivity Center
against the size reported by element managers that use a base-1000 system. For
example, suppose an element manager reports the size of a volume as 62,000 MB.
Use the following calculations to verify the total number of base-1024 GB as
reported by Tivoli Storage Productivity Center:
1. Multiply the volume size reported by the element manager by the number of

bytes in a base-1000 MB:
62,000 MB × 1,000,000 bytes per MB = 62,000,000,000 bytes

2. Divide the result by the number of bytes in a base-1024 MB:
62,000,000,000 bytes / 1,048,576 bytes per MB = 59,127.81 MB

3. Divide the quotient by the number of MB in a base-1024 GB:
59,127.81 MB / 1024 MB per GB = 57.74 GB

Tivoli Storage Productivity Center reports the volume size as 57.74 GB.

VMware capacity reports:

You must probe both the ESX Server and the Storage Resource agent on the virtual
machines before you can generate accurate reports for disk and file system
capacity.

The TOTAL row in the capacity report shows the capacity for the file system or the
disk capacity. The total includes virtualized disks, virtual machines, non-virtualized
disks, and non-virtualized machines.

For example, you have an ESX Server that has a capacity of 100 GB and 60 GB is
allocated to the virtual machine. The virtual machine uses 5 GB of space. Both the
ESX Server (H1) and the virtual machine (VC1) are probed. You also have a
physical machine (PC1) that is probed. The capacity is shown in the report, as
follows:

Column heading Capacity

Used space
(calculated as
Capacity minus Free
Space) Free space

TOTAL 130 GB 25 GB 105 GB

H1 100 GB 60 GB 40 GB

VC1 60 GB 5 GB 55 GB

PC1 30 GB 20 GB 10 GB

If you probed the physical machine (PC1) and the virtual machine (VC1) but did
not probe the ESX Server (hypervisor), the capacity is shown as follows:

Column heading Capacity

Used Space
(calculated as
Capacity minus Free
Space; negative
values are shown as
0) Free Space

TOTAL 30 GB 0 GB 65 GB

960 IBM Tivoli Storage Productivity Center: User's Guide



Column heading Capacity

Used Space
(calculated as
Capacity minus Free
Space; negative
values are shown as
0) Free Space

PC1 30 GB 20 GB 10 GB

VC1 60 GB 5 GB 55 GB

If you probed the hypervisor (H1) and the physical machine (PC1) but did not
probe the virtual machine (VC1), the capacity is shown as follows:

Column heading Capacity

Used Space
(calculated as
Capacity minus Free
Space) Free Space

TOTAL 130 GB 80 GB 50 GB

H1 100 GB 60 GB 40 GB

PC1 30 GB 20 GB 10 GB

If you have an ESX Server that has devices that are directly attached to the virtual
machine, the file system capacity created on the virtual machine is not added in
the TOTAL row.

For example, the file system capacity shown in the table is based on the following
factors:
v The file system (FS1) created on the hypervisor has a capacity of 100 GB and

uses 60 GB of space.
v The file system (FS1) created from internal storage on the hypervisor (H1) has a

capacity of 60 GB and uses 5 GB of space.
v The file system (FS2) on the device that is directly attached to the virtual

machine (VC1) has a capacity of 5 GB and uses 4 GB of space.
v The file system created on the physical machine (PC1) has a capacity of 30 GB

and uses 20 GB of space.

Column heading Capacity

Used Space
(calculated as
Capacity minus Free
Space) Free Space

TOTAL 130 GB 24 GB 106 GB

H1 FS1 100 GB 60 GB 40 GB

VC1 FS1 60 GB 5 GB 55 GB

VC1 FS2 5 GB 4 GB 1 GB

PC1 FS1 30 GB 20 GB 10 GB

Data Manager for Databases reports
Use Data Manager for Databases for reports to view both overview and detailed
information about your RDBMS storage resources, including instances, tablespaces,
databases, devices, containers, data files, fragments, tables, control files, redo logs,
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archive log directories, users. These reports are constructed from the statistical
information gathered by data collection jobs and accumulated in the database
repository.

Using Data Manager for Databases reports
Learn how to use Data Manager for Databases reports to view information about
the instances, tablespaces, databases, devices, containers, data files, fragments,
tables, control files, redo logs, archive log directories, and users within your
environment.

Before you begin:

Learn about information you should know before generating and viewing Data
Manager for Databases reports.

Before you can use reports to view detailed information about tables in an RDBMS,
you must have 1) defined a table group that contains the tables about which you
want to view storage information and 2) scheduled and run a scan against that
table group. See “Working with groups of resources” on page 373 for information
about using groups. See “Collecting storage usage and trending information” on
page 346 for information about scans and how to create them.

Data Manager for Databases - Report Categories:

Use the report categories within Data Manager for Databases reports to collect
information about RDBMS storage assets, capacity, usage, and usage violations.

The following table describes the categories of reports available in Data Manager
for Databases.

Report
Category Use these reports to do the following tasks

What job
collects
information for
these reports?

Asset
Reports

View the information gathered by probes. While running probes, Data Manager for
Databases itemizes the information for each type of database.

v Oracle: instances, table spaces, tables, data files, control files, redo logs, and
archive log directories

v SQL Server: instances, databases, tables, and data files

v Sybase: instances, devices, databases, tables, and fragments.

v UDB: instances, databases, table spaces, tables, containers, and users

Probes
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Report
Category Use these reports to do the following tasks

What job
collects
information for
these reports?

Capacity
Reports

View the storage capacity of different entities within an RDBMS. Specifically, use
Capacity reports to view:

v Instance storage capacity within all DBMSs. If you are monitoring the instances
for different DBMSs, you can use the All DBMSs node to view a summary of the
storage capacity for all those instances in a single view.

v Oracle databases

– How much storage you have for instances

– How much storage is being used for data files

– What percentage of storage for a data file is free for expansion

v SQL Server databases

– How much storage you have for instances

– How much storage is being used for data files

– What percentage of storage for a data file is free for expansion

v Sybase databases

– How much storage you have for instances

– How much storage is being used for devices

– What percentage of storage for a device is free for expansion

– How much storage is being used for fragments

– What percentage of storage for a fragment is free for expansion

v UDB databases

– How much allocated storage you have for a UDB Instance and the objects it
contains

– How much storage is being used for a UDB Instance and the objects it contains

– What percentage of UDB storage is free for expansion

The Capacity reporting function provides you with the ability to view the storage
capacity, used space, and free space for your RDBMS objects in a single view.

Probes
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Report
Category Use these reports to do the following tasks

What job
collects
information for
these reports?

Usage
Reports

Monitor and report on the usage and growth of the consumption of your DBMS
storage:

v Storage usage within all DBMSs. If you are monitoring the multiple DBMSs, use
this node to view common storage usage information for databases, table spaces,
tables, and users across all monitored DBMSs.

v Oracle databases

– View detailed information for table spaces including their total size, used
space, empty used space, # of tables and indexes, and so on.

– Identify the tables consuming the most space within your environment.

– Identify the segments with the most extents and most empty used space.

– Associate users with the amount of storage they are consuming on specific
databases, table spaces, groups of table spaces, specific computers, groups of
computers, and throughout the entire network.

v SQL Server databases

– View detailed information for databases including their total size, used space,
empty used space, # of tables and indexes, and so on.

– Identify the tables consuming the most space within your environment.

– Associate users with the amount of storage they are consuming on specific
databases, groups of databases, specific computers, groups of computers, and
throughout the entire network.

v Sybase databases

– View detailed information for databases including their total size, used space,
empty used space, # of tables and indexes, and so on.

– Identify the tables consuming the most space within your environment.

– Associate users with the amount of storage they are consuming on specific
databases, groups of databases, specific computers, groups of computers, and
throughout the entire network.

v UDB databases

– View detailed information for table spaces including their total size, used
space, empty used space, # of tables and indexes, and so on.

– Identify the tables consuming the most space within your environment. You
can view this information at the table space, database, and computer level, as
well as at a network-wide level.

– Associate users with the amount of storage they are consuming on specific
databases, table spaces, groups of table spaces, specific computers, groups of
computers, and throughout the entire network.

Scans

Usage
Violation
Reports

Create and enforce corporate storage usage policies. You can report on violations of
quotas that are set at the network-wide, instance, table space, and database levels.

Scans, Quotas

Reporting on RDBMS Objects:

Learn about the RDBMS objects upon which you can report using Data Manager
for Databases reports.

The following table lists the RDBMS objects whose storage usage is monitored by
Data Manager for Databases.
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Oracle SQL Server Sybase DB2/UDB

Instances Instances Instances Instances
Databases Databases Devices Databases
Tablespaces Datafiles Databases Tablespaces
Datafiles Tables Fragments Containers
Tables Indexes Tables Tables
Indexes Log Files Indexes Indexes
Extents
Segments
Redo Log files
Control Files
Archive Log
Directories
Note:

1. Each of the major reporting categories in the Reporting facility can be expanded in the
navigation tree to reveal additional sub-categories of reporting. Some of the nodes within
the reporting tree will appear only if you set up access for the RDBMS to which that
node applies. For example, if you set up for monitoring Oracle and SQL Server instances
only, nodes representing the other RDBMSs supported by Data Manager for Databases
(such as Sybase and UDB) will not appear within the navigation tree. If you have set up
access for only one RDBMS, the All DBMSs node will also not be available in some
nodes.

2. Data Manager for Databases does not currently support the monitoring of clustered
database applications.

Using By clauses:

Use the By clauses associated with Data Manager for Databases reports as a
method for viewing the data in those reports from different perspectives.

As you drill down through Data Manager for Databases’s reports, you will notice a
set of options that repeats for each report type. These By Clauses allow you to
generate variations of the reports with different perspectives and groupings of the
data. Some of the available By Clauses are described in the following table:

By Clause Description

By DBMS Type Use this clause to select the DBMS that you want to report
upon.

By Instance Use this clause to select the instances that you want to report
upon and the report that will be generated based upon those
instances.

By Device (Sybase only) Use this clause to select the devices that you want to report
upon and the report that will be generated based upon those
devices.

By Database Use this clause to select the database that you want to report
upon and the report that will be generated based upon those
databases.

By Tablespace Use this clause to select the tablespaces that you want to report
upon and the report that will be generated based upon those
tablespaces.

By Tablespace Group Use this clause to select the tablespace groups that you want to
report upon and the report that will be generated based upon
those tablespace groups.
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By Clause Description

By Fragments (Sybase
only)

Use this clause to select the fragments that you want to report
upon and the report that will be generated based upon those
fragments.

By Container (UDB only) Use this clause to select the containers that you want to report
upon and the report that will be generated based upon those
containers.

By Computer Use this clause to select the computers that you want to report
upon and the report that will be generated based upon those
computers.

By Computer Group Use this clause to select the computer groups that you want to
report upon and the report that will be generated based upon
those computer groups.

By User Use this clause to select the users that you want to report upon
and the report that will be generated based upon those users.

Network Wide The reports and charts that you see will be generated on all
data, network wide. This allows you to get a global view of the
storage and storage usage for your whole enterprise.

Asset reports
Use Asset reports to view information about the instances, devices, databases,
tablespaces, tables, containers, data files, fragments, control files, redo logs, and
archive log directories, and general hardware inventory of RDBMS storage assets
within your environment.

While running probes and scans, Data Manager for Databases itemizes your
RDBMS storage assets and provides a hierarchical view of that information so you
can drill down to view your those assets in greater detail. You can view
information about RDBMS storage resources through the following views:

Asset Reporting View Use these reports to...

Asset > By Computer View the instances and their related objects based upon the
computers on which they reside.

Asset > By DBMS Type This node appears if you are using Data Manager for
Databases to monitor more than one RDBMS. Expand this
node to view asset information about instances organized
according to their DBMS.

Asset > System-wide Investigate all of your instances, databases, tablespaces, tables,
container, data files, users and other assets for your entire
system.
Note: (UDB only) For the All DBMSs reports available under
the Asset > System-wide reporting nodes, the
Database-Tablespaces view shows information about UDB
tablespaces only.

By Computer, By DBMS Type:

Learn about the reports available within the By Computer and By DBMS Type
nodes within Asset reporting.
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Asset Report Type Use these reports to... What's in these reports?

By Computer

By Computer > machine_name >
instance/database_name

By DBMS Type

By DBMS Type > dbms_type >
instance/database_name

Drill down through your DBMS
storage assets in a hierarchical
manner according to the
computers on which they reside
or the DBMS to which they
belong.

Depending on the DBMS of the Instance you
want to view, you can drill down and expose its:
v Tablespaces
v Databases
v Devices
v Monitored tables
v Containers
v Data files
v Fragments
v Control files
v Redo logs
v Archive log directories
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Asset Report Type Use these reports to... What's in these reports?

Instance Information

By Computer

By Computer > machine_name >
instance_name

By DBMS Type

By DBMS Type > dbms_type >
instance_name

View information about all of
your monitored instances.
Specifically, you can view
information about the following
information based upon DBMS
type:

SQL Server
v Databases
v Monitored Tables
v Data Files

Oracle
v Tablespaces
v Monitored Tables
v Data Files
v Control Files
v Redo Logs
v Archive Log Directories

Sybase
v Devices
v Databases
v Monitored Tables
v Fragments

UDB
v Instances
v Databases
v Tablespaces
v Tables
v Containers
v Users

SQL Server

v RDBMS Type, Name, Version, Loginid

v Number of Databases, Number of Datafiles,
Number of Log Files

v Total Size of all Storage, Capacity of Data
Files, Free Space of Data Files, Capacity of Log
Files, Free Space of Log Files

v Probe Status, Last Probe Time

Oracle

Database Information tab

v Name, Owner, Block Size, Log Mode, Status

v Maximum Number of Instances, Number of
Tablespaces, Maximum Number of Data Files,
Number of Data Files, Maximum Number of
Log Files, Number of Log Files

v Total Size of all Storage, Capacity Of Data
Files, Free Space of Data Files

v Create Time, Discovered Time, Dropped Time

Instance Information tab

v RDBMS Type, Name, Version, Home Directory,
Loginid, Port, Probe Status

v Last Probe Time, Last Start Time, Discovered
Time

Sybase

v RDBMS Type, Name, Version, Home Directory,
Loginid, Port

v Number of Databases, Number of Devices,
Number of Fragments, Number of Log
Fragments

v Total Size of all Storage, Mirror Overhead,
Capacity of Data Fragments, Free Space in
Data Fragments, Capacity of Log Fragments,
Free Space in Log Fragments

v Probe Status, Last Probe Time

UDB

v RDBMS Type, Name, Version, Home Directory,
Loginid, Port

v Number of Tablespaces, Number of
Containers, Number of Log Files

v Total Size of all Storage, Container Capacity,
DMS Container Free Space, Total Size of all
Log Files

v Probe Status, Last Probe Time
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Asset Report Type Use these reports to... What's in these reports?

Oracle Detailed Instance
Information

By Computer

By Computer > machine_name >
instance_name

View information about the
objects associated with a
selected Oracle Instance.

v Tablespaces: When you expand the
Tablespaces node, click the name of a
tablespace to view information about that
tablespace and its related data file.

v Monitored Tables: When you expand the
Monitored Tables node, click on the name of
a table to view its information. Only the tables
that belong to Table Groups included in scans
will be available to view through this node.

v Data Files: Click the Data Files node, click the
name of a data file to view information about
the data files associated with the Instance,
including: Data File Path, Used Space, Percent
Used, Free Space, Total Size, Coalesced
Extents, Minimum Free Extent Size, Maximum
Free Extent Size, and Create Time.

v Control Files: Click this node to view
information on the control files associated
with the Instance, including the File Name
(full path) and File Size.

v Redo Logs: Click this node to view
information on the redo logs associated with
the Instance.

– for Log Group: Sequence Number, Status,
Archived, Total Size

– for Log File: File Name (full path)

v Archive Log Directories: Click this node to
view information on the archive log directory
associated with the Instance, including
Directory Name, Size of Files, File Count,
Status, Last Failure Time.

SQL Server Detailed Instance
Information

By Computer By Computer >
machine_name > server_name

By DBMS Type By DBMS Type
> SQL/Server > server_name

View information about the
objects associated with a
selected SQL Server Instance.

v Databases: When you expand the Databases
node, click the name of a Database to view
information about that database, its related
data file, and its related log file.

v Monitored Tables: When you expand the
Monitored Tables node, click on the name of
a table to view its information including the
computer, instances, and database on which is
resides, as well as its creator, total size, empty
used space, index size, number of indexes,
row count, etc.

Only the tables that belong to table groups
included in scans will be available to view
through this node.

v Data Files: Click the Data Files node, click the
name of a data file to view information about
the data files associated with the Instance,
including: Data File Path, Used Space, Percent
Used, Free Space, Total Size, Coalesced
Extents, Minimum Free Extent Size, Maximum
Free Extent Size, and Create Time.
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Asset Report Type Use these reports to... What's in these reports?

Sybase Detailed Instance
Information

By Computer

By Computer > machine_name >
instance_name

By DBMS Type

By DBMS Type > Sybase >
instance_name

view information about the
objects associated with a
selected Sybase Instance.

v Devices: Click this node to view information
about the Device associated with the Instance,
including its name, computer on which it
resides, path, free space, percent free, used
space, total size, fragments, mirror path, etc.

v Databases: When you expand the Databases
node, click the name of a Database to view
information about that database, its device
information, and its related fragment
information.

v Monitored Tables: When you expand the
Monitored Tables node, click on the name of
a table to view its information including the
computer, instances, and database on which is
resides, as well as its creator, total size, empty
used space, index size, number of indexes,
row count, etc.

Only the tables that belong to table groups
included in scans will be available to view
through this node.

v Fragments: Click this node to view about the
Fragments associated with the Instance
including the computer, instances, and
database on which they resides as well as their
path, used space, percent used, free space,
total size, data type, etc.

UDB Detailed Instance
Information

By Computer

By Computer > machine_name >
instance_name

By DBMS Type >

view information about the
objects associated with a
selected UDB Instance.

v Databases: When you expand the Databases
node, click the name of a databases to view
information about that database.

v Monitored Tables: When you expand the
Monitored Tables node, click on the name of
a table to view its information. Only the tables
that belong to Table Groups included in scans
will be available to view through this node.

v Containers: Click the Containers node, click
the name of a container to view information
about the containers associated with the
Instance, including: Database, Tablespace,
Container Node, Container Name, Used Space,
Percent Used, Free Space, Total Size, Container
Type, Status, Discovered Time.

System-wide:

Use System-wide reports to view your RDBMS storage assets as a whole, across
the storage environment
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Asset Report Type Use these reports to... What's in these reports?

System-Wide

Asset > System-wide

drill down through your DBMS
storage assets in a hierarchical
manner.

Depending on the DBMS of the Instance you
want to view, you can drill down and expose
its:
v Tablespaces
v Databases
v Devices
v Monitored tables
v Containers
v Data files
v Fragments
v Control files
v Redo logs
v Archive log directories

All DBMSs

Asset > System-wide >All DBMSs

view information about all the
DBMSs within your
environment based on the
objects related to those
instances.

v Instances: Expand the Instances node and
click the sorting method by which you
want to view instances.

v Databases-Tablespaces: Expand
Databases-Tablespaces node and click the
sorting method by which you want to view
information about the databases and/or
tablespaces within your environment.

v Tables: Expand the Tables node and click
the sorting method by which you want to
view tables. Only the tables that belong to
table groups included in scans will appear
within the reports viewed through this
node.

v Files: Expand the Files node and click the
sorting method by which you want to view
information about data files/containers,
which includes: File Path, Free Space,
Percent Free, Used Space, Total Size, Create
Time, and Discovered Time.

v Users: Expand the Users node and click
the sorting method by which you want to
view the users who are consuming space
on the monitored DBMS within your
environment.
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Asset Report Type What's in these reports?

All DBMSs (continued) v Instances: Expand the Instances node and click the sorting method by which you
want to view instances.

– By Instance: sort based on Instance name

– By Version: sort based on the version of the DBMS under which an Instance is
running

– By Start Time: sort based upon when an Instance was last started

– By Probe Time: sort based upon when an Instance was last probed

– By RDBMS Type: sort based upon the DBMS of an Instance

v Databases-Tablespaces: Expand the Databases-Tablespaces node and click the
sorting method by which you want to view information about the databases or
tablespaces within your environment.

– By Database-Tablespace: sort based on DB/TB name

– By Freespace: sort based on the amount of free space on a DB/TB

– By Total Size: sort based on the total size of a DB/TB

– By Table Count: sort based upon the number of tables on a DB/TB

– By Scan Time: sort based upon when a DB/TB was last scanned

– By Discovered Time: sort based upon when a DB/TB was discovered

– Dropped Tablespaces: sort based upon dropped DBs or TBs.

– By RDBMS Type: sort based upon the DBMS of a DB/TB

v Tables: Expand the Tables node and click the sorting method by which you want
to view tables. Only the tables that belong to Table Groups included in scans will
appear within the reports viewed through this node.

– By Table: sort based on table name

– By Number of Indexes: sort based upon the number of indexes associated with
a table

– By Total Size: sort based on the total size of a table

– By Row Count: sort based upon the number of rows in a table

– By Chained Row Count: sort based upon the number of chained rows in a
table

– By Discovered Time: sort based upon when a table was discovered

– Dropped Tables: sort based upon dropped tables

– By RDBMS Type: sort based upon the DBMS of a table

v Files: Expand the Files node and click the sorting method by which you want to
view information about DBMS files.

– By File: sort based on file name

– By Free Space: sort based upon file free space

– By Total Size: sort based on the total size of a file

– By Discovered Time: sort based upon when a file was discovered

– By RDBMS Type: sort based upon the DBMS of a file

v Users: Expand the Users node and click the sorting method by which you want to
view the users who are consuming space on the monitored DBMS within your
environment.
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Asset Report Type What's in these reports?

Oracle

Asset > System-wide > Oracle

v Instances: Expand the Instances node and click the sorting method by which
you want to view instances.

– By Instance: sort based on Instance name

– By Version: sort based on the version of the DBMS under which an Instance
is running

– By Start Time: sort based upon when an Instance was last started

– By Probe Time: sort based upon when an Instance was last probed

v Tablespaces: Expand this node and click the sorting method by which you
want to view information about tablespaces within your environment.

– By Tablespace: sort based on tablespace name

– By Max Free Extent: sort based on the maximum free extent size

– By Freespace: sort based on the amount of free space on a tablespace

– By Total Size: sort based on the total size of a tablespace

– By Coalesced Extents: sort based on the number of coalesced extents

– By Table Count: sort based upon the number of tables

– By Scan Time: sort based upon when a tablespace was last scanned

– By Discovered Time: sort based upon when a tablespace was discovered

– Dropped Tablespaces: sort based upon dropped tablespaces

v Tables: Expand the Tables node and click the sorting method by which you
want to view tables. Only the tables that belong to Table Groups included in
scans will appear within the reports viewed through this node.

– By Table: sort based on table name

– By Number of Indexes: sort based upon the number of indexes associated
with a table

– By Total Size: sort based on the total size of a table

– By Row Count: sort based upon the number of rows in a table

– By Chained Row Count: sort based upon the number of chained rows in a
table

– By Discovered Time: sort based upon when a table was discovered

– Dropped Tables: sort based upon dropped tables

v Data Files: Expand the Data Files node and click the sorting method by which
you want to view information about DBMS files.

– By Data File: sort based on file name

– By Max Free Extent: sort data files sorted by their max free extent sizes

– By Free Space: sort based upon file free space

– By Total Size: sort based on the total size of a file

– With Auto-extend: sort data files that have auto-extend specified

– Without Auto-extend: sort data files that do not have auto-extend specified

– By Discovered Time: sort based upon when a file was discovered

v Users: Expand the Users node and click the sorting method by which you
want to view the users who are consuming space on the monitored Oracle
instances within your environment.

Chapter 8. Reporting in the stand-alone GUI 973



Asset Report Type What's in these reports?

SQL Server

Asset > System-wide >
SQL/Server

v Instances: Expand the Instances node and click the sorting method by which
you want to view instances.

– By Instance: sort based on Instance name

– By Version: sort based on the version of the DBMS under which an Instance
is running

– By Probe Time: sort based upon when an Instance was last probed

v Databases: Expand this node and click the sorting method by which you want
to view information about databases within your environment.

– By Database: sort based on database name

– By Freespace: sort based on the amount of free space on a database

– By Total Size: sort based on the total size of a database

– By Table Count: sort based upon the number of tables in the database

– By Scan Time: sort based upon when a database was last scanned

– By Discovered Time: sort based upon when a database was discovered

– Dropped Databases: sort based upon dropped databases

v Tables: Expand the Tables node and click the sorting method by which you
want to view tables. Only the tables that belong to Table Groups included in
scans will appear within the reports viewed through this node.

– By Table: sort based on table name

– By Number of Indexes: sort based upon the number of indexes associated
with a table

– By Total Size: sort based on the total size of a table

– By Row Count: sort based upon the number of rows in a table

– By Discovered Time: sort based upon when a table was discovered

– Dropped Tables: sort based upon dropped tables

v Data Files: Expand the Data Files node and click the sorting method by which
you want to view information about data files.

– By Data File: sort based on file name

– By Free Space: sort based upon file free space

– By Total Size: sort based on the total size of a file

– With Auto-extend: sort data files that have auto-extend specified

– Without Auto-extend: sort data files that do not have auto-extend specified

– By Discovered Time: sort based upon when a file was discovered

v Users: Expand the Users node and click the sorting method by which you
want to view the users who are consuming space on the monitored SQL
Server instances.

– By Users: sort based on user names

– By Discovered Time: sort based when a user was discovered
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Asset Report Type What's in these reports?

Sybase

Asset > System-wide > Sybase

v Instances: Expand the Instances node and click the sorting method by which
you want to view instances.

– By Instance: sort based on Instance name

– By Version: sort based on the version of the DBMS under which an Instance
is running

– By Probe Time: sort based upon when an Instance was last probed

v Devices: Expand this node and click the sorting method by which you want to
view information about devices within your environment.

– By Device: sort based on device name

– By Freespace: sort based on the amount of free space on a device

– By Total Size: sort based on the total size of a device

– By Fragments: sort based upon the number of fragments for a device

– By Discovered Time: sort based upon when a device was discovered

– Dropped Devices: sort based upon dropped devices

v Databases: Expand this node and click the sorting method by which you want
to view information about databases within your environment.

– By Database: sort based on database name

– By Freespace: sort based on the amount of free space on a database

– By Total Size: sort based on the total size of a database

– By Table Count: sort based upon the number of tables in the database

– By Scan Time: sort based upon when a database was last scanned

– By Discovered Time: sort based upon when a database was discovered

– By Last Dump Time: sort based on the date/time when devices were last
dumped

– Dropped Databases: sort based upon dropped databases

v Fragments: Expand this node and click the sorting method by which you want
to view information about fragments.

– By Fragments: sort based on fragment name

– By Free Space: sort based upon the free space in fragments

– By Total Size: sort based on the total size of fragments

– By Discovered Time: sort based upon when fragments were discovered

v Tables: Expand the Tables node and click the sorting method by which you
want to view tables. Only the tables that belong to Table Groups included in
scans will appear within the reports viewed through this node.

– By Table: sort based on table name

– By Number of Indexes: sort based upon the number of indexes associated
with a table

– By Total Size: sort based on the total size of a table

– By Row Count: sort based upon the number of rows in a table

– By Chained Row Count: sort based upon the number of chained rows in a
table

– By Discovered Time: sort based upon when a table was discovered

– Dropped Tables: sort based upon dropped tables

v Users: Expand the Users node and click the sorting method by which you
want to view the users who are consuming space on the monitored Sybase
instances.
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Asset Report Type What's in these reports?

UDB

Asset > System-wide > UDB

v Instances: Expand the Instances node and click the sorting method by which
you want to view instances.

– By Instance: sort based on Instance name

– By Version: sort based on the version of the DBMS under which an Instance
is running

– By Probe Time: sort based upon when an Instance was last probed

v Databases: Expand this node and click the sorting method by which you want
to view information about databases within your environment.

– By Database: sort based on database name

– By Freespace: sort based on the amount of free space on a database

– By Total Size: sort based on the total size of a database

– By Table Count: sort based upon the number of tables in the database

– By Scan Time: sort based upon when a database was last scanned

– By Discovered Time: sort based upon when a database was discovered

– Dropped Databases: sort based upon dropped databases

v Tablespaces: Expand this node and click the sorting method by which you
want to view information about tablespaces.

– By Tablespace: sort based on tablespace name

– By FreeSpace: sort based upon the freespace in tablespaces

– By Total Size: sort based on the total size of tablespaces

– By Table Count: sort based upon the number of tables associated with
tablespaces

– By Scan Time: sort based upon the date/time when tablespaces were
scanned

– By Discovered Time: sort based upon the date/time when tablespaces were
discovered

– Dropped Tablespaces: sort based upon the names of dropped tablespaces

v Tables: Expand the Tables node and click the sorting method by which you
want to view tables. Only the tables that belong to Table Groups included in
scans will appear within the reports viewed through this node.

– By Table: sort based on table name

– By Number of Indexes: sort based upon the number of indexes associated
with a table

– By Total Size: sort based on the total size of a table

– By Row Count: sort based upon the number of rows in a table

– By Chained Row Count: sort based upon the number of chained rows in a
table

– By Discovered Time: sort based upon the date/time when a table was
discovered

– Dropped Tables: sort based upon the names of dropped tables
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Asset Report Type What's in these reports?

v Containers: Expand the Containers node and click the sorting method by
which you want to view containers.

– By Container: sort based on container name

– By Freespace: sort based upon the freespace in containers

– By Total Size: sort based on the total size of containers

– With Auto–extend: sort based upon whether containers with Auto-extend
on

– Without Auto–extend: sort based upon whether containers with
Auto-extend off

– By Discovered Time: sort based upon the date/time when container were
discovered

v Users: Expand the Users node and click the sorting method by which you
want to view the users who are consuming space on the monitored UDB
instances.

Capacity reports
Use Capacity reports to view the storage capacity, used space, and free space for
your RDBMS objects.

Capacity enable you to view storage capacity at the computer, instance, database,
device, fragment, container, and data file level. For a specific Instance, computer,
group of computers, database, group of databases, tablespace, group of tablespaces,
datafiles, containers, fragments, or all the computers in your enterprise, you can
view the following:
v How much storage you have for a DBMS and the objects it contains
v How much storage is being used for a DBMS and the objects it contains
v What percentage of DBMS storage is free for expansion

All DBMSs Capacity reports:

Use these reports to view storage capacity information about the different RDBMS
instances that you are monitoring within your environment.

Capacity Reporting View Use these reports to...

Capacity > All DBMSs > Total Instance
Storage

If you have multiple RDBMSs that you monitor using Data Manager, use
this node to view detailed storage information about the different RDBMS
instances within your environment.

Depending on the RDBMS of the instance you want to view, use this
report to view information about its:
v RDBMS instance
v RDBMS type
v total size
v file capacity
v file free space
v DB-TS count
v file count
v log file count
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Oracle Capacity reports:

Use these reports to view storage capacity information about the Oracle instances
that you are monitoring within your environment.

Capacity Reporting View Use these reports to...

Oracle

Capacity > Oracle

By Clauses for these reports:

v By Instance: sort based on Instance
name

v By Database: sort a report by database
name

v By Tablespace: sort a report by
tablespace name

v By Tablespace Group: view the desired
storage information organized by
tablespace group

v By Datafile: sort based on file name

v By Computer: sort based on the
computer where the object's Instance
resides

v By Computer Group: view the desired
storage information organized by
computer group

v Network-wide: view the desired
storage information for your entire
network

This node appears if you are using Data Manager for Databases to
monitor Oracle instances. Expand this node to view the following
information:

v Total Instance Storage. Generate a report under this node to view
detailed information about Oracle instances, including:

– total size

– file capacity

– file free space

– DB-TS count

– file count

– log file count

v Data File Used Space. Generate a report under this node to view
detailed information about the storage usage of datafiles associated
with the tablespaces in an Instance, including:

– tablespace

– data file path

– used space

– percent used

– free space

– total size

– free extents

– coalesced extents

– maximum free extent size

v Data File Free Space. Generate a report under this node to view
detailed information about the storage free space of datafiles associated
with the tablespaces in an Instance, including:

– tablespace

– data free space

– percent free

– data used space

– data size

– free extents

– coalesced extents

– maximum free extent size

SQL Server Capacity reports:

Use these reports to view storage capacity information about the SQL Server
instances that you are monitoring within your environment.
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Capacity Reporting View Use these reports to...

SQL Server

Capacity > SQL/Server

By Clauses for these reports:

v By Instance: sort based on Instance
name

v By Database: sort a report by database
name

v By Database Group: view the desired
storage information organized by
database group

v By Datafile: sort based on file name

v By Computer: sort based on the
computer where the object’s Instance
resides

v By Computer Group: view the desired
storage information organized by
computer group

v Network-wide: view the desired
storage information for your entire
network

This node appears if you are using Data Manager for Databases to
monitor SQL Server instances. Expand this node to view the following
information:

v Total Instance Storage. Generate a report under this node to view
detailed information about SQL Server instances, including:

– total size

– data file capacity

– data file free space

– log file capacity

– log file free space

– database count

– data file count

– log file count

v Data File Used Space. Generate a report under this node to view
detailed information about the storage usage of datafiles associated
with the databases in an Instance, including:

– database

– data used space

– percent used

– data free space

– data size

– log used space

– log percent used

– log free space

– log size

– number data files

v Data File Free Space. Generate a report under this node to view
detailed information about the storage free space of datafiles associated
with the databases in an Instance, including:

– database

– data free space

– percent free

– data used space

– data size

– log free space

– log percent used

– log used space

– log size

– number data files

Sybase Capacity reports:

Use these reports to view storage capacity information about the Sybase instances
that you are monitoring within your environment.
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Capacity Reporting View Use these reports to...

Sybase

Capacity > Sybase

By Clauses for these reports:

v By Device: sort based on Device name

v By Instance: sort based on Instance
name

v By Fragments: sort based upon
fragments

v By Database: sort a report by database
name

v By Database Group: view the desired
storage information organized by
database group

v By Datafile: sort based on file name

v By Computer: sort based on the
computer where the object’s Instance
resides

v By Computer Group: view the desired
storage information organized by
computer group

v Network-wide: view the desired
storage information for your entire
network

This node appears if you are using Data Manager for Databases to
monitor Sybase instances. Expand this node to view the following
information:

v Total Instance Storage. Generate a report under this node to view
detailed information about Sybase instances, including:

– total device size

– mirrored device size

– device free space

– data fragment capacity

– data fragment free space

– log fragment capacity

– log fragment free space

– device count

– database count

– fragment count

– log fragment count

v Device Used Space. Generate a report under this node to view detailed
information about the storage usage of devices associated with
instances, including:

– Instance

– device path

– used space

– percent used

– free space

– total size

– number fragments

– mirror path

– number devices

v Device Free Space. Generate a report under this node to view detailed
information about the storage free space of devices associated instances,
including:

– Instance

– device path

– free space

– percent free

– used space

– total size

– number fragments

– low, high

– mirror path

– number devices

980 IBM Tivoli Storage Productivity Center: User's Guide



Capacity Reporting View Use these reports to...

Sybase (continued)
v Fragment Used Space. Generate a report under this node to view

detailed information about the storage usage of fragments associated
with databases, including:

– Instance

– fragment path

– database

– data used space

– percent used

– data free space

– data size

– data type

– log used space

– log percent used

– log free space

– log size

– number fragments

v Fragment Free Space. Generate a report under this node to view
detailed information about the storage free space of fragments
associated databases, including:

– Instance

– fragment path

– database

– data free space

– percent free

– data used space

– data size

– log free space

– log used space

– log percent used

– log used space

– log size

– number fragments

UDB Capacity reports:

Use these reports to view storage capacity information about the UDB instances
that you are monitoring within your environment.
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Capacity Reporting View Use these reports to...

UDB

Capacity > UDB

By Clauses for these reports:

v By Container: sort based on Container
name

v By Tablespace: sort based on
Tablespace name

v By Database: sort a report by database
name

v By Database Group: view the desired
storage information organized by
database group

v By Instance: sort based on Instance
name

v By Computer: sort based on the
computer where the object’s Instance
resides

v By Computer Group: view the desired
storage information organized by
computer group

v Network-wide: view the desired
storage information for your entire
network

This node appears if you are using Data Manager for Databases to
monitor UDB instances. Expand this node to view the following
information:

v Total Instance Storage. Generate a report under this node to view
detailed information about UDB instances, including:

– total size

– container capacity

– container free space

– log file capacity

– tablespace count

– container count

– log file count

– log mode

v Container Used Space. Generate a report under this node to view
detailed information about the storage usage of containers associated
with a tablespace, including:

– Instance

– database

– tablespace

– container node

– container name

– used space

– percent used

– free space

– total size

– container type

– status

– discovered time

v Container Free Space. Generate a report under this node to view
detailed information about the storage free space of containers
associated with a tablespace, including:

– Instance

– database

– tablespace

– container node

– container name

– free space

– percent free

– used space

– total size

– container type

– status

– discovered time

Usage reports
Use Usage reports to monitor and report on the usage and growth of the storage
consumption for your databases, tablespaces, tables, segments, and users.
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Use these reports to do the following:
v View detailed information for tablespaces and databases including their total

size, used space, empty used space, # of tables and indexes, etc.
v Identify the tables consuming the most space within your environment. You can

view this information at the tablespace, database, and computer level, as well as
at a network-wide level.

v (Oracle) Identify the segments with the most extents and most empty used
space. You can view this information at the tablespace, database, and computer
level, as well as at a network-wide level.

v Associate users with the amount of storage they are consuming on specific
databases, groups of databases, tablespaces, groups of tablespaces, specific
computers, groups of computers, and throughout the entire network.

All DBMS Usage reports:

Use these reports to view storage usage information about the different RDBMS
instances that you are monitoring within your environment.

Usage Reporting View Use these reports to...

Usage > All DBMSs If you have multiple RDBMSs that you monitor using Data Manager, use
this node to view detailed storage information about the different RDBMS
instances within your environment.

Usage > All DBMSs >
Databases-Tablespaces

view storage usage statistics about the databases and tablespaces with
your monitored DBMSs. Some of the information you can view through
these reports includes:
v database name, tablespace name
v computer
v Instance
v Instance type
v total size
v used space
v empty used space
v table count
v index count
v other count

Usage > All DBMSs > Tables view storage usage statistics about the tables with your monitored
DBMSs. Some of the information you can view through these reports
includes the following:
v Largest tables
v Total size
v Creator
v Table name
v Empty used space
v Index size
v Row count
v Chained row count
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Usage Reporting View Use these reports to...

Usage > All DBMSs > Users associate users with the amount of storage they are consuming on specific
DBMS objects, specific computers, groups of computers, and throughout
the entire network.

v Group by User Name: select the users and then the resources on which
you want to report storage consumption.

For example, when setting up a report to view user storage
consumption on an Oracle or UDB tablespace, you must do the
following:

– Select the users upon which you want to report

– Select the tablespaces whose storage consumption by the selected
users you want to view

v Group by Resource: select the resources and then the users on which
you want to report storage consumption.

For example, when setting up a report to view storage consumption on
Oracle or UDB tablespaces for users, you must do the following:

– Select the tablespaces upon which you want to report

– Select the users whose storage consumption on the selected
tablespaces you want to view

Oracle Usage reports:

Use these reports to view storage usage information about the Oracle tablespaces,
tables, segments, and users that you are monitoring within your environment.

Usage Reporting View Use these reports to...

Oracle

Usage > Oracle

By Clauses for these reports:

v By Database—sort a report by database
name

v By Tablespace—sort a report by
tablespace name

v By Tablespace Group—view the
desired storage information organized
by tablespace group

v By Table—sort a report by table name

v By Table Group—view the desired
storage information organized by table
group

v By Computer—sort based on the
computer where the object’s Instance
resides

v By Computer Group—view the desired
storage information organized by
computer group

v Network-wide—view the desired
storage information for your entire
network

This node appears if you are using Data Manager for Databases to
monitor Oracle instances. Expand this node to view the following
information:

v Tablespaces. View detailed information for tablespaces including the
following:
– Instance
– Database
– Total size
– Used space
– Empty used space
– Freelist blocks
– Table count
– Index count

v Tables. Identify the tables consuming the most space within your
environment. You can view this information at the tablespace, database,
and computer level, as well as at a network-wide level. Some of the
information in these reports includes the following:
– Table name
– Total size
– Empty used space
– Index size
– Freelist blocks
– Number partitions
– Number indexes
– Number segments
– Number extents
– Percent free, used
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Usage Reporting View Use these reports to...

Oracle

Usage → Oracle

By Clauses for these reports:

v By Database—sort a report by database
name

v By Tablespace—sort a report by
tablespace name

v By Tablespace Group—view the
desired storage information organized
by tablespace group

v By Table—sort a report by table name

v By Table Group—view the desired
storage information organized by table
group

v By Computer—sort based on the
computer where the object’s Instance
resides

v By Computer Group—view the desired
storage information organized by
computer group

v Network-wide—view the desired
storage information for your entire
network

This node appears if you are using Data Manager for Databases to
monitor Oracle instances. Expand this node to view the following
information:

v Segments. Identify the segments with the most extents and most empty
used space. Some of the information in these reports includes the
following:
– Number extents
– Segment name, creator
– Tablespace
– Parent name, creator
– Total size
– Empty used space
– Number extents
– Freelist blocks, groups

v Users. Associate users with the amount of storage they are consuming
on specific databases, tablespaces, groups of tablespaces, specific
computers, groups of computers, throughout the entire network, and
applied Quotas. Some of the information included in these reports
includes the following:

– Computer, instance, database, tablespace

– Total size

– Empty used space

– Table count

– Index count

– Largest segment, 2nd largest segment

– Segment sizes: <50Kb, 500Kb-100Mb, 1Mb-10Mb, 10Mb-100Mb,
100Mb-500MB, 500Mb-1Gb, >1Gb

– Quota name

– Percent of Quota

– Quota threshold

SQL Server Usage reports:

Use these reports to view storage usage information about the SQL Server
databases, tables, and users that you are monitoring within your environment.
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Usage Reporting View Use these reports to...

SQL Server

Usage > SQL/Server

By Clauses for these reports:

v By Instance: sort based on Instance
name

v By Database: sort a report by database
name

v By Database Group: view the desired
storage information organized by
database group

v By Computer: sort based on the
computer where the object’s Instance
resides

v By Computer Group: view the desired
storage information organized by
computer group

v Network-wide: view the desired
storage information for your entire
network

v By User Quota: sort based upon the
users to which Quotas are applied. A
user who has not violated a quota will
not appear in this report.

This node appears if you are using Data Manager for Databases to
monitor storage usage on SQL Server instances. Expand this node to view
the following information:

v Databases. Generate a report under this node to view detailed
information about the storage on SQL Server databases, including the
following:
– Total size
– Used space
– Empty used space
– Table count
– Index count

v Tables. Identify the tables consuming the most space within your
environment. You can view this information at the table, database, and
computer level, as well as at a network-wide level. Some of the
information in these reports includes the following:
– Table name
– Total size
– Empty used space
– Index count
– Row count

v Users. Associate users with the amount of storage they are consuming
on specific databases, groups of databases, specific computers, groups
of computers, throughout the entire network, and applied Quotas .
Some of the information in these reports includes the following:
– Computer, instance, database
– Total size
– Empty used space
– Table count
– Index count
– Largest object, 2nd largest object
– Object sizes: <50Kb, 500Kb-100Mb, 1Mb-10Mb, 10Mb-100Mb,

100Mb-500MB, 500Mb-1Gb, >1Gb
– Quota name
– Percent of Quota
– Quota threshold

Sybase Usage reports:

Use these reports to view storage usage information about the Sybase databases,
tables, and users that you are monitoring within your environment.
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Usage Reporting View Use these reports to...

Sybase

Usage > Sybase

v By Database: sort a report by database
name

v By Database Group: view the desired
storage information organized by
database group

v By Computer: sort based on the
computer where the object’s Instance
resides

v By Computer Group: view the desired
storage information organized by
computer group

v Network-wide: view the desired
storage information for your entire
network

v By User Quota: sort based upon the
users to which Quotas are applied. A
user who has not violated a quota will
not appear in this report.

This node appears if you are using Data Manager for Databases to
monitor storage usage on Sybase instances. Expand this node to view the
following information:

v Databases. Generate a report under this node to view detailed
information about the storage on Sybase databases, including the
following:
– Database name, computer, instance
– Total size
– Used space
– Empty used space
– Table count
– Index count

v Tables. Identify the tables consuming the most space within your
environment. You can view this information at the table, database, and
computer level, as well as at a network-wide level. Some of the
information in these reports includes the following:
– Table name, database, computer, Instance, creator
– Total size
– Empty used space
– Index size
– Maximum rows per page
– Expected row size
– Fill factor
– Page gap
– Average row length
– Row count

v Users. Associate users with the amount of storage they are consuming
on specific databases, groups of databases, specific computers, groups
of computers, throughout the entire network, and applied Quotas.
Some of the information included in these reports includes the
following:
– Computer, instance, database
– Total size
– Empty used space
– Table, index count
– Largest object, 2nd largest object
– Object sizes: <50Kb, 500Kb-100Mb, 1Mb-10Mb, 10Mb-100Mb,

100Mb-500MB, 500Mb-1Gb, >1Gb
– Quota name
– Percent of Quota
– Quota threshold

UDB reports:

Use these reports to view storage usage information about the UDB tablespaces,
tables, and users that you are monitoring within your environment.
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Usage Reporting View Use these reports to...

UDB

Usage > UDB

v By Tablespace: sort a report by
tablespace name

v By Tablespace Group: view the desired
storage information organized by
tablespace group

v By Database: sort a report by database
name

v By Instance: sort a report by Instance
name

v By Computer: sort based on the
computer where the object’s Instance
resides

v By Computer Group: view the desired
storage information organized by
computer group

v Network-wide: view the desired
storage information for your entire
network

This node appears if you are using Data Manager for Databases to
monitor storage usage on UDB instances. Expand this node to view the
following information:

v Tablespaces. Generate a report under this node to view detailed
information about the storage on UDB tablespaces, including the
following:
– Database name, computer, instance
– Total size
– Used space
– Empty used space
– Table count
– Index count

v Tables. Identify the tables consuming the most space within your
environment. You can view this information at the table, database, and
computer level, as well as at a network-wide level. Some of the
information in these reports includes the following:
– Table name, database, computer, Instance, creator
– Total size
– Empty used space
– Index size
– Maximum rows per page
– Expected row size
– Fill factor
– Page gap
– Average row length
– Row count

Note: When viewing reports under the Monitored Tables node, keep
in mind that a table will appear in this report if: 1) it is included in the
definition of a table group and 2) the table group in which it is
included is defined as part of a scan.

v Users. Associate users with the amount of storage they are consuming
on specific UDB instances, tablespaces, groups of tablespaces,
computers, groups of computers, and throughout the entire network.
Some of the information included in these reports includes the
following:
– Computer, instance
– Total size
– Empty used space
– Table, index count
– Largest object, 2nd largest object
– Object sizes: <50Kb, 500Kb-100Mb, 1Mb-10Mb, 10Mb-100Mb,

100Mb-500MB, 500Mb-1Gb, >1Gb
– Quota name
– Percent of Quota
– Quota threshold

Usage Violation reports
Use Usage Violation reports to view information about quota violations and help
enforce corporate storage usage policies.

With quotas, you can control how much storage a user, or a group of users, can
consume on the following:
v Database or group of databases
v Tablespace or group of tablespaces
v Instance
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v Throughout the entire network

The following table contains information about Usage Violation reports:

Usage Violation Reporting Type Use these reports to... What’s in these reports?

Quota Violations

Usage Violations > Quota Violations

identify the quota violations within the
environment

All Quotas

Usage Violations > Quota Violations >
All Quotas

view all the quotas and quota violations
in the environment

v By User. View information about the
users who have violated quotas.

v By User Quota. View information
about the quotas that have been
violated.

v User name
v RDBMS type
v Instance
v Database-tablespace
v Space used
v Threshold
v % of threshold
v Number of violations
v Quota creator
v Quota name
v Quota type

Network Wide Quotas

Usage Violations > Quota Violations >
Network-wide Quotas

view quota violations at the
network-wide level

v By User. View information about the
users who have violated quotas.

v By User Quota. View information
about the quotas that have been
violated and which users have
violated them.

v User name
v Space used
v Threshold
v % of threshold
v Number of violations
v Quota creator
v Quota name
v Quota type

Instance Quotas

Usage Violations > Quota Violations >
Instance Quotas

view quota violations at the Instance
level

v By Instance. View Instance quota
violations sorted by Instance

v By Computer. View Instance quota
violations sorted by computer

v By Computer Group. View Instance
quota violations sorted by computer
group

v By User. View Instance quota
violations sorted by users

v By User Quota. View Instance quota
violations sorted by quota

v Computer
v RDBMS type
v Group creator (by group

clauses only)
v Group name (by group clauses

only)
v Instance
v Database-tablespace
v User name
v Space used
v Threshold
v % of threshold
v Number of violations
v Quota creator
v Quota name
v Quota type
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Usage Violation Reporting Type Use these reports to... What’s in these reports?

Database-Tablespace Quotas

Usage Violations > Quota Violations >
Database-Tablespace Quotas

view quota violations at the tablespace
level

v By Database-Tablespace. View quota
violations sorted by the database or
tablespace name on which the
violation occurred

v By Database-Tablespace Group. View
quota violations sorted by the
database or tablespace group in which
the violation occurred

v By Instance. View database or
tablespace quota violations sorted by
Instance

v By Computer. View database or
tablespace quota violations sorted by
computer

v By Computer Group. View database
or tablespace quota violations sorted
by computer group

v By User. View database or tablespace
quota violations sorted by users

v By User Quota. View database or
tablespace quota violations sorted by
quota

v Computer
v Group creator (by group

clauses only)
v Group name (by group clauses

only)
v Instance
v Database-tablespace
v User name
v Space used
v Threshold
v % of threshold
v Number of violations
v Quota creator
v Quota name
v Quota type

Data Manager for Chargeback reports
Use invoices generated by Data Manager for Chargeback to charge users or groups
of users for storage usage within a storage environment.

See “Working with invoices” on page 613 for information about how to use Data
Manager for Chargeback to generate invoices.

Disk Manager reports
Use Disk Manager reports to view the relationships among the components of a
storage subsystem and the storage capacity for a computer, filesystem, storage
subsystem, volume, Array Sites, Ranks, and disk.

Reporting on storage subsystems
Learn how to use Disk Manager to report on storage subsystems.

These reports also enable you to view the relationships among the components of a
storage subsystem. Storage-subsystems reports use data gathered by probes.

To ensure the accuracy and consistency of the data that appears in
storage-subsystem reports, run regularly scheduled probes against the hosts that
use or import volumes, and the storage subsystems upon which you want to
report. You should run probes against storage subsystems after running them
against any host.
v A disk must be partitioned before it is considered a logical volume by Disk

Manager. If a disk is not partitioned, it will not be included in a file system or
logical volumes report.
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v Before you begin, you might want to refer to Generating and viewing reports.
That section provides information on reports that applies all IBM Tivoli Storage
Productivity Center reports. It describes the types of reports: system,
user-defined, and batch. It also describes how to save reports and how to
customize reports, such as filtering information and displaying the information
in chart form.

You can view storage subsystem reports in the following ways:

Disks Use these reports to view and chart the storage capacity of storage
subsystem disks. Use By clauses to filter the storage entities that appear in
a report. For example, if you want to view a report that displays specific
disks, select By Disk; if you want to view the disks of specific storage
subsystems, select By Storage Subsystems.

Volumes
Use these reports to view and chart the storage capacity of storage
subsystem volumes. Use the By Storage Subsystem and By Storage
Subsystem Group clauses to filter the storage entities that appear in a
report; use the By Volume Space and By Probe Time clauses to sort the
volumes that appear in a report according the when a volume was probed
or the capacity of a volume.

Storage Pools
Use these reports to view and chart the storage capacity of storage pools.
Use By clauses to filter the storage entities that appear in a report. For
example, if you want to view a report that displays information about the
storage pools for specific storage systems, select By Storage Subsystem.

Array Sites
Use these reports to view information about the array sites that reside on
storage subsystems. Use By clauses to filter the storage entities that appear
in a report. For example, if you want to view a report that displays about
the array sites for specific groups of storage subsystems, select By Storage
Subsystem Group.

Disk Groups
Use these reports to view information about the disk groups that reside on
storage subsystems. Use the By clauses to filter the storage entities that
appear in a report. For example, if you want to view a report that displays
about the disk groups for specific storage subsystems, select By Storage
Subsystem.

Ranks Use these reports to view information about the ranks that reside on
storage subsystems. Use the By clauses to filter the storage entities that
appear in a report. For example, if you want to view a report that displays
about the ranks for specific groups of storage subsystems, select By
Storage Subsystem Group.

Computer Views
Use these reports to view the relationships between the computer and the
storage subsystems, volumes, and disks in your environment. The
information is gathered from the computer's viewpoint. Note that, for
reporting purposes, computer is defined as anything that is running Tivoli
Storage Productivity Center.

Restriction: These reports are available only if the following steps were
done:
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v A Storage Resource agent or Data agent is installed on a machine where
a volume is surfaced

v A probe has been run against the machine where the volume is located
v A probe has been run against the storage subsystem or IBM SAN

Volume Controller cluster

By Computer
These reports view relationships between the computer and the
storage subsystems, volumes, or disks in your environment. To
generate a report by computer, select the By Computer node and
choose an item from the Relate Computers to: field.

For example, to retrieve information on computers in your
environment and their volumes, select the By Computer node and
then choose By volumes. These settings will generate a report
detailing all computers with agents on them, which use volumes
from the monitored storage subsystems.

By Computer Group
These reports view relationships between the computer groups
(both monitoring and reporting groups) and the storage
subsystems, volumes, or disks in your environment. To generate a
report by computer group, select the By Computer group node
and choose an item from the Relate Computers to: field.

For example, to retrieve information on computers in a group that
use storage from monitored storage subsystems, select the By
Computer Group node and then choose Storage Subsystems from
the Relate Computers to: field. These settings will generate a
report detailing all computers in groups with agents on them,
which use volumes from the monitored storage subsystems.

By Filesystem/Logical Volume
These reports will view the relationships between the filesystems
or logical volumes and the storage subsystems, volumes, and disks
in your environment. To generate a report for the relationship you
want to view, select the By Filesystem/Logical Volume node and
choose an item from the Relate Filesystem/Logical Volume to:
field.

For example, to retrieve information on filesystems or logical
volumes that use storage from monitored storage subsystems,
select the By Filesystem/Logical Volume node and choose By
Storage Subsystems. These settings will generate a report detailing
all filesystems or logical volumes which use storage from
monitored storage subsystems.

By Filesystem Group
Use this report to view the relationships between the filesystem
groups (both monitoring and reporting) and the storage
subsystems, volumes, and disks in your environment. To generate
a report for the relationship you want to view, select the By
Filesystem Group node and choose an item from the Relate
Filesystem/Logical Volume to: field.

For example, to retrieve information on filesystems in a group that
use storage from monitored storage subsystems, select the By
Filesystem Group node and choose Storage Subsystems from the
Relate Filesystem/Logical Volume to: field. These settings will
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generate a report detailing all filesystems in a group which use
storage from monitored storage subsystems.

Storage Subsystem Views
Use these reports to view the relationships among the storage-subsystem
components (storage subsystems, volumes, and disks) to the computers
and file systems or logical volumes in your environment.

Note: These reports are available only if the following steps have been
performed:
v A Data agent or Storage Resource agent is installed on a system where a

volume is surfaced
v A probe has been run against the system where the volume is located
v A probe has been run against the storage subsystem or IBM SAN

Volume Controller cluster
v For IBM XIV Storage System, there is no relationship between storage

disks, pools, and volumes because of the unique storage disk
distribution and architecture.

By Storage Subsystem
These reports view the relationships between the storage
subsystems and the computers and file systems or logical volumes
in your environment. To generate a report for the relationship you
want to view, select the By Storage Subsystem node and choose
an item from the Relate Storage Subsystem to: field.

For example, to view all storage subsystems which have storage
being used by computers in the environment, select By Storage
Subsystem and choose Computers. These settings will generate a
report detailing all storage subsystems which have storage being
used by computers in the environment.

By Storage Subsystem Group
These reports view the relationships between storage subsystem
groups (both monitoring and reporting) and the computers and file
systems or logical volumes in your environment. To generate a
report for the relationship you want to view, select the By Storage
Subsystem Group node and choose an item from the Relate
Storage Subsystem to: field.

For example, to view all storage subsystem groups that have
storage being used by computers in the environment, select By
Storage Subsystem Group and choose Computers from the Relate
Storage Subsystem to: field. These settings will generate a report
detailing all storage subsystem groups that have storage being
used by computers in the environment.

By Volume
Use this report to view the relationships between the volumes and
the computers and file systems or logical volumes in your
environment. To generate a report for the relationship you want to
view, select the By Volume node and then choose an item from the
Relate Volumes to: field.

For example, to get a listing of all volumes in the environment on
which file systems or logical volumes have been created, select By
Volume and choose Filesystems/Logical Volumes from the Relate
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Volumes to: field. These settings will generate a report detailing all
volumes in the environment on which file systems or logical
volumes have been created.

To get a listing of all volumes in the environment which are being
used by computers in the environment, select By Volume and
choose Computers. These settings will generate a report detailing
all volumes in the environment which are being used by
computers in the environment.

Disks Use this report to view the relationships between disks and the
computers and file systems or logical volumes in your
environment. To generate a report for the relationship you want to
view, select the Disks node and then choose an item from the
Relate Disks to: field.

For example, to get a listing of all storage subsystem disks in the
environment on which file systems or logical volumes have been
created, select Disks and choose Filesystems/Logical Volumes.
These settings will generate a report detailing all storage
subsystem disks in the environment on which file systems or
logical volumes have been created.

Volume to HBA Assignment
Use these reports to view all the logical unit numbers (volumes) of each
probed storage subsystem that has been assigned to at least one host bus
adaptor (HBA) port world wide name (WWN). These reports only retrieve
data from machines that have HBAs.

The HBA is a fibre channel and volumes are physically attached to the
storage subsystem.

By Storage Subsystem
This report shows all the volumes of each probed storage
subsystem that has been assigned to at least one HBA Port WWN.
This report is sorted by storage subsystem name.

By Volume Space
This report views all the volumes of each probed storage
subsystem that has been assigned to at least one HBA Port WWN.
This report is sorted by volume space.

Not on Monitored Computers
This report shows only volumes that have been assigned to HBA
Port WWNs on hosts with no Storage Resource agent or Data
agent installed on them.

Not Visible to Monitored Server
Use this report to find volumes that have been assigned to hosts
with Storage Resource agents or Data agents, but not configured.
This report can be used to generate a list of all volumes that need
to be configured before they are used.

Volume to Backend Volume Assignment By Volume
Use this report to view the relationships between the virtual disks
(including mirror copies) and managed disks that are associated with a
virtualizer storage subsystem, such as the SAN Volume Controller, and the
back-end storage volumes that are associated with those managed disks.
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Note: A virtual disk with one mirror copy appears as one row in the table
on this page. A virtual disk with multiple mirror copies appears in
multiple rows in the table. Each row represents one of the copies.

Important: Some of the columns in the totals row for these reports can count
storage multiple times if the report includes the following:
v A storage virtualizer like a SAN Volume Controller
v The disk arrays that host the backend storage to a storage virtualizer like a SAN

Volume Controller

In this situation, disks and logical unit numbers (LUNs) appear to belong to both a
storage virtualizer like SAN Volume Controller and the disk arrays, and are
counted multiple times in some of the columns in the totals row. To avoid this
situation, filter the report to only display the storage virtualizer or the disk arrays.
If this situation is unavoidable, then some of the columns in the totals row can be
adjusted as follows:
1. Use the Physical Disk Space column to determine the actual physical disk

space on all arrays. This disk space is not counted multiple times.
2. Sum the Disk Space column for the disk arrays and subtract this result from

the totals row to determine the total backend storage for a virtualizer.
3. To prevents counting the backend volumes multiple times, subtract the

Backend Volume Space column from the Volume Space column in the totals
row to determine the amount of volume space.

In the topology of a subsystem,the Backend Volume Space column displays the
total amount of back-end space available to the subsystem. This is the total
capacity of the managed disks on the SAN Volume Controller, not the internal disk
storage space. In other reports, Backend Volume Space refers to the space that a
storage subsystem makes available to a storage virtualizer. These reports include:
v Reports generated through Data Manager.
v Reports generated through Disk Manager.
v Rollup reports.
v Data Manager > Reporting > Asset > By Storage Subsystem reports.

Generating storage-subsystem reports
Learn how to generate a storage subsystem report.

These reports are available only if the following steps have been performed:
1. An agent is installed on a machine where a volume is surfaced.
2. A probe has been run against the machine where the volume is located.
3. A probe has been run against the storage subsystem or SAN Volume Controller

cluster.

To generate a storage-subsystems report, do the following:
1. In the navigation tree, expand Disk Manager > Reporting > Storage

Subsystems.
2. Do one of the following:

a. In the navigation tree, expand Computer Views and click one of the
following:
v By Computer
v By Computer Group
v By Filesystem/Logical Volume
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v By Filesystem Group
b. In the navigation tree, expand Storage Subsystems Views and click one of

the following:
v By Storage Subsystem
v By Storage Subsystem Group
v By Volume
v Disks

c. In the navigation tree, expand Volume to HBA Assignment and click one of
the following:
v By Storage System
v By Volume Space
v Not On Monitored Computers
v Not Visible to Monitored Computers

d. In the navigation tree, expand Volume to Backend Volume Assignment
and click the following:
v By Volume

3. The Storage Subsystem Performance pane for your selected storage subsystem
opens the Select Resources pane. All valid available resources are listed in

Included Columns. In Available Columns and Included Columns, use

and to select the columns you want to include in your report.
4. Filters can be applied to the selected columns. In the Report Filter

Specification area, the Filter button opens the Edit Filter window.
a. Click Add to add a column to the filter list. The columns will be added in

the order they appear on your report.
b. Click Delete to delete all columns. Click the X for an individual column to

delete it.
c. In the Records Must Meet area, select All Conditions or At Least One

Condition.
d. Type the condition value in the Value 1 text field.

v If the text field is greyed-out, click Edit.
v If you wish to add additional values for the same column using the same

operator, click Edit.
e. Select the Operator.

v If you select the BETWEEN or NOT BETWEEN operators, two value text
fields will open for a lower-limit value and an upper-limit value. Click
Edit to enter the upper-limit value and lower-limit value. You must input
values in both Value 1 and Value 2 fields, if shown.

v For numeric columns, such as Free Space, a pull-down menu at the end
of the each field assists you with numerical units.

f. Once your selections have been made, click OK.
5. Click Generate Report. The report appears under a new tab window. If there is

no data, as in if a probe has not been run, the window will say "No Data To
Display."

6. Click File > Save. The report is saved under IBM Tivoli Storage Productivity
Center > My Reports. Reports can be regenerated from that node.

To change the parameters for your report, or create a new report of the same type,
do the following:
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1. Click the Selection tab before closing the Storage Subsystem Performance
window. Make the necessary changes.

2. Click Generate Report.
3. Click File > Save and enter the name of the new report.
4. Click OK.

Creating a storage subsystem performance report
Learn how to create a storage-subsystem performance report.

Before you can view a performance report on a storage subsystem, that subsystem
must have been discovered and had performance data successfully collected. For
more information on storage-subsystem discovery, see “Discover storage
subsystem, tape library, and fabric information with CIM agents” on page 333.

For a complete list of metrics available for performance reports, see “Performance
metrics” on page 1468.
1. In the navigation tree pane, expand Disk Manager > Reporting > Storage

Subsystem Performance.
2. Click the type of performance report that you want to view. You can choose

from the following performance reports:

By Storage Subsystem
This report contains performance information for storage subsystems.

By Controller
This report contains performance information for controllers.

By I/O Group
This report contains performance information for I/O groups.

By Node
This report contains historical performance data for SAN Volume
Controller (SVC) nodes.

By Array
This report contains performance information for arrays.

By Managed Disk Group
This report contains performance information for managed-disk groups.

By Volume
This report contains performance information for volumes.

By Managed Disk
This report contains performance information for managed disks.

By Port
This report contains performance information for ports.

In the content pane, the Selection page opens.
3. Select from the following options to customize the report:

Selection button
Click this button to determine the resources upon which you want to
report, such as the storage subsystems, the fibre-channel ports, and so
forth. The Select Resources window displays. The type of resources
displayed for selection depends on the type of report you selected. For
example, if you selected a By Storage Subsystem report, all displayed
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resources will be storage subsystems. If you clear the box for a resource
on the Select Resources window, a pushpin icon displays on the
Selection button.

Filter button
Click this button to further defines the data that you want to include in
the report. Filters enable you to apply general rules to the report. When
you click this button, the Edit Filter window displays.

For example, to select only data associated with subsystems that have a
name ending with "123–IBM", select the "Subsystem" column, the
"LIKE" operator, and type "*123–IBM" (without the quotation marks) in
the Value 1 field. To select only data which has a Read I/O Rate greater
than 0, select the "Read I/O Rate (overall)" column, the ">" operator,
and type "0" (without the quotation marks) in the Value 1 field.

If a filter is defined for this report, a pushpin icon displays on the Filter
button.

Time range selectors
All performance reports display historical performance data. Use the
time range selectors to specify the exact time range that you want the
report to cover. Click one of the following radio buttons to select the
type of historical report you want:

Display latest performance data
This report contains only the latest available performance data
for the selected resources. Note that even the latest data
available might still be somewhat old, depending on whether
data was recently collected for the resources. Including the time
column in the report will help you determine how old the
latest available data actually is. Regardless of the age of the
data, clicking this button ensures that only a single row
(representing a single point in time) for each selected resource
is included in the report. If no data has ever been collected for
a particular resource, then that resource is not included in the
report. If no data has ever been collected for any resource, then
the resulting report will be empty.

Display historic performance data using absolute time
This report contains only data that falls within a specific time
range. Select the time range using the From and To selectors.
The specified from and to values are interpreted as inclusive.
The resulting report contains all the performance data that is
available within the specified time range, for each selected
resource. This means that the data can consist of potentially
many rows per resource, each with a unique timestamp. If no
data has been collected for a particular resource during the
specified time range, that resource is not included in the report.
If no data has been collected for any resource during the
specified time range, then the resulting report will be empty.

To determine which historical performance records fall within
the specified time range, the beginning timestamp of the
collection intervals is used for comparison. If an historical
record contains performance data for an interval of time from
1:00 PM to 1:05 PM, that record would be included in the
report for a time range of 1:00 PM to 8:00 PM. However, that
same record would not be included if a time range of 1:02 PM
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to 8:02 PM was specified, because it is the beginning of the
time period (for example, 1:00 PM in this example) that is used
to determine inclusion in the specified time interval.

Display historic performance data using relative time
This report contains only data that falls within a specific time
range extending backward from the current date and time.
Specify the number of days in the desired time range, using the
days ago until now field. The report will be exactly the same
as a report using absolute time, with the To selector set to the
current date and time, and the From selector set to the current
date and time minus the number of days ago until now.

Note that the same criteria applies as if determining which
historical performance records fall within the specified time
range. Only the beginning timestamp of the collection intervals
is used for comparison. This means that data for the current
hour or the current day is not included in the report when
selecting hourly or daily summation data, because data for the
current hour or current day is only saved in the database when
the hour or day is complete. As an alternative, consider using
the first radio button, Display latest performance data, to see a
report showing the most recent daily summation data.

Summation Level
Use this selector to select which type of performance data records to
include in the report. The Tivoli Storage Productivity Center
Performance Manager collects and stores three different types of
performance data:

By sample
Represents the most detailed data. There is usually one sample
record per resource for every n minutes, where n is the
performance monitor interval length that was specified when
the monitor was defined. Each sample represents the average
performance of the resource over those n minutes. A sample
record with a timestamp of t will be saved at time t+n. In other
words, the beginning of each n minute time interval is used for
display and for time range matching.

Hourly
Represents an hourly average of the performance of the
specified resources. There will be one hourly record written
every hour, per resource. Each such record will be written at or
shortly after each hour mark on the (device) clock. For
example, a record with a timestamp of 12:00 PM and interval
length of 1 hour will be written at 1:00 PM.

Daily Represents a daily average of the performance of the resources.
There will be one daily record written every day, per resource.
Each daily record will be written at or shortly after midnight,
according to the device clock. For example, a record with a
timestamp of April 21, 12:00 AM and interval length of 24
hours will be written on April 22, 12:00 AM.

Note that hourly and daily records are usually retained in the database
for longer periods of time, compared to By Sample records. As a result,
if a generated report indicates that sample data is no longer available
for a particular time range in the past, it is possible that the sample
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data has already been purged, in which case you can try generating the
report using hourly or daily summation levels.

Be aware that when selecting a time range using the Display historic
performance data using relative time radio button, it is necessary to
select the length of the range in days. This can lead to unexpected
results when also selecting the daily summation level. Remember that a
daily record is not written until the day is complete, which means that
at any given time during the day, the current day's data does not yet
exist in the database. Therefore, selecting the daily summation level as
well as a relative time range of n days ago until now, will usually
result in n-1 records being returned per resource, assuming that at least
n-1 days worth of data has been previously collected for those
resources. Specifying a relative time range of 1 days ago until now will
result in an empty report.

Note: The user interface displays the date and time of data in the
Tivoli Storage Productivity Center server time zone, but the daily and
hourly aggregations are calculated based on the device time zones.
Hourly records are written at the end of each hour according to the
devices' clocks and the daily records are written at midnight according
the the devices' clocks, but both are displayed according to the Tivoli
Storage Productivity Center server's clock. For example, if a subsystem
clock is one hour ahead of the Tivoli Storage Productivity Center server
clock, the hourly data for 5:00 PM according to the device's clock is
displayed as 4:00 PM in the user interface and the daily data for 12:00
AM according to the device's clock is displayed as 11:00 PM of the
previous day.

Available Columns, Included Columns
Use these items to specify which columns to include and which
columns to exclude from the generated report.

Available Columns
Displays the columns that you can include in the generated
report that are not already included. If a column appears in the
Included Columns list box, it will not appear in the Available
Columns list box.

Included Columns
Displays the columns that will appear in the generated report.
By default, all columns for a report are listed in this list box
and will be displayed in the generated report. You can
highlight the columns and use the up and down arrows to
rearrange the order of the columns in the report. The order of
the items in this list box determines the order in which the
columns will appear in the generated report. The columns with
grayed-out names are the frozen columns, which cannot be
selected, removed, or reordered for this type of report.

If a column appears in the Available Columns list box, it will
not appear in the Included Columns list box.

To exclude a column from a report, click the name of the column in the
Included Columns list box. Click Shift+click and Ctrl+click to select
multiple columns, if so desired. Then click the left-arrow button (<<).
The selected columns are removed from the Included Columns list box,
and will appear in the Available Columns list box.

1000 IBM Tivoli Storage Productivity Center: User's Guide



To include a column in a report, click the name of the column in the
Available Columns list box. Click Shift+click and Ctrl+click to select
multiple columns, if so desired. Then click the right-arrow button (>>).
The selected columns will be removed from the Available Columns list
box, and will appear in the Included Columns list box.

To rearrange the order of columns that will appear in the generated
report, click the name of a column in the Available Columns list box.
Click Shift+click and Ctrl+click to select multiple columns, if so
desired. Then click the up-arrow button (^) or the down-arrow button
(v) to move the selected columns up or down in the list, relative to the
other columns.

4. Click Generate Report. A new tab opens and displays the report.

5. Optional: To view the report in chart format, click , specify charting
options, and then click OK. Right-click on the chart and select Customize this
Chart to further customize how the chart is displayed.

6. Optional: To save the report settings to generate later, click and enter a
name for the report. The report is saved under theIBM Tivoli Storage
Productivity Center node. See “Filtering the resources that appear on a report”
on page 825 for instructions on modifying saved report settings.

If the report is greater than 2500 rows, a dialog box will appear which will allow
you to retrieve additional rows by clicking Display More Rows. An additional
2500 rows will be retrieved from the server and displayed on the panel for each
click of the button. Do not try to display too much data or there is the possibility
of running out of memory.

Generating constraint violation reports
Learn how to generate a storage subsystem performance report.

Creating constraint violation reports:

Learn how to how to create constraint violation reports.
1. In the navigation tree pane, expand Disk Manager > Reporting > Storage

Subsystem Performance.
2. Click Constraint Violations. The constraint violation report selection page

appears in the content pane.
3. If you want to limit the report to a particular time period, select Limit to this

time range and specify the time period.
4. Click Selection to choose which storage subsystems to include in the report.
5. Click Filter to modify the filter used in generating the report.
6. Customize the performance report. By default, all supported metrics are

included. Click to move the selected metric up in the list and to move the
selected metric down in the list.

a. In the Included Columns list, select a metric and click to remove it
from the report.

b. To change the order in which the columns appear in the report, select a

metric and click either or .
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7. Click Generate Report. The Constraint Violations tab opens and displays the
report.

The report might show information about DS6000, DS8000, TotalStorage Enterprise
Storage Server, SAN Volume Controller, and other subsystems all on the same
report. By default, the report displays one subsystem per row. Results are
aggregated for the current day.

Viewing detailed constraint violation information:

Learn how to view detailed information about constraint violations.

Before you can view detailed information about constraint violations, you must
generate a constraint violation report (see “Creating constraint violation reports”
on page 1001).
1. Click on the Constraint Violations tab to view the report. The report might

show information about DS6000, DS8000, TotalStorage Enterprise Storage
Server,SAN Volume Controller, and other subsystems all on the same report. By
default, the report displays one subsystem per row. Results are aggregated for
the current day.

2. Click to view a detailed report of that subsystem.

3. Click , specify charting options, and then click OK to view the report in
chart form. Right-click on the chart and select Customize this Chart to further
customize how the chart is displayed.

Viewing affected volumes and affected hosts:

Learn how to view information on volumes and related hosts affected by
constraint violations.

Before you can view affected volumes and hosts information, you must generate a
constraint violation report (see “Creating constraint violation reports” on page
1001) and view detailed information on a subsystem (see “Viewing detailed
constraint violation information”).

1. Click for a constraint violation to display the Affected Volumes Selection
page.

2. Under Volumes, select whether you want the report to show all volumes or
only the most active volumes associated with the subsystem and component
and type in the maximum number of volumes to display in the report.

3. Under Performance Data, select whether you do not want the report to display
performance data for the volumes or you do want the report to display historic
performance data for volumes.

4. Customize the performance report. By default, all supported metrics are
included. Click to move the selected metric up in the list and to move the
selected metric down in the list.

a. In the Included Columns list, select a metric and click to remove it
from the report.
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b. To change the order in which the columns appear in the report, select a

metric and click either or .
5. Click Generate Report.

Fabric Manager reports
Fabric reports provide you with both overview and detailed information about
your fabrics, switches, and ports. The reports are based on information collected by
probes and performance monitors. You can view reports as tables of data or as
graphical charts. You can use pre-defined Fabric system reports or define your own
switch performance reports for information by port or by constraint violations.

Before you can generate a report you need to gather information about your
fabrics. You can do this through monitoring jobs, and discoveries.

Creating switch performance reports
After performance monitors are in operation, you can generate switch performance
reports. The procedure is similar for each report.

“Creating a switch performance monitor” on page 377 describes how to create
performance monitors for fabric switches.

For both reports, use the Selection tab to specify switches to report, report
columns to include, and filters to apply. When you click Generate Report, the
Ports page or Constraint Violations page is created and displays the report.
1. Expand Fabric Manager → Reporting → Switch Performance.
2. Click By Switch, By Port or By Constraint Violations. In the content pane, the

Selection page opens.
3. Select from the following options to customize the report:

Selection button
Click this button to determine the resources upon which you want to
report. The Select Resources window displays. The type of resources
displayed for selection depends on the type of report you selected. If
you clear the box for a resource on the Select Resources window, a
pushpin icon displays on the Selection button.

Filter button
Click this button to further defines the data that you want to include in
the report. Filters enable you to apply general rules to the report. When
you click this button, the Edit Filter window displays.

For example, to select only data associated with switches that have a
name ending with "123–IBM", select the "Switch" column, the "LIKE"
operator, and type "*123–IBM" (without the quotation marks) in the
Value 1 field.

If a filter is defined for this report, a pushpin icon displays on the Filter
button.

Time range selectors
All performance reports display historical performance data. Use the
time range selectors to specify the exact time range that you want the
report to cover. Click one of the following radio buttons to select the
type of historical report you want:
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Display latest performance data
This report contains only the latest available performance data
for the selected resources. Note that even the latest data
available might still be somewhat old, depending on whether
data was recently collected for the resources. Including the time
column in the report will help you determine how old the
latest available data actually is. Regardless of the age of the
data, clicking this button ensures that only a single row
(representing a single point in time) for each selected resource
is included in the report. If no data has ever been collected for
a particular resource, then that resource is not included in the
report. If no data has ever been collected for any resource, then
the resulting report will be empty.

Display historic performance data using absolute time
This report contains only data that falls within a specific time
range. Select the time range using the From and To selectors.
The specified from and to values are interpreted as inclusive.
The resulting report contains all the performance data that is
available within the specified time range, for each selected
resource. This means that the data can consist of potentially
many rows per resource, each with a unique timestamp. If no
data has been collected for a particular resource during the
specified time range, that resource is not included in the report.
If no data has been collected for any resource during the
specified time range, then the resulting report will be empty.

To determine which historical performance records fall within
the specified time range, the beginning timestamp of the
collection intervals is used for comparison. If an historical
record contains performance data for an interval of time from
1:00 PM to 1:05 PM, that record would be included in the
report for a time range of 1:00 PM to 8:00 PM. However, that
same record would not be included if a time range of 1:02 PM
to 8:02 PM was specified, because it is the beginning of the
time period (for example, 1:00 PM in this example) that is used
to determine inclusion in the specified time interval.

Display historic performance data using relative time
This report contains only data that falls within a specific time
range extending backward from the current date and time.
Specify the number of days in the desired time range, using the
days ago until now field. The report will be exactly the same
as a report using absolute time, with the To selector set to the
current date and time, and the From selector set to the current
date and time minus the number of days ago until now.

Note that the same criteria applies as if determining which
historical performance records fall within the specified time
range. Only the beginning timestamp of the collection intervals
is used for comparison. This means that data for the current
hour or the current day is not included in the report when
selecting hourly or daily summation data, because data for the
current hour or current day is only saved in the database when
the hour or day is complete. As an alternative, consider using
the first radio button, Display latest performance data, to see a
report showing the most recent daily summation data.
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Summation Level
Use this selector to select which type of performance data records to
include in the report. The Tivoli Storage Productivity Center
Performance Manager collects and stores three different types of
performance data:

By sample
Represents the most detailed data. There is usually one sample
record per resource for every n minutes, where n is the
performance monitor interval length that was specified when
the monitor was defined. Each sample represents the average
performance of the resource over those n minutes. A sample
record with a timestamp of t will be saved at time t+n. In other
words, the beginning of each n minute time interval is used for
display and for time range matching.

Hourly
Represents an hourly average of the performance of the
specified resources. There will be one hourly record written
every hour, per resource. Each such record will be written at or
shortly after each hour mark on the (device) clock. For
example, a record with a timestamp of 12:00 PM and interval
length of 1 hour will be written at 1:00 PM.

Daily Represents a daily average of the performance of the resources.
There will be one daily record written every day, per resource.
Each daily record will be written at or shortly after midnight,
according to the device clock. For example, a record with a
timestamp of April 21, 12:00 AM and interval length of 24
hours will be written on April 22, 12:00 AM.

Note that hourly and daily records are usually retained in the database
for longer periods of time, compared to By Sample records. As a result,
if a generated report indicates that sample data is no longer available
for a particular time range in the past, it is possible that the sample
data has already been purged, in which case you can try generating the
report using hourly or daily summation levels.

Be aware that when selecting a time range using the Display historic
performance data using relative time radio button, it is necessary to
select the length of the range in days. This can lead to unexpected
results when also selecting the daily summation level. Remember that a
daily record is not written until the day is complete, which means that
at any given time during the day, the current day's data does not yet
exist in the database. Therefore, selecting the daily summation level as
well as a relative time range of n days ago until now, will usually
result in n-1 records being returned per resource, assuming that at least
n-1 days worth of data has been previously collected for those
resources. Specifying a relative time range of 1 days ago until now will
result in an empty report.

Note: The user interface displays the date and time of data in the
Tivoli Storage Productivity Center server time zone, but the daily and
hourly aggregations are calculated based on the device time zones.
Hourly records are written at the end of each hour according to the
devices' clocks and the daily records are written at midnight according
the the devices' clocks, but both are displayed according to the Tivoli
Storage Productivity Center server's clock. For example, if a subsystem
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clock is one hour ahead of the Tivoli Storage Productivity Center server
clock, the hourly data for 5:00 PM according to the device's clock is
displayed as 4:00 PM in the user interface and the daily data for 12:00
AM according to the device's clock is displayed as 11:00 PM of the
previous day.

Available Columns, Included Columns
Use these items to specify which columns to include and which
columns to exclude from the generated report.

Available Columns
Displays the columns that you can include in the generated
report that are not already included. If a column appears in the
Included Columns list box, it will not appear in the Available
Columns list box.

Included Columns
Displays the columns that will appear in the generated report.
By default, all columns for a report are listed in this list box
and will be displayed in the generated report. You can
highlight the columns and use the up and down arrows to
rearrange the order of the columns in the report. The order of
the items in this list box determines the order in which the
columns will appear in the generated report. The columns with
grayed-out names are the frozen columns, which cannot be
selected, removed, or reordered for this type of report.

If a column appears in the Available Columns list box, it will
not appear in the Included Columns list box.

To exclude a column from a report, click the name of the column in the
Included Columns list box. Click Shift+click and Ctrl+click to select
multiple columns, if so desired. Then click the left-arrow button (<<).
The selected columns are removed from the Included Columns list box,
and will appear in the Available Columns list box.

To include a column in a report, click the name of the column in the
Available Columns list box. Click Shift+click and Ctrl+click to select
multiple columns, if so desired. Then click the right-arrow button (>>).
The selected columns will be removed from the Available Columns list
box, and will appear in the Included Columns list box.

To rearrange the order of columns that will appear in the generated
report, click the name of a column in the Available Columns list box.
Click Shift+click and Ctrl+click to select multiple columns, if so
desired. Then click the up-arrow button (^) or the down-arrow button
(v) to move the selected columns up or down in the list, relative to the
other columns.

4. Click Generate to run the report.
The report is displayed in the Ports tab. You can display the information in

chart form by clicking .
5. Click File → Save as to save the report in the <user–id> Reports node.
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Switch Performance:

Use the Switch Performance report to generate and view reports that provide
information about the free and occupied ports on the switches in your SAN. These
reports provide information about the port connections and status, as well as the
port and switch IDs, data and packet transfer rates, and other details. This report
can be generated only for switches that have had performance monitors run on
them.

The following list describes the columns that are on the Switch Performance report.
All of the columns in the report are for display only.

Switch
The ID of the switch.

Time The date and time of the data collection.

Interval
The size of the sample interval, in seconds.

Port Send Packet Rate
The rate at which packets are sent through this port.

Port Receive Packet Rate
The rate at which packets are received through this port.

Total Port Packet Rate
The total rate at which packet operations are performed through this port.

Port Send Data Rate
The rate at which data is sent through this port.

Port Receive Data Rate
The rate at which data is received through this port.

Total Port Data Rate
The total rate at which data is processed through this port.

Port Peak Send Data Rate
The peak rate at which data is sent through this switch.

Port Peak Receive Data Rate
The peak rate at which data is received through this switch.

Port Send Packet Size
The size of the data block that is sent out through this switch.

Port Receive Packet Size
The size of the data block that is received in through this switch.

Overall Port Packet Size
The total size of the data block that is transferred by the switch.

Error Frame Rate
The rate at which error frames are generated by the switch.

Dumped Frame Rate
The rate at which frames are dumped by the switch.

Link Failure Rate
The rate at which failed links are generated by the switch.

Fabric Performance Report - By Port:
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Click to display detailed information per computer in a Network tab. The
Network tab displays a file summary by computer.

The following list describes the columns that are on the Fabric Performance Report
- By Port report, and are for display only.

Port The ID of the port.

WWPN
The World Wide Port Name (WWPN) of the selected port.

Slot The number for the blade that the port is on.

Index The unique number for the port across the whole switch.

Time The date and time of the data collection.

Interval
The size of the sample interval, in seconds.

Port Send Packet Rate
The average number of packets sent per second, by a particular port over a
particular time interval. A send operation is a read operation processed, or
a write operation initiated by the particular port.

Port Receive Packet Rate
The average number of packets received per second, by a particular port
over a particular time interval. A receive operation is a write operation
processed, or a read operation initiated by the particular port.

Total Port Packet Rate
The average number of packets sent and received per second, by a
particular port over a particular time interval.

Port Send Data Rate
The average number of megabytes sent per second, by a particular port
over a particular time interval.

Port Receive Data Rate
The average number of megabytes received per second, by a particular
port over a particular time interval.

Total Port Data Rate
The average number of megabytes transferred per second, by a particular
port over a particular time interval.

Port Peak Send Data Rate
The peak number of megabytes sent per second, by a particular port over a
particular time interval.

Port Peak Receive Data Rate
The peak number of megabytes received per second, by a particular port
over a particular time interval.

Port Send Packet Size
The size of the data block that is sent out through this switch.

Port Receive Packet Size
The size of the data block that is received in through this switch.

Overall Port Packet Size
The total size of the data block that is transferred by the switch.
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Error Frame Rate
The rate at which error frames are generated by the switch.

Dumped Frame Rate
The rate at which frames are dumped by the switch.

Link Failure Rate
The rate at which failed links are generated by the switch.

Loss of Sync Rate
The average number of times per second that synchronization was lost
after the last reset of the device, for a particular component over a
particular time interval.

Loss of Signal Rate
The average number of times per second that the signal was lost after the
last reset of the device, for a particular component over a particular time
interval.

CRC Error Rate
The average number of frames received per second in which the CRC in
the frame did not match the CRC computed by the receiver, for a
particular component over a particular time interval.

Short Frame Rate
The average number of frames received per second that were shorter than
28 octets (24 header + 4 CRC), not including any start of frame/end of
frame bytes, for a particular component over a particular time interval.

Long Frame Rate
The average number of frames received per second that were longer than
2140 octets (24 header + 4 CRC + 2112 data), not including any start of
frame/end of frame bytes, for a particular component over a particular
time interval.

Encoding Disparity Error Rate
The average number of disparity errors received per second, for a
particular component over a particular time interval.

Discarded Class3 Frame Rate
The average number of class-3 frames per second that were discarded by a
particular component over a particular time interval.

F-BSY Frame Rate
The average number of F-BSY frames per second that were generated by a
particular component over a particular time interval.

F-RJT Frame Rate
The average number of F-RJT frames per second that were generated by a
particular component over a particular time interval.

Constraint Violations:

If you have defined switch performance alerts you can also generate the Constraint
Violations report.

Click to display detailed information per computer in a Network tab. The
Network tab displays a file summary by computer.
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The following list describes the columns that are on the Top Switch Ports Packet
Rate Performance report. The columns are for display only and are not editable.

Switch
The ID of the switch.

Total Port Data Rate Threshold
The total rate at which data is processed through this port.

Link Failure Rate Threshold
The rate at which failed links are generated by the switch.

Error Frame Rate Threshold
The rate at which error frames are generated by the switch.

Total Port Packet Rate Threshold
The total rate at which the packet operations are performed through this
port.

Tape Manager reports
You can perform the following tape library reporting tasks:
v Create and view asset reports using data collected from your tape libraries; these

reports can include such information as the library identifier and the status of
the library

v Create and view capacity reports using data collected from your tape libraries;
these reports can include such information as the number of drives in a library,
the number of tape slots, the number of occupied tape slots

System reports
Use the information in this section to learn how to generate and view system
reports. These reports are available in the IBM Tivoli Storage Productivity Center
> Reporting > System Reports and Data Manager for Databases > My Reports >
System Reports nodes in the navigation tree. Data for system reports are gathered
every time that monitoring jobs are run against your storage resources.

Generating and viewing system reports
Learn how to generate system reports, drill down through and filter their data, and
generate charts.

To display a report, complete the following steps:
1. Expand IBM Tivoli Storage Productivity Center > My Reports > System

Reports > <manager>.
2. Click the name of the report you want to view. The report will appear in the

content pane. To regenerate a report, select the report name, right-click, and
select Regenerate Report.

Many of the rows that are presented in the generated system reports enable you to:
v drill down into a row to get more detailed information
v view report information in a chart format

To drill down for more detailed report information:

v Click on the desired row. The drill down report is displayed and a new
tab representing that report is added to the tabs on the report.
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To view report information in a chart format:

v Click on the desired row. The chart is displayed and a new tab
representing that chart is added to the tabs on the report.
You can customize the charts that you generate from system reports by using the
Chart Customization window. You can access this window by right-clicking on a
system report chart and selecting Customize this chart from the pop-up menu.
See “Customizing charts” on page 814 for information on how to customize a
system report chart.

To filter the data displayed on a report:

Click the Filter button, which displays an Edit Filter window. In this window,
specify criteria for records (for example, Capacity in Data Reports), operators (for
example, =) and values for each "column" (whatever you want to type). For
example, in the Disk Space Summary report, you can specify only disks with a
capacity greater than 70 GB.

If you change any element of a report definition (for example, the maximum
number of rows in the report), you can save the new report definition (and
regenerate it later) by clicking File → Save and then typing a name for the report.
The report is saved with the name you specify under the user_id's Reports node.

System reports - Data
Use these predefined reports to view statistics about your storage resources.

Access Time Summary
This report provides a summary of the number of files in your environment and
when they were last accessed (for example, created or modified) during the last
day, the last week, the last month, the last two months, the last three months, the
last six months, the last nine months, the last year, and over a year.

The following list describes the columns that are on the Access Time Summary
report. All of the fields on the report are for display only and are not editable.

Last Accessed <= 1 day
The number and total size of the files that were accessed within the last
day.

Last Accessed 1 day — 1 week
The number and total size of the files that were accessed between 1 day
and 1 week ago.

Last Accessed 1 week — 1 month
The number and total size of the files that were accessed between 1 week
and 1 month ago.

Last Accessed 1 month — 2 months
The number and total size the files that were accessed between 1 month
and 2 months ago.

Last Accessed 2 months — 3 months
The number and total size of the files that were accessed between 2 – 3
months ago.

Last Accessed 3 months — 6 months
The number and total size of the files that were accessed between 3 – 6
months ago.
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Last Accessed 6 months — 9 months
The number and total size of the files that were accessed between 6 – 9
months ago.

Last Accessed 9 months — 1 year
The number and total size of the files that were accessed between 9
months and 1 year ago.

Overall File Count
Total number of files across a network.

Overall File Size
Total size of the space consumed by the files on a network.

Average Age
Average age of files on a network measured by days, hours, minutes,
seconds.

v To view any of the following charts, click above the report and select the
corresponding option from the pop-up menu:
– pie chart of storage space distribution for a selected row
– pie chart of file counts for a selected row
– pie chart of storage space distribution for all the rows on the report
– pie chart of file counts for all the rows on a report
– history chart of file counts
– history chart of file count by percent
– history chart of file sizes
– history chart of files size by percent

v To view a pie chart of file access times, click to left of a report row.

v To view detailed file access times for the computers on the network, click
to the left of a report row.

Disk Space Summary
This report shows storage capacity for the whole network. You can drill down
through this report to view storage capacity for each of the following levels: per
disk, per computer, per cluster, per computer group, and per domain.

The following list describes the columns that are on the Disk Space Summary
report. All of the fields on the report are for display only and are not editable.

Disk Space
Total storage capacity of the disks on the computers within a network.

Consumed File System Space
Amount of used storage space on the file systems within a network.

Available File System Space
Amount of unused storage space on the file systems within a network.

Raw Volume Space
Space on host-side logical volumes that is not occupied by file systems.

Unavailable Disk Space
Amount of storage subsystem volume or virtual storage volume space that
is dedicated to redundancy. This value is dependent on the storage
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subsystem SMI-S provider returning a valid RAID value that is used to
determine the overhead. If the value is zero for a storage subsystem, the
overhead cannot be calculated. This amount does not include storage space
information from storage subsystem volumes or virtual storage volumes
that become missing after a storage subsystem probe.

Available Disk Space
Space that is assigned to a (monitored) host that is not part of any logical
volume.

Unknown Storage Subsystem Volume Space
Volume space of unknown usage.

v To view any of the following charts click at the top of the report and
select the corresponding option from the pop-up menu:
– pie chart of network space distribution
– pie chart of network row
– history chart of the free space for a network
– history chart of the percentage of free space for a network
– history chart of the storage capacity on a network

v To view a pie chart of disk capacity, click to the left of a report row.

v To view detailed disk capacity for the computers on a network, click the
to the left of a report row.

Access File Summary
This report provides overview information for files in your storage environment.

The Access File Summary report provides overview information for files by
directory, directory group, file system, file system group, cluster, computer,
computer group, domain, and for the entire network. Through this report you can
view historically the number of files for each resource in the report. The historical
chart can be generated to show daily, weekly, or monthly history.

The following list describes the columns that are on the Access File Summary
report. All of the fields on the report are for display only.

File Size
Total size of the storage space consumed by the files on a network.

File Count
Total number of files on a network.

Directory Count
Total number of directories on a network.

Average File Size
Average storage space consumed by each of the files on a network.

File System Space
Total storage capacity of the files on a network.

v To view any of the following charts click at the top of the report and
select the corresponding option from the pop-up menu:
– History chart of storage space usage for a selected row
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– History chart of file counts for a selected row
v To view a history chart of the storage space consumed by files on a network,

click to the left of a report row.

v To view detailed file storage usage for the computers on the network, click
to the left of a report row.

Storage Access Times
This report shows when files were last accessed.

The following list describes the columns that are on the Storage Access Times
report. All of the fields on the report are for display only.

Computer
Name of a computer against which the report was run.

Last Accessed <= 1 day
Number of files that were accessed within the last 24 hours and the total
physical size of those files (measured in kilobytes, megabytes, or
gigabytes).

Last Accessed 1 day - 1 week
Number of files that were accessed between 1 day to 1 week previous and
the total physical size of those files (measured in kilobytes, megabytes, or
gigabytes).

Last Accessed 1 week - 1 month
Number of files that were accessed between 1 week to 1 month previous
and the total physical size of those files (measured in kilobytes, megabytes,
or gigabytes).

Last Accessed 1 month - 2 months
Number of files that were accessed between 1 month to 2 months previous
and the total physical size of those files (measured in kilobytes, megabytes,
or gigabytes).

Last Accessed 2 months - 3 months
Number of files that were accessed between 2 months to 3 months
previous and the total physical size of those files (measured in kilobytes,
megabytes, or gigabytes).

Last Accessed 3 months - 6 months
Number of files that were accessed between 3 months to 6 months
previous and the total physical size of those files (measured in kilobytes,
megabytes, or gigabytes).

Last Accessed 6 months - 9 months
Number of files that were accessed between 6 months to 9 months
previous and the total physical size of those files (measured in kilobytes,
megabytes, or gigabytes).

Last Accessed 9 months - 1 year
Number of files that were accessed between 9 months to 1 year previous
and the total physical size of those files (measured in kilobytes, megabytes,
or gigabytes).

Last Accessed > 1 year
Number of files that were accessed over one year previous and the total
physical size of those files (measured in kilobytes, megabytes, or
gigabytes).
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Overall File Count
Total of all the counts.

Overall File Size
Total of all the sizes.

Average Age
Average time since the file was last accessed.

To view graphical information about specific computers' access times, click

. A new tab displaying a chart for each selected computer is displayed.

Disk Defects
This report shows any disk defects that are on the monitored computers.

The following list describes the columns that are on the Disk Defects report. All of
the fields on the report are for display only and are not editable.

Device
Name of the computer containing a disk defect.

Path Full path to the location of a disk defect.

Primary Defects
Number of defects on the disk when it was new.

Manufacturer
Name of the manufacturer of the disk drive containing the disk defect.

Model Model number of the disk drive containing a disk defect.

In Storage Subsystem
Indicates Yes when a disk is an actual physical disk within the storage
subsystem.

RPM Speed that the disk turns (revolutions per minute).

Read Cache
Hardware caching turned on/off for reads.

Write Cache
Hardware caching turned on/off for writes.

Failure Predicted
Disk predicts a failure.

Probe Last Run
Date and time when the last probe was run.

Discovered Time
Date and time when a disk defect was discovered.

Disk Space
Storage capacity of the disk drive containing a defect.

Available Disk Space
Amount of unused storage space on the disk drive containing a defect.

Grown Defects
Number of defects detected by the disk since new.

Recovered Errors
Number of errors (read, write, verify) from which the disk was able to
recover.
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Unrecovered Errors
Number of errors (read, write, verify) from which the disk was not able to
recover.

Bytes Written
Number of bytes written to the disk.

Bytes Read
Number of bytes read from the disk.

Automatic Write Reallocation
Disk attempts to move the data sector on the disk in the event of a write
error.

Desired Automatic Write Reallocation
Change automatic write allocation on the next probe.

Automatic Read Reallocation
Disk attempts to move the data sector on the disk in the event of a read
error.

Desired Automatic Read Reallocation
Change automatic read allocation on the next probe.

Read Continuous (no error correction)
No error correction (setting is ON=no error correction).

Desired Read Continuous (no error correction)
Change automatic read continuous on the next probe.

Detectable
Indicates Yes when a storage volume is identified as being available to the
storage subsystem following a successful probe.

Is Virtual
Indicates Yes when a disk is identified as being available to the server or
the storage subsystem.

Mapped to Storage Subsystem
Indicates Yes when a computer disk or a backend storage volume can be
mapped to a storage subsystem.

To view more information for a specific computer:

v Click . Detailed information regarding the computer will be available in
three tabs:
– General tab. This tab displays general information about the computer, such

as computer information, discovered date and time, disk allocation
information, and so on.

– Latest Probe tab. This tab displays information about the latest probe, and
provides information such as sector size, probe last run, primary and grown
defects, and so on.

– Probe History tab. This tab displays probe history for the selected machine,
and provides information such as probe times, record type, bytes written, and
so on.

Storage Modification Times
This report shows information about files within the network that were modified
with certain time frames.
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The Storage Modification Times report provides information about files within the
network that were modified:
v within the last 24 hours
v between 24 hours and one week previous
v between one week to one month previous
v between one month to two months previous
v between two months to three months previous
v between three months to six months previous
v between six months to nine months previous
v between nine months to one year previous
v more than one year previous

The following list describes the columns that are on the Storage Modification Times
report. All of the fields on the report are for display only.

Last Modified <= 1 day
Number of files that were modified in the last 24 hours and the total
physical size of those files (measured in kilobytes, megabytes, or gigabytes)

Last Modified 1 day - 1 week
Number of files that were modified between 1 day to 1 week previous and
the total physical size of those files (measured in kilobytes, megabytes, or
gigabytes)

Last Modified 1 week - 1 month
Number of files that were modified between 1 week to 1 month previous
and the total physical size of those files (measured in kilobytes, megabytes,
or gigabytes)

Last Modified 1 month - 2 months
Number of files that were modified between 1 month to 2 months previous
and the total physical size of those files (measured in kilobytes, megabytes,
or gigabytes)

Last Modified 2 months - 3 months
Number of files that were modified between 2 months to 3 months
previous and the total physical size of those files (measured in kilobytes,
megabytes, or gigabytes)

Last Modified 3 months - 6 months
Number of files that were modified between 3 months to 6 months
previous and the total physical size of those files (measured in kilobytes,
megabytes, or gigabytes)

Last Modified 6 months - 9 months
Number of files that were modified between 6 months to 9 months
previous and the total physical size of those files (measured in kilobytes,
megabytes, or gigabytes)

Last Modified 9 months - 1 year
Number of files that were modified between 9 months to 1 year previous
and the total physical size of those files (measured in kilobytes, megabytes,
or gigabytes)

Last Modified > 1 year
Number of files that were modified over a year previous and the total
physical size of those files (measured in kilobytes, megabytes, or gigabytes)
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Overall File Count
Sum of the files

Overall File Size
Sum of the size of the files

Average Age
Average age since files were modified

To view graphical information about storage modification times, click . A
new tab displaying a chart for the network is displayed.

Most At Risk Files
This report provides information on files that were modified the longest time ago
and were not backed-up or archived since they were modified.

The following list describes the columns that are on the Most At Risk Files report.
All of the fields on the report are for display only and are not editable.

Modification Time
Date and time when an at risk file was last modified

Computer
Name of the computer where an at risk file is stored

Filesystem
Filesystem where an at risk file is stored

Path Full path to the location of an at risk file

Filename
The name of the at risk file

Owner
ID of the user who owns an at risk file

OS User Group
OS User group of the user who owns an at risk file

Logical Size
Logical size of an at risk file

Physical Size
Physical size of an at risk file (measured in kilobytes, megabytes, or
gigabytes)

Access Time
Date and time when an at risk file was last accessed

Create Time
Date and time when an at risk file was created

To view more information about a specific file:

v Click . Detailed information regarding the file is displayed in a File Detail
tab. The File Detail tab displays more information for the specific file and
provides information such as file ownership, modification and creation time, and
any file attributes that were set.
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Most Obsolete Files
This report provides information about files that have not been accessed or
modified for the longest period of time.

The following list describes the columns that are on the Most Obsolete Files report.
All of the fields on the report are for display only and are not editable.

Access Time
Date and time when an obsolete file was last accessed

Computer
Name of the computer where an obsolete file is stored

Filesystem
Filesystem where an obsolete file is stored

Path Full path to the location of an obsolete file

Filename
File name of an obsolete file

Owner
ID of the user who owns an obsolete file

OS User Group
OS User Group to which the owner of the obsolete file belongs

Logical Size
Logical size of an obsolete file

Physical Size
Physical size of an obsolete file (measured in kilobytes, megabytes, or
gigabytes)

Modification Time
Date and time when an obsolete file was last modified

Create Time
Date and time when an obsolete file was created

Viewing more information about a specific file

Click . Detailed information regarding the file is displayed in a File Detail
tab. The File Detail tab displays more information for the specific file and provides
information such as file ownership, modification and creation time, and any file
attributes that are set.

Oldest Orphaned Files
This report provides information about files that have the oldest creation date and
no longer have owners who are registered as users on the computer or network.

The following list describes the columns that are on the Oldest Orphaned Files
report. All of the fields on the report are for display only.

Access Time
Date and time when an orphaned file was last accessed

Computer
Name of the computer where an orphaned file is stored

Filesystem
Filesystem where an orphaned file is stored
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Path Full path to the location of an orphaned file

Filename
File name of an orphaned file

Owner
Operating system internal ID of the user who owned the orphaned file.
This is the internal ID that the operating system uses to identify the user,
and not the user ID

OS User Group
OS User group to which the owner of an orphaned file belongs

Logical Size
Logical size of an orphaned file

Physical Size
Physical size of an orphaned file (measured in kilobytes, megabytes, or
gigabytes)

Modification Time
Date and time when an orphaned file was last modified

Create Time
Data and time when an orphaned file was created

To view more information for a specific file:

v Click . Detailed information regarding the file is displayed in a File Detail
tab. The File Detail tab displays information about a specific file such as file
ownership, modification and creation time, and any file attributes that are set.

User Quota Violations
This report shows which users have violated a Data Manager storage usage quota.

The following list describes the columns on the User Quota Violations report. All
the fields on the report are for display only.

Quota Creator
Creator of a quota

Quota Name
Name of a quota

Computer
Computer that violated a quota

Filesystem
File system that violated a quota

User Name
ID of the user that violated a quota

Space Used
Total amount of space used

Threshold
Threshold defined by a quota

% of Threshold
Percentage of quota; always > 100

Number of Violations
Number of violations by a user
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Quota Type
Type of quota: Network Wide, Filesystem, or Computer

Computer Storage Availability
This report provides information about the availability of computers within your
environment.

If the computer is not available (determined by a ping), the storage is likely not
available for use. The following list describes the fields that are on the Storage
Availability report. All of the fields on the report are for display only.

Computer
Name of the computer

% Available
Percentage of successful pings

Transmitted
Number of pings transmitted

Received
Number of responses from the ping

Damaged
Number of responses with errors

Avg Transit Time
Average time to send and receive a response from a ping

Max Transit Time
Maximum time it took to send and receive response from a ping

Min Transit Time
Minimum time it took to send and receive response from a ping

Report Start Time
Start time of information in this row

Report End Time
End time of information

To view the ping history for a specific computer, click . A new tab
displaying ping history information for the selected computer is displayed.

Computer Disk Space
This report provides storage capacity information about each computer within
your environment.

The following list describes the columns that are on the Computer Disk Space
report. All of the fields on the report are for display only.

Computer
Name of a computer against which the report was run

Disk Space
Total storage capacity for a computer

Available Disk Space
Amount of unused storage space on a computer (not in file systems seen
by this operating system)
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Owned Disk Space
Total amount of unique disk storage space for computers in a cluster that
is owned by those computers. If Tivoli Storage Productivity Center
determines that a disk is configured for a different host, that disk's capacity
is not counted in this column. Tivoli Storage Productivity Center does not
include the following disks in its calculation of the value for this column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

Note:

v If the computer is an IBM SAN File System client, this value does not
include the capacity of any volumes that are visible to it that are owned
by the SAN File System.

v If the host is Solaris and Veritas Volume Manager (VxVM) is in use, the
product examines the Veritas disk-label and reads from the host ID. If
this does not agree with the local host ID, the disk is classified as
belonging to a different (Solaris) host.

Owned Available Disk Space
Total amount of unique disk storage space for computers in a cluster that
is not allocated to any logical volume within the computers and is owned
by the computers. If Data Manager determines that a disk is configured for
a different computer, that disk's unallocated space is not counted in this
column. Tivoli Storage Productivity Center does not include the following
disks in its calculation of the value for this column:
v Computer disks on computers that have not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from the computer.

If the computer is an IBM SAN File System client, then this value excludes
the unallocated space on any storage subsystem volumes visible to it that
are owned by the SAN File System.

If the host is Solaris and Veritas Volume Manager (VxVM) is in use, the
product will examine the Veritas disk-label and read off the host-ID. If this
does not agree with the local host-ID, the disk is classified as belonging to
a different (Solaris) host.

Non-Fibre Channel Attached Disk Space
Total amount of unique disk space on the computers in a cluster that is not
attached through a fibre channel port. Tivoli Storage Productivity Center
does not include the following disks in its calculation of the value for this
column:
v Computer disks that reside behind a fibre channel port.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Non-Fibre Channel Attached Available Disk Space
Total amount of disk storage space on the computers in a cluster that is not
allocated to any logical volume within the computers and is not attached
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through a fibre channel port. Tivoli Storage Productivity Center does not
include the following disks in its calculation of the value for this column:
v Computer disks that reside behind a fibre channel port.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Fibre Channel Attached Disk Space
Total amount of unique disk space on the computers in a cluster that is
attached through a fibre channel port. Tivoli Storage Productivity Center
does not include the following disks in its calculation of the value for this
column:
v Computer disks that do not reside behind a fibre channel port.
v Computer disks that reside behind a fibre channel port that is not

identified by a Storage Resource agent or Data agent.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Fibre Channel Attached Available Disk Space
Total amount of disk storage space on the computers in a cluster that is not
allocated to any logical volume within the computers and is attached
through a fibre channel port. Tivoli Storage Productivity Center does not
include the following disks in its calculation of the value for this column:
v Computer disks that do not reside behind a fibre channel port.
v Computer disks that reside behind a fibre channel port that is not

identified by a Storage Resource agent or Data agent.
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

OS Type
Operating system running on a computer

Network Address
Network address of a computer

IP Address
IP address of a computer

Time Zone
Time zone in which a computer is running

CPU Architecture
Instruction set architecture on the machine where an agent is running

Available File System Space
This report shows the total amount of unused storage across a network.

The following list describes the columns on the Total Freespace report. All the
fields on the report are for display only.

Available File System Space
Total amount of available storage space available on a network.
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Percent Available File System Space
Percentage of total space that is unused on a network.

Consumed File System Space
Amount of used storage space on a network.

File System Space
Total amount (capacity) of storage space on a network.

File Count
Total number of files on a network.

Directory Count
Total number of directories on a network.

Percent Free Inodes
Percentage of free Inodes on a network.

Used Inodes
Number of used Inodes on a network.

Free Inodes
Number of free Inodes on a network.

User Space Usage
This report provides information about storage statistics related to users within
your environment.

The following list describes the columns on the User Space Usage report. All the
fields on the report are for display only.

User Name
ID of a user

File Size
Total amount of space used by a user

File Count
Number of files owned or created by a user

Directory Count
Number of directories owned or created by a user

Largest File
Largest file owned by a user

2nd Largest File
Second-largest file owned by a user

Files < 1KB
Number and total space usage of files under 1KB in size

Files 1KB - 10KB
Number and total space usage of files between 1KB and 10KB in size

Files 10KB - 100KB
Number and total space usage of files between 10KB and 100KB in size

Files 100KB - 1MB
Number and total space usage of files between 100KB and 1MB in size

Files 1MB - 10MB
Number and total space usage of files between 1MB and 10MB in size

Files 10MB - 100MB
Number and total space usage of files between 10MB and 100MB in size
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Files 100MB - 500MB
Number and total space usage of files between 100MB and 500MB in size

Files > 500MB
Number and total space usage of files over 500MB in size

Wasted Space
This report provides information about storage statistics on non-OS files not
accessed in the first year and orphan files.

The following list describes the columns on the Wasted Space-File Summary by
Computer report. All the fields on the report are for display only.

File Size
Total amount of space used by the obsolete and orphan files

File Count
Total number of obsolete and orphan files

Directory Count
Total number of orphan directories

Average File Size
Average size of obsolete and orphan files

File System Space
Amount of storage space available on a storage subsystem.

To view more information for a specific file, click . Detailed information per
computer will be displayed in a Network tab. The Network tab displays file
summary by computer.

System reports - Data Manager for Databases
Use these predefined reports to view statistics about your RDBMS storage
resources. These reports are available in the Data Manager for Databases > My
Reports > System Reports node of the navigation tree.

All DBMS - Database Storage By Computer
This report shows storage information about the databases in your environment
sorted by the computers on which they are stored.

The following list describes the columns that are displayed in the All DBMS
Database Storage By Computer report.

Computer
Name of the computer where the databases are located.

Total Size
Amount of space that is consumed by the databases on the computers.

File Capacity
Storage capacity of the data files within the databases.

File Free Space
Amount of free space that is available on the data files within the
databases.

DB-TS Count
Number tablespaces that are associated with the databases.
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File Count
Number of data files that are associated with the tablespaces in the
databases.

Log File Count
Number of log files that are associated with the databases.

All DBMS - User Database Space Usage
This report shows information about the RDBMS storage space consumed by users
across the network.

The following list describes the columns that appear on the All DBMS - User
Database Space Usage report:

User Name
Name of a user upon whose storage usage information was collected.

Total Size
Amount of space consumed by the objects that are owned by the user.

Empty Used Space
Amount of empty used space that resides on the objects that are owned by
the user.

Table Count
Number of tables that are owned by the user.

Index Count
Number of indexes that are owned by the user.

Other Count
Number of other objects owned by the user.

Largest Object
Size of the largest object owned by the user.

2nd Largest Object
Size of the second largest object owned by the user.

Segment Size < 50KB
Number and total space usage of objects owned by the user that are under
50KB in size.

Segment Size 50KB - 500KB
Number and total space usage of objects owned by the user that are
between 50KB and 500KB in size.

Segment Size 500KB - 1Mb
Number and total space usage of objects owned by the user that are
between 500KB and 1MB in size.

Segment Size 1Mb - 10Mb
Number and total space usage of objects owned by the user that are
between 1MB and 10MB in size.

Segment Size 10Mb - 100Mb
Number and total space usage of objects owned by the user that are
between 10MB and 100MB in size.

Segment Size 100Mb - 500Mb
Number and total space usage of objects owned by the user that are
between 100MB and 500MB in size.
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Segment Size 500Mb - 1GB
Number and total space usage of objects owned by the user that are
between 500MB and 1GB in size.

Segment Size > 1Gb
Number and total space usage of objects owned by the user that are over
1GB in size.

All DBMS - User Database Quota Violations
This report provides information on the users who violated any storage usage
thresholds defined in quotas.

The following list describes the columns that are on the All DBMS - User Database
Quota Violations report.

Quota Creator
ID of the user who created the quota

Quota Name
Name of the quota

Computer
Name of the computer where the quota violation occurred

RDBMS type
RDBMS to which an instance belongs, for example, Oracle, SQL Server,
Sybase, or UDB

Instance
Name/SID of the Oracle Instance, SQL Server server, Sybase server, or
UDB Instance where the quota violation occurred

Database-Tablespace
Name of the database where the tablespace resides and name of the
tablespace whose quota was violated

User Name
ID of the user who violated the quota

Space Used
Amount of space consumed by the user

Threshold
Threshold of used space defined within the quota

% of Threshold
Percentage of space by which the user violated the quota

Number of Violations
Number of violations for the user

Quota Type
The type of quota: Database-Tablespace, Instance, or Network-wide

Oracle - Database Storage By Computer
This report shows storage information about the databases in your environment
sorted by the computers on which they are stored.

The following list describes the columns that are in the Oracle - Database Storage
By Computer report.

Computer
Name of the computer where the databases are located.
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Total Size
Amount of space consumed by the databases on the computers.

Data File Capacity
Storage capacity of the data files within the databases.

Data File Free space
Amount of free space available on the data files within the databases.

Tablespace Count
Number tablespaces associated with the databases.

Data File Count
Number of data files associated with the tablespaces in the databases.

Log File Count
Number of log files associated with the databases.

Oracle - Total Database Freespace
This report provides information on the total free space for data files at a
network-wide level, as well as the percentage of free space, the total used space,
number of free extents, and number of data files on a network. This report is
available for Oracle and Microsoft SQL Server.

Free Space
Amount of free space on all data files in the network.

Percent Free
Percent of free space available on the data files in the network.

Used Space
Amount of used space on the data files in the network.

Total Size
Total size of data files in the network.

Free Extents
Number of free extents on the data files in the network.

Coalesced Extents
Number of coalesced extents on the databases in the network.

Minimum Free Extent Size
Minimum size of a free extent in a database.

Maximum Free Extent Size
Maximum size of a free extent in a database.

Number Data Files
Number of data files on the databases in the network.

Oracle - User Database Space Usage
This report shows information about the RDBMS storage space consumed by users
across the network.

The following list describes the columns that appear on the Oracle - User Database
Space Usage report:

User Name
Name of a user upon whose storage usage information was collected.

Total Size
Amount of space consumed by the objects that are owned by the user.
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Empty Used Space
Amount of empty used space that resides on the objects that are owned by
the user.

Table Count
Number of tables that are owned by the user.

Index Count
Number of indexes that are owned by the user.

Other Count
Number of other objects owned by the user.

Largest Segment
Size of the largest segment owned by the user.

2nd Largest Segment
Size of the second largest segment owned by the user.

Segment Size < 50KB
Number and total space usage of objects owned by the user that are under
50KB in size.

Segment Size 50KB - 500KB
Number and total space usage of objects owned by the user that are
between 50KB and 500KB in size.

Segment Size 500KB - 1Mb
Number and total space usage of objects owned by the user that are
between 500KB and 1MB in size.

Segment Size 1Mb - 10Mb
Number and total space usage of objects owned by the user that are
between 1MB and 10MB in size.

Segment Size 10Mb - 100Mb
Number and total space usage of objects owned by the user that are
between 10MB and 100MB in size.

Segment Size 100Mb - 500Mb
Number and total space usage of objects owned by the user that are
between 100MB and 500MB in size.

Segment Size 500Mb - 1GB
Number and total space usage of objects owned by the user that are
between 500MB and 1GB in size.

Segment Size > 1Gb
Number and total space usage of objects owned by the user that are over
1GB in size.

Oracle - Segments With Wasted Space
This report provides information on the segments containing allocated space that is
currently empty/not being used. Use this information to gather information that
can help you discover space that can be reclaimed and allocated to other objects.

Empty Used Space
The amount of empty used space within a segment (table, index, etc.)

Segment Creator
The owner of a segment

Segment Name
The name of a segment
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Computer
The name of the computer on which the Instance of a segment Instance
resides

Instance
The SID of an Oracle Instance

Database
The name of the database to which the segment belongs

Tablespace
The name of the tablespace to which the segment belongs

Partition
The partition on which the segment is stored

Segment Type
Type of the segment, including:
v TABLE
v TABLE PARTITION
v TABLE SUBPARTITION
v NESTED TABLE
v CLUSTER
v INDEX
v INDEX PARTITION
v INDEX SUBPARTITION
v LOBINDEX
v LOBSEGMENT
v LOB PARTITION
v LOB SUBPARTITION

Parent Type
Subset of the segment type

Parent Creator
The owner of a segment

Parent Name
The name of a segment

Total Size
The amount of space that is allocated to a segment

Number of Extents
The number of extents that is allocated to a segment

Freelist Blocks
The number of blocks that are on the freelist chain

Initial Extent
The size of the first extent that is allocated to a segment

Next Extent
The amount of space that Oracle will retrieve when allocating another
extent

Maximum Extents
The maximum number of extents that Oracle can allocate to an object

Percent Increase
The size that Oracle allocates for the next extent
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SqlServer - Database Storage By Computer
This report shows storage information about the databases in your environment
sorted by the computers on which they are stored.

The following list describes the columns that are displayed in the SqlServer
Database Storage By Computer report.

Computer
Name of the computer on which SQL Server is running.

Total Size
Total amount of storage space allocated to SQL Server on a computer.

Data File Capacity
Amount of allocated storage space for data files that is unused on a
computer where SQL Server is running.

Data File Free space
Amount of free space available on the data files associated with SQL
Server on a computer.

Log File Capacity
Amount of allocated storage space for log files that is unused on a
computer where SQL Server is running.

Log File Free space
Amount of free space available on the log files associated with SQL Server
on a computer.

Database Count
Number of databases associated with SQL Server on a computer.

Data File Count
Number of data files associated with SQL Server on a computer.

Log File Count
Number of log files associated with SQL Server on a computer.

SqlServer - Total Database Freespace
This report provides information on the total free space for data files at a
network-wide level, as well as the percentage of free space, the total used space,
number of free extents, and number of data files on a network. This report is
available for Oracle and Microsoft SQL Server.

Data Free Space
Amount of free space on all data files in the network.

Percent Free
Percent of free space available on the data files in the network.

Data Used Space
Amount of used space on the data files in the network.

Data Size
Total size of data files in the network.

Log Free Space
Amount of free space.

Log Percent Used
Percent of used space.

Log Used Space
Amount of space used by the log.
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Log Size
Size of the log.

Number Data Files
Number of data files on the databases in the network.

SqlServer - User Database Space Usage
This report shows information about the RDBMS storage space consumed by users
across the network.

The following list describes the columns that appear on the SqlServer - User
Database Space Usage report:

User Name
Name of a user upon whose storage usage information was collected.

Total Size
Amount of space consumed by the objects that are owned by the user.

Empty Used Space
Amount of empty used space that resides on the objects that are owned by
the user.

Table Count
Number of tables that are owned by the user.

Index Count
Number of indexes that are owned by the user.

Other Count
Number of other objects owned by the user.

Largest Object
Size of the largest object owned by the user.

2nd Largest Object
Size of the second largest object owned by the user.

Object Size < 50KB
Number and total space usage of objects owned by the user that are under
50KB in size.

Object Size 50KB - 500KB
Number and total space usage of objects owned by the user that are
between 50KB and 500KB in size.

Object Size 500KB - 1Mb
Number and total space usage of objects owned by the user that are
between 500KB and 1MB in size.

Object Size 1Mb - 10Mb
Number and total space usage of objects owned by the user that are
between 1MB and 10MB in size.

Object Size 10Mb - 100Mb
Number and total space usage of objects owned by the user that are
between 10MB and 100MB in size.

Segment Size 100Mb - 500Mb
Number and total space usage of objects owned by the user that are
between 100MB and 500MB in size.
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Object Size 500Mb - 1GB
Number and total space usage of objects owned by the user that are
between 500MB and 1GB in size.

Object Size > 1Gb
Number and total space usage of objects owned by the user that are over
1GB in size.

Sybase - Database Storage By Computer
This report shows storage information about the databases in your environment
sorted by the computers on which they are stored.

The following list describes the columns on the Sybase - Database Storage By
Computer report.

Computer
Name of the computer on which Sybase is running.

Total Device Size
Total amount of storage space that is allocated to Sybase on a computer.

Mirrored Device Size
Total storage capacity of the mirrored device for an instance.

Device Free Space
Amount of free space available on the data files that are associated with
Sybase on a computer.

Data Fragment Capacity
Amount of allocated storage space for log files that is unused on a
computer where Sybase is running.

Data Fragment Free space
Amount of free space available on the data fragments that are associated
with Sybase on a computer.

Log Fragment Capacity
Amount of allocated storage space for log fragments that is unused on a
computer where Sybase is running.

Log Fragment Free space
Amount of free space available on the log files that are associated with
Sybase on a computer.

Device Count
Number of devices associated with Sybase on a computer.

Database Count
Number of databases associated with Sybase on a computer.

Fragment Count
Number of fragments associated with Sybase on a computer.

Log File Count
Number of log files associated with Sybase on a computer.

Sybase - Total Device Freespace
This report provides information on the total free space for Sybase devices at a
network-wide level, as well as the percentage of free space, the total used space,
number of fragments, and number of devices.

Free Space
Amount of free space on all the devices in the network
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Percent Free
Percent of free space available on the devices in the network

Used Space
Amount of used space on the devices in the network

Total Size
Total size of devices in the network

Number Fragments
Number of fragments associated with the devices in the network

Number Devices
Number of devices in the network

Sybase - Total Database Freespace
This report provides information on the total free space for data files at a
network-wide level, as well as the percentage of free space, the total used space,
number of free extents, and number of data files on a network. This report is
available for Oracle and Microsoft SQL Server.

Data Free Space
Amount of free space on all data files in the network.

Percent Free
Percent of free space available on the data files in the network.

Data Used Space
Amount of used space on the data files in the network.

Data Size
Total size of data files in the network.

Log Free Space
Amount of free space available to a database log.

Log Percent Used
Percentage of allocated space that a database log is consuming.

Log Used Space
Amount of storage space consumed by a database log.

Log Size
Total amount of space allocated to a database log.

Number Fragments
Number of fragments associated with a database.

Sybase - User Database Space Usage
This report shows information about the RDBMS storage space consumed by users
across the network.

The following list describes the columns that appear on the Sybase- User Database
Space Usage report:

User Name
Name of a user upon whose storage usage information was collected.

Total Size
Amount of space consumed by the objects that are owned by the user.

Empty Used Space
Amount of empty used space that resides on the objects that are owned by
the user.
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Table Count
Number of tables that are owned by the user.

Index Count
Number of indexes that are owned by the user.

Other Count
Number of other objects owned by the user.

Largest Object
Size of the largest object owned by the user.

2nd Largest Object
Size of the second largest object owned by the user.

Object Size < 50KB
Number and total space usage of objects owned by the user that are under
50KB in size.

Object Size 50KB - 500KB
Number and total space usage of objects owned by the user that are
between 50KB and 500KB in size.

Object Size 500KB - 1Mb
Number and total space usage of objects owned by the user that are
between 500KB and 1MB in size.

Object Size 1Mb - 10Mb
Number and total space usage of objects owned by the user that are
between 1MB and 10MB in size.

Object Size 10Mb - 100Mb
Number and total space usage of objects owned by the user that are
between 10MB and 100MB in size.

Object Size 100Mb - 500Mb
Number and total space usage of objects owned by the user that are
between 100MB and 500MB in size.

Object Size 500Mb - 1GB
Number and total space usage of objects owned by the user that are
between 500MB and 1GB in size.

Object Size > 1Gb
Number and total space usage of objects owned by the user that are over
1GB in size.

UDB - Instance Storage By Computer
This report shows information about the UDB instances in your environment
sorted by the computers on which they are stored.

The following list describes the columns that are displayed on the UDB - Instance
Storage By Computer report.

Computer
Name of the computer on which a UDB Instance(s) resides

Total Size
Total amount of storage space allocated to UDB on a computer

Container Capacity
Amount of storage space allocated to the containers that reside on a
computer
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Container Free Space
Amount of free space available on the containers that reside on a computer

Log File Capacity
Amount of storage space allocated to the log files that reside on a
computer

Tablespace Count
Number of tablespaces that reside on a computer

Container Count
Number of containers that reside on a computer

Log File Count
Number of log files that reside on a computer

UDB - Total DMS Container Freespace
This report shows the total free space for the containers associated with DMS
tablespaces on UDB instances within your environment.

The following columns are displayed on the UDB - Total DMS Container Freespace
report:

Free Space
Amount of free space available on the DMS containers within a network.

Percent Space
Percentage of free space available on the DMS containers within a network.

Used Space
Amount of storage space consumed on the DMS containers within a
network.

Total Size
Total amount of space on the DMS containers within a network.

Number Containers
Number of DMS containers within a network.

UDB - User Database Space Usage
This report shows information about the RDBMS storage space consumed by users
across the network.

The following list describes the columns that appear on the UDB - User Database
Space Usage report:

User Name
Name of a user upon whose storage usage information was collected.

Total Size
Amount of space consumed by the objects that are owned by the user.

Empty Used Space
Amount of empty used space that resides on the objects that are owned by
the user.

Table Count
Number of tables that are owned by the user.

Index Count
Number of indexes that are owned by the user.

Other Count
Number of other objects owned by the user.
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Largest Object
Size of the largest object owned by the user.

2nd Largest Object
Size of the second largest object owned by the user.

Object Size < 50KB
Number and total space usage of objects owned by the user that are under
50KB in size.

Object Size 50KB - 500KB
Number and total space usage of objects owned by the user that are
between 50KB and 500KB in size.

Object Size 500KB - 1Mb
Number and total space usage of objects owned by the user that are
between 500KB and 1MB in size.

Object Size 1Mb - 10Mb
Number and total space usage of objects owned by the user that are
between 1MB and 10MB in size.

Object Size 10Mb - 100Mb
Number and total space usage of objects owned by the user that are
between 10MB and 100MB in size.

Object Size 100Mb - 500Mb
Number and total space usage of objects owned by the user that are
between 100MB and 500MB in size.

Object Size 500Mb - 1GB
Number and total space usage of objects owned by the user that are
between 500MB and 1GB in size.

Object Size > 1Gb
Number and total space usage of objects owned by the user that are over
1GB in size.

System Reports - Disk Manager
Use these predefined reports to view performance information about storage
subsystems.

The following system reports are available for Disk Manager .

Array Performance
This report shows performance data for arrays. This report supports IBM System
Storage DS8000, DS6000, and IBM TotalStorage Enterprise Storage Server systems
only.

Column Description

Subsystem ID of the storage system

Array The ID of the specified array.

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.
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Column Description

Disk Utilization Percentage The approximate utilization percentage of a
rank over a specified time interval (the
average percent of time that the disks
associated with the array were busy).

Sequential I/O Percentage Percentage of all I/O operations performed
for an array over a specified time interval
that were sequential operations.

Backend Read I/O Rate Average number of I/O operations per
second for read operations.

Backend Write I/O Rate Average number of I/O operations per
second for write operations.

Total Backend I/O Rate Average number of I/O operations per
second for read and write operations.

Backend Read Data Rate Average number of megabytes (2^20 bytes)
that were transferred for read operations.

Backend Write Data Rate Average number of megabytes (2^20 bytes)
that were transferred for write operations.

Total Backend Data Rate Average number of megabytes (2^20 bytes)
that were transferred for read and write
operations.

Backend Read Response Time Average number of milliseconds that it took
to respond to each read operation. For SAN
Volume Controller models, this is the
external response time of the managed disks
(MDisks).

Backend Write Response Time Average number of milliseconds that it took
to respond to each write operation. For SAN
Volume Controller models, this is the
external response time of the managed disks
(MDisks).

Overall Backend Response Time Average number of milliseconds that it took
to respond to each I/O operation (read and
write). For SAN Volume Controller models,
this is the external response time of the
managed disks (MDisks).

Write-cache Delay Percentage Percentage of I/O operations that were
delayed due to write-cache space constraints
or other conditions. Write-cache Delay
Percentage is the ratio of delayed I/O
operations to total I/O operations.

Write-cache Delay I/O Rate Average number of I/O operations per
second that were delayed because of
write-cache space constraints or other
conditions, for a particular component over
an interval.

Controller Cache Performance
This report shows performance data for storage system controller caches. This
report supports IBM System Storage DS8000, DS6000, DS5000, DS4000, and IBM
TotalStorage Enterprise Storage Server systems only.
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Column Description

Subsystem ID of the storage system.

Controller The ID of the controller.

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

Read I/O Rate (normal) Average number of I/O operations per
second for non-sequential read operations
for a component over a specified time
interval.

Read I/O Rate (sequential) Average number of I/O operations per
second for sequential read operations for a
component over a specified time interval.

Read I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential read operations for a
component over a specified time interval.

Write I/O Rate (normal) Average number of I/O operations per
second for non-sequential write operations
for a component over a specified time
interval.

Write I/O Rate (sequential) Average number of I/O operations per
second for sequential write operations for a
component over a specified time interval.

Write I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential write operations for a
component over a specified time interval.

Total I/O Rate (normal) Average number of I/O operations per
second for non-sequential read and write
operations for a component over a specified
time interval.

Total I/O Rate (sequential) Average number of I/O operations per
second for sequential read and write
operations for a component over a specified
time interval.

Total I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential read and write operations for
a component over a specified time interval.

Cache Holding Time Average cache holding time, in seconds, for
I/O data in this subsystem controller
(cluster). Shorter time periods indicate
adverse performance.

Read Cache Hits Percentage (overall) Percentage of cache hits for both sequential
and non-sequential read operations for a
component over a specified time interval.

Write Cache Hits Percentage (overall) Percentage of cache hits for both sequential
and non-sequential write operations for a
component over a specified time interval.
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Column Description

Total Cache Hits Percentage (overall) Percentage of cache hits for both sequential
and non-sequential read and write
operations for a component over a specified
time interval.

Read Cache Hits Percentage (normal) Percentage of cache hits for non-sequential
read operations for a component over a
specified time interval.

Write Cache Hits Percentage (normal) Percentage of cache hits for non-sequential
write operations for a component over a
specified time interval.

Total Cache Hits Percentage (normal) Percentage of cache hits for non-sequential
read and write operations for a component
over a specified time interval.

Read Cache Hits Performance (sequential) The sequential read cache allocated for the
controller.

Write Cache Hits Performance (sequential) The sequential write cache allocated for the
controller.

Total Cache Hits Performance (sequential) The total sequential cache percentage (read
and write) allocated for the controller.

Record Mode Read I/O Rate Average number of I/O operations per
second for record mode read operations for
a component over a specified time interval.

Record Mode Read Cache Hits Percentage Percentage of cache hits for record mode
read operations for a component over a
specified time interval.

Disk to Cache I/O Rate Average number of I/O operations (track
transfers) per second for disk to cache
transfers for a component over a specified
time interval.

Cache to Disk I/O Rate Average number of I/O operations (track
transfers) per second for cache to disk
transfers for a component over a specified
time interval.

Write-cache Delay Percentage Percentage of I/O operations that were
delayed due to write-cache space constraints
or other conditions. Write-cache Delay
Percentage is the ratio of delayed I/O
operations to total I/O operations.

Write-cache Delay I/O Rate Average number of I/O operations per
second that were delayed due to write-cache
space constraints or other conditions for a
component over a specified time interval.

Controller Performance
This report shows performance data for storage system controllers. This report
supports IBM System Storage DS8000, DS6000, DS5000, DS4000, and IBM
TotalStorage Enterprise Storage Server systems only.

Column Description

Subsystem ID of the storage system.

Controller The ID of the controller.
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Column Description

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

Read I/O Rate (overall) Average number of megabytes (2^20 bytes)
per second that were transferred for read
operations for a component over a specified
time interval.

Write I/O Rate (overall) Average number of megabytes (2^20 bytes)
per second that were transferred for write
operations for a component over a specified
time interval.

Total I/O Rate (overall) Average number of megabytes (2^20 bytes)
per second that were transferred for read
and write operations for a component over a
specified time interval.

Read Data Rate Average number of I/O operations per
second for both sequential and
non-sequential read operations for a
component over a specified time interval.

Write Data Rate Average number of I/O operations per
second for both sequential and
non-sequential write operations for a
component over a specified time interval.

Total Data Rate Average number of I/O operations per
second for both sequential and
nonsequential read and write operations.

Read Response Time Average number of milliseconds that it took
to service each read operation for a
component over a specified time interval.

Write Response Time Average number of milliseconds that it took
to service each write operation for a
component over a specified time interval.

Overall Response Time Average number of milliseconds that it took
to service each I/O operation (read and
write) for a component over a specified time
interval.

I/O Group Performance
This report shows performance data for I/O groups. This report supports IBM
System Storage SAN Volume Controller systems only.

Column Description

Subsystem ID of the storage system

I/O Group The ID of the specified input/output (I/O)
group.

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

CPU Utilization Percentage Average utilization percentage of the CPUs.
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Column Description

Read I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential read operations for a
component over a specified time interval.

Write I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential write operations for a
component over a specified time interval.

Total I/O Rate (overall) Average number of I/O operations per
second for both sequential and
nonsequential read and write operations.

Read Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
operations for a component over a specified
time interval.

Write Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for write
operations for a component over a specified
time interval.

Total Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
and write operations for a component over a
specified time interval.

Read Response Time Average number of milliseconds that it took
to service each read operation for a
component over a specified time interval.

Write Response Time Average number of milliseconds that it took
to service each write operation for a
component over a specified time interval.

Overall Response Time Average number of milliseconds that it took
to service each I/O operation (read and
write) for a component over a specified time
interval.

Port to Host Send I/O Rate Average number of exchanges (I/Os) per
second sent to host computers by a
component over a specified time interval.

Port to Host Receive I/O Rate Average number of exchanges (I/Os) per
second received from host computers by a
component over a specified time interval.

Total Port to Host I/O Rate Average number of exchanges (I/Os) per
second transmitted between host computers
and a component over a specified time
interval.

Port to Disk Send I/O Rate Average number of exchanges (I/Os) per
second sent to storage subsystems by a
component over a specified time interval.

Port to Disk Receive I/O Rate Average number of exchanges (I/Os) per
second received from storage subsystems by
a component over a specified time interval.
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Column Description

Total Port to Disk I/O Rate Average number of exchanges (I/Os) per
second transmitted between storage
subsystems and a component over a
specified time interval.

Port to Host Send Data Rate Average number of megabytes (2^20 bytes)
per second sent to host computers by a
component over a specified time interval.

Port to Host Receive Data Rate Average number of megabytes (2^20 bytes)
per second received from host computers by
a component over a specified time interval.

Total Port to Host Data Rate Average number of megabytes (2^20 bytes)
per second transmitted between host
computers and a component over a specified
time interval.

Port to Disk Send Data Rate Average number of megabytes (2^20 bytes)
per second sent to storage subsystems by a
component over a specified time interval.

Port to Disk Receive Data Rate Average number of megabytes (2^20 bytes)
per second received from storage
subsystems by a component over a specified
time interval.

Total Port to Disk Data Rate Average number of megabytes (2^20 bytes)
per second transmitted between storage
subsystems and a component over a
specified time interval.

Managed Disk Group Performance
This report shows performance data for managed-disk (MDisk) groups. This report
supports IBM System Storage SAN Volume Controller systems only.

Column Description

Subsystem ID of the storage system

Managed Disk Group The ID of the specified managed disk.

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

Read Transfer Size Average number of KB per input/output
(I/O) for read operations, for a particular
component over an interval.

Write Transfer Size Average number of KB per I/O for write
operations, for a particular component over
an interval.

Overall Transfer Size Average number of KB per I/O for read and
write operations, for a particular component
over an interval.

Backend Read I/O Rate Average number of I/O operations per
second for read operations.

Backend Write I/O Rate Average number of I/O operations per
second for write operations.
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Column Description

Total Backend I/O Rate Average number of I/O operations per
second for read and write operations.

Backend Read Data Rate Average number of Mbps that were
transferred for read operations.

Backend Write Data Rate Average number of Mbps that were
transferred for write operations.

Total Backend Data Rate Average number of Mbps that were
transferred for read and write operations.

Node Cache Performance report
This report lists the most recently gathered performance data for IBM System
Storage SAN Volume Controller nodes, which is aggregated to the node level from
the per-node VDisk sample data.

Column Description

Subsystem ID of the storage system

Node The ID of the specified node.

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

Read Cache Hits Percentage (overall) Percentage of cache hits for both sequential
and nonsequential read operations, for a
particular component over an interval.

Write Cache Hits Percentage (overall) Percentage of cache hits for both sequential
and nonsequential write operations, for a
particular component over an interval.

Total Cache Hits Percentage (overall) Percentage of cache hits for both sequential
and nonsequential read and write
operations, for a particular component over
an interval.

Read I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential read operations for a
component over a specified time interval.

Write I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential write operations for a
component over a specified time interval.

Total I/O Rate (overall) Average number of I/O operations per
second for both sequential and
nonsequential read and write operations.

Disk to Cache Transfer Rate Average number of I/O operations (track
transfers) per second for disk to cache
transfers, for a particular component over an
interval.

Cache to Disk Transfer Rate Average number of I/O operations (track
transfers) per second for cache to disk
transfers, for a particular component over an
interval.
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Column Description

Write-cache Delay Percentage Percentage of I/O operations that were
delayed because of write-cache space
constraints or other conditions, for a
particular component over an interval. (The
ratio of delayed operations to total I/Os.)

Write-cache Overflow Percentage Percentage of write operations that were
delayed because of lack of write-cache space,
for a particular component over an interval.

Write-cache Flush-through Percentage Percentage of write operations that were
processed in flush-through write mode, for a
particular component over an interval.

Write Cache Write-through Percentage Percentage of write operations that were
processed in write-through write mode, for a
particular component over an interval.

Write-cache Delay I/O Rate Average number of I/O operations per
second that were delayed because of
write-cache space constraints or other
conditions, for a particular component over
an interval.

Write-cache Overflow I/O Rate Average number of tracks per second that
were delayed because of lack of write-cache
space, for a particular component over an
interval.

Write Cache Flush-through I/O Rate Average number of tracks per second that
were processed in flush-through write mode,
for a particular component over an interval.

Write Cache Write-through I/O Rate Average number of tracks per second that
were processed in write-through write
mode, for a particular component over an
interval.

Readahead Percentage of Cache Hits Percentage of all read cache hits which
occurred on prestaged data.

Dirty Write Percentage of Cache Hits Percentage of all write cache hits which
occurred on already dirty data in the cache.

Port Performance
This report shows performance data for ports. This report supports all storage
systems.

Column Description

Subsystem ID of the storage system

Port The ID of the specified port.

WWPN The World Wide Port Name (WWPN) of the
selected port.

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

Port Send Bandwidth Percentage The approximate bandwidth utilization
percentage for send operations by a port
based on its current negotiated speed.
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Column Description

Port Receive Bandwidth Percentage The approximate bandwidth utilization
percentage for receive operations by this
port, based on its current negotiated speed.

Overall Port Bandwidth Percentage The approximate bandwidth utilization
percentage for send and receive operations
by this port.

Port Send Utilization Percentage The average amount of time that the port
was busy sending data over a time interval.

Port Receive Utilization Percentage The average amount of time that the port
was busy receiving data over a time interval.

Overall Port Utilization Percentage The average amount of time that the port
was busy sending or receiving data over a
time interval.

Port Send I/O Rate The average number of input/output (I/O)
operations per second for send operations
for a port over a time interval.

Port Receive I/O Rate Average number of I/O operations per
second of receive operations for a port over
a time interval.

Total Port I/O Rate Average number of I/O operations per
second for send and receive operations for a
port over a time interval.

Port Send Data Rate The average number of megabytes (2^20
bytes) per second that were transferred for
send (read) operations for a port over a time
interval.

Port Receive Data Rate The average number of megabytes (2^20
bytes) per second that were transferred for
receive (write) operations for a port over a
time interval.

Total Port Data Rate The average number of megabytes (2^20
bytes) per second that were transferred for
send and receive operations for a port over a
time interval.

Port to Host Send I/O Rate The average number of exchanges (I/Os) per
second sent to host computers by a
component over a time interval.

Port to Host Receive I/O Rate The average number of exchanges (I/Os) per
second received from host computers by a
component over a time interval.

Total Port to Host I/O Rate The average number of exchanges (I/Os) per
second transmitted between host computers
and a component over a time interval.

Port to Disk Send I/O Rate The average number of exchanges (I/Os) per
second sent to storage subsystems by a
component over a time interval.

Port to Disk Receive I/O Rate The average number of exchanges (I/Os) per
second received from storage subsystems by
a component over a time interval.
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Column Description

Total Port to Disk I/O Rate The average number of exchanges (I/Os) per
second transmitted between storage
subsystems and a component over a time
interval.

Port to Host Send Data Rate The average number of megabytes (2^20
bytes) per second sent to host computers by
a component over a time interval.

Port to Host Receive Data Rate The average number of megabytes (2^20
bytes) per second received from host
computers by a component over a time
interval.

Total Port to Host Data Rate The average number of megabytes (2^20
bytes) per second transmitted between host
computers and a component over a time
interval.

Port to Disk Send Data Rate Average number of megabytes (2^20 bytes)
per second sent to storage subsystems by a
component over a time interval.

Port to Disk Receive Data Rate Average number of megabytes (2^20 bytes)
per second received from storage
subsystems by a component over a time
interval.

Total Port Data Rate Average number of megabytes (2^20 bytes)
per second transmitted between storage
subsystems and a component over a time
interval.

Port Send Response Time The average number of milliseconds that it
took to service each send (read) operation
for a port over a time interval.

Port Receive Response Time The average number of milliseconds that it
took to service each receive (write) operation
for a port over a time interval.

Total Port Response Time The average number of milliseconds that it
took to service each operation (send and
receive) for a port over a time interval.

Port Send Transfer Size The average number of KB sent per I/O by
a port over a time interval.

Port Receive Transfer Size The average number of KB received per I/O
by a port over a time interval.

Total Port Transfer Size The average number of KB transferred per
I/O by a port over a time interval.

Subsystem Performance
This report shows performance data for storage systems. This report supports all
storage systems.

Column Description

Subsystem ID of the storage system.

Time Date and time that the data was collected.
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Column Description

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

Read I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential read operations for a
component over a specified time interval.

Write I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential write operations for a
component over a specified time interval.

Total I/O Rate (overall) Average number of I/O operations per
second for both sequential and
nonsequential read and write operations.

Read Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
operations for a component over a specified
time interval.

Write Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for write
operations for a component over a specified
time interval.

Total Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
and write operations for a component over a
specified time interval.

Read Response Time Average number of milliseconds that it took
to service each read operation for a
component over a specified time interval.

Write Response Time Average number of milliseconds that it took
to service each write operation for a
component over a specified time interval.

Overall Response Time Average number of milliseconds that it took
to service each I/O operation (read and
write) for a component over a specified time
interval.

Top Active Volumes Cache Hit Performance
This report summarizes the primary metrics for active volumes, prioritized by
cache hit ratio. Only volumes with an input/output (I/O) rate that is greater than
0 will be included in this report. If all volumes are inactive, this report will be
empty. This report supports all storage systems.

Column Description

Subsystem ID of the storage system.

Volume The ID of the volume.

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.
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Column Description

Read Cache Hits Percentage (overall) Overall read cache percentage for both
sequential and nonsequential read
operations.

Write Cache Hits Percentage (overall) Percentage of cache hits for both sequential
and nonsequential write operations.

Total Cache Hits Percentage (overall) Percentage of cache hits for both sequential
and nonsequential read and write
operations.

Readahead Percentage of Cache Hits Percentage of all read cache hits which
occurred on prestaged data.

Dirty Write Percentage of Cache Hits Percentage of all write cache hits which
occurred on already dirty data in the cache.

Read I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential read operations for a
component over a specified time interval.

Write I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential write operations for a
component over a specified time interval.

Total I/O Rate (overall Average number of I/O operations per
second for both sequential and
nonsequential read and write operations.

Read Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
operations for a component over a specified
time interval.

Write Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for write
operations for a component over a specified
time interval.

Total Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
and write operations for a component over a
specified time interval.

Read Response Time Average number of milliseconds that it took
to service each read operation for a
component over a specified time interval.

Write Response Time Average number of milliseconds that it took
to service each write operation for a
component over a specified time interval.

Overall Response Time Average number of milliseconds that it took
to service each I/O operation (read and
write) for a component over a specified time
interval.

Top Volumes Data Rate Performance
This report summarizes the primary performance metrics for volumes, prioritized
by data rate. This report supports all storage systems.
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Column Description

Subsystem ID of the storage system

Volume The ID of the specified volume.

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

Read Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
operations for a component over a specified
time interval.

Write Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for write
operations for a component over a specified
time interval.

Total Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
and write operations for a component over a
specified time interval.

Read I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential read operations for a
component over a specified time interval.

Write I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential write operations for a
component over a specified time interval.

Total I/O Rate (overall) Average number of I/O operations per
second for both sequential and
nonsequential read and write operations.

Read Response Time Average number of milliseconds that it took
to service each read operation for a
component over a specified time interval.

Write Response Time Average number of milliseconds that it took
to service each write operation for a
component over a specified time interval.

Overall Response Time Average number of milliseconds that it took
to service each I/O operation (read and
write) for a component over a specified time
interval.

Top Volumes Disk Performance
This report summarizes the primary performance metrics for volumes, prioritized
by disk rate. This report supports all storage systems.

Column Description

Subsystem ID of the storage system.

Volume The ID of the volume.

Time Date and time that the data was collected.
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Column Description

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

Disk to Cache Transfer Rate Average number of I/O operations (track
transfers) per second for disk to cache
transfers, for a particular component over an
interval.

Cache to Disk Transfer Rate Average number of I/O operations (track
transfers) per second for cache to disk
transfers, for a particular component over an
interval.

Write-cache Delay Percentage Percentage of I/O operations that were
delayed because of write-cache space
constraints or other conditions, for a
particular component over an interval. (The
ratio of delayed operations to total I/Os.)

Write-cache Overflow Percentage Percentage of write operations that were
delayed because of lack of write-cache space,
for a particular component over an interval.

Write-cache Flush-through Percentage Percentage of write operations that were
processed in flush-through write mode, for a
particular component over an interval.

Write Cache Write-through Percentage Percentage of write operations that were
processed in write-through write mode, for a
particular component over an interval.

Write-cache Delay I/O Rate Average number of I/O operations per
second that were delayed because of
write-cache space constraints or other
conditions, for a particular component over
an interval.

Write-cache Overflow I/O Rate Average number of tracks per second that
were delayed because of lack of write-cache
space, for a particular component over an
interval.

Write Cache Flush-through I/O Rate Average number of tracks per second that
were processed in flush-through write mode,
for a particular component over an interval.

Write Cache Write-through I/O Rate Average number of tracks per second that
were processed in write-through write
mode, for a particular component over an
interval.

Read I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential read operations for a
component over a specified time interval.

Write I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential write operations for a
component over a specified time interval.

Total I/O Rate (overall) Average number of I/O operations per
second for both sequential and
nonsequential read and write operations.
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Column Description

Read Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
operations for a component over a specified
time interval.

Write Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for write
operations for a component over a specified
time interval.

Total Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
and write operations for a component over a
specified time interval.

Read Response Time Average number of milliseconds that it took
to service each read operation for a
component over a specified time interval.

Write Response Time Average number of milliseconds that it took
to service each write operation for a
component over a specified time interval.

Overall Response Time Average number of milliseconds that it took
to service each I/O operation (read and
write) for a component over a specified time
interval.

Top Volumes I/O Rate Performance
This report summarizes the primary performance metrics for volumes, prioritized
by I/O rate. This report supports all storage systems.

Column Description

Subsystem ID of the storage system.

Volume The ID of the specified volume.

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

Read I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential read operations for a
component over a specified time interval.

Write I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential write operations for a
component over a specified time interval.

Total I/O Rate (overall) Average number of I/O operations per
second for both sequential and
nonsequential read and write operations.

Read Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
operations for a component over a specified
time interval.
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Column Description

Write Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for write
operations for a component over a specified
time interval.

Total Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
and write operations for a component over a
specified time interval.

Read Response Time Average number of milliseconds that it took
to service each read operation for a
component over a specified time interval.

Write Response Time Average number of milliseconds that it took
to service each write operation for a
component over a specified time interval.

Overall Response Time Average number of milliseconds that it took
to service each I/O operation (read and
write) for a component over a specified time
interval.

Top Volumes Response Performance
This report summarizes the primary performance metrics for volumes, prioritized
by response rate. This report supports all storage systems.

Column Description

Subsystem ID of the storage system.

Volume The ID of the volume.

Time Date and time that the data was collected.

Interval The actual duration of the sample interval
(in seconds) for the performance data that
was collected.

Read Response Time Average number of milliseconds that it took
to service each read operation for a
component over a specified time interval.

Write Response Time Average number of milliseconds that it took
to service each write operation for a
component over a specified time interval.

Overall Response Time Average number of milliseconds that it took
to service each I/O operation (read and
write) for a component over a specified time
interval.

Peak Read Response Time The peak (worst) response time for disk
reads for a component over a time interval.

Peak Write Response Time The peak (worst) response time for disk
writes for a component over a time interval.

Read I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential read operations for a
component over a specified time interval.
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Column Description

Write I/O Rate (overall) Average number of I/O operations per
second for both sequential and
non-sequential write operations for a
component over a specified time interval.

Total I/O Rate (overall) Average number of I/O operations per
second for both sequential and
nonsequential read and write operations.

Read Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
operations for a component over a specified
time interval.

Write Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for write
operations for a component over a specified
time interval.

Total Data Rate Average number of megabytes (2^20 bytes)
per second that were transferred for read
and write operations for a component over a
specified time interval.

System reports - Fabric Manager
Use these predefined reports to view performance information about fabrics.

Port Connections
Use the Port Connections report to view information about the ports on the
switches in your storage area network (SAN). This report includes information
about the port connections and status, as well as the port and switch IDs.

Fabric ID
The ID of the fabric that the switch is in.

Switch
The label value of the switch.

Switch Port
The ID of the port (domainID,port_number).

Slot The number for the blade that the port is on.

Index The unique number for the port across the whole switch.

Switch Port State
The state of the switch port: Normal, Warning, or Critical.

Connection State
The state of the connection between the two ports: Normal, Warning, or
Critical.

Connected Port
The port that the switch port is connected to. This value is the WWN of
the device connected to that port.

Connected Port State
The state of the connected port: Normal, Warning, or Critical.

Device
The device that the connected port is on.
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Device State
The state of the device that the connected port is on: Normal, Warning, or
Critical.

SAN Assets (ALL)
Use the SAN Assets (All) report to generate and view reports that provide
information about all the assets discovered by IBM Tivoli Storage Productivity
Center.

The following list describes the columns that are on the SAN Assets (ALL) report.
All of the columns in the report are for display only.

Fabric ID
The ID of the fabric that the asset is in.

Type The type of discovered asset.

Label The label of the asset.

Identifier
The unique identifier of the storage asset. For example, a switch WWN.

Status The state of the device, either Normal, Warning, or Critical.

SAN Assets (Connected Devices)
Use the SAN Assets (Connected Devices) report to generate and view reports that
provide information about all the connected devices discovered by IBM Tivoli
Storage Productivity Center.

The following table lists the columns that are on the SAN Assets (Connected
Devices) report. All of the columns in the report are for display only.

Fabric ID
The ID of the fabric that the asset is in.

Type The type of discovered asset.

Label The label of the asset.

Identifier
The unique identifier of the asset. For example, the device worldwide
name.

Status The status of the asset: Normal, Warning, or Critical.

SAN Assets (Switches)
Use the SAN Assets (Switches) report to generate and view reports that provide
information about switches in your SAN. These reports provide information about
the switch ID, type, manufacturer, WWN, location, and other details.

The following list describes the columns that are on the SAN Assets (Switches)
report. All of the columns in the report are for display only.

Fabric ID
The ID of the fabric that the switch is in.

Type The type is always "Switch".

Switch Type
The type of discovered switch. For example, a physical switch.

Label The label of the switch.

Status The status of the switch. The possible states are Normal and Missing.
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IP Address
The IP address of the switch.

Vendor ID
The manufacturer of the switch.

Model The model name and number of the switch.

Version
The version information of the switch.

Serial Number
The serial number of the switch.

Object ID
The object ID of the switch.

Management ID
The management ID of the switch.

Management Address
The URL of the switch element manager.

Domain
The ID of the domain that the switch is in.

Contact
The contact information for the switch.

WWN The world-wide name (WWN) of the switch.

Location
The physical location of the switch.

Physical Switch WWN
The WWN for the parent or physical switch of a virtual switch. If this is
not a virtual switch then this column is empty.

Switch Performance
Use the Switch Performance report to generate and view reports that provide
information about the free and occupied ports on the switches in your SAN. These
reports provide information about the port connections and status, as well as the
port and switch IDs, data and packet transfer rates, and other details. This report
can be generated only for switches that have had performance monitors run on
them.

The following list describes the columns that are on the Switch Performance report.
All of the columns in the report are for display only.

Switch
The ID of the switch.

Time The date and time of the data collection.

Interval
The size of the sample interval, in seconds.

Port Send Packet Rate
The rate at which packets are sent through this port.

Port Receive Packet Rate
The rate at which packets are received through this port.

Total Port Packet Rate
The total rate at which packet operations are performed through this port.
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Port Send Data Rate
The rate at which data is sent through this port.

Port Receive Data Rate
The rate at which data is received through this port.

Total Port Data Rate
The total rate at which data is processed through this port.

Port Peak Send Data Rate
The peak rate at which data is sent through this switch.

Port Peak Receive Data Rate
The peak rate at which data is received through this switch.

Port Send Packet Size
The size of the data block that is sent out through this switch.

Port Receive Packet Size
The size of the data block that is received in through this switch.

Overall Port Packet Size
The total size of the data block that is transferred by the switch.

Error Frame Rate
The rate at which error frames are generated by the switch.

Dumped Frame Rate
The rate at which frames are dumped by the switch.

Link Failure Rate
The rate at which failed links are generated by the switch.

Switch Port Errors
Use the Switch Port Errors report to generate and view reports that provide
information about the errors that are being generated by ports on the switches in
your SAN. These reports provide information about the error frames, dumped
frames, link failures, port and switch IDs, and other details. This report can be
generated only for switches that have had performance monitors run on them.

To view more information for a specific file, click . Detailed information
per computer is displayed in a Network tab. The Network tab displays file
summary by computer.

The following list describes the fields on the Switch Port Errors report. All the
fields on the report are for display only.

Switch
The ID of the switch.

Port The ID of the port.

WWPN
The World Wide Port Name (WWPN) of the selected port.

Slot The number for the blade that the port is on.

Index The unique number for the port across the whole switch.

Time The date and time of the data collection.

Interval
The size of the sample interval, in seconds.
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Port Send Packet Size
The size of the data block that is sent out through this switch.

Port Receive Packet Size
The size of the data block that is received in through this switch.

Overall Port Packet Size
The total size of the data block that is transferred by the switch.

Error Frame Rate
The rate at which error frames are generated by the switch.

Dumped Frame Rate
The rate at which frames are dumped by the switch.

Link Failure Rate
The rate at which failed links are generated by the switch.

Loss of Sync Rate
The average number of times per second that synchronization was lost
after the last reset of the device, for a particular component over a
particular time interval.

Loss of Signal Rate
The average number of times per second that the signal was lost after the
last reset of the device, for a particular component over a particular time
interval.

CRC Error Rate
The average number of frames received per second in which the CRC in
the frame did not match the CRC computed by the receiver, for a
particular component over a particular time interval.

Short Frame Rate
The average number of frames received per second that were shorter than
28 octets (24 header + 4 CRC), not including any start of frame/end of
frame bytes, for a particular component over a particular time interval.

Long Frame Rate
The average number of frames received per second that were longer than
2140 octets (24 header + 4 CRC + 2112 data), not including any start of
frame/end of frame bytes, for a particular component over a particular
time interval.

Encoding Disparity Error Rate
The average number of disparity errors received per second, for a
particular component over a particular time interval.

The following list describes columns that are not part of the Switch Port Errors
system report. However, you can include them, and save the resulting report in the
<user-id> Reports node.

Port Send Packet Rate
The rate at which packets are sent through this port.

Port Receive Packet Rate
The rate at which packets are received through this port.

Total Port Packet Rate
The total rate at which packet operations are performed through this port.

Port Send Data Rate
The rate at which data is sent through this port.
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Port Receive Data Rate
The rate at which data is received through this port.

Total Port Data Rate
The total rate at which data is processed through this port.

Port Peak Send Data Rate
The peak rate at which data is sent through this switch.

Port Peak Receive Data Rate
The peak rate at which data is received through this switch.

Top Switch Ports Data Rate Performance
Use the Top Switch Port Data Rate Performance report to generate and view
reports that provide information about the switches in your SAN that have the top
data rates. This report can be generated only for switches that have had
performance monitors run on them.

This report only displays rows for the 25 highest data rates from the switch ports
monitored. It displays those rows in descending order by Total Port Data Rate. You
can adjust the number of rows shown on the Selection tab.

To view more information for a specific file, click . Detailed information
per computer is displayed in a Network tab. The Network tab displays the file
summary by computer.

The following list describes the fields that are on the Top Switch Ports Data Rate
Performance report. All of the fields on the report are for display only.

Switch
The ID of the switch.

Port The ID of the port.

Time The date and time of the data collection.

Interval
The size of the sample interval, in seconds.

Total Port Data Rate
The total rate at which data is processed through this port.

Total Port Packet Rate
The total rate at which the packet operations are performed through this
port.

The following list describes columns that are not part of the Top Switch Ports Data
Rate Performance report. However, you can include them, and save the resulting
report in the <user> Reports node.

Port Send Packet Rate
The rate at which packets are sent through this port.

Port Receive Packet Rate
The rate at which packets are received through this port.

Port Send Data Rate
The rate at which data is sent through this port.

Port Receive Data Rate
The rate at which data is received through this port.
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Port Peak Send Data Rate
The peak rate at which data is sent through this switch.

Port Peak Receive Data Rate
The peak rate at which data is received through this switch.

Port Send Packet Size
The size of the data block that is sent out through this switch.

Port Receive Packet Size
The size of the data block that is received in through this switch.

Overall Port Packet Size
The total size of the data block that is transferred by the switch

Error Frame Rate
The rate at which error frames are generated by the switch.

Dumped Frame Rate
The rate at which frames are dumped by the switch.

Link Failure Rate
The rate at which failed links are generated by the switch.

WWPN
The World Wide Name identifier for the FC port.

Slot The number for the blade that the port is on.

Index The unique number for the port across the whole switch.

Top Switch Ports Packet Rate Performance
Use the Top Switch Ports Packet Rate Performance report to generate and view
reports that provide information about the switches in your SAN that have the top
packet rates. This report can only be generated for switches that have had
performance monitors run on them.

This report only displays rows for the 25 highest packet rates from the switch ports
monitored. It displays those rows in descending order by Total Port Packet Rate.
You can adjust the number of rows shown on the Selection tab.

To view more information for a specific file:

v Click . Detailed information per computer will be displayed in a Network
tab. The Network tab displays file summary by computer.

This section describes the fields on the Top Switch Ports Packet Rate Performance
report. All the fields on the report are for display only.

Switch
The ID of the switch.

Port The ID of the port.

Time The date and time of the data collection.

Interval
The size of the sample interval, in seconds.

Total Port Packet Rate
The total rate at which the packet operations are performed through this
port.
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Total Port Data Rate
The total rate at which data is processed through this port.

The following list describes the columns that are not part of the Top Switch Ports
Packet Rate Performance report. However, you can include them, and save the
resulting report in the <user> Reports node.

Port Send Packet Rate
The rate at which packets are sent through this port.

Port Receive Packet Rate
The rate at which packets are received through this port.

Port Send Data Rate
The rate at which data is sent through this port.

Port Receive Data Rate
The rate at which data is received through this port.

Port Peak Send Data Rate
The peak rate at which data is sent through this switch.

Port Peak Receive Data Rate
The peak rate at which data is received through this switch.

Port Send Packet Size
The size of the data block that is sent out through this switch.

Port Receive Packet Size
The size of the data block that is received in through this switch.

Overall Port Packet Size
The total size of the data block that is transferred by the switch.

Error Frame Rate
The rate at which error frames are generated by the switch.

Dumped Frame Rate
The rate at which frames are dumped by the switch.

Link Failure Rate
The rate at which failed links are generated by the switch.

WWPN
The World Wide Name identifier for the FC port.

Slot The number for the blade that the port is on.

Index The unique number for the port across the whole switch.

Batch reports
Use the information in this section to learn how to generate and view batch
reports. These reports are available in the IBM Tivoli Storage Productivity Center >
Reporting > My Reports > Batch Reports node in the navigation tree.

A batch report represents any Tivoli Storage Productivity Center report that you
want to run on a regular basis and save its data to a file. Schedule batch reports to
run immediately, run once at a specified date and time, or run repeatedly at a
specified date, time, cycle, and day. You can also select the time zone to use when
running the report.
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You can view the information in a generated batch report file directly or import it
into an application of your choice. Batch reports provide a convenient and
powerful way for you to save report definitions and schedule when to run those
reports.

Creating batch reports
Create a batch report.

To create a batch report follow this procedure:
1. Expand IBM Tivoli Storage Productivity Center → Reporting → My Reports.
2. Right-click the Batch Reports node and select Create Batch Report.

Note: If the batch report you want to create is similar to an existing one, click
the name of the existing report, edit it and save it using a different name.

3. Click the Report tab and select the type of report you want to create and move

it from Available to Current Selections by clicking . See “Selecting
batch report options” on page 1063 for details of the tab contents.

4. Click the Selection tab and refine the criteria for selecting and displaying
report data. Some options might not be available for all reports. Use the
Selection page to:
v Select a profile for controlling which data is collected. This option is not

available for all reports. See “Using profiles” on page 354 for information
about profiles.

v Click Selection to specify the resources (for example, computers) that will be
displayed in the report. This option is not available for all reports. For details
about selecting resources, see “Selecting resources to appear on a report” on
page 823.

v Click Filters to apply filters the data that you want to display (for example,
show only the machines that contain over 80% used space). For details about
applying filters, see “Filtering the resources that appear on a report” on page
825.

v Select the columns you want to include in the report and move them from

Available Columns to Included Columns by clicking .

Note:

v The values you set in Available Columns and Included Columns are not
used for the following types of batch reports: History CSV File, PDF Chart,
and HTML Chart.

v The value you set in the Summation Level field is not used for the following
types of batch reports: History CSV File, PDF Chart, and HTML Chart.

5. Click the Options tab of the Batch Report job window, specify the following:
v The machine on which the report file will be saved
v The report format (for example, HTML)
v Whether to run a script when the report process is complete
v The format for the name of the batch report

See “Selecting batch report options” on page 1063 for details of the tab
contents.

6. In the When to Run tab of the Batch Report job window, specify when and
how often to run the batch report. See “Scheduling a batch report” on page
1067 for details of the tab contents.
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7. In the Alert tab of the Batch Report job window, define the conditions that will
trigger an alert and the method of notification (for example, e-mail). See
“Defining alerts for batch reports” on page 1068 for details of the tab contents.

8. Click File → Save and type a name for the batch report. The batch report will be
saved using your user ID as a prefix. For example, if you are logged onto Tivoli
Storage Productivity Center as "Smith," the name of the batch report will be
Smith.report_name.

Selecting batch report options
Define the agent computer that you want to run the batch report on and specify
the format of the file to be saved.

Use the Options page to define where the batch report is run and specify
information about the output file.
1. Use the following fields to specify the location where a batch report is saved.

TPC Server
Save the batch report on the computer where the Tivoli Storage
Productivity Center server is located. Use the Report Location field to
specify the directory where the batch report file is saved.

Agent Save the batch report on the computer where an agent is located. Use
the Report Location field to specify the directory where the batch
report file is saved.

You can save batch reports to computers on which the following agents
are deployed:
v Data agents
v Storage Resource agents that are v4.2 or higher.

The Select Agent field becomes active if you select to save a batch
report to an agent.

Select Agent
Select the name of the computer on which an agent is deployed. This
menu only displays computers on which the following agents are
deployed:
v Data agents
v Storage Resource agents that are v4.2 or higher.

To save a batch report to a computer on which v4.1 of a Storage
Resource agent is deployed, you must upgrade that agent to v4.2 or
higher.

Note:

v The type of report that is selected for the batch report determines the
agents that are available in this list. Agents that do not support the
selected report are not displayed. For example, agents for versions of
the product before v4.1 are not available for Data Source reports.

v If the agent you select from this menu is removed from the computer
before the batch report is run, an error occurs and the batch report is
not generated. If this error occurs, edit the definition of the batch
report to specify an existing agent and then run the report again.

v There are differences in the batch reports depending on whether a
Storage Resource agent or a Data agent is selected. If you are using a
Storage Resource agent to collect data, these additional columns are
available in the batch reports using the Selection tab:
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– Is Encryptable
– Is Encrypted

Report Location
Specify the directory where you want to save the batch report. This
field is only available for batch reports that are sent to the following
locations:
v TPC Server
v Storage Resource agents that are v4.2 or higher.

For Data agents, batch reports are automatically saved to the following default
locations:

Windows
C:\Program Files\IBM\TPC\ca\subagents\TPC\Data\log\

computer_name\reports\

Note: If you upgraded to Tivoli Storage Productivity Center v4.2 or
higher from a version before 3.1, the default location for batch reports
is:
C:\Program Files\IBM\TPC\ep\subagents\TPC\Data\log\

computer_name\reports\

UNIX or Linux
/opt/IBM/TPC/ca/subagents/TPC/Data/log/computer_name/reports/

Note: If you upgraded to Tivoli Storage Productivity Center v4.2 or
higher from a version before 3.1, the default location for batch reports
is:
/opt/tivoli/ep/subagents/TPC/Data/log/computer_name/reports/

For Storage Resource agent batch reports, when you select a Storage Resource
agent from the Select Agent drop-down list, you see the location for the batch
reports.

Windows
SRA_location\agent\log\computername\reports

UNIX or Linux
SRA_location/agent/log/computername/reports

Note:

You can modify the location of the batch reports for Storage Resource agents
and the TPC server only. You cannot modify the location of the batch reports
for the Data agents.

You also have the option of saving the report on the Tivoli Storage Productivity
Center server. The default path for the Tivoli Storage Productivity Center server
is:

Windows
C:\Program Files\IBM\TPC\data\log\reports

UNIX or Linux
/opt/IBM/TPC/data/log/reports

2. In the Report Type Specification section, select the type of batch report you
want to generate. You are limited to one type of output per batch report job
and can select from the following output formats:
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CSV File
Create a CSV (comma delimited) file of the batch report. Select Include
Headers to include column headers in the batch report output file.
Select Include Totals to include the Totals column in the report output
file.

Formatted File
Create a formatted text file of the batch report.

HTML File
Create an HTML file of the batch report.

History CSV File
For reports with historical trending, you can export the historical data
to a CSV file. The CSV file has the following format: <object name, date,
amount, date, amount> and so on, where <date, amount> corresponds to
each data point on the history chart.

PDF Chart
Create a chart for the batch report in PDF format. After you select this
option, you can determine the type of chart you want to create. The list
of available chart types vary by the report you selected on the Report
tab:
v Chart space usage
v History chart: File Count
v History chart: Free Space
v History chart: Free Space %
v History chart: Used Space
v History chart: Used Space %
v History chart: Capacity

Note:

v You must use Adobe Acrobat Reader to view the resulting PDF. You
can download Adobe Acrobat Reader from: http://get.adobe.com/
reader/.

v This option is available for reports that support charting only.
v For agents that run on Linux and UNIX computers, you must

perform additional configuration steps to enable this option. For
information about how to configure the agent system, go to the
Tivoli Storage Productivity Center Information Center. Search for the
topic "Configuring IBM Tivoli Storage Productivity Center for batch
reports on UNIX or Linux."

v The batch chart uses any customization settings that are defined for
the corresponding "online" chart. "Online" charts are those charts
generated using the Reporting facility.
For example, if you choose to generate a TPC-wide Storage Space >
File System Space > By Filesystem > PDF Chart > Chart space
usage batch report chart, any customization settings defined in the
Reporting facility for Data Manager > Reporting > TPC-wide
Storage Space > File System Space > By Filesystem > Chart space
usage for selected is applied to the batch report chart.
Any batch chart with an associated online report that provides a
choice between "selected" and "all" for its generated charts use the
customization settings defined for the "selected" chart.
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v If you select PDF Chart > Pie Chart from the Chart Customization
window and one of the elements represented in the pie chart is much
smaller than the other elements, the pie chart displays a graphical
error. For example, if the pie chart for a batch report shows disk
space, and the disk space used is 4 KB and the free space is 10 GB, a
graphical error is displayed.

HTML Chart
Select this option if you want to create a chart for the batch report in
HTML format. When HTML Chart is selected, the drop-down list to the
right becomes active. Use this drop-down list to select the type of chart
you want to create. The list of available chart types vary by the report
you selected on the Report tab:
v Chart space usage
v History chart: File Count
v History chart: Free Space
v History chart: Free Space %
v History chart: Used Space
v History chart: Used Space %
v History chart: Capacity

Note:

v If you generate charts for reports and these charts contain long path
names or a large number of segments, the text on the charts might
overlap and make them difficult to read.

v For agents that run on Linux and UNIX computers, you must
perform additional configuration steps to enable this option. For
information about how to configure the agent system, go to the
Tivoli Storage Productivity Center Information Center. Search for the
topic "Configuring IBM Tivoli Storage Productivity Center for batch
reports on UNIX or Linux."

v The batch chart you generate uses any customization settings that are
defined for the corresponding "online" chart. "Online" charts are
those generated using the Reporting facility.
For example, if you choose to generate a TPC-wide Storage Space >
File System Space > By Filesystem > PDF Chart > Chart space
usage batch report chart, any customization settings defined in the
Reporting facility for Data Manager > Reporting > TPC-wide
Storage Space > File System Space > By Filesystem > Chart space
usage for selected is applied to the batch report chart.
Any batch chart with an associated online report that provides a
choice between "selected" and "all" for its generated charts use the
customization settings defined for the "selected" chart.

Customize this chart
Click this button to use the Chart Customization window to customize
the chart that is generated for the batch report. You will be able to
select a chart type and chart orientation. If there is a customized chart
for the corresponding online report, the customized chart is used for
this batch report. However, you can override that customized chart by
using this function.

The button is active only when PDF Chart or HTML Chart is selected.
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3. In the Classic Column Names Specification section, check Use Classic
Column Names to use the original names of report columns in the output for
batch reports. If you do not select this option, the new names of columns are
used. For your reference, the online help displays the original names of those
columns within parentheses ( ) next to their new names.

Note: The titles of some reports have been updated. These new titles are
always used for batch reports

4. In the Script section, check Run Script to run a script when the batch report is
completed.
Select this option and enter the name of the script you want to run against the
results of the batch report. For example, if you create a batch report for the
most obsolete files on monitored computers, you can indicate a script that runs
a program to archive all the files that appear in that report.

5. In the Output File Specification section, define the output file naming format
for the batch report file.

Enter Mask that will be used to create the output file name
Displays the parameters that determine the name of the output file. For
example, if you use the default parameters, {Report creator} {Report
name} {Report run number}, Tivoli Storage Productivity Center
retrieves the values for these parameters and uses them to name the
output file. Click any of the following parameters to include them in
the mask for the name of an output file:
v Report creator (default)
v Report name (default)
v Report run number (default)
v Report title
v Report run date
v Report run time
v Unique number

Note: If you include {Report name} in the mask, Tivoli Storage
Productivity Center uses the name of the batch report definition in the
name of the output file. If you included NLS characters in the name of
the batch report definition, errors might occur if you selected a Storage
Resource agent as a destination for the batch report. You can use NLS
characters in the name of a batch report definition in the following
situations:
v TPC server or Data agent is selected as the destination for a batch

report.
v A Storage Resource agent is selected as the destination for a batch

report and the {Report name} parameter is not included in the mask
for the output file name. If {Report name} is not used in the mask, it
is recommended that other parameters are included in the mask to
ensure that the output file name is unique. For example, {Report
Creator} {Report Run Number} {Report Title} {Unique number}.

Scheduling a batch report
Determine when and how often to run a batch report.

Use the When to Run page to specify when and how often to run the batch
reporting job.
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You have the following options for determining when to generate a report:
v Generate the report immediately
v Generate the report once at a specified time and date
v Generate the report repeatedly according to a schedule you specify

Select the option you want and then edit the time and date information
accordingly. You can also use the fields in the How to handle time zones section to
indicate the time zone that IBM Tivoli Storage Productivity Center should use
when scheduling and running the batch report. For example, if you selected to run
the job at 9:00 AM, you can use the fields in this section to run the batch report at:
v 9:00 AM local time of the agent running the batch report
v 9:00 AM of the time zone where the server resides
v 9:00 AM of a specific time zone, such as 9:00 AM CST or 9:00 GMT. For

example, if you select 9:00 AM CST, the batch report will run at 7:00 AM on an
agent located in the PST time zone.

Local time in each timezone. Select this option to use the time zone of the
computer where the agent that collects data for the job is deployed. For probes of
storage systems, tape libraries, and fabrics, the time zone of the Tivoli Storage
Productivity Center server is used.

Same Global time across all timezones. Use the options in this section to apply
the same global time across all the time zones where the probe is being run.
v Use the timezone that the server runs in. Select this option to use the time zone

of the location where the Tivoli Storage Productivity Center server resides.
v Use this timezone. Select this option to indicate a specific time zone for when to

run the job. Select a timezone from the list box.

Defining alerts for batch reports
Define the alert that will be triggered if the batch report fails to run.

Use the Alert tab to define an alert that will be triggered if the report does not run
on schedule.

To define alert values for a batch report, complete the following steps:
1. Expand IBM Tivoli Storage Productivity Center > Reporting -> My Reports

and right-click on Batch Reports.
2. Select Create Batch Reports. The Create Batch Reports window opens.
3. For information on creating the batch report, see “Batch reports” on page 1061.
4. Click the Alerts tab.
5. Define the conditions that will trigger the alert. The default setting is Report

Failed. No other alerting conditions are currently available.
6. Select alert mechanisms in addition to writing an error to the error log:

v If you want to use Simple Network Management Protocol (SNMP) traps,
IBM Tivoli Enterprise Console events, or e-mail as an alert notification, you
must specify disposition values in the Alert Dispositions window. Expand
Administrative Services > Configuration > Alert Disposition.

v If you want a script to be run after an event has been triggered, you must
create the script before you create the alert.

7. Save the file:
a. Click File > Save.
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b. The Save As window opens. Enter a name for the batch report and click
OK.

Editing alert values for a batch report

1. Expand IBM Tivoli Storage Productivity Center > My Reports > Batch
Reports. The list of existing batch reports is displayed.

2. Click the batch report. The Edit Batch Report window opens.
3. In the Alerts tab, make any necessary changes.
4. Click File > Save.

Related topics:
“Batch reports” on page 1061

Creating batch reports for storage subsystem or switch
performance
This topic describes how to create a batch report for storage subsystem
performance or switch performance.

To create a batch report for storage subsystem performance or switch performance,
follow these steps:
1. Expand IBM Tivoli Storage Productivity Center > Reporting > My Reports.
2. Right-click the Batch Reports node and select Create Batch Report.
3. Click the Report tab and select the type of report you want to create and move

it from Available to Current Selections by clicking the right-arrow button (>>).
Select an item from Storage Subsystem Performance or Switch Performance.

4. Click the Selection tab. The Report Filter Specifications window displays.

Selection button
This determines the resources upon which you want to report, such as
the storage subsystems, the fibre-channel ports, and so forth. The Select
Resources window displays. The type of resources displayed for
selection depends on the type of report you previously selected on the
Report tab. For example, if you selected a By Storage Subsystem report,
all displayed resources will be storage subsystems. If you clear the box
for a resource on the Select Resources window, a warning icon displays
on the Selection button.

Filter button
This further defines the data that you want to include in the report.
Filters enable you to apply general rules to the report. When you click
this button, the Edit Filter window displays.

For example, to select only data associated with subsystems that have a
name ending with "123–IBM", select the "Subsystem" column, the
"LIKE" operator, and type "*123–IBM" (without the quotation marks) in
the Value 1 field. To select only data which has a Read I/O Rate greater
than 0, select the "Read I/O Rate (overall)" column, the ">" operator,
and type "0" (without the quotation marks) in the Value 1 field.

If a filter is defined for this report, a warning icon displays on the
Filter button.

Time range selectors
All performance reports display historical performance data. Use the
time range selectors to specify the exact time range that you want the
report to cover. Click one of the following radio buttons to select the
type of historical report you want:
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Display latest performance data
This report contains only the latest available performance data
for the selected resources. Note that even the latest data
available might still be somewhat old, depending on whether
data was recently collected for the resources. Including the time
column in the report will help you determine how old the
latest available data actually is. Regardless of the age of the
data, clicking this button ensures that only a single row
(representing a single point in time) for each selected resource
is included in the report. If no data has ever been collected for
a particular resource, then that resource is not included in the
report. If no data has ever been collected for any resource, then
the resulting report will be empty.

Display historic performance data using absolute time
This report contains only data that falls within a specific time
range. Select the time range using the From and To selectors.
The specified from and to values are interpreted as inclusive.
The resulting report contains all the performance data that is
available within the specified time range, for each selected
resource. This means that the data can consist of potentially
many rows per resource, each with a unique timestamp. If no
data has been collected for a particular resource during the
specified time range, that resource is not included in the report.
If no data has been collected for any resource during the
specified time range, then the resulting report will be empty.

To determine which historical performance records fall within
the specified time range, the beginning timestamp of the
collection intervals is used for comparison. If an historical
record contains performance data for an interval of time from
1:00 PM to 1:05 PM, that record would be included in the
report for a time range of 1:00 PM to 8:00 PM. However, that
same record would not be included if a time range of 1:02 PM
to 8:02 PM was specified, because it is the beginning of the
time period (for example, 1:00 PM in this example) that is used
to determine inclusion in the specified time interval.

Specifying an absolute time range is not suitable for batch
reports that are run on a repeating schedule, because the
specified time range is fixed and will not automatically be
updated based on the most current date and time. The result
will be that the same report is generated every time that the
batch report is run. Instead, use a relative time range for this
type of report.

Display historic performance data using relative time
This report contains only data that falls within a specific time
range extending backward from the current date and time.
Specify the number of days in the desired time range, using the
days ago until now field. The report will be exactly the same
as a report using absolute time, with the To selector set to the
current date and time, and the From selector set to the current
date and time minus the number of days ago until now.
However, when regenerating this report periodically, as the
current date and time advances, the data included in the report
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will advance as well. As a result, this is the suitable option to
select when defining batch reports that are run on a repeated
schedule.

Note that the same criteria applies as if determining which
historical performance records fall within the specified time
range. Only the beginning timestamp of the collection intervals
is used for comparison. This means that data for the current
hour or the current day is not included in the report when
selecting hourly or daily summation data, because data for the
current hour or current day is only saved in the database when
the hour or day is complete. As an alternative, consider using
the first radio button, Display latest performance data, to see a
report showing the most recent daily summation data.

Summation Level
Use this selector to select which type of performance data records to
include in the report. The Tivoli Storage Productivity Center
Performance Manager collects and stores three different types of
performance data:

By sample
Represents the most detailed data. There is usually one sample
record per resource for every n minutes, where n is the
performance monitor interval length that was specified when
the monitor was defined. Each sample represents the average
performance of the resource over those n minutes. A sample
record with a timestamp of t will be saved at time t+n. In other
words, the beginning of each n minute time interval is used for
display and for time range matching.

Hourly
Represents an hourly average of the performance of the
specified resources. There will be one hourly record written
every hour, per resource. Each such record will be written at or
shortly after each hour mark on the (device) clock. For
example, a record with a timestamp of 12:00 PM and interval
length of 1 hour will be written at 1:00 PM.

Daily Represents a daily average of the performance of the resources.
There will be one daily record written every day, per resource.
Each daily record will be written at or shortly after midnight,
according to the device clock. For example, a record with a
timestamp of April 21, 12:00 AM and interval length of 24
hours will be written on April 22, 12:00 AM.

Note that hourly and daily records are usually retained in the database
for longer periods of time, compared to By Sample records. As a result,
if a generated report indicates that sample data is no longer available
for a particular time range in the past, it is possible that the sample
data has already been purged, in which case you can try generating the
report using hourly or daily summation levels.

Be aware that when selecting a time range using the Display historic
performance data using relative time radio button, it is necessary to
select the length of the range in days. This can lead to unexpected
results when also selecting the daily summation level. Remember that a
daily record is not written until the day is complete, which means that
at any given time during the day, the current day's data does not yet
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exist in the database. Therefore, selecting the daily summation level as
well as a relative time range of n days ago until now, will usually
result in n-1 records being returned per resource, assuming that at least
n-1 days worth of data has been previously collected for those
resources. Specifying a relative time range of 1 days ago until now will
result in an empty report.

Available Columns, Included Columns
Use these items to specify which columns to include and which
columns to exclude from the generated report.

Available Columns
Displays the columns that you can include in the generated
report that are not already included. If a column appears in the
Included Columns list box, it will not appear in the Available
Columns list box.

Included Columns
Displays the columns that will appear in the generated report.
By default, all columns for a report are listed in this list box
and will be displayed in the generated report. You can
highlight the columns and use the up and down arrows to
rearrange the order of the columns in the report. The order of
the items in this list box determines the order in which the
columns will appear in the generated report. The columns with
grayed-out names are the frozen columns, which cannot be
selected, removed, or reordered for this type of report.

If a column appears in the Available Columns list box, it will
not appear in the Included Columns list box.

To exclude a column from a report, click the name of the column in the
Included Columns list box. Click Shift+click and Ctrl+click to select
multiple columns, if so desired. Then click the left-arrow button (<<).
The selected columns are removed from the Included Columns list box,
and will appear in the Available Columns list box.

To include a column in a report, click the name of the column in the
Available Columns list box. Click Shift+click and Ctrl+click to select
multiple columns, if so desired. Then click the right-arrow button (>>).
The selected columns will be removed from the Available Columns list
box, and will appear in the Included Columns list box.

To rearrange the order of columns that will appear in the generated
report, click the name of a column in the Available Columns list box.
Click Shift+click and Ctrl+click to select multiple columns, if so
desired. Then click the up-arrow button (^) or the down-arrow button
(v) to move the selected columns up or down in the list, relative to the
other columns.

5. Click the Options tab of the Batch Report job window, specify the following:
v The machine on which the report file will be saved
v The report format (for example, HTML)
v Whether to run a script when the report process is complete
v The format for the name of the batch report

6. In the When to Run tab of the Batch Report job window, specify when and
how often to run the batch report.
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7. In the Alert tab of the Batch Report job window, define the conditions that will
trigger an alert and the method of notification.

8. Click File > Save and type a name for the batch report. The batch report will
be saved using your user ID as a prefix. For example, if you are logged onto
Tivoli Storage Productivity Center as "Smith," the name of the batch report will
be Smith.report_name.

Editing batch reports
Edit existing batch report definitions.

To edit a batch-report definition, follow this procedure:
1. Expand IBM Tivoli Storage Productivity Center → Reporting → My Reports →

Batch Reports.
2. Click the report name, make your changes and then click File → Save.

Viewing job information for a batch report
View job information for batch reports on the Job Management panel. Use this
panel to check the status of a batch report schedule and view the runs, jobs, and
log files associated with it.

To display a list of the runs and jobs for a batch report, complete the following
steps:
1. Expand IBM Tivoli Storage Productivity Center → Reporting → My Reports →

Batch Reports.
2. Click the name of a batch report. The content pane displays information about

the batch report schedule.
3. Click View Job History. The Job Management panel is displayed and the batch

report schedule is highlighted in the Schedules section.
4. View the runs and jobs for the highlighted batch report schedule in the Jobs for

Selected Schedule section. See “Managing schedules, jobs, and runs” on page
297 for more information about how to use the Job Management panel.

Displaying log files for a batch report
Display the log files batch reports.

To display the log files for a batch report schedule, complete these steps:
1. Expand IBM Tivoli Storage Productivity Center → Reporting → My Reports →

Batch Reports.
2. Click the name of a batch report. The content pane displays information about

the batch report schedule.
3. Click View Job History. The Job Management panel is displayed and the batch

report schedule is highlighted in the Schedules section.
4. In the Jobs for Selected Schedule, expand the run whose log files you want to

view. Click + or - to expand or collapse the job listing under a run.
5. Select the job whose log file you want to view and click View Log File(s). See

“Managing schedules, jobs, and runs” on page 297 for more information about
how to use the Job Management panel.

Displaying batch reports from the saved directory
Access the report file that is generated from a batch report schedule. This file
contains the data for the report that you generated as a batch report.
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After you run a batch report, batch report files are saved in the directory that you
specified on the Options page of the Create Batch Report panel. Batch reports are
automatically saved to the following default locations:
v Storage Resource agents:

– Windows: C:\Program Files\IBM\TPC\agent\log\computername\reports
– UNIX/Linux: /opt/IBM/TPC/agent/log/computername/reports

v Data agents:
– Windows: C:\Program Files\IBM\TPC\ca\subagents\TPC\Data\log\

computer_name\reports\
– UNIX/Linux: /opt/IBM/TPC/ca/subagents/TPC/Data/log/

computer_name/reports/

Viewing CSV batch reports with spreadsheet applications
View CSV-formatted batch reports in third-party spreadsheet applications.

If you are using a spreadsheet program (such as Excel) to view a CSV-type batch
report file, that program might display data in the wrong columns either because
the data was exported from Data Manager, the data contains commas, or the file
was opened or formatted in the spreadsheet program by double-clicking it.

If data is displaying in the wrong columns, open the CSV file using the
spreadsheet program's open command.

Exporting and importing settings that you define
This topic describes how to export batch report definitions, constraints, groups,
and profiles.

You can export settings that you define from one instance of IBM Tivoli Storage
Productivity Center and import the settings into another instance. To export and
import your definitions, complete the following steps:
1. On the system running the server component, change to the following

directory:

On Linux and UNIX operating systems
/opt/IBM/TPC/data/server/tools/

On Windows operating systems
C:\Program files\IBM\TPC\data\server\tools\

2. To export the definitions from a command prompt, type the following
command and press Enter:
export -e <file>

where <file> is the fully qualified name of the file where the definition
information is written.

3. On the system to which you want to migrate the definitions, change to the
tools directory.

4. To import the definitions, type the following command and press Enter:
export -i <file>

where <file> is the fully qualified name of the file that you created when
exporting.
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User ID (saved) reports
Use the information in this section to learn how to generate, save, and view user
ID reports. You can create a user ID reports based on a system report or any of the
online reports available in Data Manager, Data Manager for Databases, Disk
Manager, or Fabric Manager. Once saved, user ID reports are available in the IBM
Tivoli Storage Productivity Center > Reporting >My Reports > user ID name
node in the navigation tree.

Creating a user-defined report
Create a custom report based on a system report or any of the online reports
available in Data Manager, Data Manager for Databases, Disk Manager, or Fabric
Manager.

To create a custom report, follow this procedure:
1. Specify new report criteria by doing one of the following:

v Access a system report and change its format according to your
organization's needs.

v Create a new report using the reporting component in any of the IBM Tivoli
Storage Productivity Center managers. For example, Data Manager →
Reporting → Usage → Access Load → Access Time → By Filesystem.

2. Click File → Save and a type a name for the report. The report is saved in the
Tivoli Storage Productivity Center > Reporting > My Reports > user name's
node, where user name's is your login name. For example, if you are logged in
as "Smith", your custom reports appear under the Smith's Reports node.

Displaying user-defined reports
Display a custom report saved under your user ID.

To display a list of custom reports, expand the IBM Tivoli Storage Productivity
Center > Reporting > My Reports > <your user ID> node. Click the name of the
report you want to view.

Editing user-defined reports
Change the settings for an existing user ID report and save those changes.

To edit a custom report definition, follow this procedure:
1. Expand My Reports → user name's Reports.
2. Click the report name, make your changes and then click File → Save.

Rollup reports
Use rollup reports to view the storage information collected by the master IBM
Tivoli Storage Productivity Center server from its associated subordinate servers.
Rollup reports enable you to have a network-wide perspective of storage usage in
an environment where multiple Tivoli Storage Productivity Center servers are
deployed and collecting storage metrics.

Before you can generate rollup reports, you must perform the following:
v Associate subordinate servers with the master server on the Administrative

Services > Data Sources > Tivoli Storage Productivity Center Servers window.
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v Run discoveries, probes, and scans from the subordinate servers to gather
information about their locally-monitored storage entities.

v Run discoveries, probes, and scans from the master server to gather information
about its locally-monitored storage entities. Note that information about the
storage entities monitored by a master server are automatically shown in rollup
reports.

v Run TPC Server probes from the master against the subordinate servers to
collect their storage information for the rollup reports. Use the Tivoli Storage
Productivity Center Monitoring > TPC Server Probes node to define and
schedule probe jobs.

Note:

– If the same storage entity is managed by multiple subordinate servers, rollup
reports reflect the storage information from the subordinate server that most
recently probed that entity.

– After upgrading to Tivoli Storage Productivity Center 5.1, you must run
probes against the monitored storage assets for the master server to have
information about those assets displayed in Tivoli Storage Productivity
Center > Reporting > Rollup Reports.

Tivoli Storage Productivity Center includes different rollup reporting categories
that provide you with the flexibility to view data about your storage resources
according to the needs of your environment. The following rollup reporting
categories are available:

Generating rollup reports
Learn how to generate and view rollup reports.
1. Expand the navigation tree to display the type of report you want to generate.

For example, if you want to generate a database capacity report, expand IBM
Tivoli Storage Productivity Center > Reporting > Rollup Reports > Database
Capacity.

2. Highlight a By Clause to determine how you want to view a report. For
example, to view rollup capacity information according to computer group,
click Tivoli Storage Productivity Center > Reporting > Rollup Reports > All
DBMSs > By Computer Group. The Selection page displays.

3. Use the Selection page to determine what columns appear within a report,
what storage assets to report upon (Capacity and Database Capacity reports
only), and how to filter that values that appear report columns.

4. (Capacity and Database Capacity reports only) Click Selection... to select the
objects that you want to report upon from the Select Resources window. See
“Selecting resources to appear on a report” on page 823 for information.

5. Click Filter... to further filter the objects that appear in a report. Filters enable
you to apply general rules to the report based on the rows in that report. See
“Filtering the resources that appear on a report” on page 825 for more
information on filtering.

6. Use the Available Columns and Included Columns list boxes to determine
what columns are displayed in a generated report.

7. Click Generate Report. A new tab will be added to the tab dialog representing
the report that you generated.

8. Click the new tab to view the report. Reports are tabular in format and
composed of rows and columns. You can scroll the report to view the entire
report. Use the View menu to hide/show the navigation tree to increase the
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viewable area of the report or drag the divider bar in the middle of the screen
back and forth to reallocate the amount of space that is given each pane.

Rollup reports - fragmentation
Fragmentation occurs when related storage entities are being monitored by
different subordinate IBM Tivoli Storage Productivity Center servers.

The following example shows when fragmentation can occur using subordinate
servers and rollup reports:
v Example: Host A is assigned a volume from storage subsystem 1. Host A is

being monitored only by one Tivoli Storage Productivity Center subordinate
server (Server 1) and storage subsystem 1 is being monitored by another
subordinate server (Server 2). Server 1 and Server 2 are subordinate servers to
the master server (Server 3).
Reason for fragmentation: In this example, the host and subsystem are
fragmented because they are not being monitored by the same Tivoli Storage
Productivity Center server. This will cause the Correlated Volume Space value
in the rollup reports for storage subsystems and volumes to be incorrect.

To prevent fragmentation when using master and subordinate server relationships
to generate rollup reports, we recommend the following:
v Do not monitor a storage subsystem and the hosts to which its volumes are

assigned with different subordinate servers that are associated with the same
master server.

v Do not monitor a fabric and its related switches with different subordinate
servers that are associated with the same master server.

v If an agent machine is using storage from a subsystem, then both the agent and
subsystem should be monitored by the same subordinate server.

v Configure all the subordinate servers to discover all the storage subsystems
within your environment. Note that if a subordinate server is monitoring a
subsystem with an agent other than the agent that is using storage on that
subsystem, the value for the Correlated Volume Space column in rollup reports
will be incorrect. For example:
– Host A has storage from Subsystem 1
– Subordinate server B is Monitoring Host A and Subsystem 1
– Subordinate server C is Monitoring Subsystem 1 and probed the subsystem

more recently than server B.
– The master server is monitoring subordinate servers B and server C.

The master server will report the storage subsystem data from server C. Because
the master server does not know about Host A, the value for the Correlated
Volume Space column will be incorrect.

Rollup Reports - Asset
Use these reports to view detailed statistics about agents (IBM Tivoli Storage
Productivity Center), computers, storage subsystems, disk and volume groups,
disks, filesystems, logical volumes, volumes, and fabrics that are monitored by
subordinate servers.

The information shown in these reports is gathered by the master server when it
runs Tivoli Storage Productivity Center server probes against associated
subordinate servers. If the same storage entity is managed by multiple subordinate
servers, rollup reports reflect the storage information from the subordinate server
that most recently probed that entity.
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Rollup Reports - Asset - Agents
Use this report to view information about Data agents, Fabric agents, and Storage
Resource agents that are associated with subordinate servers in your environment.

You can generate and sort the data within this report using the following By
clauses:
v By Agent: Shows agents sorted according to the name of the computer on which

they are installed.
v By OS Type: Shows agents sorted according to the operating system under

which they run. Click the magnifying glass icon next to an operating system
type to view more detailed information about each of the agents running under
that operating system.

v By TPC Server: Shows agents sorted according to the subordinate server that
manages them. Click the magnifying glass icon next to subordinate server to
view more detailed information about each of the agents associated with that
server.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

By Agent

Agent Name
Name of the computer on which an agent is installed.

Data/SR Agent Version
Tivoli Storage Productivity Center version number of a Data agent or
Storage Resource agent (for example, 4.2.0).

Fabric Agent Version
Tivoli Storage Productivity Center version number of a Fabric agent (for
example, 4.1.1).

OS Type
Operating system on the computer where an agent is installed.

Data/SR Agent Status
Status of a Data agent or Storage Resource agent. Possible statuses include
Up and Down. A down agent represents an agent that is still running but
with which the server is not communicating.

Fabric Agent Status
Status of a Fabric agent. Possible statuses include Up and Down. A down
agent represents an agent that is still running but with which the server is
not communicating.

Data/SR Agent Port
Port number on which a Data agent or Storage Resource agent listens for
requests. Port 9549 is registered for use by IBM.

Fabric Agent Port
Port number on which a Fabric agent listens for requests. Port 9550 is
registered for use by IBM.

Host Address
Network name or IP address of an agent as seen by subordinate server.

Time Zone
Time zone where the agent is installed (for example, CDT).
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CPU Architecture
Instruction set architecture on the computer where an agent is running.

By OS Type

OS Type
Operating system on the computer where an agent is installed.

Number of Data Agents/SR Agents
Total number of Data agents and Storage Resource agents that are running
on the operating system.

Number of Data Agents/SR Agents (Status: Up)
Number of Data agents and Storage Resource agents that are running on
the operating system that have a status of Up.

Number of Data Agents/SR Agents (Status: Down)
Number of Data agents and Storage Resource agents that are running on
the operating system that have a status of Down. A down agent represents
an agent that is still running but with which the server is not
communicating.

Number of Data Agents/SR Agents (Status: Defected)
Number of Data agents and Storage Resource agents that are running on
the operating system that have been reassigned to another server.

Number of Data Agents/SR Agents (Status: Upgrading)
Number of Data agents and Storage Resource agents that are running on
the operating system and are currently in the process of upgrading to the
same version as the subordinate server.

Number of Data Agents/SR Agents (Status: Unreachable)
Number of Data agents and Storage Resource agents that are running on
the operating system that are unreachable. This status indicates that an
agent that is unreachable and not responding to the server. This status
might occur when the agent is not running but did not inform the server
that it was shutting down, or when a network problem has occurred.

Number of Data Agents/SR Agents (Status: Upgrade Required)
Number of Data agents and Storage Resource agents that are running on
the operating system that require an upgrade to the same version as the
subordinate server.

Number of Data Agents/SR Agents (Status: Deleted)
Number of Data agents and Storage Resource agents that are running on
the operating system that have a status of Deleted.

Number of Fabric Agents
Total number of Fabric agents that are running on the operating system.

Number of Fabric Agents (Status: Up)
Number of Fabric agents that are running on the operating system that
have a status of Up.

Number of Fabric Agents (Status: Down)
Number of Fabric agents that are running on the operating system that
have a status of Down. A down agent represents an agent that is still
running but with which the server is not communicating.
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By TPC Server

TPC Server
Name of the TPC server on which an agent is associated.

Number of Data/SR Agents
Total number of Data agents and Storage Resource agents that are
associated with the TPC server.

Number of Data Agents/SR Agents (Status: Up)
Number of Data agents and Storage Resource agents that are associated
with the TPC server that have a status of Up.

Number of Data Agents/SR Agents (Status: Down)
Number of Data agents and Storage Resource agents that are associated
with the TPC server that have a status of Down. A down agent represents
an agent that is still running but with which the server is not
communicating.

Number of Data Agents/SR Agents (Status: Defected)
Number of Data agents and Storage Resource agents that are associated
with the TPC server that have been reassigned to another server.

Number of Data Agents/SR Agents (Status: Upgrading)
Number of Data agents and Storage Resource agents that are associated
with the TPC server and are currently in the process of upgrading to the
same version as the subordinate server.

Number of Data Agents/SR Agents (Status: Unreachable)
Number of Data agents and Storage Resource agents that are associated
with the TPC server that are unreachable. This status indicates that an
agent that is unreachable and not responding to the server. This status
might occur when the agent is not running but did not inform the server
that it was shutting down, or when a network problem has occurred.

Number of Data Agents/SR Agents (Status: Upgrade Required)
Number of Data agents and Storage Resource agents that are associated
with the TPC server that require an upgrade to the same version as the
subordinate server.

Number of Data Agents/SR Agents (Status: Deleted)
Number of Data agents and Storage Resource agents that are associated
with the TPC server that have a status of Deleted.

Number of Fabric Agents
Total number of Fabric agents associated with the TPC server.

Number of Fabric Agents (Status: Up)
Number of Fabric agents associated with the TPC server that have a status
of Up.

Number of Fabric Agents (Status: Down)
Number of Fabric agents associated with the TPC server that have a status
of Down.

Rollup Reports - Asset - Computers
Use this report to view information about the hosts and computers (including
NetApp) that are monitored by subordinate servers in your environment. This
includes VMWare-related entities such as hypervisors and virtual machines.
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Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

You can generate and sort the data within this report using the following by
clauses:
v By Computer: Shows computers monitored by subordinate servers. Sorted by

computer name.
v By TPC Server: Shows subordinate servers that are monitoring computers.

Sorted by subordinate server name. Click the magnifying glass icon next to
subordinate server to view more detailed information about each of the
computers associated with that server.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

By Computer

Note: Two entries for the same host might appear in this report and the values for
that host are counted twice in the TOTAL column. This scenario occurs under the
following circumstances:
v You install two Storage Resource agents on the same host (using the long and

short names of the host) that point to different Tivoli Storage Productivity
Center servers. For example, you install an agent from serverA using the short
name of a host (for example, hostC). You install another agent from serverB
using the long name of the same host (for example, hostC.storage.chicago.com).
You then set up the servers in a master and subordinate relationship. For
example, serverA is the master and serverB is the subordinate. In this example,
there are two entries in the report for the host: hostC and
hostC.storage.chicago.com. The values for hostC are counted twice in the
TOTAL column.

v A Storage Resource agent on a host (hostC) points to two different Tivoli Storage
Productivity Center servers (serverA and serverB). The host has a dynamic IP
address. You set up serverA as the master and serverB as the subordinate. Server
serverA probes hostC, but then the IP address of hostC changes before serverB
probes the host. In this example, the report might display two entries for hostC:
one entry with the IP address that was probed by serverA; the other entry with
the changed IP address that was probed by serverB. The values for hostC are
counted twice in the TOTAL column.

v A Storage Resource agent on a host (hostC) points to two different Tivoli Storage
Productivity Center servers (serverA and serverB). The host has a name that
resolves to hostC.storage.chicago.com on serverA and
hostC.srm.storage.chicago.com on serverB. You then set up the servers in a
master and subordinate relationship. For example, serverA is the master and
serverB is the subordinate. In this example, there are two entries in the report
for the host: hostC.storage.chicago.com and hostC.srm.storage.chicago.com. The
values for hostC are counted twice in the TOTAL column.

Computer
Name of a computer monitored by a subordinate server.

OS Type
Operating system running on a computer.

OS Version
Version of the operating system running on a computer.
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RAM Amount of RAM installed on a computer.

Disk Space (Capacity)
Total storage capacity for a computer. Tivoli Storage Productivity Center
does not include the following disks in its calculation of the value for this
column:
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Note: If the computer is an IBM Tivoli Storage SAN File Systems client,
then this value will also include the capacity of any storage subsystem
volumes visible to this computers that are owned by the SAN File System.

Number of Disks
Total number of disks for a computer. Tivoli Storage Productivity Center
does not include the following disks in its calculation of the value in this
column:
v Computer disks on a computer that has not been probed by a Storage

Resource agent or Data agent.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Processor Count
Number of CPUs running on a computer.

IP Address
IP address of a computer.

Serial Number
Serial number of a computer.

Model Model number or name of a computer.

Manufacturer
Manufacturer of a computer (for example, IBM).

Time Zone
Time zone where the computer is located.

Available File System Space (Filesystem Free Space)
Total amount unique file system storage space that is not used or available
to the computer. Tivoli Storage Productivity Center does not include the
following file systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Network Address
Network name of a computer.

Processor Type
Type of processor running on a computer (for example, GenuineIntel: x86
Family 15).

Processor Speed
Speed at which a computer's processor is running (in MHz).
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CPU Arch
Architecture of the processor (for example, IA32).

Swap Space
Amount of swap space (virtual memory) defined on a computer.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring computers in your
environment.

# of Computers
Number of computers monitored by the subordinate server.

Disk Space (Capacity)
Total storage capacity of the computers monitored by the subordinate
server. Tivoli Storage Productivity Center does not include the following
disks in its calculation of the value for this column:
v Computer disks on a computer that has not been probed.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Note: If a computer is an IBM Tivoli Storage SAN File Systems client,
then this value will also include the capacity of any storage subsystem
volumes visible to this computers that are owned by the SAN File System.

Available File System Space (Filesystem Free Space)
Total amount unique file system storage space that is not used or available
to the computers that are monitored by the subordinate server. Tivoli
Storage Productivity Center does not include the following file systems in
its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

Number of Disks
Number of disks associated with the computers monitored by the
subordinate server. Tivoli Storage Productivity Center does not include the
following disks in its calculation of the value in this column:
v Computer disks on a computer that has not been probed by the Storage

Resource agent or Data agent.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Rollup Reports - Asset - Storage Subsystems
Use this report to view information about the storage subsystems that are
monitored by subordinate servers in your environment.

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.
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You can generate and sort the data within this report using the following By
clauses:
v By Storage Subsystem: Sorted according to storage systems name. The names of

storage systems monitored by subordinate servers appear in the first column
and remain displayed when scrolling through the other columns on the report.

v By Disk Space: Sorted according to the storage capacity of storage systems. The
names of storage systems monitored by subordinate servers and their disk
capacity appear in the first two columns and remain displayed when scrolling
through the other columns on the report.

v By TPC Server: Shows storage systems aggregated at subordinate server level.
The names of subordinate servers that are monitoring storage systems appear in
the first column and remain displayed when scrolling through the other columns
on the report. Click the magnifying glass icon next to subordinate server to view
more detailed information about each of the storage systems monitored by that
server.

Note:

v Storage systems that have been discovered but not probed are not displayed in
these reports.

v This report includes information about storage system volumes. For IBM System
Storage SAN Volume Controller systems, IBM Tivoli Storage Productivity Center
uses the term "Volume" to represent "virtual disks" for those systems.

By Storage Subsystem, and By Disk Space

Name Name or alias of a storage system that is monitored by a subordinate
server or the master server.

Disk Space (Capacity)
Total raw (unformatted) disk capacity of a storage system. Tivoli Storage
Productivity Center does not include the following capacity information in
its calculation of the value for this column:
v Capacity of spare disks identified on IBM TotalStorage Enterprise

Storage Server, IBM System Storage DS8000, and IBM System Storage
DS6000 storage systems.

v Capacity of storage system disks that become missing after a storage
system probe.

Note: For Hitachi Data Systems storage systems, this value is the capacity
of all the volumes in the storage system.

Available Disk Space (Unallocated Space)
Total unformatted disk free space of the storage system. Tivoli Storage
Productivity Center does not include the following storage space in its
calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
v RAID overhead on storage systems that are identified by Tivoli Storage

Productivity Center.
v External back-end storage for TagmaStore systems.
v Storage space that is consumed by volumes that reside on external disks

when Hitachi Data Systems (HDS) storage systems are configured as
storage virtualizers.

Note: For Hitachi Data Systems storage systems, internal disk information
is not available. This field is set to 0.
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Number of Disks
Total number of disks in the storage system. Tivoli Storage Productivity
Center does not include disks that become missing after a successful
storage system probe in its calculation of the value for this column. For
Hitachi Data Systems storage systems, internal disk information is not
available. This field is to 1.

Number of Volumes (LUNs)
Number of storage volumes and virtual storage volumes discovered by a
probe. Tivoli Storage Productivity Center does not include storage volumes
or virtual storage volumes that become missing after a successful probe in
its calculation of the value for this column.

Volume Space (LUN Capacity)
Total amount of unique storage system volume space or virtual storage
volume space discovered on monitored storage system arrays. Tivoli
Storage Productivity Center does not include storage volumes or virtual
storage volumes that become missing after a successful probe in its
calculation of the value for this column.

Note: For space-efficient volumes, this value is the amount of storage
space requested for these volumes, not the actual allocated amount. This
can result in discrepancies in the overall storage space reported for a
storage system using space-efficient volumes. This also applies to other
space calculations, such as the calculations for the storage system's
Consumable (Available) Volume Space and FlashCopy Target Volume
Space.

Consumable Volume Space (Usable LUN Capacity)
Total amount of unique storage system volume space or virtual storage
volume space discovered on monitored storage system arrays. Tivoli
Storage Productivity Center does not include the following storage entities
in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a probe
v Storage system volumes or virtual storage volumes that are used as flash

copy targets.
v Storage system volumes or virtual storage volumes that are identified as

a Business Continuance Volume extended (BCVx) (EMC only).
v Storage system volumes or virtual storage volumes used as a Volume

Configuration Management (VCM) database (EMC only).

FlashCopy Target Volume Space (Capacity)
Total amount of unique storage system volume space and virtual storage
volume space discovered on monitored storage system arrays and has been
identified as flash copy target space. Tivoli Storage Productivity Center
does not include the following storage entities in its calculation of the
value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a probe.
v Storage system volumes or virtual storage volumes that are not used as

flash copy targets.

Note: TotalStorage Enterprise Storage Server systems must have at least
the following microcode levels: ess800mincodelevel = 2.4.3.56,
essf20mincodelevel = 2.3.3.89. Tivoli Storage Productivity Center does not
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report FlashCopy information if the TotalStorage Enterprise Storage Server
systems do not meet this requirement.

Correlated Volume Space (LUN Capacity Visible to Data Manager)
Total amount of storage system volume space or virtual storage volume
space on systems where the systems disks are identified by Tivoli Storage
Productivity Center as residing within the monitored storage systems in a
group. This includes storage system volumes or virtual storage volumes
identified as back-end storage volumes on monitored storage system
virtualizers.Tivoli Storage Productivity Center does not include the
following entities in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Disks that are assigned to a monitored storage system but are not

identified by Tivoli Storage Productivity Center as a disk residing within
the storage system. Reasons why these disks are not identified as
residing within the storage system include:
– Tivoli Storage Productivity Center does not support the identification

of disks for some storage system types.
– The connection of the disk to the storage system is lost and is no

longer detectable during a probe.
v Storage system volumes or virtual storage volumes that are identified as

Business Continuance Volume extended (BCVx).
v Storage system volumes or virtual storage volumes used as a Volume

Configuration Management (VCM) database.

Volume Space Not Correlated (LUN Capacity Not Visible to Data Manager)
Total amount of unique storage system volume space and virtual storage
volume space discovered on monitored storage system arrays in a group
that can be assigned or are assigned to systems within the network. Tivoli
Storage Productivity Center does not include the following entities in its
calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Disks that reside within a monitored storage system.
v Storage system volumes or virtual storage volumes that Tivoli Storage

Productivity Center identifies as back-end storage volumes on monitored
storage system virtualizers.

Unavailable Disk Space (Overhead)
Amount of storage system volume or virtual storage volume space that is
dedicated to redundancy. This value is dependent on the storage system
SMI-S provider returning a valid RAID value that can be used to
determine the overhead. If the value is zero for a storage system, the
overhead cannot be calculated.Tivoli Storage Productivity Center does not
include the storage system volumes or virtual storage volumes that become
missing after a probe in its calculation of the value for this column.

Formatted Space (Capacity)
Total amount of formatted storage space associated with the storage system
that is used or can be used for system storage volumes or virtual storage
volumes. This value is dependent on the storage system SMI-S provider
returning a formatted value.

For some storage systems, this value is the total managed space which
includes space that cannot be used for storage volumes or virtual storage
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volumes. This can occur due to a number of reasons, such as space not
being formatted until storage volumes are created.

For SAN Volume Controller, this value represents the total size of the
managed disk groups created on the SAN Volume Controller. This value
does not include managed disk space that is not defined to a managed
disk group.

Formatted Space with No Volumes (Formatted Space with No Volumes)
Total amount of formatted storage space associated with the storage system
that can be used for system storage volumes or virtual storage volumes.
This value is dependent on the storage system SMI-S provider returning a
formatted value.

For some systems, this value represents the remaining managed space that
includes space that cannot be used for storage volumes or virtual storage
volumes. This can occur due to a number of reasons, such as space not
being formatted until storage volumes are created.

For SAN Volume Controller, this value represents the space within the
managed disk groups that does not include the size of the virtual disks
created and the corresponding virtual disk extent overhead.

Overall Unavailable Disk Space (Total Overhead)
(TotalStorage Enterprise Storage Server, DS6000, DS8000,and SAN Volume
Controller storage systems only.) Total amount of unformatted space within
disk groups or array sites.

Unformatted Disk Space (Undefined Disk Group or Array Site Capacity)
This value does not apply to all storage systems. For TotalStorage
Enterprise Storage Server, DS6000, DS8000 storage systems, this value is
the total raw disk space of any unformatted disk groups or array sites. For
IBM XIV Storage System, this value is the total available physical (hard)
space that remains for pool creation. For other storage systems, this value
is the total disk space that is not within a storage pool orN/A if the value
is not applicable for the storage system.

Cache Amount of RAM or other cache for a storage system.

Note: This column is blank for SAN Volume Controllers.

Manufacturer
Manufacturer of a storage system.

Model Model number/name of a storage system.

Serial Number
Serial number of a storage system.

Firmware Revision
Microcode level of a storage system.

Assigned Volume Space (Subsystem Assigned LUN Capacity)
Total storage system volume space within the storage system that is
mapped or assigned to host systems. Tivoli Storage Productivity Center
does not include the following capacity information in its calculation of the
value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a probe.
v Storage system volumes that are not mapped or are not assigned to host

systems.
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Unassigned Volume Space (Subsystem Unassigned LUN Capacity)
Total storage system volume space within a storage system that is not
mapped or not assigned to host systems. Tivoli Storage Productivity Center
does not include the following capacity information in its calculation of the
value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a probe.
v Storage system volumes that are mapped or assigned to host systems.

Unassigned and Available Formatted Space (Subsystem Total Formatted Free
Space) Total storage system space that is not mapped or not assigned to host

systems and the total amount of formatted storage space associated with
the storage system that can be used for system storage volumes.

This total amount of formatted storage space is dependent on the storage
system SMI-S provider returning a formatted value. For some systems, this
value represents the remaining managed space that might include space
that cannot be used for storage volumes or virtual storage volumes. This
can occur due to a number of reasons, such as space not being formatted
until storage volumes are created.

Tivoli Storage Productivity Center does not include the following volumes
in its calculation of the value for this column:
v Storage system volumes that become missing after a probe.
v Storage system volumes that are mapped or assigned to host systems.

zOS Volume Space (LUN Capacity)
Total storage system space that is reserved for use on mainframe storage
such as used by zOS. Tivoli Storage Productivity Center does not include
the following volumes in its calculation of the value for this column:
v Storage system volumes that become missing after a storage system

probe.
v Storage system volumes that are reserved for use on open system server

or non-mainframe storage.

Open System Volume Space (LUN Capacity)
Total storage system space that is reserved for use on open system storage
such as used by operating systems like Linux, AIX, HP/UX, Solaris, and
Windows. Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system volumes that become missing after a storage system

probe.
v Storage system volumes that are reserved for use on mainframe storage.

Last Probed Timestamp
Date and time when a storage system was last probed by the subordinate
or master server.

Physical Disk Space (Capacity)
Total amount of physical disk space discovered on the monitored storage
system arrays. Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
v Back-end storage volumes on monitored storage system virtualizers (for

example, SAN Volume Controller) that are attached from a storage
system.
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Backend Volume Space (LUN Capacity)
Total amount of storage system volume space or virtual storage space that
Tivoli Storage Productivity Center identifies as the back-end disk space on
a monitored storage system virtualizer (for example, SAN Volume
Controller). Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Storage system volumes or virtual storage volumes that are back-end

disks on a storage system virtualizer that is not monitored.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring storage systems in your
environment.

Number of Subsystems (Total)
Number of storage systems monitored by the subordinate server.

Disk Space (Total Disk Capacity)
Total raw (unformatted) disk capacity of the storage systems that are
monitored by the subordinate server. Tivoli Storage Productivity Center
does not include the following capacity information in its calculation of the
value for this column:
v Capacity of spare disks identified on TotalStorage Enterprise Storage

Server, DS8000, and DS6000 storage systems.
v Capacity of storage system disks that become missing after a storage

system probe.

Note: For Hitachi Data Systems storage systems, this value is the capacity
of all the Volumes in the storage system.

Available Disk Space (Total Disk Unallocated Space)
Total unformatted disk free space of the storage systems that are monitored
by the subordinate server. Tivoli Storage Productivity Center does not
include the following storage space in its calculation of the value for this
column:
v Storage system disks that become missing after a storage system probe.
v RAID overhead on storage systems that are identified by Tivoli Storage

Productivity Center.
v External back-end storage for TagmaStore systems.
v Storage space that is consumed by volumes that reside on external disks

when Hitachi Data Systems (HDS) storage systems are configured as
storage virtualizers.

Note: For Hitachi Data Systems storage systems, internal disk information
is not available. This field is set to 0.

Number of Disks (Total)
Total number of disks in the storage systems that are monitored by the
subordinate server. Tivoli Storage Productivity Center does not include
disks that become missing after a successful storage system probe in its
calculation of the value for this column. For Hitachi Data Systems storage
systems, internal disk information is not available. This field is set to 1.
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Number of Volumes (Total Number of LUNs)
Total number of storage volumes and virtual storage volumes discovered
by the subordinate server. Tivoli Storage Productivity Center does not
include storage volumes or virtual storage volumes that become missing
after a successful probe in its calculation of the value for this column.

Volume Space (Total LUN Capacity)
Total amount of unique storage system volume space or virtual storage
volume space discovered on storage system arrays that are monitored by
the subordinate server. Tivoli Storage Productivity Center does not include
storage volumes or virtual storage volumes that become missing after a
successful probe in its calculation of the value for this column.

Note: For space-efficient volumes, this value is the amount of storage
space requested for these volumes, not the actual allocated amount. This
can result in discrepancies in the overall storage space reported for a
storage system using space-efficient volumes. This also applies to other
space calculations, such as the calculations for the storage system's
Consumable (Available) Volume Space and FlashCopy Target Volume
Space.

Consumable Volume Space (Total Usable LUN Capacity)
Total amount of unique storage system volume space or virtual storage
volume space discovered on storage system arrays that are monitored by
the subordinate server. Tivoli Storage Productivity Center does not include
the following storage entities in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a probe
v Storage system volumes or virtual storage volumes that are used as flash

copy targets.
v Storage system volumes or virtual storage volumes that are identified as

a Business Continuance Volume extended (BCVx) (EMC only).
v Storage system volumes or virtual storage volumes used as a Volume

Configuration Management (VCM) database (EMC only).

FlashCopy Target Volume Space (Total FlashCopy Target Capacity)
Total amount of unique storage system volume space and virtual storage
volume space discovered on storage system arrays that are monitored by
the subordinate server and have been identified as flash copy target space.
Tivoli Storage Productivity Center does not include the following storage
entities in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a probe.
v Storage system volumes or virtual storage volumes that are not used as

flash copy targets.

Note: TotalStorage Enterprise Storage Server systems must have at least
the following microcode levels: ess800mincodelevel = 2.4.3.56,
essf20mincodelevel = 2.3.3.89. Tivoli Storage Productivity Center does not
report FlashCopy information if the TotalStorage Enterprise Storage Server
systems do not meet this requirement.

Unavailable Disk Space (Overhead)
Amount of storage system volume or virtual storage volume space that is
dedicated to redundancy and is monitored by the subordinate server. This
value is dependent on the storage system SMI-S provider returning a valid
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RAID value that can be used to determine the overhead. If the value is
zero for a storage system, the overhead cannot be calculated.Tivoli Storage
Productivity Center does not include the storage system volumes or virtual
storage volumes that become missing after a probe in its calculation of the
value for this column.

Correlated Volume Space (Total LUN Capacity Visible to Data Manager)
Total amount of storage system volume space or virtual storage volume
space on systems where the systems disks are identified by Tivoli Storage
Productivity Center as residing within the storage systems that are
monitored by the subordinate server. This includes storage system volumes
or virtual storage volumes identified as back-end storage volumes on
monitored storage system virtualizers.

The value in this column reflects the systems that are monitored by the
subordinate server.Tivoli Storage Productivity Center does not include the
following entities in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Disks that are assigned to a monitored storage system but are not

identified by Tivoli Storage Productivity Center as a disk residing within
the storage system. Reasons why these disks are not identified as
residing within the storage system include:
– Tivoli Storage Productivity Center does not support the identification

of disks for some storage system types.
– The connection of the disk to the storage system is lost and is no

longer detectable during a probe.
v Storage system volumes or virtual storage volumes that are identified as

Business Continuance Volume extended (BCVx).
v Storage system volumes or virtual storage volumes used as a Volume

Configuration Management (VCM) database.

Volume Space Not Correlated (Total LUN Capacity Not Visible to Data
Manager)

Total amount of unique storage system volume space and virtual storage
volume space discovered on monitored storage system arrays that can be
assigned or are assigned to servers within the network. The value in this
column reflects the storage systems that are monitored by the subordinate
server.Tivoli Storage Productivity Center does not include the following
entities in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Disks that reside within a monitored storage system.
v Storage system volumes or virtual storage volumes that Tivoli Storage

Productivity Centeridentifies as back-end storage volumes on monitored
storage system virtualizers.

Overall Unavailable Disk Space (Total Formatted Capacity)
Total amount of formatted storage space that is used or can be used for
system storage volumes or virtual storage volumes. The value in this
column reflects the storage systems that are monitored by the subordinate
server. This value is dependent on the storage system SMI-S provider
returning a formatted value.

For some storage systems, this value is the total managed space which
includes space that cannot be used for storage volumes or virtual storage
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volumes. This can occur due to a number of reasons, such as space not
being formatted until storage volumes are created.

Note: This value does not apply to SAN Volume Controller.

Formatted Space (Total Formatted Space with No Volumes)
Total amount of formatted storage space that can be used for system
storage volumes or virtual storage volumes. The value in this column
reflects the storage systems that are monitored by the subordinate server.
This value is dependent on the storage system SMI-S provider returning a
formatted value.

For some systems, this value represents the remaining managed space that
includes space that cannot be used for storage volumes or virtual storage
volumes. This can occur due to a number of reasons, such as space not
being formatted until storage volumes are created.

For SAN Volume Controller, this value represents the total size of the
managed disk groups created on the SAN Volume Controller. This value
does not include managed disk space that is not defined to a managed
disk group.

Formatted Space with No Volumes (Total Subsystem Total Formatted Free
Space) Total storage system space that is not mapped or not assigned to host

systems and the total amount of formatted storage space associated with
the storage system that can be used for system storage volumes. The value
in this column reflects the storage systems that are monitored by the
subordinate server.

This total amount of formatted storage space is dependent on the storage
system SMI-S provider returning a formatted value. For some systems, this
value represents the remaining managed space that might include space
that cannot be used for storage volumes or virtual storage volumes. This
can occur due to a number of reasons, such as space not being formatted
until storage volumes are created.

For SAN Volume Controller, this value represents the space within the
managed disk groups that does not include the size of the virtual disks
created and the corresponding virtual disk extent overhead.

Tivoli Storage Productivity Center does not include the following volumes
in its calculation of the value for this column:
v Storage system volumes that become missing after a probe.
v Storage system volumes that are mapped or assigned to host systems.

Capacity Overhead (Total)
(TotalStorage Enterprise Storage Server and SAN Volume Controller only.)
Sum of all the space in a disk group minus the formatted capacity of the
storage systems monitored by a subordinate server.

Unformatted Disk Space (Total Undefined Disk Group or Array Site Capacity)
This value does not apply to all storage systems. For TotalStorage
Enterprise Storage Server, DS6000, DS8000 storage systems, this value is
the total raw disk space of any unformatted disk groups or array sites that
are monitored by the subordinate server. For the XIV system, this value is
the total available physical (hard) space that remains for pool creation. For
other storage systems, this value is the total disk space that is not within a
storage pool or N/A if the value is not applicable for the storage system.
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Cache (Total)
Amount of RAM or other cache for the storage systems that are monitored
by the subordinate server.

Assigned Volume Space
Total storage system volume space within the storage system that is
mapped or assigned to host systems. Tivoli Storage Productivity Center
does not include the following capacity information in its calculation of the
value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Storage system volumes that are not mapped or are not assigned to host

systems.

Unassigned Volume Space (Total Subsystem Assigned LUN Capacity)
Total storage system volume space within storage systems that is mapped
or assigned to host systems. The value in this column reflects the storage
systems that are monitored by the subordinate server. Tivoli Storage
Productivity Center does not include the following capacity information in
its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a probe.
v Storage system volumes that are not mapped or are not assigned to host

systems.

Unassigned and Available Formatted Disk Space (Total Subsystem Unassigned
LUN Capacity)

Total storage system volume space within storage systems that is not
mapped or not assigned to host systems. The value in this column reflects
the storage systems that are monitored by the subordinate server. Tivoli
Storage Productivity Center does not include the following capacity
information in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a probe.
v Storage system volumes that are mapped or assigned to host systems.

zOS Volume Space (Total zOS LUN Capacity)
Total storage system space that is reserved for use on mainframe storage
such as used by zOS. The value in this column reflects the storage systems
that are monitored by the subordinate server.Tivoli Storage Productivity
Center does not include the following volumes in its calculation of the
value for this column:
v Storage system volumes that become missing after a storage system

probe.
v Storage system volumes that are reserved for use on open system server

or non-mainframe storage.

Open System Volume Space (Total Open System LUN Capacity)
Total storage system space that is reserved for use on open system storage
such as used by operating systems like Linux, AIX, HP/UX, Solaris, and
Windows. The value in this column reflects the storage systems that are
monitored by the subordinate server. Tivoli Storage Productivity Center
does not include the following volumes in its calculation of the value for
this column:
v Storage system volumes that become missing after a storage system

probe.
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v Storage system volumes that are reserved for use on mainframe storage.

Physical Disk Space (Capacity)
Total amount of physical disk space discovered on the storage system
arrays that are monitored by the subordinate server. Tivoli Storage
Productivity Center does not include the following volumes in its
calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
v Back-end storage volumes on monitored storage system virtualizers (for

example, SAN Volume Controller) that are attached from a storage
system.

Backend Volume Space (LUN Capacity)
Total amount of storage system volume space or virtual storage space that
Tivoli Storage Productivity Center identifies as the back-end disk space on
a monitored storage system virtualizer (for example, SAN Volume
Controller). The value in this column reflects the volumes that are
monitored by the subordinate server. Tivoli Storage Productivity Center
does not include the following volumes in its calculation of the value for
this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Storage system volumes or virtual storage volumes that are back-end

disks on a storage system virtualizer that is not monitored.

Rollup Reports - Asset - Disk/Volume Groups
Use this report to view information about the disk and volume groups that are
monitored by subordinate servers in your environment.

You can generate and sort the data within this report using the following by
clauses:
v By Computer: Shows disk and volume groups aggregated at the computer level

and sorted by computer name.
v By Disk/Volume Group Space: Shows disk and volume groups aggregated at the

computer level and sorted by storage capacity.
v By Available Disk/Volume Group Space: Shows disk and volume groups

aggregated at the computer level and sorted by storage free space.
v By TPC Server: Shows disk and volume groups aggregated at the subordinate

server level and sorted by subordinate server name. Click the magnifying glass
icon next to the name of a subordinate server to view information about the
computers it monitors.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

By Computer

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

Computer Name
Name of a computer with disk and volume groups that is monitored by a
subordinate server.
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Number of Disk/Volume Groups (Volume Groups)
Number of volume groups on a computer.

Disk/Volume Group Space (Total Capacity)
Total storage capacity of the disks and volume groups on a computer.

Available Disk/Volume Group Space (Total Free Space)
Amount of storage space available on the disk and volume groups that are
monitored by a subordinate server.

OS Type
Operating system running on a computer.

Number of Disks
Number of disks on a computer.

Last Probe Time
Date and time when a computer was last probed.

By Disk/Volume Group Space (Freespace)

Computer Name
Name of a computer with disk and volume groups that are monitored by a
subordinate server.

Disk/Volume Group Space (Total Free Space)
Amount of storage space available on the disks and volume groups
associated with a computer.

Number of Disk/Volume Groups (Number of Volume Groups)
Number of volume groups on a computer.

Available Disk/Volume Group Space (Total Capacity)
Total storage capacity of the disks and volume groups on a computer.

OS Type
Operating system running on a computer.

Number of Disks
Number of disks on a computer.

Last Probe Time
Date and time when a computer was last probed.

By Available Disk/Volume Group Space (Capacity)

Computer Name
Name of a computer with disk and volume groups that is monitored by a
subordinate server.

Available Disk/Volume Group Space (Total Capacity)
Total storage capacity of the disks and volume groups on a computer.

Number of Disk/Volume Groups (Volume Groups)
Number of volume groups on a computer.

Disk/Volume Group Space (Total Free Space)
Amount of storage space available on the disks and volume groups
associated with a computer.

OS Type
Operating system running on a computer.

Number of Disks
Number of disks on a computer.
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Last Probe Time
Date and time when a computer was last probed.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring computers with disk and
volume groups.

Number of Disk/Volume Groups
Number of disk and volume groups that are monitored by a subordinate
server.

Disk/Volume Group Space (Total Free Space)
Amount of storage space available on the disks and volume groups that
are monitored by a subordinate server.

Available Disk/Volume Group Space (Total Capacity)
Total storage capacity of the disks and volume groups that are monitored
by a subordinate server.

Rollup Reports - Asset - Disks
Use this report to view information about the disks that are monitored by
subordinate servers in your environment.

You can generate and sort the data within Disk reports using the following by
clauses:
v By Available Disk Space (Computers): Shows disks aggregated at the computer

level and sorted by unallocated space. The names of computers and their system
type appear in the first two columns and remain displayed when scrolling
through the other columns on the report.

v By Available Disk Space (Subsystems): Shows disks aggregated at the storage
subsystem level and sorted by unallocated space. The names of storage
subsystems and their system type appear in the first two columns and remain
displayed when scrolling through the other columns on the report.

v By TPC Server (computers): Shows computer disks aggregated at the
subordinate server level. The names of subordinate servers appear in the first
column and remain displayed when scrolling through the other columns on the
report. Click the magnifying glass icon next to a subordinate server name to
view more information about the computers monitored by that subordinate
server.

v By TPC Server (subsystems): Shows storage subsystem disks aggregated at the
subordinate server level. The names of subordinate servers appear in the first
column and remain displayed when scrolling through the other columns on the
report. Click the magnifying glass icon next to a subordinate server name to
view more information about the storage subsystems monitored by that
subordinate server.

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

By Available Disk Space (Computers)

TOTAL
Shows the system-wide totals for each of the columns in the report.
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System Name
Name of a computer with disks that are monitored by a subordinate
server.

OS Type
Operating system running on a computer.

Available Disk Space (Total Unallocated Space)
Amount of storage space on disks that is not allocated to any logical
volume. Note: the value that appears in the TOTAL row for this column
includes the unallocated capacity of all disks within the computers
monitored by subordinate servers.

Disk Space (Total Capacity)
Amount of storage space available on the disks associated with a
computer.

Number of Disks
Number of disks on a computer.

By Available Disk Space (Subsystems)

System Name
Name of a storage subsystem with disks that are monitored by a
subordinate server.

Subsystem Type
Operating system running on a storage subsystem.

Available Disk Space (Total Unallocated Space)
Amount of space on the disk that is not allocated to any volumes for disks
within storage subsystems). Note: the value that appears in the TOTAL
row for this column includes the unallocated capacity of all disks within
the storage subsystem, including the capacity of spare disks.

Disk Space (Total Capacity)
Amount of storage space available on the disks associated with a storage
subsystem.

Note: For space-efficient volumes, this value is the amount of storage
space requested for these volumes, not the actual allocated amount. This
can result in discrepancies in the overall storage space reported for a
storage system using space-efficient volumes. This also applies to other
space calculations, such as the calculations for the storage system's
Consumable (Available) Volume Space and FlashCopy Target Volume
Space.

Number of Disks
Total number of disks in a storage subsystem.

Physical Disk Space
Total amount of physical disk space discovered on the monitored storage
subsystem arrays. Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage subsystem disks that become missing after a storage subsystem

probe.
v Back-end storage volumes on monitored storage subsystem virtualizers

(for example, IBM SAN Volume Controller) that are attached from a
storage subsystem.
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By TPC Server (Computers)

TOTAL
Shows the system-wide totals for each of the columns in the report.

TPC Server
Name of a subordinate server that is monitoring disks on computers.

Available Disk Space (Total Unallocated Space)
Amount of storage space on computer disks that is not allocated to any
logical volume and are monitored by a subordinate server.

Disk Space (Total Capacity)
Amount of storage space available on all the computer disks that are
monitored by a subordinate server.

Note: For space-efficient volumes, this value is the amount of storage
space requested for these volumes, not the actual allocated amount. This
can result in discrepancies in the overall storage space reported for a
storage system using space-efficient volumes. This also applies to other
space calculations, such as the calculations for the storage system's
Consumable (Available) Volume Space and FlashCopy Target Volume
Space.

Number of Disks
Number of computer disks monitored by a subordinate server.

By TPC Server (Subsystems)

TPC Server
Name of a subordinate server that is monitoring disks on storage
subsystems.

Available Disk Space (Total Unallocated Space)
Amount of storage space on storage subsystem disks that is not allocated
to any volume and are monitored by a subordinate server.

Disk Space (Total Capacity)
Amount of storage space available on all the storage subsystem disks that
are monitored by a subordinate server.

Number of Disks
Number of storage subsystem disks monitored by a subordinate server.

Physical Disk Space
Total amount of physical disk space discovered on the monitored storage
subsystem arrays. Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage subsystem disks that become missing after a storage subsystem

probe.
v Back-end storage volumes on monitored storage subsystem virtualizers

(for example, IBM SAN Volume Controller) that are attached from a
storage subsystem.

Rollup Reports - Asset - File Systems or Logical Volumes
Use this report to view information about the filesystems or logical volumes that
are monitored by subordinate servers in your environment.

You can generate and sort the data within File Systems or Logical Volumes reports
using the following by clauses:
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v By Available File System or Logical Volume Space: Shows filesystems aggregated
at the computer level and sorted by free space and computer name.

v By TPC Server: Shows filesystems aggregated at the subordinate server level and
sorted by subordinate server name. Click the magnifying glass icon next to a
subordinate server name to view more information about the filesystems or
logical volumes monitored by that subordinate server.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

By Available File System or Logical Volume Space

Computer Name
Name of a computer with filesystems or logical volumes that are
monitored by a subordinate server.

Available File System/Logical Volume Space (Free Space)
Amount of storage space available in the filesystems or logical volumes on
a computer.

Consumed File System/Logical Volume Space (Used Space)
Amount of storage space consumed by the filesystems or logical volumes
on a computer.

File System/Logical Volume Space (Capacity)
Total storage capacity of the filesystems or logical volumes on a computer.

OS Type
Operating system running on a computer.

Number of File Systems/Logical Volumes (Number of FSs/LVs)
Number of filesystems or logical volumes on a computer.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring the filesystems and logical
volumes in your environment.

Available File System/Logical Volume Space (Total Free Space)
Amount of storage space available in all the filesystems or logical volumes
on the computers monitored by the subordinate server.

Consumed File System/Logical Volume Space (Total Used Space)
Amount of storage space consumed by all the filesystems or logical
volumes on the computers monitored by the subordinate server.

File System/Logical Volume Space (Total Capacity)
Total storage capacity of all the filesystems or logical volumes on the
computers monitored by the subordinate server.

Number of File Systems/Logical Volumes (Number of FSs/LVs)
Number of filesystems or logical volumes on the computers monitored by
the subordinate server.
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Rollup Reports - Asset - Storage Subsystem Volumes
Use this report to view information about the Storage Subsystem Volumes that are
monitored by subordinate servers in your environment.

You can generate and sort the data within this report using the following by
clauses:
v By Storage Subsystem: Shows Storage Subsystem Volume capacity and count

aggregated at the storage subsystem level.
v By Storage Subsystem Volume Space: Shows Storage Subsystem Volume capacity

and count aggregated at the subsystem level. Sorted according to the storage
capacity of Storage Subsystem Volumes.

v By TPC Server: Shows Storage Subsystem Volume capacity and count
aggregated at the subordinate server level. Sorted by subordinate server name.
Click the magnifying glass icon next to a subordinate server to view information
about the storage subsystems it monitors.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

By Storage Subsystem

Storage Subsystem Name
Name of a storage subsystem containing Storage Subsystem Volumes that
is monitored by a subordinate server.

Storage Subsystem Type
Type of storage subsystem, such as the IBM SAN Volume Controller.

Volume Space (LUN Capacity)
Total storage capacity of the Storage Subsystem Volumes in a storage
subsystem.

Consumable Volume Space (Usable LUN Capacity)
Storage capacity of Storage Subsystem Volumes in the created disk array
(not including BCVs, VCM database, and Replication targets).

Correlated Volume Space (LUN Capacity Visible to Data Manager)
Sum of the capacity of all monitored Storage Subsystem Volumes visible to
a monitored host computer and the capacity of all monitored Storage
Subsystem Volumes that are back-end disks on a monitored Storage
Subsystem Virtualizer.

Formatted Space (Formatted Capacity)
(IBM TotalStorage Enterprise Storage Server, IBM FAStT, HP StorageWorks,
and Hitachi Data Systems only) Total amount of formatted storage space in
the storage pools associated with a storage subsystem. For example, a
RAID volume space has more capacity than a stripe-mirror volume space.

For SAN Volume Controller, this value represents the total size of the
managed disk groups created on the SAN Volume Controller. This value
does not include managed disk space that is not defined to a managed
disk group.
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Assigned Volume Space (Subsystem Assigned LUN Capacity)
Total storage capacity of all Storage Subsystem Volumes that the storage
subsystem knows are assigned to a host computer.

zOS Volume Space (zOS LUN Capacity)
Total storage capacity for all the Storage Subsystem Volumes allocated to
zOS. Data for this column is calculated for TotalStorage Enterprise Storage
Server only. The value for this column is set to N/A for other storage
subsystems.

Number of Volumes (Number of LUNs)
Number of Storage Subsystem Volumes associated with a storage
subsystem.

Backend Volume Space
Total amount of storage subsystem volume space or virtual storage space
that Tivoli Storage Productivity Center identifies as the back-end disk
space on a monitored storage subsystem virtualizer (for example, SAN
Volume Controller). Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage subsystem volumes or virtual storage volumes that become

missing after a storage subsystem probe.
v Storage subsystem volumes or virtual storage volumes that are back-end

disks on a storage subsystem virtualizer that is not monitored.

By Storage Subsystem Volume Space

Volume Space (LUN Capacity)
Total storage capacity of the Storage Subsystem Volumes in a storage
subsystem.

Consumable Volume Space (Usable LUN Capacity)
Storage capacity of Storage Subsystem Volumes in the created disk array
(not including BCVs, VCM database, and Replication targets).

Correlated Volume Space (LUN Capacity Visible to Data Manager)
Sum of the capacity of all monitored Storage Subsystem Volumes visible to
a monitored host computer and the capacity of all monitored Storage
Subsystem Volumes that are back-end disks on a monitored Storage
Subsystem Virtualizer.

Formatted Space (Formatted Capacity)
(IBM TotalStorage Enterprise Storage Server, IBM FAStT, HP StorageWorks,
and Hitachi Data Systems only) Total amount of formatted storage space in
the storage pools associated with a storage subsystem. For example, a
RAID volume space has more capacity than a stripe-mirror volume space.

For SAN Volume Controller, this value represents the total size of the
managed disk groups created on the SAN Volume Controller. This value
does not include managed disk space that is not defined to a managed
disk group.

Assigned Volume Space (Subsystem Assigned LUN Capacity)
Total storage capacity of all Storage Subsystem Volumes that the storage
subsystem knows are assigned to a host computer.

zOS Volume Space (zOS LUN Capacity)
Total storage capacity for all the storage subsystem volumes allocated to
zOS. Data for this column is calculated for TotalStorage Enterprise Storage
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Server and SAN Volume Controller and SAN Volume Controller only. The
value for this column is set to N/A for other storage subsystems.

Number of Volumes (Number of LUNs)
Number of storage subsystem volumes associated with a storage
subsystem.

Storage Subsystem Name
Name of a storage subsystem containing storage subsystem volumes that is
monitored by a subordinate server.

Storage Subsystem Type
Type of storage subsystem, such as the IBM SAN Volume Controller.

Backend Volume Space
Total amount of storage subsystem volume space or virtual storage space
that Tivoli Storage Productivity Center identifies as the backend disk space
on a monitored storage subsystem virtualizer (for example, SAN Volume
Controller). Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage subsystem volumes or virtual storage volumes that become

missing after a storage subsystem probe.
v Storage subsystem volumes or virtual storage volumes that are backend

disks on a storage subsystem virtualizer that is not monitored.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring storage subsystems.

Storage Subsystem Count
Number of storage subsystems that are monitored by a subordinate server.

Volume Space (LUN Capacity)
Total storage capacity of the Storage Subsystem Volumes that are
monitored by a subordinate server.

Consumable Volume Space (Usable LUN Capacity)
Storage capacity of Storage Subsystem Volumes in the created disk array
(not including BCVs, VCM database, and Replication targets) that are
monitored by a subordinate server.

Correlated Volume Space (LUN Capacity Visible to Data Manager)
Sum of the capacity of all monitored Storage Subsystem Volumes visible to
a monitored host computer and the capacity of all monitored Storage
Subsystem Volumes that are back-end disks on a monitored Storage
Subsystem Virtualizer associated with a subordinate server.

Formatted Space (Formatted Capacity)
(IBM TotalStorage Enterprise Storage Server, IBM FAStT, HP StorageWorks,
and Hitachi Data Systems only) Total amount of formatted storage space in
the storage pools associated with the storage subsystems that are
monitored by a subordinate server. For example, a RAID volume space has
more capacity than a stripe-mirror volume space.

For SAN Volume Controller, this value represents the total size of the
managed disk groups created on the SAN Volume Controller. This value
does not include managed disk space that is not defined to a managed
disk group.
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Assigned Volume Space (Subsystem Assigned LUN Capacity)
Total storage capacity of all Storage Subsystem Volumes that the monitored
storage subsystems know are assigned to a host computer.

zOS Volume Space (zOS LUN Capacity)
Total storage capacity for all the Storage Subsystem Volumes allocated to
zOS that are monitored by a subordinate server. Data for this column is
calculated for TotalStorage Enterprise Storage Server and SAN Volume
Controller only. The value for this column is set to N/A for other storage
subsystems.

Number of Volumes (Number of LUNs)
Number of Storage Subsystem Volumes associated with the storage
subsystems monitored by a subordinate server.

Backend Volume Space
Total amount of storage subsystem volume space or virtual storage space
that Tivoli Storage Productivity Center identifies as the backend disk space
on a monitored storage subsystem virtualizer (for example, SAN Volume
Controller). Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage subsystem volumes or virtual storage volumes that become

missing after a storage subsystem probe.
v Storage subsystem volumes or virtual storage volumes that are backend

disks on a storage subsystem virtualizer that is not monitored.

Rollup Reports - Asset - Fabrics
Use this report to view information about the fabrics that are monitored by
subordinate servers in your environment.

You can view the following reports about fabrics:
v SAN Assets (ALL): Use this report to view information about all the SAN assets

for each subordinate server.
v SAN Assets (Connected Dev): Use this report to view information about all the

connected devices for each subordinate server.
v SAN Assets (Switches): Use this report to view information about switches in

your SAN for each subordinate server.

SAN Assets (ALL)

TPC Server
Name of a subordinate server that is monitoring fabrics.

Fabric ID
The ID of the fabric that the asset is in.

Type The type of asset discovered. For example: switch, host, host bus adapter,
storage subsystem.

Label The label of the asset. For example: the host name, switch name, storage
subsystem name, node name of the port.

Identifier
The unique identifier of the switch. For example, the switch WWN.

Status The status of the asset: Normal, Warning, or Critical.
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SAN Assets (Connected Dev)

TPC Server
Name of a subordinate server that is monitoring a connected device.

Fabric ID
The ID of the fabric that the asset is in.

Type The type of asset discovered. For example: switch, host, host bus adapter,
storage subsystem.

Label The label of the asset. For example: the host name, switch name, storage
subsystem name, node name of the port.

Identifier
The unique identifier of the switch. For example, the switch WWN.

Status The status of the asset: Normal, Warning, or Critical.

SAN Assets (Switches)

TPC Server
Name of a subordinate server that is monitoring a switch.

Fabric ID
The ID of the fabric that a switch is in.

Type The type of switch discovered.

Switch Type
The switch type, such as physical.

Label The label of a switch.

Status The status of a switch: Normal, Warning, or Critical.

IP Address
The IP address of a switch.

Vendor ID
The manufacturer of the switch.

Model The model name and number of a switch.

Version
The version information of the switch.

Serial Number
The serial number of the switch.

Object ID
The object ID of the switch.

Management ID
The management ID of the switch.

Management Address
The URL of the switch element manager.

Domain
The name of the domain that the switch is in.

Contact
The contact information for the switch.

WWN The world-wide name (WWN) of the switch.
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Location
The physical location of the switch.

Physical Switch WWN
The WWN for the parent or physical switch of a virtual switch. If this is
not a virtual switch then this column is empty.

Rollup Reports - Asset - Hypervisors
Use this report to view information about the hypervisors that are monitored by
subordinate servers in your environment.

You can generate and sort the data within this report using the following by
clause:
v By Hypervisor: Sorted according to hypervisor name. The names of hypervisors

monitored by subordinate servers appear in the first column and remain
displayed when scrolling through the other columns on the report.

By Hypervisors

Hypervisor Name
Name of a hypervisor monitored by a subordinate server.

OS Version
Version of the operating system running on a computer.

RAM The amount of RAM installed on a computer.

Disk Space
Total raw (unformatted) disk capacity of a storage subsystem. Tivoli
Storage Productivity Center does not include the following capacity
information in its calculation of the value for this column:
v Capacity of spare disks identified on IBM TotalStorage Enterprise

Storage Server, IBM DS8000, and IBM DS6000 storage subsystems.
v Capacity of storage subsystem disks that become missing after a storage

subsystem probe.

Note: For Hitachi Data Systems storage subsystems, this is the capacity of
all the Volumes in the storage subsystem.

Number of Disks
Total number of disks for a computer. Tivoli Storage Productivity Center
does not include the following disks in its calculation of the value in this
column:
v Computer disks on a computer that has not been probed by a Storage

Resource agent or Data agent.
v Computer disks that become missing after a probe. Disks can become

undetectable for a number of reasons, including a physical removal of
the disks from a computer.

Processor Count
Number of CPUs running on a computer.

IP Address
IP address of a computer.

Serial Number
Serial number of a computer.

Model Model number or name of a computer.

Chapter 8. Reporting in the stand-alone GUI 1105



Manufacturer
Manufacturer of a computer (for example, IBM).

Time Zone
Time zone where the computer is located.

Available File System Space
Total amount unique file system storage space that is not used or available
to the computer. Tivoli Storage Productivity Center does not include the
following file systems in its calculation of the value for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

OS Type
Operating system running on a computer.

Network
Network name of a computer.

Processor Type
Type of processor running on a computer (for example, GenuineIntel: x86
Family 15).

Processor Speed
Speed at which a computer's processor is running (in MHz).

CPU Architecture
Architecture of the processor (for example, IA32).

Swap Space
Amount of swap space (virtual memory) defined on a computer.

Rollup Reports - Database Asset
Use these reports to view detailed statistics that have been collected by subordinate
servers about the RDBMSs in your environment, including Oracle, SQL Server,
Sybase, and UDB/DB2.

The information shown in these reports is gathered by the master server when it
runs Tivoli Storage Productivity Center server probes against associated
subordinate servers. If the same storage entity is managed by multiple subordinate
servers, rollup reports reflect the storage information from the subordinate server
that most recently probed that entity.

Rollup Reports - Database Asset - All DBMSs
Use this report to view information about the RDBMSs (including Oracle, Sybase,
SQL Server, and UDB/DB2) that are monitored by subordinate servers in your
environment.

You can generate and sort the data within this report using the following by
clauses:
v By Instance: Shows databases for each computer sorted by computer name.
v By Version: Shows databases for each computer sorted by RDBMS version.
v By DBMS Type: Shows databases for each computer sorted by RDBMS type.
v By TPC Server: Shows databases aggregated at the subordinate server level and

sorted by subordinate server name.
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Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

By Instance

Computer Name
Name of the computer on which an Instance resides.

Instance
Name of an instance.

RDBMS Type
RDBMS to which an instance belongs (e.g., Oracle, SQL Server, Sybase,
UDB, etc.).

RDBMS Version
Version of the RDBMS under which an instance is running.

Port Port on which an instance listens for requests.

Home Directory
Path of the home directory for an instance.

Logonid
ID used by Tivoli Storage Productivity Center to log in to an instance.

Probe Status
Status of the last probe run against an instance.

Last Start Time
Date and time when an instance was last started.

Last Probe Time
Date and time when an instance was last probed.

Tablespace count
Number of tablespaces associated with an instance.

File Count
Number of data files associated with an instance.

Log File Count
Number of log files associated with an instance.

File Free Space
Amount of storage free space available on the data files associated with an
instance.

Total Size
Amount of storage space allocated to an instance.

File Capacity
Amount of storage space allocated to the data files associated with an
instance.

By Version

RDBMS Version
Version of the RDBMS under which an instance is running.
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Computer Name
Name of the computer on which an instance resides.

Instance
Name of an instance.

RDBMS Type
RDBMS to which an instance belongs (e.g., Oracle, SQL Server, Sybase,
UDB, etc.).

Port Port on which an instance listens for requests.

Home Directory
Path of the home directory for an instance.

Logonid
ID used by Tivoli Storage Productivity Center to log in to an instance.

Probe Status
Status of the last probe run against an instance.

Last Start Time
Date and time when an instance was last started.

Last Probe Time
Date and time when an instance was last probed.

Tablespace Count
Number of tablespaces associated with an instance.

File Count
Number of data files associated with an instance.

Log File Count
Number of log files associated with an instance.

File Free Space
Amount of storage free space available on the data files associated with an
instance.

Total Size
Amount of storage space allocated to an instance.

File Capacity
Amount of storage space allocated to the data files associated with an
instance.

By DBMS Type

RDBMS Type
RDBMS to which an instance belongs (e.g., Oracle, SQL Server, Sybase,
UDB, etc.).

Computer Name
Name of the computer on which an instance resides.

Instance
Name of an instance.

RDBMS Version
Version of the RDBMS under which an instance is running.

Port Port on which an instance listens for requests.

Home Directory
Path of the home directory for an instance.
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Logonid
ID used by Tivoli Storage Productivity Center to log in to an instance.

Probe Status
Status of the last probe run against an instance.

Last Start Time
Date and time when an instance was last started.

Last Probe Time
Date and time when an instance was last probed.

Tablespace count
Number of tablespaces associated with an instance.

File Count
Number of data files associated with an instance.

Log File Count
Number of log files associated with an instance.

File Free Space
Amount of storage free space available on the data files associated with an
instance.

Total Size
Amount of storage space allocated to an instance.

File Capacity
Amount of storage space allocated to the data files associated with an
instance.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring DBMSs in your
environment.

Total Number of DBMSs
Number of DBMSs monitored by a subordinate server.

Number of UDB Instances
Number of UDB instances monitored by a subordinate server.

Number of Oracle Instances
Number of Oracle instances monitored by a subordinate server.

Number of SQL/Server Instances
Number of SQL/Server instances monitored by a subordinate server.

Number of Sybase Instances
Number of Sybase instances monitored by a subordinate server.

Tablespace Count
Number of tablespaces associated with the instances monitored by a
subordinate server.

File Count
Number of data files associated with the instances monitored by a
subordinate server.

Log File Count
Number of log files associated with the instances monitored by a
subordinate server.
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File Free Space
Amount of storage free space available on the data files associated with the
instances monitored by a subordinate server.

Total Size
Amount of storage space allocated to the instances monitored by a
subordinate server.

Total File Capacity (File Capacity)
Amount of storage space allocated to the data files associated with the
instances monitored by a subordinate server.

Rollup Reports - Database Asset - Oracle, SQL/Server, Sybase,
UDB
Use this report to view information about Oracle, Sybase, SQL Server, and
UDB/DB2 instances that are monitored by subordinate servers in your
environment.

You can generate and sort the data within this report using the following by
clauses:
v By Instance: Shows databases for each computer sorted by computer name.
v By Version: Shows databases for each computer sorted by the version of the

RDBMS under which a database is running.
v By TPC Server: Shows databases aggregated at the subordinate server level and

sorted by subordinate server name.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

By Instance

Computer Name
Name of the computer on which an Instance resides.

Instance
Name of an instance.

RDBMS Type
RDBMS to which an instance belongs (e.g., Oracle, SQL Server, Sybase,
UDB, etc.).

RDBMS Version
Version of the RDBMS under which an instance is running.

Port Port on which an instance listens for requests.

Home Directory
Path of the home directory for an instance.

Logonid
ID used by Tivoli Storage Productivity Center to log in to an instance.

Probe Status
Status of the last probe run against an instance.

Last Start Time
Date and time when an instance was last started.

Last Probe Time
Date and time when an instance was last probed.

1110 IBM Tivoli Storage Productivity Center: User's Guide



Tablespace count
Number of tablespaces associated with an instance.

File Count
Number of data files associated with an instance.

Log File Count
Number of log files associated with an instance.

File Free Space
Amount of storage free space available on the data files associated with an
instance.

Total Size
Amount of storage space allocated to an instance.

File Capacity
Amount of storage space allocated to the data files associated with an
instance.

By Version

RDBMS Version
Version of the RDBMS under which an instance is running.

Computer Name
Name of the computer on which an instance resides.

Instance
Name of an instance.

RDBMS Type
RDBMS to which an instance belongs (e.g., Oracle, SQL Server, Sybase,
UDB, etc.).

Port Port on which an instance listens for requests.

Home Directory
Path of the home directory for an instance.

Logonid
ID used by Tivoli Storage Productivity Center to log in to an instance.

Probe Status
Status of the last probe run against an instance.

Last Start Time
Date and time when an instance was last started.

Last Probe Time
Date and time when an instance was last probed.

Tablespace Count
Number of tablespaces associated with an instance.

File Count
Number of data files associated with an instance.

Log File Count
Number of log files associated with an instance.

File Free Space
Amount of storage free space available on the data files associated with an
instance.
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Total Size
Amount of storage space allocated to an instance.

File Capacity
Amount of storage space allocated to the data files associated with an
instance.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring DBMSs in your
environment.

Number of Oracle Instances
Number of Oracle instances monitored by a subordinate server.

Number of SQL/Server Instances
Number of SQL/Server instances monitored by a subordinate server.

Number of Sybase Instances
Number of Sybase instances monitored by a subordinate server.

Number of UDB Instances
Number of UDB instances monitored by a subordinate server.

Tablespace count
Number of tablespaces associated with the instances monitored by a
subordinate server.

File Count
Number of data files associated with the instances monitored by a
subordinate server.

Log File Count
Number of log files associated with the instances monitored by a
subordinate server.

File Free Space
Amount of storage free space available on the data files associated with the
instances monitored by a subordinate server.

Total Size
Amount of storage space allocated to the instances monitored by a
subordinate server.

Total File Capacity
Amount of storage space allocated to the data files associated with the
instances monitored by a subordinate server.

Rollup Reports - TPC Server Storage Space
Use these reports to view storage metrics related to the disk space, filesystem
space, consumed filesystem space, and available filesystem space gathered by the
subordinate servers in your environment.

The information shown in these reports is gathered by the master server when it
runs “Collecting storage statistics from Tivoli Storage Productivity Center servers”
on page 342 against associated subordinate servers. If the same storage entity is
managed by multiple subordinate servers, rollup reports reflect the storage
information from the subordinate server that most recently probed that entity.

1112 IBM Tivoli Storage Productivity Center: User's Guide



Rollup Reports - TPC Server Storage Space - Disk Space
Use this report to view disk capacity information about the computers and storage
systems that are monitored by subordinate servers in your environment.

You can generate and sort the data within this report using the following by
clauses:
v By Storage Subsystem: Shows disk capacity aggregated at the storage system

level and sorted by storage system name. Storage systems that have been
discovered but not probed are not displayed in this report.

v By Storage Subsystem Group: Shows disks capacity aggregated at the storage
system monitoring group and storage system reporting group levels and sorted
by group name. Storage systems that have been discovered but not probed are
not included in the values shown in this report.

v By Computer: Shows disks capacity aggregated at the computer level and sorted
by computer name.

v By Computer Group: Shows disks capacity aggregated at the computer
monitoring group and computer reporting group levels and sorted by group
name.

v By Cluster: Shows disks capacity aggregated at the cluster level and sorted by
cluster name.

v By TPC Server (Computers): Shows computer disk capacity aggregated at the
subordinate server level and sorted by subordinate server name.

v By TPC Server (Storage Subsystems): Shows storage system disk capacity
aggregated at the subordinate server level and sorted by subordinate server
name. Storage systems that have been discovered but not probed are not
included in the values shown in this report.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

Note: The names of some columns have been changed. For your reference, the
original names of those columns appear within parentheses ( ) next to their new
names.

By Storage Subsystem

Subsystem Name
Name of a storage system that is monitored by a subordinate server.

Subsystem Type
Type of storage system, such as the IBM System Storage SAN Volume
Controller.

Disk Space (Disk Capacity)
Total raw (unformatted) disk capacity of a storage system.

Available Disk Space (Available Capacity)
Amount of storage space available on the disks associated with a storage
system. For Hitachi Data Systems storage systems, internal disk
information is not available. This field will be 0.

Number of Disks
Number of disks associated with a storage system. For Hitachi Data
Systems storage systems, internal disk information is not available. This
field will be set to 1.

Chapter 8. Reporting in the stand-alone GUI 1113



Number of Volumes (Number of LUNs)
Number of volumes associated with a storage system.

Storage Subsystem Volume Space (LUN capacity)
Amount of storage space allocated to the volumes associated with the
storage system.

Consumable Storage Subsystem Volume Space (Usable LUN Capacity)
Storage capacity of volumes in the created disk array (not including BCVs,
VCM database, and Replication targets).

Correlated Volume Space (Visible LUN Capacity)
Capacity of all volumes visible to a Storage Resource agent or Data agent
associated with a storage system.

FlashCopy Target Storage Subsystem Volume Space (FlashCopy Target Capacity)
The total capacity of all FlashCopy target volumes in the system. Note:
TotalStorage Enterprise Storage Server systems must have at least the
following microcode levels: ess800mincodelevel = 2.4.3.56,
essf20mincodelevel = 2.3.3.89. Tivoli Storage Productivity Center does not
report FlashCopy information if the TotalStorage Enterprise Storage Server
systems do not meet this requirement.

Volume Space Not Correlated (Not Visible LUN Capacity)
Usable volume capacity minus assigned volume capacity.

Unavailable Disk Space (Overhead)
Amount of capacity that is dedicated to redundancy.

Formatted Disk Space (Formatted Capacity)
(IBM TotalStorage Enterprise Storage Server, FAStT, HP StorageWorks, and
Hitachi Data Systems only.) Total amount of formatted storage space in the
storage pools associated with the storage system. For example, a RAID
volume space has more capacity than a stripe-mirror volume space.

Formatted Disk Space with No Volumes (Total Formatted Space with No
Volumes)

(TotalStorage Enterprise Storage Server, FAStT, HP StorageWorks, and
Hitachi Data Systems only.) Amount of storage space available to allocate
to volumes in the storage pools associated with the storage system.

Unformatted Disk Space (Undefined Disk Group or Array Site Capacity)
Raw disk space in ranks on which no volume space has been defined. For
TotalStorage Enterprise Storage Server systems, this value is the total raw
capacity of any unformatted disk groups. For IBM XIV Storage System, this
value is the total available physical (hard) space that remains for pool
creation. For FAStT, HP StorageWorks, and Hitachi Data Systems storage
systems, this value is the total capacity of the disks that are not in a
storage pool.

Cache Amount of RAM or other cache for a storage system.

Note: This column is blank for SAN Volume Controllers.

Assigned Volume Space (Subsystem Assigned LUN Capacity)
Total storage capacity of all volumes that the storage system knows are
assigned to a host computer. Note: The column is blank for SAN Volume
Controller.
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Unassigned Volume Space (Subsystem Unassigned LUN Capacity)
Total storage capacity of all volumes that the storage system knows are not
assigned to a host computer. Note: The column is blank for SAN Volume
Controller.

zOS Volume Space (zOS LUN Capacity)
Total storage capacity for all the volumes allocated to zOS. Data for this
column is calculated for TotalStorage Enterprise Storage Server only. The
value for this column is set to N/A for other storage systems.

Open System Volume Space (Open System LUN Capacity)
Total volume storage capacity (excluding the zOS volume space).

Physical Disk Space
Total amount of physical disk space discovered on the monitored storage
system arrays. Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
v Back-end storage volumes on monitored storage system virtualizers (for

example, SAN Volume Controller) that are attached from a storage
system.

Backend Volume Space
Total amount of storage system volume space or virtual storage space that
Tivoli Storage Productivity Center identifies as the back-end disk space on
a monitored storage system virtualizer (for example, SAN Volume
Controller). Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Storage system volumes or virtual storage volumes that are back-end

disks on a storage system virtualizer that is not monitored.

By Storage Subsystem Group

Subsystem Group Name
Name of a storage system monitoring group or storage system reporting
group.

TPC Server
Name of a subordinate server to which the group is associated.

Disk Space (Disk Capacity)
Total raw (unformatted) disk capacity of the storage systems in a group.

Available Disk Space (Available Capacity)
Amount of storage space available on the disks associated with the storage
systems in a group.

Number of Disks
Number of disks associated with the storage systems in a group.

Number of Volumes (Number of LUNs)
Number of volumes associated with the storage systems in a group.

Storage Subsystem Volume Space (LUN capacity)
Amount of storage space allocated to the volumes associated with the
storage systems in a group.
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Consumable Storage Subsystem Volume Space (Usable LUN Capacity)
Storage capacity of volumes in the created disk array (not including BCVs,
VCM database, and Replication targets).

FlashCopy Target Storage Subsystem Volume Space (FlashCopy Target Capacity)
The total capacity of all FlashCopy target volumes in the storage systems
in a group.

Correlated Volume Space (LUN Capacity Visible to Data Manager)
Capacity of all volumes visible to a Storage Resource agent or Data agent
associated with the storage systems in a group.

Volume Space Not Correlated (LUN Capacity Not Visible to Data Manager)
Usable volume capacity minus assigned volume capacity on the storage
systems in a group.

Unavailable Volume Space (Overhead)
Amount of capacity that is dedicated to redundancy in the storage systems
in a group.

Formatted Space (Formatted Capacity)
(TotalStorage Enterprise Storage Server, FAStT, HP StorageWorks, and
Hitachi Data Systems only.) Total amount of formatted storage space in the
storage pools associated with the storage systems in a group.

Total Formatted Space with no Volumes (Total Formatted Space with No
Volumes)

(TotalStorage Enterprise Storage Server, FAStT, HP StorageWorks, and
Hitachi Data Systems only.) Amount of storage space available to allocate
to volumes in the storage pools associated with the storage systems in a
group.

Unformatted Disk Space (Total Overhead)
(TotalStorage Enterprise Storage Server only.) Sum of all the space in a disk
group minus the formatted capacity on the storage systems in a group.

Cache Amount of RAM or other cache for the storage systems in a group.

Note: This column does not include values for SAN Volume Controllers.

Assigned Volume Space (Subsystem Assigned LUN Capacity)
Total storage capacity of all volumes that the storage systems in a group
know are assigned to a host computer.

Unassigned Volume Space (Subsystem Unassigned LUN Capacity)
Total storage capacity of all volumes that the storage systems in a group
know are not assigned to a host computer.

zOS Volume Space (zOS LUN Capacity)
Total storage capacity for all the volumes on the storage systems in a
group allocated to zOS.

Open System Volume Space (Open System LUN Capacity)
Total volume storage capacity (excluding the zOS volume capacity) of the
storage systems in a group.

Physical Disk Space
Total amount of physical disk space discovered on the monitored storage
system arrays. Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
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v Back-end storage volumes on monitored storage system virtualizers (for
example, SAN Volume Controller) that are attached from a storage
system.

Backend Volume Space
Total amount of storage system volume space or virtual storage space that
Tivoli Storage Productivity Center identifies as the back-end disk space on
a monitored storage system virtualizer (for example, SAN Volume
Controller). Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system volumes or virtual storage volumes that become missing

after a storage system probe.
v Storage system volumes or virtual storage volumes that are back-end

disks on a storage system virtualizer that is not monitored.

By Computer

Note: Two entries for the same host might appear in this report and the values for
that host are counted twice in the TOTAL column. This scenario occurs under the
following circumstances:
v You install two Storage Resource agents on the same host (using the long and

short names of the host) that point to different Tivoli Storage Productivity
Center servers. For example, you install an agent from serverA using the short
name of a host (for example, hostC). You install another agent from serverB
using the long name of the same host (for example, hostC.storage.chicago.com).
You then set up the servers in a master and subordinate relationship. For
example, serverA is the master and serverB is the subordinate. In this example,
there are two entries in the report for the host: hostC and
hostC.storage.chicago.com. The values for hostC are counted twice in the
TOTAL column.

v A Storage Resource agent on a host (hostC) points to two different Tivoli Storage
Productivity Center servers (serverA and serverB). The host has a dynamic IP
address. You set up serverA as the master and serverB as the subordinate. Server
serverA probes hostC, but then the IP address of hostC changes before serverB
probes the host. In this example, the report might display two entries for hostC:
one entry with the IP address that was probed by serverA; the other entry with
the changed IP address that was probed by serverB. The values for hostC are
counted twice in the TOTAL column.

v A Storage Resource agent on a host (hostC) points to two different Tivoli Storage
Productivity Center servers (serverA and serverB). The host has a name that
resolves to hostC.storage.chicago.com on serverA and
hostC.srm.storage.chicago.com on serverB. You then set up the servers in a
master and subordinate relationship. For example, serverA is the master and
serverB is the subordinate. In this example, there are two entries in the report
for the host: hostC.storage.chicago.com and hostC.srm.storage.chicago.com. The
values for hostC are counted twice in the TOTAL column.

Computer Name
Name of a computer.

Disk Space (Total Capacity)
Total storage capacity for a computer. If the computer is an IBM Tivoli
Storage SAN File Systems client, then this value also includes the capacity
of any volumes visible to this computer that are owned by the SAN File
System.
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Available Disk Space (Total Unallocated Space)
Amount of unused storage space on a computer (not in file systems seen
by this operating system). If the computer is an IBM Tivoli Storage SAN
File Systems client, then this value excludes the unallocated space on any
volumes visible to it that are owned by the SAN File System.

Number of Disks
Number of disks on a computer.

Owned Disk Space (Owned Capacity)
Total storage capacity for a computer that is owned by that computer. If
Data Manager can determine that a disk was configured for a different
host, the capacity for that disk is counted in the "Owned Capacity".

If the computer is an IBM Tivoli Storage SAN File Systems client, then this
value does not include the capacity of any volumes visible to it that are
owned by the SAN File System. If the host is Solaris and Veritas Volume
Manager (VxVM) is in use, the product examines the Veritas disk-label and
reads the host-ID. If this host-ID does not agree with the local host-ID, the
disk is classified as belonging to a different (Solaris) host.

Other Available Disk Space (Other Unallocated Space)
Total unallocated space on disks owned by the computer. This column
does not display the total unallocated disk space on disks not owned by
the computer. If the computer is an IBM Tivoli Storage SAN File Systems
client, then this value excludes the unallocated space on any volumes
visible to it that are owned by the SAN File System.

Non-Fibre Channel Attached Disk Space (Total Other Attached Capacity)
Total disk capacity of all non-Fibre attached disks for a computer.

Fibre Channel Attached Disk Space (Total Other Attached Unallocated Space)
Total unallocated space of all non-Fibre attached disks for a computer.

Non-Fibre Channel Attached Available Disk Space (Total Fibre Channel
Attached Capacity)

Total disk capacity of all fibre channel attached disks for a computer.

Fibre Channel Attached Available Disk Space (Total Fibre Channel Attached
Unallocated Space)

Total unallocated space of all fibre channel attached disks for a computer.

By Computer Group

Computer Group Name
Name of a computer monitoring group or computer reporting group.

Disk Space (Total Capacity)
Total storage capacity for the computers in a group. If the computer is an
IBM Tivoli Storage SAN File Systems client, then this value also includes
the capacity of any volumes visible to this computer that are owned by the
SAN File System.

Available Disk Space (Total Unallocated Space)
Amount of unused storage space on the computers in a group.

Number of Disks
Number of disks on the computers in a group.

Owned Disk Space (Owned Capacity)
Total storage capacity for the computers in a group that is owned by those
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computers. If Data Manager can determine that a disk was configured for a
different host, the capacity for that disk is counted in the "Owned
Capacity".

If any computers in the group are IBM Tivoli Storage SAN File Systems
clients, then this value does not include the capacity of any volumes visible
to it that are owned by the SAN File System. If the host is Solaris and
Veritas Volume Manager (VxVM) is in use, the product examines the
Veritas disk-label and reads the host-ID. If this host-ID does not agree with
the local host-ID, the disk is classified as belonging to a different (Solaris)
host.

Other Available Disk Space (Other Unallocated Space)
Total unallocated space on disks owned by the computers in a group. This
column does not display the total unallocated disk space on disks not
owned by computers. If any of the computers in the group are IBM Tivoli
Storage SAN File Systems clients, then this value excludes the unallocated
space on any volumes visible to it that are owned by the SAN File System.

Non-Fibre Channel Attached Disk Space (Total Other Attached Capacity)
Total disk capacity of all non-Fibre attached disks on the computers in a
group.

Fibre Channel Attached Disk Space (Total Other Attached Unallocated Space)
Total unallocated space of all non-Fibre attached disks on the computers in
a group.

Non-Fibre Channel Attached Available Disk Space (Total Fibre Channel
Attached Capacity)

Total disk capacity of all fibre channel attached disks on the computers in a
group.

Fibre Channel Attached Available Disk Space (Total Fibre Channel Attached
Unallocated Space)

Total unallocated space of all fibre channel attached disks on the
computers in a group.

By Cluster

Cluster Name
Name of a cluster.

For Storwize V7000 Unified or IBM SONAS clusters, the storage system
name is included with the cluster name in the Computer or Device
column. The format of the column is storagesystem_name: cluster_name,
where storagesystem_name is the name of the Storwize V7000 Unified or
IBM SONAS device that the cluster belongs to. For example,
subsystem-03.lab.austin.us.com: kq98n5d.acct displays storage system
subsystem-03.lab.austin.us.com that cluster kq98n5d.acct belongs to.

Disk Space (Total Capacity)
Total storage capacity for a cluster.

Available Disk Space (Total Unallocated Space)
Amount of unused storage space on a cluster (not in file systems seen by
this operating system).

Owned Disk Space (Owned Capacity)
Total storage capacity for a cluster that is owned by that cluster. If Data
Manager can determine that a disk was configured for a different host, the
capacity for that disk is counted in the "Owned Capacity".
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If the computer is an IBM Tivoli Storage SAN File Systems client, then this
value does not include the capacity of any volumes visible to it that are
owned by the SAN File System. If the host is Solaris and Veritas Volume
Manager (VxVM) is in use, the product examines the Veritas disk-label and
reads the host-ID. If this host-ID does not agree with the local host-ID, the
disk is classified as belonging to a different (Solaris) host.

Other Available Disk Space (Other Unallocated Space)
Total unallocated space on disks owned by the cluster. This column does
not display the total unallocated disk space on disks not owned by the
cluster. If a computer in a cluster is an IBM Tivoli Storage SAN File
Systems client, then this value excludes the unallocated space on any
volumes visible to it that are owned by the SAN File System.

Non-Fibre Channel Attached Disk Space (Total Other Attached Capacity)
Total disk capacity of all non-Fibre attached disks in a cluster.

Fibre Channel Attached Disk Space (Total Other Attached Unallocated Space)
Total unallocated space of all non-Fibre attached disks in a cluster.

Non-Fibre Channel Attached Available Disk Space (Total Fibre Channel
Attached Capacity)

Total disk capacity of all fibre channel attached disks in a cluster.

Fibre Channel Attached Available Disk Space (Total Fibre Channel Attached
Unallocated Space)

Total unallocated space of all fibre channel attached disks in a cluster.

By TPC Server (Computers)

TPC Server
Name of a subordinate server that is monitoring computer disks in your
environment.

Disk Space (Total Capacity)
Total storage capacity of all the computer disks monitored by a
subordinate server.

Available Disk Space (Total Unallocated Space)
Amount of unused storage space on all the computer disks monitored by a
subordinate server.

Number of Disks
Number of computer disks monitored by a subordinate server.

Non-Fibre Channel Attached Disk Space (Total Other Attached Capacity)
Total disk capacity of all non-Fibre attached disks monitored by a
subordinate server.

Fibre Channel Attached Disk Space (Total Other Attached Unallocated Space)
Total unallocated space of all non-Fibre attached disks monitored by a
subordinate server.

Non-Fibre Channel Attached Available Disk Space (Total Fibre Channel
Attached Capacity)

Total disk capacity of all fibre channel attached disks monitored by a
subordinate server.

Fibre Channel Attached Available Disk Space (Total Fibre Channel Attached
Unallocated Space)

Total unallocated space of all fibre channel attached disks monitored by a
subordinate server.
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By TPC Server (Storage Subsystems)

TPC Server
Name of a subordinate server that is monitoring storage system disks in
your environment.

Disk Space (Total Capacity)
Total raw (unformatted) disk capacity of the storage systems monitored by
a subordinate server.

Available Disk Space (Total Unallocated Space)
Amount of storage space available on the disks associated with the storage
systems monitored by a subordinate server.

Number of Disks
Number of storage system disks monitored by a subordinate server.

Physical Disk Space
Total amount of physical disk space discovered on the monitored storage
system arrays. Tivoli Storage Productivity Center does not include the
following volumes in its calculation of the value for this column:
v Storage system disks that become missing after a storage system probe.
v Back-end storage volumes on monitored storage system virtualizers (for

example, SAN Volume Controller) that are attached from a storage
system.

Rollup Reports - TPC Server Storage Space - File System Space
Use this report to view file system space information about the file systems that
are monitored by subordinate servers in your environment.

You can generate and sort the data within this report using the following by
clauses:
v By Computer: Shows file system capacity aggregated at the computer level and

sorted by computer name.
v By Computer Group: Shows file system capacity aggregated at the computer

monitoring group and computer reporting group levels and sorted by group
name.

v By Cluster: Shows file system capacity aggregated at the cluster level and sorted
by cluster name.

v By TPC Server: Shows file system capacity aggregated at the subordinate server
level and sorted by subordinate server name.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

By Computer

Computer Name
Name of the computer on which a file system resides.

Total Capacity
Total amount (capacity) of storage space in the file systems on a computer.
Note that the value in this field might be greater than Total Used Space +
Total Free Space for some UNIX systems. This occurs because the used
space reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value in
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the Total Capacity field is greater than or equal to the value of Total Used
Space + Total Free Space, the difference representing the space wasted due
to the system overhead.

Total Used Space
Total amount of used storage space in the file systems on a computer. On
some UNIX file systems, this value does not include storage space reserved
by the operating system (overhead). Tivoli Storage Productivity Center
does not include the following file systems in its calculation of the value
for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

The value that appears in the TOTAL row for this column represents the
difference between the TOTAL values in the Total Capacity and Total Free
Space columns. If the calculated value for the TOTAL row is negative, the
column displays 0.

The TOTAL row does not add the used space coming from VMWare
computers. See the VMWare capacity reports topic in the Planning chapter of
the Tivoli Storage Productivity Center Installation and Configuration Guide for
information about how file system and disk capacity are calculated in this
report for VMWare computers. This topic is also available in the Planning
section of the Tivoli Storage Productivity Center Information Center.

The value that appears in the TOTAL row for this column does not
include the following file systems:
v File systems on discovered hypervisors that are assigned to virtual

machine servers where the Storage Resource agent or Data agent has
been installed.

v File systems on discovered virtual machine servers where the Storage
Resource agent or Data agent is installed, but the hypervisor for the
virtual machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

Total Free Space
Total amount of unused storage space in the file systems on a computer.

Number of FS's/LV's
Number of file systems or logical volumes on a computer.

By Computer Group

Computer Group
Name of a computer monitoring group or computer reporting group.

Total Capacity
Total amount (capacity) of storage space on the file systems in a group.
Note that the value in this field might be greater than Total Used Space +
Total Free Space for some UNIX systems. This occurs because the used
space reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value in
the Total Capacity field is greater than or equal to the value of Total Used
Space + Total Free Space, the difference representing the space wasted due
to the system overhead.
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Total Used Space
Total amount of used storage space on the file systems in a group. On
some UNIX file systems, this value does not include storage space reserved
by the operating system (overhead).

Total Free Space
Total amount of unused storage space on the file systems in a group.

Number of FS's/LV's
Number of file systems or logical volumes in a group.

By Cluster

Cluster
Name of a cluster.

Total Capacity
Total storage capacity of the file systems in a cluster. Note that the value in
this field might be greater than Total Used Space + Total Free Space for
some UNIX systems. This occurs because the used space reported on UNIX
(both by the APIs used by the Storage Resource agents or Data agents and
by the df command) does not include some space reserved by the
operating system (overhead). Therefore, the value in the Total Capacity
field is greater than or equal to the value of Total Used Space + Total Free
Space, the difference representing the space wasted due to the system
overhead.

Total Used Space
Total amount of used storage space on the file systems in a cluster. On
some UNIX file systems, this value does not include storage space reserved
by the operating system (overhead).

Total Free Space
Total amount of unused storage space on the file systems in a cluster.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring file systems in your
environment.

Total Capacity
Total storage capacity of all the file systems monitored by a subordinate
server.

Total Used Space
Total amount of used storage space on the file systems monitored by a
subordinate server. On some UNIX file systems, this value does not
include storage space reserved by the operating system (overhead).

Total Free Space
Total amount of unused storage space on the file systems monitored by a
subordinate server.

Total Number of FS's/LV's
Total number of file systems or logical volumes monitored by a
subordinate server.

Rollup Reports - TPC Server Storage Space - Consumed File
System Space
Use this report to view information about the used storage space on filesystems
that are monitored by subordinate servers in your environment.
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You can generate and sort the data within this report using the following by
clauses:
v By Computer: Shows filesystem used space aggregated at the computer level

and sorted by computer name.
v By Computer Group: Shows filesystem used space aggregated at the computer

monitoring group and computer reporting group levels and sorted by group
name.

v By Cluster: Shows filesystem used space aggregated at the cluster level and
sorted by cluster name.

v By TPC Server: Shows filesystem used space aggregated at the subordinate
server level and sorted by subordinate server name.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

By Computer

Computer Name
Name of the computer on which a filesystem resides.

Total Used Space
Total amount of used storage space in the file systems on a computer. On
some UNIX file systems, this value does not include storage space reserved
by the operating system (overhead). Tivoli Storage Productivity Center
does not include the following file systems in its calculation of the value
for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

The value that appears in the TOTAL row for this column represents the
difference between the TOTAL values in the Total Capacity and Total Free
Space columns. If the calculated value for the TOTAL row is negative, the
column displays 0.

The TOTAL row does not add the used space coming from VMWare
computers. See the VMWare capacity reports topic in the Planning chapter of
the Tivoli Storage Productivity Center Installation and Configuration Guide for
information about how file system and disk capacity are calculated in this
report for VMWare computers. This topic is also available in the Planning
section of the Tivoli Storage Productivity Center Information Center.

The value that appears in the TOTAL row for this column does not
include the following file systems:
v File systems on discovered hypervisors that are assigned to virtual

machine servers where the Storage Resource agent or Data agent has
been installed.

v File systems on discovered virtual machine servers where the Storage
Resource agent or Data agent is installed, but the hypervisor for the
virtual machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

Total Free Space
Total amount of unused storage space in the filesystems on a computer.
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Total Capacity
Total amount (capacity) of storage space in the filesystems on a computer.
Note that the value in this field might be greater than Total Used Space +
Total Free Space for some UNIX systems. This occurs because the used
space reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value in
the Total Capacity field is greater than or equal to the value of Total Used
Space + Total Free Space, the difference representing the space wasted due
to the system overhead.

Number of FS's/LV's
Number of filesystems or logical volumes on a computer.

By Computer Group

Computer Group
Name of a computer monitoring group or computer reporting group.

Total Capacity
Total amount (capacity) of storage space on the filesystems in a group.
Note that the value in this field might be greater than Total Used Space +
Total Free Space for some UNIX systems. This occurs because the used
space reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value in
the Total Capacity field is greater than or equal to the value of Total Used
Space + Total Free Space, the difference representing the space wasted due
to the system overhead.

Total Used Space
Total amount of used storage space on the filesystems in a group. On some
UNIX filesystems, this value does not include storage space reserved by
the operating system (overhead).

Total Free Space
Total amount of unused storage space on the filesystems in a group.

Number of FS's/LV's
Number of filesystems or logical volumes in a computer group.

By Cluster

Cluster
Name of a cluster.

Total Used Space
Total amount of used storage space on the filesystems in a cluster. On
some UNIX filesystems, this value does not include storage space reserved
by the operating system (overhead).

Total Free Space
Total amount of unused storage space on the filesystems in a cluster.

Total Capacity
Total storage capacity of the filesystems in a cluster. Note that the value in
this field might be greater than Total Used Space + Total Free Space for
some UNIX systems. This occurs because the used space reported on UNIX
(both by the APIs used by the Storage Resource agents or Data agents and
by the df command) does not include some space reserved by the
operating system (overhead). Therefore, the value in the Total Capacity
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field is greater than or equal to the value of Total Used Space + Total Free
Space, the difference representing the space wasted due to the system
overhead.

Number of FS's/LV's
Number of filesystems or logical volumes in a cluster.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring filesystems in your
environment.

Total Used Space
Total amount of used storage space on the filesystems monitored by a
subordinate server. On some UNIX filesystems, this value does not include
storage space reserved by the operating system (overhead).

Total Free Space
Total amount of unused storage space on the filesystems monitored by a
subordinate server.

Total Capacity
Total storage capacity of all the filesystems monitored by a subordinate
server.

Total Number of FS's/LV's
Number of filesystems or logical volumes monitored by a subordinate
server.

Rollup Reports - TPC Server Storage Space - Available File
System Space
Use this report to view information about the available storage space on file
systems that are monitored by subordinate servers in your environment.

You can generate and sort the data within this report using the following by
clauses:
v By Computer: Shows filesystem free space aggregated at the computer level and

sorted by computer name.
v By Computer Group: Shows filesystem free space aggregated at the computer

monitoring group and computer reporting group levels and sorted by group
name.

v By Cluster: Shows filesystem free space aggregated at the cluster level and
sorted by cluster name.

v By IBM Tivoli Storage Productivity Center Server: Shows filesystem free space
aggregated at the subordinate server level and sorted by subordinate server
name.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

By Computer

Computer Name
Name of the computer on which a filesystem resides.

Total Free Space
Total amount of unused storage space in the filesystems on a computer.
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Total Used Space
Total amount of used storage space in the file systems on a computer. On
some UNIX file systems, this value does not include storage space reserved
by the operating system (overhead). Tivoli Storage Productivity Center
does not include the following file systems in its calculation of the value
for this column:
v File systems that become missing after a probe.
v File systems that are mounted remotely and are not identified to a

network attached storage server.
v File systems that are not mounted.

The value that appears in the TOTAL row for this column represents the
difference between the TOTAL values in the Total Capacity and Total Free
Space columns. If the calculated value for the TOTAL row is negative, the
column displays 0.

The TOTAL row does not add the used space coming from VMWare
computers. See the VMWare capacity reports topic in the Planning chapter of
the Tivoli Storage Productivity Center Installation and Configuration Guide for
information about how file system and disk capacity are calculated in this
report for VMWare computers. This topic is also available in the Planning
section of the Tivoli Storage Productivity Center Information Center.

The value that appears in the TOTAL row for this column does not
include the following file systems:
v File systems on discovered hypervisors that are assigned to virtual

machine servers where the Storage Resource agent or Data agent has
been installed.

v File systems on discovered virtual machine servers where the Storage
Resource agent or Data agent is installed, but the hypervisor for the
virtual machine servers has not been discovered and the total used space
exceeds the capacity of the total file system capacity.

Total Capacity
Total amount (capacity) of storage space in the filesystems on a computer.
Note that the value in this field might be greater than Total Used Space +
Total Free Space for some UNIX systems. This occurs because the used
space reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value in
the Total Capacity field is greater than or equal to the value of Total Used
Space + Total Free Space, the difference representing the space wasted due
to the system overhead.

Number of FS's/LV's
Number of filesystems or logical volumes on a computer.

By Computer Group

Computer Group
Name of a computer monitoring group or computer reporting group.

Total Free Space
Total amount of unused storage space on the filesystems in a group.

Total Used Space
Total amount of used storage space on the filesystems in a group. On some
UNIX filesystems, this value does not include storage space reserved by
the operating system (overhead).
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Total Capacity
Total amount (capacity) of storage space on the filesystems in a group.
Note that the value in this field might be greater than Total Used Space +
Total Free Space for some UNIX systems. This occurs because the used
space reported on UNIX (both by the APIs used by the Storage Resource
agents or Data agents and by the df command) does not include some
space reserved by the operating system (overhead). Therefore, the value in
the Total Capacity field is greater than or equal to the value of Total Used
Space + Total Free Space, the difference representing the space wasted due
to the system overhead.

Number of FS's/LV's
Number of filesystems or logical volumes in a computer group.

By Cluster

Cluster
Name of a cluster.

Total Free Space
Total amount of unused storage space on the filesystems in a cluster.

Total Used Space
Total amount of used storage space on the filesystems in a cluster. On
some UNIX filesystems, this value does not include storage space reserved
by the operating system (overhead).

Total Capacity
Total storage capacity of the filesystems in a cluster. Note that the value in
this field might be greater than Total Used Space + Total Free Space for
some UNIX systems. This occurs because the used space reported on UNIX
(both by the APIs used by the Storage Resource agents or Data agents and
by the df command) does not include some space reserved by the
operating system (overhead). Therefore, the value in the Total Capacity
field is greater than or equal to the value of Total Used Space + Total Free
Space, the difference representing the space wasted due to the system
overhead.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring filesystems in your
environment.

Total Free Space
Total amount of unused storage space on the filesystems monitored by a
subordinate server.

Total Used Space
Total amount of used storage space on the filesystems monitored by a
subordinate server. On some UNIX filesystems, this value does not include
storage space reserved by the operating system (overhead).

Total Capacity
Total storage capacity of all the filesystems monitored by a subordinate
server.

Number of FS's/LV's
Number of filesystems or logical volumes monitored by a subordinate
server.
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Rollup Reports - Database Capacity
Use these reports to view storage capacity, used space, and free space at the
computer, computer group, database, instance, and IBM Tivoli Storage Productivity
Center server level for RDBMSs that are monitored by subordinate servers.

For a specific instance, computer, group of computers, or database that is
monitored by a subordinate server, you can use these rollup reports to view:
v how much storage you have for an RDBMS and the objects it contains
v how much storage is being used for an RDBMS and the objects it contains
v what percentage of RDBMS storage is free for expansion

The information shown in these reports is gathered by the master server when it
runs Tivoli Storage Productivity Center server probes against associated
subordinate servers. If the same storage entity is managed by multiple subordinate
servers, rollup reports reflect the storage information from the subordinate server
that most recently probed that entity.

Rollup Reports - Database Capacity - All DBMSs
Use this report to view storage capacity information for the DBMSs (including
Oracle, Sybase, SQL Server, and UDB/DB2) that are monitored by subordinate
servers in your environment.

You can generate and sort the data within this report using the following by
clauses:
v By Instance: Shows database capacity aggregated at the computer level and

sorted by instance name.
v By Computer: Shows database capacity aggregated at the computer level and

sorted by computer name.
v By Computer Group: Shows database capacity aggregated at the computer

monitoring group and computer reporting group levels and sorted by group
name.

v By TPC Server: Shows database capacity aggregated at the subordinate server
level and sorted by subordinate server name.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

By Instance

Instance
Name of an instance.

RDBMS Type
RDBMS to which an instance belongs (e.g., Oracle, SQL Server, Sybase,
UDB, etc.).

Computer Name
Name of the computer on which an Instance resides.

Total Size
Amount of storage space allocated to an instance.

File Capacity
Amount of storage space allocated to the data files associated with an
instance.
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File Free Space
Amount of storage free space available on the data files associated with an
instance.

Tablespace Count
Number of tablespaces associated with an instance.

File Count
Number of data files associated with an instance.

Log File Count
Number of log files associated with an instance.

By Computer

Computer Name
Name of the computer on which an Instance resides.

Total Size
Amount of storage space allocated to an instance.

File Capacity
Amount of storage space allocated to the data files associated with an
instance.

File Free Space
Amount of storage free space available on the data files associated with an
instance.

Tablespace Count
Number of Tablespaces associated with an instance.

File Count
Number of data files associated with an instance.

Log File Count
Number of log files associated with an instance.

By Computer Group

Computer Group
Name of a computer monitoring group or reporting group.

Total Size
Amount of storage space allocated to instances in a group.

File Capacity
Amount of storage space allocated to the data files associated with
instances in a group.

File Free Space
Amount of storage free space available on the data files associated with
instances in a group.

Tablespace Count
Number of databases or tablespaces associated with instances in a group.

File Count
Number of data files associated with instances in a group.

Log File Count
Number of log files associated with instances in a group.

TPC Server
Name of a subordinate server that is monitoring the computer group.
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By TPC Server

TPC Server
Name of a subordinate server that is monitoring DBMSs in your
environment.

Total Size
Amount of storage space allocated to instances monitored by a subordinate
server.

Total File Capacity
Amount of storage space allocated to the data files associated with
instances monitored by a subordinate server.

File Free Space
Amount of storage free space available on the data files associated with
instances monitored by a subordinate server.

Tablespace Count
Number of tablespaces associated with instances monitored by a
subordinate server.

File Count
Number of data files associated with instances monitored by a subordinate
server.

Log File Count
Number of log files associated with instances monitored by a subordinate
server.

Rollup Reports - Database Capacity - Oracle, Sybase, SQL
Server, and UDB
Use this report to view storage capacity information for the Oracle, Sybase, SQL
Server, and UDB/DB2 databases that are monitored by subordinate servers in your
environment.

You can generate and sort the data within this report using the following by
clauses:
v By Database: Shows database capacity aggregated at the computer level and

sorted by instance name.
v By Computer: Shows database capacity aggregated at the computer level and

sorted by computer name.
v By Computer Group: Shows database capacity aggregated at the computer

monitoring group and computer reporting group levels and sorted by group
name.

v By TPC Server: Shows database capacity aggregated at the subordinate server
level and sorted by subordinate server name.

Note: The first column in each report remains displayed when scrolling through
the other columns on the report.

By Database

Database Instance
Name of a database instance.

Computer Name
Name of the computer on which an instance resides.
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Total Size
Amount of storage space allocated to an instance.

File Capacity
Amount of storage space allocated to the data files associated with an
instance.

File Free Space
Amount of storage free space available on the data files associated with an
instance.

Tablespace Count
Number of tablespaces associated with an instance.

File Count
Number of data files associated with an instance.

Log File Count
Number of log files associated with an instance.

By Computer

Computer Name
Name of the computer on which an instance resides.

Total Size
Amount of storage space allocated to an instance.

File Capacity
Amount of storage space allocated to the data files associated with an
instance.

File Free Space
Amount of storage free space available on the data files associated with an
instance.

Tablespace Count
Number of tablespaces associated with an instance.

File Count
Number of data files associated with an instance.

Log File Count
Number of log files associated with an instance.

By Computer Group

Computer Group
Name of a computer monitoring group or reporting group.

Total Size
Amount of storage space allocated to instances in a group.

File Capacity
Amount of storage space allocated to the data files associated with
instances in a group.

File Free Space
Amount of storage free space available on the data files associated with
instances in a group.

Tablespace Count
Number of tablespaces associated with instances in a group.
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File Count
Number of data files associated with instances in a group.

Log File Count
Number of log files associated with instances in a group.

TPC Server
Name of a subordinate server that is monitoring the group.

By TPC Server

TPC Server
Name of a subordinate server that is monitoring DBMSs in your
environment.

Total Size
Amount of storage space allocated to instances monitored by a subordinate
server.

Total File Capacity
Amount of storage space allocated to the data files associated with
instances monitored by a subordinate server.

File Free Space
Amount of storage free space available on the data files associated with
instances monitored by a subordinate server.

Tablespace Count
Number of tablespaces associated with instances monitored by a
subordinate server.

File Count
Number of data files associated with instances monitored by a subordinate
server.

Log File Count
Number of log files associated with instances monitored by a subordinate
server.

Data source reports - overview
Use data source reports to view detailed information about the agents from which
IBM Tivoli Storage Productivity Center collects information about storage
resources. Data sources include CIMOM agents, Storage Resource agents, Data
agents, Fabric agents, VMWare, and subordinate Tivoli Storage Productivity Center
servers.

Data source reports - CIMOM agents
Use these reports to view detailed information about the CIMOM agents that have
been associated with IBM Tivoli Storage Productivity Center.

Related Topics
v Selecting resources upon which to report
v Filtering the resources that appear in a report
v Generating a report
v Drilling down a report row (By Managed Device report only)
v Navigating tabs
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Data source report - By CIMOM Agent
Use this report to view detailed information about the CIMOM agents that are
used as data sources for IBM Tivoli Storage Productivity Center.

Each CIMOM that has been associated with IBM Tivoli Storage Productivity Center
appears as its own row in this report.

Service URL
The service URL of the CIMOM containing the IP address of the CIMOM,
the port on which the CIMOM is listening, and the protocol used for
communication. This URL has a protocol [http|https], an IP address (IPv4
or IPv6), and a port number. For example:
v IPv4: https://127.0.0.1:5989
v IPv6: https://[2001:DB8::1234:0000:0000:5678:ABCD]:5989

Display Name
The name of the CIMOM as specified by the CIMOM provider that will
appear in the Tivoli Storage Productivity Center user interface.

Description
The optional description that was entered on the Add CIMOM panel.

Managed Device Category
The type of device that is managed by a CIMOM (for example, storage
subsystem, switch, or tape library). The value NA appears in this column if
you have not run a CIMOM discovery against a CIMOM or a CIMOM
does not manage any devices.

Connection Status
The status of this CIMOM with respect to Tivoli Storage Productivity
Center. Possible values are: SUCCESS, UNCONFIGURED, UNKNOWN,
INVALID_NAMESPACE, TIMEOUT, REFUSED, LOGIN_FAILED,
SSL_HANDSHAKE_ERROR, SSL_REGISTRATION_INVALID,
CIMCLIENT_ERROR

Status Timestamp
The date and time when the Connection Status information was last
collected.

Number of Managed Devices
The number of devices managed by a CIMOM.

Interoperability Namespace
The interoperability namespace of a CIMOM. This namespace within the
CIMOM allows for accessing the CIM Interop Schema (including the class
instances of the Server Profile) and determines how Tivoli Storage
Productivity Center interacts with the CIMOM when retrieving
information. For a NetApp CIMOM, enter /interop.

Username
The CIMOM user name used for authentication.

Truststore Location
The location (path on this computer) of a certificate file for certificate based
authentication in the https protocol.

User Interface Description
The name of the Human Interface Service (if any) supported by this
CIMOM.
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Software Level
The software version level of the CIMOM agent.

Protocol Version
The version of the cim-xml protocol.

Authentication Mechanism
The authentication mechanism supported by the CIMOM. This column can
contain the following values: Unknown, None, Other, Basic, Digest.

Alias The alias of the CIMOM.

Protocol
The protocol used to communicate with the CIMOM. Possible values are
http and https.

SLP Attributes
The standard set of attributes for this CIMOM. The attributes are retrieved
via SLP.

Data source report - By Managed Device
Use this report to view information about the devices managed by CIMOMs in
your environment. Only devices that are managed by the CIMOMs used as data
sources for IBM Tivoli Storage Productivity Center are displayed.

You must run a CIMOM discovery job before you can view the devices managed
by CIMOMs in this report. If a device is managed by multiple CIMOMs, the report
displays a separate row for each of those CIMOMs. Therefore, the number of rows
for a device in the report is equal to the number of CIMOMs managing that
device.

Magnifying glass icon
Click this button to view a more detailed report about a device.

Device Name
The display name (label) of the managed storage subsystem, switch, or
tape library.

Device Category
Indicates whether a device that is managed by a CIMOM is a storage
subsystem, switch, or tape library.

Device Type
Indicates the type of a managed device based on its category. For example,
a device that is a storage subsystem might have a value of DS8000 in this
column.

Device Status
The consolidated status of the managed device.

Device Operational Status
The operational status of a storage subsystem.

Device Last Probe Time
The date and time when a probe was last run on a managed device.

Device Vendor
The manufacturer of the managed device.

Device Model
The model number of the managed device.
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Device Serial Number
The serial number of the managed device.

Device Microcode Level
The microcode or firmware level of the managed device.

Device IP Address
The IP address of the managed device.

Device Element Manager
The URL or the fully-qualified name of the executable file that launches the
element manager.

CIMOM Service URL
The service URL of the CIMOM. This URL includes the IP address or host
name of the CIMOM, the port on which the CIMOM is listening, and the
protocol used for communication (http|https). For example:
https://127.0.0.1:9551.

CIMOM Display Name
The name of the CIMOM as specified by the CIMOM provider that will
appear in the Tivoli Storage Productivity Center user interface.

CIMOM Description
The optional description that was entered on the Add CIMOM panel.

CIMOM Connection Status
The status of this CIMOM with respect to Tivoli Storage Productivity
Center. Possible values are: SUCCESS, UNCONFIGURED, UNKNOWN,
INVALID_NAMESPACE, TIMEOUT, REFUSED, LOGIN_FAILED,
SSL_HANDSHAKE_ERROR, SSL_REGISTRATION_INVALID,
CIMCLIENT_ERROR

CIMOM Status Timestamp
The date and time when the Connection Status information was last
collected.

CIMOM Interoperability Namespace
The interoperability namespace of a CIMOM. This namespace within the
CIMOM allows for accessing the CIM Interop Schema (including the class
instances of the Server Profile) and determines how Tivoli Storage
Productivity Center interacts with the CIMOM when retrieving
information. For a NetApp CIMOM, enter /interop.

CIMOM Username
The CIMOM user name used for authentication.

CIMOM Trustore Location
The location (path on this computer) of a certificate file for certificate based
authentication in the https protocol.

CIMOM User Interface Description
The name of the Human Interface Service (if any) supported by this
CIMOM.

CIMOM Software Level
The software version level of the CIMOM agent.

CIMOM Protocol Version
The version of the cim-xml protocol.
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CIMOM Authentication Mechanism
The authentication mechanism supported by the CIMOM. This column can
contain the following values: Unknown, None, Other, Basic, Digest.

CIMOM Alias
The alias of the CIMOM.

CIMOM Protocol
The protocol used to communicate with the CIMOM. Possible values are
http and https.

CIMOM SLP Attributes
The standard set of attributes for this CIMOM. The attributes are retrieved
via SLP.

Tivoli Storage Productivity Center Monitoring Agent reports
After you have installed and configured the Tivoli Storage Productivity Center
Monitoring Agent, you can view reports and information from Tivoli Storage
Productivity Center.

There are four predefined workspaces which are shipped with Tivoli Storage
Productivity Center:

TPC Server Overview
Provides an over view of the key parameters and infrastructure metrics
about the Data server and Device server managed entities.

Managed SAN Overview
Provides an overview about several metrics concerning the managed SAN
environment.

Managed SAN Health
Monitors the health and availability of the SAN attached devices managed
by Tivoli Storage Productivity Center.

TPC Data Collection Overview
Displays the status of the latest probe jobs and performance monitors.

Managed SAN Overview workspace

The Managed SAN Overview workspace provides an overview about several
metrics about the managed SAN environment. You can access this workspace by
clicking Managed SAN Overview in the navigation tree of the Navigator window.
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You can see the following views:

Alerts - by Type
Displays a bar chart showing the number of all computers, switches,
storage systems, and fabric alerts including their current state
(acknowledged or active).

Alerts - All
Displays a bar chart showing the number of all alerts of all devices
including their current state (acknowledged or active).

TPC-Wide Summary
Displays a table showing the total amount of users, disks, storage system
volumes, file systems, files, and folders.

Space Summary
Displays a bar chart showing the total amount of file system capacity,
physical disk space of all storage systems, total amount of the available
volume capacity, and total amount of usable volume capacity in the
managed storage environment.

User Consuming the most Space
Displays a chart with the total amount of space allocated by single users.
Only the ten users using the most space is shown.

File System Usage
Displays a pie chart showing the total amount of free and used file system
space in the managed storage environment.

Managed SAN Health workspace

The Managed SAN Health workspace provides an overview about the objects in
the managed SAN environment. You can access this workspace by clicking
Managed SAN Health in the navigation tree of the Navigator window.

Figure 62. Managed SAN overview report
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This workspace shows the following information:

Computers
Displays a list of all managed computers including their health status.

Hypervisors
Displays a list of all managed VMware hypervisors including their health
status.

Storage Systems
Displays a list of all managed storage systems including their health status.

Fabrics
Displays a list of all managed fabrics including their health status.

Switches
Displays a list of all managed switches including their health status.

Tape libraries
Displays a list of all managed tape libraries including their health status.

TPC Server Overview workspace

The TPC Server Overview workspace provides an overview of several metrics
about the Tivoli Storage Productivity Center server. You can access this workspace
by clicking TPC Server Overview in the navigation tree of the Navigator window.

Figure 63. Managed SAN Health report
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This workspace provides the following views:

Data Server Services
Displays a table showing all the Data server services (Server, Agent,
Scheduler, Device, and GUI) including their run status.

Device Server Services
Displays a table showing all Device server services including their run
status.

TPC Job Overview
Displays a table showing statistics about the total amount of jobs and their
corresponding status.

CIMOMs
Displays a table showing all the managed CIMOMs including their
connection status.

Registered Native API Devices
Displays a table showing all managed native interface devices including
their corresponding connection status.

VMware VI Data Sources
Displays a report showing all attached VMware VI Data Sources and their
corresponding connection status.

TPC Data Collection Overview workspace

The TPC Data Collection Overview workspace provides the status of the latest
probe jobs and performance monitor jobs. You can access this workspace by
clicking TPC Data Collection Overview in the navigation tree of the Navigator
window.

Figure 64. TPC Server overview report
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This workspace provides the following information:

Probe status overview
Displays a table showing all probe jobs and their status with the last five
runs.

Performance monitor overview
Displays a table showing all performance monitor jobs and their
corresponding status.

Detailed Tivoli Storage Productivity Center reports

There are several reports which provide detailed information about the monitored
entities. You can access these reports by clicking the appropriate entity in the
navigation tree of the Navigator window. These entities are:

Storage Systems
Under Storage Systems, you can view these detailed reports:
v DISK DATA
v POOL DATA
v SUBSYSTEM ALERT DATA
v SUBSYSTEM DATA
v TAPELIBRARY DATA
v TAPELIBRARY ALERT DATA
v VMWARE VI DATA
v VOLUME DATA

TPC Server and Data Sources
Under TPC Server and Data Sources, you can view these detailed reports:
v CIMOM DATA
v DATASERVER API
v DEVICESERVER API
v JOB STATUS DATA
v REGISTERED NATIVE API DATA
v OTHER DEVICE DATA
v PERFORMANCE MONITOR DATA

Figure 65. TPC Server overview report
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v PROBE STATUS DATA
v SCHEDULED JOB DATA
v TPC SERVER DATA

Computers and Hypervisors
Under Computers and Hypervisors, you can view these detailed reports:
v COMPUTER ALERT DATA
v COMPUTER DATA
v DATA AGENT DATA
v HBA DATA
v HYPERVISOR DATA
v INBANDAGENT DATA

Fabrics and Switches
Under Fabrics and Switches, you can view these detailed reports:
v FABRIC DATA
v FABRIC ALERT DATA
v OUTBANDAGENT DATA
v SWITCH DATA
v SWITCH ALERT DATA

See the Tivoli Storage Productivity Center online help for information about these
entities.
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Chapter 9. Reporting in the web-based GUI

Use the web-based GUI reports to show information about the storage resources in
your environment.

Viewing predefined and custom reports
You can use IBM Tivoli Common Reporting to view predefined reports and create
custom reports.

Predefined reports

You view the predefined reports that are provided by Tivoli Storage Productivity
Center in Tivoli Common Reporting.

You can view one of the following types of predefined report:
v Resources
v Performance
v Historical space
v Storage tiering

Reports about resources
Run reports about resources to show the relationships between resources.
For example, to show the pools that are related to a storage system, run
the Storage Resource Relationships Summary Report. Resources reports
also provide the current capacity, the available space, and the used space
for resources. For example, to show the current space statistics for a pool
on a storage system, run the Storage System - Pools Space Report.

Reports about performance
Run reports about performance to show the most active resources on
switches, on storage virtualizers, or on storage systems over a specified
period. For example, to find out which are the most active volumes on a
storage system over a specified period, run the Storage Systems - Most
Active Volumes Report. To find out more about the performance of a
specific resource over a specified period, run a details report such as the
Storage System - Volume Details Report.

Reports about historical space
Run reports about historical space to determine whether additional storage
resources are required. For example, to show how space is used over a
specified period on volumes on storage systems, or on volumes in a
storage resource group, run the Storage System - Volumes Historical Space
Report. The space statistics are analyzed to determine the future storage
requirements for your environment.

Reports about storage tiering
Run reports about storage tiering to show the workload activity of
managed disk groups and virtual disks. You can also run the Volume
Migration Recommendation Report to identify volumes that might require
migration based on the conditions that are set in tiering policies.

© Copyright IBM Corp. 2001, 2012 1143



Charts are automatically generated for most of the predefined reports. Depending
on the type of resource, the charts show statistics for space usage, workload
activity, bandwidth percentage, and so on.

Tip: When you view a predefined report, click Help to find out more about
predefined and custom reports.

Custom reports

Unlike predefined reports, you can select the information that you want to include
in custom reports. Custom reports can contain detailed information about the
relationships between monitored resources, the properties of monitored resources,
and detailed information about the performance of monitored resources.

You can create reports with basic formatting, or you can design more complex
reports with advanced formatting features. The advanced formatting features
include inserting charts in reports, and inserting links that open related reports.

To create a report, browse the list of monitored resources in your storage
environment, and drag items that are associated with the resources into a report.
For example, you can drag items that show capacity data for storage virtualizers
into a report.

Creating and viewing reports from the web-based GUI
Use the web-based GUI to create custom reports and view predefined reports.

Restriction:

You cannot create custom reports from the following packages:
v IBM Tivoli Storage Productivity Center Historical Information
v IBM Tivoli Storage Productivity Center Storage Tiering
1. Start the web-based GUI for Tivoli Common Reporting.
2. Depending on the type of report that you want to see, open the appropriate

report tool:
v To run a predefined report and view the report, select Reporting > View

predefined reports.
v To create a basic report with limited formatting, select Reporting > Create a

basic report.
v To create a report and apply advanced formatting features to the report,

select Reporting > Design a report.
3. Select the package you require from the list of available packages that is

displayed in Tivoli Common Reporting.

Accessing report features in Tivoli Common Reporting
You can view predefined reports and create custom reports from Tivoli Common
Reporting. You do not have to return to the Tivoli Storage Productivity Center
web-based GUI to do these tasks.

1. From the Tivoli Common Reporting user interface, click the Home icon ( ),
if you are not on the Tivoli Common Reporting home page.
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2. Depending on the type of report that you want to see, open the appropriate
report tool:
v To create a basic report with limited formatting, select Launch > Query

Studio.
v To create a report and apply advanced formatting features to the report,

select Launch > Report Studio.
3. Click a package from the list of available packages that is displayed in Tivoli

Common Reporting.
4. Depending on the type of report that you want to see, open the appropriate

report tool:
v To view a predefined report, navigate to the report and click the report.
v To create a basic report with limited formatting, use the Query Studio

features to create the report.
v To create a report and apply advanced formatting features to the report, use

the Report Studio features to create the report.

Setting options for reports
When you schedule or run a report, you can specify the output format and how
the report is delivered.

You can select output formats for the report. For example, you can select PDF,
HTML, and other formats. If you choose PDF as the format for your report, you
can set options such as the orientation and paper size for reports.

You can also specify to print the report, to send the report by email, and other
delivery options.
1. Navigate to a report in Tivoli Common Reporting.
2. Depending on whether you want to schedule a report or run a report, do one

of the following steps:
v To schedule a report, and select format and delivery options, click the

Schedule icon ( ).
v To run a report, and select format and delivery options, click the Run with

options icon ( ). To set advanced options, click advanced options, and
then select Run in the background.

For more information about report options, go to the IBM Cognos 8 v4 Business
Intelligence Information Center at http://publib.boulder.ibm.com/infocenter/
c8bi/v8r4m0/index.jsp. To schedule a report, search for schedule entry frequency.
To select formats for reports, search for reports formats. To select delivery
options for reports, search for distributing reports. To set advanced report
options, search for advanced report options.

Predefined reports about resources
You can run predefined reports about resources that show the relationships
between resources, and the current space statistics for servers, storage virtualizers,
and storage systems.

Before you run the predefined reports about resources, you must ensure that data
is collected from the resources. The following table shows the data that must be
collected.
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Resource Prerequisite

Server Data must be collected from the server by
the Storage Resource agent.

Hypervisor Data must be collected from the VMware
ESX server.

NAS Data must be collected from any NetApp or
IBM Scale Out Network Attached Storage
resources that are in your storage
environment.

Storage virtualizer Data must be collected from any of the
following storage virtualizers that are in
your storage environment:

v Storwize V7000

v Storwize V7000 Unified

v SAN Volume Controller

Storage system Data must be collected from the storage
system.

You can run the following predefined reports that contain information about
resources:
v Predefined reports that show the relationships between resources
v Predefined reports that show the current capacity and space statistics for servers,

disks on servers, and file systems on servers
v Predefined reports that show the current capacity and space statistics for storage

virtualizers and related resources such as local disks, managed disks, pools, and
volumes

v Predefined reports that show the current capacity and space statistics for storage
systems and related resources such as disks, pools, and volumes

Tip: To learn more about reports, see frequently asked questions about reports in
the IBM Tivoli Storage Productivity Center Information Center
(http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/index.jsp).

Relationship reports
Storage relationship reports show the relationships between the resources in your
environment.

Running the Storage Resource Relationships Summary Report
To show the relationships between storage resources, run the Storage Resource
Relationships Summary Report.

To run the report with the default settings, click Finish.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Click Storage Resource Relationships Summary Report.
3. Optional: Select one or more of the following:

a. Servers
b. Hypervisors
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c. NAS resources
d. Storage virtualizers
e. Storage systems

4. Click Finish.

If the resources that you selected are related, a report is created. If a report is not
created, a message is displayed in the report.

Restriction: To create a report when you select a single resource, the selected
resource must be connected to other resources.
Related reference:
“Storage Resource Relationships Summary Report”
The Storage Resource Relationships Summary Report shows the relationships
between storage resources.

Storage Resource Relationships Summary Report
The Storage Resource Relationships Summary Report shows the relationships
between storage resources.

Report output

Information is provided about related resources and the devices, such as managed
disks (MDisks), that are related to resources.

Server Name
The fully qualified domain name of the server. For example, the name of a
server might be server.example.com.

Hypervisor Name
The fully qualified domain name of the hypervisor. For example, the name
of a hypervisor might be hypervisor.example.com.

NAS Name
The fully qualified domain name of the NAS device. For example, the
name of a NAS device might be nas.example.com.

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Volume Name
The name that was assigned to the storage virtualizer volume when it was
added to the system.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer MDisk Name
The name that was assigned to the managed disk on a storage virtualizer
when it was added to the system.

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage Volume Name
The name that was assigned to the storage volume when it was added to
the system.
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Related links

To open related reports, click the name of the resource or storage device, click Go
To, and then click the name of the report.

Resource or storage device Related reports

Storage virtualizer Storage Virtualizer - Details Report

Storage virtualizer volume Storage Virtualizer - Volume Details Report

Storage virtualizer pool Storage Virtualizers - Most Active Pools
Report, and Storage Virtualizer - Pool
Details Report

Storage virtualizer managed disk (MDisk) Storage Virtualizer - MDisk Details Report

Storage system Storage System - Details Report

Storage volume Storage System - Volume Details Report

Storage pool Storage Systems - Most Active Pools Report

Related tasks:
“Running the Storage Resource Relationships Summary Report” on page 1146
To show the relationships between storage resources, run the Storage Resource
Relationships Summary Report.

Running the Storage Relationships Summary Report
(Configurable)
To show the relationships between resources, run the Storage Relationships
Summary Report (Configurable). You can show or hide resources, and you can
hide resources that are not related to other resources or storage devices.

To run the report with the default settings, click Finish. Servers, storage systems,
storage virtualizers, and their related resources are shown in the report.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Click the Storage Resource Relationships Summary Report (Configurable)

link.
3. Optional: Select the storage resources that you want to show in the report.
4. Optional: Specify whether you want to show or hide a resource that is related

to other storage devices such as a file system, but not to other resources. For
example, a server has a related file system. You can show the server and its
related storage devices in the report, or you can hide the resource and its
related storage devices in the report.

5. Optional: Click Finish to run the report.
6. Optional: Click Next. In the Select storage resources page, select one or more of

the following:
a. Servers
b. Hypervisors
c. NAS resources
d. Storage virtualizers
e. Storage systems

7. Click Finish.
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If information is available for the resources that you selected, a report is created
that shows the selected resource and its related resources. If a report is not created,
a message is displayed in the report.

Restriction: To create a report when you select a single resource, the selected
resource must be connected to other storage devices or resources. To create a report
about two or more selected resources, the resources that you selected must be
related.
Related reference:
“Storage Relationships Summary Report (Configurable)”
The Storage Relationships Summary Report (Configurable) shows the relationships
between storage resources.

Storage Relationships Summary Report (Configurable)
The Storage Relationships Summary Report (Configurable) shows the relationships
between storage resources.

Report output

Information is provided about related resources and the devices, such as managed
disks (MDisks), that are related to resources.

Server Name
The fully qualified domain name of the server. For example, the name of a
server might be server.example.com.

Server Disk Path
The identifier that specifies a path to a server disk, for example
/dev/hdisk0.

A server disk might have one or more disk paths. To identify unique
server disks, add the Server Disk Serial Number column to the report, and
group the server disks by the serial number.

Logical Volume Path
The path to a logical volume on a resource, for example /dev/hd1.

File System Mount Point
The name or mount point of the file system for the resource. For example,
on Microsoft Windows systems, the value in this column header might be
c:\ or d:\. On operating systems such as AIX, Linux, Solaris, or HP-UX,
the mount point might be /opt or /export/home.

Hypervisor Name
The fully qualified domain name of the hypervisor. For example, the name
of a hypervisor might be hypervisor.example.com.

Hypervisor Disk Path
The identifier that specifies a path to a hypervisor server disk, for example
vmhba1:0:0.

NAS Name
The fully qualified domain name of the NAS device. For example, the
name of a NAS device might be nas.example.com.

NAS Export Name
The name of the exported file system.

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.
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Storage Virtualizer Volume Name
The name that was assigned to the storage virtualizer volume when it was
added to the system.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer MDisk Name
The name that was assigned to the managed disk on a storage virtualizer
when it was added to the system.

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage Volume Name
The name that was assigned to the storage volume when it was added to
the system.

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Related links

To open related reports, click the name of the resource or storage device, click Go
To, and then click the name of the report.

Resource or storage device Related reports

Storage virtualizer Storage Virtualizer - Details Report

Storage virtualizer volume Storage Virtualizer - Volume Details Report

Storage virtualizer pool Storage Virtualizers - Most Active Pools
Report, and Storage Virtualizer - Pool
Details Report

Storage virtualizer managed disk (MDisk) Storage Virtualizer - MDisk Details Report

Storage system Storage System - Details Report

Storage volume Storage System - Volume Details Report

Storage pool Storage Systems - Most Active Pools
Report

Related tasks:
“Running the Storage Relationships Summary Report (Configurable)” on page 1148
To show the relationships between resources, run the Storage Relationships
Summary Report (Configurable). You can show or hide resources, and you can
hide resources that are not related to other resources or storage devices.

Server reports
Server reports show the space statistics for servers, file systems, and disks.

Running the Server Storage Summary Report
To see information about the capacity and space of server disks and file systems,
run the Server Storage Summary Report.

To run the report with the default settings, click Finish.
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Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Server folder.
3. Click Server Storage Summary Report.
4. Optional: Select one or more servers.
5. Optional: Select a sort option. You can order the metrics represented in the

chart by disk or by file system.

Tip: When the report is created, you can change the sort option.
6. Optional: Select a sort order.
7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Server Storage Summary Report”
The Server Storage Summary Report, shows the space statistics for disks and file
systems on servers.

Server Storage Summary Report
The Server Storage Summary Report, shows the space statistics for disks and file
systems on servers.

Charts

The bar chart shows the capacity, used space, available space, and percentage of
used space for disks on servers. Dots are used to represent the total space that is
used by the file system, and the total space that is available to the file system on
the server. You can position the cursor over the dot to show the amount of used
space or the amount of available space for the file system. The position of the dot
that is used to represent the total space that is available to the file system is also
used to show the total capacity of the file system.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

For each server, the following information is provided:

Server Total Disk Capacity (GiB)
The amount of storage space that is on a server.

Server Total Disk Available Space (GiB)
The amount of unused storage space on all disks on a server.

Server Total Disk Used Space (GiB)
The amount of storage space that is used on all disks on a server.

Server Total Disk Used Space (%)
The percentage of used storage space on all disks on the server.

Server Total File System Capacity (GiB)
The amount of storage space on the file system of the resource.
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Server Total File System Used Space (GiB)
The amount of used storage space in the file system of the resource.

Server Total File System Available Space (GiB)
The amount of unused storage space in the file system of the resource.

Server Total File System Used Space (%)
The amount of used storage space in the file system of the resource.

Related reports

To open related reports, click the name of the server, click Go To, and then click
the name of the report. You can open the following related reports:
v The File System Details Report
v The Server Disk Details Report
Related tasks:
“Running the Server Storage Summary Report” on page 1150
To see information about the capacity and space of server disks and file systems,
run the Server Storage Summary Report.

Running the Server Disk Details Report
To see information about the capacity of disks on servers, run the Server Disk
Details Report.

To run the report with the default settings, click Finish.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Server folder.
3. Click Server Disk Details Report.
4. Optional: Select one or more servers.
5. Optional: Select a sort order.
6. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Server Disk Details Report”
The Server Disk Details Report shows the space statistics for disks on servers.

Server Disk Details Report
The Server Disk Details Report shows the space statistics for disks on servers.

Charts

The bar chart shows the capacity, used space, available space, and percentage of
used space for disks on servers.

Tip: To change the sort order, select a value from the Sort Order list.
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Report output

For each server, the following information is provided:

Server Disk Path
The identifier that specifies a path to a server disk, for example
/dev/hdisk0.

A server disk might have one or more disk paths. To identify unique
server disks, add the Server Disk Serial Number column to the report, and
group the server disks by the serial number.

Server Disk Capacity (GiB)
The amount of storage space that is on a server disk.

Server Disk Available Space (GiB)
The amount of unused storage space that is on a server disk.

Server Disk Used Space
The amount of storage space that is used on a server disk.

Server Disk Used Space (%)
The percentage of used storage space on the disk.

Server Disk Status
The condition of the resource, for example normal, warning, or error.

Server Disk Firmware Version
The version number of the firmware that is running on the disk.

Server Disk Model
The model name or model number of the resource.

Server Disk Vendor
The vendor who supplied the resource.

Related tasks:
“Running the Server Disk Details Report” on page 1152
To see information about the capacity of disks on servers, run the Server Disk
Details Report.

Running the File System Details Report
To see information about the capacity of file systems on servers, run the File
System Details Report.

To run the report with the default settings, click Finish.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Server folder.
3. Click File System Details Report.
4. Select one or more servers.
5. Optional: Select a sort order.
6. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
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Related reference:
“File System Details Report”
The File System Details Report shows the space statistics for file systems on
servers.

File System Details Report
The File System Details Report shows the space statistics for file systems on
servers.

Charts

The bar chart shows the capacity, used space, available space, and percentage of
used space for file systems on servers.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

For each server, the following information is provided:

File System Mount Point
The name or mount point of the file system for the resource. For example,
on Microsoft Windows systems, the value in this column header might be
c:\ or d:\. On operating systems such as AIX, Linux, Solaris, or HP-UX,
the mount point might be /opt or /export/home.

File System Type
The type of file system that the resource uses.

File System Capacity (GiB)
The amount of storage space on the file system of the resource.

File System Used Space (GiB)
The amount of used storage space in the file system of the resource.

File System Available Space (GiB)
The amount of unused storage space in the file system of the resource.

File System Used Space (%)
The percentage of used space in the file system on the server.

File System Available Inodes
The number of unused inodes in file systems on the operating system.

Tip: For Microsoft Windows systems, this column is blank.

File System Used Inodes
The number of used inodes in file systems on the operating system.

Tip: For Microsoft Windows systems, this column is blank.
Related tasks:
“Running the File System Details Report” on page 1153
To see information about the capacity of file systems on servers, run the File
System Details Report.

Storage virtualizer reports
Storage virtualizer reports show the space statistics for storage virtualizers. The
reports also show the space statistics for local disks, managed disks, pools, and
volumes on storage virtualizers.

1154 IBM Tivoli Storage Productivity Center: User's Guide



Running the Storage Virtualizers - Space Report
To see information about the capacity of pools, managed disks (MDisks), and
volumes on storage virtualizers, run the Storage Virtualizers - Space Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers in the list are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizers - Space Report.
4. Optional: Select one or more storage virtualizers.
5. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizers - Space Report”
The Storage Virtualizers - Space Report shows the space statistics for pools,
managed disks (MDisks), disks, volumes, and virtual volumes on storage
virtualizers.

Storage Virtualizers - Space Report
The Storage Virtualizers - Space Report shows the space statistics for pools,
managed disks (MDisks), disks, volumes, and virtual volumes on storage
virtualizers.

Charts

The bar chart shows the used space and available space for pools on storage
virtualizers.

Report output

For each storage virtualizer, the following information is provided:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Total Pool Capacity (GiB)
The amount of storage space in pools on the storage virtualizer.

Storage Virtualizer Pool Used Space (GiB)
The total amount of used storage space in the pools in a storage virtualizer
pool.

Storage Virtualizer Pool Available Space (GiB)
The amount of unused storage space in a storage virtualizer pool.

Storage Virtualizer Volume Allocated Space (GiB)
The amount of storage space that is allocated to volumes.
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Storage Virtualizer MDisk Capacity (GiB)
The amount of storage space on the managed disk.

Storage Virtualizer MDisk Available Space (GiB)
The amount of space on managed disks that is available to be added to a
pool.

Storage Virtualizer Total Volume Capacity (GiB)
The amount of virtual volume space on all volumes on the storage
virtualizer.

Storage Virtualizer Volume Assigned Space (GiB)
The amount of virtual volume space that is assigned to the server or
storage virtualizer.

Storage Virtualizer Disk Capacity (GiB)
The amount of local disk storage on the storage virtualizer.

Storage Virtualizer Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Storage Virtualizer Number of Volumes
The number of volumes on a resource.

Storage Virtualizer Number of MDisks
The number of managed disks on a resource.

Report links

To open related reports, click the name of the storage virtualizer, click Go To, and
then click the name of the report. You can open the following related reports:
v The Storage Virtualizer - Pools Space Report
v The Storage Virtualizer - Volumes Space Report
v The Storage Virtualizer - MDisks Space Report
v The Storage Virtualizer - Local Disks Space Report
v The Storage Virtualizers - Historical Space Report
Related tasks:
“Running the Storage Virtualizers - Space Report” on page 1155
To see information about the capacity of pools, managed disks (MDisks), and
volumes on storage virtualizers, run the Storage Virtualizers - Space Report.

Running the Storage Virtualizer - Local Disks Space Report
To see information about the capacity of local disks on storage virtualizers, run the
Storage Virtualizer - Local Disks Space Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers in the list are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer - Local Disks Space Report.
4. Optional: Select one or more storage virtualizers.
5. Click Finish.
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If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizer - Local Disks Space Report”
The Storage Virtualizer - Local Disks Space Report shows the space statistics for
local disks on storage virtualizers.

Storage Virtualizer - Local Disks Space Report
The Storage Virtualizer - Local Disks Space Report shows the space statistics for
local disks on storage virtualizers.

Charts

The bar chart shows the capacity of local disks, grouped by the storage class of the
disk, for storage virtualizers.

Report output

For each type of storage class of disk on a storage virtualizer, the following
information is provided:

Storage Virtualizer Local Disk Storage Class
The storage technology of the storage virtualizer local disk. For example,
the storage class can be serial-attached SCSI (SAS) or solid-state drive
(SSD).

Storage Virtualizer Local Disk Name
The name that was assigned to the local disk on the storage virtualizer
when it was added to the system.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Local Disk Vendor
The vendor who supplied the resource.

Storage Virtualizer Local Disk Model
The model name or model number of the resource.

Storage Virtualizer Local Disk Firmware Version
The version number of the firmware that is running on the disk.

Storage Virtualizer Local Disk Capacity (GiB)
The amount of storage space on the local disk.

Storage Virtualizer Local Disk Speed (RPM)
The speed of the storage virtualizer local disk.
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Related tasks:
“Running the Storage Virtualizer - Local Disks Space Report” on page 1156
To see information about the capacity of local disks on storage virtualizers, run the
Storage Virtualizer - Local Disks Space Report.

Running the Storage Virtualizer - MDisks Space Report
To see information about used space and available space on managed disks
(MDisks) on storage virtualizers, run the Storage Virtualizer - MDisks Space
Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers in the list are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer - MDisks Space Report.
4. Optional: Select one or more storage virtualizers.
5. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizer - MDisks Space Report”
The Storage Virtualizer - MDisks Space Report shows the space statistics for
managed disks (MDisks) on storage virtualizers.

Storage Virtualizer - MDisks Space Report
The Storage Virtualizer - MDisks Space Report shows the space statistics for
managed disks (MDisks) on storage virtualizers.

Charts

The bar chart shows the used space and the available space for MDisks on storage
virtualizers.

Report output

For each MDisk on a storage virtualizer, the following information is provided:

Storage Virtualizer MDisk Name
The name that was assigned to the managed disk on a storage virtualizer
when it was added to the system.

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer MDisk Capacity (GiB)
The amount of storage space on the managed disk.

Storage Virtualizer MDisk Used Space (GiB)
The amount of used space on the managed disk.

1158 IBM Tivoli Storage Productivity Center: User's Guide



Storage Virtualizer MDisk Available Space (GiB)
The amount of space on managed disks that is available to be added to a
pool.

Storage Virtualizer MDisk Strip Size (KiB)
The number of blocks in a strip on a storage virtualizer managed disk.

Storage Virtualizer MDisk Mode
The access mode of a managed disk on a storage virtualizer. The access
mode describes how extents are provided for virtual disks. Extents can be
provided to virtual disks in the following ways:

Array Extents are provided from local disks.

Managed
Extents are provided from a back-end storage volume.

Unmanaged
The managed disk is not used in the system.

Storage Virtualizer MDisk RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.

Storage Virtualizer MDisk Type
The type of managed disk on a storage virtualizer. For example, the
storage virtualizer can be a local or virtual managed disk.

Storage Virtualizer MDisk Is Balanced
Shows whether logical unit numbers (LUNs) are properly balanced across
storage controllers on the managed disk. If this value is Yes, the LUNs are
properly balanced.

Storage Virtualizer MDisk Fast Write State
Shows whether the cache for a volume on a disk that is managed by a
storage virtualizer is empty, contains data, or is corrupted.

Storage Virtualizer MDisk Write Verify
Shows whether all write operations on the storage virtualizer managed
disk are verified by an immediate follow-up read operation. The follow-up
read operation verifies that the write operation was successful. If this value
is Yes, all write operations are verified by a follow-up read operation.

Related tasks:
“Running the Storage Virtualizer - MDisks Space Report” on page 1158
To see information about used space and available space on managed disks
(MDisks) on storage virtualizers, run the Storage Virtualizer - MDisks Space
Report.

Running the Storage Virtualizer - Pools Space Report
To see information about the used space and available space in pools on storage
virtualizers, run the Storage Virtualizer - Pools Space Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers in the list are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
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2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer - Pools Space Report.
4. Optional: Select one or more storage virtualizers.
5. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizer - Pools Space Report”
The Storage Virtualizer - Pools Space Report shows the space statistics for pools
on storage virtualizers.

Storage Virtualizer - Pools Space Report
The Storage Virtualizer - Pools Space Report shows the space statistics for pools
on storage virtualizers.

Charts

The bar chart shows the used space and available space for pools on storage
virtualizers.

Report output

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Capacity (GiB)
The amount of storage space in the pool on the storage virtualizer. For
SAN Volume Controller, this value represents the amount of managed disk
space that is assigned to the managed disk group.

Storage Virtualizer Pool Used Space (GiB)
The amount of storage space that is used in the pool on the storage
virtualizer.

Storage Virtualizer Pool Available Space (GiB)
The amount of unused storage space in a storage virtualizer pool.

Storage Virtualizer Pool Real Volume Capacity (GiB)
The amount of space on all allocated extents in a pool. The allocated
extents include the used extents and extents that were assigned to volumes
when they were allocated.

Storage Virtualizer Pool Used Volume Space (GiB)
The amount of used space on all the volumes and volume copies in the
pool.

Storage Virtualizer Pool Virtual Volume Capacity (GiB)
The amount of virtual volume space on all volumes in the pool.

Storage Virtualizer Pool Extent Size (MiB)
The size of the extents that were specified when a pool was created.

Storage Virtualizer Pool Number of Storage Volumes
The number of volumes in the storage virtualizer pool.
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Storage Virtualizer Pool Number of MDisks
The number of managed disks on a resource.

Storage Virtualizer Pool Assigned Volume Space (GiB)
The amount of space in the pool that is on volumes that are assigned to a
server or storage virtualizer.

Storage Virtualizer Pool Unassigned Volume Space (GiB)
The amount of volume space in the pool that is not assigned to a server or
storage virtualizer.

Storage Virtualizer Pool RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.

Storage Virtualizer Pool Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.

Storage Virtualizer Pool Is Solid State
Shows whether there are solid-state drives in the pool. This property can
contain the following values:

Mixed The pool contains both hard disk drives and solid-state drives.

Non solid state
The pool contains no solid-state drives.

Solid state
The pool contains a least one solid-state drive.

Storage Virtualizer Pool Overallocation Percentage
The percentage of space that is allocated to virtual capacity on volumes in
the pool.

Storage Virtualizer Pool Warning Level
The percentage of used capacity of the resource at which a warning is
generated.

Report links

To open related reports, click the name of the storage pool, click Go To, and then
click the name of the report. You can open the following related reports:
v The Storage Virtualizer - Volumes Space Report
v The Storage Virtualizer - MDisks Space Report
v The Storage Virtualizer - Pools Historical Space Report

.
Related tasks:
“Running the Storage Virtualizer - Pools Space Report” on page 1159
To see information about the used space and available space in pools on storage
virtualizers, run the Storage Virtualizer - Pools Space Report.

Running the Storage Virtualizer - Volumes Space Report
To see information about the capacity of volumes on storage virtualizers, run the
Storage Virtualizer - Volumes Space Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers in the list are selected.
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Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Storage Virtualizer folder.
3. Click the Storage Virtualizer - Volumes Space Report link.
4. Optional: Select one or more storage virtualizers.
5. Optional: Select the type of volume.

Option Description

All Select All, the default, to view information
about all of the volumes on the selected
storage virtualizers.

Primary Select Primary to view information about
primary volumes on the selected storage
virtualizers.

Secondary Select Secondary to view information about
secondary volumes on the selected storage
virtualizers.

6. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizer - Volumes Space Report”
The Storage Virtualizer - Volumes Space Report shows the space statistics for
volumes on storage virtualizers.

Storage Virtualizer - Volumes Space Report
The Storage Virtualizer - Volumes Space Report shows the space statistics for
volumes on storage virtualizers.

Charts

The bar chart shows the used space for volumes on storage virtualizers.

Report output

For each volume on a storage virtualizer, the following information is provided:

Storage Virtualizer Volume Name
The name that was assigned to the storage virtualizer volume when it was
added to the system.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Volume Copy ID
The identifier of the storage virtualizer volume copy.
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Storage Virtualizer Volume Copy Is Primary
Shows whether the storage virtualizer volume copy is the primary volume
copy.

Storage Virtualizer Volume Used Space (GiB)
The amount of virtual space that is used on a thin-provisioned volume. For
volumes that are not thin provisioned, this value is same as the Storage
Virtualizer Volume Capacity value.

Storage Virtualizer Volume Capacity (GiB)
The amount of storage space on the volume.

Storage Virtualizer Volume Real Space (GiB)
The physical space for a thin-provisioned volume that was allocated when
the volume was created.

Storage Virtualizer Volume Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Storage Virtualizer Volume Is Assigned
Shows whether the volume is assigned to a server. If this value is Yes, the
volume is assigned to a server.

Storage Virtualizer Volume Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.

Storage Virtualizer Volume Warning Level
The percentage of used capacity of the resource at which a warning is
generated.

Storage Virtualizer Volume Type
The type of storage virtualizer volume. For example, the storage virtualizer
volume can be striped, sequential, or another type of storage virtualizer
volume.

Storage Virtualizer Volume Grain Size (KiB)
The unit in which space is allocated from a volume. Larger grain sizes
maximize performance. Smaller grain sizes maximize space efficiency.

Related links

To open the related report, click the name of the volume, click Go To, and then
click Storage Virtualizer - Volumes Historical Space Report.
Related tasks:
“Running the Storage Virtualizer - Volumes Space Report” on page 1161
To see information about the capacity of volumes on storage virtualizers, run the
Storage Virtualizer - Volumes Space Report.

Storage system reports
Storage system reports show the space statistics for storage systems. The reports
also show the space statistics for disks, pools, and volumes on storage systems.

Running the Storage Systems - Space Report
To see information about the capacity of disks, pools, and volumes on storage
systems, run the Storage Systems - Space Report.

To run the report with the default settings, click Finish. By default all of the
storage systems in the list are selected.
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Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Storage System folder.
3. Click Storage Systems - Space Report.
4. Optional: Select one or more storage systems.
5. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Systems - Space Report”
The Storage Systems - Space Report shows the space statistics for pools, disks, and
volumes on storage systems.

Storage Systems - Space Report
The Storage Systems - Space Report shows the space statistics for pools, disks, and
volumes on storage systems.

Charts

The bar chart shows the used space and available space for pools on storage
systems.

Report output

For each storage system, the following information is provided:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage System Type
The type of storage system. For example, the storage system can be a
DS8000, or an XIV system, or another type of storage system.

Storage System Pool Capacity (GiB)
The amount of storage space in pools that are on the storage system. For
an XIV system, this value represents the physical capacity of the pool, not
the virtual capacity. For other storage systems, this value might also
include overhead space if the pool is unformatted.

Storage System Used Pool Space (GiB)
The amount of space that is in use in all pools on a storage system.

Storage System Available Pool Space (GiB)
The amount of unused space in pools that are on the storage system.

Storage System Volume Capacity (GiB)
The amount of space on all volumes on the storage system.

Storage System Number of Volumes
The number of volumes on a resource.

Storage System Number of Disks
The number of disks on the storage system.
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Storage System Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Storage System Unallocated Disk Space (GiB)
The amount of disk space that can be added to a pool.

Storage System Volume Capacity Assigned to MDisks (GiB)
The amount of space that is on volumes that are assigned to a storage
virtualizer to use as managed disks.

Storage System Disk Capacity (GiB)
The total amount of space that is on a physical disk on the storage system.

Storage System Total Disk Capacity (GiB)
The amount of space on physical disks on a storage system, including
spare disks.

Storage System Cache (GiB)
The size of the cache on the storage system.

Storage System Assigned Volume Space (GiB)
The amount of space in the pool that is on volumes that are assigned to a
server or storage virtualizer.

Storage System Volume Capacity for z/OS
The amount of space on all volumes on the storage system that the z/OS
operating system can use.

Storage System Real Available Pool Space (GiB)
The amount of unused space in pools that have an associated soft size on
an XIV system. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Storage System Real Configured Pool Space (GiB)
The amount of storage space that is in pools that have an associated soft
size on an XIV system. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Report links

To open related reports, click the name of the storage system, click Go To, and
then click the name of the report. You can open the following related reports:
v The Storage Systems - Historical Space Report
v The Storage System - Disks Space Report
v The Storage System - Volumes Space Report
v The Storage System - Pools Space Report
Related tasks:
“Running the Storage Systems - Space Report” on page 1163
To see information about the capacity of disks, pools, and volumes on storage
systems, run the Storage Systems - Space Report.

Running the Storage System - Disks Space Report
To see information about the capacity of disks on DS4000, DS5000, and DS8000
storage systems, run the Storage System - Disks Space Report.

To run the report with the default settings, click Finish. By default all of the
storage systems in the list are selected.
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Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Storage System folder.
3. Click Storage System - Disks Space Report.
4. Optional: Select one or more storage systems.
5. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage System - Disks Space Report”
The Storage System - Disks Space Report shows the space statistics for disks on
DS4000, DS5000, and DS8000 storage systems.

Storage System - Disks Space Report
The Storage System - Disks Space Report shows the space statistics for disks on
DS4000, DS5000, and DS8000 storage systems.

Charts

The bar chart shows the capacity of disks, grouped by storage class, on storage
systems.

Report output

For each disk on a storage system, the following information is provided:

Storage Disk Class
The storage technology of the disk. This property applies only to DS8000,
DS5000, and DS4000 storage systems. This property can contain the
following values:

FC The disk is a Fibre Channel disk.

Nearline ATA
The disk is a nearline Advanced Technology Attachment disk.

Nearline SAS
The disk is a nearline serial-attached SCSI disk.

SAS The disk is a serial-attached SCSI disk.

SATA The disk is a Serial Advanced Technology Attachment disk.

SSD The disk is a solid-state drive.

Unavailable
The disk is on a DS5000 or DS4000 series system, and is not a
solid-state drive.

Storage Disk Name
The name that was assigned to the storage disk when it was added to the
system.

Storage Disk Name
The name of the resource.
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Storage System Type
The type of storage system. For example, the storage system can be a
DS8000, or an XIV system, or another type of storage system.

Storage Pool Name
The name of the resource.

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage Disk Vendor
The vendor who supplied the resource.

Storage Disk Model
The model name or model number of the resource.

Storage Disk Serial Number
The serial number of the resource.

Storage Disk Firmware Version
The version number of the firmware that is running on the disk.

Storage Disk Capacity (GiB)
The amount of storage space that is on a physical disk on the storage
system.

Storage Disk Speed (RPM)
The speed of the disk.

Related tasks:
“Running the Storage System - Disks Space Report” on page 1165
To see information about the capacity of disks on DS4000, DS5000, and DS8000
storage systems, run the Storage System - Disks Space Report.

Running the Storage System - Pools Space Report
To see information about the used and available space of pools on storage systems,
run the Storage System - Pools Space Report.

To run the report with the default settings, click Finish. By default all of the
storage systems in the list are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Storage System folder.
3. Click Storage System - Pools Space Report.
4. Optional: Select one or more storage systems.
5. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.

Chapter 9. Reporting in the web-based GUI 1167



Related reference:
“Storage System - Pools Space Report”
The Storage System - Pools Space Report shows the space statistics for pools on
storage systems.

Storage System - Pools Space Report
The Storage System - Pools Space Report shows the space statistics for pools on
storage systems.

Charts

The bar chart shows the used space and available space for pools on storage
systems.

Report output

For each pool on a storage system, the following information is provided:

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage Pool Capacity (GiB)
The amount of storage space in the storage pool.

Storage Pool Used Space (GiB)
The amount of storage space that is used in the pool.

Storage Pool Available Space (GiB)
The amount of unused storage space in the pool.

Storage Pool Assigned Volume Space (GiB)
The amount of space in the pool that is on volumes that are assigned to a
server or storage virtualizer.

Storage Pool Unassigned Volume Space (GiB)
The amount of volume space in the pool that is not assigned to a server or
storage virtualizer.

Storage Pool Virtual Volume Capacity (GiB)
The amount of virtual volume space on all volumes in the pool.

Storage Pool Used Volume Space (GiB)
The amount of used space on all the volumes in the pool.

Storage Pool Real Configured Space (GiB)
The amount of storage space that is in an XIV system pool that has an
associated soft size. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Storage Pool Real Available Space (GiB)
The amount of unused space that is in an XIV system pool that has an
associated soft size. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Storage Pool Repository Capacity (GiB)
The amount of space on all extents in the repository of a pool. This space
can be used to allocate track space-efficient volumes. This attribute applies
only to DS8000 storage systems.
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Storage Pool Used Repository Space (GiB)
The amount of space on all extents in the repository of a pool that are
allocated. This space can be used to allocate track space-efficient volumes.
This attribute applies only to the DS8000 storage systems.

Storage Pool Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.

Storage Pool Is Solid State
Shows whether there are solid-state drives in the pool. This property can
contain the following values:

Mixed The pool contains both hard disk drives and solid-state drives.

Non solid state
The pool contains no solid-state drives.

Solid state
The pool contains a least one solid-state drive.

Storage Pool RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.

Report links

To open related reports, click the name of the storage pool, click Go To, and then
click the name of the report. You can open the following related reports:
v Storage System - Pools Historical Space Report
v Storage System - Volumes Space Report
Related tasks:
“Running the Storage System - Pools Space Report” on page 1167
To see information about the used and available space of pools on storage systems,
run the Storage System - Pools Space Report.

Running the Storage System - Volumes Space Report
To see information about the capacity of volumes on storage systems, run the
Storage System - Volumes Space Report.

To run the report with the default settings, click Finish. By default all of the
storage systems in the list are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Resources.
2. Open the Storage System folder.
3. Click Storage System - Volumes Space Report.
4. Optional: Select one or more storage systems.
5. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
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Related reference:
“Storage System - Volumes Space Report”
The Storage System - Volumes Space Report shows the space statistics for volumes
on storage systems.

Storage System - Volumes Space Report
The Storage System - Volumes Space Report shows the space statistics for volumes
on storage systems.

Charts

The bar chart shows the used space for volumes on storage systems.

Report output

For each volume on a storage system, the following information is provided:

Storage Volume Name
The name that was assigned to the storage volume when it was added to
the system.

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage Volume WWN
The worldwide name of the volume.

Storage Volume Capacity (GiB)
The amount of storage space on the volume.

Storage Volume Used Space (GiB)
The amount of virtual space that is used on a thin-provisioned volume. For
volumes that are not thin provisioned, this value is same as the Storage
Volume Capacity value. This property applies only to DS8000 storage
systems.

Storage Volume Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Storage Volume Is Assigned
Shows whether the volume is assigned to a server. If this value is Yes, the
volume is assigned to a server.

Storage Volume Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.

Storage Volume Logical Subsystem
The logical subsystem (LSS) to which a volume or pool belongs.

Storage Volume RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.
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Related links

To open the related report, click the name of the volume, click Go To, and then
click Storage System - Volumes Historical Space Report.
Related tasks:
“Running the Storage System - Volumes Space Report” on page 1169
To see information about the capacity of volumes on storage systems, run the
Storage System - Volumes Space Report.

Predefined reports about performance
You can run predefined reports to monitor the performance of switches, storage
virtualizers, and storage systems over a specified period.

You can run the following predefined reports to monitor the performance of
resources:
v Most active reports that show which are the most active resources on switches,

storage virtualizers, and storage systems
v Detailed reports that show the performance statistics for resources such as

switches, storage virtualizers, and storage systems
v Detailed reports that show the performance statistics for resources such as pools

on storage virtualizers, or on storage systems

Tip: To learn more about reports, see frequently asked questions about reports in
the IBM Tivoli Storage Productivity Center Information Center
(http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/index.jsp).

Switch reports
Switch reports show the most active ports on switches. The reports also show
information about the performance of switches and ports on switches.

Running the Most Active Switch Ports Report
To see which ports are most active on switches, run the Most Active Switch Ports
Report.

To run the report with the default settings, click Finish. By default all of the
switches are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Fabric and Switch folder.
3. Click Most Active Switch Ports Report.
4. Select a switch, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.
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7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Most Active Switch Ports Report”
The Most Active Switch Ports Report shows the performance statistics for the most
active ports on a switch. Use the report to monitor the performance of ports over a
specified period.

Most Active Switch Ports Report
The Most Active Switch Ports Report shows the performance statistics for the most
active ports on a switch. Use the report to monitor the performance of ports over a
specified period.

Charts

The bar chart shows the most active ports on the switch. By default, ports are
sorted by the total frame rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided about the most active ports on switches is as
follows:

Switch Name
The user-defined name for the switch, or the name that was assigned to
the switch by the vendor.

Switch Port WWPN
The worldwide port name of the port on the switch.

Total Port Frame Rate (frames/s)
The average number of frames per second that are transferred. This value
includes frames that are sent and frames that are received by the port.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Related reports

To open related reports, click the name of the resource or device, click Go To, and
then click the name of the report. You can open the following related reports:
v Switch Performance Details Report
v Switch Port Performance Details Report
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Related tasks:
“Running the Most Active Switch Ports Report” on page 1171
To see which ports are most active on switches, run the Most Active Switch Ports
Report.

Running the Switch Performance Details Report
To see information about the performance of a switch, run the Switch Performance
Details Report.

To run the report, you must select a switch.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Fabric and Switch folder.
3. Click Switch Performance Details Report.
4. Select a switch.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Switch Performance Details Report”
The Switch Performance Details Report shows the performance statistics for a
switch. Use the report to monitor the performance of a switch over a specified
period.

Switch Performance Details Report
The Switch Performance Details Report shows the performance statistics for a
switch. Use the report to monitor the performance of a switch over a specified
period.

Charts

The charts show the following performance statistics for the ports on the switch:
v The send frame rates, the receive frame rates, and the total frame rates
v The send data rates, the receive data rates, and the total data rates
v The send bandwidth percentages, the receive bandwidth percentages, and the

overall bandwidth percentages

Report output

The information that is provided about the switch is as follows:

Switch Name
The user-defined name for the switch, or the name that was assigned to
the switch by the vendor.
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Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Port Send Frame Rate (frames/s)
The average number of frames per second that are sent through the port.

Port Receive Frame Rate (frames/s)
The average number of frames per second that are received by the port.

Total Port Frame Rate (frames/s)
The average number of frames per second that are transferred. This value
includes frames that are sent and frames that are received by the port.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Port Send Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Port Receive Bandwidth Percentage
The percentage of the port bandwidth that is used for receive operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Related reports

To open the related report, click the name of the switch, click Go To, and then click
Most Active Switch Ports Report.
Related tasks:
“Running the Switch Performance Details Report” on page 1173
To see information about the performance of a switch, run the Switch Performance
Details Report.

Running the Switch Port Performance Details Report
To see information about the performance of a switch port, run the Switch Port
Performance Details Report.

To run the report, you must select a switch and a switch port.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Fabric and Switch folder.
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3. Click Switch Port Performance Details Report.
4. Select a switch, and then select the WWPN (worldwide port name) of the

switch port.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Switch Port Performance Details Report”
The Switch Port Performance Details Report shows the performance statistics for a
port on a switch. Use the report to monitor the performance of a port over a
specified period.

Switch Port Performance Details Report
The Switch Port Performance Details Report shows the performance statistics for a
port on a switch. Use the report to monitor the performance of a port over a
specified period.

Charts

The charts show the following performance statistics for the port:
v The send frame rate, the receive frame rate, and the total frame rate
v The send data rate, the receive data rate, and the total data rate
v The send bandwidth percentage, the receive bandwidth percentage, and the

overall bandwidth percentage
v The error rates

Report output

The information that is provided about the port on the switch is as follows:

Switch Name
The user-defined name for the switch, or the name that was assigned to
the switch by the vendor.

Switch Port WWPN
The worldwide port name of the port on the switch.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Port Send Frame Rate (frames/s)
The average number of frames per second that are sent through the port.
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Port Receive Frame Rate (frames/s)
The average number of frames per second that are received by the port.

Total Port Frame Rate (frames/s)
The average number of frames per second that are transferred. This value
includes frames that are sent and frames that are received by the port.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Port Send Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Port Receive Bandwidth Percentage
The percentage of the port bandwidth that is used for receive operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Error Frame Rate (count/s)
The average number of error frames per second that are received. An error
frame is a frame that violates the Fibre Channel Protocol.

Discarded Frame Rate (count/s)
The average number of frames per second that are discarded because host
buffers are unavailable for the port.

Link Failure Rate (count/s)
The average number of link errors per second.

CRC Error Rate (count/s)
The average number of frames per second that are received in which a
cyclic redundancy check (CRC) error is detected. A CRC error is detected
when the CRC in the transmitted frame does not match the CRC computed
by the receiver.

Discarded Class 3 Frame Rate (count/s)
The average number of class 3 frames per second that are discarded.

Invalid Transmission Word Rate (count/s)
The average number of bit errors per second that are detected.

Related reports

To open the related report, click the name of the switch, click Go To, and then click
Most Active Switch Ports Report.
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Related tasks:
“Running the Switch Port Performance Details Report” on page 1174
To see information about the performance of a switch port, run the Switch Port
Performance Details Report.

Storage virtualizer reports
Storage virtualizer reports show the most active storage virtualizers, and the most
active storage resources on storage virtualizers.

Running the Storage Virtualizers - Most Active IO Groups
Report
To see which I/O groups are most active on your storage virtualizers, run the
Storage Virtualizers - Most Active IO Groups Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizers - Most Active IO Groups Report.
4. Optional: Select a storage virtualizer, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizers - Most Active IO Groups Report”
The Storage Virtualizers - Most Active IO Groups Report shows the performance
statistics for the most active I/O groups on storage virtualizers. Use the report to
monitor the performance of I/O groups over a specified period.

Storage Virtualizers - Most Active IO Groups Report
The Storage Virtualizers - Most Active IO Groups Report shows the performance
statistics for the most active I/O groups on storage virtualizers. Use the report to
monitor the performance of I/O groups over a specified period.

Charts

The chart shows the most active I/O groups on storage virtualizers. By default,
I/O groups are sorted by the total overall I/O rate.
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Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided for I/O groups is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer I/O Group Name
The name that was assigned to the I/O group on a storage virtualizer
when it was added to the system.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Total Normal I/O Rate (ops/s)
The average number of nonsequential I/O operations per second. This
value includes both read and write operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Processor Utilization Percentage
The average percentage of time that the processors are busy.

Related reports

To open related reports, click the name of the resource or storage device, click Go
To, and then click the name of the report. You can open the following related
reports:
v Storage Virtualizer - Details Report
v Storage Virtualizer - IO Group Details Report
Related tasks:
“Running the Storage Virtualizers - Most Active IO Groups Report” on page 1177
To see which I/O groups are most active on your storage virtualizers, run the
Storage Virtualizers - Most Active IO Groups Report.

Running the Storage Virtualizers - Most Active MDisks Report
To see which managed disks (MDisks) are most active on your storage virtualizers,
run the Storage Virtualizers - Most Active MDisks Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizers - Most Active MDisks Report.
4. Optional: Select a storage virtualizer, and then select a sort order.
5. Optional: Select an interval.

1178 IBM Tivoli Storage Productivity Center: User's Guide



6. Optional: To limit the time frame of the report, specify a date filter or a date
range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizers - Most Active MDisks Report”
The Storage Virtualizers - Most Active MDisks Report shows the performance
statistics for the most active managed disks (MDisks) on storage virtualizers. Use
the report to monitor the performance of MDisks over a specified period.

Storage Virtualizers - Most Active MDisks Report
The Storage Virtualizers - Most Active MDisks Report shows the performance
statistics for the most active managed disks (MDisks) on storage virtualizers. Use
the report to monitor the performance of MDisks over a specified period.

Charts

The chart shows the most active MDisks on storage virtualizers. By default,
MDisks are sorted by the total back-end I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided for MDisks is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer MDisk Name
The name that was assigned to the managed disk on a storage virtualizer
when it was added to the system.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
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storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Related reports

To open related reports, click the name of the resource or device, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage Virtualizer - Details Report
v Storage Virtualizer - Pool Details Report
v Storage Virtualizer - MDisk Details Report
v Storage Resource Relationships Summary Report
Related tasks:
“Running the Storage Virtualizers - Most Active MDisks Report” on page 1178
To see which managed disks (MDisks) are most active on your storage virtualizers,
run the Storage Virtualizers - Most Active MDisks Report.

Running the Storage Virtualizers - Most Active Nodes Report
To see which nodes are most active on your storage virtualizers, run the Storage
Virtualizers - Most Active Nodes Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizers - Most Active Nodes Report.
4. Optional: Select a storage virtualizer, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
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Related reference:
“Storage Virtualizers - Most Active Nodes Report”
The Storage Virtualizers - Most Active Nodes Report shows the performance
statistics for the most active nodes on storage virtualizers. Use the report to
monitor the performance of nodes over a specified period.

Storage Virtualizers - Most Active Nodes Report
The Storage Virtualizers - Most Active Nodes Report shows the performance
statistics for the most active nodes on storage virtualizers. Use the report to
monitor the performance of nodes over a specified period.

Charts

The chart shows the most active nodes on storage virtualizers. By default, nodes
are sorted by the total overall I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided for nodes is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer I/O Group Name
The name that was assigned to the I/O group on a storage virtualizer
when it was added to the system.

Storage Virtualizer Node Name
The name that was assigned to the storage virtualizer node when it was
added to the system.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Processor Utilization Percentage
The average percentage of time that the processors are busy.

Related reports

To open related reports, click the name of the resource or device, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage Virtualizer - Details Report
v Storage Virtualizer - IO Group Details Report
v Storage Virtualizer - Node Details Report
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Related tasks:
“Running the Storage Virtualizers - Most Active Nodes Report” on page 1180
To see which nodes are most active on your storage virtualizers, run the Storage
Virtualizers - Most Active Nodes Report.

Running the Storage Virtualizers - Most Active Pools Report
To see which pools are most active on your storage virtualizers, run the Storage
Virtualizers - Most Active Pools Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizers - Most Active Pools Report.
4. Optional: Select a storage virtualizer, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizers - Most Active Pools Report”
The Storage Virtualizers - Most Active Pools Report shows the performance
statistics for the most active pools on storage virtualizers. Use the report to
monitor the performance of pools over a specified period.

Storage Virtualizers - Most Active Pools Report
The Storage Virtualizers - Most Active Pools Report shows the performance
statistics for the most active pools on storage virtualizers. Use the report to
monitor the performance of pools over a specified period.

Charts

The chart shows the most active pools on storage virtualizers. By default, pools are
sorted by the total overall I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided for pools is as follows:
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Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Related reports

To open related reports, click the name of the resource or device, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage Virtualizer - Details Report
v Storage Virtualizer - Pool Details Report
v Storage Virtualizers - Most Active MDisks Report
v Storage Virtualizers - Most Active Volumes Report
v Storage Resource Relationships Summary Report
Related tasks:
“Running the Storage Virtualizers - Most Active Pools Report” on page 1182
To see which pools are most active on your storage virtualizers, run the Storage
Virtualizers - Most Active Pools Report.

Running the Storage Virtualizers - Most Active Volumes Report
To see which volumes are most active on storage virtualizers, run the Storage
Virtualizers - Most Active Volumes Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizers - Most Active Volumes Report.
4. Optional: Select a storage virtualizer, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.
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7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizers - Most Active Volumes Report”
The Storage Virtualizers - Most Active Volumes Report shows the performance
statistics for the most active volumes on storage virtualizers. Use the report to
monitor the performance of volumes over a specified period.

Storage Virtualizers - Most Active Volumes Report
The Storage Virtualizers - Most Active Volumes Report shows the performance
statistics for the most active volumes on storage virtualizers. Use the report to
monitor the performance of volumes over a specified period.

Charts

The chart shows the most active volumes on storage virtualizers. By default,
volumes are sorted by the total overall I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided for volumes is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer I/O Group Name
The name that was assigned to the I/O group on a storage virtualizer
when it was added to the system.

Storage Virtualizer Volume Name
The name that was assigned to the storage virtualizer volume when it was
added to the system.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Volume Utilization
The average percentage of time that the volume is busy.
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Related reports

To open related reports, click the name of the resource or device, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage Virtualizer - Details Report
v Storage Virtualizer - Pool Details Report
v Storage Virtualizer - IO Group Details Report
v Storage Virtualizer - Volume Details Report
v Storage Resource Relationships Summary Report
Related tasks:
“Running the Storage Virtualizers - Most Active Volumes Report” on page 1183
To see which volumes are most active on storage virtualizers, run the Storage
Virtualizers - Most Active Volumes Report.

Running the Storage Virtualizers - Most Active Ports Report
To see which ports are most active on your storage virtualizers, run the Storage
Virtualizers - Most Active Ports Report.

To run the report with the default settings, click Finish.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizers - Most Active Ports Report.
4. Optional: Select a storage virtualizer, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizers - Most Active Ports Report”
The Storage Virtualizers - Most Active Ports Report shows the performance
statistics for the most active ports on storage virtualizers. Use the report to monitor
the performance of ports over a specified period.

Storage Virtualizers - Most Active Ports Report
The Storage Virtualizers - Most Active Ports Report shows the performance
statistics for the most active ports on storage virtualizers. Use the report to monitor
the performance of ports over a specified period.
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Charts

The chart shows the most active ports on storage virtualizers. By default, ports are
sorted by the total port I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided for ports is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Port Name
An alphanumeric string that identifies a storage virtualizer port.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Related reports

To open related reports, click the name of the resource or device, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage Virtualizer - Details Report
v Storage Virtualizer - Port Details Report
Related tasks:
“Running the Storage Virtualizers - Most Active Ports Report” on page 1185
To see which ports are most active on your storage virtualizers, run the Storage
Virtualizers - Most Active Ports Report.

Storage virtualizer performance details reports
Storage virtualizer reports about performance details show information about the
performance of storage virtualizers, and information about the performance of the
resources related to storage virtualizers.

Running the Storage Virtualizer - Details Report
To see information about the performance of storage virtualizers, run the Storage
Virtualizer - Details Report.

To run the report, you must select a storage virtualizer.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer Performance Details Report.
4. Select a storage virtualizer.
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5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizer - Details Report”
The Storage Virtualizer - Details Report shows the performance statistics for a
storage virtualizer. Use the report to monitor the performance of a storage
virtualizer over a specified period.

Storage Virtualizer - Details Report
The Storage Virtualizer - Details Report shows the performance statistics for a
storage virtualizer. Use the report to monitor the performance of a storage
virtualizer over a specified period.

Charts

The charts show the following performance statistics for the storage virtualizer:
v Total overall rates for I/O operations, and the total overall response times
v The overall I/O rates for read and write operations, and the response times for

read and write operations
v The data rates for read and write operations, and the total data rates
v The overall cache hit percentage for read operations, the cache delay percentage

for write operations, and the utilization percentage for processors

Report output

The information that is provided for a storage virtualizer is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.
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Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Processor Utilization Percentage
The average percentage of time that the processors are busy.

Related reports

To open related reports, click the name of the storage virtualizer, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage Virtualizers - Most Active IO Groups Report
v Storage Virtualizers - Most Active MDisks Report
v Storage Virtualizers - Most Active Nodes Report
v Storage Virtualizers - Most Active Pools Report
v Storage Virtualizers - Most Active Ports Report
v Storage Virtualizers - Most Active Volumes Report
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Related tasks:
“Running the Storage Virtualizer - Details Report” on page 1186
To see information about the performance of storage virtualizers, run the Storage
Virtualizer - Details Report.

Running the Storage Virtualizer - IO Group Details Report
To see information about the performance of an I/O group on a storage virtualizer,
run the Storage Virtualizer - IO Group Details Report.

To run the report, you must select a storage virtualizer and an I/O group.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer - IO Group Details Report.
4. Select a storage virtualizer, and then select an I/O group.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizer - IO Group Details Report”
The Storage Virtualizer - IO Group Details Report shows the performance
statistics for an I/O group on a storage virtualizer. Use the report to monitor the
performance of an I/O group over a specified period.

Storage Virtualizer - IO Group Details Report
The Storage Virtualizer - IO Group Details Report shows the performance
statistics for an I/O group on a storage virtualizer. Use the report to monitor the
performance of an I/O group over a specified period.

Charts

The charts show the following performance statistics for an I/O group on a storage
virtualizer:
v The total overall I/O rates, and the total response times
v The overall I/O rates for read and write operations, and the response times for

read and write operations
v The data rates for read and write operations, and the total data rates
v The overall cache hit percentage for read operations, the cache delay percentage

for write operations, and the utilization percentage for processors

Report output

The information that is provided for an I/O group is as follows:
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Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer I/O Group Name
The name that was assigned to the I/O group on a storage virtualizer
when it was added to the system.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Processor Utilization Percentage
The average percentage of time that the processors are busy.
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Related reports

To open related reports, click the name of the storage virtualizer, click Go To, and
then click Storage Virtualizers - Most Active IO Groups Report.
Related tasks:
“Running the Storage Virtualizer - IO Group Details Report” on page 1189
To see information about the performance of an I/O group on a storage virtualizer,
run the Storage Virtualizer - IO Group Details Report.

Running the Storage Virtualizer - MDisk Details Report
To see information about the performance of a managed disk (MDisk) on a storage
virtualizer, run the Storage Virtualizer - MDisk Details Report.

To run the report, you must select a storage virtualizer and an MDisk.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer - MDisk Details Report.
4. Select a storage virtualizer, and then select an MDisk.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizer - MDisk Details Report”
The Storage Virtualizer - MDisk Details Report shows the performance statistics
for a managed disk (MDisk) on a storage virtualizer. Use the report to monitor the
performance of an MDisk over a specified period.

Storage Virtualizer - MDisk Details Report
The Storage Virtualizer - MDisk Details Report shows the performance statistics
for a managed disk (MDisk) on a storage virtualizer. Use the report to monitor the
performance of an MDisk over a specified period.

Charts

The charts show the following performance statistics for an MDisk on a storage
virtualizer:
v The total I/O rates for back-end operations, and the total response times for

back-end operations
v The I/O rates for read and write back-end operations, and the response times

for read and write back-end operations
v The total data rates for back-end operations, and the data rates for read and

write back-end operations
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v The overall queue times for back-end operations, and the queue times for read
and write back-end operations

Report output

The information that is provided for an MDisk is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer MDisk Name
The name that was assigned to the managed disk on a storage virtualizer
when it was added to the system.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Read Data Rate (MiB/s)
The average number of MiB per second that are read from the back-end
storage resources.
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Back-End Write Data Rate (MiB/s)
The average number of MiB per second that are written to the back-end
storage resources.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Back-End Read Queue Time (ms/op)
The average number of milliseconds that a read operation spends in the
queue before being sent to the back-end storage resources.

Back-End Write Queue Time (ms/op)
The average number of milliseconds that write operations spend in the
queue before being sent to the back-end storage resources.

Overall Back-End Queue Time (ms/op)
The average number of milliseconds that a read or a write operation
spends in the queue before being sent to the back-end storage resources.

Related reports

To open related reports, click the name of the storage virtualizer, click Go To, and
then click Storage Virtualizers - Most Active MDisks Report.
Related tasks:
“Running the Storage Virtualizer - MDisk Details Report” on page 1191
To see information about the performance of a managed disk (MDisk) on a storage
virtualizer, run the Storage Virtualizer - MDisk Details Report.

Running the Storage Virtualizer - Node Details Report
To see information about the performance of a node on a storage virtualizer, run
the Storage Virtualizer - Node Details Report.

To run the report, you must select a storage virtualizer and a node.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer - Node Details Report.
4. Select a storage virtualizer, and then select a node.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
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Related reference:
“Storage Virtualizer - Node Details Report”
The Storage Virtualizer - Node Details Report shows the performance statistics for
a node on a storage virtualizer. Use the report to monitor the performance of a
node over a specified period.

Storage Virtualizer - Node Details Report
The Storage Virtualizer - Node Details Report shows the performance statistics for
a node on a storage virtualizer. Use the report to monitor the performance of a
node over a specified period.

Charts

The charts show the following performance statistics for a node on a storage
virtualizer:
v The total overall I/O rates, and the total response times
v The overall I/O rates for read and write operations, the response times for read

and write operations
v The data rates for read and write operations, and the total data rates
v The overall cache hit percentage for read operations, the cache delay percentage

for write operations, and the utilization percentage for processors

Report output

The information that is provided for a node is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer I/O Group Name
The name that was assigned to the I/O group on a storage virtualizer
when it was added to the system.

Storage Virtualizer I/O Group Name
To be provided.

Storage Virtualizer Node Name
The name that was assigned to the storage virtualizer node when it was
added to the system.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.
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Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Processor Utilization Percentage
The average percentage of time that the processors are busy.

Related reports

To open related reports, click the name of the storage virtualizer, click Go To, and
then click Storage Virtualizers - Most Active Nodes Report.
Related tasks:
“Running the Storage Virtualizer - Node Details Report” on page 1193
To see information about the performance of a node on a storage virtualizer, run
the Storage Virtualizer - Node Details Report.

Running the Storage Virtualizer - Pool Details Report
To see information about the performance of a pool on a storage virtualizer, run
the Storage Virtualizer - Pool Details Report.

To run the report, you must select a storage virtualizer and a pool.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer - Pool Details Report.
4. Select a storage virtualizer, and then select a pool.
5. Optional: Select an interval.
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6. Optional: To limit the time frame of the report, specify a date filter or a date
range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizer - Pool Details Report”
The Storage Virtualizer - Pool Details Report shows the performance statistics for
a pool on a storage virtualizer. Use the report to monitor the performance of a pool
over a specified period.

Storage Virtualizer - Pool Details Report
The Storage Virtualizer - Pool Details Report shows the performance statistics for
a pool on a storage virtualizer. Use the report to monitor the performance of a pool
over a specified period.

Charts

The charts show the following performance statistics for a pool on a storage
virtulalizer:
v The total overall rates for I/O operations, and the total response times
v The overall I/O rates for read and write operations, and the response times for

read and write operations
v The total I/O rates for back-end operations, and overall response times for

back-end operations
v The I/O rates for back-end read operations and back-end write operations, and

the response rates for back-end read and back-end write operations

Report output

The information that is provided for a pool is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.
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Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Related reports

To open related reports, click the name of the storage virtualizer, click Go To, and
then click Storage Virtualizers - Most Active Pools Report.

Chapter 9. Reporting in the web-based GUI 1197



Related tasks:
“Running the Storage Virtualizer - Pool Details Report” on page 1195
To see information about the performance of a pool on a storage virtualizer, run
the Storage Virtualizer - Pool Details Report.

Running the Storage Virtualizer - Volume Details Report
To see information about the performance of a volume on a storage virtualizer, run
the Storage Virtualizer - Volume Details Report.

To run the report, you must select a storage virtualizer and a volume.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer - Volume Details Report.
4. Select a storage virtualizer.
5. Select a volume.

a. Type a keyword. For example, type lun, to find the names of volumes that
start with lun. To change the default search option, click Options.

Tip: Use the percent symbol (%) as a wildcard. For example, type a% to find
volume names that begin with ’a’ or ’A’. Type %a to find volume names that
begin with or contain the letter ’a’ or ’A’. You can type % to retrieve all of
the volumes on a resource.

b. Click Search. If the search is successful, the names of the volumes are
displayed in the Choice list.

c. From the list, select a volume.
6. Optional: Select an interval.
7. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

8. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizer - Volume Details Report”
The Storage Virtualizer - Volume Details Report shows the performance statistics
of a volume on a storage virtualizer. Use the report to monitor the performance of
a volume over a specified period.

Storage Virtualizer - Volume Details Report
The Storage Virtualizer - Volume Details Report shows the performance statistics
of a volume on a storage virtualizer. Use the report to monitor the performance of
a volume over a specified period.

Charts

The charts show the following performance statistics for a volume on a storage
virtualizer:
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v The total overall rates for I/O operations, and the total response times
v The overall rates for I/O read operations, the overall rates for I/O write

operations, the response times for read operations, and the response times for
write operations

v The data rates for read operations, the data rates for write operations, and the
total data rates

v The overall cache hit percentage for read operations, the cache delay percentage
for write operations, and the utilization percentage for volumes

Report output

The information that is provided for a volume is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer Volume Name
The name that was assigned to the storage virtualizer volume when it was
added to the system.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.
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Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Volume Utilization
The average percentage of time that the volume is busy.

Related reports

To open related reports, click the name of the storage virtualizer, click Go To, and
then click Storage Virtualizers - Most Active Volumes Report.
Related tasks:
“Running the Storage Virtualizer - Volume Details Report” on page 1198
To see information about the performance of a volume on a storage virtualizer, run
the Storage Virtualizer - Volume Details Report.

Running the Storage Virtualizer - Port Details Report
To see information about the performance of a port on a storage virtualizer, run
the Storage Virtualizer - Port Details Report.

To run the report, you must select a storage virtualizer and a port.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer - Port Details Report.
4. Select a storage virtualizer, and then select a port.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
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Related reference:
“Storage Virtualizer - Port Details Report”
The Storage Virtualizer - Port Details Report shows the performance statistics for a
port on a storage virtualizer. Use the report to monitor the performance of a port
over a specified period.

Storage Virtualizer - Port Details Report
The Storage Virtualizer - Port Details Report shows the performance statistics for a
port on a storage virtualizer. Use the report to monitor the performance of a port
over a specified period.

Charts

The charts show the following performance statistics for a port on a storage
virtualizer:
v The total I/O rates
v The send I/O rates for ports, and the receive I/O rates for ports
v The send data rates for ports, the receive data rates for ports, and the total data

rates for ports
v The overall bandwidth percentage for ports

Report output

The information that is provided for ports is as follows:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Port Name
An alphanumeric string that identifies a storage virtualizer port.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Port Send I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
data is sent from a port.

Port Receive I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
the port receives data.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.
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Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Related reports

To open related reports, click the name of the storage virtualizer, click Go To, and
then click Storage Virtualizers - Most Active Ports Report.
Related tasks:
“Running the Storage Virtualizer - Port Details Report” on page 1200
To see information about the performance of a port on a storage virtualizer, run
the Storage Virtualizer - Port Details Report.

Storage system reports
Storage system reports show the most active storage systems, and the most active
storage resources on storage systems.

Running the Storage Systems - Most Active Report
To see which storage systems are the most active, run the Storage Systems - Most
Active Report.

To run the report with the default settings, click Finish. By default all of the
storage systems are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage Systems - Most Active Report.
4. Select a storage system, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
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Related reference:
“Storage Systems - Most Active Report”
The Storage Systems - Most Active Report shows the performance statistics for the
most active storage systems. Use the report to monitor the performance of storage
systems over a specified period.

Storage Systems - Most Active Report
The Storage Systems - Most Active Report shows the performance statistics for the
most active storage systems. Use the report to monitor the performance of storage
systems over a specified period.

Charts

The bar chart shows the most active storage systems. By default, storage systems
are sorted by the total I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided about the most active storage systems is as
follows:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Related reports

To open related reports, click the name of the storage system, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage System - Details Report
v Storage Systems - Most Active Volumes Report
v Storage Systems - Most Active Ports Report
v Storage Systems - Most Active Arrays Report
v Storage Systems - Most Active Controllers or Modules Report
v Storage Resource Relationships Summary Report
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Related tasks:
“Running the Storage Systems - Most Active Report” on page 1202
To see which storage systems are the most active, run the Storage Systems - Most
Active Report.

Running the Storage Systems - Most Active Arrays Report
To see which arrays are most active on DS6000 series, DS8000 series, and IBM
Enterprise Storage Server storage systems, run the Storage Systems - Most Active
Arrays Report.

To run the report with the default settings, click Finish. By default all of the
storage systems are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage Systems - Most Active Arrays Report.
4. Select a storage system, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Systems - Most Active Arrays Report”
The Storage Systems - Most Active Arrays Report shows the performance statistics
for the most active arrays on DS6000 series, DS8000 series, and IBM Enterprise
Storage Server storage systems. Use the report to monitor the performance of
arrays over a specified period.

Storage Systems - Most Active Arrays Report
The Storage Systems - Most Active Arrays Report shows the performance statistics
for the most active arrays on DS6000 series, DS8000 series, and IBM Enterprise
Storage Server storage systems. Use the report to monitor the performance of
arrays over a specified period.

Charts

The bar chart shows the most active arrays on DS6000 series, DS8000 series, and
IBM Enterprise Storage Server storage systems. By default, arrays are sorted by the
I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.
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Report output

The information that is provided about the most active arrays is as follows:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage System Controller Name
The name that was assigned to the controller when it was added to the
system.

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Storage System Array Name
The name that was assigned to the array when it was added to the system.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Disk Utilization Percentage
The average percentage of time that the disks that are associated with an
array are busy.

No value is calculated for this column if there are multiple ranks in the
extent pool where the thin-provisioned volumes are allocated. In this case,
N/A appears in this column. This limitation applies only to DS8000 storage
systems.

If there is only a single rank in the extent pool, the value for this column is
calculated regardless of the thin-provisioned volumes.

Related reports

To open related reports, click the name of the resource or device, click Go To, and
then click the name of the report. You can open the following related reports:
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v Storage System - Details Report
v Storage System - Controller or Module Details Report
v Storage System - Array Details Report
Related tasks:
“Running the Storage Systems - Most Active Arrays Report” on page 1204
To see which arrays are most active on DS6000 series, DS8000 series, and IBM
Enterprise Storage Server storage systems, run the Storage Systems - Most Active
Arrays Report.

Running the Storage Systems - Most Active Controllers or
Modules Report
To see which controllers or modules are most active on storage systems, run the
Storage Systems - Most Active Controllers or Modules Report.

To run the report with the default settings, click Finish. By default all of the
storage systems are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage Systems - Most Active Controllers or Modules Report.
4. Select a storage system, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Systems - Most Active Controllers or Modules Report”
The Storage Systems - Most Active Controllers or Modules Report shows the
performance statistics for the most active controllers or modules on storage
systems. Use the report to monitor the performance of controllers or modules over
a specified period.

Storage Systems - Most Active Controllers or Modules Report
The Storage Systems - Most Active Controllers or Modules Report shows the
performance statistics for the most active controllers or modules on storage
systems. Use the report to monitor the performance of controllers or modules over
a specified period.
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Charts

The bar chart shows the most active controllers or modules on storage systems. By
default, controllers or modules are sorted by the overall I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided about the most active controllers or modules is as
follows:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage System Controller or Module Name
The name that was assigned to the controller or module when it was
added to the system.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Related reports

To open related reports, click the name of the resource or device, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage System - Details Report
v Storage System - Controller or Module Details Report
Related tasks:
“Running the Storage Systems - Most Active Controllers or Modules Report” on
page 1206
To see which controllers or modules are most active on storage systems, run the
Storage Systems - Most Active Controllers or Modules Report.

Running the Storage Systems - Most Active Pools Report
To see which pools are most active on storage systems, run the Storage
Systems - Most Active Pools Report.

To run the report with the default settings, click Finish.
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Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage Systems - Most Active Pools Report.
4. Select a storage system, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Systems - Most Active Pools Report”
The Storage Systems - Most Active Pools Report shows the performance statistics
for the most active pools on storage systems. Use the report to monitor the
performance of pools over a specified period.

Storage Systems - Most Active Pools Report
The Storage Systems - Most Active Pools Report shows the performance statistics
for the most active pools on storage systems. Use the report to monitor the
performance of pools over a specified period.

Charts

The bar chart shows the most active pools on storage systems. By default, pools
are sorted by the I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided about the most active pools is as follows:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.
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Related reports

To open related reports, click the name of the resource or device, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage System - Details Report
v Storage Systems - Most Active Volumes Report
v Storage Systems - Most Active Arrays Report
v Storage Resource Relationships Summary Report
Related tasks:
“Running the Storage Systems - Most Active Pools Report” on page 1207
To see which pools are most active on storage systems, run the Storage
Systems - Most Active Pools Report.

Running the Storage Systems - Most Active Volumes Report
To see which volumes are most active on storage systems, run the Storage
Systems - Most Active Volumes Report.

To run the report with the default settings, click Finish. By default all of the
storage systems are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage Systems - Most Active Volumes Report.
4. Select a storage system, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Systems - Most Active Volumes Report”
The Storage Systems - Most Active Volumes Report shows the performance
statistics for the most active volumes on storage systems. Use the report to monitor
the performance of volumes over a specified period.

Storage Systems - Most Active Volumes Report
The Storage Systems - Most Active Volumes Report shows the performance
statistics for the most active volumes on storage systems. Use the report to monitor
the performance of volumes over a specified period.
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Charts

The bar chart shows the most active volumes on storage systems. By default,
volumes are sorted by the I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided about the most active volumes is as follows:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Volume Name
The name that was assigned to the storage volume when it was added to
the system.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Volume Utilization
The average percentage of time that the volume is busy.

Related reports

To open related reports, click the name of the storage system, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage System - Details Report
v Storage System - Volume Details Report
v Storage Resource Relationships Summary Report
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Related tasks:
“Running the Storage Systems - Most Active Volumes Report” on page 1209
To see which volumes are most active on storage systems, run the Storage
Systems - Most Active Volumes Report.

Running the Storage Systems - Most Active Ports Report
To see which ports are most active on storage systems, run the Storage
Systems - Most Active Ports Report.

To run the report with the default settings, click Finish. By default all of the
storage systems are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage Systems - Most Active Ports Report.
4. Select a storage system, and then select a sort order.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Systems - Most Active Ports Report”
The Storage Systems - Most Active Ports Report shows the performance statistics
for the most active ports on storage systems. Use the report to monitor the
performance of ports over a specified period.

Storage Systems - Most Active Ports Report
The Storage Systems - Most Active Ports Report shows the performance statistics
for the most active ports on storage systems. Use the report to monitor the
performance of ports over a specified period.

Charts

The bar chart shows the most active ports on storage systems. By default, ports are
sorted by the I/O rate.

Tip: To change the sort order, select a value from the Sort Order list.

Report output

The information that is provided about the most active ports is as follows:
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Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage System FC Port
The number of the fibre channel (FC) port on the storage system.

Overall Port Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Related reports

To open related reports, click the name of the resource or device, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage System - Details Report
v Storage System - Port Details Report
Related tasks:
“Running the Storage Systems - Most Active Ports Report” on page 1211
To see which ports are most active on storage systems, run the Storage
Systems - Most Active Ports Report.

Storage system performance details reports
Storage system reports about performance details show information about the
performance of storage systems, and information about the performance of the
resources related to storage systems.

Running the Storage System - Details Report
To see performance statistics for a storage system, run the Storage System - Details
Report.

To run the report, you must select a storage system.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage System - Details Report..
4. Select a storage system.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.
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Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage System - Details Report”
The Storage System - Details Report shows the performance statistics for a storage
system. Use the report to monitor the performance of a storage system over a
specified period.

Storage System - Details Report
The Storage System - Details Report shows the performance statistics for a storage
system. Use the report to monitor the performance of a storage system over a
specified period.

Charts

The charts show the following performance statistics for a storage system:
v The total I/O rates, and the total response times
v The read I/O rates, write I/O rates, and response times
v The read data rates, and the write data rates
v The read cache hit percentages, and the write cache hit percentages

Report output

The information that is provided about the storage system is as follows:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.
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Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Related reports

To open related reports, click the name of the storage system, click Go To, and
then click the name of the report. You can open the following related reports:
v Storage Systems - Most Active Ports Report
v Storage Systems - Most Active Arrays Report
v Storage Systems - Most Active Pools Report
v Storage Systems - Most Active Controllers or Modules Report
Related tasks:
“Running the Storage System - Details Report” on page 1212
To see performance statistics for a storage system, run the Storage System - Details
Report.

Running the Storage System - Array Details Report
To see performance statistics for an array on DS6000 series, DS8000 series, and IBM
Enterprise Storage Server storage systems, run the Storage System - Array Details
Report.

To run the report, you must select a storage system and an array.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage System - Array Details Report.
4. Select a storage system, and then select an array.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.
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Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage System - Array Details Report”
The Storage System - Array Details Report shows the performance statistics for
arrays on DS6000 series, DS8000 series, and IBM Enterprise Storage Server storage
systems. Use the report to monitor the performance of an array over a specified
period.

Storage System - Array Details Report
The Storage System - Array Details Report shows the performance statistics for
arrays on DS6000 series, DS8000 series, and IBM Enterprise Storage Server storage
systems. Use the report to monitor the performance of an array over a specified
period.

Charts

The charts show the following performance statistics for arrays on storage systems:
v The total I/O rates, and the total response times
v The read I/O rates, the write I/O rates, the read response times, and the write

response times
v The back-end I/O rates, and the back-end I/O response times
v The back-end read I/O rates, the back-end write I/O rates, the read response

times, and the write response times

Report output

The information that is provided about the array is as follows:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage System Controller Name
The name that was assigned to the controller when it was added to the
system.

Storage System Array Name
The name that was assigned to the array when it was added to the system.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.
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Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Disk Utilization Percentage
The average percentage of time that the disks that are associated with an
array are busy.

No value is calculated for this column if there are multiple ranks in the
extent pool where the thin-provisioned volumes are allocated. In this case,
N/A appears in this column. This limitation applies only to DS8000 storage
systems.

If there is only a single rank in the extent pool, the value for this column is
calculated regardless of the thin-provisioned volumes.
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Related reports

To open related reports, click the name of the storage system, click Go To, and
then click Storage Systems - Most Active Arrays Report.
Related tasks:
“Running the Storage System - Array Details Report” on page 1214
To see performance statistics for an array on DS6000 series, DS8000 series, and IBM
Enterprise Storage Server storage systems, run the Storage System - Array Details
Report.

Running the Storage System - Controller or Module Details
Report
To see performance statistics for controllers or modules on a storage system, run
the Storage System - Controller or Module Details Report.

To run the report, you must select a storage system and a controller or module.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage System - Controller or Module Details Report.
4. Select a storage system, and then select a controller or module.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage System - Controller or Module Details Report”
The Storage System - Controller or Module Details Report shows the performance
statistics for controllers or modules on a storage system. Use the report to monitor
the performance of a controller or an array over a specified period.

Storage System - Controller or Module Details Report
The Storage System - Controller or Module Details Report shows the performance
statistics for controllers or modules on a storage system. Use the report to monitor
the performance of a controller or an array over a specified period.

Charts

The charts show the following performance statistics for each controller or module
on a storage system:
v The total I/O rates, and the total response times
v The read I/O rates, the write I/O rates, and the response times
v The read data rates, and the write data rates
v The read cache hit percentages, and the write cache hit percentages
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Report output

The information that is provided about the controller or module is as follows:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage System Controller Name or Module Name
The name that was assigned to the controller or module when it was
added to the system.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.
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Related reports

To open the related report, click the name of the storage system, click Go To, and
then click Storage Systems - Most Active Controllers or Modules Report.
Related tasks:
“Running the Storage System - Controller or Module Details Report” on page 1217
To see performance statistics for controllers or modules on a storage system, run
the Storage System - Controller or Module Details Report.

Running the Storage System - Volume Details Report
To see performance statistics for volumes on a storage system, run the Storage
System - Volume Details Report.

To run the report, you must select a storage system and a volume.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage System - Volume Details Report.
4. Select a storage system.
5. Select a volume.

a. Type a keyword. For example, type lun, to find the names of volumes that
start with lun. To change the default search option, click Options.

Tip: Use the percent symbol (%) as a wildcard. For example, type a% to find
volume names that begin with ’a’ or ’A’. Type %a to find volume names that
begin with or contain the letter ’a’ or ’A’. You can type % to retrieve all of
the volumes on a resource.

b. Click Search. If the search is successful, the names of the volumes are
displayed in the Choice list.

c. From the list, select a volume.
6. Optional: Select an interval.
7. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

8. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage System - Volume Details Report”
The Storage System - Volume Details Report shows the performance statistics for a
volume on a storage system. Use the report to monitor the performance of a
volume over a specified period.

Storage System - Volume Details Report
The Storage System - Volume Details Report shows the performance statistics for a
volume on a storage system. Use the report to monitor the performance of a
volume over a specified period.
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Charts

The charts show the following performance statistics for a volume on a storage
system:
v The total I/O rates, and the total response times
v The read I/O rates, the write I/O rates, the read response times, and the write

response times
v The read data rates, and the write date rates
v The read cache percentages, the write cache percentages, and the volume

utilization percentages

Report output

The information that is provided about the volume is as follows:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Volume Name
The name that was assigned to the storage volume when it was added to
the system.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

1220 IBM Tivoli Storage Productivity Center: User's Guide



Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Volume Utilization
The average percentage of time that the volume is busy.

Related reports

To open related reports, click the name of the storage system, click Go To, and
then click Storage Systems - Most Active Volumes Report.
Related tasks:
“Running the Storage System - Volume Details Report” on page 1219
To see performance statistics for volumes on a storage system, run the Storage
System - Volume Details Report.

Running the Storage System - Port Details Report
To see performance statistics for a port on a storage system, run the Storage
System - Port Details Report.

To run the report, you must select a storage system and a port.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Performance.
2. Open the Storage System folder.
3. Click Storage System - Port Details Report.
4. Select a storage system, and then select a port.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
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Related reference:
“Storage System - Port Details Report”
The Storage System - Port Details Report shows the performance statistics for a
port on a storage system. Use the report to monitor the performance of a port over
a specified period.

Storage System - Port Details Report
The Storage System - Port Details Report shows the performance statistics for a
port on a storage system. Use the report to monitor the performance of a port over
a specified period.

Charts

The charts show the following performance statistics for a port on a storage
system:
v The total I/O rates, and the total response times
v The read I/O rates, the write I/O rates, and the response times
v The read data rates, and the write data rates
v The send bandwidth percentages, and the receive bandwidth percentages

Report output

The information that is provided about the port is as follows:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage System Port Name
The name that was assigned to the storage port when the storage system
was added to the system.

Day or Hour or Sample
Depending on the interval that is selected to run the report, a row of
information about the specified resource or device is provided at hourly,
daily, or at a user-defined (sample) interval.

Port Send I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
data is sent from a port.

Port Receive I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
the port receives data.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Port Send Response Time (ms/op)
The average number of milliseconds to complete a send operation.

Port Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation.

Overall Port Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation.
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Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Port Send Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Port Receive Bandwidth Percentage
The percentage of the port bandwidth that is used for receive operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Related reports

To open related reports, click the name of the storage system, click Go To, and
then click Storage Systems - Most Active Ports Report the name of the report.
Related tasks:
“Running the Storage System - Port Details Report” on page 1221
To see performance statistics for a port on a storage system, run the Storage
System - Port Details Report.

Predefined reports about historical information
You can run predefined reports about historical information to monitor how space
is used on storage systems and storage virtualizers over a specified period.

You can run the following types of predefined report about historical information:
v Predefined reports that show how space is used on storage virtualizers and

related resources such as:
– Pools
– Volumes

v Predefined reports that show how space is used on storage systems such as:
– Pools
– Volumes

Tip: To learn more about reports, see frequently asked questions about reports in
the IBM Tivoli Storage Productivity Center Information Center
(http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/index.jsp).
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Running the Storage Virtualizers - Historical Space Report
To see how space on storage virtualizers is used, run the Storage
Virtualizers - Historical Space Report.

To run the report with the default settings, click Finish. By default all of the
storage virtualizers are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Historical

Information.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizers - Historical Space Report.
4. Optional: Select one or more storage virtualizers.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizers - Historical Space Report”
The Storage Virtualizers - Historical Space Report shows the usage of space on
storage virtualizers over a specified period. Use the report to determine whether
additional storage resources are required.

Storage Virtualizers - Historical Space Report
The Storage Virtualizers - Historical Space Report shows the usage of space on
storage virtualizers over a specified period. Use the report to determine whether
additional storage resources are required.

Charts

The chart shows the following space statistics for the storage virtualizers:
v The capacity of the pools on the storage virtualizers
v The used space in the pools on the storage virtualizers
v The available space in the pools on the storage virtualizers
v The capacity of the virtual volumes on the storage virtualizers
v The capacity of the managed disks (MDisks) on the storage virtualizers

Report output

The following information is included in reports for storage virtualizers:
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Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Date The date that the data was collected for the report.

Storage Virtualizer Total Pool Capacity (GiB)
The amount of storage space in pools on the storage virtualizer.

Storage Virtualizer Pool Used Space (GiB)
The amount of storage space that is used in the pool on the storage
virtualizer.

Storage Virtualizer Pool Available Space (GiB)
The amount of unused storage space in a storage virtualizer pool.

Storage Virtualizer Volume Allocated Space
The amount of storage space that is allocated to volumes.

Storage Virtualizer MDisk Capacity (GiB)
The amount of storage space on the managed disk.

Storage Virtualizer MDisk Available Space (GiB)
The amount of space on managed disks that is available to be added to a
pool.

Storage Virtualizer Total Volume Capacity (GiB)
The amount of virtual volume space on all volumes on the storage
virtualizer.

Storage Virtualizer Volume Assigned Space (GiB)
The amount of virtual volume space that is assigned to the server or
storage virtualizer.

Storage Virtualizer Disk Capacity (GiB)
The amount of local disk storage on the storage virtualizer.

Storage Virtualizer Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Storage Virtualizer Number of Volumes
The number of volumes in the storage virtualizer pool.

Storage Virtualizer Number of MDisks
The number of managed disks on a resource.

Related tasks:
“Running the Storage Virtualizers - Historical Space Report” on page 1224
To see how space on storage virtualizers is used, run the Storage
Virtualizers - Historical Space Report.

Running the Storage Virtualizer - Pools Historical Space
Report

To see how space in pools on a storage virtualizer is used, run the Storage
Virtualizer - Pools Historical Space Report.

You can see how space in a pool on a storage virtualizer, or in pools in a storage
resource group, are used.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Historical

Information.
2. Open the Storage Virtualizer folder.
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3. Click Storage Virtualizer - Pools Historical Space Report.
4. Required: Select the type of historical space report that you want to create.
5. Optional: You can filter the type of data that you want to see in a report. You

can select either of the following options:
v Of a Pool in a Storage Virtualizer

a. Click Next.
b. Select a storage virtualizer, and then select a pool.

v Of Pools in a Storage Resource Group

a. Click Next.
b. Select a storage resource group.

6. Optional: Select an interval.
7. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

8. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Virtualizer - Pools Historical Space Report”
The Storage Virtualizer - Pools Historical Space Report shows the usage of space
in a pool on a storage virtualizer, or of pools in a storage resource group over a
specified period. Use the report to determine whether additional storage resources
are required.

Storage Virtualizer - Pools Historical Space Report
The Storage Virtualizer - Pools Historical Space Report shows the usage of space
in a pool on a storage virtualizer, or of pools in a storage resource group over a
specified period. Use the report to determine whether additional storage resources
are required.

Charts

The chart shows the following space statistics for the pool on the storage
virtualizer:
v The capacity of the pool
v The used space in the pool
v The available space in the pool
v The virtual volume capacity of the pool
v The real volume capacity of the pool

The chart shows the following space statistics for the pools in the storage resource
group:
v The capacity of the pools
v The used space in the pools
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v The available space in the pools
v The virtual volume capacity of the pools
v The real volume capacity of the pools

Report output

The following information is included in reports for a pool on a storage virtualizer,
or for pools in a storage resource group:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Date The date that the data was collected for the report.

Storage Virtualizer Pool Capacity (GiB)
The amount of storage space in the pool on the storage virtualizer. For
SAN Volume Controller, this value represents the amount of managed disk
space that is assigned to the managed disk group.

Storage Virtualizer Pool Available Space (GiB)
The amount of unused storage space in a storage virtualizer pool.

Storage Virtualizer Pool Used Space (GiB)
The amount of storage space that is used in the pool on the storage
virtualizer.

Storage Virtualizer Pool Used Volume Space (GiB)
The amount of used space on all the volumes and volume copies in the
pool.

Storage Virtualizer Pool Real Volume Capacity (GiB)
The amount of space on all allocated extents in a pool. The allocated
extents include the used extents and extents that were assigned to volumes
when they were allocated.

Storage Virtualizer Pool Virtual Volume Capacity (GiB)
The amount of virtual volume space on all volumes in the pool.

Storage Virtualizer Pool Assigned Volume Space (GiB)
The amount of space in the pool that is on volumes that are assigned to a
server or storage virtualizer.

Storage Virtualizer Pool Unassigned Volume Space (GiB)
The amount of volume space in the pool that is not assigned to a server or
storage virtualizer.

Storage Virtualizer Pool Number of Storage Volumes
The number of volumes in the storage virtualizer pool.

Storage Virtualizer Pool Number of MDisks
The number of managed disks on a resource.
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Related tasks:
“Running the Storage Virtualizer - Pools Historical Space Report” on page 1225
To see how space in pools on a storage virtualizer is used, run the Storage
Virtualizer - Pools Historical Space Report.

Running the Storage Virtualizer - Volumes Historical Space
Report

To see how space on volumes on a storage virtualizer is used, run the Storage
Virtualizer - Volumes Historical Space Report

You can see how space on a volume on a storage virtualizer, or on volumes in a
storage resource group, are used.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Historical

Information.
2. Open the Storage Virtualizer folder.
3. Click Storage Virtualizer - Volumes Historical Space Report.
4. Required: Select the type of historical space report that you want to create.
5. Optional: You can filter the type of data that you want to see in a report. You

can select either of the following options:
v Of a Volume in a Storage Virtualizer

a. Click Next.
b. Select a storage virtualizer.
c. Type a keyword and click Search. For example, type lun, to find the

names of volumes that start with lun. To change the default search
option, click Options.

Tip: Use the percent symbol (%) as a wildcard. For example, type a% to
find volume names that begin with ’a’ or ’A’. Type %a to find volume
names that begin with or contain the letter ’a’ or ’A’. You can type % to
retrieve all of the volumes on a resource.

d. Select a volume.
v Of Volumes in a Storage Resource Group

a. Click Next.
b. Select a storage resource group.

6. Optional: Select an interval.
7. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

8. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
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Related reference:
“Storage Virtualizer - Volumes Historical Space Report”
The Storage Virtualizer - Volumes Historical Space Report shows the usage of
space on a volume on a storage virtualizer, or on volumes in a storage resource
group over a specified period. Use the report to determine whether additional
storage resources are required.

Storage Virtualizer - Volumes Historical Space Report
The Storage Virtualizer - Volumes Historical Space Report shows the usage of
space on a volume on a storage virtualizer, or on volumes in a storage resource
group over a specified period. Use the report to determine whether additional
storage resources are required.

Charts

The chart shows the following space statistics for the volume on the storage
virtualizer:
v The capacity of the volume
v The used space on the volume
v The real space on the volume

The chart shows the following space statistics for the volumes in the storage
resource group:
v The capacity of the volumes
v The used space on the volumes
v The real space on the volumes

If the volume is thin provisioned, the chart shows the total amount of virtual space
that is allocated to the volume, and the total amount of real space that is used by
the volume.

Report output

The following information is included in reports for a volume on a storage
virtualizer, or for volumes in a storage resource group:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer Volume Name
The name that was assigned to the storage virtualizer volume when it was
added to the system.

Date The date that the data was collected for the report.

Storage Virtualizer Volume Capacity (GiB)
The amount of storage space on the volume.

Storage Virtualizer Volume Overhead
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.
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Storage Virtualizer Volume Used Space (GiB)
The amount of virtual space that is used on a thin-provisioned volume. For
volumes that are not thin provisioned, this value is same as the Storage
Virtualizer Volume Capacity value.

Storage Virtualizer Volume Real Space (GiB)
The physical space for a thin-provisioned volume that was allocated when
the volume was created.

Related tasks:
“Running the Storage Virtualizer - Volumes Historical Space Report” on page 1228
To see how space on volumes on a storage virtualizer is used, run the Storage
Virtualizer - Volumes Historical Space Report

Running the Storage Systems - Historical Space Report
To see how space on storage systems is used, run the Storage Systems - Historical
Space Report.

To run the report with the default settings, click Finish. By default all of the
storage systems are selected.

Tip: To select a resource, click the resource. To select multiple resources, press Ctrl
and click the resources. To select a series of resources, select the first resource, and
then press Shift and click the last resource.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Historical

Information.
2. Open the Storage System folder.
3. Click Storage Systems - Historical Space Report.
4. Optional: Select one or more storage systems.
5. Optional: Select an interval.
6. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

7. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage Systems - Historical Space Report”
The Storage Systems - Historical Space Report shows the usage of space on
storage systems over a specified period. Use the report to determine whether
additional storage resources are required.

Storage Systems - Historical Space Report
The Storage Systems - Historical Space Report shows the usage of space on
storage systems over a specified period. Use the report to determine whether
additional storage resources are required.
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Charts

The chart shows the following space statistics for the storage systems:
v The capacity of the pools on the storage systems
v The used space in the pools on the storage systems
v The available space in the pools on the storage systems
v The capacity of the volumes on the storage systems

Report output

The following information is included in reports for storage systems:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Date The date that the data was collected for the report.

Storage System Pool Capacity (GiB)
The amount of storage space in pools that are on the storage system. For
an XIV system, this value represents the physical capacity of the pool, not
the virtual capacity. For other storage systems, this value might also
include overhead space if the pool is unformatted.

Storage System Used Pool Space (GiB)
The amount of space that is in use in all pools on a storage system.

Storage System Available Pool Space (GiB)
The amount of unused space in pools that are on the storage system.

Storage System Volume Capacity (GiB)
The amount of space on all volumes on the storage system.

Storage System Number of Volumes
The number of volumes on a resource.

Storage System Number of Disks
The number of disks on the storage system.

Storage System Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Storage System Unallocated Disk Space (GiB)
The amount of disk space that can be added to a pool.

Storage System Volume Capacity Assigned to MDisks (GiB)
The amount of space that is on volumes that are assigned to a storage
virtualizer to use as managed disks.

Storage System Disk Capacity (GiB)
The amount of storage space on physical disks on the storage system,
excluding spare disks.

Storage System Total Disk Capacity (GiB)
The amount of space on physical disks on a storage system, including
spare disks.

Storage System Assigned Volume Space (GiB)
The amount of space in the pool that is on volumes that are assigned to a
server or storage virtualizer.
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Storage System Volume Capacity for z/OS (GiB)
The amount of space on all volumes on the storage system that the z/OS
operating system can use.

Storage System Real Available Pool Space (GiB)
The amount of unused space in pools that have an associated soft size on
an XIV system. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Storage System Real Configured Pool Space (GiB)
The amount of storage space that is in pools that have an associated soft
size on an XIV system. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Related tasks:
“Running the Storage Systems - Historical Space Report” on page 1230
To see how space on storage systems is used, run the Storage Systems - Historical
Space Report.

Running the Storage System - Pools Historical Space Report
To see how space in pools on storage systems is used, run the Storage
System - Pools Historical Space Report.

You can see how space in a pool on a storage system, or in pools in a storage
resource group, are used.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Historical

Information.
2. Open the Storage System folder.
3. Click Storage System - Pools Historical Space Report.
4. Select the type of historical space report that you want to create.
5. Optional: You can filter the type of data that you want to see in a report. You

can select either of the following options:
v Of a Pool in a Storage System

a. Click Next.
b. Select a storage system, and then select a pool.

v Of Pools in a Storage Resource Group

a. Click Next.
b. Select a storage resource group.

6. Optional: Select an interval.
7. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

8. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
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Related reference:
“Storage System - Pools Historical Space Report”
The Storage System - Pools Historical Space Report shows the usage of space in a
pool on a storage system, or in pools in a storage resource group over a specified
period. Use the report to determine whether additional storage resources are
required.

Storage System - Pools Historical Space Report
The Storage System - Pools Historical Space Report shows the usage of space in a
pool on a storage system, or in pools in a storage resource group over a specified
period. Use the report to determine whether additional storage resources are
required.

Charts

The chart shows the following space statistics for the pool on a storage system:
v The capacity of the pool
v The used space in the pool
v The available space in the pool
v The virtual volume capacity of the pool
v The used volume space in the pool

The chart shows the following space statistics for the pool in the storage resource
group:
v The capacity of the pools
v The used space in the pools
v The available space in the pools
v The virtual volume capacity of the pools
v The used volume space in the pools

Report output

The following information is included in reports for a pool on a storage system or
for pools in a storage resource group:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Date The date that the data was collected for the report.

Storage System Pool Capacity (GiB)
The amount of storage space in pools that are on the storage system. For
an XIV system, this value represents the physical capacity of the pool, not
the virtual capacity. For other storage systems, this value might also
include overhead space if the pool is unformatted.

Storage Pool Available Space (GiB)
The amount of unused storage space in the pool.

Storage Pool Used Space (GiB)
The amount of storage space that is used in the pool.
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Storage Pool Virtual Volume Capacity (GiB)
The amount of virtual volume space on all volumes in the pool.

Storage Pool Used Volume Space (GiB)
The amount of used space on all the volumes in the pool.

Storage Pool Assigned Volume Space (GiB)
The amount of space in the pool that is on volumes that are assigned to a
server or storage virtualizer.

Storage Pool Unassigned Volume Space (GiB)
The amount of volume space in the pool that is not assigned to a server or
storage virtualizer.

Storage Pool Real Configured Space (GiB)
The amount of storage space that is in pools that have an associated soft
size on an XIV system. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Related tasks:
“Running the Storage System - Pools Historical Space Report” on page 1232
To see how space in pools on storage systems is used, run the Storage
System - Pools Historical Space Report.

Running the Storage System - Volumes Historical Space
Report

To see how space on volumes on storage systems is used, run the Storage
System - Volumes Historical Space Report.

You can see how space on a volume on a storage system, or on volumes in a
storage resource group, are used.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Historical

Information.
2. Open the Storage System folder.
3. Click Storage System - Volumes Historical Space Report.
4. Select the type of historical space report that you want to create.
5. Optional: You can filter the type of data that you want to see in a report. You

can select either of the following options:
v Of a Volume in a Storage System

a. Click Next.
b. Select a storage system.
c. Type a keyword and click Search. For example, type lun, to find the

names of volumes that start with lun. To change the default search
option, click Options.

Tip: Use the percent symbol (%) as a wildcard. For example, type a% to
find volume names that begin with ’a’ or ’A’. Type %a to find volume
names that begin with or contain the letter ’a’ or ’A’. You can type % to
retrieve all of the volumes on a resource.

d. Select a volume.
v Of Volumes in a Storage Resource Group

a. Click Next.
b. Select a storage resource group.

6. Optional: Select an interval.
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7. Optional: To limit the time frame of the report, specify a date filter or a date
range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

8. Click Finish.

If information is available for the resources that you selected, a report is created. If
no information is available for the selected resources, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Storage System - Volumes Historical Space Report”
The Storage System - Volumes Historical Space Report shows the usage of space
on a volume on a storage system, or on volumes in a storage resource group over
a specified period. Use the report to determine whether additional storage
resources are required.

Storage System - Volumes Historical Space Report
The Storage System - Volumes Historical Space Report shows the usage of space
on a volume on a storage system, or on volumes in a storage resource group over
a specified period. Use the report to determine whether additional storage
resources are required.

Charts

The chart shows the following space statistics for the volume on a storage system:
v The capacity of the volume
v The used space on the volume
v The space on the volume that is used for system management

The chart shows the following space statistics for the volumes in a storage resource
group:
v The capacity of the volumes
v The used space on the volumes
v The space on the volumes that is used for system management

If the volume is thin provisioned, the chart shows the total amount of virtual space
that is allocated to the volume, and the total amount of real space that is used by
the volume.

Report output

The following information is included in reports for a volume on a storage system,
or for volumes in a storage resource group:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage Pool Name
The name that was assigned to the pool when it was added to the system.
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Storage Volume Name
The name that was assigned to the storage volume when it was added to
the system.

Date The date that the data was collected for the report.

Storage Volume Capacity (GiB)
The amount of storage space on the volume.

Storage Volume Used Space (GiB)
The amount of virtual space that is used on a thin-provisioned volume. For
volumes that are not thin provisioned, this value is same as the Storage
Volume Capacity value. This property applies only to DS8000 storage
systems.

Storage Volume Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Related tasks:
“Running the Storage System - Volumes Historical Space Report” on page 1234
To see how space on volumes on storage systems is used, run the Storage
System - Volumes Historical Space Report.

Predefined reports about storage tiering
Use storage tier reports to help you determine the best storage-tier configuration
for your environment.

Information collection

IBM Tivoli Storage Productivity Center collects information from:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

Tivoli Storage Productivity Center provides Tivoli Common Reporting reports that
show performance and usage data for the SAN Volume Controller, Storwize V7000,
and Storwize V7000 Unified systems in your environment.

Workload activity reports

Before you run workload activity reports, you must set the back-end properties of
the managed disk (MDisk) groups in your environment.

You can use the Tivoli Storage Productivity Center CLI called tcptool to set the
back-end properties of MDisk groups. Alternatively, you can set the properties in
the MDisk Group Details page in the Tivoli Storage Productivity Center
stand-alone GUI.

Learn more: For more information, see the topics abut the setarray command, the
autosetarray command, and the lsarray command in the IBM Tivoli Storage
Productivity Center Information Center (http://publib.boulder.ibm.com/
infocenter/tivihelp/v59r1/index.jsp).

With the information that is collected from Tivoli Storage Productivity Center, you
can run workload activity reports. The reports provide information about the
workload activity of these resources:
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v Managed disk (MDisk) groups
v Virtual disks (VDisks) in MDisk groups
v VDisks in storage resource groups
v VDisks in storage virtualizers

By analyzing workload activity reports, you can determine:
v Whether the workload activity of an MDisk group is too low or too high
v Whether a VDisk should be migrated in one of the following ways:

– To an MDisk group with a faster read I/O capability rate
– To an MDisk group with a slower read I/O capability rate

Explanation: In the predefined reports about performance, resources, and
historical information, MDisk groups are called pools, and VDisks are called
volumes.

Volume migration recommendation report

Before you run the Volume Migration Recommendation Report report, complete
the following tasks:
v Create a storage tiering policy
v Analyze the storage tiering policy

Tiering policies specify the conditions for migrating volumes from one storage
resource group to another storage resource group. The Volume Migration
Recommendation Report shows the volumes that might require migration based on
the conditions that are set in the tiering policies.

Running the MDisk Groups - Workload Activity Report
To see which managed disk (MDisk) groups are most active, run the MDisk
Groups - Workload Activity Report.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Storage

Tiering.
2. Click MDisk Groups - Workload Activity Report.
3. Select a storage virtualizer.
4. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

5. Click Finish.
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Related reference:
“MDisk Groups - Workload Activity Report”
Use the MDisk Groups - Workload Activity Report to monitor the workload
activity of managed disk (MDisk) groups.
“Read I/O capability formula” on page 1272
The read I/O capability formula is used by IBM Tivoli Storage Productivity Center
to estimate the workload capacity of managed disk (MDisk) groups.

MDisk Groups - Workload Activity Report
Use the MDisk Groups - Workload Activity Report to monitor the workload
activity of managed disk (MDisk) groups.

You can use the information that the report provides to investigate which MDisk
groups are being under used or overused. To assess whether a virtual disk in an
MDisk group should be migrated to a lower-capability or higher-capability MDisk
group, you view the related MDisk Group - VDisk Workload Activity Details
Report.

Reporting periods

The name of the storage virtualizer, the date filter such as Last 7 days, and the
reporting period are displayed on the report.

If you select All as the search filter when you run a report, the system date is
displayed as the start date for the report. Depending on the time zone, 1969 or
1970 is displayed in the year field of the start date.

Retention of report data

If you remove an MDisk group or a VDisk, the daily data that is collected for
reports is retained for a configurable period. The default is 90 days. If you run a
report after the data retention period expired, the daily data for the MDisk group
or the VDisk is unavailable.

Read I/O rate capability

To estimate the read I/O rate capability of an MDisk group, you must set the
back-end pool properties of MDisk groups.

If you do not set the back-end pool properties of an MDisk group:
v Not Set is displayed in the MDisk Group Read I/O Rate Capability column
v Not Available is displayed in the MDisk Group Read I/O Rate Availability

column

If the read I/O rate capability of an MDisk group is less than the maximum read
I/O rate of the MDisk group, negative values are displayed in the report.

Charts

The maximum length of an MDisk group, VDisk, or storage resource group name
in charts is 25 characters. Names that are longer than 25 characters are truncated.
To indicate that a name is truncated, an ellipsis (...) is appended to the name. For
example, if the name of an MDisk group is myverylongmanageddiskgroupname123 in
a chart, it is truncated and displayed as myverylongmanageddiskgroupname...
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Two charts are displayed:
v Most Active MDisk Groups
v Most Available MDisk Groups

Most Active MDisk Groups
For each MDisk group two bars are used:
v A yellow bar that shows the average activity value
v A red bar that shows the maximum activity value

To calculate the average activity value of an MDisk group, the following
formula is used:
average(maximum_read_I/O_rate ÷ read_I/O_rate_capability)

To calculate the maximum activity value, the following formula is used:
maximum(maximum_read_I/O_rate ÷ read_I/O_rate_capability)

In this sample excerpt of report output for mdiskgroup1, the values that
are required to calculate average and maximum activity values are
provided.

MDisk Group Report Date
MDisk Group Read I/O
Rate Capability (ops/s)

MDisk Group Max Read
I/O Rate (ops/s)

Dec 6 2011 331 216.77

Dec 7 2011 331 256.40

Dec 8 2011 331 270.87

The average activity value of an MDisk group is calculated as follows:
1. For each report in the MDisk group, the value in the MDisk Group

Max Read I/O Rate column is divided by the value in the MDisk
Group Read I/O Rate Capability column:
216.77 ÷ 331 = 0.65
256.40 ÷ 331 = 0.77
270.87 ÷ 331 = 0.81

2. The result of the operation for each report is added:
0.65 + 0.77 + 0.81 = 2.23

3. To get the average value, the total is divided by the number of days
that are specified in the date range. For example, if the reporting period
spans 3 days, the total is divided by 3.
2.23 ÷ 3 = 0.74

The maximum value of an MDisk group is calculated as follows. For each
report in an MDisk group, the value in the MDisk Group Max Read I/O
Rate column is divided by the value in the MDisk Group Read I/O Rate
Capability column:
216.77 ÷ 331 = 0.65
256.40 ÷ 331 = 0.77
270.87 ÷ 331 = 0.81

In this sample, the maximum value is 0.81.

Most Available MDisk Groups
For each MDisk group two bars are used:
v A blue bar to represent minimum values
v A red bar to represent average values
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In this sample excerpt of report output for mdiskgroup2, the values that
are required to calculate minimum and average availability values for
MDisk Groups are provided.

MDisk Group Report Date
MDisk Group Read I/O Rate Availability
(ops/s)

Dec 6 2011 435.41

Dec 7 2011 560.92

Dec 8 2011 480.95

The minimum value of an MDisk group is calculated as follows:
v For all of the reports for an MDisk group, the lowest value in the MDisk

Group Read I/O Rate Availability column is used. In this sample, the
lowest value for mdiskgroup2 is 435.41.

The average value of an MDisk group is calculated as follows:
1. For each report in an MDisk group, the values in the MDisk Group

Read I/O Rate Availability column are added:
435.41 + 560.92 + 480.95 = 1477.28

2. To get the average value, the total is divided by the number of days
that are specified in the date range. (For example, if the reporting
period spans 3 days, the total is divided by 3.)
1477.28 ÷ 3 = 492.42

In this sample, the average value is 492.42.

The number of MDisk groups in a storage virtualizer determines how many MDisk
groups are displayed in each chart, as shown in the following table.

Number of MDisk groups
in the storage virtualizer

Number of MDisk groups
in the Most Active MDisk
Groups chart

Number of MDisk groups
in the Least Active MDisk
Groups chart

≥ 10 5 5

9 5 4

8 4 4

7 4 3

6 3 3

5 3 2

4 2 2

3 2 1

2 1 1

1 1 0

Tip: Click the bar that represents an MDisk group in a chart to open the MDisk
Group - VDisk Workload Activity Details Report. Alternatively, you can click the
name of the MDisk group in the report.

Threshold values

The names of the threshold values in the report that are used to monitor workload
activity for MDisk groups are:
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v Actual Size Threshold
v Read I/O Rate Threshold
v Max Read Response Time Threshold
v Max Write Response Time Threshold

Threshold values are set during installation. If a threshold value is changed during
a reporting period, the original value and the new threshold value are displayed as
minimum and maximum values. If, for example, the value of the actual size
threshold is changed during a reporting period from 50% to 60%, the name of the
column is changed to MDisk Group Available Size < Actual Size Threshold of {50 -
60%}. The convention that is used to represent a threshold value is a number
followed by the percent sign and enclosed in brackets: {%}. When the report is run,
the variable value is replaced with the threshold value. To calculate whether read
or write response time thresholds are exceeded, the following formula is used:
(maximum_response_time_value × maximum_response_time_threshold_value)÷ 100.

The result is converted from seconds to hours and minutes, and displayed in the
report. Read and write response times are sampled at 5-minute intervals over a
24-hour period.

Report output

For each MDisk group, the following information is provided:

MDisk Group
The name of the MDisk group.

MDisk Group Report Date
The date that the data was collected for the report.

MDisk Group Capacity Status
If the storage capacity that is allocated is less than the actual storage
capacity, a status value of OK is displayed. If the storage capacity that is
allocated is more than the actual storage capacity, a status value of Warning
is displayed. The actual capacity of the MDisk group is calculated as
follows:
(mdisk_group_real_capacity_value ÷ mdisk_group_capacity_value) × 100

MDisk Group Capacity (GB)
The total storage capacity in GB of all of the disks in the MDisk group.

MDisk Group Real Capacity (GB)
The total amount in GB of real storage capacity in the MDisk group.

MDisk Group Free Space (GB)
The total amount of remaining capacity in GB that can be allocated to
increase the size of an existing VDisk, or allocated to an additional VDisk.

MDisk Group Available Size < Actual Size Threshold of {%}
If the amount of storage space that is available for allocation to VDisks is
less than the actual size threshold, Yes is displayed in the column. If the
amount of storage space that is available for allocation to VDisks is more
than the actual size threshold, No is displayed in the column.

MDisk Group Read I/O Rate (ops/s)
The read I/O rate of the MDisk group in operations per second.

MDisk Group Read I/O Rate Capability (ops/s)
The read I/O capability rate of the MDisk group in operations per second.
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Tip: To find out how the read I/O capability rate is calculated, see “Read
I/O capability formula” on page 1272

MDisk Group Max Read I/O Rate (ops/s)
The maximum read I/O rate of the MDisk group in operations per second.

MDisk Group Read I/O Rate Availability (ops/s)
The difference between the read I/O capability rate and the maximum read
I/O rate in operations per second.

MDisk Group Read I/O Rate Availability < Read I/O Rate Capability Threshold
of {%} The availability rate for read I/O operations is compared with the read

I/O rate capability threshold. If the availability rate for read I/O
operations is less than the read I/O rate capability threshold, Yes is
displayed in the column. If the availability rate for read I/O operations is
more than the read I/O rate capability threshold, No is displayed in the
column.

MDisk Group Max Read Response Time (ms/op)
The maximum read response time in milliseconds per operation.

MDisk Group Max Read Response Time Threshold of {%} Exceeded By
(hr.:min.)

The number of hours and minutes that the maximum read response time
threshold is exceeded over a 24 hour period.

MDisk Group Average Read Response Time (ms/op)
The average read response time in milliseconds per operation.

MDisk Group Max Write I/O Rate (ops/s)
The maximum write I/O rate in operations per second.

MDisk Group Max Write Response Time (ms/op)
The maximum write response time in milliseconds per operation.

MDisk Group Max Write Response Time Threshold of {%} Exceeded By
(hr.:min.)

The number of hours and minutes that the maximum write response time
threshold is exceeded over a 24 hour period.

MDisk Group Average Write Response Time (ms/op)
The average write response time in milliseconds per operation.

MDisk Group Average Write I/O Size (KB)
The average size of write I/O operations in KB.

Related tasks:
“Running the MDisk Groups - Workload Activity Report” on page 1237
To see which managed disk (MDisk) groups are most active, run the MDisk
Groups - Workload Activity Report.

Running the MDisk Groups - VDisk Workload Activity Report
To see which virtual disks (VDisks) are most active in managed disk (MDisk)
groups, run the MDisk Groups - VDisk Workload Activity Report.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Storage

Tiering.
2. Click VDisk Workload Activity Reports.
3. Select MDisk Groups - VDisk Workload Activity Report.
4. Select a storage virtualizer.
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5. Optional: To limit the time frame of the report, specify a date filter or a date
range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

6. Click Finish.
Related reference:
“MDisk Groups - VDisk Workload Activity Report”
Use the MDisk Groups - VDisk Workload Activity Report to monitor the
performance of virtual disks (VDisks) in managed disk (MDisk) groups. The
workload activity of each MDisk group is determined by calculating the average
and the maximum peak utilization of the VDisks in the MDisk group.

MDisk Groups - VDisk Workload Activity Report
Use the MDisk Groups - VDisk Workload Activity Report to monitor the
performance of virtual disks (VDisks) in managed disk (MDisk) groups. The
workload activity of each MDisk group is determined by calculating the average
and the maximum peak utilization of the VDisks in the MDisk group.

Reporting period

The name of the storage virtualizer, the date filter such as Last 7 days, and the
reporting period are displayed on the report.

If you select All as the search filter when you run a report, the system date is
displayed as the start date for the report. Depending on the time zone, 1969 or
1970 is displayed in the year field of the start date.

Retention of report data

If you remove an MDisk group or a VDisk, the daily data that is collected for
reports is retained for a configurable period. The default is 90 days. If you run a
report after the data retention period expired, the daily data for the MDisk group
or the VDisk is unavailable.

VDisk migration

If a VDisk is migrated to another MDisk group during a reporting period, daily
VDisk reports are produced only for the target MDisk group. For the target MDisk
group, VDisk reports are produced from the day that the VDisk is migrated from
the source MDisk group until the last day of the reporting period.

Charts

The maximum length of an MDisk group, VDisk, or storage resource group name
in charts is 25 characters. Names that are longer than 25 characters are truncated.
To indicate that a name is truncated, an ellipsis (...) is appended to the name. For
example, if the name of an MDisk group is myverylongmanageddiskgroupname123 in
a chart, it is truncated and displayed as myverylongmanageddiskgroupname...

Two charts are shown:
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Most Active MDisk Groups chart
For each MDisk group two bars are shown:
v A yellow bar that shows average VDisk utilization
v A red bar that shows maximum VDisk utilization

To calculate average VDisk utilization, the following formula is used:
average(vdisk_peak_utilization)

To calculate maximum VDisk utilization, the following formula is used:
maximum(vdisk_peak_utilization)

In this sample excerpt of report output for VDisk1, the values that are
required to calculate average and maximum VDisk utilization are
provided.

VDisk Report Date VDisk Peak Utilization (%)

Dec 6 2011 86.30

Dec 7 2011 50.01

Dec 8 2011 79.41

To calculate the average value of a VDisk:
1. The values for VDisk1 in the VDisk Utilization (%) column are added:

86.30 + 50.01 + 79.41 = 215.72

2. The total is divided by the number of days that are specified in the
date range. For example, if the reporting period spans 3 days, the total
is divided by 3.
215.72 ÷ 3 = 71.91

In the sample, the average peak VDisk utilization is 71.91.

For each MDisk group, the maximum VDisk utilization is also shown in
the chart. The maximum VDisk utilization is the highest value for a VDisk
in the VDisk Utilization (%) column. In the sample, the highest value for
VDisk1 is 86.30.

Least Active MDisk Groups chart
For each MDisk group two bars are shown:
v A yellow bar that shows average VDisk utilization
v A red bar that shows maximum VDisk utilization

The same formulas that are used in the most active MDisk group chart are
also used in the least active MDisk group chart.

The number of MDisk groups in the storage virtualizer determines how many
MDisk groups are shown in each chart, as shown in the following table.

Number of MDisk groups
in the storage virtualizer

Number of MDisk groups
in the Most Active MDisk
Groups chart

Number of MDisk groups
in the Least Active MDisk
Groups chart

≥ 10 5 5

9 5 4

8 4 4

7 4 3

6 3 3
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Number of MDisk groups
in the storage virtualizer

Number of MDisk groups
in the Most Active MDisk
Groups chart

Number of MDisk groups
in the Least Active MDisk
Groups chart

5 3 2

4 2 2

3 2 1

2 1 1

1 1 0

Tip: Click the bar that represents an MDisk group in a chart to open the MDisk
Group - VDisk Workload Activity Details Report. Alternatively, click the name of
the MDisk group in the report. Click the name of the VDisk in the report to open
the VDisk Details Report.

Threshold values

The names of the threshold values that are used in the report to monitor workload
activity for VDisks are as follows:
v VDisk Max Read Response Time Threshold
v VDisk Max Write Response Time Threshold
v Max Read Cache Hits Time Threshold
v Max Read I/O Rate Threshold
v Max Write I/O Rate Threshold

Threshold values are set during installation. If a threshold value is changed during
a reporting period, the original value and the new threshold value are displayed as
minimum and maximum values. If, for example, the VDisk maximum read
response time threshold value is changed during a reporting period from 70% to
80%, the name of the column is changed to VDisk Max Read Response Time
Threshold of {70 - 80%} Exceeded By (hr.:min.). The convention that is used to
represent a threshold value is a number followed by the percent sign and enclosed
in brackets: {%}. When the report is run, the variable value is replaced with the
threshold value. To calculate whether read or write response time thresholds are
exceeded, the following formula is used: (maximum_response_time_value ×
maximum_response_time_threshold value)/100. The result is converted from seconds
to hours and minutes, and displayed in the report. Read and write response times
are sampled at 5-minute intervals over a 24-hour period.

Report output

For each VDisk in an MDisk group, the following information is provided:

MDisk Group
The name of the MDisk group.

VDisk The name of the VDisk.

VDisk Report Date
The date that the data was collected for the report.

VDisk Capacity (GB)
The total storage capacity of the VDisk in GB.

VDisk Thin Provisioning Status
The warning level threshold is set in the thin provisioning profile for the
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VDisk. The threshold is exceeded when the capacity of the VDisk that is
used exceeds or is equal to the warning level threshold. If the used
capacity of the VDisk in GB is ≥ the specified warning threshold value, a
status value of Warning is displayed. If the used capacity of the VDisk in
GB is < the specified warning threshold value, a status value of OK is
displayed. If thin provisioning is not used, a status value of Not
Applicable is displayed.

VDisk Peak Utilization (%)
The highest value of VDisk utilization over a 24-hour period.

VDisk Read I/O rate (ops/s)
The read I/O rate of the VDisk in operations per second.

VDisk Max Read I/O rate (ops/s)
The maximum read I/O rate of the VDisk in operations per second.

VDisk Average Read Response Time (ms/op)
The average read response time in milliseconds per operation.

VDisk Max Read Response Time (ms/op)
The maximum read response time in milliseconds per operation.

VDisk Max Read Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Write I/O Rate (ops/s)
The write I/O rate in operations per second.

VDisk Average Write Response Time (ms/op)
The average write response time in milliseconds per operation.

VDisk Max Write Response Time (ms/op)
The maximum write response time in milliseconds per operation.

VDisk Max Write Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum write response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Max Read Density Rate (ops/s per GB)
The maximum read density rate in operations per second per GB. This
value is calculated by dividing the maximum read I/O rate in operations
per second by the number of GB that the VDisk was allocated.

VDisk I/O Rate Share of Total VDisk Read I/O Rate (%)
The maximum read I/O rate of the VDisk as a percentage of the total
maximum read I/O rate of all the VDisks in the MDisk group.

VDisk Capacity Share of Total VDisk Capacity (%)
The real capacity of the VDisk as a percentage of the real capacity of all the
VDisks in the MDisk group.

VDisk Average Read Cache Hits (%)
The average read cache hits in percent.

VDisk Max Read Cache Hits (%)
The maximum read cache hits in percent.

VDisk Max Read Cache Hits Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read cache hits time
threshold is exceeded over a 24 hour period.
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VDisk Max Read I/O Rate Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write I/O Rate Threshold {%} Exceeded of By (hr.:min.)
The number of hours and minutes that the maximum write I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write Cache Delay I/O Rate (ops/s)
The maximum write cache delay I/O rate of the VDisk in operations per
second.

Related tasks:
“Running the MDisk Groups - VDisk Workload Activity Report” on page 1242
To see which virtual disks (VDisks) are most active in managed disk (MDisk)
groups, run the MDisk Groups - VDisk Workload Activity Report.

Running the MDisk Group - VDisk Workload Activity Details
Report

To see which of the virtual disks in a managed disk (MDisk) group are the most
active, run the MDisk Group - VDisk Workload Activity Details Report.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Storage

Tiering.
2. Click MDisk Group - VDisk Workload Activity Details Report.
3. Select a storage virtualizer, and then select an MDisk group.
4. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

5. Click Finish.
Related reference:
“MDisk Group - VDisk Workload Activity Details Report”
Use the MDisk Group - VDisk Workload Activity Details Report to monitor the
workload activity of virtual disks (VDisks) in a managed disk (MDisk) group. The
workload activity of VDisks in an MDisk group is determined by calculating the
average and maximum peak utilization of each VDisk.

MDisk Group - VDisk Workload Activity Details Report
Use the MDisk Group - VDisk Workload Activity Details Report to monitor the
workload activity of virtual disks (VDisks) in a managed disk (MDisk) group. The
workload activity of VDisks in an MDisk group is determined by calculating the
average and maximum peak utilization of each VDisk.

Reporting period

The name of the storage virtualizer, the name of the MDisk group, the date filter
such as Last 7 days, and the reporting period are displayed on the report.

If you select All as the search filter when you run a report, the system date is
displayed as the start date for the report. Depending on the time zone, 1969 or
1970 is displayed in the year field of the start date.
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Retention of report data

If you remove an MDisk group or a VDisk, the daily data that is collected for
reports is retained for a configurable period. The default is 90 days. If you run a
report after the data retention period expired, the daily data for the MDisk group
or the VDisk is unavailable.

VDisk migration

If a VDisk is migrated to another MDisk group during a reporting period, daily
VDisk reports are produced only for the target MDisk group. For the target MDisk
group, VDisk reports are produced from the day that the VDisk is migrated from
the source MDisk group until the last day of the reporting period.

Charts

The maximum length of an MDisk group, VDisk, or storage resource group name
in charts is 25 characters. Names that are longer than 25 characters are truncated.
To indicate that a name is truncated, an ellipsis (...) is appended to the name. For
example, if the name of an MDisk group is myverylongmanageddiskgroupname123 in
a chart, it is truncated and displayed as myverylongmanageddiskgroupname...

Two charts are shown:

Most Active VDisks chart
For each MDisk group, two bars are shown:
v A yellow bar that shows average VDisk utilization
v A red bar that shows maximum VDisk utilization

To calculate average VDisk utilization, the following formula is used:
average(vdisk_peak_utilization)

To calculate maximum VDisk utilization, the following formula is used:
maximum(vdisk_peak_utilization)

In this sample excerpt of report output for VDisk1, the values that are
required to calculate average and maximum VDisk utilization are
provided.

VDisk Report Date VDisk Peak Utilization (%)

Dec 6 2011 86.30

Dec 7 2011 50.01

Dec 8 2011 79.41

To calculate the average value of a VDisk:
1. The values for VDisk1 in the VDisk Utilization (%) column are added:

86.30 + 50.01 + 79.41 = 215.72

2. The total is divided by the number of days that are specified in the
date range. For example, if the reporting period spans 3 days, the total
is divided by 3.
215.72 ÷ 3 = 71.91

In the sample, the average peak VDisk utilization is 71.91.

1248 IBM Tivoli Storage Productivity Center: User's Guide



In this sample excerpt of report output for VDisk1, the values that are
required to calculate average and maximum VDisk utilization are
provided.

VDisk Report Date VDisk Peak Utilization (%)

Dec 6 2011 86.30

Dec 7 2011 50.01

Dec 8 2011 79.41

Least Active VDisks chart
For each MDisk group, two bars are shown:
v A yellow bar that shows average VDisk utilization
v A red bar that shows maximum VDisk utilization

The same formulas that are used in the most active MDisk group chart are
also used in the least active MDisk group chart.

The number of VDisks in an MDisk group determines how many VDisks are
shown in each chart, as shown in the following table.

Number of VDisks in the
MDisk group

Number of VDisks in the
Most Active VDisks chart

Number of VDisks in the
Least Active VDisks chart

≥ 10 5 5

9 5 4

8 4 4

7 4 3

6 3 3

5 3 2

4 2 2

3 2 1

2 1 1

1 1 0

Tip: Click the bar that represents a VDisk in a chart to open the VDisk Details
Report. Alternatively, click the name of the VDisk in the report. Click the name of
the MDisk group in the report to open the MDisk Group Details Report.

Threshold values

The names of the threshold values that are used in the report to monitor workload
activity for VDisks are as follows:
v VDisk Max Read Response Time Threshold
v VDisk Max Write Response Time Threshold
v Max Read Cache Hits Time Threshold
v Max Read I/O Rate Threshold
v Max Write I/O Rate Threshold

Threshold values are set during installation. If a threshold value is changed during
a reporting period, the original value and the new threshold value are displayed as
minimum and maximum values. If, for example, the VDisk maximum read
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response time threshold value is changed during a reporting period from 70% to
80%, the name of the column is changed to VDisk Max Read Response Time
Threshold of {70 - 80%} Exceeded By (hr.:min.). The convention that is used to
represent a threshold value is a number followed by the percent sign and enclosed
in brackets: {%}. When the report is run, the variable value is replaced with the
threshold value. To calculate whether read or write response time thresholds are
exceeded, the following formula is used: (maximum_response_time_value ×
maximum_response_time_threshold value)/100. The result is converted from seconds
to hours and minutes, and displayed in the report. Read and write response times
are sampled at 5-minute intervals over a 24-hour period.

Report output

For each VDisk in an MDisk group, the following information is provided:

MDisk Group
The name of the MDisk group.

VDisk The name of the VDisk.

VDisk Report Date
The date that the data was collected for the report.

VDisk Capacity (GB)
The total storage capacity of the VDisk in GB.

VDisk Thin Provisioning Status
The warning level threshold is set in the thin provisioning profile for the
VDisk. The threshold is exceeded when the capacity of the VDisk that is
used exceeds or is equal to the warning level threshold. If the used
capacity of the VDisk in GB is ≥ the specified warning threshold value, a
status value of Warning is displayed. If the used capacity of the VDisk in
GB is < the specified warning threshold value, a status value of OK is
displayed. If thin provisioning is not used, a status value of Not
Applicable is displayed.

VDisk Peak Utilization (%)
The highest value of VDisk utilization over a 24-hour period.

VDisk Read I/O rate (ops/s)
The read I/O rate of the VDisk in operations per second.

VDisk Max Read I/O rate (ops/s)
The maximum read I/O rate of the VDisk in operations per second.

VDisk Average Read Response Time (ms/op)
The average read response time in milliseconds per operation.

VDisk Max Read Response Time (ms/op)
The maximum read response time in milliseconds per operation.

VDisk Max Read Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Write I/O Rate (ops/s)
The write I/O rate in operations per second.

VDisk Average Write Response Time (ms/op)
The average write response time in milliseconds per operation.

VDisk Max Write Response Time (ms/op)
The maximum write response time in milliseconds per operation.
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VDisk Max Write Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum write response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Max Read Density Rate (ops/s per GB)
The maximum read density rate in operations per second per GB. This
value is calculated by dividing the maximum read I/O rate in operations
per second by the number of GB that the VDisk was allocated.

VDisk I/O Rate Share of Total VDisk Read I/O Rate (%)
The maximum read I/O rate of the VDisk as a percentage of the total
maximum read I/O rate of all the VDisks in the MDisk group.

VDisk Capacity Share of Total VDisk Capacity (%)
The real capacity of the VDisk as a percentage of the real capacity of all the
VDisks in the MDisk group.

VDisk Average Read Cache Hits (%)
The average read cache hits in percent.

VDisk Max Read Cache Hits (%)
The maximum read cache hits in percent.

VDisk Max Read Cache Hits Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read cache hits time
threshold is exceeded over a 24 hour period.

VDisk Max Read I/O Rate Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write I/O Rate Threshold {%} Exceeded of By (hr.:min.)
The number of hours and minutes that the maximum write I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write Cache Delay I/O Rate (ops/s)
The maximum write cache delay I/O rate of the VDisk in operations per
second.

Related tasks:
“Running the MDisk Group - VDisk Workload Activity Details Report” on page
1247
To see which of the virtual disks in a managed disk (MDisk) group are the most
active, run the MDisk Group - VDisk Workload Activity Details Report.

Running the Storage Virtualizer - VDisk Workload Activity
Report

To see which virtual disks (VDisks) are most active on a storage virtualizer, run the
Storage Virtualizer - VDisk Workload Activity Report.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Storage

Tiering.
2. Click VDisk Workload Activity Reports.
3. Select Storage Virtualizer - VDisk Workload Activity Report.
4. Select a storage virtualizer.
5. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.
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Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

6. Click Finish.
Related reference:
“Storage Virtualizer - VDisk Workload Activity Report”
Use the Storage Virtualizer - VDisk Workload Activity Report to monitor the
workload activity of virtual disks (VDisks) in a storage virtualizer. The workload
activity of VDisks in a storage virtualizer is determined by calculating the average
and maximum peak utilization of each VDisk.

Storage Virtualizer - VDisk Workload Activity Report
Use the Storage Virtualizer - VDisk Workload Activity Report to monitor the
workload activity of virtual disks (VDisks) in a storage virtualizer. The workload
activity of VDisks in a storage virtualizer is determined by calculating the average
and maximum peak utilization of each VDisk.

Reporting period

The name of the storage virtualizer, the date filter such as Last 7 days, and the
reporting period are shown on the report.

If you select All as the search filter when you run a report, the system date is
displayed as the start date for the report. Depending on the time zone, 1969 or
1970 is displayed in the year field of the start date.

Retention of report data

If you remove an MDisk group or a VDisk, the daily data that is collected for
reports is retained for a configurable period. The default is 90 days. If you run a
report after the data retention period expired, the daily data for the MDisk group
or the VDisk is unavailable.

VDisk migration

If a VDisk is migrated to another MDisk group during a reporting period, daily
VDisk reports are produced only for the target MDisk group. For the target MDisk
group, VDisk reports are produced from the day that the VDisk is migrated from
the source MDisk group until the last day of the reporting period.

Charts

The maximum length of an MDisk group, VDisk, or storage resource group name
in charts is 25 characters. Names that are longer than 25 characters are truncated.
To indicate that a name is truncated, an ellipsis (...) is appended to the name. For
example, if the name of an MDisk group is myverylongmanageddiskgroupname123 in
a chart, it is truncated and displayed as myverylongmanageddiskgroupname...

Two charts are shown:

Most Active VDisks chart
For each storage virtualizer, two bars are shown:
v A yellow bar that shows average VDisk utilization
v A red bar that shows maximum VDisk utilization

To calculate average VDisk utilization, the following formula is used:
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average(vdisk_peak_utilization)

To calculate maximum VDisk utilization, the following formula is used:
maximum(vdisk_peak_utilization)

In this sample excerpt of report output for VDisk1, the values that are
required to calculate average and maximum VDisk utilization are
provided.

VDisk Report Date VDisk Peak Utilization (%)

Dec 6 2011 86.30

Dec 7 2011 50.01

Dec 8 2011 79.41

To calculate the average value of a VDisk:
1. The values for VDisk1 in the VDisk Utilization (%) column are added:

86.30 + 50.01 + 79.41 = 215.72

2. The total is divided by the number of days that are specified in the
date range. For example, if the reporting period spans 3 days, the total
is divided by 3.
215.72 ÷ 3 = 71.91

In the sample, the average peak VDisk utilization is 71.91.

In this sample excerpt of report output for VDisk1, the values that are
required to calculate average and maximum VDisk utilization are
provided.

VDisk Report Date VDisk Peak Utilization (%)

Dec 6 2011 86.30

Dec 7 2011 50.01

Dec 8 2011 79.41

Least Active VDisks chart
For each storage virtualizer, two bars are shown:
v A yellow bar that shows average VDisk utilization
v A red bar that shows maximum VDisk utilization

The same formulas that are used in the most active VDisks chart are also
used in the least active VDisks chart.

The number of VDisks in a storage virtualizer determines how many VDisks are
shown in each chart, as shown in the following table.

Number of VDisks in the
storage virtualizer

Number of VDisks in the
Most Active VDisks chart

Number of VDisks in the
Least Active VDisks chart

≥ 10 5 5

9 5 4

8 4 4

7 4 3

6 3 3

5 3 2
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Number of VDisks in the
storage virtualizer

Number of VDisks in the
Most Active VDisks chart

Number of VDisks in the
Least Active VDisks chart

4 2 2

3 2 1

2 1 1

1 1 0

Tip: Click the bar that represents a VDisk in a chart to open the VDisk Details
Report. Alternatively, click the name of the VDisk in the report. Click the name of
the MDisk group in the report to open the MDisk Group Details Report.

Threshold values

The names of the threshold values that are used in the report to monitor workload
activity for VDisks are as follows:
v VDisk Max Read Response Time Threshold
v VDisk Max Write Response Time Threshold
v Max Read Cache Hits Time Threshold
v Max Read I/O Rate Threshold
v Max Write I/O Rate Threshold

Threshold values are set during installation. If a threshold value is changed during
a reporting period, the original value and the new threshold value are displayed as
minimum and maximum values. If, for example, the VDisk maximum read
response time threshold value is changed during a reporting period from 70% to
80%, the name of the column is changed to VDisk Max Read Response Time
Threshold of {70 - 80%} Exceeded By (hr.:min.). The convention that is used to
represent a threshold value is a number followed by the percent sign and enclosed
in brackets: {%}. When the report is run, the variable value is replaced with the
threshold value. To calculate whether read or write response time thresholds are
exceeded, the following formula is used: (maximum_response_time_value ×
maximum_response_time_threshold value)/100. The result is converted from seconds
to hours and minutes, and displayed in the report. Read and write response times
are sampled at 5-minute intervals over a 24-hour period.

Report output

For each VDisk in a storage virtualizer, the following information is shown:

MDisk Group
The name of the MDisk group.

VDisk The name of the VDisk.

VDisk Report Date
The date that the data was collected for the report.

VDisk Capacity (GB)
The total storage capacity of the VDisk in GB.

VDisk Thin Provisioning Status
The warning level threshold is set in the thin provisioning profile for the
VDisk. The threshold is exceeded when the capacity of the VDisk that is
used exceeds or is equal to the warning level threshold. If the used
capacity of the VDisk in GB is ≥ the specified warning threshold value, a
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status value of Warning is displayed. If the used capacity of the VDisk in
GB is < the specified warning threshold value, a status value of OK is
displayed. If thin provisioning is not used, a status value of Not
Applicable is displayed.

VDisk Peak Utilization (%)
The highest value of VDisk utilization over a 24-hour period.

VDisk Read I/O rate (ops/s)
The read I/O rate of the VDisk in operations per second.

VDisk Max Read I/O rate (ops/s)
The maximum read I/O rate of the VDisk in operations per second.

VDisk Average Read Response Time (ms/op)
The average read response time in milliseconds per operation.

VDisk Max Read Response Time (ms/op)
The maximum read response time in milliseconds per operation.

VDisk Max Read Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Write I/O Rate (ops/s)
The write I/O rate in operations per second.

VDisk Average Write Response Time (ms/op)
The average write response time in milliseconds per operation.

VDisk Max Write Response Time (ms/op)
The maximum write response time in milliseconds per operation.

VDisk Max Write Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum write response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Max Read Density Rate (ops/s per GB)
The maximum read density rate in operations per second per GB. This
value is calculated by dividing the maximum read I/O rate in operations
per second by the number of GB that the VDisk was allocated.

VDisk I/O Rate Share of Total VDisk Read I/O Rate (%)
The maximum read I/O rate of the VDisk as a percentage of the total
maximum read I/O rate of all the VDisks in the MDisk group.

VDisk Capacity Share of Total VDisk Capacity (%)
The real capacity of the VDisk as a percentage of the real capacity of all the
VDisks in the MDisk group.

VDisk Average Read Cache Hits (%)
The average read cache hits in percent.

VDisk Max Read Cache Hits (%)
The maximum read cache hits in percent.

VDisk Max Read Cache Hits Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read cache hits time
threshold is exceeded over a 24 hour period.

VDisk Max Read I/O Rate Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read I/O rate
threshold is exceeded over a 24 hour period.
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VDisk Max Write I/O Rate Threshold {%} Exceeded of By (hr.:min.)
The number of hours and minutes that the maximum write I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write Cache Delay I/O Rate (ops/s)
The maximum write cache delay I/O rate of the VDisk in operations per
second.

Related tasks:
“Running the Storage Virtualizer - VDisk Workload Activity Report” on page 1251
To see which virtual disks (VDisks) are most active on a storage virtualizer, run the
Storage Virtualizer - VDisk Workload Activity Report.

Running the Storage Resource Group - VDisk Workload
Activity Report

To see which virtual disks (VDisks) are most active in storage resource groups, run
the Storage Resource Group - VDisk Workload Activity Report.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Storage

Tiering.
2. Click VDisk Workload Activity Reports.
3. Select Storage Resource Group - VDisk Workload Activity Report.
4. Select a storage virtualizer.
5. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

6. Click Finish.
Related reference:
“Storage Resource Group - VDisk Workload Activity Report”
Use the Storage Resource Group - VDisk Workload Activity Report to monitor the
workload activity of virtual disks (VDisks) in storage resource groups. The
workload activity of each storage resource group is determined by calculating the
average and maximum peak utilization of the VDisks in the storage resource
group.

Storage Resource Group - VDisk Workload Activity Report
Use the Storage Resource Group - VDisk Workload Activity Report to monitor the
workload activity of virtual disks (VDisks) in storage resource groups. The
workload activity of each storage resource group is determined by calculating the
average and maximum peak utilization of the VDisks in the storage resource
group.

Reporting period

The name of the storage virtualizer, the date filter such as Last 7 days, and the
reporting period are shown on the report.

If you select All as the search filter when you run a report, the system date is
displayed as the start date for the report. Depending on the time zone, 1969 or
1970 is displayed in the year field of the start date.
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Retention of report data

If you remove an MDisk group or a VDisk, the daily data that is collected for
reports is retained for a configurable period. The default is 90 days. If you run a
report after the data retention period expired, the daily data for the MDisk group
or the VDisk is unavailable.

VDisk migration

If a VDisk is migrated to another MDisk group during a reporting period, daily
VDisk reports are produced only for the target MDisk group. For the target MDisk
group, VDisk reports are produced from the day that the VDisk is migrated from
the source MDisk group until the last day of the reporting period.

Charts

The maximum length of an MDisk group, VDisk, or storage resource group name
in charts is 25 characters. Names that are longer than 25 characters are truncated.
To indicate that a name is truncated, an ellipsis (...) is appended to the name. For
example, if the name of an MDisk group is myverylongmanageddiskgroupname123 in
a chart, it is truncated and displayed as myverylongmanageddiskgroupname...

Two charts are shown:

Most Active Storage Resource Groups chart
For each storage resource group, two bars are shown:
v A yellow bar that shows average VDisk utilization
v A red bar that shows maximum VDisk utilization

To calculate average VDisk utilization, the following formula is used:
average(vdisk_peak_utilization)

To calculate maximum VDisk utilization, the following formula is used:
maximum(vdisk_peak_utilization)

In this sample excerpt of report output for VDisk1, the values that are
required to calculate average and maximum VDisk utilization are
provided.

VDisk Report Date VDisk Peak Utilization (%)

Dec 6 2011 86.30

Dec 7 2011 50.01

Dec 8 2011 79.41

To calculate the average value of a VDisk:
1. The values for VDisk1 in the VDisk Utilization (%) column are added:

86.30 + 50.01 + 79.41 = 215.72

2. The total is divided by the number of days that are specified in the
date range. For example, if the reporting period spans 3 days, the total
is divided by 3.
215.72 ÷ 3 = 71.91

In the sample, the average peak VDisk utilization is 71.91.
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In this sample excerpt of report output for VDisk1, the values that are
required to calculate average and maximum VDisk utilization are
provided.

VDisk Report Date VDisk Peak Utilization (%)

Dec 6 2011 86.30

Dec 7 2011 50.01

Dec 8 2011 79.41

Least Active Storage Resource Groups chart
For each storage resource group, two bars are shown:
v A yellow bar that shows average VDisk utilization
v A red bar that shows maximum VDisk utilization

The same formulas that are used in the most active storage resource
groups chart are also used in the least active storage resource groups chart.

The number of storage resource groups in a storage virtualizer determines how
many storage resource groups are shown in each chart, as shown in the table.

Number of storage resource
groups in the storage
virtualizer

Number of storage resource
groups in the Most Active
Storage Resource Groups
chart

Number of storage resource
groups in the Least Active
Storage Resource Groups
chart

≥ 10 5 5

9 5 4

8 4 4

7 4 3

6 3 3

5 3 2

4 2 2

3 2 1

2 1 1

1 1 0

Tip: Click the bar that represents a storage resource group to open the Storage
Resource Group: VDisk Workload Activity Details Report. Alternatively, click the
name of the storage resource group in the report. Click the name of the VDisk in
the report to open the VDisk Details Report. Click the name of the MDisk group in
the report to open the MDisk Group Details Report.

Threshold values

The names of the threshold values that are used in the report to monitor workload
activity for VDisks are as follows:
v VDisk Max Read Response Time Threshold
v VDisk Max Write Response Time Threshold
v Max Read Cache Hits Time Threshold
v Max Read I/O Rate Threshold
v Max Write I/O Rate Threshold
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Threshold values are set during installation. If a threshold value is changed during
a reporting period, the original value and the new threshold value are displayed as
minimum and maximum values. If, for example, the VDisk maximum read
response time threshold value is changed during a reporting period from 70% to
80%, the name of the column is changed to VDisk Max Read Response Time
Threshold of {70 - 80%} Exceeded By (hr.:min.). The convention that is used to
represent a threshold value is a number followed by the percent sign and enclosed
in brackets: {%}. When the report is run, the variable value is replaced with the
threshold value. To calculate whether read or write response time thresholds are
exceeded, the following formula is used: (maximum_response_time_value ×
maximum_response_time_threshold value)/100. The result is converted from seconds
to hours and minutes, and displayed in the report. Read and write response times
are sampled at 5-minute intervals over a 24-hour period.

Report output

For each storage resource group in a storage virtualizer, the following information
is provided about VDisks:

Storage Resource Group
The name of the storage resource group.

MDisk Group
The name of the MDisk group.

VDisk The name of the VDisk.

VDisk Report Date
The date that the data was collected for the report.

VDisk Capacity (GB)
The total storage capacity of the VDisk in GB.

VDisk Thin Provisioning Status
The warning level threshold is set in the thin provisioning profile for the
VDisk. The threshold is exceeded when the capacity of the VDisk that is
used exceeds or is equal to the warning level threshold. If the used
capacity of the VDisk in GB is ≥ the specified warning threshold value, a
status value of Warning is displayed. If the used capacity of the VDisk in
GB is < the specified warning threshold value, a status value of OK is
displayed. If thin provisioning is not used, a status value of Not
Applicable is displayed.

VDisk Peak Utilization (%)
The highest value of VDisk utilization over a 24-hour period.

VDisk Read I/O rate (ops/s)
The read I/O rate of the VDisk in operations per second.

VDisk Max Read I/O rate (ops/s)
The maximum read I/O rate of the VDisk in operations per second.

VDisk Average Read Response Time (ms/op)
The average read response time in milliseconds per operation.

VDisk Max Read Response Time (ms/op)
The maximum read response time in milliseconds per operation.

VDisk Max Read Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read response time
threshold for the VDisk is exceeded over a 24 hour period.
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VDisk Write I/O Rate (ops/s)
The write I/O rate in operations per second.

VDisk Average Write Response Time (ms/op)
The average write response time in milliseconds per operation.

VDisk Max Write Response Time (ms/op)
The maximum write response time in milliseconds per operation.

VDisk Max Write Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum write response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Max Read Density Rate (ops/s per GB)
The maximum read density rate in operations per second per GB. This
value is calculated by dividing the maximum read I/O rate in operations
per second by the number of GB that the VDisk was allocated.

VDisk I/O Rate Share of Total VDisk Read I/O Rate (%)
The maximum read I/O rate of the VDisk as a percentage of the total
maximum read I/O rate of all the VDisks in the MDisk group.

VDisk Capacity Share of Total VDisk Capacity (%)
The real capacity of the VDisk as a percentage of the real capacity of all the
VDisks in the MDisk group.

VDisk Average Read Cache Hits (%)
The average read cache hits in percent.

VDisk Max Read Cache Hits (%)
The maximum read cache hits in percent.

VDisk Max Read Cache Hits Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read cache hits time
threshold is exceeded over a 24 hour period.

VDisk Max Read I/O Rate Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write I/O Rate Threshold {%} Exceeded of By (hr.:min.)
The number of hours and minutes that the maximum write I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write Cache Delay I/O Rate (ops/s)
The maximum write cache delay I/O rate of the VDisk in operations per
second.

Related tasks:
“Running the Storage Resource Group - VDisk Workload Activity Report” on
page 1256
To see which virtual disks (VDisks) are most active in storage resource groups, run
the Storage Resource Group - VDisk Workload Activity Report.

Running the Storage Resource Group - VDisk Workload
Activity Details Report

To see which virtual disks (VDisks) are most active in a storage resource group,
run the Storage Resource Group - VDisk Workload Activity Details Report.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Storage

Tiering.
2. Click Storage Resource Group - VDisk Workload Activity Details Report.
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3. Select a storage virtualizer, and then select a storage resource group.
4. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

5. Click Finish.
Related reference:
“Storage Resource Group - VDisk Workload Activity Details Report”
Use the Storage Resource Group - VDisk Workload Activity Details Report to
monitor the workload activity of virtual disks (VDisks) in a storage resource group.
The workload activity of VDisks in a storage resource group, such as a database
application, is determined by calculating the average and maximum peak
utilization of each VDisk.

Storage Resource Group - VDisk Workload Activity Details
Report

Use the Storage Resource Group - VDisk Workload Activity Details Report to
monitor the workload activity of virtual disks (VDisks) in a storage resource group.
The workload activity of VDisks in a storage resource group, such as a database
application, is determined by calculating the average and maximum peak
utilization of each VDisk.

Reporting period

The name of the storage virtualizer, the name of the storage resource group, the
date filter such as Last 7 days, and the reporting period are displayed on the
report.

If you select All as the search filter when you run a report, the system date is
displayed as the start date for the report. Depending on the time zone, 1969 or
1970 is displayed in the year field of the start date.

Retention of report data

If you remove an MDisk group or a VDisk, the daily data that is collected for
reports is retained for a configurable period. The default is 90 days. If you run a
report after the data retention period expired, the daily data for the MDisk group
or the VDisk is unavailable.

VDisk migration

If a VDisk is migrated to another MDisk group during a reporting period, daily
VDisk reports are produced only for the target MDisk group. For the target MDisk
group, VDisk reports are produced from the day that the VDisk is migrated from
the source MDisk group until the last day of the reporting period.

Charts

The maximum length of an MDisk group, VDisk, or storage resource group name
in charts is 25 characters. Names that are longer than 25 characters are truncated.
To indicate that a name is truncated, an ellipsis (...) is appended to the name. For
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example, if the name of an MDisk group is myverylongmanageddiskgroupname123 in
a chart, it is truncated and displayed as myverylongmanageddiskgroupname...

Two charts are displayed:

Most Active VDisks chart
For each storage resource group, two bars are shown:
v A yellow bar that shows average VDisk utilization
v A red bar that shows maximum VDisk utilization

To calculate average VDisk utilization, the following formula is used:
average(vdisk_peak_utilization)

To calculate maximum VDisk utilization, the following formula is used:
maximum(vdisk_peak_utilization)

In this sample excerpt of report output for VDisk1, the values that are
required to calculate average and maximum VDisk utilization are
provided.

VDisk Report Date VDisk Peak Utilization (%)

Dec 6 2011 86.30

Dec 7 2011 50.01

Dec 8 2011 79.41

To calculate the average value of a VDisk:
1. The values for VDisk1 in the VDisk Utilization (%) column are added:

86.30 + 50.01 + 79.41 = 215.72

2. The total is divided by the number of days that are specified in the
date range. For example, if the reporting period spans 3 days, the total
is divided by 3.
215.72 ÷ 3 = 71.91

In the sample, the average peak VDisk utilization is 71.91.

In this sample excerpt of report output for VDisk1, the values that are
required to calculate average and maximum VDisk utilization are
provided.

VDisk Report Date VDisk Peak Utilization (%)

Dec 6 2011 86.30

Dec 7 2011 50.01

Dec 8 2011 79.41

Least Active VDisks chart
For each storage resource group, two bars are shown:
v A yellow bar that shows average VDisk utilization
v A red bar that shows maximum VDisk utilization

The same formulas that are used in the most active VDisks chart are also used in
the least active VDisks chart.

The number of VDisks that a storage resource group uses determines how many
VDisks are displayed in each chart, as shown in the table.
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Number of VDisks that the
storage resource group uses

Number of VDisks in the
Most Active VDisks chart

Number of VDisks in the
Least Active VDisks chart

≥ 10 5 5

9 5 4

8 4 4

7 4 3

6 3 3

5 3 2

4 2 2

3 2 1

2 1 1

1 1 0

Tip: Click the bar that represents a VDisk in a chart to open the VDisk Details
Report. Alternatively, click the name of the VDisk in the report. Click the name of
the MDisk group in the report to open the MDisk Group Details Report. To
monitor the workload activity of VDisks for all storage resource groups in a
storage virtualizer, run the Storage Resource Group - VDisk Workload Activity
Report.

Threshold values

The names of the threshold values that are used in the report to monitor workload
activity for VDisks are as follows:
v VDisk Max Read Response Time Threshold
v VDisk Max Write Response Time Threshold
v Max Read Cache Hits Time Threshold
v Max Read I/O Rate Threshold
v Max Write I/O Rate Threshold

Threshold values are set during installation. If a threshold value is changed during
a reporting period, the original value and the new threshold value are displayed as
minimum and maximum values. If, for example, the VDisk maximum read
response time threshold value is changed during a reporting period from 70% to
80%, the name of the column is changed to VDisk Max Read Response Time
Threshold of {70 - 80%} Exceeded By (hr.:min.). The convention that is used to
represent a threshold value is a number followed by the percent sign and enclosed
in brackets: {%}. When the report is run, the variable value is replaced with the
threshold value. To calculate whether read or write response time thresholds are
exceeded, the following formula is used: (maximum_response_time_value ×
maximum_response_time_threshold value)/100. The result is converted from seconds
to hours and minutes, and displayed in the report. Read and write response times
are sampled at 5-minute intervals over a 24-hour period.

Report output

The following information is provided about VDisks in the storage resource group:

MDisk Group
The name of the MDisk group.

VDisk The name of the VDisk.
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VDisk Report Date
The date that the data was collected for the report.

VDisk Capacity (GB)
The total storage capacity of the VDisk in GB.

VDisk Thin Provisioning Status
The warning level threshold is set in the thin provisioning profile for the
VDisk. The threshold is exceeded when the capacity of the VDisk that is
used exceeds or is equal to the warning level threshold. If the used
capacity of the VDisk in GB is ≥ the specified warning threshold value, a
status value of Warning is displayed. If the used capacity of the VDisk in
GB is < the specified warning threshold value, a status value of OK is
displayed. If thin provisioning is not used, a status value of Not
Applicable is displayed.

VDisk Peak Utilization (%)
The highest value of VDisk utilization over a 24-hour period.

VDisk Read I/O rate (ops/s)
The read I/O rate of the VDisk in operations per second.

VDisk Max Read I/O rate (ops/s)
The maximum read I/O rate of the VDisk in operations per second.

VDisk Average Read Response Time (ms/op)
The average read response time in milliseconds per operation.

VDisk Max Read Response Time (ms/op)
The maximum read response time in milliseconds per operation.

VDisk Max Read Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Write I/O Rate (ops/s)
The write I/O rate in operations per second.

VDisk Average Write Response Time (ms/op)
The average write response time in milliseconds per operation.

VDisk Max Write Response Time (ms/op)
The maximum write response time in milliseconds per operation.

VDisk Max Write Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum write response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Max Read Density Rate (ops/s per GB)
The maximum read density rate in operations per second per GB. This
value is calculated by dividing the maximum read I/O rate in operations
per second by the number of GB that the VDisk was allocated.

VDisk I/O Rate Share of Total VDisk Read I/O Rate (%)
The maximum read I/O rate of the VDisk as a percentage of the total
maximum read I/O rate of all the VDisks in the MDisk group.

VDisk Capacity Share of Total VDisk Capacity (%)
The real capacity of the VDisk as a percentage of the real capacity of all the
VDisks in the MDisk group.

VDisk Average Read Cache Hits (%)
The average read cache hits in percent.
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VDisk Max Read Cache Hits (%)
The maximum read cache hits in percent.

VDisk Max Read Cache Hits Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read cache hits time
threshold is exceeded over a 24 hour period.

VDisk Max Read I/O Rate Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write I/O Rate Threshold {%} Exceeded of By (hr.:min.)
The number of hours and minutes that the maximum write I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write Cache Delay I/O Rate (ops/s)
The maximum write cache delay I/O rate of the VDisk in operations per
second.

Related tasks:
“Running the Storage Resource Group - VDisk Workload Activity Details Report”
on page 1260
To see which virtual disks (VDisks) are most active in a storage resource group,
run the Storage Resource Group - VDisk Workload Activity Details Report.

Running the MDisk Group Details Report
To see statistics about the performance of a managed disk (MDisk) group, run the
MDisk Group Details Report.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Storage

Tiering.
2. Click MDisk Group Details Report.
3. Select a storage virtualizer, and then select an MDisk group.
4. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

5. Click Finish.
Related reference:
“MDisk Group Details Report”
Use the MDisk Group Details Report to monitor the workload activity of a
managed disk (MDisk) group.

MDisk Group Details Report
Use the MDisk Group Details Report to monitor the workload activity of a
managed disk (MDisk) group.

The report provides information about the workload activity and capacity of a
selected MDisk group. Based on the information that is provided in the report, you
can analyze storage services for an MDisk group.
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Reporting period

The name of the storage virtualizer, the name of the MDisk group, the date filter
such as Last 7 days, and the reporting period are displayed on the report.

If you select All as the search filter when you run a report, the system date is
displayed as the start date for the report. Depending on the time zone, 1969 or
1970 is displayed in the year field of the start date.

Retention of report data

If you remove an MDisk group or a VDisk, the daily data that is collected for
reports is retained for a configurable period. The default is 90 days. If you run a
report after the data retention period expired, the daily data for the MDisk group
or the VDisk is unavailable.

Read I/O rate capability

If you do not set the back-end pool properties of an MDisk group:
v Not Set is displayed in the MDisk Group Read I/O Rate Capability column
v Not Available is displayed in the MDisk Group Read I/O Rate Availability

column

If the read I/O rate capability of an MDisk group is less than the maximum read
I/O rate of the MDisk group, negative values are displayed in the report.

Threshold values

The names of the threshold values in the report that are used to monitor workload
activity for MDisk groups are:
v Actual Size Threshold
v Read I/O Rate Threshold
v Max Read Response Time Threshold
v Max Write Response Time Threshold

Threshold values are set during installation. If a threshold value is changed during
a reporting period, the original value and the new threshold value are displayed as
minimum and maximum values. If, for example, the value of the actual size
threshold is changed during a reporting period from 50% to 60%, the name of the
column is changed to MDisk Group Available Size < Actual Size Threshold of {50 -
60%}. The convention that is used to represent a threshold value is a number
followed by the percent sign and enclosed in brackets: {%}. When the report is run,
the variable value is replaced with the threshold value. To calculate whether read
or write response time thresholds are exceeded, the following formula is used:
(maximum_response_time_value × maximum_response_time_threshold_value)÷ 100.

Tip: To monitor the workload activity of all MDisk groups in a storage virtualizer,
run the MDisk Groups - Workload Activity report.

Report output

The following information is provided about the MDisk group:

MDisk Group
The name of the MDisk group.
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MDisk Group Report Date
The date that the data was collected for the report.

MDisk Group Capacity Status
If the storage capacity that is allocated is less than the actual storage
capacity, a status value of OK is displayed. If the storage capacity that is
allocated is more than the actual storage capacity, a status value of Warning
is displayed. The actual capacity of the MDisk group is calculated as
follows:
(mdisk_group_real_capacity_value ÷ mdisk_group_capacity_value) × 100

MDisk Group Capacity (GB)
The total storage capacity in GB of all of the disks in the MDisk group.

MDisk Group Real Capacity (GB)
The total amount in GB of real storage capacity in the MDisk group.

MDisk Group Free Space (GB)
The total amount of remaining capacity in GB that can be allocated to
increase the size of an existing VDisk, or allocated to an additional VDisk.

MDisk Group Available Size < Actual Size Threshold of {%}
If the amount of storage space that is available for allocation to VDisks is
less than the actual size threshold, Yes is displayed in the column. If the
amount of storage space that is available for allocation to VDisks is more
than the actual size threshold, No is displayed in the column.

MDisk Group Read I/O Rate (ops/s)
The read I/O rate of the MDisk group in operations per second.

MDisk Group Read I/O Rate Capability (ops/s)
The read I/O capability rate of the MDisk group in operations per second.

Tip: To find out how the read I/O capability rate is calculated, see “Read
I/O capability formula” on page 1272

MDisk Group Max Read I/O Rate (ops/s)
The maximum read I/O rate of the MDisk group in operations per second.

MDisk Group Read I/O Rate Availability (ops/s)
The difference between the read I/O capability rate and the maximum read
I/O rate in operations per second.

MDisk Group Read I/O Rate Availability < Read I/O Rate Capability Threshold
of {%} The availability rate for read I/O operations is compared with the read

I/O rate capability threshold. If the availability rate for read I/O
operations is less than the read I/O rate capability threshold, Yes is
displayed in the column. If the availability rate for read I/O operations is
more than the read I/O rate capability threshold, No is displayed in the
column.

MDisk Group Max Read Response Time (ms/op)
The maximum read response time in milliseconds per operation.

MDisk Group Max Read Response Time Threshold of {%} Exceeded By
(hr.:min.)

The number of hours and minutes that the maximum read response time
threshold is exceeded over a 24 hour period.

MDisk Group Average Read Response Time (ms/op)
The average read response time in milliseconds per operation.
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MDisk Group Max Write I/O Rate (ops/s)
The maximum write I/O rate in operations per second.

MDisk Group Max Write Response Time (ms/op)
The maximum write response time in milliseconds per operation.

MDisk Group Max Write Response Time Threshold of {%} Exceeded By
(hr.:min.)

The number of hours and minutes that the maximum write response time
threshold is exceeded over a 24 hour period.

MDisk Group Average Write Response Time (ms/op)
The average write response time in milliseconds per operation.

MDisk Group Average Write I/O Size (KB)
The average size of write I/O operations in KB.

Related tasks:
“Running the MDisk Group Details Report” on page 1265
To see statistics about the performance of a managed disk (MDisk) group, run the
MDisk Group Details Report.

Running the VDisk Details Report
To see information about a virtual disk (VDisk), run the VDisk Details Report.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Storage

Tiering.
2. Click VDisk Details Report.
3. Select a storage virtualizer, and then select a VDisk.
4. Optional: To limit the time frame of the report, specify a date filter or a date

range. To reduce the amount of information that is retrieved, change the default
date filter. It is easier to analyze small amounts of information over shorter
periods.

Tip: Before you specify a start date and an end date, you must select Date
Range (below) from the list of filters.

5. Click Finish.
Related reference:
“VDisk Details Report”
Use the VDisk Details Report to monitor the workload activity of a virtual disk
(VDisk) in a managed disk group.

VDisk Details Report
Use the VDisk Details Report to monitor the workload activity of a virtual disk
(VDisk) in a managed disk group.

Based on the information that the report provides, you can analyze the
performance of a VDisk in a managed disk (MDisk) group.

Reporting period

If you select All as the search filter when you run a report, the system date is
displayed as the start date for the report. Depending on the time zone, 1969 or
1970 is displayed in the year field of the start date.
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Retention of report data

If you remove an MDisk group or a VDisk, the daily data that is collected for
reports is retained for a configurable period. The default is 90 days. If you run a
report after the data retention period expired, the daily data for the MDisk group
or the VDisk is unavailable.

Threshold values

The names of the threshold values that are used in the report to monitor workload
activity for VDisks are as follows:
v VDisk Max Read Response Time Threshold
v VDisk Max Write Response Time Threshold
v Max Read Cache Hits Time Threshold
v Max Read I/O Rate Threshold
v Max Write I/O Rate Threshold

Threshold values are set during installation. If a threshold value is changed during
a reporting period, the original value and the new threshold value are displayed as
minimum and maximum values. If, for example, the VDisk maximum read
response time threshold value is changed during a reporting period from 70% to
80%, the name of the column is changed to VDisk Max Read Response Time
Threshold of {70 - 80%} Exceeded By (hr.:min.). The convention that is used to
represent a threshold value is a number followed by the percent sign and enclosed
in brackets: {%}. When the report is run, the variable value is replaced with the
threshold value. To calculate whether read or write response time thresholds are
exceeded, the following formula is used: (maximum_response_time_value ×
maximum_response_time_threshold value)/100. The result is converted from seconds
to hours and minutes, and displayed in the report. Read and write response times
are sampled at 5-minute intervals over a 24-hour period.

Report output

The following information is displayed about the VDisk:

MDisk Group
The name of the MDisk group.

VDisk The name of the VDisk.

VDisk Report Date
The date that the data was collected for the report.

VDisk Capacity (GB)
The total storage capacity of the VDisk in GB.

VDisk Thin Provisioning Status
The warning level threshold is set in the thin provisioning profile for the
VDisk. The threshold is exceeded when the capacity of the VDisk that is
used exceeds or is equal to the warning level threshold. If the used
capacity of the VDisk in GB is ≥ the specified warning threshold value, a
status value of Warning is displayed. If the used capacity of the VDisk in
GB is < the specified warning threshold value, a status value of OK is
displayed. If thin provisioning is not used, a status value of Not
Applicable is displayed.

VDisk Peak Utilization (%)
The highest value of VDisk utilization over a 24-hour period.
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VDisk Read I/O rate (ops/s)
The read I/O rate of the VDisk in operations per second.

VDisk Max Read I/O rate (ops/s)
The maximum read I/O rate of the VDisk in operations per second.

VDisk Average Read Response Time (ms/op)
The average read response time in milliseconds per operation.

VDisk Max Read Response Time (ms/op)
The maximum read response time in milliseconds per operation.

VDisk Max Read Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Write I/O Rate (ops/s)
The write I/O rate in operations per second.

VDisk Average Write Response Time (ms/op)
The average write response time in milliseconds per operation.

VDisk Max Write Response Time (ms/op)
The maximum write response time in milliseconds per operation.

VDisk Max Write Response Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum write response time
threshold for the VDisk is exceeded over a 24 hour period.

VDisk Max Read Density Rate (ops/s per GB)
The maximum read density rate in operations per second per GB. This
value is calculated by dividing the maximum read I/O rate in operations
per second by the number of GB that the VDisk was allocated.

VDisk I/O Rate Share of Total VDisk Read I/O Rate (%)
The maximum read I/O rate of the VDisk as a percentage of the total
maximum read I/O rate of all the VDisks in the MDisk group.

VDisk Capacity Share of Total VDisk Capacity (%)
The real capacity of the VDisk as a percentage of the real capacity of all the
VDisks in the MDisk group.

VDisk Average Read Cache Hits (%)
The average read cache hits in percent.

VDisk Max Read Cache Hits (%)
The maximum read cache hits in percent.

VDisk Max Read Cache Hits Time Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read cache hits time
threshold is exceeded over a 24 hour period.

VDisk Max Read I/O Rate Threshold of {%} Exceeded By (hr.:min.)
The number of hours and minutes that the maximum read I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write I/O Rate Threshold {%} Exceeded of By (hr.:min.)
The number of hours and minutes that the maximum write I/O rate
threshold is exceeded over a 24 hour period.

VDisk Max Write Cache Delay I/O Rate (ops/s)
The maximum write cache delay I/O rate of the VDisk in operations per
second.

1270 IBM Tivoli Storage Productivity Center: User's Guide



Related tasks:
“Running the VDisk Details Report” on page 1268
To see information about a virtual disk (VDisk), run the VDisk Details Report.

Running the Volume Migration Recommendation Report
To see volumes that might require migration to other pools, run the Volume
Migration Recommendation Report.

You must create policies that specify the performance conditions for volumes.

To run the report with the default settings, click Finish. By default all of the
policies in the list are selected.

Tip: To select a policy, click the policy. To select multiple policies, press Ctrl and
click the policies. To select a series of policies, select the first policy, and then press
Shift and click the last policy.
1. In the Public Folders tab, click IBM Tivoli Productivity Center Storage

Tiering.
2. Click Volume Migration Recommendation Report.
3. Select one or more policies.
4. Click Finish.

If information is available for the policies that you selected, a report is created. If
no information is available for the selected policies, or data collection is
unsuccessful, a message is displayed in the report.
Related reference:
“Volume Migration Recommendation Report”
The Volume Migration Recommendation Report, shows the volumes that comply
with the criteria for migrating volumes to a pool in another storage resource
group. Use the report to identify volumes that might require migration based on
the conditions that are set in tiering policies.

Volume Migration Recommendation Report
The Volume Migration Recommendation Report, shows the volumes that comply
with the criteria for migrating volumes to a pool in another storage resource
group. Use the report to identify volumes that might require migration based on
the conditions that are set in tiering policies.

Report output

The following information is included in reports that recommend actions for a
volume:

Restriction: The recommendations for the migration of a volume for the tiering
policy that you select might not be shown in the report. For example, if the
destination pool that is set in the tiering policy is not available, recommendations
for migrating the volume are not provided in the report. To learn more, see the
section about troubleshooting reports in the IBM Tivoli Storage Productivity Center
Information Center (http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/
index.jsp).

Policy Name
The user-defined name of the tiering policy.
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Storage Virtualizer Current Name
The name of the storage virtualizer where the volume is located.

Storage Pool Current Name
The name of the pool where the volume is located.

Storage Volume Name
The name of the volume that satisfied the conditions for migrating the
volume to a pool in another storage resource group.

Storage Volume WWN
The worldwide name of the volume.

Storage Volume Capacity (GB)
The total amount of storage space on the volume.

Storage Virtualizer Recommended Name
The name of the storage virtualizer where the volume can be relocated.

Storage Pool Recommended Name
The name of the pool in another storage resource group where the volume
can be relocated.

Storage Volume Current Response Time (ms/op)
In the current location for the volume, the longest period for read and
write response times.

Storage Volume Predicted Response Time (ms/op)
In the recommended location for the volume, the longest period for read
and write response times.

Storage Volume Response Time Change (ms/op)
The change in response times is calculated by subtracting the current
response time from the predicted response time.

Related tasks:
“Running the Volume Migration Recommendation Report” on page 1271
To see volumes that might require migration to other pools, run the Volume
Migration Recommendation Report.

Read I/O capability formula
The read I/O capability formula is used by IBM Tivoli Storage Productivity Center
to estimate the workload capacity of managed disk (MDisk) groups.

The estimated workload capacity is compared with the actual workload capacity to
assess the most active and least active MDisk groups in a storage subsystem. To
monitor the workload activity of MDisk groups, you can run customized reports
such as the MDisk Groups - Workload Activity Report. This formula is used for
MDisk groups in the following storage systems:
v SAN Volume Controller
v Storwize V7000
v Storwize V7000 Unified

The formula that is used by IBM Tivoli Storage Productivity Center to estimate the
read I/O capability rate is:

[Estimated Read I/O Workload * Type of Disk I/O Capability * Number of Disks]
/ [Estimated Read I/O Workload * (1 − Cache Hit Ratio) + Estimated Write I/O
Workload * RAID Type Weighted I/O Ratio]
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There are two types of value that are used by the formula:
v Fixed values provided by IBM Tivoli Storage Productivity Center
v Variable values that you must specify for each MDisk group

The following fixed values are used by the formula:

Estimated Read I/O Workload
The estimated read I/O workload of an MDisk group. The estimate is set
to a fixed value of 0.7 (70%).

Estimated Write I/O Workload
The estimated write I/O workload of an MDisk group. The estimate is set
to a fixed value of 0.3 (30%).

You specify the following variable values for each MDisk group:

Type of Disk I/O Capability
When you specify the type of disk that the back-end pool uses:
v You can accept the default I/O capability per second of the disk
v You can enter a new value for the I/O capability per second of the disk

For example, the default value for the I/O capability rate per second of
fiber types of disk with 15,000 revolutions per minute (rpm) is 150 I/O
operations per second. To change the I/O capability for a type of disk, you
issue the setbackenddisktype command and you enter a new value for the
-iops parameter.

Number of Disks
You specify the number of physical disks that the back-end pool uses.

Cache Hit Ratio
When you specify the type of storage system that the back-end pool uses:
v You can accept the default cache hit ratio for the storage system
v You can enter a new value for the cache hit ratio of the storage system

For example, the default cache hit ratio of the XIV system is 0.7 (70%). To
change the cache hit ratio for a type of storage system, you issue the
setbackendtype command and you enter a new value for the -cachehit
parameter.

RAID Type Weighted I/O Ratio
When you specify the type of RAID that the back-end pool uses:
v You can accept the default value for the weighted I/O ratio of the type

of RAID
v You can enter a new value for the weighted I/O ratio of the type of

RAID

For example the weighted I/O ratio for RAID5 types of RAID is 4:1. To
change the weighted I/O ratio for a type of RAID, you issue the
setbackendraidtype command and you enter a new value for the
-weightedio parameter.

Tip: To set the values of back-end pools for an MDisk group, access the MDisk
Group Details page through the Disk Manager > MDisk Groups node of the
navigation tree. You can also use the Tivoli Storage Productivity Center CLI called
tcptool to set the values for back-end pools. See the setarray command. To change
the variable values that are used by the Read I/O capability formula, you must use
the Tivoli Storage Productivity Center CLI.
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Example

The following values have been set for a back-end pool. The type of storage
system is the XIV system. The type of disk is F15 (Fiber - 15 000 rpm), and the
type of RAID is X.

Name of variable Value

Cache Hit Ratio 0.5 (50%)

Type of Disk I/O Capability 150

RAID Type Weighted I/O Ratio 4

Number of Disks 10

Based on the values that are provided, the read I/O capability per second is:

[0.7 * 150 * 10] / [0.7 * (1 − 0.5) + 0.3 * 4]

The read I/O capability per second rate is 677. (The result of the calculation is
rounded to the nearest whole number.)

Changing threshold values in storage tier reports
Use the setdscfg command to change the threshold values in workload activity
reports for managed disk groups and virtual disks.

To change threshold values, you must know the value of the property key that is
associated with the name of the threshold in the report.
1. To start the Tivoli Storage Productivity Center CLI, issue the tpctool command.
2. Issue the setdscfg command, and then set the following values by using the

-property parameter:
a. Specify the name of the threshold with the property_key variable.
b. Specify the new threshold value with the value variable.

The following sample code sets the read I/O rate for MDisk groups to 80%:
tpctool setdscfg -url localhost:9550 -user ***** -pwd ***** -property
ManagedDiskGroupAvailIORate 80

3. Press Enter.

The value of the threshold is changed.
Related reference:
“Threshold values in storage tier reports”
Threshold values are used to assess the workload activity of managed disk
(MDisk) groups and virtual disks (VDisks) in storage tier reports. To change a
threshold value, you must know the value of the property key that corresponds
with the threshold value that is used in the report.

Threshold values in storage tier reports
Threshold values are used to assess the workload activity of managed disk
(MDisk) groups and virtual disks (VDisks) in storage tier reports. To change a
threshold value, you must know the value of the property key that corresponds
with the threshold value that is used in the report.

The following table contains the name of the threshold value and the
corresponding value of the property key for the following reports:
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v The MDisk Groups - Workload Activity Report
v The MDisk Group Details Report

Threshold name in report Property key value

Actual Size Threshold ManagedDiskGroupAvailSize

Read I/O Rate Threshold ManagedDiskGroupAvailIORate

Max Read Response Time Threshold ManagedDiskGroupBERResponseExceeds

Max Write Response Time Threshold ManagedDiskGroupBEWResponseExceeds

The following table contains the name of the threshold value and the
corresponding value of the property key for the following reports:
v MDisk Groups - VDisk Workload Activity Report
v MDisk Groups - VDisk Workload Activity Details Report
v VDisk Details Report
v Storage Resource Group - VDisk Workload Activity Report

Threshold name in report Property key value

VDisk Max Read Response Time Threshold VDiskFERResponseExceeds

VDisk Max Write Response Time Threshold VDiskFEWResponseExceeds

Max Read Cache Hits Time Threshold VDiskFERHitExceeds

Max Read I/O Rate Threshold VDiskFEIORExceeds

Max Write I/O Rate Threshold VDiskFEIOWExceeds

Related tasks:
“Changing threshold values in storage tier reports” on page 1274
Use the setdscfg command to change the threshold values in workload activity
reports for managed disk groups and virtual disks.

Custom reports about performance
You can use Tivoli Common Reporting to create custom performance reports.
Performance reports can contain detailed information about the performance of
monitored resources, and some of the properties of those resources.

The resources for which you can create performance reports are storage systems
and their components, storage virtualizers and their components, and switches and
switch ports. You can add statistics for volumes, back-end arrays, caches, ports,
port errors, and other statistics to performance reports. For example, you can add
key statistics to a report to create and generate a performance chart for a specific
volume of a storage system.

All the performance statistics from the stand-alone GUI are available in the new
reporting interface.

Creating custom performance reports in Tivoli Common
Reporting

You can create reports that show performance statistics in IBM Tivoli Common
Reporting.
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When you create a performance report, include properties and statistics for only
one type of device in the report.

The list that you use to create performance reports does not include information
about the relationships between storage resources. If you include different types of
resources in the report, the report might return incorrect results. For example, if
you include storage virtualizers and storage systems in a report, the report might
return incorrect results.

Tip: Before you run a report, you can preview the report with no data. For more
information about how to preview and run reports, see the IBM Cognos 8 v4
Business Intelligence Information Center at http://publib.boulder.ibm.com/
infocenter/c8bi/v8r4m0/index.jsp, and search for run report query studio.

You must specify the time interval for which you want to view performance
information. You can specify the time interval in two ways:
v Select a time unit, for example, day, day of week, or week of month.
v Select performance statistics from sample data, hourly data, or daily data in the

resource for which you want performance information.

Restriction:

You cannot create custom reports from the following packages:
v IBM Tivoli Storage Productivity Center Historical Information
v IBM Tivoli Storage Productivity Center Storage Tiering
1. Select the IBM Tivoli Storage Productivity Center Performance package.
2. Expand Tivoli Storage Productivity Center in the list.
3. Expand Performance.
4. Optional: Select a time unit from the Time item.
5. Explore the folders in the list to locate the resources, properties, and statistics

that you want to include in the report.
6. Depending on your browser, add properties and statistics to the report:

v Internet Explorer: Drag the items that you want to see information about to
the right pane.

v Firefox: Select the items that you want to see information about, and then
click Insert.

7. Use filters with your performance reports to ensure that your reports do not
include too much data. To use filters with your performance reports, do the
following steps:
a. Add a resource or resource type to the report.
b. Select the column heading for the resource or resource type in the right

pane, then filter the name of the resource or resource type if necessary.
c. Locate the Sample Data, Hourly Data, or Daily Data folder for the resource

or resource type in the list. Then add a time stamp from the list to the right
pane. For example, you can add a Day time stamp to the report.

d. Select the column heading for the time stamp in the right pane, and then
filter the time. If you do not enter a time stamp, the report is run on all the
records for this resource or resource type in Tivoli Storage Productivity
Center.

8. Click Save.
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Data and properties in performance reports
You can include capacity data, properties, and other information about storage
systems, storage virtualizers, and switches in performance reports.

Data for storage systems in performance reports
You can include general information, capacity data, properties, and other
information about storage systems in performance reports.

Information about storage systems

You can create performance reports that include the following information:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Capacity and usage data

You can create performance reports that include the following information:

Storage System Pool Capacity (GiB)
The amount of storage space in pools that are on the storage system. For
an XIV system, this value represents the physical capacity of the pool, not
the virtual capacity. For other storage systems, this value might also
include overhead space if the pool is unformatted.

Storage System Used Pool Space (GiB)
The amount of space that is in use in all pools on a storage system.

Storage System Available Pool Space (GiB)
The amount of unused space in pools that are on the storage system.

Storage System Volume Capacity (GiB)
The amount of space on all volumes on the storage system.

Storage System Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Storage System Assigned Volume Space (GiB)
The amount of space in the pool that is on volumes that are assigned to a
server or storage virtualizer.

Storage System Unallocated Disk Space (GiB)
The amount of disk space that can be added to a pool.

Storage System Number of Disks
The number of disks on the storage system.

Storage System Number of Volumes
The number of volumes on a resource.

Storage System Cache (GiB)
The size of the cache on the storage system.

Storage System Real Available Pool Space (GiB)
The amount of unused space in pools that have an associated soft size on
an XIV system. The soft size of a pool is the virtual size of a
thin-provisioned pool.
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Storage System Real Configured Pool Space (GiB)
The amount of storage space that is in pools that have an associated soft
size on an XIV system. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Storage System Volume Capacity for z/OS (GiB)
The amount of space on all volumes on the storage system that the z/OS
operating system can use.

Storage System Volume Capacity Assigned to MDisks (GiB)
The amount of space that is on volumes that are assigned to a storage
virtualizer to use as managed disks.

Storage System Disk Capacity (GiB)
The amount of storage space on physical disks on the storage system,
excluding spare disks.

Storage System Total Disk Capacity (GiB)
The amount of space on physical disks on a storage system, including
spare disks.

Component properties

You can create performance reports that include the following information:

Storage System Access Information
The URL from which you can access the storage system or storage
virtualizer.

Storage System Code Level
The Shared Ethernet Adapter level of a DS8000 storage system. For other
storage systems, this value is the firmware version.

Storage System Custom Tag 1
User-defined text that is associated with the resource.

Storage System Custom Tag 2
User-defined text that is associated with the resource.

Storage System Custom Tag 3
User-defined text that is associated with the resource.

Storage System User Provided Name
The name that was specified for the storage system in the storage
environment.

Status information

You can create performance reports that include the following information:

Storage System Status
The condition of the resource, for example normal, warning, or error.

Storage System Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Storage System Last Data Collection
The date and time when storage statistics were last collected from the
resource.
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Storage System Last Data Collection Status
The condition of the last data collection. The status can show if the
collection was a success, a failure, or if data was collected from the
resource.

Vendor, model, and device information

You can create performance reports that include the following information:

Storage System Type
The type of storage system. For example, the storage system can be a
DS8000, or an XIV system, or another type of storage system.

Storage System IP Address
The IP address of the resource.

Storage System Model
The model name or model number of the resource.

Storage System Vendor
The vendor who supplied the resource.

Storage System Serial Number
The serial number of the resource.

Statistics for DS6000 and DS8000 storage systems in performance reports:

You can include performance data for ports, port errors, volumes, caches, back-end
arrays, and other data for DS6000 and DS8000 storage systems in performance
reports.

Port data

You can create performance reports that include the following information:

Port Send I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
data is sent from a port.

Port Receive I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
the port receives data.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Port Send Response Time (ms/op)
The average number of milliseconds to complete a send operation.
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Port Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation.

Total Port Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation.

Port Send Transfer Size (KiB/op)
The average number of KiB that are transferred per send operation.

Port Receive Transfer Size (KiB/op)
The average number of KiB that are transferred per receive operation.

Total Port Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both send and receive operations.

Port PPRC Send I/O Rate (ops/s)
The average number of operations per second that are sent using the
Peer-to-Peer Remote Copy protocol.

Port PPRC Receive I/O Rate (ops/s)
The average number of operations per second that are received using the
Peer-to-Peer Remote Copy protocol.

Total Port PPRC I/O Rate (ops/s)
The average number of send operations and receive operations per second
using the Peer-to-Peer Remote Copy protocol.

Port PPRC Send Data Rate (MiB/s)
The average number of MiB per second that are sent using the Peer-to-Peer
Remote Copy protocol.

Port PPRC Receive Data Rate (MiB/s)
The average number of MiB per second that are received using the
Peer-to-Peer Remote Copy protocol.

Total Port PPRC Data Rate (MiB/s)
The average number of MiB per second that are transferred using the
Peer-to-Peer Remote Copy (PPRC) protocol. This value includes both send
and receive PPRC operations.

Port PPRC Send Response Time (ms/op)
The average number of milliseconds to complete a send operation using
the Peer-to-Peer Remote Copy protocol.

Port PPRC Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation using
the Peer-to-Peer Remote Copy protocol.

Total Port PPRC Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation using the Peer-to-Peer Remote Copy (PPRC) protocol.

Port error data

You can create performance reports that include the following information:

Link Failure Rate (count/s)
The average number of link errors per second.

Loss of Sync Rate (count/s)
The average number of times per second that synchronization is lost.
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Synchronization is assumed lost after a timeout interval expires.

Loss of Signal Rate (count/s)
The average number of times per second that the signal is lost.

CRC Error Rate (count/s)
The average number of frames per second that are received in which a
cyclic redundancy check (CRC) error is detected. A CRC error is detected
when the CRC in the transmitted frame does not match the CRC computed
by the receiver.

Primitive Sequence Protocol Error Rate (count/s)
The average number of primitive sequence protocol errors per second that
are detected.

This error occurs when there is a link failure for a port.

Invalid Transmission Word Rate (count/s)
The average number of bit errors per second that are detected.

Error Frame Rate (count/s)
The average number of error frames per second that are received. An error
frame is a frame that violates the Fibre Channel Protocol.

Link Reset Transmitted Rate (count/s)
The average number of times per second that the port changes from an
active (AC) state to a Link Recovery (LR1) state.

Link Reset Received Rate (count/s)
The average number of times per second that the port changes from an
active (AC) state to a Link Recovery (LR2) state.

Out of Order Data Rate (count/s)
The average number of times per second that an out-of-order frame is
detected.

Out of Order ACK Rate (count/s)
The average number of times per second that an out-of-order acknowledge
(ACK) frame is detected.

An ACK frame is used for end-to-end flow control and is sent to verify
receipt of a frame.

Duplicate Frame Rate (count/s)
The average number of duplicate frames per second that are received. A
duplicate frame is one that was previously processed for the port.

Invalid Relative Offset Rate (count/s)
The average number of times per second that frames are received with an
invalid relative offset in the frame header.

Sequence Timeout Rate (count/s)
The average number of times per second that the port detects a timeout
condition after receiving a sequence initiative for a Fibre Channel
exchange.

Volume data

You can create performance reports that include the following information:

Normal Read I/O Rate (ops/s)
The average number of nonsequential read operations per second.
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Sequential Read I/O Rate (ops/s)
The average number of sequential read operations per second.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Normal Write I/O Rate (ops/s)
The average number of nonsequential write operations per second.

Sequential Write I/O Rate (ops/s)
The average number of sequential write operations per second.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Normal I/O Rate (ops/s)
The average number of nonsequential I/O operations per second. This
value includes both read and write operations.

Total Sequential I/O Rate (ops/s)
The average number of sequential I/O operations per second. This value
includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Record Mode Read I/O Rate (ops/s)
The average number of I/O operations per second for record-mode read
operations.
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For record-mode read operations, only the requested data is managed in
the cache rather than a full track of data.

Back-end array data

You can create performance reports that include the following information:

Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Back-End Read Data Rate (MiB/s)
The average number of MiB per second that are read from the back-end
storage resources.

Back-End Write Data Rate (MiB/s)
The average number of MiB per second that are written to the back-end
storage resources.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation from
the back-end storage resources.

Back-End Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation to the
back-end storage resources.
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Overall Back-End Transfer Size (KiB/op)
The average transfer size, in KiB, of a read or a write operation to the
back-end storage resources.

Cache data

You can create performance reports that include the following information:

Normal Read Cache Hit Percentage
The percentage of nonsequential read operations that find data in the
cache.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Sequential Read Cache Hit Percentage
The percentage of sequential read operations that find data in the cache.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Normal Write Cache Hit Percentage
The percentage of nonsequential write operations that are handled in the
cache.

Sequential Write Cache Hit Percentage
The percentage of sequential write operations that are handled in the
cache.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Normal Cache Hit Percentage
The percentage of nonsequential I/O operations that are handled in the
cache. This value includes both read and write operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Total Sequential Cache Hit Percentage
The percentage of sequential I/O operations that are handled in the cache.
This value includes both read and write operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.
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You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Disk to Cache Transfer Rate (ops/s)
The average number of tracks that are transferred per second from the
disks to the cache.

Cache to Disk Transfer Rate (ops/s)
The average number of tracks per second that are transferred from the
cache to the disks.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Write Cache Delay I/O Rate (ops/s)
The average number of I/O operations per second that are delayed
because there is not enough space in the write cache.

Only write operations can be delayed but the value is calculated as an
average of all I/O operations.

Record Mode Read Cache Hit Percentage
The percentage of cache hits for record-mode read operations.

For record-mode read operations, only the requested data, rather than a
full track of data, is managed in the cache.

Other data

You can create performance reports that include the following information:

Cache Holding Time (s)
The average number of seconds that I/O data for a storage system
controller is held in the cache. A short cache holding time indicates adverse
performance.

PPRC Transfer Rate (ops/s)
The average number of tracks per second that are transferred to the
secondary device of a Peer-to-Peer Remote Copy (PPRC) pair. This value
shows the activity for the source of the PPRC relationship, but shows no
activity for the target.

HPF Read I/O Rate (ops/s)
The average number of read operations per second that are issued by the
High Performance FICON® feature of the storage system.

HPF Write I/O Rate (ops/s)
The average number of write operations per second that are issued by the
High Performance FICON feature of the storage system.

Total HPF I/O Rate (ops/s)
The average number of I/O operations per second that are issued by the
High Performance FICON feature of the storage system. This value
includes both read and write operations.

HPF I/O Percentage
The percentage of all I/O operations that are issued by the High
Performance FICON feature of the storage system.
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Statistics for block server systems in performance reports:

You can include performance data for volumes, and cache data for block server
storage systems in performance reports.

Volume data

You can create performance reports that include the following information:

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Overall Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Cache data

You can create performance reports that include the following information:

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.
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You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Statistics for an XIV system in performance reports:

You can include performance data for volumes, caches, and other data for an XIV
system in performance reports.

Volume data

You can create performance reports that include the following information:

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.
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Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Cache data

You can create performance reports that include the following information:

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Read Data Cache Hit Percentage
The percentage of all read data that is read from the cache.

Write Data Cache Hit Percentage
The percentage of all write data that is written to cache slots that are
marked as modified.

Total Data Cache Hit Percentage
The percentage of all data that is handled in the cache. This value includes
read data that is read from the cache and write data that is written to
cache slots that are marked as modified.

Read Cache Miss Response Time (ms/op)
The average number of milliseconds to complete a read-cache miss
operation.

Write Cache Miss Response Time (ms/op)
The average number of milliseconds to complete a write-cache miss
operation.

Overall Cache Miss Response Time (ms/op)
The average number of milliseconds to complete a cache miss operation.
This value includes both read-cache miss and write-cache miss operations.

Read Cache Hit Response Time (ms/op)
The average number of milliseconds to complete a read-cache hit
operation.

Write Cache Hit Response Time (ms/op)
The average number of milliseconds to complete a write-cache hit
operation.
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Overall Cache Hit Response Time (ms/op)
The average number of milliseconds to complete a cache hit operation.
This value includes both read-cache hit and write-cache hit operations.

Other data

You can create performance reports that include the following information:

Small Transfers I/O Percentage
The percentage of I/O operations with a small data transfer size. A small
data transfer has a size that is less than or equal to 8 KiB.

Medium Transfers I/O Percentage
The percentage of I/O operations with a medium data transfer size. A
medium data transfer has a size that is greater than 8 KiB and less than or
equal to 64 KiB.

Large Transfers I/O Percentage
The percentage of I/O operations with a large data transfer size. A large
data transfer has a size that is greater than 64 KiB and less than or equal to
512 KiB.

Very Large Transfers I/O Percentage
The percentage of I/O operations with a very large data transfer size. A
very large data transfer has a size that is greater than 512 KiB.

Small Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a small data transfer size. A small data transfer has a size that is less
than or equal to 8 KiB.

Medium Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a medium data transfer size. A medium data transfer has a size that
is greater than 8 KiB and less than or equal to 64 KiB.

Large Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a large data transfer size. A large data transfer has a size that is
greater than 64 KiB and less than or equal to 512 KiB.

Very Large Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a very large data transfer size. A very large data transfer has a size
that is greater than 512 KiB.

Small Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a small data transfer size. A small data transfer has a size that is less than
or equal to 8 KiB.

Medium Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a medium data transfer size. A medium data transfer has a size that is
greater than 8 KiB and less than or equal to 64 KiB.

Large Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a large data transfer size. A large data transfer has a size that is greater
than 64 KiB and less than or equal to 512 KiB.
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Very Large Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a very large data transfer size. A very large data transfer has a size that is
greater than 512 KiB.

Data for storage system volumes in performance reports
You can include general information, capacity data, properties, and other
information about storage system volumes in performance reports.

Information about storage system volumes

You can create performance reports that include the following information:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage System Controller Name
The name that was assigned to the controller when it was added to the
system.

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Storage System Array Name
The name that was assigned to the array when it was added to the system.

Storage Volume Name
The name that was assigned to the storage volume when it was added to
the system.

Capacity and usage data

You can create performance reports that include the following information:

Storage Volume Capacity (GiB)
The amount of storage space on the volume.

Storage Volume Used Space (GiB)
The amount of virtual space that is used on a thin-provisioned volume. For
volumes that are not thin provisioned, this value is same as the Storage
Volume Capacity value. This property applies only to DS8000 storage
systems.

Storage Volume Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Component properties

You can create performance reports that include the following information:

Storage Volume RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.

Storage Volume Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.
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Storage Volume Is Assigned
Shows whether the volume is assigned to a server. If this value is Yes, the
volume is assigned to a server.

Storage Volume Is Encrypted
Shows whether the resource is encrypted. If this value is Yes, the resource
is encrypted.

Storage Volume Is Encryptable
Shows whether the resource can be encrypted. If this value is Yes, the
resource can be encrypted.

Storage Volume Is Volume Control Manager Database
Shows whether a volume is used as the Volume Control Manager
Database. If this value is Yes, the volume is used as the Volume Control
Manager Database. This property applies only to EMC storage systems.

Storage Volume Format
Shows the format of the volume or pool. The format can be a Count Key
Data (CKD) format, or a fixed block format.

Storage Volume Serial Number
The serial number of the resource.

Storage Volume Number
The number of the volume that is assigned by the system.

Storage Volume WWN
The worldwide name of the volume.

Storage Volume Logical Subsystem
The logical subsystem (LSS) to which a volume or pool belongs.

Status information

You can create performance reports that include the following information:

Storage Volume Status
The condition of the resource, for example normal, warning, or error.

Storage Volume Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Statistics for volumes on DS6000 and DS8000 storage systems in performance
reports:

You can include performance data for volumes, caches, and other data for storage
system volumes on DS6000 and DS8000 storage systems in performance reports.

Volume data

You can create performance reports that include the following information:

Normal Read I/O Rate (ops/s)
The average number of nonsequential read operations per second.

Sequential Read I/O Rate (ops/s)
The average number of sequential read operations per second.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.
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Normal Write I/O Rate (ops/s)
The average number of nonsequential write operations per second.

Sequential Write I/O Rate (ops/s)
The average number of sequential write operations per second.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Normal I/O Rate (ops/s)
The average number of nonsequential I/O operations per second. This
value includes both read and write operations.

Total Sequential I/O Rate (ops/s)
The average number of sequential I/O operations per second. This value
includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Record Mode Read I/O Rate (ops/s)
The average number of I/O operations per second for record-mode read
operations.

For record-mode read operations, only the requested data is managed in
the cache rather than a full track of data.

Volume Utilization
The average percentage of time that the volume is busy.
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Cache data

You can create performance reports that include the following information:

Normal Read Cache Hit Percentage
The percentage of nonsequential read operations that find data in the
cache.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Sequential Read Cache Hit Percentage
The percentage of sequential read operations that find data in the cache.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Normal Write Cache Hit Percentage
The percentage of nonsequential write operations that are handled in the
cache.

Sequential Write Cache Hit Percentage
The percentage of sequential write operations that are handled in the
cache.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Normal Cache Hit Percentage
The percentage of nonsequential I/O operations that are handled in the
cache. This value includes both read and write operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Total Sequential Cache Hit Percentage
The percentage of sequential I/O operations that are handled in the cache.
This value includes both read and write operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.
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Disk to Cache Transfer Rate (ops/s)
The average number of tracks that are transferred per second from the
disks to the cache.

Cache to Disk Transfer Rate (ops/s)
The average number of tracks per second that are transferred from the
cache to the disks.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Write Cache Delay I/O Rate (ops/s)
The average number of I/O operations per second that are delayed
because there is not enough space in the write cache.

Only write operations can be delayed but the value is calculated as an
average of all I/O operations.

Record Mode Read Cache Hit Percentage
The percentage of cache hits for record-mode read operations.

For record-mode read operations, only the requested data, rather than a
full track of data, is managed in the cache.

Other data

You can create performance reports that include the following information:

PPRC Transfer Rate (ops/s)
The average number of tracks per second that are transferred to the
secondary device of a Peer-to-Peer Remote Copy (PPRC) pair. This value
shows the activity for the source of the PPRC relationship, but shows no
activity for the target.

HPF Read I/O Rate (ops/s)
The average number of read operations per second that are issued by the
High Performance FICON feature of the storage system.

HPF Write I/O Rate (ops/s)
The average number of write operations per second that are issued by the
High Performance FICON feature of the storage system.

Total HPF I/O Rate (ops/s)
The average number of I/O operations per second that are issued by the
High Performance FICON feature of the storage system. This value
includes both read and write operations.

HPF I/O Percentage
The percentage of all I/O operations that are issued by the High
Performance FICON feature of the storage system.

Statistics for storage system volumes on block servers in performance reports:

You can include performance data for volumes and caches for storage system
volumes on block servers in performance reports.
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Volume data

You can create performance reports that include the following information:

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Overall Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Volume Utilization
The average percentage of time that the volume is busy.

Cache data

You can create performance reports that include the following information:

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.
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Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Statistics for storage system volumes on an XIV system in performance reports:

You can include performance data for volumes, caches, and other data for storage
system volumes on an XIV system in performance reports.

Volume data

You can create performance reports that include the following information:

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.
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Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Volume Utilization
The average percentage of time that the volume is busy.

Cache data

You can create performance reports that include the following information:

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Read Data Cache Hit Percentage
The percentage of all read data that is read from the cache.

Write Data Cache Hit Percentage
The percentage of all write data that is written to cache slots that are
marked as modified.

Total Data Cache Hit Percentage
The percentage of all data that is handled in the cache. This value includes
read data that is read from the cache and write data that is written to
cache slots that are marked as modified.

Read Cache Miss Response Time (ms/op)
The average number of milliseconds to complete a read-cache miss
operation.

Write Cache Miss Response Time (ms/op)
The average number of milliseconds to complete a write-cache miss
operation.

Overall Cache Miss Response Time (ms/op)
The average number of milliseconds to complete a cache miss operation.
This value includes both read-cache miss and write-cache miss operations.

Read Cache Hit Response Time (ms/op)
The average number of milliseconds to complete a read-cache hit
operation.

Write Cache Hit Response Time (ms/op)
The average number of milliseconds to complete a write-cache hit
operation.
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Overall Cache Hit Response Time (ms/op)
The average number of milliseconds to complete a cache hit operation.
This value includes both read-cache hit and write-cache hit operations.

Other data

You can create performance reports that include the following information:

Small Transfers I/O Percentage
The percentage of I/O operations with a small data transfer size. A small
data transfer has a size that is less than or equal to 8 KiB.

Medium Transfers I/O Percentage
The percentage of I/O operations with a medium data transfer size. A
medium data transfer has a size that is greater than 8 KiB and less than or
equal to 64 KiB.

Large Transfers I/O Percentage
The percentage of I/O operations with a large data transfer size. A large
data transfer has a size that is greater than 64 KiB and less than or equal to
512 KiB.

Very Large Transfers I/O Percentage
The percentage of I/O operations with a very large data transfer size. A
very large data transfer has a size that is greater than 512 KiB.

Small Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a small data transfer size. A small data transfer has a size that is less
than or equal to 8 KiB.

Medium Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a medium data transfer size. A medium data transfer has a size that
is greater than 8 KiB and less than or equal to 64 KiB.

Large Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a large data transfer size. A large data transfer has a size that is
greater than 64 KiB and less than or equal to 512 KiB.

Very Large Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a very large data transfer size. A very large data transfer has a size
that is greater than 512 KiB.

Small Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a small data transfer size. A small data transfer has a size that is less than
or equal to 8 KiB.

Medium Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a medium data transfer size. A medium data transfer has a size that is
greater than 8 KiB and less than or equal to 64 KiB.

Large Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a large data transfer size. A large data transfer has a size that is greater
than 64 KiB and less than or equal to 512 KiB.
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Very Large Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a very large data transfer size. A very large data transfer has a size that is
greater than 512 KiB.

Data for storage system ports in performance reports
You can include general information, properties, and other information about
storage system ports in performance reports.

Information about storage system ports

You can create performance reports that include the following information:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Module Name
The name that was assigned to the module when it was added to the
system.

Storage System Port Name
The name that was assigned to the storage port when the storage system
was added to the system.

Component properties

You can create performance reports that include the following information:

Storage System Port Number
The port number on the resource.

Storage System Port Type
The type of port on the storage system, storage virtualizer, or switch. For
example, the port type can be N_Port, F_Port, or another type of port.

Storage System Port Speed (GiB/s)
The speed of a port, measured in GiB per second.

Status information

You can create performance reports that include the following information:

Storage System Port Status
The condition of the resource, for example normal, warning, or error.

Storage System Port Enabled State
Shows whether a port is enabled, disabled, or is enabled but offline.

Storage System Port Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Statistics for ports on DS6000 and DS8000 storage systems in performance
reports:

You can include performance data for storage system port and port errors on
DS6000 and DS8000 storage systems in performance reports.
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Port data

You can create performance reports that include the following information:

Port Send I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
data is sent from a port.

Port Receive I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
the port receives data.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Port Send Response Time (ms/op)
The average number of milliseconds to complete a send operation.

Port Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation.

Overall Port Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation.

Port Send Transfer Size (KiB/op)
The average number of KiB that are transferred per send operation.

Port Receive Transfer Size (KiB/op)
The average number of KiB that are transferred per receive operation.

Total Port Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both send and receive operations.

Port FICON Send I/O Rate (ops/s)
The average number of send operations per second for Fibre Channel
connection (FICON) usage.

Port FICON Receive I/O Rate (ops/s)
The average number of receive operations per second for FICON usage.

Total Port FICON I/O Rate (ops/s)
The average number of send and receive operations per second for FICON
usage.

Port FICON Send Data Rate (MiB/s)
The average number of MiB per second that is sent for FICON usage.

Port FICON Receive Data Rate (MiB/s)
The average number of MiB per second that is received for FICON usage.
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Total Port FICON Data Rate (MiB/s)
The average number of MiB per second that is transferred for FICON
usage. This value includes both send and receive FICON operations.

Port FICON Send Response Time (ms/op)
The average number of milliseconds to complete a send operation for
FICON usage.

Port FICON Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation for
FICON usage.

Total Port FICON Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation for FICON usage. This value includes both send and receive
FICON operations.

Port PPRC Send I/O Rate (ops/s)
The average number of operations per second that are sent using the
Peer-to-Peer Remote Copy protocol.

Port PPRC Receive I/O Rate (ops/s)
The average number of operations per second that are received using the
Peer-to-Peer Remote Copy protocol.

Total Port PPRC I/O Rate (ops/s)
The average number of send operations and receive operations per second
using the Peer-to-Peer Remote Copy protocol.

Port PPRC Send Data Rate (MiB/s)
The average number of MiB per second that are sent using the Peer-to-Peer
Remote Copy protocol.

Port PPRC Receive Data Rate (MiB/s)
The average number of MiB per second that are received using the
Peer-to-Peer Remote Copy protocol.

Total Port PPRC Data Rate (MiB/s)
The average number of MiB per second that are transferred using the
Peer-to-Peer Remote Copy (PPRC) protocol. This value includes both send
and receive PPRC operations.

Port PPRC Send Response Time (ms/op)
The average number of milliseconds to complete a send operation using
the Peer-to-Peer Remote Copy protocol.

Port PPRC Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation using
the Peer-to-Peer Remote Copy protocol.

Total Port PPRC Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation using the Peer-to-Peer Remote Copy (PPRC) protocol.

Port Send Utilization Percentage
The average percentage of time that the port is busy sending data.

Port Receive Utilization Percentage
The average percentage of time that the port is busy receiving data.

Overall Port Utilization Percentage
The average percentage of time that the port is busy sending or receiving
data.
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Port FCP Send I/O Rate (ops/s)
The average number of send operations per second for Fibre Channel
Protocol (FCP) usage.

Port FCP Receive I/O Rate (ops/s)
The average number of receive operations per second for FCP usage.

Total Port FCP I/O Rate (ops/s)
The average number of send operations and receive operations per second
for FCP usage.

Port FCP Send Data Rate (MiB/s)
The average number of MiB per second that are sent for FCP usage.

Port FCP Receive Data Rate (MiB/s)
The average number of MiB per second that are received for FCP usage.

Total Port FCP Data Rate (MiB/s)
The average number of MiB per second that are transferred for FCP usage.
This value includes both send and receive FCP operations.

Port FCP Send Response Time (ms/op)
The average number of milliseconds to complete a send operation for FCP
usage.

Port FCP Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation for
FCP usage.

Total Port FCP Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation for FCP usage.

Port Send Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Port Receive Bandwidth Percentage
The percentage of the port bandwidth that is used for receive operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Port error data

You can create performance reports that include the following information:

Error Frame Rate (count/s)
The average number of error frames per second that are received. An error
frame is a frame that violates the Fibre Channel Protocol.

Link Failure Rate (count/s)
The average number of link errors per second.

Loss of Sync Rate (count/s)
The average number of times per second that synchronization is lost.

Synchronization is assumed lost after a timeout interval expires.
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Loss of Signal Rate (count/s)
The average number of times per second that the signal is lost.

CRC Error Rate (count/s)
The average number of frames per second that are received in which a
cyclic redundancy check (CRC) error is detected. A CRC error is detected
when the CRC in the transmitted frame does not match the CRC computed
by the receiver.

Primitive Sequence Protocol Error Rate (count/s)
The average number of primitive sequence protocol errors per second that
are detected.

This error occurs when there is a link failure for a port.

Invalid Transmission Word Rate (count/s)
The average number of bit errors per second that are detected.

Out of Order Data Rate (count/s)
The average number of times per second that an out-of-order frame is
detected.

Out of Order ACK Rate (count/s)
The average number of times per second that an out-of-order acknowledge
(ACK) frame is detected.

An ACK frame is used for end-to-end flow control and is sent to verify
receipt of a frame.

Duplicate Frame Rate (count/s)
The average number of duplicate frames per second that are received. A
duplicate frame is one that was previously processed for the port.

Invalid Relative Offset Rate (count/s)
The average number of times per second that frames are received with an
invalid relative offset in the frame header.

Sequence Timeout Rate (count/s)
The average number of times per second that the port detects a timeout
condition after receiving a sequence initiative for a Fibre Channel
exchange.

Link Reset Transmitted Rate (count/s)
The average number of times per second that the port changes from an
active (AC) state to a Link Recovery (LR1) state.

Link Reset Received Rate (count/s)
The average number of times per second that the port changes from an
active (AC) state to a Link Recovery (LR2) state.

Statistics for storage system ports on block servers in performance reports:

You can include performance data for storage system ports on block servers in
performance reports.

Port data

You can create performance reports that include the following information:

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Chapter 9. Reporting in the web-based GUI 1303



Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Port Send I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
data is sent from a port.

Port Receive I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
the port receives data.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Statistics for ports on an XIV system in performance reports:

You can include performance data for storage system ports on an XIV system in
performance reports.

Port data

You can create performance reports that include the following information:

Port Send I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
data is sent from a port.

Port Receive I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
the port receives data.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.
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Port Send Response Time (ms/op)
The average number of milliseconds to complete a send operation.

Port Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation.

Overall Port Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation.

Port Send Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Port Receive Bandwidth Percentage
The percentage of the port bandwidth that is used for receive operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Data for storage system arrays in performance reports
You can include general information, capacity data, and properties of storage
system arrays in performance reports.

Information about storage system arrays

You can create performance reports that include the following information:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage System Controller Name
The name that was assigned to the controller when it was added to the
system.

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Storage System Array Name
The name that was assigned to the array when it was added to the system.

Capacity and usage data

You can create performance reports that include the following information:

Storage System Array DDM Capacity (GiB)
The amount of storage space on the disk drive modules in an array.

Component properties

You can create performance reports that include the following information:

Storage System Array RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.
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Storage System Array Width
The number of disks that are in the storage array.

Storage System Array DDM Speed (RPM)
The speed of the disk drive module in the array.

Storage System Array Description
Shows the array site that the array is associated with.

Storage System Array Tag
A number that identifies an array.

Statistics for storage system arrays in performance reports:

You can include front end data, cache data, back-end data, and other data for
storage system arrays in performance reports.

Front end data

You can create performance reports that include the following information:

Normal Read I/O Rate (ops/s)
The average number of nonsequential read operations per second.

Sequential Read I/O Rate (ops/s)
The average number of sequential read operations per second.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Normal Write I/O Rate (ops/s)
The average number of nonsequential write operations per second.

Sequential Write I/O Rate (ops/s)
The average number of sequential write operations per second.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Normal I/O Rate (ops/s)
The average number of nonsequential I/O operations per second. This
value includes both read and write operations.

Total Sequential I/O Rate (ops/s)
The average number of sequential I/O operations per second. This value
includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.
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Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Record Mode Read I/O Rate (ops/s)
The average number of I/O operations per second for record-mode read
operations.

For record-mode read operations, only the requested data is managed in
the cache rather than a full track of data.

Cache data

You can create performance reports that include the following information:

Normal Read Cache Hit Percentage
The percentage of nonsequential read operations that find data in the
cache.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Sequential Read Cache Hit Percentage
The percentage of sequential read operations that find data in the cache.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Normal Write Cache Hit Percentage
The percentage of nonsequential write operations that are handled in the
cache.

Sequential Write Cache Hit Percentage
The percentage of sequential write operations that are handled in the
cache.
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Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Normal Cache Hit Percentage
The percentage of nonsequential I/O operations that are handled in the
cache. This value includes both read and write operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Total Sequential Cache Hit Percentage
The percentage of sequential I/O operations that are handled in the cache.
This value includes both read and write operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Record Mode Read Cache Hit Percentage
The percentage of cache hits for record-mode read operations.

For record-mode read operations, only the requested data, rather than a
full track of data, is managed in the cache.

Disk to Cache Transfer Rate (ops/s)
The average number of tracks that are transferred per second from the
disks to the cache.

Cache to Disk Transfer Rate (ops/s)
The average number of tracks per second that are transferred from the
cache to the disks.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Write Cache Delay I/O Rate (ops/s)
The average number of I/O operations per second that are delayed
because there is not enough space in the write cache.

Only write operations can be delayed but the value is calculated as an
average of all I/O operations.

Back-end data

You can create performance reports that include the following information:
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Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Back-End Read Data Rate (MiB/s)
The average number of MiB per second that are read from the back-end
storage resources.

Back-End Write Data Rate (MiB/s)
The average number of MiB per second that are written to the back-end
storage resources.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation from
the back-end storage resources.

Back-End Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation to the
back-end storage resources.

Overall Back-End Transfer Size (KiB/op)
The average transfer size, in KiB, of a read or a write operation to the
back-end storage resources.

Sequential Back-End I/O Percentage
The percentage of all I/O operations that are issued to the back-end
storage resources. The operations are for the array and are sequential
operations.
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Other data

You can create performance reports that include the following information:

Disk Utilization Percentage
The average percentage of time that the disks that are associated with an
array are busy.

No value is calculated for this column if there are multiple ranks in the
extent pool where the thin-provisioned volumes are allocated. In this case,
N/A appears in this column. This limitation applies only to DS8000 storage
systems.

If there is only a single rank in the extent pool, the value for this column is
calculated regardless of the thin-provisioned volumes.

PPRC Transfer Rate (ops/s)
The average number of tracks per second that are transferred to the
secondary device of a Peer-to-Peer Remote Copy (PPRC) pair. This value
shows the activity for the source of the PPRC relationship, but shows no
activity for the target.

HPF Read I/O Rate (ops/s)
The average number of read operations per second that are issued by the
High Performance FICON feature of the storage system.

HPF Write I/O Rate (ops/s)
The average number of write operations per second that are issued by the
High Performance FICON feature of the storage system.

Total HPF I/O Rate (ops/s)
The average number of I/O operations per second that are issued by the
High Performance FICON feature of the storage system. This value
includes both read and write operations.

HPF I/O Percentage
The percentage of all I/O operations that are issued by the High
Performance FICON feature of the storage system.

Data for storage system controllers in performance reports
You can include general information about storage system controllers in
performance reports.

Information about storage system controllers

You can create performance reports that include the following information:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Storage System Controller Name
The name that was assigned to the controller when it was added to the
system.

Statistics for storage system controllers on DS6000 and DS8000 systems in
performance reports:

You can include front end data, cache data, back-end data, and other data for
storage system controllers on DS6000 and DS8000 series systems in performance
reports.
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Front end data

You can create performance reports that include the following information:

Normal Read I/O Rate (ops/s)
The average number of nonsequential read operations per second.

Sequential Read I/O Rate (ops/s)
The average number of sequential read operations per second.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Normal Write I/O Rate (ops/s)
The average number of nonsequential write operations per second.

Sequential Write I/O Rate (ops/s)
The average number of sequential write operations per second.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Normal I/O Rate (ops/s)
The average number of nonsequential I/O operations per second. This
value includes both read and write operations.

Total Sequential I/O Rate (ops/s)
The average number of sequential I/O operations per second. This value
includes both read and write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Record Mode Read I/O Rate (ops/s)
The average number of I/O operations per second for record-mode read
operations.

For record-mode read operations, only the requested data is managed in
the cache rather than a full track of data.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.
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Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Cache data

You can create performance reports that include the following information:

Normal Read Cache Hit Percentage
The percentage of nonsequential read operations that find data in the
cache.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Sequential Read Cache Hit Percentage
The percentage of sequential read operations that find data in the cache.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Normal Write Cache Hit Percentage
The percentage of nonsequential write operations that are handled in the
cache.

Sequential Write Cache Hit Percentage
The percentage of sequential write operations that are handled in the
cache.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Normal Cache Hit Percentage
The percentage of nonsequential I/O operations that are handled in the
cache. This value includes both read and write operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Total Sequential Cache Hit Percentage
The percentage of sequential I/O operations that are handled in the cache.
This value includes both read and write operations.
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You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Record Mode Read Cache Hit Percentage
The percentage of cache hits for record-mode read operations.

For record-mode read operations, only the requested data, rather than a
full track of data, is managed in the cache.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Disk to Cache Transfer Rate (ops/s)
The average number of tracks that are transferred per second from the
disks to the cache.

Cache to Disk Transfer Rate (ops/s)
The average number of tracks per second that are transferred from the
cache to the disks.

Write Cache Delay I/O Rate (ops/s)
The average number of I/O operations per second that are delayed
because there is not enough space in the write cache.

Only write operations can be delayed but the value is calculated as an
average of all I/O operations.

Back-end data

You can create performance reports that include the following information:

Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Back-End Read Data Rate (MiB/s)
The average number of MiB per second that are read from the back-end
storage resources.
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Back-End Write Data Rate (MiB/s)
The average number of MiB per second that are written to the back-end
storage resources.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation from
the back-end storage resources.

Back-End Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation to the
back-end storage resources.

Overall Back-End Transfer Size (KiB/op)
The average transfer size, in KiB, of a read or a write operation to the
back-end storage resources.

Other data

You can create performance reports that include the following information:

Cache Holding Time (s)
The average number of seconds that I/O data for a storage system
controller is held in the cache. A short cache holding time indicates adverse
performance.

PPRC Transfer Rate (ops/s)
The average number of tracks per second that are transferred to the
secondary device of a Peer-to-Peer Remote Copy (PPRC) pair. This value
shows the activity for the source of the PPRC relationship, but shows no
activity for the target.

HPF Read I/O Rate (ops/s)
The average number of read operations per second that are issued by the
High Performance FICON feature of the storage system.
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HPF Write I/O Rate (ops/s)
The average number of write operations per second that are issued by the
High Performance FICON feature of the storage system.

Total HPF I/O Rate (ops/s)
The average number of I/O operations per second that are issued by the
High Performance FICON feature of the storage system. This value
includes both read and write operations.

HPF I/O Percentage
The percentage of all I/O operations that are issued by the High
Performance FICON feature of the storage system.

Statistics for storage system controllers on block servers in performance reports:

You can include performance data for volumes and caches for storage system
controllers on block servers in performance reports.

Volume data

You can create performance reports that include the following information:

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.
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Overall Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Cache data

You can create performance reports that include the following information:

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Data for storage system modules in performance reports
You can include properties of storage system modules, and other information
about storage system modules in performance reports.

Information about storage system modules

You can create performance reports that include the following information:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Module Name
The name that was assigned to the module when it was added to the
system.

Component properties

You can create performance reports that include the following information:

XIV System Module IP Address
The IP address of the resource.

XIV System Module WWN
The worldwide name of the module.

Status information

You can create performance reports that include the following information:

XIV System Module Status
The condition of the resource, for example normal, warning, or error.
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XIV System Module Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Statistics for storage system modules on an XIV system in performance reports:

You can include performance data for volumes, caches, and other data for storage
system modules on an XIV system in performance reports.

Volume data

You can create performance reports that include the following information:

Read I/O Rate (ops/s)
The average number of read operations per second.

Write I/O Rate (ops/s)
The average number of write operations per second.

Total I/O Rate (ops/s)
The average number of I/O operations per second for both read and write
operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Cache data

You can create performance reports that include the following information:

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.
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You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Read Data Cache Hit Percentage
The percentage of all read data that is read from the cache.

Write Data Cache Hit Percentage
The percentage of all write data that is written to cache slots that are
marked as modified.

Total Data Cache Hit Percentage
The percentage of all data that is handled in the cache. This value includes
read data that is read from the cache and write data that is written to
cache slots that are marked as modified.

Read Cache Hit Response Time (ms/op)
The average number of milliseconds to complete a read-cache hit
operation.

Write Cache Hit Response Time (ms/op)
The average number of milliseconds to complete a write-cache hit
operation.

Overall Cache Hit Response Time (ms/op)
The average number of milliseconds to complete a cache hit operation.
This value includes both read-cache hit and write-cache hit operations.

Read Cache Miss Response Time (ms/op)
The average number of milliseconds to complete a read-cache miss
operation.

Write Cache Miss Response Time (ms/op)
The average number of milliseconds to complete a write-cache miss
operation.

Overall Cache Miss Response Time (ms/op)
The average number of milliseconds to complete a cache miss operation.
This value includes both read-cache miss and write-cache miss operations.

Other data

You can create performance reports that include the following information:

Small Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a small data transfer size. A small data transfer has a size that is less
than or equal to 8 KiB.
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Medium Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a medium data transfer size. A medium data transfer has a size that
is greater than 8 KiB and less than or equal to 64 KiB.

Large Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a large data transfer size. A large data transfer has a size that is
greater than 64 KiB and less than or equal to 512 KiB.

Very Large Transfers Data Percentage
The percentage of data that is transferred as a result of I/O operations
with a very large data transfer size. A very large data transfer has a size
that is greater than 512 KiB.

Small Transfers I/O Percentage
The percentage of I/O operations with a small data transfer size. A small
data transfer has a size that is less than or equal to 8 KiB.

Medium Transfers I/O Percentage
The percentage of I/O operations with a medium data transfer size. A
medium data transfer has a size that is greater than 8 KiB and less than or
equal to 64 KiB.

Large Transfers I/O Percentage
The percentage of I/O operations with a large data transfer size. A large
data transfer has a size that is greater than 64 KiB and less than or equal to
512 KiB.

Very Large Transfers I/O Percentage
The percentage of I/O operations with a very large data transfer size. A
very large data transfer has a size that is greater than 512 KiB.

Small Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a small data transfer size. A small data transfer has a size that is less than
or equal to 8 KiB.

Medium Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a medium data transfer size. A medium data transfer has a size that is
greater than 8 KiB and less than or equal to 64 KiB.

Large Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a large data transfer size. A large data transfer has a size that is greater
than 64 KiB and less than or equal to 512 KiB.

Very Large Transfers Response Time (ms/op)
The average number of milliseconds to complete an I/O operation that has
a very large data transfer size. A very large data transfer has a size that is
greater than 512 KiB.

Data for storage virtualizers in performance reports
You can include general information, capacity data, properties, and other
information about storage virtualizers in performance reports.

Information about storage virtualizers

You can create performance reports that include the following information:
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Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Capacity and usage data

You can create performance reports that include the following information:

Storage Virtualizer Total Pool Capacity (GiB)
The amount of storage space in pools on the storage virtualizer.

Storage Virtualizer Pool Used Space (GiB)
The amount of storage space that is used in the pool on the storage
virtualizer.

Storage Virtualizer Pool Available Space (GiB)
The amount of unused storage space in a storage virtualizer pool.

Storage Virtualizer Total Volume Capacity (GiB)
The amount of virtual volume space on all volumes on the storage
virtualizer.

Storage Virtualizer Volume Allocated Space (GiB)
The amount of storage space that is allocated to volumes.

Storage Virtualizer Volume Assigned Space (GiB)
The amount of virtual volume space that is assigned to the server or
storage virtualizer.

Storage Virtualizer MDisk Available Space (GiB)
The amount of space on managed disks that is available to be added to a
pool.

Storage Virtualizer MDisk Capacity (GiB)
The amount of storage space on the managed disk.

Storage Virtualizer Disk Capacity (GiB)
The amount of local disk storage on the storage virtualizer.

Storage Virtualizer Number of MDisks
The number of managed disks on a resource.

Storage Virtualizer Number of Volumes
The number of volumes on a resource.

Storage Virtualizer Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Component properties

You can create performance reports that include the following information:

Storage Virtualizer Access Information
The URL from which you can access the storage system or storage
virtualizer.

Storage Virtualizer Alias
Shows an alternative name for a storage virtualizer.

Storage Virtualizer Code Level
The microcode or firmware level of the storage virtualizer.
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Storage Virtualizer Time Zone
The time zone in which a resource is located.

Storage Virtualizer Custom Tag 1
User-defined text that is associated with the resource.

Storage Virtualizer Custom Tag 2
User-defined text that is associated with the resource.

Storage Virtualizer Custom Tag 3
User-defined text that is associated with the resource.

Storage Virtualizer User Provided Name
The name that was specified for the storage virtualizer in the storage
environment.

Status information

You can create performance reports that include the following information:

Storage Virtualizer Status
The condition of the resource, for example normal, warning, or error.

Storage Virtualizer Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Storage Virtualizer Last Data Collection
The date and time when storage statistics were last collected from the
resource.

Storage Virtualizer Last Data Collection Status
The condition of the last data collection. The status can show if the
collection was a success, a failure, or if data was collected from the
resource.

Vendor, model, and device information

You can create performance reports that include the following information:

Storage Virtualizer IP Address
The IP address of the resource.

Storage Virtualizer Serial Number
The serial number of the resource.

Storage Virtualizer Type
The type of storage virtualizer. For example, the storage virtualizer can be
a Storwize V7000 system, a Storwize V7000 Unified system, or a SAN
Volume Controller.

Storage Virtualizer Model
The model name or model number of the resource.

Storage Virtualizer Vendor
The vendor who supplied the resource.

Statistics for storage virtualizers in performance reports:

You can include performance data for ports, port errors, volumes, caches, back-end
arrays, and other data for storage virtualizers in performance reports.
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Port data

You can create performance reports that include the following information:

Port Send I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
data is sent from a port.

Port Receive I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
the port receives data.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Port to Host Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to host
computers.

Port to Host Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from host
computers.

Total Port to Host I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
host computers and the component.

Port to Disk Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to back-end
storage resources.

Port to Disk Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from
back-end storage resources.

Total Port to Disk I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
back-end storage resources and the component. This value includes both
send and receive operations.

Port to Local Node Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to other nodes
that are in the local SAN Volume Controller cluster.

Port to Local Node Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from other
nodes that are in the local SAN Volume Controller cluster.
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Total Port to Local Node I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
the component and other nodes that are in the local SAN Volume
Controller cluster.

Port to Remote Node Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to nodes that
are in the remote SAN Volume Controller cluster.

Port to Remote Node Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from nodes
that are in the remote SAN Volume Controller cluster.

Total Port to Remote Node I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
the component and nodes that are in the remote SAN Volume Controller
cluster.

Port to Host Send Data Rate (MiB/s)
The average rate at which data is sent to host computers. The rate is
measured in MiB per second.

Port to Host Receive Data Rate (MiB/s)
The average rate at which data is received from host computers. The rate is
measured in MiB per second.

Total Port to Host Data Rate (MiB/s)
The average rate at which data is transmitted between host computers and
the component. The rate is measured in MiB per second and includes both
send and receive operations.

Port to Disk Send Data Rate (MiB/s)
The average rate at which data is sent to back-end storage resources. The
rate is measured in MiB per second.

Port to Disk Receive Data Rate (MiB/s)
The average rate at which data is received from back-end storage
resources. The rate is measured in MiB per second.

Total Port to Disk Data Rate (MiB/s)
The average rate at which data is transmitted between back-end storage
resources and the component. The rate is measured in MiB per second and
includes both send and receive operations.

Port to Local Node Send Data Rate (MiB/s)
The average rate at which data is sent to other nodes that are in the local
SAN Volume Controller cluster. The rate is measured in MiB per second.

Port to Local Node Receive Data Rate (MiB/s)
The average rate at which data is received from other nodes that are in the
local SAN Volume Controller cluster. The rate is measured in MiB per
second.

Total Port to Local Node Data Rate (MiB/s)
The average rate at which data is transmitted between the component and
other nodes that are in the local SAN Volume Controller cluster. The rate is
measured in MiB per second.

Port to Remote Node Send Data Rate (MiB/s)
The average rate at which data is sent to nodes that are in the remote SAN
Volume Controller cluster. The rate is measured in MiB per second.
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Port to Remote Node Receive Data Rate (MiB/s)
The average rate at which data is received from nodes that are in the
remote SAN Volume Controller cluster. The rate is measured in MiB per
second.

Total Port to Remote Node Data Rate (MiB/s)
The average rate at which data is transmitted between the component and
nodes that are in the remote SAN Volume Controller cluster. The rate is
measured in MiB per second.

Port to Local Node Send Response Time (ms/op)
The average number of milliseconds to complete a send operation to
another node that is in the local SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Port to Local Node Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation from
another node that is in the local SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Overall Port to Local Node Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation with another node that is in the local SAN Volume Controller
cluster. This value represents the external response time of the transfers.

Port to Local Node Send Queue Time (ms/op)
The average time in milliseconds that a send operation spends in the
queue before being processed. This value represents the queue time for
send operations that are issued to other nodes that are in the local SAN
Volume Controller cluster.

Port to Local Node Receive Queue Time (ms/op)
The average time in milliseconds that a receive operation spends in the
queue before being processed. This value represents the queue time for
receive operations that are issued from other nodes that are in the local
SAN Volume Controller cluster.

Overall Port to Local Node Queue Time (ms/op)
The average number of milliseconds that a send or receive operation
spends in the queue before being processed. This value is for send and
receive operations that are issued between the component and other nodes
that are in the local SAN Volume Controller cluster.

Port to Remote Node Send Response Time (ms/op)
The average number of milliseconds to complete a send operation to a
node that is in the remote SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Port to Remote Node Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation from a
node that is in the remote SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Overall Port to Remote Node Response Time (ms/op)
The average number of milliseconds to complete a send operation to, or a
receive operation from a node that is in the remote SAN Volume Controller
cluster. This value represents the external response time of the transfers.

Port to Remote Node Send Queue Time (ms/op)
The average time in milliseconds that a send operation spends in the
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queue before being processed. This value represents the queue time for
send operations that are issued to a node that is in the remote SAN
Volume Controller cluster.

Port to Remote Node Receive Queue Time (ms/op)
The average time in milliseconds that a receive operation spends in the
queue before being processed. This value represents the queue time for
receive operations that are issued from a node that is in the remote SAN
Volume Controller cluster.

Overall Port to Remote Node Queue Time (ms/op)
The average number of milliseconds that a send or receive operation
spends in the queue before being processed. This value is for send and
receive operations that are issued between the component and a node that
is in the remote SAN Volume Controller cluster.

Port error data

You can create performance reports that include the following information:

Link Failure Rate (count/s)
The average number of link errors per second.

Loss of Sync Rate (count/s)
The average number of times per second that synchronization is lost.

Synchronization is assumed lost after a timeout interval expires.

Loss of Signal Rate (count/s)
The average number of times per second that the signal is lost.

CRC Error Rate (count/s)
The average number of frames per second that are received in which a
cyclic redundancy check (CRC) error is detected. A CRC error is detected
when the CRC in the transmitted frame does not match the CRC computed
by the receiver.

Primitive Sequence Protocol Error Rate (count/s)
The average number of primitive sequence protocol errors per second that
are detected.

This error occurs when there is a link failure for a port.

Invalid Transmission Word Rate (count/s)
The average number of bit errors per second that are detected.

Volume data

You can create performance reports that include the following information:

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.
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Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Cache data

You can create performance reports that include the following information:

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Disk to Cache Transfer Rate (ops/s)
The average number of tracks that are transferred per second from the
disks to the cache.

Cache to Disk Transfer Rate (ops/s)
The average number of tracks per second that are transferred from the
cache to the disks.
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Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Write Cache Delay I/O Rate (ops/s)
The average number of I/O operations per second that are delayed
because there is not enough space in the write cache.

Only write operations can be delayed but the value is calculated as an
average of all I/O operations.

Read Ahead Percentage of Cache Hits
The percentage of all read-cache hits that occur on pre-staged data.

Dirty Write Percentage of Cache Hits
The percentage of all cache write operations that occur on data in the cache
that is marked as modified. This value represents how effectively writes
are coalesced before being written to disk.

Write Cache Overflow Percentage
The percentage of write operations that are delayed because there is not
enough space in the write cache.

Write Cache Overflow I/O Rate (ops/s)
The average number of write operations per second that are delayed
because there is not enough space in the write cache.

Write Cache Flush Through Percentage
The percentage of tracks that are written to disk in flush-through mode.

Write Cache Flush Through I/O Rate (ops/s)
The average number of tracks per second that are written to disk in
flush-through mode.

Write Cache Write Through Percentage
The percentage of tracks that are written to disk in write-through mode.

Write Cache Write Through I/O Rate (ops/s)
The average number of tracks per second that are written to disk in
write-through mode.

Back-end array data

You can create performance reports that include the following information:

Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.
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Back-End Read Data Rate (MiB/s)
The average number of MiB per second that are read from the back-end
storage resources.

Back-End Write Data Rate (MiB/s)
The average number of MiB per second that are written to the back-end
storage resources.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Read Queue Time (ms/op)
The average number of milliseconds that a read operation spends in the
queue before being sent to the back-end storage resources.

Back-End Write Queue Time (ms/op)
The average number of milliseconds that write operations spend in the
queue before being sent to the back-end storage resources.

Overall Back-End Queue Time (ms/op)
The average number of milliseconds that a read or a write operation
spends in the queue before being sent to the back-end storage resources.

Back-End Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation from
the back-end storage resources.

Back-End Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation to the
back-end storage resources.

Overall Back-End Transfer Size (KiB/op)
The average transfer size, in KiB, of a read or a write operation to the
back-end storage resources.

Peak Back-End Read Response Time (ms)
The longest time for a back-end storage resource to respond to a read
operation.
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Peak Back-End Write Response Time (ms)
The longest time for a back-end storage resource to respond to a write
operation.

Peak Back-End Read Queue Time (ms)
The longest time that a read operation spends in the queue before being
sent to the back-end storage resources.

Peak Back-End Write Queue Time (ms)
The longest time that a write operation spends in the queue before being
sent to the back-end storage resources.

Other data

You can create performance reports that include the following information:

Global Mirror Write I/O Rate (op/s)
The average number of write operations per second that are issued to the
Global Mirror secondary site.

Global Mirror Overlapping Write Percentage
The percentage of overlapping write operations that are issued by the
Global Mirror primary site.

For SAN Volume Controller software releases 4.3.1 and later, some
overlapping writes are processed in parallel and are excluded from this
value. For SAN Volume Controller software releases 4.3.0 and earlier, all
overlapping writes are serialized.

Global Mirror Overlapping Write I/O Rate (op/s)
The average number of overlapping write operations per second that are
issued by the Global Mirror primary site.

For SAN Volume Controller software releases 4.3.1 and later, some
overlapping writes are processed in parallel and are excluded from this
value. For SAN Volume Controller software releases 4.3.0 and earlier, all
overlapping writes are serialized.

Peak Read Response Time (ms)
The longest time to complete a read operation.

Peak Write Response Time (ms)
The longest time to complete a write operation.

Global Mirror Secondary Write Lag (ms/op)
The average number of milliseconds to service a secondary write operation
for Global Mirror. This value does not include the time to service the
primary write operation.

You monitor the value of Global Mirror Secondary Write Lag to identify
delays that occurred while writing data to the secondary site.

Processor Utilization Percentage
The average percentage of time that the processors are busy.

Overall Host Attributed Response Time Percentage
The percentage of the average response time that can be attributed to
delays from host systems. This value includes both read response times
and write response times, and can help you diagnose slow hosts and
fabrics that are not working efficiently.

The value is based on the following conditions:
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v For read response time, the time that it takes for hosts to respond to
transfer-ready notifications from the SAN Volume Controller nodes.

v For write response time, the time that it takes for hosts to send the write
data after the node responds to a transfer-ready notification.

Zero Buffer to Buffer Credit Timer (microseconds)
The number of microseconds that the port is unable to send frames
because there is not enough buffer credit.

Buffer credits are used in Fibre Channel technology to control the flow of
frames between ports. This value is measured from the time of the last
node reset.

Data for managed disks on storage virtualizers in performance
reports
You can include general information, capacity data, properties, and other
information about managed disks on storage virtualizers in performance reports.

Information about managed disks on storage virtualizers

You can create performance reports that include the following information:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer MDisk Name
The name that was assigned to the managed disk on a storage virtualizer
when it was added to the system.

Capacity and usage data

You can create performance reports that include the following information:

Storage Virtualizer MDisk Capacity (GiB)
The amount of storage space on the managed disk.

Storage Virtualizer MDisk Available Space (GiB)
The amount of space on managed disks that is available to be added to a
pool.

Storage Virtualizer MDisk Strip Size (KB)
The number of blocks in a strip on a storage virtualizer managed disk.

Component properties

You can create performance reports that include the following information:

Storage Virtualizer MDisk RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.

Storage Virtualizer MDisk Spare Goal
The number of spare drives that are needed to maintain redundancy. Use
spare drives to protect against drive failures in the array on a managed
disk on a storage virtualizer.
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Storage Virtualizer MDisk Type
The type of managed disk on a storage virtualizer. For example, the
storage virtualizer can be a local or virtual managed disk.

Storage Virtualizer MDisk Mode
The access mode of a managed disk on a storage virtualizer. The access
mode describes how extents are provided for virtual disks. Extents can be
provided to virtual disks in the following ways:

Array Extents are provided from local disks.

Managed
Extents are provided from a back-end storage volume.

Unmanaged
The managed disk is not used in the system.

Storage Virtualizer MDisk Is Balanced
Shows whether logical unit numbers (LUNs) are properly balanced across
storage controllers on the managed disk. If this value is Yes, the LUNs are
properly balanced.

Storage Virtualizer MDisk Fast Write State
Shows whether the cache for a volume on a disk that is managed by a
storage virtualizer is empty, contains data, or is corrupted.

Storage Virtualizer MDisk Write Verify
Shows whether all write operations on the storage virtualizer managed
disk are verified by an immediate follow-up read operation. The follow-up
read operation verifies that the write operation was successful. If this value
is Yes, all write operations are verified by a follow-up read operation.

Status information

You can create performance reports that include the following information:

Storage Virtualizer MDisk Status
The condition of the resource, for example normal, warning, or error.

Storage Virtualizer MDisk Native Status
Shows the level of access of nodes in the system to the storage virtualizer
managed disk or volume. The level of access can be online, offline,
degraded, or excluded.

Statistics for managed disks on storage virtualizers in performance reports:

You can include performance data for back-end arrays on storage-virtualizer
managed disks in performance reports.

Back-end array data

You can create performance reports that include the following information:

Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.
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Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Back-End Read Data Rate (MiB/s)
The average number of MiB per second that are read from the back-end
storage resources.

Back-End Write Data Rate (MiB/s)
The average number of MiB per second that are written to the back-end
storage resources.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Read Queue Time (ms/op)
The average number of milliseconds that a read operation spends in the
queue before being sent to the back-end storage resources.

Back-End Write Queue Time (ms/op)
The average number of milliseconds that write operations spend in the
queue before being sent to the back-end storage resources.

Overall Back-End Queue Time (ms/op)
The average number of milliseconds that a read or a write operation
spends in the queue before being sent to the back-end storage resources.

Back-End Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation from
the back-end storage resources.

Back-End Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation to the
back-end storage resources.

Overall Back-End Transfer Size (KiB/op)
The average transfer size, in KiB, of a read or a write operation to the
back-end storage resources.
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Peak Back-End Read Response Time (ms)
The longest time for a back-end storage resource to respond to a read
operation.

Peak Back-End Write Response Time (ms)
The longest time for a back-end storage resource to respond to a write
operation.

Peak Back-End Read Queue Time (ms)
The longest time that a read operation spends in the queue before being
sent to the back-end storage resources.

Peak Back-End Write Queue Time (ms)
The longest time that a write operation spends in the queue before being
sent to the back-end storage resources.

Data for storage virtualizer volumes in performance reports
You can include general information, capacity data, properties, and other
information about storage virtualizer volumes in performance reports.

Information about storage virtualizer volumes

You can create performance reports that include the following information:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Storage Virtualizer I/O Group Name
The name that was assigned to the I/O group on a storage virtualizer
when it was added to the system.

Storage Virtualizer Volume Name
The name that was assigned to the storage virtualizer volume when it was
added to the system.

Capacity and usage data

You can create performance reports that include the following information:

Storage Virtualizer Volume Capacity (GiB)
The amount of storage space on the volume.

Storage Virtualizer Volume Used Space (GiB)
The amount of virtual space that is used on a thin-provisioned volume. For
volumes that are not thin provisioned, this value is same as the Storage
Virtualizer Volume Capacity value.

Storage Virtualizer Volume Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Component properties

You can create performance reports that include the following information:
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Storage Virtualizer Volume Type
The type of storage virtualizer volume. For example, the storage virtualizer
volume can be striped, sequential, or another type of storage virtualizer
volume.

Storage Virtualizer Volume WWN
The worldwide name of the volume.

Storage Virtualizer Volume Fast Write State
Shows whether the cache for a volume on a disk that is managed by a
storage virtualizer is empty, contains data, or is corrupted.

Storage Virtualizer Volume Grain Size (KiB)
The unit in which space is allocated from a volume. Larger grain sizes
maximize performance. Smaller grain sizes maximize space efficiency.

Storage Virtualizer Volume Is Assigned
Shows whether the volume is assigned to a server. If this value is Yes, the
volume is assigned to a server.

Storage Virtualizer Volume Is Auto Expand Enabled
Shows whether a volume or volume copy can allocate new extents from a
pool automatically. Volumes or volume copies might allocate new extents
to expand the real capacity of the storage virtualizer volume or volume
copy. If this value is Yes, the volume or volume copy can allocate new
extents from a pool automatically.

Storage Virtualizer Volume Is Encryptable
Shows whether the resource can be encrypted. If this value is Yes, the
resource can be encrypted.

Storage Virtualizer Volume Is Encrypted
Shows whether the resource is encrypted. If this value is Yes, the resource
is encrypted.

Storage Virtualizer Volume Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.

Storage Virtualizer Volume Metro Mirror Name
The name of the Metro Mirror that keeps the synchronous copy of the
storage virtualizer volume.

Storage Virtualizer Volume Mirror Count
The number of mirrors that keep a synchronous copy of the resource.

Storage Virtualizer Volume Preferred Node
The number of the storage virtualizer node that is used for I/O operations
for the storage virtualizer volume.

Storage Virtualizer Volume Throttle
The maximum number of commands that the storage virtualizer volume
can queue.

Storage Virtualizer Volume Warning Level
The percentage of used capacity of the resource at which a warning is
generated.

Storage Virtualizer Volume Copy Relationship
Shows whether a volume or a copy of a volume is in a FlashCopy
relationship or a point-in-time relationship. This property can contain the
following values:
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Source Relationship
The volume is the source of the relationship.

Target Relationship
The volume is the target of the relationship.

Both Source and Target Relationship
The volume is both the source and target of the relationship.

This property applies only to SAN Volume Controller.

Status information

You can create performance reports that include the following information:

Storage Virtualizer Volume Status
The condition of the resource, for example normal, warning, or error.

Storage Virtualizer Volume Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Storage Virtualizer Volume Native Status
Shows the level of access of nodes in the system to the storage virtualizer
managed disk or volume. The level of access can be online, offline,
degraded, or excluded.

Statistics for storage virtualizer volumes in performance reports:

You can include performance data for volumes, caches, and other data for storage
virtualizer volumes in performance reports.

Volume data

You can create performance reports that include the following information:

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.
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Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Overall Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Volume Utilization
The average percentage of time that the volume is busy.

Cache data

You can create performance reports that include the following information:

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Disk to Cache Transfer Rate (ops/s)
The average number of tracks that are transferred per second from the
disks to the cache.

Cache to Disk Transfer Rate (ops/s)
The average number of tracks per second that are transferred from the
cache to the disks.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Write Cache Delay I/O Rate (ops/s)
The average number of I/O operations per second that are delayed
because there is not enough space in the write cache.
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Only write operations can be delayed but the value is calculated as an
average of all I/O operations.

Read Ahead Percentage of Cache Hits
The percentage of all read-cache hits that occur on pre-staged data.

Dirty Write Percentage of Cache Hits
The percentage of all cache write operations that occur on data in the cache
that is marked as modified. This value represents how effectively writes
are coalesced before being written to disk.

Write Cache Overflow Percentage
The percentage of write operations that are delayed because there is not
enough space in the write cache.

Write Cache Overflow I/O Rate (ops/s)
The average number of write operations per second that are delayed
because there is not enough space in the write cache.

Write Cache Flush Through Percentage
The percentage of tracks that are written to disk in flush-through mode.

Write Cache Flush Through I/O Rate (ops/s)
The average number of tracks per second that are written to disk in
flush-through mode.

Write Cache Write Through Percentage
The percentage of tracks that are written to disk in write-through mode.

Write Cache Write Through I/O Rate (ops/s)
The average number of tracks per second that are written to disk in
write-through mode.

Other data

You can create performance reports that include the following information:

Global Mirror Write I/O Rate (op/s)
The average number of write operations per second that are issued to the
Global Mirror secondary site.

Global Mirror Overlapping Write Percentage
The percentage of overlapping write operations that are issued by the
Global Mirror primary site.

For SAN Volume Controller software releases 4.3.1 and later, some
overlapping writes are processed in parallel and are excluded from this
value. For SAN Volume Controller software releases 4.3.0 and earlier, all
overlapping writes are serialized.

Global Mirror Overlapping Write I/O Rate (op/s)
The average number of overlapping write operations per second that are
issued by the Global Mirror primary site.

For SAN Volume Controller software releases 4.3.1 and later, some
overlapping writes are processed in parallel and are excluded from this
value. For SAN Volume Controller software releases 4.3.0 and earlier, all
overlapping writes are serialized.

Peak Read Response Time (ms)
The longest time to complete a read operation.
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Peak Write Response Time (ms)
The longest time to complete a write operation.

Global Mirror Secondary Write Lag (ms/op)
The average number of milliseconds to service a secondary write operation
for Global Mirror. This value does not include the time to service the
primary write operation.

You monitor the value of Global Mirror Secondary Write Lag to identify
delays that occurred while writing data to the secondary site.

Overall Host Attributed Response Time Percentage
The percentage of the average response time that can be attributed to
delays from host systems. This value includes both read response times
and write response times, and can help you diagnose slow hosts and
fabrics that are not working efficiently.

The value is based on the following conditions:
v For read response time, the time that it takes for hosts to respond to

transfer-ready notifications from the SAN Volume Controller nodes.
v For write response time, the time that it takes for hosts to send the write

data after the node responds to a transfer-ready notification.

Nonpreferred Node Usage Percentage
The overall percentage of I/O performed or data transferred over the
non-preferred nodes of the virtual disks.

Data for storage virtualizer nodes in performance reports
You can include properties, and other information about storage virtualizer nodes
in performance reports.

Information about storage virtualizer nodes

You can create performance reports that include the following information:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Node Name
The name that was assigned to the storage virtualizer node when it was
added to the system.

Storage Virtualizer I/O Group Name
The name that was assigned to the I/O group on a storage virtualizer
when it was added to the system.

Component properties

You can create performance reports that include the following information:

Storage Virtualizer Node IP Address
The IP address of the resource.

Storage Virtualizer Node WWN
The worldwide name of the node.

Storage Virtualizer Node Configuration
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Status information

You can create performance reports that include the following information:

Storage Virtualizer Node Status
Shows whether a storage virtualizer node is online.

Statistics for storage virtualizer nodes in performance reports:

You can include port data, front end data, cache data, back-end data, and other
data for storage virtualizer nodes in performance reports.

Port data

You can create performance reports that include the following information:

Port Send I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
data is sent from a port.

Port Receive I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
the port receives data.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Port to Host Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to host
computers.

Port to Host Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from host
computers.

Total Port to Host I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
host computers and the component.

Port to Disk Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to back-end
storage resources.

Port to Disk Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from
back-end storage resources.
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Total Port to Disk I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
back-end storage resources and the component. This value includes both
send and receive operations.

Port to Local Node Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to other nodes
that are in the local SAN Volume Controller cluster.

Port to Local Node Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from other
nodes that are in the local SAN Volume Controller cluster.

Total Port to Local Node I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
the component and other nodes that are in the local SAN Volume
Controller cluster.

Port to Remote Node Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to nodes that
are in the remote SAN Volume Controller cluster.

Port to Remote Node Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from nodes
that are in the remote SAN Volume Controller cluster.

Total Port to Remote Node I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
the component and nodes that are in the remote SAN Volume Controller
cluster.

Port to Host Send Data Rate (MiB/s)
The average rate at which data is sent to host computers. The rate is
measured in MiB per second.

Port to Host Receive Data Rate (MiB/s)
The average rate at which data is received from host computers. The rate is
measured in MiB per second.

Total Port to Host Data Rate (MiB/s)
The average rate at which data is transmitted between host computers and
the component. The rate is measured in MiB per second and includes both
send and receive operations.

Port to Disk Send Data Rate (MiB/s)
The average rate at which data is sent to back-end storage resources. The
rate is measured in MiB per second.

Port to Disk Receive Data Rate (MiB/s)
The average rate at which data is received from back-end storage
resources. The rate is measured in MiB per second.

Total Port to Disk Data Rate (MiB/s)
The average rate at which data is transmitted between back-end storage
resources and the component. The rate is measured in MiB per second and
includes both send and receive operations.

Port to Local Node Send Data Rate (MiB/s)
The average rate at which data is sent to other nodes that are in the local
SAN Volume Controller cluster. The rate is measured in MiB per second.
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Port to Local Node Receive Data Rate (MiB/s)
The average rate at which data is received from other nodes that are in the
local SAN Volume Controller cluster. The rate is measured in MiB per
second.

Total Port to Local Node Data Rate (MiB/s)
The average rate at which data is transmitted between the component and
other nodes that are in the local SAN Volume Controller cluster. The rate is
measured in MiB per second.

Port to Remote Node Send Data Rate (MiB/s)
The average rate at which data is sent to nodes that are in the remote SAN
Volume Controller cluster. The rate is measured in MiB per second.

Port to Remote Node Receive Data Rate (MiB/s)
The average rate at which data is received from nodes that are in the
remote SAN Volume Controller cluster. The rate is measured in MiB per
second.

Total Port to Remote Node Data Rate (MiB/s)
The average rate at which data is transmitted between the component and
nodes that are in the remote SAN Volume Controller cluster. The rate is
measured in MiB per second.

Port to Local Node Send Response Time (ms/op)
The average number of milliseconds to complete a send operation to
another node that is in the local SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Port to Local Node Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation from
another node that is in the local SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Overall Port to Local Node Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation with another node that is in the local SAN Volume Controller
cluster. This value represents the external response time of the transfers.

Port to Local Node Send Queue Time (ms/op)
The average time in milliseconds that a send operation spends in the
queue before being processed. This value represents the queue time for
send operations that are issued to other nodes that are in the local SAN
Volume Controller cluster.

Port to Local Node Receive Queue Time (ms/op)
The average time in milliseconds that a receive operation spends in the
queue before being processed. This value represents the queue time for
receive operations that are issued from other nodes that are in the local
SAN Volume Controller cluster.

Overall Port to Local Node Queue Time (ms/op)
The average number of milliseconds that a send or receive operation
spends in the queue before being processed. This value is for send and
receive operations that are issued between the component and other nodes
that are in the local SAN Volume Controller cluster.

Port to Remote Node Send Response Time (ms/op)
The average number of milliseconds to complete a send operation to a
node that is in the remote SAN Volume Controller cluster. This value
represents the external response time of the transfers.
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Port to Remote Node Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation from a
node that is in the remote SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Overall Port to Remote Node Response Time (ms/op)
The average number of milliseconds to complete a send operation to, or a
receive operation from a node that is in the remote SAN Volume Controller
cluster. This value represents the external response time of the transfers.

Port to Remote Node Send Queue Time (ms/op)
The average time in milliseconds that a send operation spends in the
queue before being processed. This value represents the queue time for
send operations that are issued to a node that is in the remote SAN
Volume Controller cluster.

Port to Remote Node Receive Queue Time (ms/op)
The average time in milliseconds that a receive operation spends in the
queue before being processed. This value represents the queue time for
receive operations that are issued from a node that is in the remote SAN
Volume Controller cluster.

Overall Port to Remote Node Queue Time (ms/op)
The average number of milliseconds that a send or receive operation
spends in the queue before being processed. This value is for send and
receive operations that are issued between the component and a node that
is in the remote SAN Volume Controller cluster.

Front end data

You can create performance reports that include the following information:

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Overall Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.
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Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Cache data

You can create performance reports that include the following information:

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Read Ahead Percentage of Cache Hits
The percentage of all read-cache hits that occur on pre-staged data.

Dirty Write Percentage of Cache Hits
The percentage of all cache write operations that occur on data in the cache
that is marked as modified. This value represents how effectively writes
are coalesced before being written to disk.

Write Cache Overflow Percentage
The percentage of write operations that are delayed because there is not
enough space in the write cache.

Write Cache Flush Through Percentage
The percentage of tracks that are written to disk in flush-through mode.
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Write Cache Write Through Percentage
The percentage of tracks that are written to disk in write-through mode.

Write Cache Delay I/O Rate (ops/s)
The average number of I/O operations per second that are delayed
because there is not enough space in the write cache.

Only write operations can be delayed but the value is calculated as an
average of all I/O operations.

Write Cache Overflow I/O Rate (ops/s)
The average number of write operations per second that are delayed
because there is not enough space in the write cache.

Write Cache Flush Through I/O Rate (ops/s)
The average number of tracks per second that are written to disk in
flush-through mode.

Write Cache Write Through I/O Rate (ops/s)
The average number of tracks per second that are written to disk in
write-through mode.

Disk to Cache Transfer Rate (ops/s)
The average number of tracks that are transferred per second from the
disks to the cache.

Cache to Disk Transfer Rate (ops/s)
The average number of tracks per second that are transferred from the
cache to the disks.

Back-end data

You can create performance reports that include the following information:

Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Back-End Read Data Rate (MiB/s)
The average number of MiB per second that are read from the back-end
storage resources.

Back-End Write Data Rate (MiB/s)
The average number of MiB per second that are written to the back-end
storage resources.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.
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For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Read Queue Time (ms/op)
The average number of milliseconds that a read operation spends in the
queue before being sent to the back-end storage resources.

Back-End Write Queue Time (ms/op)
The average number of milliseconds that write operations spend in the
queue before being sent to the back-end storage resources.

Overall Back-End Queue Time (ms/op)
The average number of milliseconds that a read or a write operation
spends in the queue before being sent to the back-end storage resources.

Back-End Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation from
the back-end storage resources.

Back-End Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation to the
back-end storage resources.

Overall Back-End Transfer Size (KiB/op)
The average transfer size, in KiB, of a read or a write operation to the
back-end storage resources.

Peak Back-End Read Response Time (ms)
The longest time for a back-end storage resource to respond to a read
operation.

Peak Back-End Write Response Time (ms)
The longest time for a back-end storage resource to respond to a write
operation.

Peak Back-End Read Queue Time (ms)
The longest time that a read operation spends in the queue before being
sent to the back-end storage resources.

Peak Back-End Write Queue Time (ms)
The longest time that a write operation spends in the queue before being
sent to the back-end storage resources.

Other data

You can create performance reports that include the following information:
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Global Mirror Write I/O Rate (op/s)
The average number of write operations per second that are issued to the
Global Mirror secondary site.

Global Mirror Overlapping Write Percentage
The percentage of overlapping write operations that are issued by the
Global Mirror primary site.

For SAN Volume Controller software releases 4.3.1 and later, some
overlapping writes are processed in parallel and are excluded from this
value. For SAN Volume Controller software releases 4.3.0 and earlier, all
overlapping writes are serialized.

Global Mirror Overlapping Write I/O Rate (op/s)
The average number of overlapping write operations per second that are
issued by the Global Mirror primary site.

For SAN Volume Controller software releases 4.3.1 and later, some
overlapping writes are processed in parallel and are excluded from this
value. For SAN Volume Controller software releases 4.3.0 and earlier, all
overlapping writes are serialized.

Global Mirror Secondary Write Lag (ms/op)
The average number of milliseconds to service a secondary write operation
for Global Mirror. This value does not include the time to service the
primary write operation.

You monitor the value of Global Mirror Secondary Write Lag to identify
delays that occurred while writing data to the secondary site.

Peak Read Response Time (ms)
The longest time to complete a read operation.

Peak Write Response Time (ms)
The longest time to complete a write operation.

Link Failure Rate (count/s)
The average number of link errors per second.

Loss of Sync Rate (count/s)
The average number of times per second that synchronization is lost.

Synchronization is assumed lost after a timeout interval expires.

Loss of Signal Rate (count/s)
The average number of times per second that the signal is lost.

CRC Error Rate (count/s)
The average number of frames per second that are received in which a
cyclic redundancy check (CRC) error is detected. A CRC error is detected
when the CRC in the transmitted frame does not match the CRC computed
by the receiver.

Primitive Sequence Protocol Error Rate (count/s)
The average number of primitive sequence protocol errors per second that
are detected.

This error occurs when there is a link failure for a port.

Invalid Transmission Word Rate (count/s)
The average number of bit errors per second that are detected.

Processor Utilization Percentage
The average percentage of time that the processors are busy.
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Overall Host Attributed Response Time Percentage
The percentage of the average response time that can be attributed to
delays from host systems. This value includes both read response times
and write response times, and can help you diagnose slow hosts and
fabrics that are not working efficiently.

The value is based on the following conditions:
v For read response time, the time that it takes for hosts to respond to

transfer-ready notifications from the SAN Volume Controller nodes.
v For write response time, the time that it takes for hosts to send the write

data after the node responds to a transfer-ready notification.

Zero Buffer to Buffer Credit Timer (microseconds)
The number of microseconds that the port is unable to send frames
because there is not enough buffer credit.

Buffer credits are used in Fibre Channel technology to control the flow of
frames between ports. This value is measured from the time of the last
node reset.

Data for storage virtualizer I/O groups in performance reports
You can include general information, capacity data, and properties of storage
virtualizer I/O groups in performance reports.

Information about storage virtualizer I/O groups

You can create performance reports that include the following information:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer I/O Group Name
The name that was assigned to the I/O group on a storage virtualizer
when it was added to the system.

Capacity and usage data

You can create performance reports that include the following information:

Storage Virtualizer I/O Group Mirroring Total Memory (MiB)
The total amount of memory on the nodes in an I/O group that provides
volume mirroring functions.

Storage Virtualizer I/O Group Mirroring Free Memory (MiB)
The amount of available memory on the nodes in an I/O group that
provides volume mirroring functions.

Storage Virtualizer I/O Group FlashCopy Total Memory (MiB)
The total amount of memory on the nodes in an I/O group that provides
FlashCopy mirroring functions.

Storage Virtualizer I/O Group FlashCopy Free Memory (MiB)
The amount of available memory on the nodes in an I/O group that
provides FlashCopy mirroring functions.

Storage Virtualizer I/O Group Remote Copy Total Memory (MiB)
The total amount of memory on the nodes in an I/O group that provides
mirroring functions using a remote copy.
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Storage Virtualizer I/O Group Remote Copy Free Memory (MiB)
The amount of available memory on the nodes in an I/O group that
provides mirroring functions using a remote copy.

Storage Virtualizer I/O Group RAID Total Memory (MiB)
The total amount of memory on the nodes in an I/O group that provides
RAID mirroring functions.

Storage Virtualizer I/O Group RAID Free Memory (MiB)
The amount of available memory on the nodes in an I/O group that
provides RAID mirroring functions.

Component properties

You can create performance reports that include the following information:

Storage Virtualizer I/O Group Maintenance
Shows whether the I/O group is in maintenance mode. If this value is Yes,
the I/O group is in maintenance mode.

Statistics for storage virtualizer I/O groups in performance reports:

You can include performance data for ports, volumes, caches, back-end arrays, and
other data for storage virtualizer I/O groups in performance reports.

Port data

You can create performance reports that include the following information:

Port Send I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
data is sent from a port.

Port Receive I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
the port receives data.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Port to Host Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to host
computers.

Port to Host Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from host
computers.
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Total Port to Host I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
host computers and the component.

Port to Disk Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to back-end
storage resources.

Port to Disk Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from
back-end storage resources.

Total Port to Disk I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
back-end storage resources and the component. This value includes both
send and receive operations.

Port to Local Node Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to other nodes
that are in the local SAN Volume Controller cluster.

Port to Local Node Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from other
nodes that are in the local SAN Volume Controller cluster.

Total Port to Local Node I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
the component and other nodes that are in the local SAN Volume
Controller cluster.

Port to Remote Node Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to nodes that
are in the remote SAN Volume Controller cluster.

Port to Remote Node Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from nodes
that are in the remote SAN Volume Controller cluster.

Total Port to Remote Node I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
the component and nodes that are in the remote SAN Volume Controller
cluster.

Port to Host Send Data Rate (MiB/s)
The average rate at which data is sent to host computers. The rate is
measured in MiB per second.

Port to Host Receive Data Rate (MiB/s)
The average rate at which data is received from host computers. The rate is
measured in MiB per second.

Total Port to Host Data Rate (MiB/s)
The average rate at which data is transmitted between host computers and
the component. The rate is measured in MiB per second and includes both
send and receive operations.

Port to Disk Send Data Rate (MiB/s)
The average rate at which data is sent to back-end storage resources. The
rate is measured in MiB per second.

Port to Disk Receive Data Rate (MiB/s)
The average rate at which data is received from back-end storage
resources. The rate is measured in MiB per second.
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Total Port to Disk Data Rate (MiB/s)
The average rate at which data is transmitted between back-end storage
resources and the component. The rate is measured in MiB per second and
includes both send and receive operations.

Port to Local Node Send Data Rate (MiB/s)
The average rate at which data is sent to other nodes that are in the local
SAN Volume Controller cluster. The rate is measured in MiB per second.

Port to Local Node Receive Data Rate (MiB/s)
The average rate at which data is received from other nodes that are in the
local SAN Volume Controller cluster. The rate is measured in MiB per
second.

Total Port to Local Node Data Rate (MiB/s)
The average rate at which data is transmitted between the component and
other nodes that are in the local SAN Volume Controller cluster. The rate is
measured in MiB per second.

Port to Remote Node Send Data Rate (MiB/s)
The average rate at which data is sent to nodes that are in the remote SAN
Volume Controller cluster. The rate is measured in MiB per second.

Port to Remote Node Receive Data Rate (MiB/s)
The average rate at which data is received from nodes that are in the
remote SAN Volume Controller cluster. The rate is measured in MiB per
second.

Total Port to Remote Node Data Rate (MiB/s)
The average rate at which data is transmitted between the component and
nodes that are in the remote SAN Volume Controller cluster. The rate is
measured in MiB per second.

Port to Local Node Send Response Time (ms/op)
The average number of milliseconds to complete a send operation to
another node that is in the local SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Port to Local Node Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation from
another node that is in the local SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Overall Port to Local Node Response Time (ms/op)
The average number of milliseconds to complete a send or receive
operation with another node that is in the local SAN Volume Controller
cluster. This value represents the external response time of the transfers.

Port to Local Node Send Queue Time (ms/op)
The average time in milliseconds that a send operation spends in the
queue before being processed. This value represents the queue time for
send operations that are issued to other nodes that are in the local SAN
Volume Controller cluster.

Port to Local Node Receive Queue Time (ms/op)
The average time in milliseconds that a receive operation spends in the
queue before being processed. This value represents the queue time for
receive operations that are issued from other nodes that are in the local
SAN Volume Controller cluster.

Overall Port to Local Node Queue Time (ms/op)
The average number of milliseconds that a send or receive operation
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spends in the queue before being processed. This value is for send and
receive operations that are issued between the component and other nodes
that are in the local SAN Volume Controller cluster.

Port to Remote Node Send Response Time (ms/op)
The average number of milliseconds to complete a send operation to a
node that is in the remote SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Port to Remote Node Receive Response Time (ms/op)
The average number of milliseconds to complete a receive operation from a
node that is in the remote SAN Volume Controller cluster. This value
represents the external response time of the transfers.

Overall Port to Remote Node Response Time (ms/op)
The average number of milliseconds to complete a send operation to, or a
receive operation from a node that is in the remote SAN Volume Controller
cluster. This value represents the external response time of the transfers.

Port to Remote Node Send Queue Time (ms/op)
The average time in milliseconds that a send operation spends in the
queue before being processed. This value represents the queue time for
send operations that are issued to a node that is in the remote SAN
Volume Controller cluster.

Port to Remote Node Receive Queue Time (ms/op)
The average time in milliseconds that a receive operation spends in the
queue before being processed. This value represents the queue time for
receive operations that are issued from a node that is in the remote SAN
Volume Controller cluster.

Overall Port to Remote Node Queue Time (ms/op)
The average number of milliseconds that a send or receive operation
spends in the queue before being processed. This value is for send and
receive operations that are issued between the component and a node that
is in the remote SAN Volume Controller cluster.

Volume data

You can create performance reports that include the following information:

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.
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Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Overall Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Back-end array data

You can create performance reports that include the following information:

Back-End Read Data Rate (MiB/s)
The average number of MiB per second that are read from the back-end
storage resources.

Back-End Write Data Rate (MiB/s)
The average number of MiB per second that are written to the back-end
storage resources.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.
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Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Read Queue Time (ms/op)
The average number of milliseconds that a read operation spends in the
queue before being sent to the back-end storage resources.

Back-End Write Queue Time (ms/op)
The average number of milliseconds that write operations spend in the
queue before being sent to the back-end storage resources.

Overall Back-End Queue Time (ms/op)
The average number of milliseconds that a read or a write operation
spends in the queue before being sent to the back-end storage resources.

Back-End Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation from
the back-end storage resources.

Back-End Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation to the
back-end storage resources.

Overall Back-End Transfer Size (KiB/op)
The average transfer size, in KiB, of a read or a write operation to the
back-end storage resources.

Peak Back-End Read Response Time (ms)
The longest time for a back-end storage resource to respond to a read
operation.

Peak Back-End Write Response Time (ms)
The longest time for a back-end storage resource to respond to a write
operation.

Peak Back-End Read Queue Time (ms)
The longest time that a read operation spends in the queue before being
sent to the back-end storage resources.

Peak Back-End Write Queue Time (ms)
The longest time that a write operation spends in the queue before being
sent to the back-end storage resources.

Cache data

You can create performance reports that include the following information:

Overall Read Cache Hit Percentage
The percentage of all read operations that find data in the cache. This
value includes both sequential and nonsequential read operations.
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You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Overall Write Cache Hit Percentage
The percentage of all write operations that are handled in the cache. This
value includes both sequential and nonsequential write operations.

Total Overall Cache Hit Percentage
The percentage of all read operations and write operations that are
handled in the cache. This value includes sequential and nonsequential
operations.

You can use this value to understand throughput or response times.
Low-cache-hit percentages can increase response times because a cache
miss requires access to the back-end storage resources.

Disk to Cache Transfer Rate (ops/s)
The average number of tracks that are transferred per second from the
disks to the cache.

Cache to Disk Transfer Rate (ops/s)
The average number of tracks per second that are transferred from the
cache to the disks.

Write Cache Delay Percentage
The percentage of I/O operations that are delayed because there is not
enough space in the write cache.

Only write operations can be delayed but the value is calculated as a
percentage of all I/O operations.

Write Cache Delay I/O Rate (ops/s)
The average number of I/O operations per second that are delayed
because there is not enough space in the write cache.

Only write operations can be delayed but the value is calculated as an
average of all I/O operations.

Read Ahead Percentage of Cache Hits
The percentage of all read-cache hits that occur on pre-staged data.

Dirty Write Percentage of Cache Hits
The percentage of all cache write operations that occur on data in the cache
that is marked as modified. This value represents how effectively writes
are coalesced before being written to disk.

Write Cache Overflow Percentage
The percentage of write operations that are delayed because there is not
enough space in the write cache.

Write Cache Overflow I/O Rate (ops/s)
The average number of write operations per second that are delayed
because there is not enough space in the write cache.

Write Cache Flush Through Percentage
The percentage of tracks that are written to disk in flush-through mode.

Write Cache Flush Through I/O Rate (ops/s)
The average number of tracks per second that are written to disk in
flush-through mode.

Write Cache Write Through Percentage
The percentage of tracks that are written to disk in write-through mode.

1354 IBM Tivoli Storage Productivity Center: User's Guide



Write Cache Write Through I/O Rate (ops/s)
The average number of tracks per second that are written to disk in
write-through mode.

Other data

You can create performance reports that include the following information:

Global Mirror Write I/O Rate (op/s)
The average number of write operations per second that are issued to the
Global Mirror secondary site.

Global Mirror Overlapping Write Percentage
The percentage of overlapping write operations that are issued by the
Global Mirror primary site.

For SAN Volume Controller software releases 4.3.1 and later, some
overlapping writes are processed in parallel and are excluded from this
value. For SAN Volume Controller software releases 4.3.0 and earlier, all
overlapping writes are serialized.

Global Mirror Overlapping Write I/O Rate (op/s)
The average number of overlapping write operations per second that are
issued by the Global Mirror primary site.

For SAN Volume Controller software releases 4.3.1 and later, some
overlapping writes are processed in parallel and are excluded from this
value. For SAN Volume Controller software releases 4.3.0 and earlier, all
overlapping writes are serialized.

Peak Read Response Time (ms)
The longest time to complete a read operation.

Peak Write Response Time (ms)
The longest time to complete a write operation.

Global Mirror Secondary Write Lag (ms/op)
The average number of milliseconds to service a secondary write operation
for Global Mirror. This value does not include the time to service the
primary write operation.

You monitor the value of Global Mirror Secondary Write Lag to identify
delays that occurred while writing data to the secondary site.

Link Failure Rate (count/s)
The average number of link errors per second.

Loss of Sync Rate (count/s)
The average number of times per second that synchronization is lost.

Synchronization is assumed lost after a timeout interval expires.

Loss of Signal Rate (count/s)
The average number of times per second that the signal is lost.

CRC Error Rate (count/s)
The average number of frames per second that are received in which a
cyclic redundancy check (CRC) error is detected. A CRC error is detected
when the CRC in the transmitted frame does not match the CRC computed
by the receiver.

Processor Utilization Percentage
The average percentage of time that the processors are busy.
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Overall Host Attributed Response Time Percentage
The percentage of the average response time that can be attributed to
delays from host systems. This value includes both read response times
and write response times, and can help you diagnose slow hosts and
fabrics that are not working efficiently.

The value is based on the following conditions:
v For read response time, the time that it takes for hosts to respond to

transfer-ready notifications from the SAN Volume Controller nodes.
v For write response time, the time that it takes for hosts to send the write

data after the node responds to a transfer-ready notification.

Nonpreferred Node Usage Percentage
The overall percentage of I/O performed or data transferred over the
non-preferred nodes of the virtual disks.

Primitive Sequence Protocol Error Rate (count/s)
The average number of primitive sequence protocol errors per second that
are detected.

This error occurs when there is a link failure for a port.

Invalid Transmission Word Rate (count/s)
The average number of bit errors per second that are detected.

Zero Buffer to Buffer Credit Timer (microseconds)
The number of microseconds that the port is unable to send frames
because there is not enough buffer credit.

Buffer credits are used in Fibre Channel technology to control the flow of
frames between ports. This value is measured from the time of the last
node reset.

Data for storage virtualizer ports in performance reports
You can include properties and other information about storage virtualizer ports in
performance reports.

Information about storage virtualizer ports

You can create performance reports that include the following information:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Node Name
The name that was assigned to the storage virtualizer node when it was
added to the system.

Storage Virtualizer Port Name
An alphanumeric string that identifies a storage virtualizer port.

Component properties

You can create performance reports that include the following information:

Storage Virtualizer Port Number
The port number on the resource.

Storage Virtualizer Port Type
The type of port on the storage system, storage virtualizer, or switch. For
example, the port type can be N_Port, F_Port, or another type of port.
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Storage Virtualizer Port Speed (GiB)
The speed of a port, measured in GiB per second.

Status information

You can create performance reports that include the following information:

Storage Virtualizer Port Status
The condition of the resource, for example normal, warning, or error.

Storage Virtualizer Port Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Storage Virtualizer Port Enabled State
Shows whether a port is enabled, disabled, or is enabled but offline.

Statistics for storage virtualizer ports in performance reports:

You can include performance data about storage virtualizer ports and port errors
in performance reports.

Port data

You can create performance reports that include the following information:

Port Send I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
data is sent from a port.

Port Receive I/O Rate (ops/s)
The average number of I/O operations per second for operations in which
the port receives data.

Total Port I/O Rate (ops/s)
The average number of send operations and receive operations per second.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Port to Host Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to host
computers.

Port to Host Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from host
computers.

Total Port to Host I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
host computers and the component.
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Port to Disk Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to back-end
storage resources.

Port to Disk Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from
back-end storage resources.

Total Port to Disk I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
back-end storage resources and the component. This value includes both
send and receive operations.

Port to Local Node Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to other nodes
that are in the local SAN Volume Controller cluster.

Port to Local Node Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from other
nodes that are in the local SAN Volume Controller cluster.

Total Port to Local Node I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
the component and other nodes that are in the local SAN Volume
Controller cluster.

Port to Remote Node Send I/O Rate (ops/s)
The average number of exchanges per second that are sent to nodes that
are in the remote SAN Volume Controller cluster.

Port to Remote Node Receive I/O Rate (ops/s)
The average number of exchanges per second that are received from nodes
that are in the remote SAN Volume Controller cluster.

Total Port to Remote Node I/O Rate (ops/s)
The average number of exchanges per second that are transmitted between
the component and nodes that are in the remote SAN Volume Controller
cluster.

Port to Host Send Data Rate (MiB/s)
The average rate at which data is sent to host computers. The rate is
measured in MiB per second.

Port to Host Receive Data Rate (MiB/s)
The average rate at which data is received from host computers. The rate is
measured in MiB per second.

Total Port to Host Data Rate (MiB/s)
The average rate at which data is transmitted between host computers and
the component. The rate is measured in MiB per second and includes both
send and receive operations.

Port to Disk Send Data Rate (MiB/s)
The average rate at which data is sent to back-end storage resources. The
rate is measured in MiB per second.

Port to Disk Receive Data Rate (MiB/s)
The average rate at which data is received from back-end storage
resources. The rate is measured in MiB per second.

Total Port to Disk Data Rate (MiB/s)
The average rate at which data is transmitted between back-end storage
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resources and the component. The rate is measured in MiB per second and
includes both send and receive operations.

Port to Local Node Receive Data Rate (MiB/s)
The average rate at which data is received from other nodes that are in the
local SAN Volume Controller cluster. The rate is measured in MiB per
second.

Port to Local Node Send Data Rate (MiB/s)
The average rate at which data is sent to other nodes that are in the local
SAN Volume Controller cluster. The rate is measured in MiB per second.

Total Port to Local Node Data Rate (MiB/s)
The average rate at which data is transmitted between the component and
other nodes that are in the local SAN Volume Controller cluster. The rate is
measured in MiB per second.

Port to Remote Node Receive Data Rate (MiB/s)
The average rate at which data is received from nodes that are in the
remote SAN Volume Controller cluster. The rate is measured in MiB per
second.

Port to Remote Node Send Data Rate (MiB/s)
The average rate at which data is sent to nodes that are in the remote SAN
Volume Controller cluster. The rate is measured in MiB per second.

Total Port to Remote Node Data Rate (MiB/s)
The average rate at which data is transmitted between the component and
nodes that are in the remote SAN Volume Controller cluster. The rate is
measured in MiB per second.

Port Send Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Port Receive Bandwidth Percentage
The percentage of the port bandwidth that is used for receive operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Port error data

You can create performance reports that include the following information:

Link Failure Rate (count/s)
The average number of link errors per second.

Loss of Sync Rate (count/s)
The average number of times per second that synchronization is lost.

Synchronization is assumed lost after a timeout interval expires.

Loss of Signal Rate (count/s)
The average number of times per second that the signal is lost.

CRC Error Rate (count/s)
The average number of frames per second that are received in which a
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cyclic redundancy check (CRC) error is detected. A CRC error is detected
when the CRC in the transmitted frame does not match the CRC computed
by the receiver.

Primitive Sequence Protocol Error Rate (count/s)
The average number of primitive sequence protocol errors per second that
are detected.

This error occurs when there is a link failure for a port.

Invalid Transmission Word Rate (count/s)
The average number of bit errors per second that are detected.

Zero Buffer to Buffer Credit Timer (microseconds)
The number of microseconds that the port is unable to send frames
because there is not enough buffer credit.

Buffer credits are used in Fibre Channel technology to control the flow of
frames between ports. This value is measured from the time of the last
node reset.

Data for storage virtualizer pools in performance reports
You can include general information, capacity data, properties, and other
information about storage virtualizer pools in performance reports.

Information about storage virtualizer pools

You can create performance reports that include the following information:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Capacity and usage data

You can create performance reports that include the following information:

Storage Virtualizer Pool Capacity (GiB)
The amount of storage space in the pool on the storage virtualizer. For
SAN Volume Controller, this value represents the amount of managed disk
space that is assigned to the managed disk group.

Storage Virtualizer Pool Available Space (GiB)
The amount of unused storage space in a storage virtualizer pool.

Storage Virtualizer Pool Virtual Volume Capacity (GiB)
The amount of virtual volume space on all volumes in the pool.

Storage Virtualizer Pool Real Volume Capacity (GiB)
The amount of space on all allocated extents in a pool. The allocated
extents include the used extents and extents that were assigned to volumes
when they were allocated.

Storage Virtualizer Pool Used Volume Space (GiB)
The amount of used space on all the volumes and volume copies in the
pool.

Storage Virtualizer Pool Overallocation Percentage
The percentage of space that is allocated to virtual capacity on volumes in
the pool.
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Storage Virtualizer Pool Extent Size (MiB)
The size of the extents that were specified when a pool was created.

Storage Virtualizer Pool Assigned Volume Space (GiB)
The amount of space in the pool that is on volumes that are assigned to a
server or storage virtualizer.

Storage Virtualizer Pool Unassigned Volume Space (GiB)
The amount of volume space in the pool that is not assigned to a server or
storage virtualizer.

Storage Virtualizer Pool Number of Storage Volumes
The number of volumes in the storage virtualizer pool.

Storage Virtualizer Pool Number of MDisks
The number of managed disks on a resource.

Component properties

You can create performance reports that include the following information:

Storage Virtualizer Pool Is Encryptable
Shows whether the resource can be encrypted. If this value is Yes, the
resource can be encrypted.

Storage Virtualizer Pool Is Encrypted
Shows whether the resource is encrypted. If this value is Yes, the resource
is encrypted.

Storage Virtualizer Pool Is Solid State
Shows whether there are solid-state drives in the pool. This property can
contain the following values:

Mixed The pool contains both hard disk drives and solid-state drives.

Non solid state
The pool contains no solid-state drives.

Solid state
The pool contains a least one solid-state drive.

Storage Virtualizer Pool Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.

Storage Virtualizer Pool RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.

Storage Virtualizer Pool Warning Level
The percentage of used capacity of the resource at which a warning is
generated.

Status information

You can create performance reports that include the following information:

Storage Virtualizer Pool Status
The condition of the resource, for example normal, warning, or error.
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Storage Virtualizer Pool Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Statistics for storage virtualizer pools in performance reports:

You can include performance data for volumes and back-end arrays for storage
virtualizer pools in performance reports.

Volume data

You can create performance reports that include the following information:

Overall Read I/O Rate (ops/s)
The average number of read operations per second. This value includes
both sequential and nonsequential read operations.

Overall Write I/O Rate (ops/s)
The average number of write operations per second. This value includes
both sequential and nonsequential write operations.

Total Overall I/O Rate (ops/s)
The average number of read operations and write operations per second.
This value includes both sequential and nonsequential operations.

Read Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations.

Write Data Rate (MiB/s)
The average number of MiB per second that are transferred for write
operations.

Total Data Rate (MiB/s)
The average number of MiB per second that are transferred for read
operations and write operations.

Read Response Time (ms/op)
The average number of milliseconds to complete a read operation.

Write Response Time (ms/op)
The average number of milliseconds to complete a write operation.

Total Response Time (ms/op)
The average number of milliseconds to complete an I/O operation. This
value includes both read and write operations.

Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation.

Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation.

Total Transfer Size (KiB/op)
The average number of KiB that are transferred per I/O operation. This
value includes both read and write operations.

Back-end array data

You can create performance reports that include the following information:
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Back-End Read I/O Rate (ops/s)
The average number of read operations per second that are issued to the
back-end storage resources.

Back-End Write I/O Rate (ops/s)
The average number of write operations per second that are issued to the
back-end storage resources.

Total Back-End I/O Rate (ops/s)
The average number of I/O operations per second that are transmitted
between the back-end storage resources and the component. This value
includes both read and write operations.

Back-End Read Data Rate (MiB/s)
The average number of MiB per second that are read from the back-end
storage resources.

Back-End Write Data Rate (MiB/s)
The average number of MiB per second that are written to the back-end
storage resources.

Total Back-End Data Rate (MiB/s)
The average rate at which data is transmitted between the back-end
storage resources and the component. The rate is measured in MiB per
second and includes both read and write operations.

Back-End Read Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Write Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Overall Back-End Response Time (ms/op)
The average number of milliseconds for the back-end storage resources to
respond to a read or a write operation.

For SAN Volume Controller models, this value represents the external
response time of the managed disks.

Back-End Read Queue Time (ms/op)
The average number of milliseconds that a read operation spends in the
queue before being sent to the back-end storage resources.

Back-End Write Queue Time (ms/op)
The average number of milliseconds that write operations spend in the
queue before being sent to the back-end storage resources.

Overall Back-End Queue Time (ms/op)
The average number of milliseconds that a read or a write operation
spends in the queue before being sent to the back-end storage resources.

Back-End Read Transfer Size (KiB/op)
The average number of KiB that are transferred per read operation from
the back-end storage resources.
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Back-End Write Transfer Size (KiB/op)
The average number of KiB that are transferred per write operation to the
back-end storage resources.

Overall Back-End Transfer Size (KiB/op)
The average transfer size, in KiB, of a read or a write operation to the
back-end storage resources.

Peak Back-End Read Response Time (ms)
The longest time for a back-end storage resource to respond to a read
operation.

Peak Back-End Write Response Time (ms)
The longest time for a back-end storage resource to respond to a write
operation.

Peak Back-End Read Queue Time (ms)
The longest time that a read operation spends in the queue before being
sent to the back-end storage resources.

Peak Back-End Write Queue Time (ms)
The longest time that a write operation spends in the queue before being
sent to the back-end storage resources.

Data for switches in performance reports
You can include properties and other information about switches in performance
reports.

Information about switches

You can create performance reports that include the following information:

Switch Logical Name
The logical name of a switch or switch port.

Component properties

You can create performance reports that include the following information:

Switch WWN
The worldwide name of the switch.

Parent Switch WWN
The worldwide name of the parent switch.

Switch Name
The user-defined name for the switch, or the name that was assigned to
the switch by the vendor.

Switch Management Telnet Address
The Telnet address that you access to manage the switch.

Switch Management SNMP Address
The Simple Network Management Protocol (SNMP) address that you
access to manage the switch.

Switch Management URL Address
The URL that you access to manage the switch.

Switch Domain
The domain of the switch.
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Switch Version
The version number of the operating system that is running on the switch.

Status information

You can create performance reports that include the following information:

Switch Status
The condition of the resource, for example normal, warning, or error.

Switch Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Vendor, model, and device information

You can create performance reports that include the following information:

Switch IP Address
The IP address of the resource.

Switch Serial Number
The serial number of the resource.

Switch Vendor
The vendor who supplied the resource.

Switch Model
The model name or model number of the resource.

Statistics for switches in performance reports:

You can include performance data for switches, including switch error data, in
performance reports.

Switch data

You can create performance reports that include the following information:

Port Send Frame Rate (frames/s)
The average number of frames per second that are sent through the port.

Port Receive Frame Rate (frames/s)
The average number of frames per second that are received by the port.

Total Port Frame Rate (frames/s)
The average number of frames per second that are transferred. This value
includes frames that are sent and frames that are received by the port.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.
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Port Send Frame Size (KiB/op)
The average size of a frame, in KiB, that is sent through the port.

Port Receive Frame Size (KiB/op)
The average size of a frame, in KiB, that is received by the port.

Overall Port Frame Size (KiB/op)
The average frame transfer size. This value is measured in KiB and
includes frames that are sent and frames that are received by the port.

Port Send Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Port Receive Bandwidth Percentage
The percentage of the port bandwidth that is used for receive operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Switch error data

You can create performance reports that include the following information:

Error Frame Rate (count/s)
The average number of error frames per second that are received. An error
frame is a frame that violates the Fibre Channel Protocol.

Discarded Frame Rate (count/s)
The average number of frames per second that are discarded because host
buffers are unavailable for the port.

Link Failure Rate (count/s)
The average number of link errors per second.

Loss of Sync Rate (count/s)
The average number of times per second that synchronization is lost.

Synchronization is assumed lost after a timeout interval expires.

Loss of Signal Rate (count/s)
The average number of times per second that the signal is lost.

CRC Error Rate (count/s)
The average number of frames per second that are received in which a
cyclic redundancy check (CRC) error is detected. A CRC error is detected
when the CRC in the transmitted frame does not match the CRC computed
by the receiver.

Encoding Disparity Error Rate (count/s)
The average number of disparity errors per second that are received.

Discarded Class 3 Frame Rate (count/s)
The average number of class 3 frames per second that are discarded.

Primitive Sequence Protocol Error Rate (count/s)
The average number of primitive sequence protocol errors per second that
are detected.
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This error occurs when there is a link failure for a port.

Invalid Transmission Word Rate (count/s)
The average number of bit errors per second that are detected.

Link Reset Transmitted Rate (count/s)
The average number of times per second that the port changes from an
active (AC) state to a Link Recovery (LR1) state.

Link Reset Received Rate (count/s)
The average number of times per second that the port changes from an
active (AC) state to a Link Recovery (LR2) state.

Short Frame Rate (count/s)
The average number of frames that are received per second that are shorter
than 28 octets. This number excludes start-of-frame bytes and end-of-frame
bytes.

The 28 octet limit is calculated based on the assumption that a frame has
24 header bytes, and 4 CRC bytes.

Long Frame Rate (count/s)
The average number of frames that are received per second that are longer
than 2140 octets. This number excludes start-of-frame bytes and
end-of-frame bytes.

The 2140 octet limit is calculated based on the assumption that a frame has
24 header bytes, 4 CRC bytes, and 2112 data bytes.

F-BSY Frame Rate (count/s)
The average number of F-BSY frames per second that are generated.

An F-BSY frame is issued by the fabric to indicate that a frame cannot be
delivered because the fabric or destination N_port is busy.

F-RJT Frame Rate (count/s)
The average number of F-RJT frames per second that are generated.

An F-RJT frame is issued by the fabric to indicate that delivery of a frame
was denied.

Data for switch ports in performance reports
You can include properties and other information about switch ports in
performance reports.

Information about switch ports

You can create performance reports that include the following information:

Switch Logical Name
The logical name of a switch or switch port.

Switch Port WWPN
The worldwide port name of the port on the switch.

Component properties

You can create performance reports that include the following information:

Switch Port Number
The port number on the resource.
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Switch Port Type
The type of port on the storage system, storage virtualizer, or switch. For
example, the port type can be N_Port, F_Port, or another type of port.

Switch Port Speed (GiB/s)
The speed of a port, measured in GiB per second.

Status information

You can create performance reports that include the following information:

Switch Port Status
The condition of the resource, for example normal, warning, or error.

Switch Port Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Switch Port Enabled State
Shows whether a port is enabled, disabled, or is enabled but offline.

Statistics for switch ports in performance reports:

You can include performance data for switch ports, including port error data, in
performance reports.

Switch port data

You can create performance reports that include the following information:

Port Send Frame Rate (frames/s)
The average number of frames per second that are sent through the port.

Port Receive Frame Rate (frames/s)
The average number of frames per second that are received by the port.

Total Port Frame Rate (frames/s)
The average number of frames per second that are transferred. This value
includes frames that are sent and frames that are received by the port.

Port Send Data Rate (MiB/s)
The average rate at which data is sent through the port. The rate is
measured in MiB per second.

Port Receive Data Rate (MiB/s)
The average rate at which data is received by the port. The rate is
measured in MiB per second.

Total Port Data Rate (MiB/s)
The average rate at which data is transferred through the port. The rate is
measured in MiB per second and includes both send and receive
operations.

Port Peak Send Data Rate (MiB/s)
The fastest rate at which data is sent through this switch port.

Port Peak Receive Data Rate (MiB/s)
The fastest rate at which data is received through this switch port.

Port Send Frame Size (KiB/op)
The average size of a frame, in KiB, that is sent through the port.
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Port Receive Frame Size (KiB/op)
The average size of a frame, in KiB, that is received by the port.

Overall Port Frame Size (KiB/op)
The average frame transfer size. This value is measured in KiB and
includes frames that are sent and frames that are received by the port.

Port Send Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Port Receive Bandwidth Percentage
The percentage of the port bandwidth that is used for receive operations.
This value is an indicator of port bandwidth usage based on the speed of
the port.

Overall Port Bandwidth Percentage
The percentage of the port bandwidth that is used for send operations and
receive operations. This value is an indicator of port bandwidth usage
based on the speed of the port.

Data for errors on switch ports

You can create performance reports that include the following information:

Error Frame Rate (count/s)
The average number of error frames per second that are received. An error
frame is a frame that violates the Fibre Channel Protocol.

Discarded Frame Rate (count/s)
The average number of frames per second that are discarded because host
buffers are unavailable for the port.

Link Failure Rate (count/s)
The average number of link errors per second.

Loss of Sync Rate (count/s)
The average number of times per second that synchronization is lost.

Synchronization is assumed lost after a timeout interval expires.

Loss of Signal Rate (count/s)
The average number of times per second that the signal is lost.

CRC Error Rate (count/s)
The average number of frames per second that are received in which a
cyclic redundancy check (CRC) error is detected. A CRC error is detected
when the CRC in the transmitted frame does not match the CRC computed
by the receiver.

Encoding Disparity Error Rate (count/s)
The average number of disparity errors per second that are received.

Discarded Class 3 Frame Rate (count/s)
The average number of class 3 frames per second that are discarded.

Primitive Sequence Protocol Error Rate (count/s)
The average number of primitive sequence protocol errors per second that
are detected.

This error occurs when there is a link failure for a port.
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Invalid Transmission Word Rate (count/s)
The average number of bit errors per second that are detected.

Link Reset Transmitted Rate (count/s)
The average number of times per second that the port changes from an
active (AC) state to a Link Recovery (LR1) state.

Link Reset Received Rate (count/s)
The average number of times per second that the port changes from an
active (AC) state to a Link Recovery (LR2) state.

Short Frame Rate (count/s)
The average number of frames that are received per second that are shorter
than 28 octets. This number excludes start-of-frame bytes and end-of-frame
bytes.

The 28 octet limit is calculated based on the assumption that a frame has
24 header bytes, and 4 CRC bytes.

Long Frame Rate (count/s)
The average number of frames that are received per second that are longer
than 2140 octets. This number excludes start-of-frame bytes and
end-of-frame bytes.

The 2140 octet limit is calculated based on the assumption that a frame has
24 header bytes, 4 CRC bytes, and 2112 data bytes.

F-BSY Frame Rate (count/s)
The average number of F-BSY frames per second that are generated.

An F-BSY frame is issued by the fabric to indicate that a frame cannot be
delivered because the fabric or destination N_port is busy.

F-RJT Frame Rate (count/s)
The average number of F-RJT frames per second that are generated.

An F-RJT frame is issued by the fabric to indicate that delivery of a frame
was denied.

Custom reports about resources
You can use Tivoli Common Reporting to create custom resource reports. Resource
reports can contain detailed information about the properties of monitored
resources, and the available space and capacity of those resources.

Resource reports can contain information about the following resources and their
components:
v Servers
v Hypervisors
v Network-attached storage servers
v Storage virtualizers
v Storage systems
v Storage resource groups

Creating custom resource reports in Tivoli Common Reporting
You can create custom reports that show resource and capacity data in IBM Tivoli
Common Reporting.
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Before you can create a custom resource report, ensure that data was collected
from the resources. The following table shows where the data must be collected
from for each resource:

Resource Prerequisite

Server Data must be collected from the server by
the Storage Resource Agent.

Hypervisor Data must be collected from the VMware
ESX server.

NAS Data must be collected from any NetApp or
IBM Scale Out Network Attached Storage
resources that are in your storage
environment.

Storage virtualizer Data must be collected from the any of the
following storage virtualizers that are in
your storage environment:

v Storwize V7000

v Storwize V7000 Unified

v SAN Volume Controller

Storage system Data must be collected from the storage
system.

Tip: Before you run a report, you can preview the report with no data. For more
information about how to preview and run reports, see the IBM Cognos 8 v4
Business Intelligence Information Center at http://publib.boulder.ibm.com/
infocenter/c8bi/v8r4m0/index.jsp, and search for run report query studio.

Restriction:

You cannot create custom reports from the following packages:
v IBM Tivoli Storage Productivity Center Historical Information
v IBM Tivoli Storage Productivity Center Storage Tiering
1. Select the IBM Tivoli Storage Productivity Center Resources package.
2. Expand Tivoli Storage Productivity Center in the list.
3. Expand Servers to Storage Systems in the list.
4. Explore the folders in the list to locate the resources, properties, and statistics

that you want to include in the report.
5. Depending on your browser, do one of the following steps to add properties

and statistics to the report:
v Internet Explorer: Drag the items that you want to see information about to

the right pane.
v Firefox: Select the items that you want to see information about, and then

click Insert.
6. Click Save.

Adding filters to reports
You can use filters with reports that show resource information in IBM Tivoli
Common Reporting.

Filters allow you to show only certain records which comply with your criteria.
You can use filters when you create reports about resources. Filters for resources
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are in the same list as the resources, in the appropriate resource folder. For
example, to view the filters for servers, select Server Resources > Server Resource
Filters > Server Filters.

Filters are available for all resources, except network-attached storage resources.
1. To apply a filter to the data in the right pane, locate the filter that you require

in the folders in the list.
2. Depending on your browser, do one of the following steps to add a filter to the

report:
v Internet Explorer: Drag the filter that you want to use to the right pane.
v Firefox: Select the filter that you want to use, and then click Insert.

The filter is applied to the report. If you did not add properties and statistics to
the report, the filter is applied when you add the properties and statistics.

3. Optional: To delete the filter, right-click the filter in the right pane then select
Delete. For information about filters for resources, see the IBM Tivoli Storage
Productivity Center Information Center (http://publib.boulder.ibm.com/
infocenter/tivihelp/v59r1/index.jsp). For more information about how to use
filters with reports, see the IBM Cognos 8 v4 Business Intelligence Information
Center at http://publib.boulder.ibm.com/infocenter/c8bi/v8r4m0/index.jsp,
and search for filters query studio.

Filters for servers in resource reports
You can filter resource reports to include only the servers, server file systems, and
server logical volumes that meet specific criteria.

Filters for servers

You can create resource reports that include the following filters:

Servers Connected to Virtualizers or Storage Systems
Shows servers that are connected to storage virtualizers or storage systems.
You can use this filter to identify servers that are connected directly to
storage virtualizers, or connected directly or indirectly to storage systems.
This filter excludes local disks from the report.

Servers Directly Connected to Storage Systems
Shows servers that are directly connected to a back-end storage system.
You can use this filter to identify servers or server disks that are connected
to a storage system, but are not connected through a storage virtualizer.

For example, you might want to migrate data from one storage system to
another. In this case, you can use this filter to identify file systems or
server disks that are not virtualized. These file systems or server disks
might be affected if a storage system is removed.

Servers Directly Connected to Virtualizers
Shows servers that are directly connected to a storage virtualizer. You can
use this filter to identify servers that are connected to a storage virtualizer,
but are not connected directly to a back-end storage system.

For example, you can use this filter to identify only server disks that are
on a SAN Volume Controller.

Filters for server file systems

You can create resource reports that include the following filters:
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Rows with File System Mount Points
Shows the file systems that have a mount point on the server.

Rows without File System Mount Points
Shows resources that do not have a mount point on the server. You can use
this filter to identify disks that do not have file systems, that is, disks that
are not in use.

For example, to identify unused space include the Server Name property
and the Server Disk Path property in a report, and then include the Rows
without File System Mount Points filter.

Filters for server logical volumes

You can create resource reports that include the following filters:

Rows with Logical Volume Path
Shows the logical volumes that have a path to the server.

Rows without Logical Volume Path
Shows resources that do not have a logical volume path to the server. You
can use this filter to identify volumes that do not have paths, that is,
volumes that are not in use.

For example, to identify unused space include the Server Name property
and the Server Disk Path property in a report, and then include the Rows
without Logical Volume Path filter.

Filters for hypervisors in resource reports
You can filter resource reports to include only the hypervisors, hypervisor file
systems, and hypervisor logical volumes that meet specific criteria.

Filters for hypervisors

You can create resource reports that include the following filters:

Hypervisor with Probed Servers
Shows hypervisors that are connected to servers. You can use this filter to
include only hypervisors and their associated servers from which data was
collected. For example, you might collect data only from your critical
production servers on a hypervisor, but not your test servers. In this case,
you can use this filter to exclude information for the test servers from the
report.

Hypervisors Connected to Virtualizers or Storage Systems
Shows hypervisors that are connected to storage virtualizers or storage
systems. You can use this filter to identify hypervisors that are connected
directly to storage virtualizers, or connected directly or indirectly to
storage systems. This filter excludes local disks from the report.

Hypervisors Directly Connected to Storage Systems
Shows hypervisors that are directly connected to a back-end storage
system. You can use this filter to identify hypervisors or hypervisor disks
that are connected to a storage system, but are not connected through a
storage virtualizer.

For example, you might want to migrate data from one storage system to
another. In this case, you can use this filter to identify file systems or
hypervisor disks that are not virtualized. These file systems or hypervisor
disks might be affected if a storage system is removed.
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Hypervisors Directly Connected to Virtualizers
Shows hypervisors that are directly connected to a storage virtualizer. You
can use this filter to identify hypervisors that are connected to a storage
virtualizer, but are not connected directly to a back-end storage system.

For example, you can use this filter to identify only hypervisor disks that
are on a SAN Volume Controller.

Filters for hypervisor file systems

You can create resource reports that include the following filters:

Hypervisors with File System Mount Points
Shows the file systems that have a mount point on the hypervisor.

Hypervisors without File System Mount Points
Shows resources that do not have a mount point on the hypervisor. You
can use this filter to identify disks that do not have file systems, that is,
disks that are not in use.

For example, to identify unused space include the Hypervisor Name
property and the Hypervisor Disk Path property in a report, and then
include the Hypervisors without File System Mount Points filter.

Filters for hypervisor logical volumes

You can create resource reports that include the following filters:

Hypervisors with Logical Volume Path
Shows the logical volumes that have a path to the hypervisor.

Hypervisors without Logical Volume Path
Shows resources that do not have a logical volume path to the hypervisor.
You can use this filter to identify volumes that do not have paths, that is,
volumes that are not in use.

For example, to identify unused space include the Hypervisor Name
property and the Hypervisor Disk Path property in a report, and then
include the Hypervisors without Logical Volume Path filter.

Filters for storage virtualizers in resource reports
You can filter resource reports to include only the storage virtualizers and storage
virtualizer volumes that meet specific criteria.

Storage virtualizer filters

You can create resource reports that include the following filters:

Virtualizers Not Connected to Servers
Shows storage virtualizers that are not connected to servers.

Filters for storage virtualizer volumes

You can create resource reports that include the following filters:

Rows with Virtualizer Volumes
Shows storage virtualizer disks that are connected to the storage virtualizer
that have an associated volume.
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Rows without Virtualizer Volumes
Shows storage virtualizer disks that are connected to the storage virtualizer
that do not have an associated volume.

Virtualizer Primary Volume Information
Shows primary volumes that are connected to the storage virtualizer. You
can use this filter if you want to get a total of the used space on primary
volumes in your storage environment.

Virtualizer Volume Copy Information
Shows copy volumes that are connected to the storage virtualizer. You can
use this filter if you want to get a total of the used space on volume copies
in your storage environment.

Filters for storage systems in resource reports
You can filter resource reports to include only the storage systems or storage
volumes that meet specific criteria.

Filters for storage systems

You can create resource reports that include the following filters:

Storage Systems Directly Connected to Servers
Shows back-end storage systems that are directly connected to a server.
You can use this filter to identify storage systems that are connected to a
server, but are not connected through a storage virtualizer.

For example, you might want to migrate data from one storage system to
another. In this case, you can use this filter to identify file systems or
server disks that are not virtualized. These file systems or server disks
might be affected if a storage system is removed.

Storage Systems Connected to Servers through Virtualizers
Shows storage systems that are indirectly connected to a server through a
storage virtualizer. You can use this filter to identify storage systems that
are connected to a storage virtualizer, but are not connected directly to a
server.

For example, you can use this filter to identify only server disks that are
on a SAN Volume Controller.

Storage Systems not Connected to Servers
Shows storage systems that are not connected to a server either directly, or
indirectly through a storage virtualizer.

Rows with Storage Volumes
Shows storage resources that have an associated storage volume.

Rows without Storage Volumes
Shows storage resources that do not have an associated storage volume.

Filters for storage resource groups in resource reports
You can filter resource reports to include only the storage resource groups that
meet specific criteria.

Filters for storage resource groups

You can create resource reports that include the following filters:

Storage Resource Group for Volumes
Shows only the volumes that are in a storage resource group.
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Storage Resource Group for Pools
Shows only the pools that are in a storage resource group.

Data and properties in resource reports
You can include capacity data, properties, and other information about resources in
your storage environment in resource reports.

Data for clusters in resource reports
You can include general information about clusters in resource reports.

Information about clusters

You can create resource reports that include the following information:

Cluster Name
The name that was assigned to the cluster when it was created.

Cluster Type
The type of the cluster. The cluster can be a Microsoft Cluster Server or a
High-Availability Cluster Multiprocessing (HACMP) server.

Cluster IP Address
The IP address of the resource.

Cluster Domain Name
The domain name of the cluster.

Data for servers in resource reports
You can include general information, capacity data, properties of components, and
other information about servers in resource reports.

Information about servers

You can create resource reports that include the following information:

Server Name
The fully qualified domain name of the server. For example, the name of a
server might be server.example.com.

Server Domain Name
The domain name of the server.

Server Short Name
The host name from the fully qualified domain name of the server. For
example, if the fully qualified domain name of the server is
mycomputer.example.com, the host name is mycomputer.

Server Custom Tag 1
User-defined text that is associated with the resource.

Server Custom Tag 2
User-defined text that is associated with the resource.

Server Custom Tag 3
User-defined text that is associated with the resource.

Capacity and usage data

You can create resource reports that include the following information:
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Server Swap Space (GiB)
The amount of disk space on a resource that is available to store some of
the contents of the RAM when the RAM is full.

Server Total Disk Capacity (GiB)
The amount of storage space that is on a server.

Server Total Disk Available Space (GiB)
The amount of unused storage space on all disks on a server.

Server Total File System Available Space (GiB)
The amount of unused storage space that is available on the file systems
on a server.

Component properties

You can create resource reports that include the following information:

Server Cluster Current Hosting Node
The name of the server that is hosting the cluster resource group.

Server Cluster Resource Type
Shows whether the cluster is a node or a cluster resource group.

Server IP Address
The IP address of the resource.

Server Is Virtual Machine
Shows whether a resource is a virtual machine. If this value is Yes, the
resource is a virtual machine.

Server OS Type
The operating system that is running on the server.

Server OS Version
The version number of the operating system that is running on the
resource.

Server Processor Architecture
The architecture of the processor on the server or hypervisor. For example,
the architecture of a processor might be Intel 64bit (IA64) or Intel
32bit(IA32).

Server Processor Count
The number of processors on the server or hypervisor.

Server Processor Speed (MHz)
The speed of the processor on the server or hypervisor.

Server Processor Type
Shows information about the processor, such as the family and model of
the processor.

Server RAM (GiB)
The amount of RAM on the server or hypervisor.

Server Time Zone
The time zone in which a resource is located.

Vendor, model, and device information

You can create resource reports that include the following information:
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Server Model
The model name or model number of the resource.

Server Serial Number
The serial number of the resource.

Server Vendor
The vendor who supplied the resource.

Status information

You can create resource reports that include the following information:

Server Status
The condition of the resource, for example normal, warning, or error.

Server Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Server Last Data Collection
The date and time when storage statistics were last collected from the
resource.

Server Last Start Time
The last time that the resource was started.

Data for file systems on servers in resource reports
You can include general information, capacity data, and status information about
file systems on servers in resource reports.

Information about file systems on servers

You can create resource reports that include the following information:

File System Mount Point
The name or mount point of the file system for the resource. For example,
on Microsoft Windows systems, the value in this column header might be
c:\ or d:\. On operating systems such as AIX, Linux, Solaris, or HP-UX,
the mount point might be /opt or /export/home.

File System Export Name
The name of the exported file system.

File System Type
The type of file system that the resource uses.

Capacity and usage data

You can create resource reports that include the following information:

File System Capacity (GiB)
The amount of storage space on the file system of the resource.

File System Used Space (GiB)
The amount of used storage space in the file system of the resource.

File System Available Space (GiB)
The amount of unused storage space in the file system of the resource.

File System Physical Size (GiB)
The amount of physical storage space on the file systems on a resource.
The physical size is the size of all the clusters that the file system uses.
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File System Directory Count
The number of directories in the file systems that are on a server.

File System File Count
The number of files in the file system.

File System Available Inodes
The number of unused inodes in file systems on the operating system.

Tip: For Microsoft Windows systems, this column is blank.

File System Used Inodes
The number of used inodes in file systems on the operating system.

Tip: For Microsoft Windows systems, this column is blank.

File System Maximum Files
The maximum number of files that the file system on the resource can
contain.

Status information

You can create resource reports that include the following information:

File System Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

File System Last Scan
The date and time when file statistics were last collected from the resource.

Data for logical volumes on servers in resource reports
You can include general information, capacity data, and status information about
logical volumes on servers in resource reports.

Information about logical volumes on servers

You can create resource reports that include the following information:

Logical Volume Path
The path to a logical volume on a resource, for example /dev/hd1.

Logical Volume Is Swap Space
Shows whether a logical volume is used to store some of the contents of
the RAM when the RAM is full. If this value is Yes, the logical volume is
used to store some of the contents of the RAM.

Logical Volume Mirror Count
The number of mirrors that keep a synchronous copy of the resource.

Logical Volume Type
The type of server logical volume. For example, the logical volume type
can be concatenation or stripe set.

Capacity and usage data

You can create resource reports that include the following information:

Logical Volume Allocation on Server Disk (GiB)
The amount of disk storage space that is allocated to the logical volume.
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Logical Volume Capacity (GiB)
The amount of storage space that is on a logical volume.

Logical Volume Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Status information

You can create resource reports that include the following information:

Logical Volume Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Data for volume groups on servers in resource reports
You can include general information and capacity data about volume groups on
servers in resource reports.

Information about volume groups on servers

You can create resource reports that include the following information:

Volume Group Name
The name that was assigned to the volume group when it was added to
the system.

Volume Group Type
The type of the volume manager that manages the volume group. The
volume manager can be a logical volume manager (LVM) or a Veritas
volume manager.

Capacity and usage data

You can create resource reports that include the following information:

Volume Group Capacity (GiB)
The amount of storage space that is on a volume group.

Volume Group Available Space (GiB)
The amount of unused storage space on a server volume group.

Volume Group Number of Logical Volumes
The number of logical volumes on a resource.

Volume Group Number of Server Disks
The number of server disks in a volume group.

Data for server disks in resource reports
You can include general information, capacity data, properties of components, and
other information about server disks in resource reports.

Information about server disks

You can create resource reports that include the following information:

Server Disk Path
The identifier that specifies a path to a server disk, for example
/dev/hdisk0.
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A server disk might have one or more disk paths. To identify unique
server disks, add the Server Disk Serial Number column to the report, and
group the server disks by the serial number.

Capacity and usage data

You can create resource reports that include the following information:

Server Disk Capacity (GiB)
The amount of storage space that is on a server disk.

Server Disk Available Space (GiB)
The amount of unused storage space that is on a server disk.

Component properties

You can create resource reports that include the following information:

Server Disk Is Removable
Shows whether the disk can be removed from the server. If this value is
Yes, the disk can be removed from the server.

Status information

You can create resource reports that include the following information:

Server Disk Status
The condition of the resource, for example normal, warning, or error.

Server Disk Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Vendor, model, and device information

You can create resource reports that include the following information:

Server Disk Firmware Version
The version number of the firmware that is running on the disk.

Server Disk Model
The model name or model number of the resource.

Server Disk Serial Number
The serial number of the resource.

Server Disk Vendor
The vendor who supplied the resource.

Path information

You can create resource reports that include the following information:

Server Disk LUN
The logical unit within a small computer system interface target on a disk.

Server Disk SCSI Target
The bus address for the small computer system interface of the target on a
disk.
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Server Disk Target WWPN
The worldwide port name of the storage port that the volume is mapped
to.

Data for server groups in resource reports
You can include general information and properties of server groups in resource
reports.

Information about server groups

You can create resource reports that include the following information:

Server Group Name
The name that was assigned to the server group when it was added to the
system.

Component properties

You can create resource reports that include the following information:

Server Group Creator
The ID of the user who created the group.

Server Group Last Modified
The date and time that the resource was last modified.

Server Group Last Modified by User
The ID of the user who last modified the resource.

Data for file system groups on servers in resource reports
You can include general information about file system groups on servers, and
properties of file system groups in resource reports.

Information about file system groups on servers

You can create resource reports that include the following information:

File System Group Name
The name that was assigned to the file system group when it was added to
the system.

Component properties

You can create resource reports that include the following information:

File System Group Creator
The ID of the user who created the group.

File System Group Last Modified
The date and time that the resource was last modified.

File System Group Last Modified by User
The ID of the user who last modified the resource.

Data for hypervisors in resource reports
You can include general information, capacity data, properties, and other
information about hypervisors in resource reports.
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Information about hypervisors

You can create resource reports that include the following information:

Hypervisor Name
The fully qualified domain name of the hypervisor. For example, the name
of a hypervisor might be hypervisor.example.com.

Hypervisor Short Name
The host name from the fully qualified domain name of the hypervisor. For
example, if the fully qualified domain name of the hypervisor is
mycomputer.example.com, the host name is mycomputer.

Hypervisor Custom Tag 1
User-defined text that is associated with the resource.

Hypervisor Custom Tag 2
User-defined text that is associated with the resource.

Hypervisor Custom Tag 3
User-defined text that is associated with the resource.

Capacity and usage data

You can create resource reports that include the following information:

Hypervisor Kernel Memory (GiB)
The amount of memory on a hypervisor that is used for kernel memory.
Kernel memory is used to perform internal operating system processes.

Hypervisor Service Console Memory (GiB)
The amount of memory on a hypervisor that is used for the VMware ESX
Service Console. Service Console is the operating system that is used to
interact with ESX and the virtual machines that run on the hypervisor.

Hypervisor Swap Space (GiB)
The amount of disk space on a resource that is available to store some of
the contents of the RAM when the RAM is full.

Hypervisor Total Disk Capacity (GiB)
The amount of storage space on disks on a hypervisor.

Hypervisor Total Disk Available Space (GiB)
The amount of unused storage space on disks on the hypervisor.

Hypervisor Total File System Available Space (GiB)
The amount of unused storage space that is available on the file systems
on a hypervisor.

Component properties

You can create resource reports that include the following information:

Hypervisor IP Address
The IP address of the resource.

Hypervisor OS Type
The software that runs the hypervisor, that is, VMware ESX.

Hypervisor OS Version
The version number of the operating system that is running on the
resource.
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Hypervisor Processor Architecture
The architecture of the processor on the server or hypervisor. For example,
the architecture of a processor might be Intel 64bit (IA64) or Intel
32bit(IA32).

Hypervisor Processor Count
The number of processors on the server or hypervisor.

Hypervisor Processor Speed (MHz)
The speed of the processor on the server or hypervisor.

Hypervisor Processor Type
Shows information about the processor, such as the family and model of
the processor.

Hypervisor RAM (GiB)
The amount of RAM on the server or hypervisor.

Hypervisor Software API Version
The version number of the software API that runs on the hypervisor.

Hypervisor Software Full Name
The name, version number, and build number of the software that runs the
hypervisor.

Hypervisor Time Zone
The time zone in which a resource is located.

Vendor, model, and device information

You can create resource reports that include the following information:

Hypervisor Model
The model name or model number of the resource.

Hypervisor Serial Number
The serial number of the resource.

Hypervisor Vendor
The vendor who supplied the resource.

Status information

You can create resource reports that include the following information:

Hypervisor Status
The condition of the resource, for example normal, warning, or error.

Hypervisor Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Hypervisor Last Data Collection
The date and time when storage statistics were last collected from the
resource.

Hypervisor Last Start Time
The last time that the resource was started.

Data for file systems on hypervisors in resource reports
You can include general information, capacity data, and other information about
file systems on hypervisors in resource reports.
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Information about file systems on hypervisors

You can create resource reports that include the following information:

Hypervisor File System Mount Point
The name or mount point of the file system for the resource. For example,
on Microsoft Windows systems, the value in this column header might be
c:\ or d:\. On operating systems such as AIX, Linux, Solaris, or HP-UX,
the mount point might be /opt or /export/home.

Hypervisor File System Export Name
The name of the exported file system.

Hypervisor File System Type
The type of file system that the hypervisor uses.

Capacity and usage data

You can create resource reports that include the following information:

Hypervisor File System Capacity (GiB)
The amount of storage space on the file system of the resource.

Hypervisor File System Directory Count
The number of directories in the file systems that are on a server.

Hypervisor File System File Count
The number of files in the file system.

Hypervisor File System Available Space (GiB)
The amount of unused storage space in the file system of the resource.

Hypervisor File System Available Inodes
The number of unused inodes in file systems on the operating system.

Tip: For Microsoft Windows systems, this column is blank.

Hypervisor File System Used Inodes
The number of used inodes in file systems on the operating system.

Tip: For Microsoft Windows systems, this column is blank.

Hypervisor File System Maximum Files
The maximum number of files that the file system on the resource can
contain.

Hypervisor File System Used Space (GiB)
The amount of used storage space in the file system of the resource.

Hypervisor File System Physical Size (GiB)
The amount of physical storage space on the file systems on a resource.
The physical size is the size of all the clusters that the file system uses.

Status information

You can create resource reports that include the following information:

Hypervisor File System Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Hypervisor File System Last Scan
The date and time when file statistics were last collected from the resource.
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Data for logical volumes on hypervisors in resource reports
You can include general information, capacity data, and other information about
logical volumes on hypervisors in resource reports.

Information about logical volumes on hypervisors

You can create resource reports that include the following information:

Hypervisor Logical Volume Path
The path to the VMware ESX data store on the hypervisor, for example
datastore_svc3c.

Hypervisor Logical Volume Type
The type of logical volume, such as raw, concatenation, and mirror.

Hypervisor Logical Volume File System Type
The type of file system that the hypervisor logical volume uses. For
example, the file system can be NFS or VMFS.

Hypervisor NAS Name
The name of the network-attached storage (NAS) that the logical volume is
obtained from.

Hypervisor NAS Path Name
The path name on the network-attached storage of the logical volume.

Capacity and usage data

You can create resource reports that include the following information:

Hypervisor Logical Volume Capacity (GiB)
The amount of storage space that is on the hypervisor logical volume.

Hypervisor Logical Volume Available Space (GiB)
The amount of unused storage space on a hypervisor logical volume.

Hypervisor Logical Volume Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Hypervisor Logical Volume Block Size
The size of the blocks in the logical volume.

Hypervisor Logical Volume Allocation on Hypervisor Disk (GiB)
The amount of storage space that is allocated to the hypervisor logical
volume on hypervisor server disks.

Hypervisor Logical Volume Is Swap Space
Shows whether a logical volume is used to store some of the contents of
the RAM when the RAM is full. If this value is Yes, the logical volume is
used to store some of the contents of the RAM.

Hypervisor Logical Volume Mirror Count
The number of mirrors that keep a synchronous copy of the resource.

Hypervisor Logical Volume VM File System Version
The version number of the virtual machine file system on the hypervisor
logical volume.

Status information

You can create resource reports that include the following information:
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Hypervisor Logical Volume Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Hypervisor Logical Volume Last Scan
The date and time when file statistics were last collected from the resource.

Data for server disks on hypervisors in resource reports
You can include general information, capacity data, path information, and other
information about server disks on hypervisors in resource reports.

Information about server disks

You can create resource reports that include the following information:

Hypervisor Disk Path
The identifier that specifies a path to a hypervisor server disk, for example
vmhba1:0:0.

Capacity and usage data

You can create resource reports that include the following information:

Hypervisor Disk Capacity (GiB)
The amount of storage space that is on the hypervisor disk.

Hypervisor Disk Available Space (GiB)
The amount of unused storage space on a hypervisor server disk.

Status information

You can create resource reports that include the following information:

Hypervisor Disk Status
The condition of the resource, for example normal, warning, or error.

Hypervisor Disk Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Vendor, model, and device information

You can create resource reports that include the following information:

Hypervisor Disk Firmware Version
The version number of the firmware that is running on the disk.

Hypervisor Disk Model
The model name or model number of the resource.

Hypervisor Disk Serial Number
The serial number of the resource.

Hypervisor Disk Vendor
The vendor who supplied the resource.

Path information

You can create resource reports that include the following information:

Hypervisor Disk LUN
The logical unit within a small computer system interface target on a disk.
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Hypervisor Disk SCSI Target
The bus address for the small computer system interface of the target on a
disk.

Hypervisor Disk Target WWPN
The worldwide port name of the storage port that the volume is mapped
to.

Data for virtual machines managed by hypervisors in resource
reports
You can include general information, and file and disk information for virtual
machines in resource reports.

Information about virtual machines

You can create resource reports that include the following information:

Virtual Machine Name
The name that was assigned to the virtual machine when it was added to
the system.

Virtual Machine Configuration File
The path to the virtual machine configuration file for a hypervisor virtual
machine, for example [datastore1] example/example.vmx.

Virtual Machine Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Virtual Machine Number of CPU
The number of processors on the virtual machine.

Virtual Machine Status
The condition of the resource, for example normal, warning, or error.

Virtual Machine Total Memory (GiB)
The amount of memory on a hypervisor virtual machine.

Virtual machine file information

You can create resource reports that include the following information:

Virtual Machine File Path
The path to the virtual machine configuration file, or to the virtual
machine disk file for the virtual machine. The virtual machine
configuration file is a .vmx file, and the virtual machine disk file is a .vmdk
file.

Virtual Machine File Logical Size (GiB)
The logical size of a virtual machine disk file for a hypervisor virtual
machine.

Virtual Machine File Type
The type of the file for the virtual machine. For example, the file can be a
virtual machine configuration file, a virtual machine disk file, an ISO
image file, or other types of virtual machine file.

Virtual machine disk information

You can create resource reports that include the following information:
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Virtual Machine Disk Name
The name that was assigned to the virtual machine disk when it was
added to the system.

Virtual Machine Disk SCSI Target
The bus address for the small computer system interface of the target on a
disk.

Virtual Machine Disk Type
The type of virtual machine disk, for example, collection mirroring or
logical disk mirroring.

Data for network-attached storage systems in resource reports
You can include general information, capacity data, properties, and other
information about network-attached storage (NAS) systems in resource reports.

Information about NAS systems

You can create resource reports that include the following information:

NAS Name
The fully qualified domain name of the NAS device. For example, the
name of a NAS device might be nas.example.com.

NAS Domain Name
The domain name of the cluster, server, or NAS server.

NAS Short Name
The host name from the fully qualified domain name of the NAS device.
For example, if the fully qualified domain name of the NAS device is
mycomputer.example.com, the host name is mycomputer.

NAS Custom Tag 1
User-defined text that is associated with the resource.

NAS Custom Tag 2
User-defined text that is associated with the resource.

NAS Custom Tag 3
User-defined text that is associated with the resource.

Capacity and usage data

You can create resource reports that include the following information:

NAS Total Disk Capacity (GiB)
The amount of storage space on all disks on a NAS resource.

NAS Total Disk Available Space (GiB)
The amount of unused storage space on all disks on a NAS resource.

NAS Total File System Available Space (GiB)
The amount of unused storage space on the file systems on a NAS
resource.

Component properties

You can create resource reports that include the following information:

NAS OS Type
The operating system that is running on the server.
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NAS OS Version
The version number of the operating system that is running on the
resource.

Vendor, model, and device information

You can create resource reports that include the following information:

NAS Model
The model name or model number of the resource.

NAS Serial Number
The serial number of the resource.

NAS Vendor
The vendor who supplied the resource.

Status information

You can create resource reports that include the following information:

NAS Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

NAS Last Data Collection
The date and time when storage statistics were last collected from the
resource.

NAS Last Start Time
The last time that the resource was started.

NAS system components information

You can create resource reports that include the following information:

NAS System Name
The name that was assigned to the NAS system when it was added to the
system.

NAS System IP Address
The IP address of the resource.

NAS System Custom Tag 1
User-defined text that is associated with the resource.

NAS System Custom Tag 2
User-defined text that is associated with the resource.

NAS System Custom Tag 3
User-defined text that is associated with the resource.

Data for file systems on network-attached storage systems in
resource reports
You can include general information, capacity data, and other information about
file systems on network-attached storage (NAS) systems in resource reports.

Information about file systems on NAS systems

You can create resource reports that include the following information:
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NAS File System Mount Point
The name or mount point of the file system for the resource. For example,
on Microsoft Windows systems, the value in this column header might be
c:\ or d:\. On operating systems such as AIX, Linux, Solaris, or HP-UX,
the mount point might be /opt or /export/home.

NAS File System Export Name
The name of the exported file system.

NAS File System Type
The type of file system that the resource uses.

Capacity and usage data

You can create resource reports that include the following information:

NAS File System Capacity (GiB)
The amount of storage space on the file system of the resource.

NAS File System Directory Count
The number of directories in the file systems that are on a server.

NAS File System File Count
The number of files in the file system.

NAS File System Available Space (GiB)
The amount of unused storage space in the file system of the resource.

NAS File System Available Inodes
The number of unused inodes on the file system on a NAS server.

NAS File System Used Inodes
The number of used inodes on the file system on a NAS server.

NAS File System Maximum Files
The maximum number of files that the file system on the resource can
contain.

NAS File System Physical Size (GiB)
The amount of physical storage space on the file systems on a resource.
The physical size is the size of all the clusters that the file system uses.

NAS File System Used Space (GiB)
The amount of used storage space in the file system of the resource.

Status information

You can create resource reports that include the following information:

NAS File System Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

NAS File System Last Scan
The date and time when file statistics were last collected from the resource.

Data for network-attached storage exports in resource reports
You can include general information and status information about
network-attached storage (NAS) exports in resource reports.

Information about network-attached storage exports

You can create resource reports that include the following information:
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NAS Export Name
The name of the network-attached storage export. Use this name to mount
the network-attached storage export on a server.

NAS Export Path
The path to a logical volume on a resource, for example /dev/hd1.

NAS Export State
Shows whether the network-attached storage export is active.

Status information

You can create resource reports that include the following information:

NAS Export Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Data for logical volumes on network-attached storage systems in
resource reports
You can include general information, capacity data, and other information about
logical volumes on network-attached storage (NAS) systems in resource reports.

Information about logical volumes on NAS systems

You can create resource reports that include the following information:

NAS Logical Volume Name
The name that was assigned to the NAS logical volume when it was added
to the system.

NAS Logical Volume Type
The type of NAS logical volume. The logical volume type can be a NetApp
traditional volume or a NetApp flexible volume.

Capacity and usage data

You can create resource reports that include the following information:

NAS Logical Volume Capacity (GiB)
The amount of storage space on the NAS logical volume.

NAS Logical Volume Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Status information

You can create resource reports that include the following information:

NAS Logical Volume Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

NAS Logical Volume Last Scan
The date and time when file statistics were last collected from the resource.

Data for network-attached storage disks in resource reports
You can include general information, capacity data, properties, and other
information about network-attached storage (NAS) disks in resource reports.
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Information about NAS disks

You can create resource reports that include the following information:

NAS Disk Name
The name that was assigned to the NAS disk when it was added to the
system.

Capacity and usage data

You can create resource reports that include the following information:

NAS Disk Total Capacity (GiB)
The amount of storage space that is on the NAS disk.

NAS Disk Available Space (GiB)
The amount of unused storage space on a NAS disk.

Status information

You can create resource reports that include the following information:

NAS Disk Status
The condition of the resource, for example normal, warning, or error.

NAS Disk Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

IBM Scale Out Network Attached Storage and Storwize V7000 Unified
information

You can create resource reports that include the following information:

NSD Available Fragments
The number of fragments of disk space that are unused on the Network
Shared Disk (NSD).

NSD Failover Group
The failover group that the NSD belongs to. A failover group is a group of
resources that are grouped together to ensure that some of those resources
are available if one or more of the resources fail.

NSD Type
The type of the NSD. For example, the type can be:
v Data and metadata
v Metadata only
v Data only

NSD Last Data Collection
The date and time when storage statistics were last collected from the
resource.

NetApp information

You can create resource reports that include the following information:

NAS Disk Flag
Shows whether the NAS disk is a spare device. If this value is Spare
device, the NAS disk is a spare device.
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NAS Disk Is Encrypted
Shows whether the resource is encrypted. If this value is Yes, the resource
is encrypted.

NAS Disk Is Removable
Shows whether the disk can be removed from the server. If this value is
Yes, the disk can be removed from the server.

NAS Disk Is Solid State
Shows whether the disk is a solid-state drive.

NetApp paths information

You can create resource reports that include the following information:

NAS Disk LUN
The logical unit within a small computer system interface target on a disk.

NAS Disk SCSI Target
The bus address for the small computer system interface of the target on a
disk.

NAS Disk Target WWPN
The worldwide port name of the storage port that the volume is mapped
to.

NetApp vendor, model, and device information

You can create resource reports that include the following information:

NAS Disk Firmware Version
The version number of the firmware that is running on the disk.

NAS Disk Model
The model name or model number of the resource.

NAS Disk Serial Number
The serial number of the resource.

NAS Disk Vendor
The vendor who supplied the resource.

Data for pools on IBM SONAS and Storwize V7000 Unified
systems in resource reports
You can include general information and capacity data about pools on IBM Scale
Out Network Attached Storage and Storwize V7000 Unified systems in resource
reports.

Information about pools on network-attached storage systems

You can create resource reports that include the following information:

NAS Pool Name
The name that was assigned to the NAS pool when it was added to the
system.

Capacity and usage data

You can create resource reports that include the following information:

NAS Pool Capacity (GiB)
The amount of storage space that is in a NAS pool.
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NAS Pool Available Space (GiB)
The amount of unused storage space in a NAS pool.

NAS Pool Number of Logical Volumes
The number of logical volumes on a resource.

Data for IBM SONAS and Storwize V7000 Unified file sets in
resource reports
You can include general information, capacity data, and other information about
IBM Scale Out Network Attached Storage and Storwize V7000 Unified file sets in
resource reports.

Information about network-attached storage file sets

You can create resource reports that include the following information:

NAS File Set Name
The name that was assigned to the network-attached storage (NAS) file set
when it was added to the system.

NAS File Set Comment
A comment that is associated with the NAS file set.

NAS File Set Path
The path to a logical volume on a resource, for example /dev/hd1.

Capacity and usage data

You can create resource reports that include the following information:

NAS File Set Used Space (GiB)
The amount of used storage space in the file set of the NAS resource.

NAS File Set Used Inodes
The number of used inodes in file systems on operating systems such as
AIX, Linux, Solaris, or HP-UX.

Status information

You can create resource reports that include the following information:

NAS File Set Status
Shows whether the network-attached storage file set is linked or unlinked.

NAS File Set Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Data for storage virtualizers in resource reports
You can include general information, capacity data, properties, and other
information about storage virtualizers in resource reports.

Information about storage virtualizers

You can create resource reports that include the following information:

Storage Virtualizer Name
The user-defined name for the storage virtualizer, or the name that was
assigned to the storage virtualizer by the vendor.
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Capacity and usage data

You can create resource reports that include the following information:

Storage Virtualizer Total Pool Capacity (GiB)
The amount of storage space in pools on the storage virtualizer.

Storage Virtualizer Pool Used Space (GiB)
The amount of used storage space in the pools in a storage virtualizer
pool.

Storage Virtualizer Pool Available Space (GiB)
The amount of unused storage space in the pools in a storage virtualizer
pool.

Storage Virtualizer Total Volume Capacity (GiB)
The amount of virtual volume space on all volumes on the storage
virtualizer.

Storage Virtualizer Volume Allocated Space (GiB)
The amount of storage space that is allocated to volumes.

Storage Virtualizer Volume Assigned Space (GiB)
The amount of virtual volume space that is assigned to the server or
storage virtualizer.

Storage Virtualizer MDisk Available Space (GiB)
The amount of space on managed disks that is available to be added to a
pool.

Storage Virtualizer MDisk Capacity (GiB)
The amount of storage space on the managed disk.

Storage Virtualizer Disk Capacity (GiB)
The amount of local disk storage on the storage virtualizer.

Storage Virtualizer Disk Capacity (GiB)
The amount of local disk storage on the storage virtualizer.

Storage Virtualizer Number of MDisks
The number of managed disks on a resource.

Storage Virtualizer Number of Volumes
The number of volumes on a resource.

Storage Virtualizer Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Storage Virtualizer Tier Available Space (GiB)
The amount of unused tier storage of a particular type. The type is
identified in the Storage Virtualizer Tier Type property, in the Component
Properties folder.

Storage Virtualizer Tier Capacity (GiB)
The amount of tier storage of a particular type. The type is identified in
the Storage Virtualizer Tier Type property, in the Component Properties
folder.

Component properties

You can create resource reports that include the following information:
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Storage Virtualizer Access Information
The URL from which you can access the storage system or storage
virtualizer.

Storage Virtualizer Alias
Shows an alternative name for a storage virtualizer.

Storage Virtualizer Code Level
The microcode or firmware level of the storage virtualizer.

Storage Virtualizer Time Zone
The time zone in which a resource is located.

Storage Virtualizer Custom Tag 1
User-defined text that is associated with the resource.

Storage Virtualizer Custom Tag 2
User-defined text that is associated with the resource.

Storage Virtualizer Custom Tag 3
User-defined text that is associated with the resource.

Storage Virtualizer Location
The site location of the storage system or storage virtualizer.

Storage Virtualizer User Provided Name
The name that was specified for the storage virtualizer in the storage
environment.

Storage Virtualizer Tier Type
The type of tier that is used on the storage virtualizer or storage virtualizer
pool. For example, the tier type can be hard disk drive (HDD) or
solid-state drive (SSD).

Status information

You can create resource reports that include the following information:

Storage Virtualizer Status
The condition of the resource, for example normal, warning, or error.

Storage Virtualizer Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Storage Virtualizer Last Data Collection
The date and time when storage statistics were last collected from the
resource.

Storage Virtualizer Last Data Collection Status
The condition of the last data collection. The status can show if the
collection was a success, a failure, or if data was collected from the
resource.

Vendor, model, and device information

You can create resource reports that include the following information:

Storage Virtualizer IP Address
The IP address of the resource.

Storage Virtualizer Serial Number
The serial number of the resource.
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Storage Virtualizer Type
The type of storage virtualizer. For example, the storage virtualizer can be
a Storwize V7000 system, a Storwize V7000 Unified system, or a SAN
Volume Controller.

Storage Virtualizer Model
The model name or model number of the resource.

Storage Virtualizer Vendor
The vendor who supplied the resource.

Data for storage virtualizer pools in resource reports
You can include general information, capacity data, properties, and other
information about storage virtualizer pools in resource reports.

Information about storage virtualizer pools

You can create resource reports that include the following information:

Storage Virtualizer Pool Name
The name that was assigned to the pool when it was added to the system.

Capacity and usage data

You can create resource reports that include the following information:

Storage Virtualizer Pool Capacity (GiB)
The amount of storage space in the pool on the storage virtualizer. For
SAN Volume Controller, this value represents the amount of managed disk
space that is assigned to the managed disk group.

Storage Virtualizer Pool Available Space (GiB)
The amount of unused storage space in a storage virtualizer pool.

Storage Virtualizer Pool Virtual Volume Capacity (GiB)
The amount of virtual volume space on all volumes in the pool.

Storage Virtualizer Pool Real Volume Capacity (GiB)
The amount of space on all allocated extents in a pool. The allocated
extents include the used extents and extents that were assigned to volumes
when they were allocated.

Storage Virtualizer Pool Used Volume Space (GiB)
The amount of used space on all the volumes and volume copies in the
pool.

Storage Virtualizer Pool Overallocation Percentage
The percentage of space that is allocated to virtual capacity on volumes in
the pool.

Storage Virtualizer Pool Extent Size (MiB)
The size of the extents that were specified when a pool was created.

Storage Virtualizer Pool Assigned Volume Space (GiB)
The amount of space in the pool that is on volumes that are assigned to a
server or storage virtualizer.

Storage Virtualizer Pool Unassigned Volume Space (GiB)
The amount of volume space in the pool that is not assigned to a server or
storage virtualizer.
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Storage Virtualizer Pool Tier Capacity (GiB)
The amount of pool tier storage of a particular type. The type is identified
in the Storage Virtualizer Pool Tier Type property, in the Component
Properties folder.

Storage Virtualizer Pool Tier Available Space (GiB)
The amount of pool tier storage of a particular type that is unused. The
type is identified in the Storage Virtualizer Tier Type property, in the
Component Properties folder.

Storage Virtualizer Pool Tier Number of MDisks
The number of managed disks on a resource.

Storage Virtualizer Pool Number of Storage Volumes
The number of volumes in the storage virtualizer pool.

Storage Virtualizer Pool Number of MDisks
The number of managed disks on a resource.

Component properties

You can create resource reports that include the following information:

Storage Virtualizer Pool Is Encryptable
Shows whether the resource can be encrypted. If this value is Yes, the
resource can be encrypted.

Storage Virtualizer Pool Is Encrypted
Shows whether the resource is encrypted. If this value is Yes, the resource
is encrypted.

Storage Virtualizer Pool Is Solid State
Shows whether there are solid-state drives in the pool. This property can
contain the following values:

Mixed The pool contains both hard disk drives and solid-state drives.

Non solid state
The pool contains no solid-state drives.

Solid state
The pool contains a least one solid-state drive.

Storage Virtualizer Pool Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.

Storage Virtualizer Pool RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.

Storage Virtualizer Pool Warning Level
The percentage of used capacity of the resource at which a warning is
generated.

Storage Virtualizer Pool Tier Type
The type of tier that is used on the storage virtualizer or storage virtualizer
pool. For example, the tier type can be hard disk drive (HDD) or
solid-state drive (SSD).
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Storage Virtualizer Pool Is Easy Tier
Shows whether the IBM System Storage Easy Tier® feature is enabled. The
IBM System Storage Easy Tier feature can be set to auto, on, or off.

The IBM System Storage Easy Tier feature automatically helps optimize
solid-state storage deployments in multitier systems.

Status information

You can create resource reports that include the following information:

Storage Virtualizer Pool Status
The condition of the resource, for example normal, warning, or error.

Storage Virtualizer Pool Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Storage Virtualizer Pool Easy Tier Status

Shows whether the Easy Tier feature is active or inactive.

Data for storage virtualizer volumes in resource reports
You can include general information, capacity data, properties, information about
copies of volumes, and other information about storage virtualizer volumes in
resource reports.

Information about storage virtualizer volumes

You can create resource reports that include the following information:

Storage Virtualizer Volume Name
The name that was assigned to the storage virtualizer volume when it was
added to the system.

Capacity and usage data

You can create resource reports that include the following information:

Storage Virtualizer Volume Capacity (GiB)
The amount of storage space on the volume.

Storage Virtualizer Volume Real Space (GiB)
The physical space for a thin-provisioned volume that was allocated when
the volume was created.

Storage Virtualizer Volume Used Space (GiB)
The amount of virtual space that is used on a thin-provisioned volume. For
volumes that are not thin provisioned, this value is same as the Storage
Virtualizer Volume Capacity value.

Storage Virtualizer Volume Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Component properties

You can create resource reports that include the following information:
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Storage Virtualizer Volume Type
The type of storage virtualizer volume. For example, the storage virtualizer
volume can be striped, sequential, or another type of storage virtualizer
volume.

Storage Virtualizer Volume WWN
The worldwide name of the volume.

Storage Virtualizer Volume Fast Write State
Shows whether the cache for a volume on a disk that is managed by a
storage virtualizer is empty, contains data, or is corrupted.

Storage Virtualizer Volume Grain Size (KiB)
The unit in which space is allocated from a volume. Larger grain sizes
maximize performance. Smaller grain sizes maximize space efficiency.

Storage Virtualizer Volume Is Assigned
Shows whether the volume is assigned to a server. If this value is Yes, the
volume is assigned to a server.

Storage Virtualizer Volume Is Auto Expand Enabled
Shows whether a volume or volume copy can allocate new extents from a
pool automatically. Volumes or volume copies might allocate new extents
to expand the real capacity of the storage virtualizer volume or volume
copy. If this value is Yes, the volume or volume copy can allocate new
extents from a pool automatically.

Storage Virtualizer Volume Is Encryptable
Shows whether the resource can be encrypted. If this value is Yes, the
resource can be encrypted.

Storage Virtualizer Volume Is Encrypted
Shows whether the resource is encrypted. If this value is Yes, the resource
is encrypted.

Storage Virtualizer Volume Is Formatted
Shows whether a storage virtualizer volume is formatted. If this value is
Yes, the storage virtualizer volume is formatted.

Storage Virtualizer Volume Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.

Storage Virtualizer Volume Metro Mirror Name
The name of the Metro Mirror that keeps the synchronous copy of the
storage virtualizer volume.

Storage Virtualizer Volume Mirror Count
The number of mirrors that keep a synchronous copy of the resource.

Storage Virtualizer Volume Preferred Node
The number of the storage virtualizer node that is used for I/O operations
for the storage virtualizer volume.

Storage Virtualizer Volume Throttle
The maximum number of commands that the storage virtualizer volume
can queue.

Storage Virtualizer Volume Warning Level
The percentage of used capacity of the resource at which a warning is
generated.

Chapter 9. Reporting in the web-based GUI 1401



Storage Virtualizer Volume Copy Relationship
Shows whether a volume or a copy of a volume is in a FlashCopy
relationship or a point-in-time relationship. This property can contain the
following values:

Source Relationship
The volume is the source of the relationship.

Target Relationship
The volume is the target of the relationship.

Both Source and Target Relationship
The volume is both the source and target of the relationship.

This property applies only to SAN Volume Controller.

Status information

You can create resource reports that include the following information:

Storage Virtualizer Volume Status
The condition of the resource, for example normal, warning, or error.

Storage Virtualizer Volume Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Storage Virtualizer Volume Native Status
Shows the level of access of nodes in the system to the storage virtualizer
managed disk or volume. The level of access can be online, offline,
degraded, or excluded.

Volume copy information

You can create resource reports that include the following information:

Storage Virtualizer Volume Copy ID
The identifier of the storage virtualizer volume copy.

Storage Virtualizer Volume Copy Grain Size (KiB)
The unit in which space is allocated from a volume. Larger grain sizes
maximize performance. Smaller grain sizes maximize space efficiency.

Storage Virtualizer Volume Copy Is Auto Expand Enabled
Shows whether a volume or volume copy can allocate new extents from a
pool automatically. Volumes or volume copies might allocate new extents
to expand the real capacity of the storage virtualizer volume or volume
copy. If this value is Yes, the volume or volume copy can allocate new
extents from a pool automatically.

Storage Virtualizer Volume Copy Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Storage Virtualizer Volume Copy Is Primary
Shows whether the storage virtualizer volume copy is the primary volume
copy.

Storage Virtualizer Volume Copy Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.
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Storage Virtualizer Volume Copy Total Number of Extents
The number of extents that are used by the storage virtualizer volume
copy.

Storage Virtualizer Volume Copy Type
The type of copy of the storage virtualizer volume. For example, the copy
of the storage virtualizer volume can be sequential, a mirror copy, or
another type of copy.

Storage Virtualizer Volume Copy Warning Level
The percentage of used capacity of the resource at which a warning is
generated.

Data for managed disks on storage virtualizers in resource
reports
You can include general information, capacity data, properties, and other
information about managed disks on storage virtualizers in resource reports.

Information about managed disks on storage virtualizers

You can create resource reports that include the following information:

Storage Virtualizer MDisk Name
The name that was assigned to the managed disk on a storage virtualizer
when it was added to the system.

Capacity and usage data

You can create resource reports that include the following information:

Storage Virtualizer MDisk Capacity (GiB)
The amount of storage space on the managed disk.

Storage Virtualizer MDisk Available Space (GiB)
The amount of space on managed disks that is available to be added to a
pool.

Storage Virtualizer MDisk Strip Size (KB)
The number of blocks in a strip on a storage virtualizer managed disk.

Component properties

You can create resource reports that include the following information:

Storage Virtualizer MDisk RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.

Storage Virtualizer MDisk Spare Goal
The number of spare drives that are needed to maintain redundancy. Use
spare drives to protect against drive failures in the array on a managed
disk on a storage virtualizer.

Storage Virtualizer MDisk Type
The type of managed disk on a storage virtualizer. For example, the
storage virtualizer can be a local or virtual managed disk.

Storage Virtualizer MDisk Mode
The access mode of a managed disk on a storage virtualizer. The access
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mode describes how extents are provided for virtual disks. Extents can be
provided to virtual disks in the following ways:

Array Extents are provided from local disks.

Managed
Extents are provided from a back-end storage volume.

Unmanaged
The managed disk is not used in the system.

Storage Virtualizer MDisk Is Balanced
Shows whether logical unit numbers (LUNs) are properly balanced across
storage controllers on the managed disk. If this value is Yes, the LUNs are
properly balanced.

Storage Virtualizer MDisk Fast Write State
Shows whether the cache for a volume on a disk that is managed by a
storage virtualizer is empty, contains data, or is corrupted.

Storage Virtualizer MDisk Write Verify
Shows whether all write operations on the storage virtualizer managed
disk are verified by an immediate follow-up read operation. The follow-up
read operation verifies that the write operation was successful. If this value
is Yes, all write operations are verified by a follow-up read operation.

Status information

You can create resource reports that include the following information:

Storage Virtualizer MDisk Status
The condition of the resource, for example normal, warning, or error.

Storage Virtualizer MDisk Native Status
Shows the level of access of nodes in the system to the storage virtualizer
managed disk or volume. The level of access can be online, offline,
degraded, or excluded.

Data for local disks on storage virtualizers in resource reports
You can include general information, capacity data, properties, and other
information about local disks on storage virtualizers in resource reports.

Information about local disks on storage virtualizers

You can create resource reports that include the following information:

Storage Virtualizer Local Disk Name
The name that was assigned to the local disk on the storage virtualizer
when it was added to the system.

Capacity and usage data

You can create resource reports that include the following information:

Storage Virtualizer Local Disk Capacity (GiB)
The amount of storage space on the local disk.

Component properties

You can create resource reports that include the following information:
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Storage Virtualizer Local Disk Is Encryptable
Shows whether the resource can be encrypted. If this value is Yes, the
resource can be encrypted.

Storage Virtualizer Local Disk Is Encrypted
Shows whether the resource is encrypted. If this value is Yes, the resource
is encrypted.

Storage Virtualizer Local Disk Storage Class
The storage technology of the storage virtualizer local disk. For example,
the storage class can be serial-attached SCSI (SAS) or solid-state drive
(SSD).

Storage Virtualizer Local Disk Is Solid State
Shows whether the disk is a solid-state drive.

Storage Virtualizer Local Disk Speed (RPM)
The speed of the storage virtualizer local disk.

Status information

You can create resource reports that include the following information:

Storage Virtualizer Local Disk Status
The condition of the resource, for example normal, warning, or error.

Vendor, model, and device information

You can create resource reports that include the following information:

Storage Virtualizer Local Disk Firmware Version
The version number of the firmware that is running on the disk.

Storage Virtualizer Local Disk Model
The model name or model number of the resource.

Storage Virtualizer Local Disk Serial Number
The serial number of the resource.

Storage Virtualizer Local Disk Vendor
The vendor who supplied the resource.

Data for storage systems in resource reports
You can include general information, capacity data, properties of components, and
other information about storage systems in resource reports.

Information about storage systems

You can create resource reports that include the following information:

Storage System Name
The user-defined name for the storage system, or the name that was
assigned to the system by the vendor.

Capacity and usage data

You can create resource reports that include the following information:

Storage System Pool Capacity (GiB)
The amount of storage space in pools that are on the storage system. For
an XIV system, this value represents the physical capacity of the pool, not
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the virtual capacity. For other storage systems, this value might also
include overhead space if the pool is unformatted.

Storage System Used Pool Space (GiB)
The amount of space that is in use in all pools on a storage system.

Storage System Available Pool Space (GiB)
The amount of unused space in pools that are on the storage system.

Storage System Volume Capacity (GiB)
The amount of space on all volumes on the storage system.

Storage System Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Storage System Assigned Volume Space (GiB)
The amount of space on the storage system that is on volumes that are
assigned to a server or storage virtualizer.

Storage System Unallocated Disk Space (GiB)
The amount of disk space that can be added to a pool.

Storage System Number of Disks
The number of disks on the storage system.

Storage System Number of Volumes
The number of volumes on a resource.

Storage System Cache (GiB)
The size of the cache on the storage system.

Storage System Real Available Pool Space (GiB)
The amount of unused space in pools that have an associated soft size on
an XIV system. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Storage System Real Configured Pool Space (GiB)
The amount of storage space that is in pools that have an associated soft
size on an XIV system. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Storage System Volume Capacity for z/OS (GiB)
The amount of space on all volumes on the storage system that the z/OS
operating system can use.

Storage System Volume Capacity Assigned to MDisks (GiB)
The amount of space that is on volumes that are assigned to a storage
virtualizer to use as managed disks.

Storage System Disk Capacity (GiB)
The amount of storage space on physical disks on the storage system,
excluding spare disks.

Storage System Total Disk Capacity (GiB)
The amount of space on physical disks on a storage system, including
spare disks.

Component properties

You can create resource reports that include the following information:
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Storage System Access Information
The URL from which you can access the storage system or storage
virtualizer.

Storage System Code Level
The Shared Ethernet Adapter level of a DS8000 storage system. For other
storage systems, this value is the firmware version.

Storage System Custom Tag 1
User-defined text that is associated with the resource.

Storage System Custom Tag 2
User-defined text that is associated with the resource.

Storage System Custom Tag 3
User-defined text that is associated with the resource.

Storage System User Provided Name
The name that was specified for the storage system in the storage
environment.

Status information

You can create resource reports that include the following information:

Storage System Status
The condition of the resource, for example normal, warning, or error.

Storage System Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Storage System Last Data Collection
The date and time when storage statistics were last collected from the
resource.

Storage System Last Data Collection Status
The condition of the last data collection. The status can show if the
collection was a success, a failure, or if data was collected from the
resource.

Vendor, model, and device information

You can create resource reports that include the following information:

Storage System Type
The type of storage system. For example, the storage system can be a
DS8000, or an XIV system, or another type of storage system.

Storage System IP Address
The IP address of the resource.

Storage System Model
The model name or model number of the resource.

Storage System Vendor
The vendor who supplied the resource.

Storage System Serial Number
The serial number of the resource.
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Data for storage system pools in resource reports
You can include general information, capacity data, properties of components, and
other information about storage system pools in resource reports.

Information about storage systems pools

You can create resource reports that include the following information:

Storage Pool Name
The name that was assigned to the pool when it was added to the system.

Capacity and usage data

You can create resource reports that include the following information:

Storage Pool Capacity (GiB)
The amount of storage space in the storage pool.

Storage Pool Available Space (GiB)
The amount of unused storage space in the pool.

Storage Pool Assigned Volume Space (GiB)
The amount of space in the pool that is on volumes that are assigned to a
server or storage virtualizer.

Storage Pool Unassigned Volume Space (GiB)
The amount of volume space in the pool that is not assigned to a server or
storage virtualizer.

Storage Pool Virtual Volume Capacity (GiB)
The amount of virtual volume space on all volumes in the pool.

Storage Pool Used Volume Space (GiB)
The amount of used space on all the volumes in the pool.

Storage Pool Real Configured Space (GiB)
The amount of storage space that is in an XIV system pool that has an
associated soft size. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Storage Pool Real Available Space (GiB)
The amount of unused space that is in an XIV system pool that has an
associated soft size. The soft size of a pool is the virtual size of a
thin-provisioned pool.

Storage Pool Repository Capacity (GiB)
The amount of space on all extents in the repository of a pool. This space
can be used to allocate track space-efficient volumes. This attribute applies
only to DS8000 storage systems.

Storage Pool Used Repository Space (GiB)
The amount of space on all extents in the repository of a pool that are
allocated. This space can be used to allocate track space-efficient volumes.
This attribute applies only to the DS8000 storage systems.

Storage Pool Overallocation Percentage
The percentage of space that is allocated to virtual capacity on volumes in
the pool.

Component properties

You can create resource reports that include the following information:
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Storage Pool RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.

Storage Pool Is Solid State
Shows whether there are solid-state drives in the pool. This property can
contain the following values:

Mixed The pool contains both hard disk drives and solid-state drives.

Non solid state
The pool contains no solid-state drives.

Solid state
The pool contains a least one solid-state drive.

Storage Pool Is Encrypted
Shows whether the resource is encrypted. If this value is Yes, the resource
is encrypted.

Storage Pool Format
Shows the format of the volume or pool. The format can be a Count Key
Data (CKD) format, or a fixed block format.

Storage Pool Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.

Storage Pool Logical Subsystem
The logical subsystem (LSS) to which a volume or pool belongs.

Storage Pool Rank Group
The rank group to which a pool is assigned, that is, 0 or 1. This property
applies only to the DS8000 and DS6000 storage systems.

Storage Pool Lock Behavior
Shows whether the pool is locked for write operations, or is disabled for
both read and write operations when storage space is limited. This
property applies only to an XIV system.

Status information

You can create resource reports that include the following information:

Storage Pool Status
The condition of the resource, for example normal, warning, or error.

Storage Pool Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Data for storage system volumes in resource reports
You can include general information, capacity data, properties, and other
information about storage system volumes in resource reports.

Information about storage system volumes

You can create resource reports that include the following information:

Storage Volume Name
The name that was assigned to the storage volume when it was added to
the system.
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Capacity and usage data

You can create resource reports that include the following information:

Storage Volume Capacity (GiB)
The amount of storage space on the volume.

Storage Volume Used Space (GiB)
The amount of virtual space that is used on a thin-provisioned volume. For
volumes that are not thin provisioned, this value is same as the Storage
Volume Capacity value. This property applies only to DS8000 storage
systems.

Storage Volume Overhead (GiB)
The amount of space that is used for system management. The amount of
space also includes space reserved for redundancy.

Component properties

You can create resource reports that include the following information:

Storage Volume RAID Level
The RAID level of the resource, such as RAID 5 or RAID 10. The RAID
level affects the performance and fault tolerance of the volumes that are
allocated from the resource.

Storage Volume Is Thin Provisioned
Shows whether a pool, volume, or volume copy is thin-provisioned. If this
value is Yes, the resource is thin-provisioned.

Storage Volume Is Assigned
Shows whether the volume is assigned to a server. If this value is Yes, the
volume is assigned to a server.

Storage Volume Is Encryptable
Shows whether the resource can be encrypted. If this value is Yes, the
resource can be encrypted.

Storage Volume Is Encrypted
Shows whether the resource is encrypted. If this value is Yes, the resource
is encrypted.

Storage Volume Is Volume Control Manager Database
Shows whether a volume is used as the Volume Control Manager
Database. If this value is Yes, the volume is used as the Volume Control
Manager Database. This property applies only to EMC storage systems.

Storage Volume Format
Shows the format of the volume or pool. The format can be a Count Key
Data (CKD) format, or a fixed block format.

Storage Volume Serial Number
The serial number of the resource.

Storage Volume Number
The number of the volume that is assigned by the system.

Storage Volume WWN
The worldwide name of the volume.

Storage Volume Logical Subsystem
The logical subsystem (LSS) to which a volume or pool belongs.
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Status information

You can create resource reports that include the following information:

Storage Volume Status
The condition of the resource, for example normal, warning, or error.

Storage Volume Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Data for storage system disks in resource reports
You can include properties, and other data about storage system disks in resource
reports.

Information about storage system disks

You can create resource reports that include the following information:

Storage Disk Name
The name that was assigned to the storage disk when it was added to the
system.

Capacity and usage data

You can create resource reports that include the following information:

Storage Disk Capacity (GiB)
The amount of storage space that is on a physical disk on the storage
system.

Component properties

You can create resource reports that include the following information:

Storage Disk Flags
Shows whether a device is a spare device. This property applies only to
DS8000 storage systems. DS5000

Storage Disk Is Encryptable
Shows whether the resource can be encrypted. If this value is Yes, the
resource can be encrypted.

Storage Disk Is Encrypted
Shows whether the resource is encrypted. If this value is Yes, the resource
is encrypted.

Storage Disk Is Solid State
Shows whether the disk is a solid-state drive.

Storage Disk Speed (RPM)
The speed of the disk.

Storage Disk Tag
A number that identifies the array to which a disk belongs. This property
applies only to DS8000 and DS6000 storage systems, and to ESS servers.

Storage Disk Class
The storage technology of the disk. This property applies only to DS8000,
DS5000, and DS4000 storage systems. This property can contain the
following values:
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FC The disk is a Fibre Channel disk.

Nearline ATA
The disk is a nearline Advanced Technology Attachment disk.

Nearline SAS
The disk is a nearline serial-attached SCSI disk.

SAS The disk is a serial-attached SCSI disk.

SATA The disk is a Serial Advanced Technology Attachment disk.

SSD The disk is a solid-state drive.

Unavailable
The disk is on a DS5000 or DS4000 series system, and is not a
solid-state drive.

Unsupported
The disk is on a system that is not a DS8000, DS5000, or DS4000
series system.

Status information

You can create resource reports that include the following information:

Storage Disk Status
The condition of the resource, for example normal, warning, or error.

Storage Disk Is Detected
Shows whether the resource was detected the last time that data was
collected. If this value is Yes, the resource was detected.

Vendor, model, and device information

You can create resource reports that include the following information:

Storage Disk Firmware Version
The version number of the firmware that is running on the disk.

Storage Disk Model
The model name or model number of the resource.

Storage Disk Serial Number
The serial number of the resource.

Storage Disk Vendor
The vendor who supplied the resource.

Data for storage system groups in resource reports
You can include general information about, and properties of, storage system
groups in resource reports.

Information about storage system groups

You can create resource reports that include the following information:

Storage System Group Name
The name that was assigned to the storage system group when it was
added to the system.
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Component properties

You can create resource reports that include the following information:

Storage System Group Creator
The ID of the user who created the group.

Storage System Group Last Modified
The date and time that the resource was last modified.

Storage System Group Last Modified by User
The ID of the user who last modified the resource.

Data for storage resource groups in resource reports
You can include general information about storage resource groups in resource
reports.

Information about storage resource groups

You can create resource reports that include the following information:

Storage Resource Group Name
The name that was assigned to the storage resource group when it was
created.

Storage Resource Group Last Modified by User
The ID of the user who last modified the resource.

Storage Resource Group Custom Tag 1
User-defined text that is associated with the resource.

Storage Resource Group Custom Tag 2
User-defined text that is associated with the resource.

Storage Resource Group Custom Tag 3
User-defined text that is associated with the resource.

Troubleshooting reports
Find answers to questions about resolving issues with reports in Tivoli Common
Reporting.

Problem
When you run a report, the report opens in a new web browser window
rather than a new tab of the existing web browser window.

Solution
Configure the browser to open new windows in a tab.

Internet Explorer

1. Click Tools > Internet Options.
2. In the Tabs section of the General tab, click Settings.
3. Select Always open pop-ups in a new tab.
4. In the Tabbed Browsing Settings window, click OK.
5. Click OK to close the Internet Options window.

Learn more: For more information, check the documentation that
is provided with your browser. The instructions that are provided
here are based on Internet Explorer version 8.

Firefox
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1. Click Tools > Options.
2. Click Tabs.
3. Select Open new windows in a new tab instead.
4. Click OK.

Learn more: For more information, check the documentation that
is provided with your browser. The instructions that are provided
here are based on Firefox version 10.0.3.

Problem
In Tivoli Common Reporting, you right-click a property in the navigation
tree, and click Lineage to identify the data source of properties, such as
resources and performance metrics. When you click Lineage, a parsing
error, MSR-LIN-0006, might be generated.

Solution
To prevent the error message from being generated, you disable the feature
in the following two packages:
v IBM Tivoli Storage Productivity Center Resources

v IBM Tivoli Storage Productivity Center Performance

Repeat the following procedure to disable the two packages:
1. In the Public Folders tab, click the Set properties icon next to the

package.
2. Click the Capabilities tab.
3. Select Override the parent capabilities acquired from the parent entry

with.
4. Select the Everyone check box.
5. In the Lineage row, clear the Grant check box, and select Deny.
6. Click OK.

Problem
When you run reports, Tivoli Common Reporting times out.

Solution
Based on your operating system, complete the following steps to change
the timeout:

Windows

1. Open a command-line interface.
2. Stop Tivoli Common Reporting:

c:\program files\IBM\tipv2Components\TCRComponent\bin
\stopTCRserver.cmd

3. Open the configuration directory:
c:\program files\IBM\tipv2Components\TCRComponent
\cognos\configuration

4. Copy the cogstartup.xml file and, then change the name of the
copied file to cogstartup.orig.

5. Open the cogstartup.xml file:
c:\program files\IBM\tipv2Components\TCRComponent\cognos
\configuration\cogstartup.xml

6. In the cogstartup.xml file, enter the new timeout value in
seconds for the inactivityTimeout setting.
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7. In the cogstartup.xml file, enter new timeout value in minutes
for the mdmSessionTimeout setting.

8. Save the cogstartup.xml file.
9. Start Tivoli Common Reporting:

c:\program files\IBM\tipv2Components\TCRComponent\bin
\startTCRserver.cmd

AIX or Linux

1. Open a command-line interface.
2. Stop Tivoli Common Reporting:

/opt/IBM/tipv2Components/TCRComponent/bin/stopTCRserver.sh

3. Open the configuration directory:
/opt/IBM/tipv2Components/TCRComponent/cognos/configuration

4. Copy the cogstartup.xml file and, then change the name of the
copied file to cogstartup.orig.

5. Open the cogstartup.xml file:
/opt/IBM/tipv2Components/TCRComponent/cognos
/configuration/cogstartup.xml

6. In the cogstartup.xml file, enter the new timeout value in
seconds for the inactivityTimeout setting.

7. In the cogstartup.xml file, enter new timeout value in minutes
for the mdmSessionTimeout setting.

8. Save the cogstartup.xml file.
9. Start Tivoli Common Reporting:

/opt/IBM/tipv2Components/TCRComponent/bin/startTCRserver.sh

Problem
In Internet Explorer 8, when you open a report in Report Studio for the
first time, a CM-REQ-4158 error might be displayed.

Solution
For information about how to resolve this problem, see the IBM Tivoli
Systems Management Information Center at http://publib.boulder.ibm.com/
infocenter/tivihelp/v3r1/index.jsp, and search for CM-REQ-4158.

Problem
You can set output format options for reports either when you schedule a
report or run a report. If you choose PDF format for your report and the
report contains many columns, all of the columns might not fit on one
page. For example, if a report contains 20 columns, then the row for a
specific resource might be shown on more than one page: 10 columns on
the first page and 10 columns on the second page.

Solution
To fit the maximum number of columns on one page, set the PDF options
in one of the following ways:

When you schedule a report

1. Navigate to a report in Tivoli Common Reporting.

2. Click the Schedule icon ( ).
3. Select Override the default values.
4. Select PDF, and then click Set.
5. From the Orientation list, select Landscape.
6. From the Paper size list, select 11 × 17.

Chapter 9. Reporting in the web-based GUI 1415

http://publib.boulder.ibm.com/infocenter/tivihelp/v3r1/index.jsp
http://publib.boulder.ibm.com/infocenter/tivihelp/v3r1/index.jsp


When you run a report

1. Navigate to a report in Tivoli Common Reporting.

2. Click the Run with options icon ( ).
3. Click advanced options in the upper right of the "Run with

options" window.
4. Click Run in the background.
5. Select PDF, and then click Set.
6. From the Orientation list, select Landscape.
7. From the Paper size list, select 11 × 17.

Problem
When you create a custom report, you cannot find online help that
describes the columns that you can include in your reports.

Solution
To view the online help, follow these steps:
1. Navigate to the dashboard of the Tivoli Storage Productivity Center

web-based GUI.

2. Click the Help icon ( ).
3. Click Tivoli Storage Productivity Center Reporting.
4. Navigate to the help content that you want to view.

Problem
If the Tivoli Storage Productivity Center database (TPCDB) is not
accessible, you are prompted to reenter your user ID and password
although you previously entered the correct user ID and password.

Solution
Check that the server that hosts TPCDB is available. Check that the firewall
settings on the server are not preventing you from accessing TPCDB.

Problem
If the password to access the Tivoli Storage Productivity Center database
(TPCDB) is changed, you must also change the password in Tivoli
Common Reporting.

Solution
In Tivoli Common Reporting, complete the following steps:
1. In the Public Folders tab, click Launch > Administration.
2. Click the Configuration tab.
3. Click TPCDB, and then click TPCDB again.
4. In the Actions column, click the Set properties icon, and then click the

Signon tab.
5. Click Edit the signon.
6. Make your changes, and then click OK.

Setting up multiple connections to the TPCDB data source in Tivoli
Common Reporting

In Tivoli Common Reporting, you can add multiple connections to the Tivoli
Storage Productivity Center data source so that you can run reports against
multiple Tivoli Storage Productivity Center databases (TPCDBs). If you create
multiple connections, you can run reports for multiple Tivoli Storage Productivity
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Center servers from one Tivoli Common Reporting server. You can also develop
and test reports on multiple TPCDB databases in your storage environment.

After you add multiple connections to the TPCDB data source, when you run a
report you select the TPCDB database to connect to.
1. On the Tivoli Common Reporting server, add the remote TPCDB database to

the system database catalog, and assign an alias to the database. For example,
you can catalog the remote TPCDB database as TPCSRV1. For information
about how to catalog a remote database, go to the IBM Tivoli Storage
Productivity Center Information Center (http://publib.boulder.ibm.com/
infocenter/tivihelp/v59r1/index.jsp), and search for Installing Tivoli Common
Reporting on a remote server.

2. In the Tivoli Storage Productivity Center web-based GUI, select Reporting >
View predefined reports.

3. Click Launch > Administration, and click the Configuration tab.

4. Click the TPCDB data source, and click the New Connection icon ( ).
5. Enter the alias that you created in step 1 in the Name field, and then click

Next.
6. From the Type list, select DB2, and then click Next.
7. Enter the alias that you created in step 1 in the DB2 database name field.
8. Click Signons, select Password, and then enter a user ID and password for

the remote database.
9. Click Test the connection, and then click Test. Verify that the status of the

connection is Succeeded.
10. Click Close, and then click Close again.
11. Click Finish.
12. If you scheduled reports, modify the parameters of all scheduled reports to

specify the database against which to run the report. For more information
about report schedules, go to the IBM Cognos 8 v4 Business Intelligence
Information Center (http://publib.boulder.ibm.com/infocenter/c8bi/v8r4m0/
index.jsp), and search for schedule management.
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Appendix A. Reference

This topic contains reference material.

Alerts and schedules associated with monitoring groups and
templates

Use alerts to notify you when conditions for storage devices are detected by a data
collection schedule. Include storage devices in monitoring groups or templates to
automatically associate alerts and schedules with those devices.

IBM Tivoli Storage Productivity Center includes predefined groups and templates
that are associated with different sets of alerts and schedules. The group or
template that you select for a storage device determines what conditions are
checked when data is collected for those devices. Use the information in this topic
to help you determine the groups and templates that you want to use for the
storage devices in your environment.

Notes:

v If you want to include a storage device in a group, you can select a user-defined
group rather than a predefined group. Any alerts and schedules associated with
that user-defined group are automatically applied to the devices.

v When not using the Configure Devices wizard, you are not required to include a
storage device in a group or template to collect data or associate alerts with it.
You can include storage devices individually in schedules and associate alerts
with them at any time. Monitoring groups and templates are intended to help
you assign the same schedules and alerts to a number of related devices at the
same time.

v You can edit predefined monitoring groups and their associated probes, pings,
and alerts at any time. You can also edit the probes, pings, and alerts that are
created based on templates.
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Storage Subsystems

Table 98. Predefined monitoring groups, templates, schedules, and alerts for storage subsystems

Group name / Template name
The data collection schedule
associated with a group or template

Alert conditions that are checked for
devices in the group or template
during data collection1, 2

Group: Subsystem Basic Group

Template: Basic Subsystem
Monitoring

Schedule name: Subsystem Basic Probe

When it is run: 1x/week on Tuesday at
1:00 am

The schedule name and time are
different for templates. See table note 3

for more information.

Subsystem Discovered
Disk Not Found
Storage Subsystem Not Found
Subsystem Status Change Offline
Subsystem Status Change Online
Volume Status Change Offline
Volume Status Change Online
Pool Status Change
Pool Discovered
Pool Status Change Offline
Pool Status Change Online
Volume Not Found
File System Is Missing
Cluster Was Rediscovered
Cluster Was Removed
NSD Is Missing
NSD State Changed

Group: Subsystem Standard
Group

Template: Standard Subsystem
Monitoring

Schedule name: Subsystem Standard
Probe

When it is run: 2x/week on Monday
and Wednesday at 1:00 am

The schedule name and time are
different for templates. See table note 3

for more information.

Subsystem Discovered
Disk Not Found
Storage Subsystem Not Found
Subsystem Status Change Offline
Subsystem Status Change Online
Backend Controller Status

Change Offline
Backend Controller Status

Change Online
Volume Status Change Offline
Volume Status Change Online
Volume Capacity Change
Pool Status Change
Pool Discovered
Pool Status Change Offline
Pool Status Change Online
Pool Capacity Change
Volume Not Found
File System Is Missing
File System Reconfigured
Cluster Was Rediscovered
Cluster Was Removed
Export Is Missing
Export State Changed
NSD Is Missing
NSD State Changed
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Table 98. Predefined monitoring groups, templates, schedules, and alerts for storage subsystems (continued)

Group name / Template name
The data collection schedule
associated with a group or template

Alert conditions that are checked for
devices in the group or template
during data collection1, 2

Group: Subsystem Advanced
Group

Template: Advanced Subsystem
Monitoring

Schedule name: Subsystem Advanced
Probe

When it is run: 1x/day at 10:00 pm

The schedule name and time are
different for templates. See table note 3

for more information.

Subsystem Discovered
Cache Increased
Cache Decreased
Disk Not Found
Storage Subsystem Not Found
Subsystem Status Change Offline
Subsystem Status Change Online
Subsystem Version Change
Subsystem Property Change
Subsystem Allocated Capacity

Change
Subsystem Available Capacity

Change
Subsystem Backend Capacity

Change
Backend Controller Status

Change Offline
Backend Controller Status

Change Online
Volume Status Change Offline
Volume Status Change Online
Volume Capacity Change
Pool Status Change
Pool Discovered
Pool Status Change Offline
Pool Status Change Online
Pool Capacity Change
Node Status Change Offline
Node Status Change Online
Node Status Change
Node Discovered
Datapath State Change
Volume Not Found
File System Is Missing
File System Reconfigured
Cluster Was Rediscovered
Cluster Was Removed
Export Is Missing
Export Path Changed
Export Protocol Changed
Export State Changed
NSD Is Missing
NSD State Changed
Node State Changed
Node Status Changed to Error
Node Status Changed to Offline
Node Status Changed to Online
Node Status Changed to Warning

Default Storage Subsystem
Group4

No schedule is associated with this
group

No alert conditions are associated with
this group
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Table 98. Predefined monitoring groups, templates, schedules, and alerts for storage subsystems (continued)

Group name / Template name
The data collection schedule
associated with a group or template

Alert conditions that are checked for
devices in the group or template
during data collection1, 2

Notes:

1. See Triggering conditions for storage subsystem alerts for descriptions of the alert triggering conditions for
storage subsystems.

2. Performance alerts for storage subsystems are not associated with groups and templates. Performance alerts are
alerts that contain a "threshold" triggering condition. If you want to include a storage subsystem in a
performance alert, you must create an alert with a threshold triggering condition and then individually include
the storage subsystem in that alert. See “Creating storage system alerts” on page 392for information about how
to create storage subsystem alerts.

3. Note the following differences between schedules created from templates and groups:

v The name of a probe schedule created from a template contains a prefix that is defined in the Configure
Devices wizard. For example, if the Basic Subsystem Monitoring template is selected and "ABC" is entered as
the prefix, the resulting schedule is named "userID.ABCssBasicProbe", where userID represents the ID of the
user that is logged in toTivoli Storage Productivity Center.

v The probe schedule created from a template might not run at the time specified in this table. Tivoli Storage
Productivity Center determines the time at which the probe is run to ensure optimal server performance.

4. The Default Storage Subsystem Group is not automatically associated with a schedule or alerting conditions.
However, you can manually include this group in a schedule or associate it with alerts at any time.

Fabrics

Table 99. Predefined monitoring groups, templates, schedules, and alerts for fabrics

Group name / Template name
The data collection schedule
associated with a group or template

Alert conditions that are checked for
devices in the group or template
during data collection1

Group: Fabric Basic Group

Template: Basic Fabric
Monitoring

Schedule name: Fabric Basic Probe

When it is run: 2x/week on Monday
and Wednesday at 3:00 am

The schedule name and time are
different for templates. See table note 2

for more information.

Fabric State Change
Fabric to Switch Change
Switch discovered
Switch State Change
Switch Status Change Offline
Switch Status Change Online

Group: Fabric Standard Group

Template: Standard Fabric
Monitoring

Schedule name: Fabric Standard Probe

When it is run: 1x/day at 4:00 am

The schedule name and time are
different for templates. See table note 2

for more information.

Fabric State Change
Fabric to Switch Change
New Connection
Connection State Change
Switch discovered
Switch State Change
Switch Status Change Offline
Switch Status Change Online
Switch Blade Change
Switch Blade Change Offline
Switch Blade Change Online
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Table 99. Predefined monitoring groups, templates, schedules, and alerts for fabrics (continued)

Group name / Template name
The data collection schedule
associated with a group or template

Alert conditions that are checked for
devices in the group or template
during data collection1

Group: Fabric Advanced Group

Template: Advanced Fabric
Monitoring

Schedule name: Fabric Advanced Probe

When it is run: 2x/day at 6:00 am and
6:00 pm

The schedule name and time are
different for templates. See table note 2

for more information.

Fabric State Change
Fabric to Switch Change
Zone State Change
Zone Set State Change
Zone Set Discovered
Zone Set to Zone Change
Zone Alias to Member Change
New Connection
Connection State Change
Switch discovered
Switch State Change
Switch Status Change Offline
Switch Status Change Online
Switch Version Change
Switch Blade Change
Switch Blade Change Offline
Switch Blade Change Online

Default Fabric Group3 No schedule is associated with this
group

No alert conditions are associated with
this group

Notes:

1. See Triggering conditions for fabric alerts for descriptions of the alert triggering conditions for fabrics. See
Triggering conditions for switch alerts for descriptions of the alert triggering conditions for switches.

2. Note the following differences between schedules created from templates and groups:

v The name of a probe schedule created from a template contains a prefix that is defined in the Configure
Devices wizard. For example, if the Basic Fabric Monitoring template is selected and "ABC" is entered as a
prefix, the resulting schedule is named "userID.ABCfabBasicProbe", where userID represents the ID of the user
that is logged in to Tivoli Storage Productivity Center.

v The probe schedule created from a template might not run at the time specified in this table. Tivoli Storage
Productivity Center determines the time at which the probe is run to ensure optimal server performance.

3. The Default Fabric Group is not automatically associated with a schedule or alerting conditions. However, you
can manually include this group in a schedule or associate it with alerts at any time.

Computers

Table 100. Predefined monitoring groups, templates, schedules, and alerts for computers

Group name / Template name
The data collection schedule
associated with a group or template

Alert conditions that are checked for
devices in the group or template
during data collection1

Group: Computer Basic Group

Template: Basic Computer
Monitoring

v Ping schedule

Name: Computer Basic Ping

When it is run: every 3 hours

v Probe schedule

Name: Computer Basic Probe

When it is run: 2x/week on Monday
and Wednesday at 3:00 am

The schedule name and time are
different for templates. See table note 2

for more information.

Disk Not Found
New Disk Defect Found
Disk Failure Predicted
Computer Unreachable
Computer Discovered
Computer Status Change Offline
Computer Status Change Online
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Table 100. Predefined monitoring groups, templates, schedules, and alerts for computers (continued)

Group name / Template name
The data collection schedule
associated with a group or template

Alert conditions that are checked for
devices in the group or template
during data collection1

Group: Computer Standard
Group

Template: Standard Computer
Monitoring

v Ping schedule

Name: Computer Standard Ping

When it is run: every 60 minutes

v Probe schedule

Name: Computer Standard Probe

When it is run: 1x/day at 3:00 am

The schedule name and time are
different for templates. See table note 2

for more information.

New Disk Detected
Disk Not Found
New Disk Defect Found
Grown Disk Defects Exceed 5
Disk Failure Predicted
New Filesystem Detected
Computer Unreachable
Computer Discovered
Computer Status Change Offline
Computer Status Change Online
HBA Driver Version Change
HBA Firmware Version Change

Group: Computer Advanced
Group

Template: Advanced Computer
Monitoring

v Ping schedule

Name: Computer Advanced Ping

When it is run: every 30 minutes

v Probe schedule

Name: Computer Advanced Probe

When it is run: 2x/day at 5:00 am at
5:00 pm

The schedule name and time are
different for templates. See table note 2

for more information.

RAM Increased
RAM Decreased
Virtual Memory Increased
Virtual Memory Decreased
New Disk Detected
Disk Not Found
New Disk Defect Found
Grown Disk Defects Exceed 5
Disk Failure Predicted
New Filesystem Detected
Cluster Resource Group Added
Cluster Resource Group Removed
Cluster Resource Group Moved
Computer Unreachable
Computer Discovered
Computer Status Change Offline
Computer Status Change Online
Computer Property Change
HBA Driver Version Change
HBA Firmware Version Change

Default Computer Group3
v Ping schedule

Name: Default Ping

When it is run: every 30 minutes

v Probe schedule4

Name: Default Probe

When it is run: 1x/day at 1:45 am

No alert conditions are associated with
this group

1424 IBM Tivoli Storage Productivity Center: User's Guide



Table 100. Predefined monitoring groups, templates, schedules, and alerts for computers (continued)

Group name / Template name
The data collection schedule
associated with a group or template

Alert conditions that are checked for
devices in the group or template
during data collection1

Notes:

1. See Triggering conditions for computer alerts for descriptions of the alert triggering conditions for computers.

2. Note the following differences between schedules created from templates and groups:

v The name of a probe or ping schedule created from a template contains a prefix that is defined in the
Configure Devices wizard. For example, if the Basic Computer Monitoring template is selected and "ABC" is
entered as a prefix, the resulting schedule is named "userID.ABCcompBasicProbe", where userID represents the
ID of the user that is logged in to Tivoli Storage Productivity Center.

v The probe schedule created from a template might not run at the time specified in this table. Tivoli Storage
Productivity Center determines the time at which the probe is run to ensure optimal server performance.

3. The Default Computer Group is not automatically associated with alerting conditions. However, you can
manually associate it with alerts at any time.

4. When computers are added to Tivoli Storage Productivity Center, they are automatically included in the default
computer group, and that group is included in the default probe schedule (TPCUser.Default Probe). Because the
computers are included in TPCUser.Default Probe, they are considered to be configured for monitoring and are
not displayed in the Configure Devices wizard. To use the Configure Devices wizard to configure computers
that were included in TPCUser.Default Probe, you must move them into a group that is not associated with an
existing probe schedule. For more information, see .

Tape Libraries

Table 101. Predefined monitoring groups, templates, and schedules for tape libraries1

Group name / Template name
The data collection schedule associated with a group or
template

Group: Tape Basic Group

Template: Basic Tape Monitoring

Schedule name: Tape Basic Probe

When it is run: 1x/week on Sunday at 4:00 am

The schedule name and time are different for templates. See
table note 2 for more information.

Group: Tape Standard Group

Template: Standard Tape Monitoring

Schedule name: Tape Standard Probe

When it is run: 2x/week on Sunday and Wednesday at 4:00
am

The schedule name and time are different for templates. See
table note 2 for more information.

Group: Tape Advanced Group

Template: Advanced Tape Monitoring

Schedule name: Tape Advanced Probe

When it is run: 1x/day at 6:00 am

The schedule name and time are different for templates. See
table note 2 for more information.

Default Tape LibraryGroup2 No schedule is associated with this group
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Table 101. Predefined monitoring groups, templates, and schedules for tape libraries1 (continued)

Group name / Template name
The data collection schedule associated with a group or
template

Notes:

1. There are no alerting conditions available for tape libraries.

2. Note the following differences between schedules created from templates and groups:

v The name of a probe schedule created from a template contains a prefix that is defined in the Configure
Devices wizard. For example, if the Basic Tape Monitoring template is selected and "ABC" is entered as a
prefix, the resulting schedule is named "userID.ABCtapeBasicProbe", where userID represents the ID of the
user that is logged in to Tivoli Storage Productivity Center.

v The probe schedule created from a template might not run at the time specified in this table. Tivoli Storage
Productivity Center determines the time at which the probe is run to ensure optimal server performance.

3. The Default Tape Library Group is not automatically associated with a schedule. However, you can manually
include this group in a schedule at any time.

Supported Fabric Agent Types
The following table shows the supported agent types for Switch and Fabric
functions.

Table 102. Supported agent types for Switch and Fabric Functions

Function > Switch Brocade Cisco 1 QLogic

Switch Performance
Monitoring

CIMOM agent CIMOM agent CIMOM agent

Zone Control 2 CIMOM agent Storage Resource agent
required in each VSAN 6

Storage Resource agent 6

Zone Control with Zone
Aliases

CIMOM agent Not supported Not supported

Switch and switch port
information collected

Recommended: CIMOM
agent

Also supported:
Out-of-band Fabric agent
or Storage Resource
agent

Recommended: CIMOM agent

Also supported: Out-of-band
Fabric agent or Storage
Resource agent

Out-of-band Fabric agent or
Storage Resource agent

Topology connectivity
information collected

Recommended: CIMOM
agent

Also supported:
Out-of-band Fabric agent
or Storage Resource
agent

Out-of-band Fabric agent or
Storage Resource agent

Out-of-band Fabric agent or
Storage Resource agent

Zoning information
collected 2

Recommended: CIMOM
agent

Storage Resource agent
required in each VSAN 3 4 5

Storage Resource agent

Tivoli Storage
Productivity Center
Alerts

Recommended: CIMOM
agent

Also supported:
Out-of-band Fabric agent
or Storage Resource
agent

Out-of-band Fabric agent or
Storage Resource agent

Out-of-band Fabric agent or
Storage Resource agent
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Table 102. Supported agent types for Switch and Fabric Functions (continued)

Function > Switch Brocade Cisco 1 QLogic

Hosts, endpoint devices,
device-centric and
host-centric information
collected

Storage Resource agent Storage Resource agent Storage Resource agent

Switch "Sensors and
Events"

Out-of-band Fabric agent Out-of-band Fabric agent Out-of-band Fabric agent

Notes®:
1 The Storage Resource agent gets the information about a VSAN basis. Each VSAN is viewed as an individual
SAN. The Out-of-band Fabric agent and CIMOM agent get the physical fabric information and can correlate the
VSAN information to a physical infrastructure. The Out-of-band Fabric agent also collects some VSAN
information.
2 Zone Control refers to the ability to actively configure zoning. "Zone information collected" indicates that the
active zone set and the inactive zoning library information is collected during a fabric probe.
3 For many Cisco proprietary zone members, the values are displayed as zeros.
4 If a zoning configuration has Cisco proprietary zone members, then you will not be able to modify the zoning
for that configuration through Tivoli Storage Productivity Center. You need to use the element manager to
remove proprietary zone members or do zoning.
5 Orphan Cisco zones are not reported.
6 Tivoli Storage Productivity Center does not get a transaction lock on the switch while making zone changes on
the fabric.

Supported storage systems providing full disk encryption and
solid-state drives

IBM Tivoli Storage Productivity Center supports full disk encryption and
solid-state drives in the IBM System Storage DS8000 and IBM System Storage
DS5000 Storage Manager systems described in this topic.

DS8000 4.2 and later

Tivoli Storage Productivity Center supports full disk encryption and solid-state
drives in DS8000 4.2 and later.

IBM System Storage DS5000 Storage Manager series

IBM Tivoli Storage Productivity Center supports full disk encryption and
solid-state drives in the following DS5000 series systems:
v DS5100 and DS5300 - full disk encryption, solid-state drives, 1 TB SATA drives
v DS5020 - full disk encryption

To support full disk encryption and solid-state drives in DS5000, the LSI SMI-S
Provider is required. For more information about the LSI SMI-S Provider, see the
LSI Web site at http://www.lsi.com.

Frequently Asked Questions
Use this section to view answers to common questions about IBM Tivoli Storage
Productivity Center. These questions are organized according to the manager to
which they apply.
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General and Migration Information
Learn about the issues when working with IBM Tivoli Storage Productivity Center,
upgrading to a new version of the product, or migrating from another product.

What Java version is officially supported by Tivoli Storage Productivity Center
version 4.1 graphical user interface?

Java 5 is the level supported for the Tivoli Storage Productivity Center
GUI. For information about how to start the Tivoli Storage Productivity
Center graphical user interface, see the information center. Search for
Starting and stopping the console.

You are entering namespaces manually for CIM agents and switches in the
Tivoli Storage Productivity Center user interface. What are the current
namespaces for the supported brands?

Table 103. Interop Namespaces for CIM Agents for switches and storage systems

Switch or system Namespace

IBM (other than IBM System Storage TS3310 Tape
Library)

/root/ibm

IBM System Storage TS3310 Tape Library /root/cimv2

Brocade /interop

Cisco /root/cimv2

For version 3.2.1 or later:
/root/pg_interop

Engenio /interop

EMC /root/emc

HDS For HiCommand 5.6 or later, use: /root/smis/current

For a HiCommand version that supports SMI-S 1.2, use
following namespace to traverse the model as SMI-S 1.1:
/root/smis/smis11

For HiCommand versions earlier than HiCommand 5.6, use:
/root/hitachi/dmxx, where xx is represents the level of
HiCommand.

HP /root

LSI /root/PG_InterOp

SUN /root/sun3510 or /interop

Note: This namespace is for a system and not a switch.

XYRATEX /root/PG_interop

Check with your switch vendor to ensure you use the most current
namespaces.

What if you specify an incorrect namespace?
If you specify an incorrect namespace the following issues might occur:
v The connection test fails when the CIMOM is added.
v The discovery does not discover all information of the system managed

by the CIMOM.
v The probe fails.
v The function you want to perform on the system might fail (for example,

collecting performance data).
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What are the required steps when upgrading the Tivoli Storage Productivity
Center to the latest version?

See the Tivoli Storage Productivity Center information center for detailed
information about how to upgrade the product:http://
publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. To access
information about upgrading, expand the Tivoli Storage Productivity
Center > Upgrading node in the information center.

You are using an older version of IBM Tivoli Storage Productivity Center for
Data. How can I upgrade to this latest version?

See the Tivoli Storage Productivity Center information center for detailed
information about how to upgrade the product: http://
publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. To access
information about upgrading, expand the Tivoli Storage Productivity
Center > Upgrading node in the navigation tree.

Data Manager
Use the questions in this section to answer questions about working with the Data
Manager component of IBM Tivoli Storage Productivity Center.

How do you know if your storage system is supported by Data Manager and
which SMI-S agents are supported?

To confirm whether your storage system is supported and which SMI-S
agent is supported for that system, review the supported products list for
the current release of Tivoli Storage Productivity Center. Go to
http://www-01.ibm.com/support/docview.wss?rs=40&context=SWJ50
&q1=matrix&uid=swg21386446&loc=en_US&cs=utf-8&lang=en and click
the applicable Tivoli Storage Productivity Center release in the Storage
column.

Fabric Manager
Use the questions in this section to answer questions about working with the
Fabric Manager component of Tivoli Storage Productivity Center.

Keep in mind the following information and considerations:

What type of fabric agents should you be using in Tivoli Storage Productivity
Center?

The following table shows the current agent types supported for the
Switch Performance Management functionality and the Fabric Zone
Configuration functionality.

Table 104. Supported agent types for Switch and Fabric Functions

Function > Switch Brocade Cisco 1 QLogic

Switch Performance
Monitoring

CIMOM agent CIMOM agent CIMOM agent

Zone Control 2 CIMOM agent Storage Resource agent
required in each VSAN 6

Storage Resource agent 6

Zone Control with Zone
Aliases

CIMOM agent Not supported Not supported
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Table 104. Supported agent types for Switch and Fabric Functions (continued)

Function > Switch Brocade Cisco 1 QLogic

Switch and switch port
information collected

Recommended: CIMOM
agent

Also supported:
Out-of-band Fabric agent
or Storage Resource
agent

Recommended: CIMOM agent

Also supported: Out-of-band
Fabric agent or Storage
Resource agent

Out-of-band Fabric agent or
Storage Resource agent

Topology connectivity
information collected

Recommended: CIMOM
agent

Also supported:
Out-of-band Fabric agent
or Storage Resource
agent

Out-of-band Fabric agent or
Storage Resource agent

Out-of-band Fabric agent or
Storage Resource agent

Zoning information
collected 2

Recommended: CIMOM
agent

Storage Resource agent
required in each VSAN 3 4 5

Storage Resource agent

Tivoli Storage
Productivity Center
Alerts

Recommended: CIMOM
agent

Also supported:
Out-of-band Fabric agent
or Storage Resource
agent

Out-of-band Fabric agent or
Storage Resource agent

Out-of-band Fabric agent or
Storage Resource agent

Hosts, endpoint devices,
device-centric and
host-centric information
collected

Storage Resource agent Storage Resource agent Storage Resource agent

Switch "Sensors and
Events"

Out-of-band Fabric agent Out-of-band Fabric agent Out-of-band Fabric agent

Notes:
1 The Storage Resource agent gets the information about a VSAN basis. Each VSAN is viewed as an individual
SAN. The Out-of-band Fabric agent and CIMOM agent get the physical fabric information and can correlate the
VSAN information to a physical infrastructure. The Out-of-band Fabric agent also collects some VSAN
information.
2 Zone Control refers to the ability to actively configure zoning. "Zone information collected" indicates that the
active zone set and the inactive zoning library information is collected during a fabric probe.
3 For many Cisco proprietary zone members, the values are displayed as zeros.
4 If a zoning configuration has Cisco proprietary zone members, then you will not be able to modify the zoning
for that configuration through Tivoli Storage Productivity Center. You need to use the element manager to
remove proprietary zone members or do zoning.
5 Orphan Cisco zones are not reported.
6 Tivoli Storage Productivity Center does not get a transaction lock on the switch while making zone changes on
the fabric.

What are the prerequisites for using the Switch Performance functionalities in
Tivoli Storage Productivity Center?

The prerequisite steps for using the Switch Performance functionalities are:
1. Add a CIMOM as a data source to the Tivoli Storage Productivity

Center system that manages the switch.
2. Run a CIMOM discovery and wait for it to complete successfully for

that CIMOM.
3. Run a probe against the fabric and wait for it to complete successfully.
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After you complete these steps, create a Switch Performance monitor to
trigger defined switch performance alert conditions or generate switch
performance reports.

Why does an Out of Band Fabric (SNMP) agent show a state of "not contacted"?
Perform the following tasks to help determine why an Out of Band Fabric
(SNMP) agent show a state of "not contacted":
v Check that the IP Address or name is entered correctly in the Out of

Band Fabric agent details panel.
v Ensure the FA MIB is enabled on the switch.
v Ensure that the Tivoli Storage Productivity Center server IP address is

included in any SNMP Access Control List that exists on the switches.
v Ensure you are using SNMP v1.
v Ensure the string on the Tivoli Storage Productivity Center Out of Band

Fabric agent details panel in the SNMP Community field matches one of
the community strings on the switch.

Can you add a storage subsystem as an Out of Band Fabric (SNMP) agent?
No. Out of Band Fabric agents within Tivoli Storage Productivity Center
are meant for switches only. Disk Manager uses CIMOMs to gather
subsystem information.

Why aren't all the properties of a switch populated in the Topology Switch
views?

A combination of Inband and CIMOM agents or a combination of Inband
and Out of Band fabric agents might be required to gather all topology
information for a switch. However, all of the properties are not normally
needed.

How can you specify a different management application to launch for a
switch?

Launch the Element Manager for a switch from the topology viewer. To do
this, access the Switch view, right-click a switch, and select Launch
Element Manager. To change what is launched, right-click a switch and
select the Launch Details Panel. The element manager information is
displayed in the Details tab. To change this information, press Set and
enter the HTTP, Telnet, or application information into the pop-up dialog
and press OK.

How do you manually change a fabric or switch label that is displayed
throughout the system?

Access the topology viewer in the Fabric or Switch view as appropriate.
Right-click the entity you want to label to and select Launch Details Panel.
Within the Details Panel, change the data in the Label field and click the
save icon (or press Ctrl S).

Why do you get the error "Agent capable of configuration zoning could not be
found on this Fabric" for a fabric?

For Brocade switches you must have a CIMOM agent configured for this
fabric. A CIMOM agent is used by default if present. If a CIMOM for the
fabric is present, you must run a CIMOM discovery and probe of the fabric
before you can perform zone control.

For all other supported switches, you must have a Tivoli Storage
Productivity Center Inband Fabric agent in the fabric.
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Disk Manager
Use the questions in this section to answer questions about working with the Disk
Manager component of IBM Tivoli Storage Productivity Center.

Keep in mind the following information and considerations:

You encounter errors while collecting performance data on SAN Volume
Controller. You fail to associate SAN Volume Controller performance data from
non-configuration node with SAN Volume Controller performance data from
configuration node. You encounter incomplete SAN Volume Controller
performance data sample.

This issue is caused by a configuration issue with SAN Volume Controller
(time zone). Reset the time zone on SAN Volume Controller by logging
into the SAN Volume Controller through putty. Run this command first:
svctask settimezone -timezone 509

This forces the cluster into the Universal time zone. To get the time zone
you want the cluster to be in, run this command:
svctask settimezone -timezone

Click on Launch Element Manager. The URL that appears is http://0.0.0.0/ica
This error is caused by the wrong configuration of the SAN Volume
Controller ICAT. Use the SAN Volume Controller GUI to remove and add
the cluster again to the ICAT. This populates the correct value for the
access point which is stored in the database repository during the next
discovery. Use this cli command to set the IP address and port of the user
interface.

For example: svcluster -x modify -p 9.155.62.91:9080

This is the same command used by the user interface and CIMOM.

Arguments and window locations available with the inbound launch in
context feature

This section describes the arguments and window locations available with the
inbound launch in context feature.

Launch in context parameters
You can use the launch in context parameters, definitions, and examples.

The command format for Java Web Start is unique in that a parameter and its
value are separated by an equal sign (=). Parameter=value pairs are separated by
an ampersand (&).

Not all parameters can be used with all launch types. Where this is true, it is noted
in the parameter definition.

Parameters

-user The user ID. The value must be a valid user ID to log on to the IBM Tivoli
Storage Productivity Center server, for example, -user admin.

Note: This parameter is not supported in a Web Browser's URL when
using Java Web Start to launch the Tivoli Storage Productivity Center user
interface.
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-passwd
The password. The value must be a valid password to log on to the Tivoli
Storage Productivity Center server, for example, -passwd MyPassword.

Note: This parameter is not supported in a Web Browser's URL when
using Java Web Start to launch the Tivoli Storage Productivity Center user
interface.

-encpasswd
The password encrypted. This is used if you choose to encrypt the
password instead of entering the text password, for example, -encpasswd
48735.

Tip: To encrypt a password using Tivoli Storage Productivity Center (the
preferred method), enter the following command in the Command Prompt
window:

TPC-HOME/data/server/tools/tpctool encrypt text password

The encrypted password is returned.

Note: This parameter is not supported in a Web Browser's URL when
using Java Web Start to launch the Tivoli Storage Productivity Center user
interface.

-encmethod
The encryption method used to encrypt the password. The password can
be encrypted using Tivoli Storage Productivity Center or Tivoli Enterprise
Portal. The preferred method is to use Tivoli Storage Productivity Center to
encrypt the password. If encpasswd is selected, you must also select
encmethod with a value. The default is TPC. For example, -encpasswd
48735 -encmethod TPC

Note: This parameter is not supported in a Web Browser's URL when
using Java Web Start to launch the Tivoli Storage Productivity Center user
interface.

Tip: The Tivoli Enterprise Portal graphical user interface (GUI) does not
start the Tivoli Storage Productivity Center GUI properly with a Tivoli
Enterprise Portal-encrypted password if that encryption creates a string
with spaces in it. Such a string is handled as multiple values unless it is
enclosed in double quotation marks (").

Tip: Encryption using Tivoli Enterprise Portal creates a string pattern.
There are multiple string patterns that can result in the same decrypted
value, so it is possible that different string patterns used as an encrypted
password might result in same decrypted password.

-function
Specify one of the following values:
v The task to perform on the remote data server. See “Launch in context

task parameters” on page 1434 for tasks and their specific parameters.
For example, -function disk.create_volume -subsystem_id <ID of the
subsystem>.

v The window name to open on the target system. The window name is
mapped to the name of the node on the navigation tree. See “Available
windows” on page 1435 for a list of available windows. For example,
-function topology.computer.
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-server
The Tivoli Storage Productivity Center server to log on to. This argument
specifies a single server. For example, -server tivoli11:9549.

-servers
Not used with the Web Browser. The Tivoli Storage Productivity Center
server or servers to log on to, in the format server:port. You can specify
multiple server ports separated by commas. For example, -servers
"tivoli11:9549,wanda:9549,invader:9549". If you specify multiple server
ports, Tivoli Storage Productivity Center will connect to the first server. If
you later initiate a new connection from the main window (Connection >
New Connection), the server list box will include the available servers in
the Connection dialog.

-help Not used with the Web Browser. The help argument is used alone in the
Arguments text field. It is entered as -help functions. This argument
returns a list of the windows representing nodes in the navigation tree that
can be launched. Typing -help with no arguments will return an error
message.

You can also enter help as a command in the Command Prompt window
as tpc.bat -help functions for Windows, and TPCD.sh -help functions
for AIX. Linux, or UNIX.

Launch in context task parameters
Use the launch in context feature task parameters to perform tasks.

Task parameters associated with actions taken on the Data server also use the
-function parameter. For example:-function
data.filesystem_capacity_by_computer -computer_id "<computer_id>".

Create a volume (disk.create_volume)

-subsystem_id
The ID of the system on which the volume will be created. The
subsystem_id is the name of the system as seen in the IBM Tivoli Storage
Productivity Center graphical user interface (GUI). This parameter is
required.

-name The name of the volume. The name is not valid for IBM TotalStorage
Enterprise Storage Server and is ignored. If more than one volume is to be
created, this value is treated as a prefix.

-size The size of the volume.

-unit The units to be used while creating the volume. Permissible values are KB,
MB, and GB. The default unit is MB.

-number
The number of volumes to be created.

SAN Planner (disk.san_planner)

-computer_id
The ID of the computer for which the plan is to be created. The
computer_id is the name of the computer as seen in the Tivoli Storage
Productivity Center GUI.
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-subsystem_id
The ID of the system for which the plan is to be created. The subsystem_id
is the name of the system as seen in the Tivoli Storage Productivity Center
GUI Disk Manager.

-plan_id
The ID of the previously saved plan. When the computer_id and
subsystem_id are provided, plan_id is ignored. When you open a plan in
the SAN Planner using launch in context, you must enter the exact name
of the plan. The value for -plan_id is case-sensitive and must match the
name of the plan when it was created. For example, if you created a plan
named UserPlan1, you must use -plan_id UserPlan1 in the launch in
context command.

Capacity report (data.filesystem_capacity_by_computer)

-computer_id
The ID of the computer for which the report is to be created. If this value
is not specified, the Tivoli Storage Productivity Center GUI opens the
default report panel for Data Manager > Reporting > Capacity >
FileSystem Capacity > By Computer.

You must enter a value for -computer_id that matches the ID for that
computer that is stored in the Tivoli Storage Productivity Center database
repository. You will receive a warning message if the ID for the computer
you enter in the command line does not match the ID stored in the data
repository. To ensure that this report is displayed properly when using
launch in context, make sure to enter an ID for the computer that matches
the ID that is displayed for it through the Topology Viewer or appropriate
report in the product's user interface.

Wasted space report (TPC.reports_data.wasted_space)

This report has no parameters. The Tivoli Storage Productivity Center GUI opens
the default report panel for Data Manager > Reporting > System Reports > Data
> Wasted Space.

Available windows
You can use windows with the inbound launch in context feature to start IBM
Tivoli Storage Productivity Center. These windows are called with the -function
window name argument.

Available window names for function argument

Table 105. Available windows for inbound launch in context

Tree Node Window Name

Administrative Services->Data Sources->CIMOM Agents datasource.cimom

Administrative Services->Data Sources->Data Agents datasource.data

Administrative Services->Data Sources->Inband fabric
Agents

datasource.inband_fabric

Administrative Services->Data Sources->Out of band
fabric Agents

datasource.out_of_band_fabric

Administrative Services->Data Sources->IBM Tivoli
Storage Productivity Center Servers1

datasource.tpc_servers
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Table 105. Available windows for inbound launch in context (continued)

Tree Node Window Name

Administrative Services->Data Sources->VMWare VI data
source1

datasource.vmware

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->All

alert.all

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Alerts Directed to user

alert.alerts_directed_to_user

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Storage Subsystem

alert.storage_subsystem

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Computer

alert.computer

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Disk

alert.disk

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Filesystem

alert.filesystem

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Directory1

alert.directory

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->User1

alert.user

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->OS User Group1

alert.os_user_group

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Fabric

alert.fabric

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Switch

alert.switch

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Endpoint Device

alert.endpoint_device

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->External

alert.external

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Tape Library

alert.tape_library

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Configuration Analysis1

alert.configuration_analysis

IBM Tivoli Storage Productivity Center->Alerting->Alert
Log->Hypervisor1

alert.hypervisor

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Data->Disk Space Summary1

data_report.disk_capacity

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Data->Storage Access Times1

data_report.storage_access_times

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Data->Most Obsolete Files1

data_report.most_obsolete_files

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Data->Storage Availability

data_report.storage_availibility

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Data->Storage Capacity1

data_report.storage_capacity

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Data->Total Freespace1

data_report.total_freespace
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Table 105. Available windows for inbound launch in context (continued)

Tree Node Window Name

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Data-> User Space Usage1

data_report.user_space_usage

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Disk->Port Performance1

disk_report.port_performance

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Disk->Subsystem
Performance1

disk_report.subsystem_performance

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Disk->Top Volumes Data Rate
Performance1

disk_report.top_volumes_data_rate_performance

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Disk-> Top Volumes I/O Rate
Performance1

disk_report.top_volumes_io_rate_performance

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Fabric-> San Assets (ALL)

fabric_report.san_assets

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Fabric ->Port Connections

fabric_report.port_connections

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Fabric -> Switch Performance1

fabric_report.switch_performance

IBM Tivoli Storage Productivity Center->My
Reports->System Reports->Fabric ->Top Switch Ports
Data Rate Performance1

fabric_report.top_switch_ports_data_rate_performance

IBM Tivoli Storage Productivity Center->Topology-
>Computers

topology.computers

IBM Tivoli Storage Productivity Center->Topology-
>Fabrics

topology.fabrics

IBM Tivoli Storage Productivity Center->Topology-
>Switches

topology.switches

IBM Tivoli Storage Productivity Center->Topology-
>Storage

topology.storage

IBM Tivoli Storage Productivity Center->Topology-
>Storage resource groups

topology.storage_resource_groups

IBM Tivoli Storage Productivity Center->Topology-
>Other

topology.other

IBM Tivoli Storage Productivity Center->Configuration
Utility

config

Disk Manager->Storage Subsystems disk.storage_subsystems

Fabric Manager->Fabrics fabric.fabrics

Tape Manager->Tape Libraries tape.tape_libraries

Windows that correspond to launch in context tasks

Fabric Manager -> SAN Planner1 disk.san_planner

Disk Manager -> Storage Subsystems disk.create_volume

Data Manager-> Reporting -> Capacity -> Filesystem
Capacity -> By Computer1

data.filesystem_capacity_by_computer

IBM Tivoli Storage Productivity Center -> My Reports ->
System Reports -> Data -> Wasted Space1

TPC.reports.data.wasted_space

1This window is not available in IBM Tivoli Storage Productivity Center Basic Edition.
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Alerts
You can set up Tivoli Storage Productivity Center so that it examines the data that
it collects about your storage infrastructure and writes an alert to a log when an
event occurs. You also can specify that an action is initiated, such as sending an
SMNP trap, sending an e-mail, or running a script when the event occurs.

Alerts that are triggered based on the data collected by monitoring jobs (for
example, pings, scans, and probes) must be defined before the monitoring jobs are
run. Alerts that are triggered based on an external source, such as an SNMP trap,
must be defined after the SNMP server is configured properly.

You can define an alert in the following ways:
v As part of a data collection schedule
v As part of an alert definition

When an event occurs and triggers an alert, the alert is written to a log. You can
also select one or more other ways to be notified of the event. These alert
notifications include SNMP traps, IBM Tivoli Enterprise Console events, Tivoli
Storage Productivity Center login notifications, operating-system event logs, or
email.

Note: Alerts are not generated in a Tivoli Storage Productivity Center instance for
actions that you perform from that instance. For example, if you start Tivoli
Storage Productivity Center and use Disk Manager to assign or unassign volumes
for a subsystem, you do not receive alerts for those volume changes in that
instance. However, if you assign and unassign volumes outside of that Tivoli
Storage Productivity Center instance, an alert is generated.

Triggering conditions for alerts

In general, the following types of conditions can trigger alerts:
v A data collection schedule failed to complete.
v A change occurred in the storage infrastructure.
v A performance threshold was violated.

The specific conditions that can trigger events vary, depending on the type of
storage resource that is being monitored. See “Triggering conditions for alerts” on
page 1439 for more information about triggering conditions.

Alert notifications and triggered actions

Notification methods, or triggered actions, define the method by which you are
notified of an alert: SNMP Trap, Tivoli Enterprise Console Event, Login
Notification, Windows Event Log, UNIX Syslog, and email. Alerts are always
written to the error log. Additionally, if a Data agent or Storage Resource agent is
deployed on a monitored computer, you can run a script or start an IBM Tivoli
Storage Manager job in response to the alert. See “Triggered actions for alerts” on
page 1453 for more information about triggered actions.

Prerequisites for successfully using alerts

The following conditions must be met in order to successfully use alerts:
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v Data collection schedules are configured and scheduled to run on a regular
basis.

v If you want to be notified about an alert in some way other than an entry in the
log file, such as using SNMP traps.Tivoli Enterprise Console events, or email,
alert notification instructions must be configured before using the alert. See
“Configuring alert destinations” on page 395).

v If an alert is triggered based on an SNMP trap from the monitored resource, you
must properly configure the SNMP server of the monitor resource to enable
Tivoli Storage Productivity Center to listen to SNMP traps. The default port
number is 162, and the default community is public.

Default alerts

The following types of alerts are set for your system by default:
v New entity found
v Job failed

You can change the triggered actions and enable or disable these alerts, but you
cannot delete them.

Triggering conditions for alerts
You can define alerts so that IBM Tivoli Storage Productivity Center notifies you
when a specified event occurs. Such events are the triggering conditions for the alert.
The specific triggering conditions that you can use to define an alert depend on the
sort of storage resource that you are monitoring.

Some triggering conditions, like thresholds, require you to enter values. If input is
not required for the triggering condition you select, the value fields will be grayed
out. For information about thresholds, see “Performance thresholds” on page 1457.

Triggering conditions for computer alerts
Triggering conditions are events on a computer that generate alerts in Tivoli
Storage Productivity Center. Each condition has a related error message identifier
that is displayed when the condition is detected on a computer.

Remember: The term "computer" is used in the stand-alone GUI to refer to a
server.

Table 106. Triggering conditions and related error messages for computer alerts

Triggering Condition Explanation Related Error Message*

RAM Increased The amount of RAM on a monitored computer is
increased.

ALR0001I

RAM Decreased The amount of RAM on a monitored computer is
decreased.

ALR0001W

Virtual Memory
Increased

The amount of virtual memory on a monitored
computer is increased.

ALR0002I

Virtual Memory
Decreased

The amount of virtual memory on a monitored
computer is decreased.

ALR0002I

New Disk Detected A new disk is discovered on a monitored computer. ALR0003I

Disk Not Found A disk is removed from a monitored computer. ALR0004E

New Disk Defect
Found

A new grown disk defect is detected on a monitored
disk.

ALR0011W
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Table 106. Triggering conditions and related error messages for computer alerts (continued)

Triggering Condition Explanation Related Error Message*

Grown Disk Defects
Exceed n value

The grown disk defect threshold is exceeded. Enter a
value for n.

ALR0012W

Disk Failure Predicted A managed disk predicts that a disk failure is
imminent.

ALR0007E

Cluster Resource Group
Added

A new cluster resource group is added. ALR0055I

Cluster Resource Group
Removed

A cluster resource group is removed. ALR0056I

Cluster Resource Group
Moved

A cluster resource group is moved. ALR0057I

Computer Discovered A new, unmanaged computer is discovered. This alert
condition is not triggered when hypervisor virtual
machines are discovered.

ALR0022I

Computer Status
Change Offline

A monitored computer goes offline. ALR4273E, ALR4044W

Computer Status
Change Online

A monitored computer comes online. ALR4274I, ALR4045I

Computer Property
Change

An HBA or HBA to a computer node is newly
discovered, is missing, or is rediscovered.

ALR4275W

HBA Driver Version
Change

The driver version of host bus adapter changes. ALR4034W

HBA Firmware Version
Change

The firmware version of host bus adapter changes. ALR4035W

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.

Triggering conditions for file system alerts
Triggering conditions are events on a file system that generate alerts in Tivoli
Storage Productivity Center. Each condition has a related error message identifier
that is shown when the condition is detected on a file system.

Table 107. Triggering conditions and related error messages for file system alerts

Triggering Condition Explanation Related Error Message*

New File System
Detected

A file system was detected for the first time. This
alert applies to a file system on a Storwize V7000
Unified or a server managed by a Storage Resource
agent.

ALR0005I, ALR0005W

File System Was Not
Found

A file system is removed or unmounted from a
cluster. This alert applies to a file system on a
Storwize V7000 Unified or a server managed by a
Storage Resource agent.

ALR0006E

File System Was
Reconfigured

The physical space definition of a managed file
system is reconfigured. This alert applies to a file
system on a Storwize V7000 Unified or a server
managed by a Storage Resource agent.

ALR0008I

File System Free Space
Less Than

A file system is low on available storage space. This
value is usually entered as a percent.

ALR0009W
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Table 107. Triggering conditions and related error messages for file system alerts (continued)

Triggering Condition Explanation Related Error Message*

Available UNIX File
System I-Nodes Less
Than

A UNIX file system is low on free inodes. This value
is usually as a percent.

ALR0010W

New File System Was
Detected

A file system was detected for the first time. ALR4427I, ALR0005W

File System Is Low on
Relative Free Space

A file system is low on free space based on a
percentage value threshold. This alert is triggered
when the corresponding SNMP trap is received from
Storwize V7000 Unified.

ALR4433W

File System Is Low on
Absolute Free Space

A file system is low on free space based on an
absolute value threshold. This alert is triggered
when the corresponding SNMP trap is received from
Storwize V7000 Unified.

ALR4433W

File System Mount
State Changed to
Normal

The mount state for a file system reached normal
level. This alert is triggered when the corresponding
SNMP trap is received from Storwize V7000 Unified.

ALR4358I

File System Mount
State Changed to Error

The mount state for a file system reached error level.
This alert is triggered when the corresponding
SNMP trap is received from Storwize V7000 Unified.

ALR4356E

File System Is Low On
Relative Free I-Nodes

A file system is low on free i-nodes based on a
percentage value threshold. This alert is triggered
when the corresponding SNMP trap is received from
Storwize V7000 Unified.

ALR4458W

File System Is Low On
Absolute Free I-Nodes

A file system is low on free i-nodes based on an
absolute value threshold. This alert is triggered
when the corresponding SNMP trap is received from
Storwize V7000 Unified.

ALR4458W

New File Set Was
Detected

A file set was detected for the first time. This alert
applies only to Storwize V7000 Unified.

ALR4447I

File Set Is Missing A file set that was found during a previous probe
was not found in the current probe. This alert
applies only to Storwize V7000 Unified.

ALR4474W

File Set Is Linked A file set was linked to a file system. This alert
applies only to Storwize V7000 Unified.

ALR4448I

File Set Is Unlinked A file set was unlinked from a file system. This alert
applies only to Storwize V7000 Unified.

ALR4455I

File Set Was
Rediscovered

A file set that was missing was found by the current
probe. This alert applies only to Storwize V7000
Unified.

ALR4475I

Quota Was Exceeded A quota was exceeded. This alert applies only to
Storwize V7000 Unified.

ALR4482W

New Quota Was
Detected

A quota was detected for the first time. This alert
applies only to Storwize V7000 Unified.

ALR4496I

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.
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Triggering conditions for directory alerts
Triggering conditions are events in a monitored directory that generate alerts in
Tivoli Storage Productivity Center. Each condition has a related error message
identifier that is shown when the condition is detected in a directory.

Table 108. Triggering conditions and related error messages for directory alerts

Triggering Condition Explanation Related Error Message*

Directory Not Found A directory cannot be found. ALR0014E

Directory Consumes
More Than

A user or directory storage quota is
exceeded. Enter a value, usually in
megabytes.

ALR0015W

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.

Triggering conditions for instance alerts
Triggering conditions are events on a database instance that generate alerts in
Tivoli Storage Productivity Center. Each condition has a related error message
identifier that is displayed when the condition is detected on an instance.

Table 109. Triggering conditions and related error messages for instance alerts

Database
Application Triggering Condition Explanation Related Error Message*

All New Database - Tablespace
Discovered

A new database-tablespace is
discovered.

ALR0028I

Oracle Archive Log Directory Contains
More Than

An archived log directory quota is
exceeded. Enter a value for quota.

ALR0027W

New Tablespace Discovered A new tablespace is discovered. ALR0028I

SQL Server New Database Discovered A new database is discovered. ALR0028I

Sybase Total Device Freespace Less
Than

The total amount of device free space
is less than a specified amount.

ALR0044W

Total Device Freespace Greater
Than

The total amount of device free space
is greater than a specified amount.

ALR0045W

New Device Discovered A new device is discovered. ALR0042I

Device Dropped A device is dropped. ALR0043E

New Database Discovered A new database is discovered. ALR0028I

DB2 New Tablespace Discovered A new database-tablespace is
discovered.

ALR0028I

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.

Triggering conditions for database-tablespace alerts
Triggering conditions are events on a database-tablespace that generate alerts in
Tivoli Storage Productivity Center. Each condition has a related error message
identifier that is displayed when the condition is detected on a
database-tablespace.
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Table 110. Triggering conditions and related error messages for database-tablespace alerts

Database
application Triggering Condition Explanation Related Error Message*

All Database - Tablespace Freespace
Less Than

The free space on a database-tablespace
is less than a specified amount.

ALR0031W

Database - Tablespace Offline A database-tablespace is taken offline. ALR0030E

Database - Tablespace Dropped A database-tablespace is dropped. ALR0029E

Oracle Tablespace Freespace Less Than The free space on a tablespace is less
than a specified amount.

ALR0031W

Freespace Fragmented into More
Than

The free space on a tablespace is
fragmented into more than the
specified number of extents.

ALR0032W

Largest Free Extent Less Than The largest free extent is less than the
specified size.

ALR0033W

Tablespace Offline A tablespace is taken offline ALR0030E

Tablespace Dropped A tablespace is dropped. ALR0029E

SQL Server Database Data Freespace Less
Than

The free space on a database is less
than a specified amount.

ALR0031W

Database Log Freespace Less
Than

The free space on a database log is less
than the specified percent.

ALR0041W

Database Offline A database is taken offline. ALR0030E

Database Dropped A database is dropped. ALR0029E

Sybase Database Data Freespace less
Than

The free space on a database is less
than a specified amount.

ALR0031W

Database Log Freespace Less
Than

The free space on a database log is less
than the specified percent.

ALR0027W

Last Dump Time Less Than The last dump time was the less than
the specified number of days.

ALR1111W

Database Offline A database is taken offline. ALR0030E

Database Dropped A database is dropped ALR0029E

DB2 Tablespace Freespace Less Than The free space on a tablespace is less
than a specified amount.

ALR0031W

Tablespace Offline A tablespace is taken offline. ALR0030E

Tablespace Dropped A tablespace is dropped ALR0029E

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.

Triggering conditions for table alerts
Triggering conditions are events on a database table that generate alerts in Tivoli
Storage Productivity Center. Each condition has a related error message identifier
that is displayed when the condition is detected on a table.
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Table 111. Triggering conditions and related error messages for table alerts

Database
application Triggering Condition Explanation Related Error Message*

All Total Table Size Greater Than The total size of a table is greater
than a specified size.

ALR0036W

Table Dropped A table is dropped. ALR0039E

Oracle Max Extents - Allocated Extents A table segment is near its
maximum allowed extents.

ALR0035W

Segment Has More Than A table segment has taken too
many extents.

ALR0034W

Chained Row Count Greater
Than

A table has too many chained
rows.

ALR0037W

Empty Used Segment Space
Exceeds

An empty used segment space
exceeds the specified size.

ALR0038W

Total Table Size Greater Than The total size of a table is greater
than a specified size.

ALR0036W

Table Dropped A table is dropped. ALR0039E

SQL Server Total Table Size Greater Than The total size of a table is greater
than a specified size.

ALR0036W

Table Dropped A table is dropped. ALR0039E

Sybase Forwarded Row Count Greater
Than

A forwarded row count is greater
than the specified percent.

ALR0037W

Total Table Size Greater Than The total size of a table is greater
than a specified size.

ALR0036W

Table Dropped A table is dropped. ALR0039E

DB2 Overflow Row Count Greater
Than

An overflow row count is greater
than the specified percent.

ALR0037W

Total Table Size Greater Than The total size of a table is greater
than a specified size.

ALR0036W

Table Dropped A table is dropped. ALR0039E

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.

Triggering conditions for storage system alerts
Triggering conditions are events in a storage system that generate alerts in Tivoli
Storage Productivity Center. Each condition has a related error message identifier
that is displayed when the condition is detected on a storage system.

Table 112. Triggering conditions and related error messages for storage-system alerts

Triggering Condition Explanation Related Error Message1

New Storage System
discovered

A new storage system is discovered. ALR1114I

Cache Increased A storage system cache increases. ALR0050W

Cache Decreased A storage system cache decreases. ALR0050W

New Disk Detected2 A new disk is detected. ALR4323I

Disk Not Found2 A previously detected disk is not found. ALR4324W
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Table 112. Triggering conditions and related error messages for storage-system alerts (continued)

Triggering Condition Explanation Related Error Message1

Storage System Not
Found

A previously detected storage system is not found. ALR0048W

Storage System Status
Change Offline

A storage system goes offline. ALR4241E

Storage System Status
Change Online

A storage system comes online. ALR4242W

Storage System Version
Change

A storage system version changes. ALR4243W

Storage System
Property Change

A port on a storage system is newly discovered,
missing, or rediscovered.

ALR4278W

Storage System
Allocated Capacity
Change

The allocated capacity of a storage system changes. ALR4244W

Storage System
Available Capacity
Change

The available capacity of a storage system changes. ALR4245W

Storage System
Backend Capacity
Change

The allocated capacity of a storage system changes. ALR4246W

Backend Storage
System Status Change
Offline

A back-end storage system goes offline. ALR4247W

Backend Storage
System Status Change
Online

A back-end storage system comes online. ALR4248I

Volume Status Change
Offline

A volume goes offline. ALR4249W

Volume Status Change
Online

A volume comes online. ALR4250I

Volume Capacity
Change

The capacity of a volume changes. ALR4251W

Pool Status Change A pool is missing or rediscovered. ALR4252W

Pool Discovered A pool is discovered. ALR4253I

Pool Status Change
Offline

A pool goes offline. ALR4254W

Pool Status Change
Online

A pool comes online. ALR4255I

Pool Capacity Change The capacity of a pool changes. ALR4256W

Pool Available Space
Change

The available space in a pool changes. ALR4257W

Node Status Change
Offline

A node goes offline. ALR4226W

Node Status Change
Online

A node comes online. ALR4227I

Node State Change A IBM System Storage SAN Volume Controller node is
missing or rediscovered.

ALR4224W

Node Discovered A SAN Volume Controller node is discovered. ALR4225I
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Table 112. Triggering conditions and related error messages for storage-system alerts (continued)

Triggering Condition Explanation Related Error Message1

Datapath State Change The state of a data path changes. ALR4353W

Datapath Discovered A data path is discovered. ALR4354I

New Volume
discovered

A new volume is discovered during a probe of a storage
system.

ALR4325W

Volume not found A volume which had existed before is not found during
a probe of a storage system.

ALR4326W

Link Failure Rate
Threshold

The average number of miscellaneous fibre channel link
errors (for example, an unexpected Not Operational
(NOS) received or a link state machine failure detected)
per second that were encountered by a port over a
period of time.

ALR0548E, ALR0549W,
ALR0550W, ALR0551E

Error Frame Rate
Threshold

The threshold for the number of frames per second that
violated Fibre Channel protocol for a port over a period
of time.

ALR0544E, ALR0545W.
ALR0546W, ALR0547E

Overall Port Response
Time Threshold

The threshold for the average number of milliseconds
that it took to service each operation (send and receive),
by a particular port over a particular time interval.

ALR0540E, ALR0541W,
ALR0542W, ALR0543E

Total Port Data Rate
Threshold

The threshold for the average number of megabytes
transferred (send and receive) for a particular port over
a particular time interval

ALR0536E, ALR0537W,
ALR0538W, ALR0539E

Total Port IO Rate
Threshold

The threshold for the average number of send and
receive operations processed per second, for a particular
port over a particular time interval

ALR0532E, ALR0533W,
ALR0534W, ALR0535E

CPU Utilization
Threshold

The threshold is based on the average utilization
percentage of the CPUs in the SAN Volume Controller
nodes. This value for each node is checked against the
threshold boundaries for each collection interval.

ALR0556E, ALR0557W,
ALR0558W, ALR0559E

Cache Holding Time
Threshold

The threshold is reached for the average cache holding
time, in seconds, for I/O data in a particular component
over a particular time interval. Shorter time periods
indicate adverse performance

ALR0528E, ALR0529W,
ALR0530W, ALR0531E

Write-cache Delay
Percentage Threshold

The threshold is based on the percentage of I/O
operations that were delayed due to write-cache space
constraints. This value for each node is checked against
the threshold boundaries for each collection interval

ALR0524E, ALR0525W,
ALR0526W, ALR0527E

Total Data Rate
Threshold

For the storage system controllers or I/O groups, the
threshold for the average number of MB per second for
read and write operations is reached

ALR0520E, ALR0521W,
ALR0522W, ALR0523E

Total I/O Rate
Threshold

For the storage system controllers or I/O groups, the
threshold for the average number of I/O operations per
second is reached

ALR0516E, ALR0517W,
ALR0518W, ALR0519E

Overall Backend
Response Time
Threshold

The threshold for the average number of milliseconds
that it takes to respond to MDisk I/O operations is
reached

ALR0512E, ALR0513W,
ALR0514W, ALR0515E

Total Backend Data
Rate Threshold

For MDisk groups, the threshold for the average
number of megabytes per second that are transferred for
MDisk read and write operations is reached

ALR0508E, ALR0509W,
ALR0510W, ALR0511E

Zero Buffer-Buffer
Credit Timer

The number of microseconds for which the port has
been unable to send frames due to lack of buffer credit
since the last node reset.

ALR0624E, ALR0625W,
ALR0626W, ALR0627E
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Table 112. Triggering conditions and related error messages for storage-system alerts (continued)

Triggering Condition Explanation Related Error Message1

Total Backend I/O Rate
Threshold

For MDisk groups, the threshold for the average
number of MDisk read and write operations per second
is reached.

ALR0504E , ALR0505W,
ALR0506W, ALR0507E

Invalid Transmission
Word Rate Threshold

The threshold for the average number of times per
second that “bit” errors are detected on a port over a
period of time.

ALR0620E, ALR0621W,
ALR0622W, ALR0623E

CRC Error Rate
Threshold

The threshold for the average number of frames
received per second where the CRC in the frame did not
match the CRC computed by the receiver for a
component over a period of time.

ALR0616E, ALR0617W,
ALR0618W, ALR0619E

Disk Utilization
Percentage Threshold

The threshold is reached for the approximate utilization
percentage of a particular array over a particular time
interval. For example, the average percentage of time
that the disk associated with the array was busy

ALR0500E, ALR0501W,
ALR0502W, ALR0503E

Port Receive Bandwidth
Percentage Threshold3

The threshold for the average port bandwidth utilization
percentage for receive operations.

ALR0612E, ALR0613W,
ALR0614W, ALR0615E

Port Send Bandwidth
Percentage Threshold3

The threshold for the average port bandwidth utilization
percentage for send operations.

ALR0608E, ALR0609W,
ALR0610W, ALR0611E

Port Receive Utilization
Percentage Threshold

The threshold for the average amount of time that ports
are busy receiving data.

ALR0604E, ALR0605W,
ALR0606W, ALR0607E

Port Send Utilization
Percentage Threshold

The threshold for the average port bandwidth utilization
percentage for send operations.

ALR0600E, ALR0601W,
ALR0602W, ALR0603E

Peak Back-end Write
Response Time
Threshold

The threshold for the peak (worst) response time among
all MDisk write operations by a node.

ALR0596E, ALR0597W,
ALR0598W, ALR0599E

Non-preferred Node
Usage Percentage
Threshold

The threshold for the non-preferred node usage
percentage of an I/O group.

ALR0592E, ALR0593W,
ALR0594W, ALR0595E

Port to Local Node
Receive Queue Time
Threshold

The threshold for the average number of milliseconds
that each receive operation issued to another node in the
local SVC cluster spent on the queue before being
issued.

ALR0588E, ALR0589W,
ALR0590W, ALR0591E

Port to Local Node
Send Queue Time
Threshold

The threshold for the average number of milliseconds
that each send operation issued to another node in the
local SVC cluster spent on the queue before being
issued.

ALR0584E, ALR0585W,
ALR0586W, ALR0587E

Port to Local Node
Receive Response Time
Threshold

The threshold for the average number of milliseconds it
took to service each receive operation from another
node in the local SVC cluster.

ALR0580E, ALR0581W,
ALR0582W, ALR0583E

Port to Local Node
Send Response Time
Threshold

The threshold for the average number of milliseconds it
took to service each send operation from another node
in the local SVC cluster.

ALR0576E, ALR0577W,
ALR0578W, ALR0579E

Back-end Write Queue
Time Threshold

The threshold for the average number of milliseconds
that each write operation spent on the queue before
being issued to the back-end device.

ALR0572E, ALR0573W,
ALR0574W, ALR0575E

Back-end Read Queue
Time Threshold

The threshold for the average number of milliseconds
that each read operation spent on the queue before
being issued to the back-end device.

ALR0568E, ALR0569W,
ALR0570W, ALR0571E
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Table 112. Triggering conditions and related error messages for storage-system alerts (continued)

Triggering Condition Explanation Related Error Message1

Back-end Write
Response Time
Threshold

The threshold for the average number of milliseconds
that it took to service each array and MDisk write
operation.

ALR0564E, ALR0565W,
ALR0566W, ALR0567E

Back-end Read
Response Time
Threshold

The threshold for the average number of milliseconds
that it took to service each array and MDisk read
operation.

ALR0560E, ALR0561W,
ALR0562W, ALR0563E

Notes:

1. Use the error message identifiers in this column to locate any additional information about the error messages
related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center Information
Center or the IBM Tivoli Storage Productivity Center Messages Guide.

2. This condition does not trigger alerts for the following storage systems:

v SAN Volume Controller

v Storwize V7000

v Storwize V7000 Unified

3. This condition does not trigger alerts for the DS6000.

Related tasks:
“Creating a performance threshold within an alert” on page 148
You can monitor the performance of your enterprise by creating alerts with
performance thresholds for storage subsystems and SAN switches. By defining
alerts that are triggered by performance thresholds, you can get timely information
about performance issues in your enterprise.
Related reference:
“Performance thresholds” on page 1457
Performance thresholds are triggering conditions which are used to monitor a
component with user-defined values.

Triggering conditions for fabric alerts
Triggering conditions are events in a fabric that generate alerts in Tivoli Storage
Productivity Center. Each condition has a related error message identifier that is
displayed when the condition is detected in a fabric.

Table 113. Triggering conditions and related error messages for fabric alerts

Triggering Condition Explanation Related Error Message*

Fabric Discovered A fabric is discovered. ALR4046I

Fabric State Change A fabric is missing or rediscovered. ALR4047W, ALR4048I

Fabric to Switch
Change

A switch to fabric association is discovered,
rediscovered, or missing.

ALR4066I, ALR4067W, ALR4068I

Zone State Change A zone is missing or rediscovered. ALR4052W, ALR4053I,
ALR4090W, ALR4094I

Zone Discovered A zone is discovered. ALR4051I, ALR4091I

Zone Set State Change A zone set in a fabric was activated, deactivated, or
has gone missing.

ALR4055W, ALR4089W,
ALR4093E, ALR4056I, ALR4095I

Zone Set Discovered A zone set is discovered. ALR4054I, ALR4092I

Zone to Zone Alias
Change

A zone to zone alias association is discovered, missing,
or rediscovered.

ALR4079W, ALR4080I,
ALR4110W, ALR4111I, ALR4078I,
ALR4109I
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Table 113. Triggering conditions and related error messages for fabric alerts (continued)

Triggering Condition Explanation Related Error Message*

Zone to Zone Member
Change

A zone to zone member association is discovered,
missing, or rediscovered.

ALR4081I, ALR4096I, ALR4082I,
ALR4083I, ALR4097I, ALR4098I

Zone Set to Zone
Change

A zone set to zone association is discovered, missing,
or rediscovered.

ALR4084I, ALR4099I, ALR4085I,
ALR4086I, ALR4107I, ALR4108I

New Connection A new connection is detected. ALR4063I

Connection State
Change

A connection is missing or rediscovered. ALR4064W, ALR4065I

Zone Alias to Member
Change

A zone alias to member association is discovered,
rediscovered, or missing.

ALR4329I, ALR4330I, ALR4331I

Endpoint Discovered An endpoint is discovered. ALR4000I

Endpoint State Change An endpoint is missing or rediscovered. ALR4001W, ALR4002I

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.

Triggering conditions for switch alerts
Triggering conditions are events on a switch that generate alerts in Tivoli Storage
Productivity Center. Each condition has a related error message identifier that is
displayed when the condition is detected on a switch.

Important: The following triggering conditions are performance thresholds. A
performance monitor must collect data about a switch before Tivoli Storage
Productivity Center can determine if a performance threshold has generated an
alert.
v Total Port Data Rate Threshold
v Port Receive Bandwidth Percentage Threshold
v Port Send Bandwidth Percentage Threshold
v Link Failure Rate Threshold
v Error Frame Rate Threshold
v Total Port Packet Rate Threshold

Table 114. Triggering conditions and related error messages for switch alerts

Triggering Condition Explanation Related Error Message*

Switch Discovered A switch is discovered. ALR4020I

Switch State Change A switch is missing or is rediscovered. ALR4021E, ALR4022I

Switch Property
Changes

A port on the switch has changed to online or offline, is
discovered, is missing, or is rediscovered.

ALR4015I, ALR4016W,
ALR4017I, ALR4018W,
ALR4019I,

Switch Status
Degraded

The status of the switch has changed from OK to a
reduced level. This condition does not necessarily mean
that the switch is missing.

ALR4024W

Switch Status
Improved

The status of the switch has been upgraded to OK. ALR4025I

Switch Version Change The version of a switch changes. ALR4023W

Switch to Port Change A switch to switch port association is discovered, is
missing, or is rediscovered.

ALR4069I, ALR4070W,
ALR4071I
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Table 114. Triggering conditions and related error messages for switch alerts (continued)

Triggering Condition Explanation Related Error Message*

Switch Blade Change A switch module is discovered, is missing, or is
rediscovered.

ALR4026I, ALR4027W,
ALR4028I

Switch Blade Change
Offline

A switch module goes offline. ALR4029E

Switch Blade Change
Online

A switch module comes online. ALR4030I

Total Port Data Rate
Threshold

A total port data rate threshold is reached. ALR0536E, ALR0537W,
ALR0538W, ALR0539E

Port Receive
Bandwidth Percentage
Threshold

The threshold on the average port bandwidth utilization
percentage for receive operations. The Port Send
Utilization Percentage metric is checked against the
threshold boundaries for each collection interval. This
threshold uses the following default values: 85,75,-1,-1.

ALR0612E, ALR0613W,
ALR0614W, ALR0615E

Port Send Bandwidth
Percentage Threshold

The threshold on the average port bandwidth utilization
percentage for send operations. The Port Send Utilization
Percentage metric is checked against the threshold
boundaries for each collection interval. This threshold
uses the following default values: 85,75,-1,-1.

ALR0608E, ALR0609W,
ALR0610W, ALR0611E

Link Failure Rate
Threshold

A link failure rate threshold is reached. ALR0548E, ALR0549W,
ALR0550W, ALR0551E

Error Frame Rate
Threshold

An error frame rate threshold is reached. ALR0544E, ALR0545W,
ALR0546W, ALR0547E

Total Port Packet Rate
Threshold

A total port packet rate threshold is reached. ALR0552E, ALR0553W,
ALR0554W, ALR0555E

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.

Triggering conditions for endpoint device alerts
Use this topic to view the events that can trigger endpoint device alerts and their
related error message identifiers.

Table 115. Triggering conditions and related error messages for endpoint device alerts

Triggering Condition Explanation Related Error Message*

Endpoint Discovered An endpoint device is discovered. ALR4239W

Endpoint State Change An endpoint device is missing or is rediscovered. ALR4231W

Endpoint Version
Change

The version for an endpoint device changes. ALR4313W

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.

Triggering conditions for hypervisor alerts
Triggering conditions are events on a hypervisor that generate alerts in Tivoli
Storage Productivity Center. Each condition has a related error message identifier
that is displayed when the condition is detected on a hypervisor.
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Table 116. Triggering conditions and related error messages for hypervisor alerts

Triggering Condition Explanation Related Error Message*

Hypervisor Discovered A hypervisor is discovered. ALR4315I

Hypervisor Missing A hypervisor that was previously discovered is missing. ALR4321W

Virtual Machine Added A new virtual machine was added. ALR4316I

Virtual Machine
Removed

A virtual machine was removed. ALR4317W

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.

Triggering conditions for Other NAS alerts
Triggering conditions are events on network-attached storage (NAS) that generate
alerts in Tivoli Storage Productivity Center. Each condition has a related error
message identifier that is displayed when the condition is detected on a NAS
device.

Table 117. Triggering conditions and related error messages for NAS alerts

Triggering Condition Explanation Related Error Message*

Node Status Changed
to Normal

The clustered Common Internet File System (CIFS) for
a NAS device is active. This alert is triggered when
the corresponding SNMP trap is received from
Storwize V7000 File Module.

ALR4365I

Node Status Changed
to Warning

The clustered CIFS for a NAS device is disabled. This
alert is triggered when the corresponding SNMP trap
is received from Storwize V7000 File Module.

ALR4366W

Node Status Changed
to Error

The status of a clustered CIFS for a NAS device
reached the error level. This alert is triggered when
the corresponding SNMP trap is received from
Storwize V7000 File Module.

ALR4367E

GPFS Status Reached
Normal Level

The General Parallel File System (GPFS) for a NAS
device is active. This alert is triggered when the
corresponding SNMP trap is received from Storwize
V7000 File Module.

ALR4368I

GPFS Status Reached
Warning Level

The GPFS state for a NAS device reached the warning
level. This alert is triggered when the corresponding
SNMP trap is received from Storwize V7000 File
Module.

ALR4369W

GPFS Status Reached
Error Level

The GPFS for a NAS device is down. This alert is
triggered when the corresponding SNMP trap is
received from Storwize V7000 File Module.

ALR4370E

Node State Changed The state of a node changed. ALR1245W

Node Was Discovered A node was discovered. ALR1246W

Node Status Changed
to Online

A node status changed to online. ALR4227W

Node Status Changed
to Offline

A node status changed to offline. ALR4226W

Processor Usage
Reached Normal Level

Processor use for a network-attached storage (NAS)
device reached the normal level. This alert is
triggered when the corresponding SNMP trap is
received from Storwize V7000 File Module.

ALR4361I
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Table 117. Triggering conditions and related error messages for NAS alerts (continued)

Triggering Condition Explanation Related Error Message*

Processor Usage
Reached Warning Level

Processor use for a NAS device reached the warning
level. This alert is triggered when the corresponding
SNMP trap is received from Storwize V7000 File
Module.

ALR4360W

Processor Usage
Reached Error Level

Processor use for a NAS device reached the error
level. This alert is triggered when the corresponding
SNMP trap is received from Storwize V7000 File
Module.

ALR4359E

Memory Usage
Reached Normal Level

Memory use for a NAS device reached the normal
level. This alert is triggered when the corresponding
SNMP trap is received from Storwize V7000 File
Module.

ALR4364I

Memory Usage
Reached Error Level

Memory use for a NAS device reached the error level.
This alert is triggered when the corresponding SNMP
trap is received from Storwize V7000 File Module.

ALR4362E

Cluster Was Discovered A cluster was discovered. ALR4528I

Cluster Was Removed A cluster that was found during a probe was not
found in the current probe.

ALR4529I

Cluster Was
Rediscovered

A cluster that was missing was found by the current
probe.

ALR4530I

New Export Was
Detected

An export was detected for the first time. ALR4460I

Export Is Missing An export that was found during a previous probe
was not found in the current probe.

ALR4470W

Export Was
Rediscovered

An export that was missing was found by the current
probe.

ALR4471I

Export State Changed The state of an export changed. ALR4461W

Export Path Changed An export was linked to a new path. ALR4462W

Export Protocol
Changed

The protocols that were configured for an export
changed.

ALR4463W

New NSD Detected A Network Shared Disk (NSD) was detected for the
first time.

ALR4503I

NSD Is Missing An NSD that was found during a previous probe was
not found in the current probe.

ALR4505W

NSD State Changed The state of an NSD changed. ALR4507W

NSD Status Reached
Normal Level

NSD use for a NAS device reached the normal level. ALR4387I

NSD Status Reached
Warning Level

NSD use for a NAS device reached the warning level. ALR4386W

NSD Status Reached
Error Level

NSD use for a NAS device reached the error level. ALR4385E

Note: * Use the error message identifiers in this column to locate any additional information about the error
messages related to triggering conditions in the Messages section of the IBM Tivoli Storage Productivity Center
Information Center or the IBM Tivoli Storage Productivity Center Messages Guide.
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Alert suppression actions
If you selected a threshold as a triggering condition for alerts, you can specify the
conditions under which alerts are triggered and choose whether you want to
suppress repeating alerts. Alerts can be suppressed to avoid generating too many
alert log entries or too many actions when the triggering condition occurs often.
You can view suppressed alerts in the constraint violation reports.

You can define the following options that enable you to specify conditions that
trigger and suppress alerts. If a threshold is not selected as a triggering condition,
these options are not available.

Trigger alerts for both critical and warning conditions
Generates an alert upon the violation of either critical or warning threshold
boundaries. This is the default.

Trigger alerts for critical conditions only
Generates alerts only upon violation of one of the critical threshold
boundaries. Violation of a warning boundary creates an entry in the
constraint violation report, but does not result in an entry in the alert log
or an action being triggered.

Trigger no alerts
Does not generate an alert upon violation of any threshold boundaries.
Creates entries only in the constraint violation report.

Do not suppress repeating alerts
Does not suppress any repeating alerts. This is the default.

Suppress alerts unless the Triggering Condition has been violated continuously
for a specified length of time

Generates alerts only if the triggering condition has occurred continuously
within the length of time specified in the Length of time field. Alerts for
the first and any subsequent occurrences of the triggering condition within
the specified time in minutes will be suppressed. At the point that there
have been consecutive occurrences with the specified number of minutes,
an alert is generated. When the specified suppression period has expired,
the cycle starts again. Note that the timing for this feature is based on the
IBM Tivoli Storage Productivity Center server clock rather than the various
system clocks.

This option is useful for cases when a single occurrence of the triggering
condition may be insignificant, but repeated occurrences can signal a
potential problem.

Suppress alerts if a repeat violation has occurred within a specified length of
time after the initial violation of the Triggering Condition

Generates alerts only for the first occurrence of the triggering condition.
Alerts for repeated occurrences of the triggering condition within the
length of time specified in the Length of time field are suppressed. When
the specified suppression period has expired, the cycle starts again. Note
that the timing for this feature is based on the IBM Tivoli Storage
Productivity Center server clock rather than the various system clocks.

This option is useful for avoiding e-mail messages or similar disruptive
alerts if the same triggering condition occurs repeatedly in successive
sample passes. This option generally useful for all threshold types.

Triggered actions for alerts
You define triggered actions to occur as a result of the alert.
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An alert is always entered in the error log file each time it occurs. In addition, you
can define the following notifications or triggered actions:

SNMP Trap
Generates an SNMP trap message to any network-management system,
console, or terminal. You must set up the SNMP trap ringer with the
fabric.mib and tivoliSRM.mib files.

TEC / OMNIbus Event
Sends an alert to the IBM Tivoli Enterprise Console or OMNIbus EIF probe
server in your environment. The Tivoli Enterprise Console administrator
can write correlation and automation rules to analyze theIBM Tivoli
Storage Productivity Center events. Tivoli Enterprise Console also performs
responses such as sending further notifications, creating or updating
trouble tickets, and running programs. You must load the tivoliSRM.baroc
and fabric.baroc files into the active rulebase of the Tivoli Enterprise
Console server.

Login Notification
Tivoli Storage Productivity Center lists the alerts for the specified users
when they log in. Use the Preferences > Edit General option on the Tivoli
Storage Productivity Center menu bar to control which alerts a user views
upon logging in to the product.

Windows Event Log, UNIX Syslog
Writes the alerts to the operating-system log. You can select from the
following levels of operating-system events:
v UNIX: Informational, Notice, Warning, Error, Critical, or Alert
v Microsoft Windows: Error, Warning, and Information.

For UNIX, you also can select User or Local.

Run Script
Runs a script in response to the alert. Use this option to run third-party
tools for such actions as recovery and provisioning.
1. Click Define to specify the script that is run when the triggering

condition occurs. The Specify Script window opens.
2. Type the name of the script in the Script Name field.
3. Select where to run the script.

If parameters are given for the triggering condition, they are listed in the
Specify Script window. These parameters are used when the alert is
triggered.

Note: Scripts can only be run against systems on which a Storage Resource
agent or Data agent is deployed.

Archive/Backup
(Constraints only) Runs an IBM System Storage Productivity Center
backup or archive job in response to an alert associated with a constraint.
Click the Define button.

Email Sends an email. Use this section to view, add, and delete email addresses
and edit the text of the message in the email.

For Directory Alerts, if the Directory Consumes More Than triggering
condition is selected, additional fields are available to send email to the
quota violator. The email address can be based on Directory Owner or
Directory Name.
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Alert display colors
Status symbols for alerts are shown in the colors listed for the alert action.

When you have active alerts shown within the subnodes under the IBM Tivoli
Storage Productivity Center-> Alering -> Alert Log node, the indicator next to
those subnodes will appear as green or red depending on their corresponding
alerts. The following table shows the colors that are generated for the subnodes by
their different alerts:

Table 118. Alert colors

Alert Color

Probe failed Red

RAM increase Green

RAM decrease Red

Memory increase Green

Memory decrease Red

New disk Green

Missing disk Red

Disk defect Red

Disk failure predicted Red

New filesystem Green

Filesystem reconfigured Red

Scan failed Red

Missing filesystem Red

Filesystem freespace Red

Filesystem free Inodes Red

Computer unreachable Red

New directory Red

Missing directory Red

Directory quota violation Red

Filesystem quota violation Red

Computer quota violation Red

Network quota violation Red

Constraint violation Red

Failed job Red

Disk defect quota Red

Ping failed Red

Discovery failed Red

Aggregator failed Red

Filesystem quota failed Red

Computer quota failed Red

Network quota failed Red

Computer discovered Red

Report failed Red
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Table 118. Alert colors (continued)

Alert Color

DB probe failed Red

DB tablespace quota violation Red

DB instance quota violation Red

DB net quota violation Red

DB tablespace quota failed Red

DB instance quota failed Red

DB net quota failed Red

Scan failed Red

Archive log overflow Red

New tablespace Red

Tablespace free space Red

Tablespace offline Red

Tablespace fragmented Red

Tablespace extent size Red

Dropped tablespace Red

Table fragmented Red

Table maximum extents Red

Table size Red

Table chained rows Red

Table wasted space Red

Dropped table Red

NAS discovery failed Red

NAS computer discovered Green

Script failed Red

NetApp quota job failed Red

Device freespace less Red

Device freespace greater Red

Dropped device Red

New device Red

DB log freespace Red

DB dump time Red

Disk array discovered Green

Disk array missing Red

Filer missing Red

Cache increase Green

Cache decrease Red

Automatic filesystem extension Red

Stopped automatic filesystem
extension

Red

Extend job failed Red
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Table 118. Alert colors (continued)

Alert Color

Upgrade failed Red

Added cluster resource group Green

Removed cluster resource group Green

Moved cluster resource group Green

DB report failed Red

File backup failed Red

Hypervisor discovered Green

Hypervisor missing Red

Virtual machine discovered Green

Virtual machine missing Red

Performance data
Use the IBM Tivoli Storage Productivity Center to view the performance data of
devices in your environment.

General performance guidelines
This topic provides some general performance considerations for configuring the
IBM Tivoli Storage Productivity Center environment.
v Do not overpopulate the SLP discovery panel with SLP agent hosts. Remember

that Tivoli Storage Productivity Center includes a built-in SLP User Agent (UA)
that receives information about SLP Service Agents and Directory Agents (DA)
that reside in the same subnet as the Tivoli Storage Productivity Center server.

v Ensure that you have not more than one DA per subnet.
v Misconfiguring the Tivoli Storage Productivity Center Common Information

Model Object Manager (CIMOM) discovery preferences might affect
performance on auto discovery or on device presence checking. It might also
result in application timeouts, as attempts are made to resolve and communicate
with hosts that are unavailable. CIMOMs are not required to communicate with
storage systems that use native interfaces. Tivoli Storage Productivity Center
uses native interfaces to communicate with IBM System Storage DS8000 Storage
Manager, IBM XIV Storage System, and IBM System Storage SAN Volume
Controller.

v It should be considered mandatory to run the CIM Agent software on a separate
host from the Tivoli Storage Productivity Center server. Attempting to run a full
Tivoli Storage Productivity Center implementation on the same host as the CIM
agent, can result in dramatically increased wait times for data retrieval. You
might also experience resource contention and port conflicts.

Performance thresholds
Performance thresholds are triggering conditions which are used to monitor a
component with user-defined values.

You can monitor the performance of your enterprise by creating alerts on
performance thresholds for switches and storage subsystems. By creating alerts
that are triggered by performance thresholds, you can be informed about
performance issues in your enterprise. Threshold events tell you when a
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component has fallen outside of the user-defined values. For example, when a
threshold value has reached critical stress.

Threshold boundaries

You can establish your boundaries for the normal expected subsystem performance
when defining storage subsystem alerts for performance threshold events. When
the collected performance data samples fall outside the range you have set, you are
notified of this threshold violation so you are aware of the potential problem. The
upper-threshold boundaries are Critical Stress and Warning Stress. The
lower-threshold boundaries are Warning Idle and Critical Idle. Usually you will
want the stress boundaries to be high numbers and the idle to be low numbers.
The exception to this rule is Cache Holding Time Threshold, where you want the
stress numbers to be low and the idle numbers to be high.

If you do not want to be notified of threshold violations for any boundaries, you
can leave the boundary field blank and the performance data will not be checked
against any value. For example, if you leave the Critical Idle and Warning Idle
fields blank, no alerts will be sent for any idle conditions.

The Ignore triggering condition when the sequential I/O percentage exceeds
check box is active only for the triggering condition Disk Utilization Percentage
Threshold. It is a filter condition. The default is 80%.

The Ignore triggering condition when the Back-end Read I/O Rate is less than
check box only applies to the Back-end Read Response Time and Back-end Read
Queue Time thresholds.

The Ignore triggering condition when the Back-end Write I/O Rate is less than
check box only applies to the Back-end Write Response Time and Back-end Write
Queue Time thresholds.

The Ignore triggering condition when the Total Back-end I/O Rate is less than
check box only applies to the Overall Back-end Response Time threshold.

The Ignore triggering condition when the Total I/O Rate is less than check box
only applies to the Non-preferred Node Usage Percentage threshold.

The Ignore triggering condition when the Write-cache Delay I/O Rate is less than
check box only applies to the Write-cache Delay Percentage threshold.

Setting the thresholds

Only a few thresholds have defaults and on the other thresholds you will have to
determine the best values for stress, idle, critical, and warning values so you can
derive the maximum benefit without generating too many false alerts. Since
suitable stress thresholds are highly dependant on the type of workload you are
running, your exact hardware configuration, the number of physical disks, exact
model numbers, and so forth, there are no easy or standard default rules.

One of the best approaches is to monitor your performance for a number of weeks
and, using this historical data, determine reasonable values for each threshold
setting. Once that is done you can fine tune these settings to minimize the number
of false alerts.
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Related tasks:
“Archive and delete files” on page 142
This scenario shows you how to reclaim storage space by archiving and deleting
files that meet criteria you define.
Related reference:
“Controller thresholds” on page 1463
The following table lists and describes the Controller thresholds.
“Port thresholds” on page 1464
Port thresholds are used to set limits for such things as bandwidth utilization, data
rates, and I/O operations.
“Array thresholds”
The following table lists and describes the Array thresholds.

Array thresholds
The following table lists and describes the Array thresholds.

Table 119. Array thresholds

Threshold (Metric) Device/Component Type Description

Array Thresholds

Disk Utilization
Percentage

TotalStorage Enterprise
Storage Server, DS6000,
DS8000 array

Sets thresholds on the approximate
utilization percentage of the arrays in a
particular subsystem; for example, the
average percentage of time that the disks
associated with the array were busy. The
Disk Utilization metric for each array is
checked against the threshold boundaries
for each collection interval. This
threshold is enabled by default for
TotalStorage Enterprise Storage Server
systems and disabled by default for
others. The default threshold boundaries
are 80%, 50%, -1, -1. For DS6000 and
DS8000 subsystems, this threshold
applies only to those ranks which are the
only ranks in their associated extent pool.

Total Back-end I/O
Rate

SAN Volume Controller
MDisk group and MDisk,
TotalStorage Enterprise
Storage Server, DS6000,
DS8000 array

Sets thresholds on the average number of
I/O operations per second for array and
MDisk read and write operations. The
Total I/O Rate metric for each array or
MDisk is checked against the threshold
boundaries for each collection interval.
This threshold is disabled by default.

Total Back-end
Data Rate

SAN Volume Controller
MDisk group and MDisk,
TotalStorage Enterprise
Storage Server, DS6000,
DS8000 array

Sets thresholds on the average number of
MB per second that were transferred for
array and MDisk read and write
operations. The Total Data Rate metric
for each array or MDisk is checked
against the threshold boundaries for each
collection interval. This threshold is
disabled by default.
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Table 119. Array thresholds (continued)

Threshold (Metric) Device/Component Type Description

Back-end Read
Response Time

SAN Volume Controller
MDisk, TotalStorage
Enterprise Storage Server,
DS6000, DS8000 array

Sets thresholds on the average number of
milliseconds that it took to service each
array and MDisk read operation. The
Back-end Read Response Time metric for
each array or MDisk is checked against
the threshold boundaries for each
collection interval. Though this threshold
is disabled by default, suggested
boundary values of 35,25,-1,-1 are
pre-populated. A filter is available for
this threshold which will ignore any
boundary violations if the Back-end Read
I/O Rate is less than a specified filter
value. The pre-populated filter value is 5.

Back-end Write
Response Time

SAN Volume Controller
MDisk, TotalStorage
Enterprise Storage Server,
DS6000, DS8000 array

Sets thresholds on the average number of
milliseconds that it took to service each
array and MDisk write operation. The
Back-end Write Response Time metric for
each array or MDisk is checked against
the threshold boundaries for each
collection interval. Though this threshold
is disabled by default, suggested
boundary values of 120,80,-1,-1 are
pre-populated. A filter is available for
this threshold which will ignore any
boundary violations if the Back-end Write
I/O Rate is less than a specified filter
value. The pre-populated filter value is 5.

Overall Back-end
Response Time

SAN Volume Controller
MDisk

Sets thresholds on the average number of
milliseconds that it took to service each
MDisk I/O operation, measured at the
MDisk level. The Total Response Time
(external) metric for each MDisk is
checked against the threshold boundaries
for each collection interval. This
threshold is disabled by default. A filter
is available for this threshold which will
ignore any boundary violations if the
Total Back-end I/O Rate is less than a
specified filter value. The pre-populated
filter value is 10.
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Table 119. Array thresholds (continued)

Threshold (Metric) Device/Component Type Description

Back-end Read
Queue Time

SAN Volume Controller
MDisk

Sets thresholds on the average number of
milliseconds that each read operation
spent on the queue before being issued to
the back-end device. The Back-end Read
Queue Time metric for each MDisk is
checked against the threshold boundaries
for each collection interval. Though this
threshold is disabled by default,
suggested boundary values of 5,3,-1,-1
are pre-populated. A filter is available for
this threshold which will ignore any
boundary violations if the Back-end Read
I/O Rate is less than a specified filter
value. The pre-populated filter value is 5.
Violation of these threshold boundaries
means that the SVC deems the MDisk to
be overloaded. There is a queue
algorithm that determines the number of
concurrent I/O operations that the SVC
will send to a given MDisk. If there is
any queuing (other than during a backup
process) then this suggests performance
can be improved by resolving the
queuing issue.

Back-end Write
Queue Time

SAN Volume Controller
MDisk

Sets thresholds on the average number of
milliseconds that each write operation
spent on the queue before being issued to
the back-end device. The Back-end Write
Queue Time metric for each MDisk is
checked against the threshold boundaries
for each collection interval. Though this
threshold is disabled by default,
suggested boundary values of 5,3,-1,-1
are pre-populated. A filter is available for
this threshold which will ignore any
boundary violations if the Back-end Read
I/O Rate is less than a specified filter
value. The pre-populated filter value is 5.
Violation of these threshold boundaries
means that the SVC deems the MDisk to
be overloaded. There is a queue
algorithm that determines the number of
concurrent I/O operations that the SVC
will send to a given MDisk. If there is
any queuing (other than during a backup
process) then this suggests performance
can be improved by resolving the
queuing issue.
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Table 119. Array thresholds (continued)

Threshold (Metric) Device/Component Type Description

Peak Back-end
Write Response
Time

SAN Volume Controller
Node

Sets thresholds on the peak (worst)
response time among all MDisk write
operations by a node. The Back-end Peak
Write Response Time metric for each
node is checked against the threshold
boundaries for each collection interval.
This threshold is enabled by default, with
default boundary values of
30000,10000,-1,-1. Violation of these
threshold boundaries means that the SVC
cache is having to “partition-limit” for a
given MDisk group. The de-staged data
from the SVC cache for this MDisk group
is causing the cache to fill up (writes are
being received faster than they can be
de-staged to disk). If delays reach 30
seconds or more, then the SVC will
switch into “short-term mode” where
writes are no longer cached for the
MDisk Group.

Port to Local Node
Send Response
Time

SAN Volume Controller
Node

Sets thresholds on the average number of
milliseconds it took to service each send
operation to another node in the local
SVC cluster. The Port to Local Node Send
Response Time metric for each node is
checked against the threshold boundaries
for each collection interval. This
threshold is enabled by default, with
default boundary values of 3,1.5,-1,-1.
Violation of these threshold boundaries
means that it is taking too long to send
data between nodes (on the fabric), and
suggests that there is either congestion
around these FC ports, or an internal
SVC microcode problem.

Port to Local Node
Receive Response
Time

SAN Volume Controller
Node

Sets thresholds on the average number of
milliseconds it took to service each
receive operation from another node in
the local SVC cluster. The Port to Local
Node Receive Response Time metric for
each node is checked against the
threshold boundaries for each collection
interval. This threshold is enabled by
default, with default boundary values of
1,0.5,-1,-1. Violation of these threshold
boundaries means that it is taking too
long to send data between nodes (on the
fabric), and suggests that there is either
congestion around these FC ports, or an
internal SVC microcode problem.
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Table 119. Array thresholds (continued)

Threshold (Metric) Device/Component Type Description

Port to Local Node
Send Queue Time

SAN Volume Controller
Node

Sets thresholds on the average number of
milliseconds that each send operation
issued to another node in the local SVC
cluster spent on the queue before being
issued. The Port to Local Node Send
Queue Time metric for each node is
checked against the threshold boundaries
for each collection interval. This
threshold is enabled by default, with
default boundary values of 2,1,-1,-1.
Violation of these threshold boundaries
means that the node has to wait too long
to send data to other nodes (on the
fabric), and suggests congestion on the
fabric.

Port to Local Node
Receive Queue
Time

SAN Volume Controller
Node

Sets thresholds on the average number of
milliseconds that each receive operation
issued to another node in the local SVC
cluster spent on the queue before being
issued. The Port to Local Node Receive
Queue Time metric for each node is
checked against the threshold boundaries
for each collection interval. This
threshold is enabled by default, with
default boundary values of 1,0.5,-1,-1.
Violation of these threshold boundaries
means that the node has to wait too long
to receive data from other nodes (on the
fabric), and suggests congestion on the
fabric.

Controller thresholds
The following table lists and describes the Controller thresholds.

Table 120. Controller thresholds

Threshold (Metric)
Device/Component
Type Description

Controller Thresholds

Total I/O Rate
(overall)

TotalStorage
Enterprise Storage
Server, DS6000,
DS8000 controller

SAN Volume
Controller I/O group

Sets threshold on the average number of I/O
operations per second for read and write
operations, for the subsystem controllers
(clusters) or I/O groups. The Total I/O Rate
metric for each controller or I/O group is
checked against the threshold boundaries for
each collection interval. These thresholds are
disabled by default.

Total Data Rate TotalStorage
Enterprise Storage
Server, DS6000,
DS8000 controller

SAN Volume
Controller I/O group

Sets threshold on the average number of MB
per second for read and write operations for
the subsystem controllers (clusters) or I/O
groups. The Total Data Rate metric for each
controller or I/O group is checked against the
threshold boundaries for each collection
interval. These thresholds are disabled by
default.
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Table 120. Controller thresholds (continued)

Threshold (Metric)
Device/Component
Type Description

NVS Full
Percentage

TotalStorage
Enterprise Storage
Server, DS6000,
DS8000 controller

Sets thresholds on the percentage of time that
NVS space constraints caused I/O operations
to be delayed, for the subsystem controllers
(clusters). The NVS Full Percentage metric for
each controller is checked against the
threshold boundaries for each collection
interval. This threshold is enabled by default,
with default boundaries of 10, 3, -1, -1.

Cache Holding
Time

TotalStorage
Enterprise Storage
Server, DS6000,
DS8000 controller

Sets thresholds on the average cache holding
time, in seconds, for I/O data in the
subsystem controllers (clusters). Shorter time
periods indicate adverse performance. The
Cache Holding Time metric for each
controller is checked against the threshold
boundaries for each collection interval. This
threshold is enabled by default, with default
boundaries of 30, 60, -1, -1.

Write-cache Delay
Percentage

TotalStorage
Enterprise Storage
Server, DS6000,
DS8000 controller,
SAN Volume
Controller node

Sets thresholds on the percentage of I/O
operations that were delayed due to
write-cache space constraints. This metric for
each controller or node is checked against the
threshold boundaries for each collection
interval. This threshold is enabled by default,
with default boundaries of 10, 3, -1, -1. In
addition, a filter is available for this threshold
which will ignore any boundary violations if
the Write-cache Delay I/O Rate is less than a
specified filter value. The pre-populated filter
value is 10 I/Os per second.

Non-Preferred
Node Usage
Percentage

SAN Volume
Controller I/O group

Sets thresholds on the Non-Preferred Node
Usage Percentage of an I/O group. This
metric of each I/O group is checked against
the threshold boundaries at each collection
interval. his threshold is disabled by default.
In addition, a filter is available for this
threshold which will ignore any boundary
violations if the Total I/O Rate of the I/O
group is less than a specified filter value.

Port thresholds
Port thresholds are used to set limits for such things as bandwidth utilization, data
rates, and I/O operations.

Table 121. Port thresholds

Threshold (Metric) Device/Component Type Description

Port Thresholds
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Table 121. Port thresholds (continued)

Threshold (Metric) Device/Component Type Description

Total Port I/O Rate TotalStorage Enterprise Storage Server,
DS6000, DS8000 switch port, XIV

Sets thresholds for ports on
the average number of I/O
operations or packets per
second for send and receive
operations. The Total I/O
Rate metric for each port is
checked against the
threshold boundaries for
each collection interval. This
threshold is disabled by
default.

Total Port Data
Rate

TotalStorage Enterprise Storage Server,
DS6000, DS8000 switch port, XIV

Sets thresholds for ports on
the average number of MB
per second for send and
receive operations. The Total
Data Rate metric for each
port is checked against the
threshold boundaries for
each collection interval. This
threshold is disabled by
default.

Overall Port
Response Time

TotalStorage Enterprise Storage Server,
DS6000, DS8000

Sets thresholds for ports on
the average number of
milliseconds that it takes to
service each send and receive
I/O operation. The Total
Response Time metric for
each port is checked against
the threshold boundaries for
each collection interval. This
threshold is disabled by
default.

Error Frame Rate DS8000 Sets thresholds on the
average number of frames
per second received in error
by ports. The Error Frame
Rate metric for each port is
checked against the
threshold boundary for each
collection interval. This
threshold is disabled by
default.

Link Failure Rate DS8000 SAN Volume Controller Sets thresholds on the
average number of link
errors per second for ports.
The Link Failure Rate metric
for each port is checked
against the threshold
boundary for each collection
interval. The default
boundaries are 0.0030,-1,-1,-1
cnt/s. This threshold is
disabled by default.
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Table 121. Port thresholds (continued)

Threshold (Metric) Device/Component Type Description

Total Port Data
Rate

Switch port Sets thresholds on the critical
and warning data rates for
stress and idle in MB per
second. The Total Port Data
Rate metric for each port is
checked against the
threshold boundary for each
collection interval. This
threshold is disabled by
default.

Total Port Packet
Rate

Switch port Sets thresholds on critical
and warning data rates for
stress and idle conditions in
packets per second. For
example, a critical stress or
warning stress condition
occurs when the
upper-threshold boundary
for the packet rate of a
switch is detected. A critical
idle or warning idle
condition occurs when the
lower-threshold boundary
for the packet rate of a
switch is detected. The Total
Port Packet Rate metric for
each port is checked against
the threshold boundary for
each collection interval. This
threshold is disabled by
default.

Port Send
Utilization
Percentage

TotalStorage Enterprise Storage Server,
DS6000, DS8000

Sets thresholds on the
average amount of time that
ports are busy sending data.
The metric for each port is
checked against the
threshold boundaries for
each collection interval. This
threshold is disabled by
default.

Port Receive
Utilization
Percentage

TotalStorage Enterprise Storage Server,
DS6000, DS8000

Sets thresholds on the
average amount of time that
ports are busy receiving
data. The metric for each
port is checked against the
threshold boundaries for
each collection interval. This
threshold is disabled by
default.
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Table 121. Port thresholds (continued)

Threshold (Metric) Device/Component Type Description

Port Send
Bandwidth
Percentage

TotalStorage Enterprise Storage Server,
DS8000, SAN Volume Controller
switch port, XIV

Sets thresholds on the
average port bandwidth
utilization percentage for
send operations. The Port
Send Utilization Percentage
metric is checked against the
threshold boundaries for
each collection interval. This
threshold is enabled by
default, with default
boundaries 85,75,-1,-1.

Port Receive
Bandwidth
Percentage

TotalStorage Enterprise Storage Server,
DS8000, SAN Volume Controller
switch port, XIV

Sets thresholds on the
average port bandwidth
utilization percentage for
receive operations. The Port
Send Utilization Percentage
metric is checked against the
threshold boundaries for
each collection interval. This
threshold is enabled by
default, with default
boundaries 85,75,-1,-1.

CRC Error Rate DS8000 port, SAN Volume Controller
switch port

Sets thresholds on the
average number of frames
received in which the cyclic
redundancy check (CRC) in a
frame does not match the
CRC computed by the
receiver. The CRC Error Rate
metric for each port is
checked against the
threshold boundary for each
collection interval. The
default boundaries are 0.033,
0.01, -1, -1 cnt/s. This
threshold is disabled by
default.

Invalid
Transmission Word
Rate

DS8000, SAN Volume Controller
switch port

Sets thresholds on the
average number of bit errors
detected on a port. The
Invalid Transmission Word
Rate metric for each port is
checked against the
threshold boundary for each
collection interval. The
default boundaries are 0.033,
0.01, -1, -1 cnt/s. This
threshold is disabled by
default.
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Table 121. Port thresholds (continued)

Threshold (Metric) Device/Component Type Description

Zero Buffer - Buffer
Credit Timer

SAN Volume Controller Sets thresholds on the
number of microseconds that
a port has been unable to
send frames because of a
lack of buffer credit since the
last node reset. The Zero
Buffer-Buffer Credit Timer
metric for each port is
checked against the
threshold boundary for each
collection interval. The
default boundaries are
198000000,75000000,-1,-1 us.
This threshold is disabled by
default.

Performance metrics
A description of the metrics that are displayed in the columns of performance
reports is provided.

Common columns

The following table contains information about the columns that are common
among performance reports.

Column Description

Time Date and time that the data was collected

Interval Size of the sample interval in seconds. You can specify a minimum
interval length of five minutes and a maximum interval length of sixty
minutes for the following models:

v TotalStorage Enterprise Storage Server

v DS6000

v DS8000

v the XIV system

For SAN Volume Controller models earlier than V4.1, you can specify
a minimum interval length of 15 minutes and a maximum interval
length of sixty minutes. For SAN Volume Controller models V4.1 and
later, you can specify a minimum interval length of 5 minutes, and a
maximum interval length of sixty minutes.

Note: When you view metrics for the ESS and DS6000 and DS8000 storage
systems, you must take into account the following differences between IBM Tivoli
Storage Productivity Center reports and the native reports of those systems:
v Tivoli Storage Productivity Center reports display port performance metrics as

send and receive metrics (for example, Send Data Rate and Receive Data Rate).
v Storage system native reports (for example, reports based on data collected by

the DS CLI) display port performance metrics as read and write metrics (for
example, Byteread and Bytewrite).

When a host performs a read operation, the DS port sends data to the host.
Therefore "read" metrics in DS6000 and DS8000 reports correspond to "send"
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metrics in Tivoli Storage Productivity Center reports. When a host performs a write
operation, DS6000 and DS8000 ports receive data from the host. Therefore "write"
metrics in DS6000 and DS8000 reports correspond to "receive" metrics in Tivoli
Storage Productivity Center reports.

When you view port Peer-to-Peer Remote Copy (PPRC) performance metrics, you
must take into account the following additional differences between Tivoli Storage
Productivity Center reports and native reports for storage systems:
v Metrics for PPRC reads in storage system native reports are represented as PPRC

receives in Tivoli Storage Productivity Center (reads = receives).
v Metrics for PPRC writes in storage system native reports are represented as

PPRC sends in Tivoli Storage Productivity Center (writes = sends).

XIV system metrics

To distinguish between metrics that were introduced in different versions of the
XIV systems, the following convention was used in this topic:
v

1 is displayed next to metrics that are available in the XIV system version 10.2.2
or later.

v
2 is displayed next to metrics that are available in the XIV system version 10.2.4
or later.

For example:
v The Read I/O Rate (overall) metric is available for the XIV systems version

10.2.2 and later. In the Devices: components column of the list of metrics, the
entry for Read I/O Rate (overall) is displayed like this: XIV1: volume, module,
subsystem

v The Small Transfers Response Time metric is available for the XIV systems
version 10.2.4 and later. In the Devices: components column of the list of
metrics, the entry for Small Transfers Response Time is displayed like this: XIV2:
volume, module, subsystem

Volume-based metrics

The following table contains information about volume-based metrics.

Note: Tivoli Storage Productivity Center does not calculate volume-based metrics
if there are space efficient volumes allocated in an extent pool consisting of
multiple ranks. In this case, the columns for volume-based metrics display the
value N/A in the Storage Subsystem Performance > By Array report for the arrays
associated with that extent pool. However, if there are no space efficient volumes
allocated in a multi-rank extent pool, or if the space efficient volumes are allocated
in an extent pool consisting of a single rank, then this limitation does not apply
and all volume-based metrics are displayed in the By Array report.

Column Devices: components Description

I/O Rates

Read I/O
Rate
(normal)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Average number of I/O operations per second for
nonsequential read operations for a component
over a specified time interval.

Read I/O
rate
(sequential)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Average number of I/O operations per second for
sequential read operations for a component over a
specified time interval.
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Column Devices: components Description

Read I/O
Rate
(overall)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of I/O operations per second for
both sequential and nonsequential read operations
for a component over a specified time interval.

Write I/O
Rate
(normal)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Average number of I/O operations per second for
nonsequential write operations for a component
over a specified time interval.

Write I/O
Rate
(sequential)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Average number of I/O operations per second for
sequential write operations for a component over
a specified time interval.

Write I/O
Rate
(overall)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of I/O operations per second for
both sequential and nonsequential write
operations for a component over a specified time
interval.

Total I/O
Rate
(normal)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Average number of I/O operations per second for
nonsequential read and write operations for a
component over a specified time interval.

Total I/O
Rate
(sequential)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Average number of I/O operations per second for
sequential read and write operations for a
component over a specified time interval.

Total I/O
Rate
(overall)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of I/O operations per second for
both sequential and nonsequential read and write
operations for a component over a specified time
interval.

Global
Mirror Write
I/O Rate

SVC: VDisk, node, I/O
group, subsystem

Average number of write operations per second
issued to the Global Mirror secondary site for a
component over a specified time interval.
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Column Devices: components Description

Global
Mirror
Overlapping
Write
Percentage

SVC: VDisk, node, I/O
group, subsystem

Average percentage of write operations issued by
the Global Mirror primary site which were
serialized overlapping writes for a component
over a specified time interval. For SVC 4.3.1 and
later, some overlapping writes are processed in
parallel (are not serialized) and are excluded. For
earlier SVC versions, all overlapping writes were
serialized.

Global
Mirror
Overlapping
Write I/O
Rate

SVC: VDisk, node, I/O
group, subsystem

Average number of serialized overlapping write
operations per second encountered by the Global
Mirror primary site for a component over a
specified time interval. For SVC 4.3.1 and later,
some overlapping writes are processed in parallel
(are not serialized) and are excluded. For earlier
SVC versions, all overlapping writes are serialized.

HPF Read
I/O Rate

DS8000: volume, array,
controller, subsystem

Average number of read operations per second
that were issued via the High Performance FICON
(HPF) feature of the storage subsystem for a
component over a specified time interval.

HPF Write
I/O Rate

DS8000: volume, array,
controller, subsystem

Average number of write operations per second
that were issued via the High Performance FICON
(HPF) feature of the storage subsystem for a
component over a specified time interval.

Total HPF
I/O Rate

DS8000: volume, array,
controller, subsystem

Average number of read and write operations per
second that were issued via the High Performance
FICON (HPF) feature of the storage subsystem for
a component over a specified time interval.

HPF I/O
Percentage

DS8000: volume, array,
controller, subsystem

The percentage of all I/O operations that were
issued via the High Performance FICON (HPF)
feature of the storage subsystem for a component
over a specified time interval.

PPRC
Transfer Rate

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Average number of track transfer operations per
second for PPRC usage for a component over a
specified time interval. This metric shows the
activity for the source of the PPRC relationship,
but shows no activity for the target.

Small
Transfers
I/O
Percentage

XIV2: volume, module,
subsystem

Percentage of I/O operations over a specified
interval. Applies to data transfer sizes that are <=
8 KB.

Medium
Transfers
I/O
Percentage

XIV2: volume, module,
subsystem

Percentage of I/O operations over a specified
interval. Applies to data transfer sizes that are > 8
KB and <= 64 KB.

Large
Transfers
I/O
Percentage

XIV2: volume, module,
subsystem

Percentage of I/O operations over a specified
interval. Applies to data transfer sizes that are >
64 KB and <= 512 KB.

Very Large
Transfers
I/O
Percentage

XIV2: volume, module,
subsystem

Percentage of I/O operations over a specified
interval. Applies to data transfer sizes that are >
512 KB.

Cache hit percentages
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Column Devices: components Description

Read Cache
Hits
Percentage
(normal)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Percentage of cache hits for nonsequential read
operations for a component over a specified time
interval.

Read Cache
Hits
Percentage
(sequential)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Percentage of cache hits for sequential read
operations for a component over a specified time
interval.

Read Cache
Hits
Percentage
(overall)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Percentage of cache hits for both sequential and
nonsequential read operations for a component
over a specified time interval.

Write Cache
Hits
Percentage
(normal)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Percentage of cache hits for nonsequential write
operations for a component over a specified time
interval.

Write Cache
Hits
Percentage
(sequential)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Percentage of cache hits for sequential write
operations for a component over a specified time
interval.

Write Cache
Hits
Percentage
(overall)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Percentage of cache hits for both sequential and
nonsequential write operations for a component
over a specified time interval.

Total Cache
Hits
Percentage
(normal)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Percentage of cache hits for nonsequential read
and write operations for a component over a
specified time interval.

Total Cache
Hits
Percentage
(sequential)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

Percentage of cache hits for sequential read and
write operations for a component over a specified
time interval.
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Column Devices: components Description

Total Cache
Hits
Percentage
(overall)

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Percentage of cache hits for both sequential and
nonsequential read and write operations for a
component over a specified time interval.

Readahead
Percentage
of Cache
Hits

SVC: VDisk, node, I/O
group, subsystem

Percentage of all read cache hits which occurred
on prestaged data.

Dirty Write
Percentage
of Cache
Hits

SVC: VDisk, node, I/O
group, subsystem

Percentage of all write cache hits which occurred
on already dirty data in the cache.

Read Data
Cache Hit
Percentage

XIV2: volume, module,
subsystem

Percentage of read data that was read from the
cache over a specified time interval.

Write Data
Cache Hit
Percentage

XIV2: volume, module,
subsystem

Percentage of write data that was written to the
cache over a specified time interval.

Total Data
Cache Hit
Percentage

XIV2: volume, module,
subsystem

Percentage of all data that was read from or
written to the cache for a component over a
specified time interval.

Data rates

Read Data
Rate

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of megabytes (2^20 bytes) per
second that were transferred for read operations
for a component over a specified time interval.

Write Data
Rate

ESSDS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of megabytes (2^20 bytes) per
second that were transferred for write operations
for a component over a specified time interval.
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Column Devices: components Description

Total Data
Rate

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of megabytes (2^20 bytes) per
second that were transferred for read and write
operations for a component over a specified time
interval.

Small
Transfers
Data
Percentage

XIV2: volume, module,
subsystem

Percentage of data that was transferred over a
specified interval. Applies to I/O operations with
data transfer sizes that are <= 8 KB.

Medium
Transfers
Data
Percentage

XIV2: volume, module,
subsystem

Percentage of data that was transferred over a
specified interval. Applies to I/O operations with
data transfer sizes that are > 8 KB and <= 64 KB.

Large
Transfers
Data
Percentage

XIV2: volume, module,
subsystem

Percentage of data that was transferred over a
specified interval. Applies to I/O operations with
data transfer sizes that are > 64 KB and <= 512
KB.

Very Large
Transfers
Data

XIV2: volume, module,
subsystem

Percentage of data that was transferred over a
specified interval. Applies to I/O operations with
data transfer sizes that are > 512 KB.

Response times

Read
Response
Time

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of milliseconds that it took to
service each read operation for a component over
a specified time interval.

Write
Response
Time

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of milliseconds that it took to
service each write operation for a component over
a specified time interval.
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Column Devices: components Description

Overall
Response
Time

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of milliseconds that it took to
service each I/O operation (read and write) for a
component over a specified time interval.

Peak Read
Response
Time

SVC: VDisk, node, I/O
group, subsystem

The peak (worst) response time among all read
operations.

Peak Write
Response
Time

SVC: VDisk, node, I/O
group, subsystem

The peak (worst) response time among all write
operations.

Global
Mirror Write
Secondary
Lag

SVC: VDisk, node, I/O
group, subsystem

The average number of additional milliseconds it
takes to service each secondary write operation for
Global Mirror, beyond the time that is required to
service primary writes.

Overall Host
Attributed
Response
Time
Percentage

SVC: VDisk, node, I/O
group, subsystem

The percentage of the average response time, both
read response time and write response time, that
can be attributed to delays from host systems. This
metric is provided to help diagnose slow hosts
and poorly performing fabrics. The value is based
on the time taken for hosts to respond to
transfer-ready notifications from the SVC nodes
(for read) and the time taken for hosts to send the
write data after the node has responded to a
transfer-ready notification (for write).

Read Cache
Hit
Response
Time

XIV2: volume, module,
subsystem

Average number of milliseconds that it takes to
service each read cache hit operation over a
specified time interval.

Write Cache
Hit
Response
Time

XIV2: volume, module,
subsystem

Average number of milliseconds that it takes to
service each write cache hit operation over a
specified time interval.

Overall
Cache Hit
Response
Time

XIV2: volume, module,
subsystem

Average number of milliseconds that it takes to
service each read cache hit operation and each
write cache hit operation over a specified time
interval.

Read Cache
Miss
Response
Time

XIV2: volume, module,
subsystem

Average number of milliseconds that it takes to
service each read cache miss operation over a
specified time interval.

Write Cache
Miss
Response
Time

XIV2: volume, module,
subsystem

Average number of milliseconds that it takes to
service each write cache miss operation over a
specified time interval.
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Column Devices: components Description

Overall
Cache Miss
Response
Time

XIV2: volume, module,
subsystem

Average number of milliseconds that it takes to
service each read cache miss operation and each
write cache miss operation over a specified time
interval.

Small
Transfers
Response
Time

XIV2: volume, module,
subsystem

Average number of milliseconds that it takes to
service each I/O operation. Applies to data
transfer sizes that are <= 8 KB.

Medium
Transfers
Response
Time

XIV2: volume, module,
subsystem

Average number of milliseconds that it takes to
service each I/O operation. Applies to data
transfer sizes that are > 8 KB and <= 64 KB.

Large
Transfers
Response
Time

XIV2: volume, module,
subsystem

Average number of milliseconds that it takes to
service each I/O operation. Applies to data
transfer sizes that are > 64 KB and <= 512 KB.

Very Large
Transfers
Response
Time

XIV2: volume, module,
subsystem

Average number of milliseconds that it takes to
service each I/O operation. Applies to data
transfer sizes that are > 512 KB.

Transfer sizes

Read
Transfer Size

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of KB per I/O for read
operations.

Write
Transfer Size

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of KB per I/O for write
operations.
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Overall
Transfer Size

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, MDisk group,
subsystem

SMI-S BSP: volume,
controller, subsystem

XIV1: volume, module,
subsystem

Average number of KB per I/O for read and write
operations.

Write-cache constraints

Write-cache
Delay
Percentage

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, subsystem

Percentage of I/O operations that were delayed
due to write-cache space constraints or other
conditions for a component over a specified time
interval. (The ratio of delayed operations to total
I/Os.)

Write-cache
Delayed I/O
Rate

ESS/DS6000/DS8000:
volume, array,
controller, subsystem

SVC: VDisk, node, I/O
group, subsystem

Average number of I/O operations per second that
were delayed due to write-cache space constraints
or other conditions for a component over a
specified time interval.

Write-cache
Overflow
Percentage

SVC: VDisk, node, I/O
group, subsystem

Percentage of write operations that were delayed
due to lack of write-cache space for a component
over a specified time interval.

Write-cache
Overflow
I/O Rate

SVC: VDisk, node, I/O
group, subsystem

Average number of tracks per second that were
delayed due to lack of write-cache space for a
component over a specified time interval.

Write-cache
Flush-
through
Percentage

SVC: VDisk, node, I/O
group, subsystem

Percentage of write operations that were processed
in Flush-through write mode for a component
over a specified time interval.

Write-cache
Flush-
through I/O
Rate

SVC: VDisk, node, I/O
group, subsystem

Average number of tracks per second that were
processed in Flush-through write mode for a
component over a specified time interval.

Write-cache
Write-
through
Percentage

SVC: VDisk, node, I/O
group, subsystem

Percentage of write operations that were processed
in Write-through write mode for a component
over a specified time interval.

Write-cache
Write-
through I/O
Rate

SVC: VDisk, node, I/O
group, subsystem

Average number of tracks per second that were
processed in Write-through write mode for a
component over a specified time interval.

Record mode reads

Record
Mode Read
I/O Rate

ESSDS6000/DS8000:
volume, array, controller

Average number of I/O operations per second for
record mode read operations for a component over
a specified time interval.
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Record
Mode Read
Cache %

ESS/DS6000/DS8000:
volume, array, controller

Percentage of cache hits for record mode read
operations for a component over a specified time
interval.

Cache transfers

Disk to
Cache I/O
Rate

ESS/DS6000/DS8000:
volume, array, controller

SVC: VDisk, node, I/O
group, subsystem

Average number of I/O operations (track
transfers) per second for disk to cache transfers for
a component over a specified time interval.

Cache to
Disk I/O
Rate

ESS/DS6000/DS8000:
volume, array, controller

SVC: VDisk, node, I/O
group, subsystem

Average number of I/O operations (track
transfers) per second for cache to disk transfers for
a component over a specified time interval.

Miscellaneous computed values

Cache
Holding
Time

ESS/DS6000/DS8000:
controller, subsystem

Average cache holding time, in seconds, for I/O
data in this subsystem controller (cluster). Shorter
time periods indicate adverse performance.

CPU
Utilization

SVC: node, I/O group,
subsystem

Average utilization percentage of the processors.

Non-
Preferred
Node Usage
Percentage

SVC: VDisk, I/O group The overall percentage of I/O performed or data
transferred via the non-preferred nodes of the
VDisks, for a component over a specified time
interval.

Volume
Utilization

ESS/DS6000/DS8000:
volume

SVC: VDisk

SMI-S BSP: volume

XIV1: volume

The approximate utilization percentage of a
volume over a specified time interval (the average
percent of time that the volume was busy).

Back-end-based metrics

The following table contains information about back-end-based metrics.

Column Devices: components Description

I/O rates

Backend
Read I/O
Rate

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of I/O operations per second for
read operations.

Backend
Write I/O
Rate

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of I/O operations per second for
write operations.
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Total
Backend I/O
Rate

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of I/O operations per second for
read and write operations.

Data rates

Backend
Read Data
Rate

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of megabytes (2^20 bytes) that
were transferred for read operations.

Backend
Write Data
Rate

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of megabytes (2^20 bytes) that
were transferred for write operations.

Total
Backend
Data Rate

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of megabytes (2^20 bytes) that
were transferred for read and write operations.

Response times

Backend
Read
Response
Time

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of milliseconds that it took to
respond to each read operation. For SAN Volume
Controller models, this is the external response
time of the managed disks (MDisks).

Backend
Write
Response
Time

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of milliseconds that it took to
respond to each write operation. For SAN Volume
Controller models, this is the external response
time of the managed disks (MDisks).

Overall
Backend
Response
Time

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of milliseconds that it took to
respond to each I/O operation (read and write).
For SAN Volume Controller models, this is the
external response time of the managed disks
(MDisks).

Backend
Read Queue
Time

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of milliseconds that each read
operation spent on the queue before being issued
to the back-end device.
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Backend
Write Queue
Time

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of milliseconds that each write
operation spent on the queue before being issued
to the back-end device.

Overall
Backend
Queue Time

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of milliseconds that read and
write operations spent on the queue before being
issued to the back-end device.

Peak
Back-end
Read
Response
Time

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

The peak (worst) response time among all read
operations for a component over a specified time
interval. For SAN Volume Controller, it represents
the external response time of the MDisks.

Peak
Back-end
Write
Response
Time

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

The peak (worst) response time among all write
operations for a component over a specified time
interval. For SAN Volume Controller, it represents
the external response time of the MDisks.

Peak
Back-end
Read Queue
Time

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

The lower bound on the peak (worst) queue time
for read operations for a component over a
specified time interval. The queue time is the
amount of time that the read operation spent on
the queue before being issued to the back-end
device.

Peak
Back-end
Write Queue
Time

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

The lower bound on the peak (worst) queue time
for write operations for a component over a
specified time interval. The queue time is the
amount of time that the write operation spent on
the queue before being issued to the back-end
device.

Transfer sizes

Back-end
Read
Transfer Size

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of KB per I/O for read
operations for a component over a specified time
interval.

Back-end
Write
Transfer Size

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of KB per I/O for write
operations for a component over a specified time
interval.

Overall
Back-end
Transfer Size

ESS/DS6000/DS8000:
rank, array, controller,
subsystem

SVC: node, I/O group,
MDisk, MDisk group,
subsystem

Average number of KB per I/O for read and write
operations for a component over a specified time
interval.

Disk utilization

1480 IBM Tivoli Storage Productivity Center: User's Guide



Column Devices: components Description

Disk
Utilization
Percentage

ESS/DS6000/DS8000:
array

The approximate utilization percentage of a rank
over a specified time interval (the average percent
of time that the disks associated with the array
were busy).
Note: Tivoli Storage Productivity Center does not
calculate a value for this column if there are
multiple ranks in the extent pool where the
space-efficient volumes are allocated. This column
displays value of N/A for the reports in which it
appears. However, if there is only a single rank in
the extent pool, Tivoli Storage Productivity Center
does calculate the value for this column regardless
of the space-efficient volumes.

Sequential
I/O
Percentage

ESS/DS6000/DS8000:
array

Percentage of all I/O operations performed for an
array over a specified time interval that were
sequential operations.

Frontend and fabric-based metrics

The following table contains information on frontend and fabric-based metrics.

Column Devices: components Description

I/O or packet rates

Port Send
I/O Rate

ESS/DS6000/DS8000:
port, subsystem

SVC: port, node, I/O
group, subsystem

SMI-S BSP: port

XIV2: port

Average number of I/O operations per second for
send operations for a port over a specified time
interval.

Port Receive
I/O Rate

ESS/DS6000/DS8000:
port, subsystem

SVC: port, node, I/O
group, subsystem

SMI-S BSP: port

XIV2: port

Average number of I/O operations per second for
receive operations for a port over a specified time
interval.

Total Port
I/O Rate

ESS/DS6000/DS8000:
port, subsystem

SVC: port, node, I/O
group, subsystem

SMI-S BSP: port

XIV2: port

Average number of I/O operations per second for
send and receive operations for a port over a
specified time interval.

Port Send
Packet Rate

switch port, switch Average number of packets per second for send
operations for a port over a specified time interval.

Port Receive
Packet Rate

switch port, switch Average number of packets per second for receive
operations for a port over a specified time interval
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Total port
Packet Rate

switch port, switch Average number of packets per second for send
and receive operations for a port over a specified
time interval.

Port to Host
Send I/O
Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
sent to host computers by a component over a
specified time interval.

Port to Host
Receive I/O
Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
received from host computers by a component
over a specified time interval.

Total Port to
Host I/O
Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
transmitted between host computers and a
component over a specified time interval.

Port to Disk
Send I/O
Rate A

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
sent to storage subsystems by a component over a
specified time interval.

Port to Disk
Receive I/O
Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
received from storage subsystems by a component
over a specified time interval.

Total Port to
Disk I/O
Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
transmitted between storage subsystems and a
component over a specified time interval.

Port to Local
Node Send
I/O Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
sent to other nodes in the local SAN Volume
Controller cluster by a component over a specified
time interval.

Port to Local
Node
Receive I/O
Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
received from other nodes in the local SAN
Volume Controller cluster by a component over a
specified time interval.

Total Port to
Local Node
I/O Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
transmitted between other nodes in the local SAN
Volume Controller cluster and a component over a
specified time interval.

Port to
Remote
Node Send
I/O Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
sent to nodes in the remote SAN Volume
Controller cluster by a component over a specified
time interval.

Port to
Remote
Node
Receive I/O
Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
received from nodes in the remote SAN Volume
Controller cluster.

Total Port to
Remote
Node I/O
Rate

SVC: port, node, I/O
group, subsystem

Average number of exchanges (I/Os) per second
transmitted between nodes in the remote SAN
Volume Controller cluster and a component over a
specified time interval.

Port FCP
Send I/O
Rate*

ESS/DS6000/DS8000:
port

Average number of send operations per second
using the FCP protocol, for a port over a specified
time interval.

Port FCP
Receive I/O
Rate*

ESS/DS6000/DS8000:
port

Average number of receive operations per second
using the FCP protocol for a port over a specified
time interval.
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Total Port
FCP I/O
Rate*

ESS/DS6000/DS8000:
port

Average number of send and receive operations
per second using the FCP protocol for a port over
a specified time interval.

Port FICON
Send I/O
Rate*

ESS/DS6000/DS8000:
port

Average number of send operations per second
using the FICON protocol for a port over a
specified time interval.

Port FICON
Receive I/O
Rate*

ESS/DS6000/DS8000:
port

Average number of receive operations per second
using the FICON protocol for a port over a
specified time interval.

Total Port
FICON I/O
Rate*

ESS/DS6000/DS8000:
port

Average number of send and receive operations
per second using the FICON protocol for a port
over a specified time interval.

Port PPRC
Send I/O
Rate

ESS/DS6000/DS8000:
port, subsystem

Average number of send operations per second for
Peer-to-Peer Remote Copy usage for a port over a
specified time interval.

Port PPRC
Receive I/O
Rate

ESS/DS6000/DS8000:
port, subsystem

Average number of receive operations per second
for Peer-to-Peer Remote Copy usage for a port
over a specified time interval.

Total Port
PPRC I/O
Rate

ESS/DS6000/DS8000:
port, subsystem

Average number of send and receive operations
per second for Peer-to-Peer Remote Copy usage for
a port over a specified time interval.

Data rates

Port Send
Data Rate

ESS/DS6000/DS8000:
port, subsystem

SVC: port, node, I/O
group, subsystem

SMI-S BSP: port

switch port, switch

XIV2: port

Average number of megabytes (2^20 bytes) per
second that were transferred for send (read)
operations for a port over a specified time interval.

Port Receive
Data Rate

ESS/DS6000/DS8000:
port, subsystem

SVC: port, node, I/O
group, subsystem

SMI-S BSP: port

switch port, switch

XIV2: port

Average number of megabytes (2^20 bytes) per
second that were transferred for receive (write)
operations for a port over a specified time interval.

Total Port
Data Rate

ESS/DS6000/DS8000:
port, subsystem

SVC: port, node, I/O
group, subsystem

SMI-S BSP: port

switch port, switch

XIV2: port

Average number of megabytes (2^20 bytes) per
second that were transferred for send and receive
operations for a port over a specified time interval.
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Port Peak
Send Data
Rate

switch port Peak number of megabytes (2^20 bytes) per second
that were sent by a port over a specified time
interval

Port Peak
Receive Data
Rate

switch port Peak number of megabytes (2^20 bytes) per second
that were received by a port over a specified time
interval.

Port to Host
Send Data
Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second sent to host computers by a component
over a specified time interval.

Port to Host
Receive Data
Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second received from host computers by a
component over a specified time interval.

Total Port to
Host Data
Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second transmitted between host computers and a
component over a specified time interval.

Port to Disk
Send Data
Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second sent to storage subsystems by a component
over a specified time interval.

Port to Disk
Receive Data
Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second received from storage subsystems by a
component over a specified time interval.

Total Port to
Disk Data
Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second transmitted between storage subsystems
and a component over a specified time interval.

Port to Local
Node Send
Data Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second sent to other nodes in the local SAN
Volume Controller cluster by a component over a
specified time interval.

Port to Local
nNode
Receive Data
Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second received from other nodes in the local SAN
Volume Controller cluster by a component over a
specified time interval.

Total Port to
Local Node
Data Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second transmitted between other nodes in the
local SAN Volume Controller cluster and a
component over a specified time interval.

Port to
Remote
Node Send
Data Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second sent to nodes in the remote SAN Volume
Controller cluster by a component over a specified
time interval.

Port to
Remote
Node
Receive Data
Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second received from nodes in the remote SAN
Volume Controller cluster by a component over a
specified time interval.

Total Port to
Remote
Node Data
Rate

SVC: port, node, I/O
group, subsystem

Average number of megabytes (2^20 bytes) per
second transmitted between nodes in the remote
SAN Volume Controller cluster and a component
over a specified time interval.

Port FCP
Send Data
Rate*

ESS/DS6000/DS8000:
port

Average number of megabytes (2^20 bytes) per
second sent over the FCP protocol for a port over a
specified time interval.
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Port FCP
Receive Data
Rate*

ESS/DS6000/DS8000:
port

Average number of megabytes (2^20 bytes) per
second received over the FCP protocol for a port
over a specified time interval.

Total Port
FCP Data
Rate*

ESS/DS6000/DS8000:
port

Average number of megabytes (2^20 bytes) per
second sent or received over the FCP protocol for a
port over a specified time interval.

Port FICON
Send Data
Rate*

ESS/DS6000/DS8000:
port

Average number of megabytes (2^20 bytes) per
second sent over the FICON protocol for a port
over a specified time interval.

Port FICON
Receive Data
Rate*

ESS/DS6000/DS8000:
port

Average number of megabytes (2^20 bytes) per
second received over the FICON protocol, for a
port over a specified time interval.

Total Port
FICON Data
Rate*

ESS/DS6000/DS8000:
port

Average number of megabytes (2^20 bytes) per
second sent or received over the FICON protocol
for a port over a specified time interval.

Port PPRC
Send Data
Rate

ESS/DS6000/DS8000:
port, subsystem

Average number of megabytes (2^20 bytes) per
second sent for Peer-to-Peer Remote Copy usage
for a port over a specified time interval.

Port PPRC
Receive Data
Rate

ESS/DS6000/DS8000:
port, subsystem

Average number of megabytes (2^20 bytes) per
second received for Peer-to-Peer Remote Copy
usage for a port over a specified time interval.

Total Port
PPRC Data
Rate

ESS/DS6000/DS8000:
port, subsystem

Average number of megabytes (2^20 bytes) per
second transferred for Peer-to-Peer Remote Copy
usage for a port over a specified time interval.

Response times

Port Send
Response
Time

ESS/DS6000/DS8000:
port, subsystem

XIV2: port

Average number of milliseconds that it took to
service each send (read) operation for a port over a
specified time interval.

Port Receive
Response
Time

ESS/DS6000/DS8000:
port, subsystem

XIV2: port

Average number of milliseconds that it took to
service each receive (write) operation for a port
over a specified time interval.

Overall Port
Response
Time

ESS/DS6000/DS8000:
port, subsystem

XIV2: port

Average number of milliseconds that it took to
service each operation (send and receive) for a port
over a specified time interval.

Port to Local
Node Send
Response
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds it took to service
each send operation to another node in the local
SAN Volume Controller cluster for a component
over a specified time interval. This is the external
response time of the transfers.

Port to Local
Node
Receive
Response
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds it took to service
each receive operation from another node in the
local SAN Volume Controller cluster for a
component over a specified time interval. This is
the external response time of the transfers.

Total Port to
Local Node
Response
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds it took to service
each send or receive operation between another
node in the local SAN Volume Controller cluster
and a component over a specified time interval.
This is the external response time of the transfers.
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Port to Local
Node Send
Queued
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds that each send
operation issued to another node in the local SAN
Volume Controller cluster spent on the queue
before being issued for a component over a
specified time interval.

Port to Local
Node
Receive
Queued
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds that each receive
operation from another node in the local SAN
Volume Controller cluster spent on the queue
before being issued for a component over a
specified time interval.

Total Port to
Local Node
Queued
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds that each
operation issued to another node in the local SAN
Volume Controller cluster spent on the queue
before being issued for a component over a
specified time interval.

Port to
Remote
Node Send
Response
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds it took to service
each send operation to a node in the remote SAN
Volume Controller cluster for a component over a
specified time interval. This is the external
response time of the transfers.

Port to
Remote
Node
Receive
Response
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds it took to service
each receive operation from a node in the remote
SAN Volume Controller cluster for a component
over a specified time interval. This is the external
response time of the transfers.

Total Port to
Remote
Node
Response
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds it took to service
each send or receive operation between a node in
the remote SAN Volume Controller cluster and a
component over a specified time interval. This is
the external response time of the transfers.

Port to
Remote
Node Send
Queued
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds that each send
operation issued to a node in the remote SAN
Volume Controller cluster spent on the queue
before being issued for a component over a
specified time interval.

Port to
Remote
Node
Receive
Queued
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds that each receive
operation from a node in the remote SAN Volume
Controller cluster spent on the queue before being
issued for a component over a specified time
interval.

Total Port to
Remote
Node
Queued
Time

SVC: node, I/O group,
subsystem

Average number of milliseconds that each
operation issued to a node in the remote SAN
Volume Controller cluster spent on the queue
before being issued for a component over a
specified time interval.

Port FCP
Send
Response
Time*

ESS/DS6000/DS8000:
port

Average number of milliseconds it took to service
all send operations over the FCP protocol for a
port over a specified time interval.
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Port FCP
Receive
Response
Time*

ESS/DS6000/DS8000:
port

Average number of milliseconds it took to service
all receive operations over the FCP protocol for a
port over a specified time interval.

Overall Port
FCP
Response
Time*

ESS/DS6000/DS8000:
port

Average number of milliseconds it took to service
all I/O operations over the FCP protocol for a port
over a specified time interval.

Port FICON
Send
Response
Time*

ESS/DS6000/DS8000:
port

Average number of milliseconds it took to service
all send operations over the FICON protocol for a
port over a specified time interval.

Port FICON
Receive
Response
Time*

ESS/DS6000/DS8000:
port

Average number of milliseconds it took to service
all receive operations over the FICON protocol for
a port over a specified time interval.

Overall Port
FICON
Response
Time*

ESS/DS6000/DS8000:
port

Average number of milliseconds it took to service
all I/O operations over the FICON protocol for a
port over a specified time interval.

Port PPRC
Send
Response
Time

ESS/DS6000/DS8000:
port, subsystem

Average number of milliseconds it took to service
all send operations for Peer-to-Peer Remote Copy
usage for a port over a specified time interval.

Port PPRC
Receive
Response
Time

ESS/DS6000/DS8000:
port, subsystem

Average number of milliseconds it took to service
all receive operations for Peer-to-Peer Remote
Copy usage for a port over a specified time
interval.

Overall Port
PPRC
Response
Time

ESS/DS6000/DS8000:
port, subsystem

Average number of milliseconds it took to service
all I/O operations for Peer-to-Peer Remote Copy
usage for a port over a specified time interval.

Transfer sizes

Port Send
Transfer Size

ESS/DS6000/DS8000:
port, subsystem

SMI-S BSP: port

Average number of KB sent per I/O by a port over
a specified time interval.

Port Receive
Transfer Size

ESS/DS6000/DS8000:
port, subsystem

SMI-S BSP: port

Average number of KB received per I/O by a port
over a specified time interval.

Overall Port
Transfer Size

ESS/DS6000/DS8000:
port, subsystem

SMI-S BSP: port

Average number of KB transferred per I/O by a
port over a specified time interval.

Port Send
Packet Size

switch port, switch Average number of KB sent per packet by a port
over a specified time interval.

Port Receive
Packet Size

switch port, switch

Overall Port
Packet Size

switch port, switch Average number of KB received per packet by a
port over a specified time interval.

Special computed values
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Column Devices: components Description

Port Send
Utilization
Percentage

ESS/DS6000/DS8000:
port

Average amount of time that the port was busy
sending data over a specified time interval.

Port Receive
Utilization
Percentage

ESS/DS6000/DS8000:
port

Average amount of time that the port was busy
receiving data over a specified time interval.

Overall Port
Utilization
Percentage

ESS/DS6000/DS8000:
port

Average amount of time that the port was busy
sending or receiving data over a specified time
interval.

Port Send
Bandwidth
Percentage

ESS/DS8000: port

SVC: port

switch, port

XIV2: port

The approximate bandwidth utilization percentage
for send operations by a port based on its current
negotiated speed.

Port Receive
Bandwidth
Percentage

ESS/DS8000: port

SVC: port

switch, port

XIV2: port

The approximate bandwidth utilization percentage
for receive operations by this port, based on its
current negotiated speed.

Overall Port
Bandwidth
Percentage

ESS/DS8000: port

SVC: port

switch, port

XIV2: port

The approximate bandwidth utilization percentage
for send and receive operations by this port.

Error rates

Error Frame
Rate

switch port, switch

DS8000: port,
subsystem

The number of frames per second that were
received in error by a port over a specified time
interval.

Dumped
Frame Rate

switch port, switch The number of frames per second that were lost
due to a lack of available host buffers for a port
over a specified time interval.

Link Failure
Rate

switch port, switch

DS8000: port,
subsystem

SVC: port, node, I/O
group, subsystem

The number of link errors per second that were
experienced by a port over a specified time
interval.

Loss of Sync
Rate

switch port, switch

DS8000: port,
subsystem

SVC: port, node, I/O
group, subsystem

The average number of times per second that
synchronization was lost for a component over a
specified time interval.
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Column Devices: components Description

Loss of
Signal Rate

switch port, switch

DS8000: port,
subsystem

SVC: port, node, I/O
group, subsystem

The average number of times per second that the
signal was lost for a component over a specified
time interval.

CRC Error
Rate

switch port, switch

DS8000: port,
subsystem

SVC: port, node, I/O
group, subsystem

The average number of frames received per second
in which the CRC in the frame did not match the
CRC computed by the receiver for a component
over a specified time interval.

Short Frame
Rate

switch port, switch The average number of frames received per second
that were shorter than 28 octets (24 header + 4
CRC) not including any SOF/EOF bytes for a
component over a specified time interval.

Long Frame
Rate

switch port, switch The average number of frames received per second
that were longer than 2140 octets (24 header + 4
CRC + 2112 data) not including any SOF/EOF
bytes for a component over a specified time
interval.

Encoding
Disparity
Error Rate

switch port, switch The average number of disparity errors received
per second for a component over a specified time
interval.

Discarded
Class3 Frame
Rate

switch port, switch The average number of class-3 frames per second
that were discarded by a component over a
specified time interval.

F-BSY Frame
Rate

switch port, switch The average number of F-BSY frames per second
that were generated by a component over a
specified time interval.

F-RJT Frame
Rate

switch port, switch The average number of F-RJT frames per second
that were generated by a component over a
specified time interval.

Primitive
Sequence
Protocol
Error Rate

switch port, switch

DS8000: port,
subsystem

SVC: port, node, I/O
group, subsystem

The average number of primitive sequence
protocol errors detected for a component over a
specified time interval.

Invalid
Transmission
Word Rate

switch port, switch

DS8000: port,
subsystem

SVC: port, node, I/O
group, subsystem

The average number of transmission words per
second that had an 8b10 code violation in one or
more characters; had a K28.5 in its second, third,
or fourth character positions; and/or was an
ordered set that had an incorrect Beginning
Running Disparity.

Zero
Buffer-Buffer
Credit Timer

SVC: port, node, I/O
group, subsystem

The number of microseconds that the port has
been unable to send frames due to lack of buffer
credit since the last node reset.
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Column Devices: components Description

Link
Recovery
(LR) Sent
Rate

switch port, switch

DS8000: port,
subsystem

The average number of times per second that a
port has transitioned from an active (AC) state to a
Link Recovery (LR1) state over a specified time
interval.

Link
Recovery
(LR)
Received
Rate

switch port, switch

DS8000: port,
subsystem

The average number of times per second a port
has transitioned from an active (AC) state to a
Link Recovery (LR2) state over a specified time
interval

Out of Order
Data Rate

DS8000: port,
subsystem

The average number of times per second that an
out of order frame was detected for a port over a
specified time interval.

Out of Order
ACK Rate

DS8000: port,
subsystem

The average number of times per second that an
out of order ACK frame was detected for a port
over a specified time interval.

Duplicate
Frame Rate

DS8000: port,
subsystem

The average number of times per second that a
frame was received that has been detected as
previously processed for a port over a specified
time interval.

Invalid
Relative
Offset Rate

DS8000: port,
subsystem

The average number of times per second that a
frame was received with invalid relative offset in
the frame header for a port over a specific time
interval.

Sequence
Timeout Rate

DS8000: port,
subsystem

The average number of times per second the port
has detected a timeout condition on receiving
sequence initiative for a fiber channel exchange for
a port over a specified time interval.

Tip: * The value N/A is displayed for this metric if you set the Summation Level to hourly
or daily before generating the report.

Protocols and standards
This section provides an overview of the protocols and standards that are used
within IBM Tivoli Storage Productivity Center.

Web Based Enterprise Management
Web Based Enterprise Management (WBEM) is an initiative of the Distributed
Management Task Force (DTMF) with the objective to enable the management of
complex IT environments. It defines a set of management and internet standard
technologies in order to unify the management of complex IT environments.

The WBEM initiative is composed of three main conceptual elements:

Common Interface Model (CIM)
CIM is a formal object-oriented modeling language that is used to describe
the management aspects of systems.

xmlCIM
This is the grammar to describe CIM declarations and messages used by
the CIM protocol.

Hypertext Transfer Protocol (HTTP)
HTTP is used as a way to enable communication between a management
application and a device that both use CIM.
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The WBEM architecture defines the following elements:

CIM Client
The CIM Client is a management application like IBM Tivoli Storage
Productivity Center that uses CIM to manage devices. A CIM Client can
reside anywhere in the network, because it uses HTTP to talk to CIM
Object Managers and Agents.

CIM Managed Object
A Managed Object is a hardware or software component that can be
managed by a management application by using CIM.

CIM Agent
A CIM Object Manager that includes the provider service for a limited set
of resources. An agent may be embedded or hosted and can be an
aggregator for multiple devices.

CIM Provider
A CIM Provider is the element that translates CIM calls to the
device-specific commands. A provider is always closely linked to a CIM.

CIM Object Manager (CIMOM)
The central component of the CIM Server responsible for the
communication between the CIM server components.

CIM Server
A server that receives and processes CIM Operation Message Requests and
issues CIM Operation Message Responses.

Storage Management Initiative Specification
The Storage Networking Industry Association (SNIA) defines a standard that is
used within IBM Tivoli Storage Productivity Center to create and develop a
universal open interface for managing storage devices including storage networks.

Information on SMI-S can be found at this Web site:
http://www.snia.org

SNIA has fully adopted and enhanced the Common Information Model (CIM)
standard for storage management in its Storage Management Initiative -
Specification (SMI-S). SMI-S was launched to create and develop a universal open
interface for managing storage devices including storage networks. SMI-S provides:
v A comprehensive specification for the management of heterogeneous storage and

storage area networks (SANs).
v The information available to a WBEM client from an SMI-S compliant CIM

server (provider).
v Profiles organized by:

– Storage
– Fabric
– Host
– Common profiles and subprofiles

v An object-oriented CIM and XML-based interface for managing SAN devices,
services, and fabrics.

v An initial discovery, which is SLP based.
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The idea behind SMI-S is to standardize the management interfaces so that
management applications can utilize these and provide cross-device management.
This means that a newly introduced device can be immediately managed as it will
conform to the standards.

The models and protocols in the SMI-S implementation are platform-independent,
enabling application development for any platform, and enabling them to run on
different platforms. The SNIA will also provide interoperability tests which will
help vendors test their applications and devices if they conform to the standard.

Service Location Protocol
The Service Location Protocol (SLP) is an Internet Engineering Task Force (IETF)
standard. SLP provides a scalable framework for the discovery and selection of
network services.

The Internet Engineering Task Force (IETF) is a large open international
community of network designers, operators, vendors, and researchers concerned
with the evolution of the Internet architecture and the smooth operation of the
Internet. The IETF includes formal standards for SNMP and MIBs. More
information on IETF can be found at this Web site:
http://www.ietf.org

SLP enables the discovery and selection of generic services, which could range in
function from hardware services such as those for printers or fax machines, to
software services such as those for file servers, e-mail servers, Web servers,
databases, or any other possible services that are accessible through an IP network.

Traditionally, to use a particular service, a user or client application needed to
supply the host name or network IP address of that service. With SLP, however,
the user or client no longer needs to know individual host names or IP addresses.
Instead, the user or client can search the network for the desired service type and
an optional set of qualifying attributes.

For example, a user could specify to search for all available printers that support
Postscript. Based on the given service type (printers), and the given attributes
(Postscript). SLP searches the user's network for any matching services, and returns
the discovered list to the user.

Simple Network Management Protocol
The Simple Network Management Protocol (SNMP) is an Internet Engineering
Task Force (IETF) protocol for monitoring and managing systems and devices in a
network. Functions supported by the SNMP protocol are the request and retrieval
of data, the setting or writing of data, and traps that signal the occurrence of
events.

SNMP is a method that enables a management application to query information
from a managed device. The managed device has software running that sends and
receives the SNMP information. This software module is usually called the SNMP
agent.

An SNMP manager can read information from an SNMP agent in order to monitor
a device. Therefore, the device needs to be polled on an interval bases. The SNMP
manager can also change the configuration of a device, by setting certain values to
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corresponding variables. A device can also be set up to send a notification to the
SNMP manager (this is called a trap) to asynchronously inform this SNMP
manager of a status change.

Depending on the existing environment and organization it is very likely that your
environment already has an SNMP management application in place. IBM Tivoli
Storage Productivity Center can be set up to send traps.

SNMP uses a hierarchical structured Management Information Base (MIB) to define
the meaning and the type of a particular value. A MIB defines managed objects
that describe the behavior of the SNMP entity, which can be anything from an IP
router to a storage subsystem. The information is organized in a tree structure.

For users planning to make use of the Tivoli Storage Productivity Center SNMP
trap alert notification capabilities, an SNMP MIB is included in the server
installation.

The MIB is provided for use by your SNMP management console software. Most
SNMP management products provide a program called a MIB compiler that can be
used to import MIBs. This will allow you to view Tivoli Storage Productivity
Center generated SNMP traps from within your management console software.
Refer to your management console software documentation for instructions on
how to compile or import a third party MIB.

Tivoli Storage Productivity Center uses port 162 to listen for SNMP traps. This is
the default port. For switches, you must configure the switch to send SNMP traps
to the Device server IP address. If you need to change the default port number, use
the setdscfg command. The attribute to set is SNMPTrapPort.

System administrators must set up their SNMP trap ringer with the provided MIB
files in order to receive SNMP traps from Tivoli Storage Productivity Center. These
files are located in the following directories on the product installation DVD:

For Data server:
data\snmp\tivoliSRM.mib

For Device server:
device\snmp\fabric.mib

Fibre Channel Methodologies of Interconnects
IBM Tivoli Storage Productivity Center supports the ANSI T11 Fibre Channel
FC-MI (Fibre Channel Methodologies of Interconnects) for the automated discovery
of FC SAN assets and topology.

ANSI T11 Fibre Channel FC-MI includes the following for the automated discovery
of FC SAN assets and topology:
v Hosts (HBAs)
v FC interconnects
v FC storage devices

The T11 FC-MI also includes the following:
v FC-GS-3/4 (discovery, zoning, and so forth)
v RNID (advanced device recognition)
v Platform registration (device recognition and launch)
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v Common HBA API (fabric and storage views)
v Name server (connectivity)
v Management server (SAN connectivity and topology)
v RSCN (advanced event detection)
v SCSI queries (storage views, volume information, and so forth)
v SNMP Fabric Element (FE) MIB
v SNMP FC Management MIB (discovery, performance statistics, and so forth)
v SNMP alerts
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Appendix B. Accessibility features for Tivoli Storage
Productivity Center

Accessibility features help users who have a disability, such as restricted mobility
or limited vision, to use information technology products successfully.

Accessibility features

The following list includes the major accessibility features in IBM Tivoli Storage
Productivity Center:
v Tivoli Storage Productivity Center functions are available using the keyboard for

navigation instead of the mouse. You can use keys or key combinations to
perform operations that can also be done using a mouse. However, you must
use the mouse to navigate the Topology Viewer and report graphs. Standard
operating system keystrokes are used for standard operating system operations.

v You can use screen readers to read the user interface.
v The user interface communicates all information independently of color.
v The IBM Tivoli Storage Productivity Center Information Center, and its related

publications are accessibility-enabled and include the following accessibility
features:
– The information center is provided in XHTML 1.0 format, which is viewable

in most Web browsers. XHTML allows you to view documentation according
to the display preferences set in your browser. With XHTML, you can use
screen readers and other assistive technologies.

– All documentation for Tivoli Storage Productivity Center is available in
Adobe Portable Document Format (PDF) using the Adobe Acrobat Reader.
You can access the PDFs from the Printable PDFs topic in the information
center at http://publib.boulder.ibm.com/infocenter/tivihelp/v59r1/index.jsp
.

– All images are provided with alternative text, so that users with vision
impairments can understand the contents of the images.

Keyboard navigation

This product uses standard Microsoft Windows navigation keys.

Displaying the interface

Click Preferences > Look and Feel to select how to display the Tivoli Storage
Productivity Center user interface. To do so, complete the following steps:
1. Start the Tivoli Storage Productivity Center user interface.
2. Click Preferences > Look and Feel to change the visual appearance of the user

interface to best suit your visual needs:
v Windows Classic
v Windows
v CDE/Motif
v Metal
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Limitations for sight-impaired users on IBM Tivoli Storage
Productivity Center for Replication

There some limitations in the product graphical user interface (GUI) that requires
special attention before you start using Tivoli Storage Productivity Center for
Replication with a screen reader:

Dojo components are not read by all screen readers.

The JAWS screen reader does not read some Dojo components on Internet
Explorer 7. Use the command-line interface instead of the GUI with JAWS
on Internet Explorer 7.

IBM and accessibility

See the IBM Human Ability and Accessibility Center Web site for more information
about the commitment that IBM has to accessibility.
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Appendix C. Accessibility features for Tivoli Storage
Productivity Center for Replication

Accessibility features help users who have a disability, such as restricted mobility
or limited vision, to use information technology products successfully.

The following list includes the major accessibility features in Tivoli Storage
Productivity Center for Replication:
v Keyboard-only operation
v Interfaces that are commonly used by screen readers
v Keys that are discernible by touch but do not activate just by touching them
v Industry-standard devices for ports and connectors
v The attachment of alternative input and output devices

See the IBM Human Ability and Accessibility Center website at
www.ibm.com/able for more information about the commitment that IBM has for
accessibility.

Accessibility and keyboard shortcuts in the information center

Accessibility features help users with physical disabilities, such as restricted
mobility or limited vision, to use software products successfully. Using the major
accessibility features in this product, users can perform these tasks:
v Use assistive technologies, such as screen-reader software and digital speech

synthesizer, to hear what is displayed on the screen. Consult the product
documentation of the assistive technology for details on using those technologies
with this product.

v Operate specific or equivalent features by using only the keyboard.
v Magnify what is displayed on the screen.

In addition, the documentation was modified to include the following features to
aid accessibility:
v All documentation is available in HTML formats to give the maximum

opportunity for users to apply screen-reader software technology.
v All images in the documentation are provided with alternative text so that users

with vision impairments can understand the contents of the images.

Use the following key combinations to navigate the interface by keyboard:
v To go directly to the Topic pane, press Alt+K, and then press Tab.
v In the Topic pane, to go to the next link, press Tab.
v To go directly to the Search Results view, press Alt+R, and then press the Enter

or Up-Arrow key to enter the view.
v To go directly to the Navigation (Table of Contents) view, press Alt+C, and then

press the Enter or Up-Arrow key to enter the view.
v To expand and collapse a node in the navigation tree, press the Right and

Left-Arrow keys.
v To move to the next topic node, press the Down-Arrow or Tab key.
v To move to the previous topic node, press the Up-Arrow key or Shift+Tab.
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v To go to the next link, button, or topic node from inside on of the views, press
Tab.

v To scroll all the way up or down in a pane, press Home or End.
v To go back, press Alt+Left Arrow; to go forward, press Alt+Right Arrow.
v To go to the next pane, press F6.
v To move to the previous pane, press Shift+F6.
v To print the active pane, press Ctrl+P.

Related accessibility information for sight-impaired users

The following list contains hints and tips that can help you more fully use the
graphical user interface:

Drop-down lists are positioned directly over or before the radio button that
activates it.

If you use a screen reader, you should be aware that there are radio
buttons to activate drop-down lists for several GUI pages. The way to
activate the drop-down list is by selecting the associated radio button. The
drop-down list is positioned directly over or before the radio button that
activates it. When you use a screen reader that processes the fields and
controls of a page sequentially, you might select the radio button, but not
know that the associated drop-down list has been activated. The screen
reader processes inactive drop-down lists first, and then processes the next
radio button. The drop-down list is activated if you select the radio button.

On the following pages, keep in mind that radio buttons activate a
drop-down list:
v Administration
v ESS/DS Paths
v Sessions
v Session Details
v Storage Systems

Tables are best understood by reviewing the surrounding text and the table row
and column number of the table.

On some graphical user pages, tables use the header or row ID attributes
when reading a single cell. The screen reader reads the table row and
column number, along with cell data. Therefore, you can infer the column
header and row ID.

Experiment with and fine-tune the way your screen reader pronounces some of
the product abbreviations.

Your screen reader might pronounce abbreviations as if they were words.
For example, the common abbreviation for Enterprise Storage Server is
ESS. Your screen reader might read ESS as the word "ess". With some
screen readers you can hear alternate pronunciations. If you frequently use
the software you might prefer to fine-tune such associations in your
settings. When an association is created, the screen reader can recognize
the abbreviation as a word. If you can add dictionary words with your
screen reader, replace the capitalized character sequence with the sequence
E space S space S.

Typically, this abbreviation is used in the combination form of ESS/DS.
This term refers to the Enterprise Storage Server 800, the DS6000, or the
DS8000.
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Some decorative artifacts might persist if the cascading style sheet is disabled.

Enable cascading style sheets when possible; otherwise, some decorative
elements might persist in the web browser GUI. These artifacts do not
affect performance. If they become too distracting, consider using the
command-line interface instead.

For efficiency, confirmation dialogs place initial focus on the Yes button.

When a confirmation dialog box is displayed, focus is given to the Yes
button. Therefore, the screen reader reads “Yes” but does not read the
confirmation text. The software processes the information in this way when
you do the following types of tasks:
v Perform an action on a session
v Remove a connection to a storage system
v Click the About link

v Create a high-availability connection

To read the confirmation text before clicking the Yes, No, or OK button,
view the previous heading before the button.

Dojo components are not read by all screen readers.

The Job Access for Windows and Speech (JAWS) screen reader does not
read some Dojo components on Internet Explorer 7. Use the command-line
interface instead of the GUI with JAWS on Internet Explorer 7.

Firefox is the preferred browser for use with a screen reader.
Use Firefox as the screen reader because other browsers might not fully
expose assistive technology content to the screen reader.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758
U.S.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE: This information contains sample application programs in
source language, which illustrate programming techniques on various operating
platforms. You may copy, modify, and distribute these sample programs in any
form without payment to IBM, for the purposes of developing, using, marketing or
distributing application programs conforming to the application programming
interface for the operating platform for which the sample programs are written.
These examples have not been thoroughly tested under all conditions. IBM,
therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any
kind. IBM shall not be liable for any damages arising out of your use of the sample
programs.
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If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at http://www.ibm.com/legal/copytrade.shtml.

Adobe and PostScript are registered trademarks of Adobe Systems Incorporated in
the United States, and/or other countries.

Intel and Itanium are registered trademarks of Intel Corporation or its subsidiaries
in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Notices 1503

http://www.ibm.com/legal/copytrade.shtml


1504 IBM Tivoli Storage Productivity Center: User's Guide



Glossary

This glossary includes terms and definitions for IBM Tivoli Storage Productivity Center.

The following cross-references are used in this
glossary:
v See refers the reader from a term to a preferred

synonym, or from an acronym or abbreviation
to the defined full form.

v See also refers the reader to a related or
contrasting term.

To view glossaries for other IBM products, go to:
http://www.ibm.com/software/globalization/
terminology/.

active management server
A management server from which the
storage environment can be monitored
and managed. The active management
server replicates its database to the
standby server.

business continuity
The capability of a business to withstand
outages and to operate mission-critical
services normally and without
interruption in accordance with
predefined service-level agreements.

CIM See Common Information Model.

CIM agent
The code that consists of common
building blocks that can be used instead
of proprietary software or device-specific
programming interfaces to manage
devices that are compliant with the
Common Information Model (CIM).

CKD See count key data.

cluster
1. In SAN Volume Controller or Storwize
V7000, a pair of nodes that provides a
single configuration and service interface.
2. In IBM System Storage™ DS8000®, a
partition capable of performing all
DS8000 series functions. With two clusters
in the DS8000 storage unit, any
operational cluster can take over the
processing of a failing cluster.

Common Information Model (CIM)
An implementation-neutral,
object-oriented schema for describing

network management information. The
Distributed Management Task Force
(DMTF) develops and maintains CIM
specifications.

community name
The part of a Simple Network
Management Protocol (SNMP) message
that represents a password-like name and
that is used to authenticate the SNMP
message.

consistency group
A group of copy relationships between
virtual volumes or data sets that are
maintained with the same time reference
so that all copies are consistent in time.

copy set
The set of source volumes or target
volumes involved in a FlashCopy
operation.

count key data (CKD)
In mainframe computing, a data-record
format employing self-defining record
formats in which each record is
represented by up to three fields: a count
field identifying the record and specifying
its format, an optional key field that can
be used to identify the data area contents,
and an optional data field that typically
contains the user data.

data collection
The process of obtaining performance and
availability monitoring data and
providing that data to a metric evaluator.
Examples of data collectors include
Domain Name System (DNS) probes, web
page analyzers, or database analyzers. See
also discovery.

discovery
The process of finding resources within
an enterprise, including finding the new
location of monitored resources that were
moved. See also schedule.

enterprise repository
A component of the Data server that
records and stores all information about
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the monitored computers' storage assets
and their usage over time. The repository
is organized into relational database
tables and is accessed by Data server
using Java Database Connectivity (JDBC).

extended count key data (ECKD)
An extension of the count key data (CKD)
architecture.

FlashCopy
In storage systems, a feature that creates a
point-in-time copy of a volume or set of
volumes on a specified target volume.

flush-through mode
A process in which data is written to a
storage device at the same time as the
data is cached.

freeze An operation in which a storage system
blocks I/O from the host system to the
affected volumes on the primary site. A
freeze operation stops mirroring between
the primary and secondary volumes to
ensure data consistency at the secondary
site. See also thaw.

GiB See gibibyte.

gibibyte (GiB)
A base-2 unit of measurement that is
equal to 1,073,741,824 bytes (2 to the 30th
power). See also gigabyte.

gigabyte (GB)
In decimal notation, 1,073,741,824 bytes,
when referring to memory capacity; in all
other cases, it is defined as 1,000,000,000.

Global Copy
A non-synchronous long-distance copy
option for data migration and backup. See
also remote mirror and copy and Metro
Mirror.

Global Mirror
An optional capability of the remote
mirror and copy feature that provides a
two-site extended-distance remote copy.
Data that is written by the host to the
storage unit at the local site is
automatically maintained at the remote
site. See also Metro Mirror and remote
mirror and copy.

Globally Unique Identifier (GUID)
An algorithmically determined number
that uniquely identifies an entity within a
system.

grain size
The unit size for allocating space on
thin-provisioned volumes, such as 32, 64,
128, and 256 kibibyte. The grain size is
defined when a volume is created.

GUID See Globally Unique Identifier.

Hardware Management Console (HMC)
In a system storage environment, a
system that acts as the focal point for
configuration, management of Copy
Services functions, and maintenance.

heat map
A color-coded data chart where colors are
used to differentiate values in a data set.

high availability
Pertaining to a clustered system that is
reconfigured when node or daemon
failures occur, so that workloads can be
redistributed to the remaining nodes in
the cluster.

high-availability solution
A combination of hardware, software, and
services that fully automates the recovery
process and does not disrupt user activity.
High-availability solutions must provide
an immediate recovery point with a fast
recovery time.

HMC See Hardware Management Console.

host volume
A volume that represents the volume
functional role from an application point
of view. The host volume can be
connected to a host or server. It receives
read, write, and update application I/O,
depending on the site to which the
application is writing.

in-band discovery
The process of discovering information
about the storage area network (SAN),
including topology and attribute data,
through the Fibre Channel data paths.
Contrast with out-of-band discovery.

job A unit of work within a run for a
schedule. One run can have multiple jobs.
For example, a system probe schedule has
one job created per system in its
definition.

job scheduler
A component of the Data server that
deploys all monitoring activities.
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journal volume
A volume that holds a consistent copy of
data until a new consistent copy is
formed. The journal volume restores the
last consistent point during a recovery.

KiB See kibibyte.

kibibyte (KiB)
A base-2 unit of measurement that is
equal to 1,024 bytes (2 to the 10th power).
See also kilobyte.

kilobyte
For processor storage, real and virtual
storage, and channel volume, 2 to the
power of 10 or 1,024 bytes. For disk
storage capacity and communications
volume, 1,000 bytes.

logical unit number (LUN)
In the Small Computer System Interface
(SCSI) standard, a unique identifier that is
used to differentiate devices, each of
which is a logical unit (LU).

LUN See logical unit number.

Management Information Base (MIB)
In the Simple Network Management
Protocol (SNMP), a database of objects
that can be queried or set by a network
management system.

management server
A system that provides a central point of
control for managing data replication.

management server relationship
A connection between two replication
servers, where one server acts as the
active server and replicates the data that
is necessary for the standby server to take
control of the replication environment.

mebibyte (MiB)
A base-2 unit of measurement that is
equal to 1,048,576 bytes (2 to the 20th
power). See also megabyte.

megabyte (MB)
For processor storage, real and virtual
storage, and channel volume, 2 to the
20th power or 1,048,576 bytes. For disk
storage capacity and communications
volume, 1,000,000 bytes.

Metro Mirror
A method of synchronous remote
replication that operates over distances up
to 300 kilometers. This method constantly

updates a secondary copy of a volume to
match changes that are made to a source
volume. See also remote mirror and copy
and Global Copy.

Metro Global Mirror
A three-site, high-availability, disaster
recovery solution. Metro Global Mirror
uses synchronous replication to mirror
data between a local site and an
intermediate site, and asynchronous
replication to mirror data from an
intermediate site to a remote site.

MiB See mebibyte.

MIB See Management Information Base.

native interface
An interface that is specific to a system or
subsystem.

out-of-band discovery
The process of discovering storage area
network (SAN) information, including
topology and device data, without using
the fibre-channel data paths. A common
mechanism for out-of-band discovery is
the use of Simple Network Management
Protocol (SNMP) Management
Information Base (MIB) queries, which are
invoked over an IP network. Contrast
with in-band discovery.

ping A job that tracks the availability of assets
and that is performed by an agent.
Several ping jobs can be used to monitor
the availability of any computer or subset
of computers in the network. See also
schedule.

pool A storage pool or pool is a grouping of
storage space that consists of volumes,
logical unit numbers (LUNs), or addresses
that share a common set of administrative
characteristics.

practice volume
A volume that can be used to test
disaster-recovery actions while
maintaining disaster-recovery capability.

primordial pool
Storage capacity that is deallocated on a
storage device. Storage pools are created
by allocating storage capacity from
primordial pools.

probe A job that itemizes and creates an
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inventory of assets, such as computers,
controllers, disk drives, file systems, and
logical units. See also schedule.

recovery point objective
The maximum amount of data loss that
can be tolerated during a service
interruption.

remote mirror and copy
A feature of a storage server that
constantly updates a secondary copy of a
logical volume to match changes made to
a primary logical volume. The primary
and secondary volumes can be on the
same storage server or on separate
storage servers. See also Metro Mirror and
Global Mirror.

resource
In a storage environment, an entity that is
monitored. Resources can include fabrics,
switches, computers, storage systems, and
tape libraries.

role A job function that identifies the tasks
that a user can perform and the resources
to which a user has access. A user can be
assigned one or more roles.

role pair
The association of two roles in a
replication session that take part in a copy
relationship. For example, in a Metro
Mirror session, the role pair can be the
association between the volume roles of
Host1 and Host2.

scan job
A job that monitors the usage and
consumption of storage. See also schedule.

schedule
A monitoring task that collects data about
storage resources. Monitoring tasks
include scans, probes, pings, discovery,
and performance monitors. For example,
define a probe schedule to collect data
about storage systems; define a scan
schedule to collect file-level information
about hosts.

session
A collection of volumes within a logical
subsystem that are managed together
during the creation of consistent copies of
data. All volumes in a session must
transfer their data successfully to the
remote site before the increment can be
called complete.

site awareness
The association of a location (site) with
each storage system and each session's
volume role. When a copy set is added,
only the storage systems with locations
that match those locations of the volumes'
roles can be selected. This constraint
prevents the reversing of a hardware
relationship or the selection of a volume
at the wrong location.

SMI-S See Storage Management Initiative
Specification.

standby management server
A management server that is a backup for
the active server. The replication
environment cannot be monitored or
managed from the standby server.

Storage Management Initiative Specification
(SMI-S)

A design specification developed by the
Storage Networking Industry Association
(SNIA) that specifies a secure and reliable
interface with which storage management
systems (SMSs) can identify, classify,
monitor, and control physical and logical
resources in a storage area network
(SAN). The interface integrates the
various devices to be managed in a SAN
and the tools used to manage them.

storage pod
A logical entity of components of a
system that consists of two storage nodes,
and one or two storage subsystems
directly connected with these storage
nodes.

storage resource group
A named collection of logically related
resources that are monitored by Tivoli
Storage Productivity Center. Monitored
resources can include fabrics, switches,
computers, storage systems, tape libraries,
and other storage resource groups.

target volume
A volume that receives data from a host
volume or another intermediate volume.
It is used only in FlashCopy sessions.

thaw An operation in which a storage system
releases the block of the I/O from the
host system to the affected volumes on
the primary site. A thaw operation can
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occur after a freeze operation ends and
consistency is formed on the secondary
site. See also freeze.

track space-efficient (TSE) volume
A volume in which storage space is
allocated on an as-needed basis by using
space on the target volume only when
tracks are copied from the source volume
to the target volume.

virtualization
The substitution of virtual resources for
actual resources, where the virtual
resources have the same functions and
external interfaces as their counterparts,
but differ in attributes, such as size,
performance, and cost. Virtualization is
commonly applied to physical hardware
resources by combining multiple physical
resources into shared pools from which
users receive virtual resources.

virtual storage area network (VSAN)
A fabric within the storage area network
(SAN).

VSAN See virtual storage area network.

zone A logical grouping of switches, switch
ports, and their attached devices in a
fabric.

zone alias
A name that is given to a collection of one
or more zone members that you want to
manage together.

zone set
A group of zones that function together
on a fabric.
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editing 481
overview 479

schedules
data collection 324
managing 43

screen shots
Create Virtual Disk wizard 563
Storage Subsystem window 552
Storage-Subsystem Details page 553
Virtual Disks page 565
Virtual-Disk Details page 566
Volumes page 570

scripts
resolving script names 498
running 496

scripts (continued)
running scripts with alerts 493
using with jobs 493

Secure Socket Layer (SSL)
disabling 241
enabling 240

security 788
considerations 124

security planner 112
segments with wasted space report 1029
sending comments xvi
sequential VDisk 132
server alerts

triggering conditions 1439
server custom reports 1376, 1378, 1379,

1380, 1382
servers 1376

Server Disk Details Report
capacity 1152
run 1152
used and available space 1152
utilization 1152

server disks 1387
File System Details Report 1152

server groups 1382
server reports

view 1150
Server Storage Summary Report

capacity 1151
run 1150
used and available space 1151
utilization 1151

servers
custom reports

server filters 1372
Server Storage Summary Report

capacity 1150
used and available space 1150
utilization 1150

viewing information in the web-based
GUI 629

viewing status in the web-based
GUI 635

service
Data server

starting 193
Data Server 189

Service Location Protocol
configuration recommendations 327
using to discover CIM agents 252

Service Location Protocol (SLP)
overview 1492

Service tool
for agents 226
for servers 226

services
Data server

broadcasting location 192
configuring audit logging 192
configuring tracing 191
configuring tracing services 191
displaying 190
displaying service log 191
shutting down 192

Device server 194
changing the password 195
displaying information 195
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services (continued)
Device server (continued)

viewing log 195
starting 197
stopping 196
viewing and managing 188

session commands
Basic HyperSwap 729
FlashCopy 730
Global Mirror 734
Global Mirror with Practice 736
Metro Global Mirror 737
Metro Global Mirror with

Practice 740
Metro Mirror 731
Metro Mirror with Practice 733
Snapshot 730

session state change trap
descriptions 666

session types
Basic HyperSwap 82, 703
FlashCopy 83, 704
Global Mirror 91, 712
Metro Global Mirror 96, 717
Metro Mirror 85, 706
Snapshot 84, 705

sessions
about 689
FlashCopy 746
Global Mirror 750
images 767
Metro Global Mirror 752
Metro Mirror 749
properties 771
removing 758
Snapshot 747
states 769
status icons 766
viewing 766
viewing details 784

Global Mirror 785
viewing health summary 765
viewing properties 784

setting
remote standby management

server 669
SNMP 672
standby management server 669
volume protection 683

setting units of measurement for
reports 38

setting up invoices 615
shortcuts in minimap 502
sight-impaired 1497
single sign-on

overview 54
user authentication method used

with 54
site awareness 678, 743
site, modifying location of 758
SMI-S support 327
Snapshot

about 84, 705
creating a session 747
session commands 730

snapshot selection panel 404

SNMP
adding managers 672
MIBs 1492
overview 1492
setting up 672
trap alert notification 108, 1438
traps 1492
viewing alerts 766

SNMP trap descriptions
communication-failure 668
configuration change 667
management servers state

change 668
session state change 666
suspending-event notification 667

SNMP traps
in-band 327

software zoning 114
solid-state drives

icons, storage 507
support for 1427

sorting rows in the web-based GUI 655
space usage

pools 1233
storage resource groups 1233, 1235
storage systems 1231
storage virtualizers 1224
volumes 1235

SSL certificates
how to import for VMware 217

standby management servers
about 664
setting 669
setting a remote server 669

starting 612
DS8000 589
IBM Tivoli Storage Productivity

Center for Replication 657
through Tivoli Integrated Portal

Tivoli Storage Productivity
Center 180

Tivoli Storage Productivity Center
for Replication 180

Tivoli Storage Productivity
Center 175

Tivoli Storage Productivity Center for
Replication 179

Tivoli Storage Productivity Center
stand-alone GUI 175

Tivoli Storage Productivity Center
web-based GUI 178

starting services 197
Tivoli Integrated Portal server 199

states, session 769
status messages, role pairs 783
status of resources in the web-based GUI

acknowledging the status of a
resource 642

acknowledging the status of a
top-level resource 642

acknowledging the status of an
internal resource 643

how the status of resources is
determined 636

viewing the overall status of
resources 639

status of resources in the web-based
GUI (continued)

viewing the status of internal
resources 641

viewing the status of top-level
resources 640

status, checking in topology viewer 513
status, session icons 766
stopping

Tivoli Storage Productivity Center for
Replication 658

stopping services 196
Storage Access Times report 1014
storage area networks (SANs), viewing

topology 501
Storage Availability report 1021
storage capacity 990
storage connections

removing 680
viewing details 786

storage controller 419
Storage Management Initiative -

Specification (SMI-S) 1491
Storage Modification Times report 1017
storage network, viewing 501
Storage Networking Industry Association

(SNIA) 1491
storage optimization policies

Volume Migration Recommendation
Report 1271

Storage Optimizer
analysis report 432
creating analysis report 434
creating optimization report 437
deleting an optimization report 440
deleting analysis jobs 439
launching from topology viewer 535
optimization report 432
overview 432
retrieving optimization report job

definition 440
scenario for identifying hot spots 156
scenario for retiring systems 158
starting from topology viewer 535
supported storage systems 432
using 433
viewing analysis report 435
viewing optimization report 438
zoning recommendations provided

by 440
storage planner 112
storage pool 419
storage port 419
Storage Resource agents

changing authentication 263
configuring for upgrade 260
deployment considerations 118, 273
registering with a different

server 272
uninstalling using GUI 270
upgrading 259

storage resource group
VDisk workload activity details

reports 1261
VDisk workload activity reports 1256
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Storage Resource Group - VDisk
Workload Activity Details Report

run 1260
Storage Resource Group - VDisk

Workload Activity Report
run 1256

storage resource group sessions
deleting 431, 493
groups

storage resource groups 431, 493
viewing 431, 493
working with 431, 493

storage resource groups
custom reports

filters for storage resource
groups 1375

groups
storage resource groups 489

most active 1260
overview 489
Storage Resource Group - VDisk

Workload Activity Report 1256
volumes space usage 1229

Storage Resource Relationships Summary
Report

capacity 1147
run 1146
used and available space 1147
utilization 1147

Storage Resource Relationships Summary
Report (Configurable)

run 1148, 1149
storage resources

information, collect 324
storage subsystem

creating a group 551
data collection 325
deleting a group 551
editing a group 552
group 551
performance reports 1047

storage subsystem constraint violation
reporting

generate report 1001
storage subsystem reporting 990

computer views 990
generate report 995
storage subsystem views 990
Volume to HBA assignment 990

Storage Subsystem window, screen
shot 552

storage subsystems
managing 551
overview 286
removing 553
setting user-defined properties 553
viewing information 554

storage system
adding 286
removing 294
testing connection 294

Storage System - Array Details Report
performance metrics 1215

Storage System - Controller or Module
Details Report

performance statistics 1217

Storage System - Details Report
performance statistics 1213
predefined reports 1213
run 1212, 1219

Storage System - Disks Space Report
capacity 1165, 1166
run 1165
used and available space 1165
utilization 1165

Storage System - Disks Space Reportdisk
details

capacity 1166
Storage System - Historical Space Report

historical reports 1231
space usage 1231

Storage System - Most Active Arrays
Report

performance statistics 1204
running 1204

Storage System - Most Active Ports
Report

running 1211
Storage System - Pools Space Report

capacity 1167
report 1168
run 1167
used and available space 1167

Storage System - Port Details Report
performance statistics 1222
run 1221

Storage System - Volume Details Report
performance statistics 1220

Storage System - Volumes Historical
Space Report

historical reports 1235
Storage System - Volumes Space Report

capacity 1169
run 1169
used and available space 1169
view 1170

storage system alerts
triggering conditions 1444

storage system modules on an XIV
system, custom reports 1317

storage system reports
view 1163

Storage System- Array Details Report
run 1214

Storage System- Controller or Module
Details Report

run 1217
storage systems

about 673
adding a connection to 679
custom reports

block server storage system
controllers 1315

block server storage systems 1286
disks 1411
DS6000 and DS8000 storage system

controllers 1311
DS6000 and DS8000 storage

systems 1279
pools 1408
storage resource groups 1413
storage system arrays 1305, 1306
storage system controllers 1310

storage systems (continued)
custom reports (continued)

storage system filters 1375
storage system groups 1412
storage system modules 1316
storage system ports 1299
storage system ports on block

servers 1303
storage system volumes 1290
storage system volumes on block

servers 1295
storage systems 1277, 1405
volumes 1409
XIV system 1287
XIV system modules 1317
XIV system ports 1304
XIV system volumes 1296

icons 673
managing 673
modifying connection properties 682
modifying location of 682
most active 1202, 1203
most active arrays 1215
most active ports 1211
performance details 1212
ports performance statistics 1222
refreshing the configuration 683
removing 681
removing a connection to 680
reports

Storage System - Details
Report 1212

Storage System - Volumes Space
Report 1170

Storage System- Array Details
Report 1214

Storage Systems - Most Active
Report 1202

Storage Systems - Most Active
Volumes Report 1209

Storage Systems - Space Report 1164
Storage Systems- Space Report 1163
supported 673
viewing details 786
viewing health summary 765
viewing information in the web-based

GUI 629
viewing status in the web-based

GUI 635
viewing volumes 786

Storage Systems - Most Active
running 1202, 1209

Storage Systems - Most Active Controllers
or Modules Report

performance statistics 1207
predefined reports 1207
running 1206

Storage Systems - Most Active Pools
Report

performance statistics 1208
running 1207

Storage Systems - Most Active Ports
Report

most active ports 1211
Storage Systems - Most Active Report

performance statistics 1203
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Storage Systems - Most Active Volumes
Report

run 1210
Storage Systems - Space Report

capacity 1164
space 1164

Storage Systems- Space Report
capacity 1163
run 1163
used and available space 1163

storage tier
reports 1238

storage tier reports
threshold values 1274
threshold values, change 1274

storage tiering
reports 1266

storage tiering policies
creating 442
storage tiering 442
tiered storage 442

storage tiers
workload activity reports 1236

Storage Usage By Database User
sample invoice 619

storage virtualizer
Storage Virtualizer - VDisk Workload

Activity Report 1251
Storage Virtualizer - IO Group Details

Report
performance statistics 1189

Storage Virtualizer - Local Disks Space
space report 1157

Storage Virtualizer - Local Disks Space
Report

capacity 1156
run 1156
used and available space 1156

Storage Virtualizer - MDisk Details
Report

performance statistics 1191
run 1191

Storage Virtualizer - MDisks Space
Report

capacity 1158
run 1158
used and available space 1158

Storage Virtualizer - Node Details Report
performance statistics 1194
run 1193

Storage Virtualizer - Performance Details
Report

performance statistics 1187
Storage Virtualizer - Pool Details Report

performance metrics 1196
run 1195

Storage Virtualizer - Pools Historical
Space Report

space usage 1226
Storage Virtualizer - Pools Space Report

capacity 1159
capacity and space report 1160
run 1159
used and available space 1159

Storage Virtualizer - Port Details Report
performance statistics 1201
run 1200

Storage Virtualizer - VDisk Workload
Activity Report

run 1251
Storage Virtualizer - Volume Details

Report
run 1198

Storage Virtualizer - Volumes Historical
Space Report

space usage 1229
Storage Virtualizer - Volumes Space

Report
capacity 1161
capacity and space report 1162
run 1161
used and available space 1161

Storage Virtualizer – IO Group Details
Report

run 1189
Storage Virtualizer – Volume Details

Report
performance statistics 1198
predefined reports 1198

Storage Virtualizer Performance Details
Report

run 1186
storage virtualizers

custom reports
I/O groups 1347, 1348
local disks 1404
managed disks 1330, 1331, 1403
nodes 1338, 1339
pools 1360, 1362, 1398
ports 1356, 1357
storage virtualizers 1319, 1322,

1374, 1395
volumes 1333, 1335, 1400

disks 1155
most active reports 1177
performance details 1186
pools 1155
space usage 1224
Storage Virtualizer - IO Group Details

Report 1189
Storage Virtualizer - Local Disks

Space 1157
Storage Virtualizer - Node Details

Report
nodes 1193

Storage Virtualizer - Performance
Details Report 1187

Storage Virtualizer - Pool Details
Report 1195

Storage Virtualizer Performance
Details Report 1186

Storage Virtualizers - Most Active IO
Groups Report 1177

Storage Virtualizers - Most Active
MDisks Report 1178

Storage Virtualizers - Most Active
Nodes Report 1180

Storage Virtualizers - Most Active
Pools Report 1182

Storage Virtualizers - Most Active
Ports Report 1185

Storage Virtualizers - Most Active
Volumes Report 1183

storage virtualizers (continued)
Storage Virtualizers - Space

Report 1155
VDisk workload activity reports 1252
virtual volumes 1155

Storage Virtualizers - Historical Space
Report

space usage 1224
Storage Virtualizers - Most Active IO

Groups Report
most active 1177
running 1177

Storage Virtualizers - Most Active MDisks
Report

most active 1179
running 1178

Storage Virtualizers - Most Active Nodes
Report

performance statistics 1181
running 1180

Storage Virtualizers - Most Active Pools
Report

performance statistics 1182
running 1182

Storage Virtualizers - Most Active Ports
Report

performance statistics 1186
running 1185

Storage Virtualizers - Most Active
Volumes Report 1184

running 1183
Storage Virtualizers - Space Report

capacity 1155
capacity and space 1155
run 1155
used and available space 1155

storage virtualizers reports
view 1155

storage-subsystem controllers
performance reports 1040

Storage-Subsystem Details page, screen
shot 553

storage-subsystem performance
reports 997

Storwize V7000 Unified
file sets 1395
pools 1394

striped VDisk 132
superuser group

adding administrator role to 791
suspending-event notification trap

descriptions 667
switch 419

Most Active Switch Ports Report
ports 1171

switch alerts
creating 393
triggering conditions 1449

switch performance
gathering data 337

Switch Performance Details Report
performance metrics 1173
predefined reports 1173

Switch Performance Management 1426
switch performance monitor

creating 377
editing 378
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Switch Performance report 1007, 1056
switch performance report, define and

generate 1003
Switch Port Errors report 1057
Switch Port Performance Details Report

performance metrics 1175
ports 1175
predefined reports 1175
reports 1175
running 1174
switch ports 1175

switch reports
view 1171

switch zone 419
switches

custom reports
ports 1367, 1368
switches 1364, 1365

performance metrics 1173
viewing information in the web-based

GUI 629
viewing status in the web-based

GUI 635
symbols

data copying 767
session status 766
volume roles 767

symmetric virtualization 126
SYSMAINT authority

checking and setting 186
system maintenance authority

checking and setting 186
system reports 1011, 1025

Access File Summary 1013
Access Time Summary 1011
Computer Disk Space 1021
database storage by computer 1025,

1027, 1031, 1033
Disk Defects 1015
Disk Space Summary 1012
Fabric Manager 1054
instance storage by computer 1035
Most at Risk Files 1018
Most Obsolete Files 1019
node cache performance 1044
Oldest Orphaned Files 1019
Port Connections 1054
SAN Assets (ALL) 1055
SAN Assets (Connected

Devices) 1055
SAN Assets (Switches) 1055
segments with wasted space 1029
Storage Access Times 1014
Storage Availability 1021
Storage Modification Times 1017
Switch Performance 1007, 1056
Switch Port Errors 1057
Top Switch Ports Data Rate

Performance 1059
Top Switch Ports Packet Rate

Performance 1060
total database freespace 1028, 1031,

1034
total device freespace 1033
total DMS container freespace 1036
Total Freespace 1023
user database quota violations 1027

system reports (continued)
user database space usage 1026,

1028, 1032, 1034, 1036
User Quota Violations 1020
User Space Usage 1024
using 1010
Wasted Space 1025

T
T11 FC-MI 1493
table alerts 391

description 391
triggering conditions 1444

tablespace alerts 389
description 389

tabs
alert 506

tabular view
tape libraries 540, 541

taking over management from the active
server 671

tape
topology 539
topology viewer

tape libraries 539
tape cartridge, locating 341
tape libraries 1010

alerts 404
discovering 584
groups 373
managing 584
monitoring 340, 383, 585
probes 340
tabular view 540, 541
topology view 540
viewing details 385, 585

Tape Manager
monitoring 340, 383, 585
overview 584
reports 1010

temporary zone sets 114
testing connection

storage system 294
thin provisioning profiles

creating 549
deleting 549, 550
modifying 549, 551
viewing 551
working with 549

threshold
alert 149
array 1459
array threshold 1459
controller 1463
controller thresholds 1463

threshold values
storage tier reports, change 1274

thresholds 1457
port 1464
port thresholds 1464

tiered storage
optimizing 441
storage tiering 441
tiering policies 441

time zone 419

timeout values
setting for Device server 202

timeouts
reports 1413
setting, changing 1413

Tivoli Integrated Portal
overview 53
starting server 199

Tivoli Storage Manager archive/backup
actions, see archive/backup
actions 476

Tivoli Storage Productivity Center
managing schedules, runs, and

jobs 43
Tivoli Storage Productivity Center for

Replication
backing up 187
recovering 187
stopping 658

Tivoli Storage Productivity Center servers
overview 280

tivoliSRM.mib file 1492
tool bar 42
tools

repository copy 221
top n active volumes cache hit

performance
performance reports 1048

Top Switch Ports Data Rate Performance
report 1059

Top Switch Ports Packet Rate
Performance report 1060

top volumes data rate
performance reports 1050

top volumes disk performance
performance reports 1050

top volumes I/O rate
performance reports 1052

top volumes response performance
performance reports 1053

topology 419
topology settings, shortcut to 502
topology viewer

arranging entities within a group 512
connections, displaying 532
Data Path Explorer 523
element managers, launching 534
entities, removing from database 538
entities, selecting 539
entity information, displaying 532
filtering resources 533
groups, creating custom 522
groups, default 503
icons, storage 507
labels, specifying 534
launch planner 535
launch Storage Optimizer 535
levels of detail 501
locating entities 536
manage storage subsystems 536
manage zone control 536
minimap 502
missing entities 538
monitoring and troubleshooting a data

path 523
pinning entities to monitor 537
reports 532
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topology viewer (continued)
show alert logs 539
show monitoring status 539
start Storage Optimizer 535
status, checking 513
table view 506
tape libraries 540
user-defined properties (UDPs) 523
viewing a single data path 523
zones and zone sets 531

total database freespace report 1028,
1031, 1034

total device freespace report 1033
total DMS container freespace 1036
Total Freespace report 1023
Total Size By Database -Tablespace

sample invoice 620
TotalStorage Enterprise Storage Server

port thresholds 1464
TPC server probes

creating 343
TPCDB

connect to 1413
multiple connections to 1417

trademarks 1503
translations

browser locale requirement xv
traps for SNMP 1492
trending 817

history charts 817
triggering conditions

alerts 1439
computer alerts 1439
database-tablespace alerts 1443
device 393
directory alerts 1442
endpoint device alerts 1450
fabric alerts 1448
file system alerts 1440
hypervisor alerts 1451
instance alerts 1442
NAS alerts 1451
performance 393
server alerts 1439
storage system alerts 1444
switch alerts 1449
table alerts 1444

troubleshooting
reports 1413
too many host ports (SAN Volume

Controller) 562
volumes not displayed 574

U
UDPs (user-defined properties) in

topology viewer 523
uninstalling

Data agent 270
Storage Resource agent 270

units of measurement, setting for
reports 38

UNIX Event alert notification 108, 1438
unplanned outage of local (H1) with

production move to remote (H3) 169

Unplanned outage of local (H1),
production move to intermediate
(H2) 167

unplanned outage of remote (H3) 168
unplanned outage of Site 2 (H2) 168
usage reporting

access load reports 920
directories reports 927
files reports 922
OS user groups reports 927
overview 920, 983
users reports 927

usage violation reporting
constraint violations report 928
overview 927, 928, 988
quota violations reports 928

Usage Violation Reporting
information in Usage Violation

reports 989
Quota Violations 989

user administration 788
adding superuser groups 791
granting access privileges 791
modifying access privileges 792
removing user access 792
viewing access privileges 792

user authentication
Secure Socket Layer (SSL)

disabling 241
enabling 240

user database quota violations
report 1027

user database space usage report 1026,
1028, 1032, 1034, 1036

user group name
adding to Tivoli Storage Productivity

Center for Replication 186
user interface

content pane 35
menu bar 35
navigation tree 34
navigation tree nodes 24
starting

using Tivoli Integrated Portal 199
tool bar 42
using 22

user interfaces
when to use 19

User Quota Violations report 1020
user roles

description of 68
User Space Usage report 1024
user-defined properties

setting 553
user-defined properties (UDPs) in

topology viewer 523
users

about 788
groups 788
roles 788

users reports 927
using practice volumes 762

V
VDisk Details Report

run 1268

VDisks
assigning host ports 562
creating 563
definition 126
deleting 132, 565
illustration 132
least active 1243
managing 562
most active 1243
naming conventions 563
overview 132
states 132
types

sequential 132
striped 132

VDisk Details Report 1268
viewing information 566

ver command 660
version

check 187
version of IBM Tivoli Storage

Productivity Center for
Replication 660

View menu 36
viewing

access privileges 792
alerts 399
configuration changes in graphical

view 407
configuration changes in table

view 409
constraint violations 1002
error messages 787
health summary 765
logical paths 687, 787
provisioning profiles 548
session details 784

Global Mirror 785
session properties 784
sessions 766
SNMP alerts 766
storage capacity 990
storage connection details 786
storage resource group sessions 431,

493
storage system details 786
storage-subsystem information 554
thin provisioning profiles 551
VDisk information 566
volume details 786
volume information 574
volumes affected by constraint

violations 1002
workload profiles 544

viewing invoices 617
viewing your topology

arranging entities within a group 512
connections, displaying 532
element managers, launching 534
entities, removing from database 538
entities, selecting 539
entity information, displaying 532
filtering resources 533
groups, creating custom 522
groups, default 503
icons, storage 507
labels, specifying 534
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viewing your topology (continued)
levels of detail 501
locating entities 536
minimap 502
pinning entities to monitor 537
reports 532
status, checking 513
table view 506
user-defined properties (UDPs) 523
zones and zone sets 531

views
overview 218
retrieving information 218, 220

virtual disks
MDisk Groups - VDisk Workload

Activity Report 1242
Storage Resource Group - VDisk

Workload Activity Details
Report 1260

Storage Resource Group - VDisk
Workload Activity Report 1256

Storage Virtualizer - VDisk Workload
Activity Report 1251

VDisk Details Report 1268
Virtual disks

least active 1243
most active 1243

Virtual Disks page, screen shot 565
virtual SANs (VSANs), viewing

topology 501
Virtual-Disk Details page, screen

shot 566
VMware

capacity reports 960
VMware data source

viewing and managing 294
VMware support

how to import SSL certificates 217
volume creation 419
volume groups 1380
Volume Migration Recommendation

Report
migrating volumes 1271
no data 1413
tiering policy 1413

volume planning 419
volume protection

about 678
setting 683

volume roles
about 693
symbols 767

volumes 571
assigning host ports 570
creating 571
creating volumes and assigning them

to a host 571
deleting 573
managing 570
migration 1236
most active 1184, 1210
performance statistics 1220
practice 694, 763
predefined reports 1170
RAID levels, selecting 571
role pairs 694
roles 693

volumes (continued)
Storage System - Volume Details

Report 1219
Storage System - Volumes Space

Report 1169
Storage Systems - Most Active

Volumes Report 1209
Storage Virtualizer - Volume Details

Report 1198
Storage Virtualizer - Volumes Space

Report 1161, 1162
Storage Virtualizers - Most Active

Volumes Report 1183
viewing details 786
viewing information 574

Volumes Details page 574
Volumes page, screen shot 570
volumesstorage resource groups

storage virtualizers 1229
VPA 419
VSANs 116
VSANs (virtual SANs), viewing

topology 501

W
Wasted Space report 1025
Web Based Enterprise Management

(WBEM) 1490
web-based GUI 623

acknowledging alerts 652
acknowledging the status of a

resource 642
acknowledging the status of a

top-level resource 642
acknowledging the status of an

internal resource 643
alert severities 649
alerts

acknowledging 652
removing 652
viewing 648

customizing columns in lists 656
customizing lists 655
dashboard 631
display differences with the

stand-alone GUI 628
exporting information about resources,

jobs, and alerts 653
filtering 655
how information is organized 629
how the status of resources is

determined 636
internal and related resources,

list 625
managing jobs 644
Monitoring the status of

resources 635
removing alerts 652
resources that can be monitored 625
saving information about resources,

jobs, and alerts 653
sorting rows in lists 655
status of resources 635
viewing alerts 648
viewing information about internal

and related resources 634

web-based GUI (continued)
viewing information about

resources 629
viewing information about top-level

resources 633
viewing job logs 647
viewing summary information about

resources 631
viewing the overall status of

resources 639
viewing the status of internal

resources 641
viewing the status of top-level

resources 640
web-based GUI reports

custom 1143
predefined 1143

windows
create script 480, 494
edit script 481
instance alerts 389
Online Execution 616
Storage Subsystem window 552
Storage-Subsystem Details page 553
table alerts 391
Virtual-Disk Details page 566
Volumes page 570

Windows log alert notification 108, 1438
Windows menu 38
wizard

host planner 110
wizards

Assign Host Ports wizard 562, 570
Create Virtual Disk wizard 563

working with
provisioning profiles 544
storage resource group sessions 431,

493
thin provisioning profiles 549
workload profiles 541

workload profile 419
workload profiles

creating 542
deleting 543
modifying 543
viewing 544
working with 541

WWN zoning 114

X
XIV Storage System

port thresholds 1464

Z
zone 114, 419

change properties 578
concepts 114
configure 115
creating 576
default 114
delete 579
duplicate 578
hardware 114
membership 114
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zone (continued)
non standard 116
orphan 115
port 114
software 114
supported switches 116
working with 576

zone alias
change properties 582
creating 581
delete 583
duplicate 583
working with 581

zone planning 419
zone set 114, 419, 579

activate 581
change definition 580
creating 579
deactivate 581
delete while contains zones 115
duplicate 581
temporary 114

zones 113
zones and zone sets in topology

viewer 531
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